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C3DKB basics
Getting started
Last updated: 2023-05-17

Content
The material in this knowledge base is intended for people working on WisDOT highway design and 
construction projects. To support this audience, the following items apply to the content:

WisDOT focus

 l WisDOT resource files and customizations are used. These resources are available to every-
one and can be found here.

 l WisDOT project structure, file naming standards, and object naming standards are used. The 
best attempts are made to keep material up-to-date with current standards. Some material 
will be out-of-date with current standards. WisDOT naming standards are kept current at 
FDM 15.5.3 attachments

 l The majority of content relates to AutoCAD Civil 3D. There is content relating to other add-ons 
and software.

 l There is a blend of generic training and documentation that applies to any usage of AutoCAD 
Civil 3D and content that is specific to highway design and construction as approached by 
WisDOT. 

Best practices

In situations where best practices have been identified, content has been developed with the fol-
lowing focus:

 l Live connections: Workflows that support live data connections are preferred to those that 
use copies of data.

 l Managing data edits: Workflows that allow for easier editing of data after creation are pre-
ferred to workflows that may be faster or simpler initially, but are more difficult or time-con-
suming to edit data later on.

 l One powerful method: Often there are many possible ways to solve a problem in engin-
eering software. When best practices identify one workflow as superior or more flexible 
across more scenarios, that workflow is taught rather than teaching multiple methods for the 
following reasons:

 o Once learned, it is easier to simplify workflows to simpler situations rather than 
attempt to use simple workflows that aren't appropriate to complex design situations.

 o Simplistic workflows  apply to fewer situations or have drawbacks that new users may 
be unaware of.

Usage
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Role-based Training courses have been developed for new users to cover basics and common work-
flows. "New user topics" on the facing page cover helpful items to complete the training courses suc-
cessfully.

There are many topics that are not in the training courses. Once complete with new user training, 
the C3DKB is searchable for more focused topics.

Tip: Demonstrations and exercises are provided throughout the C3DKB. It is strongly recom-
mended that users do the demos and exercises along with instructors. The best way to learn 
it, is to do it.

Topic display
Click on the green headings to expand or collapse a single sub-topic.

Click on the "expand/collapse all" button to the right of the print button to toggle between states.

 

Formatting

Files and objects

File names are bold. wisdot16.dwt, ProjectID\BaseData\Surf-Ex.dwg

Object names are bold and italic. 25-prop, Int-12-BB-NW-CG

Commands

Commands have a grey background.

Button clicks/keystrokes have an outline. Ok Enter Erase Existing Entities Esc

Command line text looks like this: Offset Enter 12 enter 

Drilldowns are a path of clicks and right-clicks that lead to a command. Drilldowns look like this: 
Home tab > Create Design panel > Alignment dropdown > Alignment Creation Tools, Right-
click modelspace > Options... > Open and Save tab

Important concepts

Important concepts are in color with an icon.

Requirement: Requirements are green with a check mark. Requirements are items that must 
be followed and often refer to the FDM.

Warning: Warnings are red with a stop sign. They identify steps and workflows that should be 
avoided.
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Tip: Tips are yellow with a light bulb. They aren't necessary, but they are a good idea and can 
save time.

Info: Infos are blue with an i. Infos often are reasons why a step is used or provide more 
explanation.

Prerequisite: Prerequisites are orange with an exclamation point in a triangle. They identify 
topics that should be understood before learning the current topic.

New user topics
Last updated: 2020-10-26

Training courses
Training courses for new users are available. They are defined by typical job types and are intended 
to give users enough knowledge and experience to be comfortable working in Civil 3D. Training 
courses do not include all of the topics in the C3DKB. There are many intermediate, advanced, and 
reference topics. These topics can be found through navigation and search and referred to when 
needed.

When using the training courses online, the breadcrumbs will not show the training course. They will 
show the structure in the C3DKB. Use your browser's Back functionality to get back to the training 
course from a topic.

Excel spreadsheets are provided for each training course and the entire C3DKB. The intent of the 
training course spreadsheets is that you can download a personal copy and track your progress. The 
spreadsheets also contain a "Last Updated" field. This can be used to see what material has been 
updated since new user training. For example, if you completed new user training in January 2016, 
you can check "C3DKB updates" on page 51 or you can download the C3DKB spreadsheet and sort 
by Last Updated newest on top to find updated material.

How to approach new user training
These are identified best practices for increasing the success of new user training in Civil 3D.

 1. Timing: Try to complete new user training right before needing to use Civil 3D. Training too 
far before  needing to use the software in production will not be remembered as well.

 2. Session duration: Plan for 1-4 hour blocks of training at a time. Less than an hour at a time 
will not have continuity of topics. Most people's focus will start to fade after the 2-4 hour 
range.

 3. Course schedule: Training courses have the total amount of video time reported on them. 
Actual time spent training will be more than this. With reviewing content and doing exercises, 
a good estimate is 1.5-2 times the total video time for total training time. This total training 
time should be planned to be completed in 6-8 weeks. Training that takes longer than this will 
likely not get completed. Shorter training time frames will likely require longer sessions that 
don't fit well into a work schedule or are not absorbed as well.
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 4. Focus:Manage your surroundings to increase your retention and understanding of training 
material.

 A. Use times and locations that are conducive to training. Choose times when you typ-
ically don't have meetings, phone calls, or people stopping by. Consider training away 
from your workspace if there are too many distractions.

 B. Shut down the web, social media, email, and the phone. "Keeping an eye on email" or 
responding to phone calls is typically too much distraction for people to retain tech-
nical training.

 5. Complete training: The new user courses are structured to be an introduction to Civil 3D. 
Completing a course gives you a base level of preparation to use it in production. Not com-
pleting a course will leave you unprepared and not fully understanding the purpose of early 
topics and how they impact later ones.

 6. Have an open mindset: Attitude is critical to learning anything new. Whether you believe 
you will succeed or not, you're probably right. Give yourself the opportunity to make mis-
takes, learn, and grow.

 7. Practice with the instructor:"The only way to really know it, is to really do it." While some of 
the training may seems simple to retain by just watching the instructors or reading the text, it 
is critical to retention to actually do the exercises. No one learns everything about swimming, 
riding a bike, or playing a musical instrument by reading text and watching videos. Doing a 
task provides a whole level of comprehension beyond reading about it or watching someone 
else. 

 8. Train on exercise data, not live projects: It can be very tempting to "train" on live projects. 
It can increase engagement and seems like an efficient approach. However, the likelihood 
that you will make mistakes in new user training is extremely high. The downstream costs of 
poor data management or workflows that do not provide dynamic links between data can be 
extremely high later on. Allow yourself the time to learn prior to applying that knowledge. 
You'll likely save yourself time and headaches in the long run.

Controlling video open and speed playback
Last updated: 2022-03-08

Many knowledge base topics have videos associated with them. They use native browser func-
tionality to play the videos and not customized video playback wrappers.

Open video in new tab/window
Default action to open a link in many browsers is to replace the current webpage with the new link. 
However, when you go back to the previous page, it will not remember where you were on the page. 
This can be troublesome for very long topics.

To open a video and keep the topic webpage open, you can open a video link in a new tab or win-
dow. The following commands work in Microsoft Edge and Google Chrome and should work in all 
Chromium-based browsers:
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Open link in new tab

 1. Right-click link > Open link in new tab
 2. Ctrl + Click link

Open link in new window

 1. Right-click link > Open link in new window
 2. Shift + Click link

Video speed playback control
You may want to speed up, slow down, skip ahead or back on videos in addition to play/pause func-
tionality. This is most easily managed with a browser extension.

The extension that is approved for WisDOT use is:

Video Speed Controller

To add this extension to Edge or Chrome:

 1. Click Video Speed Controller - Chrome Web Store (google.com)
 2. Click Add to Chrome on the webpage

Control options and keyboard shortcuts can be found by right-click Video Speed Controller exten-
sion > Extension options

Source code and documentation at GitHub - igrigorik/videospeed: HTML5 video speed controller (for 
Google Chrome)

WisDOT Civil 3D forms
Last updated: 2022-11-17

Form Description Last 
updated

WisDOT-C3D-
DesignData-Meta.docx

Civil 3D Metadata Sheet for WisDOT Pro-
ject - Design Data

1/2017

WisDOT-C3D-Check-
list.docx

Electronic data checklist for  deliverables 
received from design consultants.

5/2021

WisDOT-C3D-Con-
trDataPack-Meta.docx

Civil 3D Metadata Sheet for WisDOT Pro-
ject - Contractor Data Packet

11/2022

C3DKB updates
Last updated: 2023-05-03

The heading date indicates the publish date for the topics contained within.
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2023-05-03

Group Topic

"Alignments" on page 589
"Create best fit alignment from survey points" 
on page 636 topic updated.

 

"Calculate superelevation correctly for WisDOT 
standards and subassemblies" on page 633 
replaced topic WisDOT superelevation 
design macro explained.

 
"Floating curves in alignments" on page 606 
replaced topic  Alignment reverse and com-
pound curves.

Analyze panel QTO - Areas Report topic updated.

  QTO - Lengths Report topic updated.

"Corridor modeling situations 
and design elements" on 
page 1074

"DaylightProfileControlled workshop" on 
page 1074 topic updated for addition of target 
parameter Clear zone width from profile.

Design panel Profile - Control Profile Editor topic updated.

  Profile - Create Surface Profiles topic created.

 
Surfaces - Create Cropped Surfaces topic 
updated.

Manage panel
Surfaces - Rebuild Surfaces topic removed. 
No longer needed.

  DWG - Purge Unused References topic added.

  Xref tools - Assign Xref to Layer topic updated.

  Xref tools - Load Xref on Layer topic updated.

"Quantities" on page 1793
"3D Surface area" on page 1868 topic updated. 
Tool source code migrated from Dynamo to 
C#.
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Group Topic

Sheet Creation panel
Sheet Tools - Add/Update Block Mask topic 
added.

  Component palettes topic updated.

"Plan production" on page 1297

"Sample plan sheets" on page 1398 updated 
with Earthwork matchlines renamed from 
Cross-section matchlines. New sample sheet 
pdf linked.

2023-01-25

Group Topic

Manage panel
Project - Sync Project Files topic updated. 
Instructions for creating SyncFiles.csv added.

 
CutFillProfileControlled topic updated. Target 
parameter Recoverable offset from profile 
added.

 
DaylightProfileControlled topic updated. Tar-
get parameter Clear zone width from profile 
added.

"Roundabout" on page 1036 
group added.                             

"Roundabout: vertical design - introduction" 
on page 1036 topic added. Replaces Round-
about modeling workflow.

 
"General notes sheet" on page 1405 topic 
updated. Many standardized notes added to 
speed sheet template.

 
"Fixing bad triangles at intersections with null 
regions" on page 788 topic added.

"Design checks" on page 1255
"Profile sight distance analysis" on page 1288 
topic added. Replaces Stopping sight dis-
tance - 2D analysis with AutoTURN
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Group Topic

Draw panel group added.                             Curves - Floating Curve topic added.

  Curves - Free Curve  topic added.

  Lines - Floating Line topic added.

  Lines - Free Line  topic added.

Plot Configuration panel 
renamed to Plot panel

Publish Collections Manager topic added.

"Subassemblies and assemblies" 
on page 715

"Copy assembly" on page 739 topic updated 
for current Civil 3D functionality.

WisDOT subassembly help
CutFillProfileControlled topic updated. Target 
parameter Recoverable offset from profile 
added.

 
DaylightProfileControlled topic updated. Tar-
get parameter Clear zone width from profile 
added.

 
ProfileToParameterRef topic updated to more 
accurately describe subassembly logic. 

2022-12-13

Group Topic

"C3DKB basics" on page 47
"WisDOT Civil 3D forms" on page 51 topic 
updated. CDP feedback form removed. CDP 
Metadata sheet updated.

"Contractor data" on page 1878
Contractor data packet feedback form 
removed. No longer needed.

"Corridor modeling fun-
damentals" on page 767

"Redundant intersection corridor feature 
lines" on page 791 topic updated.

"Corridor modeling situations "DaylightProfileControlled workshop" on 
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Group Topic

and design elements" on 
page 1074

page 1074 topic updated.

 
"Modeling beam guard energy absorbing ter-
minals (BG EATs)" on page 1093 topic updated.

  Modeling rural driveways topic added.

"File/software management" on 
page 207

"Update WisDOT Civil 3D desktop application" 
on page 214 topic updated for new Updater 
msi.

"Infraworks" on page 2254 The entire group has been updated.

"Parcels/Plats" on page 1611
"R/W DWG extraction for GIS" on page 1679 
topic added.

"WisDOT Civil 3D project setup" 
on page 179

"Project data workflow map" on page 181 
topic updated.

2022-11-02

Group Topic

"C3D 2022" on page 1953
" WisDOT Civil 3D 2022 "What's new?"" on 
page 1953 topic updated.

"Alignments" on page 589
"Alignment basics" on page 589 topic updated.
                             

 
"Alignment layout tools" on page 590 topic 
updated.                             

 
"Alignment lines and curves" on page 594 
topic updated.                             

 
"Create alignment for objects" on page 599 
topic updated.                             

 
"Alignment from existing alignment" on 
page 603 topic updated.                             
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Group Topic

 
"Alignment editing" on page 607 topic 
updated.                             

 
"Alignment properties" on page 611 topic 
updated.                             

 
"Offset alignments and widenings" on 
page 618 topic updated.                             

 
"Alignment superelevation" on page 627 topic 
updated.                             

"Data management" on 
page 131

"Data management for Civil 3D projects" on 
page 131 topic added.

"Design checks" on page 1255
"Profile sight distance analysis" on page 1288 
topic added. Replaces Stopping sight dis-
tance - 2D analysis with AutoTURN

Design panel
Points - Point Station Offset to UDP topic 
updated for update to interface.

 
Profile - Create Profile from Points topic 
added.

  Profile - Control Profile Editor topic updated.

"File/software management" on 
page 207

"AutoTurn: Import WisDOT vehicle libraries" 
on page 260 topic updated for updated file 
format.

"Known issues" on page 97

"Known issue - Excel Civil 3D quantities 
"Microsoft Excel is waiting for another applic-
ation to complete an OLE action."" on page 99 
topic added.

 

 l C3D 2018 Pipe network parts list pay items 
missing/incorrect,

 l WisDOT culvert and storm drain reports, cor-
rected invert elevations and station values,
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Group Topic
 l Known issue: Storm and Sanitary Analysis: 

incorrect depth and spread calculations with 
Neenah inlet grates

topics removed. They no longer apply.

Manage panel
DWG - Replace Blocks topic updated to current 
interface.

  Layers - Apply Layer State topic added.

  Layers - Layer Color Manager topic added.

 
Workspace - Remove Current Profile topic 
added.

 
Workspace - Restore User Settings topic 
updated.

  Refresh Palettes removed.

 
Workspace - Reset WisDOT Profile topic 
removed. Workspace Remove and Workspace 
restore replace this functionality.

 
Layers - Convert Layer Colors topic 
removed. Replaced with Layers - Layer Color 
Manager

"Plan production" on page 1297
"Earthwork quantities sheet" on page 1581 
topic updated with known issue.

 
"Miscellaneous quantities sheets" on 
page 1550 topic updated with known issue.

"Profiles" on page 679 "Profile basics" on page 679 topic updated.

 
"Create surface profile" on page 679 topic 
updated.

 
"Profile properties and styles" on page 684 
topic updated.
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Group Topic

 
"Profile view properties" on page 687 topic 
updated.

 
"Profile layout tools" on page 690 topic 
updated.

 
"Create profile with lines and curves" on 
page 693 topic updated.

 
"Create design profile" on page 695 topic 
updated.

 
"Edit design profile" on page 697 topic 
updated.

  "Profile labels" on page 701 topic updated.

 
"Create best fit profile" on page 703 topic 
updated.

WisDOT subassembly help CGBasic topic updated for TBT curb head.

 
MultiProfParameterRef topic updated for 
default value support.

Excel - WisDOT Civil 3D add-in Excel  - Repeat Selection Every topic added.

2022-08-31

Group Topic

"C3D 2022" on page 1953
" WisDOT Civil 3D 2022 "What's new?"" on 
page 1953 topic updated.

 
"Civil 3D 2022 add-ons" on page 2035 topic 
updated.

Analyze panel
Visibility Check - Check Sight Distance topic 
added.

  Visibility Check - Check Profile Sight Distance 
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Group Topic

topic added.

"Contractor data" on page 1878
"Export alignment superelevation data" on 
page 1900 video added to topic.

 
"Contractor data packet overview" on 
page 1878 topic updated.

 
"Geodetic references documentation" on 
page 1884 topic added.

 
"Export LandXML files" on page 1884 video 
added to topic.

 
"Export ACAD DWG files" on page 1889 video 
updated.

 

"Extract design surface breaklines" on 
page 1894 topic added. Replaces Extract sur-
face model and Extract design surface data 
utility overview

 
"Export cross section slope stake files" on 
page 1901 video added to topic.

 
"Create Zip file of ConstData folder for deliv-
ery" on page 1902 topic updated.

 
"Run CDP Integrity Report" on page 1903 video 
added to topic.

"Design checks" on page 1255
"3D sight distance analysis" on page 1272 
topic added. Replaces Stopping sight dis-
tance - 3D analysis

"Corridor modeling fun-
damentals" on page 767

"Redundant intersection corridor feature 
lines" on page 791 topic added.

Excel - WisDOT Civil 3D add-in
Excel  - Data Link Named Range topic updated 
to Data Link instead of MQ
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Group Topic

"File/software management" on 
page 207

"Civil 3D install and initialize process 
(WisDOT only)" on page 207 topic updated. 
Update app desktop icon removed from 
instructions. Link to add-ons added.

 
"Installing and Initializing Autodesk Storm and 
Sanitary Analysis   (WisDOT only)" on page 211 
topic added.

"Non-Survey base data" on 
page 509

"Creating a wetland survey Civil 3D drawing" 
on page 523 topic added.

"Plan production" on page 1297
"Options to create slope intercept file" on 
page 1596 topic added.

 
"Earthwork quantities sheet" on page 1581 
topic updated to use new tools.

 
"Miscellaneous quantities sheets" on 
page 1550 topic updated to use new tools.

"Quantities" on page 1793
"Earthwork quantities" on page 1793 topic 
updated for new tools related to Excel and 
earthwork.

WisDOT Design tab
Alignment - Adjust Superelevation Runout 
topic updated to current interface.

 
Contractor Data - Design Surface Data 
Extractor topic updated to current interface.

 
Pipe Network - Structure Sump Adjust topic 
updated to current interface.

 
Profile - Control Profile Editor topic updated to 
current interface.

WisDOT Sheets tab
Assign Page Setup topic updated to current 
interface.
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Group Topic

 
Set Textstyle/Size topic updated to current 
interface.

   

 
"C3DKB blog" on page 88 out-of-date material 
removed.

2022-05-20

Group Topic

"AutoCAD fundamentals" on 
page 335

Topics updated with screenshots current with 
interface.

"C3DKB basics" on page 47
"Controlling video open and speed playback" 
on page 50 topic added.

"Corridor modeling fun-
damentals" on page 767

"Corridor data shortcut surface modeling" on 
page 797 topic updated to current tools.

"Corridor modeling situations 
and design elements" on 
page 1074

Controlling corridor slopes with profiles topic 
removed.

 
DaylightProfileControlled subassembly: deep 
dive topic removed.

 
"DaylightProfileControlled workshop" on 
page 1074 topic added.

 
"Modeling beam guard energy absorbing ter-
minals (BG EATs)" on page 1093 topic updated 
to current tools.

"Cross sections" on page 1685
"Add section view to existing group" on 
page 1764 topic updated with better workflow 
for adding section to existing group.

"Design checks" on page 1255
"Intersection sight distance - 3D analysis" on 
page 1294 topic added.
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Group Topic

"File/software management" on 
page 207

Adding WisDOT node package location to user 
profile (Outside WisDOT only) topic removed. 
No longer needed.

 
"Civil 3D install and initialize process 
(WisDOT only)" on page 207 topic updated for 
internal distribution updates. 

 
"Update WisDOT Civil 3D desktop application" 
on page 214 topic updated for internal dis-
tribution updates.

 
"Troubleshooting ribbons/palettes/C3D profile 
problems" on page 215 topic added.

"Known issues" on page 97
"Known issue - monitor display scale and res-
olution" on page 97 topic added.

 
"Issue related to Civil 3D Survey databases cre-
ated with Civil 3D 2020 (WisDOT)" on page 112 
topic updated to current tools.

"Quantities" on page 1793
"3D Surface area" on page 1868 topic updated 
to current tools.

"Plan production" on page 1297
"Create layout manually" on page 1310 topic 
updated to current user interface.

 
"Dynamic station/offset labels and tables on a 
surface with pipe networks" on page 1601 
topic updated to current tools.

 
"Traffic control / Stage construction" on 
page 1506 topic added.

 
"Sample plan sheets" on page 1398 topic 
updated with new training.

Sheet Creation panel
"08 Structures" on page 1381 topic updated 
with new tools.
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Group Topic

"Structures plan production" on 
page 1381

"Creating structures layout sheets with rotated 
viewports" on page 1396 topic added.

WisDOT Any tab Create Object Folders topic updated.

WisDOT Design tab
Alignment - Assign Alignment Styles topic 
updated.

 
Corridor - Assign Corridor Targets topic 
updated.

 
Corridor - Create Corridor Surfaces topic 
updated.

 
QTO - Earthwork Detail Report (Beta) topic 
added.

 
Surfaces - Create Wall Surface topic updated 
for new functionality.

 
Visibility Check - Check Sight Distance topic 
added.

 
Visibility Check - Sight Distance Palette topic 
updated.

WisDOT Sheets tab
Sheet Tools - Create Typical from Assembly 
topic added.

 
Sheet Tools - Create data links and tables topic 
added.

WisDOT Survey tab
Import SOE topic updated for current inter-
face.

Excel - WisDOT Civil 3D add-in Group added.

 
Excel  - Earthwork Summary Report topic 
added.

  Excel  - Format Station topic added.

  Excel  - Line Every topic added.
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Group Topic

  Excel  - MQ Named Ranges topic added.

2022-02-15

Group Topic

"Civil 3D version info" on 
page 1953

"C3D 2022" on page 1953 topic added.

"C3D 2022" on page 1953
" WisDOT Civil 3D 2022 "What's new?"" on 
page 1953 topic added.

 
"Civil 3D 2022 add-ons" on page 2035 topic 
added.

 
"Civil 3D release comparison 2018 through 
2022" on page 2035 topic added.

 
"Civil 3D project version migration from 2016 
to Civil 3D 2022" on page 2047 topic added.

Analyze panel
Visibility Check - Check Intersection Sight 
Distance topic added.

 
Visibility Check - Sight Distance Palette topic 
added.

 
QTO - Lengths Report topic updated for Civil 
3D 2022.

 
QTO - Areas Report topic updated for Civil 3D 
2022.

"Contractor data" on page 1878
"Contractor data packet overview" on 
page 1878 topic updated with current content.

  Contractor data basics topic removed.

 
"Contractor data packet metadata sheet" on 
page 1884 topic added.
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Group Topic

 
Contractor data packet feedback form 
topic added.

 
"Export LandXML files" on page 1884 topic 
updated to current standards and Civil 3D 
2022.

 

"Export ACAD DWG files" on page 1889 topic 
updated with Detach option instead of Ignore. 
Topic updated to link to production Contractor 
Data Packet metadata form and details for dif-
ferent data type file exports.

 
"Export alignment superelevation data" on 
page 1900 topic updated.

 
"Copy earthwork data spreadsheet" on 
page 1902 topic added.

 
"Create Zip file of ConstData folder for deliv-
ery" on page 1902 topic updated.

 
"Run CDP Integrity Report" on page 1903 topic 
added.

 
"eSubmit Contractor Data Packet" on 
page 1903 topic added.

 

Export survey control LandXML file topic 
removed. Content added to "Create survey 
control file from field survey" on page 550 and 
"Export LandXML files" on page 1884

"Cross sections" on page 1685
"Project objects onto section views" on 
page 1773 topic updated and videos added.

"Design checks" on page 1255
Stopping sight distance - 3D analysis topic 
updated with current tool locations in inter-
face.

Design panel Assembly - Label Assembly topic updated for 
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Group Topic

Civil 3D 2022.

 
Pipe Network - Move Pipe End topic updated 
for Civil 3D 2022.

 
Pipe Network - Pipe Separation at Structure 
topic updated for Civil 3D 2022.

 
Profile View - Profile View Elevation Range 
topic updated for Civil 3D 2022.

  Surfaces - Create Wall Surface topic added.

   

"File/software management" on 
page 207

"Civil 3D install and initialize process 
(WisDOT only)" on page 207 topic updated for 
Civil 3D 2022. 

 
"Update WisDOT Civil 3D desktop application" 
on page 214 topic updated for Civil 3D 2022.

Manage panel  

 
DWG - Import Description Keys topic updated 
for Civil 3D 2022.

 
DWG - WisDOT Reference Template: OFF/ON 
topic updated for Civil 3D 2022.

 
Layer States Palette topic updated for Civil 3D 
2022.

 
Xref tools - Load Xref on Layer topic updated 
for Civil 3D 2022.

Output panel
Contractor Data - CDP Integrity Report topic 
added.

 
Contractor Data - Create Verification Surface 
topic added.
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Group Topic

Sheet Creation panel
Sheet Tools - Label Section Sheets topic 
updated for Civil 3D 2022.

 
Sheet Tools - Rotate Mleader, Mtext & Blocks 
to Vport topic updated for Civil 3D 2022.

 
Sheet Tools - Station Increment Labels topic 
updated for Civil 3D 2022.

  "08 Structures" on page 1381 topic added.

"Structures plan production" on 
page 1381

New group topic added.

 
"Setting up a Structures drawing with a rotated 
modelspace" on page 1392 topic added.

 
"Structures insert sheets" on page 1398 topic 
added.

"Survey" on page 540
"Create survey control file from field survey" 
on page 550 topic added.

 
Export survey control LandXML file topic 
removed. Content added 

View panel
Delete Views topic removed. Tool has been 
removed from interface.

  Import Views topic updated for Civil 3D 2022.

WisDOT Civil 3D custom items WisDOT sheet borders topic added.

WisDOT subassembly help
MedianDitchorBerm topic corrected video 
links.

Zone Category: WisDOT retired

The Zone Category WisDOT has been retired for Civil 3D 
2020 and beyond. Detailed information has been 
updated in the following topics:

 l "Wisconsin coordinate projection issue - 
XML/SDB" on page 116

 l "Wisconsin coordinate projection issue - 
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Group Topic
SDB/DWG" on page 120

 l "WisDOT Civil 3D coordinate system action sum-
mary" on page 191

 l "Wisconsin coordinate system settings in Civil 
3D" on page 188

 l "Transform projection of different object types" 
on page 196

 l "Culvert pipes and parcels from ArcGIS Online to 
Civil 3D" on page 299

 l "Export road linework from InfraWorks to Civil 
3D" on page 309

 l "Export Civil 3D data to Google Earth, 2D" on 
page 311

 l "Export Civil 3D data to Google Earth, 3D" on 
page 317

 l "Export Civil 3D parcels to GIS shapefile" on 
page 321

 l "Attach an ortho image to a DWG using Map Con-
nect" on page 517

 l "Working with spatially referenced DWG, image, 
and GIS files" on page 519

2021-11-16

Group Topic

"AutoCAD fun-
damentals" on 
page 335

"Annotation" on page 472 topic updated for Civil 3D 2020.

 
"Annotative scale" on page 490 topic updated for Civil 3D 
2020.

 
"AutoCAD basic creation and editing" on page 335 topic 
updated for Civil 3D 2020.

 
"Blocks and external references" on page 450 topic updated 
for Civil 3D 2020.

  "Create a custom annotative scale (annoscale)" on page 505 
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Group Topic

topic updated for Civil 3D 2020.

  "Grips" on page 420 topic updated for Civil 3D 2020.

  "Hatch" on page 403 topic updated for Civil 3D 2020.

 
"Layers and their properties" on page 433 topic updated for 
Civil 3D 2020.

 
"Light drafting techniques" on page 504 topic updated for Civil 
3D 2020.

 
"AutoCAD modify" on page 376 topic updated for Civil 3D 
2020.

  "Object snaps" on page 357 topic updated for Civil 3D 2020.

 
"Polar and osnap tracking" on page 369  topic updated for Civil 
3D 2020.

 
"TrueView navigating and measuring" on page 506   topic 
updated for Civil 3D 2020.

"Civil 3D inter-
face" on 
page 263

"Adding a folder link to a Civil 3D dialog" on page 290  topic 
updated for Civil 3D 2020.

 
"Basic mouse operations" on page 274 topic updated for Civil 
3D 2020.

 
"Borrowing and returning a Civil 3D license" on page 287 topic 
updated for Civil 3D 2020.

 
"Command shortcuts and hotkeys" on page 273 topic 
updated for Civil 3D 2020.

  "Data shortcuts" on page 284 topic updated for Civil 3D 2020.

 
"File, model, and layout overview" on page 278 topic updated 
for Civil 3D 2020.

 
"File open, save, and new" on page 276 topic updated for Civil 
3D 2020.
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Group Topic

  "Inquiry tool" on page 286 topic updated for Civil 3D 2020.

 
"Interface introduction" on page 263 topic updated for Civil 
3D 2020.

 
 "Ribbon and tabs" on page 265 topic updated for Civil 3D 
2020.

  WisDOT reference templates topic updated for Civil 3D 2020.

  "Status bar" on page 276 topic updated for Civil 3D 2020.

 
"Steering wheel control" on page 275 topic updated for Civil 
3D 2020.

  "Toolspace" on page 266 topic updated for Civil 3D 2020.

 
"External references" on page 279 topic updated for Civil 3D 
2020.

 
"Xreference vs data shortcut concepts" on page 285 topic 
updated for Civil 3D 2020.

"Design checks" 
on page 1255

"Compare existing cross slope profiles with superelevation 
design" on page 1267 topic updated with new tool locations in 
interface.

"Plan pro-
duction" on 
page 1297

"Sample plan sheets" on page 1398 topic updated with 
sample r/w plat.

WisDOT Civil 3D 
custom items

WisDOT Civil 3D custom user interface topic added.

  WisDOT Civil 3D styles topic added.

  WisDOT dimension styles topic added.

  WisDOT linetypes topic added.

  WisDOT layers topic added.
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Group Topic

  WisDOT layer states topic added.

  WisDOT multileader styles topic added.

  WisDOT pay item data topic added.

  WisDOT page setups topic added.

  WisDOT pipe network objects, data, and settings topic added.

  WisDOT plot styles topic added.

  WisDOT reference templates topic added.

  WisDOT Civil 3D survey settings topic added.

  WisDOT subassemblies and assemblies topic added.

  WisDOT textstyles topic added.

WisDOT *** tab 
> Manage panel 

Xref tools - Assign Xref to Layer  topic added.

WisDOT *** tab 
> Support panel

WisDOT FDM topic added.

WisDOT Design 
tab > Analyze 
panel

QTO - Areas Report topic added.

  QTO - Lengths Report topic added.

  Retired tools removed.

WisDOT Design 
tab > Design 
panel

Alignment - Create Alignments From Intersection Block topic 
added.

WisDOT Design 
tab > Output 
panel

Contractor Data - Superelevation Report topic updated for 
new interface.

 
Contractor Data - Design Surface Data Extractor topic updated 
with correct file template.
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2021-09-08

Group Topic

"AutoCAD fun-
damentals" on 
page 335

"Layers and their properties" on page 433 updated with 
native command for XREF layer properties reset.

"Contractor data" on 
page 1878

Extract design surface data utility overview topic 
updated with Contractor Data - Assign CDP Breakline 
Layers

"Design checks" on 
page 1255

"Compare existing cross slope profiles with super-
elevation design" on page 1267 topic updated for 
updated UI and tools. 

"File/software man-
agement" on page 207

"Civil 3D install and initialize process (WisDOT only)" on 
page 207 topic updated for new interface.

"Non-Survey base 
data" on page 509

"Create topo file from Mapping" on page 509 topic 
updated.

 
"WisDOT AutoTURN "What's new?"" on page 257 topic 
updated.

WisDOT Design tab Alignment - Create Curb Offsets topic added.

 
Contractor Data - Assign CDP Breakline Layers topic 
added.

  Contractor Data - Slope Stake Report topic updated. 

  Export - Export C3D Table topic added.

WisDOT Survey tab Import PI ALI File topic added.

  Insert Mapping File topic updated.

  Replace Topo Blocks topic added.

 
Reports - Course Table topic updated for curve defin-
ition support.
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Group Topic

WisDOT *** tab > Man-
age panel

DWG - Replace Blocks topic updated and moved from 
Survey tab.

  Create Object Folders topic updated. 

 
Project - Force Synchronize References topic updated 
with current content.

WisDOT subassembly 
help

CGBasic topic updated with complete target para-
meters.

 
MultiUseWidthAndSlopeLinks topic updated for func-
tionality updates.

2021-06-29

Group Topic

"C3DKB basics" 
on page 47

"WisDOT Civil 3D forms" on page 51 topic added.

"Contractor 
data" on 
page 1878

"Export ACAD DWG files" on page 1889 topic updated for cur-
rent user interface.

"Parcels/Plats" 
on page 1611

"Parcel basics" on page 1611, "Create/edit parcels" on 
page 1614,"Parcel labels" on page 1616, "Parcel tables" on 
page 1619,"Create existing r/w" on page 1620, "Create pro-
posed r/w" on page 1626, "Create ultimate r/w" on page 1634, 
"Create takings parcels" on page 1638, "Create plat sheets" on 
page 1649, "Plat sheet details" on page 1653, "Import survey 
data" on page 1678 topics updated for Civil 3D 2020

"Plan pro-
duction" on 
page 1297

"Storm sewer plan/profile sheet" on page 1459 topic updated.

"Points" on 
page 528

"Civil 3D point basics" on page 528, "Accessing Civil 3D points" 
on page 529, "Point groups and styles" on page 530, "Point cre-
ation tools" on page 532, "Importing points from a file" on 
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Group Topic

page 533, "Editing points" on page 534, "Transparent com-
mands for points" on page 535, "Creating points from align-
ments" on page 536 topics updated for Civil 3D 2020

"Surfaces" on 
page 556

"Accessing Civil 3D surfaces" on page 556, "Surface styles" on 
page 557, "Surface basics" on page 558, "Surface properties - 
General" on page 559, "Surface properties - Definition" on 
page 560, "Surface breaklines" on page 562, "Surface creation" 
on page 564, "Surface boundaries" on page 564, "Surface 
masks" on page 567, "Surface edits" on page 567, "Surface 
properties - Analysis" on page 568 topics updated for Civil 3D 
2020.

"Survey" on 
page 540

"Survey database fundamentals" on page 540, "Create survey 
databases and queries" on page 541, "Import PAC/LandXML 
into survey database" on page 542, "Set up to edit/add survey 
figures" on page 543, "Editing survey figures" on page 544, 
"Create survey figure" on page 546, "Verify DWG and SDB 
match" on page 548, "Replicate/copy SDB to PDS C3D project" 
on page 549,"Create/update topo file from field survey" on 
page 550, "Create ad-hoc survey queries" on page 554 topics 
updated for Civil 3D 2020.

Training 
courses

All courses updated with "Parcels/Plats" on page 1611, "Points" 
on page 528, "Surfaces" on page 556, and "Survey" on page 540

"WisDOT Civil 
3D project 
setup" on 
page 179

"WisDOT standards – Civil 3D project folders" on page 179 topic 
updated to correct location for project template.

WisDOT Civil 3D 
ribbon tabs

WisDOT Design tab, WisDOT Sheets tab, WisDOT Survey tab 
topics updated for UI update

2021-02-24
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Group Topic

"Civil 3D interface" on 
page 263

"File open, save, and new" on page 276 topic updated to 
current version of Civil 3D.

"Corridor modeling fun-
damentals" on 
page 767

"Corridor data shortcut surface modeling" on page 797  
topic added.

"Cross sections" on 
page 1685

"Cross sections with pipes" on page 1785 topic added.

"Known issues" on 
page 97

"Issue related to Civil 3D Survey databases created with 
Civil 3D 2020 (WisDOT)" on page 112 topic added.

"Pipe networks" on 
page 1195

"Storm sewer summary" on page 1230 topic updated 
with more detail on inlet surface elevation adjustments.

"Plan production" on 
page 1297

"Sample plan sheets" on page 1398 topic updated with 
new sheets.

 
"Permanent signing" on page 1490 topic added. 
Replaces Sign block fundamentals, Signing plan sheets, 
and Staged signing plan sheets topics

  "Plan details" on page 1437 topic added.

  "Planting detail sheet" on page 1489 topic added.

 
"Traffic signal plan sheet and phasing" on page 1495  
topic added.

"Quantities" on 
page 1793

"3D Surface area" on page 1868 topic updated with 
Create-CroppedSurfaces and Report-3DSurfaceAreas 
dynamo scripts.

 
"Creating design surfaces for WisDOT earthwork quant-
ities" on page 1834 topic added.

"Surfaces" on page 556
Cropped surfaces topic removed. Replaced with 
updated topic "3D Surface area" on page 1868

"WisDOT Civil 3D pro-
ject setup" on 

"WisDOT standards – Civil 3D project folders" on 
page 179 topic updated. Link to FDM corrected.
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Group Topic

page 179

WisDOT Civil 3D 
dynamo scripts

Action-AssignAliStyles topic added.

  Action-PointStationOffsettoUDP topic added.

 
Action-SetCorridorTargets topic updated for feature line 
support. More explanation of input csv file added.

  Action-SyncProjectFiles topic added.

  Action-TransformSRV topic added.

  Create-CroppedSurfaces topic added.

  Create-ObjectFolders topic added.

  Create-PointsFromSOE topic added.

  Report-3DSurfaceAreas topic added.

 
Report-Culverts topic updated. Inputs removed from 
Dynamo Player.

  Report-PointsToSurfaceComparison topic added.

 
Report-StormSewerPipes topic updated. Inputs 
removed from Dynamo Player.

 
Report-StormSewerStructures topic updated. Inputs 
removed from Dynamo Player.

 
Report-Superelevation topic updated. Inputs removed 
from Dynamo Player.

WisDOT *** tab > Man-
age panel

Enable/disable reference template update topic added.

WisDOT *** tab > Man-
age panel

Refresh palettes topic added.

WisDOT Design tab > Adjust Superelevation Runout topic updated. Tool 
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Group Topic

Design Utilities panel renamed.

WisDOT Design tab > 
Pipe Network Utilities 
panel

Move Pipe End topic added.

  Structure Sump Adjust topic updated. Tool renamed.

WisDOT Sheets tab > 
Plot Configuration 
panel

Assign Page Setup topic updated. Tool renamed.

WisDOT Sheets tab > 
Sheet Utilities panel

Align Viewport topic added.

WisDOT subassembly 
help

All subassembly and assembly help files have been 
updated to be fully HTML5 compliant. Local chm file has 
been modified to point to the web as a single source of 
documentation.

  MedianDaylight topic added.

2020-12-04

Group Topic

"C3D 2020" on 
page 2081

 WisDOT Civil 3D 2020 "What's new?" topic updated.

"Contractor data" on 
page 1878

Contractor data basics topic updated with current pro-
ject template location.

"Corridor modeling fun-
damentals" on 
page 767

"Exploration of data reference corridors" on page 794 
topic added.

"Data exchange" on 
page 293

"Culvert pipes and parcels from ArcGIS Online to Civil 
3D" on page 299 topic updated with correct link to cul-
vert inventory map.

"File/software man- "AutoTurn configuration" on page 258 topic updated to 
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Group Topic

agement" on page 207 fix AutoTURN ribbon not appearing.

 
"DWG TrueView installation and configuration " on 
page 252 topic updated with instructions for 
WisDOT configuration for consultants.

 

"Civil 3D install and initialize process (WisDOT only)" on page 207 
topic updated with:

 l Group policy force if Civil 3D doesn't launch.

 l Initial steps to configure WisDOT Dynamo Player.

"Known issues" on 
page 97

"Textstylecauses WisDOT custom linetype errors" on 
page 98 topic added.

"Plan production" on 
page 1297

"Alignment sheet" on page 1546 topic added.

  "Earthwork quantities sheet" on page 1581 topic added.

  "Erosion control sheet" on page 1456 topic updated.

  "Pavement marking sheet" on page 1497 topic updated.

  "Sample plan sheets" on page 1398 topic updated.

"WisDOT Civil 3D pro-
ject setup" on 
page 179

"Create a Civil 3D project" on page 179 topic updated 
with current project template location.

WisDOT Civil 3D 
dynamo scripts

WisDOT Civil 3D Dynamo scripts 2020 topic added.

 
General Dynamo Player help topic updated with initial 
steps to configure WisDOT Dynamo Player.

 
Action-AdjustSuperelevationBand topic updated for 
script having all command line prompts.

  Action-AdjustSuperelevationRunout topic added.

  Action-AssignCivilObjectLayers topic added.
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Group Topic

  Action-AssignPageSetups topic added.

  Action-RenamePipes topic added.

 
Action-SetProfileViewElevationRange topic updated for 
script having all command line prompts.

  Action-StructureSumpAdjust topic added.

  Action-SwapPartListStyles topic added.

 
Create-ControlProfiles topic updated for script having all 
command line prompts.

 
Create-PhotoMarkerPerLocation topic updated for 
script having all command line prompts.

 
Create-PhotoMarkerPerPhoto topic updated for script 
having all command line prompts.

WisDOT subassembly 
help

LnExtendBase topic updated with control profile para-
meters for width.

 
ShldGeneric topic updated with control profile para-
meters for width. 

2020-10-07

Group Topic

"C3D 2020" on page 2081  WisDOT Civil 3D 2020 "What's new?" topic updated.

"C3D 2018" on page 2132 WisDOT Civil 3D 2018 "What's new?" topic updated.

"Contractor data" on 
page 1878

Export alignment description csv files topic 
removed. No longer needed per FDM.

 
"Export ACAD DWG files" on page 1889 topic 
updated. Step to export design surfaces removed. 
No longer needed per FDM.

"Corridor modeling situ- "Modeling beam guard energy absorbing terminals 
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Group Topic

ations and design ele-
ments" on page 1074

(BG EATs)" on page 1093 topic updated with 2020 
files and dynamo scripts.

"File/software man-
agement" on page 207

 Adding WisDOT node package location to user pro-
file (Outside WisDOT only) topic created.

"Known issues" on 
page 97

"Export KML toolbox utility does not bring Civil 3D 
points into Google Earth" on page 103 topic created.

"Non-Survey base data" on 
page 509

"Create topo file from Mapping" on page 509 topic 
updated.

WisDOT Civil 3D dynamo 
scripts

Action-SetCorridorTargets topic created.

  Action-StructureSumpAdjust  topic created.

  Create-AlignmentFromSDMS_PCPT_Ali topic created.

 
Create-PointsFromSOE (Dynamo SOE/SOD import) 
topic created.

  Report-CheckStructurePipeSeparation topic created.

  Report-Culverts topic created.

  Report-StormSwerPipes topic created.

  Report-StormSewerStructures topic created.

2020-08-05

Group Topic

"Cross sec-
tions" on 
page 1685

"Cross section labels: custom labels for corridors and station 
values" on page 1788 topic updated with custom suffix for 
cross section station values.

 
"Project objects onto section views" on page 1773 topic 
updated with labeling options.
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Group Topic

"Data 
exchange" on 
page 293

"Export DWG to DGN workflow using Civil 3D" on page 295 
topic updated.

 
"Export Civil 3D parcels to GIS shapefile" on page 321 topic 
updated.

"Contractor 
data" on 
page 1878

Extract design surface data utility overview topic updated with 
utility requirements and best practices.

"Design checks" 
on page 1255

"Compare existing cross slope profiles with superelevation 
design" on page 1267 topic added.

"File/software 
management" 
on page 207

"Reset reference template" on page 247 topic created.

 
"Things that can slow performance in Civil 3D/AutoCAD" on 
page 233 topic created.

 
WisDOT templates for different dwg file types topic 
removed. Replaced with "WisDOT Civil 3D start and sheet tem-
plates and how to use them" on page 2093

"Pipe networks" 
on page 1195

"Storm sewer layout using pipe networks" on page 1203 topic 
updated. Video for  pipe separation at structures corrected.

"Plan pro-
duction" on 
page 1297

"Miscellaneous quantities sheets" on page 1550 topic updated 
with recommended location of excel spreadsheets.

"Quantities" on 
page 1793

"3D Surface area" on page 1868 topic updated for new location 
of statistics properties in WisDOT Civil 3D 2020.

WisDOT Civil 
3D dynamo 
scripts

General Dynamo Player help topic updated.

  Action-AdjustSuperelevationBand topic added.
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Group Topic

  Action-SetProfileViewElevationRange topic added.

  Create-AlignsFromBgBlock topic added.

  Create-ControlProfiles topic added.

  Create-CorridorSurfaces topic added.

  Create-CrossSlopeProfiles topic added.

  Create-PhotoMarkerPerLocation topic updated.

  Create-PhotoMarkerPerPhoto topic updated.

  Report-AlignmentDescription topic added.

  Report-C3D_TableExport topic renamed.

  Report-CourseTable topic added.

  Report-FeatureLine_Describe topic added.

  Report-FeatureLine_OffsetFromAlignment topic added.

  Report-ParcelLegalDescription topic added.

  Report-PN_Name_Sta_OS_XYZ topic added.

  Report-SlopeStake topic added.

  Report-SOE topic added.

  Report-StructuresToPointXML topic added.

  Report-Superelevation topic added.

  Report-UnitsZone topic added.

2020-06-05

Group Topic

"Data exchange" 
on page 293

"Culvert pipes and parcels from ArcGIS Online to Civil 3D" on 
page 299 topic added.
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Group Topic

"Data man-
agement" on 
page 131

"Repairing data shortcuts and data references" on page 165 
topic added.

 
"Best practices to manage Civil 3D projects at remote loc-
ations" on page 149 topic updated with more detail.

"File/software 
management" on 
page 207

"Update WisDOT Civil 3D desktop application" on page 214  
topic updated to address user profile in various versions of 
Civil 3D.

 
"Civil 3D install and initialize process (WisDOT only)" on 
page 207 topic updated  to address user profile in various ver-
sions of Civil 3D.

"Plan production" 
on page 1297

"Plan/profile sheet" on page 1559 topic created.

 
"Sample plan sheets" on page 1398 topic updated with new 
samples.

 
"Project overview sheet" on page 1409 topic updated with 
Add all components step.

WisDOT Civil 3D 
Apps (desktop 
shortcut)

Enable/Disable topic created. This tool is active in 2016 and 
replaced in other areas in beyond versions.

WisDOT Civil 3D 
dynamo scripts

General Dynamo Player help topic added.

  Closure report topic added.

  Export Civil 3D table topic added.

  Export pipe network tables topic added.

  PhotosToDWG topic added.

  Point station offset topic added.

  Structures to point XML topic added.
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2020-03-23

Group Topic

  "C3DKB blog" on page 88 topic updated.

"Known issues" on 
page 97

C3D 2018 Pipe network parts list pay items miss-
ing/incorrect topic created.

"Civil 3D interface" on 
page 263

"Borrowing and returning a Civil 3D license" on 
page 287 topic updated.

"Data management" on 
page 131

"Best practices to manage Civil 3D projects at remote 
locations" on page 149 topic updated.

"C3D 2020" on 
page 2081

Group created.

 
"Civil 3D release comparison 2018 to 2020" on 
page 2082 topic created.

  "Civil 3D 2020 add-ons" on page 2081 topic created.

 
 "Civil 3D project version migration from 2016 to Civil 
3D 2020" on page 2098 topic created.

  WisDOT Civil 3D 2020 "What's new?" topic created.

"C3D 2018" on 
page 2132

WisDOT Civil 3D 2018 "What's new?" topic updated.

WisDOT customizations
WisDOT Civil 3D futures topic updated. Tech preview 
board removed from Trello.

WisDOT Civil 3D Toolbox

Alignment Description Report, Parcel Legal Descrip-
tion Report, Culvert and Storm Drain Report, Point 
Course Table Report, Point Stakeout Report, Points to 
Surface Comparison Report, Slope Stake Report, Sta-
tion-Offset-Elevation Report, Feature Line Report top-
ics updated for user interface updates and precision 
output settings.
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Group Topic

"File/software man-
agement" on page 207

"Update WisDOT Civil 3D desktop application" on 
page 214  topic updated.                         

 
Standards downloader updater topic removed. No 
longer needed or accurate.

Support panel Reset - Import WisDOT profile topic added.

  Restore User Settings topic added.

WisDOT Civil 3D Apps 
(desktop shortcut)

Enable/Disable WisDOT Civil 3D Standards topic 
removed. App removed from desktop shortcut.

WisDOT subassembly 
help

CutFillProfileControlled and DaylightProfileControlled 
topics updated for options to override final daylight 
location.

"AutoCAD fundamentals" 
on page 335

Linetype best practices, Using Design Center to trans-
fer layouts from one dwg file to another, 
WisDOT linetypes topics deleted. Newer content else-
where in KB.

  "Linetype scale explained" on page 497 topic added.

"Plan production basics" 
on page 1297

"Place north arrow" on page 1334 topic added.

2020-02-07

Group Topic

"Data management" on 
page 131

"Best practices to manage Civil 3D projects at remote 
locations" on page 149 topic created.

"Quantities" on 
page 1793

"Earthwork quantities" on page 1793 topic updated to 
go to desktop WisDOT Civil 3D Apps.

"Contractor data" on 
page 1878

Contractor data basics topic updated with current con-
struction data structure.

  "Export ACAD DWG files" on page 1889 topic updated. 
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Group Topic

Alignment export to ACAD DWG not required.

 
 Export survey control LandXML file topic updated. 
Projection data should not be set.

WisDOT customizations WisDOT Civil 3D custom items heading added.

WisDOT Civil 3D custom 
items

"WisDOT Civil 3D start and sheet templates and how 
to use them" on page 2093 topic added.

  topic moved and updated.

"AutoCAD fundamentals" 
on page 335

Old linetype topics removed.

 
"Create a custom annotative scale (annoscale)" on 
page 505 topic added.

"Plotting & layouts" on 
page 1336

"Plot sheet set in DWG TrueView" on page 1374 topic 
added.

WisDOT subassembly 
help

CutFillProfileControlled topic updated.

"Plan production" on 
page 1297

"Cross section sheets" on page 1594 topic updated.

"Plan production basics" 
on page 1297

"Xref topography file" on page 1303 topic updated to 
use Load XREF on layer tool.

"File/software man-
agement" on page 207

"AutoTurn configuration" on page 258 topic updated 
to remove choosing AutoTURN 2D or 3D.

Feedback
Last updated: 2022-03-08

The material in the knowledge base relies heavily on user feedback. We do our best to stay on top of 
providing relevant material with minimal errors. But no one's perfect.

If you notice errors, omissions, or just have a great idea, please share it with us. We don't promise to 
address every request, but all feedback will be seriously considered.
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Topic feedback
All topics contain an email hyperlink. The email will auto-populate with the CAE support inbox 
address and the topic name and link. Please use these links to report any problems you encounter 
with content. 

General feedback
Feedback on issues related to installing WisDOT resource files, training material, and knowledge con-
tent can be sent from external users to the CAE support inbox. 

Requests for adds and changes to resource files can be made by anyone on the public WisDOT Civil 
3D Futures Trello board 1-Submit Ideas
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C3DKB blog
Last updated: 2023-05-17

Sometimes there will be communication notes or snippets of content that aren't quite ready for a 
topic. This is where they will be.

Civil 3D dialog boxes in unexpected locations with some mon-
itors, resolutions, and text scaling #c3d-dia-box-move
Last updated:  2020-02-26

There is a wide array of possibilities for display in Windows between different monitors, laptop dis-
plays, resolutions, and text scaling. These settings can be managed in Right-click Desktop > Dis-
play settings or by a custom video driver interface.

Sometimes certain Civil 3D dialog boxes can get "confused" and pop up in unlikely places. Recom-
mendations for minimizing this are:

 l Use native resolutions for monitors. This is designated by (Recommended) in Display set-
tings.

 l Set text scaling to 100%.
 l Do not change resolutions while Civil 3D is open.

 

If a dialog box is not visible, it may have opened off screen. If this should happen:

 1. Execute the command to activate the dialog window.
 2. Press Alt+Spacebar on the keyboard.
 3. Press M and tap an arrow key.
 4. Move the mouse to bring the window into view.
 5. Click the left mouse button to cancel the operation.

 

More information can be found at Dialog windows do not display in an Autodesk application

Map Connect to attach ortho images #mapconnect
Last updated:  2019-10-15

Having problems with attached images? Large raster files can exhibit problems at plot time. See 
"Attach an ortho image to a DWG using Map Connect" on page 517 for a more reliable method than 
MAPIINSERT.

"Prompting for Name" when Inserting Civil 3D Subassemblies 
#prompt-for-name
Last updated:  2019-06-12
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"Prompting for Name" when Inserting Civil 3D Subassemblies is a Civil Immersion topic that shows 
how to change the default mode for subassembly insertion. You may like it for some workflows. It 
doesn't change the behavior of copied or mirrored subassemblies, so it's always going to be a good 
idea to review subassembly names and parameter values in an assembly before using it in a cor-
ridor.

AutoTURN | Evaluating the quality of a swept path analysis 
#autoturn-evalswptpth
Last updated:  2019-05-02

TRANSOFT recorded webinar: AUTOTURN | EVALUATING THE QUALITY OF A SWEPT PATH ANALYSIS

Superelevation design macro #super
Last updated:  2018-11-27

Civil 3D superelevates shoulders as an extension of the driving surface beyond the lanes. This means 
that shoulders have a longer superelevation transition than the driving lanes they are adjacent to.

This is not how WisDOT applies superelevation to roadways. The superelevation transition length is 
identical for the shoulder next to the lanes. See FDM 11-10.5.3.3 Superelevation Transition, Attach-
ment 5-10, Attachment 5-11. 

WisDOT provides a tool to remove and correct the appropriate superelevation sections so that super-
elevation design matches FDM standards. Documentation for the tool is at Superelevation Design 
macro

How to find where a file is Xreferenced #find-xref
Last updated:  2018-10-29

Autodesk support article: How to find where a file is Xreferenced

Corridor and refinement surfaces: what do I do? #crdr
Last updated:  2018-10-17

It can be easy to forget the extents and creation methods for the most common design surfaces 
required by FDM 15-5-7

Here's a little math to help.

Crdr-Datum = Point codes Daylight_Sub to Daylight_Sub

Crdr-Top = Point codes Daylight to Daylight

 

Rfnt-Top = All Crdr-Tops

Rfnt-Datum = Rfnt-Top + All Crdr-Datums
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Which point codes do I include in my corridor surfaces? 
#which-pt-cod
Last updated:  2018-09-10

Confused on what point codes/feature lines are required to build corridor surfaces?   This guide will 
provide a tip to help figure it out.  

Standard Corridor Surface Structure:
The following is the standard corridor surface definition for the different types of corridor surfaces.  
The basecourse surface is to be used for cross section display representing the bottom of the hard 
pavement or the top of the base gravel.  The corridor top surface spans the top of the corridor from 
slope intercept to slope intercept.  The corridor datum surface represents the bottom of the earth-
work between the intersections with the corridor top surface (inside of the subgrade shoulder points 
and/or sidewalk datum).

Refinement Surface Creation
Rfnt-All-Top: Paste Crdr-Top

Rfnt-All-Datum: Paste Rfnt-All-Top and Crdr-Datum

Corridor Surface Definition
Not all corridor surfaces (datum, basecourse, and top) are defined with the same feature lines from 
project to project, sometimes they are different between corridors within a project.  Once a corridor 
is created, the corridor section editor can be used to assist users in figuring out exactly which point 
codes are required for corridor surface creation.

 1. Corridor contextual ribbon > Modify Corridor Sections > Section Editor
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 A. View Tools > View/Edit Options

 I. Default Styles > Code Set Style > CRDR Proposed - Point Codes

 II. OK OK
Instead of showing the elevation and offset labels as is standard in CRDR Proposed, the CRDR Pro-
posed – Point codes code set style will show all the point codes/feature lines within the section 
editor.
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Knowing where the corridor surfaces need to be in the cross section, the cross section editor now 
can be used to figure out which point codes/feature lines are required to create a properly defined 
corridor surface.

 1. Corridor Section Editor tab > Select the corridor > Modify Corridor > Corridor Surfaces

 A. Create the corridor surfaces (datum, basecourse, and top) and add the appropriate 
point code/feature lines to the definition for each surface. The following is an example.

Page: 92

Published on: 5/17/2023

Corridor Surface Definition



REGEN3 in 3D view #regen
Last updated:  2017-11-08

The commands regenand regenall will regenerate the graphics of modelspace or modelspace 
and all layouts respectively. But depending on the view style, they may not work. regen3 will work in 
these cases.

Parameter overrides and grip edits should never be used in 
corridor surface modeling #param
Last updated:  2017-04-27
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One of the most common places that people have problems in Civil 3D is in corridors. There are a lot 
of controls and options to be aware of and understand. One of the most common problems we see 
in support is use of parameter overrides.

Civil 3D corridors are very efficient at:

 1. Following a parameter set in an assembly
 2. Referencing a parameter to another parameter
 3. Targeting an object for the value of a parameter you want to change over a range of stations

Civil 3D corridors are more likely to crash or at  least process extremely slowly if parameter overrides 
or grip edits (visual version of parameter overrides) are used. 

Other helpful tips on successful corridor modeling can be found at Roadway design requirements, 
tips, info, and warnings

What should I do if I have curb ramps on my project? #curb-
ramp
Last updated:  2017-03-01

Content here is accurate as of posting date. Please refer to the FDM and C3DKB for most accurate 
information.

FDM 11-46-10 Curb Ramps contains FDM standard guidance on curb ramps.

Standard Detail Drawing 8D5: Curb Ramps contains standard layout information.

FDM 15-5-7.2.2 Surface Model Content describes surface model requirements on WisDOT projects 
and contains a table of design features, whether or not they need to be modeled, and what pro-
posed surfaces needs to be modeled for the feature.

Based on Table 7.2, modeling curb ramps is optional. The following note:

[1] While modeling isn't required, curb ramps should be modeled at locations where elev-
ations make challenging to comply with ADA requirements according to the designs shown in 
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the Standard Detail Drawings.

Standard detail drawings do not ensure that any feature is constructable. The first part of Curb 
ramps contains a workflow for a design check  without a full modeling effort. This will be sufficient for 
some situations, but not all. The remainder of the topic covers fully modeling a Type 2 curb ramp.

Curb ramps type 1A and Curb ramps type 4B1 cover modeling those types of curb ramps respect-
ively. However, the design check workflow in Curb ramps may be sufficient.

Rebuild sample lines #rebuild
Last updated:  2017-01-30

This came up in support recently. Specifically, a user was trying to run the WisDOT Slope stake report 
in Civil 3D 2014 for contractor data packet creation. The report wasn't working in Civil 3D 2014, but 
had been updated in Civil 3D 2016. The user opened cross section files in Civil 3D 2016 just to run 
the report. Some files worked, some didn't. For the files that didn't work, a solution that involved cre-
ating the sample lines new in Civil 3D 2016 worked.

Recreating a sample line group, particularly one with gaps, special stations, and different sample line 
widths can take a long time. There is no "copy/paste" functionality for sample line groups. The fol-
lowing workflow is a fairly short solution to rebuilding a sample line group. It would also provide a 
good start to a sample line group that was very similar to an existing group but needed a few sample 
lines added or deleted.

xsec-rebld-smpl-lin.mp4 3:27

 1. Toolspace > Alignments > specified alignment > Sample Line Groups > specified 
sample line group > Right-click menu > Select

 2. Home tab > Modify panel > explode button This results in a block with 3D polylines rep-
resenting the sample lines.

 3. Select the block.
 4.  Home tab > Modify panel > explode button This results in 3D polylines of the sample 

lines.
 5. Select the 3D polylines.
 6. flatten This results in 2D polylines.
 7. Home tab > Profile & Section Views panel > Sample Lines button
 8. After selecting the correct alignment, Sample Line Tools dialog > Create sample lines 

drop-down > Select existing polylines option.
 9. Select the polyline for sample line creation.

Initial roll-out 
Last updated:  2017-01-27

The WisDOT Civil 3D knowledge base is the latest iteration of  training and support material for high-
way design software at WisDOT. It combines all existing training material, help documents, and other 
content into one location that is:
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 l Public
 l Open
 l Web-native
 l Searchable
 l Mobile-first

Existing material and users currently working through a training 
course
All existing material has been converted to the knowledge base and will be maintained here. Some 
groups of material have been updated and added in the conversion. Details are at "C3DKB updates" 
on page 51. Material found in the Training courses has been updated at the group level (e.g. all Align-
ment topics have been replaced). Old training material (pdfs, mp4s, zips) will remain in their existing 
locations available until the end of March 2017 to allow users that choose to finish with that material 
to do so. Further details about the knowledge base, training courses, and new features can be found 
in "C3DKB basics" on page 47.
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Known issues
Known issue - monitor display scale and resolution
Last updated: 2022-04-19

Background
Application errors may occur when using Civil 3D with certain monitor display scale and resolution 
settings.  The problems most often occur when using high resolution monitor, when using monitors 
plugged into a USB dock or hub, or using a multi-monitor setup with displays of different types. 
Issues can also arise when moving from one computing environment to another (for example, home 
to office) where there are different monitor setups. Unwanted behaviors include, but are not limited 
to:

 l Frequent "fatal error" crashing
 l AutoCAD right-click or hover menus not working
 l "Lost" toolbars or palettes

Known issues
 l Windows sets the default display scaling to 125% or higher when connecting a high resolution 

(width or height greater than 1920x1080) monitor. AutoCAD performs best with display scal-
ing set to 100%.

 l Windows sets the display resolution to the monitor default for each display independently. In 
a multi-monitor setup, each monitor may have a resolution setting different than the other(s). 
AutoCAD performs best when all monitors are set to the same resolution.

 l USB docks and hubs use virtual display drivers or have external graphics cards. Typically 
these display systems underperform when compared to the computer's display system. 
AutoCAD performs best when using the computer's native GPU (s).

 l AutoCAD remembers the X, Y coordinate origin of a palette, and the size in pixels of a palette 
when the application is closed. In Windows, the coordinates of the screens span all screens, 
not each individual screen. Coordinate 0,0 begins at the upper left corner of the leftmost dis-
play and all other display coordinates are relative to that position. When switching from one 
computing environment to another with different display setups, a situation may arise where 
a palette was located at a coordinate on one display that does not exist on a secondary dis-
play.

Best practices
 l It is strongly recommended to have all monitors set to 100% display scaling. There are known 

bugs in AutoCAD for which there is no other workaround.
 l It is recommended to have all monitors set to the same display resolution (when possible).
 l Preference should be given to the computer's display system over an external device. When 

possible, plug monitors directly into the computer's display port(s) instead of a USB dock or 
hub.
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 l Having Hardware Acceleration on when using an underperforming display system will cause 
issues. Turn off Hardware Acceleration if using an external device.

 l Have the main Civil 3D application window open on the screen with the best performing dis-
play system.

 l When switching computing environments open Civil 3D and move all palettes and the applic-
ation window to the main screen before closing Civil 3D. This is especially important when 
moving from environments with different number of displays.

Recovering "lost" toolbars and palettes
Most of the time, unhooking any secondary displays and opening Civil 3D on the main display will 
bring the palettes back.

 1. Unhook all secondary monitors or disconnect them in the Windows display settings.
 2. Open Civil 3D. The application window and any open palettes should all return to the main 

display.
 3. Close all open palettes and close Civil 3D on the main display. (This should reset the position 

of the palettes relative to the upper left of the main display.)
 4. Hook any secondary displays back up and open Civil 3D.
 5. Verify the palettes are now visible when opened.

If the above does not work and there are still “lost” palettes, you can “retrieve” them from the last 
monitor where they appeared. This may be necessary if a palette is on a secondary display and the 
positions and resolutions of the displays were different when Civil 3D was closed than when re-
opened. (For example, closed on two stacked displays with different resolutions and opened on two 
side-by-side displays with different resolutions.) To retrieve a lost palette that does not return to the 
main display:

 1. Return to the last display environment (if possible) and connect the monitors in the same con-
figuration as before. (Or hook up any set of displays in the exact same configuration, pos-
itions, and resolutions.)

 2. Open Civil 3D. The palettes should be visible on the monitor where they were last virtually loc-
ated.

 3. Move the Civil 3D application window and the palette(s) onto the main display.
 4. Close the palette(s), and close Civil 3D.
 5. Unhook all secondary displays or disconnect them in the Windows display settings.
 6. Open Civil 3D and verify the palettes are now visible when opened.
 7. If the above does not work, reset the AutoCAD profile. (Use as a last resort. Resetting the pro-

file may result in custom settings being reset.)

Textstylecauses WisDOT custom linetype errors
Last updated: 2022-12-15
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Overview

AutoCAD .SHX files contain shapes, symbols, or fonts compiled  from an .SHP shape file or .PFB font 
file. The WisDOT Civil 3D custom configuration uses the file dgnlstyle-ewdotudls.shx to store shape 
definitions for custom linetypes.

Some files that are converted to .DWG from MicroStation may contain a "poison" textstyle named 
Style-dgnlstyle-ewdotudlsthat has the font file set to dgnlstyle-ewdotudls.shx. Since dgnlstyle-
ewdotudls.shx holds shapes  for WisDOT linetypes and not fonts, it is substituted with the default 
AutoCAD font file to create the textstyle.

Issue

Since dgnlstyle-ewdotudls.shx was substituted with the default AutoCAD font file, AutoCAD cannot 
find the WisDOT linetype shapes when the linetype file is loaded. Multiple error dialog boxes will 
appear.

When the drawing is opened it will display font characters (ABC, 123, !@#, etc.) in place of shapes for 
the WisDOT custom linetypes. The linetype errors will occur in every drawing or xref subsequently 
opened during the drawing session. Linetype display will return to normal after Civil 3D is closed and 
re-opened as long as the drawing with the textstyle Style-dgnlstyle-ewdotudls is not opened first.

How to fix the issue

Open the drawing containing the "poison" textstyle and PURGE  Style-dgnlstyle-ewdotudls.

Tip: The .DWG containing Style-dgnlstyle-ewdotudls may be attached as an xref.

Known issue - Excel Civil 3D quantities "Microsoft Excel is 
waiting for another application to complete an OLE action."
Last updated: 2022-11-02
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Issue

There is a known issue where Civil 3D struggles to open existing quantities drawings when using the 
paste link method to create quantities plan sheets in Civil 3D. Civil 3D and Excel end up in an endless 
cycle of 'Microsoft Excel is waiting for another application to complete an OLE action" warning mes-
sage and the quantities file will not open.

Training that uses this method is posted here:

 l "Miscellaneous quantities sheets" on page 1550
 l "Earthwork quantities sheet" on page 1581

Solution

The solution is to disable the Bluebeam Add-Ins in Excel.

 1. Close Civil 3D 
 2. Open Excel 
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 3. 

File > Options

 4. Scroll down to and select Add-ins
 5.  A. Change the drop down to COM Add-Ins
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 B. 

Click GO

 6. In COM Add-ins, Deselect the Bluebeam Add-ins
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 A. 

OK

 7. Close Excel 
 8. Open Civil 3D 
 9. Open the quantities drawing 

Export KML toolbox utility does not bring Civil 3D points into 
Google Earth
Last updated: 2020-10-26

Issue
There may be situations where the Autodesk Export KML utility does not produce a file that can be 
imported by Google Earth Pro.  The following error may appear.
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The error occurs when a description table, of what appears to be attribute information, is added to 
the kml file.  There are certain attributes within the kml description table that Civil 3D does not define 
correctly in the kml file. 

Proposed workarounds include:

 1. Option 1: Use Notepad++ to remove corrupt description tables from kml file
 2. Option 2: Export point file using Civil 3D Point Report
 3. Option 3: Export shapefile using Civil 3D 202X SHP Import/Export utility

  Option 1 Option 2 Option 3

Civil 3D Version 2016, 2018, 202X
2016, 2018, 
202X

202X

Civil 3D objects
All (also 
AutoCAD ele-
ments)

COGO Points
COGO Points, Feature 
Lines

Additional Software 
Needed

Notepad++ (or 
equivalent)

No No
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  Option 1 Option 2 Option 3

Available Cus-
tomization

shortcuts.xml 
(Notepad++)

No No

Available WisDOT 
Google style template

No No WisDOTC3DPtsList.kst

Access point attribute 
data

No Yes Yes

Display point number Yes Yes Yes

Display point descrip-
tion

Yes
Only by 
selecting 
point

Only by selecting point

Point appears in 
Google Street View

Yes No No

Warning: Do not use data in Google Earth Pro for survey control or stakeout.  This information 
is only used for visualizing project data.

Option 1: Use Notepad++ to remove corrupt description tables from kml 
file
There are some attributes being passed to the KML that are not defined or recognized. The coordin-
ate data and point descriptions exported correctly. An alternative solution is to remove the bad 
description tables in the KML file that cause the “not well formed” error. 

A program like Notepad++ that recognizes the coding format is needed to update the file.  Using 
Notepad does not work.

NOTE: When exporting kml information, only select Export text and Export object information when 
specifying which drawing objects to export.

NOTE: This workflow only works with kml files and not kmz files.  Export to the kml file format when 
using the Civil 3D Export KML utility.

Notepad++

 1. File > Open
 A. Select the xml file exported from Civil 3D
 B. Open

 2. Search > Replace...
 A. Find tab: < description>[\s\S]*?<\/description > (no spaces)
 B. Replace tab: < description >< /description > (no spaces)
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 3. File > Save

A Notepad++ macro has been created to automate the process.  It is included in the file linked below.

shortcuts.xml

The xml file provided will replace the existing shortcuts.xml.  If there are other custom 
macros already created, the xml code for “Clean KML” can be copied and pasted into 
the original shortcuts.xml.   

Place file here: C:\Users\DOTS3P\AppData\Roaming\Notepad++\shortcuts.xml

To run the macro in Notepad++: Macro tab > CleanKML

Info: NotePad++ will saves the previous entries in the Find and Replace fields.

Google Earth Pro

 1. File > Open
 A. Open updated kml file

 2. Temporary Places > Name of kml > Model
 3. Double-click on point to zoom to area of interest
 4. Data may be saved to My Places so it is accessible during the next session of using Google 

Earth
 A. Right mouse-click and drag the imported folder or point under Temporary 

Places to My Places

Option 2: Export point file using Civil 3D Point Report
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Civil 3D

 1. Assign Coordinate System

 A. App menu > Drawing Utilities > Drawing Settings > Units and Zones tab > Zone

 I. Categories: WisDOT
 II. Available coordinate systems: Appropriate county system in US Feet

 2. Toolspace palette > Toolbox tab > Miscellaneous Utilities > Reports > Point > Points 
Report (COGO Point Report) > Right-mouse click > Execute

 A. Point Selection tab
 I. Select Point Group or Points from Drawing

 II. Selected Points: click the List Points button to show selected points
 III. Report Settings: select point properties to include and arrange them in the 

desired order
 a. Latitude and Longitude need to be selected in order to import points 

into Google Earth Pro
 IV. Save report to: browse to the desired location and save as a *.txt file
 V. Create Report

 3. The report opens in Microsoft Notepad
 4. Delete the report title, client information, address information.
 5. Delete any blank rows at the beginning or end of the file.
 6. The first row will then be the column headings for the point data followed by the rows of 

point data
 7. File > SaveAs

 A. Browse to desired location and enter file name
 B. Save file as Text Document (*.txt)
 C. Encoding: UTF-8
 D. Save

 8. Close the *.txt file
 9. COGO Point Report dialog box > Done

Google Earth Pro

 1. File > Import > select *.txt file

 A. Open
 2. Data Import Wizard

 A. Specify Delimiter
 I. Field Type: Delimited

 II. Delimited: Tab
 III. Supported encodings: UTF-8
 IV. Point data appears in preview pane
 V. Next

 B. Select Latitude/Longitude Fields
 I. Latitude field: Latitude

 II. Longitude field: Longitude
 III. Next
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 C. Specify Field Types
 I. Accept default field types

 II. Finish
 D. Do you want to apply a style template to the features you ingested? Yes

 I. Create new template: select
 II. Name tab > Set name field: Point_Number

 III. OK
 IV. Save

 3. Imported data appears under Temporary Places.

 4. Data may be saved to My Places so it is accessible during the next session of using Google 
Earth

 A. Right mouse-click and drag the imported folder or point under Temporary 
Places to My Places

Option 3: Export shapefile using Civil 3D 202X SHP Import/Export utility

Civil 3D 202X

The SHP Import/Export Utilities are available in Civil 3D 2020 and later.

 1. Assign Coordinate System

 A. App menu > Drawing Utilities > Drawing Settings > Units and Zones tab > Zone

 I. Categories: WisDOT
 II. Available coordinate systems: Appropriate county system in US Feet

 2. Toolspace palette > Toolbox tab > SHP Import/Export Utilities > SHP Import/Export > 
Export Cogo Points to SHP > Right-mouse click > Execute

 3. EXPORTSHPCOGOPOINTSURVEYDATA Select Points to export:Select points

 4. EXPORTSHPCOGOPOINTSURVEYDATA Select Points to export:Enter

 5. EXPORTSHPCOGOPOINTSURVEYDATA

 A. Enter file name and path of .shp file
 B. Select attribute data that will be exported with points
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 I. Expand and select attribute data to customize output
 C. OK

Windows explorer

 1. Open Windows explorer
 2. Copy/paste the following string into the address bar: %user-

profile%\AppData\LocalLow\Google\GoogleEarth\My Style Templates
 3. Copy WisDOTC3DPtsList.kst to %user-

profile%\AppData\LocalLow\Google\GoogleEarth\My Style Templates

Google Earth Pro

 1. File > Import
 A. Switch file format in dropdown to ESRI Shape (*.shp)
 B. Select and open shapefile exported from Civil 3D
 C. Do you want to apply a style template to the features you ingested? Yes

 I. Using a style template allows the user to specify which data field is used to 
label the points in Google Earth.

 D. Select Use existing template
 II. Select the WisDOTC3DPtsList

 a. Using the WisDOTC3DPtsList allows the user to categorize the impor-
ted points by type 

 b. C:\Users\DOTXXX\AppData\LocalLow\Google\GoogleEarth\My Style Tem-
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WisDOTC3DPtsList.kst


plates\WisDOTC3DPtsList.kst
 c. A new template can be created instead to customize output

 E. Data appears under Temporary Places

 F. Data may be saved to My Places so it is accessible during the next session of using 
Google Earth

 I. Right mouse-click and drag the imported folder or point under Tem-
porary Places to My Places

AutoCAD insertion scale units:  what you need to know
Last updated: 2020-06-16
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Background
AutoCAD 2017 and later includes the option to set the insertion scale units (INSUNITS variable) to 
"US Survey Feet".  In prior versions, only "Feet" was available.  By default, the WisDOT Civil 3D 2016 
and Civil 3D 2018 templates are set to "Unitless".  This prevents unintended shifts when using 
AutoCAD-based commands such as for inserting or Xreferencing drawings.

However, when a coordinate system is assigned, the INSUNITS variable is automatically changed to 
"Feet" for Civil 3D 2016 and "US Survey Feet" for Civil 3D 2018.  This happens when App menu > 
Drawing Utilities > Drawing Settings > Units and Zones tab > Set AutoCAD variables to 
match: Checked
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The WisDOT Civil 3D 2016 and Civil 3D 2018 configurations reset the INSUNITS variable back to "Unit-
less" the next time the drawing is opened.

Potential Issues

Tip: If you are using the WisDOT Civil 3D configurations, the potential for issues is very small.  
Since the WisDOT configuration forces INSUNITS to "unitless" each time a drawing is opened, 
AutoCAD does not do any scaling of units when inserting or Xreferencing drawings.

Here is one example scenario where there could be an issue:

 1. A drawing is created with Civil 3D 2016
 2. The Civil 3D 2016 drawing is assigned a coordinate system.  (this changes the INSUNITS to 

"Feet")
 3. The Civil 3D 2016 drawing is not re-opened with the WisDOT configuration.
 4. A new drawing is created with Civil 3D 2018
 5. The Civil 3D 2018 drawing is assigned a coordinate system.  (this changes the INSUNITS to "US 

Survey Feet")
 6. The Civil 3D 2018 drawing is not re-opened with the WisDOT configuration.
 7. The Civil 3D 2016 drawing is Xreferenced or inserted into the Civil 3D 2018 drawing.
 8. This will result in a shift in the data due to the "Feet" to "US Survey Feet" conversion.

Summary and Prevention
 1. Users should be mindful of the INSUNITS setting when working in Civil 3D to prevent any dis-

crepancies when working with multiple drawings.
 2. When Xreferencing or inserting a drawing, both drawings must either have the same 

INSUNITS setting, or one of the drawings must have INSUNITS set to "Unitless".
 3. The INSUNITS variable only changes when you manually change it or when you assign a 

coordinate system with the "Set AutoCAD variables to match" box is checked.
 4. INSUNITS does not affect Civil 3D data shortcut referencing.
 5. If you are using the WisDOT configurations of Civil 3D, there are safeguards in place that force 

INSUNITS back to "Unitless" the next time a drawing is opened.  If you are not using the 
WisDOT Civil 3D configurations, contact support.cae@dot.wi.gov for more information on 
how to force the INSUNITS variable to "Unitless" at drawing startup.

 6. Future versions of the WisDOT Civil 3D templates will not have the "Set AutoCAD variables to 
match" box checked in the drawing settings.  This will add an additional safeguard by pre-
venting INSUNITS from changing when a coordinate system is assigned.

Issue related to Civil 3D Survey databases created with Civil 
3D 2020 (WisDOT)
Last updated: 2022-03-10

Affected data
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Survey databases created in Civil 3D 2020 could be affected by this issue. Since it is standard practice 
to verify the survey database settings upon creation or create the survey database using the 
WisDOT survey database template, the scope of this issue is expected to be low. However, if a pro-
ject is affected, the impact could be significant.

Survey databases created in previous versions of Civil 3D and migrated to Civil 3D 2020 are not likely 
affected.

Issue description
An error in the WisDOT Survey User Setting file is preventing the initial survey database settings from 
being read correctly. These settings are normally applied when creating a new survey database. If 
the settings are not read from the User Settings file, default values are used. Since the default units 
setting in Civil 3D is International Foot, it is important to verify that the survey database units have 
been set to US Foot for WisDOT projects prior to loading data into the survey database. Changing the 
survey database units after loading data into the database will change the coordinate values on the 
data.

Issue identification
Verify that the units are correct for all WisDOT project survey databases created with Civil 3D 2020. 
WisDOT has provided a tool Reports - Units and Zone that will search all subdirectories for Civil 3D 
2020 survey databases and report the units and zone settings. If a survey database is identified with 
incorrect units, refer to Scenario 1 or 2 below. Since it is possible for the survey database to have the 
correct units, but incorrect data coordinates, refer to Scenario 3 if you suspect there could be an 
issue with other survey databases. With any scenario, all DWG files must be updated with the cor-
rected data after the survey database is repaired.

Scenario 1: Survey database identified with incorrect units, but coordinates of the data 
match those in the source files

In this scenario, the source data file did not have units specified. Therefore, a transformation did not 
occur when importing the data to the survey database. The remedy for this scenario is to re-create 
the survey database with the correct units, or transform the data in the survey database with the fol-
lowing steps:

 1. Export Survey LandXML Toolspace > Survey > Survey Databases > Right-click database > 
Export Survey LandXML...
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 2. Keep the output file as International Foot

 A. Export Settings > Distance: International Foot

 B. OK
 3. Edit the output xml file using Notepad to change the units from "foot" to "USSurveyFoot".
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 4. Create a new survey database Toolspace > Survey > Right-click Survey Databases > New 
local survey database...

 A. Enter the name of the new database, OK
 5. Verify the survey database settings

 A. Toolspace > Survey > Survey Databases > Right-click database > Edit survey 
database settings...

 I. Units > Distance: US Foot, OK
 6. Import survey data, select XML file

 A. Home tab > Create Ground Data panel > Create Ground Data pulldown > Import 
Survey Data

Scenario 2: Survey database identified with incorrect units, and coordinates of the data 
do not match those in the source files

In this scenario, the source data file specified the units at collection. Therefore, a transformation 
occurred when importing the data to the survey database. The remedy for this scenario is to set the 
survey database to the correct units. Setting the survey database units will adjust the coordinate val-
ues.

Scenario 3: Survey database units are correct, but coordinates of the data do not match 
those in the source files #s3

In this scenario, the survey database units were not set correctly prior to importing the source data. 
Then, after the data was imported, the survey database units were set. The remedy for this scenario 
is to re-create the survey database with the correct units or follow the steps in Scenario 1 to trans-
form the data.

Issue prevention
Always verify the survey database settings upon creation. WisDOT will issue a new Survey User Set-
tings file with the next Civil 3D update (Q1 2021) that corrects the error. To correct the error now:
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 1. Open C:\ProgramData\Autodesk\C3D 2020\enu\Survey\WisDOT 2020 Survey User Set-
tings.usr_set in Notepad. 

 2. Remove "2020 " as shown in the image.

 3. Save and close the file. 

Wisconsin coordinate projection issue - XML/SDB
Last updated: 2022-02-14

Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 
2018 has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is 
needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, 
Wisconsin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

Issue
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Multiple coordinate systems exist within Civil 3D for Wisconsin counties.  WisDOT has provided 
coordinate systems in categories that begin with "WisDOT NAD83/".  These categories include the Wis-
consin County Coordinate System (WCCS) and the Wisconsin Coordinate Reference System (WisCRS), 
which are not equivalent, but very similar (typically < 0.01 ft difference). There are also two county 
systems in the "USA, Wisconsin" category that are preloaded with Civil 3D and other Autodesk soft-
ware.  The "USA, Wisconsin" category county systems are not equivalent to the systems provided by 
WisDOT. 

Warning: When importing data into the survey database via LandXML, there is a field in the 
import options where a coordinate systems can be assigned to the XML file.  If the survey data-
base coordinate system and LandXML coordinate system are different, the survey data is trans-
formed when it is imported into the survey database. 

Since the county coordinate systems listed in the "USA, Wisconsin" category are not equivalent to 
each other, or to the WCCS and WisCRS systems that WisDOT has provided, users will see a trans-
formation of their survey data when these systems are used interchangeably between the LandXML 
file and the survey database.  The magnitude of the transformation can vary depending on the 
county and the project location within the county, but we have observed transformations as much as 
3 feet.  This occurs in all versions of Civil 3D.
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Cause

Survey database coordinate system assignment does not match LandXML coordinate system assign-
ment.

Solution

Make sure that the LandXML coordinate system matches the survey database coordinate system, or 
do not assign a coordinate system to the survey database or LandXML file.

Tip: To avoid confusion, or unintended errors, Methods Development recommends that 
coordinate systems should not be assigned to either the survey database or the LandXML file.

Detailed description
When the survey database coordinate system does not match the LandXML coordinate system, the 
survey data is transformed when it is imported from the LandXML file to the survey database.  The 
exception to this is if either the survey database, the LandXML file, or both do not have a coordinate 
system assigned.  In this case, the data will not be transformed when imported into the survey data-
base.  The transformation may have a magnitude of up to 3 ft.  The following are example scenarios 
where a transformation can be expected or not expected.

Coordinate System 
Assignment #1 (SDB or 

Drawing)

Coordinate System 
Assignment #2 (SDB or 

Drawing)

Data Trans-
formation?

No assignment Any system assigned No

Any system assigned No assignment No

No assignment No assignment No

Any system assigned Same system as #1 No

*Category beginning with 
"WisDOT NAD83/": "WCCS-..." 

*Category beginning with 
"WisDOT NAD83/": "WisCRS-..." 

Yes  (Typically <0.01') 

USA Wisconsin Category: Begins 
with "Wisconsin County Systems" 

USA Wisconsin Category: Begins 
with "Wisconsin <County name>" 

Yes
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Coordinate System 
Assignment #1 (SDB or 

Drawing)

Coordinate System 
Assignment #2 (SDB or 

Drawing)

Data Trans-
formation?

USA Wisconsin Category: Begins 
with "Wisconsin County Systems" 

*Any system located in the cat-
egories beginning with "WisDOT 
NAD83/"

Yes

USA Wisconsin Category: Begins 
with "Wisconsin <County name>" 

*Any system located in the cat-
egories beginning with "WisDOT 
NAD83/"

Yes

Info:  *The NAD 83 and NAVD 88 adjustment years for these coordinate systems do not affect 
the transformation.  See "Wisconsin coordinate system settings in Civil 3D" on page 188 for 
more information.

Project data verification #project
It is not possible to look directly at an import event in the survey database to see which coordinate 
system was chosen for a LandXML file import.  To verify that the imported data was not transformed, 
choose a point in the survey database and note its coordinates.  Then open the LandXML file in Note-
pad or other XML editing application.  Find the point in the file and verify that the coordinates match 
what is shown in the survey database.  If the coordinates do not match, re-import the LandXML file 
into the survey database without assigning a coordinate system to the LandXML file.
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Frequently asked questions
 1. Is there a way to determine which coordinate system was used for the LandXML 

import event?

No.  The only way to determine if a coordinate transformation occurred is by comparing the 
coordinate values in the survey database with the values in the source LandXML file.

 2. Will removing the survey database coordinate system assignment automatically fix 
the data transformation that occurred with the Import Event?

No. The LandXML import event must be recreated.  Also, the survey database points and fig-
ures will need to be re-inserted into the drawings. 

Wisconsin coordinate projection issue - SDB/DWG
Last updated: 2023-05-17

Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 
2018 has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is 
needed.
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Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, 
Wisconsin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

Issue
Multiple coordinate systems exist within Civil 3D for Wisconsin counties.  WisDOT has provided 
coordinate systems in categories that begin with "WisDOT NAD83/".  These categories include the Wis-
consin County Coordinate System (WCCS) and the Wisconsin Coordinate Reference System (WisCRS), 
which are not equivalent, but very similar (typically < 0.01 ft difference). There are also two county 
systems in the "USA, Wisconsin" category that are preloaded with Civil 3D and other Autodesk soft-
ware.  The "USA, Wisconsin" category county systems are not equivalent to the systems provided by 
WisDOT. 

Warning: The survey database coordinate system is independent from the drawing coordin-
ate system.  If the survey database coordinate system and drawing coordinate system are dif-
ferent, the survey data is transformed when it is inserted into the drawing.  

This is described in the AutoDesk Civil 3D help documentation.  Since the county coordinate systems 
listed in the "USA, Wisconsin" category are not equivalent to each other, or to the WCCS and WisCRS 
systems that WisDOT has provided, users will see a transformation of their survey data when these 
systems are used interchangeably between the survey database and a drawing.  The magnitude of 
the transformation can vary depending on the county and the project location within the county, but 
we have observed transformations as much as 3 feet.  This occurs in all versions of Civil 3D.

Cause

Survey database coordinate system assignment does not match drawing coordinate system assign-
ment.

Solution

Make sure that the drawing coordinate system matches the survey database coordinate system or, 
do not assign a coordinate system to the survey database.

Tip: To avoid confusion, or unintended errors, Methods Development recommends that 
coordinate systems should not be assigned to the survey database.

Detailed description
When the survey database coordinate system does not match the drawing coordinate system, the 
survey data is transformed when it is inserted into the drawing.  The exception to this is if either the 
survey database, the drawing, or both do not have a coordinate system assigned.  In this case, the 
data will not be transformed when imported into the drawing.  The transformation may have a mag-
nitude of up to 3 ft.  The following are example scenarios where a transformation can be expected or 
not expected.
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Coordinate System 
Assignment #1 (SDB or 

Drawing)

Coordinate System 
Assignment #2 (SDB or 

Drawing)

Data Trans-
formation?

No assignment Any system assigned No

Any system assigned No assignment No

No assignment No assignment No

Any system assigned Same system as #1 No

*Category beginning with 
"WisDOT NAD83/": "WCCS-..." 

*Category beginning with 
"WisDOT NAD83/": "WisCRS-..." 

Yes  (Typically <0.01') 

USA Wisconsin Category: Begins 
with "Wisconsin County Systems" 

USA Wisconsin Category: Begins 
with "Wisconsin <County name>" 

Yes

USA Wisconsin Category: Begins 
with "Wisconsin County Systems" 

*Any system located in the cat-
egories beginning with "WisDOT 
NAD83/" Yes

USA Wisconsin Category: Begins 
with "Wisconsin <County name>" 

*Any system located in the cat-
egories beginning with "WisDOT 
NAD83/"

Yes

Info:  *The NAD 83 and NAVD 88 adjustment years for these coordinate systems do not affect 
the transformation.  See "Wisconsin coordinate system settings in Civil 3D" on page 188 for 
more information.
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Project data verification #project
To assist project teams that may be affected by this issue, a tool has been developed that will report 
the assigned coordinate system for all drawings in a Civil 3D project folder.  The report has been 
implemented into Civil 3D 2014 and Civil 3D 2016 WisDOT customizations available at Roadway 
design files, Civil 3D - WisDOT.

 1. To check the coordinate system assigned to the survey database:

 A. Toolspace > Survey tab > Survey Databases > Right-click SDB > Open for read-
only Open the survey database.

 B. Right-click SDB > Edit survey database settings...  The coordinate system will be lis-
ted under the Units sections.

 2. Run Coordinate System Report.

In Civil 3D 2016 - WisDOT Tools ribbon > WisDOT Report panel > Other.

In Civil 3D 2014 - Toobox > WisDOT Toolbox > WisDOT Reports > Other Reports > "Geo-
graphic Coordinate System – Multiple DWGs".

 A. File menu > Open Folder... > Select the project folder. 

The tool will find and report on all dwg files located in the chosen directory and sub-
directories.  Depending on the number of files, it could take some time to run the full 
report.  If you know there are a lot of dwg files in the project, you may want to run the 
report on specific subdirectories or files at a time.

 B. File > Save As... once the report is complete to save the results in a CSV file.
 3. Note any drawings with coordinate systems that do not match the survey database coordin-

ate system.  Reference the table above to determine if there was a possible transformation 
based on the differing coordinate system assignments.

 4. If it is determined that a transformation is possible, open the dwg to see if any information 
from the survey database was inserted into the drawing.

 5. Spot-check drawing point coordinates with the coordinates listed for those points in the sur-
vey database.
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 6. If there are differences in the coordinates, evaluate the impacts to the work done in the draw-
ing and any drawings that reference it.

 7. Once the coordinate system assignment has been removed from the survey database, the 
survey data can be re-inserted into the drawings at the correct location.

Frequently asked questions
 1. My survey database has already been created with a coordinate system assigned.  

Should I go back and remove the coordinate system assignment?

In order to use the workflow (described under "Project data verification #project" on the pre-
vious page) to check for drawing files that may have transformed survey data, you must first 
know what coordinate system is assigned to the survey database.  Therefore, we recommend 
checking the project drawings before removing the survey database coordinate system 
assignment.  Once the coordinate system assignment has been removed from the survey data-
base, translation issue can be avoided in any new drawings.

 2. Will removing the survey database coordinate system assignment automatically fix 
the data transformation in my drawings?

No, the survey database points and figures must be re-inserted into the drawing.

WisDOT Civil 3D coordinate system action summary
Last updated: 2023-05-17

Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 
2018 has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is 
needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, 
Wisconsin. WISCRS projections begin with NSRS2011 Wisconsin County CRS
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Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

Introduction
In late 2016 it was discovered that project survey data was being transformed when coordinate sys-
tems were not being used uniformly throughout a Civil 3D project.  This transformation occurs when 
the coordinate system selected for a LandXML import differs from the coordinate system assign-
ment for a survey database.  The transformation also occurs when data from a survey database is 
inserted into a dwg file that has a coordinate system assignment different from the survey database.  
For more information on the issue and what can be done to identify and resolve the issue refer the 
following C3DKB topics:

 l "Wisconsin coordinate projection issue - XML/SDB" on page 116
 l "Wisconsin coordinate projection issue - SDB/DWG" on page 120

The WisDOT Methods Development Unit and Surveying and Mapping Section has coordinated with 
Autodesk to identify the source of the unintended transformations.  The source of the unintended 
transformations depends on the coordinate systems that are selected.

Issue #1

Civil 3D is shipped with a coordinate system category called "USA, Wisconsin".  This category of 
coordinate systems includes two series of Wisconsin County coordinate systems.  Examples:
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Figure 1:  Original Civil 3D prepackaged coordinate systems used HPGN datum (NAD 83/1991)
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Figure 2:  Autodesk later introduced coordinate systems that use state-specific HARN datums (NAD 83/1991)
While these two systems have different datum assignments (HPGN vs HARN/WI), the two datums are 
equivalent, both based on NAD83(1991), and only differ by name.  However, it was discovered that 
the transformation definitions into and out of these two datums are not equivalent in Civil 3D.  In the 
example above, the transformation definition into and out of the "Wisconsin Ashland, US FT (or use 
HARN/WI.AshlandWI-F)" is based on a series of grid files for every state.  Civil 3D processes the grid 
files in an order defined by the transformation definition.  Since the grid files overlap, and the Wis-
consin grid file is near the bottom of the list, the transformations often occur based on another 
states grid file.  Therefore, this transformation definition is not correct.  For the "Wisconsin County Sys-
tems: Ashland County, US Foot" example, the transformation definition is correctly defined by a 
single grid file specific to Wisconsin.

Issue #2

In 2016, WisDOT deployed its own set of coordinate systems in Civil 3D.  These systems are organized 
in categories that begin with "WisDOT".  Within these categories, there are two county systems, 
"WCCS" and "WisCRS".  Each of these coordinate systems, regardless of which "WisDOT" category 
they fall into, are defined by the Civil 3D NAD83 datum.  The NAD83 datum in Civil 3D is based on the 
1986 adjustment year.
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Figure 3:  In 2016, WisDOT introduced coordinate systems using the Civil 3D NAD83 datum (NAD 83/1986)
Since the coordinate systems located in the "USA, Wisconsin" category use Civil 3D datums based on 
the 1991 adjustment year of NAD 83 and the coordinate systems that WisDOT provided in the 
"WisDOT..." categories are based on the 1986 adjustment year of NAD 83, a transformation occurs 
when moving data between these systems.

End-user prevention of unintended transformations
WisDOT recommends that project teams immediately stop assigning a coordinate system to the sur-
vey database and associated LandXML files.  The absence of a coordinate system assignment will 
assure that an unintended transformation does not occur in dwg files receiving the survey data.  Dwg 
files can still have a coordinate system assignment without the risk of an unintended transformation.

Action taken by WisDOT to prevent unintended transformations

Action #1:  Modify Civil 3D transformation definitions

This action addresses Issue #1, the incorrect transformation between the two County systems 
provided in the USA, Wisconsin category of Civil 3D. To accomplish this, the "NAD83_to_HPGN 
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transformation definition in Civil 3D has been modified so the Wisconsin grid file is moved to the top 
of the list and therefore processed first.

Figure 4:  Grid files are processed based on the order shown in the Geodetic Transformation

Action #2:  Set all "WisDOT" coordinate systems to the HARN/WI datum

By setting the "WisDOT" coordinate systems to use the HARN/WI datum in Civil 3D, it will assure they 
match the Wisconsin County coordinate systems included in the USA, Wisconsin category.  Unin-
tended transformations would no longer occur between the WisDOT coordinate systems and the 
USA, Wisconsin coordinate systems because they would have the same datum.

Action #3:  Eliminate the current WisDOT coordinate system naming convention

The naming convention deployed in 2016 for the WisDOT coordinate systems was designed so that 
the adjustment year of the collected survey could be documented in the dwg file.

Figure 5:  2016 WisDOT coordinate system naming convention includes adjustment year as metadata
WisDOT has removed that metadata from the name and provided a single set of coordinate systems 
based on NAD 83 (1991), building upon Action #2.  All names indicate that the coordinate system is 
based on NAD 83 (1991), so there is no uncertainty for the user.
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Figure 6:  Sample WisDOT coordinate system naming and structure

Action #4:  Remove FDM 19-10-43.4.1 requirement to assign coordinate system to 
all dwg files

FDM 19-10-43.4.1 states that "The coordinate projection used for the project shall be set on all 
DWGs."  This requirement has been removed.  This will lessen the likelihood of unintended trans-
formations of data. However, users still have the option to assign a coordinate system to dwg files.  
There are situations where that needs to be done, such as for the Bing Map functionality in Civil 3D.

Frequently asked questions

Should I remove or change the coordinate system assigned to my DWG files?

This is not necessary.  The old "2016 version" of the WisDOT coordinate systems is still present in the 
WisDOT customization files.  They have been modified to use the HARN/WI datum to match the 
coordinate systems in the "USA Wisconsin" category.  Moving forward, please use the coordinate sys-
tems under the "WisDOT" category located at the bottom of the Categories list.

Where did the old "2016 version" of the WisDOT coordinate systems go?

They are not located in the "Obsolete Coordinate Systems" category so they are present for legacy 
data.  Moving forward, please discontinue using these coordinate sytems.
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Data management
Data management for Civil 3D projects
Last updated: 2023-02-01

Definition

Info: What is data management for Civil 3D projects?

Data management for Civil 3D projects is the theory, standards, and methods for:

 1. Naming
 2. Organization/Structure/Division
 3. Connections of data

This includes all of the data (files and objects within those files) that can be used in a Civil 3D project:

 1. Existing condition data
 2. Design files (options, analysis, ultimate design, hydrology, right-of-way, etc.)
 3. Sheet files (Plan sets, report inserts, large format, etc.)
 4. Digital files for construction (Contractor Data Packet)

Goals

Info: Why do we care about data management?

 1. Keep a design project "healthy" throughout the lifecycle of the design timeline. Your car 
needs oil changes, tire rotates, battery checks. Your design files need love too!

 A. Eliminate/minimize crashes
 B. Good user experience

 I. Performance (reasonable time to open/save files)
 II. Easy and quick to understand the content of files/objects on any given project

 III. Able to create new files and objects that are easily consumed by other users.
 C. Efficient

 I. It should be easy for an individual to work through a workflow and it should be 
easy for multiple users working throughout the lifetime of a project. There is a 
balance between the "fastest" way to complete an item and making sure it is 
appropriate for downstream uses and needs.

 II. Example: Plan/sheet printing at various milestones is standardized, repeatable, 
efficient, and effective.

 III. Example: Edits/updates can be completed with the minimum amount of work 
while staying prepared for downstream workflows.

 D. Maintain project data that is flexible to changes
 2. Deliver files to post-design business needs. Currently this is mostly the Contractor data 

Packet (CDP) for construction.

Standards for folders, files, layouts, and Civil 3D objects
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This is the language of project files and objects. It is not an all-inclusive list that works for every pro-
ject. It is a base level of common need and a language for expansion so that when you need to cre-
ate your own content, others will be able to understand it.

There are reasons why the standards are what they are. Here they are:

 l FDM 15-5 Attachment 3.1 CADDS AutoCAD Civil 3D Project Folder Structure Standard
 o Short folder names. Character count can matter depending on how deep the structure 

is.
 o Custom subfolders are allowed. Don't delete standard folders.
 o All current, active sheet files should reside in ProjectID\sheets. This will make creating 

a DSD file for plotting easier.
 o Contractor Data folders have a CD-prefix. This prevents mistakes in copy/paste func-

tions.
 l FDM 15-5 Attachment 3.3 CADDS AutoCAD Civil 3D File and Layout Naming Standard

 o There are common design files and standards for sheet files. Review them BEFORE 
starting design. Your future self will thank your past self.

 o Layout names should only be 01, 02, 03, etc. This serves two purposes:
 n Makes more layouts directly accessible from the bottom edge
 n Combined with placing all sheet DWG files in the same folder, makes plotting 

from a DSD file through batch publish as fast as possible.
 l FDM 15-5 Attachment 3.4 CADDS AutoCAD Civil 3D Object Naming Conventions

 o Roadway alignment names need to be as short as possible.
 n Highways - Numbers only. Drop the STH, WIS, IH, US, etc.
 n County roads prefix with Cty-, local roads prefix with Lcl-. This will group all sta-

tioned highway classes together.
 o Roadway alignments are the basis of all following alignments. It is a best practice to 

make edgelines that participate in corridors (ETW, EPS, EGS, etc.) alignments with intel-
ligent names to make modeling easier and fully documented.

 o Template - Highway-Side-Feature-Location. This can be expanded for directional road-
ways, intersections, roundabouts, curb returns, etc. Keep things short. It makes them 
more accessible and usable in software dialog boxes.

 l FDM 15-5 Attachment 3.2 CADDS AutoCAD Civil 3D File and Object Naming Abbreviation 
Standard

 o Drop vowels unless the result is unreadable.
 o Try to keep abbreviated terms to 4 characters or less.
 o Acronyms are all caps. Abbreviations are mixed case.

Layers and standards for AutoCAD objects
 l Besides files, layouts, and Civil 3D objects there are AutoCAD objects (mtext, plines, etc).

 o All Civil 3D and AutoCAD objects within a file are on a layer.
 n Standard layers are built into the WisDOT template files.
 n Files do not need to have every layer within them.
 n Custom layers are allowed, but should be prefixed with standard layers.
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Things to know about layers

 1. Freezing layers is more powerful than turning layers off when it comes to XREFs. This pre-
vents the data from being in the working session.

 2. The default layers for WisDOT Civil 3D objects is a layer group prefix followed by the name of 
the object. Example: The layer for a proposed alignment with a name of 10 (for US 10) would 
be P_Ali_10. This allows for layer control of freeze/thaw or on/off for individual Civil 3D 
objects. When using the WisDOT standard templates, Civil 3D Object layer assignments are 
automated.

 3. Layer filters are groups of layers that let you work with focused layer subsets in the layer 
properties manager and layer lists.

 4. The vast majority of WisDOT plotting is done through the color of the layer. (i.e. changing the 
color of a layer can change how it plots). Some plotting of Civil 3D objects is controlled 
through styles.

 5. Layer properties are a table of values that can be changed if needed. Color can be changed 
for different plotting effects and freezing/thawing layers can be very common. 

 6. Layer states are snapshots of the layer properties of a file and it's XREFs at any given time. 
These states can be saved and reused to speed up changing layer states in a file. Layers and 
their properties

Helpful layer tools
 1. WisDOT *** Tab > Manage panel > Layers pulldown

 A. Layers - Convert Layer Colors
 B. Layers - Layer Order
 C. Layer States Palette
 D. Layers - Assign Object Layer Defaults

 2. WisDOT *** Tab > Manage panel > Xref tools pulldown 
 A. Xref tools - Load Xref on Layer
 B. Xref tools - Assign Xref to Layer

Dividing and connecting files/objects

Info: When/why do we break up files/objects?

 1. Logical break out
 2. Allow multiple users to edit data concurrently
 3. Keep file sizes manageable for hardware/infrastructure
 4. Setting up data for downstream deliverables (CDP)

Info: When/why do we connect files/objects?

There are MANY reasons that are seemingly obvious. For example, to design cross-sections, you 
need many  inputs (alignment/profile, existing ground, proposed horizontal geometry). The import-
ant things to understand is:
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 1. Once you divide data into multiple files, you  need to connect data together to complete cer-
tain tasks.

 2. You need access and resources to not only open the file you're working in, but all the files 
you're connected to at any given time.

 A. Example: If you have a 5KB alignment file that has a data shortcut to a 10GB existing 
surface, you are working with 10GB, not just the 5KB.

 B. Example: If you have 10x 100MB topo files, if you XREF one of them, you're working 
with 100MB. If you XREF ALL of them, you're working with 1GB!

Methods to connect to files in Civil 3D

 1. XREF
 A. Visual representation of entire file. Can see all AutoCAD and Civil 3D objects
 B. Basic display. You cannot access the attributes of Civil 3D objects (superelevation, sur-

face data, changing styles)
 C. Can turn on/off, freeze/thaw data on XREF layers.

 2. DREF (data shortcut)
 A. Intelligent and dynamic connection to specific Civil 3D object types
 B. Surfaces, alignments, profiles, pipe networks, corridors, sample line groups, view 

frame groups
 C. Can access attributes and have different styles than the source file. Example: an exist-

ing surface can have a border only style in the source file and you can change it to a 
contour interval in a host file.

 3. SREF (survey data reference)
 A. These are file connections that are not XREFs or DREFs. They are similar to DREFs in 

that you can access attributes of the source objects, but the connections are not made 
through the Data Shortcuts interface.

 B. Any DWG can have connections to 
 I. Survey databases/queries to see points and figures. Examples:

 a. Topo-Ex.dwg
 b. Cross section files referencing utility figures
 c. Hydro design files connecting to culverts

 C. Surfaces can have connections to:
 I. Survey databases/queries

 II. PNT/FLT files
 III. LandXML files
 IV. DEM files
 V. TIN files

 D. Data Connect (Map 3D)
 4. Source DWG

 A. The file where the object has been created
 5. Host DWG

 A. A file where the object or file is consumed
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Things to know about XREFs

 1. With few exceptions, XREFs should be
 A. Relative (stays intact even if project is moved or copied)
 B. Overlay, Not Attachment (prevents XREFs from getting passed on through multiple lay-

ers of references. This may be convenient in some cases, but it is not a best practice 
for data management since it provides more opportunities for circular references and 
potentially unintended load increase)

 C. Scale = 1, Rotation = 0, Insertion = 0,0,0
 2. The best way to do XREFs is WisDOT *** Tab > Manage panel > Xref Tools pulldown > 

Load Xref on Layer It does all the settings above AND places the XREF on it's own layer that 
is the name of the file.

 3. XREFs should only be saved to a file if they are often being used. To minimize the impact of 
large XREFs on file open, the XREF definition can be retained, but unload the XREF.

Things to know about DREFs

 1. Promote creates a copy of an object in a host file that does not stay live to the original object. 
This command should not be used unless this functionality is needed.

 2. The style of a DREF can be changed in a host file.
 3. If you change the name of an object in a source file, Civil 3D will keep the connection live, but 

it will not automatically change the name in the available Data Shortcuts or the name in host 
files.

 A. Toolspace > Prospector > Validate Data Shortcuts will apply new names (and check 
for missing objects)

 B. Inside each host file, Manage tab > Data Shortcuts panel > Validate Data Short-
cuts will apply new names (and check for missing objects) in the host file.

 C. If you can avoid renaming objects after they are being consumed in other files, that 
can save you some headaches.

 4. If you need to redefine object geometry, it is not necessary to delete the object and create a 
new one.

Project structure and data flow
Detailed documentation

 1. Project data workflow map
 2. Edgeline data management

Data management concepts that experts use
 1. There is no one way to do data management that fits every single project. We have too 

many different scope possibilities for design projects for that to work.
 2. The biggest part of delivering a design and plan is the decision-making process of developing 

the design, not the drafting of the sheets.
 3. You don't look up standards after you design a project. You look up standards BEFORE you 

design. The same concept should be brought to data management (structure, naming).
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 4. Develop a plan (storyboard) for your work before beginning your work.
 A. What existing condition data do we need?
 B. What design do we need?

 I. Corridor(s)
 II. Drainage

 C. What sheets will we need?
 D. What CDP files will we need to deliver?

 5. The first time you do something in Civil 3D, you should NOT be thinking "what shortcuts can I 
take?". The first time you should be following steps exactly. Only after going through an entire 
design process, should you be looking for shortcuts.

 6. Files that are consumed by many different downstream files need to have as little connected 
files as possible to avoid circular references and longer load times.

 A. The following files should NEVER have any permanent XREFs in it. They get consumed 
by so many downstream files.

 I. AliProf-*.dwg
 II. Srfc-Ex.dwg

 III. Topo-Ex.dwg
 7. Data needs to flow in one direction to avoid circular references.
 8. XREFs and DREFs only cause circular reference problems if they are saved into the host file 

database (i.e. the file is then looked for when host file is opened.). You can reference a file 
and unload or remove the reference before you save it.

 9. Don't be afraid to:
 A. Ask for assistance.

 I. CAE Support
 II. Methods Development

 III. Experienced local users
 IV. Google

 B. Push buttons
 C. Create/edit/delete data
 D. Build out the entire flow of files with preliminary data and then make updates to them 

as the design progresses
 I. Example: AliProf > Corridor > Refinement Surface > Cross Sections 

You've got a messed up file, now what should you do?
We'll work on getting your file back up and running, but the most important thing to remember is 
even if you fix the file, if you keep doing the same thing (same file size, same DREF/XREF, same work-
flow, same button pushes, etc.), you should expect the file to break in the same way again.

"Insanity: doing the same thing over and over again and expecting different results." - Albert Einstein

Requirement: You NEED to change SOMETHING.

 l Are my files too big?
 l Is there a bad/huge XREF?
 l Maybe the steps I took aren't good for some reason?
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 l When Civil 3D locks up or crashes
 l How to fix damaged or corrupt drawings
 l Keeping drawings clean and working
 l Repair external references
 l Repairing data shortcuts and data references
 l Things that can slow performance in Civil 3D/AutoCAD

Moving Civil 3D project files, directories, and data shortcuts
Last updated: 2015-04-17

This process describes the process for transferring Civil 3D Project files, directories and Data Short-
cuts. This example shows the transfer of an entire Civil 3D project from a local drive to a network 
drive.

Transfer files and directories
 1. Create a top level project folder on the network drive.

 A. For example... N:\PDS\C3D\<network project folder>
 2. Browse to the local folder of the project you wish to copy.

 A. For example... C:\Civil 3D Projects\<local project folder>
 3. Copy the entire contents of <local project folder> to <network project folder>.

Use the Data Shortcuts Editor
The Data Shortcuts Editor is used to re-path Civil 3D data shortcuts from one location to another loc-
ation.

 1. Open Data Shortcuts Editor
 o Start Menu > All Programs > Autodesk > Autodesk AutoCAD Civil 3D 2014 > Data 

Shortcuts Editor
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 2. Browse to N:\PDS\C3D\<network project folder>

Info: Select the folder above the _Shortcuts folder
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 3. View the data shortcuts in the Editor window. You will notice the path is pointing to the ori-
ginal location of the files. Take note of this folder path only up to and including the project 
number.
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 4. Select Find and Replace... from the Edit menu

 5. Enter the <old folder path> in Find: and the <new folder path> in Replace with:
Note: Only enter the part of the path up to and including the project number

 6. Click Replace All
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 7. Verify the New path is correct in the Editor window and click the Save button.

Info: You must click the "Save" button before exiting the Data Shortcuts Editor or you will lose 
any changes made.

 8. Exit the Data Shortcuts Editor.

Reset shortcut history and folders
 1. Reset shortcut history and folders to allow Civil 3D to recognize the new project location.
 2. Browse to:  N:\PDS\C3D\<network project folder>\_Shortcuts\
 3. Delete the file ShortcutsHistory.xml
 4. Browse to:  C:\Users\<your username>\AppData\Roaming\Autodesk\C3D 2014\enu\Pro-

ject Management\
 5. Delete the files ShortcutFolders.xml and WorkingFolders.xml
 6. Open Civil 3D
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 7. Right-click on Data Shortcuts in the Prospector and select Set Working Folder...

 8. Browse to: N:\PDS\C3D\

Info: Select the folder above the <network project folder>
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 9. Right-click on Data Shortcuts in the Prospector and select Set Data Shortcuts Project Folder...

 10. Select the newly transferred <network project folder>.
 11. Continue working in the project or exit Civil 3D.

Merging Civil 3D project files, directories, and data shortcuts
Last updated: 2015-04-17

This process describes the process for merging Civil 3D Project files, directories and Data Shortcuts 
into an existing project folder. This example shows the merging of a Civil 3D project from an external 
folder into an existing WisDOT network folder.

Rename existing directory and transfer files
 1. Browse to an existing WisDOT project folder. (These folders are typically named with the pro-

ject number) For example... N:\PDS\C3D\12345678 Ensure no one is working with any files in 
the folder before proceeding.

 2. Rename the project folder by appending "–merge" to the project number. For example... 
N:\PDS\C3D\12345678-merge

Info: Note: This folder will store the existing files until we are ready to merge. Do not copy files 
into here yet.

 3. Create a new empty project folder using the same name as the original folder. For example... 
N:\PDS\C3D\12345678 We will use this folder to transfer new files into.

 4. Browse to the <Civil 3D project folder> you wish to merge.
 5. Transfer the entire contents of the <Civil 3D project folder> into the empty <project number> 

folder you just created.

Use the Data Shortcuts Editor
The Data Shortcuts Editor is used to re-path Civil 3D data shortcuts from one location to another loc-
ation.
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 1. Open Data Shortcuts Editor
 o Start Menu >> All Programs >> Autodesk >> Autodesk AutoCAD Civil 3D 2014 >> 

Data Shortcuts Editor

 2. Browse to N:\PDS\C3D\<project number>

Info: Note: Select the folder above the _Shortcuts folder
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 3. View the data shortcuts in the Editor window. You will notice the path is pointing to the ori-
ginal location of the files. Take note of this folder path only up to and including the project 
number.
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 4. Select Find and Replace... from the Edit menu

 5. Enter the <old folder path> in Find: and the <new folder path> in Replace with:

WisDOT only: Note: Only enter the part of the path up to and including the project number

 6. Click Replace All

 7. Verify the New path is correct in the Editor window and click the Save button.
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Info: Note: You must click the "Save" button before exiting the Data Shortcuts Editor or you 
will lose any changes made.

 8. Exit the Data Shortcuts Editor.

Merge project files

Info: Files may be overwritten during a merge. Make an archive of the project folder if there is 
any question as to if files should be overwritten or not.

 1. Browse to the <project number> folder with the newly transferred files. For example... 
N:\PDS\C3D\12345678

 2. Move the entire contents of this folder to the "–merge" folder created at the beginning of this 
workflow. For example... N:\PDS\C3D\12345678  toà  N:\PDS\C3D\12345678-merge

Warning: If the Confirm Folder Replace dialog appears, check Do this for all current items and 
click YES
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Warning: If the Move File dialog appears, check Do this for the next XX conflicts and click 
Move and Replace
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 3. There should now be an empty project folder. Verify there is nothing in it, then delete the 
empty folder.

 4. Remove the suffix from the merge folder and rename <project number-merge> to <project 
number>. For example... N:\PDS\C3D\12345678-merge  toà  N:\PDS\C3D\12345678

Best practices to manage Civil 3D projects at remote loc-
ations
Preparing to work remotely
Working on a Civil 3D project remotely over VPN can be very slow.  This topic outlines requirements 
and best practices to work on a copy of a Civil 3D project that is not the master project. Along with 
these steps, it is critical to communicate with others working in the project how you intend 
to work in the copy, what your process for synchronizing is, and what files you are working 
on. Preventing multiple people from working in the same files in the same timeframe will 
eliminate the possibility of overwriting others' work.

Consider checking out a Civil 3D license. You need to check out a license if you won't be using VPN. 
"Borrowing and returning a Civil 3D license" on page 287
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Term Definition

Office
Wisconsin DOT office or office directly connected to the WisDOT 
network drive.

Network 
drive

A Local Area Network (LAN) drive (example: N:drive).  A cloud ser-
vice like BOX, Dropbox, etc is not a network drive.

Local drive A hard drive directly connected to your computer.

Master pro-
ject

Civil 3D project that is created on the office network drive.

Data Short-
cut

A data shortcut is the mechanism used to create a data reference. 
The data shortcuts are listed at the bottom in the Civil 3D 
Toolspace Prospector.

Data Refer-
ence

A data reference is the actual object reference connection between 
the host and source drawings. Once a data reference is created, 
the data shortcut no longer needs to exist for the data reference to 
be valid. (Think of it like a shortcut on your desktop. You can delete 
the shortcut, but the application that it pointed to will still work.)

User 1
Project team member that creates new content in dwg or data 
shortcut, data reference.

User 2
Project team member that consumes and uses new content cre-
ated by User 1.

 

Recommended Setup

Q: Can I work on my project(s) on the N drive through VPN?

A: It is technically possible to do this. Depending on your internet connection, the VPN traffic, and 
your level of patience, you might even find this a reasonable setup for tasks in small files. We do not 
recommend this setup for long-term work. Think of any tasks that take a long time in the office (plot-
ting an entire plan set, working with corridors, surfaces, or ortho-images) and multiply that time by a 
very large number. File corruption due to connection dropouts is also possible when using VPN.

 1. Make sure the local drive has enough space to store the Civil 3D project files.  Minimum space 
required is 2x (twice) the size of the Civil 3D project files.
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 2. Make sure all XREFs are set to relative path. 
 A. Windows Start > All Programs > Autodesk Civil 3D 20XX - English > Reference 

Manager to check
 B. Always use the relative path option for XREFs. This will make sure XREFs work even if 

the project is moved.
 3. Before leaving the office, copy the entire project directory from the network (N: drive) to the 

C:\Civil 3D Projects folder.
 4. The N drive project is the master. Your C drive is a copy.  Always consider the office (N drive) 

project the master project. It is backed up to ensure against hardware failure, data cor-
ruption, etc.

Set Data Shortcuts Project Folder in Civil 3D

 1. Open Civil 3D
 2. Set Working Folder 

 A. Toolspace > Prospector > Right-click Data Shortcuts > Set Working Folder...
 B. Browse to C:\Civil 3D Projects
 C. Select Folder

 3. Set Data Shortcuts Project Folder 
 A. Toolspace > Prospector > Right-click Data Shortcuts > Set Data Shortcuts Project 

Folder...
 B. Select Project ID
 C. OK

 4. Continue working in the project or exit Civil 3D

See "Repairing data shortcuts and data references" on page 165 if broken data references occur or 
contact CAE Support.

See the Autodesk help documentation Data Shortcut Projects for additional information.

Recommendations when working remote #recommend

Virtual Private Network (VPN)

Possible reasons to connect to VPN from a Civil 3D perspective:

 l A Civil 3D license has not been borrowed, so Civil 3D needs to access the software license 
through VPN

 l Back up design files on the network
 l Sharing information - Other people are creating and/or using Civil 3D files for the project

Possible scenario when not connecting to VPN:

 l A Civil 3D license needs to be borrowed while in the office or while previously connected 
through VPN

 l Files only exist on your computer and back up design files will not be on the network
 l Files do not need to be shared with others during remote work
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Communication

Tips: 
It is critical to communicate with others working in the project

 l How often will files be saved back to the network? 
 o This will depend on the number of people working with you on the Civil 3D 

design project.  It is best if the frequency of file transfers is established prior to 
working remotely.

 l What files are you working on? 
 o Know who the owner is for each file.  This person is responsible for com-

municating the creation of the file and any updates.
 o Preventing multiple people from working in the same files in the same time-

frame will eliminate the possibility of overwriting others' work.

When two versions of the same file exist

If someone worked in the same file as you while you were away, consider alternatives for moving 
your work back to the server project:

 1. Change the file name and keep both versions. See "Repairing data shortcuts and data ref-
erences" on page 165

 2. Transfer data by LandXML from one file to the other. See "Repairing data shortcuts and data 
references" on page 165

Recreating Data Shortcuts

Q: If I move my local dwg file to the N-drive project master location, how do I include any data short-
cuts that I created for that dwg?

A: It is important to understand the difference between data shortcuts and data references.  A data 
shortcut is the mechanism used to create a data reference.  The data shortcuts are listed at the bot-
tom in the Civil 3D Toolspace Prospector.  A data reference is the actual object reference connection 
between the host and source drawings.  Once a data reference is created, the data shortcut no 
longer needs to exist for the data reference to be valid.  (Think of it like a shortcut on your desktop.  
You can delete the shortcut, but the application that it pointed to will still work.)

So what does this mean for working on projects remotely?  If you create data shortcuts in the local 
copy of the project, those data shortcuts will not be created in the N-drive copy of the project.  
However, when you copy a dwg from your local drive to the N-drive, the data reference connections 
will still work as long as the source drawings are located in the same relative location in the N-drive 
project.

Options for recreating Data Shortcuts

Option 1 (not recommended):  Copy the drawing to the N-drive.  Then set your working 
folder to the N-drive and create the data shortcut.  You will find this process to be very 
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slow.  Civil 3D may appear to be “unresponsive” for several minutes or more depending 
on the VPN connection speed.

Option 2:  Copy the drawing to the N-drive.  Copy the corresponding shortcut xml file to 
the N-drive.  Communicate to the team that the shortcut was created so everyone can 
download the new xml file to their local copy of the project.

Option 3:  Copy the drawing to the N-drive.  Don’t worry about creating data shortcuts 
for the N-drive copy at this time.  They can be created as-needed when the team is back 
working in the office. If there are others working on the same project remotely, they can 
create the data shortcut(s) for their local project as-needed.

See "Repairing data shortcuts and data references" on page 165 if broken data references occur or 
contact CAE Support.

See the Autodesk help documentation Data Shortcut Projects for additional information.

Copying files between the local drive and network drive

Use Windows File Explorer to copy and paste files between the local drive (C drive) and the network 
drive (N drive).  Copying files using the drag and drop method is not preferred since it introduces the 
possibility of copying files to an unintended or unknown location, but is an option based on comfort 
level.

Remember to keep in communication with others as to who is working in which files and 
when!

 1. Copy individual files and directories as needed except the _Shortcuts folder from the local 
drive to the network.

 2. Copy individual shortcut xml files for newly created data shortcut to _Shortcuts folder. 
Example:

 A. User 1 updates a dwg and creates a shortcut locally.
 B. User 1 uploads the dwg to the N-drive and also uploads the shortcut xml.
 C. User 1 notifies the team that the dwg was updated and that they uploaded the short-

cut xml.
 D. User 2 downloads the new dwg to their local project.
 E. User 2 downloads the new shortcut xml to their project.

Batch Files

The steps above can be automated with batch files. Below are examples of batch files that can be cre-
ated to automate file copying. The code below will not overwrite newer files. See robocopy doc-
umentation for all options.

 1. Copy the text files to your local PC.
 2. Change the project id for your actual project.
 3. Add a new line for each project you are working on.
 4. Rename the .txt extension to .bat
 5. Right-mouse click on the file and select “Run as administrator”
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 6. Run the Push or Pull batch file.

Pull-ProjectFiles-ToPC.txt

Push-ProjectFiles-ToLAN.txt

A possible workflow to keep files synchronized would be:

 1. At the beginning of a day 
 A. VPN
 B. Pull-ProjectFiles-ToPC.bat
 C. Disconnect from VPN

 2. Work in Civil 3D project throughout the day
 3. At the end of a day 

 A. VPN
 B. Push-ProjectFiles-ToLAN.bat
 C. Disconnect from VPN

And remember to keep in communication with others as to who is working in which files and when!

Warning: This workflow would replicate C drive Data Shortcut XML files that would need to be 
replaced with N drive versions.

Contact CAE Support for further assistance on copying files and data shortcuts.

Returning to the office after remote work
Review that all local design files developed by the project team have been copied to the network.  See 
"Recommendations when working remote #recommend" on page 151 above for additional inform-
ation on updating project files.

Set Data Shortcuts Project Folder in Civil 3D

 1. Open Civil 3D
 2. Set Working Folder 

 A. Toolspace > Prospector > Right-click Data Shortcuts > Set Working Folder...
 B. Browse to N:\PDS\C3D\
 C. Select Folder
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 3. Set Data Shortcuts Project Folder 
 A. Toolspace > Prospector > Right-click Data Shortcuts > Set Data Shortcuts Project 

Folder...
 I. Select Project ID

 II. OK
 4. Continue working in the project or exit Civil 3D

See Repairing Data References if broken data references occur or contact CAE Support.

See the Autodesk help documentation Data Shortcut Projects for additional information.

Final steps

 1. Verify all the data has been copied from the local drive to the network drive
 2. Verify the network drive project is working as anticipated
 3. Create a zip of project from local drive and delete the project in C:\Civil 3D Projects

Migrating blocks between Civil 3D versions
Last updated: 2015-04-17

It is good practice when migrating blocks to insert them into a blank out-of-the-box template. This 
way we avoid saving forward any old settings contained in the drawings within which these older 
blocks reside. Depending on the scale of migration we can accomplish this a couple of different 
ways. 

Workflow 1 – Migrating a small number of blocks
 1. Start a new block library drawing using the out-of-the-box acad.dwt template found here:

 o C:\Users\<user name>\appdata\local\autodesk\c3d 2014\enu\template

 2. Insert older blocks using Design Center
 o Open Design Center, and browse to the source drawing containing the blocks to be 

migrated. The reason this workflow is designed for migrating a small number of blocks 
is because Design Center only allows one block to be inserted at a time. That is not 
ideal for migrating hundreds of blocks, but it does work well for smaller numbers.

 o Open the Blocks section in the source drawing in Design Center, and drag each block 
into model space one at a time. Otherwise, right-click on each block and choose Insert 
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Block.

 3. Save the new block library drawing in the appropriate location with the appropriate name, 
and the newly migrated blocks are now ready to be used. 

Workflow 2 – Migrating many blocks
 1. Start a new block library drawing using the out-of-the-box acad.dwt template found here:

 o C:\Users\<user name>\appdata\local\autodesk\c3d 2014\enu\template

 2. Insert and explode existing block library drawing
 o Click on the Insert tab of the Ribbon and then select the Insert button on the Block 

panel. In the Insert dialog box browse to the existing block library drawing you wish to 
migrate. Be sure that the Insertion point, Scale, and Rotation options are all 
unchecked. Be sure the Explode option is checked on. This will insert the entire draw-
ing into the new 2014 drawing template and will explode into its individual objects. 
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 o Next we will run a few commands in order to clean unwanted items out of the new 
block library drawing.

 n Type PURGE in the command line. Be sure that the option for Confirm each 
item to be purged is unchecked and that the option for Purge nested items is 
checked on. Click on the Purge All button, and close the dialog box when the 
command is finished. 
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 n Type –PURGE in the command line. Type R to select the option Regapps. Hit 
enter to select the default asterisk for name of regapps to purge. This will select 
all regapps. Type N when prompted to verify each name to be purged. This will 
get rid of any 3rd party apps running in the background. 

 n Type AUDIT in the command line. Type Y when prompted to fix any errors 
detected in the drawing. 

 o Save the new block library drawing in the appropriate location with the appropriate 
name, and the newly migrated blocks are now ready to be used.

External reference best practices
Last updated: 2021-02-17

Use Load Xref on Layer tool
Load Xref on Layer is a custom WisDOT tool that creates an XREF with the following features:
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 1. Reference type: Overlay
 2. Path type: Relative
 3. Layer: xref-<file name>

Overlay xrefs prevent circular references from being created.

Relative paths do not break when projects are moved.

Creating a custom layer for the xref allows individual xrefs to be frozen/thawed with layer controls.

Drawings that contain Data Shortcuts
Drawings that contain data shortcut objects should not be used in an xref. If this situation cannot be 
avoided, the layers of the data shortcut objects should be frozen. The objects can then be directly 
included as a data shortcut in the target DWG.

Nesting xrefs should be avoided
A nested xref as shown in the images below occurs when an xref is created using the Attachment 
option, and the host file is then referenced into another drawing as an Attachment. Creating nested 
xrefs limits the ability to use a file as an xref because the user must be aware of and need the nested 
files, and more importantly, the user must ensure that no circular references or data shortcut con-
flicts exist. By creating xrefs as overlays there is no possibility of having nested xrefs.
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Partial reference
Use clipping boundaries (xclip) to define a partial reference. Clipping boundaries crop the display of 
a selected external reference or block reference to a specified boundary and can ensure better per-
formance. They can be accessed from the contextual ribbon when an xref is selected.

The clipping boundary determines the portion of an xref or block instance that is hidden, either out-
side or inside the boundary.
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Multiple xrefs of the same drawing
Sometime there may be a need to xref the same file multiple times. This can be handy when you 
need to reference different parts of a file in different areas of a target file.

To create multiple overlay references of the same drawing file, the Reference Name of each xref 
must be unique. The drawing name is automatically assigned as the Reference Name when adding a 
reference.

Therefore, before adding a second instance of a reference drawing, change the Reference Name.
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Then the drawing can be xreferenced again.
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One advantage of creating multiple xref instances of the same drawing is the option to leverage the 
visibility and plot styles of the same objects in different layouts and different viewports.

Xref layers
Each external reference should be set to its own unique layer. This allows for the most optimum dis-
play control of the xrefs.

Repair external references
Last updated: 2020-10-26
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 1. Home ribbon > Palettes panel > External References Manager

 2. In the external references manager look for drawings that say "Not Found" in the status 
column. Also, look for "Attach" or "Overlay" in the Type column and make sure they all say 
"Overlay". (There may be some rare cases where "Attach" is the desired setting) To repair 
these settings, follow steps 3 & 4.

 3. For drawings with a status of "Not Found", one at a time, click on the reference name. The 
details pane of the External References Manager will populate. Click on the "Saved Path" line 
of the details pane and an ellipses will appear. Click the ellipses to navigate to the updated/ 
location/ file name of the external reference. Choose the drawing and click Open. The path 
for the external reference will be updated.
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 4. Suggested Best Practice:  External references should be inserted as an overlay using a relative 
path type. This can be verified in the external reference manager.   Under the "Type" column, 
all dwg's should be listed as overlay.  Under the "Saved Path" column, all paths should start 
with a "..\Folder\" (see previous screenshot).  An absolute path is designated in the Saved Path 
column starting with a drive letter (ie. N:\pds\c3d...).  If either of these are not true for an 
attached drawing, they can be easily repaired.

 A. Right click on the drawing name
 B. From the menu that appears click on Xref Type and choose "Overlay"

 C. To update the path to relative click on the path and choose "Make Relative"

Repairing data shortcuts and data references
Last updated: 2021-09-03

The following topics describe situations where the relationship between a Civil 3D object and the 
data shortcut has changed or data references have been broken and need to be repaired.  The solu-
tions to these situations are listed below.

Warning: It is generally recommended that civil objects and files are NOT renamed or moved 
after they have been data referenced in other files during the design and plans production pro-
cess.

Page: 165

Published on: 5/17/2023

Repairing data shortcuts and data references



Term Definition

Data Shortcut
A data shortcut is the mechanism used to create a data ref-
erence. The data shortcuts are listed at the bottom in the Civil 
3D Toolspace Prospector.

Data Reference

A data reference is the actual object reference connection 
between the host and source drawings. Once a data reference 
is created, the data shortcut no longer needs to exist for the 
data reference to be valid. (Think of it like a shortcut on your 
desktop. You can delete the shortcut, but the application that 
it pointed to will still work.)

Civil Object

In the scope of this topic, this refers to an object that could 
have a data shortcut and/or data reference created for it. 
There are some Civil 3D-specific objects that cannot have data 
shortcuts/data references, but for this topic, we will focus on 
items found in Toolspace > Prospector > Data Shortcuts 

 

Validate and repair data shortcuts #validate

Info: All data shortcuts and data references should be fully functional prior to a project migra-
tion effort to a new version of Civil 3D.

All data shortcuts must by synchronized and working properly to create new data references in con-
suming files.

 1. Ensure all project files are closed. This may require communication with the entire project 
team

 2. Toolspace > Prospector tab > Right-click Data Shortcuts > Set Data Shortcuts Project 
Folder.. to view all available data shortcuts for a project.

 3. Toolspace > Prospector tab > right-click Data Shortcuts > Validate Data Shortcuts
 4. Expand the entire Data Shortcut tree for each object, and search for any exclamation symbols 

 5. Use the right click menu to Remove or Repair Broken Shortcuts

 

 6. An additional dialog box may prompt to Repair All Broken Shortcuts 
 A. YES
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 7. This may repair the rest of the broken Shortcuts in the project depending on the data short-
cut issue.

 8. Search for any more Exclamation symbols in the Data Shortcut tree in the Prospector tab
 9. Close and reopen Civil 3D to save Data Shortcut edits

Civil 3D also includes a tool to assist users in repairing broken data references within a drawing.  
Information on how to use the Data Shortcut Manager is published on Autodesk's website.

Data Shortcut Manager Dialog Box

Manage Data Shortcuts

Civil object is renamed after data shortcut has been created

Scenario

 1. Data shortcut has already been created
 2. Civil object has been data referenced into another drawing
 3. Civil object is now renamed in source file
 4. Source Civil 3D file has been saved and closed

Solution

"Validate and repair data shortcuts #validate" on the previous page and repair and synchronize 
broken references in consuming files.

In the file consuming the data reference created by the data shortcut...
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 1. Manage tab > Data Shortcuts panel > Synchronize References

 A. Update the reference name
 2. The data shortcut name has been updated and synchronized.

 3. Save the file.

Test repair

 1. Select data referenced object in the consuming DWG file
 2. Right-click > Open Source Drawing
 3. DWG that contains the data shortcuts source Civil 3D object is opened

Source DWG file is renamed after data shortcut has been created

Scenario

 1. Data shortcut has already been created
 2. DWG that contains the source Civil 3D object is renamed, saved, and closed
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Solution

"Validate and repair data shortcuts #validate" on page 166 and repair and synchronize broken ref-
erences in consuming files.

In the file consuming the data reference created by the data shortcut...

 1. Toolspace > Prospector tab > Data Shortcuts > Alignments > Centerline Alignments

 2. Right-click 51 alignment data shortcut > Repair Broken References...
 A. Browse to the file that contains the Civil object used for the data shortcut
 B. Open
 C. Repair all broken references

 3. Manage tab > Data Shortcuts panel > Synchronize References
 4. Save the file

Test repair

 1. Select data referenced object in the consuming DWG file
 2. Right-click > Open Source Drawing
 3. DWG that contains the data shortcuts source Civil 3D object is opened

The civil object is moved to a different source file after the data short-
cut has been created #civil-objct-mov

Scenario

 1. Data shortcut has already been created
 2. User decides that the source civil object referenced by the data shortcut should be kept and 

maintained in a different file.
 3. Data referenced object is promoted into a new drawing
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Solution

"Validate and repair data shortcuts #validate" on page 166 and repair and synchronize broken ref-
erences in consuming files.

In file consuming the data reference..

 1. Manage tab > Data Shortcuts panel > Manage Data Shortcuts
 A. Data Shortcut Manager dialog box > Data Shortcuts panel (right side of dialog box) 

 I. Source File: Select folder and browse to new file that be the source of the 
data shortcut

 B. OK
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 C. Additional broken shortcuts may happen as a result of changing the source file. 
 I. Select Repair all broken shortcuts

 2. Save the file.

Test repair

 1. Toolspace > Prospector tab > Data Shortcut
 A. Check that Data Shortcuts folder is set for the current project
 B. Right-click Data Shortcuts > Validate Data Shortcuts

 I. Check for error messages
 C. Select the data shortcut for the moved object 

 I. The source file name should be correct in the table at the bottom of the Pro-
spector tab

 2. Open drawing using updated data shortcut 
 A. Select the data referenced object > right-click > Open Source Drawing

An existing data reference needs to point to a different source civil 
object

Scenario

 1. Data shortcut has already been created
 2. The original civil object no longer exists
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Solutions

"Validate and repair data shortcuts #validate" on page 166 and...

 1. If the new source object has the same name and is in the same file - Civil 3D will associate the 
new source object with the existing data reference.

 2. If the new source object has the same name but is in a different file - See "The civil object is 
moved to a different source file after the data shortcut has been created #civil-objct-mov" on 
page 169

Test repair

 1. Select data referenced object in the consuming DWG file
 2. Right-click > Open Source Drawing
 3. DWG that contains the data shortcuts source Civil 3D object is opened

Replace drawing objects with data shortcut references

Scenario

 1. Data shortcut has already been created
 2. A duplicate object that is not data referenced or an object representing the same design 

entity exists in a file that is not the source drawing
 3. The duplicate entity is to be replaced with a data reference of the source object

Solution

In the file with the duplicate object, replace it with a data shortcut.
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 1. Manage tab > Data Shortcuts panel > Manage Data Shortcuts

 2. Additional information on how to use the Data Shortcut Manager is published on Autodesk's 
website. 

 A. Manage Data Shortcuts

Test

 1. Select data referenced object in the consuming DWG file
 2. Right-click > Open Source Drawing
 3. DWG that contains the data shortcuts source Civil 3D object is opened

Replace an existing data reference with a new data shortcut reference

Scenario

 1. Data reference has already been created for the civil object that will be replaced
 2. There is a new source object that has a different name and it is located in a different file
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Solution

In consuming files with the incorrect data reference, promote the incorrect data reference to a civil 
object and replace it with the correct data shortcut.

 1. Promote the data referenced object in the consuming file
 2. Rename the civil object in the consuming file to match the name of the new source civil object
 3. Create a new data shortcut from the new object in the new source file
 4. Manage tab > Data Shortcuts panel > Manage Data Shortcuts

 5. Replace drawing objects with data shortcut references 
 A. Additional information on how to use the Data Shortcut Manager is published on 

Autodesk's website. 
 I. Manage Data Shortcuts

 6. Delete the old data shortcut

Test repair

 1. Select data referenced object in the consuming DWG file
 2. Right-click > Open Source Drawing
 3. DWG that contains the data shortcuts source Civil 3D object is opened
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A data shortcutted object is deleted but is still needed for the project

Scenario

 1. The object for a data shortcut is deleted and the source file is then saved.
 2. The object has been data referenced into another drawing
 3. The data shortcut still exists

Solution

 1. Open a dwg file where the object has been data referenced 
 A. A cached copy of the object still exists within the consuming drawing

 2. Output tab > Export panel > Export to LandXML
 A. Export to LandXML dialog box 

 I. Pick from drawing 
 a. Select data shortcutted object that was deleted
 b. Enter

 II. OK
 B. Browse to the desired location and save the LandXML file

 3. Close the dwg file
 4. Open the drawing that will be the source file for the data shortcutted object
 5. Insert tab > LandXML > browse and select xml file > Open > OK
 6. Save and close the file

Test

 1. Open a dwg file that is using the data shortcut
 2. Check that the data shortcut is working properly 

 A. If errors or warnings occur - See "The civil object is moved to a different source file 
after the data shortcut has been created #civil-objct-mov" on page 169.

Verifying and updating data shortcut paths
The Data Shortcuts Editor can be used to re-path Civil 3D data shortcuts from one location to 
another location. This is important when moving a Civil 3D project from one storage location to 
another (N drive to C drive for instance).

 1. Close Civil 3D
 2. Windows Start > All Programs > Autodesk Civil 3D 20XX - English > Data Shortcuts 

Editor
 3. File > Open Data Shortcuts Folder... > C:\Civil 3D Projects\<project folder>\_Shortcuts 

folder
 4. View the data shortcuts in the Editor window. You will notice the path is pointing to the ori-

ginal location of the files. Take note of this folder path only up to and including the project 
number.
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 5. Edit > Find and Replace...

 A. Find and Replace dialog box 
 I. Find = <old folder path>  (Example: N:\PDS\C3D\XXXXXXXX) 

 a. Only enter the part of the path up to and including the project number
 II. Replace with = <new folder path>  (Example: C:\Civil 3D Projects\XXXXXXXX) 

 a. Only enter the part of the path up to and including the project number
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 III. Replace All

 6. Verify the new path is correct in the Editor window.

 7. Save
 A. You must click the "Save" button before exiting the Data Shortcuts Editor or you will 

lose any changes made.
 8. File > Exit
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WisDOT Civil 3D project setup
Create a Civil 3D project
Last updated: 2023-03-20

Total video time: 01:59

prj-creat-c3d-prj-01.mp4 1:59

Create a Civil 3D project from a project template

 1. Toolspace > Prospector tab > Right-click  Data Shortcuts > Set Working Folder.
 2. Browse to the working folder. Example: For the project data folder N:\PDS\C3D\11111111 the 

working folder is N:\PDS\C3D (The working folder is always one folder above the project data 
folder.)

 3. Toolspace > Prospector tab > Data Shortcuts  > Right-click Data Shortcuts > New Pro-
ject Data Folder

 4. In the New Data Shortcut Folder dialog box:
 A. Name = 11111111
 B. Description = optional
 C. Use project template = Checked
 D. Project template = WisDOTProjectTemplate
 E.  OK

Info: The default storage location for Civil 3D project templates is C:\User-
s\Public\Documents\Autodesk\Civil 3D Projects Templates

WisDOT standards – Civil 3D project folders
Last updated: 2023-03-20

Total video time: 06:05

prj-wisdot-stnd-c3d-prj-01.mp4 6:05

Requirements: 
FDM 15-5 Attachment 3.1 CADDS AutoCAD Civil 3D Project Folder Structure Standard

FDM 15-5 Attachment 3.3 CADDS AutoCAD Civil 3D File and Layout Naming Standard

Project folder structure is important

 l Connectivity of referenced data: Data references and external references (XREF).

 l Project consistency: The ability to find files based on the type of data.
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 l Project portability: The ability to move a project internally or externally, and maintain the data 
connectivity.

Creating the project folder structure

 l All WisDOT Civil 3D projects use data shortcuts.

 l The New Data Shortcut Projects Folder creation tool lends itself well to the WisDOT Civil 3D 
workflows.

 l The project folder structure can be created from the WisDOTProjectTemplate project folder 
template: Create a Civil 3D project

Using the project folder structure

 l The top level of the project folder should never change.

 l Folders can be added underneath the top level project folder.

 l Folders created from the project folder template should never be deleted, renamed, or 
moved.

Create a basic Civil 3D file in a WisDOT project folder struc-
ture
Last updated: 2023-03-20

Requirements: 
FDM 15-5 Attachment 3.1 CADDS AutoCAD Civil 3D Project Folder Structure Standard

FDM 15-5 Attachment 3.3 CADDS AutoCAD Civil 3D File and Layout Naming Standard

Create a basic Civil 3D file in a WisDOT project folder structure

Prerequisites: 
WisDOT Civil 3D start and sheet templates and how to use them

There are four primary methods to create a basic WisDOT Civil 3D file.

Quick Access Toolbar

Info: Using the Quick Access Toolbar button, a new drawing will be created from the default 
drawing template setting for QNEW. The default WisDOT drawing template is design-start.dwt.

 1. Quick Access Toolbar > New

 2. A new drawing tab will open with the name Drawing[#].dwg.

 3. SAVE file with correct name and location in WisDOT project folder structure.
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C3D Application menu

Info: This method can be used to choose a specific drawing "start" template other than 
design-start.dwt.

 1. C3D Application menu > New > Drawing

 2. Browse to C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg and select a drawing "start" 
template.

 3. Open

 4. A new drawing tab will open with the name Drawing[#].dwg.

 5. SAVE file with correct name and location in WisDOT project folder structure.

WisDOT Sheets tool palettes

Info: This method can be used to choose a specific sheet drawing template.

 1. Toggle tool palettes on: Ribbon > WisDOT Sheets tab > Manage panel > Palettes

 2. Select a sheet type: Ribbon > WisDOT Sheets tab > Sheet Creation panel >  (select a sheet 
type button)

 3. Select a drawing template: Startup Main tool palette > (select a start-up template but-
ton)

 4. A new drawing tab will open with the name Drawing[#].dwg.

 5. SAVE file with correct name and location in WisDOT project folder structure.

Start Tab "New" menu

Info: This method can be used to choose any drawing template.

 1. Select the Start tab. (The tab farthest to the left of any open drawing tabs.)

 2. On the left side of the page, click the dropdown arrow on the "New" button and select a draw-
ing template from the menu. (Or select Browse templates... from the menu to choose a draw-
ing template not in the list.)

 3. A new drawing tab will open with the name Drawing[#].dwg.

 4. SAVE file with correct name and location in WisDOT project folder structure.

Project data workflow map
Last updated: 2023-03-24

WisDOT Civil 3D Project Data Workflow Map
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Overview
The linked WisDOT Civil 3D Project Data Workflow Map is a visual representation of the typical 
folder layout of a project, where files should be stored, and how files and objects should connect for 
the development of a WisDOT Civil 3D project.

The map shows common:

 l Project folder structure

 l File locations

 l Object locations

 l Data shortcuts between objects and files

 l XREF connections

 l Survey database and queries location

 l Drawing startup template types and location

 l Plan sheet template types and location

Mapping & Survey data workflow
Last updated: 2023-03-24

Survey & Mapping Civil 3D workflow

Overview
The linked Survey & Mapping Civil 3D workflow PDF shows the relationship between mapping & 
survey source files, standard base data files, and design & plan sheets. Updates and/or edits to any 
existing condition data should done through the same workflows so that design and plan sheet files 
automatically see the changes.

Edgeline data management
Last updated: 2023-03-24

Project Edge Line Component Development and Consumption Map

Overview
The linked Project Edge Line Component Development and Consumption Map shows the rela-
tionships among edgeline design objects (alignments) and how they fit in WisDOT's Civil 3D object 
and file referencing scheme. Some edgeline objects are used in both design and plan production 
workflows, and some are only used in one capacity or the other. 

There are 3 scenarios shown in the map detailing how object and file references are used.
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 1. Scenario 1 shows the relationships when there is no corridor modeling required.

 2. Scenario 2 shows the relationships when there is one corridor being modeled.

 3. Scenario 3 shows the relationships when there are many corridors being modeled.

Updating settings and styles in production DWG files
Last updated: 2020-10-26

Most of the settings and styles that control a DWG file are contained within the file. Updates to a tem-
plate file are not automatically brought into existing files. This topic covers the different methods for 
updating settings and styles for existing files in Civil 3D.

Civil 3D styles and drawing settings update
Use the import styles tool to update a DWG file's Civil 3D standards with those found in the latest 
WisDOT template.

 1. Open the dwg file you wish to update in Civil 3D.
 2. Manage ribbon > Styles panel > Import
 3. Browse to template file containing standards you'd like to apply to the dwg file. 

C:\WisDOT\Stnd\C3D20XX\Templates\Begin-dwg\design-wisdotxx.dwt.

 4. In the Import Civil 3D Styles dialog box, you can review new Civil 3D standards that will be 
imported. You can also choose to delete standards that are no longer in the WisDOT template 
- if they aren't in use in the drawing. You can make modifications to the import/delete actions 
if you wish. You can turn on, or off import drawing settings. Details are available in Civil 3D 
Help documents.
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 5.  OK Save the dwg file.
 6. Consider updating AutoCAD standards also.

AutoCAD standards update
Use the import styles tool to update a DWG file's AutoCAD standards with those found in the latest 
WisDOT template.

 1. Open a new drawing using the template containing the new standards you want applied to 
the project dwg file.

 2. C3D button > Save As > AutoCAD Drawing Standards. Remember where you save this 
DWS file.

 3. Open the dwg file you wish to update.
 4. Manage ribbon > CAD Standards panel > Configure
 5. In the Configure Standards dialog box, Standards tab, click the + button and browse to you 

DWS file.
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 6. In the Configure Standards dialog box, Plug-Ins tab, select the types of standards you'd like to 
update. Usually you'd check all.
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 7. Click the Settings... button. The settings should look as shown.

 8. Click Check Standards... button
 9. The tool will notify you of DWG layers that are no longer in the DWS standards file. You can 

cycle through this by clicking Next. The layer will not be deleted from the dwg file.
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 10. When the update is complete you will receive a notification with update statistics.

 11. Close the Check Standards dialog box
 12. Manage ribbon > CAD Standards panel > Configure
 13. Remove the DWS file from the drawing by clicking the X button. Click OK to close the Con-

figure Standards dialog box.
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 14. Save the DWG file.

Wisconsin coordinate system settings in Civil 3D
Last updated: 2023-05-17

Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 
2018 has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is 
needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, 
Wisconsin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

Warnings: 
In late 2016 it was discovered that project survey data was being transformed when coordin-
ate systems were not being used uniformly throughout a Civil 3D project. This transformation 
occurs when the coordinate system selected for a LandXML import differs from the coordin-
ate system assignment for a survey database. The transformation also occurs when data 
from a survey database is inserted into a DWG file that has a coordinate system assignment 
different from the survey database.

For more information on the issue and what can be done to identify and resolve the issue 
refer the following C3DKB topics:

Wisconsin coordinate projection issue - XML/SDB
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Wisconsin coordinate projection issue - SDB/DWG

WisDOT Civil 3D coordinate system action summary

Wisconsin coordinate systems available in Civil 3D
 l SPCS – State Plane Coordinate System – FDM 9-20-26  Developed nationally by the US Coast 

and Geodetic Survey in the 1930s.  Wisconsin has three state plane zones North, Central and 
South that follow county lines.

 l WCCS – Wisconsin County Coordinate System – FDM 9-20-27  Developed in 1993 by 
WisDOT.  Achieved design goal of minimal distortion between grid (map) and ground dis-
tances by creating individualized ellipsoids for every county.

 l WISCRS – Wisconsin Coordinate Reference System – FDM 9-20-28  Developed in 2006.  
Design goal is to arrive at the same WCCS coordinate while utilizing one nationally recognized 
ellipsoid, making it easier for vendors to include Wisconsin county coordinates in their soft-
ware and equipment.  For all counties except Jackson County, WCCS and WISCRS coordinates 
will essentially be the same for a given point.

 l WTM – Wisconsin Transverse Mercator – FDM 9-20-25.3.1  Developed by the Wisconsin 
DNR in the 1980s.  The Universal Transverse Mercator used by the Department of Defense 
divided Wisconsin almost equally into two zones down the 90 degree west longitude line.  The 
WTM is centered on the 90 degree longitude line and allows Wisconsin to be covered by one 
WTM zone rather than two UTM zones.

Info: It is encouraged that new projects are surveyed in WISCRS. 

Frequently Asked Questions (FAQ)

How do I choose a coordinate system for a WisDOT dwg file?

The coordinate system that was used to collect survey data should be obtained from the surveyor or 
the WisDOT Survey Data Coordinator.  Review the Form DT1773 Geodetic Reference Documentation 
with the Survey Data Coordinator. 

Can I set the coordinate system for multiple files at once?

To set a coordinate system in multiple files at once, use Assign Coordinate System - Multiple dwgs.

What should I do with my existing project?

Check with the Region Survey Data Coordinator to verify that the correct coordinate system has 
been applied to the drawing.  Changing the coordinate system in Civil 3D will not affect the data in 
the drawing itself but may cause errors to referenced aerial photos, GIS information, or survey data-
base data if they are based on a different coordinate system.

Page: 189

Published on: 5/17/2023

Wisconsin coordinate systems available in Civil 3D

shr-mng-dwg-assgn-crdnt-sstm-multi-dwg.htm


Is the survey information drawn differently for the adjustment years?

The horizontal datum versions for NAD 83 include (1986), (1991), (1997), (2007) and (2011). The dif-
ferences are fundamentally a result of upgrades and enhancements in technology, surveying meth-
odologies and computing power. In addition, as the Wisconsin Height Modernization program has 
worked its way around the state, additional measurements (horizontal and vertical) to survey sta-
tions has added more data to further refine the previously published coordinates.  There is no direct 
mathematical relationship between NAD83 adjustment years.  Therefore, any change in coordinate 
values due to a change in adjustment year should be handled by the Region Survey Data Coordin-
ator outside of Civil 3D. 

Civil 3D is a design tool and should not be considered a survey adjustment tool.  Any questions or 
concerns regarding the project datum and adjustment should be addressed to the Region Survey 
Data Coordinator.  Any changes to the project survey datum and adjustment should be overseen by 
the Region Survey Data Coordinator.

Should I translate my survey data to a newer projection?

No.  Transforming a project to another coordinate system is reserved for the Survey Data 
Coordinator and should not be done by the engineer/designer.  If survey data is collected based 
on the NAD 83 (2011) coordinates and saved to a survey database, then the project is in NAD 83 
(2011) coordinates. Civil 3D projects are a Cartesian plane based on what the survey database tells 
the project the coordinates are.  The adjustment year in the coordinate name does not include any 
additional information that will allow Civil 3D to translate coordinates between adjustment years. 
Only one adjustment year is provided in the "WisDOT" category.

Civil 3D reflects what is imported in the survey database, and if another coordinate system is needed 
by Civil 3D, then the survey data coordinator should transform the data.

What is the difference between WCCS and WISCRS?

In general, WCCS is based on a local ellipsoid (the reference surface) for each county, whereas 
WISCRS uses GRS 80 as the single reference ellipsoid for all individual coordinate systems.

Vertical differences

There is no difference in elevations between WCCS and WISCRS. It is a horizontal system only. See 
Version updates for elevation version updates from NGS.

Horizontal differences

Except for Jackson County, there is negligible difference between WCCS coordinates and WISCRS 
coordinates. The goal of the WISCRS system is to replicate WCCS coordinates (from lat/long) using a 
‘simpler' mathematical method. The vast majority of ‘differences' between WCCS and WISCRS (over 
97%) are less than 3 mm (0.010') and there are no differences of over 5 mm (0.016').
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Jackson County WISCRS (Transverse Mercator) is a completely different projection than WCCS (Lam-
bert Conformal Conic), so the user will get radically different coordinates from the same lat/long.

What coordinate system should I use for Jackson County?

Please note that only the WISCRS Jackson County coordinate projection is to be used for new 
WisDOT projects.  Do not use the WCCS Jackson County coordinate system for new projects.  The 
WCCS Jackson County coordinates have been retained for legacy projects.  Refer to FDM 9-20-28 Wis-
consin Coordinate Reference System for more information.

Resources:
FDM Section 9-20 Spatial Reference Systems

Wisconsin State Cartographer's Office – Coordinate Reference Systems

WisDOT Civil 3D coordinate system action summary
Last updated: 2023-05-17

Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 
2018 has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is 
needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, 
Wisconsin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

Introduction
In late 2016 it was discovered that project survey data was being transformed when coordinate sys-
tems were not being used uniformly throughout a Civil 3D project.  This transformation occurs when 
the coordinate system selected for a LandXML import differs from the coordinate system assign-
ment for a survey database.  The transformation also occurs when data from a survey database is 
inserted into a dwg file that has a coordinate system assignment different from the survey database.  
For more information on the issue and what can be done to identify and resolve the issue refer the 
following C3DKB topics:

 l "Wisconsin coordinate projection issue - XML/SDB" on page 116
 l "Wisconsin coordinate projection issue - SDB/DWG" on page 120

The WisDOT Methods Development Unit and Surveying and Mapping Section has coordinated with 
Autodesk to identify the source of the unintended transformations.  The source of the unintended 
transformations depends on the coordinate systems that are selected.
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Issue #1

Civil 3D is shipped with a coordinate system category called "USA, Wisconsin".  This category of 
coordinate systems includes two series of Wisconsin County coordinate systems.  Examples:

Figure 1:  Original Civil 3D prepackaged coordinate systems used HPGN datum (NAD 83/1991)
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Figure 2:  Autodesk later introduced coordinate systems that use state-specific HARN datums (NAD 83/1991)
While these two systems have different datum assignments (HPGN vs HARN/WI), the two datums are 
equivalent, both based on NAD83(1991), and only differ by name.  However, it was discovered that 
the transformation definitions into and out of these two datums are not equivalent in Civil 3D.  In the 
example above, the transformation definition into and out of the "Wisconsin Ashland, US FT (or use 
HARN/WI.AshlandWI-F)" is based on a series of grid files for every state.  Civil 3D processes the grid 
files in an order defined by the transformation definition.  Since the grid files overlap, and the Wis-
consin grid file is near the bottom of the list, the transformations often occur based on another 
states grid file.  Therefore, this transformation definition is not correct.  For the "Wisconsin County Sys-
tems: Ashland County, US Foot" example, the transformation definition is correctly defined by a 
single grid file specific to Wisconsin.

Issue #2

In 2016, WisDOT deployed its own set of coordinate systems in Civil 3D.  These systems are organized 
in categories that begin with "WisDOT".  Within these categories, there are two county systems, 
"WCCS" and "WisCRS".  Each of these coordinate systems, regardless of which "WisDOT" category 
they fall into, are defined by the Civil 3D NAD83 datum.  The NAD83 datum in Civil 3D is based on the 
1986 adjustment year.
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Figure 3:  In 2016, WisDOT introduced coordinate systems using the Civil 3D NAD83 datum (NAD 83/1986)
Since the coordinate systems located in the "USA, Wisconsin" category use Civil 3D datums based on 
the 1991 adjustment year of NAD 83 and the coordinate systems that WisDOT provided in the 
"WisDOT..." categories are based on the 1986 adjustment year of NAD 83, a transformation occurs 
when moving data between these systems.

End-user prevention of unintended transformations
WisDOT recommends that project teams immediately stop assigning a coordinate system to the sur-
vey database and associated LandXML files.  The absence of a coordinate system assignment will 
assure that an unintended transformation does not occur in dwg files receiving the survey data.  Dwg 
files can still have a coordinate system assignment without the risk of an unintended transformation.

Action taken by WisDOT to prevent unintended transformations

Action #1:  Modify Civil 3D transformation definitions

This action addresses Issue #1, the incorrect transformation between the two County systems 
provided in the USA, Wisconsin category of Civil 3D. To accomplish this, the "NAD83_to_HPGN 
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transformation definition in Civil 3D has been modified so the Wisconsin grid file is moved to the top 
of the list and therefore processed first.

Figure 4:  Grid files are processed based on the order shown in the Geodetic Transformation

Action #2:  Set all "WisDOT" coordinate systems to the HARN/WI datum

By setting the "WisDOT" coordinate systems to use the HARN/WI datum in Civil 3D, it will assure they 
match the Wisconsin County coordinate systems included in the USA, Wisconsin category.  Unin-
tended transformations would no longer occur between the WisDOT coordinate systems and the 
USA, Wisconsin coordinate systems because they would have the same datum.

Action #3:  Eliminate the current WisDOT coordinate system naming convention

The naming convention deployed in 2016 for the WisDOT coordinate systems was designed so that 
the adjustment year of the collected survey could be documented in the dwg file.

Figure 5:  2016 WisDOT coordinate system naming convention includes adjustment year as metadata
WisDOT has removed that metadata from the name and provided a single set of coordinate systems 
based on NAD 83 (1991), building upon Action #2.  All names indicate that the coordinate system is 
based on NAD 83 (1991), so there is no uncertainty for the user.
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Figure 6:  Sample WisDOT coordinate system naming and structure

Action #4:  Remove FDM 19-10-43.4.1 requirement to assign coordinate system to 
all dwg files

FDM 19-10-43.4.1 states that "The coordinate projection used for the project shall be set on all 
DWGs."  This requirement has been removed.  This will lessen the likelihood of unintended trans-
formations of data. However, users still have the option to assign a coordinate system to dwg files.  
There are situations where that needs to be done, such as for the Bing Map functionality in Civil 3D.

Frequently asked questions

Should I remove or change the coordinate system assigned to my DWG files?

This is not necessary.  The old "2016 version" of the WisDOT coordinate systems is still present in the 
WisDOT customization files.  They have been modified to use the HARN/WI datum to match the 
coordinate systems in the "USA Wisconsin" category.  Moving forward, please use the coordinate sys-
tems under the "WisDOT" category located at the bottom of the Categories list.

Where did the old "2016 version" of the WisDOT coordinate systems go?

They are not located in the "Obsolete Coordinate Systems" category so they are present for legacy 
data.  Moving forward, please discontinue using these coordinate sytems.

Transform projection of different object types
Last updated: 2022-02-14

Total video time: 28:12
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Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 
2018 has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is 
needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, 
Wisconsin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

AutoCAD objects

prj-trnsfrm-prjctn-dffrnt-objct-01.mp4 6:41

This will show the steps to transform a project from one coordinate system to another. This project 
straddles two counties; here we will transform the coordinates from one county system to the neigh-
boring one. The topo file is primarily made up of AutoCAD objects such as lines, arcs, polylines... 
They may contain intelligent objects like survey figures or COGO points but those will have to be 
transformed by another process either by exploding them down to AutoCAD objects or using the sur-
vey database.

 1. Set the file to the coordinate system it is currently in
 A.  Application menu dropdown > Drawing Utilities > Drawing Settings > Units and 

Zone
 I. Categories: WisDOT

 II. Available coordinate systems: WISCRS-Vilas NAD 83 (1991)-USF
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 B. Save and Close
 2. Open a new drawing and set coordinates

 A.  Application menu dropdown > Drawing Utilities > Drawing Settings > Units and 
Zone

 I. Categories: WisDOT
 II. Available coordinate systems: WISCRS-Oneida NAD 83 (1991)-USF
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 B. Save As: TopoEx-Oneida.dwg
 3. MAPWSPACE > Task Pane <On> Map Explorer tab
 4. Make sure source drawing is closed.
 5. Right Click Drawings > Attach > Navigate to the other drawing > Add > OK

Info: If the drawing you want to attach is on a drive other than the C: drive you will 
have to create alias:
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 6. Right click Current Query > Define > Location > All > OK
 7. Query Mode > Draw > Execute Query
 8. Zoom Extents to see everything has been brought in
 9. In the Geolocation tab turn on the Bing Aerial map to make sure objects are lining up with the 

coordinate system
 10. Detach the drawing now that all the data is in the current drawing

Survey figures

prj-trnsfrm-prjctn-dffrnt-objct-02.mp4 2:12

Moving Survey Figures requires a different method than transforming AutoCAD objects.

 1. In the source drawing set the coordinate system

 A.  Application menu dropdown > Drawing Utilities > Drawing Settings > Units and 
Zone

 I. Categories: WisDOT
 II. Available coordinate systems: WISCRS-Vilas NAD 83 (1991)-USF
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 2. In the destination file: Survey database > Figures > highlight the figures to insert > right 
click > Insert

 3. Save

Survey database points

prj-trnsfrm-prjctn-dffrnt-objct-03.mp4 1:50

There are multiple ways to transfer points from one coordinate system to another system. If the 
points are in the survey data base and the data base is assigned to a coordinate system:

 1. Start a new drawing
 2. Assign the new drawing to a coordinate system
 3. Survey Database > Survey Points > Points > Insert into drawing
 4. Load in Bing maps to check if the points landed in the desired location

Civil 3D points

prj-trnsfrm-prjctn-dffrnt-objct-04.mp4 4:56

There are multiple ways to transfer points from one coordinate system to another system. If the 
points are not in a survey database, export the points to a file:
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 1. Settings tab > Point > Point File Formats > Select Autodesk Uploadable File > right click 
and Copy

 2. Name it: AUF-Oneida county (File type- Location)
 3. Check Coordinate zone transform

 A. Category: WisDOT 
 B. Coordinate system: WISCRS-Oneida NAD 83 (1991)-USF

 4. Change Northing and Easting to Grid Northing and Grid Easting > OK > OK
 5. Output tab > Export Points

 A. Format: AUF Oneida
 B. Destination File: Points-Oneida.auf (In the Survey folder)
 C. Check box: Do Coordination if Possible
 D. OK

 6. Start a new drawing and assign the new coordinate system

 A.  Application menu dropdown > Drawing Utilities > Drawing Settings > Units and 
Zone

 I. Categories: WisDOT
 II. Available coordinate systems: WISCRS-Oneida NAD 83 (1991)-USF

 B. Save As: TopoEx-Oneida.dwg
 7. Import tab > Points from File

 A. Autodesk Uploadable file format
 B. Points: Points-Oneida.auf
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 C. Uncheck: Do coordinate transformation if possible 
 D. OK
 E. Load in the Aerial map to check if the points have transformed into the correct loc-

ation

Surfaces

prj-trnsfrm-prjctn-dffrnt-objct-05.mp4 6:18

The IMX file format is used to exchange data between Civil 3D and Infraworks; it can also be use as a 
medium to translate the data from one coordinate system to another. The IMX file will import and 
export surfaces, alignments and pipe networks.

 1. IMX_EXPORT > Save Drawing?- Yes > Confirm Path > Version 2.1 > Enter
 2. Open new drawing > Save As: Surf-Ex-Oneida-2018 dwg
 3. Set the coordinate system

 A. Application menu dropdown > Drawing Utilities > Drawing Settings > Units and 
Zone

 I. Categories: WisDOT
 II. Available coordinate systems: WISCRS-Oneida NAD 83 (1991)-USF

 B. IMX_IMPORT > Surf-Ex-Vilas-2018 dwg > Open
 C. Open the Aerial image to check if the surface is in the correct location

Surfaces, dynamic connection between IMX and DWG
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prj-trnsfrm-prjctn-dffrnt-objct-06.mp4 2:00

 

A dynamic connection can be maintained between the translated surface and the original surface. To 
update any changes:

 1. In the source drawing Export_IMX
 2. Confirm the destination, IMX version and overwrite the file
 3. In the destination drawing Prospector tab > Surfaces > EXIST > 

 A. Right click Remove Snapshot 
 B. Right click Rebuild surface

Alignments

prj-trnsfrm-prjctn-dffrnt-objct-07.mp4 4:15

Transforming Alignments from one coordinate system to another is done in much the same way as 
transforming surfaces.

 1. IMX_EXPORT > Save Drawing?- Yes > Confirm Path > Version 2.1 > Enter
 2. Open new drawing > Save As: AliProf-Oneida-2018 dwg
 3. Set the coordinate system

 A.  Application menu dropdown > Drawing Utilities > Drawing Settings > Units and 
Zone

 I. Categories: WisDOT
 II. Available coordinate systems: WISCRS-Oneida NAD 83 (1991)-USF
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 B. IMX_IMPORT > AliProf-Vilas-2018 dwg > Open
 C. Open the Aerial image to check if the surface is in the correct location
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File/software management
Civil 3D install and initialize process (WisDOT only)
Last updated: 2022-08-30

WisDOT only: This topic is for internal WisDOT users only.

Total video time: 4:26

Installing the Civil 3D application (WisDOT staff) #install-app-staff

Warnings: 
If, for any reason, any of the process does not complete all the way through to the end of the 
defined process, contact CAE Support.  Do not restart the process from the beginning.

VERIFY BEFORE CONTINUING: If installing multiple versions of Civil 3D, install order matters. 
Civil 3D 2016 must be installed prior to Civil 3D 2022.  If a previous version of Civil 3D is 
needed after a more recent version has already been installed, the more recent version must 
be uninstalled before installing the previous version.  Installing in the reverse order damages 
the Civil 3D installs severely, likely leading to a machine reimage.

VERIFY BEFORE CONTINUING: User should request the following installs through the DOT IT 
Service Portal:

 l New and rebuilt devices
 l Devices without a version of Civil 3D installed
 l Devices that require Civil 3D 2016 installed first

Devices that fail to install Civil 3D using Software Center, described in this section, will need to 
contact IT support staff so they can install Civil 3D from the local distribution point.

Civil 3D Software Center installation

All devices that currently have a version of Civil 3D installed, can use Software Center to install  Civil 
3D 2022. This can be done by the user without assistance from IT support staff.

Prepare for the installation

 1. Print this document. Since the install process restarts the computer and the WisDOT custom 
configuration install begins as soon as you log in, it is recommended to have a hard copy of 
this document for you to reference.

 2. Close any important work prior to following the rest of these instruction.  The final process for 
the install requires Windows to restart. There is not much time to save work once you receive 
the Windows restart warning message.  The install is expected to take up to 30-45 minutes.

 3. Reboot your computer.  Reboot your computer before attempting an installation of Civil 3D.  
This assures there are no other pending reboots from other application installs or updates.
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fil-sftwr-mgt-wisdot-c3d-instl-01.mp4 1:41

Begin installation

 4. Open the Software Center
 A. From the Windows Search Bar, Type Software Center
 B. or Start > Microsoft System Center > Software Center
 C. In the Software Center Applications, select Civil 3D 20XX
 D. Install

 5. Civil 3D 20XX will begin to install.
 A. At first it will download the Civil 3D package.  This might sit at 0% for some time, even 

though it is working.
 B. Once the download is complete, the installation process will begin.  This is estimated 

to take 30-45 minutes.
 6. Once complete, an Update WisDOT Civil 3D icon will be on the desktop.
 7. The final step of the installation process requires Windows to be restarted. A warning mes-

sage will appear briefly to notify you Windows will restart. Please allow the restart to occur.
 8. After the restart, installation can be verified in the log file.

 A. In File Explorer, navigate to C:\tagfiles\Civil 3D 20XX.log and open it.
 B. Scroll towards the bottom of the file. Look for the string "Should report to SCCM as suc-

cess." This indicates a successful installation.
 9. If Software Center indicates that the installation has failed, restart your computer and retry  

the installation in Software Center.  If it still fails, contact the IT Service Desk.

Installing the Civil 3D application (WisDOT IT support)
BITS staff will need to review their own application installation documentation to install the Autodesk 
Civil 3D application.

Installing the WisDOT Civil 3D standards (WisDOT IT support)
Information about how to initialize the WisDOT add-on configuration is provided here in full detail 
for the user to perform.  The initialization and configuration process are automated with a com-
bination of a login script, Group policy and an update app that is all included in the Civil 3D install-
ation package.

The IT staff performing the Civil 3D installation have no post install processes that need to be com-
pleted.

Initialize and configure Civil 3D (WisDOT staff) #Initialize

fil-sftwr-mgt-wisdot-c3d-instl-02.mp4 2:44
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 1. Requirement: This process requires the device to be connected in a DOT office (recom-
mended) or connected remotely through VPN.

 2. After the computer has restarted, log in as the intended Civil 3D user.
 3. A short time after the desktop is displayed, the Update WisDOT Civil 3D system tray applic-

ation will display a notification.

 A. Tip: Drag the icon from the hidden icons area onto the taskbar so it is visible at 
all times.

 B. Set up Civil 3D by Right-click Civil 3D Update icon > Run Update

 4. Civil 3D will initialize for the first time.
 5. WisDOT standards files will be downloaded and installed to the computer. During the update 

process Civil 3D will open and close briefly.  Do not interrupt. A notification will appear when 
the configuration is complete.

 6. Verify that the Civil 3D 20XX WisDOT and WisDOT Civil 3D Apps icons exist on the desktop.
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 7. Open Civil 3D by double clicking the Civil 3D 20XX WisDOT icon. If Civil 3D does not launch, 
apply group policies. From the Windows search bar, type gpudpate /force Enter.

 8. If you receive the following dialog box, select Always reassociate DWG files with AutoCAD.

 9. Once Civil 3D opens, verify that the WisDOT ribbon is loaded in the workspace. Civil 3D 20XX 
opens at the Start tab so a dwg must be opened first to see the ribbon. Start tab > New > 
design-start.dwt.

 10. When the first drawing is opened, a welcome message may appear. Click Don't show this 
again.
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 11. Civil 3D is now ready to use.

 l The Update WisDOT Civil 3D application will check for updates every 4 hours.

Right-click Civil 3D Update icon > Check Now will manually check for updates at anytime. 

 l Right-click Civil 3D Update icon > Settings > Reset Profile on Update will reset the Civil 
3D user profile when running an update.

 l Right-click Civil 3D Update icon > Help > Reset Civil 3D will reset Civil 3D to factory 
defaults and re-install the WisDOT Civil 3D configuration. 

Configuration is complete. Contact CAE Support for any questions.

"Civil 3D 2022 add-ons" on page 2035

Installing and Initializing Autodesk Storm and Sanitary Ana-
lysis   (WisDOT only)
Last updated: 2022-08-30

Install SSA
Autodesk Storm and Sanitary Analysis (SSA) is available for WisDOT staff on Software Center if Civil 
3D is installed. Access Software Center in the search/start menu of Windows.
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Initialize SSA
Prior to installing the WisDOT custom SSA files, SSA must be initialized.  To initialize, open Autodesk 
Storm and Sanitary Analysis 20XX from the desktop. Once SSA opens, close the application.

Install WisDOT custom SSA files

Use the Update WisDOT Civil 3D application to install the WisDOT custom SSA files.

 1. From the windows system tray, locate the Update WisDOT Civil 3D icon. 

 A. Right-click Civil 3D Update icon > Run Update

 2. The WisDOT Civil 3D and SSA standards files will be downloaded and installed to the com-
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puter. A notification will appear when the configuration is complete.

Repair SSA install
If SSA is installed and the WisDOT update has been installed prior to running SSA, a corrupt install 
message will most likely appear when SSA is opened.

To Repair:

 1. Navigate to C:\ProgramData\Autodesk\SSA 2022
 2. Delete the Database folder
 3. From the Desktop, run Autodesk Storm and Sanitary Analysis 20XX
 4. Once SSA opens, close the application.
 5. Install the latest WisDOT Civil 3D Standards

 A. From the windows system tray, locate the Update WisDOT Civil 3D icon.
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 I. Right-click Civil 3D Update icon > Run Update

 B. The WisDOT Civil 3D and SSA standards files will be downloaded and installed to the 
computer.

 6. From the Desktop, run Autodesk Storm and Sanitary Analysis 20XX. The errors should be 
resolved.

Update WisDOT Civil 3D desktop application
Last updated: 2022-12-08

Warning: The following instructions are for consultant installation and are not to be used to 
install on any internal WisDOT device.

WisDOT offers a single desktop application “Update WisDOT Civil 3D” to receive the latest Civil 3D 
standards package for WisDOT staff and consultant users.

All versions of the application after the Update WisDOT Civil 3D ver 2022.6.0.6 may be installed 
without the need to uninstall the previous version.

Legacy standards packages will still be available for version 2016 through a request to sup-
port.cae@dot.wi.gov

Warning: Autodesk Civil 3D is required to be fully installed, configured and initialized (opened 
once) prior to installing and running the Update WisDOT Civil 3D desktop app. If installed, 
Storm Sewer Analysis is also required to be initialized. The Update WisDOT Civil 3D desktop 
app does not install any Autodesk Civil 3D applications, updates, or extensions. The app 
deploys WisDOT standards files to be used when running Civil 3D.

Download the install file

Consultants can download the Update WisDOT Civil 3D desktop app Update WisDOT C3D_ver 
20XX.x.x.x.msi from: https://wisconsindot.gov/Pages/doing-bus/eng-consultants/cnslt-
rsrces/tools/cad/civil-3d.aspx

Warning: All previous versions of WisDOT Updater and/or Downloader must be uninstalled 
prior to installing the Update WisDOT Civil 3D_ver 20XX.x.x.x.msi. The install will remove all 
files for all versions of Civil 3D that have been previously installed in C:\WisDOT\Stnd, except 
for the temp and users folders and all previous download packages in C:\WisDOT\Downloads.

What Civil 3D product versions does the Update WisDOT Civil 3D desktop app 
support?

Info: WisDOT recommends switching all projects to Civil 3D 2022 unless the project is using 
Civil 3D 2016.
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The Update WisDOT Civil 3D desktop app currently supports updates the following Civil 3D ver-
sions:

 l 2018
 l 2020
 l 2022

Guide documents

 l Update WisDOT C3D - User's Guide.pdf

 l Update WisDOT C3D - Installation and Administrator's Guide.pdf

Deployment and server installation options
For information on customized deployments of the Update WisDOT Civil 3D app contact: sup-
port.cae@dot.wi.gov

What to know about switching between starting Civil 3D with the 
WisDOT settings and starting with any other settings (Consultant) 
#what

Info: WisDOT has retired the Enable/Disable switch in the WisDOT Civil 3D Apps for all ver-
sions after Civil 3D 2016. The new process is built into the WisDOT plugin and functions during 
the Civil 3D startup.

How switching between WisDOT settings and other settings works #switch

The Civil 3D 202X WisDOT desktop shortcut launches Civil 3D using the WisDOT settings profile.  The 
startup process verifies that the current profile is the WisDOT profile. If the current profile is the 
WisDOT profile, then the WisDOT workspace is loaded. If Civil 3D is launched with a different short-
cut, the WisDOT settings profile is not current and the WisDOT workspace is not loaded.

When opening Civil 3D without using the WisDOT desktop icon

When opening Civil 3D without using the WisDOT desktop icon Civil 3D may show prompts request-
ing actions on running or not running WisDOT tools (dll).  It is recommended that the user allows 
theC:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll to 
always be loaded. This will allow the tool to recognize if Civil 3D was started using a different profile 
and it will then not load the WisDOT configuration and profile.

Troubleshooting ribbons/palettes/C3D profile problems
Last updated: 2022-03-08

Civil 3D uses user profiles in the software to manage the software interface. Sometimes these pro-
files can be accidentally deleted or broken.

This can manifest as missing portions or entire tabs or tool palettes.
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Beta installer testers (consultants only): Uninstall beta Updater and 
install current Updater
If you were running a beta version of the Update WisDOT Civil 3D desktop app, that app needs to be 
uninstalled and then the production version installed.

 1. Make sure Civil 3D is closed.
 2. Windows Start > Settings Gear > Apps

 A. Search for Update WisDOT C3D
 B. Uninstall

 3. Install production MSI from Civil 3D file descriptions (wisconsindot.gov)

Open Civil 3D with WisDOT Desktop shortcut.

If things are still incorrect,

Reset WisDOT Civil 3D profile
 1. Open Civil 3D with WisDOT Desktop shortcut.
 2. WisDOT [***] tab >  Manage Panel > Workspace pulldown > Workspace - Reset WisDOT 

Profile
 3. If you have customizations to retrieve, WisDOT [***] tab > Manage Panel > Workspace 

pulldown > Workspace - Restore User Settings

If things are still incorrect,

Reset Civil 3D Settings to default
 1. Make sure Civil 3D is closed.
 2. Windows Start > Autodesk Civil 3D 20XX - English > Reset Settings to Default
 3. Select “Reset custom settings"

 4.               AutoCAD will open as part of the process. Once AutoCAD is finished opening, close AutoCAD.
 5.         Open Civil 3D 20XX using the Imperial shortcut.

Page: 216

Published on: 5/17/2023

Beta installer testers (consultants only): Uninstall beta Updater and install current Updater

https://wisconsindot.gov/Pages/doing-bus/eng-consultants/cnslt-rsrces/tools/cad/civil-3d.aspx
c3d/wisdot-cstm/c3d-tab/shr/shr-mng-wrkspc-imprt-wisdot.htm
c3d/wisdot-cstm/c3d-tab/shr/shr-mng-wrkspc-imprt-wisdot.htm
../../../../../../Content/c3d/wisdot-cstm/c3d-tab/shr/shr-mng-wrkspc-restor-usr-sttng.htm


Windows Start > Autodesk Civil 3D 20XX - English > Civil 3D 20XX Imperial Once Civil 3D 
is finished opening, Close Civil 3D.

Tip: Opening the Imperial version ensures the default profile and workspace are fully 
integrated, prior to assigning the workspace to the wisdot profile.

 6.         Open Civil 3D 20XX WisDOT using the desktop icon.

Fatal error on open, reset Civil 3D
Last updated: 2020-10-26

Issue
Civil 3D 2018 may crash with a "Fatal Error" message.  When re-opening Civil 3D, the "Fatal Error" 
message returns, even with computer restarts and re-opening of Civil 3D.

Solution
 1. Close Civil 3D, if open.
 2. Start > Autodesk AutoCAD Civil 3D 2018 > Reset Settings to Default
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 3. Reset Settings - Backup dialog box > Reset custom settings
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 4. OK after settings have been reset.

 5. Autodesk AutoCAD Civil 3D  will begin an initialization process. Once it completes, AutoCAD 
will open.  Do not interrupt this process.

 6. Once AutoCAD opens completely, close the application.
 7. From the desktop, Update WisDOT C3D

 A. Click the checkbox next to the version to be updated
 B. Deploy
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 8. Let the Civil 3D update process complete.
 9. From the desktop, Civil 3D WisDOT

 10. Once the application opens, WisDOT Tab > Support panel drop-down > Refresh / Con-
figure System Profile

 A. Civil 3D will close.
 11. Re-open Civil 3D WisDOT. The application is ready to use.

When Civil 3D locks up or crashes
Last updated: 2015-06-03

Restart procedure
Follow these steps to restart your session:

 1. You may first need to use the Task Manager to end the current session of Civil 3D.
 2. Make sure all sessions of Civil 3D are closed.
 3. Restart Civil 3D using the Civil_3D_2014_WisDOT icon on the desktop.
 4. Once Civil 3D has completed the initialization startup process the Drawing Recovery Manager 

should be open. 
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 o If the Drawing Recovery Manager does not open go to the Drawing Utilities in the File 
pull-down menu and select Open the Drawing Recovery Manager
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 5. Select every file or file grouping in the recovery pane, use the right-mouse-click menu, and 
delete.

 o There should be no need to keep this list populated. Ignoring this step because you do 
not know where the other drawings in the list came from is meaningless. If you do not 
know, who does? These are specific to your computer user profile. 

 6. After you have deleted all the files and groupings listed, or if there were no files listed, close 
the Drawing Recovery Manager by pressing the X.

 7. Close Civil 3D. Make sure all sessions of Civil 3D are closed.
 8. Open the Windows Browser and type %temp% in the path field.

 o This will set the path to your local user folder.
 9. Select all the files in this folder and delete them. If you get a message that a file cannot be 

deleted, select the option to skip the file.
 o Browse to C:\WisDOT\Stnd\Temp, then select all the files in this folder and delete 

them
 o Optionally for the two previous steps, if you have the ClearAutodeskCache tool on 

your desktop or in C:\WisDOT\Stnd\C3D2014\Appdata\Profiles\Shortcut use this 
tool. It will do the previous step automatically.

 10. Empty the Recycle Bin, after verifying any other files already in the trash are not needed.
 11. Open Civil 3D.
 12. At the Command Line key-in RECOVER. In the dialog that appears, select the last current draw-

ing you were in when Civil 3D locked or crashed, and choose open.
 13. Save the drawing once recovery is finished.
 14. Repeat the last two steps one at a time for each drawing that may have been opened when 

the lock or crash occurred.
 15. If the original drawing had xrefs attached to it, review the source drawing of each xref to 

ensure they can be opened by repeating the steps 12 and 13 on these drawings.
If you experience a crash again at any point through these steps, start from the beginning of these 
steps. If you are still experiencing frequent crashes, contact DOT CAE Support at  DOTCAESup-
port@dot.wi.gov

You should now be able to work on your drawing again. Choosing to not work through these steps 
lessens your ability to be productive.

How to fix damaged or corrupt drawings
Last updated: 2016-03-10

Issue
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Your AutoCAD drawing file (. dwg) has become damaged or corrupt in some way, showing one or 
more of the following symptoms: 

 l File will not open.
 l File hangs or crashes AutoCAD.
 l Slow performance when editing and manipulating the file.
 l Error message when opening or when working in the file.
 l Some commands do not work or have a considerable delay.
 l Unexplained file size increase.
 l Display/regen problems.
 l Drawing elements missing.

Causes
 l Third-party applications running inside AutoCAD.
 l DWG files created or saved by non-Autodesk or non-RealDWG products.
 l AutoCAD terminated/crashed while saving the drawing.
 l Old drawings used repeatedly over the course of years.
 l Network anomalies (transmission errors, file locking, latent writing of data).
 l Storage media degradation (bad sectors on a hard drive).
 l Defective or failing RAM.
 l Operating system issues.
 l Power surges.
 l Referenced object(s) drawing file corrupt, or modified to create data reference errors.

Solution
Use the following guidelines and instructions to clean, repair, and recover your drawing. 

If the drawing file (DWG) will not open at all:

Your drawing may show the message Drawing file is not valid, display a message about errors being 
found, hang or crash during the open process, or simply may not appear in AutoCAD after you have 
selected to open it (i.e., you open it but all you ever see is the default "Drawing1.dwg" or another file 
that you currently have open).

Refer to Error: "Drawing file is not valid" when opening a file in AutoCAD if you receive the Drawing 
file is not valid error when opening the DWG file.

The first possibility is that you might have leftover .dwl or .dwl2 files in the folder directory. These 
are two hidden files that have the same name as the .dwg file but with the extensions .dwl and
 .dwl2. To remove these files use the following steps:

 1. In the Windows Control Panel, go to Folder Options.
 2. On the View tab, turn on the option to show hidden files.
 3. Go back to the folder directory and delete the .dwl & .dwl2 files found alongside your DWG 

file.
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Tips: Note: the previous steps can also be done using the Remove Extraneous 
Project Files tool in the WisDOT Maintenance desktop app. Once these steps 
are completed, attempt to open the DWG again.

If the drawing will still not open:

If the previous steps do not allow you to open the DWG, move on to the next set of steps. Try these 
steps one at a time. Be sure to stop and try to open the file after each step. If the file opens, there is 
no need to continue through the rest of the steps. 

 1. Open a blank DWG and run the RECOVER command. Select the problematic file. AutoCAD will 
attempt to recover the file and open it.

 2. Open a blank DWG and run the RECOVERALL command. Select the problematic file. AutoCAD 
will attempt to recover the file and open it.

 3. Copy the file to the local C-drive.  Disconnect the network drive to isolate the file from the rest 
of the project.  Try to open the file.  If the file opens, there likely a circular reference.  Identify 
and remove the circular reference.  Remap the network drive and place the file back in the 
project directory.  Open the file.

 4. Open a blank DWG and run the INSERT command. Select the problematic file and see if it will 
insert. If it does, then run EXPLODE and select the inserted block. Run AUDIT and PURGE com-
mands, and then use SAVEAS to create a new DWG.

 5. Look in the same directory where the DWG resides and see if there is a BAK file of the same 
name. If so, rename the BAK extension to DWG and see if the file can then be opened.

 6. Look in C:\Windows\Temp for files with an .sv$ extension. If any exist with a similar name to 
the corrupted DWG file, then rename the extension to DWG and see if it can then be opened.

 7. Go to your backup system and restore the file from a time before it became corrupted.

If the drawing file (DWG) opens with problems:

Perform the following steps in the order listed:

 1. Open the drawing file.
 2. Purge Registered Applications (from the command line):

 o Type -PURGE.
 o R for Regapps (registered applications), then Enter.
 o * for names to purge
 o N when asked to verify each name to be purged, then Enter.

 3. Type PURGE at the command line. With all checkboxes checked on, click Purge All.
 4. Audit and fix any errors: 

 o Type AUDIT at the command line.
 o Y for Yes to fix any errors, then Enter.

 5. Save the drawing.

If the drawing persists with problems:

Perform the following steps in the order listed:
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 1. Ensure all layers are on, thawed, and unlocked.
 2. Detach all external references (XREFs). Double-check that the xrefs do not have circular attach-

ments.
 3. Write Block all necessary information in the file out to a new drawing (from the command 

line):
 o Type WBLOCK at the command line.
 o Under Source, select Objects
 o Under Objects, click the Select objects icon.
 o Use a selection window to choose only the necessary objects from the file (do not 

simply type ALL).
 o Set file path and name, then OK.

 4. Open a new blank drawing file.
 5. Insert the file created in Step 3 (from the command line): 

 o Type INSERT at the command line.
 o Select the file.
 o Uncheck Specify On-screen and check Explode, then OK.

 6. Type PURGE at the command line. With all checkboxes checked on, click Purge All.
 7. AUDIT and fix any errors.
 8. Type SAVEAS and create a new file name.

Still having problems?

Try the following steps.  They can be done in any order, but have been listed in the order that 
Autodesk recommends. The file can be checked after each step. If the problem is resolved, you don't 
need to continue.

 1. Open a blank DWG and type RECOVER at the command line. Browse to the problematic file to 
allow AutoCAD a chance to restore the file.

 2. Type OVERKILL at the command line, and select all objects. Check or uncheck properties to 
include or ignore, then click OK.

 3. Type DELCON at the command line, and select all objects.
 4.  Type BREP and select all objects (if there are solids or surfaces in the file)
 5.  Type -SCALELISTEDIT, then R for reset, then Y for yes.
 6.  Type FILTERS, then click on the delete filters button.
 7.  The DGNPURGE tool can be run if the file size is unexpectedly very large.
 8.  Try using a different version of AutoCAD to open the drawing, such as AutoCAD 2013 vs. 

AutoCAD 2015 or plain AutoCAD vs. AutoCAD Architecture, etc. Try different computers if 
available.

 9.  Open a blank DWG, and try to attach the problematic file as an XREF. If it allows you to attach 
the file, try next to BIND it to the current file. If that works, run the repair steps listed above.

 10.  Use the SAVEAS command to save the DWG in an older file format. Attempt to open the 
newly created file.

 11.  Export the file to DXF format using the DXFOUT command. Next, open a blank DWG and use 
the DXFIN command to import the file just created.

 12.  Restore the Layout tabs: 
 o Right-Click one of the default layout tabs
 o Select From Template...
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 o Open the original file
 o Choose the layout tabs to restore. (It is recommended to do this one tab at a time, in 

case one or more layout tabs are corrupted)
 13. Move drawing objects between model and paper space. You may find that only one drawing 

space is usable in your file, although your main concern is model space: 
 o Create a new layout and if need be, create a viewport.
 o Use CHSPACE to move all the geometry to paper space.
 o Create a new drawing and use the Design Center (ADC) to move the layout from the 

damaged file into it.
 o Use CHSPACE again to move the geometry back to model space.
 o Restore the original layouts from the bad file using the Design Center.

 14. Dissect the drawing. In a copy of the file, conduct a process of elimination using QSELECT to 
select different object types and then delete them to see if that fixes what is wrong in the file. 
Do PURGE All after each deletion. Eventually you should remove the problem elements and 
then you can choose to leave them out, copy them in again from another file, recreate them, 
or further troubleshoot individual items to pinpoint exactly which one is problematic. A quick 
start to this whole process is to delete everything in the drawing and then test it. This will 
quickly tell you if the issue is with a drawing object or if it is a part of the drawing database.

 15. To eliminate all invisible DWG entities select all features that are relevant in the DWG and 
"Copy with Base Point" these via the clipboard into a new DWG. Make sure you have switched 
on all layers that contain relevant data.

Keeping drawings clean and working
Last updated: 2016-03-10

Purge
AutoCAD's PURGE command will allow you to clear out data from your AutoCAD file's database that 
isn't part of the drawing.  For example, even if you have deleted all copies of a block out of a drawing, 
its definition will still be in the drawing's database. This is the same for components of any type.

Remember to check the ‘Purge nested objects' box to clear out nested block references. AutoCAD 
has the handy option to clear out empty text and zero length lines and includes the option to purge 
empty groups.

Application menu > Drawing Utilities Panel > Purge
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Command entry: purge

Save your file after you've purged it to re-write the database before you audit. You may need to 
purge and audit a couple of times to completely clean up your DWG. Best practice is to purge your 
production files frequently as part of your housekeeping routine.
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Tips: Tip: Use the PURGE command as a detective tool to help with problem 
files. Check the ‘View items you cannot purge.

Purge regapps
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This is a command line only version of the purge command. ‘Regapps' is short for ‘Registered Applic-
ations.

AutoCAD holds a bit of memory space free for vertical products to use if they need it. If you receive 
files that could have been created with one of the AutoCAD verticals, or other third party add-ons, 
you can get back some memory space by using this command.

Type -purge at the command line, then type r and hit enter to choose Regapps. AutoCAD will 
prompt you to list the names you want to purge. Just hit enter to accept the default asterisk * which 
will select all the available regapps. Now type N and hit enter so you don't have to verify each regapp 
to be purged.

AutoCAD will recreate any regapps memory space it needs should the file be re-opened by an 
AutoCAD vertical, so this won't cause anyone problems down the line.

Tips: Note: If you created a backup copy of your file, compare the file size 
now. You should notice that it is substantially reduced.

 

Audit
AutoCAD's AUDIT command inspects the drawing file's database for errors. Type AUDIT at the com-
mand line, Type Y to fix errors and then hit the F2 key to see what AutoCAD has done to your file. 
Save your file before you run the purge command again.

You may need to run the Purge – save and Audit – save commands a few times to completely optim-
ize your file.

Go easy on explodes
If you receive a drawing from a third party, don't be tempted to explode all their blocks. This can be a 
really bad idea. If there is more than one copy of each block in the drawing then the blocks will actu-
ally be saving memory.
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If you suspect a block is causing a problem, copy it out into a blank file and explode it. Then follow 
the advice below on the new file. Carefully rebuild the block and then replace or re-define the block 
in the original drawing.

Be careful that you don't explode a dynamic block. The dynamic properties of the block may not be 
able to resolve themselves and this may corrupt your DWG. If you need to explode a simple dynamic 
block, make sure that the Dwg Clean tool or purge and audit are completed on the drawing prior to 
continuing and saving the drawing.

Delete unused geometry
If you need to make a change to your drawing, it can be tempting to copy the old detail to one side 
‘just in case'. This is all additional data that AutoCAD needs to manage. If you end up with a lot of 
unnecessary, old or out-dated geometry, create an archive copy of the AutoCAD DWG file and delete 
your intermediate work from your working DWG file.

When working with Civil 3D objects, be sure to name alternatives uniquely, even if they represent the 
same thing.  Also, keep track of data shortcuts and data references to be sure you are using the 
intended alternatives in downstream drawings.

When deleting Civil 3D objects, pay attention to dependencies.  Start by deleting children and then 
move on to the parent objects.  For example, an alignment needs to be deleted, but there are several 
profiles and offset alignments associated with that alignment.  Start by deleting the profiles and off-
set alignments.  Then delete the parent alignment.  Another example is deleting a corridor with cor-
ridor surfaces.  Start by deleting the corridor surface from the corridor surface dialogue within the 
corridor properties.  Then, delete the corridor object.  If the option is available, delete a Civil 3D 
object from the dialogue it was created whenever possible.

Tips: Note: A quick way to delete all unnecessary objects from your drawing 
file is to hit CTRL+A (select all), then hold down the Shift key whilst de-select-
ing what you want to keep. Now hit delete. Poof!  All unused data will be 
gone.

Find Invisible objects
There are a number of objects that could be effecting your DWG's file size – that aren't always visible. 
This could include empty text strings, points and blocks that contain only invisible attributes.

To pick up points, type DDPTYPE at the command line to change the size and style of points in your 
drawing. You can now delete what you don't need.

To find empty text strings, type QTEXTMODE at the command, set the value to 1 and perform a 
regen. This will replace all the text strings in your drawing with bounding boxes. You can now hunt 
down and delete any empty text boxes. Set qtextmode back to 0 when you are done to put your 
text back to normal.
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Tips: Note: AutoCAD has the option to purge empty text strings in the 
‘PURGE' dialogue – see below.

 

To find Block definitions that contain Invisible attributes, type ATTDISP at the command line, and set 
attribute display to on. You can now select and delete any previously invisible blocks that you don't 
need.

To find 3D objects with invisible faces, type SPLFRAME at the command line, and set the value to 1. 
This will reveal the shapes control polygon, allowing you to select and delete it.

It is possible to create an AutoCAD group with nothing in it. Fire up the GROUP command and 
‘explode' any groups you don't need or recognise.

Tips: Note: AutoCAD now has the option to purge empty groups – see below.
 

Finally, to find wipeouts that have their frames turned off type ‘TFRAMES' at the command line and 
hit return. This system variable toggles wipeout frames on and off.

Delete unused layers
Did you know that AutoCAD won't let you delete a layer that is in use? Open the Layer manager, 
select every Layer you don't need and hit Delete. You can't accidently delete a layer you need. This 
will get rid of a whole load of extra data that AutoCAD doesn't need to manage.

AutoCAD won't let you delete the active layer, so check which layer is active before you start. 
AutoCAD won't let you delete a layer that is frozen in a viewport – even if there are no objects on that 
layer, so check through each viewport if you have problem layers.

Use LAYMRG to merge objects to a target layer. The original layers are purged from the drawing.

Use the LAYDEL command to permanently delete any layers that you can't shake. Be careful with 
this tool – there's no going back!

Tips: Note: The system variable ‘SHOWLAYERUSAGE' puts a check mark in the 
layer dialogue by each layer that is in use. If you have lots of layers in your 
drawings, setting this to ‘0' will prevent AutoCAD from tracking ‘in use' layers, 
which will help speed things up.

Delete unused Layer filters
Now you've deleted all the layers you don't need out of your drawing, maybe you've got a whole load 
of layer filters you don't need either? The quickest way to clean out layer filters is with the FILTERS 
command. This pops up a little dialog which allows you to quickly delete unused layer filters from 
your AutoCAD DWG file.
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Tips: Note: The command is ‘FILTERS‘– not ‘FILTER'. The Filter command is like 
an Uber Quick select tool.

Check your styles
Civil 3D won't let you purge text, dimension or multi-leader styles while they are in use – even if you 
are not using the style in the drawing they may be being consumed in civil object styles or assigned 
to current styles. Check which styles are current before you purge.

Recover
The recover command is a little like the AUDIT command – only you run it before you open the prob-
lem drawing. To use the recover command, go to the application menu and choose, Drawing util-
ities > Recover. You will be prompted to pick a file.  The file will be Audited, and then opened in 
AutoCAD.

Wblock
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Wblock should only be used with native AutoCAD objects and never used with civil objects such as 
alignments, profiles, profile views, corridors, cross sections, and assemblies to name a few.

You can also try ‘WBLOCK'ing the native AutoCAD geometry you require into another drawing. The 
wblock command will only take what it needs to support what you have chosen to export from your 
drawing. This can leave corrupted elements behind. Native AutoCAD objects are things like lines, 
polylines, blocks, dimensions, ant text. Basically anything that is included in the Home ribbon, Draw 
and Modify panels can be used to Wblock.

Things that can slow performance in Civil 3D/AutoCAD
Last updated: 2020-10-26

There are many factors that contribute to overall system speed which can affect Civil 3D/AutoCAD 
performance.

 1. Hardware (CPU, hard drive, RAM, video card)
 2. Network (cable, switches, server)
 3. Operating system
 4. Software
 5. Files (number, size, objects within files, connections to other files)

The issues and solutions in this topic are not a complete list of every possible issue, but they give a 
good sampling of common issues and how to fix them.

Issue: Optimize the performance of your AutoCAD-based program in 
Windows

Solution

Follow these guidelines to improve your AutoCAD performance. Determine which of them provides 
the best results for your environment. Not all guidelines have the same effect on all systems, so test 
and compare results.

Windows environment guidelines

 l Verify that your hardware meets or exceeds AutoCAD's minimum system requirements. 
See System requirements for AutoCAD.

 l When running other applications at the same time as AutoCAD, be sure at least 2GB of RAM is 
available to AutoCAD.

 l Update your computer's graphics card driver to the latest version available. See How to 
update to the latest certified video driver.

 l Turn off all compatibility settings except for Run This Program As Administrator:

 A. File Explorer > Right-click AutoCAD executable file > Properties
 I.  Compatibility tab > Deselect all options except Run This Program As 

Administrator

 l Stop the Windows Presentation Foundation Font Cache:
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 A. Windows Start > Search for \'Services\' > Click View Local Services
 I. Services dialog box > Scroll down to Windows Presentation Foundation 

Font Cache 3.0.0.0 > Right-click > Stop

 l Delete the contents of the Windows TEMP folder. See How to delete temporary files in Win-
dows.

 l Disable your antivirus program to see if it's slowing down your AutoCAD software. If it is, set 
up antivirus exclusions. See How to set up Antivirus (AV) exclusions to improve stability and 
performance of Autodesk software.

 l Eliminate slow network performance. See Working with shared contents: eliminating slow net-
work performance (blog).

 l If you're using Windows 7, change the desktop theme to Windows Basic.

Civil 3D/AutoCAD guidelines

 l Toggle hardware acceleration on and off to see which setting improves your performance. 
See How to enable or disable hardware acceleration in AutoCAD. 

 l Download and install the latest service pack and any hotfixes for your AutoCAD software. 
See Install Updates, Add-ons, and Enhancements.

 l Options dialog > Display tab > Turn off

 A. Show Tool Tips
 B. Show Rollover Tool Tips

 l Turn off Quick Properties QPMODE set to -1
 l Remove network paths from Options dialog > Files tab > Support File Search Path.
 l Remove any third-party plugins that are installed.
 l Clean up drawings with performance issues. See How to repair corrupt AutoCAD files. Exam-

ine highly nested blocks and consider exploding and purging them. 
 l Use the UCSICON command to activate the origin in the drawing. Determine whether any 

data or XREFs are located far from the origin. If so, use the MOVE command to 
relocate the data closer to the origin. Choose coordinates close to the origin when loading 
drawings via XREF.

 l Disable one or more system variables which may impact graphics performance: See Improv-
ing AutoCAD performance with older or low-end graphics cards

Issue: Large amounts of text or hatches degrading performance
AutoCAD drawings which contain large amounts of text or hatches may degrade performance. In 
most cases this is due to older or low-end video cards, however, depending on the amount of data 
being displayed high-end graphic cards may be affected as well.

Causes

Several new system variables were introduced with AutoCAD 2015. These variables will display 
information about selection sets in the properties palette or high light objects when selected or 
hovered over. This may affect performance with some graphic cards.
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Solution

 1. Close or Autohide the Properties palette until it's needed.        
 2. Change the following variables to off within AutoCAD (type them on the command line) until 

they are needed:        

ANNOALLVISIBLE set to "0"
Hides or displays annotative objects that do not support the current annotation scale.

The ANNOALLVISIBLE setting is saved individually for model space and each layout.

NOTE: When ANNOALLVISIBLE is set to 1, annotative objects that support more than one scale will 
only display one scale representation.

Value Description

0
Only annotative objects that support the current annotation scale are dis-
played

1 All annotative objects are displayed

COMMANDPREVIEW set to "0"
Controls whether a preview of the possible outcome of the command is displayed.

NOTE: The SELECTIONPREVIEW system variable value is ignored when COMMANDPREVIEW is on.

Value Description

0 Off

1 On

DRAWORDERCTL set to "0"
Controls the default display behavior of overlapping objects when they are created or edited.

Info: Full draw order display may slow some editing operations.

Value Description

0

Turns off the default draw order of overlapping objects: after objects are 
edited, regardless of their draw order, the objects are displayed on top until a 
drawing is regenerated (REGEN) or reopened. This setting also turns off draw 
order inheritance: new objects that are created from another object using the 
commands listed below are not assigned the draw order of the original 
object. Use this setting to improve the speed of editing operations in large 
drawings. The commands that are affected by inheritance are BREAK, FILLET, 
HATCH, HATCHEDIT, EXPLODE, TRIM, JOIN, PEDIT, and OFFSET.

1 Turns on the default draw order of objects: after objects are edited, they are 
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Value Description
automatically displayed according to the correct draw order.

2
Turns on draw order inheritance: new objects created from 
another object using the commands listed above are assigned 
the draw order of the original object.

3
Provides full draw order display. Turns on the correct draw 
order of objects, and turns on draw order inheritance.

DYNMODE set to "0"
Turns Dynamic Input features on and off.

When all features are on, the context governs what is displayed.

If dynamic prompts are on ( DYNPROMPT is set to 1), they are displayed when DYNMODE is set to 1, 
2, or 3.

When DYNMODE is set to 1, 2, or 3, you can turn off all features temporarily by holding down the 
temporary override key F12

Value Description

0 All Dynamic Input features, including dynamic prompts, off

1 Pointer input on

2 Dimensional input on

3 Both pointer input and dimensional input on

ISAVEPERCENT set to "0"
Controls the amount of space allocated in DWG files for incremental saves, which affects the number 
of quick save operations that can be performed before a full save is required.

When the file save estimate exceeds the specified percentage, the next save will be a full save. Valid 
values can range from 0 to 100 percent.

 l A value of 0 means that all save operations are full saves. A full save optimizes the size of a 
DWG file, but is noticeably slower on large drawings.

 l A value of 100 increases the space available to append changes to the maximum possible. 
This value results in the greatest number of incremental quick save operations between full 
saves at the expense of larger file sizes.

Info: Saving to a different format always results in a full save.

LAYOUTREGENCTL set to "0" or "1"
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Specifies how the display list is updated in the Model tab and layout tabs.

For each tab, the display list is updated either by regenerating the drawing when you switch to that 
tab or by saving the display list to memory and regenerating only the modified objects when you 
switch to that tab.

The performance gain achieved by changing the LAYOUTREGENCTL setting is dependent on several 
factors, including the drawing size and type, the objects contained in the drawing, the amount of 
available memory, and the effect of other open drawings or applications. When LAYOUTREGENCTL is 
set to 1 or 2, the amount of additional memory used is the size of the Model tab's display list mul-
tiplied by the number of viewports in each layout for which the display list is saved.

If LAYOUTREGENCTL is set to 1 or 2 and performance seems slow in general or when you switch 
between tabs for which the display list is saved, consider changing to a setting of 0 or 1 to find the 
optimal balance for your work environment.

Regardless of the LAYOUTREGENCTL setting, if you redefine a block or undo a tab switch, the draw-
ing is regenerated the first time you switch to any tab that contains saved viewports.

Value Description

0 The drawing is regenerated each time you switch tabs.

1

For the Model tab and the last layout made current, the display list is saved to 
memory and regenerations are suppressed when you switch between the 
two tabs. For all other layouts, regenerations still occur when you switch to 
those tabs.

2

The drawing is regenerated the first time you switch to each tab. 
For the remainder of the drawing session, the display list is 
saved to memory and regenerations are suppressed when you 
switch to those tabs.

ORTHOMODE set to "0"
Constrains cursor movement to the perpendicular.

When ORTHOMODE is turned on, the cursor can move only horizontally or vertically relative to the 
UCS and the current grid rotation angle

Value Description

0 Turns off Ortho mode

1 Turns on Ortho mode

PALETTEOPAQUE set to "1"
Controls whether palettes can be made transparent.
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When transparency is available and turned on, use the Transparency option on the shortcut menu to 
set a different degree of transparency for the current palette or for all palettes.

When hardware acceleration is enabled, the settings 2 and 3 are available; when disabled, only the 
settings 0 and 1 are available.

Value Description

0 Palette transparency is turned on

1 Palette transparency is turned off

2
Transparency is turned on and is not supported by the hardware 
or operating system

3
Transparency is turned off, but is not supported by the hard-
ware or operating system

PROPERTYPREVIEW set to "0"
Controls whether you can preview the changes to currently selected objects when you roll over drop-
down lists and galleries that control properties.

Info: Property previews are displayed only from the ribbon and the Properties palette. They 
are not available from other palettes.

Value Description

0 Turns off rollover property previews

1 Displays rollover property previews

QPMODE set to "0"
Controls whether the Quick Properties palette is displayed when objects are selected.

Value Description

0
Turns off the display of the Quick Properties palette for all 
objects when they are selected in the drawing area

1
Turns on the display of the Quick Properties palette for all objects when they 
are selected in the drawing area

2
Turns on the display of Quick Properties palette, but only for 
objects that are supported in the Customize User Interface (CUI) 
editor for displaying quick properties when they are selected in 
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Value Description

the drawing area

ROLLOVERTIPS set to "0"
Controls the display of rollover tooltips when the cursor hovers over an object.

The content in tooltips can be customized in the Customize User Interface (CUI) Editor.

Value Description

0 Object rollover tooltips are not displayed

1 Object rollover tooltips are displayed

SAVEFIDELITY set to "0"
Controls the visual fidelity for annotative objects in AutoCAD 2007 and earlier.

This setting affects drawings only when saving to AutoCAD 2007 or earlier file formats.

SELECTIONCYCLING set to "0"
Controls the display options associated with overlapping objects and selection cycling.

Ctrl+W to toggle the current setting on and off.

When you roll over overlapping 2D objects, options are available to alert you and let you select 
between the objects.

Value Description

0 The display options are turned off

1 A badge displays when you hover over objects that overlap

2 Both a badge and the Selection dialog box displays

SELECTIONPREVIEW set to "0"
Controls the display of selection previewing.

Objects are highlighted when the pickbox cursor rolls over them. The highlighting indicates that the 
object would be selected if you clicked it. The setting is stored as a bitcode using the sum of the fol-
lowing values:

Info: The SELECTIONPREVIEW system variable value is ignored when COMMANDPREVIEW is 
on.

Value Description

0 Off
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Value Description

1 On when no commands are active

2 On when a command prompts for object selection

SNAPMODE set to "0"
Turns the Snap mode on and off in the current viewport. (grid snap)

Value Description

0 Off

1 On

UCSDETECT set to "0"
Controls whether dynamic UCS acquisition is active when creating objects involving 3D planar sur-
faces.

You can align the UCS dynamically when your cursor hovers over a planar face on a 3D solid, a 
planar mesh element, or a planar point cloud segment while as you create an object.

Info: Dynamic UCS alignment does not detect planar surface objects or 2D geometry.

Value Description

0 Not active

1 Active

WHIPTHREAD set to "3"
Controls whether to use an additional processor to improve the speed of operations such as ZOOM 
that redraw or regenerate the drawing.

WHIPTHREAD has no effect on single processor machines.

When multithreaded processing is used for redraw operations (value 2 or 3), the order of objects spe-
cified with the DRAWORDER command is not guaranteed to be preserved for display, but is pre-
served for plotting.

Value Description

0
No multithreaded processing; restricts regeneration and redraw 
processing to a single processor. This setting restores the beha-
vior of AutoCAD 2000 and previous releases.
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Value Description

1
Regeneration multithreaded processing only; regeneration pro-
cessing is distributed across two processors on a multiprocessor 
machine.

2
Redraw multithreaded processing only; redraw processing is dis-
tributed across two processors on a multiprocessor machine.

3
Regeneration and redraw multithreaded processing; regen-
eration and redraw processing is distributed across two pro-
cessors on a multiprocessor machine.

If you are running Windows Vista or Windows 7, try turning off Aero by setting your desktop theme 
to Windows Basic.

Issue: Damaged/corrupted dwg files
How to repair a damaged or corrupted AutoCAD drawing (.dwg) file. A drawing may have one or 
more of the following symptoms: 

 l Drawing file does not open.        
 l Drawing file opens with errors.        
 l File hangs or crashes AutoCAD.        
 l Slow performance when editing a file.        
 l Error messages appear when working in a file.        
 l Commands do not work or are delayed.        
 l Unexplained increase in file size.         
 l Display or regen problems.        
 l Drawing elements missing or shown incorrectly.        

Causes

 l Third-party software is running within AutoCAD.        
 l Non-Autodesk or non-RealDWG product created or saved the file.       
 l AutoCAD terminated while saving a drawing file, such as during a power surge or outage.        
 l Old drawings have been used repeatedly over a long time period.        
 l Network anomalies have occurred (such as transmission errors, file locking, and latent writing 

of data).        
 l Storage media has degraded (such as bad sectors on a hard drive).       
 l System RAM is failing or defective.       
 l Operating system issues exist.       

Solutions

Work through the following solutions as listed:

Page: 241

Published on: 5/17/2023

Issue: Damaged/corrupted dwg files



 l If a drawing file will open, see Optimizing the AutoCAD drawing file: Purge, Audit & Recover.       
 l If a file will not open, see Recovering drawing files which fail to open in AutoCAD.       
 l Export the file using the WBLOCK command (see Optimizing the AutoCAD drawing file: 

Wblock Purge).       
 l Remove duplicate or overlapping objects in the drawing with the OVERKILL command 

(see Using OVERKILL to remove duplicate or overlapping objects in AutoCAD).       
 l Remove excessive constraints in the drawing using the DELCONSTRAINT command (see How 

to turn off and delete constraints in AutoCAD).       
 l Remove excessive annotation scales from the drawing with the SCALELISTEDIT command 

(see Warning: "This drawing contains a large number of annotation scales" when opening a 
file in AutoCAD).       

 l Remove excessive layer filters with the FILTERS command (see How to delete layer filters in 
AutoCAD).       

Updating settings and styles in production DWG files
Last updated: 2020-10-26

Most of the settings and styles that control a DWG file are contained within the file. Updates to a tem-
plate file are not automatically brought into existing files. This topic covers the different methods for 
updating settings and styles for existing files in Civil 3D.

Civil 3D styles and drawing settings update
Use the import styles tool to update a DWG file's Civil 3D standards with those found in the latest 
WisDOT template.

 1. Open the dwg file you wish to update in Civil 3D.
 2. Manage ribbon > Styles panel > Import
 3. Browse to template file containing standards you'd like to apply to the dwg file. 

C:\WisDOT\Stnd\C3D20XX\Templates\Begin-dwg\design-wisdotxx.dwt.

 4. In the Import Civil 3D Styles dialog box, you can review new Civil 3D standards that will be 
imported. You can also choose to delete standards that are no longer in the WisDOT template 
- if they aren't in use in the drawing. You can make modifications to the import/delete actions 
if you wish. You can turn on, or off import drawing settings. Details are available in Civil 3D 
Help documents.
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 5.  OK Save the dwg file.
 6. Consider updating AutoCAD standards also.

AutoCAD standards update
Use the import styles tool to update a DWG file's AutoCAD standards with those found in the latest 
WisDOT template.

 1. Open a new drawing using the template containing the new standards you want applied to 
the project dwg file.

 2. C3D button > Save As > AutoCAD Drawing Standards. Remember where you save this 
DWS file.

 3. Open the dwg file you wish to update.
 4. Manage ribbon > CAD Standards panel > Configure
 5. In the Configure Standards dialog box, Standards tab, click the + button and browse to you 

DWS file.
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 6. In the Configure Standards dialog box, Plug-Ins tab, select the types of standards you'd like to 
update. Usually you'd check all.
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 7. Click the Settings... button. The settings should look as shown.

 8. Click Check Standards... button
 9. The tool will notify you of DWG layers that are no longer in the DWS standards file. You can 

cycle through this by clicking Next. The layer will not be deleted from the dwg file.
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 10. When the update is complete you will receive a notification with update statistics.

 11. Close the Check Standards dialog box
 12. Manage ribbon > CAD Standards panel > Configure
 13. Remove the DWS file from the drawing by clicking the X button. Click OK to close the Con-

figure Standards dialog box.
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 14. Save the DWG file.

Reset reference template
Last updated: 2020-08-04

WisDOT uses reference templates in Civil 3D 2020 and beyond to manage and update styles and set-
tings to production DWG files.

If there is a need to reset the layers, linetypes, markers for styles and textstyles back to the WisDOT 
template standards and the Add All Components tool does not do a satisfactory job in updating the 
standards, another option is provided within the reference template structure.

To do a reset of the AutoCAD base standards using the reference template use the following steps:

Warning: The ref-layer-line-marker-text template should always remain on the top of the list, 
the Load button should be unchecked and the Status should be Out of date, before and after 
following these steps.

 1. Manage tab > Styles panel > Reference (command: _AttachReferenceTemplate) Select 
ref-layer-line-marker-text template

 2. Load: checked, OK
 3. Repeat Step 1, Load: unchecked, OK
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Steps to refresh updated subassemblies in existing corridor 
files
Last updated: 2020-06-16

Sometimes a WisDOT subassembly will be updated with new functionality.

To access the new functionality, users have to replace the old subassemblies with the new ones.

Warning: If you do not need the new functionality, there is no need to replace the sub-
assemblies.

 1. If you want to change the default input parameters
 A. Find the new subassembly in the appropriate WisDOT subassembly tool palette.
 B. Right click > Properties... > Parameters to set the default input parameters.
 C. OK

 2. To replace the old subassembly with the new subassembly
 A. Tip: Before you start, document the subassembly names used in the assemblies 

and target parameters used in the corridor(s).

 B. Find the new subassembly in the appropriate WisDOT subassembly tool palette.
 C. Click the new subassembly > R enter for the replace option > click the sub-

assembly to replace in the existing assembly 
 D. Keep similar targets to retain targets for identical target parameters.
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 E. New subassemblies will have default naming. Rename subassemblies to custom 
names.

 F. Repeat for all instances of the subassembly.
 G. Rebuild corridor(s).
 H. Tip: Verify target parameters were translated completely and accurately.

Resolving Civil 3D file performance degradation (files prior 
to Nov 2016)
Last updated: 2020-06-16

Tips: 
If your project contains any files that were originally created in Civil 3D 2012, Civil 3D 2014, 
the entire project is likely suffering from some level of performance degradation.  If your pro-
ject contains files that were originally created with Civil 3D 2016 before service pack 3 was 
applied (November 2016 on WisDOT computers), the project could also be impacted.

The extent of performance degradation can vary, depending on the number of project files 
impacted and the age of the files.  Projects originating from Civil 3D 2014 or Civil 3D 2012 are 
most likely being impacted the most.  Symptoms of performance degradation include exten-
ded wait times for file open/save, and possible frequent application crashes.

The Autodesk Batch Save Utility should be used on projects that are suspected of suffering 
from performance degradation.  We have seen significant performance gains with this pro-
cess.  For example, some drawings that once took 5-10 minutes to open, now open in less 
than a minute.

 1. Exit all versions of Civil 3D.
 2. Windows Start Menu > Autodesk > Civil 3D Batch Save Utility

Page: 249

Published on: 5/17/2023

Resolving Civil 3D file performance degradation (files prior to Nov 2016)



 3. Target Civil 3D Version
 A. Choose the target Civil 3D version.  If your project is currently using Civil 3D 2016, 

choose "Civil 2016"
 4. Custom Script

 A. choose qsave.scr from the drop-down menu.  
 B. This script saves each drawing in the version of Civil 3D selected.  This is all that is 

necessary to apply the performance degradation fix to all files.  As an alternative, you 
can further clean the project drawings by selecting defaultClean.scr.  This script will 
purge reg apps, purge all, and audit each drawing in addition to saving.
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 5. Target Folders
 A. If there are any directories that you would like to exclude from the process, choose 

them by clicking Exclude Add.  However, not saving all project drawings could rein-
troduce the performance degradation if those files are affected and referenced into 
other project drawings.

 6. Skip Drawings
 A. We recommend only checking the "Read only" box.

 7. Process Settings
 A. We recommend only checking the "Timeout for a drawing" box (set to 10) and the "Pro-

cess simultaneously" box (set to 4).
 8. Start  Depending on the number of files, this process could take some time.
 9. Log to verify the batch save process was successful for all files.
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DWG TrueView installation and configuration 
Installing DWG TrueView (WisDOT only)
The DWG TrueView installation is available for all DTSD devices via Software Center.  Users can install 
DWG TrueView on their own using Software Center, or request the installation from IT support staff.  
This installation will also include Autodesk Design Review.
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Prepare for Installation

Civil 3D and/or AutoCAD must be closed when running the DWG TrueView installation.

Begin installation

 1. Open Software Center
 A. From the Windows Search Bar, Type Software Center

 B. or Start > Microsoft System Center > Software Center

 C. In Software Center Applications > Autodesk DWG TrueView 20XX
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 D. Install

 2. DWG TrueView will begin to install

 A. At first it will download the DWG TrueView package.  This might sit at 0% for some time, 
even though it is working.
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 B. Once the download is complete, the installation process will begin.
 3. Once the installation is complete, Software Center can be closed and you can begin the ini-

tialization and configuration steps for DWG TrueView

Initialize and configure DWG TrueView (WisDOT only) #init
After DWG TrueView is installed, it must be initialized and configured to properly view and plot 
WisDOT Civil 3D drawings.

 1. Run DWG TrueView by double-clicking the DWG TrueView desktop shortcut.

 2. You may receive the following dialog box.
 A. Select Always reassociate DWG files with DWG TrueView if you do not have Civil 

3D or AutoCAD installed.
 B. Select Do not associate DWG Files with DWG TrueView if you have Civil 3D or 

AutoCAD installed.

 3. Close DWG TrueView.
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 4. Apply group policies to configure DWG TrueView for proper viewing and plotting of WisDOT 
Civil 3D drawings

 A. From the Windows Search Bar, Type gpupdate /forceEnter

 5. A Windows command window will open as the group policies are applied.
 6. Once the Windows command window closes, the group policies have been applied and DWG 

TrueView is ready to use.

DWG TrueView WisDOT configuration (Consultants only)
After installing DWG TrueView, it must be configured to properly view and plot WisDOT Civil 3D draw-
ings.

 1. Run DWG TrueView by double-clicking the DWG TrueView desktop shortcut.
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 2. You may receive the following dialog box.
 A. Select Always reassociate DWG files with DWG TrueView if you do not have Civil 

3D or AutoCAD installed.
 B. Select Do not associate DWG Files with DWG TrueView if you have Civil 3D or 

AutoCAD installed.

 3. Open any dwg in DWG TrueView.
 4. Tools > Option > Files Tab Expand the Support File Search Path

 A. Add the path: C:\wisdot\stnd\c3d20XX\components\support (XX for versions 18 or 
20) to the top of the Support File Search Path

 5. Expand the and Printer Support File Path/Printer Configuration Search Path
 A. Add the path: C:\WisDOT\Stnd\C3D2020\Appdata\Plotters

 6. Expand the and Printer Support File Path/Printer Description File Search Path
 A. Add the path: C:\WisDOT\Stnd\C3D2020\Appdata\Plotters\PMPFiles

 7. Expand the and Printer Support File Path/Plot Style Table Search Path
 A. Add the path: C:\WisDOT\Stnd\C3D2020\Appdata\Plotters\PlotStyles

 8. Close DWG Trueview.

Info: Multiple search paths can be added to each of these sections to accommodate other con-
figurations that may be needed.

WisDOT AutoTURN "What's new?"
Last updated: 2021-08-10

2021-08-09
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Description: V11.0 Initial Release - Contains the same vehicles as version 10.2.

Updated files: wisdotdatabase11.zip, wisdotlibrary11.zip

2019-05-22

Description:

Added "160' x 16'" to "WisDOT" library

Moved "55 Meter Wind Blade" to "WisDOT Misc" libary and unlocked

Moved "80' Mobile Home" to "WisDOT Misc" libary and unlocked

Moved "165' Beam" to "WisDOT Misc" libary and unlocked

Moved "Combine" to "WisDOT Misc" libary and unlocked

Moved "Wind Tower 80M Mid" to "WisDOT Misc" libary and unlocked

Updated files:
wisdotdatabase102.zip, wisdotlibrary102.zip

Discontinue   wisdotdatabase101.zip, wisdotlibrary101.zip

2018-04-17

Description: V10.2 Initial Release - Contains the same vehicles as version 10.1.

Updated files: wisdotdatabase102.zip, wisdotlibrary102.zip

AutoTurn configuration
Last updated: 2020-10-28

Initialization steps
These steps apply to all versions of Civil 3D and AutoTURN

 1. Make sure Civil 3D is closed.
 2. From the Windows Start menu, select AutoTURN <version> for Autodesk AutoCAD Civil 3D 

<version> - English
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 3. After AutoTURN completely loads, close Civil 3D.  Do not do production work in this instance 
of Civil 3D.  Use the Civil_3D_<version>_WisDOT desktop icon to open a new instance of Civil 
3D to do production work.  

If AutoTURN ribbon does not appear
After opening Civil 3D using the Civil_3D_Version_WisDOT desktop link and the Autoturn Ribbon/Tab 
does not appear, complete the following steps.

 1. In the top left hand corner of Civil 3D, select the workspace drop-down and choose Drafting 
& Annotation
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 2. Once the Drafting & Annotation workspace loads, re-select the workspace drop-down and 
choose Civil 3D.

 3. The AutoTURN Ribbon should now be available.

AutoTurn: Import WisDOT vehicle libraries
Last updated: 2022-10-31

Info: This topic is for external users of the WisDOT AutoTURN customization files only. Internal 
WisDOT user installs are managed automatically.

There are two alternatives to import the WisDOT vehicle libraries. The first alternative involves 
importing each vehicle manually into the vehicle database. The second alternative involves down-
loading the complete pre-loaded vehicle database along with the associated dwg files.

Alternative 1 - Import individual vehicles
This alternative works well when only a few vehicles need to be updated on a single workstation 
because each vehicle can be imported individually.

 1. Download the wisdotlibraryXX.zip file. (XX = AutoTURN version) A link to the current version 
can be found at https://wisconsindot.gov/Pages/doing-bus/eng-consultants/cnslt-
rsrces/tools/cad/autoturn.aspx

 2. Extract the wisdotlibraryXX.zip file to a temporary location.

Page: 260

Published on: 5/17/2023

AutoTurn: Import WisDOT vehicle libraries

https://wisconsindot.gov/Pages/doing-bus/eng-consultants/cnslt-rsrces/tools/cad/autoturn.aspx
https://wisconsindot.gov/Pages/doing-bus/eng-consultants/cnslt-rsrces/tools/cad/autoturn.aspx


 3. If the workstation has a previous version of the WisDOT vehicle library, the previous version 
of the vehicles must be removed before importing the new version. The vehicles in the 
WisDOT library are locked and cannot be removed unless the user has logged into AutoTURN 
as an administrator.

To log into AutoTURN as an administrator, go to Program Settings > Permissions. Type 
"admin" for the password and click submit. The individual vehicles can now be unlocked and 
deleted.

 4. Import the desired vehicle.veh file in the Select Current Vehicle dialogue.

Alternative 2 - Replace vehicle database
This alternative works well when updating the entire WisDOT vehicle library.

 1. Download the wisdotdatabaseXX.zip file. (XX = AutoTURN version)
 2. Extract the wisdotdatabaseXX.zip file to temporary location.

Warnings: 
Overwriting the vehicle database on a workstation will remove any custom vehicles that have 
been created. All custom vehicles must be exported before overwriting the vehicle database. 
Once the new database is in place, the custom vehicles can then be re-imported.

To export a vehicle: AutoTURN tab > Configure panel > Vehicles > Select library with cus-
tom vehicle > Highlight custom vehicle > Export Vehicle button

To import a vehicle: AutoTURN tab > Configure panel > Vehicles > Select library > 
Import Vehicle button

 3. Exporting and importing 
 4. Once the files have been extracted on the workstation, the new vehicle database (.db exten-

sion) can be copied to the vehicle database directory. It is a good practice to rename the exist-
ing database file with a .bak extension before moving the new database file to that directory. 
If a vehicle is needed from the old database, it can be renamed with the .db extension.

The default location for the vehicle database file is (AutoTURN Pro 3D shown):

Version 10.2 & later = %AppData%\Transoft Solutions\Common\Databases\

 4. Move the remaining extracted dwg files to their destination directories. (AutoTURN Pro 3D 
shown)

Extracted 
Folder Destination Directory

Profiles User
10.2 & later: %AppData%\Transoft Solu-
tions\Common\ProfilesUser\

Vehicles User
10.2 & later: %AppData%\Transoft Solu-
tions\Common\vehicles user\

Page: 261

Published on: 5/17/2023

Alternative 2 - Replace vehicle database



Extracted 
Folder Destination Directory

Vehicles3D 
User

10.2 & later: %AppData%\Transoft Solu-
tions\Common\vehicles3d user\
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Civil 3D interface
Interface introduction
Last updated: 2021-11-09

Total video time:  21:24

Welcome screen

c3d-intrfc-intro-01.mp4 9:41

What you will find on the Welcome screen are:

 1. Short video tutorials, such as: user interface, surfaces, alignments, profiles, corridors, inter-
sections and pipe networks.

 2. Exercise tutorials, show step-by-step processes on broader topics.
 3. What's New, explores new features in Civil 3D for the current year.

Info: Most of these are web-based and will need internet connection.

Tip: To turn-off the start screen, in the command line type Startmode, press Enter, 
type 0, press Enter.

Tip: To turn-on start screen, select Help button (? button in upper right), option listed in 
dropdown.

Application menu browser

c3d-intrfc-intro-02.mp4 3:15

 1. Large C icon in upper left corner.
 2. When selected once, it allows access to the general production menu. When selected twice, 

Civil 3D will close.
 3. Menu includes

 A. New - new drawing or sheet set
 B. Open - opens a drawing, not a template
 C. Save
 D. Save As - has different formats
 E. Export - has different formats
 F. Publish - one example, eTransmit packages all the files attached to your project, includ-

ing Xrefs and data shortcuts.
 G. Print - Plot, batch plot, plot preview, page setup, etc.
 H. Drawing utilities - Set drawing properties, drawing settings, units, audit, purge, 

recover, etc.
 I. Close - To close all drawings or current drawing.
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 4. Options button - Opens a dialog box with options.
 5. Search bar at the top, to find commands within the ribbon.
 6. Application menu also lists currently open and recently used files. Pin a drawing here to find it 

quickly.
 7. Exit button for exiting Civil 3D.

Quick Access toolbar

c3d-intrfc-intro-03.mp4 1:04

 1. Found to the right of the Application menu browser button at the top of the screen.
 2. Allows access to general commands; new, open, save, plot, undo/redo, and others.
 3. To add your own choice of command to the Quick Access menu

 A. Select dropdown > More Commands...
 B. Customize User Interface dialog box 

 I. Select command name you want to add > OK
 4. To show the menu bar

 A. Select dropdown > Show Menu Bar
 B. Menu bar will appear above the tabs of the ribbon

Ribbon
 1. The ribbon is a user interface tool that allows all of the icon selection in Civil 3D to be cent-

ralized in a space sufficient area.
 2. The ribbon is organized into tabs that manage the different tools available.
 3. Each tab is subdivided into panels that contain the icons for the tools. If there are more tools 

than shown, a panel pulldown (arrow in lower right corner of panel) will display.

Tip: To keep the panel expanded while using a tool repeatedly, select the thumbtack 
(icon found in lower left corner of expanded panel).

Toolbars

c3d-intrfc-intro-04.mp4 1:25

 1. Toolbars are the command structures for base AutoCAD, prior to the ribbon. Transparent 
commands is the only toolbar open by default. All other toolbars have been added to the rib-
bon.

 2. Selecting the dash line (found at the top or left side of the bar) you can move the bar. Right-
click in the gray space of the toolbar to access a list of old toolbars.

Command Line

c3d-intrfc-intro-05.mp4 2:16
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 1. The command line can be found at the bottom of the screen. It is used for the typed version 
of commands.

 2. The command line is in a tool palette and can be moved.  Like other toolbars, select the dash 
line (found on the left side) and drag to new location, even another screen.

 3. The command line is not in use when it displays "Type a command". Once you have typed a 
command, it will prompt you through to command.

Status bar

c3d-intrfc-intro-06.mp4 2:13

 1. The status bar can be found below the command line. It is a series of icons that will allow for 
settings for certain functions within AutoCAD and Civil 3D.

 2. The status bar displays the cursor location, drawing tools, and tools that affect your drawing 
environment.

 3. The status bar provides quick access to some of the most commonly used drawing tools. 
There are function key alternatives for most of these icons, but not all.

 4. Some of the tools include; Snap mode, Ortho mode, Polar Tracking, Object Snap (OSnap), 
Annotation scale, and Workspace.

Drawing Scale

c3d-intrfc-intro-07.mp4 1:27

 1. The drawing scale is a representation of the drawing area the you have and is 1" = 1".
 2. The annotation scale is found at the bottom in the status bar. Use the arrow to activate a fly-

out menu and change the scale of your drawing.
 3. The drawing scale controls the size of text; text in labels, text in dimension labels, and text in 

multileaders, and space between section views in an array.

Ribbon and tabs
Last updated: 2021-10-22

Total video time: 8:14

Ribbon interface

c3d-intrfc-rbn-01.mp4 4:21

The ribbon is a management style of keeping commands at the top of the screen. The ribbon man-
agement area includes tabs, panels, and icons.

 1. Tabs contain a grouping of command panels.
 2. Panels are a grouping of similar command icons.
 3. Icons start the commands directly.

Tabs
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c3d-intrfc-rbn-02.mp4 3:53

The tabs are found on top of the ribbon directly below the Quick Access toolbar.  Some of the tabs 
included are: Home, Insert, Annotate, Modify, Analyze, View, Output, Manage, and so on. The tabs 
also include WisDOT Design and WisDOT Sheets.

Panels

Panels are labeled on the bottom of the ribbon. Each panel contains tool/commands that are related 
to that panel.  If the panel's name has an arrow next to it, select to see additional tools/commands. 
This is called a fly-out menu and once a tool/command is selected it will minimize.

Icons

Icons are tools/commands. If there is an arrow next to the icon, select it for a dropdown menu of 
additional related commands.

Minimize ribbon

To minimize the ribbon to have more drafting room, select the last icon within the row of tabs.  This 
button has 4 options, and must be clicked each time to activate.

 1. First click, Minimize to Panel Buttons
 2. Second click, Minimize to Panel Titles
 3. Third click, Minimize to Tabs
 4. Forth click, Show full ribbon

Toolspace
Last updated: 2021-11-09

Total video time: 38:07

Toolspace overview

c3d-intrfc-tlspc-01.mp4 4:52

Toolspace palette is the area on the left side of the screen. This palette is where you can find the 
objects created and manage them.  The palette, by default, is docked on the left side of the display, 
but it can be moved.

Toolspace area includes

 1. Tabs; Prospector, Settings, Survey and Toolbox
Tabs can be toggled on/off to save space

 2. Preview window
Area located at the bottom of the Toolspace.  Used to look at the data of an object. For 
example, select Points, all the point numbers and information about each point will be 
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displayed. If Select Preview is turned on in the Toolspace area, a graphic image could be dis-
played in the preview window.

 3. Active drawing view/Master view
This is located at the top of the Toolspace and decides what is displayed in the Toolspace.

Active Drawing View option will give you the active drawing and all of its objects, listing them 
as one single drawing. It will also include a listing of the data shortcuts.

Master View will give a listing of every drawing file that is open and a list of all of objects. The 
current active drawing will be in bold print.

 A. Projects Area is the Vault connection.

Info: The Projects collection of the Prospector tree is is not visible if you have 
installed Autodesk Vault Client and Server Application. WisDOT does not use 
Vault.

 B. Drawing Templates area lists all of the drawing templates in a specific, preset file loc-
ation.  Templates can be accessed to check the standards.

Toolspace tabs

c3d-intrfc-tlspc-02.mp4 8:01

Toolspace palette is the area on the left side of the screen. This area includes tabs, preview window, 
and active drawing view/master view.

The Toolspace docking options, for more drafting space

 1. Hold left-click and drag to new location. It's a floating dock window.
 2. Right-click next to Toolspace name for a menu

 A. checkmark Allow Docking
 B. Select either Anchor Left or Anchor Right

Tip: This will anchor the Toolspace and autohide it.

If the Toolspace palette is closed, to reopen

Ribbon > Home tab > Palettes panel > Toolspace

This Toolspace button is a toggle for turning it on and off.  The little icons to the right of the 
Toolspace button are toggles for the tabs mentioned below.  The order in which they are selected will 
decide the order they are displayed in the Toolspace palette.

Tabs

Tabs are located on the right side of the Toolspace palette. Tabs can be toggled on/off.

Prospector tab

Used to create and edit or manage objects
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 1. Drawing object access
 A. Objects include points, point groups, surfaces, alignments (profile & sections), sites 

(grading & parcels), catchments, pipe networks (including interference objects), cor-
ridors, assemblies, intersections, and view frame groups.

 B. The plus sign [+] next to the object name expands for more specific objects used 
within your project.

Settings tab

Comprehensive list of styles for each object, found in Civil 3D.

If Surface is expanded, it includes surface styles, label styles, table styles, and commands. Some 
objects may not have these styles, but include criteria and rules.

Survey tab

Survey database are external and available to any drawing.

Toolbox tab

To toggle a tab on/off

Ribbon > Home tab > Palettes panel

Next to the Toolspace toggle are mini toggles, one for each tab. Blue background is active, white 
background is inactive.  The order you turn them on will be the order they display in the Toolspace 
palette.

Active Drawing View/Master View

This is located at the top of the Toolspace and decides what is displayed in the Toolspace.

 1. Active Drawing View option will give you the active drawing and all of its objects, listing them 
as one single drawing. It will also include a listing of the data shortcuts.

 2. Master View will give a listing of every drawing file that is open and a list of all of objects.
 A. Open Drawings, lists all open drawing files. The current active drawing will be in bold-

type. You can switch between drawings by selecting "Switch to" in the right-click menu.
 B. Data Shortcuts
 C. Drawing Templates area lists all of the drawing templates, folder and available types in 

a preselected location.

More overview of the Prospector tab

Used to create and edit objects

 1. Drawing object access
 A. Objects include points, point groups, surfaces, alignments (profile & sections), sites 

(grading & parcels), catchments, pipe networks (including interference objects), cor-
ridors, assemblies, intersections, and view frame groups.
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 2. Data Shortcuts
 A. Reference files including surfaces, alignments (and profiles), pipe networks, corridors, 

and view frame groups.
 B. An external point or access point to a specific project, and are referenced into a file 

you are currently in.
 3. Managing objects

 A. Right-click object names for properties and edit customizations.

Prospector tab

c3d-intrfc-tlspc-03.mp4 3:52

Toolspace palette > Prospector tab > expand drawing name all objects listed

 1. Objects include points, point groups, surfaces, alignments (profile & sections), sites (grading & 
parcels), catchments, pipe networks (including interference objects), corridors, assemblies, 
intersections, and view frame groups.

 2. The plus sign [+] next to the object name expands for more specific objects.
 3. A small arrow before the name of an object indicates it is a data shortcut. No arrow means 

that the object is live and has been defined in the drawing file.
 4. Right-click menu options

 A. Properties and styles
 B. Synchronize or promote
 C. Select, zoom to, or pan to
 D. Lock or unlock
 E. Export
 F. Refresh

Data Shortcuts

 1. Objects include surfaces, alignments, pipe networks, pressure networks, corridors, and view 
frame groups.

Settings tab

c3d-intrfc-tlspc-04.mp4 2:49

Toolspace > Settings tab

The Settings tab is a comprehensive list of styles, for each object, found in Civil 3D. Styles including 
label styles, table styles, and commands. Some objects styles may different settings, like criteria or 
rules.

Styles overview

You can select on any object to use the below process.  Surface is our example.
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Surface

Toolspace > expand active drawing > expand Surface

 1. Surface Styles
 A. Expand to see list of styles that can be applied to the surface.
 B. This list can also be found through the active drawing, in the surface properties. 

 I. Select the surface of your drawing > right-click and select Surface Prop-
erties... 

 a. Surface Properties dialog box 
 i. Information tab > select Surface Styles dropdown

Info: When there is a orange marker in front of the style name, in the Toolspace, it 
means the style is active/live in the drawing.  It doesn't define where it is used, but if 
edited it will affect your drawing. View it as a warning.

 2. Label Styles
 A. Contains sub-styles; Contour, Slope, Spot Elevation, and Watershed.
 B. Some sub-styles contain Expressions, used to build a mathematical model.

 3. Tables Styles
 A. Table objects from base AutoCAD that are created in a form that responds to surface 

objects.
 B. Contains sub-styles; Directions, Elevation, Slope, Slope Arrow, Contour, Watershed, 

and User-Defined Contour.
 4. Commands

Macros for creation settings

 A. Right-click on a command and select "Edit Command Settings..." to change the default 
settings and overall drawing settings.

Edit feature settings

Toolspace > Settings tab > right-click Surface > select Edit Feature Settings...

Use to access default settings

Edit drawing settings

Toolspace palette > Settings tab > right-click drawing name > select Edit Drawing Settings...

Drawing Settings dialog box

 1. Units and Zone tab
 A. Drawing or Angular units
 B. Imperial to Metric conversion, should be set to US Survey Foot
 C. Scale or Custom scale
 D. Zone

 2. Transformation tab
 A. Transform zone, grid factor or sea factor
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 3. Object Layers tab
 A. Assigns default layer assignment to each object

 4. Abbreviation tab
 A. List of label abbreviations

 5. Ambient Settings tab
 A. Set global ambient settings here, Apply and OK.

Survey tab

c3d-intrfc-tlspc-05.mp4 3:01

Toolspace palette > Survey tab

 1. Survey Database
 A. External and are available to any drawing. Survey databases, that are created inside 

the survey tab, are available per project.
 B. To add a new survey database 

 I. Right-click on header, select "New local survey database..."
 2. Equipment Database

 A. A repository for survey equipment and data sheets for the equipment being used.
 3. Figure Prefix Database

 A. Linework coding that was shot in the field. It manages those codes, then finds linework 
styles, layers, and connectivity for the linework.

 B. Contain set up for WisDOT Topography 
 I. Right-click WisDOT Topography > Manage Figure Prefix Database, to open 

Figure Prefix Database Manager dialog box.
 4. Linework Code Sets

 A. What the surveyor used in the field to identify certain points connected the linework.
 B. Contains linework set up for WisDOT Proposed

Toolbox tab

c3d-intrfc-tlspc-06.mp4 2:53

Toolspace palette > Toolbox tab

 1. Reports Manager
 A. Contains predefined report types for alignments, corridors, parcels, pipes, points, pro-

files, parcel_CCW, surfaces, and breaklines.
 B. To run a report 

 I. Right-click on report name, select "Execute..."
 2. Subscription Extension Manager

 A. Contains Autodesk subscription advantage packs
 3. Miscellaneous Utilities

 A. Includes Reports, Coordinate Geometry, Export KML, Parcels, Survey, Surfaces, and 
CAiCE Translator

 4. SHP Import/Export Utilities
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Survey database

c3d-intrfc-tlspc-07.mp4 3:35

Toolspace palette > Survey tab

 1. Survey Database
 A. External to any drawing file, external source.
 B. Survey Database is per project.

 2. Equipment Database
 A. Set up to aid in analysis
 B. Right-Click Equipment Database > New..., opens New Equipment Database dialog 

box.
Here is where you can set up a new database.

 C. Expand Equipment Database > right-click New > Select Manage Equipment Data-
base...
Here you can edit units, angle, Electronic Distance Meter (EDM), prism, and Standard 
Deviations.

 3. Figure Prefix Database
 A. Contain set up for WisDOT Topography
 B. Right-click WisDOT Topography > Manage Figure Prefix Database, to open Figure 

Prefix Database Manager dialog box. 3. You can edit the Breakline, Lot Line, Layer, 
Style and Site via checkboxes or dropdown menus.

 4. Linework Code
 A. Contains linework set up for WisDOT Proposed
 B. Right-click WisDOT Proposed > Edit, to see information dialog box.

User Settings

Icon (Tripod w/person) found at top of Toolspace palette, are set to the WisDOT package

Survey User Settings dialog box

 1. Miscellaneous
 2. Survey Database Defaults
 3. Equipment Defaults
 4. Linework Processing Defaults

 A. Option: Process linework during import
 5. Figure Defaults

 A. Option: Current figure prefix database, WisDOT Topography
 6. Interactive Graphics
 7. Import Defaults
 8. Export Defaults
 9. Network Preview

 10. Setup Preview
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 11. Figure Review
 12. Change Reporting

Command shortcuts and hotkeys
Last updated: 2021-11-09

Total video time: 5:53

Exercise files: c3d-intrfc-data-c3d20.zip

ProjectID\SheetsPlan\STH25-XS.dwg

c3d-intrfc-cmnd-shrtct-htky-01.mp4 9:27

All commands have a typed alternative

Some typed commands are quicker than switching ribbon tabs 

Tip: This is not a comprehensive list – just some helpful ones

AutoCAD Keyboard Shortcuts is an Autodesk webpage with a more complete listing of AutoCAD-spe-
cific keyboard shortcuts.

Hotkeys
 l Esc = Exit a command                 

 l Spacebar = Enter

 l F1 = Opens Help to topic you are working with

 l F2 = Expands command line to a window

 l F3 = OSNAPS toggle

 l Shift + Right-Click – Temporary OSNAP Overrides

 l Shift + Spacebar = selection cycling

 l Ctrl + Left-click select for some labels

 l Ctrl + 9 = toggles Command Line palette

 l Ctrl + 3 = toggles tool palettes

Command line commands
 l z enter e enter = Zoom Extent ("Fit View")

 l z enter enter = "real-time" zoom

 l P enter = Pan

 l Delete = Erase

 l E = Erase

 l PL for polyline
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 l PEfor polyline edit

 l DI for Distance command (slightly different than ribbon version) 

 l FILEDIA, setting should = 1

 l CMDDIA, setting, should =1 

 l GEOMARKERVISIBLITY = 0

 l OSNAPZ = if 1 then snaps to 3D objects (x/y/z), if 0 then snaps to X/Y but ignores elevation z

 l OPTIONS = opens OPTIONS dialog box

 l XREF = opens Xreference manager dialog box

 l OOPS = Brings back last deleted selection

 l REA = Regenerates graphics

Basic mouse operations
Last updated: 2021-11-09

Total video time: 9:19

Exercise files: c3d-intrfc-data-c3d20.zip

ProjectID\SheetsPlan\STH25-XS.dwg

c3d-intrfc-basc-mous-01.mp4 12:24

Exercise file: STH25-XS.dwg

Three-button wheel mouse 

Click = select

Right-click = context menus

Wheel operation

 l Roll forward/backward = zoom in/out 
 l Click wheel = pan
 l Double-click wheel = zoom extents

Keyboard & mouse clicks
Shift + Right-click = Temporary OSNAPS menu 

 Shift + wheel-button = Orbit

Ctrl + Click for some objects allows individual label editing

Shift + Click  = remove from selection set 

MBUTTONPAN
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= 1, pan

= 0, Temporary OSNAP menu

Options > User Preference tab > Right-click Customization button  = Right-click customization

Context sensitive

Repeat Last command

Steering wheel control
Last updated: 2021-10-22

c3d-intrfc-strng-whl-01.mp4 5:08

Steering wheel control is found in the navigation toolbar on the right side of the screen.  Steering 
wheel control is a series of navigation controls that follow the cursor when turned on. Navigation 
controls include zoom to, pan to, orbit, and center.

Open navigation toolbar
 1. View tab > Viewport Tools panel > select Navigation Bar
 2. navbar, Enter an option: on

Steering wheel and parts
Select Full Navigation Wheel, 2nd icon from the top, to have the steering wheel appear attached to 
the cursor.

The steering wheel has different parts that are highlight as you go over them. Place wheel where you 
went the command to start before selecting.

Outside ring:

 1. Zoom, hold left-click and move mouse forward and backward
 2. Orbit, use Center to create a pivot point and move mouse to orbit
 3. Pan, hold left-click and move around screen
 4. Rewind, rewind video

Inside ring:

 1. Walk, walk over your project
 2. Center, pivot point for the orbit
 3. Look
 4. Up/Down

To close wheel, select the X in upper right corner of wheel or use ESC.

Wheel Choices
Below the Full Navigation Wheel icon is a dropdown arrow to open a menu.  Checkmark appears 
before the selected wheel.
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 1. Full Navigation Wheel, detailed above.
 2. Mini Full Navigation Wheel, smaller wheel that includes same tools as Full Navigation Wheel.
 3. Mini View Object Wheel, smaller wheel that includes pan, zoom, orbit, and rewind.
 4. Mini Tour Building Wheel, smaller wheel that includes walk, look, rewind, and up/down.
 5. Basic View Object Wheel, includes center, zoom, rewind, and orbit.
 6. Basic Tour Building Wheel, includes forward, look, rewind, and up/down.
 7. 2D Wheel, includes zoom, rewind, and pan.

Status bar
Last updated: 2021-11-09

Total video time: 6:16

Exercise files: c3d-intrfc-data-c3d20.zip

ProjectID\SheetsPlan\STH25-XS.dwg

c3d-intrfc-status-bar-01.mp4 6:16

Status bar
 l Icons...
 l Function Key Alternatives 
 l Right-Click Settings

Status bar keys
 l Constraints Ctrl+Shift+I
 l Snap/Grid F9/ F7
 l Ortho Snap F8
 l Polar Track F10
 l OSNAP F3
 l 3D OSNAP F4
 l Object Snap Tracking F11
 l Dynamic UCS F6
 l Dynamic Input F12
 l Lineweight 
 l Transparency
 l Quick Properties Ctrl+Shift+P
 l Selection Cycling Ctrl+W
 l Annotation objects

File open, save, and new
Last updated: 2023-02-22

Total video time: 4:40
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c3d-intrfc-fil-opn-sav-new-01.mp4 4:40

Overview

Opening a file

 1. There are multiple ways to open a file
 A. App menu > Open
 B. Quick Access toolbar > Open (file folder icon)
 C. Right-click File tab > right-click menu > Open...

Opening a new template

 1. There are multiple ways to open a new file
 A. App menu > New
 B. Quick Access toolbar > QNew 

 C. Right-click File tab > right-click menu > New...
 D. Plus sign next to File tab

 2. All new files start with a template (.dwt).  The template brings in the settings for the new draw-
ing; specific object and layout styles.

 3. When opening a new template, WisDOT has template files already setup.
 A. App menu > New
 B. Select Template dialog box 

 I. Look in should be set to the Begin-dwg folder and contain starting templates; 
drawing, plat and survey.

 II. Select design template and Open

Saving a new file

 1. To save a new file
 A. Right-click File tab > right-click menu > Save... 

 I. Save Drawing As dialog box 
 a. Save in, browse to project folder
 b. Rename file name (.dwg)
 c. Save

 2. Once saved, there will be no drawing in the modelspace, but the styles are populated in the 
settings

 A. Toolspace > Settings tab > expand Surface
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File, model, and layout overview
Last updated: 2021-11-09

Total video time: 5:50

c3d-intrfc-fil-mdl-lyout-01.mp4 5:50

File tabs
 1. File tabs display the current open files. They are located directly above the Toolspace palette 

and model space.
 2. To turn off display tabs

 A. Right-click in the modelspace > right-click menu > Options...
 B. Options dialog box

 I. Display tab > Window elements > uncheck box Display File Tabs

Tip: Keep the box checked to keep the tabs displayed.

 C. OK to save changes, Apply to see changes, or Cancel to exit
 3. Hover over tab to see open layouts. Each layout has the option to layout or plot.
 4. If the file name, in the tab, has an asterisk (*) at the end, it has not been saved yet. Select Save 

in the Quick Access toolbar to have to disappear.
 5. Right-click on a tab to get right-click menu dropdown. Commands include: New, Open, Save, 

Save As, Save All, Close, Close All, and Close All Other Drawings.  On the active drawing you get 
two additional commands: Copy Full File Path and Open File Location.

 6. Plus symbol, next to the tabs, will open a new file using your default template.

Model and layout tabs
 1. Model and layout tabs can be found on the lower left.

 A. Model tab is modelspace, displaying the drawing at 1:1 ratio.
 B. Layout tab is paperspace, used for plotting at scale. Paperspace includes the printable 

area, title block information, and a viewport to display portions of Modelspace.
 2. To turn off tabs

 A. In paperspace, right-click on the drawing > right-click menu > Options...
 B. Options dialog box

 I. Display tab > Layout elements > uncheck box Display Layout and Model 
Tabs

Tip: Keep the box checked to keep the tabs displayed.

 3. In paperspace, the squares/rectangles are called viewports. Viewports are like picture frames 
into modelspace, the area selected to be viewed. When a viewport is selected, the scale 
appears in the bottom status bar.

 4. The ribbon displays commands based on the tab selected.
 5. Plus symbol, next to the tabs, will open a new layout.
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Model space viewports
Last updated: 2021-11-09

Total video time: 4:10

c3d-intrfc-mdlspc-vwprt-01.mp4 4:10

Modelspace viewport overview
Model space can have one viewport or multiple viewports. Multiple viewports are real time windows, 
and zoom or pan can be used within each window independently.

Multiple viewports in Modelspace

 1. To change your model space into multiple viewports
 A. View tab > Model Viewports panel > Viewport Configuration dropdown
 B. Select Three Left configuration
 C. The active viewport will be highlighted with a blue box/border.

Any change made within one viewport will change in all since they are real time windows.
 2. The plus sign [+] in the top left corner of viewport for dropdown menu options

 A. Maximize Viewport
 B. Viewport Configuration List, same list as in ribbon

 3. The word next to the plus sign in brackets is the view point and can be changed. Views can be 
Top, Bottom, Left, Right, Front, Back, SW isometric, SE isometric, NE isometric, NW isometric.

 4. Name your viewports
 A. View tab > Model Viewports panel > select Named
 B. Viewports dialog box 

 I. New Viewports tab
 II. New name: My Viewport (Enter the name you would like to save it as)

 III. OK
 5. Restore to original view

 A. View tab > Model Viewports panel > select Restore
 6. Load custom configuration

 A. Select minus sign [-] in upper left corner of model space
 B. Viewport Configuration List > Custom Viewport Configuration > My Viewport

 7. Join viewports
 A. View tab > Model Viewports panel > select Join
 B. Select dominant viewport: Select a viewport
 C. Select viewport to join: Select a second viewport

External references
Last updated: 2023-02-22

Total video time: 19:23

XREFs overview
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c3d-intrfc-xref-01.mp4 8:39

XREFS are drawings used behind the drawing you are working on, and only used as a reference. 
Doing so, reduces the design drawing file size.

XREF file types

 1. DWG file, overlays
 2. DGN file, underlays
 3. Attach images
 4. Attach PDFs

XREF Manager

Where XREFs are stored and accessed.

 1. Unload, you don't see the XREF in your file but remains in The XREF Manager.
 2. Detach, removes from your drawing file and XREF Manager.
 3. Binding, inserts XREF data into your drawing file.

Fade Control

Controls how light/dark the XREF is seen with active drawing.

Ribbon > Insert tab > Reference panel pulldown

Add and manage XREFs

c3d-intrfc-xref-02.mp4 10:44

 1. Start a new file
 A. Quick Access toolbar > New (WisDOT Template file)

 2. Ribbon > Insert tab > Reference panel > select Attach
 3. Select Reference Files dialog box

 A. Look in: Local drive:\WisDOT\Projects\86753090\Design\AliProfs
 B. Select file: AliProf-51
 C. Open or Enter

 4. Attach External Reference dialog box
 A. Verify Name is AliProf-51, if not select Browse to search.
 B. Scale

 I. X = 1.00
 II. Y = 1.00

 III. Z = 1.00

Tip: Select Specify On-screen to select points on drawing.
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 C. Insertion point
 I. X = 0.00

 II. Y = 0.00
 III. Z = 0.00

Tip: Select Specify On-screen to enter specific coordinates.

 D. Rotation
 I. Angle = 0

Tip: Select Specify On-screen to pick rotation on screen.

 E. Path type
 I. Dropdown > Relative path

 F. Reference type
 I. Attachment

 G. OK

 5. Select an object, all of the XREF highlights because it is one entity.
 6. The Contextual ribbon changes to External Reference tab

 A. Edit panel 
 I. Edit Reference in Place

 II. Open Reference
 B. Clipping panel 

 I. Create Clipping Boundary
 II. Remove Clipping

 C. Options panel 
 I. External References

Create clipping boundary

 1. Select 4 points, creating a closed object around an area of the XREF
 2. Select the XREF drawing
 3. Ribbon > Clipping panel > select Create Clipping Boundary
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 4. Select polyline/polygonal/rectanguar/invert clip: type SEnter
 5. Select object you created
 6. Boundary is created and only shows the XREF within it.

Remove clipping boundary

Ribbon > Clipping panel > select Remove Clipping

Fade Control

Ribbon > Insert tab > Reference panel pulldown

Controls how light/dark the XREF is seen with active drawing.

Use the slider to control the variance or type in a percentage number.

External Reference palette aka XREF Manager
 1. Start with a new file
 2. Quick Access toolbar > New (WisDOT Template file)
 3. Command line: XREFEnter
 4. Opens XREF Manager
 5. File References, active drawing(s) listed
 6. Attach icon, first on left

Attach file types; DWG, Image, DWF, DNG, PDF, Point Cloud, or Coordination Model.

 A. Select Attach DWG...
 B. Select Reference File dialog box 

 I. Look in: Local drive:\WisDOT\Projects\86753090\Design\AliProfs
 II. Select file: AliProf-51

 III. Open or Enter
 C. Attach External Reference dialog box 

 I. Verify Name is AliProf-51, if not select Browse to search.
 II. Scale, all = 1.00

 III. Insertion point, all = 0.00
 IV. Rotation angle = 0
 V. Path type, change to Full path

 VI. Reference type, Attachment
 VII. OK

 D. File References now includes reference file, AliProf-51.

Selecting specific object(s) from XREF

 1. Command line: NCOPYEnter
 2. Select nested objects to copy: Select object(s)
 3. Enter when selection is finished
 4. Specify base point: Select Enter, it will assume the origin point is 0,0,0 and place the 

object(s) in the exact same location on active drawing.
 5. Enter to end command
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Unload XREF to turn off and show only NCOPY reference data.

 1. Command line: XREF
 2. XREF Manager

 A. Right-click AliProf-51 > Unload

Reload XREF to turn on all XREF data.

 1. Command line: XREF
 2. XREF Manager

 A. Right-click AliProf-51 > Reload

Attach an XREF that isn't appearing

 1. Command line: XREF
 2. XREF Manager

 A. Right-click on missing XREF > Attach...
 B. Attach External Reference dialog box 

 I. Name: Search for XREF
 II. OK

Remove an XREF(s) from XREF Manager

 1. Command line: XREF
 2. XREF Manager

 A. Right-click on XREF to remove > Detach

Bind brings all XREF data into the active drawing

 1. Command line: XREF
 2. XREF Manager

 A. Right-click AliProf-51 > Bind...
 B. Bind Xrefs/DGN underlays dialog box 

 I. Button options 
 a. Bind will have the original drawing name listed along with all the layers.
 b. Insert will put a marker in front of it indicating it's not an original layer.

 II. Select BindOK

Editing XREF objects

 1. Edit Reference in Place
 A. Ribbon > External Reference tab > Edit Reference in Place
 B. Reference Edit dialog box

 I. Reference name: AliProf-51
 II. If there are nested objects, select  Automatically select all nested objects.

 III. OK
 C. Make changes to object

Page: 283

Published on: 5/17/2023

External Reference palette aka XREF Manager



 D. Ribbon > Insert tab > Edit References panel > Save Changes

Warning: Saving changes will be saved to the original file that is being XREFed 
in.

 2. Open Reference
 A. Ribbon > External Reference tab > Open Reference
 B. Opens the actual XREF
 C. Make edits/changes
 D. Save

Data shortcuts
Last updated: 2021-11-09

Total video time: 10:04

Exercise files: c3d-intrfc-data-c3d20.zip

ProjectID\Design\Corridors\Corridor-STH25-4thAve.dwg

ProjectID\BaseData\Mapping\ExistSurface.dwg

Overview

c3d-intrfc-data-shrtct-01.mp4 2:24

Exercise file: Existing Surface.dwg

Provides selective object data for use in other files

 l surfaces
 l alignments
 l profiles
 l corridors
 l pipe networks
 l pressure networks
 l view frame groups

Files must be attached to a "project"

Object geometry is in one file, can be referenced into many other files. Allows for different styles to 
be applied to the same object in different references.

Data References can be used simultaneously 

Control/distribution of geometry held in XML file

Data shortcut folder relationship
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c3d-intrfc-data-shrtct-02.mp4 2:46

Working Folder = Path where projects are stored (level above project folders) 

Project Folder = in working folder path where project files are stored

"_shortcut" folder = inside Project folder, where actual data shortcuts reside 

 l The data is in XML format
 l DO NOT edit these files – this is for Civil 3D to access/manage 

If a project is moved, these locations are relative.

Data shortcut process

c3d-intrfc-data-shrtct-03.mp4 4:53

 1. Right-click on Data Shortcuts > Set Working Folder
 2. Right-click on Data Shortcuts > New (or Set) Project Folder
 3. Right-click on Data Shortcuts > Create Data Shortcuts

Now that project path and folder are established, this step is repeated throughout project.

Xreference vs data shortcut concepts
Last updated: 2021-11-09

Total video time: 4:14

Exercise files: c3d-intrfc-data-c3d20.zip

ProjectID\SheetsPlan\STH25-XS.dwg

ProjectID\Design\AliProfs\AliProf4thSt-Best-Fit.dwg

Concepts

c3d-intrfc-xref-vs-data-shrtct-01.mp4 4:14

XREFS

 l Connects to an entire file, then items can be filtered out by layer
 l Intended for items that you cannot data shortcut (acad objects, and a few civil 3d objects, cor-

ridors most notably)

Data shortcuts

 l Connects to individual objects
 l Intelligent data remains intact through connection (example: you can get station offset of an 

alignment through a data shortcut, but not an xref)
 l Styles can be different per connection (you cover this well)
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Info: In general, you should use the data connection intended for the object (i.e. use data 
shortcut for those objects, xref for others). The reverse is also true. You should generally not 
XREF objects that can have a data shortcut. If you happen to XREF a file that has connections to 
data shortcut objects, you can either remove the data shortcut or freeze the layer of the data 
shortcut object in the XREF. Classic example here is XREF topo and there's a DS to an align-
ment. That alignment will show up static and cannot be styled or queried. It's better to freeze 
the ali out of the xref and data shortcut it.

Both tools for referencing data in different ways 

 l Data Shortcuts are more Civil 3D specific. 
 l XREFs are "generally" more AutoCAD entities.
 l Civil 3D Objects will Xref and are usable

Data shortcuts usage

 l When you need data from surface, alignment, profile or pipes 
 l View Frames for plan and profile sheets
 l When object interaction is needed
 l Alignment (for sample line creation)
 l Corridors when using C3D 2018

XREFS usage

 l Background information
 l Just for labeling, but not for interaction with other objects 
 l Everything else

Inquiry tool
Last updated: 2021-11-09

Total video time: 8:56

c3d-intrfc-inqry-01.mp4 8:56

Inquiry tool overview

Inquiry tool palette

Inquiry tools are for reporting data from Civil 3D objects.

Inquiry types include: point, surface, alignment, profile view, profile, section view, section, and cor-
ridor section.

Example of field values include a location, x-coordinate and y-coordinate, easting or northing inde-
pendently of each other, etc.
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Point inquiry

 1. Analyze tab > Inquiry panel > select Inquiry Tool > opens Inquiry Tool palette
 2. Select an inquiry type: open dropdown > expand Point > select Point Inverse
 3. Enter Values

 A. Point 1 Number: 780Enter, known data populates table
 B. Point 2 Number: 779Enter, known data populates table

Info: Values you can fill in are white, blue fields will report back.

 4. Graphically a line will appear on your drawing, indicating the points and data from the table.

Surface inquiry

 1. Inquiry Tool palette
 2. Select an inquiry type: open dropdown > expand Surface > select Surface Elevation and 

Grade at Point
 3. Enter Values

 A. Surface Name: EXIST Enter
 B. Point Coordinate: Click on Select from Screen icon, select a point on drawing, known 

data populates table

Alignment inquiry

 1. Inquiry Tool palette
 2. Select an inquiry type: open dropdown > expand Alignment > select Alignment Two Sta-

tion and Offsets at Point
 3. Enter Values

 A. Point Coordinate: Click on Select from Screen icon, select a point on drawing, known 
data populates table

Profile inquiry

 1. Inquiry Tool palette
 2. Select an inquiry type: open dropdown > expand Profile > select Profile Station and Elev-

ation at Point
 3. Select profile dialog box

 A. Select STH258estFitOK
 4. Select Station, marker will appear at geographic location

Borrowing and returning a Civil 3D license
Last updated: 2023-02-22

Testing a borrowed license before leaving the office
It is recommended that you test to make sure your borrow license is working properly before leaving 
the office. 

Laptops
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 1. Borrow the license(s)
 2. Close Civil 3D
 3. If you will be using a wireless connection at the remote location, undock to switch to the DOT 

wireless network. 
 4. Restart your computer
 5. Open Civil 3D to verify the borrowed license(s) work.

Desktops

 1. Borrow the license(s)
 2. Close Civil 3D
 3. If you will not have an internet connection at the remote location, unplug the network cable. 

Otherwise, proceed to step 4.
 4. Restart your computer
 5. Open Civil 3D to verify the borrowed license(s) work.

Borrowing a Civil 3D license #borrow
A license will need to be borrowed for each Civil 3D version you will be using.

If you borrow a license you are removing it from the network pool of licenses, whether you are act-
ively using it or not. The license can be borrowed for a limited amount of time, after which it will auto-
matically be removed from your computer and returned to be available on the network. You can 
only borrow networked licenses, not stand alone licenses.

 1. With Civil 3D open, Help tab > About panel About Civil 3D This is on the right side of the 
Help tab.

 A. About dialog: Manage License
 I. License manager: Borrow

 a. Borrow License: In the calendar, select the automatic return date. This 
date must be within a length of time set by your administrator.

 b. Borrow License
 c. Wait for the message that says “You have successfully borrowed a 

license.” to confirm the license has been borrowed. Close
 B. Red X to close About dialog.
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Returning a borrowed Civil 3D license #return

Returning a license earlier than the date specified

You can return a license earlier than your chosen automatic return date. The options below all have 
the exact same result. You only need to choose the method that works for the circumstances you 
find yourself in.

Returning a license earlier than the date specified, option 1

At the beginning of each session of Civil 3D while the license is checked out you should receive a bal-
loon notification stating that the license is checked out and can be returned early.

 1.  Click here in the balloon notification to return the license
 2. Return Borrowed License dialog: YES to confirm the early return.

 3. License Returned dialog: Close

Returning a license earlier than the date specified, option 2

If you are not receiving that balloon notification, or you closed it before using the early return option, 
but would like to return the license early do the following steps:

 1. With Civil 3D open, Help tab > About panel About Civil 3D This is on the right side of the 
Help tab.

 A. About dialog: Manage License
 I. License manager: Return

 a. Wait for the message that says “You have successfully returned a 
license.” to confirm the license has been returned. Close

 A. Red X to close About dialog.

Returning a license earlier than the date specified, option 3

If you are not receiving that balloon notification, or you closed it before using the early return option, 
but would like to return the license early do the following steps:
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 1. Status Bar > Right-click License button > Return License Early...

 2. Return Borrowed License dialog: YES to confirm the early return.
 3. License Returned dialog: Close

Adding a folder link to a Civil 3D dialog
Last updated: 2023-02-22

Total video time: 3:47

c3d-intrfc-add-fldr-lnk-to-c3d-dlg-01.mp4 3:47

Creating a shortcut folder

Tip: These folders are for quick access to your project(s) and are temporary and can be 
deleted after you are done with your project.

 1. Quick Access bar > select Open (open folder icon)
 A. Select File dialog box

 I. Look in: browse to Local Drive:\WisDOT\Design\C3D
 II. Select Up one level icon

Tip: Set the shortcut folder one level higher than project folders for quick 
access to your projects.

 III. Left-click C3D folder and drag to Places list (blue bar, left side of dialog box)
 IV. Select the C3D shortcut folder to see all project folders
 V. Left-click 86753090 folder and drag it into the Places list

Removing a shortcut folder
 1. Quick Access bar > select Open (open folder icon)

 A. Select File dialog box 
 I. In Places list, right-click on 86753090 folder > Remove

 II. Prompt: Are you sure you want to remove '...C3D\86753090' from Places? Yes
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 III. Select Cancel
 IV. Prompt: Would you like to save changes you made to the Places list? Yes
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Data exchange
Translate DGN to DWG workflow using Civil 3D 2016
Last updated: 2020-10-26

Translate DGN to DWG workflow using Civil 3D 2016
This workflow document will outline the steps involved to translate a MicroStation DGN file to 
AutoCAD 2016 DWG file format. The workflow will be Civil 3D based and the final deliverable will be 
the DWG file.

Warning: The DGN import and export capabilities are designed to provide a fundamental 
exchange of information between MicroStation V8 DGN files and AutoCAD DWG files. 
However, translating data from one format to a completely different format has inherit com-
promises and substitutions.

Simple elements: Simple geometric objects such as lines, arcs, and circles, and properties such as 
layer assignments correlate directly between the DWG and DGN data formats.

Elements with custom properties: Data with built-in features or variations are visually approx-
imated. For example, text and dimensions might have specialized formatting, and color definitions 
might be customized.

Product-specific features: Some data cannot be translated completely. For example, product-spe-
cific features such as data fields or dynamic blocks can be represented visually but not behaviorally.

No symbol color: AutoCAD only supports colors for lines so all entities in the DGN file that have a 
color property set for a symbol in MicroStation lose the symbol color when imported as a block.

Multilines do not retain linetypes: When importing DGN files that contain multilines, any linetypes 
associated with the multilines do not display.

Closed property of polyline not retained: The closed property of a DGN polygon or closed polyline 
is automatically set to No when imporproting a DGN file into AutoCAD. This is done to ensure that 
linetypes display properly.

Import to AutoCAD
 1. In AutoCAD Civil 3D create a New drawing.
 2. From the Application Menu Button select Open > DGN. The Import DGN File dialog will 

appear. 
Command: DGNIMPORT

 3. Select the file you want to convert and then select Open. The DGN Import Settings dialog will 
appear.

 4. Check ON Import into current drawing and select Ignore duplicate names radio button.
 5. In the External DGN references section of the dialog select the radio button Translate ref-

erences to blocks or xrefs.
 6. In the Specify DGN units to convert to DWG units select the Master units radio button.
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Info: 
In the Import DGN Settings dialog box, if you select "Import into Current Drawing" and select 
the "Translate References to Blocks or Xrefs" option in the External DGN references section, 
all referenced DGN files are converted to block references. If you do not select "Import into 
Current Drawing" and select the "Translate References to Blocks or Xrefs" option, then all ref-
erenced DGN files are converted to DWG external references.

If you are importing a V7 DGN file that MicroStation V7 DGN file does not have ByLayer set-
ting for color. The user may want to use the Standard DGN mapping rather than the WisDOT 
one to preserve colors.

 7. Click the WisDOT DGN-DWG IMPORT as the setup.
 8. Click the OK button. The Import DGN dialog will close and the file will be imported.
 9. Zoom extents the drawing and Select All the elements.

 10.  Properties dialog
 l Color = ByLayer
 l Linetype = ByLayer
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 l Lineweight = ByLayer

Verify the imported drawing
 1. In AutoCAD Civil 3D go to the Ribbon and the View tab > Coordinates panel select World 

icon.

Info: 
World aligns the UCS with the world coordinate system (WCS). You can also click the UCS icon 
and choose World from the origin grip menu.From the pull down menu View > 3D Views > 
Plan View > World UCS
Command: PLAN [W]Enter

Plan view set to World displays an orthographic view of the XY plane of a specified user 
coordinate system.

 2. Locate a known coordinate location in the file and verify the coordinates out to 3 decimal 
points.

 3. Save drawing and then Exit AutoCAD Civil 3D.

Export DWG to DGN workflow using Civil 3D
Last updated: 2020-10-26

Overview
This is a workflow to translate a Civil 3D DWG format file to a MicroStation DGN format file. The work-
flow is Civil 3D based and the final deliverable is a DGN file.
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Export Civil 3D DWG to MicroStation DGN
 1. Open the target DWG to export.
 2. C3D Application Menu > Export > Export Civil 3D Drawing or EXPORTC3DDRAWING at the 

command line.

 3. The Export Autodesk Civil 3D Drawing dialog box will appear. Use the following settings:
 A. Export to file type: MicroStation DGN
 B. External DWG references: Bind and Insert
 C. Files to Export: Current drawing on

 4. Destination Folder: Click ... to choose the save location of the DGN.
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 5. OPTIONAL: Enter a Destination file name prefix or Destination file name suffix to the exported 
DGN filenames.

 6. OPTIONAL: Checkmark: Include sheets (To also export layout sheets.)
 7. In the Files to Export column, check or uncheck the files to be exported.

 8. Export Settings....

 9. In the Export Settings dialog box set the following:
 A. Export file type: MicroStation DGN

 B. DGN file version: V8
 C. Conversion units: Master
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 D. ... to select the Seed file: C:\WisDOT\Stnd\C3D20xx\Templates\Conversion\wisdot-
seed3d.dgn

 E. Mapping setup: WisDOT DWG-DGN EXPORT
 F. OK.

 11. In the Export Autodesk Civil 3D Drawing dialog box Export . 

 12. The Export Status progress dialog will appear. Wait for the DGN(s) to be created. The export 
process may take some time to complete.
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Warning: The Export to MicroStation DGN process doesn't always complete successfully. It will 
sometimes fail, hang, or crash Civil 3D without warning. If this happens contact sup-
port.cae@dot.wi.gov for troubleshooting help.

 13. When the button is no longer grayed out, click OK to dismiss the Export Status progress dia-
log.

 14. Click the exit button (X) to close the Export Autodesk Civil 3D Drawing dialog box.
 15. Individual DGN files will be exported to the folder specified, one DGN for model space and 

one DGN for each individual layout (if layouts are selected).

Importing PDF and XLS files
Last updated: 2012-01-10

Total video time: 2:05

Importing PDF and XLS files

data-xchng-imprt-pdf-xls-01.mp4 2:05

Insert (PDF) and Paste (XLS)

Culvert pipes and parcels from ArcGIS Online to Civil 3D
Last updated: 2022-02-14

Warning: The data downloaded in this exercise is for planning purposes only. It is not spatially 
accurate enough for design or plat purposes.

Tip: The website used below is for internal staff and requires VPN.

Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 
2018 has been retired and is no longer needed in Civil 3D 2020 and beyond.
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Coordinate systems in Civil 3D should only be applied when a projection transformation is 
needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, 
Wisconsin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

Download data from ArcGIS Online
 1. Access the Statewide Culvert Inventory App       
 2. Zoom to the project area.         

 A. Default is for the Culvert Pipe layer to be active.  The Parcel layer is also available from 
this app.

Download culvert data

 1. Select Menu > Select by Polygon

 A. Select an area surrounding the Project
 2. In the Select Menu, Next to Active Culvert Condition Rating, click the ellipse > Export to 

GeoJSON
 A. Rename the downloaded file to culverts.geojson. The file was saved to the user's 

Downloads folder
 3. Convert to shape file by following "Convert GeoJSON files to SHP #convert" on page 302 

below       
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Download parcel data

 1. If previously downloaded culvert data, clear the selected data.             
 A. Select Menu > Clear                                  

               

 2. Layers Menu > Deselect Culvert Condition Rating
 3. Layers Menu > Select WDOA 2018 Parcels
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 4. Select Menu > Select by Polygon

 A. Select an area surrounding the project, making sure the parcels desired to be seen are 
selected.  The selection maxes out at 1000 parcels.

 B. In the select menu, click the ellipse > Export to GeoJSON
 I. Rename the downloaded file to parcels.geojson

Convert GeoJSON files to SHP #convert

 1. Visit mapshaper.org
 2. Drag and drop the culverts.geojson into the web app.             

 A. Import

 

 3. Export > *Select* Shapefile > Export
 A. File is saved in Downloads

 4. Refresh mapshaper.org and repeat the same process for the parcels.geojson           
 5. Extract the zip files to a known location such as Civil 3D Project/BaseData/Other

Import data into Civil 3D
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Import culvert data into Civil 3D

 1. Set DWG coordinate system         
 A. App menu > Drawing Utilities > Drawing Settings
 B. Set the Coordinate system to the project coordinate system. 

 I. Category: WisDOT
 II. Cooridinate System: Appropriate county USF

 2. MAPIMPORT

 A. Change file type to ESRI Shapefile (*.shp)

                       

 B. Navigate to the location of the shapefile for culverts > OK           
 C. Click the ellipse under Input Coordinate System to choose the coordinate system of 

the imported map data.
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 I. In the Coordinate Sytem Library, search LL84
 a. Select the LL84 Coordinate System > Select
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 D.              Data column > ...             
 I. Create object data: selected

 II. OK

 E. OK
 3. Culverts are imported as AutoCAD Points.  All attributes in the database are imported into the 

properties of the point.       
 4. Adjust the style display of the points as desired         

 A. DDPTYPE

 I. Choose an point marker
 II. Change Size: 

 a. Set size in absolute units
 b. Size = 10 to 50 units

Import parcel data into Civil 3D

 1. Set DWG coordinate system         
 A. App menu > Drawing Utilities > Drawing Settings
 B. Set the Coordinate system to the project coordinate system. 

 I. Category: WisDOT
 II. Cooridinate System: Appropriate county USF
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 2. MAPIMPORT

 A. Change file type to ESRI Shapefile (*.shp)

                       

 B. Navigate to the location of the shapefile for parcels > OK           
 C. Click the ellipse under Input Coordinate System to choose the coordinate system of 

the imported map data.
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 I. In the Coordinate Sytem Library, search LL84
 a. Select the LL84 Coordinate System > Select
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 D.              Data column > ...             
 I. Create object data: selected

 II. OK

 E. OK
 3. Parcels are imported into Civil 3D as filled shapes. All attributes in the database are imported 

into the properties of the shape.  
 4. Turn off the shape fill

 A.  FILLMODEEnter 0 Enter                     
 B. REA Enter 

 5. The data should line up with project data and aerial imagery.
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Export road linework from InfraWorks to Civil 3D
Total video time: 4:57

Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 
2018 has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is 
needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, 
Wisconsin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

Create InfraWorks model and export to IMX

data-xchng-xprt-rd-linwrk-IWX-to-C3D-01.mp4 4:57

Home Screen > Click Model builder
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 1. Model Builder Dialog Box

 A. Search By Location:  Minocqua, Wisconsin, United States
 B. Model Window: Pan and Zoom to area of interest
 C. Area of Interest: By Rectangle
 D. Model Name: USH51-STH47
 E. Create Model

 2. Model Builder Confirmation Dialog Box > Close
 3. Model Builder Dialog Box > Close Dialog Box

Home Screen > Click USH51-STH47 Thumbnail

 1. Settings > Model Properties > UCS Globe
 A. Category: WisDOT
 B. Code: Double-Click WCCS-vilH8391USF
 C. Road Design standards: AASHTO_Imperial_2011

 2. Settings > Export IMX
 A. Target Coordinate System: Confirm WCCS-vilH8391USF
 B. Target Files: Left-Click Folder Icon "N" Drive\PDS\C3D\11701970 - prjct-ovrvu\-

basedata\other
 C. File Name: USH51-STH47_export.imx
 D. Save
 E. Extent > Define Interactively: Polygon

 I. Create Polygon to reduce extraneous data in model
 II. Double Click to complete Polygon

 F. Export
This topic is followed by "Project overview sheet" on page 1409
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Export Civil 3D data to Google Earth, 2D
Last updated: 2022-08-30

Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 
2018 has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is 
needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, 
Wisconsin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

This workflow shows how to export Civil 3D edgelines to Google Earth. These files can be uploaded 
onto any device and show location in the field relative to the new linework. This can be a powerful 
communication tool.

If viewed on a mobile device on site, you can see your location with respect to the Terrain and the 
file.

Warning: Google Earth horizontal and vertical data is not as accurate as collected existing 
ground data and designs based on it. All users must understand this and make sure that 
people they communicate and share this data with understand the limitations on accuracy as 
well.

Export Civil 3D file
 1. Open file > Save As a new file
 2. Change lineweight

 A. Modelspace > Ctrl+A > Right-click > Properties...
 I. Lineweight: 0.002"
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 3. Assign Coordinate System
 A. App menu > Drawing Utilities > Drawing Settings > Units and Zones tab > Zone

 I. Categories: WisDOT
 II. Available coordinate systems: Appropriate county system in US Feet

 4. Export KMZ file
 A. Toolspace > Toolbox > Miscellaneous Utilities > Export KML > Export KML

 I. General > Name: Change name to the desired file name
 II. Objects

 a. Select all objects or manually chose by choosing the selected objects but-
ton

 b. Export text: checked
 c. Export object information: checked

 III. Geo-reference: Drawing Coordinate System Transform should be default selec-
ted

 IV. Nudge
 a. Drape objects on ground: checked

Info: This is for 2D data only. See "Export Civil 3D data to Google 
Earth, 3D" on page 317 for 3D surface data.

 V. File
 a. Select location and name of file
 b. Export

 VI. Export and view: View

View the file in Google Earth (Desktop)
With Google Earth installed, open the file by double clicking on it

Under Places > My Places

 l The files can be turned on/off by checking the box next to the file name
 l The transparency can be adjusted by highlighting the file name and moving the slider
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View the file in Google Earth (iPad/iPhone)
 1. Download Google Earth application
 2. Email or download the file to the device
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 3. Copy to Google Earth
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 4. Turn on/off layers by expanding the menu and selecting My Places
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Export Civil 3D data to Google Earth, 3D

Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 
2018 has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is 
needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, 
Wisconsin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

This workflow shows how to export Civil 3D surfaces to Google Earth. These files can be uploaded 
onto any device and show location in the field relative to the new surfaces. This can be a powerful 
communication tool.

If viewed on a mobile device on site, you can see your location with respect to the Terrain and the 
file.
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This procedure works well with projects that are on grade or in a fill situation. Projects with sig-
nificant cut will not give good results as surfaces below Terrain in Google Earth do not display. Adjust-
ments can be made for shallow cuts to yield a good visual in Street View and Map View. These 
adjustments are covered in this topic.

Warning: Google Earth horizontal and vertical data is not as accurate as collected existing 
ground data and designs based on it. All users must understand this and make sure that 
people they communicate and share this data with understand the limitations on accuracy as 
well. 

Export Civil 3D file
 1. Open file > Save As a new file
 2. Assign Coordinate System 

 A. App menu > Drawing Utilities > Drawing Settings > Units and Zones tab > Zone
 I. Categories: WisDOT

 II. Available coordinate systems: Appropriate county system in US Feet
 3. Extract triangles 

 A. Select surface > Right-click > Surface Properties... > Information tab 
 I. Surface Style: Top Triangles

 B. Contextual ribbon > Surface Tools panel > Extract from Surface drop-down > 
Extract Objects

 I. Triangles: Select All
 II. Ok
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 4. Change the color of triangles 
 A. Modelspace > Select the 3D faces to set color > Right-click > Properties...

 I. Color: Set to user preference

 5. Export KMZ file 
 A. Toolspace > Toolbox > Miscellaneous Utilities > Export KML > Export KML

 I. General > Name: Change name to the desired file name
 II. Objects 

 a. Select all objects or manually chose by choosing the selected objects but-
ton

 b. Export text: checked
 c. Export object information: checked

 III. Geo-reference: Drawing Coordinate System Transform should be default selec-
ted

 IV. Nudge 
 a. Elevation relative to sea level: checked

Nudging the surface up may be needed to see all of it. Google Earth elev-
ations can be different than collected data and surfaces below the Ter-
rain in Google Earth are not visible.

 b. Select location and name of file
 V. Export

 VI. Export and view: View

View the file in Google Earth (Desktop)
With Google Earth installed, open the file by double clicking on it

Under Places > My Places

 l The files can be turned on/off by checking the box next to the file name
 l The transparency can be adjusted by highlighting the file name and moving the slider
 l Under layers, the Terrain box must be checked
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Three common viewing issues and solutions
 1. Model does not appear in Google Earth If the model does not show up at all with the Ter-

rain box checked. Uncheck the box and see if the model displays in 2D. If it does and appears 
to be hovering around 100 FT from the surface, then this is likely a Civil 3D export issue.

Solution: Reassign coordinate system in Civil 3D and repeat export steps.

 A. App menu > Drawing Utilities > Drawing Settings > Units and Zones tab

 I. Scale objects inserted from other drawings: checked
 II. Set AutoCAD variables to match: checked

 2. Model in Street View is shifted horizontally When viewing the 3D model in street view, the 
model may look like it is not in the correct horizontal location.

Page: 320

Published on: 5/17/2023

Three common viewing issues and solutions



Solution: In Civil 3D, translate the triangle faces a few feet by using a Move command then 
export the file again.

 3. Model in Street View is shifted vertically When viewing the 3D model in street view, the 
model may look like it is not in the correct vertical location. Chances are that the elevations 
from Google Earth and the model elevations are not identical. Google Earth has a feature for 
vertical scaling to help make the drawings align. Note: Google Earth layers are locked. In cut 
locations it may be difficult to get a desired visual.

Solution: Scale in Google Earth

 A. Google Earth > Tools menu > Options... 
 I. Modify the Elevation Exaggeration (default = 1). A value less than 1  will have the 

effect of raising the Civil 3D model.

Export Civil 3D parcels to GIS shapefile
Last updated: 2022-02-14
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Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 
2018 has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is 
needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, 
Wisconsin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

This topic describes the workflow for translating parcels with associated attributes, such as parcel 
number and parcel area, into shapefiles for use with GIS software such as ArcGIS.

Verify/set the coordinate system
Verify the coordinate system in a parcel drawing by looking in the drawing status bar.

If there is no box showing a coordinate system then there is not a coordinate system assigned to the 
drawing.

To set a coordinate system use

 1. Close the target drawing(s) if currently open. The macro cannot be used on a drawing that is 
currently open.

 2. WisDOT Sheets tab > Manage panel pulldown > Set Coordinate System - Multiple 
DWGs

 A. Browse to the drawing(s) by Add...
 B. Select a county from the list in the dialog box and select the datum.
 C. Process All to set the coordinate system.

Export Civil 3D objects to SDF
Civil 3D objects, such as parcels, must be exported to Autodesk Spatial Data Format (SDF) before 
exporting to shapefile. This converts the parcels into data objects (polylines) with attributes asso-
ciated to the data objects. Parcels can be converted to polylines in other ways to create shapefiles, 
but no other method includes the parcel attributes except exporting to SDF.

Warning: Civil 3D objects with a style of "_No Display" will not export. Visible linework 
must be present in the drawing in order to export a Civil 3D object.
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 1. Output tab > Export panel > Export Civil Objects to SDF

 2. The Export to SDF dialog box will appear. Set the file name and location, confirm that the 
coordinate system information is correct, and click OK to export all Civil 3D Objects to SDF.

Import SDF file into new drawing
 1. Start a new drawing.       
 2. MAPIMPORT at the command line.       
 3. Choose Files of type:Autodesk SDF (*.sdf), browse to an SDF file, and click OK. The Import 

dialog box will appear.         
 A. Set the coordinate system for the new drawing           
 B. Input Layer column: Uncheck all except Parcels
 C. Data column: Click to set attribute data for parcels           
 D. Import polygons as closed polylines: checked
 E. Click in the Data column in the Parcels row to set attribute data.
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 I. Attribute data         
 a. Create object data: selected
 b. Select Fields... A list of attributes associated with parcels will appear in 

the Object Data Mapping dialog box. Select or deselect attributes to 
import.
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 a. OK  all open dialog boxes to import the SDF file. Parcel shapes are inser-
ted into the drawing as polylines with attributes.

 F. OK

Export polylines with attributes to a shapefile
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 1. MAPEXPORT at the command line. This will bring up the Export Location dialog box.       
 2. Export Location: Choose Files of type:ESRI Shapefile (*.shp), enter a file name, and OK. The 

Export dialog box will appear.         
 A. Selection tab > Object type: Line selected
 B. Selection tab > Select objects to export: Choose either Select all to include all line-

work in the drawing, or choose Select manually. To select objects manually click the 

selection button.
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 A. Data tab > Select Attributes...

 A. Select Attributes dialog. Under Object Data check the attributes to be exported and 
click OK. 
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 B. OK
 3. OK in the Export Dialog box and a shapefile will be created, complete with attribute data, for 

use with GIS applications.       

CAiCE import tools
Last updated: 2020-10-26

Exercise files: data-xchng-CAiCE-imprt-tls-data-C3D12.zip

Total video time: 60:28

Warning: A known issue has been identified related to Wisconsin county coordinate pro-
jections between XML and SDB files. Please review "Wisconsin coordinate projection issue - 
XML/SDB" on page 116 before proceeding with this topic.

General items

data-xchng-CAiCE-imprt-tls-01.mp4 3:17

 l The workflow to import CAiCE data deals with many different objects in Civil 3D. It is recom-
mended to have that training before importing CAiCE data

 l CAiCE project needs to be unarchived to import data from it.
 l If you don't know the naming conventions used on the CAiCE project, look for the metadata 

document in the project.
 l Don't bring in all data all at once. Better to run import process multiple times.
 l Easier to set layers and styles prior to import rather than fixing them later.
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 l Set active layer before import
 l For survey surface data, if you have items in their original formats (SRV, PAC, CAiCE points 

and survey chains), it is better to bring those items in directly to C3D rather than using the 
CAiCE DTMs. This is because the surface comes in as a snapshot and you can't see the items 
that built the surface.

Unzip CAiCE project

data-xchng-CAiCE-imprt-tls-02.mp4 2:53

 l Unzip the project to a folder that has the same name as the zip file
 l Look for metadata.doc file.

Points and survey chains: Convert CAiCE Survey to Text (*.PT4)

data-xchng-CAiCE-imprt-tls-03.mp4 4:02

Points and survey chains should be brought into a survey database. This is not necessary for design 
or plat based points, but it needs to be done for survey chains, survey points should be with the sur-
vey chains, and it is easy to extract and delete the design or plat based points from the survey data-
base.

 1. Create a new file from wisdot12-etopog.dwt. Save it as C:\WisDOT\design\c3d-train-
ing\180-020-exercisefiles\cas-survey.dwg

Create text file

 1. Toolspace > Toolbox > CAiCE Tools > Import > Convert CAiCE Survey to Text (*.PT4)
 o Select CAS.PT4. Click Open

 2. Make sure all point types are selected and select all of the survey chains to be processed. 
Click Next 

 3. Make sure the destination file format is CAiCE. Create the destination file 
C:\WisDOT\design\c3d-training\180-020-exercise-files\cas-caice-import.txt. Click Convert

 4. Cancel the option to import another file.

Importing data into a survey database

data-xchng-CAiCE-imprt-tls-04.mp4 5:25

 1. Home tab > Create Ground Data panel > Import Survey Data
 2. Specify Database
 3. Click Create New Survey Database...
 4. Type "CAS". Click OK
 5. Click Edit Survey Database Settings...

 o Coordinate zone - Should be set for the survey database. Coordinate systems that 
start with Wisconsin County Systems are Wisconsin County Coordinate (WCCS) defin-
itions
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 n Distance - US Foot (unless known to be otherwise)
 n Click on Categories...Select "USA, Wisconsin"
 n Click on Available projection systems dropdown..Select "Wisconsin County Sys-

tems: Portage County, US Foot". Click "OK".
 o Units: US Foot
 o Survey Command Window

 n Auto-point numbering: Do not use unless neeeded
 o Extended Properties

 n Create new definitions automatically - Yes. This setting will automatically create 
new data fields if they don't already exist in the database.

 o Click OK. Click Next
 6. Specify Data Source
 7. Data source type: Point File
 8. Click grey cross button
 9. Browse to C:\WisDOT\design\C3D-training\180-020-exercise-files\cas-caice-import.txt

 10. Click Next
 11. Specify Network: Click Next
 12. Import Options

 o Point file format: CAiCE
 o Current figure prefix database: WisDOT12-etopog
 o Process line work during import: Yes
 o Current line work code set: WisDOT

Process line work sequence: By import order

Insert and review data

data-xchng-CAiCE-imprt-tls-05.mp4 3:38

 1. Right-click on the objects or group of objects to be inserted and click Insert into drawing
 2. If points all come in identical, apply point description key set
 3. Toolspac > Point Group > Right click > _All Points > Apply Description Keys
 4. Review data
 5. Recommend removing design/plat points from the file

Geometry chains-alignments: Import CAiCE Project (*.PT4)

data-xchng-CAiCE-imprt-tls-06.mp4 7:58

 1. Create a new file from wisdot12.dwt. Save it as C:\WisDOT\design\c3d-training\180-020-
exercise-files\AliProfs-CAS.dwg

 2. Imports will be performed feature code by feature code. For each feature code, set the active 
layer and default styles appropriately. For proposed reference lines:
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 o Layer Property Manager: set active layer to P_ALI
 o Toolspace > Settings > Alignment > Commands > CreateAlignmentLayout

 n Default Styles
 n Alignment Style: ALI Proposed

 3. Toolspace > Toolbox > CAiCE Tools > Import > Import CAiCE Project (*.PT4)
 o Select C:\WisDOT\design\C3D-training\180-020-exercise-files\cas\cas.pt4. Click OK
 o Unselect all points, survey chains, and DTMs
 o Unselect all geometry chains and then select those with the feature code "PRL". Click 

Next
Profiles will be matched up with alignments that have the same beginning characters. Drag any unas-
signed profiles to their appropriate alignments. Click "Import".

data-xchng-CAiCE-imprt-tls-07.mp4 11:45

 4. Run AUDIT to clean up objects
 5. Curves that have tangents in and out come in as free curves
 6. Some profiles may give an error due to length the differences.
 7. Any superelevation data will be applied to the alignments.

Geometry chains-edgelines: Import CAiCE Project (*.PT4) 

 1. Repeat the process with other feature codes (CZ and SI used in exercise). Create a new file 
from wisdot12.dwt. Save it as C:\WisDOT\design\c3d-training\180-020-exercise-
files\Edgelines-CAS.dwg

 2. Make sure to set active layer prior to import
 3. Any geometry chains that are default set to feature lines should be moved to Miscellaneous 

Alignments. Feature lines are 3D objects and do not support true curves while geometry 
chains are 2D and can have curves. There are also far more styles available for alignments.

 4. Styles and label sets seem to be hardcoded. Select an alignment. Right-click.
 o Click Select Similar
 o Go to Properties window, change style for CZ alignments to "AREA Clear Zone"
 o Select a label set. Right-click
 o Click Select Similar. Press Delete

 5. Repeat for SI, set style to RW Proposed-SlopeIntercepts
Important to remember

 l Think about which files you want which objects in. It is far easier to import geometry chains 
into the correct file than try to move them later on.

 l Rename any alignments before creating data shortcuts for them.

Surfaces: Import CAiCE DTM Points (*.PT4)

data-xchng-CAiCE-imprt-tls-08.mp4 5:34

 1. There are 3 different options for importing surfaces from CAiCE (*.PT4,*.TRI,*.XY). Use *.PT4 
because it will retain breaklines the same as what it was in CAiCE.
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 2. Unless you know surfaces are very small, only import one surface at a time to one surface per 
file.

 3. If you have all of the source files for an existing surface, it is better to create the surface in 
Civil 3D from those files. Edits can then be made if needed.

 4. Create a new file from wisdot12.dwt. Save it as C:\WisDOT\design\c3d-training\180-020-
exercise-files\Surface-CAS-Exist.dwg

 5. Set the active layer and default style appropriately. For existing ground:
 o Layer Property Manager: set active layer to E_SURF
 o Toolspace > Settings > Surface > Commands > CreateSurface

 n Default Styles
 n Surface Default Style: EX Border

 6. Toolspace > Toolbox > CAiCE Tools > Import > Import CAiCE Project (*.PT4)
 o Select C:\WisDOT\design\C3D-training\180-020-exercise-files\cas\cas.pt4. Click OK
 o Unselect all points, survey chains, and geometry chains
 o Select DTM: CASMIR6
 o Click the option to Import points and breaklines
 o Click Import

 7. An XYZ point file is created associated with the DWG and a breakline set is created as well.
Rename any surfaces before creating data shortcuts for them.

Import CAiCE Cross Sections (*.EAR)

data-xchng-CAiCE-imprt-tls-09.mp4 3:56

 1. File needs to have an alignment in it or data shortcutted in it for the cross sections to be asso-
ciated with

 2. Cross sections are imported into a static corridor. They can then be viewed on a section view 
group.

 3. Create a new file from wisdot12.dwt. Save it as C:\WisDOT\design\c3d-training\180-020-
exercise-files\Sections-CAS-prrmp10.dwg

 4. Set default code set styles to CAiCE codes
 o Toolspace > Settings > Corridor > Commands > CreateCorridor

 n Default Styles
 n Code Set Style: CAiCE codes

 o Toolspace > Settings > Corridor > Commands > ViewEditCorridorSection
 n Default Styles

 n Code Set Style: CAiCE codes
 o Toolspace > Settings > Corridor > Right click > Edit Feature Settings

 n Default Styles
 n Code Set Style: CAiCE codes

data-xchng-CAiCE-imprt-tls-10.mp4 5:46
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 1. Import alignment rmp10 with Import CAiCE Project (*.PT4)
 2. Toolspace > Toolbox > CAiCE Tools > Import > Import CAiCE Cross Sections (*.EAR)

 o Select C:\WisDOT\design\C3D-training\180-020-exercise-files\cas\prrmp10.ear. 
Click OK

 o Alignment: rmp10
 o Create sample lines: yes (you'll make sure to catch any odd stations)
 o Create section views: no (they don't come out with grid in this process or size cor-

rectly).
 3. Review static corridor prrmp10

 o Prospector > prrmp10 > right click > Corridor Section Editor
 n CAiCE color should show up.
 n Labels not exactly the same
 n Left and right widths 150 FT (this equals sections 1IN:20FT Horiz)

 o Prospector > prrmp10 > right click > Properties
 n Codes tab: Link and Point codes showing up are what are actually in the cor-

ridor. Anything with no Style does not have a corresponding code in the code 
set style.

data-xchng-CAiCE-imprt-tls-11.mp4 5:54

 1. Home tab > Profile & Section Views > Create Multiple Views
 o General

 n Alignment: RMP10
 n Sample line group name: prrmp10
 n Section view style: Sheets 1 IN 20 FT Horiz 20 FT Vert

 n Click Next
 o Section Placement

 n Placement Options: Production: wisdot12-09-xs.dwt|X-Section 1 IN 20 FT Horiz 
20 FT Vert

 n Click Next
 o Offset Range

 n Automatic: Left -150 Right 150
 n Click Next

 o Elevation Range
 n Click Next

 o Section Display Options
 n Verify Style: CAiCE codes

 n Click Create Section Views
 2. Change labels (add Elev Off label for right clear zone break point)

 o Elevation Offset labels controlled by point codes. Slope labels controlled by link codes
 o Toolspace > Prospector > Corridors > prrmp10 > Right click. Click Properties

 n Codes tab > Click Edit Current Selection
 n Right click "Point". Click Add

 n Click OK for Marker Style: "_No Display"
 n Code will come up as "NEW CODE" Click to edit and change to "CZR".
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 n Change Label Style to Elevation Offset Rotated. Click OK
 n Click OK (3x).

 o You may not be able to get labels to match identically since they are controlled dif-
ferently in Civil 3D than CAiCE.
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AutoCAD fundamentals
AutoCAD basic creation and editing
Last updated: 2023-01-04

Total video time: 28:31

There are several tools available in Civil 3D that are intended for basic geometry object creation. 
These basic objects can either be an end product such as with a standard detail layout or they can be 
used as a foundation from which to create Civil 3D objects. This section will focus on using basic Line, 
Polyline, 3D Polyline, Rectangle, Curve and Circle tools along with basic Object Snap settings to cre-
ate geometry for a standard detail drawing.

Osnap & Line

Exercise files: acad-data-c3d20.zip

Start with acad-basc-creat-edit-begin.dwg

acad-basc-creat-edit-01.mp4 3:56

Line

One of the most basic geometry objects available is the Line. In Civil 3D, a single Line has two ver-
tices with independent locations and elevations. The Line is often used as a starting point or guide by 
which other objects are laid out.

 1. Open acad-basc-creat-edit-begin.dwg

 2. Ribbon > Home tab > Draw panel > Line icon > Create Line  (l Enter for command 
line option)

 A. Specify first point

 I. Left-click
 B. Specify next point

 I. Left-click
 3. Enter
 4. Activate ERASE command: eEnter

 A. select lines

 B. Enter

Info: Another option for erasing objects is to select an object and press the delete key.

Info: Keying Enter immediately after a command is finished executing will repeat the same 
command.

Info: Keying Spacebar executes an active command the same way as keying Enter

Page: 335

Published on: 5/17/2023

AutoCAD fundamentals

https://c3dkb.dot.wi.gov/data/acad/acad-data-c3d20.zip
https://c3dkb.dot.wi.gov/video/acad/acad-basc-creat-edit-01.mp4


Object snaps

When laying out object geometry or specifying a location when prompted in a command, it is often 
helpful to be able to reference existing object geometry. The object snap tool is built for just that. 
When Object Snaps are turned on (as a system variable) and you are prompted to specify a location 
within a command you can "snap" to the exact point desired based on the type of Object Snap 
turned on simply by moving the cursor within an Object Snap tolerance distance from that point. 
There are multiple ways to turn on Object Snaps for either "one-time" use or to remain on until 
turned off. We will cover these and other uses of Object Snaps in a later training module. This sec-
tion is intended to show what Object Snaps are and provide a few examples of their use.

 1. Continue working in acad-basc-creat-edit-begin.dwg
 2. Status Bar > right-click Object Snap icon

 A. Endpoint: checked
 B. Center: checked

 3. Status Bar > right-click Object Snap icon
 A. Object Snap Settings

 I. Object Snap On = checked
 II. OK
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 4. Ribbon > Home tab > Draw panel > Line icon > Create Line
 A. Move cursor near bottom endpoint of red guiding line on left side of Section A-A
 B. Observe Endpoint Object Snap glyph appear

 I. Left-click
 C. Move cursor near bottom endpoint of red guiding line on right side of Section A-A

 I. Left-click

 D. Esc to end command

 I. 

Info: F3 is a "hotkey" that will toggle Object Snaps on/off
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 5. Tips: A common theme you will notice in Civil 3D is that there are multiple ways to 
access the same commands. Toggling Object Snaps on via Object Snaps Settings vs 
the F3 hotkey is only one example. With experience you will find the personal work-
flows you are comfortable with, thus reducing the some of the complexity of Civil 3D.

Polyline

Start with acad-basc-creat-edit-begin.dwg

acad-basc-creat-edit-02.mp4 4:46

A Polyline is arguably one of the most versatile basic AutoCAD drawing objects. It can be edited in 
many ways including joining multiple linear geometry objects to one, adding/removing vertices, 
adding/removing curves and more. In addition, many Civil 3D objects can be created from a Polyline, 
thus allowing you to set geometry in place using the simpler Polyline object then generate more 
powerful objects necessary for Civil 3D workflows. This section focuses on basic Polyline creation. It 
should be noted that when adding elevation data to your objects, a Line can have different elev-
ations at start and end vertices, while a Polyline can have only one elevation for all vertices.

 1. Continue working in acad-basc-creat-edit-begin.dwg
 2. Ribbon > Home tab > Draw panel > Line icon > Create Line

 A. left click below SECTION B-B
 B. left click at a higher point to the right of the first
 C. left click to create to create a peak shape with the line
 D. esc

 3. Ribbon > Home tab > Draw panel > Polyline 

Info: PL is a command alias that will activate the Polyline command. A command alias 
is an alternative to activating a command from the Ribbon or typing the full name of 
the command on the command line. Simply begin typing any command alias when 
your drawing area (i.e. Model space) is active to call it up on the command line
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 A. Follow the command prompts and create a polyline directly below the line created in 
the last step. 

 B. Confrim in the properties of the polyline that the elevation values are the same on 
each vertex

 C. E Enter for the ERASE command
 I. select the lines and polyline

 II. spacebar to exit command
 4. Check to be sure Endpoint and Center object snaps are on.
 5. Command Line > PL spacebar

 A. Move cursor near  red guiding circle on left side of Section A-A
 I. left click

 B. Move cursor near  red guiding circle on just to the left of of Section A-A
 I. left click

 C. Mid-command option: A
 I. Enter

 II. Move cursor near endpoint of subgrade Line
 a. Left click

 b. Enter

 6. Ribbon > Home tab > Draw panel > Polyline
 A. Begin drawing Polyline border using outermost guiding circles
 B. Command line prompt:  Close

3D polyline & rectangle

Start with acad-basc-creat-edit-begin.dwg

acad-basc-creat-edit-03.mp4 4:53

3D Polyline

A 3D Polyline behaves in many ways the same as a Polyline. The chief difference is that a 3D Polyline 
can have different elevations at each of its vertices. Having multiple vertex elevations assigned 
ahead of time can be useful when creating a Civil 3D object such as a Feature Line, Surface Breakline, 
or Pipe Network from a 3D Polyline.

 1. Continue working in acad-basc-creat-edit-begin.dwg

 2. Select Polyline border

 3. Properties palette > expand Geometry > Elevation = 100

 A. Cycle Current Vertex

 B. Observe same elevation for all vertices
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 4. Delete

 5. Ribbon > Home tab > Draw panel > Draw dropdown > 3D Polyline button
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 6. Begin drawing 3D Polyline border using outermost guiding circles

 7. command line: C

 8. Enter

Info: 3DPOLY is a command alias that will activate the 3D Polyline command. A command alias 
is an alternative to activating a command from the Ribbon or typing the full name of the com-
mand on the command line. Simply begin typing any command alias  on the command line to 
access the associated command.

 9. Select 3D Polyline > Properties palette > expand Geometry > Elevation = 100

 10. Cycle Current Vertex

 A. Observe different elevation for other vertices

 B. These vertex elevations can be manually changed within the Properties palette.

Rectangle

The Rectangle command creates a closed Polyline with rectangle geometry. This simplifies the cre-
ation of a Polyline using the common rectangle shape.

 1. Continue working in acad-basc-creat-edit-begin.dwg
 2. Select 3D Polyline border

 A. delete

 3. Ribbon > Home tab > Draw panel > Rectangle button 
 A. Specify first corner

 I. Snap to upper left guiding circle
 B. Specify second corner

 I. Snap to lower right guiding circle

Page: 341

Published on: 5/17/2023

3D polyline & rectangle



 4. Spacebar
 A. Repeat the last steps around "6" text on left side of drawn objects

 5. Command line: RECT Enter 
 A. Snap to guiding circle around "6" text on right side of drawn objects
 B. D

 I. Enter
 C. 2.8

 I. Enter
 D. 11.6

 I. Enter
 E. Move cursor to upper right quadrant relative to Rectangle starting corner

 I. Left-click

Curve & Circle

Start with acad-basc-creat-edit-begin.dwg

acad-basc-creat-edit-04.mp4 4:43

Curve

The Curve command includes several variations that use existing reference objects (i.e. tangent 
Lines) to create single radius, compound, or reverse curves. The object created is referred to as an 
Arc. The curve command can be helpful when laying out geometry from which to create a smart Civil 
3D object.

 1. Continue working in acad-basc-creat-edit-begin.dwg
 2. Ribbon > Home tab > Draw panel > Curve flyout > Create Curve on Two Lines  

 3. Select edge of paved median shoulder (Section A-A) as first tangent
 4. Select left edge of asphalt concrete hatch boundary as second tangent

 A. Radius: 3
 I. Enter

 5. Ribbon > Home tab > Draw panel > Curve flyout > Create Curves between Two Lines
 1. Select one Section B-B Median Foreslope Line as first tangent
 2.  Select other Section B-B Median Foreslope Line as second tangent

 A. R

 I. Enter
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 B. Specify Radius: 20 Enter

Circle

The Circle command creates an object with circular geometry. Civil 3D refers to the object as a Circle. 
If a Circle object is trimmed, it becomes an Arc object. Several options are built into the command 
from which to dictate the radius and location of the Circle.

Continue working in acad-basc-creat-edit-02.dwg

 1. Ribbon > Home tab > Draw panel > Circle flyout > Center, Radius

 2. Ensure Center Object Snap is toggled on: F3

 3. Pan and Zoom to Plan View, R3-4 signage

 4. Move cursor over existing signage Arcs to activate Center Object Snap glyph

 5. Left-click
Page: 343

Published on: 5/17/2023

Curve & Circle



 6. Specify radius of circle: 2.4

 7. Zoom Extents

Object Selection

Start with acad-basc-creat-edit-02.dwg

acad-basc-creat-edit-05.mp4 5:52

In order to direct commands or apply edits to an object, the objects must be selected.  In many cases 
this can be either before or after a command is activated. This is referred to as "pick first" or "pick 
last". Selecting an object is also a way to gather information about the object via the Properties 
palette. Objects can be selected using a variety of methods. In this section we will cover simple 
cursor selection, Window, Crossing, Lasso, Fence and Quick Selection. We will also cover ways to 
deselect, append and edit the current selection without need to start your selection over from 
scratch. 
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Properties palette population

When the Properties palette is open, selecting an object or group of objects will populate the Prop-
erties palette with object information common to the entire selection. 

 1. Open acad-basc-creat-edit-02.dwg
 2. Methods for activating the Properties palette

 A. Command line > PROPERTIES

 B. Ribbon > Home tab > Palettes panel > Properties 
 C. Ctrl + 1
 D. Select an object > right-click > Properties

 3. esc to deselect

Cursor PickBox selection

 1. Continue working in acad-basc-creat-edit-02.dwg
 A. Move cursor PickBox over any object geometry in Model space

 I. Left-click to select object
 II. esc to deselect

Left to Right Window Select

All objects completely enclosed by a left to right window selection will be included in the Selection 
Set. Objects to be selected are highlighted white in a blue background.
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 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Move cursor left of desired object(s)

 A. Left-click to activate Window Selection
 B. Release mouse button
 C. Move cursor right of desired object(s)
 D. Left-click to specify selection area
 E. esc to deselect

Right to Left Crossing Window Select

All objects enclosed or crossed by a right to left crossing window selection will be included in the 
Selection Set. Objects to be selected are highlighted white in a green background.
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 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Move cursor right of desired object(s)

 A. Left-click to activate Crossing Selection
 B. Release mouse button
 C. Move cursor left of desired object(s)
 D. Left-click to specify selection area
 E. esc to deselect

Fence Select

All objects crossed by a fence selection path will be included in the Selection Set. A fence can have 
any number of vertices in any direction. Objects to be selected are highlighted white.

 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Move cursor to desired location of Fence

 A. Left-click to activate Selection
 I. Command Line > F

 II. Enter
 a. Left-click to create additional Fence path vertices
 b. Enter
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 c. Esc

Left to Right Window Polygon Select

Similar to the Left to Right Window Selection, all objects completely enclosed by a Left to Right Win-
dow Polygon Selection will be included in the Selection Set. Objects to be selected are highlighted 
white in a blue background.

 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Move cursor to desired initial vertex of Window Polygon

 A. Left-click to activate Selection
 I. Command Line > WP

 II. Enter
 a. Moving clockwise, Left-click to create successive Window Polygon ver-

tices
 b. Enter
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 c. Esc to deselect

Crossing Window Polygon Select

Similar to the standard Right to Left Crossing Window Selection, all objects at least enclosed or 
crossed by a Right to 
Left Crossing Polygon Selection will be included in the Selection Set. Objects to be selected are high-
lighted white in a green background.

 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Move cursor to desired initial vertex of Window Polygon

 A. Left-click to activate Selection
 I. Command Line > CP

 II. Enter
 a. Left-click to create successive Window Polygon vertices
 b. Enter
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 c. Esc to deselect

Lasso Select

Similar to both standard Window/Crossing or Polygon Window/Crossing Selection, a Lasso selection 
can be applied either clockwise or counter-clockwise. Objects to be selected are highlighted white.

 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Move cursor to desired initial start point of Lasso Selection

 A. Left-click and hold mouse button to activate Lasso Selection
 B. Move cursor along desired boundary of Lasso Selection
 C. Release mouse button
 D. esc to deselect
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Quick Select

The Quick Select tool allows you to build a selection query based on object properties. The query can 
either be inclusive (select what is queried) or exclusive (select all but what is queried). The query can 
also be set to append or replace any current selection set.
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 1. Continue working in acad-basc-creat-edit-02.dwg
 A. Right-click > Quick Select

 I. Apply to = Entire drawing
 II. Object type = Line

 III. Operator = Select All
 IV. Include in new selection set = checked
 V. Append to current selection = checked

 VI. OK
 B. esc to deselect

Editing current selection

Once multiple objects are selected, you may wish to remove certain objects from the selection set. 
To switch selection tools from selecting to deselecting, hold the Shift key while performing the selec-
tion in Model Space. A "-" glyph indicating deselection will appear next to the cursor when holding 
the Shift key and hovering over an object in the current selection set.
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 1. Continue working in acad-basc-creat-edit-end.dwg
 A. Select multiple objects
 B. Hold Shift

 I. Use cursor selection to deselect objects from the selection set
 C. esc to deselect all

Grips

Start with acad-basc-creat-edit-end.dwg

acad-basc-creat-edit-06.mp4 4:21

When an object is selected, Grips will be displayed along the object. These Grips make various geo-
metric object edits available. They are generally located at key points along or adjacent to an object 
(i.e Line endpoints/midpoint or Arc endpoints/midpoint/radius point. To edit an object based on a 
Grip, click on a Grip or hover over it and choose from available Grip options. There are several 
advanced object edits that can be performed using grips. Many of these will be covered in a later 
training module. This section will cover a sample of basic grip functions. This is intended to provide a 
general understanding of grips as a foundation for further independent exploration.

Tips: When performing grip edits, displacement values can be keyed in or spe-
cified by mouse click.

Line grips

When a Line is selected, three Grips are displayed. The two endpoint Grips allow you move/stretch 
or lengthen the respective endpoint independently. The midpoint Grip allows you to move the Line 
with the midpoint as a basepoint, keeping all other geometry properties intact (i.e. length, rotation).
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 1. Open acad-basc-creat-edit-end.dwg
 2. Select Line representing subgrade

 A. Left-click endpoint Grip
 I. Move mouse

 II. Left-click to place new endpoint
 B. Hover over endpoint Grip

 I. Lengthen
 a. Move mouse
 b. Left-click to place new endpoint

 C. Left-click midpoint Grip
 I. Move mouse

 II. Left-click to place line in new location
 D. esc to deselect

Arc grips

When an Arc is selected, four Grips are displayed. The two endpoint vertex Grips allow you 
move/stretch or lengthen the respective vertex independently. The midpoint Grip allows you to 
change the radius of the arc keeping intact either the location of the endpoint vertices or their align-
ment with the radius point. The radius point grip allows you to move the arc with the radius point as 
a basepoint,  keeping all other geometry properties intact (i.e. radius).
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 1. Continue working in acad-basc-creat-edit-end.dwg
 2.  Select Arc representing median nose

 A. Left-click centerpoint Grip
 I. Move mouse

 II. Left-click to place in new location
 B. Hover over midpoint Grip

 I. Stretch
 a. Move mouse
 b. Left-click to place new endpoint

 C. Hover over midpoint Grip
 I. Radius

 a. Move mouse
 b. Left-click to set new radius

 D. Hover over endpoint Grip
 I. Stretch

 a. Move mouse
 b. Left-click to place new endpoint

 E. Hover over endpoint Grip
 I. Lengthen

 a. Move mouse
 b. Left-click to place new endpoint

 F. esc to deselect
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Polyline grips

When a Polyline is selected, square Grips are displayed at all vertices and dash Grips are displayed at 
all line segment midpoints. Endpoint vertex Grips allow you stretch (i.e. move) the respective vertex 
independently or add a vertex adjacent to the endpoint. The midpoint Grip allows you to stretch the 
line segment, add a vertex between the two adjacent endpoint vertices, or convert the line segment 
to an arc. When stretching a line segment, the length and rotation geometry of the selected line seg-
ment stays intact. Geometry of any adjacent line segments will adjust as necessary. When converting 
a Polyline line segment to arc, a radius must be specified. A Polyline arc segment can also be con-
verted back to a line segment.

 1. Continue working in acad-basc-creat-edit-end.dwg
 2. Select the polyline representing bottom of base course

 A. Hover over endpoint Grip
 I. Add Vertex

 a. Move mouse
 b. Left-click to place new vertex

 B. Hover over midpoint Grip
 I. Add Vertex

 a. Move mouse
 b. Left-click to place segment in new location
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 C. Hover over Polyline line segment midpoint Grip
 I. Convert to Arc

 a. Move mouse
 b. Left-click to place set radius

 D. Hover over Polyline arc segment midpoint Grip
 I. Convert to Line

 E. esc to deselect

Object snaps
Last updated: 2023-01-04

Total video time: 18:14

Object Snaps are tools built into Civil 3D that help ensure precision when laying out geometry with 
both basic objects (i.e. Line, Polyline) and smart Civil 3D objects. The idea is that when specifying loc-
ation during a command, a given Object Snap will force the location to be at the exact specified 
object point when the command is active and your cursor is within the Object Snap buffer distance. 
When an Object Snap is ready to take effect, a glyph will appear indicating the type of Object Snap 
and location of the snap point.

Object snap glyphs

Object 
Snap Glyph Image Object 

Snap Glyph Image

Endpoint Extension

Midpoint Insertion
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Object 
Snap Glyph Image Object 

Snap Glyph Image

Center
Per-
pendicular

Geometric 
Center

Tangent

Node Nearest

Quadrant
Apparent 
Intersection

Inter-
section

Parallel
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Introduction & settings

Exercise files: acad-data-c3d20.zip

Start with acad-objct-snp-begin.dwg

acad-objct-snp-01.mp4 4:17

Access to settings

There are a few different ways to access Object Snap settings.

 1. Open acad-objct-snp-begin.dwg
 2. Status Bar > Customization

 A. 2D Object Snaps = checked
 B. Press icon to Turn on Object Snaps
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 3. Status Bar > Object Snap icon
 A. Right-click on 2D Object Snap icon
 B. Place checkmark to turn on individual Object Snaps
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 4. Status Bar > Object Snap icon

 A. Left-click flyout triangle 
 B. Observe access to running Object Snaps list

 I. Object Snap Settings...
 a. Drafting Settings dialog box, Object Snap tab
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 a. Object Snap On = checked
 b. Select All
 c. Clear All
 d. Midpoint = checked
 e. OK

 C. Ribbon > Home tab > Draw panel > Polyline button
 I. Turn on Midpoint Object Snap

 II. Move cursor over objects
 a. Observe Midpoint glyph appear
 b. esc to deselect

 5. Model space
 A.  Shift+right-click

 I. Osnap Settings...
 B. Observe access to Drafting Settings dialog, Object Snap tab

Introduction to Object Snap use

In this example you will use the Midpoint Snap to move Mtext to the correct location on a title block.
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 1. Continue working in  acad-intrfc-begin.dwg
 2. Status Bar > Object Snap icon

 A. Right-click
 I. Midpoint = checked

 3. Select "MAINTAINENCE CROSSOVER FOR FREEWAYS" Mtext object
 A. Select insertion point grip

 I. Move cursor near middle of red construction line
 II. Observe Midpoint glyph appear

 III. Left-click

 B. Select red construction line
 I. delete

Workflow efficiency

Start with acad-objct-snp-begin.dwg

acad-objct-snp-02.mp4 3:37

F3 hotkey

A "alias" is essentially a single keystroke shortcut designed to streamline execution of a task or string 
of tasks. Many hotkeys are programmed and ready for use in Civil 3D. The"F3" key is one powerful 
hotkey relevant to Object Snap use. You might incorporate this into your typical Object Snap work-
flow to improve efficiency.

 1. Continue working in acad-objct-snp-begin.dwg
 2. Toggle Object Snaps off: F3
 3. Toggle Object Snaps on: F3
 4. Ribbon > Home tab > Draw panel > Polyline button

 A. Hold F3
 B. Hover over a Line object
 C. Observe that Object Snaps are temporarily suppressed
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Object snap cycling

Pressing the tab key allows you to cycle through Object Snaps relevant to a given object as long as 
those Object Snaps are turned on.

 1. Continue working in acad-objct-snp-begin.dwg
 2. Status Bar > Object Snap icon

 A. Right-click
 I. Endpoint = checked

 II. Midpoint = checked
 B. Verify Object Snaps turned on

 3. Ribbon > Home tab > Draw panel > Polyline button
 A. Hover cursor over middle of EDGE OF PAVED MEDIAN SHOULDER Line

 I. Observe Midpoint glyph appear
 II. tab

 III. tab
 IV. tab

System variable: ignore elevation

By default, Civil 3D will apply existing geometry elevation  when using Object Snaps and existing geo-
metry to specify location. You can change this behavior so elevation properties are ignored and only 
location in the X,Y plane are used when "snapping". This is done by resetting the OSNAPZ System 
Variable. When this is done, the elevation Z=0 will be used for new location specification.

 1. Continue working in acad-objct-snp-begin.dwg
 2. Ribbon > Home tab > Draw panel > Polyline button

 A. Draw a single Polyline
 I. Select Polyline drawn

 II. Properties Palette > Geometry
 a. Set Elevation = 100
 b. esc
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 3. Ribbon > Home tab > Draw panel > Polyline button
 A. Use Endpoint Snap to specify location on end of Polyline drawn in 2.A

 I. Select Polyline drawn
 II. Properties Palette > Geometry

 a. Observe Elevation = 100
 4. Command line: OSNAPZ

 A. enter
 B. 1

 C. enter
 5. Ribbon > Home tab > Draw panel > Polyline button

 A. Use Endpoint Snap to specify location on end of Polyline drawn in 2.A
 I. Select Polyline drawn

 II. Properties Palette > Geometry
 a. Observe Elevation = 0

 6. Select previous three Polylines drawn
 A. delete

Temporary overrides

Calling up temporary Object Snap overrides either through the command line or right-click menu 
allows a "one-time use" override to current Object Snap settings. For example, you could have End-
point Object Snaps currently on, then use a temporary Midpoint Object Snap override to ignore all 
Endpoint Snaps and use Midpoint Snaps for the next location specification. Alternatively you might 
have all running Object Snaps off, then use any temporary Object Snap overrides as you need them 
for the next location specification. This temporary override workflow avoids the need to open a run-
ning Object Snap interface and thus can improve efficiency.

After a command requiring location input is activated, hold Shift key and right-click to open the tem-
porary Object Snap override menu. Choose a one-time use temporary Object Snap override from 
this list. Continue location specification.

 1. Continue working in acad-objct-snp-begin.dwg
 2. Turn on running Endpoint Object Snap using your method of choice
 3. Ribbon > Home tab > Draw panel > Polyline button

 A.  Shift+Right-click
 I. Midpoint

 B. Left-click first endpoint and then second endpoint of line you want to midpoint snap 
to.

Example 1

Start with acad-objct-snp-begin.dwg

acad-objct-snp-03.mp4 4:48
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Geometric Center

This Object Snap analyzes any closed area object and snaps to the centroid of that area. The object 
can be irregularly shaped, but must show as "closed" in the properties palette for the Geometric 
Center snap to work.

 1. Continue working in acad-objct-snp-begin.dwg
 2. Turn on running Geometric Center Object Snap using your method of choice
 3. Select "6" Mtext at right of drawing extents

 A. Select middle-center Mtext insertion point
 I. Move cursor to hover over adjacent rectangular closed Polyline

 II. Observe Geometric Center glyph appear
 III. Left-click

Quadrant

This Object Snap grabs the location on a Circle, Ellispse or Arc object intersecting with any of the four 
2D quadrant lines (i.e. along X or Y axis).

 1. Continue working in acad-objct-snp-begin.dwg
 2. Turn on running Node Object Snap using your method of choice.

 A. Observe the behavior of the Node Object Snap glyph as you hover over different 
objects.

 3. Turn on running Quadrant Object Snap using your method of choice.
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 4. Select Line representing signage in the PLAN VIEW area of drawing extents
 A. M enter

 I. Shift+Right-click
 a. Midpoint

 B. Move cursor near Circle representing sign post in PLAN VIEW area of drawing extents
 I. Observe Quadrant glyph along positive X-axis appear

 II. Left-click

 5. Turn on running Intersection Object Snap using your method of choice.
 A. Observe glyph behavior as you hover over any area of intersecting geometry. 

Examples 2

Start with acad-objct-snp-01.dwg

acad-objct-snp-04.mp4 5:32

Extension

The Extension Object Snap will find a point on a projected extension of a drawing object.

 1. Open  acad-objct-snp-01.dwg
 2. Turn on running Extension Object Snaps using your method of choice.
 3. Ribbon > Home tab > Draw panel > Polyline button

 A. Move cursor near any arc in PLAN VIEW area of drawing extents
 I. Observe Extension Object Snap glyph appear and that it shows a continuing 

green extension of the arc as you move outside of the arc.

Page: 367

Published on: 5/17/2023

Examples 2

https://c3dkb.dot.wi.gov/video/acad/acad-objct-snp-04.mp4


 II. Left-click
 B. Move cursor near a line and extend along the path of the line past its endpoint and 

notice the same green extension appear. 
 C. esc

Insertion

The Insertion Object Snap will snap to the insertion point of objects such as blocks or text. 

 1. Open  acad-objct-snp-01.dwg
 2. Turn on running Insertion Object Snaps using your method of choice
 3. Ribbon > Home tab > Draw panel > Polyline button

 A. Move cursor near any block or text in the drawing. 
 I. Observe Insertion Object Snap glyph appear at the insertion point of the object.

 B. esc

Perpendicular

The Perpendicular Object Snap will snap perpendicular to any object such as a line or polyline in rela-
tion to the object being drawn. 

 1. Open  acad-objct-snp-01.dwg
 2. Turn on running Perpendicular Object Snaps using your method of choice.
 3. Ribbon > Home tab > Draw panel > Polyline button

 A. Click any point in the drawing.
 B. Hover near any line or other object in the drawing for your second point. 

 I. Observe Perpendicular Object Snap glyph appear at the perpendicular point of 
the other object. 

 C. esc

Tangent

The Tangent Object Snap finds the point of tangency on a Circle, Arc, or Ellipse object coming in from 
any Line or Polyline object.

 1. Open  acad-objct-snp-01.dwg
 2. Turn on running Tangent Object Snaps using your method of choice.
 3. Ribbon > Home tab > Draw panel > Create Line

 A. Move cursor near  PLAN VIEW area of drawing extents.
 I. Left-click anywhere to place first point. 

 B. Move cursor near Circle representing median back of curb in PLAN VIEW area of draw-
ing extents

 I. Observe Tangent Object Snap glyph appear
 II. Left-click to create line tangent to the circle.

Nearest

The Nearest Object Snap will anywhere on an object nearest to where the user clicks. 
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 1. Open  acad-objct-snp-01.dwg
 2. Turn on running Nearest Object Snaps using your method of choice
 3. Ribbon > Home tab > Draw panel > Polyline button

 A. Click any point in the drawing.
 B. Hover near any line or other object in the drawing and observe the Nearest Object 

Snap glyph appear. 
 C. esc

Parallel and Apparent Intersection

Use the Parallel Object Snap to lay out new linear objects while referencing existing linear objects for 
directional orientation. You will first start the new linear object command (i.e. Line), then hover over 
the desired linear reference object. This will activate the Parellel Object Snap and you will see a 
dashed extension line as a preview of your new linear object draw parallel to that existing. Apparent 
Intersection Object Snap allows a user to snap to where two objects would intersect even if they do 
not actually connect. This object snap will extrapolate the linework to find the point at which the 
objects would intersect if they were extended far enough to intersect. 

 1. Continue working in  acad-objct-snp-01.dwg
 2. Turn on running Enpoint, Apparent Intersection and Parallel Object Snaps using your method 

of choice
 3. Ribbon > Home tab > Draw panel > Line flyout > Polyline button

 A. Move cursor near upper right of SECTION A-A, CRUSHED AGGREGATE BASE COURSE 
border Line

 I. Observe Endpoint Object Snap glyph appear
 II. Left-click

 B. Move cursor to hover over adjacent TOPSOIL Line
 I.  Observe Parallel Object Snap glyph appear

 C. Move cursor along path from the new Line starting vertex parallel to TOPSOIL Line
 I. Observe Parallel preview line appear

 D. Move cursor to point of intersection of parallel preview line and existing BOTTOM OF 
MEDIAN Line.

 I. Observe Apparent Intersection Object Snap glyph appear
 II. Left-click

Polar and osnap tracking
Last updated: 2023-01-04

Total video time: 14:01

Both Polar Tracking and Object Snap (aka Osnap) Tracking are tools designed to streamline the pro-
cess of specifying location precisely when executing a command. Polar tracking allows "snapping" 
along vectors based on preset angle increments around an initially specified point. Osnap Tracking 
allows projection out from existing Osnap locations to specify the next command location. These pro-
jection vectors can come from multiple Osnap locations and can use current Polar Tracking angles to 
form the projections. Once you become familiar with the tools, both Polar Tracking and Object Track-
ing can greatly improve efficiency when specifying command location.
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Polar Tracking

Exercise files: acad-data-c3d20.zip

Start with acad-polr-osnp-trak-begin.dwg

acad-polr-osnp-trak-01.mp4 4:33

Basics

This section will get you started using Polar Tracking with an example exercise laying out title block 
Lines.

 1. Open acad-polr-osnp-trak-begin.dwg
 2. Status Bar > Customization flyout

 A. Polar Tracking = checked
 3. Status Bar

 A. Polar Tracking on

 4. Ribbon > Home tab > Draw panel > Polyline button
 A. Left-click anywhere in Model space to specify first points
 B. Rotate cursor around first point location
 C. Observe Polar Tracking vector "snapping"

 5. Status Bar > Polar Tracking icon
 A. Right-click

 I. Increment = 45, 90, 135, 180...
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 6. Status Bar
 A. Dynamic Input off
 B. Polar Tracking off
 C. Center Object Snap on

 7. Zoom to lower right of drawing extents
 8. Ribbon > Home tab > Draw panel > Polyline button

 A. Snap to bottom red guiding Circle for first point
 I. @26<180 Enter

 II. Enter
 B. Enter
 C. Status Bar

 I. Dynamic Input on
 D. Snap to middle red guiding Circle for first point

 I. 26

 II. tab
 III. 180

 a. Enter
 9. Status Bar

 A. Dynamic Input off
 B. Polar Tracking on

 I. Increment = 90, 180, 270, 360...
 10. Ribbon > Home tab > Draw panel > Polyline button

 A. Snap to top red guiding Circle for first point
 I. Move cursor until 180 deg Polar Tracking vector appears

 a. 26

 i. enter
 II. Move cursor until 270 deg Polar Tracking vector appears

 a. 16.5

 i. enter
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Access to settings

Start with acad-polr-osnp-trak-01.dwg

acad-polr-osnp-trak-02.mp4 3:46

You can customize the way Polar Tracking works based on your preferences and/or workflow needs. 
Here you will be able to add increment angles, additional angles (single angle relative to 0 deg), set 
display preferences, set Osnap Tracking interaction preferences, and toggle between relative (dir-
ection of last drawn line segment is assumed as 0 deg) and absolute angle measurement. This sec-
tion will walk you through these settings and their effect on Polar Tracking function.

 1. Open acad-polr-osnp-trak-begin.dwg
 2. Status Bar > Polar Tracking icon > Polar Tracking flyout > Tracking Settings

 A. Polar Tracking On = checked
 B. Polar Angle Settings

 I. Increment angle = 60
 C. OK
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 3. Ribbon > Home tab > Draw panel > Polyline button
 A. Left-click in anywhere in Model space to specify first point

 I. Rotate cursor around first point
 II. Observe 60 deg Polar Tracking angle increments

 B. esc
 4. Status Bar > Polar Tracking icon > Polar Tracking flyout > Tracking Settings

 A. Polar Angle Settings
 I. Additional angles = checked

 II. New
 III. 75

 B. OK
 5. Ribbon > Home tab > Draw panel > Polyline button

 A. Left-click in anywhere in Model space to specify first point
 I. Rotate cursor around first point

 II. Observe 75 deg Polar Tracking additional angle
 B. esc

 6. Status Bar > Polar Tracking icon > Polar Tracking flyout > Tracking Settings

Info: Clicking on the Options button inside of the Tracking Settings dialog box brings 
up the Options dialog box. Located in the upper-right corner are the on-screen visual 
options for AutoTrack which can be toggled ON/OFF.

Object Snap Tracking

Start with acad-polr-osnp-trak-02.dwg

acad-polr-osnp-trak-03.mp4 5:42

In this section you will be introduced to the Object Snap (aka Osnap) Tracking tool including func-
tionality when combined with Polar Tracking and Dynamic Input. Keep in mind that for Object Snap 
Tracking to take effect, you will first need to have at least one Osnap turned on.

Basics

 1. Open acad-polr-osnp-trak-02.dwg
 2. Status Bar

 A. Polar Tracking on
 B. Object Snap Tracking on
 C. Object Snap on

 3. Status Bar > Polar Tracking icon > Polar Tracking flyout
 A. Increment = 45, 90, 135, 180...

 4. Status Bar > Object Snap icon > Object Snap flyout
 A. Endpoint = checked

 5. Ribbon > Home tab > Draw panel > Polyline button
 6. Move cursor to hover over a Line endpoint

 A. Observe Object Snap Tracking activate
 B. Rotate cursor around active Object Snap Tracking location

Page: 373

Published on: 5/17/2023

Object Snap Tracking

https://c3dkb.dot.wi.gov/video/acad/acad-polr-osnp-trak-03.mp4


 C. Observe Tracking vectors available based on Polar Tracking increments
 7. Move cursor to hover over additional endpoint

 A. Move cursor until Tracking vectors intersect

 8. Status Bar > Polar Tracking icon > Polar Tracking flyout > Tracking Settings...
 A. Object Snap Tracking Settings

 I. Track orthogonally only = checked
 B. OK

 9. Ribbon > Home tab > Draw panel > Polyline button
 A. Move cursor to hover over a Line endpoint
 B. Observe Object Snap Tracking activate
 C. Rotate cursor around active Object Snap Tracking location
 D. Observe Tracking vectors available based on x and y-axes only

 10. Move cursor to hover over activated Object Snap Tracking location again to deactivate

Exercise: align objects

 1. Continue working in acad-polr-osnp-trak-02.dwg
 2. Status Bar > Object Snap icon > Object Snap flyout

 A. Midpoint = checked
 B. Insertion Point = checked

 3. Select both SECTION A-A and SECTION B-B Mtext objects
 A. Hold shift

 I. Select middle insertion point grips on both Mtext objects
 II. Note grip color change to red

 A. Release shift
 4. Select one red Mtext grip to begin Move command

 A. Move cursor to hover over insertion point grip
 I. Observe insertion point Osnap Tracking activate

 B. Move cursor to hover over midpoint of top sheet border Line
 I. Observe midpoint Osnap Tracking activate
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 C. Move cursor to intersection of Osnap Tracking vectors
 D. Left-click to specify destination location for Move command

Exercise: lay out geometry

 1. Continue working in acad-polr-osnp-trak-02.dwg
 2. Status Bar > Object Snap icon > Object Snap flyout

 A. Endpoint = checked
 3. Status Bar

 A. Object Snap Tracking on
 B. Polar Tracking on
 C. Dynamic Input on

 4. Ribbon > Home tab > Draw panel > Polyline button
 A. Move cursor to hover over lower right sheet border Line endpoint

 I. Observe Object Snap Tracking activation
 II. Move cursor left of Endpoint Snap location along 180 deg Object Snap Tracking 

vector 
 a. 26 enter
 b. Move cursor above Line first point along 90 deg Object Snap Tracking 

vector
 i. 16.5 enter

 c. Move cursor right of Line second point along 0 deg Object Snap Tracking 
vector
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 i. 26 enter

AutoCAD modify
Last updated: 2023-01-04

Total video time: 44:42

Modify commands are used to make changes to objects that have already been drawn. These com-
mands can greatly improve workflow efficiency by eliminating the need to re-create objects, stream-
lining object creation and location specification, combining multiple commands, and otherwise 
utilize existing geometry objects.

Move & Copy

Exercise files: acad-data-c3d20.zip

Start with acad-modify-begin.dwg

acad-modify-01.mp4 4:54
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Move

The Move command allows you to relocate objects either by keying in X, Y, Z displacement or by 
cursor-selecting a base point and destination point.

 1. Open acad-modify-begin.dwg
 2. Ribbon > Home tab > Modify panel > Move 

Info: m is a command line "alias" that also invokes the move command.

 A. Select objects: SD.D.11.A 1-3 text in lower right of drawing extents 

 B. spacebar

 C. Specify base point: lower right Endpoint of sheet border Line

 D. Specify second point: pick anywhere to place new base point location

 E. Ctrl+z  to undo previous command.

 3. sRibbon > Home tab > Modify panel > Move
 A. Select objects: SD.D.11.A 1-3 text in lower right of drawing extents 
 B. Displacement 

 I. Enter
 C. -50,0,0

 I. enter
 D. Ctrl+z to undo previous command.

Copy

The Copy command allows you to duplicate an existing object and then paste it to a location either 
by keying in X, Y, Z displacement or by cursor-selecting a base point and destination point.

 1. Continue working in acad-modify-begin.dwg
 2. Ribbon > Home tab > Modify panel > Copy 

Info: co is a command line "alias" that also invokes the copy command.

 A. Select objects: SD.D.11.A 1-3 text in lower right of drawing extents 

 I. Right-click or spacebar

 B. Specify second point: lower left Endpoint of sheet border Line

 C. Left-click multiple additional destination points

 D. Select copies made in above step and delete

 3. Ribbon > Home tab > Modify panel > Copy
 A. Select objects: SD.D.11.A 1-3 text in lower right of drawing extents 

 I. Right-click or spacebar
 B. Displacement

 I. enter
 C. -50,0,0

 I. enter
 D. Ctrl+z to undo previous command.
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 4. Ribbon > Home tab > Modify panel > Copy
 A. Select text to copy

 I. Right-click or spacebar
 B. Mode

 I. Multiple (allows multiple copies of selected objects)
 C. spacebar to end command

Rotate & Scale

Continue with acad-modify-begin.dwg

acad-modify-02.mp4 5:27

Rotate

The Rotate command allows you to rotate an object in the XY plane about a point either by keying in 
a rotation angle, selecting a relative rotation point, or picking two points to form a reference "line" 
and two points to form a destination rotation "line". 

 1. Continue working in acad-modify-begin.dwg
 2. Select SD.D.11.A 1-3 text in lower middle of drawing extents 

 A. Select the square grip on the text
 B. Place the grip at the lower left corner of the sheet border to move the text

 3. Ribbon > Home tab > Modify panel > Rotate (roEnter for command line hotkey option)

Info: ro is a command line "alias" that also invokes the rotate command.

 A. Specify base point: lower left corner of the sheet border

 B. Specify rotation angle: 180 enter

 4. Ribbon > Home tab > Modify panel > Rotate
 A. Select SD.D.11.A 1-3 text

 I. Right-click or spacebar
 II. Specify base point: lower left corner of the sheet border
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 III. Reference
 a. Left-click first and second reference angle points 

 b. Specify the new angle: p

 i. enter

 c. Left-click first and second new angle points 

Scale

The Scale command allows you to resize a selection of objects while holding a specified base point 
either by keying in a scale factor or referencing existing objects.

 1. Continue working in acad-modify-begin.dwg
 2. Double-click middle mouse wheel to Zoom Extents
 3. Window-Select full-sized "PLAN VIEW"

 A. delete
 4. Ribbon > Home tab > Modify panel > Scale

Info: sc is a command line "alias" that also invokes the scale command.

 A. Select objects: Window-Select half-size objects to left of full-size objects

 B. Specify base point: lower right of half-size border Line

 C. Specify scale factor: 2 enter

 D. Ctrl+z to undo last command
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 5. SC enter
 A. Window-Select half-sized objects to left of full-size objects
 B. Specify base point: lower right of half-size border Line
 C. R enter for Reference
 D. Specify reference length: Left-click beginning and end of bottom half-size border Line
 E. Specify new length: P enter

 I. Left-click beginning and end of bottom full-sized border Line
 6. Window Select "PLAN VIEW" objects that were Scaled up

 A. m enter
 B. Specify base point: lower left of bottom border Line that was Scaled up
 C. Specify second point: lower left of original full-size bottom border Line

 7. Select redundant border Lines
 A. delete

 8. Double-click middle mouse wheel to Zoom Extents

Join & Explode

Start with acad-modify-01.dwg

acad-modify-03.mp4 5:23

Join

The Join command will take all Line and/or Arcs objects included in a selection set that share com-
mon start and end point coordinates (same X,Y,Z) and combine them into a single Polyline.

 1. Open acad-modify-01.dwg

 2. Pan and zoom to PLAN VIEW detail

 3. Ribbon > Home tab > Modify panel flyout > Join 

Info: j is a command line "alias" that also invokes the join command.

 4. Select Lines and Arc representing median back of curb

 A. spacebar
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 5. Repeat above step on the other side. 
 6. Ribbon > Home tab > Modify panel flyout > Join
 7. Select all "breakline symbol" Polylines along right side of PLAN VIEW detail

 A. enter
 8. Observe "0 objects joined, 6 objects discarded..." on command line history
 9. Select  "breakline symbol" Polyline near bottom right of PLAN VIEW detail

 A. Left-click vertex grip
 B. Use Endpoint Object Snap to set vertex at same location as adjacent Polyline vertex
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 10. esc
 11. Ribbon > Home tab > Modify panel flyout > Join

 A. Select two Polylines whose vertices were aligned in previous step. 
 B. enter
 C. Observe "5 segments joined into 1 polyline" on command line history

 12. Ribbon > Home tab > Modify panel flyout > Join
 A. Select all 4 sides of sheet border.
 B. enter
 C. Observe "3 objects converted to 1 polyline, 1 objects discarded..." on command line 

history

 I. In the Properties palette, observe that the left sheet border line has a different 
elevation at its vertices than the polyline created with the previous join com-
mand. 

 II. Set the Z axis on the left line to 0.
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Info: All linework must be have the same elevation (Z) value in order for 
the join command to work. 

 D. Ribbon > Home tab > Modify panel flyout > Join
 I. Select all sheet border linework.

 II. enter
 III. Observe that the border is 1 polyline. 

Explode

The Explode command will break objects down into foundational pieces. For example, a single 
Polyline can be Exploded into multiple Lines and/or Arcs that make up the Polyline geometry.

Warning: Never Explode a Civil 3D Object (i.e. Alignment, Surface, Corridor). This will cause 
you to lose dynamic updating, labeling, data referencing and other powerful object func-
tionality. Thus, the Explode command should be limited to simple AutoCAD objects as demon-
strated in this section.

 

 1. Continue working in acad-modify-01.dwg

 2. Ribbon > Home tab > Modify panel > Explode

Info: x is a command line "alias" that also invokes the explode command.

 3. Select PLAN VIEW median Polyline previously Joined

 A. enter

 4. Zoom and pan to R3-4 signage detail

 5. x enter

 A. Select R3-4 Block

 B. enter

 6. x enter

 A. Select outermost Polyline resulting from the Exploded R3-4 Block

 B. enter
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Erase & Stretch

Continue with acad-modify-01.dwg

acad-modify-04.mp4 3:02

Erase

The Erase command allows you to remove a selection set of objects from a drawing. You can either 
invoke the command and then select objects to remove using your selection method of choice or 
vice-versa.

Tip: It is a good idea to hit esc a couple times before selecting objects to erase. This will ensure 
that you do not have objects selected that you do not intend to erase. Selected objects are not 
always visible depending your current Zoom level and Pan location. Your Properties Palette is 
a good place to check on what is included in the current selection set.

 

 1. Continue working in acad-modify-01.dwg

 2. Ribbon > Home tab > Modify panel > Erase
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Info: e is a command line "alias" that also invokes the erase command.

 3. Select outermost Lines surrounding the R3-4 and R3-4A details

 A. enter

Stretch

The Stretch command allows you to move objects and simultaneously lengthen and reorient adja-
cent objects while maintaining the original attachment location. After invoking the Stretch command, 
any objects completely enclosed in a Crossing selection will be moved and any objects partially 
enclosed in the same Crossing selection will be lengthened and reoriented.

 1. Continue working in acad-modify-01.dwg

 2. Ribbon > Home tab > Modify panel > Stretch

Info: str is a command line "alias" that also invokes the stretch command.
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 3. Use a Window Selection to select all "breakline symbol" Polylines on the left side of the PLAN 
VIEW detail

 A. enter

 B. Right-click to finish selection

 I. Left-click to specify base point

 II. Move Cursor and Left-click to specify second point

 III. Observe move-only behavior

 4. Ctrl+z to undo last command.

 5. Ribbon > Home tab > Modify panel > Stretch

 6. Use a Crossing Selection to select all "breakline symbol" Polylines on the left side of the PLAN 
VIEW detail

 A. enter
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 B. Right-click to finish selection

 I. Left-click to specify base point

 II. Move Cursor and Left-click to specify second point

 III. Observe intended Stretch behavior

Mirror & Offset

Start with acad-modify-02.dwg

acad-modify-05.mp4 5:52

Mirror

The Mirror command allows you to essentially copy, rotate, and paste an object in the X-Y plane 
about a mirror line you specify. You can then choose to keep or remove the original object you have 
mirrored. This can greatly reduce your task time  whenever you are creating object with an axis of 
symmetry in the X-Y plane.

 1. Open acad-modify-02.dwg

 2. Zoom and Pan to PLAN VIEW detail area of drawing

 3. Ribbon > Home tab > Modify panel > Mirror

Info: mi is a command line "alias" that also invokes the mirror command.

Page: 387

Published on: 5/17/2023

Mirror & Offset

https://c3dkb.dot.wi.gov/video/acad/acad-modify-05.mp4


 4. Select "section line arrow" and "B" Text in upper pavement area of PLAN VIEW detail

 A. Right-click

 B. Turn on Quadrant Osnap

 C. Use Quadrant Osnap to specify first point of mirror line at quadrant point on median 
Arc

 D. Use Quadrant Osnap to specify second point of mirror line at center of opposite 
median Arc

 A. Erase source objects: N

 I. enter

 5. mi enter

 A. Select "THROUGH PAVEMENT" Text and adjacent "arrow symbol"

 B. Right-click

 C. Turn on Midpoint Osnap

 D. Use Midpoint Osnap to specify first point of mirror line at upper midpoint of edge-of-
pavement Line

 E. Use Midpoint Osnap to specify second point of mirror line at lower midpoint of edge-
of-pavement Line
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 F. Erase source objects: N

 I. enter

 6. Select newly created "THROUGH PAVEMENT" Text and adjacent "arrow symbol"

 7. m enter

 A. Specify base point and second point to move objects to lower pavement area of PLAN 
VIEW detail

Offset

The Offset command allows you to create an object in reference to existing Polyline, Line or Arc 
objects. The geometry of the newly created objects is dictated by a constant distance measured per-
pendicularly from the source object. You can call out the offset distance using a known numeric 
value or by specifying an offset location using your cursor. This tool is especially helpful when laying 
out proposed roadway or parcel linework (i.e. Edge of Pavement, ROW)

Tip: Using modify commands such as Offset to manipulate Polylines is a great way to lay the 
foundation for dynamic Civil 3D Objects. This is because many dynamic Civil 3D Objects (i.e. 
Alignment, Feature Line) can be initially created from simpler AutoCAD Objects (i.e. Polyline). 

 

 1. Continue working with acad-modify-02.dwg
 2. Zoom and Pan to SECTION A-A detail area of drawing
 3. Ribbon > Home tab > Modify panel > Offset button

Info: of is a command line "alias" that also invokes the offset command.
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 A. Specify offset distance: 1.5

 B. enter

 C. Select object to offset: select subgrade Line on left side of SECTION A-A 
detail

 D. Specify point on side to offset:  left-click above subgrade Line

 A. enter or esc to end command.

 4. Of enter
 A. Specify offset distance: Through

 B. Turn on Endpoint Osnap
 C. Specify through point: Endpoint of median nose Arc

 D. Select object to offset: select "CRUSHED AGGREATED BASE COURSE 
SHOULDER" Line on right side of SECTION A-A detail

 E. Specify through point: Endpoint of median nose Arc on right side of SECTION A-
A detail

 5. of enter
 A. select object to offset: MEDIAN FORESLOPES Polyline in SECTION B-B detail
 B. Specify offset distance: 10

 I. enter
 C. specify point on side to offset: above selected Polyline
 D. Repeat above steps selecting previously offset Polyline as object to offset

 I. Observe disappearance of Arc segment on offset Polyline
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Trim, Extend & Lengthen

Continue with acad-modify-02.dwg

acad-modify-06.mp4 5:36

Trim

The Trim command allows you to modify existing geometry such that a section is removed based on 
intersection with other referenced existing geometry. For example, a Line can be shortened to the 
point at which it intersects with another Line. The Trim command applies to objects such as Line, 
Polyline, Circle, Ellipse, and Arc.

 1. Continue working with acad-modify-02.dwg
 2. Zoom and Pan to SECTION A-A detail area of drawing
 3. Ribbon > Home tab > Modify panel > Trim

Info: tr is a command line "alias" that also invokes the trim command.

 A. Select Objects: select smaller Arc intersecting with Line representing AGGREGATE 
SHOULDER

 B. spacebar

 C. Trim: select segment of Line you wish to trim

 D. enter or esc to end command. 

Page: 391

Published on: 5/17/2023

Trim, Extend & Lengthen

https://c3dkb.dot.wi.gov/video/acad/acad-modify-06.mp4


Extend

The Extend command is essentially the reverse of the Trim command. Extend allows you to lengthen 
a geometry object (i.e. Line, Polyline, Arc) up to the point where it would intersect referenced existing 
geometry.

 1. Continue working with acad-modify-02.dwg
 2. Ribbon > Home tab > Modify panel > Extend

Info: ex is a command line "alias" that also invokes the extend command.

 A. Select Objects: select median nose Arc on right side of SECTION A-A detail

 B. spacebar

 C. Extend: select Line you wish to extend

 D. enter or esc to end command. 

Page: 392

Published on: 5/17/2023

Trim, Extend & Lengthen



Tips: 
Hold shift while the Trim command is active in order to switch to the Extend command on the 
fly.

While selecting objects to Extend or Trim, choose the mid-command option <select all>. This 
allows you to use any existing geometry object as a potential Extend boundary or Trim cut-
ting edge.

Lengthen

The Lengthen command allows you to continue an object along it's current direction without the 
need for existing geometry to serve as a boundary to extend to. You can use Object Snaps to specify 
the amount you wish to lengthen the object. The Lengthen command also includes mid-command 
options to measure selected object geometry.

 1. Continue working with acad-modify-02.dwg
 2. Ribbon > Home tab > Modify flyout > Lengthen

Info: len is a command line "alias" that also invokes the length command.

 A. Select an object to measure or: DY

 I. enter
 B. Select an object to change: select Line on left side of SECTION A-A rep-

resenting SUBGRADE
 C. specify new end point: use Endpoint Osnap to select the end of the Line rep-

resenting CRUSHED AGGREGATE BASE COURSE SHOULDER on the right side of 
SECTION A-A detail

 D. enter
 E. tr enter

 I. Trim the middle of the lengthened line using the 2 should arcs. 
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Fillet & Break

Start with acad-modify-03.dwg

acad-modify-07.mp4 6:14

Fillet

The Fillet command allows you to insert an Arc at the intersection (or apparent intersection) of two 
Lines (or Polylines) and trim the Lines at the points of tangency of the Arc. Fillet mid-command 
options allow you to specify Radius, apply Fillets to all line segment intersections on a Polyline, or 
continue the command and apply it multiple times consecutively.

 1. Open acad-modify-03.dwg
 2. Zoom and Pan to R3-4 sign above PLAN VIEW detail
 3. Ribbon > Home tab > Modify panel > Fillet

Info: f is a command line "alias" that also invokes the fillet command.

 A. Select first object or: R

 I. enter

 B. specify fillet radius: 0

 I. enter

Page: 394

Published on: 5/17/2023

Fillet & Break

https://c3dkb.dot.wi.gov/video/acad/acad-modify-07.mp4


 C. Select first object: select one of the outermost R3-4 detail Lines

 D. Select second object to apply corner: select adjacent R3-4 detail Line

 4. f enter
 A. Select first object or: R

 I. enter
 B. specify fillet radius: 0.35

 I. enter
 C. Select first object: select one of the outermost R3-4 detail Lines
 D. Select second object to apply corner: select adjacent R3-4 detail Line

 5. f enter
 A. Select first object or: Multiple

 I. enter
 B. Apply Fillets to all remaining outermost R3-4 detail Lines

 I. enter
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 6. Select all four innermost Lines on R3-4 detail
 A. j enter

 B. f enter
 C. Select first object or: R

 I. enter
 D. specify fillet radius: 0.2

 I. enter
 E. Select first object or: polyline

 I. enter
 F. Select 2d polyline: select Polyline formed in Step 6.A

Tip: Use the Fillet command with radius=0 to extend line segments to their point of apparent 
intersection. The arc segment will then be omitted.

Break

The Break command allows you to create two Lines or Polylines from a single existing Line. You have 
the option to Break the Line at a single point so that the two resulting Lines share a common end-
point location or to Break the Line at two points so that a gap is formed between the two resulting 
Lines.

 1. Continue working with acad-modify-03.dwg
 2. Zoom and Pan to PLAN VIEW detail area of drawing
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 3. Ribbon > Home tab > Modify flyout > Break

Info: br is a command line "alias" that also invokes the break command.

 A. Select object: select Line bounding MEDIAN SHOULDER on bottom side of 
PLAN VIEW detail tangent to median Arc

 B. Specify second break point or: first point

 C. Specify first break point: Use Endpoint Osnap to select intersection of 
median Arc and Line

 D. Specify second break point or: Use Endpoint Osnap to select intersection of 
median Arc and Line on opposite side of median crossover detail

 4. Ribbon > Home tab > Modify flyout > Break at Point
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 A. Select object: select Line bounding MEDIAN SHOULDER on top side of 
PLAN VIEW detail tangent to median Arc

 B. Specify second break point: Use Endpoint Osnap to select intersection of 
median Arc and Line

 5. Repeat the previous step on the opposite side of median crossover detail.

 6. Select and delete the middle line that was created from the previous 2 steps. 

Array

Continue with acad-modify-04.dwg

acad-modify-08.mp4 4:36

The Array command allows you to copy a selected object and paste the object repetitively in a Rect-
angular, Polar, or Path based Array. A Rectangular Array is arranges the copied object in rows and 
columns. A Polar Array arranges the copied object at a radius and incremental angle about a spe-
cified location. A Path Array arranges the copied object at a specified location along a path based on 
an existing Line or Polyline. This section will cover the Rectangular Array.

 1. Open acad-modify-04.dwg
 2. Zoom and Pan to PLAN VIEW detail area of drawing
 3. Select Polyline representing "breakline symbol"
 4. Ribbon > Home tab > Modify panel > Array (Rectangular)

Info: ar is a command line "alias" that also invokes the array command.
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 A. Ribbon > Array contextual tab > Columns panel

 I. Columns = 1

 B. Ribbon > Array contextual tab > Rows panel

 I. Rows =6

 C. Select grip to edit array or: Spacing

 I. enter

 D. Specify distance between rows: Use Endpoint Osnap to select two similar 
points on "breakline symbol" Polylines on left side of PLAN VIEW

 I. enter

 II. enter or esc to end command. 
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Reverse & Align

Continue with acad-modify-04.dwg

acad-modify-09.mp4 3:38

Reverse

The Reverse command will change the order of Polyline vertices. This is helpful when you wish to 
add a vertex to the end of an existing Polyline. By default, Civil 3D will add the vertex in front of the 
highest numbered vertex (the last vertex placed). If you want to add a vertex to the end of the lowest 
numbered vertex (vertex 1), it will instead be placed between vertex 1 and 2. The order of Polyline 
and Line vertices also affects how a Linetype is generated. Linetypes will start at vertex 1.

 1. Continue working with acad-modify-04.dwg
 2. Open Properties Palette

 A. props

 I. enter
 3. Select Polyline drawn along bottom of 10" CRUSHED AGGREGATE BASE COURSE Hatch

 A. Properties palette > Geometry dropdown > Current Vertex
 B. Toggle between numbered vertices
 C. Observe glyph showing vertex location in drawing area
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 D. Hover cursor over vertex 1
 I. Add vertex

 II. Observe default placement of new vertex

 E. Ribbon > Home tab > Modify flyout > Reverse
 I. Properties palette > Geometry dropdown > Current Vertex

 II. Observe reversed order of Polyline vertices
 F. Hover cursor over vertex 5

 I. Add vertex
 II. Observe default placement of new vertex

 III. Use desired Osnap to place new vertex
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Align

The Align command combines the functionality of the Move, Rotate, and Scale commands. Most 
basic AutoCAD objects can be affected by the Align command (i.e. Polyline, Block, Hatch, Text). Once 
the command is activated, you will select objects to Align then select at least two source and des-
tination points. If any rotation, repositioning, or scaling is necessary to replace the source points with 
destination points, the Align tool will do this for you.

 1. Continue working with acad-modify-04.dwg
 2. Zoom and Pan to area including SECTION A-A detail and misaligned objects above sheet bor-

der Line
 3. Ribbon > Home tab > Modify flyout > Align

Info: al is a command line "alias" that also invokes the align command.

 A. Select objects: select misaligned objects above sheet border Line

 I. Right-click

 B. Specify first source point: use Endpoint Osnap to select lower left Polyline 
vertex

 C. Specify first destination point: use Endpoint Osnap to select analogous 
destination point on SECTION A-A detail
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 D. Specify second source point: use Endpoint Osnap to select lower right 
Polyline vertex

 E. Specify second destination point: use Endpoint Osnap to select analogous 
destination point on SECTION A-A detail

 F. specify third source point or <continue>:

 I. spacebar

 G. Scale objects base on alignment point?: y

 I. enter

Hatch
Last updated: 2023-01-04

Total video time: 15:15

A Hatch is an object that fills in a bounded area and displays either a Solid, Pattern, or Gradient. The 
display of the Hatch can be affected by setting a hatch scale, rotation, color (typically ByLayer), 
and/or transparency. The origin of the Hatch pattern can be reset so that it displays appropriately 
depending on the shape of the area filled, the hatch rotation, and the hatch scale.

There are also options to associate the Hatch with a boundary object such as a Polyline, so that a 
change to the boundary object will affect the Hatch accordingly such as with a Move, Scale or Rotate 
command. A Hatch object can be made Annotative so that the scale of the drawing dictates the scale 
of the Hatch. There are several additional Hatch options such as Match Properties and Separate 
Hatches that affect the way a Hatch is defined.

Warning: Having a large number of Hatch objects can significantly reduce drawing per-
formance and stability. This is especially true if Hatch transparency and/or associative hatches 
are used.
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Info: Many of the desired effects of a Hatch object are handled by Styles when working with 
Civil 3D objects (i.e. Surface, Pipe Network, or Corridor objects). This has the benefit of the 
"hatched" area of the Civil 3D object being created automatically as part of the object, being 
dynamically linked to the object, and being turned on/off at any time by editing Style display 
settings.

Hatch Creation, Pattern, & Properties

Exercise files: acad-data-c3d20.zip

Start with acad-htch-begin.dwg

acad-htch-01.mp4 7:11

Hatch creation

 1. Open acad-htch-begin.dwg
 2. Zoom and Pan to SECTION A-A detail
 3. Ribbon > Home tab > Draw panel > Hatch

 4. Hatch Pick internal point or: leave default to pick internal point
 A. Or, if necessary, Hatch Select objects or: pick internal point
 B. Move cursor inside area bounded by Lines representing 4" ASPHALTIC CONCRETE
 C. Observe Hatch preview

 D. Left-click to place Hatch
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 E. enter

 F. Select previously created Hatch
 I. delete

 5. Ribbon > Home tab > Draw panel > Hatch
 A. Ribbon > Hatch contextual tab > Boundaries panel > Select

 B. Or, if necessary, Hatch Select objects or: pick internal point
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 C. Select individual Lines bounding SECTION A-A PAVEMENT area
 I. enter

 D. Select previously created Hatch
 I. delete

 6. Select individual Lines bounding SECTION A-A PAVEMENT area
 A. j enter

 7. Ribbon > Home tab > Draw panel > Hatch
 A. Ribbon > Hatch contextual tab > Boundaries panel > Select
 B. Select single Polyline bounding SECTION A-A PAVEMENT area

 I. enter
 8. Ribbon > Home tab > Draw panel > Hatch

 A. Ribbon > Hatch contextual tab > Pattern panel > ANSI31
 B. Ribbon > Hatch contextual tab > Boundaries panel > Pick Points
 C. Left-click inside Lines bounding both SECTION A-A TOPSOIL areas

 I. enter

 9. Ribbon > Home tab > Draw panel > Polyline
 A. Use Endpoint Osnap to pick vertices bounding SECTION A-A 10" CRUSHED AGGREGATE 

BASE COURSE area
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Tip: It may be necessary to create a Polyline to help with Hatch creation if existing linework 
does not get you the results you are after. You can delete the Polyline afterward if desired and 
still retain the Hatch.

Pattern & Properties

Use the Pattern panel flyout found on the Hatch contextual tab to choose from the available Pat-
terns. Use the Properties panel to set fill type (Pattern, Solid, or Gradient), scale, rotation angle, and 
transparency. A Hatch scale will work in combination with the drawing scale if the Hatch is set to be 
annotative (see Associative & Annotative section). 

 10. Ribbon > Home tab > Draw panel > Hatch
 A. Ribbon > Hatch contextual tab > Pattern panel > ANGLE
 B. Ribbon > Hatch contextual tab > Boundaries panel > Select

 I. Select Polyline bounding SECTION A-A 10" CRUSHED AGGREGATE BASE COURSE 
area

 a. enter
 II. Select Polyline bounding SECTION A-A 10" CRUSHED AGGREGATE BASE COURSE 

area
 a. delete

 11. Select previously created TOPSOIL Hatch
 A. Ribbon > Hatch contextual tab > Properties panel

 I. Hatch pattern scale = 10
 B. Ribbon > Hatch contextual tab > Pattern panel flyout

 I. Patten = AR-SAND

Associative & Annotative

Start with acad-htch-01.dwg
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acad-htch-02.mp4 5:04

Associative Boundaries

A Hatch is an independent object. As such, it does not depend on the presence of a boundary object 
in order to be retained after it is first generated. If desired, however, a Region or Polyline boundary 
can be created to aid in moving or retaining the original shape of a Hatch. For example, a Polyline 
boundary provides basepoint grips when performing a Move command on a Hatch. A Region will 
retain the original shape of the Hatch in the event the Hatch needs to be rebuilt. In order for the 
Hatch to move with or respond to edit to the boundary, the boundary must be made associative.

 1. Open acad-htch-01.dwg
 2. Zoom and Pan to left side of SECTION B-B detail
 3. Select Hatch representing PAVEMENT section

 A. M enter
 I. Select basepoint and second points

 a. Observe lack of Hatch boundary

 4. Select Hatch
 A. Observe available grips
 B. M enter

 I. Observe lack of grips during Move command
 II. esc

 5. Ctrl+z to undo initial Move
 6. Select Hatch

 A. Ribbon > Hatch contextual tab > Boundaries panel > Recreate
 I. Enter type of boundary object: Polyline

 a. enter
 II. Associate hatch with new boundary? Y

 a. enter
 B. esc
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 7. Select Hatch boundary Polyline
 A. M enter

 I. Select basepoint and second point
 II. Observe Hatch association with Polyline

 8. Select Hatch boundary Polyline
 A. M enter

 I. Use Endpoint Osnap to move Polyline back to original location

Annotative

Annotative scaling is used to dynamically set an annotative object's displayed scale based on the cur-
rent drawing scale. It can also be used control visibility of annotative objects based on inclusion of 
scales in an object's annotative scales list. The end goal here is to display objects at the correct scale 
when plotting layouts. More detail on annotative scaling in general can be found in the training mod-
ule dedicated to the topic. This section will walk you through making a Hatch annotative and man-
aging the annotative scales list. You will also see how the Hatch pattern scale is different from a 
Hatch annotative scale, and how the two can work together.

 1. Continue working in acad-htch-01.dwg
 2. Select Hatch representing PAVEMENT section on left side of SECTION B-B detail

 A. Ribbon > Hatch contextual tab > Properties panel
 I. Observe Hatch pattern scale = 5.0000
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 B. Properties palette > Pattern dropdown 
 I. Annotative = Yes
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 A. Observe Hatch pattern displayed scale change
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 B. Ribbon > Hatch contextual tab > Properties panel
 I. Hatch pattern scale: 0.5

 3. Status bar > Current drawing scale flyout
 A. Select 1 IN:5 FT
 B. Observe no change in Hatch pattern displayed scale

 4. Status bar > Current drawing scale flyout
 A. Select 1 IN: 10 FT

 5. Select Hatch representing PAVEMENT section on left side of SECTION B-B detail
 A. Ribbon > Hatch contextual tab > Properties panel

 I. Pattern dropdown > Annotative scale > dialog box icon
 a. Annotation Object Scale dialog

 i.  Add...
 i. Add Scales to Object dialog

 i. 1 IN:5 FT
 ii. OK
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 6. Status bar > Current drawing scale flyout
 A. Select 1 IN:5 FT
 B. Observe change in Hatch pattern displayed scale

Match Properties & Separate Hatches

Continue with acad-htch-01.dwg

acad-htch-03.mp4 3:00

Match Properties

Use the Match Properties button found on the Hatch contextual tab to push pattern, color, trans-
parency, and Hatch pattern scale from a source to destination Hatch. This saves you time if you need 
to update multiple Hatches to have similar Hatch properties. 
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 1. Continue working in acad-htch-01.dwg
 A. Select PAVED SHOULDER Hatch on left side of SECTION B-B detail
 B. Ribbon > Hatch contextual tab > Options panel > Match Properties

 I. Select FINISHED SHOULDER as source Hatch

Separate Hatches

You can set your Hatch creation options so that picking multiple bounded areas while in a single 
Hatch command creates either a single Hatch throughout all bounded areas or individual Hatch 
objects for each bounded area. You can also break an existing single Hatch that covers multiple 
bounded areas into separate Hatch objects for each bounded area.
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 1. Continue working in acad-htch-01.dwg
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 A. Zoom and Pan to PLAN VIEW detail
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 B. Ribbon > Home tab > Draw panel > Hatch
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 I. Ribbon > Hatch contextual tab > Options flyout
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 a. Hatch and Gradient dialog
 i. Create separate hatches = unchecked
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 II. Pick internal points in the three bounded areas along top of PLAN VIEW detail
 a. enter
 b. Observe a single Hatch object created that covers all three bounded 

areas
 C. Ribbon > Home tab > Draw panel > Hatch

 I. Ribbon > Hatch contextual tab > Options flyout
 a. Hatch and Gradient dialog

 i. Create separate hatches = checked
 II. Pick internal points in the MEDIAN SHOULDER and median crossover areas 

through center of PLAN VIEW detail
 a. enter
 b. Observe multiple Hatch objects created for the bounded areas

 D. Select Hatch created in step 1.B
 I. Ribbon > Hatch contextual tab > Options dropdown > Separate Hatches

 II. Observe single Hatch split into multiple Hatches

Grips
Last updated: 2023-01-04

Total video time: 22:50
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Object Grips are used to interact with and edit objects in through the drawing view (i.e. Model 
Space). Upon selecting an object, available Grips will display for the object(s) selected. Depending on 
the type of object selected, you may have Multifunction Grips allowing access to several options for 
Grip editing. Additionally, for all Grips, you can cycle between Grip Modes including Move, Rotate, 
Scale, and Mirror. Though many of the edits you perform using Grips can be handled elsewhere, util-
izing Grip edits in combination with object snaps, polar tracking, and dynamic input can significantly 
expedite your object editing workflow.

Basics: stretch vs move

Exercise files: acad-data-c3d20.zip

Start with acad-grips-begin.dwg

acad-grips-01.mp4 3:50

Arguably the most basic Grip function is the Stretch. Within the category of Stretch Grip functions, 
are two distinct types of editing behavior: Stretch and "move". In general, an endpoint  Grip has a 
Stretch behavior and a midpoint or insertion Grip has "move" behavior. The Stretch behavior relo-
cates the Grip and changes the length or radius and rotation or center point of an object as neces-
sary. The "move" behavior will relocate the Grip and object while retaining all other object geometry 
properties such as length and rotation.

Grips with Stretch function exhibiting "stretch" behavior:

 l Polyline vertex and endpoint
 l Line endpoint
 l Arc endpoint

Grips with Stretch function exhibiting "move" behavior

 l Text insertion point 
 l Line midpoint
 l Circle center
 l Block insertion point
 l COGO Point

Info: The COGO Point is a Civil 3D object. COGO Points are covered in detail in later training 
modules and thus are not included in the example workflows here.

 1. Open acad-grips-begin.dwg
 2. Select CRUSHED AGGREGATE BASE COURSE SHOULDER Line on left side of SECTION A-A 

detail
 A. Observe display of two endpoint Grips and one midpoint Grip
 B. Left-click midpoint Grip to activate

 I. Move cursor and observe behavior
 II. esc to deselect
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 3. Select R3-4 Block at top of PLAN VIEW detail
 A. Observe display of insertion point Grip
 B. Left-click insertion point Grip to activate

 I. Move cursor and observe behavior
 II. esc to deselect

 4. Select SECTION A-A Text
 A. Properties palette > Text dropdown > Justify

 I. Observe Justify = Center
 B. Left-click insertion point Grip

 I. Move cursor and observe behavior
 II. esc to deselect

 5. Zoom & Pan left of SECTION A-A detail
 6. Select red guiding Circle

 A. Observe display of four quadrant Grips and one center Grip
 B. Left-click center Grip to activate

 I. Move cursor and observe behavior
 II. esc to deselect

 7. Select CRUSHED AGGREGATE BASE COURSE SHOULDER Line on left side of SECTION A-A 
detail

 A. Left-click endpoint Grip to activate
 I. Move cursor and observe behavior

 II. esc to deselect
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 8. Select the Polyline bounding 10" CRUSHED AGGREGATE BASE COURSE Hatch
 A. Left-click insertion Grip to activate

 I. Move cursor and observe behavior
 II. esc to deselect

 9. Select the SECTION A-A detail median nose Arc
 A. Left-click center Grip to activate

 I. Move cursor and observe behavior
 II. esc to deselect

Shift+select multiple

Continue with acad-grips-begin.dwg

acad-grips-02.mp4 6:08

Hold the Shift key and select multiple Grips to simultaneously apply a similar Grip edit to multiple 
object Grip locations. The Grips will display red once selected and activated. Release the Shift key 
and select one of the activated Grips to apply a Grip edit as normal. The Grip edit will then be applied 
to all Grips included in the selection.

 1. Continue working in acad-grips-begin.dwg
 2. Zoom and Pan left of SECTION A-A detail
 3. Observe location of red guiding Circles
 4. Turn on Center and Endpoint Object Snaps
 5. Select BOTTOM OF MEDIAN Line

 A. Left-click left-most endpoint Grip
 I. Specify stretch point or:

 a.  Use Osnaps to relocate Line endpoint at center of guiding Circle
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 6. Select both CRUSHED AGGREGATE BASE COURSE and SUBGRADE Lines
 A. shift+select both leftmost endpoint Grips

 I. Release shift key
 II. Left-click one of the shift+selected Grips

 a. Use Osnaps to relocate Line endpoints at center of guiding Circles

 III. esc to deselect
 7. Select PAVED MEDIAN SHOULDER Line

 A. Verify Dynamic Input is on
 I. Status bar > Customization button

 a. Dynamic Input = checked
 II. Status bar

 a. Dynamic Input toggled on
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 B. Hover cursor over leftmost Line endpoint
 I. Observe Dynamic Input tooltip

 a. Lengthen
 II. Specify end point: 5 enter

 III. Use Osnaps to Lengthen Line to center of red guiding Circle
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 8. Select both CRUSHED AGGREGATE BASE COURSE and SUBGRADE Lines
 A. shift+select both leftmost endpoint Grips

 I. Release shift key
 II. Left-click one of the shift+selected Grips

 a. ctrl to cycle Grip function = Lengthen

 B. Use Osnaps to Lengthen Lines to leftmost endpoint of PAVED MEDIAN SHOULDER Line
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 C. esc to deselect
 9. Pan to right of SECTION A-A detail

 A. Use crossing selection to select TOPSOIL Hatch and bounding Lines

 A. shift-select appropriate endpoints of selected objects
 I. Release shift key

 II. Select rightmost endpoint of BOTTOM OF MEDIAN Line
 a. Move cursor and observe behavior
 b. Use Osnaps to uniformly relocate selected linework endpoints
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Ctrl+select to copy

Continue with acad-grips-begin.dwg

acad-grips-03.mp4 2:10

Hold the ctrl key when selecting a Grip to make a copy of the objects attached to the Grip. For 
example, ctrl+select a Text Grip to copy the full Text object. Ctrl+select a Polyline vertex to copy and  
the Line segements touching the selected Grip(s). You can combine the ctrl+select  technique with the 
shift+select technique to copy multiple objects attached to the shift+selected Grips

 1. Continue with acad-grips-begin.dwg
 2. Select SECTION A-A Text

 A. ctrl+select insertion point Grip
 I. Release ctrl key

 II. Pan to SECTION B-B detail
 a. Use Osnaps to place copied Text at center red guiding Circle
 b. esc to deselect

 3. Pan to PLAN VIEW detail
 4. Select breakline symbol Polyline at top-right of PLAN VIEW detail

 A. shift+select all vertex Grips
 B. Release shift key

 I. ctrl+select righ-most vertex Grip
 II. Release ctrl key

 a. Use Osnaps to place copies at all remaining red guiding Circles
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 b. esc to deselect

Grip modes

Start with acad-grips-01.dwg

acad-grips-04.mp4 6:57

In addition to object-specific Grip edit behavior, all Grips have the ability to edit associated objects 
using four standard behaviors. These standard Grip editing behaviors are known as Grip Modes. 
They include Move, Rotate, Scale, and Mirror.  Once an object is selected and a Grip is activated, use 
the enter key to cycle between Grip Modes. Once you begin cycling, you are limited to one of the 
four standard Grip Modes. Hit esc and re-activate a Grip to perform a non-Grip Mode edit such as 
Stretch or Lengthen.

 1. Open acad-grips-01.dwg
 2. Zoom and Pan to PLAN VIEW detail
 3. Select  Line just below R3-4A signage

 A. Left-click topmost endpoint Grip
 I. Observe command line prompt Specify stretch point or:

 II. Move cursor and observe behavior
 a. enter

 III. Observe command line prompt change Specify stretch Move or:
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 IV. Repeat steps 3.A.I - 3.A.III to cycle all Grip Modes
 V. esc

 B. esc to deselect
 4. Zoom and Pan to SECTION A-A detail
 5. Select CRUSHED AGGREGATE BASE COURSE SHOULDER Multileader

 A. Left-click leader Grip
 I. enter

 II. Specify move point or: Copy

 a. Left-click to place a copy of Multileader on right side of SECTION A-A 
detail

 b. esc to deselect

 6. Pan to SECTION B-B detail
 7. Verify midpoint Object Snap is on
 8. Window select breakline symbol Polyline and Hatch near EDGE OF PAVEMENT Multileader
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 9. Left-click one of the displayed Grips
 A. enter to cycle to Mirror Grip Mode

 I. Specify second point or: Base point

 a. Use midpoint Object Snap to specify midpoint of 4" ASPHALTIC 
CONCRETE Polyline

 II. specify second point or: copy

 a. Hold shift for temporary Orthomode
 b. Left-click second mirror point above basepoint
 c. esc to deselect

 10. Select PAVED SHOULDER Hatch one left side of SECTION B-B detail
 A. Left-click a displayed Grip

 I. Right-click
 a. Mirror

 i. Specify second point or: Base point

 i. Use midpoint Object Snap to specify midpoint of 4" 
ASPHALTIC CONCRETE Polyline

 ii. specify second point or: copy

 i. Hold shift for temporary Orthomode
 ii. Left-click second mirror point above basepoint
 iii. esc to deselect
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Multifunction grips

Continue with acad-grips-01.dwg

acad-grips-05.mp4 3:45

In addition to the four standard Grip Modes, some objects have Multifunction Grips. The first 
example we saw of this was the Line endpoint Grip. This is a Multifunction Grip with Stretch and 
Lengthen functions. Once a Multifunction Grip is activated, use the ctrl key to cycle between Grip 
functions. When only a single Multifunction Grip is activated, hover your cursor over the Grip to see a 
Multifunction Grip menu. This menu will not display when multiple Grips are activated such as when 
shift+selecting multiple Grips. 

 1. Continue with acad-grips-01.dwg
 2. Zoom and Pan to SECTION B-B detail
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 3. Select MEDIAN FORESLOPES APPROACHING CROSSOVER Multileader
 A. Left-click the leader landing Grip

 I. ctrl to cycle Grip functions to Add Leader
 a.  specify leader arrowhead location:

 i. Use endpoint Object Snap to specify location at Arc endpoint

 II. ctrl to cycle Grip functions to Stretch
 a. Use red guiding Circle to relocate leader vertex

 B. Select Polyline representing MEDIAN FORESLOPES APPROACHING CROSSOVER
 I. Left-click Polyline arc segment midpoint Grip

 a. ctrl to cycle Grip functions to Convert to Line
 b. enter

 C. Select Polyline representing MEDIAN FORESLOPES APPROACHING CROSSOVER
 I. Left-click Polyline line segment midpoint Grip

 a. ctrl to cycle Grip functions to Convert to Arc
 i. specify midpoint of arc segment:

 i. Use Osnaps to place specify center of red guiding Circle 
 ii. esc to deselect

Layers and their properties
Last updated: 2023-01-04

Total video time: 29:42

Layer basics

Exercise files: acad-data-c3d20.zip

Start with acad-layr-prprtis-begin.dwg
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acad-layr-prprtis-01.mp4 4:53

Layers in AutoCAD are used to control object display properties, visibility, plotting, object selection, 
and organization. All objects in a drawing will reside on a Layer. The Layer an individual object 
resides on is known as the Object Layer. When AutoCAD objects are created, they will be placed on 
the Current Layer. You can set which Layer is the Current Layer either through the Ribbon Layer 
Panel or Layer Properties Manager. Some of the most commonly used/edited Layer properties are 
On/off, Isolate/unisolate, Freeze/thaw, Lock/unlock.

Info: 
Civil 3D objects are made up of components. For example, an Alignment can have Line, 
Curve, Spiral, and/or other components. The object and it's components can all be on unique 
layers. When Civil 3D objects (i.e. Alignments, Corridors, Surfaces) are created, they will be 
placed on the default Object Layer specified in the Drawing Settings dialog.

An optional Layer name wildcard can be included that will append the default Object Layer 
name with the name you give to the Object. In this way, a new Layer will be created for each 
named Civil 3D Object created. For example, the default Object Layer for Alignments in the 
WisDOT design template is P_ALI_*. The * character is the wildcard. If an Alignment is named 
HWY 14, the default Object Layer created will be P_ALI_HWY 14.

 1. Open acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layers panel

 A. Observe Current Layer = E_ALI
 B. Change Current Layer to E_ALI_CPI

 I. Layer of an object can be changed in the Properties palette. 
 3. Application menu dropdown > Drawing Utilities > Drawing Settings > Object Layers 

tab
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 A. Observe default Civil 3D Object Layers
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Info: The Ribbon Layer Panel dropdown shows the Current Layer if no object is selec-
ted. It shows the selected Object Layer if an object is selected.

 4. Select BOTTOM OF MEDIAN Line on right side of SECTION A-A detail
 A. Ribbon > Home tab > Layers panel dropdown

 I. Observe Object Layer = P_XS_FinalBorrow
 5. Select BOTTOM OF MEDIAN Line on right side of SECTION A-A detail

 A. Ribbon > Home tab > Layers panel > Make Current
 6. Properties palette > General 

 A. Observe Object Layer = P_XS_FinalBorrow
 7. esc
 8. PLINE enter

 A. Ribbon > Home tab > Layers panel dropdown
 I. Observe Current Layer = P_XS_FinalBorrow

 B. Draw Polyline with two vertices anywhere between SECTION A-A and SECTION B-B 
details
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 9. Select any other polyline
 A. Ribbon > Home tab > Layers panel > Make Current

 I. Observe that Current Layer changes accordingly

Layer commands: off, freeze, isolate, lock

Start with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-02.mp4 5:56

Commonly edited Layer properties

Layer property Description

On/off
When a Layer is turned off, objects residing on that Layer will not dis-
play, although they will be accounted for when processing object dis-
play, such as when you Zoom Extents or Regen.

Isolate/unisolate
Depending on Layer settings, Layer Isolate will either Lock and fade dis-
play or turn off all Layer except those of selected objects.

Freeze/thaw

When a Layer is frozen, objects residing on that Layer will not display 
and will not be accounted for when processing object display. Freezing 
a Layer with an extraordinarily large number of objects can help draw-
ing performance.

Lock/unlock

Objects on a locked Layer cannot be deleted or edited. Locking Layers 
can be helpful when you wish to use objects on a Locked Layer for 
visual reference or to snap to while also protecting alteration of the geo-
metry.

On/  off

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layer panel > Off
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 3. Select an object on the layer to be turned off 

 A. Select multiple objects below SECTION A-A detail
 B. esc

 4. Double-click middle mouse wheel
 A. Observe Zoom Extents is still accounting for Layers turned off

 5. Ribbon > Home tab > Layer panel > Turn All Layers On

Freeze/  thaw

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layer panel > Freeze

 3. Select an object on the layer to be Frozen

 A. Select multiple objects below SECTION A-A detail
 B. esc
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 4. Double-click middle mouse wheel
 A. Observe Zoom Extents not accounting for frozen Layers

 5. Ribbon > Home tab > Layer panel > Thaw All Layers

Isolate/  unisolate

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layer panel > Isolate

 3. Select an object on the layer to be Isolated

 A. Select BOTTOM OF MEDIAN Line on right side of SECTION A-A detail
 B. enter
 C. Observe non-isolated Layers fade and lock

 4. Ribbon > Home tab > Layer panel > Isolate

 A. Select an object on the layer to be Isolated or Settings
 I. Off

 a. This will turn non-isolated layers off rather than fading and locking 
them. 

 5. Ribbon > Home tab > Layer panel flyout
 A. Adjust Locked Layer Fading with slider

 6. Ribbon > Home tab > Layer panel > Unisolate

Lock/  unlock

 1. Ribbon > Home tab > Layer panel > Lock

 2. Select an object on the layer to be Locked
 A. Select BOTTOM OF MEDIAN Line on right side of SECTION A-A detail
 B. enter
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 C. Observe Locked layer display fade
 D. Hover cursor over object on locked Layer
 E. Observe "padlock" glyph indicating the Layer is locked

 3. Ribbon > Home tab > Layer panel > Unlock
 A. Select an object on locked P_XS_FinalBorrow Layer

Layer properties manager: interface & editing

Start with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-03.mp4 7:49

The Layer Properties Manager is where you can sort, create and delete Layers or edit Layer prop-
erties such as Layer name, description, display color, visibility (on/off or freeze/thaw), plot style name 
(how thick a lines will plot), whether the Layer will plot or not, etc. Take advantage of shift+select and 
ctrl+select to affect multiple Layers at once.

 1. Continue with acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layer panel > Layer Properties

 A. Observe "366 total Layers" listed along bottom of Layer Properties Manager palette
 B. Observe the layer filters on the left side of the palette.
 C. Notice that the columns width can be adjusted for readability.

 3. Set a Layer Current by selecting a row and clicking the Set Current button  or double-click-
ing a row in Layer Properties Manager
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 A. Layer Properties Manager
 I. Observe Status = Current

 4.  Select a row in by left clicking
 A. Left click once more on the Layer name to edit the name

 I. Left click elsewhere in  to cancel or finish the name edit
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 B. Toggle Layer Off
 I. "The current layer will be turned off. What do you want to do?"

 a. Turn the current layer off

 C. Toggle Layer On
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 D. Toggle Layer Freeze
 I. "This layer cannot be frozen because it is the current layer."

 a. Close

 E. Toggle lock
 I. Observe Layer display fade in Model Space

 F. Color column
 I. Click on color of any layer

 a. Observe list of colors
 b. Cancel

 G. Linetype column
 I. Click on linetype of any layer

 a. Observe list of linetypes
 b. Cancel

 H. Lineweight column
 I. Click on lineweight of any layer

 a. Observe list of lineweights
 b. Cancel

 I. Plot column
 I. Toggle plot/  noplot

 J. Plot Style column
 I. Click on any named Plot Style

 a. Observe list of Plot Styles
 b. Cancel
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Warning: In pre-2018 WisDOT drawings, Named plot styles have 
been assigned intentionally to Layers included in the WisDOT 
design template. These Plot Styles dictate the plotted color (i.e. 
Black), linetype and lineweight of plotted objects. Do not change 
these assigned Plot Styles as doing so will result in non-uniformity 
among plotted WisDOT plan sets.

 K. New VP Freeze column
 I. Toggle New VP Freeze

Info: New VP Freeze affect creation of new Viewports. Viewports are 
used for plan production to "look" from your plan sheet Layout (Paper 
Space) into your Civil 3D model (Model Space). The concepts and use of 
Layouts, Viewports and Paper Space vs Model Space will be covered in 
more depth in later training modules.

 L. Layer Properties Manager
 I. Right-click any column header

 a. Maximize all columns
 II. Right-click Name column header

 a. Freeze column
 i. Observe static display of Name and Status Column while scrolling 

left-right
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Layer properties manager: create new & layer notification

Continue with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-04.mp4 3:44

 1. Continue with acad-layr-prprtis-begin.dwg
 2. Layer Properties Manager

 A. Select E_ALI row
 B. Create New Layer

 I. Layer name = E_ALI2
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Info: When creating a new Layer in the Layer Properties Manager, all 
properties of the selected Layer other than the Layer name will be 
assigned to the new Layer created.

Requirement: When creating a new layer, follow the WisDOT Layer nam-
ing convention. For example, E_ALI_<object name> ("E for existing or P 
for proposed"_"three or four letters for object type"_"optional additional 
sections of three or four letters for object type"_ "object name or descrip-
tion")

 C. Select E_ALI2
 I. Right-click > Merge selected layer(s) to...

 a. Select E_ALI
 b. OK
 c. "The selected layers will be merged into layer E_ALI. Do you want to con-

tinue?"
 i. Yes

 D. Layer Settings
 I. New Layer Notification = checked

 II. Evaluate new layers added to drawing = checked
 III. Evaluate all new layers = filled

 E. Select E_ALI
 F. Create new Layer
 G. Right click newly created Layer 1

 I. Reconcile Layer
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Layer properties manager: properties filter & settings

Continue with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-05.mp4 2:56

Layer Properties Filters essentially query all the Layers in your drawing based on Layer name text or 
other Layer properties. This allows you to reduce the Layers listed in Layer Properties Manager, mak-
ing Layers easier to find and work with. You can also use the search field in the upper right corner of 
Layer Properties Manager to filter the Layers shown based on Layer name. Using Layer Settings, you 
can also apply the current Layer Properties Filter to the Ribbon Layer Panel dropdown list.

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Layer Properties Manager

 A. Filters
 I. Alignment

 a. Observe reduced list of Layers displayed in Layer Properties Manager
 b. Observe Layer quantification note in lower-left of Layer Properties Man-

ager window

 II. Right-click Alignment Layer Filter > Properties
 a. Observe Layer Filter Properties name-based query
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 III. Right-click All Used Layers Filter
 a. Observe inability to modify properties or delete this filter

Info: The All Used Layers Filter is one of the default Layer Filters 
automatically created in any drawing. These default Layer Filters 
cannot be modified or deleted. Additional default Layer Filters 
include External Reference, Non-External Reference, Unreconciled 
Layers and Viewport Overrides.

Info: When Layers are referenced by a Civil 3D Style included in a 
drawing or template, the Layers are included in the All Used Lay-
ers Filter and cannot be deleted. This is true even if there are no 
Civil 3D objects in the drawing. For example the Alignment Civil 3D 
Style layers are included in the WisDOT design template even 
before any Alignments are created.

 3. Layer Properties Manager > New Property Filter

Info: Layer Filters using Name filtering can use a * as a wildcard on either end of the 
name to capture unique layer names that fit the layer filter criteria. 

Layer states & layer walk

Continue with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-06.mp4 4:24
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Layer states

A Layer State is a saved version of the way a drawings Layer properties are set up. The properties 
saved in a Layer State include Layer On/ off, Freeze/ thaw, Lock/ unlock, Color, Linetype, Lineweight, 
Transparency, Plot style, Plot/ no plot, New VP Freeze and VP Freeze. Layer States can be imported, 
saved from the current Layer Properties setup, or restored in a drawing at any time. Restoring a 
Layer State will reset all Layer properties currently set in a drawing to those saved in the Layer State. 
Use Layer States to quickly and accurately switch to a desired Layer properties setup for specific 
design, external referencing, or plotting workflows. Some key Layer States are included in the 
WisDOT design template and on the Ribbon WisDOT Standards tab. The Layer States on the WisDOT 
Standards tab can be imported through the Layers Tool Palette.

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layers panel flyout > Layer State dropdown > New Layer State

 A. New layer state name = color
 B. OK

 3. Layer Properties Manager
 A. Shift+select all Layers
 B. Click any Layer Color field

 I. Color = red
 II. OK

 4. Ribbon > Home tab > Layers panel flyout > Layer State dropdown > New Layer State
 A. New layer state name = Red
 B. OK

 5. Ribbon > Home tab > Layers panel flyout > Layer State dropdown > Color
 A. Observe all Layer Color properties restored based on color Layer State

 6. Ribbon > Home tab > Layers panel flyout > Layer State dropdown > Red
 A. Observe all Layer Color properties changed to red

Layer walk

The Layer Walk command allows you to sort and select Layers from a list or your drawing area and 
see them displayed in real time. You can use Layer Walk to efficiently select a group of Layers either 
by name or by selecting objects in the drawing area, then create a Layer State based on that selec-
tion from within the Layer Walk dialog. The Layer State created from within the Layer Walk command 
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will only affect visibility through the Layer on/ off property. All other properties will remain 
unchanged.

 1. Ribbon > Home tab > Layers panel flyout > Layer Walk
 A. Layer Walk dialog

 I.  Right-click in Layer list
 a.  Select all
 b. Observe Layers displayed in drawing area

 II. Select only P_XS_Final Borrow

 a. Right-click P_XS_Final Borrow
 i.  Save Layer State

 i. New layer state name = Layer State
 ii. OK

 III. Close

Blocks and external references
Last updated: 2023-01-04

Total video time: 80:01

Both Block References (aka Blocks) and External References (aka Xrefs) allow you to bring previously 
created, external objects into your Civil 3D drawing. 

A Block is an object type that is made up of one or more other drawings objects. When objects are 
contained in a Block, they are easily inserted into any drawing to avoid duplicated work in assem-
bling the various objects making up the Block. Blocks are typically used for Survey Point Markers, 
standard construction or plan details, plan set sheet text and typical plan-view linework. Blocks can 
be dynamics in that you have special control options for visibility or editing. They can also contain 
attributes, which are text objects whose content can be edited while locking down the text Style/Lay-
er/etc.

You can think of an Xref as a view in a destination drawing back to a source drawing. In the des-
tination drawing, the Xref source objects are protected from editing beyond Layer display control. 
Additionally, a source drawing can be Externally Referenced into multiple destination drawings sim-
ultaneously. Whenever a change is made to an Xref source drawing, you are prompted in the 
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destination drawing to update the Xref. In this way, the referenced source content is easily kept up 
to date and consistent throughout all destination drawings. Xrefs can be used in design drawings to 
see and reference linework or other objects for the purposes of design without actually having those 
reference objects in your current drawing. Another use for an Xref is for displaying existing con-
ditions or other site objects needed on multiple plan sheets. If you only want to display certain 
objects from the Xref on certain plan sheets, you can accomplish this through Viewport Freezing 
Layer control. More detailed information on plan production will be covered in later training module. 

Block creation basics

Exercise files: acad-data-c3d20.zip

Start with acad-blk-xref-begin.dwg

acad-blk-xref-01.mp4 5:07

In this exercise, you will create a Block such that you have Layer control of the Block once created. 
You will do this by setting the objects making up the Block on Layer 0.

 1. Open acad-blk-xref-begin.dwg
 2. Set Current Layer = 0
 3. Ribbon > Home tab > Draw panel > Circle

 A. Draw a Circle
 I. Radius = 15±

 B.  Ribbon > Home tab > Draw panel > Polyline
 I. Draw a Polyline within the circle at its quadrants using quadrant Osnap.

 4. Ribbon > Insert tab > Block panel > Create

Info: bl is a command line "alias" that also invokes the block command.

 A. Name = test

 B. Base Point

 I. Specify on-screen = unchecked

 II.  Pick point

 a. Use Osnaps to specify center of Circle

 C. Settings

 I. Block unit = unitless

 D. Objects

 I. Specify on-screen = unchecked

 II. Convert to block = filled

 III. Select objects

 a. Select Circle and Polyline

 b. enter
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 E. Behavior

 I. Annotative = unchecked

 II. Scale uniformly = checked

 III. Allow exploding = checked

 F. OK

 5. Select test Block
 A. Properties palette > General

 I. Layer = E_ALI_Marker
 II. Observe Layer properties take effect

Info: In order to have Layer control of a Block Reference, the objects included 
in the Block must be placed on Layer 0. The Block itself can then be placed on 
any Layer as needed and the Layer properties will take effect.

Block creation continued, attributes & editing

Continue with acad-blk-xref-begin.dwg

acad-blk-xref-02.mp4 8:00

In this exercise, you will create a Block such that you do not have Layer control, then edit the Block 
so that you do have Layer control. You will also learn how to add a Block Attribute, which is a text 
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object contained in the Block whose properties are protected and whose content value can be edited  
in a user-friendly interface. When you insert an Attributed Block into a drawing, you will be prompted 
to enter specific information for the attribute content. Block Attributes are a great way to ensure that 
necessary text information is entered and that it is in the correct format. In the process of com-
pleting this exercise, you will take an introductory look at the Block Editor interface.

 1. Continue working in acad-blk-xref-begin.dwg
 2. Current Layer = E_ALI
 3. Ribbon > Home tab > Draw panel > Circle

 A. Draw a Circle
 I. Radius = 15±

 B. Ribbon > Home tab > Draw panel > Polyline
 I. Draw a Polyline within the circle at its quadrants using quadrant Osnap.

 4. bl enter
 A. Name = test2
 B. Base Point

 I.  Pick point
 a. Use Osnaps to specify center of Circle

 5. Objects
 A. Select objects

 I. Select Circle and Polyline
 II. enter

 6. Select test2 Block
 A. Properties palette > General

 I. Layer = E_ALI_Marker
 II. Observe Layer properties not taking effect

Info: If a Block has been created such that you do not have Layer control, you 
can enter Block Editor and place the objects contained in the Block on Layer 0. 
Then you will have Layer control of the Block.

 7. Ribbon > Insert tab > Block panel > Edit

Info: Two alternative ways to open block editor is by simply double-clicking on the 
block on choose it from the list, or by right-clicking and selecting edit block.

 A. Block to create or edit = test2

 B. OK

 I. Select Circle and Polyline

 a. Properties > General

 i. Layer = 0

 II. Block Editor Ribbon > Close panel > Close Block Editor

 a. Save the changes to test2
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 8. Observe Layer properties take effect
 9.  Select test2 Block

 A. Properties palette > General
 I. Layer = E_ALI

 10. Double-click test2 Block
 A. Block to create or edit = test2
 B. OK

 I. Block Editor Ribbon > Action Parameters panel > Attribute Definition
 a. Attribute

 i. Tag = Marker_ID
 ii. Prompt = Enter Marker ID
 iii. Default = Default ID

 b. Text Settings
 i. Annotative = unchecked
 ii. Text Height = 1

 c. OK
 II. Specify insertion point of Attribute within Circle

 C. Block Editor Ribbon > Close panel > Close Block Editor
 I. Save the changes to test2

 11. Ribbon > Insert tab > Blocks panel flyout > Synchronize Attributes
 A. Enter an option: Select

 B. Select test2 Block
 C. enter

 12. Double-click test2 Block
 A. Enhanced Attribute Editor > Attribute tab

 I. Value = 12345
 II. OK

Insert from block definition & edit insertion point

Continue with acad-blk-xref-begin.dwg

acad-blk-xref-03.mp4 3:53

In this exercise you will learn to insert a Block from the definition stored in the current drawing. You 
will also learn two methods to reset a Block insertion point in Block Editor.

 1. Continue with acad-blk-xref-begin.dwg
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 2. Ribbon > Insert tab > Block panel > Insert dropdown > Recent Blocks 
 A. Click test2 block

 I. Insertion point = checked
 II. Uniform Scale = unchecked

 a. value = 1
 III. Rotation = unchecked

 a. value = 0
 IV. Drag and drop block test2 into Model Space. 

 a. Edit Attributes
 i. Enter Marker ID = 6789

 b. OK
 3. Block Editor opens automatically

 A. Select all block objects
 B. m enter

 I. Specify base point: bottom quadrant of circle
 II. Specify second point: 0,0 enter
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 III.  
 C. Block Editor Ribbon > Close panel > Close Block Editor

 I. Save the changes to test2
 II. Notice grip edit has moved to lower quadrant of circle.

 4. be enter 
 A. choose test2 from list 

 I. OK
 B.  Block Editor Ribbon > Action Parameters panel > Basepoint

 I. Select the center of the circle using Osnap. 
 C. Block Editor Ribbon > Close panel > Close Block Editor

 I. Save the changes to test2
 II. Notice grip edit has moved to the center of circle.

Write block (WBLOCK)

Continue with acad-blk-xref-begin.dwg

acad-blk-xref-04.mp4 3:28

The WBLOCK command will write a Block Definition based on either existing Blocks or objects in the 
current drawing or the entire current drawing to a new, external drawing. This workflow is com-
monly used to write an entire drawing that has become corrupt to Block in order to leave behind 
those elements causing the corruption. This Block can then be inserted into a new drawing created 
from the appropriate template.

 1. Continue with acad-blk-xref-begin.dwg
 2. wblock enter

Info: When an entire drawing is written to a Block Definition using WBLOCK, the inser-
tion point for the newly written Block will be at the same location relative to the newly 
written Block objects as the 0,0 coordinate in the original drawing was to the original 
drawing objects. 

Tip: In the case where WBLOCK is used to insert an entire drawing  into a blank drawing 
started from an appropriate template in order to leave behind corruption, the Insertion 
point: Specify on-screen option is typically unchecked. This way the objects in the ori-
ginal drawing and the Block inserted into the new drawing will be a the same coordin-
ates. Additionally, the Explode option is typically checked. This way the newly inserted 
Block is automatically broken down to the level of the objects in the original drawing,

 A. Source = Entire drawing

 B. Destination

 I. File name and path: ...

 a. Browse to folder containing acad-blk-xref-begin.dwg
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 b. File name = new block.dwg

 c. Save

 C. Insert units = unitless

 D. OK

 E. Include AutoCAD Map information in the export?

 I. No

 3. Ribbon > Insert tab > Block panel > Insert
 A. Recent blocks:

 I. Choose new block and drag into Model Space
 4. x enter for explode

 A. select new block
 I. enter

 II. Notice that the block has been exploded into the two blocks contained within 
new block. This is called a nested block. 

 5. Windows File Explorer
 A. Browse to folder containing new block.dwg
 B. Select new block.dwg

 I. Drag and drop into Civil 3D drawing area
 6. Specify insertion point near other drawing objects

 A. Enter x scale factor <1>:

 I. enter
 B. Enter y scale factor <use x scale factor>:

 I. enter
 C. Specify rotation angle <0>:

 I. enter

Block Definitions, Insert Methods, Purge

Start with acad-blk-xref-01.dwg

acad-blk-xref-05.mp4 10:07

In this video you will how it is possible to purge Block Definitions if they are not currently inserted 
into the drawing are or referenced by Civil 3D or AutoCAD Styles. You will then use the Add Marker 
Symbols tool located on the Ribbon WisDOT Standards tab to bring those Block Definitions back into 
the drawing. The Add Marker Symbols tool can be used to add the standard WisDOT Marker Blocks 
into any drawing regardless of whether that drawing ever had those Block Definitions or not.

 1. Open acad-blk-xref-01.dwg
 2. Delete all blocks in Model Space. 
 3. Ribbon > Insert tab > Block panel > Insert dropdown 

 A. Observe test, test2 and new block listed. 
 B. Choose block A/C

 I. Insert block into Model Space. 
 4. Ribbon > WisDOT Sheets tab > Standards Components panel > Block Symbols
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 5. Ribbon > Insert tab > Block panel > Insert dropdown
 A. Observe many new blocks in the list. 

 6. Ribbon > Insert tab > Block panel > Insert dropdown > Recent blocks
 A. Switch to Current Drawing tab in Blocks palette
 B. Select block ZOR

 I. Insertion Point = checked
 II. Place block in Model Space.

 7. Delete all blocks in Model Space.
 8. Verify that all block definitions still exist in the Insert dropdown list. 
 9. PU enter to run the purge command. 

 A. Items not used in drawing

 I. select Blocks

 B. Purge Checked Items

 C. Purge All Checked Items

 D. Notice blocks test and test2 now show up in the purge list. This is because these were 
nested blocks within the new block definition. Once new block was purged, these two 
block definitions were added to the drawing. 

 I. Repeat the above steps to purge test and test2

Info: Alternatively, the option purge nested items could have been 
checked in order to remove test and test2 since these were nested 
blocks. 

 I. Close
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 10. Ribbon > Insert tab > Block panel > Insert dropdown
 A. Observe ZOR, test, test2 and new block not listed

 11. Ribbon > WisDOT Sheets tab > Standards Components panel > Block Symbols to add all 
WisDOT block definitions back into the drawing. 

 12. Ribbon > Insert tab > Block panel > Insert dropdown
 A. Observe ZOR listed

Design center: Insert block

Continue with acad-blk-xref-01.dwg

acad-blk-xref-06.mp4 5:06

In this exercise you will explore options to insert a Block Definition from an external drawing when it 
is not available through the WisDOT contextual tabs. You can either insert an entire external drawing 
using the INSERT command or pick which Block(s) to insert from an external drawing using the 
Design Center interface.

 1. Continue working in acad-blk-xref-01.dwg
 2. Ribbon > Insert tab > Block panel > Insert dropdown

 A. Select new block
 B. Specify insertion point anywhere in drawing area

 3. i enter
 A. Drag and drop new block from the Blocks palette.

 4. Delete the blocks placed in above steps. 
 5. Purge enter

 A. Items not used in drawing
 I. select Blocks

 B. Purge Checked Items
 C. Purge This Item
 D. Repeat the above steps to remove the block definition test which was a nested block. 
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 6. Ribbon > Home tab > Palettes panel flyout > Design Center

Info: dc is a command line "alias" that also invokes the Design Center palette. Altern-
atively,  ctrl + 2 will also open Design Center. 

 A. Folders tab > expand Folder list to new block.dwg

 A.  A. Select Blocks
 B. Drag and drop test2 into drawing area

Info: Another way to insert a block is to right-click on the block in Design 
Center, and choose Insert Block. All insert options can be modified in the res-
ulting Insert dialog box. 

 

 7. Edit Attributes
 A. Enter Marker ID: WisDOT
 B. OK

WisDOT sheets tab: topo tool palette

Start with acad-blk-xref-02.dwg

acad-blk-xref-07.mp4 2:47
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The topography Blocks used as Point Markers in Civil 3D Point Styles can be found and inserted dir-
ectly as Blocks into any drawing through the WisDOT Topo Tool Palette, which is found on the 
WisDOT Sheets contextual Ribbon. The Blocks inserted from these Tool Palettes are defined in 
external source drawings that install with the WisDOT Standards package.

 1. Open acad-blk-xref-02.dwg
 2. Ribbon > WisDOT Sheets

 A. Sheet Creation Components panel > Topo
 B. Tools panel > Palettes ON/OFF

 I. Topo Tool Palette > BuildingFencesTrees tab
 a. Tree Stump

 i. Specify insertion point near other drawing objects
 3. Select STMP Block

 A. Properties palette > General
 I. Layer = E_LAND_Vegetation

 4. Select STMP Block
 5. Ribbon > Home tab > Layers > Make Current

Info: The Blocks included on the Topo Tool Palette are also included as Block 
Definitions in most of the WisDOT templates. They are referenced as Point 
Markers in Civil 3D Point Styles which are also included in the WisDOT tem-
plates. More detailed information on Civil 3D Point Styles and Markers can be 
found in the Points training module.

Automatic scaling: block units & insertion units

Continue with acad-blk-xref-02.dwg

acad-blk-xref-08.mp4 7:40

When a Block is inserted into a drawing it will be automatically scaled by a factor based on the draw-
ing Insertion Units and the individual Block Units. The scale factor applied to a Block upon insertion 
will  represent the Block in terms of the drawing Insertion Units. For example, a Block with Block 
Units of "inches" and a length magnitude of 24 that is inserted into a drawing with Insertion Units of 
"feet" will be scaled by a factor of 1/12 and will be have a length magnitude of 2 after insertion. Both 
the Insertion Units and the Block Units must be set to a value other than "unitless" in order for this 
form of automatic scaling to take place. If either is set to unitless in the source drawing, the Block will 
come in with the same length quantity as that in the source drawing.

Info: Note that automatic Block scaling is not Annotative scaling, which will be 
covered in later training modules. 

 1. Continue working in acad-blk-xref-02.dwg
 2. Select STMP Block
 3. Properties palette > Misc

 A. Observe Block Unit = Unitless
 B. Observe that this field is not editable here
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 4. BE enter
 A. Block to create or edit = STMP

 B. OK

 C. Properties palette > Block

 I. Units = Inches

 D. Block Editor Ribbon > Close panel > Close Block Editor

 I. Save the changes to STMP

Warning: The Blocks included in the WisDOT Tool Palettes and various 
Templates should not be edited by the end user. This training module 
exercise is intended to teach you general Block behavior. You may need 
to edit Blocks coming from outside of WisDOT, however.

 5. units enter
 A. Units to scale inserted content to: feet
 B. OK

 6. i enter
 A. drag and drop the STMP block into Model Space.
 B. Select the block and open the Properties palette. 

 I.  Misc
 a. Observe Unit factor = 0.0833

 II.  Geometry
 a. Observe Scale = 0.0833

 III. esc
 C. Select the first block that was placed in the exercise and open the Properties palette. 

 I.  Misc
 a. Observe Unit factor = 0.0833

 II.  Geometry
 a. Observe Scale = 12

 III. esc
 7. Topo Tool Palette  > BuildingFencesTrees tab

 A. Tree Stump

 I. Specify insertion point near other objects

 II. Observe lack of automatic scaling

Info: When a Block is inserted from an external Block Definition, such as the 
source drawing used by the WisDOT Topo Tool Palette, the Block will scale 
based on the units in that external source drawing even if the Block Definition 
in the current drawing has been edited to have different Block units. To avoid 
this, the Block Definition in the source drawing would need to be edited.

Page: 462

Published on: 5/17/2023

Automatic scaling: block units & insertion units



 8. Topo Tool Palette  > BuildingFencesTrees tab
 A. Right-click Tree Stump
 B. Redefine
 C. Select the smallest block and open the Properties palette. 

 I.  Misc
 a. Block Unit: Unitless
 b. Observe Unit factor = 1

 II.  Geometry
 a. Observe Scale = 0.0833

 III. esc
 D. Select one of the larger blocks and open the Properties palette. 

 I.  Misc
 a. Block Unit: Unitless
 b. Observe Unit factor = 1

 II.  Geometry
 a. Observe Scale = 1

 III. esc
 9. qselect enter

 A. Object type = block reference
 B. Properties = name
 C. Value = STMP
 D. OK
 E. Observe that X and Y coordinate *VARIES* on the Properties palette
 F. Set Scale = 1

 I. Observe that the small block is not the same size as the other 2 blocks. 

Automatic scaling: redefine block from design center

Continue with acad-blk-xref-02.dwg

acad-blk-xref-09.mp4 7:41

The Blocks included on the WisDOT Tool Palettes can be redefined in a drawing by right-clicking on 
the corresponding Tool Palette button and choosing Redefine. For those Blocks not included on the 
WisDOT Tool Palettes, you can redefine the drawing Block Definition by browsing to the source draw-
ing through Design Center. This exercise goes through the workflow to redefine a Block through 
Design Center.

 1. Continue with acad-blk-xref-02.dwg
 2. Select test2 Block
 3. BE enter

 A. Block to create or edit = test2
 B. OK

 4. Properties palette > Block
 A. Units = Inches
 B. Block Editor Ribbon > Close panel > Close Block Editor

 I. Save the changes to test2
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 5. i enter
 A. Drag and drop test2 into Model Space. 
 B. OK
 C. Observe that this block is smaller than the one that was already in the drawing due to 

changing the units to inches in the block definition.
 6. DC enter

 A. Folders
 I.  Browse to new block.dwg

 a. Blocks
 i. Drag & drop test2 into Model Space. 
 ii. OK

 7. Properties palette
 A.  Geometry

 I. Observe Scale = 12

Info: In order to Insert a Block from an external source, such as through a Design Center, and 
have that external Block Definition update that in the current drawing, the Block in the 
external source drawing must be edited. Then you can browse to that Block in the external 
source through Design Center and redefine any instances of that Block Definition in the cur-
rent drawing. This is the same functionality that is found by right-clicking a WisDOT Tool 
Palette button and choosing Redefine, but it applies to any Block even if it is not included in 
the WisDOT Tool Palette.

 8. Open new block.dwg
 9. BE enter

 A. Block to create or edit = test2
 B. OK

 10. Properties palette > Block
 A. Units = Inches
 B. Block Editor Ribbon > Close panel > Close Block Editor

 I. Save the changes to test2
 11. Application menu > SaveAs

 A. File name = new block1.dwg
 B. Save

 12. DC enter
 A. Folders

 I. Browse to new block 1.dwg
 a. Blocks
 b. right-click test2

 i. Redfine only
 13. qselect enter

 A. Object type = block reference
 B. Properties = name
 C. Value = test2
 D. OK
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 14. Open Properties palette
 A. Observe that there are 3 blocks selected in Properties palette
 B. Properties palette > Geometry

 I. Scale = 1

WisDOT sheets tab: signs tool palette

Start with acad-blk-xref-03.dwg

acad-blk-xref-10.mp4 3:24

This exercise will walk you through the unique features included in the WisDOT Signs Tool Palette. 
The Blocks included on this tool palette represent the WisDOT standard signage details. These 
Dynamic Blocks include the ability to choose a version of each block from a dropdown list (Visibility 
Set) as well as a hyperlink to quickly view the associated WisDOT standard detail sheets. 

 1. Open acad-blk-xref-03.dwg
 2. Ribbon > WisDOT Sheets tab > Sheet Creation Components panel > Signs
 3.  Ribbon > WisDOT Sheets tab > Sheet Creation Components panel > Palettes ON/OFF

 A. D-Signs tab
 I. D1-51

 a. Specify insertion point anywhere in drawing area
 4. Select D1-51 Block

 A. Visibility set dropdown
 B. Choose alternative Visibilty from list
 C. esc
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 5. Double-click D1-51Block
 A. Enhanced Attribute Editor

 I. Select SIZE row
 II. Value = 120"X15"

 III. OK
 IV. Observe update to D1-51 Block in drawing area

 6. Ctrl+click D1-51 Block
 A. Observe web browser open the WisDOT signage detail D1-51.pdf

WisDOT design tab: intersections, beam guards & general blocks

Continue with acad-blk-xref-03.dwg

acad-blk-xref-11.mp4 5:47

The WisDOT Intersection Blocks and Beam Guard Tool Palattes contain dynamic Blocks which 
include easily editable linework to get started with your geometric layout. Insert these Blocks and 
use the Properties palette or dynamic Block grips to edit the linework. The WisDOT Design Ribbon 
tab also includes the Autodesk Palettes button. This will populate your Tool Palette with all of the 
default Autodesk Tool Palette tabs. Some of these default Tool Palette tabs contain default Autodesk 
Blocks that could potentially be useful to convey your design intentions.

 1. Continue working in acad-blk-xref-03.dwg
 2. Ribbon > WisDOT Design > Parametric Design panel > Intersection Blocks 

 A. Int-Type-A-Q-Grtr-80-In-Curve
 B. Specify insertion point near other drawing objects

 3. Select Int-Type-A-Q-Grtr-80-In-Curve Block
 A. Select Grip along incoming intersection centerline

 I. Specify point location for centerline
 B. Select Visibility Set dropdown

 I. Graphics Mode = checked
 C. Properties palette > Custom

 I. Observe editable parameters in tabulated form
 D. esc

 4. Ribbon > WisDOT Design >  Parametric Design panel > Beam Guard Blocks
 A. BG EAT R Right Curve
 B. Specify insertion point near other drawing objects
 C. OK 

 5. Select BG EAT R Right Curve Block
 A. Observe grips to edit linework geometry
 B. Properties palette > Custom

 I. Observe editable parameters in tabulated form
 C. esc
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 6. Ribbon > WisDOT Design >  Autodesk panel > Autodesk Palettes
 A. Left-click "stacked" tabs at bottom of Tool Palette
 B. Scroll down in list

 I. Highways
 a. Scroll to explore available out-of-the-box Blocks

 II. External Works
 a. Scroll to explore available out-of-the-box Blocks

Xref: overlay vs attach

Start with acad-blk-xref-04.dwg, acad-blk-xref-05.dwg and acad-blk-xref-06.dwg

acad-blk-xref-12.mp4 7:00

This exercise will introduce you to the External Referencing (Xref) workflow. You will create an Over-
lay Xref then change it to an Attach Xref and observe behavioral differences between the two. When 
an Xref is created as the type "Overlay", the Externally Referenced source drawing will not be carried 
forward if the destination drawing is then Externally Referenced into another drawing. When an Xref 
is created as the type "Attach", the Externally Referenced source drawing will be carried forward.

 1. Open acad-blk-xref-04.dwg, acad-blk-xref-05.dwg and acad-blk-xref-06.dwg
 2. File tab > acad-blk-xref-05
 3. Ribbon > Home tab > Palettes panel flyout > External Reference Manager

 

 4. External References palette > Attach dropdown > Attach DWG
 A. Browse to acad-blk-xref-04.dwg

 I. Open
 5. Attach External Reference

 A. Reference Type = Overlay
 B. Insertion Point > Specify On Screen = unchecked
 C. OK

 6. Ribbon > Home tab > Layers panel > Layer Properties
 A. Observe presence of Xref Layer Filters and Xref Layers
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 7. File tab > acad-blk-xref-06
 8. xr enter
 9. External References palette > Attach dropdown > Attach DWG

 A. Browse to acad-blk-xref-05.dwg
 I. Open

 B. Info: 
When acad-blk-xref-05.dwg is externally referenced into acad-blk-xref-06.dwg, 
no objects are displayed in acad-blk-xref-06.dwg. This is because the objects 
displayed in acad-blk-xref-05.dwg are only an "Overlay" xref of acad-blk-xref-
04.dwg. "Overlay" xrefs are not carried forward when their destination drawing 
is then used as an xref source drawing in another drawing. "Attach" xrefs are 
carried forward in this manner, however.

When acad-blk-xref-05.dwg is externally referenced into acad-blk-xref-06.dwg, 
xref Layers prefixed with acad-blk-xref-05 are created and are similar to the 
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Layers in acad-blk-xref-04.dwg. This is because both acad-blk-xref-04.dwg and 
acad-blk-xref-05.dwg were started from the same template (wisdot16.dwt) and 
this template includes all of those Layers.

 10. File tab > acad-blk-xref-05
 11. xr enter
 12. External References palette

 A. click on acad-blk-xref-04
 B. Details > Type = Attach

 13. Save acad-blk-xref-05.dwg
 14. File tab > acad-blk-xref-06

 A. xr enter
 I. Observe that acad-blk-xref-05.dwg needs reloading

 II. Right-click on acad-blk-xref-05.dwg and Reload.

Xref source path: full vs relative

Continue with acad-blk-xref-04.dwg, acad-blk-xref-05.dwg and acad-blk-xref-06.dwg

acad-blk-xref-13.mp4 6:05

You have three options to specify how the Xref file path relationship between the source drawing 
and destination drawing is defined. A Full Path Xref requires that the source drawing exist at the 
exact drive location called out in the destination drawing when the Xref was created. If not, the Xref 
source file will not be read and a notification will be displayed. A Relative Path Xref requires that the 
source drawing exist at the same folder hierarchy location relative to the destination drawing. In 
other words, the source and destination drawings must be the same number of folders away from 
each other in order for the Xref source drawing to be read. There is also a No Path option which 
requires that the path to the source drawing be included in the Civil 3D profile options support file 
search path list. This No Path Xref type is less common and will not be covered in this exercise.

 1. Continue working in acad-blk-xref-04.dwg, acad-blk-xref-05.dwg and acad-blk-xref-06.dwg
 2. Open External Reference Manager

 A. Observe full path displayed in acad-blk-xref-04 row, Saved Path column
 3. File tab > Close acad-blk-xref-04
 4. Windows File Explorer

 A. Browse to acad-blk-xref-04.dwg
 B. Move acad-blk-xref-04.dwg into XREF folder

 5. External References palette > right-click acad-blk-xref-04
 A. Reload
 B. Observe "Not Found" displayed in acad-blk-xref-04 row, Status column

 6. Windows File Explorer
 A. Browse to acad-blk-xref-04.dwg
 B. Move acad-blk-xref-04.dwg to location displayed in Saved Path column of External 

References palette
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 7. External References palette > right-click acad-blk-xref-04
 A. Reload
 B. Observe "Loaded" displayed in acad-blk-xref-04 row, Status column
 C. Right-click acad-blk-xref-04

 I. Change Path Type > Make Relative
 II. Observe partial file path displayed in acad-blk-xref-04 row, Saved Path column

 8. Save acad-blk-xref-05.dwg
 9. File tab > Close acad-blk-xref-05

 10. Windows File Explorer
 A. Browse to acad-blk-xref-04.dwg
 B. Move acad-blk-xref-04.dwg and acad-blk-xref-05.dwg into XREF folder

 11. Open acad-blk-xref-05.dwg
 12. External References Manager

 A. Observe "Loaded" displayed in acad-blk-xref-04 row, Status column

Bind xref

Start with acad-blk-xref-07.dwg

acad-blk-xref-14.mp4 3:56

Once an Xref is created in a drawing, you can insert the source objects, styles, Block Definitions and 
Layers through the BIND command. This will insert the source drawing content and create or merge 
similar content (i.e. similarly named Layers or Blocks) depending on the type of Bind you specify. In 
this exercise, you will Bind an Xref using both types of the Bind command and observe behavioral dif-
ferences between the two.

 1. Open acad-blk-xref-07.dwg
 2. xr enter

 A. Attach DWG
 I. Browse to acad-blk-xref-04.dwg

 a. Open
 B. Attach External Reference

 I. OK
 3. External References palette > Right-click acad-blk-xref-04

 A. Bind
 B. Bind Xrefs/DGN underlays

 I. Bind Type = Bind
 II. OK

Info: When you Bind an Xref using the type Bind, any content in the source 
drawing similarly named in the destination drawing will be duplicated. That 
duplicated content will be named with a prefix based on the source drawing 
name. When you Bind using the type Insert, any content in the source drawing 
similarly named in the destination drawing will be merged. The version of that 
similar content in the destination drawing will be used.
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 4. Ribbon > Home tab > Layers panel > Layer Properties
 A. Observe duplicate Layer naming convention

 5. Select all drawing objects
 A. Properties

 I. Observe selected object is a Block Reference
 II. Misc

 a. Observe name = acad-blk-xref-04
 B. esc

 6. Quick Access toolbar > Undo dropdown > Xref
 7. External Reference Manager

 A. Attach DWG
 I. Browse to acad-blk-xref-04.dwg

 a. Open
 B. Attach External Reference

 I. OK
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 8. External References palette > Right-click acad-blk-xref-04
 A. Bind
 B. Bind Xrefs/DGN underlays

 I. Bind Type = Insert
 II. OK

 9. Select acad-blk-xref-04 Block
 10. Ribbon > Home tab > Layers panel > Layer Properties

 A. Observe no duplicate Layers created

Annotation
Last updated: 2023-01-04

Total video time: 41:03

This section will cover annotation tools used to add notes and callouts to a drawing. We will go over 
AutoCAD tools to create Multiline Text (text-only notes), Multileaders (callouts with text and pointer), 
and Dimensions as well as their associated styles. It should be noted that any Civil 3D objects have 
their own Label Styles which can automatically label key design features and dynamically update 
based on changes to associated Civil 3D objects. These Civil 3D Labels Styles should always be used 
where possible as they reduce the potential for human error and eliminate tedious, manual annota-
tion work.  The annotation tools covered in this section are typically reserved for cases where Civil 3D 
Label Styles are not applicable. For example, they can be used for things like construction details, 
title sheets, and plan sheet borders.

Multiline text

Exercise files: acad-data-c3d20.zip

Start with acad-annotatn-begin.dwg

acad-annotatn-01.mp4 6:51

Info: Multiline text is the preferred method in WisDOT for typing or inserting general notes.

 1. Open acad-annotatn-begin.dwg
 2. Ribbon > Annotate tab > Text panel

 A. text style  dropdown: CalibriLight
 B. textsize: 0.10

 3.  Ribbon > Annotate tab > Text panel > Multiline Text
 A. Specify first corner:

 I. Use Osnaps to pick upper left corner of title block box
 B. Specify opposite corner:

 I. Use Osnaps to pick lower right corner of title block box
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 C. Type notes in  Mtext box
 D. Open maintainence crossover.txt in Notepad

 I. Copy text content
 II. Paste text content into Mtext box

 4. Select previously created Mtext with single click
 A. Observe insertion, column height and column width Grips displayed
 B. esc

 5. Double click previously created Mtext
 A. Observe Mtext contextual Ribbon displayed
 B. Mtext Ribbon

 I.  Formatting panel > Text style dropdown
 a. Choose alternative Text style
 b. Set back to CallibriLight

 II. Style panel > Text height field
 a. Key in new Text height
 b. Set back to 0.1000

 III. Paragraph panel > Justification dropdown
 a. Choose Middle Center

 C. Left-click outside Mtext editing box
 6. Select Mtext object

 A. Use Geometric Center Osnap to place insertion point at centroid of title block area
 B. esc

 7. Ribbon > Annotate tab > Text panel > Mulitline Text
 A. Specify first corner:

 I. Pick lower endpoint of green guiding Line
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 B. Specify opposite corner:

 C. Type general notes into Mtext box
 D. Highlight general notes text content
 E. Mtext Ribbon > Formatting panel > Change case dropdown

 I. Uppercase
 F. Mtext Ribbon > Tools panel flyout > Import Text

 I. Browse to general notes.txt
 II. Open

 G. Select part of the Mtext content
 H. Mtext Ribbon

 I.  Formatting panel > Text style dropdown
 a. Change Text style
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 II. Style panel > Text height field
 a. Change Text height

 III. Formatting panel > Match
 a. Highlight Text content with source formatting
 b. Highlight Text content for which to apply formatting

 IV. Highlight entire Mtext content
 a. Style panel > Text height field

 i. Text height = 0.1250
 V. Insert panel > Columns dropdown > No Columns

 a. Right click top of Mext box
 i. Set Mtext width = 38
 ii. OK

 I. Left-click outside Mtext box to finish editing

Text editing & legacy text

Continue with acad-annotatn-begin.dwg

acad-annotatn-02.mp4 5:32

In this exercise, you will learn some time-saving text editing functions including Change Case, Con-
vert to Mtext, Text Align, Match Properties, Check Spelling, and Find/ Replace as well as  the dif-
ferences between Multiline Text (Mtext) and Text (aka Dtext). Essentially, Text is the old version of 
Mtext. Where Mtext can have multiple lines of text content sorted into columns and rows as desired, 
Text is single line and has no column sorting ability built in. You can type mulitple lines of text con-
tent in a Text object, but each line will result in its own individual Text object. There is much less edit-
ing ability with Text vs Mtext and no associated contextual Ribbon. All that said, many older drawings 
or Civil 3D drawings with content imported from Microstation will contain the older legacy Text.

 1. Continue working in acad-annotatn-begin.dwg
 2. Ribbon > Annotate tab > Text panel > Multiline text dropdown > Single Line

 A. Specify start point of text or

 I. Pick bottom endpoint of the green Line above SECTION B-B detail
 B. Specify paper height <0.1000>

 I. enter
 C. Specify rotation angle of text <0>

 I. enter
 D. Type section a-a

 I. Left-click outside of Text object
 II. esc

 3. Select section a-aText
 A. tcase enter
 B. TCASE dialog box : UPPER CASE
 C. OK

 4. Ribbon > Home tab > Clipboard panel > Match properties 

Info: Command can also be invoked at command line using MA
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 A. Select source object

 I. Left click SECTION B-B Text

 B. Select destination object

 I. Left click SECTION A-A Text

 5. Select SECTION A-A Text
 A. Properties palette > Text

 I. Justify = Center
 6.  Ribbon > Express tools tab > Text panel > Convert to Mtext

 A. Select objects

 I. Select STATE OF WISCONSIN DEPARTMENT OF Text
 II. Select TRANSPORTATION Text

 III. enter
 7. Select STATE OF WISCONSIN DEPARTMENT OF TRANSPORTATION Mtext

 A. Properties palette > Text
 I. Justify = Middle Center

 II. esc
 8. Ribbon > Annotate tab > Text panel > Text Align

 A. Select text objects to align

 I. SECTION B-B Text
 II. SECTION A-A Text

 III. enter
 IV. Select text object to align to

 a.  SECTION A-A Text
 b. Pick second point

 i.  shift + left click below SECTION A-A Text
 9. Ribbon > Annotate tab > Text panel > Check Spelling

 A. Start
 B. Add to Dictionary
 C. Close

 10. Ribbon > Annotate tab > Text panel
 A. Find and Replace field: shld
 B.  Find and Replace

 I. Replace with: SHOULDER
 II. Replace All

 III. Done

Text Styles
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Continue with acad-annotatn-begin.dwg

acad-blk-xref-03.mp4 3:43

Whenever creating either Mtext or Text, the first step is to choose a Text Style. You pick this from a 
dropdown list on your Ribbon. As with other Civil 3D and AutoCAD Styles, the Text Styles available 
are associated with a drawing or template. The WisDOT Design templates come with the standard 
WisDOT Text Styles pre-loaded, though you may need to create or edit one when working with a 
drawing not created from the WisDOT template. A Text Style mainly controls font, text height, and 
annotative scaling functionality. In the following exercise you will learn how to interface with, edit 
and create a Text Style.

 1. Continue with acad-annotatn-begin.dwg
 2. Ribbon > Annotate tab > Text panel > Text Style flyout button or type STYLE at the com-

mand line.
 

 3. Current Text Style: CalibriLight
 4. New

 A. Style Name: style 2
 B. OK

 I. Font Name: Cambria
 II. Font Style: Regular

 III. Paper Text Height = 0.0000
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Info: When Paper Text Height = 0 in a Text Style, the height set in the TEXTSIZE 
system variable or the last Text Height used is applied.

 IV. Font Name: cdm.shx
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Info: Two basic font types can be used in Civil 3D. They are True Type or SHX. 
Whereas True Type fonts such as Arial and Calibri can have unique shapes and 
thickness, the older, SHX fonts are only one pixel wide and are more limited in 
styling options. WisDOT Text Styles as well as most design firms and software 
applications in general use True Type fonts. Note the different icons in the Font 
Name dropdown.

Multileader creation

Start with acad-annotatn-01.dwg

acad-annotatn-04.mp4 4:27

A Multileader (aka Mleader) is an annotation object consisting of a combination of a text and one or 
more leader/pointers. It is used to manually add notes pointing to a specific area of interest. The text 
portion behaves just like Mtext and the leader portion is dynamically attached to the text portion. 
The behavior of an Mleader is quite flexible. For instance, you can add multiple leaders on one or 
both sides of the text portion of an Mleader if you like. A typical use case for an Mleader would be 
for manual annotation of construction details or title sheets. In the following exercise, you will learn 
how to create and edit Mleaders.

Keep in mind that Civil 3D objects have their own automatically generated Civil 3D Labels that will 
automatically annotate key information like Alignment stationing, Points of Curvature/Tangency, 
PVIs, Corridor Cross Section information, etc and thus do not require manually created Mleaders for 
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annotation. More information on Civil 3D Label Styles will be covered in other training modules. Use 
of Mleaders should be reserved for cases where you are either not dealing with a Civil 3D object or 
need to add extra information not feasible to put into a Civil 3D Label. 

 1. Open acad-annotatn-01.dwg
 2. Select BOTTOM OF MEDIAN Mleader on right of SECTION A-A detail

 A. Double-click on the text portion
 B. Observe Mtext contextual Ribbon populated
 C. Left-click away from Mleader 

 3. Ribbon > Annotate tab > Leaders panel > Multileader
 A. Specify leader arrowhead location

 I. Use Nearest Osnap to pick bottom of TOPSOIL Line on right side of SECTION A-
A detail

 B. Specify leader landing location

 I. Pick below and left of arrowhead location
 C. Type TOPSOIL

 I. Left-click away from Mleader
 4. Repeat Steps 3.A - 3.C for 10:1 MAX 20:1 NORMAL Mleader

 5. Select TOPSOIL Mleader
 A. Select arrow Grip

 I. Specify stretch point

 a. Pick to left of TOPSOIL text portion

Info: Note that the Leader portion of the Mleader is dynamically 
attached to the text portion. Once the specified location of the Leader 
arrow crosses the middle of the text portion, the Leader landing will auto-
matically flip to the other side of the text.

 B. Select text insertion Grip
 I. Specify stretch point

 a. Left-click a new location
 C. Hover cursor over Leader landing Grip to reveal menu options

 I. Stretch
 a. Move text location just as in previous step
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 II. Lengthen landing
 a. Specify leader landing endpoint

 i. Left-click new location
 III. Add Leader

 a. Specify leader arrowhead location

 i. Left-click multiple new locations
 D. Hover cursor over arrow Grip

 I. Remove Leader
 E. Ribbon > Annotate tab > Leaders panel > Remove Leader

 I. Specify leaders to remove

 a. Select Leader
 b. enter

 F. Ribbon > Annotate tab > Leaders panel > Align
 I. Select multileaders

 a. Select TOPSOIL and 10:1 MAX 20:1 NORMAL Mleaders
 b. enter

 II. Select Multilieader to align to

 a. Select 10:1 MAX 20:1 NORMAL Mleader
 III. Specify direction

 a. shift + left-click left of 10:1 MAX 20:1 NORMAL Mleader

Multileader styles

Continue with acad-annotatn-01.dwg

acad-annotatn-05.mp4 7:30

Whenever creating an Mleader, you want to be aware of the currently set Mleader Style. You set this 
through the Ribbon Mleader Style Manager button. Mleader Styles control what Text Style is used for 
the Text portion, what the Leader and arrow portion looks like, whether a user-defined Block is used 
for either the arrow or in place of the text, and whether the Mleader is affected by Annotative Scaling 
among other things.  Through the following exercise, you will learn how to set the current Mleader 
Style, how to create or edit an Mleader Style, and what key Mleader parameters are set through the 
Mleader Style. The WisDOT templates come pre-loaded with standard WisDOT Mleader Styles and as 
with other Civil 3D or AutoCAD Styles, these should be used to streamline the plan production work-
flow and maintain a standard appearance across WisDOT plan sets.

 1. Continue working in acad-annotatn-01.dwg
 2. Select TOPSOIL Mleader

 A. Properties palette > Misc
 I. Observe Multileader style = 070

 3. Ribbon > Annotate tab > Leaders panel > Mleader Style Manager flyout button or type 
MLEADERSTYLE at the command line.
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 A. Current mulitleader style: 070
 B. Modify
 C. Leader Format tab:

 I. General
 a. Type = Straight

 II. Arrowhead
 a. Symbol = Dot

 III. OK
 D. Close
 E. Observe update to existing Mleaders with 070 Mleader Style
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 4. Ribbon > Annotate tab > Leaders panel > Mleader Style Manager flyout button
 A. Modify
 B. Leader Format tab

 I. Arrowhead
 a. Symbol = Closed filled

 II. Leader break
 a. Break size = 0.0700

 III. OK
 C. Close

 5. Select TOPSOIL and 10:1 MAX 20:1 NORMAL Mleaders
 A. Use Mleader Grips to relocate  Leader landings such that Leader lines cross

 6. Ribbon > Annotate tab > Dimensions panel > Break
 A. Select dimension to add/remove break

 I. Select 10:1 MAX 20:1 NORMAL Mleader
 B. Select object to break dimension

 I. Select TOPSOIL Mleader
 II. enter

Tip: The "object to break dimension" does not need to be an Mleader or Dimen-
sion. This could be most any Civil 3D or AutoCAD object

 7. Ribbon > Annotate tab > Leaders panel > Mleader Style Manager flyout button
 A. Modify
 B. Leader Structure tab

 I. Constraints
 a. Maximum leader points = 3

Info: Setting Maximum leader points = 3 or greater means you will be prompted 
for intermediate vertex points between the arrowhead and Leader landing 
when creating an Mleader. If Maximum leader points = 2, you can still place addi-
tional Leader vertices manually by hovering your cursor over an Mleader arrow-
head Grip and choosing Add vertex.

 C. OK
 D. Close

 8. Ribbon > Annotate tab > Leaders panel > Multileader
 A. Specify leader arrowhead location

 I. Pick any location for arrowhead
 B. Specify next point

 I. Pick any location to place break in leader line
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 C. Specify leader landing location

 D. Pick any location for landing placement

Info: This can also be achieved even if Maximum leader points is set to 2 by right-click-
ing on the arrow and selecting Add Vertex. 

 9. Repeat above steps to change Maximum leader points back to 2. 
 10. Ribbon > Annotate tab > Leaders panel > Mleader Style Manager flyout button

 A. Content tab
 I. Multileader type = Block

 a. Block options
 i. Source block = Detail Callout

 B. OK
 11. Ribbon > Annotate tab > Leaders panel > Multileader

 A. Specify leader arrowhead location

 I. Pick any location
 B. Specify leader landing location

 I. Pick any location
 C. Edit Attributes

 I. Enter view number = 1
 II. Enter sheet number = 2

 D. OK
 12. Place a multileader in the drawing

 A. Multileader type = Mtext
 I. Text options

 a. Text Style = Calibri Light
 b. The button to the right opens the Text Style Manager 
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 a. Cancel
 II. Leader connection

 a. Observe options affecting Horizontal, Vertical Leader landing attach-
ment

Dimension creation

Start with acad-annotatn-02.dwg

acad-annotatn-06.mp4 3:19

In Civil 3D, a Dimension is an object used to call out an angle or distance (length, radius, etc) in your 
drawing. It is made up of Dimension lines, Tick marks, and an automatically generated and dynamic 
Dimension value derived from the object or points you specify, the drawing units, and the Dimension 
Style units. The following exercise will walk you though how to create a Dimension as well as the 
importance of setting the correct Dimension Style.
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 1. Open both acad-annotatn-02.dwg and acad-annotatn-end.dwg
 2. acad-annotatn-end filetab

 A. Observe 20'-0"V.C. Dimension in SECTION B-B detail
 B. Observe 3' CRUSHED AGGREGATE BASE COURSE and 12' Dimensions in SECTION A-A 

detail
 3. acad-annotatn-02 filetab

 A. Ribbon > Annotate tab > Dimensions panel > Dimension Style dropdown > 070-
PLAN-CONVENTIONAL

 B. Dim Layer Override = Use Current
 C. Ribbon Home tab > Layers panel > Layer dropdown > P_MISC
 D. Ribbon > Annotate tab > Dimensions panel > Dimension type dropdown > Lin-

ear
 E.  Linear

 I. Specify first extension line origin

 a. Left end of arc in SECTION B-B
 II. Specify first extension line origin

 a. Right end of arc in SECTION B-B
 III. Specify dimension line location

 a. Above arc

 4. acad-annotatn-end filetab
 A. Double click 20'-0" V.C. Dimension

 I. Observe that all text in cell is highlighted 

Info: The highlighted text in a Dimension is automatically generated based on 
the geometry of the Dimension along with the Dimension Style. It can include a 
prefix or suffix such as "ft" etc. among other things

Dimension styles

Exercise files: acad-data-c3d20.zip

Continue with acad-annotatn-02.dwg

acad-annotatn-07.mp4 5:24

 1. Continue with both acad-annotatn-02.dwg and acad-annotatn-end.dwg
 2. acad-annotatn-02 filetab

 A. Select 20.00' Dimension
 I. Properties palette > Misc

 a. Observe Dim Style = 070-PLAN-CONVENTIONAL
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 II. Ribbon > Annotate tab > Dimensions panel > Dimension Style Manager 
flyout button or type DIMSTYLE at the command line.

 III. Styles
 a.  Select 070-PLAN-CONVENTIONAL

 i. Set Current
 IV. New...

 a. Annotative: checked
 b. Continue
 c. New Dimension Style dialog

 i.  Primary Units tab
 i. Unit format = Engineering
 ii. Precision = 0'-0"
 iii. Suffix = V.C.

 d. OK
 V. Close

 3. Select 20.00' Dimension
 A. Properties palette > Misc

 I. Dim Style = Copy(2) of 070-PLAN CONVENTIONAL
 4. Ribbon > Annotate tab > Dimensions panel > Dimension Style Manager flyout button

 A. Select Copy(2) of 070-PLAN CONVENTIONAL Dimension Style
 B. Modify

 I. Primary Units tab
 a. Linear dimensions

 i. Scale factor = 12
 b. Place a space before V.C. in the suffix
 c. Zero suppression

 i. 0 feet = unchecked
 ii. 0 inches = unchecked
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 C. OK
 D. Close

 

Additional Dimension Tools

Continue with acad-annotatn-02.dwg

acad-annotatn-08.mp4 4:17

 1. Continue with both acad-annotatn-02.dwg and acad-annotatn-end.dwg
 2. acad-annotatn-end filetab

 A. Observe dimensions for SECTION A-A
 3. acad-annotatn-02 filetab
 4.  Ribbon > Annotate tab > Dimensions panel > Dimension Style dropdown

 A. Select Copy of 070-PLAN CONVENTIONAL
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 5. Ribbon > Annotate tab > Dimensions panel > Linear
 A. Specify first extension line origin

 I. Left endpoint of pavement in SECTION A-A
 B. Specify second extension line origin

 I. Crown endpoint of pavement in SECTION A-A
 C. Specify dimesion line location

 I. Above SECTION A-A detail
 6. Ribbon > Annotate tab > Dimensions panel > Continue

 A. Specify Second extension line origin

 I. Right endpoint of pavement in SECTION A-A
 B. Specify second extension line origin

 I. Right endpoint of SECTION A-A Crushed Aggregate Shoulder
 II. enter

 7. Select previously drawn Dimensions
 8. delete
 9. Status bar > Selection cycling = on

 10. Ribbon > Annotate tab > Dimensions panel > Quick
 A. Select geometry to dimension

 I. Select Lines on top of SECTION A-A Pavement
 II. enter

 B. Specify dimension line position

 I. Above SECTION A-A detail
 11. Ribbon > Annotate tab > Dimensions panel > Quick

 A. Select geometry to dimension

 I. Select the four arcs in SECTION A-A
 II. enter

 III. Right-click Radius 
 IV. Delete these dimensions when finished. 

 12. Ribbon > Annotate tab > Dimension panel > Continue
 A. Specify Second extension line origin

 I. Select the right side linear dimension in SECTION A-A from the previous steps
 B. Specify second extension line origin

 I. Select endpoint of subgrade line in SECTION A-A
 13. Repeat the last step on the left side of SECTION A-A
 14. Double click 3' Dimension

 A. Place cursor after auto-generated Dimension text
 B. Type CRUSHED AGGREGATE BASE COURSE SHOULDER

 15. Repeat the last step for other 3' Dimension
 16. Select 3' CRUSHED AGGREGATE BASE COURSE SHOULDER Dimension

 A. Hover cursor over text Insertion Grip
 I. Move Text Only

 II. Relocate Dimension text beside outer Dimension extension line
 17. Repeat the last step for other 3' CRUSHED AGGREGATE BASE COURSE SHOULDER Dimension
 18. Double-click 3' CRUSHED AGGREGATE BASE COURSE SHOULDER Dimension

 A. Right-click width icon Set Mtext Width
 B. Reset width to 12 units

 19. Repeat the last step for other 3' CRUSHED AGGREGATE BASE COURSE SHOULDER Dimension
 20. Ribbon > Annotate tab > Dimension panel > Dimension
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Info: This is a dynamic dimension tool which will intuitively place the appropriate dimension 
type according to the selected objects. 

Annotative scale
Last updated: 2023-01-04

Total video time: 16:24

Annotative scaling is a way to control display and scaling of certain annotation-related AutoCAD 
objects when setting up a sheet layout to plot. The purpose of this scaling is to maintain readability 
of your plan sheet regardless of the sheet  scale. For instance, you may want to label individual prop-
erty parcels on a 1 IN:40 FT scale, but omit the parcel labels at a 1 IN:200 FT scale since they would 
not be readable. You may want to label street or highway names at a constant plotted text height on 
both a 1 IN:40 FT scale sheet and a 1 IN:200 FT sheet. You can accomplish both of these scenarios 
without  creating duplicate text objects and Layers for different sheet sizes. It should be noted that 
Civil 3D objects will be labeled automatically based on their Label Style and these Labels will auto-
matically scale similarly to AutoCAD objects affected by Annotative scaling.

Any object that will be affected by Annotative Scaling is said to be Annotative. AutoCAD objects avail-
able to be Annotative include Multiline Text, legacy single line Text, Blocks, Hatch objects, Dimen-
sions and Multileaders. Many of the text-related WisDOT Styles (Multiline Text, Dimension and 
Multileader Styles) are already set up to be Annotative. You can also change any Non-annotative Mul-
tiline Text, legacy single line Text, Block, Hatch object, Dimension or Multileader to be Annotative 
through the Properties Palette.

This training module will familiarize you with basic sheet Layout concepts necessary to understand 
Annotative Scaling, how Annotative Scaling works and tools/best practices for managing Annotative 
objects. More detailed information on sheet Layouts and plotting will be covered in other training 
modules.

Model vs paper, layouts & viewports

Exercise files: acad-data-c3d20.zip

Start with acad-annotatv-scl-begin.dwg

acad-annotatv-scl-01.mp4 5:08

This exercise will introduce you to the concepts of Model space vs Paper space, Layouts, Viewports, 
and Viewport Scales. Model space is the interface you will design your Civil 3D model in. It includes 
all of the Civil 3D and AutoCAD objects you will create to represent your modeled design. You can 
switch from Model space to a Layout interface where you will set up what your plotted plan sheet 
will look like. In a Layout, you can either draw objects in Paper space, which will not affect Model 
space, or have a Viewport object that acts as a window looking into Model space. You will learn how 
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to switch between Model space and a Layout, how to work in Paper space and Model space within a 
Layout, and how to create a Viewport and work with the Viewport scale. 

 1. Open acad-annotatv-scl-begin.dwg
 2. Observe the Model tab and Layout tab in the bottom left of your interface

 A. Click S11A103 Layout tab to activate the Layout

 3. Status Bar
 A.  Customization 

 I. Paper space = checked
 B. Paper space active
 C. Draw a Circle on your Layout in Paper space

 4. Click Model tab to activate Model space
 A. Observe no Circle displayed in Model space

 5. S11A103 Layout tab
 A. Delete the Circle drawn in the above step.

 6. Status Bar
 A. Model space active

Info: Activating Model space by toggling the Status Bar PAPER/MODEL button allows 
you to work in Model space through your Layout Viewport. This is not the same as 
switching to Model space by clicking the Model tab in the bottom left of your interface.

 B. Draw a Circle on your Layout in Model space
 7.   Model 

 A. Observe Circle displayed in Model space
 8.   S11A103 Layout tab

 A. Delete the Circle drawn in Model space

Info: Double-click in an empty area outside your Viewport as an alternative method to 
activate Paper space. Double-click in area inside a Viewport as an alternative method to 
activate Model space.

 9. Select Viewport
 A. delete
 B. Observe Model space objects not displayed
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 10. Ribbon > Home tab > Layers panel > Layer Properties
 A. Filters

 I. All = checked
 B. P_MISC_NoPlot = Current

 11. MVIEW enter
 A. Specify corner of viewport: 0,0

 I. enter
 B. Specify opposite corner: 17,11

 I. enter
 12. Select the Viewport created in the previous step

 A. Observe that the Viewport scale ≠ 1IN:10 FT
 B. Viewport scale dropdown > 1IN:10 FT

 13. Status bar
 A. Lock Viewport scale

 B. Zoom in/out
 I. Observe Viewport scale unchanged

 14. Status bar
 A. Unlock Viewport scale
 B. Double-click inside Viewport to activate Model space
 C. Zoom in/out

 I. Observe Viewport scale changed
 D. Undo Zoom command to reverse Viewport scale change

Scaling factor, display options & object scales list

Continue with acad-annotatv-scl-01.dwg

acad-annotatv-scl-02.mp4 5:52

In this exercise you will learn how Annotative Scale factors are applied based on the currently set 
Annotative Scale (aka Viewport Scale). Annotative objects have a constant Paper space size and a 
Model space size that depends on the current Annotative Scale. After completing this exercise, you 
will learn how to manually add scales to an Annotative Object's scales list to enable Annotative Scal-
ing of the object. Additionally, you will learn how to utilize Annotative scaling Status Bar options to 
control when Annotative Objects are displayed and whether scales are added to Annotative Objects 
automatically.

 1. Continue working in acad-annotatv-scl-01.dwg
 2. Select S.T.H. 25 Annotative Mtext near 557+00

 A. Properties Palette > Text
 I. Observe Paper Text Height = 0.1250, Model Text Height = 5.0000

 3. Status Bar
 A. Observe current view Annotative Scale = 1 IN:40 FT
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Info: For Annotative Objects, the Paper size is set manually or by the object Style. The 
current view Annotative Scale is set manually by selecting from a dropdown list on the 
Status Bar. The Model size is set automatically and is a product of the Paper Size and 
the current Annotative Scale (i.e. Model Text Height = Paper Text Height x Annotative 
Scale = 0.1250" x (40'/1") = 5.0000'

 4. Click 1IN_40FT - 4 Layout tab
 5. Verify Paper text height

 A. Dist enter
 B. Specify first point

 I. Left-click near bottom of S.T.H. 25 Mtext
 C. Specify second point

 I. Move cursor near top of S.T.H. 25 Mtext
 II. Observe tooltip displaying approx. 0.1250
 I. esc

 6. Verify Model text height
 A. Double-click inside plan  Viewport
 B. Repeat steps above on S.T.H. 25 Mtext

 I. Observe tooltip displaying approx. 5.0000
 C. esc

 7. 1IN_200FT - 1
 8. Status Bar

 A. Show annotation objects = on

Turning "Show annotation objects" on allows all Annotative objects to be displayed regardless 
of whether they have the current view Annotative Scale added to their object Scales List or 
not. If objects do have the current view Annotative Scale added to their object Scales List, they 
will be scaled using the current view Annotative Scale. If not, they will be displayed  using the 
original Annotative Scale added to their scales list.

 B. Observe all Annotative Objects displayed in plan view Viewport
 9. Select one of the S.T.H. 25 Mtext objects.

 A. Properties > Text 
 I. Observe Annotative scale = 1IN:40 FT

 B. Right-click menu > Annotative Object Scale > Add/Delete Scales
 I. Add

 a. 1 IN:200 FT
 b. OK

 10. Select S.T.H. 25 Mtext from above step. 
 A. Properties > Text

 I. Observe Annotative scale = 1 IN:200 FT
 II. Observe multiple scale previews displayed
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 B. Use insertion grip to move Mtext
 I. Observe only the display of the 1IN:200 FT scaled Mtext is moved

Info: When an Annotative Object has multiple scales, you have different loc-
ations for the display of the object at each scale. Do this by setting the scale of 
the display you want to move as the current Annotative Scale, then use the dis-
played Insertion Grip to move the object. The object will not be moved for the 
remaining object scales.

 II. esc

 11. Select 4TH AVE Mtext
 A. Right-click menu > Annotative Object Scale > Add Current Scale

 12. Select 4TH AVE Mtext
 A. Use insertion grip to move Mtext for readability

 13. Status Bar
 A. Show annotation objects = off
 B. Observe annotative objects lacking the current Annotation Scale in their object scales 

list no longer displayed

Use cases & scales list best practices
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Continue with acad-annotatv-scl-01.dwg

acad-annotatv-scl-03.mp4 5:24

In this exercise, you will learn best practices for Annotative object management including how to use 
the Annotative Scaling Status Bar options, strategies for object Scales List management, how to clean 
up multiple insertion points for objects with multiple object scales.

 1. Continue working in acad-annotatv-scl-01.dwg
 2. Click Model tab
 3. Status bar

 A. Add scales to annotative objects when the annotation scale changes = on
 B. Note that the above Status bar option is commonly referred to as "Add scales auto-

matically" or similar

 4. Status bar > Annotation scale dropdown > 1 IN:200 FT
 A. Observe scaling of both AutoCAD Annotative objects and Civil 3D Labels

Info: When the "Add scales automatically" Status Bar option is turned on and you 
change the current view Annotative scale, the new Annotative scale will be auto-
matically added to all Annotative object Scales lists in the drawing.

Warning: If you find yourself switching the current view Annotative scale often, it is 
best to leave the "Add scales automatically" Status Bar option turned off. This will pre-
vent you from adding extraneous object scales to Annotative objects unintentionally. 
You may not want all Annotative objects displayed at a given scale and thus should be 
more selective about adding Annotative Scales to object Scales lists. Additionally Civil 
3D must read all object Scales for display generation and this can become a significant 
resource drain if the number of object scales is too great.

 5. Select one of the S.T.H. 25 Mtext objects
 A. Properties palette > Text

 I. Observe Annotative scale = 1 IN:200 FT
 6. 1IN_200FT - 1

 A. Observe all Annotative objects now displayed at 1 IN:200 FT scale
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 7. Model
 A. Status bar > Annotation scale dropdown > 1 IN:40 FT

 8. Select all Annotative Mtext objects
 A. Right-click menu > Annotative Object Scale > Add/Delete Scale

 I. List all scales for selected objects = checked
 II. 1 IN:200 FT

 a. Delete
 III. OK

 9. Status bar
 A.  Add scales automatically = off
 B. Current view Annotative Scale dropdown > 1 IN:200 FT

 10. Select 4TH AVE Mtext and S.T.H. 25 Mtext near 380+00
 A. Right-click menu > Annotative Object Scale > Add Current Scale

 11. Select the Mtext from the above step.
 A. Relocate respective insertion points for readability
 B. esc
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 12. Select 4TH AVE Mtext
 A. Right-click menu > Annotative Object Scale > Synchronize multiple scale pos-

itions

Info: When running Synchronize multiple scale positions, the insertion point location 
used for synchronization is that associated with the current view Annotative Scale. Con-
veniently, this will be this insertion point whose Grip is displayed.

Linetype scale explained
Last updated: 2023-02-23

Total video time: 8:42

A list of the annotative and true scale linetypes used in WisDOT Civil 3D resource files can be found 
at WisDOT linetypes.

Annotative linetypes
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acad-lintyp-scl-xplnd-01.mp4 2:26

Most linetypes are annotative. Generally these linetypes include dashes, spaces and letters.  Annot-
ative linetypes automatically change size and spacing based on the annotation scale.  Examples 
include utility linetypes and real estate linetypes.

Set annotation scale in model space

Tip: A best practice is to set the model space annotation scale to the same annotation scale 
used for the layout viewports in the file. This will make annotative linetypes look the same in 
model space and the layout viewports.  If there is any difference in linetype appearance when 
the model space scale and paper space scale are the same, type REA (regen all) in the com-
mand line to update the graphics.

 1. Left-click the Annotation Scale button in the status bar and select a new annotation scale 
from the list.
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Set annotation scale in layout viewports

 1. Left-click select a layout viewport 

The viewport scale for the layout is displayed in the status bar                        

 

 2. Left-click the Viewport Lock button in the status bar to unlock the viewport

 3. 

 4. Left-click the Annotation Scale button in the status bar and select a new annotation scale 
from the list.
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 5. Left-click the Viewport Lock button in the status bar to lock the viewport
 6. Esc

 A. The viewport is unselected
 7. REA

 A. Regenerates and updates all the graphics.

True scale linetypes

acad-lintyp-scl-xplnd-02.mp4 3:39

True scale linetypes are not annotative. The appearance and spacings for these linetypes remain the 
same no matter what annotation scale is used. Examples include traffic control items (barrels at 25-
foot spacing) and pavement marking (12.5-foot dash with 37.5-foot skip) which have objects placed 
at specific distances. The appearance of the line is set through the object linetype scale to match 
drawing scale.
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Model space

Drawing true scale linetypes:

 1. Set the annotation scale to 1IN:1FT

 A. All of the linework entities may not be visible if a larger scale is selected before the line 
is drawn.

 2. Home tab > Draw panel > Polyline

 A. PLINE Specify start point: left-click the beginning of the line
 B. PLINE Specify next point or [Arc Halfwidth Length Undo Width]: 

select Length
 C. PLINE Specify length of line: Enter a distance that is a multiple of the entity 

spacing 
 I. Example: Barrels at a 25-foot spacing 

 a. Entering a length of 500 feet would place a barrel at the beginning and 
end of the line.

 b. Entering a length of 490 feet would NOT place a barrel at the beginning 
and end of the line. 

 i. Round down if the distance needed is between a multiple of the 
entity.

 D. Right-click > Enter
 I. The active command of drawing the polyline is ended.

 3. Select the line > Right-click > Properties
 A. Linetype scale = 1 / scale that the drawing will be in 

 I. Enter 1/40 or 0.025 for a 40 scale drawing
 4. Set the annotation scale to 1IN:40FT

 5. REA

 A. Regenerates and updates all the graphics.

Layouts

 1. 01 layout tab > Double-left-click inside sheet viewport
 A. Model space within the layout viewport is now active

 2. Select the line 
 A. A dot will appear at each end of the line to indicate the total length of the line

 3. Right-click > Properties 
 A. Linetype scale = 1 / scale of the line 

 I. Enter 1/100 or 0.01 to match the viewport scale of 1IN:100FT in this example.
 4. REA

 A. Regenerates and updates all the graphics.
 5. Double-left-click outside the viewport

 A. Working in model space within the layout is deactivated

XREF a file with true scale linetypes to a file with a different scale

acad-lintyp-scl-xplnd-03.mp4 2:36
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Layouts

True scale linetypes do not behave like annotative linetypes.  True scale linetypes will not display cor-
rectly after changing the viewport to a different annotation scale.

Options for handling differences in scale between drawings using true scale linetypes:

 1. Draw true scale linetypes in the same file as the layouts used for plans production
 2. LTSCALE (In the receiving file) 

 A. LTSCALE Enter new linetype scale factor:2.5
 I. LTSCALE is the global linetype scale for the receiving file, not the source file

 II. The new linetype scale factor equals the original scale of the true scale linework 
divided by the new scale 

 a. Example: Original scale of 100 / New scale of 40 = 2.5

Text styles - fonts
Last updated: 2016-03-11

2016 fonts
All of the custom DOT-fonts and DOT .shx font files are being retired as of the Civil 3D 2016 release. 
WisDOT Civil 3D 2016 standard fonts are now all Windows True-Type fonts. 

The old fonts will be provided for legacy purposes during the transition from Civil 3D 2014 to Civil 3D 
2016, but should not be used going forward.  The legacy text styles that use the DOT fonts are not 
included in the 2016 startup templates or sheet templates. The following is a list of the new 2016 
Text Styles with corresponding fonts.

Style Name Font Name Font Style Annotative

ArialBlack Arial Black Regular Yes

ArialNarrow Arial Narrow Regular  Yes

ArialNarrowBold Arial Narrow Bold Bold  Yes

ArialRegular Arial Regular Regular Yes

CalibriLight Calibri Light Regular Yes

CalibriRegular Calibri Regular Yes

Legend Calibri Regular No

Standard Arial Regular No

Annotative text styles
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The default for all but two of these Text Styles is Annotative. The text height is set to 0.00 in each 
style. The size of text should be addressed at the Civil 3D style level or annotation tool level and not 
at the Text Style level. This allows to leverage the civil annotation tools without the need for multiple 
styles with different sizes. To maintain typical WisDOT production standards it is unnecessary to 
develop any other Text Styles.

Legacy text styles & DOT fonts vs. Civil 3D 2016 text styles
The default for all but two of these Text Styles is Annotative. The text height is set to 0.00 in each 
style. The size of text should be addressed at the Civil 3D style level or annotation tool level and not 
at the Text Style level. This allows to leverage the civil annotation tools without the need for multiple 
styles with different sizes. To maintain typical WisDOT production standards it is unnecessary to 
develop any other Text Styles.

Legacy 2016 and beyond   Legacy 2016 and beyond

C3D Text Style C3D  Text Style   DOT Font C3D  Text Style

080 CalibriLight   DOT_FONT_5 CalibriLight

100 CalibriLight   Dot_Font_10 CalibriLight

120 CalibriLight   dot_font15 ArialRegular

140 CalibriLight   dot_font20 CalibriLight

175 CalibriLight   dot_font25 TBD

200 CalibriLight   dot_font35 ArialBlack

350 CalibriLight   dot_font44 TBD

TPP_240 ArialRegular   dot_font45 ArialRegular

TPP_280 ArialRegular   dot_font49 TBD
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TPP_400 ArialRegular   dot_font55 CalibriRegular

TPP_500 ArialRegular   dot_font125 TBD

TPP_525 ArialRegular      

Light drafting techniques
Last updated: 2022-03-14

Total video time: 4:56

Exercise files: acad-lit-drfting-data-C3D20.zip

acad-lit-drfting.mp4 4:56

Light drafting technique
 1. c3d > 12345678 > Design > AliProfs

 A. Open file AliProf-Sth-15-Alt3.dwg
 2. Scroll down to Data Shortcuts

 A. Right-Click on Data Shortcuts > Set Working Folder
 I. Set to folder 2 folders above shortcut folder

 a. C3D and OK
 B. Right-Click on Data Shortcuts > Set Data Shortcut Project Folder > choose pro-

ject folder > 
 I. OK

 3. Data Shortcuts pull down > Surfaces > right-click on Exist > Create Reference
 A. OK

 4. Double Click on wheel mouse to Zoom.
 5. Data Shortcuts pull down > Alignments > centerline alignments > right-click on 15-Alt1 

> Create Reference
 A.  OK

 6. Left-Click on the surface > Modify panel > Surfaces Properties
 7.  A. Information tab > Surface style = EX Contours 5'Major:1'Minor

 B. OK.
 C. ESC

 8. Draw panel of the Ribbon > Polyline
 A. Starting from the left hand side and working to the right click a series of points. 
 B. Enter 

 9. Annotate tab of the Ribbon > Text panel > Multiline Text
 10. Left-Click to create a text box.
 11. Type in the box Passing lane 150' - widen 12'
 12. Left-Click to enter text box.
 13. SC Enter
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 14. Click on text and type in 10.
 15. Enter

Create a custom annotative scale (annoscale)
Last updated: 2022-03-14

acad-creat-cstm-annoscale-01.mp4 2:48

Sometimes you may have a need for an annotative scale that is not in a template DWT.

 1. To access the scale list in the status bar 

 A. Select the edge of a viewport, or double-click inside the viewport to activate it

 B. Or go to the Model tab to access the list

Info: A viewport cannot be set to a different scale and a custom scale cannot be cre-
ated while a locked viewport is selected. The status bar scale display will be grayed 
out. Either temporarily unlock the viewport or go to the model tab to create a scale. 

 2. Status bar > Scale drop-down > Custom...

 3. Edit Drawing Scales dialog > Add

 4. Type in a name for the new scale 
 A. Typical format is 1 IN: X FT (or X MI)

 B. Example ¼ mile (or 0.25 MI) is 1 IN: 0.25 MI. 
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 5. In the Drawing units field type in the feet of the scale. 
 A. Scale properties are unitless. If you are creating a scale that one unit to a different unit 

(feet to miles for instance) you need to make the scale all in one unit. 

 I. Example: 0.25 MI is 1320 FT ( calculated: 5280/4=1320) 

 B. Drawing units: 1320

 I. OK

 6. Use Move Up and Move Down to place the new scale in the appropriate place in the list. 

 7. This scale can be assigned to any viewport or to the model tab drawing scale in this file.

Info: Newly created scales only exist in the file they are created it in.

TrueView navigating and measuring
Last updated: 2021-03-18

Total video time: 3:35

Exercise files: acad-truvu-nvigat-mesur-data-C3D20.zip

acad-truvu-nvigat-mesur.mp4 3:35

TrueView navigating and measuring
 1. c3d > 12345678 > SheetsOther

 A. Open file Stoneridge Road Aerial.dwg

Info: Ignore missing SHX files if prompted. 

 2. Scroll with the wheel to zoom in.
 3. Push the wheel to pan.
 4. View ribbon  > Unsaved View > 

 A. West
 B. North
 C. East
 D. Intersection

 5. Navigation ribbon > Extents

Info: Zoom Extents is also done by double-clicking on the scroll button of the mouse. 

 6. Zoom to Intersection saved view. 
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 7. Measure ribbon > Measure > Distance
 A. Object Snap toolbar > Endpoint
 B. Left-Click on the end of driveway
 C. Object Snap toolbar > Intersection
 D. Left-Click where two road ways intersect.
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Non-Survey base data
Create topo file from Mapping
Last updated: 2021-09-09

Total video time: 18:35

Export from MicroStation to DWG

nosrvy-creat-topo-frm-map-01.mp4 3:39                 

Info: 
This process is best if a DGN doesn't contains any of the legacy levels (Level 1, Level 2, Level 3, 
etc.)

This process is typically completed by the Survey and Mapping unit.  Prior to exporting to 
DWG, the Survey and Mapping unit will export a 3D DGN of the mapping data to a 2D DGN.

 1. In Microstation, open the DGN file.       
 2. File > Save As                  Save as Type: Autodesk (R) DWG Files (*.dwg) 

 3. Options
 A. General tab

 I. Basic                 
 a. DWG Version: Newest available
 b. DWG Seed File: C:\ProgramData\Bentley\MicroStation V8i 

(SELECTseries)\WorkSpace\System\seed\seed.dwg

Page: 509

Published on: 5/17/2023

Non-Survey base data

https://c3dkb.dot.wi.gov/video/acad/nosrvy-bs-data/nosrvy-creat-topo-frm-map-01.mp4


 II. Cells                 
 a. Create Single Block for Duplicated Cells: Checked
 b. Create Scaled Blocks: Checked

            
 B. Remap tab

 I. CSV File: C:\CADDS\msv8i\data\WISDOT-V8DGN-EXPORT.CSV
 II. Turn on:                 

 a. Apply Level Mapping
 b. Apply Line Style Mapping
 c. Apply Color Mapping
 d. Apply Weight Mapping
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 III. OK                                   

              
Save

Insert exported DWG into Civil 3D

nosrvy-creat-topo-frm-map-02.mp4 7:03                

 1. Open Civil 3D (applicable for 2020 and newer)         
 A. Application Menu > New > survey-start.dwt
 B. Application menu > Save As >Enter file name

 I. Standard naming for Existing Mapping topography is M(flightname)-<C3D ver-
sion>.dwg

 II. Standard naming for topographic files used in plans production is Topo-
ex.dwg. This can be a combination of mapping and survey objects, just map-
ping objects, or just survey objects, depending on project needs.

 III. Civil 3D File Naming Standard: FDM 15-5 Attachment 3.3 CADDS AutoCAD Civil 
3D File and Layout Naming Standard

 2. WisDOT Survey Tab > Mapping Panel > Insert Mapping File
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a

 A. Select the DWG that was exported from Microstation > Open

 B. The chosen file is inserted into the drawing.  
 C. Repeat the command if more files need to be inserted.

The Insert Mapping File tool works to ensure that all blocks and text objects contained in the 
dwg are properly migrated from the Microstation exported DWG.  The remaining topics below 
are provided as guides if there are things that need to be corrected.  In cases where objects 
need to be corrected, please notify support.cae@dot.wi.gov so the Insert Mapping File tool can 
be reviewed. 

Optional: Update blocks

nosrvy-creat-topo-frm-map-03.mp4 9:11                

Info: At times, certain blocks that are migrated from DGN to Civil 3D DWG may not convert cor-
rectly.  This is apparent when reviewing the insert block dialog.  Blocks that contain names with 
"_##" in them are blocks that need to be updated.  They also show up as color in the insert 
block dialog.
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 1. Add all correct block definitions to the drawing: WisDOT #### Tab > Manage Panel > Add  
Components > All Components

 A. Repeat this step later on if it appears that a target block to be inserted is missing.
 2. Review the Insert Block Dialog Box to find blocks that need to be replaced.         

 A. Command Line: InsertEnter
 B. The Insert Dialog Box will open.  Scroll through the Current Drawing Tab to find any 

blocks that need to be replaced, as shown in the image above.           
 C. Typically, blocks that end with _## will need replacement.           
 D.              Best practice is to keep the Block Dialog open while updating blocks.  Use the Block 

Dialog as a reference as to which blocks need to be updated.  Once the old blocks are 
purged from the drawing using Purge command PU or the DOTClean Action Recorder 
Script, the Block Dialog will update and not show the old blocks.  This is recommended 
to be completed after all blocks are updated.           

 E.              To see locations of "bad" blocks, use Quick Select to select all instances of the blocks 
that meet the search criteria applied.             

 I. Right Click > Quick Select
 II. Apply to: Entire Drawing

 III. Object Type: Block Reference
 IV. Properties: Name
 V. Operator: * Wildcard Match
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 VI. Value: BlockName_*

 3. The block replacement command requires the selection of the new block. Begin by placing 
the target new block that will be replacing the outdated blocks.  This can be done anywhere in 
modelspace.         
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 A. Only select blocks that appear white and do not have the _## suffix.

 4.          WisDOT #### Tab > Manage Panel > DWG > Replace Blocks
 A. Select the blocks to be replaced             

 I. Option 1: Type the Name of the block                 
 a. At the Command Line type AC_* (Block name without the number suf-

fixes plus a wildcard >  XX_*)                                            It is recommend to always include the "_
*"when typing the name of a block (ie AC_*), unless you know exactly 
the name of the block that is needing to be replaced, whereas the com-
plete block name could be entered  (ie AC_1).

 b. Enter
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 II. Option 2: Select a block to be replaced in model space.                 
 a. After entering the DOTBLKREPLACE command, pick the option Select 

block to use name

 b. Navigate to and select a block to be replaced 
 i. The tool will look at the block name and create a filter based on 

that name.  For instance, if the block name is INLT_61, it will auto-
matically select all blocks that meet the wildcard name of INLT_*

 B. Select the block that is the target replacement             
 I. Selection must be done in modelspace

 II. This could be a block that is placed using the Insert Dialog Box in step 2, or a 
block that has already been placed in model space.

 C. The blocks will be replaced while maintaining all original properties 
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 5. Repeat steps 3 and 4 for all remaining blocks.         
 A. Use the Insert Block Dialog Box to determine which blocks to replace.

 6. Clean and purge all unused blocks from the drawing.         
 A. Command Line: PurgeEnter

 I. In the Purge Dialog Box, ensure all checkboxes are selected.

 B. Purge All
 C. All unused _## blocks should be removed.           

 7. Review the Block Palette for any blocks that may contain _## in the name and should be 
replaced.       

Attach an ortho image to a DWG using Map Connect
Last updated: 2022-02-14

Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 
2018 has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is 
needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, 
Wisconsin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.
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There are multiple ways to bring in imagery files into Civil 3D. Sometimes these files will not plot cor-
rectly.

Warning: MAPIINSERT should be avoided. It can cause shifts in plots that will not manifest 
until plot time (i.e. looks good in modelspace, looks good in paperspace, pdf/hardcopy shifts). 
Any large image that requires a rotation in the viewport, that is aligned with a linear object is a 
good candidate to show this problem.

The following workflow is recommended to minimize issues related to plotting ortho-imagery files.

 1. MAPWSPACE Enter
 2. MAPWSPACE Task Pane <On>: Enter
 3. TASK PANE > Display Manager tab > Data > Connect to Data...

 A. Data Connections by Provider: Add Raster Image or Surface Connection
 B. Navigate to desired image.
 C. Open File

Warning: An image will not connect if the name of the image file has a comma 
(,) in it. Rename the image file, replacing any commas with underscores (_) 
before attempting to add a new connection.

 D. Connect
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 E. At this point, an image can be reprojected if it's projection is different than the DWG. 
See "Working with spatially referenced DWG, image, and GIS files" below for steps to 
reproject.

 F. Add to Map

 

Working with spatially referenced DWG, image, and GIS files
Last updated: 2022-02-14

Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 
2018 has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is 
needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, 
Wisconsin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

Assign coordinate system to active DWG and any DWG files to be attached

 1. Application Menu > Drawing Utilities > Drawing Settings.
 o Drawing Settings dialog box > Units and Zone tab.

 n In the zone area at the bottom of the tab, change the category to "USA, Wis-
consin".

 n Change the available coordinate system to the one desired. Make sure that the 
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units are set correctly.
 n OK

If other DWG files are to be georeferenced, repeat this process for all DWG used to be used.

Open the map task pane or Mapconnect

There are two options for connecting to spatial data

 1.  MAPWSPACE Enter.  Enter at the next prompt to set the task pane on. The Task Pane should 
be visible. This method is necessary for attachng to a spatially-referenced DWG.

 2. MAPCONNECT Enter If using this method, go directly to "How to use a data connection #con-
nection" below

The rest of the commands can all be found in the same area, but have slightly different options 
depending on what type of file is being attached.

Attach DWG

 1. Map Task Pane > Display Manager tab > Data button > Add Drawing Data > Attach 
Source Drawings

 o This will open the Define/Modify Drawing Set dialog box.
 o Click Attach... This will open the Select Drawings to Attach dialog box.
 o The first time this dialog is used, an alias will need to be set for any drives other than 

the C drive.

Set N drive as an alias

 1. Select Drawings to Attach dialog box > Create/Edit Aliases  
 o It can be found two buttons to the right of the drive letter dropdown. This will open 

the Drive Alias Administration dialog box.
 o For Drive Alias Details Drive Alias: N
 o Actual Path: \\wis31fp1\n3public (This is an example in drive for the Wisconsin Rapids 

office. A user's individual in drive can be found by looking at the path after the N drive 
in My Computer in Windows Explorer.)

 2. Click Add. The alias letter and path should appear in the Drive List window. Click Close.
 3. Select the alias letter where the DWGs are in the Look in: window.
 4. Navigate to the folder with the DWGs. Highlight the files to attach. Click Add.
 5. When all of the DWGs have been selected, click OK. This will return the user to the 

Defined/Modify Drawing Set dialog box.
 6. Click on the drawings to be attached, or click Select All. Click OK.
 7. The files may not display immediately. If this occurs, in the Task Pane, click the Map Explorer 

tab. The attached files should show up under Drawings. Right-click on the file name and click 
"Quick View" to view the file.

How to use a data connection #connection

All types of data connections work in a similar manner. The following instructions will use a shape 
file for an example. Data connections to local files can either be at the folder level or at the file level. 
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A folder full of shape files can be managed through one data connection.

 1. Click Add SHP Connection.
 o Connection name: Set this to something meaningful. "Dane County Tax Parcels" for 

instance.
 o Source file or folder: Click either the Open File or Browse Folder buttons to navigate to 

the correct location. This field will then fill in with the correct information.
 o When the source is populated, the Connect button will be enabled. Click Connect . This 

will open the AddDatatoMap dialog.
The available files will display in a window. If Civil 3D can read the files projection information, it will 
show up here under Coordinate System. If a coordinate system is not found,<unknown > will be dis-
played.

 2. To set the coordinate systems for files, click on the file to set under Schema, then click the 
Edit Coordinate Systems button. This will open the Edit Spatial Contexts dialog box.

 o Click on the files to set the coordinate system for and click Edit.... This will open the 
Coordinate System Library dialog box.

 n In the Category: window, select the appropriate category of coordinate sys-
tems. This should always be the WisDOT category.

 n In the Unit: window, select the appropriate unit. For example, US Survey Foot.
 n In the main window, click the coordinate system to be assigned to the ref-

erenced file.
 n Click Select. This will bring back the Edit Spatial Contexts dialogbox.

 o Click OK. This will bring back the AddDatatoMap dialog. The correct coordinates sys-
tem should show up in the main window.

 o Click Add to Map. The contents of the file should show up in model space and also 
show up in the Task Pane. Raster images will also show up in the AutoCAD reference 
dialog.

Working with GIS data

This section will not attempt to go into all of the different options available to work with GIS data in 
Civil 3D.

 l In Task Pane > Display Manager, right-click on any data layer to see all of the possible 
options associated with it.  From this right-click menu, data display, selection, labeling, data 
table viewing, and other options can be accessed.

Raster design
Last updated: 2015-04-21

Raster design

Included with your Civil 3D 2014 install is AutoCAD Raster Design 2014. Methods does not have train-
ing or workflow documentation for Raster Design. More information concerning Raster Design func-
tionality can be found at http://www.autodesk.com/products/autodesk-autocad-raster-
design/overview#

Page: 521

Published on: 5/17/2023

Raster design

http://www.autodesk.com/products/autodesk-autocad-raster-design/overview#
http://www.autodesk.com/products/autodesk-autocad-raster-design/overview#


To run AutoCAD Raster Design 2014 click on the icon on the desktop, Raster Design 2014 on 
AutoCAD 2014 – English, or go to Start>All Programs>Autodesk>AutoCAD Raster Design 2014 
and select Raster Design 2014 on AutoCAD 2014 – English.

Using the Civil 3D Bing map feature for the first time (WisDOT employ-
ees)
Last updated: 2016-03-08

Civil 3D Bing map feature

In Civil 3D 2016, any time you assign a coordinate system to a drawing, or open a drawing with a 
coordinate system assigned, the GeoLocation ribbon will automatically appear.

To access a Bing Roadway, Aerial, or Hybrid map, make your selection through the Map pull-down 
menu.

The first time you use this feature, you will be prompted to log on to the dot proxy server.  Use your 
dot computer logon username and password.
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Next, you will be prompted for an Autodesk A360 username and password.  If you already have an 
A360 account, enter your credentials and the Bing map will appear.

If you do not have an A360 account, you can sign up for a free account at this address.

https://login.autodesk360.com/login/signup?edition=personal

Creating a wetland survey Civil 3D drawing
Last updated: 2022-06-03
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nosrvy-creat-wetlnd-dwg-01.mp4 12:37                 

DWG  Import

This workflow is intended for DWG's that are created from other applications (for example Micro-
station or Trimble Business Center). The AutoCAD DWG's created by these applications are not dir-
ectly ready for consumption within the WisDOT Civil 3D workflow and need to be modified to look 
and print according to WisDOT Standards.

This workflow requires the usage of the WisDOT Civil 3D Package, which can be downloaded and 
installed here for external partners: Wisconsin Department of Transportation Civil 3D file descrip-
tions (wisconsindot.gov)

Create new DWG

 1. Start Civil 3D using the Civil 3D 20XX WisDOT Desktop Shortcut
 2. Create a new drawing using the survey-start.dwt.

 A. Civil 3D Start tab > New > survey-start.dwt
 3. Save the drawing in the desired location.

Import Wetland DWG

 1. WisDOT Survey tab > Mapping Panel > Insert Mapping File
 2. Most likely, the lines/objects that are inserted into the drawing will not be on the correct 

layer. Each object will need to move to the correct WisDOT Civil 3D layer.
 3. Add all components (Layers, Linetypes, etc)

 A. WisDOT tab > Manage Panel > Add Components > All Components
 4. Update all wetland boundary objects

 A. Select one boundary > right click > select similar
 B. Change the active layer for the objects 

 I. Home tab > Layers Panel > Layers Drop Down
 II. E_WTR_Wetland_Boundary

 5. Update all project area objects
 A. Select one boundary > right click > select similar
 B. Change the active layer for the objects 

 I. Home tab > Layers Panel > Layers Drop Down
 II. E_WTR_Wetland_ProjArea

 6. Update all sample point objects
 A. If applicable: Convert all AutoCAD  points to COGO points 

 I. Home tab > Points > Point Creation Tools
 a. Manual Points Drop Down > Convert AutoCAD Points
 b. Window select all objects in model space.  All AutoCAD points will be selec-

ted and all others will be filters out.
 c. Command Line: Enter a point description: Enter without enter-

ing a description. (For each point)
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 B. Update Point Layer 
 I. Select a sample point > right click > select similar

 II. Change the active layer for the objects 
 a. Home tab > Layers Panel > Layers Drop Down
 b. E_WTR_Wetland

 C. Update point style 
 I. Select all points

 II. Contextual Ribbon > Edit/list points
 a. Shift-select all points in list
 b. Style Column > Hold Shift > Click one cell in the Style column to set 

the Point Style 
 i. Select Point Style: Standard

 c. Point Label Style Column > Hold Shift > Click one cell in the Point 
Label Style Column to set the label style 

 i. Select Label Style: Pnt Number
 d. Update Point Numbers as required
 e. Green Check Mark to dismiss the dialog

 7. Delete other un-needed objects
 A. Duplicate lines

Add wetland type property set

The survey template is delivered with a property set containing all possible wetland types.  This prop-
erty set must be manually added to the objects. This property set works on polylines, feature lines, 
survey figures, and more.

 1. Select all wetland boundaries
 2. Right click > Properties
 3. Properties Palette > Extended Data tab
 4. Click the Add Property Sets button in the bottom left corner

 5. From the Add Property Sets dialog, select the WetlandType property set > OK

Assign the appropriate wetland types

Now that the objects have the WetlandType property set, the wetland type can be assigned. This 
property set works on polylines, feature lines, survey figures, and more.
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 1. Select all boundaries of the same wetland type.
 2. Properties Palette > Extended data:  Assign the appropriate wetland type.

 3. Repeat for the remaining wetland boundary objects.

Add Wetland Labels

After the wetland objects have the wetland type property set assigned, the objects can be labeled.

 1. Annotate tab > Add Labels

 A. Feature: Line and Curve
 B. Label Type: Single Segment
 C. Line Label Style: Wetland
 D. Curve Label Style: Wetland

 2. Add
 3. Select the objects to place labels
 4. After placement, adjust the location of the labels for best viewing, or leave as is.
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Drawing clean up

After migrating all objects to appropriate layers and display styles, the unused components can be 
purged from the drawing

 1. Command line: PU
 2. Purge all unused components (Layers, Linetypes, blocks, etc)
 3. Save the drawing.
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Points
Civil 3D point basics
Last updated: 2021-06-17

Total video time: 05:31

pnt-basc-01.mp4 5:31

Exercise Files:pnt-basc-data-begin-c3d20.zip

Point types

AutoCAD Point (aka Node)

 1. XYZ marker, marks Cartesian coordinate location. 
 2. Not used for most Civil 3D workflows.
 3. PTYPE Enter

 A. Point Style dialog box
 B. Select a Point Style (style will affect every AutoCAD point in the file).
 C. OK

 4. Limited display control; only Layers.

COGO Points

 1. Typically used for proposed construction staking points, not existing survey data pre-
dominantly.

 2. Appearance is controlled by Civil 3D Styles with Description Key Set.  Point Style for the sym-
bol, Point Label Style for the text.

 3. Select on marker or text is all one unit.

Survey Points

 1. Survey Points are COGO points held in the Survey Database and can only be edited in the Sur-
vey Database.

 2. Survey points are imported into the file from the Survey Database.
 3. Appearance can be changed through Civil 3D Styles and Description Key Sets the same as 

COGO points.
 4. When inserting Survey Database Points into a file, use the Survey Template so the correct 

Styles are available for the survey points.
 A. Toolspace > Survey tab > Survey Databases

Description Key Set
Toolspace > Settings tab > Point > Description Key Sets

 1. Uses point data to place the point on the designated layer, assigned style or label, and other 
properties.
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Point Groups
Toolspace > Prospector tab > Point Groups

 1. Point Groups section off groupings of points so point style or labels can be assigned.  Also you 
can gather points by a common characteristic or control need, such as, surface definition 
points.

 2. A point can be a part of as many point groups as they have been defined to. The Toolspace 
listing of point group names is a priority listing of style assignment when any point is part of 
more then one conflicting point group style.

 3. Point Groups can hold both survey and COGO points. 

Accessing Civil 3D points
Last updated: 2023-03-24

Total video time: 05:19

pnt-accs-01.mp4 5:19

Points in Civil 3D can be accessed in several different ways.

                     Model space                 
Directly selecting a COGO or Survey Point in Model space opens the respective Contextual Ribbon. A 
Contextual Ribbon is not available when multiple survey points are selected.

Toolspace

Points

 1. Toolspace palette > Prospector tab > Points 
 2. Left-click Points (populates Toolspace Preview window)

 A. right-click  Points > Edit Points... (opens Panorama window)

Point Groups

 1. Toolspace palette > Prospector tab > Point Groups
 2. Left-click Point Groups (populates Toolspace Preview window, lists Point Groups in priority 

order for style display)
 3. Expand Point Groups list, for selecting specific point groups.
 4. Right-click Point Groups (for contextual functions)

 A. right-click  Point Groups > Edit Points... (opens Panorama window)
 

Info: 
Left-click and Drag to move column headers. Left click on a column header to sort rows by 
selected column header.
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Left-click on a point for editing. (Ctrl+Select) to cherry-pick multiple points, (Shift+Select) to 
select a range of points, (Ctrl+A) to select all points.

Ribbon
Access Point creation, conversion and modification tools through the Ribbon

Point Creation Tools

 1. Home tab > Create Ground Data panel > Points dropdown
 A. Point Creation Tools (toolbar with different tools to build or create points in a file)

Tip: These tools can also be found under Point Creation Tools fly-out menus.

 B. Create Point Group
 C. Convert AutoCAD Points (will convert AutoCAD points to COGO points)

Properties Palette
Select a point > Right-click  > Select Properties…

You can see detailed information and make limited modifications in the Properties Palette. Not all 
Properties can be edited.

Warning: Changing information in the Properties Palette is not recommended. It may make it 
harder to find where the change is taking place. 

Point groups and styles
Last updated: 2021-06-29

Total video time: 04:22

pnt-grp-styl-01.mp4 4:22

Editing individual points
 1. Select a point
 2. Right-click > Edit Points…

Point styles

 3. Point Editor Panorama
 A. Style column

 I. Left-click  Style field
 4. Select Point Style dialog box

 A. Dropdown to select style
 B. OK
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Point label style

 5. Point Editor Panorama
 A. Point Label Style column

 I. Left-click  Point Label Style field
 6. Select Label Style dialog box

 A. Dropdown to select style
 B. OK

Point layer

 7. Point Editor Panorama
 A. Point Layer column

 I. Left-click  Point Layer field
 8. Layer Selection dialog box

 A. Select existing layer
 B. New... to create a layer not available in existing list.
 C. OK

Info: The Description Key Set may assign a style, label style, and layer into these fields during 
creation or import.

Description key set

Raw Description is what the surveyor or point creator entered for the description field.

Full Description is what that description is after the description key has filtered through it.

 9. Toolspace > Settings tab > Point > Description Keys Sets > right-click WisDOT Topo-
graphy… > Edit Keys…

             Editing point groups         
Toolspace > Point Groups

Point style or label style

 10. Point Groups > right-click Surface Points > Properties…
 11. Point Group Properties - Surface Points dialog box

 A. Information tab
 I. Default Styles area

 a. Point style dropdown
 b. Point label style dropdown

 12. OK

Tip: The Description Keys assigned to a point will prevent a point group from assigning styles 
or label styles. For the point group to take back control from the Description Key.
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 13. Point Groups > right-click Surface Points > Properties…
 14. Point Group Properties - Surface Points dialog box

 A. Overrides tab
 I. Style: checked

 II. Point Label Style: checked
 15. OK

Point creation tools
Last updated: 2022-12-07

Total video time: 06:05

pnt-creat-tl-01.mp4 6:05

Exercise data:pnt-creat-tl-data-begin-c3d20.zip

Point Creation Tools
Point creation tools are for placing and creating COGO points, not survey points.

Two ways to access point creation tools

 1. Ribbon > Home tab > Create Ground Data tab > Points dropdown > Point Creation 
Tools > flyout menus

 2. Choose Point option       
 3. Ribbon > Home tab > Create Ground Data tab > Points dropdown > Select Point 

Creation Tools
 4. Create Points toolbar > Point dropdowns

 A. Choose Point option

Tip: Point Creation toolbar (cheveron) dropdown > expand Point Creation Used to change 
Point Creation settings, such as, Prompt For Elevations or Prompt For Descriptions. Click 
(cheveron) again to close.

Create point toolbar examples

Miscellaneous points > Manual

 1. Ribbon > Home tab > Create Ground Data > Points dropdown > Left-click Point 
Creation Tools > Create Points toolbar > Miscellaneous dropdown > Manual

 A. Specify location of new point: select a location to drop point      
 B. Enter a point description: EA (Edge of Asphalt) Enter
 C. Specify a point elevation: 962.31Enter 
 D. Repeat steps 1-3 for additional points. 
 E.       Enter
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Intersections > Direction/Distance

For placing points after you have other information available.

Info: Watch what the Command Line asks for.

 1. Ribbon > Home tab > Create Ground Data > Points dropdown > Left-click Point 
Creation Tools > Create Points toolbar > Intersections dropdown > Direction/Distance

 A. Specify a location for the radial point: (Shift+Right-click),  NODE and 
snap to COGO point      

 B. Enter radius: 5Enter
 C. Specify start point: (Shift+Right-click),  Node and snap to same COGO point. 
 D. Specify Direction at start point: B (Bearing) Enter
 E. Specify quadrant: (3 or select SW of start point. 
 F. Specify Bearing: 62.05Enter
 G. Specify an offset: 0Enter
 H. Enter a point description: Bldg CornerEnter
 I. Specify a point elevation: 961.55Enter
 J.       Enter

 K. Repeat steps for additional points. 
 L.       Enter

Alignments > Station offset

 1. Ribbon > Home tab > Create Ground Data > Points dropdown > Left-click Point 
Creation Tools > Create Points toolbar > Alignment dropdown > Station/Offset

 A. Select alignment: Select alignment (a red-rubberband-line keeps point per-
pendicular to alignment).      

 B. Specify station along baseline: 154Enter
 C. Specify an offset: 12Enter             (Negative numbers are left, positive numbers are 

right of alignment).
 D. Enter a point description: EA (Edge of Asphalt) Enter
 E. Specify a point elevation: 965Enter
 F.       Enter

Exercise data:pnt-creat-tl-data-end-c3d20.zip

Importing points from a file
Last updated: 2021-06-29

Total video time: 04:12

pnt-imprt-frm-fil-01.mp4 4:12

Exercise files: pnt-imprt-frm-fil-data-begin-c3d20.zip

Contains description keys, styles, layers, etc. for points to display correctly.
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Open survey template file
 1. Menu Browser > New Do not go to QNew icon. That will start a design file, not a survey file.

 A. Select Template dialog box
 I. Begin-dwg folder > survey-start.dwt

 II. Open

Info: Once open, save file in project location.

Import Point File
 2. Ribbon > Insert tab > Import panel > Points from File
 3. Browse to file
 4. Select correct File Format (ie. PNEZD - Point Number, Northing, Easting, Elevation, Descrip-

tion)
 5. Toggle Add Points to Point Group On/Off
 6. OK

Editing points
Last updated: 2021-06-29

Total video time: 06:22

pnt-edit-01.mp4 6:22

Exercise data: pnt-edit-data-begin-c3d20.zip

Using grips to edit points
Selecting a COGO point gives 2 grip points.

 1. Rhombus/diamond grip point
 A. Select to move point or hover over grip > Move Marker
 B. hover over grip > Rotate Marker (rotates only marker and leaves label alone)
 C. hover over grip > Rotate marker and label (rotates both marker and label together)
 D. If any of these options were used,  hover over grip > Reset options available

 2. Square grip point
 A. Select to move and get a leader line, Esc to cancel
 B. hover over grip > Rotate Label (rotates only label and leaves marker alone)
 C. hover over grip > Toggle sub item grips (allows you to move each component; point 

number, point description, and point elevation)
 D. If any of these options were used,  hover over grip > Reset options available

Editing points from data

Editing points number from data

 1. Toolspace > Prospector tab > select Points
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 2. In Toolspace Preview window, Right-click on a point > Renumber… (allows adding a factor 
to elevation)

 3. Enter an additive factor to point numbers: 10000 Enter:

Info: Right-click Points > Refresh to update Preview Window.

Editing point elevation from data

 1. Toolspace > Prospector tab > select Point Groups > Survey User-Defined

Info: If point isn't in Toolspace Preview list, right-click Survey User-Defined > Update 
(populates new point numbers to list).

 2. In Toolspace Preview window, Right-click on new point 10001 > select Datum… (allows 
adding a factor to elevation)

 3. Change in Elevation: 900 Enter

Editing point elevation from surface

 1. Toolspace > Prospector tab > select Point Groups > Survey User-Defined
 2. In Preview window

 A. Right-click on new point 10001 > select Elevation from Surface…
 B. Select surface dialog box, 2 options :

 I. Select a surface from dropdown list, Exist, OK
 II. Select from Screen icon

 a. Select Exist surface, OK

Transparent commands for points
Last updated: 2021-06-29

Total video time: 04:15

pnt-trnsprnt-cmnd-01.mp4 4:15

Exercise files: pnt-trnsprnt-cmnd-data-begin-c3d20.zip

Using transparent commands
Transparent commands that help you draw with point object, point number, or point name.

Transparent command for point object

 1. Ribbon > Home tab > Create Design panel > Feature Line dropdown > Create Feature 
Line

 2. Create Feature Lines dialog box
 A. Name: checkedEA1
 B. OK
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 3. Ribbon > Transparent tab > Point panel > Point Object
 A. Select a point
 B. Specifiy elevation: Enter
 C. Repeat steps 4-5 until all points are selected.
 D. Enter to end Transparent command.
 E. Enter to end Draw Feature Line command.

Transparent command for point numbers

Start a 3D polyline:

 4. 3dpoly Enter
 5. Ribbon > Transparent tab > Point panel > Point Number
 6. 3284,3374,3391,3400 Enter

Info: Use (,) between numbers. (Space) is Enter in the command line. Use (-) between 
numbers to draw a line between all points within a range in order. 

 7. Enter to end Transparent command.
 8. Enter to end 3D Polyline command

Creating points from alignments
Last updated: 2021-06-29

Total video time: 08:21

pnt-creat-frm-ali-01.mp4 8:21

Exercise files: pnt-frm-ali-data-begin-c3d20.zip

Creating points from alignments workflow
Home tab > Create Ground Data > Points dropdown > select Point Creation Tools

Start by setting automatic settings

 1. Open chevron  
 2. Expand Points Creation

 A. Prompt For Elevations = Automatic
 B. Prompt For Descriptions = Automatic - Object 

Info: Object part will pick up name and station of the alignment for each point. 
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 3. Minimize to close Point Creation.
 4. Expand Point Identity 

 A. Next Point Number = 10000

Info: Allows you to identify proposed points easily

 5. Chevron to close.

Creating points from alignments

 6. Point by Alignment dropdown > At Geometry Points 
 A. Select alignment: select the alignment

 I. Select a profile dialog box : <none> 
 a. OK

 B. Starting station: Enter to accept
 C. Ending station: Enter to accept
 D. Enter

 7. Point by Alignment dropdown > Profile Geometry Points 
 A. Select alignment: select the alignment

 I. Select a profile dialog box : RiverRoad-CL 
 a.  OK

 B. Starting station: Enter to accept
 C. Ending station: Enter to accept
 D. Enter
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Info: If you don’t have the Elevation Description set to Automatic, you’ll need to 
put that information in for each point.

 8. Point by Alignment dropdown > Measure Alignment 
 A. Select alignment: select the alignment

 I. Select a profile dialog box : <none>
 a.  OK

 B. Starting station: Enter to accept
 C. Ending station: Enter to accept
 D. Specify an offset: 0.000Enter 
 E. Enter an interval: 50Enter
 F. Enter

 9. Close Create Points tools dialog. 

Update new points to point groups

Toolspace > Prospector tab > right-click Point Groups > Update

Create a new point group

 10. Toolspace > Prosector tab > right-click Point Groups > New… 
 11.          Point Group Properties dialog box 

 A. Information tab 
 I. Name: RiverRoad Align

 II. Default Styles:
 a. Point Style: Basic
 b. Point Label Style: Pnt Number Raw Desc Elev

Info: Double-check these Styles. They may not be the default. 

 B. Include tab
 I. With raw description matching (checked):   RiverRoad*

 C. Select Point List tab to verify there are points there. 
 D. OK

Verifying points are taking existing ground elevation, not proposed

 12. Toolspace > Prospector tab > Point Groups > right-click RiverRoad Align 
 13. Toolspace Preview window

 A. Shift+A to select all points.
 B. Right-click > select Elevations from Surface

 I. Select surface : Exist
 II. OK

Export as *.csv, send out to the field

 14. Toolspace > Prospector tab > Point Groups > right-click RiverRoad Align > Export 
Points… 
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 15. Export Points dialog box 
 A. Format dropdown: PNEZD (comma delimited)
 B. Destination File: browse folder

 I. Look in dropdown: project folder Other
 II. File Name: RiverRoad Align

 III. Files of Type: *.csv
 IV. Open

 C. Limit to Points in Point Group (checked)
 D. OK
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Survey
Survey database fundamentals
Last updated: 2021-02-15

Total video time: 5:47

Survey database fundamentals

srvy-db-fndmntl-01.mp4 1:33

 1. Survey database is a series of files external to any drawing.      
 2. Multiple survey jobs can be stored in a single survey database.       
 3. A survey database can only have one projection assignment.      
 4. There should be one survey database per project with the exception of multiple projections.       
 5. Survey data must be inserted into a DWG to see it in Civil 3D.       
 6. By default data inserted into a DWG is locked and can only be edited if the source survey data-

base is open for editing.
 7. Survey databases must be created in Civil 3D, but can only be deleted in a Windows  file man-

ager.

Survey object data types

srvy-db-fndmntl-02.mp4 2:03

 1. Survey point: Virtually identical to Civil 3D point. In the survey database, points have a 
Description (feature code) that is translated to layer and style information in the DWG.

 2. Survey figure: Very similar to Civil 3D feature line. It is a 3D linear object, but it does support 
curve definitions. Survey figures do not have Description (feature code). Layer and style 
information can be set from the figure prefix. Survey figures have their own definition in the 
DWG.

 3. Network: A traverse. It contains all associated known control points, known directions, 
setups, and observations. Networks have their own definition in the DWG.

 4. Additional survey database objects: Groups can be built for all of the above objects. Survey 
databases also have Import Events that track how data came into the survey database.

Survey user settings

srvy-db-fndmntl-03.mp4 2:11

Files that interact with the survey database

 1. Equipment databases: Survey equipment data to aid analysis.
 2. Figure prefix database: Manages the linework style and layer. 
 3. Linework code set: Field codes that generate figures from points. 
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 4. DWG file: Contains Point Description key set, point styles to translate description, and survey 
figure styles to translate the layer prefix.

 

Info: These settings are accessible from the top left button on the Survey tab. WisDOT Civil 3D 
customization files must be installed prior to changing these settings. If WisDOT settings are 
not seen in Survey User Settings dialog box, import WisDOT user settings.       

Survey interface in Civil 3D        

 1. Toolspace > Survey Tab
 A. Survey databases have a working folder. This location can be changed, but only the 

survey databases in the active working folder can be seen at a time.
 B. Equipment databases: Only needed for working with networks.
 C. Figure prefix database: Use database starting with WisDOT.
 D. Linework code set: Use code set starting with WisDOT.

Important Survey user settings

 1. Toolspace > Survey Tab > Edit Survey User settings button
 2. Survey Database Defaults:

 A. Survey database settings path: C:\ProgramData\Autodesk\C3D 2020\enu\Survey
 B. Survey Database Settings: WisDOT_Survey Database Settings
 C. Extended properties definition path: C:\ProgramData\Autodesk\C3D 2020\enu\Sur-

vey
 D. Extended properties definition: WisDOT Survey Extended Properties

 3. Linework Processing Defaults:
 A. Current linework code set: WisDOT

 4. Import Defaults:
 A. Default figure site: Field Survey

Create survey databases and queries
Last updated: 2021-06-14

Total video time: 08:04

Exercise files: srvy-data-c3d20.zip

Warning: A known issue has been identified related to Wisconsin county coordinate pro-
jections between XML and SDB files. Please review Wisconsin coordinate projection issue - 
XML/SDB before proceeding with this topic.

Create the survey database directly in Civil 3D

srvy-creat-db-qry-02.mp4 2:08
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 1.  1. Toolspace > Survey tab > right-click Survey Databases > Set working folder....
 A. Browse to C:\WisDOT\Projects.
 B. OK.

 2. Toolspace > Survey tab > right-click on Survey Databases > New local survey database.
 A. Name: SD-12345678
 B. OK.

 3. Toolspace > Survey tab > Survey Databases > right-click "SD-12345678" > Edit survey 
database settings....

 A. Coordinate Zone: None
 B. Distance: US Foot
 C. OK.

Import the survey query QML files

Info: This process is only for if the survey database was built  from scratch, or if you discover 
that one or more of the standard WisDOT survey queries are not in the survey database.

srvy-creat-db-qry-03.mp4 2:46

 1. Toolspace > Survey tab > Survey Databases > right-click > SD-12345678 > Open for Edit
 2. Toolspace > Survey tab > Survey Databases > SD-12345678 > right-click Survey Queries 

> Import 
 A. Browse to C:\WisDOT\stnd\SD2020Template.
 B. Select the survey queries that are required. (Hold Ctrl or Shift to select multiples.)
 C. OK.

Import PAC/LandXML into survey database
Last updated: 2021-06-29

Total video time: 05:21

Exercise files: srvy-data-c3d20.zip

Translate a PAC file to a LandXML file

srvy-import-pac-xml-01.mp4 2:17

Info: Translating the PAC file is only necessary if you have not received the LandXML file. If you 
have received the LandXML file proceed to the next section Import the LandXML File Into the 
Survey Database.

Tip: Use the Ctrl or Shift key to select more than one SDMS point file to convert at a time.
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 1. Toolspace > Toolbox tab > WisDOT Toolbox > SDMS Translators > right-click PAC, CTL 
translator > Execute

 2. Browse to 12345678/BaseData/Survey.
 3. Select the 12345678-wo1.pac file.
 4. Open
 5. In the Browse For Folder dialog, browse to 12345678/BaseData/Survey to select the folder 

for the converted LandXML file.
 6. OK
 7. In the Convert SDMS Point Files to LandXML Files dialog, verify there were no errors.
 8. OK to exit.

12345678\BaseData\Survey\srvy-import-pac-xml-01-end.dwg

Import the LandXML file into the survey database

srvy-import-pac-xml-02.mp4 3:04

 1. Ribbon > Home tab > Create Ground Data panel > Flyout > Import Survey Data.
 2. Specify Database:

 A. Name: SD-12345678
 3. Next
 4. Specify Data Source :

 A. Data source type: LandXML File
 B. Selected file: Folder Icon

 I. Browse to 12345678/BaseData/Survey and select 12345678-wo1.XML.
 II. Open.

 5.  Next
 6. Import Options:

 A. Import Settings:
 I. Current figure prefix database: WisDOT Topography

 II. Process Linework During Import: YES.
 III. Current Linework Code Set: WisDOT
 IV. Insert Network Object: NO
 V. Insert Figure Objects: NO

 VI. Insert Survey Points: NO
 VII. Display Tolerance Errors: NO

 B. LandXML Data:      
 I. Make sure all of the items are checkmarked

 II. Coordinate System: No Datum, No Projection
 7. Finish

12345678\BaseData\Survey\srvy-import-pac-xml-02-end.dwg

Set up to edit/add survey figures
Last updated: 2021-06-14

Total video time: 05:21
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Exercise files: srvy-data-c3d20.zip

Create a survey editing DWG

srvy-setup-add-figur-01.mp4 1:48

 1. Application Icon > New >survey-start.dwt.
 2. Application Icon > Save-as > 12345678 folder > BaseData folder > Survey >Sur-

veyEdits.dwg

12345678\BaseData\Survey\srvy-setup-add-figur-01-end.dwg

Import or remove a survey query into a file

srvy-setup-add-figur-02.mp4 3:33

 1. Toolspace > Survey tab > right-click Survey Databases > Set working folder...
 2. Browse to 12345678\BaseData\Survey
 3. Select Folder
 4. Toolspace > Survey tab > Survey Databases > right-click SD-12345678 > Open for edit.
 5. Toolspace > Survey tab > Survey Databases > SD-12345678 > Survey Queries (expand 

selection)
 A. Select each item below, hold left mouse button down, and drag and drop into the Sur-

vey Edits.dwg: 
 I. UtilityFigures1

 II. UtilityFigures2
 III. UtilityPoints1

 B. Toolspace > Survey tab > Survey Databases > SD-12345678 > Survey Queries> 
right-click UtilityPoints2 > Insert into file.

 6. Toolspace > Prospector tab > Point Groups > Update.
 7. Set drawing scale: 1IN:40FT.
 8. Remove a survey query from a file.

 A. Toolspace > Survey tab > Survey Databases > SD-12345678 > Survey Queries  
(expand selection)

 I. Select Centerlines, hold left mouse button down, and drag and drop into draw-
ing window.

 B. Toolspace > Survey tab > Survey Databases > SD-12345678 > Survey Queries > 
right-click Centerline > Remove from drawing.

 C. ZE (Zoom to Extents) and Save the drawing.

12345678\BaseData\Survey\srvy-setup-add-figur-02-end.dwg

Editing survey figures
Last updated: 2021-06-14
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Total video time: 09:16

Exercise files: srvy-data-c3d20.zip

12345678\BaseData\Survey\SurveyEdits.dwg

Editing survey figures by adding or deleting points

srvy-edit-figur-01.mp4 5:14

 1. Open 12345678\BaseData\Survey\SurveyEdits.dwg
 2. Toolspace > Survey tab > right-click Survey Databases > Set working folder...
 3. Browse to folder: 12345678\BaseData\Survey
 4. Select Folder
 5. Toolspace > Survey tab > Survey Databases > right-click SD-12345678 >Open for edit
 6. Ribbon > Transparent tab > Plan panel > Zoom to Point.     

 A. ZTP Zoom to point number, name or point range:4240,4252ENTER
 7. Left click on the survey figure in between the two points.     

 A. Ribbon > Survey Figures contextual tab > Survey Figure Properties
 B. Figure Properties dialog box:    

 I. Select point 4252, then click the Red X in order to delete the selected vertex
 II. OK

 8. Ribbon > Transparent tab > Plan panel > Zoom to Point.
 A. ZTP Zoom to point number, name or point range: 

4240,4251,4234ENTER
 9. Left click on the survey figure in between the two points.     

 A. Ribbon > Survey Figures contextual tab > Survey Figure Properties
 B. Figure Properties dialog box:    

 I. Right-click point 4240, then click Insert a vertex before the selected vertex
 II. In the  Number column of the new row: name the point 4251 ENTER

 III. OK

12345678\BaseData\Survey\srvy-edit-figur-01-end.dwg

Editing survey figures by changing the relationship between points

srvy-edit-figur-02.mp4 4:02

 1. Open 12345678\BaseData\Survey\srvy-edit-figur-02-begin.dwg
 2. Toolspace > Survey tab > right-click Survey Databases > Set working folder...
 3. Browse to folder: 12345678\BaseData\Survey
 4. Select Folder
 5. Toolspace > Survey tab > Survey Databases > right-click SD-12345678 >Open for edit
 6. Ribbon > Transparent tab > Plan panel > Zoom to Point.     

 A. ZTP Zoom to point number, name or point range:4234,4251ENTER
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 7. Left click on the survey figure in between the two points.     
 A. Ribbon > Survey Figures contextual tab > Survey Figure Properties
 B. Figure Properties dialog box:    

 I. Select point 4251, then click the DOWN ARROW in the toolbar once to reorder 
the points

 II. OK
 8. Ribbon > Transparent tab > Plan panel > Zoom to Point.

 A. ZTP Zoom to point number, name or point range: 4240,4252ENTER
 9. Left click on the survey figure in between the two points.     

 A. Ribbon > Survey Figures contextual tab > Survey Figure Properties
 B. Figure Properties dialog box:    

 I. Click point 4251, then rename it to 4252.
 II. OK

 III. This will change the ending point of the survey figure from point 4251 to point 
4252.

12345678\BaseData\Survey\srvy-edit-figur-02-end.dwg

Create survey figure
Last updated: 2021-06-14

Total video time: 13:03

Exercise files: srvy-data-c3d20.zip

12345678\BaseData\Survey\srvy-creat-srvy-figur-01-begin.dwg

Create a survey figure point-to-point

srvy-creat-srvy-figur-01.mp4 3:40

 1. Open the file C:\WisDOT\Projects\12345678\BaseData\Survey\srvy-creat-srvy-figur-01-
begin.dwg

 2. Ribbon > Transparent commands tab > Plan panel > Zoom to point 
 3. Type 4254,4219 (no spaces between numbers and comma).
 4. Toolspace > Survey tab > expand SD-12345678 > right-click Figures > Modify Figure > 

Begin new figure
 A. Enter the figure name of OH and Enter.
 B. Use the Snap to Point osnap option from the osnap toolbar. 
 C. Snap to the point marker for point number 4219. 
 D. P for Point.

 5. For the next point in the figure line: 
 A. P for the Point option.
 B. 4254 Enter.

 6. End the figure creation method by typing DO for done. 
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Insert the new figure(s) to the drawing file

 1. Creating figures in the database add them only to the database, not the drawing file. If you 
need the figure in the drawing file, you need to insert them. Adding "all" of the figures will 
only insert the new or edited figures.

 2. Toolspace > Survey tab > expand SD-12345678 > left-click and drag Figures into mod-
elspace

12345678\BaseData\Survey\srvy-creat-srvy-figur-01-end.dwg

Create a survey figure interactively

srvy-creat-srvy-figur-02.mp4 3:28

12345678\BaseData\Survey\srvy-creat-srvy-figur-02-begin.dwg

 1. Open the file C:\WisDOT\Projects\12345678\BaseData\Survey\srvy-creat-srvy-figur-02-
begin.dwg

 2. Ribbon > Transparent commands tab > Plan panel > Zoom to point
 3. Type 4311,4312,4294 (no spaces between numbers and comma).
 4. Toolspace > Survey tab > expand SD-12345678 > right-click Figures > Create figure inter-

actively
 5. Name the Figure OH and OK.
 6. Select the PPOL points graphically from 4311 to 4312 to 4294 (near the south of the project).
 7. OK in the Figure Properties dialog.
 8. Insert the new figure(s) to the drawing file

 A. Creating figures in the database add them only to the database, not the drawing file. If 
you need the figure in the drawing file you need to insert them. Adding "all" of the fig-
ures will only insert the new or edited figures.

 B. Toolspace > Survey tab > expand SD-12345678 > left-click and drag Figures into 
modelspace

12345678\BaseData\Survey\srvy-creat-srvy-figur-02-end.dwg

Create survey figure from object

srvy-creat-srvy-figur-03.mp4 5:55

 1. Open the file C:\WisDOT\Projects\12345678\BaseData\Survey\srvy-creat-srvy-figur-03-
begin.dwg

 2. Ribbon > Transparent commands tab > Plan panel > Zoom to point
 3. Type 4295,4296 (no spaces between numbers and comma).
 4. Ribbon > Home tab > Draw panel > Polyline
 5. Ribbon > Transparent commands tab > Point panel > Point Object
 6. Select the PPOL points graphically from 4295 to 4296 (near the south of the project).
 7. Esc twice to end the transparent command and the polyline command.
 8. Toolspace > Survey tab > expand SD-12345678 > right-click Figures > Create figure from 

object

Page: 547

Published on: 5/17/2023

Create a survey figure interactively

https://c3dkb.dot.wi.gov/video/srvy/srvy-creat-srvy-figur-02.mp4
https://c3dkb.dot.wi.gov/video/srvy/srvy-creat-srvy-figur-03.mp4


 9. Select the polyline that you just created.
 A. Name: OH
 B. Current Figure Prefix Database: WisDOT20-Etopog
 C. Associate Survey Points to Vertices: YES
 D. OK.
 E. Enter to end the command.

 10. Select the polyline and delete it.
 11. Toolspace > Survey tab > expand SD-12345678 > right-click on Figures > Insert into 

drawing
 A. Zoom to the figure you just created and left-click on it to select it.
 B. Contextual ribbon > Survey Figure Properties

 I. Figure Properties dialog box >  Convert figure to chain and edit vertices > 
Convert the survey figure

 II. Check the elevations of the two points.
 III. OK.

12345678\BaseData\Survey\srvy-creat-srvy-figur-03-end.dwg

Verify DWG and SDB match
Last updated: 2021-06-14

Total video time: 04:37

Exercise files: srvy-data-c3d20.zip

12345678\BaseData\Survey\SurveyEdits.dwg

Verify the DWG and SDB match

srvy-verify-dwg-sdb-mtch-01.mp4 4:37

 1. Open: 12345678/BaseData/Survey/SurveyEdits.dwg
 2. Save the file.      
 3. Toolspace > Survey tab > right-click Survey Databases > Set working folder...
 4. Browse to folder: 12345678\BaseData\Survey
 5. Select Folder
 6. Toolspace > Survey tab > Survey Databases > right-click SD-12345678 >Open for edit
 7. Toolspace > Survey tab > Survey Databases > SD-12345678 (expand selection)
 8. Toolspace > Survey tab > Survey Databases > SD-12345678 > left-click Figures > drag 

and drop into modelspace

Info: This does not duplicate lines, but replaces them with the most up-to-date objects. 

 9. Toolspace > Survey tab > Survey Databases > SD-12345678 > left-click Survey Points > 
drag and drop into modelspace 
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Info: This does not duplicate points, but replaces them with the most up-to-date 
objects. 

 10. Toolspace > Prospector tab > right-click Point Groups > Update
 11. Toolspace > Prospector tab > Survey > Figures       

 A. In the preview window at the bottom of the Toolspace, check figures for error flags. 
 B. If there are error flags:       

 I. Toolspace > Prospector tab > Survey > right-click Figures > Update from 
survey data

 12. Save the file. 

12345678\BaseData\Survey\srvy-verify-dwg-sdb-mtch-01-end.dwg

Replicate/copy SDB to PDS C3D project
Last updated: 2021-06-14

Total video time: 5:44

Replicate the SDB to the PDS C3D project

srvy-replicat-to-pds-01.mp4 3:02

 1. Right-click the Windows Start button and choose File Explorer.       
 2. In the path field at the top type in this address (you can copy it from this line and paste it into 

that field): C:\WisDOT\Stnd\Apps
 3. Double-click the WisDOT Civil 3D Apps.exe file.       
 4. Replicate Survey Database tab         

 A. Source Survey Project Path: C:\WisDOT\SD-12345678.
 B. Destination Design Project Path: N:\C3D\ProjectID\BaseData\Survey.
 C. Replicate Database.

 5. Toolspace > Survey tab > right-click Survey Databases > Set working folder....         
 A. Browse to: N:\C3D\12345678\BaseData\SD-12345678 

Info: The survey database from C:\wisdot\SD-12345678 is now duplicated here.

Replicate the SDB to the user's local drive

srvy-replicat-to-pds-02.mp4 2:42

 1. Right-click the Windows Start button and choose File Explorer.       
 2. In the path field at the top type in this address (you can copy it from this document and paste 

it into that field): C:\WisDOT\Stnd\Apps
 3. Double-click the WisDOT Civil 3D Apps.exe file.       
 4. Replicate Survey Database tab        

 A. Source Survey Project Path: N:\C3D\Projects\SD-12345678.
 B. Destination Design Project Path: C:\WisDOT\Projects.
 C. Build Database
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 D. Replicate Database
 E. Close the WisDOT Civil 3D Apps window. 

 5. Toolspace > Survey tab > right-click Survey Databases > Set working folder....      
 A. Browse to: C:\WisDOT\Projects\SD-12345678              

Info: The survey database from N:\C3D\12345678\BaseData\SD-12345678 is now 
duplicated here.

Create survey control file from field survey
Last updated: 2022-02-14

Create the survey control file
 l This file is prepared by the Survey Data Coordinator or person overseeing the project survey 

data.
 l The survey control file includes existing horizontal and vertical field control.
 l Only horizontal and vertical control that will be used during construction is included in this 

file.

 1. Application Icon > New > survey-start.dwt
 2. Application Icon > Save-as > 12345678\BaseData\Surv-Cntrl.dwg
 3. Add the survey control point query to the file

 A. Toolspace > Survey tab > Survey Databases > SD-12345678 > Survey Queries
 B. Drag and drop the following query into the survey control file:

 I. Control Points
 4. Remove temporary points and other points that will not be used during construction.
 5. Save the drawing

Create/update topo file from field survey
Last updated: 2021-06-14

Total video time: 05:45

Exercise files: srvy-data-c3d20.zip

12345678\BaseData\Survey\Topo-Ex.dwg

Insert the topo queries into the topo file

srvy-updat-topo-frm-field-01.mp4 1:44

 1. Open: 12345678/BaseData/Topo-Ex.dwg
 2. Save the file.      
 3. Toolspace > Survey tab > right-click Survey Databases > Set working folder...
 4. Browse to 12345678\BaseData\Survey
 5. Select Folder

Page: 550

Published on: 5/17/2023

Create survey control file from field survey

https://c3dkb.dot.wi.gov/data/srvy/srvy-data-c3d20.zip
https://c3dkb.dot.wi.gov/video/srvy/srvy-updat-topo-frm-field-01.mp4


 6. Toolspace > Survey tab > Survey Databases > right-click SD-12345678 > Open for read-
only

 7. Toolspace > Survey tab > Survey Databases > SD-12345678 (expand selection)
 8. Toolspace > Survey tab > Survey Databases > SD-12345678 > Survey Queries (expand 

selection)
 A. Select each item below, hold left mouse button down, and drag and drop into drawing 

window.
 I. TopoFigures1

 II. TopoFigures2
 III. TopoPoints1
 IV. TopoPoints2
 V. TopoPoints3

 9. Save the file.

12345678\BaseData\Survey\srvy-updat-topo-frm-field-01-end.dwg

Delete mapping data if needed

srvy-updat-topo-frm-field-02.mp4 4:01

 1. Open: 12345678/BaseData/Topo-Ex.dwg
 2. Save the file.
 3. Toolspace > Survey tab > right-click Survey Databases > Set working folder...
 4. Browse to 12345678\BaseData\Survey
 5. Select Folder
 6. Toolspace > Survey tab > Survey Databases > right-click SD-12345678 >Open for edit
 7. Toolspace > Survey tab > Survey Databases > SD-12345678 (expand selection)
 8. Toolspace > Survey tab > Survey Databases > SD-12345678 > Survey Queries  (expand 

selection) > right-click TopoFigures1 > Zoom to.
 9. Toolspace > Survey tab > Survey Databases > SD-12345678 >  left-click Figures > Scroll 

in Preview Window and select HEDG24.

Info: In model space, this figure contains duplicate line data.

 10. Ribbon > Home tab > Modify panel > Explode
 A. Select: Mapping data block.
 B. Esc to exit command.
 C. Select: Mapping data block.

Info: The duplicated item is no longer linked to the survey figure.

 D. Delete duplicated item.

12345678\BaseData\Survey\srvy-updat-topo-frm-field-02-end.dwg

Create utility file from field survey
Last updated: 2021-06-14
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Total video time: 06:01

Exercise files: srvy-data-c3d20.zip

Warning: A known issue has been identified related to Wisconsin county coordinate pro-
jections. Please make sure to use to only use projections beginning with "WisDOT NAD83/". 
Please review Wisconsin coordinate projection issue - XML/SDB for more information.

Create the utility file

srvy-creat-uti-frm-field-01.mp4 1:56

 1. Application Icon > New >survey-start.dwt.
 2. Application Icon > Save-as > 12345678 folder > BaseData folder >Uti-Ex.dwg.
 3. Toolspace > Survey tab > right-click Survey Databases > Set working folder....
 4. Browse to 12345678\BaseData\Survey.
 5. Select Folder
 6. Toolspace > Survey tab > Survey Databases > right-click SD-12345678 > Open for edit.
 7. Add the utility point and linework queries to the file:

 A. Toolspace > Survey tab > Survey Databases > SD-12345678 > Survey Queries 
(expand selection)

 B.  Select each item below, hold left mouse button down, and drag and drop into mod-
elspace: 

 I. UtilityFigures1
 II. UtilityFigures2

 III. UtilityPoints1
 IV. UtilityPoints2

 8. Save the drawing.

Clean up the utility linework

srvy-creat-uti-frm-field-02.mp4 4:05

12345678\BaseData\Survey\srvy-creat-uti-frm-field-02-begin.dwg

 1. Continue working in the Uti-Ex.dwg from previous section.
 2. Change the drawing scale: 1IN:40 FT.
 3. For the utility survey figures that have special linetypes (those represented with letters) check 

to make sure the letters in the linetype are not upside down.
 4.  If you find a linetype that is upside down:

 A. Select on that survey figure.
 B. Ribbon > Survey Figures contextual tab > Edit Geometry panel > Reverse.
 C. Continue selecting survey figures and reversing them as needed. This works on one 

survey figure at a time.
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 5. Set the utility point label style:
 A. Toolspace > Prospector tab > right-click Point Groups > Update.
 B. Toolspace > Prospector tab > Point Groups > right-click Survey User Defined > 

Properties. 
 I. Information tab 

 a. Point Label Style: _No Display.
 C. OK.

12345678\BaseData\Survey\srvy-creat-uti-frm-field-02-end.dwg

Updating/merging SDB from other SDBs
Last updated: 2021-06-14

Total video time: 05:30

Exercise files: srvy-data-c3d20.zip

12345678\BaseData\Survey\SurveyEdits.dwg

Export the SDB to a LandXML file

srvy-updat-sdb-frm-sdb-01.mp4 2:34

 1. Toolspace > Survey tab > right-click Survey Databases > Set working folder...
 2. Browse to 12345678\BaseData\Survey
 3. Select Folder
 4. Toolspace > Survey tab > Survey Databases > right-click SD-12345678 > Open for edit.
 5. Toolspace > Survey tab > Survey Databases > right-click SD-12345678 > Export Survey 

LandXML.       
 A. Browse to the project 12345678/BaseData/Survey folder.
 B. Save.

 6. Export Survey LandXML dialog       
 A.  OK.

Info: This process can also be performed with an import event. When this is done, the edits 
done in the survey database are exported. The import event is just used as the selection set.

12345678\BaseData\Survey\srvy-updat-sdb-frm-sdb-01-end.dwg

Import the LandXML file into the stored SDB

srvy-updat-sdb-frm-sdb-02.mp4 2:56

 1. Toolspace > Survey tab > right-click Survey Databases > Set working folder...
 2. Browse to 12345678\BaseData\Survey
 3. Select Folder
 4. Toolspace > Survey tab > Survey Databases > right-click SD-12345678 > Open for edit.
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 5. Toolspace > Survey tab > Survey Databases > right-click SD-12345678 > Import > Import 
Survey LandXML.       

 6. Browse to the project 12345678/BaseData/Survey folder.
 7. Select SD-12345678.xml.
 8.  Open
 9. Import Survey LandXML dialog box: 

 A. Import Settings:
 I. Current figure prefix database: WisDOT Topography

 II. Process Linework During Import: YES
 III. Current Linework Code Set: WisDOT
 IV. Insert Network Object: NO
 V. Insert Figure Objects: NO

 VI. Insert Survey Points: NO
 VII. Display Tolerance Errors: NO.

 B. LandXML Data:      
 I. Make sure all of the items are checkmarked.

 II. Coordinate System: No Datum, No Projection.
 10.  OK

12345678\BaseData\Survey\srvy-updat-sdb-frm-sdb-02-end.dwg

Create ad-hoc survey queries
Last updated: 2021-06-14

Total video time: 5:35

Exercise files: srvy-data-c3d20.zip

12345678\BaseData\Survey\SurveyEdits.dwg

Clear out file of previous survey edit work

srvy-creat-adhoc-qry-01.mp4 1:50

 1. Open12345678\BaseData\Survey\SurveyEdits.dwg.
 2. Toolspace > Survey tab > Survey databases > SD-12345678 database > right-click Fig-

ures > Remove from drawing
 3. Toolspace > Survey tab > Survey databases > SD-12345678 database > right-click Sur-

vey points > Remove from drawing

12345678\BaseData\Survey\srvy-creat-adhoc-qry-01-end.dwg

Create a survey query

srvy-creat-adhoc-qry-02.mp4 3:45
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12345678\BaseData\Survey\srvy-creat-adhoc-qry-02-begin.dwg

 1. Continue working in the SurveyEdits.dwg.
 2. Toolspace > Survey tab > Survey databases > SD-12345678 database > right-click Sur-

vey Queries > New
 A. Name: Ditch
 B. Points - Add a parameter 

 I. Properties: Description
 II. Operator: Contains

 III. Value: DTCH
 IV. You can add more parameters to the query using the AND and OR options

 a. AND will require both parameters to be met by the query
 b. OR will enable the query to be satisfied if either of the parameters is 

met
 C. Figures - Add a parameter 

 I. Properties: Name
 II. Operator: Contains

 III. Value: DTCH
 3. Preview in Drawing.
 4. Dismiss Preview (upper left of the model space).
 5. Save Query.
 6. Close the Survey Query Builder palette.
 7. Ribbon > Survey Query contextual tab > Close.

Exercise files: srvy-data-c3d20.zip

12345678\BaseData\Survey\srvy-creat-adhoc-qry-02-end.dwg
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Surfaces
Accessing Civil 3D surfaces
Last updated: 2021-06-29

Total video time: 5:20

Exercise files: srfc-accs-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\Surf-Ex .dwg

srfc-accs-01.mp4 5:20

Accessing surfaces from Home Ribbon
Context Ribbon > Home tab > Create Ground Data panel > select Surfaces dropdown

 1. Create Surface creates a surface with no definition.
 A. In the dialog box you can control the surface type and properties.

 2. Create Surface with a file; DEM, Point Cloud, TIN, etc.

Accessing surfaces from Toolspace
 3. Toolspace > Prospector tab > right-click Surfaces

 A. Create surface options 
 B. Export file options. This will export all surfaces in surface area. 

 4. Toolspace > Prospector tab > expand Surfaces > right-click Exist
 A. Edit properties and styles, rebuild, work with Snapshots, delete, or use other basic 

AutoCAD tools.
 5. Toolspace > Prospector tab > expand Surfaces > expand Exist

 A. Create or edit Masks
 B. Create or edit Watersheds
 C. Expand Definitions

 I. Add data to define the surface; boundaries, adding breaklines to a surface, cre-
ating a surface from contours, DEM file, drawing objects, edits, import point 
files or point groups, or survey queries.

Accessing surfaces from Context Ribbon

 6. Left-click surface in file > opens Context Ribbon (opens tools specifically for the surface)
 A. Label & Tables tab

 I. Add Labels; Slope labels, Spot elevations, or Contour labels
 II. Add Legend, tables.

 B. General Tools tab
 I. Inquiry; add points to check elevation or distance.

 II. AutoCAD properties of objects
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 C. Modify Tools tab
 I. C3D Surface properties or edit surface styles.

 II. Add Data, same tools listed as Toolspace Definition.
 III. Edit Surface dropdown > Paste Surface is an important tool used with 

WisDOT surfaces.
 D. Analyze Tools tab

 I. Waterdrop and Catchment Area (basic analysis of waterflow over a surface)
 II. Create a Volume Dashboard

 III. Visibility Check
 IV. Analyze tab dropdown 

 a. Check for Contours Problems
 b. Stage Storage for potential ponds.

 E. Surface Tools tab
 I. Drape an Image

 a. Extract from Surface dropdown
 i. Create Cropped Surface, if surface is too large
 ii. Extract an Object; triangle lines, border, or contours lines
 iii.  Export to DEM

 F. Launch Pad tab
 I. Create a Profile

 II. Data Shortcut
 III. Grading Tools
 IV. Quick Profile to troubleshoot an area 

Surface styles
Last updated: 2021-06-29

Total video time: 04:08

Exercise files: srfc-styl-data-begin-c3d20.zip Surf-Ex.dwg

srfc-styl-01.mp4 4:08

Two ways to access surface styles

Contextual Ribbon

 1. Click on surface to select     
 2. Context Ribbon > Modify panel > click Surface Properties

 A. Surface Properties dialog box             
 I. Information tab > Surface style dropdown and select style                 Click Apply to 

view the surface selected before clicking OK.               
 II. OK               
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Toolspace

 3. Click on surface to select     
 4. Toolspace > Prospector tab > expand Surfaces > right-click Exist > Surface Properties...

 A. Surface Properties dialog box             
 I.                  Information tab > Surface style dropdown and select style                 Click Apply to 

view the surface selected before clicking OK.               
 II. OK               

Copy a surface style

Warning: Do not use Edit Surface Style option for WisDOT projects. This will cause conflicts 
with the currently assigned style from the WisDOT template file, which should remain as stand-
ards. Copy the style and edit the copy instead.

 5. Click on surface to select     
 6. Context Ribbon > Modify panel > click Surface Properties

 A. Surface Properties dialog box             
 I.                  Information tab > Surface style dropdown: P Contours 5' Major:1' Minor

 II.                  select Edit icon dropdown > Copy Current Selection                 Copy will take ALL of 
the settings from selected surface style.                 

 a. Surface Style [Copy] dialog box 
 i. Information tab > Name: P Contours 5' Major
 ii. Display tab > Minor Contours: turn off (lightbulb)
 iii. Display tab > Major Contours: change color to green

 b. OK
 III. Apply to view or OK to set style               

Surface basics
Last updated: 2021-06-29

Total video time: 03:58

Exercise files: srfc-basc-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\Surf-Ex.dwg

srfc-basc-01.mp4 3:58

Civil 3D surfaces are a dynamic object representing elevation through a series of triangles; TIN sur-
face triangles or gridded surface triangles.

Change surface style

 1. Select surface > right-click menu > select Surface Properties...
 A. Surface Properties dialog box  

 I. Default styles box 
 a. Surface style dropdown: EX TrianglesOK
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Tip: TIN triangles are irregular.  Gridded triangles are even or squared; two right-triangles that 
define the grid.

Surface borders and boundaries

Borders: Indicates where the edge of the triangles is located.

Outer Boundaries: Prevent triangles from being made outside the boundary line.

Inner or Hide Boundaries (aka Void boundaries): Prevents triangles from being made inside its 
shape.

Show Boundary: Drawn inside the Hide Boundary and are used to display triangles that the Hide 
Boundary removed.

Volume surface

Comparison of volume between two surfaces, TIN or grid.

 2. Toolspace > Prospector tab > right-click Surfaces > select Create Surface
 A. Create Surface dialog box  

 I. Type dropdown: TIN volume surface
 II. Properties box 

 a. Surface style dropdown: EX TrianglesOK
 b. Name: TIN Vol
 c. Base Surface: Exist
 d. Comparison Surface: Grading

 III. OK
 3. Toolspace > Prospector tab > expand Surfaces > right-click TIN Vol > Surface Prop-

erties...
 4. Surface Properties - TIN Vol dialog box 

 A. Surface style: Vol Elevation
 B. OK 

Surface properties - General
Last updated: 2021-06-29

Total video time: 03:51

Exercise files: srfc-prprtis-gnrl-data-begin-c3d20.zip Surf-Ex.dwg

srfc-prprtis-gnrl-01.mp4 3:51

Surface properties overview
3 ways to locate surface properties

 1. Toolspace > Prospector tab > expand Surfaces > right-click Exist (name of surface) > 
Surface Properties... opens dialog box
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 2. Select surface > Contextual Ribbon > Modify panel > Surface Properties clicking on but-
ton/icon to launch dialog box

 3. Select surface > right-click surface > Surface Properties... opens dialog box

About surface dialog box
Surface dialog box has 4 tabs

 4. Information
 A. surface name, description, create or manage surface styles, and change render mater-

ial.
 5. Definition (See video above)
 6. Analysis

 A. User can run analysis on the surface, baking the information into the surface to be dis-
played through tables or styles that are applied to the surface. Color schemes can be 
used to help with visibility of analysis on the surface.

 B. Types of analysis; contours, direction, elevation, slopes, slope arrows, user-defined, or 
watersheds.

 C. Set range and range details
 7. Statistics

 A. General, coordinates and elevation information.
 B. Extended, surface areas and slopes.
 C. TIN, triangle information; number of triangles, area, and lengths.

Info: This information is not editable.

Surface properties - Definition
Last updated: 2021-06-29

Total video time: 07:09

Exercise files: srfc-prprtis-defnitn-data-begin-c3d20.zipSurf-Ex.dwg

srfc-prprtis-defnitn-01.mp4 7:09

The definition tab will provide an area where the user can control what rules the surface has to fol-
low to be built, any limitations, as well as a list of all edits.

Tab location
 1. Select on surface
 2. Context Ribbon > Modify panel > Surface Properties

 A. Surface Properties dialog box 
 I. Definition tab 

 a. Definition options: build options, rules and limitations
 b. Operation type: list of edits
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Changing long triangles
Sometimes found along outside edges of the surface

 3. Surface Properties dialog box 
 A. Definition tab 

 I. Expand Build 
 a. Use maximum triangle length: Yes
 b. Maximum triangle length: 85

 B. OK
 4. Surface Properties - Rebuild Surface dialog box > Rebuild the surface

Info: Void areas, areas where the triangles exceeded 85 feet. This might be an area 
where the user could use a boundary to clear out the triangles.

Tell the surface to use or ignore crossing breaklines
 5. Surface Properties dialog box         

 A. Definition tab 
 I. Operation Type: check box Add breakline, Breakline set1

 B. Apply
 6. Surface Properties - Rebuild Surface dialog box > Rebuild the surface
 7. Surface Properties dialog box         

 A. Definition tab 
 I. Operation Type: check box Add breakline, Breakline set2

 B. Apply
 8.          Surface Properties - Rebuild Surface dialog box > Rebuild the surface
 9. Panorama > Events tab > Error         Info: Error says breakline is not being used because it 

is crossing over.        
 A. select Green Check Mark to close

 10. To correct the crossing breakline error, Context Ribbon > Modify panel > Surface Prop-
erties

 A. Surface Properties dialog box 
 I. Definition tab 

 a. Operation Type: uncheck box Add breakline, Breakline set2
 b. Definition Option > Allow Crossing breaklines: Yes
 c. Definition Option > Elevation to use: Use last breakline elevation at 

intersection
 d. Operation Type: check box Add breakline, Breakline set2

 II. Apply
 11. Surface Properties - Rebuild Surface dialog box > Rebuild the surface
 12. Panorama > Events tab > Information       
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Changing the order of operation definition
 13. Surface Properties dialog box         

 A. Definition tab             
 I. Operation Type > select Add breakline, Breakline set2

 II. Click Up Arrow button

Info: Orange markers will appear whenever you make a change to the 
order, telling you to take notice.

          
 B. Apply

 14. Surface Properties - Rebuild Surface dialog box > Rebuild the surface
 15. OK
 16.          Parorama box > select Green Check Mark to close  

Exercise files: srfc-prprtis-defnitn-data-end-c3d20.zipSurf-Ex.dwg     

Surface breaklines
Last updated: 2021-06-29

Total video time: 07:04

Exercise files: srfc-brklin-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\srfc-brklin.dwg

srfc-brklin-01.mp4 7:04

Surface breaklines are 3-dimensional lines that prevent a surface from triangulating in areas that it 
should not. 

Standard breaklines

Info: 3D polylines or feature lines are the best to use for breaklines.

 1. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand 
Definition > right-click Breaklines > Add...

 A. Add Breaklines dialog box 
 I. Type: Standard

 II. OK

Info: If you are creating a proposed surface using breaklines, using File link 
options will allow to set certain factors for the triangles. 

 B. Select feature line and Enter
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Proximity breaklines

Proximity breaklines are 2D polylines that will translate into 3D data.

 2. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand 
Definition > right-click Breaklines > Add...

 A. Add Breaklines dialog box
 I. Type: Proximity

 II. OK
 B. Select feature line and Enter

Wall breaklines

If the surveyor only has top or bottom points of a wall in the file, and height documented, this is how 
the user can add the other points of a wall.

 3. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand 
Definition > right-click Breaklines > Add...

 A. Add Breaklines dialog box 
 I. Type: Wall

 II. OK
 4. Select object: PolylineEnter
 5. Pick offset side: select south side of line 
 6. Enter option for wall height: All Enter        All is all of the points will take the same 

height.  Individual is each vertex point will have a different height. 
 7. Enter elevation difference for offset points: 5Enter

Info: Right-click surface > Object viewer... will allow user to view/confirm the wall.

Non-destructive breakline

The elevation for each new point is extracted from the original surface triangle, therefore main-
taining the integrity of the original surface.

 8. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand 
Definition > right-click Breaklines > Add...

 A. Add Breaklines dialog box
 I. Type: Non-destructive

 II. OK
 9. Select feature line and Enter

From file breaklines

 10. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand 
Definition > right-click Breaklines > Add...

 A. Add Breaklines dialog box  
 I. Type: From file

 II. From link options: Break link to file
 III. OK

 B. Import Breakline File > Exist.flt > Open
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Exercise files: srfc-brklin-data-end-c3d20.zip

Surface creation
Last updated: 2021-06-15

Total video time: 04:05

Exercise files: srfc-creat-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\Surf-Ex .dwg

srfc-creat-01.mp4 4:05

Build a surface

 1. Ribbon > Home tab > Create Ground Data panel > Surfaces dropdown > Create Surface
 2. Create Surface dialog box

 A. Properties box 
 I. Name: Exist

 II. Style: EX Contour 10' Major:2' MinorOK
 B. OK

 3. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand 
Definition > right-click Point Files > Add...

 A. Add Point File dialog box
 I. Select File: Browse > EXIST.pnt > Open

 II. Specify point file format: PENZ (space delimited)
 III. OK

 4. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand 
Definition > right-click Breaklines > Add...

 A. Add Breaklines dialog box 
 I. Type: From file

 II. File link option: Break link to file
 III. OK

 B. Import Breakline File > EXIST.flt > Open

Exercise files: srfc-creat-data-end-c3d20.zip

Surface boundaries
Last updated: 2021-06-29

Total video time: 06:57

Exercise files: srfc-bndry-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\Surf-Ex .dwg
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Data Clip and Outer boundaries

srfc-bndry-01.mp4 3:56

Data Clip boundaries

Data Clip boundaries are placed before you have a surface definition, preventing the definition from 
being too large.

 1. Start with a closed polyline shape.

Tip: Closed polyline shape is important, otherwise the boundary tool will close it for you and 
you may get a result you weren't expecting. 

 2. Toolspace > Prospector tab > right-click Surfaces > select Create Surfaces
 A. Create Surfaces dialog box 

 I. Properties box 
 a. Name: Exist
 b. Style: EX TrianglesOK

 II. OK
 3. Toolspace > Prospector tab > expand Surfaces > expand Exist > expand Definition > 

right-click Boundaries > select Add...
 A. Add Boundaries dialog box 

 I. Name: Data
 II. Type dropdown: Data Clip

 III. OK
 B. Select polyline

 4. Select Polyline drawn in Step 1
 5. Toolspace > Prospector tab > expand Surfaces > expand Exist > expand Definition > 

right-click Point Files > select Add...
 A. Add Point File dialog box 

 I. Selected Files: Add (+) 
 a. Select Source dialog box 

 i. Exist.pnt
 ii. Open

 II. Specify point file format: PENZ (space delimited)
 B. OK

Outer boundaries

Outer boundaries are placed after the surface has been created.

 6. Context Ribbon > Draw tab > select Polyline tool
 A. Draw a closed polyline

Tip: At second to last point, press "C" to close the shape. 

 7. Toolspace > Prospector tab > expand Surfaces > expand Exist > expand Definition > 
right-click Boundaries > select Add...
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 A. Add Boundaries dialog box 
 I. Name: Outer

 II. Type dropdown: Outer
 III. OK

 B. Select polyline

Info: Non-destructive stops triangles up to the edge of the boundary line. Destructive 
ends at the triangle just past the boundary line.

Hide and Show boundaries

srfc-bndry-02.mp4 3:01

Hide and Show Boundaries are meant to prevent surface triangles from being created inside the 
area you area working in.

Hide boundary

 1. Toolspace > Prospector tab > expand Surfaces > expand Exist > expand Definition > 
Right-click Boundaries > select Add... This step is going to add a new boundary. 

 A. Add Boundaries dialog box 
 I. Name: Treeline

 II. Type dropdown: Hide
 III. Non-destructive breakline: checked                 Non-destructive stops triangles up to the 

edge of the boundary line. Destructive ends at the triangle just past the bound-
ary line. 

 IV. OK
 2. Select polyline shape 
 3. Right-click for dropdown, Enter

Show boundary

A space with triangles inside a Hide Boundary.

 4. Select closed polyline shape inside Hide Boundary.
 5.  Toolspace > Prospector tab > expand Surfaces > expand Exist > expand Definition > 

Right-click Boundaries > select Add...
 A. Add Boundaries dialog box 

 I. Name: Show
 II. Type dropdown: Show

 III. Non-destructive breakline: checked
 IV. OK

 6. Select polyline, Enter

Info: Show boundaries remember where the triangles were before the Hide boundary was cre-
ated.  Show boundaries cannot be created on their own, they need a Hide boundary first.

Page: 566

Published on: 5/17/2023

Hide and Show boundaries

https://c3dkb.dot.wi.gov/video/srfc/srfc-bndry-02.mp4


Surface masks
Last updated: 2021-06-29

Total video time: 02:37

Exercise files: srfc-msk-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\Surf-Ex.dwg

srfc-msk-01.mp4 2:37

Surface masks are meant to cover up or obscure the surface definition in an area without removing 
surface triangles from the definition.

Info: Only allowed one mask per surface.

 1. Toolspace > Prospector tab, expand Surfaces > expand Exist (surface 
file) > right-click Masks > Create Mask...

 2. Select objects:  select closed polyline shape Enter
 3. Create Mask dialog box

 A. Properties box > Information > Name: Mask 1
 B. Masking box > Mask type: Inside

Info: Inside mask will cover everything inside the selected polyline shape.  Out-
side mask will cover everything outside the selected polyline shape.

 A. OK

Surface edits
Last updated: 2021-06-29

Total video time: 05:26

Warning: Surfaces edits should not be used on design or refinement surfaces. They can be 
used in setup and non-design surfaces.

Exercise files: srfc-edit-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\Setup-Crdr-STH25.dwg

srfc-edit-01.mp4 5:26

 1. Open file Setup-Crdr-STH25.dwg
 2. Select surface
 3. Context Ribbon > Modify panel > Edit Surfaces dropdown > Swap Edge
 4. Select a surface triangle edge
 5. Select first Tin Surface in Selection Cycling
 6. Enter
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Surface point editing tool
 7. Select surface
 8. Context Ribbon > Modify tab > Surface Properties dropdown > Edit Surface Style

 A. Surface Style dialog box 
 I. Display tab 

 a. Point component, check light bulb
 B. OK
 C. Warning box, select Apply the edits for this drawing session only

Adding a surface point
 9. Select surface

 10. Context Ribbon > Modify tab > Edit Surface dropdown > Add Point
 11. Select a location to place new point
 12. New elevation: 1157.5Enter
 13. Enter to end command

Moving a surface point
 14. Select surface
 15. Context Ribbon > Modify tab > Edit Surface dropdown > Move Point
 16. Specify point to move: left-click on a point
 17. Specify a new location for the point: left-click new location
 18. Enter to end command

Modifying a surface point
 19. Select surface
 20. Context Ribbon > Modify tab > Edit Surface dropdown > Modify Point
 21. Select point: left-click a point Enter
 22. New elevation: 1157.78Enter
 23. Enter to end command

Adding a line
 24. Select surface       
 25. Context Ribbon > Modify tab > Edit Surface dropdown > Add Line                  Needs point vertices 

turned on.       
 26. Left-click a vertex point, then select a second vertex point to add a line between       
 27. Enter to end command       

Surface properties - Analysis
Last updated: 2021-06-29

Total video time: 06:15
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srfc-prprtis-anlysis-01.mp4 6:15

Analysis tools
Types of analyses you can run on a surface include elevation banding, slopes, slope arrows, spe-
cialized contours, user-defined contours, and watersheds.

Location of tools

 1. Select surface > Contextual Ribbon > Modify panel > Surface Properties
 A. Surface Properties dialog box             

 I. Analysis tab > Analysis type dropdown

Tip: Before you run an analysis, select or create a style that visualizes its results.

Create new surface style

 2. Surface Properties dialog box         
 A. Information tab             

 I. Default styles > Surface style > select Create button dropdown > Create 
New

 a. Surface Style - New Surface Style dialog box 
 i. Information tab 

 i. Name: Slope Arrows
 ii. Display tab 

 i. Slope Arrow visible, select light bulb
 ii. Triangles visible, select light bulb

 iii. Analysis tab 
 i. expand Slope arrows 

 i. Scheme: Rainbow or any color gradient that is dif-
ferent

 II. OK
 3. Analysis tab         

 A. Analysis type: Slope Arrows
 B. Legend: WisDOT Standard
 C. check box Preview
 D. Ranges, Number: 8
 E. Select down arrow button to start the analysis in preview

Info: In Range Details, user can edit Minimum Slope, Maximum Slope, and 
Scheme

      
 4. OK

Create a legend table

 5.          Context Ribbon > Annotate tab > Add Tables > Add Surface Legend Table       
 6. Enter table type: A (slopeArrows) Enter      
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 7. Behavior: Enter (Dynamic)       
 8. Left-click on surface to add table       

Cropped surfaces
Last updated: 2021-06-29

Total video time: 04:21

srfc-crop-01.mp4 4:21

Creating a cropped surface
 1. Home tab > Create Ground Data panel > Surfaces dropdown > Create Cropped Data
 2. Create Cropped Surface dialog box 

 A. Properties box 
 I. Crop Information 

 a. Select surface to crop: Exist
 b. Select crop area: click (...) Ellipsis button 

 i. P Enter                        Press F3 to turn off OSNAPS 
 ii. Click polygon points in drawing, C Enter to close last point.

 II. New Surface 
 a. Drawing for new surface: Select an open drawing
 b. Select Open drawing: Surf-Exist-Cropped.dwg
 c. New Surface name: Exist-crop
 d. Surface Style > (...) Ellipsis button > EX TrianglesOK
 e. Layer >  (...) Ellipsis button > E_SURFOK

 III. OK
 3. Select Surf-Exist-Cropped file tab 

The cropped surface is linked to the original surface. Any changes made to the original surface will 
not appear on the cropped surface until you do the following:

 4. Toolspace > Prospector tab > expand Surface
 5. Right-click Exist-crop > Rebuild Snapshot
 6. Right-clck Exist-crop > Rebuild

Changes should appear in cropped surface.

Create Exist surface from mapping
Last updated: 2021-06-29

Total video time: 8:22

Create Exist surface file

srfc-creat-exst-frm-map-01.mp4 3:00
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Exercise data: srfc-creat-exst-frm-map-data-begin-c3d20.zip

 1. Menu browser > New
 2. Surface template dialog box

 A. Look in: Begin-dwg folder
 B. Select template survey-start.dwt
 C. Click Open

 3. Menu browser > Save As
 4. Save Drawing As dialog box

 A. Browse to Local drive:\PDS\C3D\11701902\BaseData
 B. Rename file, File name: Surf-Ex
 C. Save

Create data clip boundary

Add Xref Data

 5. Ribbon > WisDOT Survey tab > Manage panel > Load Xref on Layer
 6. Select a File to Xref dialog box

 A. Browse for file, Look in: 11701902\BaseData
 B. Select file Topo-Ex.dwg
 C. Click Open

 7. Use Zoom Extents (Z+Enter, E+Enter) to see Xref is in place

Create Boundary

 8. Scroll/Zoom to project area 
 9. Commandline: Type PL

Tip: Polyline command can also be found in Home tab > Draw panel > Polyline

 10. Select a start point near the surface. Continue adding polyline vertices around the surface. At 
last point, type C to close the polyline shape. 

Save file

Quick Access bar > Save

Transform SRV to PNT/FLT files

srfc-creat-exst-frm-map-02.mp4 2:17
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 1.  Desktop > open WisDOT Civil 3D Apps 
 2. WisDOT Civil 3D Apps dialog box

 A. SRV to PNT/FLT tab
 B. Select folder icon to browse 

 I. Select SRV File dialog box 
 a. Browse to Local Drive:\PDS\C3D\11701902\BaseData\Mapping
 b. Select SRV file
 c. Click Open

 C. OK
 D. Select OK to any Convert SRV dialogs regarding missing files
 E. Select OK to any messages regarding the location of the PNT and FLT files.

 3. Repeat steps B-E for each SRV file available. 
 4. Open Civil 3D

Info: This step is not necessary but is to confirm the files created from the SRV. In Win-
dows Explorer, browse to the project folder, 11701902\BaseData\Mapping and confirm 
the *.pnt, *.flt, *-bldg.flt and *-obsc.flt were created. There may also be *-weak.flt and 
*-ewbdy.flt files created here, depending on your project.

Create surface from PNT/FLT files

srfc-creat-exst-frm-map-03.mp4 3:05

 1. WisDOT Survey tab > Mapping panel > Surface from PNT/FLT
 2. Open dialog box

 A. Browse Local drive:/PDS/C3D/11701902/BaseData/Mapping
 B. SHIFT+Select all PNT and FLT files (no folders)
 C. Open

 3. Select outer boundary Polyline ESC for none: Select polyline representing 
boundary on surface

 4. Enter name of new Surface: default is Exist, select Enter to accept default name.
 5. Process runs. Surface will be created when done.

To locate surface

 6. Toolspace > Prospector tab > expand Surfaces > right-click Exist > select Zoom to

Rebuild surface

When you find the Exist surface in Toolspace, there might be a yellow alert symbol asking for the sur-
face to be rebuilt.

 7. Right-click Exist > select Rebuild

Save file

Quick Access bar > Save
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Exercise data: srfc-creat-exst-frm-map-data-end-c3d20.zip

Create surface from survey & add to Exist
Last updated: 2022-08-30

Total video time: 10:20

Create file from survey data

srfc-creat-exst-frm-srvy-01.mp4 3:02

Exercise data: srfc-creat-exst-frm-srvy-data-begin-c3d20.zip

 1. Menu browser > New
 2. Surface template dialog box

 A. Look in: Begin-dwg folder
 B. Select template survey-start.dwt
 C. Open

 3. Menu browser > Save As
 4. Save Drawing As dialog box

 A. Browse to Local drive:\PDS\C3D\11701902\BaseData
 B. Select Survey folder
 C. Rename file, File name: type Surf-Ex-Survey
 D. Click Save

Build surface

 5. Home tab > Create Ground Data panel > Surfaces dropdown > Create Surface
 6. Create Surface dialog box

 A. Change Name to Exist-Survey
 B. OK

 7. Quick Access bar > Save

Add survey data

 8. Toolspace > Survey tab > expand Survey Databases > right-click SD-11701902 > Open 
for edit

 9. Expand Survey queries 
 10. Select and Select+Drag the following survey queries into file:

 o Centerlines
 o SurfaceFigures
 o SurfacePoints1
 o SurfacePoints2
 o SurfacePoints3

Info: Must drag each query individually, not as a selected group.

 11. Quick Access bar > Save
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Add clip boundary

srfc-creat-exst-frm-srvy-02.mp4 2:31

Create data clip boundary

 1. Scroll/Zoom to project area 
 2. Commandline: Type PL

Tip: Polyline command can also be found Home tab > Draw panel > Polyline

 3. Select a start point near the surface. Continue adding polyline vertices around the surface. At 
last point, type C to close the polyline shape. 

Add data clip boundary to surface definition

 4. Toolspace > Prospector tab > expand Surfaces > expand Exist-Survey > expand Defin-
ition > right-click Boundaries > Add...

 5. Add Boundaries dialog box
 A. Type dropdown, select Data Clip
 B. OK

 6. Select boundary on surface

Remove survey points and figures from file

 7. Toolspace > Survey tab > right-click Survey Points > Points fly-out > Remove from 
drawing...

 A. Are you sure you wish to remove these points from the drawing? 
Yes

 8. Toolspace > Survey tab > right-click Figures > Remove from drawing...
 A. Are you sure you wish to remove these objects from the drawing? 

Yes
 9. Quick Access bar > Save

Add survey data and create data shortcut

srfc-creat-exst-frm-srvy-03.mp4 3:00

Add survey data as a reference

 1. Survey tab > Modify panel > Survey Query
 2. Survey Queries Ribbon > Manage panel > dropdown > select SurfacePoints1
 3. Survey Queries Ribbon > Query Results panel > select Add to Surface
 4. Add Survey Query Results to Surface dialog box

 A. Add query results to this surface dropdown: select Exist-Survey
 B. Query Results: select Reference the survey database for dynamic query res-

ults
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 C. Use these survey queries: Check mark the following: Centerlines, Sur-
faceFigures, SurfacePoints1, SurfacePoint2, & SurfacePoints3.

 D. OK
 5. Data is transferred in drawing file
 6. Quick Access bar > Save

Create data shortcuts

 7. Toolspace > Prospector tab > right-click Data Shortcuts > Create Data Shortcuts...
 8. Create Data Shortcuts box

 A. Select Exist-Survey
 B. OK

Remove surface triangle lines outside of boundary

There are a few triangles jumping across the boundary.

 9. Select surface > right-click menu > select Surface Porperties...
 10. Surface Properties dialog box

 A. Surface styles: select EX Triangles
 B. Apply
 C. OK

 11. Select surface
 12. Surface tab > Modify panel > Edit Surface > Delete Line
 13. Crossing-windows select all lines outside of boundary area
 14. Enter
 15. Select surface
 16. Surface ribbon > Modify panel > select Surface Porperties...
 17. Surface Properties dialog box

 A. Surface styles: select EX Border
 B. OK

 18. Esc
 19. Quick Access bar > Save
 20. Survey Queries ribbon > Close

Paste survey surface into Exist surface

srfc-creat-exst-frm-srvy-04.mp4 1:45

Open Exist surface file

 1. Quick Access bar > Open
 2. Select File dialog box

 A. Look in: PDS\C3D\11701902\BaseData
 B. Select Surf-Ex.dwg
 C. Open

 3. Toolspace > Prospector tab > expand Data Shortcuts > expand Surfaces > expand Exist-
ing > right-click Exist-Survey > select Create Reference
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 4. Create Surface Reference dialog box
 A. Style: set to EX Border
 B. OK

Locate surface

 5. Toolspace > Prospector tab > expand Surfaces > expand Existing > right-click Exist-Sur-
vey > select Zoom to

Paste survey surface into Exist surface

 6. Toolspace > Prospector tab > expand Surfaces > expand Exist > expand Definition > 
right-click Edits > select Paste Surface...

 7. Select Surface to Paste dialog box
 A. Select Exist-Survey
 B. OK

 8. Quick Access bar > Save

Exercise data: srfc-creat-exst-frm-srvy-data-end-c3d20.zip

Create a drainage analysis surface from USGS data in Civil 
3D
Last updated: 2020-10-26

Total video time: 25:10

Exercise files: srfc-create-drn-anlysis-dem-data-C3D12.zip

Download USGS DEM data

srfc-create-drn-anlysis-dem-01.mp4 6:38

This segment will demonstrate how to download USGS DEM data.

Download USGS DEM data

 1. Open the USGS National Map Viewer http://viewer.nationalmap.gov
 2. Click the Download Data button at the top of the screen.
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 3. Navigate to your location
 4. Turn on the Box/Point button and drag a rectangle around the area you wish to capture

 5. On the left check the Elevation Products (3DEP)
 6. Multiple options will likely be available to you. The smaller the arc second value, the higher 

the point grid density will be. Point elevation accuracy is the same. Check the desired data set. 
Be sure to choose the ArcGrid format. 

 7. Click Find Products 
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 8. Click Add to cart. View cart Download

Page: 578

Published on: 5/17/2023

Download USGS DEM data



 9. It will take a few minutes to download
 10. Unzip the data to your project folder \BaseData\Other\USGS-DEM\

Info: Note: 1/3 arc second is typically adequate, but download the best avail-
able. Later, if you are unable to load a denser point density, try a larger (less 
dense point spacing) or break the DEM into smaller pieces. This may occur on 
larger areas.

Create surface from USGS DEM

srfc-create-drn-anlysis-dem-02.mp4 18:32

Warnings: This segment includes a large dataset and may take a long time to 
download.

Create USGS DEM surface file

Create a new dwg file from the WisDOT template and save it as Surface-USGS-DEM_meters.dwg.

 1. In the drawing settings set the Drawing Units to Meters. Set the Zone to USA, Wisconsin and 
Wisconsin County Systems: {Your project County}, Meter. Click OK.

 2. Import the project mapping into the drawing to provide spatial reference. Refer to nosrvy-
bsdata-wrk-sptl-rfrnc-DWG-img-GIS for this procedure.
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 3. Draw a closed polyline around the area where the DEM Surface is needed. Make this area as 
small as possible to improve system performance.

 4. Create a new surface called USGS-DEM
 5. Expand the surface definition in the Toolspace-Prospector.
 6. Right click on Boundaries and select Add....
 7. Set the Type to Data Clip. Click OK and select the closed polyline from the screen.
 8. In the Toolspace-Prospector, right click on DEM Files under the surface definition. Select 

Add...
 9. At the top of the dialogue box, select the DEM file. The file extension is ESRI Binary Grid 

(*.adf). You will see multiple .adf files in the data set downloaded. Choose the one with the 
largest file size.

 10. Set the CS Code to Lat Longs, NAD83 datum, Latitude-Longitude; Degrees. (Coordinate Sys-
tem Code is LL83) Click OK. Civil 3D will transform the DEM surface from Lat/Long to the 
coordinate system assigned to the drawing. However, it will not transform the elevations. This 
is why we first bring the DEM into a metric drawing.

 11. Click OK to finish loading the DEM file. The surface is now viewable according to the assigned 
style. This may take some time depending on the point density and area.

 12. In the Toolspace-Prospector, right click on the surface and select Export LandXML... Make 
sure the surface (only the surface) is selected in the Export to LandXML dialogue box. Click 
OK. Save the xml file to the BaseData\Other\USGS-DEM\ directory. Name the file USGS-DEM_
meters.

 13. Save and Close the drawing.
 14. Create a new dwg file from the WisDOT template and save it as Surface-USGS-DEM_

USFoot.dwg.
 15. In the Drawing Settings, set the Zone to USA, Wisconsin, Wisconsin County Systems: {Your 

Project County}, US Foot. Click OK.
 16. Data shortcut reference your roadway alignment or xreference your mapping to provide spa-

tial reference.
 17. From the Insert Tab - Import Panel, click LandXML. Select the USGS-DEM_meters.xml file 

and click Open.
 18. Click OK at the Import LandXML dialogue box. The DEM surface will now appear in your draw-

ing according to its assigned style. Save the drawing and create a data shortcut for the sur-
face. The DEM surface now has elevations in feet.

Create drainage analysis surface from USGS data in Infra-
works
Last updated: 2020-10-26

Total video time: 35:03

Warning: A known issue has been identified related to Wisconsin county coordinate pro-
jections. Please make sure to use to only use projections beginning with "WisDOT NAD83/". 
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Please review "Wisconsin coordinate projection issue - XML/SDB" on page 116 for more inform-
ation.

Exercise files: srfc-creat-dem-infrawrks-data-C3D14.zip

Introduction

srfc-creat-dem-infrawrks-01.mp4 5:26

 l Infraworks is capable of processing larger data sets. Therefore it is sometimes easier to con-
sume DEM files, LiDAR files, or other large sets of data in Infraworks instead of working dir-
ectly in Civil 3D. Once the data is inside Infraworks, smaller sample surfaces can be exported 
to Civil 3D.

 l Another advantage to consuming data in Infraworks is coordinate transformations. Infra-
works will automatically transform data to project specific coordinate systems. Then, when 
that data is exported to Civil 3D, it will appear in the correct location.

 l WisDOT employees can have Infraworks installed on their workstation by contacting the IT 
service desk.  http://dotnet/it/serviceportal/redirect.htm

 l In this exercise, we will be using the same USGS data obtained in the surface from USGS data 
training topic. Download the project dataset to follow along. Alternatively, the dem data can 
be obtained from the national map viewer. http://viewer.nationalmap.gov/viewer/

 l In this example, we are going to download a topographic quad map and load it into the 
model. Aerial images can also be used.

 o https://www.topoquest.com/find/state.php?state=WI
 o Download the Dallas and Dorrity Creek Maps

Start an Infraworks project

srfc-creat-dem-infrawrks-02.mp4 4:55
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 1. Start Infraworks
 2. Under Model, select New.

 3. Since the Infraworks model will only be used for consuming data, we recommend that the 
Infraworks project be kept on the users' C-drive. Infraworks projects can grow quickly in size 
and take up unnecessary server space.

 4. Name the project the project ID and provide a descriptions such as the highway name and 
project title.

 5. It is important to define the model extents when practical. The model extents limit the Infra-
works model to the area of interest. Without model extents, the Infraworks model will include 
the entire planet and performance would suffer. However, since the Infraworks engine can 
process large data, the model extents can be set significantly larger than the project. There 
are several options for setting the model extents:

 o Option 1: One way to obtain coordinate values for the model extents, is to open the 
project mapping file in Civil 3D. Choose minimum coordinates representing a point 
southwest of the expected area of interest. Choose maximum coordinates rep-
resenting a point northeast of the expected area of interest.

 o Option 2: The simplest way to set the model extents is with the data that will be con-
sumed. By clicking on the Load Extents From File button, you can select the data that 
will be brought into Infraworks. The extents will be set automatically based on the spa-
tial limits of the data.

In this example, we'll select the .adf file from our USGS DEM download. These extents will be much 
larger than what we will need. However, we can reduce the model extents later.
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 6. Under Advanced Setting, there are some options regarding coordinate systems. These can be 
left as the default even if they do not match your project coordinate system. The UCS coordin-
ate system can be changed to the project coordinate system if you wish. This will display the 
project coordinate system in the model. For our application, there is no need to change the 
database coordinate system.
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 7. Click Ok to create the model.

Model navigation

srfc-creat-dem-infrawrks-03.mp4 1:29

To navigate the model, hold the left mouse button down to orbit. Hold the right mouse button down 
to pan. Use the wheel to zoom in and out. To return to a top view with north up, hover the cursor 
over the viewcube and click on the home symbol. This is the default view for the home view. The 
home view can be changed if desired by click in the down arrow next to the view cube.

Load image data into model and refine model extents

srfc-creat-dem-infrawrks-04.mp4 4:58

 1. We can now begin to load data into the model. We recommend that you load an image file (or 
files) that encompasses the area of interest first. In this example, we are going to download a 
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topographic quad map and load it into the model. Aerial images can also be used.
 o https://www.topoquest.com/find/state.php?state=WI
 o Download the Dallas and Dorrity Creek Maps

 2. To load the images into the model, just drag and drop the image files (one at a time) into Infra-
works.

 o Under the geolocation tab, there should not be any edits that are needed. The coordin-
ate system of the image should automatically load.

 o Under the Raster tab, there are no required edits. However, since in this example we 
are loading a topographic quad map, we can change the classification to Topographic 
Map.

 o We recommend that you check the Clip to Model Extent box for all data loaded into 
Infraworks.

 o Click the Close & Refresh button
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 3. In this example, the area of interest spans 2 topographic quad maps. Repeat the previous 
step to load the second map. Now we can refine our model extents before loading our terrain 
data. From the Infraworks menu, select Model Settings. Under Extent, we can interactively 
define the model extents with a bounding box or polygon. Select the one that you prefer. For 
bounding box, first left click on one extent corner in the model. Next, double left click on the 
other extent corner in the model.

 4. Click Save and then Click Close. The model extents are now refined.
 

Loading terrain data into model

srfc-creat-dem-infrawrks-05.mp4 1:48

 1. The process for loading terrain data is the same. Drag and drop the USGS .adf file into the 
model.

 2. Under the Raster Tab, it is important to check the Clip to Model Extent box for terrain data.
 3. Click Close & Refresh

Infraworks tools and tips

srfc-creat-dem-infrawrks-06.mp4 7:10

 l Terrain themes
 o Terrain Themes can be a very useful tool for analysis. Under the Analyze Tab, select 

Terrain Themes. Click the green plus button to add a theme. You can make your own 
theme, or choose one of the preset themes. To access a preset them, click the palette 
type drop down menu. For USGS DEM files, the USGS National Map palette can be 
very useful. More than one theme can be loaded if desired.

 o Once a theme is added, it can be toggle on and off or edited. A common useful edit is 
transparency. This allow you to view the images loaded into the model at the same 
time as the terrain theme.

 l Surface layers
 o If more than one image is loaded and they overlap, the order can be adjusted to view 

one or the other in the overlap area. In the example, the 2 topographic quads overlap. 
To switch which image is on top, click the Manage Surface Layers button from the 
home tab. In the dialogue, the images can be turned on and off and reordered.

 l Visual effects
 o To adjust the visual effects, such as lighting, go to the Visual Effect tab. One common 

effect modification is the Light intensity. Often, the light intensity is set too high for 
optimal viewing of the topographic quad maps. Gradually slide the light intensity down 
until desired effect is achieved.
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 l Terrain exaggeration
 o For flatter terrain, it can be difficult to distinguish watershed boundaries. Exaggerating 

the terrain in Infraworks can quickly reveal these boundaries. To exaggerate the ter-
rain, right click on the .adf file under the data sources. Choose configure. In the geo-
location tab, set the exaggeration under the z scale. In the example, we exaggerate by 
5. Click Close & Refresh. Since the terrain has been exaggerated in the z direction, you 
may need to zoom out to bring it back into view. Also note, that new terrain themes 
will need to be added for the exaggerated data.

Export Infraworks terrain to Civil 3D

srfc-creat-dem-infrawrks-07.mp4 6:50

Warnings: IMPORTANT: You must remove any terrain exaggeration before 
exporting to Civil 3D.

 1. To export the terrain to Civil 3D, go to the Infraworks menu. Select Export – Export IMX
 2. Define the area of the model that you want to export using either a bounding box or polygon. 

If the model size is not large, the entire model can be exported. We recommend exporting 
only the area that is required. The exported area remains dynamic with the Civil 3D surface 
that is create. The Civil 3D surface reads the .imx file in its definition. Therefore, if the .imx file 
is updated the Civil 3D surface will update. 

 3. Set the target file/location to the Civil 3D project directory. N:\PDS\C3D\Pro-
jectID\BaseData\Other\USGSDEM\USGS-DEM-ProjectID.imx

 4. Click Export
 5. Open Civil 3D. Save a new drawing called N:\PDS\C3D\ProjectID\BaseData\Other\USGS-

DEM\USGS-DEMProjectID.dwg

Warnings: IMPORTANT: Set the project coordinate system for the drawing in 
the drawing settings. This is how the terrain will get transformed to the pro-
ject coordinate system.

 6. Insert Tab - Import Panel – Import IMX. Select the IMX file.
 7. The surface will automatically be created and named AIM_Existing_Ground. Give the surface a 

logical name such as Exist-USGS-DEM
 8. If the surface extents need to be updated, just re-export the IMX file from Infraworks with the 

new extents. Overwrite the previous IMX file. The Civil 3D surface will update.

Update surface limits

srfc-creat-dem-infrawrks-08.mp4 2:27

 l The exported area remains dynamic with the Civil 3D surface that is creates. The Civil 3D sur-
face reads the .imx file in its definition. Therefore, if the .imx file is updated the Civil 3D sur-
face will update. If it is discovered that a larger (or smaller) area is needed for the Civil 3D 
surface, redefine the export extents in Infraworks.
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 l If the surface extents need to be updated, just re-export the IMX file from Infraworks with the 
new extents. Overwrite the previous IMX file. The Civil 3D surface will update.
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Alignments
Alignment basics
Last updated: 2022-11-01

Total video time: 4:07

Alignments in context of project

ali-basc-01.mp4 2:05

Project index for location by station and offset.

Basis for design of corridors.

Targets for corridor design.

Basis for profiles, profile views, and sample lines.

Folder and object naming

In FDM 15-5-3 Att. 3.4 the folder location and the file naming is spelled out, with multiple examples.

Alignments will be created and saved with any related profiles. Multiple alignment/profile com-
binations can be stored in a single file or split up. In general, fewer files are better unless there is a 
need (such as multi-user editing) to have multiple files. These will be data shortcut referenced so 
they can be shared among project files.

Offset alignments, and their profiles, must be in the same file as the parent alignment.

Sites in relation to alignments

Sites are a control mechanism that allow objects to interact. These objects include parcels, grading 
elements and possibly alignments. Alignments are an option in the site control since they usually do 
not need the sort of interaction that is required, and can sometimes become a problem with other 
objects in the file. It is best to make sure the alignments you create are set to "No site" so that acci-
dental interaction does not occur. Places where alignment interaction with objects is preferred 
would be with parcels, and will be discussed in detail there.

Alignment types

ali-basc-02.mp4 2:02

There are five types of alignments that can be created. Generally, users should only be concerned 
with two of those types, centerlines and rail, outlined below: 

 l Centerlines: Despite its name, centerline type alignments are not always centerlines of a 
design. These are alignments created by a user, and is the predominant type for designs. 
These can be used for design start locations, as well as targeting for design definitions (edge 
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of travel ways, shoulder slope breaks, etc.) Centerline alignments can have superelevation 
assigned to them.

 l Rail: If you are creating rail design this type understands the Cant functionality, and will build 
with specific rail needs in mind. You should not use rail alignment types in other designs.

 l Offset: This type of alignment creates a child alignment that is geometrically tied to a parent 
alignment. This type is used for creating tapers and geometry parallel to centerline align-
ments.

 l Curb Return: This type of alignment is built by the intersection tool to create curb return hori-
zontal geometry. The user would not create a curb return alignment manually, and an align-
ment should never have the type changed to this after it is created. In the case this switch is 
made it has prevented other functionality from working.

 l Miscellaneous: The alignment type is created from pipe networks. The user should not 
change an alignment to the miscellaneous type, and there is no acceptable way to create a 
miscellaneous type alignment manually.

Offset Alignments

This type of alignment creates a child alignment that is geometrically tied to a parent alignment. This 
will allow generally parallel design that moves to stay a defined offset from the parent alignment. 
This type does allow for widening while maintaining the geometric tie to the parent alignment. This 
type is created with specific creation commands, and you should not change an alignment you are 
creating to an offset type manually. In the case this switch is made it has prevented other func-
tionality from working. If you need to create an offset alignment , select the parent alignment and 
choose Create Offset to create the geometric connection.

Superelevation assignments in alignments

While creating corridor designs that utilize superelevation to transition subassembly slope over long 
distances, the data needed to accomplish this will be stored in the alignment. This alignment data 
will then work with properly attached subassemblies to create the needed slopes and transitions.

Alignment layout tools
Last updated: 2022-11-01

Total video time: 11:24

Layout tool overview

Exercise file: ali-data-C3D22.zip

ali-lyout-tool-01.mp4 2:36
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve-ali-lyout-tool-01.dwg
 C. Open

Layout Creation Tools

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment 
Creation Tools

 2. Create Alignment - Layout dialog box
 A. Name: Lcl 4th Ave
 B. Type: Centerline
 C. Description: (added information about alignment) Leave blank
 D. Starting station: leave set to default, 0+00.00", but any start number can be given.
 E. Site: <None>
 F. Alignment style, layer, and label set: Leave as is.
 G. OK

 3. Alignment Layout Tools toolbar

Info: The title bar displays the current alignment, Lcl 4th Ave.

 A. Left-click Draw Tangent-Tangent tool
 B. Specify first point: Left-click point 1201
 C. Specify next point: Left-click point 1202
 D. Specify next point: Continue left-click all points, west to east, ending at point 

1205

Info: Direction of an alignment should be west to east or south to north.

 E. Right-click to end command

Alignment Layout Tools toolbar

The Alignment Layout Tools toolbar performs site specific design by layouts.

 l Design tangents, curves, and spirals.
 l Add or remove PI (point of intersection).
 l Convert AutoCAD lines and arcs to an alignment.
 l Reverse or edit created layout entities.
 l Delete sub-entities.
 l Display design elements in a table/grid format.

Curve settings

ali-lyout-tool-02.mp4 1:29
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve-ali-lyout-tool-01.dwg
 C. Open

Edit curve settings

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment 
Creation Tools

 2. Create Alignment - Layout dialog box
 A. Name: Lcl 4th Ave
 B. Leave all other setting as is.
 C. OK

 3. Alignment Layout Tools toolbar > Tangent-Tangent tool dropdown > Curve and Spiral 
Settings...

 4. Curve and Spiral Settings dialog box
 A. Type: Clothoid
 B. Box checked Curve
 C. Default radius: 100
 D. OK

Tangent-Tangent no curves or with curves

ali-lyout-tool-03.mp4 2:22

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve-ali-lyout-tool-01.dwg
 C. Open

Set Object Snap (OSnap) setting

 1. Status bar > Object Snap dropdown > Node (uncheck all other OSnaps)

Tangent-Tangent (no curves)

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment 
Creation Tools

 2. Create Alignment - Layout dialog box
 A. Name: Lcl 4th Ave
 B. Leave all other setting as is.
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 C. OK
 3. Alignment Layout Tools toolbar > Tangent-Tangent tool dropdown > Tangent-Tangent 

(No curves)
 4. Specify start point: Left-click point 1201
 5. Specify next point: Left-click point 1202
 6. Specify next point: Left-click point 1203
 7. Right-click to end command

Tangent-Tangent (with curves)

 1. Alignment Layout Tools toolbar > Tangent-Tangent tool dropdown > Tangent-Tangent 
(With curves)

 2. Specify start point: Left-click point 1203
 3. Specify next point: Left-click point 1204
 4. Specify next point: Left-click point 1205
 5. Right-click to end command

PI (point of intersection) editing

 ali-lyout-tool-04.mp4 2:59

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve-ali-lyout-tool-04.dwg
 C. Open

Set Object Snap (OSnap) setting

 1. Status bar > Object Snap dropdown > Node (uncheck all other OSnaps)

Add missing points to the alignment

 1. Left-click the alignment
 2. Contextual ribbon > Modify panel > Geometry EditorOR Right-click menu > Edit Align-

ment Geometry...
 3. Alignment Layout Tools toolbar > Insert PI command
 4. Pick point near PI to insert: Hover over point 1204 and left-click to snap 
 5. Right-click to accept
 6. Alignment Layout Tools toolbar > Insert PI command
 7. Pick point near PI to insert: Hover over point 1207 and left-click to snap 
 8. Right-click to accept

Deleting PI from the alignment

 1. Alignment Layout Tools toolbar > Delete PI command
 2. Pick point near PI to delete: Hover over point 1207 and left-click to snap 
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 3. Right-click to remove

Break-apart PI

 1. Alignment Layout Tools toolbar > Break-apart PI command
 2. Pick point near PI to split: Hover over point 1204 and left-click to snap 
 3. Enter distance by which to split PI:25Enter
 4. Right-click to accept

X to close Alignment Layout Tools toolbar

Sub-entity editing

ali-lyout-tool-05.mp4 1:58

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve.dwg
 C. Open

Reverse sub-entity direction

Looking at the alignment, the labeling stops midway. This means there is a sub-entity going in the 
wrong direction.

 1. Left-click the alignment
 2. Contextual ribbon > Modify panel > Geometry EditorOR Right-click menu > Edit Align-

ment Geometry...
 3. Alignment Layout Tools toolbar > Reverse Sub-entity Direction command
 4. Select fixed line or curve to reverse: Left-click curve by point 1203

Labels should appear complete to the end of the alignment.

Delete sub-entity

 1. Alignment Layout Tools toolbar > Delete Sub-entity command
 2. Select subentity to remove: Left-click line between points 1204 & 1205
 3. Right-click to accept.

Alignment lines and curves
Last updated: 2022-11-01

Total video time: 12:14

Line and curve overview
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Exercise file: ali-data-C3D22.zip

Video: ali-lin-crv-01.mp4 1:54

Alignment line and curve tools, in the Alignment Creation Tools toolbar, allow you to draw the align-
ment segment by segment, close(???) subentity. It allows you to design with site specific design geo-
metry; lines, curves, and spirals with specific tangency requirements. And these tools are different 
from the tools Tangent-Tangent (no curves) and Tangent-Tangent (with curves). These will allow you 
to draw the alignment from start to finish without exiting the command.

The three main ways to draw these subentities are fixed, floating, and free geometry.

Fixed lines and curves

 l Are geometrically defined and locked or fixed in their precision and must be edited directly.
 l Are not affected by other geometry entities.
 l Do not maintain tangency.
 l Example: A three-point-curve

Floating lines and curves

 l Are constraint based alignment geometry.
 l Relative to other geometry.
 l Will maintain tangency.
 l Example: A curve tangent to line, through a point.

Free lines and curves

 l Are defined by other entities, their geometry, as that a fillet between two entities.
 l All definition relative to other geometry.
 l Will maintain tangency
 l Example: A curve tangent to two lines and/or a line tangent to two curves.

Alignment layout with fixed lines and fixed curve options

Video: ali-lin-crv-02.mp4 3:40

Set Object Snap (OSnap) setting

 1. Status bar > Object Snap dropdown > Node

Open transparent commands

Transparent commands are commands used within a running command.

 1. By default, the commands can be found on the right edge in the drawing area. 
 2. If not displayed, Ribbon > View tab > Interface panel > Toolbars dropdown > CIVIL 

> select Transparent Commands.
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-lin-crv-02.dwg
 C. Open

Create fixed line

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment 
Creation Tools

 2. Create Alignment - Layout dialog box
 A. Name: 4th Ave
 B. Leave all other settings as is.
 C. OK

 3. Alignment Layout Tools toolbar > Line tool dropdown > Fixed Line (Two points)
 4. Specify start point: Left-click point 1201

Info: Direction of an alignment should be west to east or south to north.

 5. Specify next point: Use Transparent command Bearing Distance.
 6. Specify quadrant (1-4): As you rotate around point 1201, there are 4 quadrants. Left-

click in Quadrant: 1 - NE.
 7. Specify bearing:73.5147Enter
 8. Specify distance:234.85Enter
 9. Enter to end command

Create fixed curve

 1. Alignment Layout Tools toolbar > Curve tool dropdown > More Fixed Curves > Fixed 
Curve (From entity end through point)

 2. Select entity for start point and direction: Left-click on line
 3. Specify end point: Left-click point 1207
 4. Enter to end command

Alignment layout with floating line and floating curve options

Video: ali-lin-crv-03.mp4 1:43

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-lin-crv-03.dwg
 C. Open
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Create floating line

 1. Alignment Layout Tools toolbar > Line tool dropdown > Floating Line (From curve end, 
length)

 2. Select entity to attach to: Left-click curve 
 3. Specify length:156Enter
 4. Enter to end command

Create floating curve

 1. Alignment Layout Tools toolbar > Curve tool dropdown > Floating Curve (From entity, 
radius, through point)

 2. Select entity to attach to: Left-click line
 3. Specify radius or [Degree of curvature]:90Enter
 4. Is curve solution angle [Greaterthan180/Lessthan180] 

<Lessthan180>:Enter
 5. Specify end point: Left-click point 1216
 6. Right-click or Enter to end command

Alignment layout with free line and free curve options

Video: ali-lin-crv-04.mp4 2:10

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-lin-crv-04.dwg
 C. Open

Create free line

Add a line tangent between two curves with free line options.

 1. Left-click on the alignment
 2. Contextual ribbon > Modify panel > Geometry EditorOR Right-click menu > Edit Align-

ment Geometry...
 3. Alignment Layout Tools toolbar > Line tool dropdown > Free Line (Between two 

curves)

Warning: Pay attention to the direction of the alignment. Direction of an alignment 
should be west to east or south to north.

 4. Select first entity: Left-click on west curve entity, incoming curve.
 5. Select next entity: Left-click on east curve entity, outgoing curve. 
 6. Right-click or Enter to end command
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Create free curve

Add a free curve tangent between two lines with free curve options. Curve will be between the two 
lines tangents on east end of alignment.

 1. Alignment Layout Tools toolbar > Curve tool dropdown > Free Curve Fillet (Between 
two entities, radius)

 2. Select first entity: Left-click on the west line entity, incoming tangent.
 3. Select next entity: Left-click on the east line entity, outgoing tangent.
 4. Is curve solution angle [Greaterthan180/Lessthan180] 

<Lessthan180>:Enter
 5. Specify radius:90Enter
 6. Right-click or Enter to end command.

Changing curve types after placement

Video: ali-lin-crv-05.mp4 2:47

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve.dwg
 C. Open

Curve tangency constraint

 1. Left-click on the alignment
 2. Contextual ribbon > Modify panel > Geometry EditorOR Right-click menu > Edit Align-

ment Geometry...
 3. Alignment Layout Tools toolbar > Alignment Grid View tool
 4. In Panorama

 A. Select Entity No. 2

Info: When selecting an entity in the chart, it will highlight the entity in the draw-
ing.

 5. Left-click on that curve entity
 6. Left-click point-of-intersection grip point and move it down. Notice the radius, direction sta-

tion, and all connecting entities change. Both sides of the curve change equally due to the tan-
gency constraint.
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Changing parameter constraint

 1. In Panorama
 A. Select Entity No. 2

 I. Tangency Constraint: Change to Constrained by Previous (Floating)
 II. Parameter Constraint Lock: Unlock

 III. Parameter Constraint: Radius and Length
 2. Left-click on curve entity
 3. Arrow grip appears on the east end of the curve allowing change to the length. It is free on 

the east constraint but not the west constraint.
 4. X to close panorama

Create alignment for objects
Last updated: 2022-11-01

Total video time: 12:47

Cleaning up AutoCAD objects prior to conversion

ali-data-c3d22.zip

Video: ali-creat-frm-objct-01.mp4 2:11

Warning: It is preferred that you use the layout tools to build alignments. This prevents gaps 
in alignment objects that can cause problems in stationing, targeting, and other advanced func-
tions. If you need to translate AutoCAD objects into alignment objects it is preferred that these 
objects be transformed into singular polylines prior to conversion. This will prevent tangent 
segments that are not properly snapped from ending an alignment early.

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-creat-frm-objct-clnup.dwg
 C. Open

Connect lines and arcs into a polyline

 1. Ribbon > Modify tab > Modify panel dropdown > Polyline Edit commandORCom-
mandline:PEEnter for polyline edit.

 2. Commandline:MEnter for multiple.
 3. Select objects: Click and drag cursor over all lines and arcs.
 4. Convert lines, arcs, and splines to polylines:YEnter
 5. Enter an option:JEnter for join.
 6. Enter to end command
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 7. Select polyline to verify all are connected.

Info: If there are lines/arcs not connected to the polyline it might be because the end-
points are not snapped together. To correct this:

 A. Select object
 B. Shift + Right-click > Endpoint
 C. Select connecting end grip point
 D. Enter to end command.
 E. Commandline:J Enter to join.
 F. Select objects to join: Click and drag cursor over objects.
 G. Enter

Create alignment from objects dialog

Video: ali-creat-frm-objct-02.mp4 3:12

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-creat-frm-objct-dialg.dwg
 C. Open

Create alignment from objects

 1. Select object to verify it is a polyline; one complete/joined object. 
 2. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Alignment 

from Objects command
 3. Select the first line/arc/polyline: Select object south end of polyline.

Tip: Direction of an alignment should be west to east or south to north. When con-
verting an alignment, selecting the west/south point will force the directional path of 
the alignment. If the path is in the wrong direction, the commandline will prompt you 
the option reverse the path.

 4. Press enter to accept alignment direction or (R)everse:Enter
 5. Create Alignment from Objects dialog box

 A. Name: type AliProf-All
 B. Starting station: delete what is there and type 33000
 C. General tab

 I. Site: <None>
 II. Leave Alignment style, layer, and label set as is.

 III. Conversion options: 
 a. Uncheck box Add curves between tangents
 b. Check box Erase existing entities
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 D. Design Criteria tab
 I. Starting design speed: 45m/h

 II. Check box Use criteria-based design
 III. Check box Use design criteria file
 IV. ...

 a. Look in: browse to Local Drive:\ProgramData\Autodesk\C3D 
20xx\enu\Data\Corridor Design Standards\Imperial

 b. Select file _WisDot Design Criteria 2009.xml 
 c. Open

 V. Default criteria
 a. Minimum Radius Table: WisDOT eMax 4%
 b. Transition Length Table: 1LaneRamp, 2LaneUnDiv@CL
 c. Attainment Method: Crowned Roadway

 E. OK

Reversing alignment direction during creation

Video: ali-creat-frm-objct-03.mp4 1:30

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-creat-frm-objct-rvrs-dring.dwg
 C. Open

Create alignment from objects

 1. Select object to verify it is a polyline; one complete/joined object. 
 2. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Alignment 

from Objects command
 3. Select the first line/arc/polyline: Select object north end of polyline.
 4. Press enter to accept alignment direction or (R)everse:R Enter

Tip: Direction of an alignment should be west to east or south to north. 

 5. Create Alignment from Objects dialog box
 A. Name: type AliProf-All
 B. Starting station: delete what is there and type 33000
 C. General tab

 I. Site: <None>
 II. Leave Alignment style, layer, and label set as is.

 III. Conversion options: 
 a. Uncheck box Add curves between tangents

 D. OK
Station numbers should increase going south to north on the alignment.
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Reversing alignment direction after creation

Video: ali-creat-frm-objct-04.mp4 2:02

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-creat-frm-objct-rvrs-aftr.dwg
 C. Open

Correct alignment label direction

When you select the alignment, notice the stationing numbers decrease going south to north.

 1. Select alignment. 
 2. Contextual Ribbon > Modify panel dropdown > Reverse Direction
 3. Warning! dialog box: OK

Confirm station numbers are reversed.

Exercise: Create alignment from objects

Video: ali-creat-frm-objct-05.mp4 3:52

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-creat-frm-objct-exrcs.dwg
 C. Open

Cleanup and join all objects into a polyline

 1. Ribbon > Modify tab > Modify panel dropdown > Polyline Edit commandORCom-
mandline:PEEnter for polyline edit.

 2. Commandline:MEnter for multiple.
 3. Select objects: Click and drag cursor over all lines and arcs.
 4. Convert lines, arcs, and splines to polylines:YEnter
 5. Enter an option:JEnter for join.
 6. Enter to end command
 7. Select polyline to verify all are connected.
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Convert polyline to alignment

 1. Ribbon > Home tab > Modify panel dropdown > Create Alignment from Objects com-
mand

 2. Select the first line/arc/polyline: Select south end of polyline, forcing dir-
ection/path to go north.

 3. Press Enter to accept alignment direction or (R)everse:Enter
 4. Create Alignment from Objects dialog box

 A. Name: type AliProf-All
 B. Starting station: delete what is there and type 33000
 C. General tab

 I. Site: <None>
 II. Leave Alignment style, layer, and label set as is.

 III. Conversion options: 
 a. Check box Add curves between tangents
 b. Default radius: 2865
 c. Check box Erase existing entities

 D. Design Criteria tab
 I. Starting design speed: 45m/h

 II. Check box Use criteria-based design
 III. Check box Use design criteria file
 IV. ...

 a. Look in: browse to Local Drive:\ProgramData\Autodesk\C3D 
20xx\enu\Data\Corridor Design Standards\Imperial

 b. Select file _WisDot Design Criteria 2009.xml 
 c. Open

 E. Default criteria
 I. Minimum Radius Table: WisDOT eMax 4%

 II. Transition Length Table: 1LaneRamp, 2LaneUnDiv@CL
 III. Attainment Method: Crowned Roadway

 F. OK
Polyline is converted to an alignment. Curve is added to north end of alignment.

Alignment from existing alignment
Last updated: 2022-11-01

Total video time: 6:32

Create alignment from an existing alignment using alignment stations

Exercise file: ali-data-C3D22.zip

Video: ali-frm-exst-ali-01.mp4 2:16
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Create alignment using alignment stations

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Alignment 
from Existing Alignment

 2. Select an alignment:Hover over alignment > left-click > Selection Cycling dialog 
box > select Alignment

Tip: To toggle selection cycling, press Ctrl + W.

 3. Specify split point on alignment or [(E)ntities (F)inish]:40245Enter
 4. Specify next point or (S)tation (F)inish:34325Enter
 5. Specify next point or (S)tation (F)inish:FEnter
 6. Create Alignment from Existing Alignment dialog box

 A. Name: type AliProf-All-Alt1
 B. Leave all other settings as is.
 C. OK

Check if new alignment exists

 1. Hover over alignment > left-click > Selection Cycling dialog box
 2. See if new alignment is in the list.
 3. ESC to close

Add design to new alignment

Video: ali-frm-exst-ali-02.mp4 2:16

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Add new data design information to alignment

This method is best used to create a diversion, an alternate, from the original alignment.
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 1. Zoom to the center of the alignment, between the two curves.
 2. Hover over alignment > left-click > Selection Cycling dialog box > select new Alignment 

(top of the list, when selected should highlight the tangent between the two curves.)
 3. Ribbon > Modify panel > Geometry EditorORRight-click menu > Edit Alignment Geo-

metry...
 4. Alignment Layout Tools toolbar > Line tool dropdown > Fixed Line (Two points)
 5. Specify start point: Left-click along, but not on, the alignment.
 6. Specify next point: Left-click another point heading north-east from start point.
 7. Alignment Layout Tools toolbar > Curve tool dropdown > Free Curve Fillet (Between 

two entities, through point)
 8. Specify first entity:Hover over alignment > left-click > Selection Cycling dialog 

box > select Alignment (tangent between two curves)
 9. Select next entity: Left-click newly created tangent

 10. Specify a through point: Move cursor between tangents until an appropriate arc is dis-
played. Left-click to accept.

 11. Right-click to end command.
 12. X to close Alignment Layout Tools toolbar

Create alignment from an existing alignment using alignment entities

Video: ali-frm-exst-ali-03.mp4 2:00

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Create alignment using alignment entities

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Alignment 
from Existing Alignment

 2. Select an alignment:Hover over alignment > left-click > Selection Cycling dialog 
box > select Alignment

 3. Specify split point on alignment or [(E)ntities (F)inish]:EEnter
 4. Specify alignment entities or (S)tation (F)inish:Hover over alignment > 

left-click > Selection Cycling dialog box > select Alignment
 5. Specify alignment entities or (S)tation (F)inish:Hover over curve south 

of tangent > left-click > Selection Cycling dialog box > Left-click on alignment
 6. Specify alignment entities or (S)tation (F)inish:FEnter
 7. Create Alignment from Existing Alignment dialog box

 A. Name: type AliProf-All-Alt2
 B. Leave all other settings as is.
 C. OK
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Check if new alignment exists

 1. Hover over alignment > left-click > Selection Cycling dialog box
 2. See if new alignment is in the list.
 3. ESC to close

Floating curves in alignments
Last updated: 2023-05-02

Total video time: 5:44

ali-float-crv-01.mp4 5:44

Floating curve

Description of each curve type

In each description, the curve is attached to a fixed line segment.

 l Fixed curve: When the vertex  is selected and moved, the point between the curve and line 
segment, the tangency is not maintained. 

 l Free curve: When the vertex, or pass-through point, is selected and moved, the tangency is 
maintained but the curve's radius and length change.

 l Floating curve: When the vertex  is selected and moved, curve moves with the line and tan-
gency is maintained with no change to the curve's radius or length.

Info: Floating curves are not used often in WisDOT projects because maintaining tangency 
between straight line segments is easier to do using free curves. Floating curves are generally 
created for reverse curves or compound curves off an existing alignment.

Add a floating curve, to north end of project

 1. Open drawing file
 A. Quick Access > Open
 B. Select File dialog box

 I. Look in: ...c3d\12345678\dsgn\aliprof
 II. Select file AliProf-25-Best-Fit.dwg

 III. Open
 2. Select alignment STH25-Best-Fit
 3. Contextual ribbon > Modify panel > select Geometry Editor

Tip: Or you could right-click the alignment and select Edit Alignment Geometry...

 4. Alignment Layout Tools toolbar
 A. Curves dropdown > More Floating Curves fly-out menu > select Floating Curve 

(From entity end, radius, length)
 5. Select entity to attach to: select alignment STH25-Best-Fit
 6. Specify curve direction [Clockwise 
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 7. cOunterclockwise]: Clockwise
 8. Specify radius or [Degree of curvature]: type 2500 Enter
 9. Specify curve length or [deltaAngle Tanlen Chordlen widOrd]: type 

1056.87 Enter

Alignment editing
Last updated: 2022-11-01

Total video time: 12:23

Alignment grip-point editing

Exercise file: ali-data-C3D22.zip

Video: ali-edit-01.mp4 1:56

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Zoom to north end of alignment, north end to first curve.

Selection Cycling

If the cursor displays a double box icon this means the cursor pick box is over more than one object.

 1. Hover over alignment, double boxes appear > left-click > Selection Cycling dialog box > 
select Alignment

Grip point editing

 1. Left-click end grip point, furthest north, and drag left or right will change the alignment's bear-
ing. Left-click to release.

 2. Left-click next grip point down and drag left or right will move the line segment while main-
taining its bearing. Left-click to release.
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 3. Left-click circular grip point, top of curve (or the bottom) will symmetrical change the length of 
the curve. Left-click to release.

 4. Left-click the middle circular grip point, of the curve, and drag left or right will change the 
curve's radius. Left-click to release.

 5. Left-click the middle triangle, perpendicular to the curve, and drag left or right will change the 
curve's radius and length at the same time. Left-click to release.

 6. Left-click the point-of-intersection, triangle pointing north, moving it will change the bearing 
of both incoming and outgoing tangents.

Editing parameter constraint in the data grid

Video: ali-edit-02.mp4 3:19

 1. Open drawing file
 A. Quick Access > Open
 B. Open File dialog box

 I. Look in: browse to folder dataset is saved.
 II. Select AliProf-All.dwg

 III. Open
 2. Zoom to north end of alignment, north end to first curve.
 3. Hover over alignment > left-click > Selection Cycling dialog box > select Alignment

Data grid editing functions

 1. Contextual ribbon > Modify panel > Geometry EditorORRight-click menu > Edit Align-
ment Geometry...

 2. Alignment Layout Tools toolbar > Alignment Grid View tool
 3. In Panorama

 A. Select Entity No. 5
 I. Tangency Constraint: Constrained by Previous (Floating)

 B. Select Entity No. 4
 I. Parameter Constraint Lock: Unlock

 II. Parameter Constraint: Radius and Length
 C. X to close

 4. Left-click alignment > Selection Cycling dialog box > select Alignment
 5. Left-click diamond grip point, at the end of curve, and drag south & west. This will change the 

curve's radius and length. Left-click to release.
 6. Left-click on square grip floating right side of alignment. This is tied to the original alignment's 

location when first created. Move it and notice how the editing has changed due to the para-
meter constraint lock. Left-click to release.
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 7. Alignment Layout Tools toolbar > Alignment Grid View tool

 8. In Panorama
 A. Select Entity No. 4

 I. Parameter Constraint Lock: Lock
 B. X to close

 9. Alignment Layout Tools toolbar > Pick Sub-entity tool
 10. Pan to south end of alignment and select curve
 11. Left-click > Selection Cycling dialog box > select Alignment
 12. Alignment Layout Parameters dialog box

 A. Geometry
 I. Radius value: 2685Enter

 B. X to close dialog box
 13. X to close toolbar

Change alignment direction and add length

Video: ali-edit-03.mp4 4:14

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve.dwg
 C. Open

Correct alignment direction

Alignment stationing is on the wrong side of the alignment and numbering is in the wrong direction, 
north to south. 

Info: Direction of an alignment should be west to east or south to north.

 1. Left-click on the alignment
 2. Contextual ribbon > Modify panel dropdown > Reverse direction
 3. Warning dialog box > OK
 4. Keep alignment active and continue.
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Lengthening alignment west end

The length will be added to the start point, on west end of the alignment.

 1. Contextual ribbon > Modify panel > Geometry Editor
 2. Alignment Layout Tools toolbar > Tangent-Tangent tool dropdown > Tangent-Tangent 

(No curve)
 3. Specify start point: Select any point beyond (west of) the alignment's start point.
 4. Specify next point:Shift + right-click > Endpoint OSnap > Left-click alignment start 

point
 5. Right-click to accept. 

Establish new start point

The new line segment added has a negative station number because it was added on to the start 
point, 0+00, going west.

 1. Left-click on the alignment
 2. Contextual ribbon > Modify panel > Alignment Properties
 3. Alignment Properties dialog box

 A. Notice in station information, start station has a negative number.
 B. Station Control tab > Reference point box > select Pick reference point icon, 

next to Y coordinate.
 C. Warning dialog box > OK
 D. Select alignment reference point location:Shift + right-click > End-

point OSnap > Left-click alignment new start point
 E. Notice in station information, start station has changed to 0+00.
 F. OK to accept

Lengthening alignment east end

The length will be added to the end point, on east end of the alignment.

 1. Alignment Layout Tools toolbar > Tangent-Tangent tool dropdown > Tangent-Tangent 
(No curve)

 2. Specify start point:Shift + right-click > Endpoint OSnap > Left-click alignment end 
point

 3. Specify next point: Select any point beyond (east of) the alignment's end point.
 4. Right-click to accept.

Endpoint stationing continues in sequence.

Troubleshooting gaps

Video: ali-edit-04.mp4 2:54
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve.dwg
 C. Open

Zoom to east end of the alignment. The end segment is missing labeling, numbering is in the wrong 
direction and needs a curve.

Change line segment direction

 1. Left-click the alignment
 2. Contextual ribbon > Modify panel > Geometry Editor OR Right-click menu > Edit Align-

ment Geometry...
 3. Alignment Layout Tools toolbar > Reverse Sub-entity Direction tool
 4. Left-click end line segment
 5. Right-click to accept.

Add curve

 1. Alignment Layout Tools toolbar > Curve tool dropdown > Free Curve Fillet (Between 
two entities, radius)

 2. Select first entity: Left-click on incoming line segment, the line before the end line 
segment

 3. Select next entity: Left-click end line segment
 4. Is curve solution angle (G)reaterthen180 (L)essthan180:LEnter
 5. Specify radius:90Enter

Edit curve to include 90' radius

 1. Alignment Layout Tools toolbar > Delete Sub-entity tool
 2. Left-click on curve between stations 5+00 and 6+00.
 3. Right-click to accept
 4. Alignment Layout Tools toolbar > Curve tool dropdown > Free Curve Fillet (Between 

two entities, radius)
 5. Select first entity: Left-click on incoming line segment, west of break
 6. Select next entity: Left-click outgoing line segment, east of break
 7. Is curve solution angle (G)reaterthen180 (L)essthan180:LEnter
 8. Specify radius:90Enter

Alignment properties
Last updated: 2022-11-01

Total video time: 19:29

Reference point control
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Exercise file: ali-data-C3D22.zip

Video: ali-prprtis-01.mp4 2:46

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-prprtis-01.dwg
 C. Open

Move reference point

 1. Left-click Alignment STH25
 2. Hover over Alignment STH25, double boxes appear > left-click > Selection 

Cycling dialog box > select Alignment

 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Station Control tab > Reference point
 I. Select Pick Reference Point icon

 II. Warning dialog box > OK
 III. Shift + right-click > OSnap Apparent Intersect > Left-click cross point of 

Alignment 25 and Alignment 4th Ave.
 B. OK

 5. ECS to end command

Change reference point station number

 1. Left-click Alignment 25
 2. Hover over Alignment 25, double boxes appear > left-click > Selection Cyc-

ling dialog box > select Alignment

 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Station Control tab > Reference point
 I. Station: type 10000

 B. OK
 I. Warning dialog box > OK

 C. OK
 5. ESC to end command

Station equation

Video: ali-prprtis-02.mp4 2:50
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-prprtis-02.dwg
 C. Open

Add station equation

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Station Control tab > Station equations
 I. Select Add station equation icon

 II. Warning dialog box > OK
 B. Specify station along baseline: type 42759.12Enter
 C. Station Control tab > Station equations

 I. Station Ahead: type 42800
 II. Warning dialog box > OK

 D. OK
 5. ESC to end command

Remove station equation

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Station Control tab > Station equations
 I. Select Equation 1

 II. Select Delete station equation icon
 III. Warning dialog box > OK

 B. OK
 5. ESC to end command

Masking

Video: ali-prprtis-03.mp4 3:15
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-prprtis-02.dwg
 C. Open

Add masking region

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Masking tab > Masking regions
 I. Select Add masking region icon

 II. Specify first station for masking region: type 42325Enter
 III. Specify second for masking region: type 45535Enter

Info: In the Masking regions area, of the Alignment Properties dialog box, 
the green check mark under Mask indicates the region between the start 
and end stations is masked. The locks for start and end stations act as 
anchor points for the mask region, in case the alignment changes.

 B. OK
 5. ESC to end command

Remove masked region

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Masking tab > Masking regions
 I. Select Region 1 

 II. Select Delete masking region icon
 B. OK

 5. ESC to end command

Point of intersection and constraint editing settings

Video: ali-prprtis-04.mp4 3:20
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Two types of Point of intersection

 l Explicit PI - The point at which two fixed tangents meet on a horizontal alignment, and can be 
labeled, moved, deleted, or broken apart.

 l Implied PI - The computed PI at an alignment curve or curve group. The implied PI indicates 
where tangents would meet if they were extended outward. They can be labeled.

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4th-Ave.dwg
 C. Open

Point of Intersection settings

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Point of Intersection tab
 I. Select radial button By individual curves and curve group

 B. OK
 5. Zoom to south curve, see PI displayed.

 o Point of Curve is the beginning of curve.
 o Point of Tangent is the end of curve.
 o Implied PI is found in between with a gray triangle grip point.

 6. Hover over gray triangle grip point to display Solve PI.
 7. Left-click gray triangle grip point.
 8. Grip point color changed to cyan. It is now an Explicit PI. It has the option to Move PI or Break-

apart PI.
 9. ESC to end command

Constraint editing settings

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Constraint Editing tab 
 I. Check box Lock all parameter constraints

 II. Check box Always perform implied tangency constraint swapping
 III. OK

 5. ESC to end command

Design speed
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Video: ali-prprtis-05.mp4 3:35

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-prprtis-02.dwg
 C. Open

Add design speeds

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Design Criteria tab > Design Speeds
 I. Select Add design speed icon

 II. The table populates with an entry.
 III. Change Design Speed to 45 mi/h
 IV. Select Add design speed icon
 V. The table populates with a new entry.

Info: When adding design speeds, the new entry will populate at the top 
of the table, using the design speed of the last entry.

 VI. In Entry 2, select Start Station. A Pick from Screen icon appears, left-click it.
 VII. Specify station along baseline:43775Enter

 VIII. Change Design Speed to 30 mi/h
 IX. Select Add design speed icon
 X. The table populates with a new entry.

 XI. In Entry 1, highlight Start Station and type 46675
 XII. Click somewhere outside that box. The table will auto-sort itself, Changing the 

first entry to be the lowest Start Station number. Entry 1 is now Entry 3.
 XIII. In Entry 3, change Design speed to 45 mi/h

 B. OK
 5. ESC to end command

Remove design speed

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
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 4. Alignment Properties dialog box
 A. Design Criteria tab > Design Speeds

 I. Select Entry 3
 II. Select Delete design speed icon

 III. Select Entry 2
 IV. Select Delete design speed icon

 B. OK
 5. ESC to end command

Criteria-based design

Video: ali-prprtis-06.mp4 3:40

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-prprtis-02.dwg
 C. Open

Adding WisDOT criteria-based design data

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Design Criteria tab
 I. Design Speeds box

 a. Select Add design speed icon
 b. The table populates with an entry.
 c. Change Design Speed to 45 mi/h

 II. Check box Use criteria-based design
 III. Check box Use design criteria file
 IV. Select ...

 a. Select Design Speed Table dialog box
 i. Look in: dropdown, browse to C:\ProgramData\Autodesk\C3D 

2020\enu\Data\Corridor Design Standards\Imperial
 ii. File name: select WisDOT Design Criteria 2009.xml
 iii. Open

 V. Default criteria box
 a. Minimum Radius Table > WisDOT eMax 4%
 b. Transition Length Table > 3LaneTWLWL@CL
 c. Attainment Method > Crowned Roadway

 VI. Check box Check for tangency between elements
 B. OK
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 5. ESC to end command

Offset alignments and widenings
Last updated: 2022-11-01

Total video time: 36:22

Introduction to offset alignments and widening

Exercise file: ali-data-C3D22.zip

Video: ali-offst-widen-00.mp4 2:36

A roadway design consists of 3 main elements; alignment, profile, and cross-section. When com-
bined, provides a 3D layout of the roadway.

 l Alignment is the route of the road, defined by horizontal tangents and curves.
 l Profile is the vertical aspect of the road.
 l Cross-section shows the precision and number of lanes and sidewalks, cross slopes or banks, 

drainage features, and pavement structures.
 

Offset alignment function helps place identify the lanes, sidewalks, and other geometric physical ele-
ments of the road horizontally. Offset alignments are dynamically linked to a parent alignment and 
dependent on their geometry. Usually it is the centerline of the road. The offset alignment function is 
perfect for defining linear geometry as the roadway evolves.

Widening regions can be placed along the geometry of the offset alignments and useful for creating 
bus bays, medians, turn lanes, shoulders, and parking lanes. Offset widening should not be a neg-
ative offset value.

Creating offset alignments from parent alignment

Video: ali-offst-widen-01.mp4 5:37

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Create offset alignment

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Offset Align-
ment
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 2. Select an alignment:Right-click > Select Alignment dialog box > select alignment 
25 OK

Tip: When there are more than one alignment, right-click and select the alignment from 
the list in the Select Alignment dialog box.

 3. Create Offset Alignments dialog box
These settings are based off the parent alignment. We will keep most as is, but they can be 
edited.

 A. Incremental offset on left: type 12
 B. Incremental offset on right: type12
 C. General tab > Alignment style: dropdown and select RDWY Shoulder Paved
 D. General tab > Alignment label set: dropdown and select _No Labels
 E. OK

 4. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Offset Align-
ment

 5. Select an alignment:Right-click > Select Alignment dialog box > select alignment 
25 OK

 6. Create Offset Alignment dialog box
 A. Incremental offset on left: type 15
 B. Incremental offset on right: type 15
 C. General tab > Alignment style: dropdown and select RDWY Pavement Edge
 D. General tab > Alignment label set: dropdown and select_No Labels
 E. OK

 7. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Offset Align-
ment

 8. Select an alignment:Right-click > Select Alignment dialog box > select alignment 
25 OK

 9. Create Offset Alignment dialog box
 A. Incremental offset on left: type 25
 B. Incremental offset on right: type 25
 C. General tab > Alignment style: dropdown and select RDWY Shoulder Aggregate
 D. General tab > Alignment label set: dropdown and select _No Labels
 E. OK

The drawing now contains alignment 25 and offset alignments with object styles. If the parent align-
ment changes, the offset alignments are dynamically linked and will move along maintaining their 
offset values.

Cleanup offset alignment names

Video: ali-offst-widen-02.mp4 8:46
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-offst-widen-02.dwg
 C. Open

Viewing alignments and offset alignments in Toolspace

 1. Toolspace > Prospector tab
In Master View, Open Drawings should be expanded and list all drawings. The drawing in bold 
font is the active drawing.

 2. Expand AliProf-All > expand Alignments > expand Centerline Alignments and Offset 
Alignments

How to open Alignment Properties dialog box

 l Left click alignment 
 l Contextual ribbon > Modify panel > Alignment Properties
 l Right-click menu > Alignment Properties...
 l Toolspace > Prospector tab > expand Alignments > expand Offset Alignment > right-

click alignment > Properties...

Renaming offset alignments

 1. Toolspace > Prospector tab > expand Alignments > expand Offset Alignment > right-
click offset alignment 25-Left-12.000 > Properties...

 2. Alignment Properties dialog box
 A. Information tab > Name: type 25-L-ETW (edge of travel way)
 B. OK

 3. Continue down the list for each offset alignment listed in Toolspace.
 4. Right-click offset alignment 25-Left-15.000 > Properties...
 5. Alignment Properties dialog box

 A. Information tab > Name: type 25-L-EPS (edge of paved shoulder)
 B. OK

 6. Right-click offset alignment 25-Left-25.000 > Properties...
 7. Alignment Properties dialog box

 A. Information tab > Name: type 25-L-EGS (edge of gravel shoulder)
 B. OK

 8. Right-click offset alignment 25-Right-12.000 > Properties...
 9. Alignment Properties dialog box

 A. Information tab > Name: type 25-R-ETW
 B. OK

 10. Right-click offset alignment 25-Right-15.000 > Properties...
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 11. Alignment Properties dialog box
 A. Information tab > Name: type 25-R-EPS
 B. OK

 12. Right-click offset alignment 25-Right-25.000 > Properties...
 13. Alignment Properties dialog box

 A. Information tab > Name: type 25-R-EGS
 B. OK

Check your work

 1. Left-click furthest left/west offset alignment
 2. Properties palette > Information

 A. Confirm Style: RDWY Shoulder Aggragate
 B. Confirm Name: 25-L-EGS

 3. ESC to end

Save drawing and close drawing

 1. Quick Access > SaveORCtrl + S
 2. Close drawing, left-click X on AliProf-All tab, at the top of Modelspace.

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve-ali-offst-widen-02.dwg
 C. Open

Renaming offset alignments

 1. Toolspace > Prospector tab > expand Alignments > expand Offset Alignment > right-
click offset alignment 4thAve-Left-12.000 > Properties...

 2. Alignment Properties dialog box
 A. Information tab > Name: type 4thAve-L-ETW
 B. OK

 3. Right-click offset alignment 4thAve-Left-18.000 > Properties...
 4. Alignment Properties dialog box

 A. Information tab > Name: type 4thAve-L-EGS
 B. OK

 5. Right-click offset alignment 4thAve-Right-12.000 > Properties...
 6. Alignment Properties dialog box

 A. Information tab > Name: type 4thAve-R-ETW
 B. OK

 7. Right-click offset alignment 4thAve-Right-15.000 > Properties...
 8. Alignment Properties dialog box

 A. Information tab > Name: type 4thAve-R-EPS
 B. OK
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Check your work

 1. Left-click furthest left/north offset alignment
 2. Properties palette > Information

 A. Confirm Style: RDWY Shoulder Aggragate
 B. Confirm Name: 4thAve-L-EGS

 3. ESC to end

Add widening to offset alignment

Video: ali-offst-widen-04.mp4 4:38

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Open Toolspace palette

The Toolspace palette helps to navigate through, gives details of what Civil3D objects exist in the 
drawing, and styles or settings that can be selected and are available. Two ways to open the 
Toolspace palette:

 l Commandline: type Toolspace
 l Ribbon > Home tab > Palettes panel > Toolspace and anchor to left or right side of the 

drawing area.

Add widening to offset alignment

Adding widening to the road allows more room to get around turns, create off ramps, turn lanes, 
and bus bays.

 1. Toolspace > Prospector tab > expand Alignments > expand Centerline and Offset Align-
ments

 2. Offset Alignments > Right-click 25-R-ETW > Add Widening...
 3. Create Widening portion as a New Alignment? [Yes/No]:YEnter
 4. Select start station:38370Enter
 5. Select end station:38462Enter
 6. Enter widening offset:22Enter
 7. Specify side [Left/Right]:REnter
 8. Offset Alignment Parameters dialog box
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Changing properties in Alignment Parameters dialog box

Zoom into widening area of the alignment to visually see the changes. The component that is chan-
ging will highlight in the drawing.

 1. Transition Parameters at Exit > Transition Length: type 1Enter
 A. Notice transition taper is gone and there's a sharp return.

 2. Transition Parameters at Entry > Transition Length: type 50Enter
 A. Notice start station changed from 383+70.00' to 383+45.00'.
 B. Notice region length increased from 92' to 117'.

 3. Widening Parameters > Start station: type 38350Enter
 A. Notice it maintained the 50' transition length, but moved the station forward and 

reduced the region length.
 4. Widening Parameters > End station: type 38367Enter

 A. Notice region length decreased.
 5. Transition Parameters at Entry > Taper Input Type: change to By Taper Ratio
 6. Transition Parameters at Entry > Taper Ratio: type 3Enter (it will assume the 1: portion)

 A. Notice widening area in the drawing, measuring 1' in length.

Adding widening areas to the EPS alignment

Video: ali-offst-widen-05.mp4 3:16

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Add widening to EPS alignment

 1. Toolspace > Prospector tab > expand Alignments > expand Centerline and Offset Align-
ments

 2. Offset Alignments > Right-click 25-R-EPS > Add Widening...
 3. Create Widening portion as a New Alignment? [Yes/No]:NEnter
 4. Select start station:Shift + right-click > Osnap Endpoint > select start station 

point of previous widening area.
 5. Select end station: Select end station point of previous widening area.
 6. Enter to end command
 7. Enter widening offset:37Enter
 8. Offset Alignment Parameters dialog box

 A. Transition Parameters at Entry > Taper Input Type: change to By Taper Ratio
 B. Transition Parameters at Entry > Taper Ratio: type 3Enter
 C. Widening Parameters > Start station: select Green Box icon - Select from Screen

 I. Shift + right-click > Osnap Endpoint > select start station point of previous 
widening area.
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 D. Transition Parameters at Exit > Transition Length: type 1Enter
 E. Select X to close Offset Alignment Parameters dialog box 

Create a masked area

Video: ali-offst-widen-06.mp4 2:38

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Add masking to offset alignment 12-R-ETW

The masking properties allows a selected area or region, along the alignment, to be masked or hid-
den. Even though the area isn't visible, the information still exists; the stationing and geometry is still 
active.

 1. Toolspace > Prospector tab > expand Alignments > expand Offset Alignments > Right-
click 12-R-ETW > Properties...

 2. Alignment Properties dialog box
 A. Masking tab > Masking regions > Add masking region icon
 B. Specify first station for masking region: type 33000Enter
 C. Specify second station for masking region:OSnap to the start point of 

the widening transition area. Enter
 3. Alignment Properties dialog box

 A. Masking tab > Masking regions > Add masking region icon
 B. Specify first station for masking region:OSnap to the end point of the 

widening transition area.
 C. Specify second station for masking region: type 48519Enter

 4. Alignment Properties dialog box
 A. OK

Adding widening areas during offset alignment creation

Video: ali-offst-widen-07.mp4 4:04

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve.dwg
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 C. Open

Create offset alignment with widening

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Offset Align-
ment

 2. Select an alignment: Left-click alignment
 3. Create Offset Alignments dialog box

 A. Alignment to offset from: 4thAve
 B. Offsets name template: Leave as is
 C. Station range: Check box From start and check box To end
 D. No. of offsets on left: 1
 E. No. of offsets on right: 0
 F. Incremental offset on left: 18
 G. General tab

 I. Site: <None>
 II. Alignment style: RDWY Lane Edge

 III. Alignment layer: P_ALI-Base
 IV. Alignment label set: _No Labels

 H. Create Offset Profile tab
 I. Check box Create profile for offset alignment

 II. Leave all other settings as is.
 I. Widening Criteria tab

 I. Check box Add widening around curves
 II. Property Widening to Apply on: Inside Only

 III. Increase in width: 4
 IV. Transition length: 50

 J. OK

Edit widening

 1. Left-click offset alignment
 2. Locate Padlock symbol, this is where widening occurs. 
 3. Left-click the padlock, this will unlock and allow edits.
 4. Contextual ribbon > Modify panel > Offset Parameters
 5. Offset Alignment Parameters dialog box
 6. As you select each Property type, it will highlight in the drawing. Change the values to edit the 

widening.

Edit parameters of widened offset alignment

Video: ali-offst-widen-08.mp4 2:02
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve.dwg
 C. Open

Edit widening parameters

 1. Toolspace > Prospector tab > expand Alignments > expand Offset Alignments > Right-
click 4thAve-Left-18.000 > Edit Offset Parameters...

 2. Offset Alignment Parameters dialog box
 A. Nominal Offset: 15Enter

Info: When entering a value, the placement of the offset decides if the value is 
positive or negative. Since the offset is to the left, this value will automatically be 
negative.

 B. Transition In > Transition Length: 45Enter
 C. Widening Region > Increased Width from Standard: 10Enter
 D. X to close box

Edit widening to offset alignment graphically

Video: ali-offst-widen-09.mp4 2:11

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve-ali-offst-widen-09.dwg
 C. Open

Edit widening to offset alignment

 1. Left-click the offset alignment
 2. Notice the different grip points along the parent and offset alignments.
 3. Left-click the cyan diamond grip point on the east end of alignment.

 A. Specify stretch point: slide the grip point left/west 20' OR point the grip west 
and type 20Enter

 4. Left-click the cyan diamond grip point on the west end of alignment.
 A. Specify stretch point: slide the grip point right/east 20' OR point the grip east 

and type 20Enter
 5. Left-click the cyan plus symbol to create an offset widening area.
 6. Left-click the gray circle grip in transition. Two cyan circle grips appear on either side. Left-

click and drag the cyan grips to make a tapered transition.
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 A. Notice two gray diamond grips on the parent alignment. These will also adjust to trans-
ition ends along the parent alignment.

 7. Left-click the cyan triangle grip point and drag up or down. This will change the offset distance 
of the widened area.

Alignment superelevation
Last updated: 2022-11-01

Total video time: 21:42

Check alignment properties before creating a superelevation table

Exercise file: ali-data-C3D22.zip

Video: ali-super-01.mp4 3:00

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Tip: Another option to open Open File dialog box, Use Ctrl + O.

Set alignment properties

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Design Criteria tab
 I. Design Speeds box

Info: If there isn't an entry, select Add design speed icon and the table 
will populate with an entry with default settings.

 II. Check box Use criteria-based design
 III. Check box Use design criteria file
 IV. Select ...

 a. Select Design Speed Table dialog box
 i. Look in: dropdown, browse to C:\ProgramData\Autodesk\C3D 

2020\enu\Data\Corridor Design Standards\Imperial
 ii. File name: select WisDOT Design Criteria 2009.xml
 iii. Open
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 V. Default criteria box
 a. Minimum Radius Table > WisDOT eMax 4%
 b. Transition Length Table > 2LaneUndiv@OE, 4LaneUndiv@CL, 

4LaneUndiv@ME
 c. Attainment Method > Crowned Roadway

 VI. Uncheck box Use design check set
 a. Dropdown select Standard

 VII. Check box Check for tangency between elements
 B. Apply
 C. OK

 5. ESC to end command

Warning: Superelevation cannot be applied to a Miscellaneous alignment type since design cri-
teria cannot be assigned to this type of alignment.

Using superelevation wizard

Video: ali-super-02.mp4 3:22

Continue from previous exercise.

Use superelevation wizard to create table

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Superelevation dropdown > Calculate/Edit Super-

elevation
 4. Superelevation Curve Manager dialog box

 A. Select Superelevation Wizard
 B. Calculate dialog box

 I. Calculate for: Select radial button Entire alignment
 II. OK

 C. Calculate Superelevation - Roadway Type dialog box (Wizard)
 I. Roadway Type

 a. Select radial button Undivided Crowned
 b. Pivot Method dropdown > Center Baseline
 c. Next >

 II. Lanes
 a. Check box Symmetric Roadway
 b. Normal lane width: type 14'
 c. Normal lane slope: type -2%
 d. Next >
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 III. Shoulder Control
 a. Outside edge shoulders box

 i. Check box Calculate
 ii. Normal shoulder width: type 5'
 iii. Normal shoulder slope: type -4%
 iv. Shoulder slope treatment

 i. Low side: dropdown, select Breakover removal
 ii. High side: dropdown, select Match lane slopes

 b. Next >
 IV. Attainment

 a. Design criteria file: WisDOT Design Criteria file is assigned
 b. Check box Automatically remove overlap

 D. Finish
 5. Superelevation Table panorama opens.
 6. Select green check mark (upper right corner) to close panorama.
 7. X to close Superelevation Curve Manager dialog box
 8. ESC to end command

Editing and exporting superelevation table

Video: ali-super-03.mp4 2:47

Continue from previous exercise.

Editing superelevation table

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Superelevation dropdown > View Tabular Editor
 4. Superelevation Table panorama

 A. Curve 1 > Transition In Region > Runoff > Begin Full Super
 I. Go to column Left Outside Shoulder and change value to 2.75%Enter

 B. Curve 1 > Transition Out Region > Runoff > End Full Super
 I. Go to column Left Outside Shoulder and change value to to 2.75%Enter

Export superelevation table

In the Superelevation Table panorama, there are two icons in the top row with blue arrows. One is 
for import, the other is for export.

 1. Select Export superelevation table icon
 2. Export to CSV dialog box

 A. Save in: Project folder
 B. File Name: type 12345678-Super-AliProf
 C. File type: CSV
 D. Save
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Select green check mark (upper right corner) to close panorama.

X to close Superelevation Curve Manager dialog box

ESC to end command

Create superelevation view

Video: ali-super-04.mp4 2:20

Continue from previous exercise.

Create superelevation view

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Superelevation dropdown > Create Superelevation 

View
 4. Create Superelevation View dialog box

 A. Specify superelevation display options:
 I. Left Outside Lane > Display, check box > Color, change to RedOK

 II. Right Outside Lane > Display, check box > Color, change to GreenOK
 III. Left Outside Shoulder > Display, uncheck box  
 IV. Right Outside Shoulder > Display, uncheck box  
 V. OK

 5. Select superelevation view origin: Left-click anywhere to the right of alignment.
 6. Zoom in on the superelevation.
 7. Left-click on either red or green line. Diamond grip points appear for editing, if required.

Build an assembly that uses subassemblies that superelevate

Video: ali-super-05.mp4 3:28

Continue from previous exercise.

Build an assembly

 1. Ribbon > Home tab > Create Design panel > Assembly dropdown > Create Assembly
 2. Create Assembly dialog box

 A. Name: Main Road
 B. Leave all other settings as is.
 C. OK

 3. Specify assembly baseline location: Left-click to the right of the alignment.
 4. Once placed, it will zoom into itself.
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Build subassemblies

 1. Open Tool palette
 2. Ribbon > Home tab > Palettes panel > Tool Palettes icon
 3. Select palette and drag to left to anchor.
 4. Open Properties palette
 5. Ribbon > Home tab > Palettes panel > Properties icon
 6. Select palette and drag to right to anchor.
 7. Tool palette > Roadway tab > select LnExtendBase
 8. Properties palette > Design tab > Advanced > Parameters

 A. Lane width: change to 14'
 B. Superelevation type: Use outside lane SE
 C. Subgrade superelevation method: Use outside lane SE

 9. Left-click on the right side of the assembly, the right side lane subassembly will drop in.
 10. Left-click on the left side of the assembly, the left side lane subassembly will drop in with 

identical properties set.
 11. Right-click and end command.

Open superelevation table for editing

Video: ali-super-06.mp4 2:49

Continue from previous exercise.

Open superelevation curve manager to edit

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > 

select Alignment
 3. Contextual ribbon > Modify panel > Superelevation dropdown > Calculate/Edit Super-

elevation
 4. Superelevation Curve Manager dialog box

 A. Superelevation status: displays *Calculated*
 B. Superelevation Curve: dropdown, select Curve 2

Info: The <<Previous and Next>> buttons can be used to select a curve within 
the alignment. The curve selected will be highlighted in the drawing.

 C. Superelevation Curve Details > Design Speed > Left-click in field to edit
 I. Alignment Properties - Design Speed dialog box

 a. Number 1 > Design Speed, change to 35 m/h
 b. OK

 D. Superelevation Criteria > Normal Shoulder Width, change to 6'

 E. Superelevation status: displays warning, *Out of Date*
 F. Left-click Recalculate

 I. Superelevation - Manual Edits Found dialog box
 a. Left-click Continue to recalculate

 G. Superelevation status: displays *Calculated*
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 5. X to close Superelevation Curve Manager dialog box
 6. ESC to end command

Adding superelevation to a tangent-only alignment

Video: ali-super-07.mp4 3:56

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-super-07.dwg
 C. Open

Open superelevation curve manager to add data

 1. Left-click alignment
 2. Contextual ribbon > Modify panel > Superelevation dropdown > Calculate/Edit Super-

elevation
 A. Edit Superelevation - No Data Exists dialog box

 I. Left-click Open the superelevation curve manager
 3. Superelevation Curve Manager dialog box

 A. Left-click Create user-defined curve icon
 I. Select entities to create a user-defined curve: Left-click align-

ment
 II. Select another entity or press Enter to finish:Enter

 B. X to close Superelevation Curve Manager dialog box
 4. Left-click alignment
 5. Contextual ribbon > Modify panel > Superelevation dropdown > View Tabular Editor
 6. Superelevation Table panorama

 A. Left-click User-Defined 1
 B. Left-click Add a superelevation critical station icon (plus sign)

 I. Specify station along baseline:2085Enter
 C. Left-click Add a superelevation critical station  icon

 I. Specify station along baseline:2188Enter
 D. Left-click Add a superelevation critical station  icon

 I. Specify station along baseline:2300Enter
 E. Left-click Add a superelevation critical station  icon

 I. Specify station along baseline:2430Enter
 F. Transition In Region > select name Manual station and rename to Begin Slope 

Change
 G. Transition In Region > select name Manual station(2) and rename to Begin Full Slope 

Change
 H. Transition Out Region > select name Manual station and rename to End Full Slope 

Change
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 I. Transition Out Region > select name Manual station(2) and rename to End Slope 
Change

 J. Transition In Region > Begin Slope Change > Left Outside Shoulder, type -2%
 K. Transition In Region > Begin Full Slope Change > Left Outside Shoulder, type -3.62%
 L. Transition In Region > End Full Slope Change > Left Outside Shoulder, type -3.7%

 M. Transition In Region > End Slope Change > Left Outside Shoulder, type -2%
 N. Select green check mark (upper right corner) to close panorama.

Calculate superelevation correctly for WisDOT standards 
and subassemblies
Last updated: 2023-05-02

Dataset: ali-calc-supr-for-wisdot-c3d22.zip

ali-calc-supr-for-wisdot-01.mp4 7:00

 1. Before you begin calculating superelevations
 A. Review WisDOT Standard FDM-11-10 5.3 Superelevations 
 B. Use the WisDOT Design Criteria files

 I. Select alignment 25
 II. Contextual ribbon > Modify panel > select Alignment Properties

 III. Alignment Properties dialog box
 a. Design Criteria tab

 i. Use design criteria file > ... (ellipse) to browse
 i. Check box next to _WisDOT Design Criteria 2009.xml
 ii. Open

 2. Apply superelevation to alignment
 A. Select alignment 25
 B. Contextual ribbon > Modify panel > Superelevation dropdown > select Cal-

culate/Edit Superelevation
 C. Edit Superelevation - No Data Exists dialog box

 I. Message: The alignment does not contain superelevation data. What would you 
like to do? Select Open the superelevation curve manager

 D. Superelevation Curve Manager palette
 I. Select Superelevation Wizard

 II. Calculate dialog box
 a. Radio selected: Entire alignment
 b. OK

 III. Calculate Superelevation - Roadway Type dialog box
 a. Roadway Type

 i. Radio selected: Undivided Crowned
 ii. Pivot Method: Center Baseline
 iii. Next >

 b. Lanes
 i. Check box: Symmetric Roadway
 ii. Number of lanes right: 2
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 iii. Next >
 c. Shoulder Control

 i. Outside edge shoulders
 i. Check box Calculate
 ii. Normal shoulder width: 6.000'
 iii. Normal shoulder slope: -4.00%
 iv. Shoulder slope treatment

 i. Low side: Breakover removal
 ii. High side: Match lane slopes

 ii. Next > 
 d. Attainment

 i. Design criteria file: ... (ellipse) to browse
 ii. Open dialog box

 i. Select _WisDOT Design Criteria 2009.xml
 ii. Open

 iii. Finish
 E. Superelevation Tubular Editor panorama

 I. Look for End Normal Shoulder and End Normal Crown, Begin Normal Crown 
and Begin Normal Shoulder

 II. Notice that the shoulder and lane transitions start and end at the same point.
 III. Also notice that the start and end station's slopes are different.

 a. To match the slopes, use WisDOT Alignment Superelevation Runout tool
 b. Ribbon > WisDOT Design tab > Design panel > Alignment dropdown 

> Alignment - Adjust Superelevation Runout
 c. Alignment Superelevation Runout dialog box

 i. Alignments with Superevlevation: select 25
 ii. OK

 F. Return to Superelevation Tubular Editor panorama
 I. Slopes should match

 3. Create superelevation view
 A. Select alignment 25
 B. Contextual ribbon > Modify panel > Superelevation dropdown > select Create 

Superelevation View
 C. Create Superelevation View dialog box

 I. Specify superelevation display options:
 a. Go through the list and change each lane color, making each a different 

color.
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 II. OK
 D. Select superelevation view origin: Select a place outside of the project 

area.

Info: If there are warning symbols in the superelevation view, this means the 
transitions for the shoulders exceed what Civil 3D has built into the standards, 
but for our example they are correct. 

 4. Save file when finished.

Alignment from best fit
Last updated: 2022-11-01

ali-data-c3d22.zip

Create Fixed Line – Best Fit entity
 1. Open AliProf-All.dwg
 2. Home tab > Create Design panel > Alignment drop-down > Alignment Creation Tools 
 3. Alignment Layout toolbar > Line drop-down > Fixed Line - Best Fit
 4. From the Tangent by Best Fit dialog select From COGO points
 5. OK
 6. Select the south-most grouping of points, and the one point just north of that group.
 7. Right-click > Enter 
 8. Review the Regression Graph and click the green check mark in the upper right corner to 

close it and create the alignment.
 9. Click Save.

Create Floating Curve – Best Fit entities
 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
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 3. Select the Geometry Editor
 4. Alignment Layout toolbar > Curve drop-down > Floating curve - Best Fit
 5. When prompted at the command line to select the entity to attach to select, graphically select 

the tangent alignment entity at the south of the project.
 6. In the Curve by Best Fit dialog select the From COGO Points option 
 7. OK
 8. Graphically select the points that are grouped in the lower part of the southern curve.
 9. Right-click > Enter

 10. In the Regression Graph scroll to the bottom and turn on the Pass Through option for the 
last point.

 11. Click the green check mark in the upper right corner to close it and create the alignment.
 12. Zoom into the curve that was just created and graphically select it.
 13. Select the circular grip point at the mid-point of the curve. Drag the grip point back to be in 

line with the COGO point objects.

Create compound curve with Floating Curve – Best Fit
 1. Alignment Layout toolbar > Curve drop-down > Floating curve - Best Fit
 2. When prompted at the command line to select the entity to attach to select, graphically select 

the curve alignment entity that was just created.
 3. In the Curve by Best Fit dialog select the From COGO Points option 
 4. OK
 5. Graphically select the points that are grouped in the upper part of the southern curve.
 6. Right-click > Enter
 7. In the Regression Graph scroll to the bottom and turn on the Pass Through option for the 

last point.
 8. Click the green check mark in the upper right corner to close it and create the alignment.
 9. Save

Create Fixed Curve – Best Fit
 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
 3. Select the Geometry Editor
 4. Alignment Layout toolbar > Curve drop-down > Fixed curve - Best Fit
 5. In the Curve by Best Fit dialog select the From COGO Points option 
 6. OK
 7. Graphically select the points that are grouped in the lower part of the northern curve.
 8. Right-click > Enter
 9. In the Regression Graph scroll to the bottom and turn on the Pass Through option for the 

last point.
 10. Click the green check mark in the upper right corner to close it and create the alignment

Create best fit alignment from survey points
Last updated: 2023-05-02
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Total video time: 7:00

Dataset: ali-creat-best-fit-frm-pnt-c3d22.zip

ali-creat-best-fit-frm-pnt-01.mp4 7:00

Alignment creation by best fit from survey points
 1. Open template

 A. Quick Access > New
 B. Select template dialog box

 I. Look in: ...\Begin-dwg
 II. Select file design-start.dwt

 III. Open
 2. Populate existing roadways points for STH25

 A. Toolspace > Survey tab > right-click Survey Databases > select set working 
folder...

 B. Set Working Folder dialog box
 I. Browse to: C:\WisDOT\Design\c3d\12345678\base\srvy

 II. Select Folder
 C. Toolspace > Survey tab > expand Survey Databases > right-click SD12345678 > 

select Open for edit
 D. Toolspace > Survey tab > Survey Databases > SD12345678 > expand Survey Quer-

ies > right-click Centerlines > select Insert into drawing
 3. Save drawing

 A. Quick Access > Save As
 B. Save Drawing As dialog box

 I. Save in: ...c3d\12345678\dsgn\aliprof
 II. File Name: type AliProf-25-Best-Fit

 III. Save
 4. Create alignment, starting at south end of project 

 A. Ribbon > Home tab > Create Design panel > Alignment dropdown > select Align-
ment Creation Tools

 B. Create Alignment - Layout dialog box
 I. Name: type STH25-Best-Fit

 II. Accept defaults
 III. OK

 C. Alignment Layout Tools toolbar
 I. Line dropdown > select Fixed Line - Best Fit

 D. Tangent by Best Fit dialog box
 I. Radio selected From COGO points

 II. OK
 E. Select point objects or [Numbers Groups]: Using crossing window select, 

select the points that include the straight line before the curve.
 F. Enter 
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 G. Regression Data panorama opens
 I. Select green check mark to accept

 H. New line segment is created
 5. Create alignment, middle section of project

 A. Alignment Layout Tools toolbar
 I. Line dropdown > select Fixed Line - Best Fit

 B. Tangent by Best Fit dialog box
 I. Radio selected From COGO points

 II. OK
 C. Select point objects or [Numbers Groups]: Using crossing window select, 

select the points that are between the two curves.
 D. Enter
 E. Regression Data panorama opens

 I. Select green check mark to accept
 F. New line segment is created

 6. Create curve, between the two line segments
 A. Alignment Layout Tools toolbar

 I. Curve dropdown > select Free Line - Best Fit
 B. Select first entity: Select first alignment, and using selection cycling, select 

Alignment
 C. Select next entity: Select second alignment (up station)
 D. Curve by Best Fit dialog box

 I. Radio selected From COGO points
 II. OK

 E. Select point objects or [Numbers Groups]: Using crossing window select, 
select the points that are between the two curves.

 F. Enter
 G. Regression Data panorama opens

 I. Select green check mark to accept
 H. New curve is created

Tip: If the curve needs adjusting, use the triangle grip at curve's PI to move the 
curve. Because it is a free curve, tangency is maintained.

Intersection edgeline geometry creation
Last updated: 2023-05-17

Total video time: 25:28

Insert south intersection dynamic block

Exercise files: ali-int-edglin-geom-creat-01-data-C3D16.zip

ali-int-edglin-geom-creat-01.mp4 3:18
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 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Layer panel> Layer Properties 
 3. New Layer 

 4. Name new Layer P_Int_Block_NPLT
 5. Mark the Plot Column. 
 6. Close the Layer Manager box.
 7. Open the WisDOT Design tab.
 8. Palettes ON/OFF

 9. Parametric Design panel > Intersection Blocks

Tip: Refer to SDD 9a1: At-Grade Side Road Intersections for type A, B1, B2, C, and D.

 10. Int-Type-B-Tan

 11. Hover near where the south-main road alignment crosses the center line of the secondary 
road. 

 A. Shift + right-click > Apparent Intersect 
 I. Snap to that point. 

Adjust south intersection dynamic block

Exercise files: ali-int-edglin-geom-creat-02-data-C3D16.zip

ali-int-edglin-geom-creat-02.mp4 2:39

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Select on the block.
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 3. Hover over dark blue origin grip point, left-click.

 A. Right-click > Rotate
 I. Shift + right-click > Nearest

 II. Snap to the edge of roadway.
 4. Left click the blue directional arrow. 

 A. Shift + right-click > Nearest
 B. Snap to the center-line of the secondary road.
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 5. Select block.
 A. Right-click > Properties

 I. Scroll to Custom field.
 II. SRLaneWidth = 10

 III. W = 15

 6. Close the Palette. 

Insert north intersection dynamic block and make adjustments

Exercise files: ali-int-edglin-geom-creat-03-data-C3D16.zip

ali-int-edglin-geom-creat-03.mp4 1:39

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Intersection Layout palette > Int-Type-B-Tan

 3. Shift+ right click > Apparent Intersect
 A. Snap to north edge lane.

 4. Select on the block. 
 A. Left-click in grip edit.
 B. Right-click > Rotate
 C. Shift + right-click > Nearest
 D. Snap to west-side of line. 
 E. Left click the blue directional arrow.
 F. Shift + right-click > Nearest
 G. Snap to the center-line of the secondary road.

 5. Select block.
 A. Right-click > Properties
 B. Scroll to Custom field.
 C. SRLaneWidth = 10
 D. W = 15

 6. Esc
 7. Select blocks.
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 8. Home tab > Layer panel > Layer Manager pull-down menu
 A. Select the P_Int_Block_NPLT layer

Create curb and gutter edge lines for NW and NE quadrants

Exercise files: ali-int-edglin-geom-creat-04-data-C3D16.zip

ali-int-edglin-geom-creat-04.mp4 2:58

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to Int-CthE-RiverRd-NW-CG.
 B. Change the Alignment style to RDWY Curb&Gutter Flange.
 C. Change the Alignment label set to _No Labels.
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 3. OK
 4. Line Tool > Fixed Line (Two Points).

 A. O-Snap to the top of the North-West intersection.
 B. O-Snap to the end of the curve.
 C. Right-click to set the points. 

 5. Curve Tool > Fixed Curve (Three Points)
 A. O-Snap to the start of the curve.
 B. Shift + right-click > Midpoint
 C. Select the endpoint of the curve
 D. Right-click to set the points. 
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 6. Line Tool > Fixed Line (Two Points)
 A. O-Snap to the end of the curve.
 B. Shift + right-click > Endpoint
 C. Select the endpoint of the line
 D. Right-click to set the points. 

 7. Home tab > Create Design > Alignment > Alignment Creation Tools 
 A. Change the name to Int-CthE-RiverRd-NE-CG.
 B. Leave the rest of the selections as is. 

 8. OK
 9. Line Tool > Fixed Line(Two Points)

 A. O-Snap to the bottom of the North-East intersection.
 B. O-Snap to the end of the curve.
 C. Right-click to set the points. 
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 10. Curve Tool > Fixed Curve(Three Points)
 A. O-Snap to the end of the curve.
 B. Shift + right-click > Midpoint

 11. Select the start of the curve. 
 12. Right-click to set the points. 
 13. Line Tool > Fixed Line (Two Points)

 A. O-Snap to the end of the curve.
 B. Shift + right-click > Endpoint
 C. Select the endpoint of the line
 D. Right-click to set the points. 

Create curb and gutter edgelines for SW and SE quadrants

Exercise files: ali-int-edglin-geom-creat-05-data-C3D16.zip

ali-int-edglin-geom-creat-05.mp4 1:32

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to Int-CthE-RiverRd-SW-CG
 B. Change the Alignment style to RDWY Curb&Gutter Flange
 C. Change the Alignment label set to _No Labels
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 3. OK
 4. Line Tool > Fixed Line (Two Points).

 A. O-Snap to the start of the South-West intersection.
 B. O-Snap to the end of the curve.
 C. Right-click to set the points. 

 5. Curve Tool > Fixed Curve (Three Points)
 A. O-Snap to the start of the curve.
 B. Shift + right-click > Midpoint
 C. Select the endpoint of the curve. 
 D. Right-click to set the points. 
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 6. Line Tool > Fixed Line (Two Points)
 A. O-Snap to the end of the curve.
 B. Shift + right-click > Endpoint
 C. Select the endpoint of the line
 D. Right-click to set the points. 

 7. Home tab > Create Design > Alignment > Alignment Creation Tools 
 8. Change the name to Int-CthE-RiverRd-SE-CG.

 A. Leave the rest of the selections as is. 

 9. OK
 10. Line Tool > Fixed Line (Two Points)

 A. O-Snap to the bottom of the South-East intersection.
 B. O-Snap to the end of the curve.
 C. Right-click to set the points. 
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 11. Curve Tool > Fixed Curve(Three Points)
 A. Shift + right-click > Midpoint
 B. Select the start of the curve. 
 C. Right-click to set the points. 

 12. Line Tool > Fixed Line (Two Points).
 A. O-Snap to the end of the curve.
 B. Shift + right-click > Endpoint
 C. Select the endpoint of the line
 D. Right-click to set the points. 

Create CthE ETW edgelines

Exercise files: ali-int-edglin-geom-creat-06-data-C3D16.zip

ali-int-edglin-geom-creat-06.mp4 2:49

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to CthE-L-ETW.
 B. Change the Alignment style to RDWY Pavement Edge.

 3. OK
 4. Tan-Tan(No Curves)

 5. On the north side of CTH E, endpoint OSNAP to:
 A. the west end of the lane transition.
 B. the west transition line connects to the NW curb and gutter
 C. the east transition line connects to the NE curb and gutter
 D. the east transition meets the ten foot extension of the NE curb and gutter
 E. the widened lane transition ends
 F. the bend in the transition lane
 G. east end of the widened lane transition
 H. the east end of the ten foot transition extension

 6. Right-click to end the Draw Tangent command.
 7. Close the toolbar.
 8. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to CthE-R-ETW.
 9. OK

 10. Tan-Tan(No Curves)
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 11. on the south side of CTH E, endpoint OSNAP to: 
 A. the west end of the ten foot extension of the lane transition.
 B. the west end of the transition line
 C. the west transition line bend
 D. the west transition meets the ten foot extension of the SW curb and gutter
 E. the west transition line connects to the SW curb and gutter
 F. the east transition line connects to the SE curb and gutter
 G. the east transition meets the ten foot extension of the NE curb and gutter
 H. the widened lane transition ends
 I. the east end of the ten foot transition extension

 12. Right-Click to end the Draw Tangent command.
 13. Close the toolbar

Create CthE EPS edgelines

Exercise files: ali-int-edglin-geom-creat-07-data-C3D16.zip

ali-int-edglin-geom-creat-07.mp4 1:43

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to CthE-L-EPS
 B. Change the Alignment style to RDWY Shoulder Paved. 
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 3. OK
 4. Tan-Tan(No Curves)

 5. Snap to the end of the paved shoulder, end of the transition, end of the line.
 6. Right-Click to lock in the points.
 7. Close the tool bar. 
 8. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to CthE-R-EPS
 B. OK
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 7. Snap to the end of the lane, the end of the transition, and the end of the paved shoulder. 
 8. Right-Click to lock in the points.
 9. Close the tool bar.

Create CthE EGS edgelines

Exercise files: ali-int-edglin-geom-creat-08-data-C3D16.zip

ali-int-edglin-geom-creat-08.mp4 1:42

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to CthE-L-EGS
 B. Change the Alignment style to RDWY Shoulder Aggregate. 
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 3. OK
 4. Tan-Tan(No Curves)

 5. On the north side of CTH E, endpoint OSNAP to:
 A. the west end of the EGS line.
 B. the west EGS line bends before the NW curb and gutter
 C. the west EGS connects to the NW curb and gutter
 D. the east EGS connects to the NE curb and gutter
 E. the east EGS transition bend
 F. the east end of the EGS line

 6. Right-Click to end the Draw Tangent command.
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 7. Close the toolbar.
 8. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to CthE-R-EGS.

 9. OK
 10. Tan-Tan(No Curves)
 11. On the south side of CTH E, endpoint OSNAP to:

 A. the west end of the EGS
 B. the west EGS bend in transition line
 C. the west end of the EGS where it matches the SW curb and gutter
 D. the east end of the EGS where it matches the SE curb and gutter 
 E. the east EGS line bends after the SE curb and gutter
 F. east end of the EGS line. 

 12. Right-Click to end the Draw Tangent command.
 13. Close the tool bar.

Create RiverRd ETW edgelines

Exercise files: ali-int-edglin-geom-creat-09-data-C3D16.zip

ali-int-edglin-geom-creat-09.mp4 2:07
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 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to RiverRd-L-ETW.
 B. Change the Alignment style to RDWY Shoulder Aggregate

 3. OK
 4. Tan-Tan(No Curves)

 5. Starting at the south end 
 A. snap to the end of the extension
 B. snap to the beginning of the transition
 C. snap to the end of transition.

 6. Jump to the other side
 A. snap to where it touches the curve
 B. snap to where it returns back to the pavement
 C. snap to the end of the extension
 D. snap to the end of the 10 foot extension. 
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 7. Right-Click to lock in the points.
 8. Close the tool bar.
 9. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to RiverRd-R-ETW.

 10. OK
 11. Tan-Tan(No Curves)

 A. the south end of the ETW at the 10' extension
 B. the south end of the transition lane line
 C. the south end where the transition line meets the SW curb and gutter
 D. the north end where the transition line meets the curb and gutter
 E. the north end where the transition meets the 10' extension of the curb and gutter
 F. the north end of transition line
 G. the north end f the 10' extension of the transition line

 12. Right-Click to end the Draw Tangent command.
 13. Close the toolbar.

Create RiverRd EGS edgelines

Exercise files: ali-int-edglin-geom-creat-10-data-C3D16.zip
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ali-int-edglin-geom-creat-10.mp4 1:43

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to RiverRd-L-EGS.
 B. Change the Alignment style to RDWY Shoulder Aggregate

 3. OK
 4. Tan-Tan(No Curves)

 5. on the west side of River Rd, endpoint OSNAP to:
 A. the south end of the EGS
 B. the south end where the EGS line meets the SW curb and gutter
 C. the north end where the EGS line meets the curb and gutter
 D. the north end of the EGS
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 6. Right-click to end the Draw Tangent command.
 7. Close the toolbar.
 8. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to RiverRd-R-EGS.

 9. OK
 10. Tan-Tan(No Curves)
 11. on the east side of River Rd, endpoint OSNAP to:

 A. the south end of the EGS
 B. the south end where the EGS line meets the SW curb and gutter
 C. the north end where the EGS line meets the curb and gutter
 D. the north end of the EGS

 12. Right-Click to end the Draw Tangent command.
 13. Close the toolbar

Create layers for edgeline alignments

Exercise files: ali-int-edglin-geom-creat-11-data-C3D16.zip

Page: 657

Published on: 5/17/2023

Create layers for edgeline alignments

https://c3dkb.dot.wi.gov/data/ali/ali-int-edglin-geom-creat-11-data-C3D16.zip


ali-int-edglin-geom-creat-11.mp4 2:38

 1. Home tab > Layer panel > Layer Properties
 2. New Layer 

 A. Name the new layer P_RDWY_LaneEdge-L.
 B. Enter

 3. Create another new layer.
 A. Name this new layer P_RDWY_LaneEdge-R.
 B. Enter

 4. Create another new layer.
 A. Name this new layer P_RDWY_ShldAgg-L.
 B. Enter

 5. Create another new layer.
 A. Name this new layer P_RDWY_ShldAgg-R.
 B. Enter

 6. Create another new layer.
 A. Name this new layer P_RDWY_ShldPaved-L.
 B. Enter

 7. Create another new layer.
 A. Name this new layer P_RDWY_ShldPaved-R.
 B. Enter

 8. Close the Layer Properties manager.

Assign edgeline alignments to layers

Exercise files: ali-int-edglin-geom-creat-12-data-C3D16.zip

ali-int-edglin-geom-creat-12.mp4 4:25

 1. Left-Click on the north side of CTH E and the west side of River Rd
 A. Right-click > Properties
 B. Select the Layer pull-down.
 C. Select P_RDWY_LaneEdge-L
 D. ESC

 2. Select the south side of CTH E and the east side of River Rd.
 A. With both selected Right-click > Properties
 B. Select the Layer pull-down.
 C. Select P_RDWY_LaneEdge-R
 D. ESC

 3. Select the paved shoulder west of CTH E.
 A. With both selected Right-click > Properties
 B. Select the Layer pull-down.
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 C. Select P_RDWY_ShldPaved-L
 D. ESC

 4. Select the paved shoulder on the left hand side of CTH E.
 A. With both selected Right-click > Properties
 B. Select the Layer pull-down.
 C. Select P_RDWY_ShldPaved-R
 D. ESC

 5. Select the shoulder aggregate left of CTH E and the shoulder aggregate west side of River Rd.
 A. With both selected Right-click > Properties
 B. Select the Layer pull-down.
 C. Select P_RDWY_ShldAgg-L
 D. ESC

 6. Select the shoulder aggregate right of CTH E and the shoulder aggregate east side of River Rd.
 A. With both selected Right-click > Properties
 B. Select the Layer pull-down.
 C. Select P_RDWY_ShldAgg-R.
 D. ESC

 7. Select all the Curb&Gutter radii. 
 A. With both selected Right-click > Properties
 B. Select the Layer pull-down.
 C. Select P_RDWY_C_and_G.
 D. ESC

 8. Close out the Properties Dialogue box.

Create data shortcuts

Exercise files: ali-int-edglin-geom-creat-13-data-C3D16.zip

ali-int-edglin-geom-creat-13.mp4 1:38

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Save
 3. Prospector > Right-click on Data Shortcuts [] > Create Data Shortcuts
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 4. Click on Centerline Alignments to select all the alignments.
 5. OK

Mask CthE ETW and EGS edgelines in intersection

Exercise files: ali-int-edglin-geom-creat-14-data-C3D16.zip

ali-int-edglin-geom-creat-14.mp4 2:51

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Select on the north ETW alignment. 

 A. Home tab > Modify panel> Alignment Properties
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 B. Go to the Masking tab.
 C. Create Masking Station.
 D. Endpoint Snap to:

 I. ETW where it matches to the NW curb and gutter
 II. ETW where it matches to the NE curb and gutter.

 E. OK
 F. ESC

 3. Select on the north EGS alignment. 
 A. Go to the Masking  tab
 B. Create Masking Station.
 C. Endpoint Snap to:

 I. EGS where it matches to the NW curb and gutter
 II. EGS where it matches to the NE curb and gutter.

 D. OK
 E. ESC

 4. Select on the south ETW alignment. 
 A. Endpoint Snap to:

 I. ETW where it matches to the NW curb and gutter
 II. ETW where it matches to the NE curb and gutter.

 B. OK
 C. ESC to release the ETW.

 5. Select on the south EGS alignment. 
 A. Endpoint Snap to:

 I. EGS where it matches to the NW curb and gutter
 II. EGS where it matches to the NE curb and gutter.

 6. OK
 7. ESC to release the EGS

Mask RiverRd ETW and EGS edgelines in intersection

Exercise files: ali-int-edglin-geom-creat-15-data-C3D16.zip

ali-int-edglin-geom-creat-15.mp4 2:38

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Select on the River Rd west ETW alignment. 

 A. Home tab > Modify panel> Alignment Properties
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 B. Go to the Masking tab.
 C. Create Masking Station.
 D. Endpoint Snap to where the west ETW line intersects the SW curb and gutter.
 E. Endpoint snap to where the west ETW line intersects the NW curb and gutter.
 F. OK
 G. ESC

 3. Select on the River Rd east ETW alignment. 
 A. Home tab > Modify panel> Alignment Properties

 B. Go to the Masking tab.
 C. Create Masking Station.
 D. Endpoint Snap to where the west ETW line intersects the SE curb and gutter.
 E. Endpoint snap to where the west ETW line intersects the NE curb and gutter.
 F. OK
 G. ESC

 4. Select on the River Rd west EGS alignment. 
 A. Home tab > Modify panel> Alignment Properties

 B. Go to the Masking tab.
 C. Create Masking Station.
 D. Endpoint Snap to where the west EGS line intersects the SW curb and gutter.
 E. Endpoint snap to where the west EGS line intersects the NW curb and gutter.
 F. OK
 G. ESC 

 5. Select on the River Rd east EGS alignment. 
 A. Home tab > Modify panel> Alignment Properties
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 B. Go to the Masking Tab.
 C. Create Masking Station.
 D. Endpoint Snap to where the east EGS line intersects the SE curb and gutter.
 E. Endpoint snap to where the east EGS line intersects the NE curb and gutter.
 F. OK
 G. ESC 

Mask curb return extensions

Exercise files: ali-int-edglin-geom-creat-16-data-C3D16.zip

ali-int-edglin-geom-creat-16.mp4 2:47

 1. Beginning in the Northwest Quadrant select on the alignment. 
 2. Home tab > Modify panel> Alignment Properties

 A. Go to the Masking tab.
 B. Create Masking Station.
 C. Starting at the North end of the block

 I. Endpoint Snap to the beginning of the curb return extension.
 II. Endpoint snap to where the curb return actually begins.

 D. Create Masking Station.
 E. From the South end of the block.

 I. Endpoint snap to where the curb return actually begins.
 II. Snap to the beginning of the curb return extension.

 F. OK
 G. ESC

 3. Beginning in the Northeast Quadrant select on the alignment. 
 4. Home tab > Modify panel> Alignment Properties

 A. Go to the Masking tab.
 B. Create Masking Station.
 C. Starting at the east end of the block

 I. Endpoint Snap to the beginning of the curb return extension.
 II. Endpoint snap to where the curb return actually begins.

 D. Create Masking Station.
 E. From the North end of the block.

 I. Endpoint snap to where the curb return actually begins.
 II. Snap to the beginning of the curb return extension.

 F. OK
 G. ESC

 5. Beginning in the Southwest Quadrant select on the alignment. 

Page: 663

Published on: 5/17/2023

Mask curb return extensions

https://c3dkb.dot.wi.gov/data/ali/ali-int-edglin-geom-creat-16-data-C3D16.zip
https://c3dkb.dot.wi.gov/video/ali/ali-int-edglin-geom-creat-16.mp4


 6. Home tab > Modify panel> Alignment Properties
 A. Go to the Masking tab.
 B. Create Masking Station.
 C. Starting at the west end of the block

 I. Endpoint Snap to the beginning of the curb return extension.
 II. Endpoint snap to where the curb return ends.

 D. Create Masking Station.
 E. From the South end of the block.

 I. Endpoint snap to where the curb return ends.
 II. Snap to the beginning of the curb return extension.

 F. OK
 G. ESC

 7. Beginning in the Southeast Quadrant select on the alignment. 
 8. Home tab > Modify panel> Alignment Properties

 A. Go to the Masking tab.
 B. Create Masking Station.
 C. Starting at the South end of the block

 I. Endpoint Snap to the beginning of the curb return extension.
 II. Endpoint snap to where the curb return ends.

 D. Create Masking Station.
 E. From the South end of the block.

 I. Endpoint snap to where the curb return actually begins.
 II. Snap to the beginning of the curb return extension.

 F. OK
 G. ESC

 9. Home tab > Layers panel> Layer pull down
 A. Type in P_Int_Block_NPLT
 B. Freeze the layer 

 10. Save

Edit CthE geometry and linework

Exercise files: ali-int-edglin-geom-creat-17-data-C3D16.zip

ali-int-edglin-geom-creat-17.mp4 2:46

 1. Open Crdr-Int-CthE-RiverRd.dwg

Tip: This is only to show the edit process, should that be necessary. This will not be part of the 
regular creation workflow.

 2. Home tab > Layer panel > Layer Panel Pull-down
 A. Find the P_Int_Block_NPLT layer and thaw it. 

 3. Select on the northern block.
 A. Right-click > Properties
 B. Scroll down to Custom. 
 C. R1 = 50
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 D. Close the window.
 E.  ESC to let go of the block.

 4. Select on the block. 
 A. Select on the alignment for the curb-return.
 B. Grab the end point of the alignment and move it to the end.
 C. Grab the end of the straight portion and move it to the end of the curb.
 D. On the top half of the block grab the end point of the alignment and move it to the 

end.
 E. Grab the end of the straight portion and move it to the end of the curb.

 5. Select on the ETW.
 A. Move the end of the ETW to the intersection point. 

 6. Select on the EGS.
 A. Move the top end point to the end of the EGS line.
 B. Move the end point to where the EGS line matches the curb and gutter.
 C. ESC

 7. Select (2:30 Mark) 
 8. Snap overlap to the end of the block.
 9. Snap the corner to the end of transition.

 10. ESC
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 11. Select the EGS and snap that to the end of the EGS line.
 12. Repeat the steps for the top half of the curve.

Edit RiverRd geometry and linework and masks

Exercise files: ali-int-edglin-geom-creat-18-data-C3D16.zip

ali-int-edglin-geom-creat-18.mp4 2:51

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Select on the ETW.

 A. Select on the end point of the ETW an move it to the end of the transition. 
 B. Move the ETW match point to curb to the new location of the end of the curb.
 C. ESC

 3. Select on the EGS line.
 A. Select on the end point of the EGS and move it to the end of the transition. 
 B. Move the EGS match point with the curb to the new location of the end of the curb.
 C. ESC

 4. Select on the West EGS alignment.
 5. Home tab > Modify panel> Alignment Properties

 A. Click on the Masking tab.
 B. Select the Start Station inside Region 1.
 C. Select from Screen Icon.

 D. Endpoint OSNAP to the end of the curb and gutter.
 E. OK
 F. ESC

 6. Select on the West ETW alignment.
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 7. Home tab > Modify panel> Alignment Properties
 A. Click on the Masking tab.
 B. Select the Start Station inside Region 1.
 C. Select from Screen Icon.
 D. Endpoint OSNAP to the end of the curb and gutter
 E. OK
 F. ESC

 8. Select on the North ETW alignment.
 9. Home tab > Modify panel> Alignment Properties

 A. Click on the Masking tab.
 B. Select on the North EGS alignment.
 C. Select the Start Station inside Region 1.
 D. Select from Screen Icon.

 E. Select back of curb endpoint.
 F. OK
 G. ESC

 10. Select on the North EGS alignment.
 11. Home tab > Modify panel> Alignment Properties

 A. Click on the Masking tab.
 B. Select the End Station inside Region 1.
 C. Select from Screen Icon.
 D. Select back of curb endpoint.
 E. OK.
 F. ESC

 12. Grab the end of the EGS alignment and snap it to the new location of the end of the EGS.
 A. ESC

 13. Grab the ETW alignment and snap it to the new location of the end of the ETW.
 A. ESC

 14. Home tab > Layer panel > Layer Panel Pull-down
 15. Type P_Int_Block_NPLT and select the sunshine icon to freeze the block.
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Make edgelines ready for plan production
Last updated: 2020-10-26

Total video time: 12:53

Data reference edgeline alignments into Pavt.dwg

Exercise files: ali-mak-edglin-rdy-pln-prod-01-data-C3D16.zip

ali-mak-edglin-rdy-pln-prod-01.mp4 4:15

 1. 12345678 > Design Folder > Edgelines Folder > Open pavt.dwg file
 2. Prospector > Right-click on Data Shortcuts [] > Set Working Folder

 A. Open C3D file.
 3. Data Shortcuts > Alignments > Centerline Alignments > Right-click on CthE-L-EGS > 

Create Reference
 A. Alignment style = RDWY Shoulder Aggregate
 B. Label Set = _No Label

 4. OK
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 5. Right-Click on CthE-R-EGS > Create Reference
 A. OK

 6. Right-Click on RiverRd-L-EGS > Create Reference
 A.  OK

 7. Right-Click on RiverRd-R-EGS > Create Reference
 A. OK

 8. Right-Click on the CthE-L-EPS > Create Reference
 A. Alignment style = RDWY Shoulder Paved

 B. OK
 9. Right-Click on the CthE-R-EPS > Create Reference

 A. OK
 10. Right-Click on the CthE-L-ETW > Create Reference

 A. Alignment style = RDWY Pavement Edge
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 B. OK
 11. Right-Click on the CthE-R-ETW > Create Reference

 A.  OK
 12. Right-Click on the RiverRd-L-ETW  > Create Reference

 A. OK
 13. Right-Click on the RiverRd-R-ETW > Create Reference

 A. OK
 14. Right-Click on the Int-CthE-RiverRd-NE-CG > Create Reference

 A. Alignment style = RDWY Curb&Gutter Flange

 B. OK
 15. Right-Click on the Int-CthE-RiverRd-NW-CG  > Create Reference

 A.  OK
 16. Right-Click on the Int-CthE-RiverRd-SE-CG > Create Reference

 A. OK
 17. Right-Click on the Int-CthE-RiverRd-SW-CG  > Create Reference

 A. OK

Create offsets for back of curb edgelines

Exercise files: ali-mak-edglin-rdy-pln-prod-02-data-C3D16.zip

ali-mak-edglin-rdy-pln-prod-02.mp4 4:08
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 1. Home Tab > Create Design > Alignment > Create Offset Alignment

 2. Select NW Curb and Gutter Flange.
 A. Un-Check From Start and To End
 B. Click select from Screen Icon for the start.

 C. Select the North End for the start.
 D. Click the select from screen button for the end.
 E. Snap to the end.
 F. Offsets on right = 1
 G. Incremental offset on right = 36"
 H. Alignment Style = RDWY Curb&Gutter Back
 I. Select the sheet icon in the Alignment layer.

 I. Modifier = None
 II. Base Layer Name = P_RDWY_C_and_GBack
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 J. Alignment label set = _No Labels

 K. OK
 3. Home Tab > Create Design > Alignment > Create Offset Alignment
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 5. Select NE Curb and Gutter Flange.
 A. Un-Check From Start and To End
 B. Click select from Screen Icon for the start.

 C. Select the North End for the start.
 D. Click the select from screen button for the end.
 E. Snap to the end.
 F. Select the sheet icon in the Alignment layer.

 I. Modifier = None
 II. Base Layer Name = P_RDWY C_and_GBack
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 G. OK
 6. Home Tab>Create Design>Alignment > Create Offset Alignment
 7. Select SW Curb and Gutter Flange.

 A. Un-Check From Start and To End
 B. Click select from Screen Icon for the start.

 C. Select the North End from the west end.
 D. Click the select from screen button for the end.
 E. Snap to the south end. 
 F. Select the sheet icon in the Alignment layer

 I. Modifier = None
 II. Base Layer Name = P_RDWY_C_and_GBack

 G. OK
 8. Home Tab > Create Design > Alignment > Create Offset Alignment
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 9. Select SE Curb and Gutter Flange.
 A. Un-Check From Start and To End
 B. Click select from Screen Icon for the start.

 C. Click the select from screen button for the end.
 D. Snap to the east end. 
 E. Select the sheet icon in the Alignment layer.

 I. Modifier = None
 II. Base Layer Name = P_RDWY_C_and_GBack

 F. OK

Create offsets for face  of curb edgelines

Exercise files: ali-mak-edglin-rdy-pln-prod-03-data-C3D16.zip

ali-mak-edglin-rdy-pln-prod-03.mp4 3:14

 1. Home Tab > Create Design > Alignment > Create Offset Alignment
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 2. Select the NW back of curb.
 A. Check From Start and To End
 B. Offsets on left = 1
 C. Offsets on right = 0
 D. Incremental offset on left = 6"
 E. Alignment Style = RDWY Curb&Gutter Face
 F. Select the sheet icon in the Alignment layer.

 I. Modifier = None
 II. Base Layer Name = P_RDWY_C_and_GFace

 G. Alignment label set = _No Labels
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 H. OK
 3. Home Tab > Create Design > Alignment > Create Offset Alignment
 4. Select the NE back of curb.

 A. Select the sheet icon in the Alignment layer.
 I. Modifier = None

 II. Base Layer Name = P_RDWY_C_and_GFace

 B. OK
 5. Home Tab>Create Design>Alignment > Create Offset Alignment
 6. Select the SW back of curb.

 A. Select the sheet icon in the Alignment layer.
 I. Modifier = None.

 II. Change the Base Layer Name to P_RDWY_C_and_GFace.
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 B. OK
 7. Home Tab > Create Design > Alignment > Create Offset Alignment
 8. Select the SW back of curb.

 A. Select the sheet icon in the Alignment layer.
 I. Change the modifier to None.

 II. Change the Base Layer Name to P_RDWY_C_and_GFace.

 B. OK
 9. Save 

Edit curb and gutter offset edgelines

Exercise files: ali-mak-edglin-rdy-pln-prod-04-data-C3D16.zip

ali-mak-edglin-rdy-pln-prod-04.mp4 1:16

 1. Left-Click on the back of curb.
 2. Select the diamond that appears on the parent flange of curb
 3. Adjust the length of the parent alignment. 
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Profiles
Profile basics
Last updated: 2022-11-01

Total video time: 4:17

prfl-basc-01.mp4 4:17

Introduction to profile and profile views

Profiles are a sub-entity of alignments. During creation of a profile you will be required to assign an 
alignment.

Important terms:

 l Profile is the actual elevation data.
 l Profile View is the grid and the text around it.
 l Profile Band displays of profile elevations and station information, found at the bottom of the 

profile view grid.
 
Profile data types:

 l Surface profile can be of existing conditions, but can also be surfaces from proposed cor-
ridors. A surface profile has no grip points because it gets its definition from a surface and is 
not manually editable.

 l Design profile is information you have built yourself. When selected, there are grip point for 
editing.

 
Profiles are a key element of elevation in design: 

 l Baseline elevation is where design is initiated.
 l Target elevation that design is going to. This is useful in assigning elevations to subassembly 

ends or subassembly slope transition.

Create surface profile
Last updated: 2022-05-16

Total video time: 23:18

Create surface profile

Exercise files: prfl-data-c3d22.zip

Video: prfl-creat-srfc-01.mp4 5:21
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-CtyE-prfl-creat-srfc-begin.dwg
 C. Open

Create a surface profile

 1. Ribbon > Home tab > Create Design panel > Profile dropdown > select Create Surface 
Profile

 2. Create Profile from Surface dialog box
 A. Alignment: CthE

Tip: Next to the alignment name is a Select from Screen icon. Use this to select 
alignment from screen graphically.

 B. Station range: 
 I. Alignment Start and End stations are locked and cannot be changed.

 II. To sample: keep stations as the entire length.

Tip: You could type the start and end stations, or use the Select from 
Screen icon to assign start and end stations

 C. Select surfaces: 
 I. Select Exist

 II. Add >>
 D. Profile list: CthE-Exist has populated.
 E. Select surfaces

 I. Sample offset: check box, type 20'
 II. Add >>

 F. Profile list: Exist-Surface-20.000' has populated.
 I. Style: select PROF Existing

 II. Pick profile style dialog box
 a. dropdown > select RDWY Lane Edge
 b. OK

 G. Select Draw in profile view

Info: To delete a profile you just created click Remove

 3. Create Profile View dialog box opens

Create profile view - general tab

Video: prfl-creat-srfc-02.mp4 3:17

Continuing from previous exercise.

Create Profile View dialog box
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 1. General tab
 A. Select alignment: Name of the alignment. If the selected alignment is not correct, use 

the dropdown to select an alignment from the list or use the Select from Screen icon 
to select alignment from the drawing graphically.

 B. Profile view name: This is the name of the profile, PV-(<[Next Counter(CP)]>). The 
name is set with a running counter that will automatically increase the value based on 
the number of profiles made in the file.

 C. Description: Enter a short description, if needed.
 D. Profile view style: The selections are WisDOT standards.
 E. Profile view layer: Name of the layer
 F. Vertically stacked option: You would use this option if you have more than one profile 

and want to show them with their own profile views.
 G. No changes will be made. 

 2. Next >

Create profile view - station range and profile view height tabs

Video: prfl-creat-srfc-03.mp4 3:35

Continuing from previous exercise.

Create Profile View dialog box

 1. Station Range tab
 A. Station range

 I. Automatic radial: When selected, will use the full range of the profile.
 II. Start and End values: These are the actual start and end stations of the profile. 

They are locked and cannot be edited.
 III. User specified range radial: When selected, will allow you the enter a sample 

range.
 IV. Miniature schematic: A preview of what has been selected.

 B. Select the Automatic radial.
 C. Next >

 2. Profile View Height tab
 A. Profile view height

 I. Automatic radial: When selected, will use the full height of the profile.
 II. Minimum and Maximum values: These are the lowest and highest elevation of 

the profile, with a little pad. They are locked and cannot be edited.
 III. User specified radial: When selected, will allow you the enter a sample range.
 IV. Split profile view: Only available if are using User specified option. The schem-

atic will display the multiple views; first, intermediate, and last, and will adjust 
the elevations of the profile so it fits into each profile view.

 V. Split station and Datum option: These are for the station and elevation option 
of where that split takes place.

 B. Select the Automatic radial.
 C. Next >

Create profile view - profile display options tab
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Video: prfl-creat-srfc-04.mp4 3:44

Continuing from previous exercise.

Create Profile View dialog box

 1. Profile Display Options tab
 A. Specify profile display options:

There are a lot of stats listed here. We will only go over a few of them.

 I. Name: Will display all profiles created.
 II. Draw: check box, list of profile(s) you would like to view.

 III. Clip Grid: radial, referencing a style option. Clip the grid, at the profile data, 
both in the station elevation or station direction.

 IV. Split Grid: radial, only used if the Split profile view option was selected in the Pro-
file View Height tab.

 V. Style: If you have multiple profiles, changing the style on each will make it 
easier to differentiate between the profiles. The styles are usually set in profile 
creation, but can be changed here too.

 VI. Labels: Default is WisDOT Standard.
 B. Change the Labels, for both profiles, to _No Labels
 C. Next >

Create profile view - data bands tab

Video: prfl-creat-srfc-05.mp4 2:23

Continuing from previous exercise.

Create Profile View dialog box

 1. Data Bands tab
Data bands are placing existing and proposed elevations at major and minor stations. The 
data band, per WisDOT standards, is found at the bottom of the profile view.

 A. Select band set: Elevation Both (Existing Left Proposed Right) is default and works best 
for most profile views.

 B. List of bands
 I. Location: Bottom of profile view

 II. Set band properties:
 a. Profile Data 1 > Style: Elevation Left > Profile 1: CthE-Exist > Profile 2: 

CthE-Exist
 b. Profile Data 2 > Style: Elevation Right > Profile 1: change to Exist-Sur-

face-20.000' > Profile 2: change to Exist-Surface-20.000'
 c. Profile Data 3 > Style: Station Labels > Profile 1: CthE-Exist > Profile 2: 

CthE-Exist
 d. Profile Data 4 > Style: Vertical View Offset > Profile 1: CthE-Exist > Profile 

2: CthE-Exist
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 C. Next >

Create profile view - profile hatch options tab

Video: prfl-creat-srfc-06.mp4 1:39

Continuing from previous exercise.

Create Profile View dialog box

 1. Profile Hatch Options tab
This option will hatch a profile view between two surfaces that you define. This option is not 
often used do to the amount of color it adds to the drawing.

 A. Cut Area: Select schematic button and table populates.
 I. Hatch Area

 a. Cut - (2) > Shape Style: WisDot Standard (default)
 b. Upper boundary > Profile: CthE-Exist
 c. Lower boundary > Profile: <Select a profile>, change to Exist-Surface-

20.000'
 B. Fill Area: Select schematic button and table populates.

 I. Hatch Area
 a. Fill - (2) > Shape Style: WisDot Standard (default)
 b. Upper boundary > Profile: <Select a profile>, change to Exist-Surface-

20.000'
 c. Lower boundary > Profile: CthE-Exist

 2. This was just to show how to use this option. We need to delete this data.
 A. Select Fill - (2)
 B. Select red X
 C. Select Cut - (2)
 D. Select red X

 3. Select Create Profile View

Create a separate profile view

Video: prfl-creat-srfc-07.mp4 3:19

Create an additional profile view

 1. Zoom out to see an open area above current profile view. This is where the new one will be 
placed.

 2. Ribbon > Home tab > Profile & Section View panel > Profile View dropdown > select 
Create Profile View
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 3. Create Profile View dialog box
 A. General tab

 I. Select Alignment: CthE

Warning: Verify the correct alignment is selected here. When the dialog 
box opens, it may not have the alignment you want listed.

Tip: If there is any doubt about which alignment you are dealing with use 
the Select from Screen icon.

 II. Profile view name: PV-(<[Next Counter(CP)]>)
 III. Profile view style: Stations 100' Major 50' Minor
 IV. Next >

 B. Station Range tab
 I. Station Range: select User specified range radial

 II. Start: type 1100
 III. End: type 1500
 IV. Next >

 C. Profile View Height tab
 I. Next >

 D. Profile Display Options tab
 I. Name: CthE-Exist > Draw: Checked box > Labels: change to _No LabelsOK

 II. Name: Exist-Surface-20.000' > Draw: Checked box > Labels: change to _No 
LabelsOK

 III. Next >
 E. Data Bands tab

 I. Set bands properties:
 a. Profile Data 2 > Style: Elevation Right > Profile 1: change to Exist-Sur-

face-20.000'
 F. Select Create Profile View

 4. Select profile view origin: Left-click in area above other profile view.
The new profile view is linked to the first profile view. Any changes made will appear in both profile 
views.

Profile properties and styles
Last updated: 2022-05-16

Total video time: 7:22

Profile styles

Exercise files: prfl-data-c3d22.zip

Video: prfl-prprtis-styl-01.mp4 2:35
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-CtyE-prfl-prprtis-begin.dwg
 C. Open

Change profile style from surface profile (existing)

 1. Left-click surface profile in profile view.
 2. Contextual ribbon > Home tab > Modify panel > select Profile Properties
 3. Profile Properties dialog box

 A. Information tab
 I. Object style: dropdown, select PROF Proposed

 B. Apply
 C. OK

 4. ESC to end command

Info: The line is solid green line.

 5. Left-click surface profile.
 6. Contextual ribbon > Home tab > Modify panel > select Profile Properties
 7. Profile Properties dialog box

 A. Information tab
 I. Object style: dropdown, select RDWY Lane Edge

 B. OK
 8. ESC to end command

Info: The line is solid white linetype.

 9. Left-click surface profile.
 10. Contextual ribbon > Home tab > Modify panel > select Profile Properties
 11. Profile Properties dialog box

 A. Information tab
 I. Object style: dropdown, select PROF Existing

 B. OK
 12. ESC to end command

Info: The line is a dashed blue  line.

Change profile style from design profile (proposed)

 1. Left-click proposed profile.
 2. Contextual ribbon > Home tab > Modify panel > select Profile Properties
 3. Profile Properties dialog box

 A. Information tab
 I. Object style: dropdown, select PROF Ditch Flow Line

 B. OK
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 4. ESC to end command

Info: The line is a dashed purple  line.

Profile properties - information and profile data tab

Video: prfl-prprtis-styl-02.mp4 1:38

Continue from previous exercise.

 1. Left-click proposed profile.
 2. Contextual ribbon > Home tab > Modify panel > select Profile Properties
 3. Profile Properties dialog box

 A. Information tab
 I. Name: This is where you can change the name.

 II. Description: This is where a short description can be entered.
 III. Object style: dropdown, dropdown, contains several WisDOT templates.

 a. Select PROF Proposed
 IV. Next >

 B. Profile Data tab
 I. Profile data tab contains a window with vital stats about the profile.

 II. Parent horizontal alignment contains the name of the parent alignment and its 
start and end stations.

Profile properties - design criteria tab

Video: prfl-prprtis-styl-03.mp4 1:16

Continue from previous exercise.

 1. Design Criteria tab
 A. Check box Use criteria-based design.
 B. Use design criteria file box is checked.

 I. Left-click ... to browse
 II. Select Design Speed Table dialog box

 a. Look in: dropdown, browse to C:\ProgramData\Autodesk\C3D 
2020\enu\Data\Corridor Design Standards\Imperial

 b. File name: select WisDOT Design Criteria 2009.xml
 c. Open

 C. Default criteria table will populate. Keep Value as WisDOT Standard - Desirable Cat-
egory 1

 D. Use design check set is checked. Keep as Standard.

Profile properties - profile locking tab

Video: prfl-prprtis-styl-04.mp4 1:53
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Continue from previous exercise.

 1. Profile Locking tab
Profile locking allows you to control the profile information, in case the alignment length or 
geometry changes.

 A. Anchor profile geometry points to alignment points radial - As the alignment gets 
longer, so does the profile and proposed profile. Everything is connected.

 I. Modify affected entities radial
 a. Notify which entities are affected check box - Yellow exclamation 

bubbles appear at locations that are affected, allowing you to modify.
 II. Delete affected entities radial - This allows you to redesign yourself.

 B. Anchor profile to alignment start radial
 2. OK

Profile view properties
Last updated: 2022-05-16

Total video time: 11:23

Profile view properties

Exercise file: prfl-data-c3d22.zip

Video: prfl-vu-prprtis-01.mp4 2:15

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-CtyE-prfl-vu-prprtis-begin.dwg
 C. Open

Two ways to open profile view properties

 1. Open profile view properties in Toolspace
 A. Toolspace > Prospector tab > expand Alignments > expand CthE (host align-

ment) > expand Profile Views > right-click PV - (1) > select Properties...

Tip: From the right-click menu, select Zoom to to verify the profile is the one 
you want.

 B. Profile View Properties dialog box
 2. Open profile view properties in Contextual ribbon

 A. Left-click and select profile view.

Info: Only select the grid, not the data or labels withing the grid.
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 B. Contextual ribbon > Modify View panel > select Profile View Properties
 C. Profile View Properties dialog box

Profile view properties - information tab

Video: prfl-vu-prprtis-02.mp4 1:09

Continuing from previous exercise.

Profile View Properties dialog box

 1. Information tab
 A. Name: The name of profile view
 B. Description: Create a short description of the profile view.
 C. Object style: Controls the appearance of the objects in the grid; this includes the lines,  

how often the major and minor grids are displayed, how often the major and minor 
elevations are displayed,  what the elevation styles look like, the text size and color, 
and how the band will look.

Warning: If the profile view is split, the object style information will be ignored. 

Profile view properties - stations tab

Video: prfl-vu-prprtis-03.mp4 1:31

Continuing from previous exercise.

Profile View Properties dialog box

 1. Stations tab
 A. Alignment name: Uneditable, has the name of the alignment.
 B. Automatic radial: When selected, the grid will show the full length of the alignment, 

start station to end station.
 C. User specified range radial: When selected, stations can be entered manually or with 

Pick from Screen button. Select Apply to see changes.

Profile view properties - elevations tab

Video: prfl-vu-prprtis-04.mp4 3:03

Continuing from previous exercise.

Profile View Properties dialog box

 1. Elevations tab
 A. Elevation range

 I. Automatic height radial: When selected, minimum is lowest height and max-
imum is the highest height.
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 II. User specified height: When selected, height can be manually entered. Select 
Apply to see changes.

 a. Select radial User specified height
 b. Maximum: type 910
 c. Apply

 B. Split profile view check box: This is useful for printing on multiple sheets or if there's a 
height requirement.

 I. Automatic radial: When selected, it will detect where the paper ends and 
should auto cut it for you.

 II. Manual radial: When selected, you select where you want the adjustments to 
take place.

 a. Check box Split profile view
 b. Select radial Manual 
 c. Split profile view data: 
 d. Select + button
 e. Specify station: turn on OSnap, left-click at 1150 (or type 1150) 

Enter
 f. Specify elevation: type 900Enter
 g. Select + button
 h. Specify station: OSnap, left-click at 1700 (or type 1700) Enter
 i. Specify elevation: type 880Enter
 j. Apply

 III. Elevation range
 a. Change height to 25
 b. Apply
 c. Change height to 30
 d. Apply

 IV. Split profile view data
 a. Line No 1 > Adjusted Datum: change to 880
 b. OK

Profile view properties - profiles tab

Video: prfl-vu-prprtis-05.mp4 1:46

Continuing from previous exercise.

Profile View Properties dialog box

 1. Profiles tab
 A. Draw: check box, controls which Profiles are shown in the view.

 I. Uncheck box Exist - Surface 20.00'
 B. Clip Grid: radial, used to clip the grid at one of the profiles.
 C. Split At: radial, for when you are using automatic split view which then splits at the first 

major, minor, or exact station of the assigned profile.
 D. Offset: Lists offsets
 E. The other stats that are important to verify are Style and Labels values.
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Profile view properties - bands and hatch tabs

Video: prfl-vu-prprtis-06.mp4 1:39

Continuing from previous exercise.

Profile View Properties dialog box

 1. Bands tab
Lists all the band information displayed at the bottom of the grid.

 A. Band type: > Table
 I. Style: Elevation Left (Exist)

 a. Profile 1: leave as CthE-Exist
 b. Profile 2: leave as CthE-Exist

 II. Style: Elevation Right (Proposed)
 a. Profile 1: change to CthE
 b. Profile 2: change to CthE

 III. Apply
 2. Hatch tab

Used for cutting or adding material in the space between the existing and proposed.

 A. Cut Area, Fill Area, and Multiple boundaries are buttons displaying the hatch options.
 B. The table contains editable stats, such as styles.

Profile layout tools
Last updated: 2022-05-16

Total video time: 10:13

Creation tangent-tangent

Exercise file: prfl-data-c3d22.zip

Video: prfl-lyout-tl-01.mp4 3:40

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-CtyE-prfl-lyout-tl-begin.dwg
 C. Open

Open Profile Layout Tools toolbar

 1. Left-click profile view
 2. Contextual ribbon > Modify Profile panel > select Geometry Editor
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Profile Layout Tools toolbar

Tangent-Tangent tool options

 l Draw Tangents - Drawing tangents without curves, but curves can be added.
 l Draw Tangents With Curves
 l Curve Settings - Default setting, every time a curve is created it has a set radius. Curves can be 

adjusted.
 l Convert Curves - Convert free curves through point.

 1. Left-click Tangent-Tangent tool dropdown
 2. Left-click Curves Settings

 A. Vertical Curve Settings dialog box
 I. Select curve type: Parabolic

 II. Crest curves, Length: 200'
 III. Sag curves, Length: 200'
 IV. OK

 3. Left-click Tangent-Tangent tool dropdown
 4. Left-click Draw Tangents With Curves

 A. Specify start point:Shift + right-click > OSnap menu > select Endpoint Left-
click start point of existing alignment

 B. Specify end point: Left-click to top of curve, of existing alignment, following to 
the right.

 C. Specify end point: Left-click to bottom of curve,  of existing alignment, following 
to the right.

 5. Right-click to end command.
Notice tangent has a curve. Left-click on curve to see grip points.

Toolbar creation add and delete PI

Video: prfl-lyout-tl-02.mp4 1:29

Continue from previous exercise.

 1. Profile Layout Tools toolbar > Left-click Tangent-Tangent tool dropdown > Left-click 
Draw Tangents

 A. Specify start point:Shift + right-click > OSnap menu > select Endpoint Left-
click last point of previous tangent (from previous exercise) as the start point.

 B. Specify end point: Left-click a point above existing alignment, following to the 
right.

 C. Specify end point: Left-click a point below existing alignment, following to the 
right.

 2. Right-click to end command.
Notice there are no curves, only tangent lines.
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Insert PVI point

 1. Profile Layout Tools toolbar > Left-click Insert PVI icon
 A. Specify point for new PVI: Left-click a point in the middle of the first tangent. 

Tip: You don't have to check on the line. The command will add a bend to the 
nearest tangent.

 2. Right-click to end command.

Delete PVI point

 1. Profile Layout Tools toolbar > Left-click Delete PVI icon
 A. Pick point near PVI to delete: Hover over PVI and left-click.

 2. Right-click to end command.

Creation by data

Video: prfl-lyout-tl-03.mp4 2:15

Continue from previous exercise.

Create a new proposed profile

 1. X to close Profile Layout Tools toolbar
 2. Ribbon > Home tab > Create Design panel > Profile dropdown > select Profile Creation 

Tools
 3. Select profile view to create profile: Left-click on profile view
 4. Create Profile dialog box

 A. Name: type Cty-E-Prop
 B. OK

 5. Profile Layout Tools toolbar > Left-click Insert PVI - Tubular icon
 A. Insert PVI dialog box

 I. Vertical curve type: Parabolic
 II. Station: type 1000Enter, Elevation: 890Enter, Curve Len: 0Enter

 III. Station: type 1200Enter, Elevation: 897Enter, Curve Len: 200Enter
 IV. Station: type 1400Enter, Elevation: 890Enter, Curve Len: 0Enter
 V. OK

Copy profile design

Video: prfl-lyout-tl-04.mp4 2:49

Continue from previous exercise.
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Copy profile

 1. Profile Layout Tools toolbar > Left-click Copy Profile icon

Info: This process will copy the profile on top of itself, then the copy can be moved or 
accessed.

 A. Copy Profile Data dialog box
 I. Source profile information

 a. Name: CthE
 b. Style: PROF Proposed

 II. Destination profile options
 a. Select Create new profile radial

 III. PVI Range
 a. Select All radial

 IV. OK
 2. Hover over existing profile, Selection Cycling (two boxes) appears

 A. Left-click > Selection Cycling dialog box > select first Profile on list
 3. Profile Layout Tools toolbar > Left-click Raise/Lower PVIs icon

 A. Raise/Lower PVI Elevation dialog box
 I. Elevation change: -6

 II. PVI range
 a. Select All radial

 III. OK
 4. ESC to end command

Delete profile copy

 1. Left-click on copy profile
 2. Verify it is the copy, the toolbar should say (Copy) in the name.
 3. Delete

Create profile with lines and curves
Last updated: 2022-05-16

Total video time: 7:17

Create profiles with lines

Exercise files: prfl-data-c3d22.zip

Video: prfl-lin-crv-01.mp4 2:59
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-CtyE-prfl-lin-crv-begin.dwg
 C. Open

Create profile

 1. Ribbon > Home tab > Create Design panel > Profile dropdown > left-click Profile 
Creation Tools

 2. Select profile view to create profile: Left-click on profile view
 3. Create Profile dialog box

 A. Alignment: CthE
 B. Name: Cty-E-Proposed-2
 C. OK

Add fixed tangent to slope on left side (incoming)

Info: Eyeball your own points.

 1. Profile Layout Tools toolbar > Tangent Line dropdown > left-click Fixed Tangent (Two 
points)

 2. Specify start point:Shift + right-click > OSnap menu > select Endpoint Left-click a 
point near the low vertical point on left side, before curve.

 3. Specify end point: Left-click a point near the high vertical point on left side, before 
curve.

 4. Right-click to end command

Add fixed tangent to slope on right side (outgoing)

Info: Eyeball your own points.

 1. Profile Layout Tools toolbar > Tangent Line dropdown > left-click Fixed Tangent (Two 
points)

 2. Specify start point:Shift + right-click > OSnap menu > select Endpoint Left-click a 
point near the high vertical point on right side, after curve.

 3. Specify end point: Left-click a point near the low vertical point on right side, after curve.
 4. Right-click to end command

Create profile with curves

Video: prfl-lin-crv-02.mp4 4:18

Continue from previous exercise.
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Create free vertical curve

 1. Profile Layout Tools toolbar > Vertical Curve dropdown > Left-click Free Vertical Curve 
(Parabola)

 2. Select first entity: Left-click tangent on incoming slope.
 3. Select next entity: Left-click tangent on outgoing slope.
 4. Specify curve length or [Radius, Passthrough, K]: type REnter
 5. Specify radius or [Length, Passthrough, K]: type 1000Enter
 6. ESC to end command

Create floating vertical curve

 1. Profile Layout Tools toolbar > Vertical Curve dropdown > Left-click Floating Vertical 
Curve (Parameter, through point)

 2. Select entity to attach to: Left-click tangent on outgoing slope.
 3. Specify radius or [K]:Enter to accept default of 5000'
 4. Specify end point: Left-click a point to the right of tangent.
 5. Right-click to end command.

Create floating tangent

 1. Profile Layout Tools toolbar > Tangent Line dropdown > left-click Floating Tangent 
(Through point)

 2. Select entity to attach to: Left-click on last curve.
 3. Select through point: Left-click near the end on existing alignment.
 4. Right-click to end command.

Create fixed vertical curve

 1. Profile Layout Tools toolbar > Vertical Curve dropdown > Left-click Fixed Vertical 
Curve (Three points)

 2. Specify start point:Shift + right-click > OSnap menu > select Endpoint Left-click 
endpoint of floating tangent.

 3. Specify second point: Left-click a point to the right.
 4. Specify end point: Left-click a point to the right.
 5. Right-click to end command.

Create design profile
Last updated: 2022-05-16

Total video time: 9:13

Create design profile

Exercise files: prfl-data-c3d22.zip

Video: prfl-creat-dsn-01.mp4 4:03
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-CtyE-prfl-creat-dsn-begin.dwg
 C. Open

Create design (proposed) profile

 1. Home Tab  >  Create Design panel >  Profile dropdown > left-click Profile Creation Tools
 2. Select profile view to create profile: Left-click on profile view grid.
 3. Create Profile dialog box

 A. Alignment: CthE
 B. Name: type Cty-E-Prop
 C. General tab

 I. Profile style: PROF Proposed
 II. Profile label set: dropdown, select WisDOT Standard

 D. OK
Profile Layout Tools toolbar opens.

Transparent commands

Video: prfl-creat-dsn-02.mp4 5:10

Continue from previous exercise.

Transparent commands are special commands that need a command running before they get star-
ted. They work in conjunction with other commands and won't stop that command from running 
once started. 

Transparent command can be found, usually on the right-hand side of the screen.

The transparent commands that work with profiles:

 l Profile Station Elevation - Specifies a profile view point location by specifying a station and 
elevation.

 l Profile Grade Station - Specifies a profile view point location using grade and station values 
from a known point.

 l Profile Grade Elevation - Specifies a profile view point location using grade and elevation val-
ues from a known point. 

 l Profile Grade Length - Specifies a profile view point location using grade and length values 
from a known point.

Create profile with transparent commands

 1. Ribbon > Home tab > Create Design panel > Profile dropdown > select Profile Creation 
Tools
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 2. Select profile view to create profile: Left-click on profile view grid.
 3. Create Profile dialog box

 A. Alignment: CthE
 B. Name: type CthE-Prop-Trans
 C. OK

 4. Profile Layout Tools toolbar > Tangent tools dropdown > select Draw Tangents
 A. Specify start point:Shift + right-click > OSnap menu > select Endpoint Left-

click on start point of existing profile.
 B. Specify end point: Transparent Command toolbar > Left-click Profile Station Elev-

ation command

 I. Select a profile view: Left-click on profile view grid.
 II. Specify station: type 1375Enter

 III. Specify elevation: graphically select, left-click near 916'.
 IV. Specify station: graphically select, left-click near 1414'.
 V. ESC to end transparent command.

 C. Transparent Command toolbar > Left-click Profile Grade Station command
 I. Specify grade:-5Enter

 II. Specify station:2040Enter
 III. ESC to end transparent command.

 D. Transparent Command toolbar > Left-click Profile Grade Elevation command
 I. Specify grade:5Enter

 II. Specify elevation:904Enter
 III. ESC to end transparent command.

 E. Transparent Command toolbar > Left-click Profile Grade Length command
 I. Specify grade:2Enter

 II. Specify length:10Enter
 III. Specify grade:5Enter
 IV. Specify length:40Enter
 V. ESC to end transparent command.

 F. ESC to end profile creation command.

Edit design profile
Last updated: 2022-11-01

Total video time: 11:19

Edit design profile with grip points

Exercise files: prfl-data-c3d22.zip

Start with prfl-01.dwg

prfl-edit-dsn-01.mp4 2:48
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Endpoint grip point

 1. Select CthE profile.
 2. Left-click the grip point at the end of CtE.
 3. Shift right-click.
 4. Select Endpoint.
 5. Snap the end point snap to the end of the CthE-Exist profile.

Midpoint grip point

 1. Select the square grip point in the middle of the last slope of the CthE profile.
 2. Move the grip point.
 3.  Esc

Curve length grip points

 1. Select the circular grip point at the beginning of the last curve.
 2. Drag it to the right to shorten the length of the curve.

Curve radius grip point

 1. Select the circular grip point in the middle of the last curve.
 2. Move the grip point up and down to graphically change the radius of the curve.
 3. Esc

PVI grip points

PVI adjusting incoming and outgoing slopes

 1. Grab the triangle grip point that points straight up.
 2. Move it up and down, left and right to move the PVI point.
 3. Esc.

PVI maintain one slope

 1. Select the triangular grip point that points to the right.
 2. Move the grip point left and right to adjust the PVI while holding the incoming tangent.
 3. Esc

Edit design profile through toolbar edits

prfl-edit-dsn-02.mp4 2:21

 1. Select the CthE profile.
 2. Context ribbon > Modify panel > Geometry Editor.
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 3. Insert PVI.

 4. Click near the middle slope line.
 5. Delete PVI points.

 6. Click near the PVI point that was just added.
 7. Move PVI.

 8. Select near the sag curve PVI point.
 9. Left-click a new point to the right of the original PVI location.

 10. Esc to end command.

Delete design profile entities

prfl-edit-dsn-03.mp4 1:09

 1. Select the CthE profile.
 2. Context ribbon > Modify Profile > Geometry Editor
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 3. Select the Delete Entity icon.

 4. Select the last tangent line.
 5. Left-click on the curve attached to the last tangent line.
 6. In the toolbar select the Undo icon.

Edit design profile by data grid

prfl-edit-dsn-04.mp4 2:50

 

In the toolbar select Profile Grid View 

In the third entity row make the following changes:

Variable Value

Station 2097

Elevation 895

Grade In -2.5

Grade Out 3

Profile Curve Length 500

K Value 90

Curve radius 8000

Click the X in the title bar to close the Profile Grid View panorama.
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Edit design profile by parameter grid

prfl-edit-dsn-05.mp4 2:13

Select the Select PVI icon.

Select near the PVI at the sag curve.

In the dialog make the following changes:

Variable Value

Grade In -2.5

Grade Out 3

PVI Station 2079

PVI Elevation 899

Profile Curve Length 400

Low Point Elevation 902

Curve radius 1500

K Value 74

Click the X in the upper right of the dialog.

Esc

Profile labels
Last updated: 2022-11-01

Total video time: 4:51

Profile Label sets

Exercise files: prfl-data-c3d22.zip

Start with prfl-01.dwg

prfl-lbl-01.mp4 2:01
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 1. Select the profile view grid.
 2. Context ribbon > Labels > Edit Profile Labels

 A. Select the CthE profile data inside the profile view grid.

 B.  Import Label Set.
 I. Select the WisDOT Standard [ALI DESC]+00 set.

 II.  OK
 C.  OK

 3.  Esc
 4. Select the profile view grid.
 5. Context ribbon > Labels > Edit Profile Labels
 6. Select the CthE profile data inside the profile view grid.

 A.  Import Label Set.
 A. Select the WisDOT Standard set.
 B.  OK

 B. OK

Profile View labels

prfl-lbl-02.mp4 1:41

 1. Select the profile view grid.
 2. Context ribbon > Labels > Add View Labels > Station Elevation.

 A.  1265 Enter.
 B.  912.65 Enter.
 C. Esc

 3. Select the profile view grid.
 4. Context ribbon > Labels > Add View Labels > Depth.

 A. Select a point inside the profile view grid.
 B. Select a second point inside the profile view grid.
 C. Esc

Removing profile labels

prfl-lbl-03.mp4 1:09

 1. Select one of the labels that needs to be removed.
 2. Context ribbon > Modify > Edit Label Group
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 A.  Import Label Set
 B. Select _No Labels
 C. OK

 3. OK

Create best fit profile
Last updated: 2022-05-16

Total video time: 10:33

Create best fit profile, part 1

Exercise files: prfl-data-c3d22.zip

Video: prfl-creat-best-fit-01.mp4 3:59

Warning: Upon review of Autodesk Best Fit profile tools, there does not appear to be a work-
flow that would result in design as acceptable WisDOT design standards. Therefore, 
WisDOT does not recommend using the provided tools, but rather use an alternative workflow 
instead. Only pursue the Best Fit workflow if there's a significant need.

Info: This workflow will be mostly hand drawn, with curves being created using K Value inputs.

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-CtyE-prfl-creat-bst-fit-begin.dwg
 C. Open

Create proposed profile

 1. Ribbon > Home tab > Create Design panel > Profile dropdown > select Profile Creation 
Tools

 2. Select profile view to create profile: Left-click profile view.
 3. Create Profile dialog box

 A. Alignment: CthE
 B. Name: type Cty-Prop-Best Fit
 C. OK

 4. Profile Layout Tools toolbar > Tangent-Tangent tool dropdown > select Draw Tangents
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 5. Specify start point:Shift + right-click > Endpoint OSnap > Left-click CthE-Exist pro-
file start point.

 6. Specify end point: Left-click a point at top of curve.
 7. Specify end point: Continuing to the right, left-click a point at the middle of slope.Tip: If 

you need to adjust one of the tangent's slopes, but not the other, use the triangle grip point 
that is in the direction of the slope that needs to be maintained.

 8. Right-click to end command.
 9. Profile Layout Tools toolbar > Vertical Curve tool dropdown > More Free Vertical 

Curves > select Free Vertical Parabola (PVI based)
 10. Pick point near PVI or curve to add curve: Left-click near PVI
 11. Specify curve length or [Passthrough, K]: type KEnter
 12. Enter K value or [Length, Passthrough]: type 45Enter
 13. Enter to end command.
 14. Graphically make adjustments, left-click and drag grip points.
 15. ESC

Create best fit profile, part 2

Video: prfl-creat-best-fit-02.mp4 3:12

Warning: Upon review of Autodesk Best Fit profile tools, there does not appear to be a work-
flow that would result in design as acceptable WisDOT design standards. Therefore, 
WisDOT does not recommend using the provided tools, but rather use an alternative workflow 
instead. Only pursue the Best Fit workflow if there's a significant need.

Continue from previous exercise.

Create tangents that do not meet at PVI point

 1. Profile Layout Tools toolbar > Tangent Line tool dropdown > select Fixed Tangent 
(Two-points)
All points are eye-balled, graphically picked.

 2. Specify start point: Left-click a point near incoming tangent's endpoint.
 3. Specify end point: Left-click a point that follow the length of the slope.
 4. Specify start point: Left-click a point near the endpoint of previous tangent.
 5. Specify end point: Left-click a point extending past the curve.
 6. Specify start point: left-click a point at start of outgoing slope.
 7. Specify end point:Shift + right-click > Endpoint OSnap > Left-click CthE-Exist profile 

end point.
 8. Profile Layout Tools toolbar > Vertical Curve tool dropdown > select Free Vertical 

Curve (Parabola)
 9. Select first entity: Select on incoming line.

 10. Select next entity: Select next outgoing line.

Tip: If commandline is not asking for K Value, type KEnter to change the command.
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 11. Enter K value or [Radius, Length, Passthrough]: type 175Enter
 12. Select first entity: Select on incoming line.
 13. Select next entity: Select next outgoing line.
 14. Enter K value or [Radius, Length, Passthrough]:Enter
 15. Select first entity: Select on incoming line.
 16. Select next entity: Select next outgoing line.
 17. Enter K value or [Radius, Length, Passthrough]: type 53Enter
 18. ESC to end command.

Create best fit profile, part 3

Video: prfl-creat-best-fit-03.mp4 3:22

Warning: Upon review of Autodesk Best Fit profile tools, there does not appear to be a work-
flow that would result in design as acceptable WisDOT design standards. Therefore, 
WisDOT does not recommend using the provided tools, but rather use an alternative workflow 
instead. Only pursue the Best Fit workflow if there's a significant need.

Continue from previous exercise.

Create copy of existing conditions

 1. Left-click on existing surface profile in profile view.
 2. Contextual ribbon > Modify Profile panel > select Profile Properties
 3. Profile Properties dialog box

 A. Profile Data tab
 I. Update Method: change to Static

 B. OK

Info: If you make a change to this profile, it will no longer be connected to the existing 
ground.

 4. Profile still selected.
 5. Contextual ribbon > Modify Profile panel > select Geometry Editor
 6. Profile Layout Tools toolbar > select Copy command
 7. Copy Profile Data dialog box

 A. PVI Range 
 I. All radial is selected.

 B. Destination profile options
 I. Create new profile radial is selected.

 C. OK
 8. ESC to end command.
 9. Hover over profiles > left-click > Selection Cycling dialog box > select second Profile on 

list
 10. Contextual ribbon > Modify Profile panel > select Profile Properties
 11. Profile Properties dialog box

 A. Profile Data tab
 I. Update Method: change to Dynamic
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 B. OK
 12. ESC to end command.
 13. Hover over profiles > left-click > Selection Cycling dialog box > select first Profile on list

Tip: To verify this is the copy profile, the Profile Layout Tools toolbar will have Copy in 
the name, Cty-Exist [Copy].

 14. Contextual ribbon > Modify Profile panel > select Profile Properties
 15. Profile Properties dialog box

 A. Information tab
 I. Name: Cty-Prop-Best Fit

 B. OK
 16. Profile Layout Tools toolbar > select Delete PVI command

 A. Left-click to remove PVIs, as needed.
 17. ESC to end command.
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Roadway design
Roadway design requirements, tips, info, and warnings
Last updated: 2020-10-26

Create corridor surfaces as early as you can in the design process.
When creating a design corridor, create the corridor surfaces immediately along with it. Maintain the 
corridor surface feature line list as the design concept evolves. Inspect these surfaces as design 
modifications are made.

A design can look OK in the corridor, but it might not be structured properly to make corridor sur-
face development as easy as it should be. This structural problem in the corridor data can lead to sig-
nificant design rework if it isn't identified early. Fortunately there is an easy way to see these 
problems. They show up visibly in the surface models. 

Significant time will be spent reworking design if corridor surfaces are not created early and the res-
ulting surface models inspected as the design progresses.

Why corridor links are not allowed to define, or help define corridor sur-
faces:
Methods hears this question frequently, presumably because the use of corridor links would save 
time in defining and maintaining the definition of corridor surface models. Making the use of cor-
ridor links even more attractive is the "overhang correction" functionality in corridors that helps 
clean up areas of vertical links in our corridor surfaces. With all these benefits tied to the use of cor-
ridor links in surface definition, why does WisDOT require corridor surfaces be defined by corridor 
feature lines only? 

Let's discuss the Design Model deliverables before answering this question. Here are a few key 
aspects of the Design Model deliverables:

 l The principle component of Design Model packages are surface models.  The surface models 
communicate design intent clearly, more so than the other deliverables in the Design Model.

 l Proposed surface model longitudinal breaklines are also an important deliverable. Some con-
tractors will choose not to use Design Model surface models in construction operations, and 
will instead develop their own sets of surface models that suit their construction operations 
and workflows. Contractors who anticipate following this practice have clearly stated that the 
longitudinal breaklines of proposed surfaces will be most useful to them in their Construction 
Model development efforts.

 l The primary source of longitudinal breaklines in the Design Model surface models is the list 
of corridor feature lines used to define corridor surfaces. 

 l It is critical that all the data in Design Models be:
 o Consistent with the plan
 o Consistent with itself
 o Must be complete, with no missing information.
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Again, why not use corridor links to define surface models?

 l One reason is that using corridor links to define corridor surfaces significantly increases the 
risk that the designer will not specify all the needed corridor feature lines in the corridor sur-
face definition, leading to delivery of an incomplete set of breaklines in the Design Model 
package. By adding corridor links to the definition, the designer will fix problems in the cor-
ridor surface related to missing corridor feature lines. This is bad. Those problems should be 
visible to the designer, not hidden or fixed behind the scenes. If corridor links are not used in 
surface definition, the absence of needed corridor feature lines will be clearly visible to the 
designer, especially in corridor section editor. When corridor links are used in the surface 
definition, the missing corridor feature line problems are hidden from the designer making it 
very easy to deliver an incomplete set of longitudinal breaklines in the Design Model. The end 
result: a Design Model package with surface models that are inconsistent with breaklines. 
This is a deal-breaker as far as the use of corridor links is concerned, WisDOT deliverable 
requirements will disallow use of corridor links in corridor surface definition until this prob-
lem is resolved.

 l Overhang correction functionality cleans up surface model triangulation in areas of vertical 
links, but it does not correct the problem in the longitudinal breaklines. If overhang correction 
is used to fix these problems in design, the problems will reappear when contractors use 
Design Model breaklines to develop Construction Model surfaces. See "3. How can I correct 
vertical link problems in my proposed surface models without using "overhang correction" 
with corridor links in the corridor surface definition, or without using a surface edit actions on 
the refinement surface? #fix-vert-link" below for a method to collect these vertical link prob-
lems without using "overhang correction".

 l Longitudinal breakline data leads to better, more consistent roadway surface model tri-
angulation than cross sectional patterned data. This is a similar concept as survey collection. 
Originally WisDOT collected survey data for DTM surfaces in the traditional cross sectional col-
lection pattern. Experience taught us that longitudinal breakline collection of roadway data 
results in better triangulation overall, and survey collection practices changed to a lon-
gitudinal feature based collection pattern for existing ground surface models. The same is 
true for proposed surface models. Many times that triangulation from cross sectional ele-
ments, such as corridor links, is OK. But some situations that commonly appear in roadway 
terrain areas will triangulate incorrectly with cross sectional based data, use of longitudinal 
roadway features (corridor feature lines) corrects those triangulation errors.

Vertical links
3. How can I correct vertical link problems in my proposed surface models without using "overhang 
correction" with corridor links in the corridor surface definition, or without using a surface edit 
actions on the refinement surface? #fix-vert-link

 l A vertical link is created when 2 corridor feature lines (CFLs) that are the same offset distance 
from the baseline, are both used in defining the same surface model. Fix the vertical link prob-
lem by inserting LinkWidthAndSlope subassembly to your assembly. 
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 l Using a generic link subassembly like LinkWidthAndSlope, create a new CFL to replace one of 
the old CFLs from the vertical link. Offset the new CFL from the old CFL by 0.01'. Use the new 
CFL in the corridor surface definition, remove the old CFL from the corridor surface definition.
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System performance
When modifying corridors, turning off all baselines that are outside the area you are working in will 
improve system performance. When finished working with the corridor turn all baselines back on 
and rebuild the corridor before saving and closing the DWG file, this will ensure the corridor surfaces 
are completely constructed through the full extents of the corridor.
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Parameter overrides
Avoid using "Parameter Overrides" to make changes to your corridor. Make the needed to changes 
to the input parameter values in your assemblies instead.

Parameter overrides will save time when initially used, but will cost you much lost time overall.

Parameter overrides are tied to a station, not a location in coordinate space. If baseline stationing 
shifts, parameter overrides are all incorrect and must be redone.

Design changes are difficult to execute within corridors that are heavy on parameter overrides.

Changes made in parameter overrides are much less visible in the design data than are independent 
assemblies and regions. 

Info: Parameter overrides can be a useful tool for experimenting with results of different input 
parameter values. But once the correct input parameter solution is identified, remove the para-
meter overrides and implement the changes with a copy of the assembly and new corridor 
region.

Conditional subassemblies
Explore using conditional subassemblies ConditionalHorizontalTarget and ConditionalCutOrFill in 
your designs.

These can save a lot of time in design by: consolidating multiple typical section scenarios within a 
single assembly, reducing corridor structure complexity by reducing number of regions. 

ConditionalHorizontalTarget makes transition locations between typical sections easier to adjust 
because the locations are defined by a target object that can be moved easily. ConditionalCutOrFill 
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makes it easier to manage multiple daylighting solutions within a single assembly/region. There are 
many other timesaving uses of conditional subassemblies, they are very flexible tools that open up 
opportunities for creative corridor design solutions.

Use a target oriented philosophy in corridor design
Don't try to manage all the roadway cross section geometry changes with input parameters, use hori-
zontal and vertical target objects to define geometry when you can. Create target objects for applic-
able horizontal roadway features.

Use single object representation in design data
Don't have multiple objects representing the same thing, use a single object and reference it when 
needed. Design changes are much easier to manage when this approach is followed. 

 l Example: Use the same objects for corridor targeting that are used for plan sheet roadway 
feature graphics. Doing so will help keep plan sheets and Design Models synchronized.

Info: Note: Be careful about making copies. If you copy a dwg, you now have 
a copy of all the objects that lived in the original dwg. Those objects now need 
to be renamed in the new dwg.

Viewing surfaces
Don't just look at surfaces in the corridor section editor. This only tells part of the story. Orbit around 
the surface to look for problems early and often.

Building corridors
Build as much of your design as you can in the corridor. You can do more than you think there.

Building surfaces
Refinement surfaces represent the current state of your design. Corridors are one source of refine-
ment surface definition, but feature lines and other 3D linework can also be used as breaklines 
and/or grading surfaces.

Intersections
Build corridors from intersections outward. Designing in Civil 3D is easier if this is done.

Assemblies
Use copies of assemblies in different regions rather than reusing the same assembly in multiple 
regions

Unintended changes can occur to a design when there are multiple regions using the same 
assembly. The assembly could be modified for a specific situation, forgetting the modification will be 
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applied to the other regions. It is better to have multiple identical assemblies of different names 
than it is to have a single assembly used multiple times.

Combining surfaces
Projects with multiple design corridors can combine multiple corridor surfaces (of the same type) 
into a single refinement surface by using multiple "Paste" operations.

Subassembly types
Use both WisDOT subassemblies and Autodesk subassemblies.

The 2 subassembly libraries can be used effectively in the same design. 

The one problem with this in practice is the combining of WisDOT subassemblies with Autodesk sub-
assemblies using Axis of Rotation (AOR) superelevation functionality. Use of AOR requires dif-
ferences in baseline superelevation definition that are not compatible with WisDOT subassemblies. 
See " Don't use WisDOT subassemblies in the same baseline (horizontal reference line) as Autodesk 
subassemblies with Axis of Rotation (AOR) superelevation functionality. #dont-mix-sub" below.

Subassembly with superelevation functionality
 Don't use WisDOT subassemblies in the same baseline (horizontal reference line) as Autodesk sub-
assemblies with Axis of Rotation (AOR) superelevation functionality. #dont-mix-sub

 

Use of AOR requires differences in the baseline's superelevation definition that are not compatible 
with WisDOT subassemblies. If you need to use Autodesk AOR subassemblies in your design, don't 
use the WisDOT subassemblies with slope control by superelevation on the same baselines as the 
Autodesk AOR subassemblies.

Generic links
It is possible to build your entire roadway assembly with generic link subassemblies. That may not be 
the best way to construct an assembly, but thinking that way can help solve unique assembly prob-
lems for which there is no subassembly.

Downstream design
Keep the data flowing down stream. (Follow the Civil 3D Project Data Map)

There is a uni-directional flow to the data relationships in the WisDOT roadway design workflow, the 
Civil 3D Project Data Map depicts this idea. Keeping this concept in mind will help keep your project 
data structured and operating correctly, and help you avoid data problems such as circular ref-
erences.

Target naming
For subassemblies that require targeting, name them so you know what the target should be. 
Example name: TARGET-ETW AliProf and SideRoad AliProf

Dividing corridors
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A corridor can easily be broken apart into multiple corridors in separate files, but multiple corridors 
cannot be combined together easily.

Surface profiles
Do not create data shortcuts of surface profiles. Instead, data reference the surface and create the 
surface profile in each drawing it is needed.

This practice reduces the total amount of objects in your data shortcut list. This practice will also 
make it easier to avoid circular references, and it may improve system performance in some situ-
ations.

Surface edit tools
Avoid use of surface editing tools. It is better to make changes through corridor tools, or use of fea-
ture line and 3D linework as breaklines, and the Civil 3D grading tools.

Use of surface edit tools will make changes to the surface model, but those changes will not be in the 
breakline delivery for those surfaces, leading to Design Model data inconsistency. These design 
changes can be made in a way that will promote better data consistency.

Example: using the "Swap Edge" command can alter triangulation of a refinement surface as desired, 
but the same can be accomplished by adding a feature line or 3D poly or line as a breakline to the 
refinement surface.

Longitudinal breaklines

Info: The purpose of the corridor in our design workflow is to create the lon-
gitudinal breaklines of our proposed work surface models.

Refinement surfaces

Info: Refinement surfaces represent your finished design work, they are the 
design goal. Refinement surfaces are the surface models for proposed work 
in Design Model delivery. 

Cross sections
Surface models are the goal of roadway design, not cross sections.

Cross sections have traditionally been the primary goal of roadway design, but not anymore. They 
have been replaced by surface models as the primary form of roadway design output. Cross sections 
are now a by-product of the design process. Develop Design Model surface models correctly, and 
then cut sections on those surface models for plan sheets.

Corridor link graphics
It is OK to use corridor link graphics in plan sheet section views.
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Some people prefer the look of cross sections achieved by keeping corridor links visible in plan sheet 
section views, this is acceptable practice.  

But, in all cases, the correct refinement surface models must be visible in plan sheet section views 
also. This is a key quality control element in our design workflow that helps ensure plan sheets and 
Design Models are consistent with each other.

Unneeded corridor feature lines
Turn off connection of unneeded corridor feature lines to improve system performance.

Some subassemblies produce corridor points which are assigned multiple point codes. When a cor-
ridor is constructed, by default a corridor feature line is created for each corridor point code. Cor-
ridor points with multiple codes produce multiple coincident corridor feature lines. The redundant 
corridor feature lines can be turned off by un-checking them in the Corridor Properties dialog box as 
shown below, only 1 corridor feature line per corridor point is needed to define surface models.

Subassemblies and assemblies
Subassembly elements
Last updated: 2020-10-26

Total video time: 04:56

Subassembly elements

sa-sub-elemnt-01.mp4 04:56
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   A. Hover over subassemblies to highlight

 B. Point Codes
 n Hover over point codes for more information
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 C. Links
 n Hover over links for more information

 D. Shape codes
 n Left Click on CGBasic
 n Contextual Ribbon>Subassembly Properties>Subassembly Properties dialog 

box>Codes tab

Tip: To re-size point markers and labels, adjust drawing scale

Subassembly parameters
Last updated: 2020-10-26

Total video time: 04:56

Subassembly parameters
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sa-sub-prmtr-01.mp4 04:56

Exercise files: sub-asmbly-data-c3d16.zip

Start with sa-asmbly-begin.dwg

sa-sub-prmtr-01.mp4 04:56

 1. WisDOT Design tab > Palettes On/Off > Assemblies & Subassemblies > WisDOT & Civil 
Imperial

 2. Select the Lanes & Shoulders tab of the Tool palette
 3. Left Click on LnExtendBase

 4. Scroll down in the Properties Panel
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 5. Make necessary changes to subassembly parameters
 6. Left Click on Assembly marker
 7. Esc

 

Corridor targets in subassemblies
Last updated: 2020-10-26

Total video time: 03:00

Corridor targets in subassemblies

sa-sub-crdr-trgt-01.mp4 03:00

Subbassembly target types

 l Horizontal targets
 l Vertical targets
 l Surface targets

To view the default parameters for a subassembly

 1. Left Click to select subassembly
 2. Contextual ribbon > subassembly Properties
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 3. Subassembly properties dialog box > parameters tab

AutoDesk and WisDOT subassemblies
Last updated: 2020-10-26

Total video time: 02:59

Autodesk and WisDOT subassemblies

sa-sub-adsk-wisdot-01.mp4 02:59

There are 2 set of subassemblies in the WisDOT template files

Autodesk subassemblies and WisDOT provided subassemblies

To access subassemblies
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 1. Ribbon>WisDOT Design tab>Tools panel>Palettes ON/OFF

 2. Ribbon>WisDOT Desgn tab>Assemblies & Subassemblies panel>WisDOT & Civil Imper-
ial

 3. Left Click on the bottom of the tabs on the tool palette 
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WisDOT Subassemblies are ALL CAPS

Do not mix WisDOT and Autodesk Lanes and Shoulders subassemblies

Subassemblies that superelevate
Last updated: 2020-10-26

Total video time: 03:47

Subassemblies that superelevate

sa-sub-supr-01.mp4 03:47

To view or modify the superelevation function of a subassembly

 1. Left Click on Subassembly
 2. Contextual ribbon > Subassembly Properties > Subassembly properties dialog box > 

Parameters tab
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 o Scroll down to superelevation data field
 o Left Click in field to access Pick Default Value dialog box

 o Select desired value
 o Ok

Superelevation fields vary from subassembly to subassembly. Check parameters carefully and thor-
oughly.

Conditional subassemblies
Last updated: 2020-10-26

Total video time: 06:11

Conditional subassemblies Cut/fill targets

sa-sub-cndtnl-01.mp4 03:25

To access default conditional subassemblies
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 1. Ribbon > WisDOT Design tab > Palettes ON/OFF

 2. Ribbon > WisDOT Design tab > WisDOT & Civil Imperal

 3. Left Click on bottom of tabs in Tool Palette

 4. select Conditional
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 5. Left Click on ConditionalCutFill to access options for the subassembly

Info: The width and slope settings in the parameters of conditional subassemblies has no 
effect on the design. It is purely a visual reference.

Conditional subassemblies Horizontal targets

sa-sub-cndtnl-02.mp4 02:46

Left Click on ConditionalHorizontalTarget to access options for the assembly.

Info: The width and slope settings in the parameters of conditional subassemblies has no 
effect on the design. It is purely a visual reference.
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Subassembly help files
Last updated: 2020-10-26

Total video time: 04:42

Subassembly help files

sa-sub-hlp-01.mp4 04:42

To access the subassembly help files

 1. Navigate to desired subassembly in Tool Palette
 2. Right Click on subassembly
 3. Select Help

Addituionally to access WisDOT subassembly help files

 1. Ribbon > WisDOT Design tab > Subassembly Help

Page: 726

Published on: 5/17/2023

Subassembly help files

https://c3dkb.dot.wi.gov/video/rdwy-dsn/sub-asmbly/sa-sub-hlp-01.mp4


Tip: You can also use the command SHOWWISSUBHELP to access WisDOT subassembly help 
files.

Assembly basics
Last updated: 2020-10-26

Total video time: 11:42

Assembly basics

Exercise files: sub-asmbly-data-c3d16.zip

Start with sa-asmbly-begin.dwg

sa-asmbly-basc-01.mp4 02:04

Create assembly

sa-asmbly-basc-02.mp4 03:39

 1. Home tab of ribbon > Create Design panel > Assembly drop down > Create Assembly

 A. Name: CthE-10+00 to 25+00
 B. Assembly Type: Other
 C. Assembly Style: WisDOT Standard
 D. Code set style: CRDR Proposed
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 E. OK
 2. Left Click to place assembly
 3. Double check label

Connect subassemblies to assembly

sa-asmbly-basc-03.mp4 02:59

Ribbon > WisDOT Design tab > Palettes ON/OFF > WisDOT & Civil Imperial

 1. LANES tab of TOOL PALETTE
 2. Left click LnExtendBase
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 3. PROPERTIES panel
 A. Lane width: 15

 4. Left click on Assembly marker
 5. Left click on ShldGeneric

 6. Left click on appropriate marker
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 7. Select the DAYLIGHT tab of the tool palette
 8. Left Click DaylightProfileControlled subassembly

 9. Left click on appropriate marker
 10. Right click and select Cancel
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Naming subassemblies in an assembly

sa-asmbly-basc-04.mp4 01:36

 1. Left Click on subassembly
 2. Contextual ribbon > Modify Subassembly panel > Subassembly Properties

 3. Subassembly Properties dialog box  >  Information tab
 4. Name: LnExtendBase-L-TARGETBikeLane
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 5. OK

Referencing subassembly parameters

sa-asmbly-basc-05.mp4 02:24

 1. Left Click on Assembly Marker
 2. Contextual ribbon > Modify assembly > Assembly Properties

 3. Assembly Properties dialog box > Construction tab > Item Window
 4. Left click to Select Left > ShldGeneric
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 5. In the Input values window, scroll down to Paved shoulder slope
 6. Click the Use checkbox

 7. In the Get value from field, select LnExtendBase-L-TARGET-BikeLane.Pavement slope 
[Output]
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 8. OK

Commands to change structure of subassemblies in assemblies
Last updated: 2020-10-26

Total video time: 04:53

Commands to change structure of subassemblies in assemblies

Exercise files: sub-asmbly-data-c3d16.zip

Start with sa-asmbly-04.dwg

sa-asmbly-sub-cmnd-01.mp4 04:53

Important to NOT use the base AutoCAD copy, mirror, or move commands with subassemblies.

Mirror

 1. Select subassemblies to mirror
 2. Contextual ribbon > Modify Subassemblies panel > Mirror
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 3. Select Assembly marker

 4. Esc
Create new assembly

 1. Ribbon > Home tab > Create Design panel > Assembly > Create Assembly

 2. Create assembly dialog > Name field
 3. Type CthE-25+00 to 35+00
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 4. OK
Copy

 1. Select lane subassembly on right side 

 2. Contextual Ribbon > Modify Subassemblies panel > Copy
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 3. Left click on Assembly Marker

 4. Window select all left side subassemblies

 5. Contextual Ribbon > Modify Subassemblies panel > Copy

 6. Left Click on Assembly marker
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 7. Left Click on left side shoulder subassembly

 8. Contextual Ribbon > Modify Subassemblies > Mirror
 9. Left Click on white edge of traveled way marker on right side lane

Move
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 1. Select subassembly to move

 2. Contextual Ribbon > Modify Subassemblies panel > Move
 3. Left click on subassembly point marker of desired location

Copy assembly
Last updated: 2023-01-25

Overview

The WisDOT Copy Assembly function makes is possible to copy an assembly within the same DWG or 
to another DWG. The function is access through the assembly object right click menu.
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Usage

 1. Select assembly > Right-click > Copy Assembly

 2. Right-click > Paste > Paste (places the copy at the cursor coordinates)

Or

Right-click > Paste > Paste to Original Coordinates  (places the copy at the same location 
as the original)

Warning: Only the assembly can be selected in modelspace for WisDOT Copy Assembly to 
work from the right-click menu.

Editing subassembly parameters in assemblies
Last updated: 2020-10-26

Total video time: 02:33

Editing subassembly parameters in assemblies

Exercise files: sub-asmbly-data-c3d16.zip

Start with sa-asmbly-06.dwg

sa-asmbly-edit-sub-prmtr-01.mp4 02:33

Method 1

 1. Left Click on Assembly Marker
 2. Contextual ribbon > Modify Assembly panel > Assembly Properties
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 3. Assembly Properties dialog box > Construction tab
 4. In the Items window > Baseline > RightLeft Click on LnExtendBase

 5. In the Input Values window, scroll down to Lane Width
 6. Change value to 20
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 7. Apply
 8. OK

Method 2

 1. Left Click on subassembly
 2. Contextual ribbon > Subassembly Properties

 3. Subassembly Properties dialog box > Parameters tab
 4. Input Values window change the Lane width value to 15
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 5. OK
Method 3

 1. Left Click on subassebly
 2. Right Click
 3. Properties

 4. In the Properties panel, scroll down to the parameters
 5. Change lane width value to 16
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 6. Esc

Place WisDOT assembly in modelspace from tool palette
Last updated: 2020-10-26

Total video time: 01:38

Place WisDOT assemby in model space from tool palette

Exercise files: sub-asmbly-data-c3d16.zip

Start with sa-asmbly-07.dwg

sa-asmbly-plac-wisdot-01.mp4 01:38

Page: 744

Published on: 5/17/2023

Place WisDOT assembly in modelspace from tool palette

https://c3dkb.dot.wi.gov/data/rdwy-dsn/sub-asmbly/sub-asmbly-data-c3d16.zip
https://c3dkb.dot.wi.gov/video/rdwy-dsn/sub-asmbly/sa-asmbly-plac-wisdot-01.mp4


 1. Ribbon>WisDOT Design tab>Tools panel>Palettes ON/OFF

 2. Left Click on BEAM GUARD ASSEMBLIES tab

 3. Left Click on Beam Guard assembly
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 4. Left Click desired location in model space
 5. Enter

Create custom assembly
Last updated: 2020-10-26

Total video time: 04:46

Create custom assembly

Exercise files: sub-asmbly-data-c3d16.zip

Start with sa-asmbly-07.dwg

sa-asmbly-creat-cstm-01.mp4 04:46

 1. Home tab of ribbon > Create Design panel > Assembly > Create Assembly

 2. Name new assembly CthE-L-ETW-12+50 to 14+25
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 3. OK
 4. Left click in model space to place assembly
 5. Select the right side lane subassembly from the assembly above

 6. Contextual ribbon > Modify Subassebly panel > Copy
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 7. Left click on assembly marker CthE-L-ETX-12+50 to 14+25
 8. Left click on newly copied subassembly
 9. Contextual ribbon > Modify Subassembly panel > Subassemby Properties

 10. Select the Parameters tab of Subassembly properties dialog box
 11. Change the Pavement slope value to 2
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 12. OK
 13. Select the right side lane assembly from the assembly above
 14. Contextual ribbon > Modify Subassembly > Copy
 15. Left click on white marker of lane assembly

 

 16. Select the right side shoulder and daylight subassemblies from the assembly above
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 17. Contextual ribbon > Modify Subassembly panel > Copy
 18. Left click on white marker of newest lane subassembly

 19. Select the left side shoulder and daylight subassmblies from the assembly above

 20. Contextual ribbon > Modify Subassembly panel > Copy
 21. Left Click on assembly marker CthE-L-ETW-12+50 to 14+25
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Review subassembly parameters

 1. Left click on subassembly
 2. Contextual ribbon > Modify Subassembly panel > Subassembly Properties

 3. Parameters tab of Subassembly Propeties dialog box
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 4. Verify parameters are correct for assembly conditions
 5. OK

WisDOT subassemblies and superelevation (Civil 3D 2012 and bey-
ond)
Last updated: 2015-04-21

WisDOT subassemblies and superelevation (Civil 3D 2012 and beyond) 

Civil 3D 2012 provides new superelevation controls.  This content explains what the new functionality 
means for users of the WisDOT subassembly library.

New features
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The C3D2012 stock subassembly library is built to work in tandem with new superelevation controls 
in the superelevation wizard to add flexibility in defining how corridors handle superelevation. If you 
want to explore the new superelevation controls, build an assembly using Autodesk's LaneSuper-
elevationAOR subassembly, run through different combinations of superelevation configurations, 
and monitor the changes to the assemblies' behavior in a corridor. Controls like the inputs for Poten-
tial Pivot, Slope Direction, and specifying SE side different from insertion direction all work to allow 
flexibility in defining the Axis of Rotation through superelevation transitions.

The WisDOT subassembly library is not built to use this functionality. In fact, with some combinations 
of Superelevation wizard inputs, WisDOT subassembly corridors will produce a slew of error mes-
sages and may not read the intended lane slopes. The WisDOT subassembly library already has the 
superelevation controls needed for WisDOT design standards built into lane and shoulder sub-
assembly logic. If you choose to use the WisDOT library for your roadway lanes and shoulders, the 
alignment superelevation should be developed in the superelevation wizard as follows:
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Remember to run the Superelevation Update macro and you now have the baseline superelevation 
properties needed to use WisDOT subassemblies in your corridors. This same Undivided – Crowned 
superelevation setup will work for all cases of general roadway design with WisDOT subassemblies.

For more information on WisDOT's superelevation macro and why it is needed, see Civil 3D New 
User Training, alignments module.

WisDOT subassembly inputs

So how do you set up your WisDOT subassemblies' superelevation controls in this system? For 
detailed information on subassembly behavior, review the subassembly help files. To help you get 
started, here's a look at several different roadway typical section types:

Case 1: Single lane ramp, crown at lane edge, planar subgrade (shoulder slopes down at crown but 
subgrade continues upward)
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Case 2: Undivided Roadway with crown (Left side same settings as right)
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Case 3: Divided Roadway with median, baseline at median edge or center of median, crown between 
lanes (only showing one of the divided roadways, the other is a mirror image)
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Frequently asked questions

What do you prefer that we do? Use WisDOT lane/shoulder subassemblies, or stock? Should I change 
my assemblies to use the stock subassemblies?

Some possible scenarios: 

I'm starting a new corridor
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My corridor is built, but there's time to change it

I have a PS&E in 4 months

The choice is yours. We developed the WisDOT subassemblies to use point, link, and shape codes 
that are compatible with the stock subassemblies' codes, allowing use of WisDOT and Autodesk sub-
assemblies side-by-side resulting in consistent surface and corridor output. And, with the new super-
elevation functionality in C3D2012 the Autodesk lanes and shoulders subassembly offerings have 
the needed controls to develop superelevation as per our design standards. So you have some flex-
ibility to choose which subassemblies work best for your design intentions.

There are limitations to this flexibility however. Each alignment has a single set of superelevation 
properties, and these superelevation properties may need to be different for WisDOT subassemblies 
vs. Autodesk subassemblies because of the differences in subassembly logic. The WisDOT sub-
assemblies can't correctly read the Axis of Rotation information created by some input combinations 
in the Superelevation Wizard, so you shouldn't use both Autodesk and WisDOT lanes/shoulders on 
the same corridor baseline alignment. For each baseline alignment, use all WisDOT subassemblies 
on superelevated parts of your assemblies, or use all Autodesk subassemblies on superelevated 
parts of your assemblies. Don't mix up lanes and shoulders subassemblies, or other superelevated 
subassemblies, on the same baseline alignment. You can use non-superelevated WisDOT sub-
assemblies in combination with Autodesk lanes and shoulders.

Keep in mind there is other functionality in some of the WisDOT lanes and shoulders that isn't cur-
rently in the stock subassemblies. So you have to choose what's right for your situation. 

Are you telling us to never use "Use Inside Lane SE"? What about an urban roadway with parking 
lanes where the parking lane slope varies to match adjacent properties? Wouldn't we need to use 
inside and outside lane superelevation there?

You can still use Inside Lane superelevation definition for situations that need it. WisDOT sub-
assemblies will correctly read the Inside Lane SE data. To include the Inside Lane Superelevation con-
tainers in an alignment's superelevation properties, use a number value of 2 in the Number of lanes 
field in the Lanes dialog box of the Superelevation Wizard, other settings are as shown above.
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You probably will not get design-ready results from the Superelevation Wizard in this scenario; you 
may have to do some manual editing of the lane slope values and transition locations in the tabular 
editor. 
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Another way to do mass changes is to the tabular editor superelevation data is to export to a csv file, 
edit the csv file in Microsoft Excel, and import the edited csv back into the alignment's tabular editor 
superelevation data. A csv file is a comma-separated value file that can be opened in Excel and 
edited with common spreadsheet copy-paste functions.

Update subassemblies in existing files
Last updated: 2021-02-12

While infrequent, WisDOT will sometimes update an existing subassembly with new parameters. An 
example of this is the subassembly updates of October 2018 of DaylightProfileControlled and 
CutFillProfileControlled.

After updating WisDOT customizations, the new subassemblies will be included in subassemblies 
and assemblies from the WisDOT tool palettes.

For existing corridor files:

 l They will not automatically get the updates with the new subassemblies.
 l There is no requirement to update subassemblies. If you do not need new functionality it is 

recommended to not update the subassemblies.
To update subassemblies in existing corridor files:

 1. Open Corridor Properties > Parameters tab > Uncheck all regions > Apply > Rebuild 
the corridor to rebuild an empty corridor. This is required to clear out the old subassembly 
definition from the corridor.

 2. Right-click the new subassembly on the tool palette > Properties... > Set any default 
input parameters needed

 3. Click the new subassembly from the tool palette.
 4. rEnter to start the replace option for subassembly insert. This is the only insertion method 

that will retain parameter targeting.
 5. Select the subassembly in the assembly to replace > Keep similar targeting
 6. Repeat for all instances of the subassembly to replace.
 7. Open Corridor Properties > Parameters tab > Check all regions > Apply > Rebuild the 

corridor

Corridor modeling fundamentals
Corridor basics
Last updated: 2020-10-26

Total video time: 03:14

crdr-basc-01.mp4 03:14

crdr-data-c3d16.zip

Corridor Object - A 3 dimensional object built from horizontal, vertical and cross sectional geo-
metry.
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Alignment - Controls the horizontal geometry of a corridor object

Profile - Controls the vertical geometry of a corridor object

Assembly - Controls the cross sectional geometry of a corridor object

Corridor properties
Last updated: 2020-10-26

Total video time: 08:03

Regions

Exercise files: crdr-data-c3d16.zip

Start with CthE.dwg

crdr-prprtis-01.mp4 02:31

Regions of a corridor are defined by a station range and an assembly

To set the station range

 1. Left click in the Start Station column
 2. Type 1000
 3. Left click in the End Station Column
 4. Type 3250

 5. Enter
 

Frequency

crdr-prprtis-02.mp4 05:32
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Frequency defines how often the assembly is applied along the baseline

To adjust frequency

 1. Left click the ellipses in the frequency column

 2. Adjust frequency settings
 A. Along tangents 10
 B. Along curves At an incriment
 C. Curve increment 5
 D. Along spirals 25
 E. At alignment geometry points Yes
 F. At superelevation critical points Yes
 G. Along profile curves 5
 H. At profile geometry points Yes
 I. At high/low points Yes
 J. At offset target geometry points Yes

 K. Adjacent to offset target start/stop Yes
 L. Along offset target curves At an increment

Page: 769

Published on: 5/17/2023

Corridor properties



 M. Curve increment 5

 3. Add Additional stationing
 4. Left click Plus sign

 5. Type 1717.14
 6. Enter
 7. OK
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Create corridor
Last updated: 2020-10-26

Total video time: 01:51

Create corridor

Exercise files: crdr-data-c3d16.zip

Start with CthE.dwg

crdr-creat-01.mp4 01:51

 1. Home tab of ribbon>Create Design panel>Corridor

 2. Name the corridor Crd-CthE
 3. Select Alignment CthE
 4. Select Profile CthE
 5. Select assembly CthE-10+00 to 32+50
 6. Select Target Surface Exist
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 7. OK
The Corridor Properties dialog box opens
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Corridor targets
Last updated: 2020-10-26

Total video time: 05:44

Corridor targets

Exercise files: crdr-data-c3d16.zip

Start with CthE.dwg

crdr-trgt-01.mp4 05:44

Targeting allows you to create a more complex design geometry by widening or changing slopes 
based on targeted objects such as alignments, profiles, feature lines polylines, etc.

It is not recommended to target any xreffed objects.

 1. Left click on corridor
 2. Contextual ribbon>Modify Region>Edit Targets

 3. Left click inside of region
 4. In the Target Mapping dialog box, scroll down to the Lane width left 
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 5. Left click in the Object name column
 6. In the Set Width Or Offset Target dialog box, select alignments
 7. Left click on CthE-Left-15.000 (1)
 8. Click Add

Page: 774

Published on: 5/17/2023

Corridor targets



 9. OK
 10. Scroll down to Lane profile left
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 11. Left click in the Object name column
 12. In the Set Slope Or Elevation Target, select Profiles
 13. Select the CthE-Left-15.000 (1) alignment
 14. Select the CthE profile
 15. Click Add

 16. OK
 17. OK

 

Create corridor regions
Last updated: 2020-10-26

Total video time: 04:24

Split regions

Exercise files: crdr-data-c3d16.zip

Start with CthE.dwg

crdr-creat-rgn-01.mp4 01:51

Split Region

 1. Left click on corridor 
 2. Contextual Ribbon>Modify Region>Split Region
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 3. Left click inside corridor
 4. Left click the area to split region
 5. Left click to the right of the region break
 6. Left click a second region break

 7. Esc
Region Properties

 1. Left click on corridor
 2. Contextual ribbon>Modify Region dropdown>Region Propeties

 3. Left click inside region to change
 4. In the Corridor Region Properties dialog, left click the ellipses in the Assembly field
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 5. In the Edit Corridor Region dialog, change the Assembly to CthE-RiverRd-Int-Through

 6. OK
 7. OK
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 8. Esc
Add Region

 1. Contextual ribbon>Modify Region panel>Add Regions

 2. Type 3255
 3. Enter
 4. Type 4000
 5. Enter
 6. In the Create Corridor Region dialog, select the CthE-32+55 to 40+00 assembly

 7. OK
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 8. In the Target Mapping Dialog under Surfaces, select <Click here to set all> 

 9. In the Pick a Surface dialog box, left click on Exist

 10. OK
 11. OK
 12. Esc, Esc

Corridor issues: waterfalls
Last updated: 2020-10-26

Total video time: 05:04

Corridor issues: waterfalls

Exercise files: crdr-data-c3d16.zip
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Start with CthE.dwg

crdr-isu-wtrfl-01.mp4 05:04

To check for corridor waterfalls

 1. Left click on corridor
 2. Right click
 3. Select Object viewer

 4. Left click, hold and move your mouse to orbit 

 5. Inspect where waterfall happens
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 6. Close object viewer
To fix waterfall

 1. Check design profile start station

 2. Left click on corridor
 3. Contextual ribbon>Modify Corridor panel>Corridor Properties
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 4. Change corridor start region station value to 1037

 5. OK
 6. Rebuild Corridor
 7. Inspect in object viewer

Corridor issues: bowties
Last updated: 2020-10-26

Total video time: 03:29
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Corridor issues: bowties

Exercise files: crdr-data-c3d16.zip

Start with CthE.dwg

crdr-isu-bowtie-01.mp4 03:29

Bowties happen when the corridor links cross over themselves.

Causes

 l Jog in alignment
 l Wide daylighting on the inside of a curve

How to recognize Bowties

 l Corridor surface contours look odd
 l Corridor surface boundary won't create
 l Corridor doesn't look right when orbiting in object viewer

Possible solutions
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 l Adjust alignment
 l Adjust assembly
 l Adjust targets
 l Create a gap in the corridor

Corridor issues: missing daylights
Last updated: 2020-10-26

Total video time: 03:07

Corridor issues: missing daylights

Exercise files: crdr-data-c3d16.zip

Start with CthE.dwg

crdr-isu-miss-dalit-01.mp4 03:29

Missing daylight

Causes

 l No surface information in daylight ares
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 l Surface targets not set in corridor region

Fixes

 l Adjust daylight slopes
 l Request expanded surface data
 l Define surface targets

To define surface targets

 1. Left click on corridor
 2. Contextual ribbon>Modify Corridor panel>Corridor Properties

 3. Corridor Properties dialog box>Parameters tab
 4. Select the region 
 5. Left click in Set all targets column
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 6. Select <Click here to set all>

 7. Select the surface Exist

 8. OK
 9. OK

 10. Select to Rebuild Corridor
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Fixing bad triangles at intersections with null regions
Last updated: 2023-01-24

Total video time: 05:20

crdr-isu-null-regn.mp4 5:20

Issue

At some intersections, the corridor surfaces may exhibit undesirable triangulation within the curb 
return regions.

Solution
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Due to unknown reasons, at times the surface triangles try to connect from a sideroad region on one 
side of the mainline to a sideroad region on the other side of the mainline. There are is a simple solu-
tion to break these connections.

Remove redundant feature lines

If not completed yet, adjust the intersection assemblies to remove redundant feature lines as shown 
here: Redundant intersection corridor feature lines (wi.gov). This should be done on every inter-
section on every project.

Add a null region on the sideroad baseline

If removing redundant feature lines does not correct this situation, add in a null region along the 
sideroad baseline. When building an intersection, a designer may typically only have corridor regions 
on the sideroad where there is a roadway section that needs be built. Because part of the sideroad 
alignment/baseline goes through and intersects with the mainline corridor regions, there will be a 
gap in the regions along the sideroad baseline.

 1. Create a Null Assembly
 A. Home Tab > Create Design Panel > Assembly > Create Assembly

 I. Name: Null
 II. OK

 B. Digitize the location of the assembly
 C. Do not add any subassemblies. As the name implies, this assembly will be “empty.”

 2. Add a region in the sideroad gap using the Null assembly.
 A. Select the corridor > Contextual Ribbon > Add regions
 B. Select the sideroad baseline

 I. Utilize the baseline preview to determine and select the sideroad baseline.
 C. Specify the region start station

 I. The region should begin at the intersection of the sideroad alignment and main-
line ETW.

 D. Specify the region end station
 I. The region should end at the intersection of the sideroad alignment and oppos-

ite mainline ETW.
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 E. Create Corridor Region dialog:
 I. Region Name: Leave default or assign custom region name

 II. Assembly: Null
 III. OK

 F. Warning Dialog box: No targets found in scripts
 I. OK
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 3. Verify that triangulation is corrected.

Redundant intersection corridor feature lines
Last updated: 2022-12-05

Total video time: 11:18

crdr-isu-rdndnt-fl-01.mp4 11:18

Issue:

Avoid creating corridor surfaces with two feature lines from two different regions on top of each 
other. This problem does not become apparent until the breakline extraction process is performed. 
Within an intersection, we typically get two feature lines in the red-highlighted areas.
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 1. Along the main roadway, you get a Crown feature line from the curb return region and an 
ETW feature line from the mainline through lane region. 

 2. Along the side road, you get a Crown feature line from both curb return regions. 

The feature lines end up competing to define the surface. Then, when you extract the breaklines 
from the refinement surface definition, neither of the competing feature lines are coincident with 
the surface triangle vertices. 

Solution

There are two ways that this can be addressed. 

 1. Option A:  Make sure that the competing feature lines have all the same vertices. 

 A. Add special sections in competing regions.
 B. More difficult option.
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 2. Option B: Delete/Remove the Crown point codes in the LnExtendBase subassembly within 
the curb return regions.

 A. No feature lines will be constructed along the crown portion of the Lane subassembly 
within the curb return regions. This removes the redundant feature line along the 
mainline ETW and the sideroad Crown.

 B. To correct the sideroad Crown (No feature lines from curb returns), add a 0 width lane 
region along sideroad alignment within the curb return regions.
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Exploration of data reference corridors
Last updated: 2020-12-11
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Tip: Workflows demonstrated here may or may not be a best practice for all design scenarios. 
They are showing different options for design solutions.

crdr-xplor-dref-crdr-data-c3d20.zip

Basics

crdr-xplor-dref-crdr-01.mp4 6:25

Create data shortcut

In source drawing containing Corridor Object, create the data shortcut.

 1. Toolspace > Prospector > Right-click Data Shortcuts > Create Data Shortcut
 2. Under Corridors select the Corridor and OK

Create reference

When creating a data reference of a corridor, all baseline objects will be referenced as well. This 
include all alignments, profiles, and/or feature lines used as baselines.

 1. Toolspace > Prospector
 2. Expand the project
 3. Expand corridors
 4. Right-click on the corridor > Create Data Reference
 5. Accept the style defaults

The corridor and all associated baselines will be inserted into the drawing.  The baselines (align-
ments) will adapt the styles described in the create alignment reference drawing settings.

Cross section sheets

crdr-xplor-dref-crdr-02.mp4 9:36

The corridor can be data referenced into a cross section sheet file and sampled into section views.

 1. Start a new drawing using the WisDOT Design Template.
 2. Create data references to the following objects:

 A. Existing surface
 B. Design refinement surfaces (Top and Datum)
 C. Corridor

 I. Since the alignments are referenced when a corridor is referenced, they do not 
need to be referenced again.

 3. Create Sample Lines
 A. Home Tab > Profile and Section Views Panel > Sample Lines
 B. Sample the corridor, existing surface, and design surfaces.

 I. Recommended corridor code set style: XS Sheets with Shapes
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 4. Create Section Views
 A. Home Tab > Profile and Section Views Panel > Section Views > Create Multiple 

Views
 5. Create Section Sheets

Build surfaces

crdr-xplor-dref-crdr-03.mp4 8:53

After creating a data reference of a corridor, the feature lines that make up certain parts of surfaces 
can be extracted and used as breaklines to create design surfaces.

Corridor surfaces can also be made from the feature line codes in the data referenced corridor prop-
erties.

Extract corridor feature lines for use in secondary corridors

crdr-xplor-dref-crdr-04.mp4 11:36

Extracted feature lines could be used as targets in a secondary corridor or as a baseline in a sec-
ondary corridor.

Possible Uses

 l Construction Staging
 l Lane Shifts
 l Intersections
 l Cul-de-Sacs
 l Roundabouts
 l Divided Highways

General Workflow

 1. Create data references to the following objects:
 A. Corridor (since the alignments are referenced when a corridor is referenced, they do 

not need to be referenced again.)
 2. Extract feature lines to be used

 A. Select corridor > Launch Pad > Feature Lines from Corridor
 B. Select the feature line to be extracted

 I. Command Line: Choose the part of the corridor to be extracted.
 II. Enter to select only the feature line selected

 III. All selects all feature lines in the corridor
 C. Extract Corridor Feature Lines Dialog Box

 I. Assign a site if desired
 II. Choose the Style to be assigned to the feature line.

 III. Adjust the layer if desired
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 IV. Enter Settings
 a. Dynamic Link: Checked
 b. Apply Smoothing: Unchecked
 c. Name: Not required, but perhaps helpful

 3. Freeze the Data Referenced Corridor Layer or hide the corridor if so desired
 4. Create the new corridor, using the extracted feature line as a baseline.

 A. Extracted baselines may also be used as targets in a secondary corridor

Data shortcut reference feature lines?

crdr-xplor-dref-crdr-05.mp4 10:20

This exploratory use case utilizes the corridor data reference as a vehicle to essentially data ref-
erence feature lines from one drawing to another.

Option 1:

 1. Create a corridor and add the feature lines as baselines. (No regions are needed)
 2. Create a data shortcut for the new corridor.
 3. Open a new drawing and create a data reference of the new corridor.

 A. The baselines (feature lines) used in the definition of the corridor will be inserted into 
the drawing as alignments and profiles.

Option 2:

 1. Create an assembly
 A. Contains one "MarkedPoint" subassembly

 2. Create a corridor
 A. Create a baseline and region (using above assembly) for each feature line to be ref-

erenced.
 3. Create a data shortcut for the corridor
 4. Data reference the corridor into a new drawing

 A. Alignments are created for the Feature Line Baselines.  Freeze or hide the alignments if 
desired.

 5. Extract the feature lines from the corridor

This process may be simplified using Dynamo.  Are there any workflows where this could be useful?

Corridor data shortcut surface modeling
Last updated: 2022-03-10

Warning: This topic contains videos that refer to WisDOT dynamo scripts. Those scripts have 
been retired. References to current tools are in the webpage. Videos have not been corrected. 
They will be updated at a later date.

Total video time: 38:40

Introduction
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crdr-ds-srfc-mdl-01.mp4 8:26

 l This presentation will walk through a practical workflows for using Corridor data shortcuts in 
the development of top and datum refinement surfaces and to manage multiple corridor 
drawings that use setup corridors to define superelevation and cross slope transitions.

 l Review steps for successful surface designs.
 l Learn some best practices for managing corridor data shortcut surfaces.
 l Walk away with concepts on how you may be able to use corridor data shortcuts to build sur-

face models in your own projects.

Corridor data shortcut

It is a corridor object that is assigned to a Civil 3D project collection.

Before you create a corridor reference in a drawing, the data shortcut must exist in the 
current project collection.

Corridor data reference

It is a reference to a corridor data shortcut in a drawing.

The corridor reference gives you access to corridor data as a lightweight read-only copy 
of the original.

Setup Corridor

It is a simple corridor(s) using a link-based assembly to create superelevation and slope 
criteria surfaces.

The corridor is used to create surfaces that can be data referenced into any project 
design corridor dwg.

In the project design corridor it can be used to create surface profiles that can be used 
as targets to define the default cross slopes and super elevation cross slopes.

One way of thinking about this is that the setup corridor(s) is the basic backbone that 
captures the roadway cross slope design to be used in all your design corridors to tie 
the project together.
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Setup corridor assembly construction

Notice the assembly’s link slopes parameters are set to the Superelevation tables inside and outside 
lane slope data.

Setup corridor assembly superelevation

Here we can see the simple setup corridor following the superelevation by viewing the corridor sec-
tion editor.
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Why is a setup corridor important for corridor data shortcut development?

 l It allows for preliminary geometry development for final corridors. Specifically, you can 
develop vertical geometry that can be passed to surface profiles to be used as tie-ins for 
areas that need vertical geometry that connects to it (intersection curb returns)

 l Setup corridors also allow users to separate the limits of preliminary geometry development 
from detailed geometry development, giving more flexibility to the design process.

Review common corridor surface workflows

crdr-ds-srfc-mdl-02.mp4 6:47

 "Create corridor surface" on page 847 This is the workflow for creating both the top and datum cor-
ridor surfaces.

Corridor surface using WisDOT design workflows consists of mostly creating the top and datum sur-
faces using point codes to define the longitudinal featurelines. Some tighter frequency corridors with 
simple grade transitions that define a single surface, like the superelevation setup corridors can use 
link codes to define the required surface.
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Create Corridor Surfaces tool

The creation of the top and datum corridor surfaces can be sped up with Corridor - Create Corridor 
Surfaces.

Concepts and workflow basics for corridor and refinement surfaces

 l https://c3dkb.dot.wi.gov/Content/c3d/rd wy-dsn/crdr-rfnt-srfc.htm

 l https://c3dkb.dot.wi.gov/Content/c3d/rd wy-dsn/crdr-rfnt-srfc/rfnt-srfc-basc.htm

 l The refinement surface basics still holds true when creating and using corridor data short-
cuts.

Refinement surface basics

 l Grading or surface adjustments beyond the corridor may be needed for a final surface.

 l Refinement surface is the final surface, a combination of all definitions pasted together.

 l One refinement surface for each final surface: Top, Datum.

 l No matter how divided up the project definitions are

 o ALL Top surfaces in Rfnt-Top

 o ALL Datum surfaces in Rfnt-Datum

 o Other gradings or adding breaklines
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 l Plan the order to be pasted to avoid last order rule.

 l Top and Datum surfaces are defined to daylight, so there are large areas that are coin-
cidental.

Refinement surface workflows

 l https://c3dkb.dot.wi.gov/Content/c3d/rd wy-dsn/crdr-rfnt-srfc/rfnt-srfc-creat.htm

 l This is the basic workflow for creating a composite refinement surfaces.
 l All the corridor top surfaces are pasted into a single refinement top surface.
 l All the corridor datum surfaces are pasted into a single refinement datum

Corridor and refinement surface progression

In most cases when creating the corridor top surface, the top surface covers the entire extents of the 
corridor, between the slope intercept, or daylight on each side. The datum usually is defined 
between the subgrade shoulder intercepts on each side, or the extents of the subgrade behind the 
curb on each side.
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The common workflow is to make a data shortcut of the corridor surfaces with defined boundaries 
in the corridor dwg and then create a new dwg and data reference the corridor surfaces into the dwg 
to create the refinement surfaces.
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This map depicts the refinement surface progression with multiple drawings each with a corridor, 
using the surface data shortcut workflow.
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What is unique about using a corridor data shortcut?

 l Corridor Data Shortcuts allow for complete creation of a corridor surface and surface bound-
aries from the referenced corridor.

Why does this matter?

 l Corridor Data Shortcuts allow for complete creation of a corridor surface and surface bound-
aries from the referenced corridor.

 l This means as part of the workflow, the corridor surface boundaries do no need to be part of 
a data reference at all.

What else should we know about referencing a corridor?

 l Data shortcuts are automatically created for the corridor baselines alignment and profiles 
and can be seen in the Prospector.

 l What does not come along as part of the corridor data shortcut is any target geometry used 
to define the corridor.

 l Baselines created from featurelines are treated as alignment/profile references in the ref-
erenced drawing, but do not appear in Prospector. For example, when you select the baseline 
of the referenced corridor, the Alignment contextual ribbon tab is displayed, but since it is not 
actually an alignment the querying and labeling tools will not work. Also, since the featureline 
is not brought into the prospector as an object the only way to access the feature line is by 
selecting the representation graphically in the drawing area.

 l One thing that can not be done with a reference to a corridor data shortcut is to promote the 
corridor into a new dwg.

Page: 805

Published on: 5/17/2023

Corridor data shortcut surface modeling



 l The unique layer setting option when creating a reference of a corridor data shortcut does 
not work.

 o A work around for this may be creating a corridor reference Layer State with generic 
corridor layers to share, and then set the corresponding layer current before creating 
corridor reference.

Corridor data shortcut example

crdr-ds-srfc-mdl-03.mp4 4:24

 1. Open new drawing
 2. Create unique corridor layer
 3. Set unique corridor layer current
 4. Data shortcut corridor

 A. Baseline alignments and profiles data shortcuts also are created.
 5. Most of the corridor contextual ribbon is greyed out.

 A. Surfaces and boundaries can be created.
 B. Cannot edit parameters, codes, or features.
 C. Can change code set style.

Corridor and refinement surfaces using corridor data shortcuts

When creating the refinement surface drawing, instead of data referencing each corridor surface 
from each corridor dwg, we can data reference each corridor into the refinement surface and then 
create all the corridor top and corridor datum surfaces in the same dwg. Then we can paste the cor-
ridor top and corridor datum in the respective refinement surface. We are able to make all the sur-
face edits, boundary edits, and grading edits in the same dwg.
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Multiple dwg corridor data shortcut refinement surface approach

Depending on the size of each corridor and how the project is structured, it may be necessary to 
divide the refinements surface into more than one dwg. Maybe for phasing needs or a gap in the pro-
ject.
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Multiple corridor in dwgs, corridor data shortcut refinement surface approach

This image just further illustrates the progression with multiple corridors in multiple drawings all 
being collected into the refinement surface dwg. The surfaces then being created in that dwg.
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Multiple corridor data shortcut example

crdr-ds-srfc-mdl-04.mp4 5:13

Roundabout, data shortcut multiple corridors through surface boundaries

Multiple corridor data shortcut example continued 1

crdr-ds-srfc-mdl-05.mp4 7:23

Create refinement surfaces and paste all corridor surfaces into them.

Multiple corridor data shortcut example continued 2 and conclusion

crdr-ds-srfc-mdl-06.mp4 6:24

What do changes in the corridors look like?

Edit region limits to see changes.

Remember, boundaries are not coming from the corridor definitions, so they are not 
automatically updated.

Benefits and drawbacks to using corridor references

Benefits

 l This workflow allows for collaboration of surface creation efforts.
 l Separates the dwg corridor design efforts from surface and boundary production.
 l No need to swap between dwgs to do the same surface tasks.
 l This workflow process can speed up surface production by creating and editing a collection of 

corridor and refinements surfaces in one dwg.
 l The ability to determine the make up of the surface drawings independent of how the cor-

rdior drawings needed to be
 l Data shortcut corridor Top and Datum surfaces can still be created out of the surface col-

lection drawing.

Drawbacks

 l For small projects or a project that is being designed by a single person, extra dwg files may 
be created and managed.

 l Additional objects like alignments and profiles are also data referenced at the time the cor-
ridor is data referenced.

 l Probably some other workflow that works best with just using surface data shortcuts instead 
of corridor data shortcuts.

 l Does not solve
 o Surface boundary creation.
 o Need for a refinement surface.
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 o The process of creating and maintaining corridor datum surface boundaries can still 
be a tedious effort, or one that requires being able to custom code the assemblies 
used.

Intersection objects
Intersection object basics
Last updated: 2020-10-26

Total video time: 04:45

Intersection object basics

Exercise files: int-objct-01-data-c3d16.zip

Start with CthE.dwg

int-objct-basc-01.mp4 04:45

To create an intersection you need to have 2 alignments that cross. These alignments will also need 
design profiles that accompany them.

To create an intersection object

 1. Home tab of the ribbon > Create Design panel > Intersections drop down > Create 
Intersection

 2. Select the intersection point
 3. Shift+Right click to use apparent intersection snap
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 4. Select the primary road alignment CthE
 A. In the first page of the Create Intersection dialog, accept defaults and click Next >

 B. Geometry Details

Create or specify offset alignments: unchecked
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 C. Create Intersection
 

Connecting geometry between setup corridors and intersection 
objects
Last updated: 2020-10-26

Total video time: 10:57

Setup corridor adjustments

Exercise files: int-objct-01-data-c3d16.zip

Start with CthE.dwg

int-objct-setup-crdr-cnect-01.mp4 02:56

Page: 812

Published on: 5/17/2023

Connecting geometry between setup corridors and intersection objects

https://c3dkb.dot.wi.gov/data/rdwy-dsn/int-objct/int-objct-01-data-c3d16.zip
https://c3dkb.dot.wi.gov/video/rdwy-dsn/int-objct/int-objct-setup-crdr-cnect-01.mp4


Turn off setup assembly links 

 1. Click on subassembly > Right click > Properties...

 2. Properties > ADVANCED Parameters
 3. Omit Link: Yes
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 4. Repeat for left side
 5. Close properties panel
 6. Click corridor > Contextual ribbon > Modify Corridor panel > Rebuild Corridor

Extract feature lines from setup corridor

int-objct-setup-crdr-cnect-02.mp4 02:03

To extract feature lines from corridor

 1. Left click on corridor
 2. Contextual Ribbon>Launch Pad>Alignment from Corridor
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 3. Left click on corridor feature line
 4. In the Create Alignment from Objects dialog, name the alignment CthE-ETW-RT-Setup
 5. Set Alignment style to RDWY Lane Edge
 6. Set Alignment label set to _No Labels

 7. OK
 8. OK
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 9. Left click on another corridor feature line
 10. In the Create Alignment from Object dialog, name the alignment CthE-ETW-LT-Setup

 11. OK
 12. OK

Create secondary profile

int-objct-setup-crdr-cnect-03.mp4 02:36

To create a secondary profile

 1. Zoom out in lower viewport
 2. Ribbon>Home tab>Profile & Section Views panel>Profile View dropdown>Create Pro-

file View

 3. In the Create Profile View dialog, General, select the RiverRd alignment 
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 4. Click Profile Display Options page
 5. Scroll to the right
 6. Change Style to PROF Existing

 7. OK
 8. Change Labels to _No Labels
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 9. OK
 10. Create Profile View
 11. Left Click in models space to place the profile view
 12. Ribbon>Home tab>Create Design panel>Profile dropdown>Profile Creation Tools
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 13. Left click on profile view grid
 14. In the Create Profile dialog, accept defaults
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 15. OK
 16. Profile Layout Tools toolbar>Tangents dropdown>Draw Tangents
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 17. Draw in new profile
 18. Right click to end command

 19. Close toolbar

Create intersection objects

int-objct-setup-crdr-cnect-04.mp4 03:22
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 1. Ribbon>View tab>Model Viewports panel>Viewport Configuration

 2. Ribbon>Home tab>Create Design panel>Intersections dropdown>Create Intersection

 3. Left click to select intersection location
 4. Select primary alignment
 5. In the Create Intersection - General dialog accept defaults
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 6. Next
 7. Adjust alignment order. RiverRd should be 2nd.
 8. Uncheck Create or specify offset alignments

 9. Create Intersection
Repeat steps 2 through 9 two more times for the remaining intersecting alignments

Inspect the design profile
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Feature lines and gradings
Grading and feature line fundamentals
Total video time: 4:53

fl-grdg-fndmntl-01.mp4 4:53

 1. Site 
 A. Allows several objects to interact 

 I. Grading/feature lines, parcels, sometimes alignments
 B. Objects in other sites will NOT interact
 C. Grading groups need a site so they can create interaction between grading objects 

 I. But they can be "siteless" to prevent interactions with anything
 2. Feature Line 

 A. Used for the grading footprint
 B. Basically a 3D Polyline only smarter
 C. Many editing options 

 I. Geometry and elevation
 D. Besides a grading footprint, can also be 

 I. added to surface as a breakline separate from grading tools
 II. used as XSECT view utility markers or property lines

 III. anywhere a polyline might be used.
 3. Grading Criteria 

 A. Rules for grading from footprint (feature line)
 B. User defines two sides of right triangle
 C. There are four provided in Basic Set 

 I. Slope/grade to distance
 II. Slope/grade to elevation

 III. Slope/grade to relative elevation
 IV. Slope/grade to Surface

 D. Can build your own 
 I. this will only be created in the file that you are working in, so don't expect it in 

the next project file
 E. Unlocked criteria prompts for user entry, makes criteria more versatile for different 

uses/projects
 F. Locked criteria takes default, speeds up grading process

 4. Grading Objects 
 A. Individual gradings 

 I. From footprint with criteria
 II. Can be whole feature line or just portions

 III. Represented with diamond inside grading
 IV. Technically transitions and infills are also grading objects

 5. Grading Group 
 A. Allow separate grading objects to interact
 B. Grading objects and feature lines in different groups will not interact
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 C. Allows balancing of site volumes
 D. Do not need to be contiguous

Create feature line
Total video time: 15:18

                     Create new geometry with elevation options                 

Exercise files: fl-grdg-creat-fl-data-begin-c3d18.zip

Begin with Grading example.dwg

fl-grdg-creat-fl-01.mp4 5:18

 1. Home tab > Create design panel > Feature Line dropdown > Create Feature Line
 2. Site: <None>

 A. Can create a new Site at this time if needed.
 B. Name: checked, Ditch east
 C. Style: checked, RDWY Ditch Flowline
 D. Layer: P_FTLN
 E. OK

 3. Specify start point: Click in modelspace on surface
 4. DRAWFEATURELINE Specify elevation or [Surface]: s Enter

 A. Select Surface: Exist
 B. OK

 5. Specify the next point: Click in modelspace on surface
 6. DRAWFEATURELINE Specify elevation or [Grade Slope Difference Surface 

Transition]: g Enter to switch to grade mode
 7. DRAWFEATURELINE Specify grade or [Grade Slope Difference Surface 

Transition]: -2 Enter
 8. Specify the next point or [Arc Length Undo]: Right click in modelspace > Arc 

> Click on surface
 9. DRAWFEATURELINE Specify grade or [Grade Slope Difference Surface 

Transition]: d Enter to switch to elevation difference mode
 10. DRAWFEATURELINE Specify elevation difference or [Grade Slope Dif-

ference Surface Transition]: -1 Enter
 11. Specify the next point or [Arc Length Undo]: Right click in modelspace > 

Line > Click on surface 
 12. DRAWFEATURELINE Specify elevation difference or [Grade Slope Dif-

ference Surface Transition]: su Enter to switch to surface mode
 A. Enter to accept surface elevation

 13. Specify the next point or [Arc Length Close Undo]: Enter to finish the feature 
line

Create feature line from 2D polyline on surface
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fl-grdg-creat-fl-02.mp4 4:54

 1. Home tab > Draw panel > Polyline
 2. PLINE Specify start point: Click in modelspace on surface

Elevation of this point is 0.

 3. PLINE Specify next point or [Arc Halfwidth Length Undo Width]: Click in 
modelspace on surface

 4. PLINE Specify next point or [Arc Halfwidth Length Undo Width]: Right 
click in modelspace > Arc > Click in modelspace on surface

 5. PLINE Specify next point or [Arc Halfwidth Length Undo Width]: Right 
click in modelspace > Line > Click in modelspace on surface

 6. PLINE Specify next point or [Arc Halfwidth Length Undo Width]: Right 
click in modelspace > Enter to finish

 7. Home tab > Create design panel > Feature Line dropdown > Create Feature Lines from 
Objects

 8. CREATEFEATURELINES Select lines, arcs, polylines or 3d polylines ot 

convert to feature lines or [Xref]: Click polyline > Enter
 A. Site: <None>
 B. Name: unchecked
 C. Style: checked, WisDOT Standard
 D. Layer: P_FTLN
 E. Conversion options

 I. Erase existing entities: checked
 II. Assign elevations: checked

 III. Weed points: checked
Weeding point is not often recommended since it can eliminate data.

 F. OK
 G. Assign Elevations

 I. From Surface: checked, Exist
 a. Insert intermediate grade break points: checked

This will add elevation-only points to the feature line

 II. OK
 H. Weed Vertices

 I. Weeding Factors
 a. Angle: checked, 1
 b. Grade: checked, 0.1%
 c. Length: checked, 4'

 II. Close Point Removal
 a. 3D distance: checked, 0.1'

1 of 69 vertices will be weeded. These vertices show up red in mod-
elspace.

 III. OK    
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Create feature line from stepped offset

fl-grdg-creat-fl-03.mp4 1:40

 1. Home tab > Create design panel > Feature Line dropdown > Create Feature Line from 
Stepped Offset

 2. OFFSETFEATURE Specify offset distance or [Through Layer]: Click first point 
in modelspace > Click second point in modelspace

 3. OFFSETFEATURE Select an object to offset or [Name]: Click feature line that 
was just created

 4. OFFSETFEATURE Specify side to offset or [Multiple]: Click to the east of the 
feature line

 5. OFFSETFEATURE Specify elevation difference or [Grade Slope Elevation 

Variable]: s Enter to switch to slope mode
 6. OFFSETFEATURE Specify slope or [Grade Slope Elevation Variable]: -4 

Enter
 7. Esc to exit the command

Create feature line from alignment

fl-grdg-creat-fl-04.mp4 2:18

A feature line can be created with the horizontal data from an alignment and the vertical data from 
one of it's profiles.

 1. Home tab > Create design panel > Feature Line dropdown > Create Feature Lines from 
Alignment

 A. CREATEFEATURELINEFROMALIGN Select an alignment <or press enter 

key to select from list>: Click alignment in modelspace
 B. Create Feature Line from Alignment

 I. Site: None
 II. Name: unchecked

 III. Profile: USH51
 a. Mid-ordinate distance: 0.1

Feature lines cannot have curves. This setting is how far away a chord 
can be created from the original curve

 IV. Spiral tesselation factor: 0.25
 V. Create dynamic link to the alignment: checked

 VI. OK
 C. Weed Vertices

 I. OK

Create feature line from corridor
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fl-grdg-creat-fl-05.mp4 1:06

Two options

 1. Select corridor > Contextual ribbon > Launch pad panel > Feature Lines from Corridor
 2. Home tab > Create design panel > Feature Line dropdown > Create Feature Line from 

Corridor
 A. Select feature lines or [All by Regions within Polygon]

 B. Extract corridor feature lines
 I. Feature lines can be added or removed in this dialog

 II. Site, Layer, Pay Item, and Style can be set
 III. Settings...

 a. Dynamic Link to Corridor
 b. Apply Smoothing
 c. Name
 d. Code Set Style to automate applying settings

 IV. Join feature lines in adjoining regions
 V. OK

Exercise files: fl-grdg-creat-fl-data-end-c3d18.zip

Edit feature line elevation
Total video time: 18:20

Overview and Elevation Editor

Exercise files: fl-grdg-edit-elevtn-data-begin-c3d18.zip

Begin with Grading example.dwg

fl-grdg-edit-elevtn-01.mp4 3:22

 1. Click on blue feature line in modelspace > Contextual ribbon
 A. Edit Geometry and Edit Elevations are feature line contextual ribbon panels that can 

be turned on/off from the feature line contextual ribbon Modify panel. Make sure they 
are turned on.

 2. Contextual ribbon > Edit Elevations panel > Elevation Editor
 A. This will open the Grading Elevation Editor panorama
 B. There will be a row for each elevation point on the feature line
 C. Green triangles designate the elevation points in the panorama table and in mod-

elspace
 D. Internal stationing designates where along the length of the feature line the elevation 

points are
 E. If you click on an elevation point in the panorama, that point highlights in modelspace
 F. Stationing cannot be changed here. Elevation can be changed either directly or with 

the Grade Back, Grade Ahead columns

Elevation Editor panorama
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fl-grdg-edit-elevtn-02.mp4 3:20

 1. Relative to surface
 A. Adds the columns Elevation Derived From and Elevation(Relative) to the table. 

Points can be set relative to a surface and individual points can be relative to a surface 
by unique positive or negative amounts.

 2. Raise/Lower by increments controls
 A. Single or all points can be raised/lowered by a preset amount. If no row is selected, all 

points are adjusted.
 3. Flatten Grade or Elevation

 A. Constant Elevation
 B. Constant Grade

 4. Drape over surface
 A. Applies elevations from a surface

 5. Can select a point and zoom to it's location in modelspace

Insert/delete elevation point

fl-grdg-edit-elevtn-03.mp4 1:43

 1. Contextual ribbon > Edit Elevations panel > Insert Elevation Point
A green circle will slide along the feature line for horizontal location

 A. Specify point or [Distance/Increment]: Click a point in modelspace
 B. INSERTELEVPOINT Specify elevation or [Surface]: 1615 Enter
 C. Specify point or [Distance/Increment]: Click a point in modelspace
 D. INSERTELEVPOINT Specify elevation or [Surface]: 1613 Enter
 E. Enter to stop the command

Distance and Increment are other options for horizontal location points to have better 
control of placement.

 2. Contextual ribbon > Edit Elevations panel > Delete Elevation Point
Nearest point will highlight

 A. DELETEELEVPOINT Specify point or [All]: Click an elevation point
 B. Enter to stop the command. The feature line is still selected

Other Edit Elevations tools

fl-grdg-edit-elevtn-04.mp4 4:17

The following tools are in the top row of buttons in the Edit Elevations panel
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Quick Elevation Edit

 1. Contextual ribbon > Edit Elevations panel > Quick Elevation Edit
 A. QUICKEDITFEATUREELEVS Specify point or [Site Reference]:

This tool will display the elevation of any point or the grade of any segment of any fea-
ture line in modelspace.

 B. Click the southmost point of the blue feature line
 C. QUICKEDITFEATUREELEVS Specify elevation or [Surface]: 1615 Enter
 D. QUICKEDITFEATUREELEVS Specify point or [Site Reference]: Click the 

segment to the north of the point when the arrow is pointing northwards.
 E. QUICKEDITFEATUREELEVS Specify grade or [Slope]: -2 Enter
 F. Right click > Enter to stop the command

Edit Elevations

 2. Contextual ribbon > Edit Elevations panel > Edit Elevations

This tool starts at the beginning point of the feature line and walks through every elevation 
point

 A. EDITFEATUREELEVS Elevation or [Grade SLope SUrface Insert eXit]: 
Enter to accept the first point in the feature line

 B. EDITFEATUREELEVS Elevation or [Previous Grade SLope SUrface 

Insert Move Delete eXit]: Enter to accept the 2nd point in the feature line
 C. EDITFEATUREELEVS Elevation or [Previous Grade SLope SUrface 

Insert Move Delete eXit]: SL to switch to slope mode
 D. EDITFEATUREELEVS Slope or [Previous Grade Elevation eXit]: -2 Enter 

to apply a -2:1 slope from that point northward
 E. EDITFEATUREELEVS Slope or [Previous Grade Elevation eXit]: G Enter 

to switch to grade mode
 F. EDITFEATUREELEVS Grade or [Previous Slope Elevation eXit]: -2 Enter 

to apply -2% grade from that point northward
 G. EDITFEATUREELEVS Grade or [Previous Slope Elevation eXit]: E Enter 

to switch to elevation mode for the last point
 H. EDITFEATUREELEVS Elevation or [Grade SLope SUrface Insert eXit]: 

Enter to accept the current elevation
 I. Esc to stop the command

Set Grade/Slope between Points

 3. Contextual ribbon > Edit Elevations panel > Set Grade/Slope between Points
This tool sets a constant grade/slope between any 2 elevations points on a feature line. It will 
overwrite elevations of the last point and any points in between the first and last elevation 
points.

 A. SETFEATUREGRADE Specify the start point: click the 2nd elevation point on 
the feature line

 B. SETFEATUREGRADE Specify elevation: Enter to accept the current elevation
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 C. SETFEATUREGRADE Specify the end point: Click the 4th elevation point on the 
feature line

 D. SETFEATUREGRADE Specify grade or [Slope Elevation Difference]: G 
Enter to switch to grade mode

 E. Specify grade or [Slope/Elevation/Difference]: -2 Enter to apply a -2% 
grade between the points

 F. SETFEATUREGRADE Select object or  [Name]: Enter to stop the command

Insert High/Low Elevation Point

 4. Contextual ribbon > Edit Elevations panel > Insert High/Low Elevation Point
This tool will create a high/low point between 2 points with 2 grades/slopes in between.

 A. INSERTFEATUREHIGHLOWPOINT Specify the start point: Click the first point 
in the feature line

 B. INSERTFEATUREHIGHLOWPOINT Specify the end point: Click the 4th point in 
the feature line

 C. INSERTFEATUREHIGHLOWPOINT Specify the grade ahead or [Slope]: -3 
Enter

 D. INSERTFEATUREHIGHLOWPOINT Specify the grade back or [Slope]: -1 
Enter

 E. INSERTFEATUREHIGHLOWPOINT  Select object or  [Name]: Enter to stop the 
command

Other Edit Elevations tools 2

The following tools are in the middle row of buttons in the Edit Elevations panel

fl-grdg-edit-elevtn-05.mp4 3:36

Raise/Lower by Reference

This tool will raise or lower a feature line based on a grade, slope or relative elevation from a ref-
erence point.

 1. Contextual ribbon > Edit Elevations panel > Raise/Lower by Reference
 A. RAISELOWERFEATURESBYREF Specify reference point: Click point on surface
 B. RAISELOWERFEATURESBYREF Specify point: Click point on feature line
 C. RAISELOWERFEATURESBYREF Specify grade or [Slope Difference]: D 

Enter to switch to difference mode
 D. RAISELOWERFEATURESBYREF Specify difference or [Slope Grade]: -1 

Enter

Set Elevation by Reference

This tool will set the elevation of an entire feature line in reference to a know point of elevation
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 2. Contextual ribbon > Edit Elevations panel > Set Elevation by Reference
 A. SETFEATUREELEV Specify reference point: Click point on surface
 B. SETFEATUREELEV Specify point: Click point on the feature line
 C. SETFEATUREELEV Specify grade or [Slope Difference]: s Enter to switch 

to slope mode
 D. SETFEATUREELEV Specify slope or [Grade Difference]: 4 Enter

Adjacent Elevations by Reference

 3. Contextual ribbon > Edit Elevations panel > Adjacent Elevations by Reference
Since there was a feature line already selected, that will be the reference object and the fea-
ture line selected will be edited

 A. ADJACENTFEATUREELEVSBYREF Select object to edit or [Name]: Click 
feature line

 B. ADJACENTFEATUREELEVSBYREF Specify elevation difference or [Grade 

Slope]: S Enter to switch to slope mode
 C. ADJACENTFEATUREELEVSBYREF Specify slope or [Grade Difference]: -2 

Enter
 D. Enter to stop the command

Grade Extension by Reference

 4. Contextual ribbon > Edit Elevations panel > Grade Extension by Reference
 A. FEATUREGRADEEXTENSIONBYREF Select reference segment: Click on seg-

ment of reference feature line
 B. FEATUREGRADEEXTENSIONBYREF Select object to edit or [Name]: click 

on feature line to be modified
 C. FEATUREGRADEEXTENSIONBYREF Specify point: Click point on feature line
 D. FEATUREGRADEEXTENSIONBYREF Specify grade or [Slope Elevation Dif-

ference Surface]: -1 Enter to create a -1% slope between the reference point in 
the feature line

Other Edit Elevations tools 3

fl-grdg-edit-elevtn-06.mp4 2:00

The following tools are in the bottom row of buttons in the Edit Elevations panel

Elevations from Surface

 1. Contextual ribbon > Edit Elevations panel > Elevations from Surface

 A. Surface: Exist
 B. Insert intermediate grade break points: unchecked
 C. OK

 2. FEATUREELEVSFROMSURF Select object or [Multiple Partial]: Enter to accept 
the default of the entire feature line being adjusted
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Raise/Lower

 3. Contextual ribbon > Edit Elevations panel > Raise/Lower
 A. RAISELOWERFEATURES Specify elevation difference: 5 Enter to raise the 

feature line 5 FT

Edit feature line geometry
Total video time: 11:32

Overview and Insert/Delete PI

Exercise files: fl-grdg-edit-geomtry-d  ata-begin-c3d18.zip

Begin with Grading example.dwg

fl-grdg-edit-geomtry-01.mp4 3:11

Most edits in the Edit Geometry panel are X,Y not Z.

Most tools are very similar to the polyline editing tools.

In some of the tools, there will be station information. This is internal stationing that corresponds dir-
ectly to the length of the feature line. It should not be confused with alignment stationing that can 
start at any value and contain station equations.

 1. Select blue feature line
 2. Contextual ribbon > Modify panel

 A. Edit Geometry: visible
 B. Edit Elevations: visible

 3. Contextual ribbon > Edit Geometry panel > Insert PI     New PI location will start rubber-
banding between existing PIs

 A. INSERTFEATUREPI Specify point or [Distance Increment]: Click new PI 
between first and second PIs

 B. INSERTFEATUREPI Specify elevation or [Surface]: 1618 Enter
 C. Right click > Enter to stop command

 4. Contextual ribbon > Edit Geometry panel > Delete PI
 A. DELETEFEATUREPI Specify point: Click PI that was just created
 B. DELETEFEATUREPI Select object or [Name]: Right click > Enter to stop com-

mand

Edit geometry tools 

fl-grdg-edit-geomtry-02.mp4 2:38

The following tools are in the top row of buttons in the Edit Geometry panel
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Break

 1. Contextual ribbon > Edit Geometry panel > Break
 A. BREAKFEATURES Select an object to break or [Name]: Click on feature 

line
 B. BREAKFEATURES Specify second break point or [First point]: Click 

second point on feature line

Join

 2. Grip edit south feature line to meet north feature line

 3. Select the south feature line
 4. Contextual ribbon > Edit Geometry panel > Join

 A. JOINFEATURES Select the connecting feature line, polyline or 3D 

polyline or [Multiple]: Click adjoining feature line Enter

Trim

 5. Home tab > Draw > Polyline > Draw a polyline across the feature line
 6. Click feature line to select
 7. Contextual ribbon > Edit Geometry panel > Trim

 A. TRIMFEATURES Select cutting edges: Click on polyline Enter
 B. TRIMFEATURES Select an object to trim or [Name]: Click on feature line 

on side of polyline to remove
 C. Right click > Enter

Reverse

 8. Contextual ribbon > Edit Geometry panel > Reverse     This command reverses the direction 
of a feature line. This function is not often needed, but it's good to know it exists.

Edit geometry tools 2

fl-grdg-edit-geomtry-03.mp4 2:57

The following tools are in the middle row of buttons in the Edit Geometry panel

Edit Curve

 1. Select blue feature line

 2. Contextual ribbon > Edit Geometry panel > Edit Curve

 A. Select feature line curve to edit or [Delete]: Click feature line curve
 B. Radius: 87'
 C. Apply OK
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Fillet

 3. Select blue feature line

 4. Contextual ribbon > Edit Geometry panel > Fillet
 A. FILLETFEATURE Specify corner or [All Join Radius]: R Enter
 B. FILLETFEATURE Specify radius: 25 Enter
 C. FILLETFEATURE Specify corner or [All Join Radius]: Right click Enter to 

stop command
The All command will insert fillets between all line segments with the same radius

Fit Curve

 5. Select blue feature line
 6. Contextual ribbon > Edit Geometry panel > Fillet

 A. FITCURVEFEATURE Specify point or [Points Options]: pEnter
 B. FITCURVEFEATURE Specify the start point: Click northernmost point
 C. FITCURVEFEATURE Specify the end point: Click the next point on the feature 

line
 D. FITCURVEFEATURE Specify the start point: Click the next point on the fea-

ture line
 E. FITCURVEFEATURE Specify the end point: Click the next point on the feature 

line
 F. Esc     This will create best fit curves at the end of the feature line

Quick Access Toolbar > Undo to remove the curves

Smooth

 7. Select blue feature line
 8. Contextual ribbon > Edit Geometry panel > Smooth will create a spline with the feature 

line vertices

Edit geometry tools 3

fl-grdg-edit-geomtry-04.mp4 2:43

The following tools are in the bottom row of buttons in the Edit Geometry panel
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Weed

 1. Select magenta feature line
 2. Contextual ribbon > Edit Geometry panel > Weed

 A. Angle: checked, 5 d
 B. Grade: checked, 1%
 C. Length: checked, 3'
 D. 3D distance: checked, 0.4'     Points that will be weeded out will highlight in red. The 

number of points to be weeded will be reported in the dialog prior to the action.
 E. Esc

Grading objects have difficulty with very short segments. Weeding can help with that.

Stepped Offset

 3. Select blue feature line

 A. Contextual ribbon > Edit Geometry panel > Stepped Offset
 B. OFFSETFEATURE Specify offset distance or [Through Layer]: Click a 

point near the feature line
 C. OFFSETFEATURE Specify second point: Click a point further away from the fea-

ture line to define the offset distance.
 D. OFFSETFEATURE Specify side to offset or [Multiple]: Click on the left 

side of the feature line
 E. OFFSETFEATURE Specify slope or [Grade Elevation Difference Vari-

able]: -3 Enter to use a -3:1 slope
 F. Esc to stop the command

Exercise files: fl-grdg-edit-geomtry-data-end-c3d18.zip

Create grading
Total video time: 8:56

Create grading and grade to relative elevation

Exercise files: fl-grdg-creat-grdg-data-begin-c3d18.zip

Begin with Grading example.dwg

fl-grdg-creat-grdg-01.mp4 3:15

 1. Home tab > Create Design panel > Grading > Grading Creation Tools
 A. Create Group button

 I. Name: Ditch East
 II. Automatic surface creation: checked

 III. Use the Group Name: checked
 IV. Surface style: _No Display
 V. OK

 B. OK
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 C. Surface button: The surface is currently set to Exist. The surface button will allow you 
to switch surfaces if need be.

 D. Layers button: This button will allow you to change default layers.
 E. Grading Criteria set button: WisDOT only has the Basic set with the standard grading 

options and allows for changing the values of the grading criteria.
 F. Create Grading

 I. Select the feature: Click the blue feature line. The feature line is not in 
the correct site.

 2. Select feature line > right-click > Move to Site...
 A. Destination Site: Field Survey
 B. OK

 3. Grading toolbar > Create Grading
 A. Select the feature: Click the blue feature line
 B. Continue Grading without the weeding
 C. CREATEGRADING Select the grading side: Click to the left of the blue feature 

line
 D. CREATEGRADING Apply to entire length? [Yes No]: Enter to accept the 

default Yes
 E. CREATEGRADING Grade to Relative Elevation: -.5 Enter
 F. CREATEGRADING Format [Grade Slope]: G Enter
 G. CREATEGRADING Grade: 2 Enter for 2% slope

Grade to distance and surface, create transition

fl-grdg-creat-grdg-02.mp4 2:57

 1. Grading toolbar > Grading criteria dropdownGrade to Distance
 A. CREATEGRADING Select the feature: Click blue feature line
 B. CREATEGRADING Select the grading side: Click to the right of the blue fea-

ture line
 C. CREATEGRADING Apply to entire length? [Yes No]: Enter to accept the 

default Yes
 D. CREATEGRADING Specify distance: 15 Enter
 E. CREATEGRADING Slope: -2Enter

The gratings create feature lines at the extent of the grading. These feature lines can-
not be edited with the regular feature line edit commands. They can be used as the 
start for a new grading.

Page: 838

Published on: 5/17/2023

Create grading

https://c3dkb.dot.wi.gov/video/rdwy-dsn/fl-grdg/fl-grdg-creat-grdg-02.mp4


 2. Grading toolbar > Grading criteria dropdownGrade to Surface
 A. CREATEGRADING Select the feature: Click left yellow-dashed line
 B. CREATEGRADING Apply to entire length? [Yes No]: Enter to accept the 

default Yes
 C. CREATEGRADING Cut Format [Grade Slope]: Enter to accept the default Slope
 D. CREATEGRADING Cut Slope: 4 Enter
 E. CREATEGRADING Fill Format [Grade Slope]: Enter to accept the default 

Slope
 F. CREATEGRADING Fill Slope: 3 Enter

 3. Grading toolbar > Grading criteria dropdownGrade to Distance

 A. CREATEGRADING Select the feature: Click right yellow-dashed line
 B. CREATEGRADING Apply to entire length? [Yes No]: N Enter to change to 

the No option
 C. CREATEGRADING Select the start point: 0 Enter to start the beginning of the 

feature line
 D. Station <0+00.0'>: Enter to accept the station
 E. CREATEGRADING Specify point or [Length]: Click point about 50FT along fea-

ture line
 F. Station <0+49.90'>: Enter to accept the station
 G. CREATEGRADING Specify distance: 7 Enter
 H. CREATEGRADING Slope: -2 Enter

 I. CREATEGRADING Select the feature: Click right full-length, yellow-dashed line
 J. CREATEGRADING Select the start point: Click in the middle of the feature 

line
 K. Station <1+00.24'>: Enter
 L. CREATEGRADING Specify point or [Length]: Click just shy of the end of the 

feature line
 M. Station <1+60.08'>: Enter
 N. CREATEGRADING Specify distance: 10 Enter
 O. CREATEGRADING Format [Grade Slope]: Enter to accept the default of Slope
 P. CREATEGRADING Slope: -3 Enter

The gradings need a transition between them.

 4. Grading toolbar > Grading criteria dropdownCreate Transition
 5. CREATEGRADINGTRANSITION Select the feature: Select the feature line from which 

the 2 different ratings start.
 6. CREATEGRADINGTRANSITION Select a location between two gradings or 

[Points]:  Click somewhere between the 2 gradings to transition.
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 7. Esc to exit the command. Close the Grading toolbar.

Create infill grading

fl-grdg-creat-grdg-03.mp4 2:43

Infills are area gradings that need to be created within a closed feature line.

 1. Select magenta feature line
 2. Right-click > Move to Site...

 A. Destination Site: Field Survey
 B. OK

 3. Home tab > Create design panel > Feature Line dropdown > Create Feature Line

 A. Site: Field Survey
 B. Leave all other defaults
 C. OK

 4. DRAWFEATURELINE Specify a start point: Shift+right-click > Endpoint > Snap to 
south end of magenta feature line

 5. DRAWFEATURELINE Specify elevation or [Surface]: Enter to accept elevation
 6. DRAWFEATURELINE Specify the next point or [Arc]: Shift+right-click > End-

point > Snap to south end of closest dashed-yellow feature line
 7. DRAWFEATURELINE Specify elevation or [Surface]: Enter to accept elevation

 8. Enter to stop the command

 9. Home tab > Create design panel > Feature Line dropdown > Create Feature Line
 A. Leave all defaults
 B. OK

 10. DRAWFEATURELINE Specify a start point: Click in the area shown below

 11. DRAWFEATURELINE Specify elevation or [Surface]: 1609 Enter
 12. DRAWFEATURELINE Specify the next point: Click in the area shown below

 13. DRAWFEATURELINE Specify elevation or [Surface]: 1609 Enter
 14. Enter to stop the command

This creates a closed shape with 4 feature lines. The last one created overlaps, but Civil 3D 
can resolve this.

 15. Home tab > Create Design panel > Grading > Create Grading Infill
 A. CREATEGRADINGINFILL Select an area to infill: Click inside the area out-

lined by the 4 feature lines. As you hover over this area, the feature lines will highlight.
 B. Esc to exit the command
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 16. Toolspace > Prospector > Surfaces > Select Ditch East > Right-click > Properties...
 A. Information tab > Surface style: P Countours 2' Major: 0.5' Minor
 B. OK

Exercise files: fl-grdg-creat-grdg-data-end-c3d18.zip

Edit grading
Total video time: 1:29

Exercise files: fl-grdg-edit-grdg-data-begin-c3d18.zip

Begin with Grading example.dwg

fl-grdg-edit-grdg-01.mp4 1:29

Click on green diamond grip for large, northern grading

Contextual ribbon > Modify panel > Grading Editor

 1. Criteria is reported. Depending on the criteria, some data is editable and some is not.

 2. Relative Elevation: -.25 Enter
 3. Grade: 1.5% Enter     Editing a grading can also be done from the right-click menu

Select grading > Right-click > Delete Grading...

Select grading > Right-click > Grading Editor...

Exercise files: fl-grdg-edit-grdg-data-end-c3d18.zip

Grading troubleshooting
Total video time: 5:16

Fillet feature line PIs to smooth gradings

Exercise files: fl-grdg-trblshoot-grdg-data-begin-c3d18.zip

Begin with Grading example.dwg

fl-grdg-trblshoot-grdg-01.mp4 1:42

 1. Home tab > Create Design panel > Grading > Grading Creation Tools
 2. Grading toolbar > Grading criteria dropdownGrade to Distance
 3. Grading toolbar > Create Grading

 A. CREATEGRADING Select the feature: Click blue feature line
 B. CREATEGRADING Select the grading side: Click left of the blue feature line
 C. CREATEGRADING Apply to entire length? [Yes No]: Enter to accept the 

default Yes
 D. CREATEGRADING Specify distance: 15 Enter
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 E. CREATEGRADING Format: Enter to accept the default Slope
 F. CREATEGRADING Slope: Enter to accept the default -3

if gradings around vertices are jagged, using a fillet on the vertex can smooth them out.

 4. Select blue feature line
 5. Contextual ribbon > Edit Geometry > Fillet
 6. FILLETFEATURE Specify corner or [All Join Radius]: R Enter
 7. FILLETFEATURE Specify radius: 1 Enter
 8. Esc > Esc to exit the command
 9. Select grading > Right-click > Grading Group Properties...

 A. Automatic Surface Creation: checked
 I. Style: P Contours 5' Major:1' Minor

 II. OK
 B. OK

Begin and end gradings accurately on feature lines

fl-grdg-trblshoot-grdg-02.mp4 1:30

Tips: 
Using the zero station is the most accurate method to find the beginning of a feature line.

Using the length option and accepting the default is the most accurate method to find the 
end of a feature line.

 1. Grading toolbar > Grading criteria dropdownGrade to Distance
 2. Grading toolbar > Create Grading

 A. CREATEGRADING Select the feature: Click blue feature line                     
 B. CREATEGRADING Select the grading side: Click right of the blue feature line                     
 C. CREATEGRADING Apply to entire length? [Yes No]: n Enter                    
 D. CREATEGRADING Select the start point: 0 Enter                    
 E. CREATEGRADING Specify point or [Length]: L Enter for length option                     
 F. CREATEGRADING Specify length: 75 Enter                     
 G. CREATEGRADING Specify distance: Enter to accept 15
 H. CREATEGRADING Format [Grade/Slope]: Enter to accept default Slope
 I. CREATEGRADING Slope: Enter to accept default -3:1
 J. CREATEGRADING Select the grading side: Click right of the blue feature line 

past the previous grading                     
 K. CREATEGRADING Select the start point: 100 Enter                    
 L. CREATEGRADING Station: Enter                    

 M. CREATEGRADING Specify point or [Length]: L Enter for the length option                     
 N. CREATEGRADING Specify length: Enter to accept the default to the end of the 

feature line                     
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 O. CREATEGRADING Specify distance: Enter to accept 15
 P. CREATEGRADING Format [Grade/Slope]: Enter to accept default Slope
 Q. CREATEGRADING Slope: Enter to accept default -3:1

Elevation issues with crossing feature lines in the same site

fl-grdg-trblshoot-grdg-03.mp4 2:04

 1. Home tab > Create design panel > Feature Line dropdown > Create Feature Line

 A. Site: Field Survey
 B. Leave defaults
 C. OK 

 2. DRAWFEATURELINE Specify start point: Click right of gradings
 3. DRAWFEATURELINE Specify elevation: 0 Enter
 4. DRAWFEATURELINE Specify the next point or [Arc]: Click left of gradings
 5. Right-click > Enter to stop command
 6. The contour lines are extremely dense because the crossing feature line is at elevation 0.0

If you select the feature line down the center of the gradings, you will see the zero elevation crossing 
that cannot be edited. If you select the crossing feature line, those elevations can be edited.

 7. Select new feature line > Contextual ribbon > Edit Elevations panel Elevation Editor
 A. Select all vertex rows
 B. Elevation(Actual): 1612 Enter
 C. Close Panorama

Exercise files: fl-grdg-trblshoot-grdg-data-end-c3d18.zip

Rural driveways
Last updated: 2020-10-26

Total video time: 79:59

Create Ex-Top Surface and Combine with Exist Surface

Exercise files: fl-grdg-rurl-dwy-01-data-C3D14.zip

fl-grdg-rurl-dwy-01.mp4 7:00

Rural driveway modeling requires targeting both the proposed work and existing ground. Therefore, 
the two must be combined into a single surface. Utilize the Rfnt-Top surface and existing ground sur-
face to create the Cmbn-Ex-Top surface.  This surface will be the driveway grading target.
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 1. Start a new drawing and called Surf-Cmbn-Ex-Top.dwg.
 2. Data reference the existing ground surface and the Rfnt-All-Top surfaces.
 3. Create a new surf called Cmbn-Ex-Top.
 4. Paste in the existing ground surface and then the Rfnt-All-Top surface.
 5. Save the drawing and create a data shortcut for the Cmbn-Ex-Top surface

Create New Drawing for Driveway Surfaces

fl-grdg-rurl-dwy-02.mp4 5:01

 1. Create a new drawing using the wisdot template and save the drawing with an appropriate 
name such as RuralDwy.dwg

 2. Data shortcut reference the Cmbn-Ex-Top surface
 3. Data shortcut reference alignments for the centerline, edge of pavement, edge of paved 

shoulder, and edge of gravel shoulder
 4. Xreference mapping dwg file(s)

Create Driveway Horizontal Geometry

fl-grdg-rurl-dwy-03.mp4 14:24

 1. Determine the approximate driveway limits (offset).  
 A. This can be done in multiple ways such as using your corridor section editor, or cre-

ating a quick profile along the driveway.
 B. The minimum extent of your driveway limits should be at the back slope of the adja-

cent ditch (slope intercept).
 C. Determine  whether you will need more than one slope to define your driveway for 

added culvert clearance or rollover control.
 2. Draw the driveway "top" in plan view on the P_DWY layer.

 A. Include the driveway entry radii and tapers.
 B. The driveway can be created with line and arcs, but the driveway edges should ulti-

mately be converted to five polylines (left side, right side, match location, centerline, 
and edge of shoulder).

Determine Driveway Elevation/Grade

fl-grdg-rurl-dwy-04.mp4 11:33

 1. Create a new Site  
 A. Name the site the approximate location of the driveway (For example:  380+75 LT).

 2. Convert the driveway match polyline into a feature line.
 A. Name the feature line appropriately (For example: 380+75 LT Match).
 B. Assign the Standard style to the feature line.
 C. The style assignment determines the elevation hierarchy of the feature lines in the 

site.
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 D. Assign elevation to the feature line from the Cmbn-Ex-Top surface using the Elevations 
from Surface command

 E. Make sure it is included in the site created for this driveway.
 F. It is highly recommended that you set up two viewports. One viewport should be set 

to plan view and the other should be set to an isometric view of the driveway location. 
 G. Set the isometric viewport to a rendered view style such as Conceptual. This will allow 

you to watch your driveway surface take shape as you build it.
 3. Convert the edge of shoulder polyline into a feature line.

 A. Name the feature line appropriately (For example: 380+75 LT ES).
 B. Assign the Standard style to the feature line.
 C. Assign elevation to the feature line from the Cmbn-Ex-Top surface using the Elevations 

from Surface command.
 D. Make sure it is included in the site created for this driveway.

 4. Convert the driveway centerline polyline into a feature line 
 A. Name the feature line appropriately (For example:  380+75 LT CL) 
 B. Do not assign the feature line a style. 
 C. The feature line will adopt its elevations from the edge of shoulder and match feature 

lines.
 5. Convert the driveway left and right side polylines into a feature lines.

 A. Name the feature lines appropriately (For example:  380+75 LT LT and 380+75 LT RT).
 B. Do not assign the feature line a style.
 C. The feature line will automatically adopt elevations from the edge of shoulder and 

match feature lines.
 6. Use the Grade/Slope Between Points command to straight-line grade the left and right sides 

between the edge of shoulder and the match location. 

Create Gradings

fl-grdg-rurl-dwy-05.mp4 9:43

 1. Create a Grading Group in the same Site as the driveway.  
 A. Name the Grading Group the driveway location.
 B. Check "Automatic Surface Creation" and "Use Group Name".

 2. Set the Grading Criteria Set to Rural Driveway
 A. If your drawing does not have the Rural Driveway criteria set, use or create a slope to 

surface criteria.
 3. Create 6:1 Gradings along the left and right driveway feature lines. 

 A. If the roadway foreslope is steeper than the driveway side slope, the gradings should 
extend from the driveway slope intercept (match location) to approximately +/-10' 
short of the edge of gravel shoulder.

 B. If the roadway foreslope is the same as or flatter than the driveway side slope, the 
grading can extend the full length of the feature line.

Tips: When prompted for the grading end location, it is useful to use the 
Length option at the command line. The command will then notify you of the 
length remaining to the end of the feature line.
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 4. Create additional gradings along the left and right driveway feature lines that match the road-
way foreslope if the roadway foreslope is steeper than the driveway side slope. 

 A. These gradings should extend from a point about +/-0.01' from the end of edge of 
gravel shoulder to the edge of gravel shoulder.

Create Grading Transitions (only if the roadway foreslope is steeper than the drive-
way side slopes)

 1. Select Create Transition from the Grading Creation Tools
 2. Select the feature line
 3. Select a point between the 6:1 grading and 4:1 grading
 4. Save the drawing

Create Grading Infill for Driveway Top

 1. Choose the Create Infill command from the Grading Creation Tools
 2. Select the regions defining the top of the driveway and hit enter
 3. You will see the completed driveway surface in the isometric view
 4. Save the drawing

Driveways with skew and multiple slopes - Horizontal Geometry

fl-grdg-rurl-dwy-06.mp4 12:53

 1. All the steps outlined above apply
 2. Add an additional polyline representing the slope break in the driveway profile

Driveways with skew and multiple slopes - Determine Driveway Elevation and 
Grade

fl-grdg-rurl-dwy-07.mp4 7:22

 1. All the steps outlined above apply
 2. Convert the additional polyline representing the slope break in the driveway profile to a fea-

ture line
 3. Assign the feature line the  standard style
 4. Assign this feature line elevation by using the Adjacent Elevations by Reference command

Driveways with skew and multiple slopes - Create Gradings

fl-grdg-rurl-dwy-08.mp4 8:03

All the steps outlined above apply

Combine Driveway Surfaces into a Single Surface
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Exercise files: fl-grdg-rurl-dwy-02-data-C3D14.zip

fl-grdg-rurl-dwy-09.mp4 4:00

 1. Create Combined Driveway Surface
 A. Extract the boundary of each driveway surface
 B. Create a new surface called Rfnt-All-RuralDwy
 C. Toolspace > Prospector > Rfnt-All-RuralDwy surface definition > right-click on 

Edits > Paste Surface
 D. Select all of the individual driveway surfaces and click OK.
 E. Draw a polyline that encompasses all of the individual driveways.
 F. Toolspace > Prospector > Rfnt-All-RuralDwy surface definition > right-click on 

Boundaries > Add
 I. Type = Hide 

 II. OK  
 III. Select the polyline boundary that encompasses all the driveways.

 G. Toolspace > Prospector > Rfnt-All-RuralDwy surface definition > right-click on 
Boundaries > Add

 I. Type = Show
 II. OK

 III. Select individual driveway 3D polyline boundaries.

Corridor and refinement surfaces
Create corridor surface
Last updated: 2022-03-09

Total video time: 09:59

Top corridor surface creation

ProjectID\Design\Corridors\Crdr-25-begin.dwg

Exercise files: crdr-rfnt-srfc-data-c3d16.zip

Start with Crdr-Int-CthE-RiverRd.dwg

crdr-srfc-creat-01.mp4 03:19

Open Cdr-Int-CthE-RiverRd.dwg

c3d\12345678\Design\Corridors\Cdr-Int-CthE-RiverRd.dwg

To create corridor surface

 1. Left click on corridor
 2. Contextual Ribbon > Modify Corridor > Corridor Surfaces
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 3. In the Corridor Surfaces dialog on the Surfaces tab, left click create surface

 4. Rename surface Crdr-CthE-Top
 5. Change Add Data, Data type to Feature Lines
 6. Add the following codes: Crown, Daylight, Daylight_Sub, Ditch_Out, ES, ETW, Hinge
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 7. Left click Boundaries tab
 8. Right click Crcr-CthE-Top
 9. Select Corridor extents as outer boundary

 10. OK
 11. Rebuild Corridor
 12. Double check surface Toolspace > Prospector tab > Surface
 13. Esc

Datum corridor surface creation

crdr-srfc-creat-02.mp4 01:46

To create a datum surface

 1. Left click on corridor
 2. Contextual ribbon > Modify Corridor panel > Corridor Surfaces
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 3. On the Surfaces tab of the Corridor Surfaces dialog, Left click Create a corridor surface

 4. Rename the surface Crdr-CthE-Datum
 5. Change the Data type to Feature Lines
 6. Add the following codes: Crown_Sub, Daylight, Daylight_Sub, Ditch_Out, ETW_Sub, Hinge
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 7. Left click the Boundaries tab
 8. Right click on Crdr-CthE-Datum
 9. Select Corridor extents as outer boundary

 10. OK
 11. Rebuild Corridor

Data shortcut corridor surface

crdr-srfc-creat-04.mp4 01:08

To create Data Shortcuts

 1. Save 
 2. In the Prospector tab of Toolspace, Right click on Data Shortcuts
 3. Select Create Data Shortcuts
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 4. In the Create Data Shortcuts dialog, Check Surfaces

 5. OK

Refinement surface basics
Last updated: 2020-10-26

Total video time: 01:45

rfnt-srfc-basc-01.mp4 01:45

 l Corridor design is only one step in final surface creation
 l Other gratings or surface adjustments may be needed for final surface
 l Refinement surface is the final surface, combination of all definitions, pasted together
 l Refinement surfaces source of data in section views, plans/profile sheets, etc.
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 l One refinement surface for each final surface:
 o Top, Datum

 l No matter how divided up the project definition
 o ALL Top surfaces in Rfnt-Top
 o ALL Datum surfaces in Rfnt-Datum

 l Other gradings or adding breaklines
 

 l Pasting into final refinement
 o Last surface pasted takes precedence where there is conflict
 o Plan the order to be pasted
 o Top and Datum surfaces are defined to daylight, so there are large areas already 

exactly the same

Create refinement surface
Last updated: 2022-03-09

Total video time: 07:50

Top refinement surface creation

ProjectID\Design\Corridors\Crdr-25-begin.dwg

Exercise files: crdr-rfnt-srfc-data-c3d16.zip

Start with Surf-Rfnt-All-Top.dwg

rfnt-srfc-creat-01.mp4 02:41

Create top refinement surface

 1. Menu browser > New
 2. Select design-start.dwt

 3. Open
 4. Menu browser > Save As
 5. Design > Surface
 6. Name: Surf-Rfnt-All-Top

 7. Save
 8. Toolspace > Prospector tab > Data Shortcuts > Surfaces
 9. Right click Crdr-CthE-Top

 10. Create Reference...

 11. Accept defaults
 12. OK
 13. Ribbon > Home tab > Create Ground Data panel > Surfaces dropdown > Create Surface
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 14. Name surface Rfnt-CthE-Top
 15. Left click ellipses in style field
 16. Select Top Border
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 17. OK
 18. OK
 19. Toolspace > Prospector tab > Surfaces > Rfnt-CthE-Top > Definition
 20. Right Click Edits
 21. Select Paste Surface...
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 22. Select Crdr-CthE-Top
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 23. OK
 24. Double click mouse wheel
 25. Save
 26. Toolspace > Prospector tab > Data Shortcuts
 27. Right click Data Shortcuts
 28. Select Create Data Shortcuts...

 29. Select Rfnt-CthE-Top
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 30. OK

Datum refinement surface creation

rfnt-srfc-creat-02.mp4 03:01

 1. QNEW
 2. Save As
 3. Surf-Rfnt-All-Datum

 4. Save
 5. Toolspace > Prospector tab > Data Shortcuts > Surfaces
 6. Right click Crdr-CthE-Datum
 7. Select Create Reference...

 8. OK
 9. Toolspace > Prospector tab > Data Shortcuts > Surfaces

 10. Right clickRfnt-CthE-Top
 11. Select Create Reference...

 12. OK
 13. Ribbon > Home tab > Create Ground Data panel > Surfaces dropdown > Create Surface
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 14. Name surface Rfnt-CthE-All-Datum
 15. Change style to Datum Border

 16. OK
 17. OK
 18. Toolspace > Prospector tab > Surfaces > Rfnt-CthE-All-Datum > Definition
 19. Right click Edits
 20. Select Paste Surface...

 21. Select Rfnt-CthE-Top
 22. OK
 23. Double click mouse wheel
 24. Toolspace > Prospector tab > Surfaces > Rfnt-CthE-All-Datum > Definition
 25. Right clickEdits
 26. Select Paste Surface...
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 27. Select Crdr-CthE-Datum
 28. OK
 29. Save
 30. Toolspace > Prospector tab > Data Shortcuts
 31. Right Click Data Shortcuts
 32. Select Create Data Shortcuts...
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 33. Select Rfnt-CthE-All-Datum

 34. OK
 

Corridor and refinement surface progression
Last updated: 2020-10-26

Recommended surface progression

There are multiple methods for creating the Datum and Top refinement surfaces. Both surfaces 
need to cover the entire limits of proposed work within Daylight codes (slope intercepts). To min-
imize the amount of data, work, and processing time, designers can create the Crdr-Top surface from 
Daylight to Daylight and create the Crdr-Datum surface only under the roadway, then paste it over 
the Rfnt-Top surface.

In the recommended progression, the Crdr-Datum surface only extends to the edge of the roadway 
subgrade (typically 2 ft outside the back of curb and gutter in urban or the subgrade shoulder point 
in rural).  The Crdr-Top surface extends to the slope intercepts. Any refinements outside the roadway 
then automatically appear in the Rfnt-Datum surface.
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Benefits

There are several instances in our roadway design workflows that require us to build an additional 
surface in order to progress the design.  Listed below are a few of those cases:

 1. Pipe Networks:  For pipe networks, we create a special corridor surface called Crdr-
PipeDatum.  The purpose of this surface is to provide a reference for the pipe network cover 
rule.  This surface includes the roadway subgrade only.  Since the recommended Crdr-Datum 
surface has the same definition, the Crdr-PipeDatum surface can be eliminated.

 2. Crdr-Ultimate surface:  This surface is used for several purposes and is typically combined 
with the existing surface to show a "finished project" state.  Possible uses include rural drive-
way workflow, curb ramp workflow, visualization, and others.  Since the recommended Crdr-
Top surface has the same definition, the Crdr-Ultimate surface can be eliminated.

 3. Urban surface refinement:  The benefit demonstrated  is for surface refinements that span 
the ETW_Datum_CG feature line (point typically 2 ft behind curb and gutter).  The purpose of 
those refinements is for driveways and curb ramps.  The refinements must occur on a top sur-
face that spans the ETW_Datum_CG feature line.  Those refinements are then reflected auto-
matically in the Rfnt-Datum surface.  This recommended workflow can be beneficial anywhere 
there is a need for surface refinements that span the connection of Top and Datum.

 4. Quicker visualization models:  If a quick  visualization model is needed, the recommended 
Crdr-Top surface can  be used.

Drawbacks

The drawback to this workflow shows up in the Crdr-Datum surface boundary creation when the sur-
face is not continuous in the transverse direction.  A divided highway is a good example of this scen-
ario.  The recommended workflow will require the user to create two surface boundaries:
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 1. One that follows the outside subgrade shoulder points
 2. A second "hide" boundary that follows the median side subgrade shoulder points.

Alternatively, the user could create two separate Crdr-Datum surfaces; one for the NB/EB subgrade, 
and a second for the SB/WB subgrade.

Surface model deliverable impact

Since the result of the refinement surfaces is not changed, the impact to the surface model deliv-
erable is not affected, with one exception.

Warning: Rural driveway surfaces should not be pasted into the Rfnt-Top surface.  Since the 
Rfnt-Top surface is a component of the Rfnt-Datum surface, the rural driveways must be kept 
separately.

Contractors do not want the rural driveways to be part of the datum surfaces based on the workflow 
of their construction operations. The rural driveways surface is  a separate surface model deliverable. 
See FDM 15-5-7 for additional details on design model requirements.

Fixing triangle edges
Last updated: 2022-09-14

These best practices for surface model creation will make the breakline extraction much simpler. If 
these best practices are not followed, the breakline extraction process will not work as intended.

Links for corridor surface definition

This is a bad practice for the deliverable that we want to achieve. We want the surfaces to be defined 
by longitudinal breaklines because these are the elements that our contractors are looking for. It is 
not a good idea to mix links and feature lines in the surface definition because once you include the 
links, there is not a good way to know if you have all of the required feature lines. If you have all of 
the required feature lines, there really isn’t any need for the links. One argument for links is that they 
help force desired triangulation in certain situations. An intersection radius is an example of that. 
However, this can easily be resolved by adding a single line or 3D Polyline to the refinement surface 
definition.
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Surface edit tools

We do not want designers using the surface edit tools, except is certain situations.
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Warning: Added surface definition created by these tools cannot be extracted and delivered 
for construction. In the example from the first bullet, the add line or swap edge commands are 
often used to clean up the intersection triangulation. However, the proper way to address that 
is by adding a line or 3D polyline as a breakline. The commands highlighted in pink should not 
be needed for design surface definition. The delete line and delete point command can be 
used because they take away previously created elements of the surface definition. Delete line 
is often used to remove external triangulation that was not removed by a corridor boundary. 
Using the delete point command will cause the point’s source breakline segment to be no 
longer valid and will therefore be excluded from the breakline deliverable by the Design Sur-
face Data Extractor. Adjustments to the corridor or addition of breaklines should address situ-
ations where the remaining surface edit commands would otherwise be used. When 
breaklines are extracted from the refinement surface definition, you should be able to recre-
ate the refinement surface from those breaklines alone. If these surfaces edits are used, the 

Page: 865

Published on: 5/17/2023

Fixing triangle edges



surface created from the extracted breaklines will not match the refinement surface. In sum-
mary, the surface edits cannot be extracted and conveyed in the breakline file.

Civil 3D QC surface checklist
Last updated: 2022-12-16

Civil 3D QC surface checklist

This spreadsheet is a tool to aid in reviewing the creation of project surfaces.  The spreadsheet can 
be editted to fit the review needs for each project.

Civil 3D QC surface checklist.xlsx

Rural intersection
Rural intersection: introduction
Last updated: 2020-10-26

Overview

The rural intersection topic is long. It is the culmination of many concepts in the Roadway design - 
beginner training course. It starts with  mainline and side road alignments and profiles and an exist-
ing surface and goes through to refinement surfaces after the corridor. There are two primary reas-
ons for this approach:

 1. Many of the steps and best practices used make more sense when seen in context with the 
rest of the workflow.

 2. We especially want new users to have the opportunity to work through all of the steps they 
are likely to see in a first production design project.

 3. A rural intersection has the opportunity to train many workflows, tools, and best practices. All 
of these items may not be needed in any given project, but once learned, a user can choose 
to use a tool. Tools that are never learned are never used.

Content for existing designers

Many items that have been individual topics or not yet released have been incorporated into this 
workflow. Below is a list of topics that may have new or interesting concepts or tools for existing 
designers.

 1. Data management for objects that are used in corridor modeling and plan sheets

The following series of topics cover the organization of data so that named alignment objects 
can be used for corridor targeting and data shortcutted to a single file to be used as an xref in 
plan sheets.

 A. "Rural intersection: data management" on the facing page
 B. "Rural intersection: project-wide edgeline alignments" on page 870
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 C. "Rural intersection: alternative layout layers" on page 872
 D. "Rural intersection: alternative layouts" on page 873
 E. "Rural intersection: mask project-wide edgeline alignments" on page 878
 F. "Rural intersection: create pavement file" on page 881

 2. Setup corridor and surface

Sometimes proposed geometry needs to be generated before a final corridor can be created. 
We call a corridor with this purpose a setup corridor.

 A. "Rural intersection: setup assemblies" on page 889
 B. "Rural intersection: setup corridor" on page 890
 C. "Rural intersection: setup surface" on page 895

 3. Intersection objects to connect curb return profiles to mainline and sideroad geo-
metry

 A. "Rural intersection: side road setup corridor" on page 912
 B. "Rural intersection: curb return setup and assembly" on page 915
 C. "Rural intersection: curb return setup corridor" on page 916
 D. "Rural intersection: curb return profiles" on page 927

 4. Refinement surfaces

 A. "Rural intersection: create refinement datum surface" on page 979
 B. "Rural intersection: create refinement top surface" on page 976

 5. Optional edits - slope control profiles

At the end of the exercise, some optional steps have been added. They show matching up the 
transition between a rural and urban shoulder so that the surfaces are smooth. These steps 
are not required for construction data packet deliverable, but they are very good practice for 
using the Slope/ Width control editor in conjunction with WisDOT subassemblies that use 
slope/width profile control.

 A. "Rural intersection: optional edits introduction" on page 986
 B. "Rural intersection: grading behind curb and gutter with corridor" on page 1004
 C. "Rural intersection: grading behind curb and gutter with corridor" on page 1004
 D. "Rural intersection: taper curb head ends to zero height" on page 1010
 E. "Rural intersection: match top of gravel shoulder to top of terrace behind curb and gut-

ter" on page 1016
 F. "Rural intersection: edit shoulder foreslope to match ditch behind curb and gutter" on 

page 1032

Rural intersection: data management
Total video time: 4:26

Last updated: 2020-10-26

Exercise files: rurl-int-begin-data-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg
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rurl-int-data-mngmnt-01.mp4 4:26

Data management

This will give a brief overview of the project as a whole to get a better understanding of how we are 
going to structure our project data and why we put certain objects in certain files.

This project is a reconstruction of WIS 25 along with a reconfiguration of some of the intersections. 
We're going to square up 4th Avenue as best as we can. 

At 14th street we will create a T intersection and improve the angle.

At Upper Pine Drive we will create a T intersection and obliterate the stretch of road on the other 
side rerouting that traffic to 14th Street.

This project will be split among three designers. WisDOT will design the main corridor of WIS 25 and 
the intersection at 4th Avenue. Two contractors will design the other intersections.

The following diagram shows how we are going to organize the project.
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The AliProf file will contain all the information pertaining to the entire project including the mainline 
alignments for Highway 25- centerline, Edge of travelway, edge of paved shoulder and edge of gravel 
surface. It will also include a dynamic intersection block for the initial  layout and alternative inter-
section designs.

The corridor drawings will contain objects that are specific to that intersection and are not project 
wide. The corridor drawing for 4th Avenue will contain the edge line alignments for the turn lanes, 
the curb return, 4th Ave edge of pavement and edge of gravel.

All of the information created in those 4 drawings will get data referenced into the Pavt.dwg.

And then that data will be used as an Xref in the Plan Sheets drawing.

Tip: There are three designers on this project but even if there was a single designer it is best 
to still have three corridors. With a single designer you could place all you edgeline alignments 
in the AliProf and then data reference them into the pertinent corridor file.
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 1. Tan-Tan (with curves) > click on the beginning of the curb
 2. Hover over the end of the tangent- a + sign appears
 3. Hover over the next tangent and a + sign appears
 4. Hover out where the PI is and the intersection will be marked by dashed lines > left click
 5. Click the end of the curb > Enter
 6. Use the grip at the PI to move the curb into place
 7. Repeat for the final curb

Rural intersection: project-wide edgeline alignments
Total video time: 5:19

Last updated: 2020-10-26

Project-wide edgeline alignments

Exercise files: rurl-int-begin-data-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-prjct-wid-edglin-ali-01.mp4 5:19

The alignments created here will be used throughout the entire project. They include the WIS 25 
centerline, edge of travelway, edge of paved surface and edge of gravel surface. 

The topographic mapping was used as an Xref to establish the side road alignments. When working 
in Civil 3D you want to show only the graphics that you need for any given task. The more that you 
show on the screen the more its going to degrade the performance of the application.

 1. Select the topographical Xref > Right click > Unload
 2. Home tab > Create Design > Alignment > Create Offset Alignment

 A. Select the main line alignment
 B. Set the auto naming to [Parent Alignment Name(CP)]>-<[Side]>-ETW

Info: Standard naming conventions can be found at: https://wis-
consindot.gov/rdwy/fdm/fd-15-05-att.pdf#fd15-5a3.4

 C. Station Range: 370+00 to 423+00
 D. No. of offsets on left/right: 1
 E. Incremental offset: 12.00'
 F. Alignment Style: RDWY Pavement Edge
 G. Alignment Labels: _None

 3. Repeat the steps with the edge of paved surface and the edge of gravel surface 
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Rural intersection: alternative layout layers
Total video time: 4:37

Last updated: 2020-10-26

Alternative layout layers

Exercise files: rurl-int-prjct-wid-edglin-ali-end-data-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-layout-layr-01.mp4 4:37

Tip: To make it easy to compare different design alternatives create new layers for each of 
them.

 1. Open layer manager
 2. Create new layer
 3. Begin each new layer name with P_RDWY to utilize the layer filters
 4. Give a description that explains the type of intersection
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 5. Double click on the 4thAve_Alt1 to make it the current layer

Rural intersection: alternative layouts
Total video time: 8:34

Last updated: 2020-10-26

Alternative layouts

Exercise files: rurl-int-prjct-wid-edglin-ali-end-data-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-layout-altrnativ-01.mp4 4:36

 1. Set the layer to P_RDWY_4thAve_IntLayout_Alt1
 2. WisDOT Design tab > Parametric Design > Intersection Blocks > Int-Type-B-Tan
 3. The insertion point is the intersection of main line centerline and ETW of side road

 4. Rotate > select the block > select the insertion point for the base > select a point along the 
ETW alignment
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 5. Set the intersection angle by dragging the triangular grip over to the side road alignment
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 6. Adjust the lane width in the Design tab of the properties block
 7. Use the Standard detail drawing to determine the Radii based on the Q value
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Info: Standard detail drawings can be found at https://wisconsindot.gov/rdwy/sdd/sd-
09a01.pdf#1

 8. Repeat the steps with the west side of the intersection

rurl-int-layout-altrnativ-02.mp4 3:58

 9. Set the current layer to P_RDWY_4thAve_IntLayout2
 10. Copy the east intersection to a new layer

 A. Select the intersection block
 B. Home tab > Layer ribbon > Copy to layer
 C. Select the Alt2 layer to copy to
 D. Select the base point and then select the point again
 E. Turn off the Alt1 layer

 11. Insert a Type D intersection block on the west side of the road
 12. Rotate it in place
 13. Set the intersection angle
 14. Set the side road width to 11'
 15. Set the W value to the width of the shoulder or 5'
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 16. Set R1 to 40' and R2 to 70'
 17. Now you can toggle between the alternatives by turning on and off the layers

 

Rural intersection: mask project-wide edgeline alignments
Total video time: 6:59

Last updated: 2020-10-26

Remaining intersections & alignment masking

Exercise files: rurl-int-prjct-wid-edglin-ali-end-data-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

 rurl-int-mask-prjct-edglin-ali-01.mp4 6:59

Repeat the process above to insert In-Type-B-Tan blocks for the other 2 intersections. 

Highlight all the intersection blocks and at the bottom of the properties switch the Visibility to graph-
ics mode which will hide some of the lines making it less cluttered.

The project wide edgeline alignments span through the intersection. This will not work for plans pro-
duction purposes. We will need to mask the alignments in the intersection areas. For masking the 
alignments turn on all the block layers to match the mask to the intersection footprint that is the 
greatest.

 1. Select the alignment > Alignment Properties > Masking tab > Add Masking Region
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 2. Select the point at which the main road alignment matches into the side road taper

 3. Next select where the main road alignment matches into the turn lane taper
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 4. OK The part of the alignment in the intersection will now be masked
 5. Go back into the alignment properties and add a mask for the 14th street intersection
 6. Repeat the process to mask the EPS and EGS on both sides of the road
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Now that masking is complete the intersection graphics are much more presentable

Rural intersection: create pavement file
Total video time: 3:48

Last updated: 2020-10-26

Create pavt.dwg file

Exercise files: rurl-int-prjct-wid-edglin-ali-end-data-c3d16.zip

Start with 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-creat-pavt-fil-01.mp4 3:48

With the project wide edgeline alignments complete we can now make data shortcuts for those 
objects
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 1. Manage tab > Create Data Shortcuts
 2. Select all of the offset alignments OK

Warning: It is a bad practice to create data shortcuts for surface profiles. Instead of using data 
shortcuts for surface profiles, data shortcut the surface and make new surface profiles in the 
file where they are needed.

Comment: The pavement file is a repository for all the various edgelines in your project. They all get 
data referenced into the pavement file and then they get Xreferenced into the plan sheets

 1. Open an new drawing > Save as Pavt.dwg in the Edgelines folder
 2. Data reference the edgelines from AliProf.dwg

 A. Toolspace > Prospector tab > Data Shortcuts > Alignments > Offset Alignments 
> 25-Left-EGS > right click > Create Reference

 B. Alignment style > RDWY Shoulder Aggregate 
 C. No labels
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 D. Continue with the other alignments making sure the alignment style is correct for each 
of them

Info: Note there are gaps in the alignments. This is from the masking. Those gaps will be filled 
in as we create more alignments in the corridor files. 
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Rural intersection: create preliminary plans
Total video time: 7:12

Last updated: 2020-10-26

Preliminary plans 1

Exercise files: rurl-int-creat-pavt-fil-end-data-c3d16.zip

Start with: 12345678\Design\edgelines\pavt.dwg

rurl-int-prelim-pln-01.mp4 3:57

To print some preliminary sheets without having the corridor complete we can Xref AliProf.dwg. 
Because we masked the alignments to the larger of the blocks there will be some gaps when only 
Alt1 is showing. We will create some linework to fill that in.

 1. In the AliProf.dwg set current layer to P_RDWY_PavtEdge 
 2. Draw a polyline to from the edge of the block across the intersection to the other edge of 

block
 3. Trim the line to the edges of the other Alt block
 4. Repeat with the EPS and EGS
 5. Select all the new polylines and create a block
 6. Set the block layer to Alt2
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 7. Set the block layer to Alt2
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Preliminary plans 2

rurl-int-prelim-pln-02.mp4 3:15

 1. Open Preliminary.dwg in the SheetsOther folder
 2. Xref pvmt.dwg
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 3. Xref AliProf.dwg- this will give us the intersection lines

Info: The AliProf file contains a lot of information that is not necessary here.

 4. In Layer Properties in the AliProf Xref freeze all the layers except the ones starting with P_
RDWY

 5. In 4thAve Alt1 viewport double click in the view frame to activate it
 6. Freeze the Alt2 layer in this view only
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 7. In Alt 2 view Freeze Alt1 layer

This gives you a preliminary plan set without creating the corridors
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Rural intersection: setup assemblies
Total video time: 5:04

Last updated: 2020-10-26

Setup assembly
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Exercise files: rurl-int-prelim-pln-end-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-setup-asmbly-01.mp4 5:04

The design team has decided to go with the Intersection with the turn lane so freeze the layer Alt2. 
We're going to create a setup corridor to the AliProf drawing to know the elevation at the main road 
ETW and what elevation to tie the curb and gutter ends. The setup corridor will develop a surface 
that we can pull a profile from for those critical locations.

 1. Select all the intersection blocks and change the visibility to Design mode
 2. Home tab > Create Design > Assembly > Create Assembly
 3. Name it 25-Setup-ETW > OK > Place in drawing

Tip: Assemblies and corridors display better if you change the display scale to 1 
IN:10FT or 1 IN:5FT 

 4. WisDot Design tab > WisDOT & Civli Imperial palette > General Subassemblies tab > 
MultiUseWidthAndSlopeLinks

 5. Place on the assembly

 6. Select the assembly and Assembly properties to set the parameters

 7. Repeat for the left side

Rural intersection: setup corridor
Total video time: 6:13

Last updated: 2020-10-26
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Setup corridor

Exercise files: rurl-int-prelim-pln-end-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-setup-crdr-01.mp4 6:13

 1. In the WisDOT Design tab select label assemblies select All and enter

 2. Home tab > Create Design > Corridor
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Info: The FDM has the maximum frequency spacing requirements: https://wis-
consindot.gov/rdwy/fdm/fd-15-05.pdf

 3. Set the start and end stations to include the entire footprint of the intersection
 4. Set the frequency to 2.5'
 5. OK > Rebuild Corridor
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 6. Select corridor and Add Regions
 7. Set the regions for 14th street and Upper Pine to include the footprint of the entire inter-

section
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 8. With the Corridor selected use the Match Parameters command > select the first region as 
the source and then the next two as destinations

 9. Add critical frequencies where the elevation has to be absolutely correct like at the curb and 
gutter line and where the side road centerline crosses the main road ETW

 A. Select the corridor
 B. Modify Corridor Sections panel > Add a Section
 C. Select the end of curb and ETW at centerline of intersecting roadway
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Rural intersection: setup surface
Total video time: 2:45

Last updated: 2020-10-26

Setup surface

Exercise files: rurl-int-prelim-pln-end-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-setup-srfc-01.mp4 2:45

Create the setup surface from the setup corridor
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 1. Select the corridor > Corridor Surfaces > Create Corridor Surfaces
 2. Rename it to Crdr-25-setup-ETW
 3. Style > Top Triangles
 4. Set Data type to Links and Code to Top > +

 5. OK > Rebuild Surface
 6. Select the corridor and set the codes to No display
 7. Feature lines tab > select all feature lines > No Display
 8. Create a data shortcut for the Corridor surface
 9. Save

Rural intersection: create corridor file
Total video time: 4:07

Last updated: 2020-10-26

Create corridor file

Exercise files: rurl-int-setup-srfc-end-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-crdr-fil-01.mp4 4:07

Create the setup surface from the setup corridor

 1. Open a new WisDOT template file > save as Crdr-25-4thAve in the corridor folder
 2. Create Data References

 A. Surfaces > Existing Ground > Existing border Display style
 B. Surfaces > Crdr-25-Setup-ETW > No Display
 C. Alignments > Centerlines > 25 > 1IN 40FT Ticks 100' Major 500' Minor
 D. Alignments > Centerlines > Lcl-4thAve > 1IN 40FT Ticks 100' Major 500' Minor
 E. Alignments > Offset Alignments > add all offset alignments with No Display to their 

respective layers
 3. Xref AliProf.dwg and adjust the layers

 A. Layer Properties > AliProf 
 B. Select all P_RDWY > invert selection > freeze
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 C. Freeze 14thSt-IntLayout
 D. Freeze UpperPine-IntLayout

Rural intersection: side road profile
Total video time: 13:43

Last updated: 2020-10-26

Side road profile

Exercise files: rurl-int-creat-crdr-fil-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-sdrd-prfl-01.mp4 4:54

Create the setup surface from the setup corridor

 1. Home tab > Create Design > Profile > Create Profile
 2. Alignment > Lcl-4thAve
 3. Surfaces > Existing > Add > Draw in Profile View

 4. Profile Display Options tab > Labels > No Labels
 5. Accept the remaining defaults > Create Profile View
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 6. Place in drawing off to the side
Comment: To create a proposed profile you need to have an idea where to match existing ground. 
One of the controlling factors is knowing the extents of the superelevation of the curve. To quickly 
find that add a label to the alignment.

 1. Select the alignment > Right click > Edit Alignment Labels
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 2. Type drop down > Superelevation Critical Points > Add
 3. Check none > check Begin normal crown and End normal crown
 4. OK > OK
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Comment: The corridor will have to begin at 43+21 and end at 53+05

 1. Home tab > Create Design > Profile > Profile Creation Tools
 2. Select 4thAve alignment > Profile view
 3. <[Alignment Name]>-Prop > PROF Proposed style > WisDOT Standard Label set
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 4. Draw Tangents without curves 
 5. Use the transparent command Profile Station and Elevation from Plan > follow prompts

 F. Select the profile view
 G. Select the surface
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 H. Select the beginning point by typing in the Station 43+20
 I. Select the end station 53+05
 J. Enter > Enter

 K. A profile is created that is tied into the existing ground at the beginning and end station

Side road profile (intersection object)

rurl-int-creat-sdrd-prfl-02.mp4 5:41

With the ends of the profile tied in we can now tie down the profile to match into highway 25 at the 
centerline and both edges. The intersection object tool locks profile alignment combinations 
together. We will lock the proposed profile to the highway 25 existing profile.

 1. Home tab > Create Design > Intersections > Create Intersection
 2. Select the intersection point of the two alignments

 3. The command line prompts you for the main road alignment which is the controlling align-
ment- Select Highway 25

 4. Name > <Primary Name>-<Secondary Name>
 5. Make sure 25 is the main alignment and Lcl4thAve is the secondary > uncheck create offset 

alignments
 6. Create Intersection- a PVI is created and the elevation is locked down
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 7. Create surface profile for Highway 25 ETW 
 A. Home tab > Create Design > Profile > Create Surface Profile
 B. Alignment > 25-Left-ETW > Crdr-25-Setup-ETW > Add
 C. Alignment > 25-Right-ETW > Crdr-25-Setup-ETW > Add > OK

 8. Home tab > Create Design > Intersections > Create Intersection
 9. Select the ETW

 10. Select 25-Right ETW for the main alignment > Lcl4thAve secondary
 11. Uncheck create offset alignments > Create intersection
 12. Repeat with the left side
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 13. Create Intersection- a PVI is created and the elevation is locked down
 14. The key locations for the profile are locked down

Info: Because 4thAve crosses Highway at a skew the slopes are not 2%. They are 2% 
when perpendicular.

Side road profile continued

rurl-int-creat-sdrd-prfl-03.mp4 3:08

The rest of the work is design work. the PVI's and elevations have been pre-determined and they will 
just be entered here.
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 1. Select the profile > Profile Properties > Design Criteria tab
 2. Check Use criteria-based design and Use design criteria file > WisDOT Design Criteria 

2009.xml > WisDOT Standard-Desirable Category 1 > OK

 3. Select Geometry Editor > Insert PVI 
 4. Use the transparent command Profile Station Elevation

Sta 44+35 Elev 1141.03'
Sta 46+30 Elev 1137.50'
Sta 51+60 Elev 1141.00'

 5. Press Enter 3 times to complete the task

 6. Create Free Vertical Curve (Parabola) 
 7. Select the first entity and second entity on screen > Length = 230'
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 8. Select the next two tangents > Length = 155'
 9. Select the last two tangents > Length = 150'

Info: In the tabular editor you can see the minimum K values based on the design 
speed established on the alignment.

Rural intersection: intersection edgeline alignments
Total video time: 23:27

Last updated: 2020-10-26

Corridor alignments

Exercise files: rurl-int-creat-sdrd-prfl-end-data-c3d16.zip

Start with 12345678\Design\Crdr-25-4thAve.dwg

rurl-int-crdr-edglin-ali-01.mp4 4:00

The rest of the work is design work. the PVI's and elevations have been pre-determined and they will 
just be entered here.

 1. Home tab > Create Design > Alignment > Alignment Creation Tools
 2. Draw Tangent- Tangent without curves > name it 25-Right-TrnLn > RDWY Pavement Edge style 

> No Labels > OK 
 3. Trace the entire reference block ETW
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 4. To better view the alignments fade the xref to 60
 5. Home tab > Create Design > Alignment > Alignment Creation Tools
 6. 25-Right-EPS > RDWY paved shoulder
 7. Trace the paved shoulder in the block
 8. Repeat the process with the gravel shoulder
 9. Repeat all the steps for the left side

Corridor alignments continued

rurl-int-crdr-edglin-ali-02.mp4 7:08
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There are two alternatives for creating the side road edgeline alignments.

Method 1:  Create offset alignments from the centerline alignment from construction limit to con-
struction limit.  Mask the alignments between the curb return approach tapers.  Create separate 
alignments for the curb return approach tapers.

Upside-

• Dynamic connection to the centerline alignment.  Reactive to side road geometric 
changes. (still requires manual edits at the curb return approach tapers)

• Less risk to the curb return intersection objects because they are based on separate 
alignments for the tapers.

Downside-

• Minimum of 4 additional alignments to manage.

• More alignments to target with the corridor.

Method 2: Create a single alignment for each edgeline from construction limit to construction 
limit.

Upside-

• Less alignments to target.  Allows for expanded use of the Match Corridor Region Para-
meters command.

• Less alignments to create and manage, especially related to data shortcuts.

Downside-

• Requires more editing if side road geometry changes.

• May need to recreate curb return intersection objects if side road geometry changes.

Create the alignment

 1. Create a offset of 11' on either side of the 4th Avenue alignment to have something to snap to 
 2. Create 3' offsets from those lines for the shoulder
 3. Home tab > Create Design > Alignment > Alignment Creation Tools
 4. Lcl-4thAve-Left-ETW > RDWY Pavement Edge style > No Labels
 5. Draw Tangent- Tangent without curves
 6. Select the transparent command Station Offset
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 7. Specify the station 4320 > -11' offset (for left side) > Escape > Select the PC and enter

Tip: The best snaps to have turned on right now are the Endpoint, Intersection and 
Extension

 8. Draw Tangent- Tangent without curves > Select the PT and then the PC > Enter
 9. Draw Tangent- Tangent without curves > Select the next PT > start of taper > end of taper > 

extension to ETW > across the intersection > back of curb > finish the tapers
 10. Draw Tangent- Tangent without curves > last PT > use the Station Offset transparent tool 

5305 > -11'
 11. Free Curve Fillet (Between two entities, through point) > select the two tangents and then a 

point along the curve

Tip: Using the Selection cycling here ensures that you are grabbing the alignment and 
not the poly line which are on top of each other.

 12. Repeat with the remaining curves > Enter to end the command
 13. Repeat all the steps for the shoulder and the ETW & EGS on the right side
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Corridor alignments continued

rurl-int-crdr-edglin-ali-03.mp4 5:29

Comment: The final alignments are the curb return alignments. The curb return blocks slightly over-
lap the ETW alignment. We will have intersection objects tying down the ends of the curb and gutter. 
Intersection objects work best when the intersecting alignments have some overlap.

 

 1. Home tab > Create Design > Alignment > Alignment Creation Tools
 2. Name > Int-25-4thAve-SE-CG > RDWY Curb&Gutter Flange > No Labels

Tip: All alignments should be created in a clockwise direction. This allows the use of 
one assembly for all the curbs. 

 3. Tan-Tan (No curves) > draw the beginning and end tangents on the curb
 4. Free Curve Fillet (between two entities, through point) > Select the tangents then a point of 

the curve
 5. Repeat for the NE C&G

Comment: An alternate method is to us tangent with curve command.

Corridor alignments continued

rurl-int-crdr-edglin-ali-04.mp4 6:50

Start by masking the part of the alignments that we don't want to see in the Plans Productions draw-
ings

 1. Select an alignment > Alignment Properties > Masking tab > Select region > select the edge of 
the alignment where you want to mask > OK

 2. Repeat with all the other alignments to clean up the drawing
 3. Create Data Shortcuts > Select all the miscellaneous Alignments just created
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 4. Open the pavement file
 5. In TOOLSPACE Prospector tab select an alignment > right click > Create Reference > Set Align-

ment Style > No Labels
 6. Repeat with all the miscellaneous alignments
 7. Select the Home tab > Create Design > Alignment > Alignment Creation Tools
 8. Draw Tangent- Tangent without curves > name it 25-Right-TrnLn > RDWY Pavement Edge style 

> No Labels > OK 
 9. Trace the entire reference block ETW

Tip: There is a part of the block that overlaps the 25-Right-ETW alignment 10' before 
the start for the taper. It is best practice to overlap the alignments this way instead of 
starting right at the end of the matching alignment to aid in conditional targeting.

 10. To better view the alignments fade the xref to 60
 11. Home tab > Create Design > Alignment > Alignment Creation Tools
 12. 25-Right-EPS > RDWY paved shoulder style
 13. Trace the paved shoulder in the block
 14. Repeat the process with the Gravel shoulder
 15. Repeat all the steps for the left side

Rural intersection: side road setup corridor
Total video time: 5:25

Last updated: 2020-10-26

Side road ETW setup corridor

Exercise files: rurl-int-crdr-edglin-ali-end-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-sdrd-setup-crdr-01.mp4 5:25

Comment: In the AliProf.dwg we made a Highway 25 setup corridor which will be used to tie down 
the curb and gutter elevation. We need another setup corridor to tie down the curb and gutter elev-
ations for 4th Ave.

 1. Create the Assembly
 A. WisDOT Design tab > WisDOT & Civil Imperial palette > General tab 
 B. Home tab > Create Design > Assembly > Create Assembly
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 C. Place the Assembly off to the side
 D. MultiUseWidthAndSlopeLinks > Place on the assembly

Right inside width 20.000'
Right inside SE Use outside lane SE
Right outside width 5.000'
Right outside SE Use outside lane SE
Left inside width 20.000'
Left inside SE Use outside lane SE
Right outside width 5.000'
Right outside SE Use outside lane SE

 E. OK
 2. Home tab > Create Design > Corridor
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 3. Set the Baseline and Region Parameters to the end of each taper
 4. Set the frequencies to 2.5'
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 5. OK > OK > Rebuild Corridor
 6. Add Sections at the back of curb
 7. Create corridor surface > adjust the name > No Display > Top code > Add as a breakline > OK
 8. In the corridor change the code set to No Display and the feature lines to No Display

Rural intersection: curb return setup and assembly
Total video time: 3:56

Last updated: 2020-10-26

Setup curb & gutter assembly

Exercise files: rurl-int-creat-sdrd-setup-crdr-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-cr-setup-prfl-asmbly-01.mp4 3:56

Comment: Develop the curb return profiles by creating another setup corridor. This setup corridor 
will give us a range of where we can set our curb return profiles. The range is developed by setting a 
minimum and maximum slope away from 25 ETW and 4thAve centerline

 1. WisDOT & Civil Imperial palette > Setup Assemblies tab > Setup-Curb-Prof
 2. Place by the other assembly 
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 3. Set Assembly Properties
 A. Max slope -4%
 B. Min slope -1%
 C. Norm slope -2%

 4. Home tab > Create Design > Profile > Create Surface Profile
 5. Select the Int-25-4thAve-NE-CG alignment > Exist surface > Add > OK

 6. Repeat for the other three corners

Rural intersection: curb return setup corridor
Total video time: 12:16

Last updated: 2020-10-26

Setup curb & gutter profile corridor

Exercise files: rurl-int-creat-sdrd-setup-crdr-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-cr-setup-crdr-01.mp4 4:24

Info: Develop the curb return profiles by creating another setup corridor. This setup corridor 
will give us a range of where we can set our curb return profiles. The range is developed by set-
ting a minimum and maximum slope away from 25 ETW and 4thAve centerline

 1. Home tab > Create Design > Corridor > 4thAve-Setup-CG-Prof
 2. Alignment > Int-25-4thAve-NE-CG
 3. Set the frequencies to 2.5' and set the profile settings to No

Page: 916

Published on: 5/17/2023

Rural intersection: curb return setup corridor

https://c3dkb.dot.wi.gov/data/rdwy-dsn/rurl-int/rurl-int-cr-setup-crdr-end-data-c3d16.zip
https://c3dkb.dot.wi.gov/video/rdwy-dsn/rurl-int/rurl-int-cr-setup-crdr-01.mp4


 4. Set Targets

 
Target Object Name Subassembly

Target Align-
ment

25-Right-ETW

Lcl-4thAve

Target ETW Ali_Prof and Sideroad 
Ali_Prof

Target Align-
ment

Int-25-4thAve-NE-CG Max Slope-TARGET-Curb Return Ali

Target Align-
ment

25-Right-ETW-Crdr-25-
Setup-ETW

Lcl-4thAve-Prop

Target ETW Ali_Prof and Sideroad 
Ali_Prof
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 5. OK > OK
 6. Because the targets are similar between the NE and SE corners we can quickly create the SE 

corner using data from the NE
 7. Select corridor > Add Baseline > Select the SE Alignment > OK > Add region > Select the begin-

ning and end of the CG > Setup-Curb-Prof > OK > OK
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 8. With the corridor still selected > Match Parameters > Select the NE then the SE > Enter
 9. Edit targets > Change the Max slope to SE from NE
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Setup Curb & Gutter Profile Corridor Continued

rurl-int-cr-setup-crdr-02.mp4 3:07

 1. With corridor selected > Add base > Select the SW CG > Click the beginning and end of CG > 
 2. Alignment > Int-25-4thAve-SW-CG
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 3. Set the frequencies to 2.5' and set the profile settings to No
 4. Set targets

 
Target Object Name Subassembly

Target Align-
ment

25-Left-ETW

Lcl-4thAve

Target ETW Ali_Prof and Sideroad 
Ali_Prof

Target Align-
ment

Int-25-4thAve-SW-CG Max Slope-TARGET-Curb Return Ali

Target Align-
ment

25-Left-ETW-Crdr-25-
Setup-ETW

Lcl-4thAve-Prop

Target ETW Ali_Prof and Sideroad 
Ali_Prof

 5. Because the targets are similar between the SW and NW corners we can quickly create the 
NW corner using data from the SW

 6. Select corridor > Add Baseline > Select Profile > Add region > Select the beginning and end of 
the CG > Setup-Curb-Prof > OK > OK
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 7. With the corridor still selected > Match Parameters > Select the SW then NW
 8. Edit targets > Change the Max slope to NW from SW
 9. Highlight the corridor > Match Parameters > Settings > Only Match Frequencies 

 10. Select the SE region then the SW & NW > Enter
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Setup curb & gutter profile corridor continued

rurl-int-cr-setup-crdr-03.mp4 4:49

 1. Select the corridor > Section Editor
 2. Viewport Configuration 
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Info: From the curb return baseline the corridor finds the 25-ETW or Lcl4thAve centerline and 
then projects three slopes- the min, max and norm. Those slopes can be set to whatever is 
needed but for this project they are -1%, -4% & -2%. That gives a range in which to set the final 
profile. Next we will create three surfaces- one for each slope.

 1. Select corridor > Corridor Surfaces 

 2. Rebuild Corridor
 3. Profile > Create Profile from Surface > Select SE Alignment > Select the three surfaces > Add > 

Change style to RDWY Lane Edge
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 4. Draw in Profile View > Profile Display Options > No Labels > Create Profile View

 5. Repeat with the three other corners

Rural intersection: curb return profiles
Total video time: 12:35

Last updated: 2020-10-26

Curb & gutter profiles
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Exercise files: rurl-int-cr-setup-crdr-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-cr-prfl-01.mp4 3:39

Tip:  This symbol indicates the corridor is out of date. Right 
click and you can rebuild. They can also be set up to rebuild automatically. The advantage of 
auto rebuild is you get automatic feedback on design changes. The disadvantage is every time 
changes are made the corridor will take time to rebuild.

 1. In the corridor properties set the code set style to No Display and select all the feature lines > 
No Display

 2. Profile > Create Surface Profile > 25-Right-Trn-Ln alignment > Crdr-25-Setup-ETW surface > 
Add > OK

 3. Repeat for the left side
 4. Repeat for the 4thAve right and left sides

Setup curb & gutter profile corridor continued

rurl-int-cr-prfl-02.mp4 5:39

 1. Profile > Profile Creation Tools > Select the Profile view > <[Alignment Name]>-Prop > OK
 2. Tan Tan No curves > draw a line past the extents of the profiles (elevation doesn't matter 

here)

 3. Repeat for the other three corners
 4. Intersection > Create Intersections > Select the intersection point > 25-Right-TrnLn is main > 

deselect create offset alignments > Create 
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 5. Repeat for the other seven intersections

Curb & gutter profiles continued

rurl-int-cr-prfl-03.mp4 3:17

Comment: Now we will refine the profiles so they fit nicely within the slope ranges we have created

 1. Select a profile > Geometry Editor > Insert PVI 
 2. Place it somewhere in between the slope ranges
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 3. Repeat with the other curves
 4. Use the grip at the PVI to drag it to a place that fits well
 5. When there is a pronounced grade change you can smooth it out by adding a vertical curve
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Rural intersection: create mainline assembly with conditional sub-
assemblies
Total video time: 8:26

Last updated: 2020-10-26

Part 1

Exercise files: rurl-int-cret-mnln-asmbly-cndtnl-01-begin-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-mnln-asmbly-cndtnl-01.mp4 4:48

Here we will build the assemblies for the corridor design. These assemblies will use conditional sub-
assemblies so one assembly can do much of the design work for the entire intersection. This is an 
optional method; a more traditional method would be to build a series of assemblies that react to 
regions in the corridor which we will cover in the side roads design.

 1. Home > Create Design > Assembly > Create Assembly
 2. Name it 25-FullSection- something to easily identify later
 3. Place in drawing by other assemblies
 4. WisDOT Design > WisDOT & Civil Imperial > Lanes tab > LnExtendBase 
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 5. Accept the defaults and select the assembly twice to add the sub to each side

 6. Tool Palette > Conditional tab > Conditional Horizontal Target
 7. Place a Target Not Found and a Target Found at the right edge of the roadway
 8. Place a Target Not Found at the end of the Target Found Subassembly
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 9. Tool Palette > Lanes tab > ShldGeneric
 10. Use the default parameters and attach to the Target Not Found subassembly

 11. Tool Palette > Daylights & Slopes tab > DaylightProfileControlled
 12. In the Parameters box 

 A. Ditch/Fill switch > Ditch to create a ditch all the time even with fill
 B. Ditch backslope > 4.00:1
 C. Daylight fill slope > 4.00:1
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 13. Select the outside of the ShldGeneric subassembly
 14. This conditional assembly completes the main road assembly or the areas where there is no 

turn lane
 15. Save to use for the next exercise

Part 2

Exercise files: rurl-int-cret-mnln-asmbly-cndtnl-01-begin-data-c3d16.zip

Start with the previous exercise or start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-asmbly-cndtnl-02.mp4 3:38

This step will build the conditional Target Found where there is a turn lane

 1. Highlight the right lane assembly
 2. Modify Subassembly tab > Copy
 3. Select the end of the Found > Not Found conditional
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 4. Highlight the curb & gutter subassembly and copy to the outside of the lane

Tip: In this condition the subassembly represents the turn lane which starts narrow and 
widens. The target will override the width parameter but it may start early or overlap. To safe-
guard against this set the lane width parameter in the subassembly properties to 0.01'
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 5. In the Curb and gutter subassembly properties set the paved width to 0.00'

 6. Highlight all the conditional subassemblies 
 7. Modify Subassembly > Mirror
 8. Select the outside of the left lane

Rural intersection: rename subassemblies
Total video time: 4:23

Last updated: 2020-10-26

Exercise files: rurl-int-cret-mnln-asmbly-cndtnl-01-begin-data-c3d16.zip
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Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-renam-sub-01.mp4 4:23

Tip: It is critical to make sure all of the names of the subassemblies are correct. You can do it 
as you are building them or after the assembly is built. Be sure to label right or left side and 
what the assembly targets.

 1. LnExtendBase-R
 2. CondHorizTarget-TrnLn-NotFound-R
 3. CondHorizTarget-TrnLn-Found-R
 4. CondHorizTarget-IntCore-NotFound-R
 5. ShldGeneric-R
 6. LnExtendBase-TrnLn-R
 7. ShldGeneric-TrnLn-R
 8. DaylightProfileControlled-R
 9. DaylightProfileControlled-TrnLn-R

 10. Tip: If you label all of the subassemblies before you mirror them the names will follow 
them. Then you would only have to change each R to an L. These don't have to be 
labeled- labels are shown here for informational purposes.

 11. LnExtendBase-L
 12. CondHorizTarget-TrnLn-NotFound-L
 13. CondHorizTarget-TrnLn-Found-L
 14. CondHorizTarget-IntCore-NotFound-L
 15. ShldGeneric-L
 16. LnExtendBase-TrnLn-L
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 17. ShldGeneric-TrnLn-L
 18. DaylightProfileControlled-L
 19. DaylightProfileControlled-TrnLn-L

Rural intersection: create side road assemblies
Total video time: 4:30

Last updated: 2020-10-26

Exercise files: rurl-int-creat-trgt-ali-int-cor-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-sdrd-asmbly-01.mp4 4:30

In this topic we will build the assembly for the secondary road, 4th Avenue

 1. Home > Create Design > Assembly > Create Assembly
 2. Name it 4thAve-FullSection
 3. Insert it just below the other assembly
 4. Select each of the roads > copy and paste to the new assembly
 5. Select the curb and gutter and daylight assemblies > copy and past to 4thAve-FullSection
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 6. Info: As the corridor enters the intersection there may be sections where it doesn't 
have daylight. For these we will create an assembly with just one side of the road. 
Because 4thAve does not go through the intersection but skips over it we will create a 
null assembly for that area.

 7. Copy the 4thAve assembly twice to just below it
 8. Delete the right subassemblies from the left copy
 9. Delete the left subassemblies from the right copy

 10. Rename to 4thAve-DayLeft and 4thAve-DayRight

 11. Home > Create Design > Assembly > Create Assembly
 12. Name it 4thAve-Null
 13. Do not add sub assemblies

Warning: It is important at this point to make sure all your subassemblies are named appro-
priately. If you haven't already take some time to rename them all so you can find them later.

Rural intersection: create curb return assemblies
Total video time: 7:57

Last updated: 2020-10-26

Info: No matter which way you decide to do your assemblies, whether you do conditional sub-
assemblies or use the more traditional regions method, the curb return fillet assemblies will 
have to be made separately. 

Assembly with no daylight

Exercise files: rurl-int-creat-sdrd-asmbly-end-data-c3d16.zip
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Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-cr-asmbly-01.mp4 3:27

 1. Home > Create Design > Assembly > Create Assembly
 2. Name it Curb Return Fillet
 3. Copy the pavement from the left side
 4. Open the Subassemblies Properties > Parameters tab

 A. Pavement slope > 2.00%
 B. Crown location > Outside
 C. Inside base extension width > 5.00'

Info: This subassembly is going to start at the curb and build back toward the crown; most 
other assemblies start at the crown. The inside base extension will create a sub base for the 
curb and gutter.

 5. Tool Palette > Barriers tab > CGBasic
 6. Properties > Parameters

 A. Curb and gutter size > Wi 36"
 B. Wi 36" curb types > D 6" curb sloped
 C. Terrace slope (%) > -4.00%
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 D. Select the Assembly

Info: There is a slight overlap of the sub base and curb. That material will be measured along 
the bottom where they overlap.

 7. Save for next exercise

Assembly with daylight

Exercise files: Continue with previous data set or start with: rurl-int-creat-cr-asmbly-01-end-data-
c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-cr-asmbly-02.mp4 3:35

There may be time that you need to daylight the back of curb. Start by copying the curb and gutter 
assembly.

 1. Select the new assembly > Properties
 2. Rename Curb Return Fillet Daylight
 3. Tool Palette > General Assemblies tab > LinkProfileControlled
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 4. Properties > Parameters
 A. Slope > -4.00:1
 B. Outer Point > Ditch_In
 C. Link > Top,LABELSLP

Tip: The exact spelling and capitalization is very important for the coding that comes up 
later.

 5. Tool Palette > Daylight tab > CutFillProfileControlled
 6. Properties > Parameters

 A. Offset to measure recoverable slope from > 1.00'
 B. Recoverable slope > 6.00:1
 C. Clear zone distance > 1.00'
 D. Recoverable fill slope distance > 1.00'
 E. Cut slope > 4.00:1
 F. Fill slope > 4.00:1

 7. Connect the subassembly to the back end of the LinkProfileControlled sub
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Label assemblies
Total video time: 1:54

Last updated: 2020-10-26

Label assemblies

Exercise files: rurl-int-creat-cr-asmbly-02-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

Page: 945

Published on: 5/17/2023

Label assemblies

https://c3dkb.dot.wi.gov/data/rdwy-dsn/rurl-int/rurl-int-creat-cr-asmbly-02-end-data-c3d16.zip


rurl-int-labl-asmbly-01.mp4 1:54

Overview

One tool that is not strictly necessary, but can be very helpful is the Label Assemblies tool. The Label 
Assemblies tool creates pre-filled and pre-formatted Mtext labels containing the name of an 
assembly. The tool can be used to place a single label at a time or can automatically place labels for 
all assemblies in the drawing at once.

Using the Label Assemblies tool

WisDOT Civil 3D 2016

WisDOT Design Tab > Assemblies & Subassemblies Panel > Label Assemblies

WisDOT Civil 3D 2018

WisDOT Design Tab > WisDOT Assemblies & Subassemblies Panel > Label Assemblies

It can also be accessed from the command line: SMAT.

To label a single assembly at a time

 1. Press Enter to accept the current text size as shown in the command line or type a new text 
size. (0.075 is a good size.)

 2. Press Enter for single labeling.
 3. Select an existing label to erase or press Enter to continue to add a new label.
 4. Select an assembly to label.
 5. Left-click on the screen to place the label in the desired location.
 6. Select an existing label to erase or press Enter to continue adding new single labels.
 7. When you are done adding labels press Enter twice.
 8. Press Quit or type Q on the command line to exit the Label Assemblies tool.

To label all assemblies in the drawing at once

 1. Press Enter to accept the current text size as shown in the command line or type a new text 
size. (0.075 is a good size.)

 2. Press All or type A on the command line to label all assemblies.
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Rural intersection: create target alignments for intersection core
Total video time: 3:05

Last updated: 2020-10-26

Exercise files: rurl-int-lbl-asmbly-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-trgt-ali-int-cor-01.mp4 3:05

The next step is to create the targets for the interior of the intersection core. The regular assembly is 
going to build the road and the turn lane but when it gets to the intersection we want it to drop 
everything except the lane edge. We will create an alignment that stretches across the intersection.

 1. Home > Create Design > Alignment > Alignment Creation Tools

 2. Name it: Int-25-4thAve-IntCore-Rt
 3. Alignment Style > RDWY Lane Edge
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 4. Use the tangent tangent no curve tool to draw from the beginning of intersection to the end

Page: 948

Published on: 5/17/2023

Rural intersection: create target alignments for intersection core



 5. Close out the tool bar
 6. Repeat the above steps for the left side
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Info: These alignments do not need to be data referenced. We will be using them only in the 
file. If needed they could be data referenced if they were needed elsewhere.

Rural intersection: mainline assembly corridor targeting
Total video time: 12:41

Last updated: 2020-10-26

Horizontal targets

Exercise files: rurl-int-creat-trgt-ali-int-cor-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-mnln-asmbly-crdr-trgt-01.mp4 6:07

Here we will start to build the corridor starting with Highway 25. One assembly will almost all of the 
design but we have to do quite a bit of targeting first.
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 1. Home tab > Create Design > Corridor Set the following parameters

 A. Start Station: 370+00.00'
 B. End Station: 423+00.00'
 C. Frequency: 25.00'

 2. Open Target Mapping dialog box
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 3. Surfaces > All Existing
 4. Set Parameters carefully > Add > OK

 5. Repeat for the left side
 6. Save for the next exercise

Vertical targets

Exercise files: Continue with previous data set or start with: rurl-int-creat-trgt-ali-int-cor-end-data-
c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-mnln-asmbly-crdr-trgt-02.mp4 1:52
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 1. LnExtendBase-R > 25-Right-ETW-25-Right-ETW-crdr-25-Setup-ETW
 2. LnExtendBase-TrnLn-R > 25-Right-TrnLn-25-Right-TrnLn-Crdr-25-Setup-ETW

 3. Repeat for the left
 4. OK > OK > Rebuild Corridor

Fix frequency inside intersection footprint
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Exercise files: Continue with previous data set or start with: 

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-mnln-asmbly-crdr-trgt-03.mp4 4:42

Increase the frequency to 2.5 FT from end of taper to end of taper. This will be done by splitting the 
existing regions and modifying the frequency of the regions inside the intersection.

 1. Select corridor > contextual ribbon > Modify Region panel > Split Region
 A. Click start of NB right turn lane taper
 B. Click start of SB right turn lane taper
 C. Esc

 2. Select corridor > contextual ribbon > Modify Corridor panel > Corridor Properties > 
Parameters tab

 A. Middle region, 381+50 > 390+00, Frequency ...
 I. Alignment

 a. Along tangents: 2.5'
 b. Curve increment: 2.5'
 c. Along spirals: 2.5'

 II. Profile
 a. Along profile curves: 2.5'

 III. OK
 B. OK
 C. Rebuild Corridor

Add frequencies at intersection of side road alignment with mainline edge of travelled way.

 3. Select corridor > contextual ribbon > Modify Region panel > Edit Frequency > Click 
inside region

 A. Click + to add manual frequencies.
 I. Shift+right click > Apparent intersection > click intersection of side road 

alignment with SB edge of travelled way
 II. Shift+right click > Apparent intersection > click intersection of side road 

alignment with NB edge of travelled way
 III. Esc

 B. OK
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Rural intersection: create side road regions
Total video time: 10:22

Last updated: 2020-10-26

Insert assemblies

Exercise files: rurl-int-mnln-asmbly-crdr-trgt-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-sdrd-rgn-01.mp4 5:36

Here we will add in the side road using regions for 4th Ave

 1. Select the Corridor > Corridor Properties > Parameters tab > Add Baseline > Lcl-4thAve 

 2. Alignment > Lcl-4thAve
 3. Profile > Lcl4thAve-Prop
 4. Right click the region and Add Region
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 5. Select the 4thAve-FullSection to start

 6. Select the region > In Start Station click select on screen > Select the beginning of one of the 
alignments

 7. End Station > Select from screen
 8. Select the beginning of the first taper.
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 9. Select the region > In Start Station click select on screen > Select the beginning of the first 
taper

 10. End Station > Select from screen
 11. Select the first curb return
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 12. Set frequency to 2.5 FT
 A. Click ellipsis button on Frequency for region
 B. Along tangents: 2.5
 C. Curve increment: 2.5
 D. OK

 13. Right click the region > Insert region - After

Info: Because the curb return will be the target on the left side here we will only have lane and 
daylight on the right hand side until the other curb and gutter starts.
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 14. Assembly > 4thAve-Day-Right > Select the start of curb return on the right

 15. Set frequency to 2.5 FT
 A. Click ellipsis button on Frequency for region
 B. Along tangents: 2.5
 C. Curve increment: 2.5
 D. OK

 16. Right click that region > Insert Region - After > Assembly > 4thAve-Day-Left > > Begin Station > 
Select the nearest curb return on the far side of intersection

Page: 959

Published on: 5/17/2023

Rural intersection: create side road regions



 17. Right click the region >  End Station > select the farthest taper
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 18. Right click that region > Insert Region - After > Assembly > 4thAve-Null > Select the nearest 
curb return on the far side of intersection
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 19. Right click the null region > Insert Region - After > 4thAve-Day-Left > End Station > select the 
next curb return
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 20. Right click the new region > Insert Region - After > 4thAve-FullSection > End Station > End of 
the alignments
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 21. OK > Rebuild Corridor

 22. Save for use with next exercise

Set targets
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Exercise files: Continue with previous data set or start with: rurl-int-mnln-asmbly-crdr-trgt-end-
data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-sdrd-rgn-02.mp4 4:46

Now we will make sure the targets are correct for 4thAve. You can go into Corridor Properties and 
select the ellipse for each one and edit there or better yet select Edit Targets and select the region. 
That way you will only be show the targets in that region.

 1. Select the Corridor > Edit Targets > Select the first region
 2. Surfaces > Click here to set all > Exist
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 3. The next section will only have targets on the right
 4. The other Daylight section will only have targets on the left
 5. The last section will be targeted the same as the first

 6. Save

Rural intersection: create curb return regions
Total video time: 9:09

Last updated: 2020-10-26
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Regions without daylight

Exercise files: rurl-int-cr-rgn-01-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-cr-rgn-01.mp4 5:05

To finish of the corridor design we need to create the curb return fillet regions. these will be assem-
blies that move along the curb return baseline and shoot back towards the lane edge of 25 and the 
centerline of 4th Ave. We will use a no daylight assembly in the southern 2 quadrants. Later we will 
make daylight versions in the north quadrants.

 1. Corridor Properties > Parameters tab > Add Baseline
 2. Alignment > Int-25-4thAve-SE
 3. Profile > Int-25-4thAve-SE-CG-Prop
 4. Alternately you can select from screen

 5. Right click the Baseline > Add Region > Assembly > Curb Return Fillet
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 6. Select the Beginning and the End of the curb return

 7. Set the frequencies to 2.50'
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 8. Open the Target Mapping dialog box
 9. Target Lane Width to Lcl4thAve (the centerline of the side road)

 10. Target Lane Width a second time to 25-Left-ETW

Info: The 25-Left-ETW is not visible right now, it is masked out so you aren't able to select from 
the screen.

 11. Target Lane Profile to 25-Left-ETW > 25-Left-ETW-Crdr-25-Setup-ETW
 12. Target Lane Profile a second time to Lcl4thAve > Proposed Profile
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 13. OK > OK > Rebuild Corridor

Tip: If the corridor doesn't match up perfectly you may have to manually add a frequency.

 14. Highlight the Corridor > Edit Frequency > Select the Region
 15. In the Frequency dialog box select the + and left click the point on the screen
 16. OK > the frequency is added
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 17. Repeat the steps with the SE curb return
 18. Save for the next exercise

Regions with daylight

Exercise files: Continue with previous data set or start with: rurl-int-cr-rgn-01-end-data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-cr-rgn-02.mp4 4:04

For the north two curb returns we will add a daylight

 1. Corridor Properties >  Parameters tab > Add Baseline > Int-25-4thAve-NE-CG
 2. Horizontal Alignment > Int-25-4thAve-NE-CG
 3. Right click the Baseline > Add Region > Assembly > Curb Return Fillet Daylight
 4. Select the beginning and end of curb return
 5. Set frequencies to 2.50'
 6. Target Lane Width to Lcl4thAve (the centerline of the side road)
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 7. Target Lane Width a second time to 25-Right-ETW
 8. Target Lane Profile to 25-Right-ETW > 25-Right-ETW-Crdr-25-Setup-ETW
 9. Target Lane Profile a second time to Lcl4thAve > Proposed Profile

 10. OK > OK > Rebuild Corridor
 11. Repeat for the NE curb return

Rural intersection: create corridor top surface
Total video time: 3:21

Last updated: 2020-10-26

Create surface and data shortcut

Exercise files: rurl-int-creat-crdr-datm-srfc-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-crdr-top-srfc-01.mp4 3:21

Page: 972

Published on: 5/17/2023

Rural intersection: create corridor top surface

https://c3dkb.dot.wi.gov/data/rdwy-dsn/rurl-int/rurl-int-creat-crdr-datm-srfc-end-data-c3d16.zip
https://c3dkb.dot.wi.gov/video/rdwy-dsn/rurl-int/rurl-int-creat-crdr-top-srfc-01.mp4


 1. Open Corridor Surfaces dialog box
 2. Create new surface named Crdr-25-Top
 3. Data Type > Feature Lines
 4. Specify code

 A. BackCurb
 B. Berm_In
 C. Berm_Out
 D. CG_Terrace
 E. Clear_Zone
 F. Crown
 G. Daylight
 H. Daylight_Sub
 I. Ditch_In
 J. EPS

 K. ES
 L. ETW

 M. FaceCurb
 N. Flange
 O. Flowline_Gutter
 P. TopCurb

 5. Add boundary
 A. Corridor Surfaces  > Boundaries tab > Right-click Crdr-25-Top > Corridor Extents 

as outer boundary
 B. OK
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 C. Rebuild the corridor

 6. Save the file.
 7. Toolspace > Prospector > Right-click Data Shortcuts >  Create Data Shortcuts...

 A. Crdr-25-Top: checked
 B. OK

Rural intersection: create corridor datum surface
Total video time: 5:03

Last updated: 2020-10-26

Exercise files: rurl-int-cr-rgn-02-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-crdr-datm-srfc-01.mp4 5:03

Now we will create data surfaces from the corridor. Because the top and datum surfaces overlap in a 
lot of areas we use a surface progression to not duplicate the data. Conventional surface pro-
gression truncates the top surface where the top and datum meet- daylight areas of the back of the 
curb and gutter. The alternate progression is the opposite where the top goes to the daylight and 
the datum is truncated. You can find more on this by searching for Surface Progression in the 
C3DKB.

 1. Select the corridor > Right-click > Corridor Surfaces > Surfaces tab > Create Corridor 
Surface > Rename it Crdr-25-Datum
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 2. Data type > Feature lines
 3. Specify code

 A. Crown_Sub
 B. Daylight_Sub
 C. ETW_Datum_CG
 D. ETW_Pave1_CG
 E. ETW_Sub
 F. ETW_Sub_CG

 4. Boundaries tab > right click Surface > Corridor extents as outer boundary 
 5. OK > Rebuild Corridor
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 6. To check the surface right lick the surface in Prospector tab > Surface Properties > Surface 
Style > P Contours 2' Major: 0.5' Minor

 7. Save the file
 8. Right click on Data Shortcuts > Create Data Shortcuts > select the surface

Rural intersection: create refinement top surface
Total video time: 3:01

Last updated: 2020-10-26

Exercise files: rurl-int-creat-rfnt-datm-srfc-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-rfnt-top-srfc-01.mp4 3:01

Next we will build the top refinement surface. We had to do the datum surface first because the 
datum surface does play a role in creating the top surface. That is how the conventional surface pro-
gression works- the datum is be pasted in from daylight to daylight and the top surface is being pas-
ted on top.
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 1. Create a new file > QNew

 2. Save As > ProjectID\Design\Surfaces\Srfc-Rfnt-All-Top.dwg
 3. Save
 4. Toolspace > Prospector tab > Data Shortcuts > Surfaces > right click Crdr-25-Top > 

Create Reference
 A. Style: No Display
 B. OK

 5. Tip: You could set the style so it is visible but at this point it is better to leave as _No Dis-
play so when the Refinement Top surface is created the end result is visualized.

 6. Home tab > Create Ground Data > Create Surface
 A. Name it- Rfnt-25-Top

Tip: You could set the visual style to anything you want but setting it to some-
thing noisy like this will help visualize how the surface is progressing.

 B. Style: P Contours 2' Major:0.5' Minor
 C. OK

 7. Toolspace > Prospector tab > Surfaces > Rfnt-25-Top> Definition > right click Edits > 
Paste Surface > OK
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Warning: It is important that these are created in the right order. What ever is pasted 
second will override what was pasted first. Whenever there is a conflict what was save 
last wins. You could set the visual style to anything you want but setting it to something 
noisy like this will help visualize how the surface is progressing.

 8. Save
 9. Right click Data Shortcuts > Create Data Shortcut
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Info: This video shows the acceptable minimum for design. If you had grading surfaces 
done you could add them here. We will cover grading, pipe clearance and other design 
options in later videos.

Rural intersection: create refinement datum surface
Total video time: 3:16

Last updated: 2020-10-26

Exercise files: rurl-int-creat-crdr-top-srfc-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-rfnt-datm-srfc-01.mp4 3:16

Now that the corridor top surface and datum surface are created and data referenced into the pro-
ject we will create the refinement surface files 
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 1. Create a new file > QNew

 2. Save As > up 1 level and into Surfaces folder > Srfc-Rfnt-All-Datum.dwg
 3. Save
 4. Toolspace > Prospector tab > Data Shortcuts > Surfaces > right click Rfnt-25-Top > 

Create Reference

Tip: You could set the style so it is visible but at this point it is better to leave as _No Dis-
play so when the Refinement surface is created the end result is visualized.

 5. Toolspace > Prospector tab > Data Shortcuts > Surfaces > right click Crdr-25-Datum > 
Create Reference

 6. Home tab > Create Ground Data > Create Surface
 7. Name it- Rfnt-25-Datum 

Tip: You could set the Style to P Border to just see the outline but it is better to set it to 
P Contours 2' Major:0.5' Minor to show that the surface is everywhere you want it to be.

 8. Toolspace > Prospector tab > Surfaces > Rfnt-25-Datum > Definition > right click Edits > 
Paste Surface > OK

Click Rfnt-25-Top > OK

 9. Toolspace > Prospector tab > Surfaces > Rfnt-25-Datum > Definition > right click Edits > 
Paste Surface > OK

Click Crdr-25-Datum > OK
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 10. Save
 11. Right click Data Shortcuts > Create Data Shortcut
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Info: You can see the grading for ditches on the northern curb returns where they are 
daylighted. This video shows the acceptable minimum for design. If you had grading 
surfaces done you could add them here. We will cover grading, pipe clearance and 
other design options in later videos.

Rural intersection: design surface edits
Total video time: 7:46

Last updated: 2020-10-26

In this video we will show a few common edits that can be synchronized throughout the project to 
keep the refinement surfaces up to date. We will be addressing some of the common edits that most 
intersections will need and how to quickly deal with them.

Remove extra triangles

Exercise files: rurl-int-creat-rfnt-top-srfc-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-dsn-srfc-edit-01.mp4 1:16

Here we will turn on surface triangles and clean up triangles that break through the barrier some-
how. Open the Crdr-25-4thAve file.

 1. Prospector tab > Surfaces > right click Crdr-25-Datum > Surface Properties > Surface 
style > P Triangles

 2. Select one of the triangles to highlight the surface
 3. Edit Surface > Delete lines
 4. Highlight the triangle lines you want to delete being careful not to delete ones you want
 5. Enter to delete
 6.  Esc to end command
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 7. Save to use for the next exercise

Add breaklines in curb returns to datum surface

Exercise files: Continue with the previous data set or start here: rurl-int-dsn-srfc-edit-01-end-data-
c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-dsn-srfc-edit-02.mp4 3:29

The surface is not respecting the frequency lines in parts of the intersection because some of the 
centerline points of 25 points can see the centerline points on 4thAve better then the curb returns. 
To fix this we will add breaklines from curb return to the intersection of 25 and 4thAve in the refine-
ment surface. We will open the refinement surface.

 1. Open 12345678\Design\Surfaces\Srfc-Rfnt-All-Datum.dwg
 2. Toolspace > Prospector > Surfaces > Right-click Rfnt-25-Datum > Rebuild to synchronize 

changes from the corridor surface.
 3. Select Rfnt-25-Datum surface > Right-click Surface Properties...

 A. Surface style: Datum Triangles
 B. OK

 4. Change current layer to P_SURF_Rfnt-25-Datum
 5. Using the line command create a line from the edge of curb return at the mid point to the 

intersection of the quadrants
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 6. Toolspace > Prospector tab > Rfnt-25-Datum > Definition > Right click Breaklines > Add 
Breaklines

 A. Type: Standard
 B. OK

 7. Select all 4 of them > Enter

Info: This might not be perfect through here. You can add more breaklines to refine it more if 
needed. Save here to push any referenced data out.
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 8. Save the file
 9. Select Rfnt-25-Datum surface > Right-click Surface Properties...

 A. Surface style: P Contours 2' Major 0.5' Minor
 B. OK

 10. Save for the next exercise

Add breaklines in curb returns to top surface

Exercise files: Continue with the previous data set or start here: rurl-int-dsn-srfc-edit-02-end-data-
c3d16.zip

Start with: 12345678\Design\Surfaces\Srfc-Rfnt-All-Top.dwg

rurl-int-dsn-srfc-edit-03.mp4 2:24

 1. Open 12345678\Design\Surfaces\Srfc-Rfnt-All-Top.dwg
 2. Select Rfnt-25-Datum surface > Right-click Surface Properties...

 A. Surface style: Datum Triangles
 B. OK

 3. Change current layer to P_SURF_Rfnt-25-Top
 4. Toolspace > Prospector > Surfaces > Right-click Rfnt-25-Top > Rebuild to synchronize 

changes from the corridor surface.
 5. Using the line command create a line from the edge of curb return at the mid point to the 

intersection of the quadrants

 6. Toolspace > Prospector tab > Rfnt-All-Top > Definition > right click Breaklines > Add 
Breaklines
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 7. Select the 4 lines

Tip: When using the multi-select window the last line added will be above the rest. Use 
this tool to select the lines just created and not the previous feature lines.

 8. Select Rfnt-25-Top surface > Right-click Surface Properties...
 A. Surface style: P Contours 2' Major 0.5' Minor
 B. OK

 9. Save the file.

Rural intersection: optional edits introduction
Total video time: 4:03

Last updated: 2020-10-26

rurl-int-optnl-edit-intro-01.mp4 4:03

Optional edits introduction

Before showing the optional edits to help the shoulder elevations and the curb and gutter elevations 
match we will show you an overview of the results to help you decide if these options are necessary. 
These edits are optional only used if you find a special need to make the resulting surface more like 
what will be constructed out in the field.

Info: To show the changes clearly colors of the links have been changed here: green for the 
shoulder, yellow for the terrace behind the curb and gutter. We've also removed several point 
code labels that were cluttering the view.
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 1. Match the curb head closer at the match point between the shoulder and the curb.
 2. Before

 3. After

 4. Flatten the shoulder slope as we approach the curb and gutter match point. this will make the 
ditch point of the shoulder match more closely to the ditch point that would result from the 
back of terrace point.

 5. Before
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 6. After

 7. There is now almost a 6:1 slope vs. the original 4:1

Rural intersection: grading behind curb and gutter with feature lines
Total video time: 14:28

Last updated: 2020-10-26

What we will look at now are the several control options you have over the corridor. We have shown 
the minimum for design and now we are going to look at some tools and workflows for different 
design situations. Instead of being tied to make adjustments to targets at curb return where daylight 
is added you may choose to create feature lines to the area behind the curb return. This process will 
add a lot of flexibility on how to edit and control the graded area, but it does come with a lot of 
manual control.
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Add back of terrace

Exercise files: rurl-int-dsn-srfc-edit-03-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-fl-01.mp4 6:34

Starting in the SW quadrant there is a big gap in the surface area. We will add in a manual feature 
line to build a surface in this area which will then be pasted into the refinement surface further down 
the project.

 1. Home tab > Create Design > Feature Line> Create Feature Line
 2. Change the layer to P_CRDR-Base
 3. Select the daylight_sub feature line just outside the back of curb and gutter it will inherit the 

elevation of that point

 4. Select the same feature line on the far side of quadrant
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 5. Enter to Specify elevation
 6. Insert a PI somewhere along the middle- it can be adjusted later
 7. Enter to specify elevation
 8. Select Free curve fillet between two entities or Radius if you know the radius
 9. Adjust the grips to get it to match the back of curb closely- it will not be tangent anymore
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 10. Save to use for the next exercise

Add ditch, slope intercept and back of curb

Exercise files: Contiue with previous data set or start with: rurl-int-dsn-srfc-edit-03-end-data-
c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-fl-02.mp4 2:46

 1. Home tab > Create Design > Feature Line> Create Feature Line
 2. Set lalyer to P_Crdr-Base
 3. Select the Ditch_In feature line it will inherit the elevation of that point
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 4. Select the same feature line on the far side of quadrant

 5. Enter to Specify elevation
 6. Insert a PI somewhere along the middle- it can be adjusted later
 7. Enter to specify elevation
 8. Select Free curve fillet between two entities or Radius if you know the radius
 9. Adjust the grips to get it to match the other feature line
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 10. Repeat for the Daylight Feature Line
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Requirement: Because this is a daylight feature line we need to go through an extra 
step to make sure it drapes over the ground surface

 11. Select the feature line
 12. Edit elevations tab > Elevations from surface
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 13. Select Existing Surface 
 14. Insert intermediate grade break points > yes
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 15. OK > Escape

Info: We need to add one more feature line along the corridor. This one needs to be based off 
the corridor so if there are any changes to the corridor it will react with it.
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 16. Left click the outside corridor line > Create Feature Line from Corridor

 17. Layer > P_Crdr-Base
 18. No Smoothing

Tip: In many cases smoothing works great but it does change the elevation slightly and 
will create little holes in the surface.

 19. OK > Escape
 20. When you hover over it you can see it is identified as an Auto Corridor Feature Line
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 21. Save for use in the next exercise

Create surface

Exercise files: Continue with previous data set or start with: rurl-int-dsn-srfc-edit-03-end-data-
c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-fl-03.mp4 5:08

Now we need to create a surface from the four feature lines.

 1. Home > Create Ground Data > Surfaces > Create Surface
 2. Name in Grdg-Int-SW-Quad
 3. Change style to Contours 2' Major:0.5'Minor
 4. OK
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 5. Prospector > Surfaces > Grdg-Int-SW-Quad > Definitions > right click Breaklines > Add
 6. Type > Standard
 7. Weeding > yes > 5.00'
 8. Supplementing > 10.0'
 9. Mid-ordinate distance > 0.125

Info: The supplementing factor can never be less than the Weeding factor as they have 
opposite functions. The mid-ordinate distance should be low because it is a curve but if 
you get too low it could cause excessive computing time.

 10. Select the lines being careful to select the Auto Corridor Feature Line 
 11. OK
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 12. Change the surface style to P_Triangles and you can see triangles that should not be part of 
that surface
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 13. Highlight surface > Edit Surface > Delete Line
 14. Select all the lines outside the surface > Enter > Escape
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 15. Save > Create Data Shortcuts

Info: This will be pasted into the refinement surface

 1. Design > Surfaces folder > Srfc-Rfnt-All-Datum.dwg > Open
 2. Data Shortcuts > right click Grdg-Int-SW-Quad > Create Reference
 3. Project > Surfaces > Rfnt-Int-All-Datum > Definition > right click edits > Paste surface > Select 

Grdg-Int-SW-Quad 
 4. OK
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Rural intersection: grading behind curb and gutter with corridor
Total video time: 9:40

Last updated: 2020-10-26

In this session we will continue with a series of optional additions to the design by adding an align-
ment and profile target for ditch control. This will provide a greater amount of control as deign 
changes are needed later on. This is optional and only need if you are concerned with specific clear-
ances such as pipe clearances or other specific situations that require a higher level of precision.

Create ditch alignment

Exercise files: rurl-int-grdg-bhnd-cg-fl-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-crdr-01.mp4 3:18

Starting in the NW quadrant the curb daylights far before the rest of the corridor. Here we would 
want to add a ditch that matches up with whats going on with the rest of the corridor.
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 1. Home tab > Create Design > Alignment > Alignment Creation Tools
 2. Name it Int-25-4thAve-NW-Ditch
 3. Alignment Style > ALI Proposed

 4. Tangent Tangent (No curves)
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 5. Select along the edge of gravel surface starting and ending a ways into the corridor to help it 
blend in. The further back you select the more lead in you have and you can tell a better story 
as you are trying to design the profile.

 6. Insert a PI somewhere along the middle- it can be adjusted later
 7. Select Free curve fillet between two entities or Radius if you know the radius

 8. Select two points along the curve as it approaches and leaves the PI
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 9. Save for use in the next exercise

Create ditch profile

Exercise files: Continue with data set or start with: rurl-int-grdg-bhnd-cg-fl-end-data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-crdr-02.mp4 2:46

Even though this will be a proposed surface we will create a profile from surface

 1. Home tab > Create Design > Profile > Create Profile from Surface
 2. Alignment > Int-25-4thAve-NW-Ditch

Page: 1007

Published on: 5/17/2023

Rural intersection: grading behind curb and gutter with corridor

https://c3dkb.dot.wi.gov/data/rdwy-dsn/rurl-int/rurl-int-grdg-bhnd-cg-fl-end-data-c3d16.zip
https://c3dkb.dot.wi.gov/video/rdwy-dsn/rurl-int/rurl-int-grdg-bhnd-cg-crdr-02.mp4


 3. Select Surfaces > Crdr-25-Datum Add > Draw in Profile View

 4. Profile > Profile Creation Tools
 5. Select the defaults
 6. Draw tangent to tangent no curves
 7. Snap to each of the points

 8. Save

Target parameters
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Exercise files: Continue with previous data set of start wit:rurl-int-grdg-bhnd-cg-fl-end-data-
c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-crdr-03.mp4 2:13

 1. Highlight the corridor > corridor properties > NW quadrant > Targets
 2. Width of Offset dropdown > Width > LinkProfileControlled > OK 
 3. Int-25-4thAve-NW-Ditch > Add > OK

 4. Elevation > LinkProfileControlled > Int-25-4thAve-NW-Ditch > Add > OK
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 5. OK > OK > Rebuild Corridor

Synchronize refinement datum surface

Exercise files: Continue with previous data set of start with: rurl-int-grdg-bhnd-cg-fl-end-data-
c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-crdr-04.mp4 1:23

This has changed the way the corridor surface area is built in this area so first save the file to force 
the changes onto the refinement surface. Open the Rfnt-All-Datum file to synchronize.

 1. Prospector tab > Surfaces > right click Crdr-25-Datum > Synchronize
 2. Right click Rfnt-25-Datum > Rebuild
 3. Save

Rural intersection: taper curb head ends to zero height
Total video time: 9:14

Last updated: 2020-10-26
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Here we are looking at optional edits that can further refine your intersection design. One of the 
optional edits that can solve some of the transition from shoulder to curb return issues that you may 
run into in a very detailed manner would be to suppress the curb head at the beginning and end of 
the curb return area. This will better reflect whats going to happen out in the field and actually give a 
truer elevation of the tie ins. Keep in mind that this is not necessary unless you need a higher level of 
precision for your design. 

Create slope control profile

Exercise files: rurl-int-grdg-bhnd-cg-crdr-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int/rurl-int-tapr-crb-head-01.mp4 2:47

We are going to use the slope width control editor on an alignment that's already there. The profile 
views will be affected at the end of the process. You can make a note here that the bottom line of 
one of these views is 1120' so you can set the views back after this process is done.

 1. WisDOT Design tab > Slope / Width Control Editor > Create tab
 2. Alignment > Int-25-4thAve-SW-CG > It gets a New Profile Name with the prefix ZCP-
 3. Go from the beginning to the end of the stations
 4. Slopes > 0.0
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Tip: Without closing this window you could create the profiles for the other 3 quad-
rants here.

 5. Save

Edit slope control profile

Exercise files: Continue with the previous data set or start here: rurl-int-grdg-bhnd-cg-crdr-end-
data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-tapr-crb-head-02.mp4 2:35

Here we will create a table to control the slope width through the curb return. There was a 10' over-
lap in the design so the curb return does not start until station 10+00 and ends 10' before the station 
ending.
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 1. WisDOT Design tab > Slope / Width Control Editor > Edit tab
 2. Station 10+00 > Slope/Width: 0.0' > Add
 3. Station 20+00 > Slope/Width: 0.5' > Add
 4. Station 79+00 > Slope/Width: 0.0' > Add
 5. Station 69+00 > Slope/Width: 0.5' > Add
 6. Update Profile From Table

Tip: You could do the other 3 quadrants here before closing the window.

 7. OK > OK > Rebuild Corridor
 8. Save

Finish all quadrants

Exercise files: Continue with previous data set or start here: rurl-int-grdg-bhnd-cg-crdr-end-data-
c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-tapr-crb-head-03.mp4 2:37

Here we will finish the other 3 quadrants

 1. WisDOT Design tab > Slope / Width Control Editor > Create tab
 2. Alignment > Int-25-4thAve-NW-CG > It gets a New Profile Name with the prefix ZCP-
 3. Go from the beginning to the end of the stations
 4. Slopes > 0.0
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 5. Repeat for the remaining two quadrants
 6. OK > OK > Rebuild Corridor
 7. Save
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Info: Zoom out and you can see the profile views are very large now. We will go into each one 
and change the elevation range to 1120' as we had mentioned at the beginning of this topic.

 1. Select the profile view > Profile view properties > User Specified Height > 1120'

 2. Repeat with the other 3 profile views
 3. Save

Synchronize refinement datum surface

Exercise files: Continue with previous data set or start here: rurl-int-grdg-bhnd-cg-crdr-end-data-
c3d16.zip

Start with 12345678\Design\Surfaces\Srfc-Rfnt-All-Datum.dwg

rurl-int-tapr-crb-head-04.mp4 1:15

We will now synchronize the data with the surface files. Because these files were closed when we 
saved the changes to the corridor file the will update automatically but it is still necessary to rebuild 
the corridor.

 1. Start with Srfc-Rfnt-All-Datum.dwg
 2. Prospector tab > Surfaces > right click Rfnt-25-Datum > Rebuild
 3. Open the Srfc-Rfnt-All-Top.dwg
 4. Prospector tab > Surfaces > right click Rfnt-25-Datum > Rebuild
 5. Save
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Rural intersection: match top of gravel shoulder to top of terrace 
behind curb and gutter
Total video time: 8:56

Last updated: 2020-10-26

There are more optional ways you can further refine your corridor intersection. One of the easier 
ways to affect the design width is to align the shoulder and width match points. Because of the dif-
fering elevations of the two areas, creating a tie in point will help your surfaces transition more 
appropriately or more seamlessly. This process is just adjusting the target alignments so EGS 
matches back of terrace.

Edit shoulder alignments along mainline

Exercise files: rurl-int-grdg-bhnd-cg-crdr-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-mtch-egs-top-trrc-bhnd-cg-01.mp4 2:55

Move some alignments along the main line so the EGS lines up with the GC Terrace Feature Line

 1. Select the EGS Alignment on right side
 2. Geometry Editor > Add PI near the last frequency
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 3. Drag the end of the alignment out to the CG Terrace Feature Line
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 4. Highlight the left ETW alignment and drag the alignment out to the CG Terrace > Rebuild Cor-
ridor
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 5. Save

Info: The other feature lines of the corridor will adjust with the alignment. The grading along 
the curb return will have to be adjusted.

Edit feature lines behind curb and gutter

Exercise files: Continue with previous data set or start here: rurl-int-grdg-bhnd-cg-crdr-end-data-
c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-mtch-egs-top-trrc-bhnd-cg-02.mp4 2:10

 1. Highlight a feature line behind the Back of Curb grading in the SW quadrant
 2. Drag the end grip to line up with the corridor
 3. Repeat with the other two feature lines
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 4. Prospector tab > Surfaces > right click Int-SW-Quad-Grading > Rebuild
 5. There may be some extra lines to remove
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 6. Save
 

Finish quadrants and synchronize refinement datum surface

Exercise files: Continue with previous data set or start here: rurl-int-grdg-bhnd-cg-crdr-end-data-
c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-mtch-egs-top-trrc-bhnd-cg-03.mp4 3:51

Repeat on the north side
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 1. Highlight Lcl-4thAve-Left-EGS alignment
 2. Drag the end to the CG_Terrace

 3. Highlight the 25-Left-TrnLn alignment
 4. Insert PI at the start of the taper
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 5. Drag the end of the alignment to the GC_Back of Terrace feature line
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 6. On the NE side select the 25-Right-TrnLn Alignment 

Tip: Because elements overlap here make sure the Selection Cycling function is on. This 
can be found in the Snap settings dialog box Selection Cycling tab.
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 7. Drag the end of the alignment to match the CG Terrace feature line
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 8. Select the Lcl-4thAve-Left-EGS
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 9. Drag it to CG_Terrace
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 10. Select Lcl-4thAve-Right-EGS
 11. Drag the end to the CG_Terrace
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 12. Rebuild Corridor
 13. Select the Int-25-4thAve-NW-Ditch
 14. Adjust the grips to tie into the CG_Terrace

 15. Rebuild Corridor
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 16. Save
 17. Open Srfc-Rfnt-All-Datum
 18. Prospector tab > Surfaces > right click Rfnt-25-Datum > Rebuild
 19. Save
 20. Open Srfc-Rfnt-All-Top
 21. Prospector tab > Surfaces > right click Rfnt-25-Top> Rebuild
 22. Save

Rural intersection: edit shoulder foreslope to match ditch behind 
curb and gutter
Total video time: 6:03

Last updated: 2020-10-26
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Here we will look at optional edits for the transition between the shoulder area into the curb return 
area. If this transition requires a higher level of precision such as when a culvert pipe depth is a con-
cern, then transitioning from a 4:1 slope to a 6:1 slope will help match into that curb return area and 
reduce the amount of awkward transition. There are some subassembly parameters that respond 
well with the slope/width control editor. 

Create slope control profile

Exercise files: rurl-int-creat-cr-asmbly-02-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-edit-shldr-frslp-mtch-dtch-bhnd-cg-01.mp4 3:19

 1. WisDOT Design tab > Slope/Width Control Editor 
 2. Alignment > 25-Right-TrnLn-EGS
 3. Station Range > Select from screen the end of the curb and gutter for end station
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 4. Input the start station at 2+11 or 100' back
 5. Start slope > 0.25
 6. End slope > 0.167
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 7. Save

Create slope control profile

Exercise files: rurl-int-creat-cr-asmbly-02-end-data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-edit-shldr-frslp-mtch-dtch-bhnd-cg-02.mp4 2:44

 1. Corridor > Corridor Properties > 25-FullSection > Targets
 2. Slope Elevation Targets > Foreslope from profile > ShldGeneric-TrnLn-R
 3. Alignment > 25-Right-TrnLn-EGS
 4. Select ZCP-25-Right-TrnLn-EGS > Add
 5. OK > OK > OK > Rebuild Corridor
 6. Save
 7. Open Srfc-Rfnt-All-Datum
 8. Prospector tab > Surfaces > right click Rfnt-25-Datum > Rebuild
 9. Save

 10. Open Srfc-Rfnt-All-Top
 11. Prospector tab > Surfaces > right click Rfnt-25-Top> Rebuild
 12. Save
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Roundabout
Roundabout: vertical design - introduction
Last updated: 2023-02-21

Total video time: 22:58

Overview

Video: rndbt-vrtcl-dsgn-intro-01.mp4 3:51

Roundabout projects require familiarization with the Roundabout sections in the FDM.

This training covers vertical design modeling workflows of profiles, corridors, and surfaces as it 
relates to the roundabout stages of development shown and described in FDM 11-26 Roundabouts 
5.3, 5.3.2.

The emphasis of these workflows will be the vertical design elements covered as part of the DSR 
approval stage and final design for Pre-PSE submittal.

The roundabout workflow shown in this training are directly relate to what the FDM refers to as “one 
of the primary critical elements of design”. That critical element is the vertical control of the round-
about project.
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The workflows demonstrated in this roundabout training are examples of how to use Civil 3D tools 
to develop a vertical hierarchy model structure that will give design flexibility all the way through the 
design development process to final profiles, surfaces, and cross sections.

It is important with all design and modeling in Civil 3D to have a clear understanding of what objects 
and elements will be used during the design process. Creating a schematic or rough drawing of all 
the objects to be created with the relationships between each object and the naming scheme to use 
will not only assist in clarify the workflow but also help minimize errors and confusion.
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The main civil objects that will be used to develop the vertical hierarchy system (or vertical backbone) 
are alignments, design profiles, surface profiles, corridors, surfaces, intersection objects, control pro-
files and superelevations.

Develop storyboard of vertical model development

The following diagrams are created in a storyboard format to illustrate the concept of planning this 
vertical control process. Creating this linear reference progression in a storyboard format may help 
develop a clear understanding of the elements required, the timeline in which the elements need to 
be developed, and the relationship between the elements of the design.

Roundabout Alignment Diagrams

This diagram is to give some context to the roundabout alignments that will be needed to create the 
vertical control structure as it follows the alignment and profile criteria described in FDM 11-26 
Roundabouts 30.6.2.

 l An alignment along the curb gutter flange line located between the truck apron and the cir-
culatory roadway.

 l An alignment at the roundabout ends of the splitter island flange lines will define the outer cir-
culatory roadway.

 l The baseline alignments that run along each side of the splitter island will be referred to as 
primary and secondary alignments. The primary alignments will run in the east and north 
travel direction and the secondary alignments will run in the west and south travel directions.

 l Other alignments needed will be the outer edge of pavement alignments. These will run 
along each quadrant and will not run across the roundabout like with a typical intersection.

 l Curb return alignments will be needed and the workflow for these will be very similar to the 
typical rural intersection workflow.

 l Splitter island alignments will be used to define the vertical geometry.
 l In this diagram you can see that we are basically creating eight (8) T intersections.
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Horizontal geometry development

Video: rndbt-vrtcl-dsgn-intro-02.mp4 3:13

 1. Extract Linework from roundabout edge line drawing
In this roundabout example we are assuming that a 2D edge line drawing is provided by the 
Roundabout engineer and the design engineer is tasked with developing the baseline align-
ments. The designer working closely with the Roundabout engineer may already have 
developed baseline alignments using different methods. The workflow we will be showing 
here is to extract edge line objects from an edge line dwg that is x-referenced into the aliprof 
dwg.

 A. FDM 11-26 Roundabouts 30.6.2

Info: Info: The edge line drawing will be Xref’d into the rdbt-ali-prof.dwg.
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 2. Develop a top surface Titled Plane
If we look at the Profile Information section of the Roundabout chapter in the FDM the base 
hierarchy element of our vertical design is described. FDM 11-26 Roundabouts 30.6.3.

Comment: “It is ideal from a drivability and safety perspective to design and construct the cir-
cular component of the roundabout in one plane (planar) with one low point and one high 
point around the circle.”

To create and maintain the circle as a singular planar surface the concept of a tilted plane has 
been introduced.

The titled plane surface will act as the base vertical design element and will control the elev-
ation of the central island and the singular slope across it.
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 3. Create circulatory roadway alignment (inner)
The FDM established that we should have a circulatory roadway alignment at the curb flange 
edge of the central island.

The working design profile for this alignment will be a surface profile sampled from the tilted 
plane surface.
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 4. Create the outer circulatory roadway construction alignment
The circulatory roadway will be crowned 12 ft from the central island curb flange and the split-
ter islands will be 8ft outward from the crown. (recommended circulatory roadway crown 
installed, at 2/3 inward and 1/3 outward).

We will create an outer circulatory roadway construction alignment that runs along the ends 
of the splitter islands.

 5. Create primary baseline alignments
Using the extracted objects from the edgeline drawing, create primary baseline alignments 
from the extracted edge line objects. These alignments run along the curb flange edge of the 
splitter island.
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 6. Create secondary baseline alignments
Using the extracted objects from the edgeline drawing, create secondary baseline alignments 
from the extracted edge line objects. These alignments run along the curb flange edge of the 
splitter island.
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 7. Create outer edge of pavement alignments
Using the extracted objects from the edgeline drawing, create the outer edge of pavement 
alignments by. These alignments do not cross over the circulatory roadway but are create in 
each quadrant and extend along the pavement edge of each entry and exit lane.

 8. Develop the curb return alignments
Use the copy alignment tool to help develop the curb return alignments from the outer edge 
of pavement alignments. Additional development to design the curb end conditions is 
required.
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 9. Develop match-line alignments
Match line alignments will be created along each leg where existing conditions or design cor-
ridors of the roadway legs end. One way to think of it is that the match line defines where the 
typical roadway corridors end, and the roundabout workflow begins. The match line profile 
will serve to match the roundabout profiles to these separate leg surface elevations.

Vertical geometry development
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Videos: rndbt-vrtcl-dsgn-intro-03.mp4 3:32, rndbt-vrtcl-dsgn-intro-04.mp4 4:43

 1. Create circulatory roadway alignment profile
Once all the alignments are created from the edgeline geometry, it is time to create the cent-
ral island profile as a sampled surface profile of the tilted plane surface.

 2. Develop circulatory roadway crowned setup surface
Here is where we will create the circulatory roadway crowned setup surface so we can estab-
lish the crown and the elevations at the ends of each splitter island. This corridor uses the 
central island profile to establish the inside elevations. Where does the central island sample 
it’s profile from? Right, the tilted plane surface. If fine tuning cross slope transitions is neces-
sary, they may be defined through targeting control profiles or using other corridor transition 
methods.

The assembly we use to create the top setup surface, will also include the min and max cross 
slopes. A Min, Max and Norm surface will be created to use with the curb return profile cre-
ation workflow.
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 3. Create the outer circulatory roadway profile
This step will extend the vertical control hierarchy out from the tilted plane to the central 
island profile, to the crowned setup surface to the outer circulatory roadway construction pro-
file. The profile will be a surface profile that samples the crowned setup surface. Now we 
have a profile at the end of the splitter islands that we can use to tie those elevations to the 
primary profiles of each leg.
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 4. Develop primary alignment profiles
The next part of the vertical design is to create the primary profiles. At this point these pro-
files can be a simple tangent between the match lines so critical elevations may be added 
along the profiles.

 5. Create primary profile intersection objects
So, if you caught the foreshadowing, the next thing we will create is the primary profile inter-
section objects and assign the priority elevation to the outer circulatory roadway profile. Here 
is where we are establishing the vertical control of the circulatory roadway to each leg profile.

After the intersections are added to the primary profiles, further design development will 
need to be added to the profiles along each leg extending past the matchline alignments. 
These profiles should extend past the matchline alignments but where possible be coin-
cidental to the profiles being used for the roadways beyond the matchline.
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 6. Develop roadways corridors for each leg
Develop full roadway alignments, profiles, and corridors for each leg to stop at the match line 
alignment. Each leg should be a separate corridor with a top and datum surface created. 
These corridors could be part of a larger project than just the roundabout, but should stop at 
the matchlines and could be develop independently of this roundabout workflow.
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 7. Create matchline profiles and intersection objects
With each corridor leg completed, a matchline profile can be create that samples the top sur-
face for that leg. At this point we can create an intersection object to tie each primary design 
profile to the elevations of the matchline profile.

This completes the vertical control of the primary profiles. Now the primary profile elevation 
is controlled at the match line by the outer corridors of each leg and controlled at the cir-
culatory roadway by the crowned setup corridor.

 8. Create secondary alignment profiles
Create the secondary profiles. At this point the profiles should just be a single tangent from 
start to end. Further elevations and vertical geometry will be added.
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 9. Create secondary profiles intersection objects
Create the secondary profile intersection objects. Both profiles will be tied to the outer cir-
culatory roadway profile with an intersection object and tied on the other end of the profile to 
the primary profile with an intersection object.
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 10. Develop primary setup corridor top surfaces
At this stage we will create a setup corridor top surface along each leg of the primary align-
ments. The corridors will use control profiles to define the cross slopes. These surfaces will 
assist in developing the grading across the splitter islands and the outer edge of pavement 
profiles. This where we can set the cross slopes and test the transitions of some of the incom-
ing and outgoing lanes by using simple link assemblies.

 11. Develop Secondary profiles
From the setup surface we create surface profiles along the secondary alignments. We can 
use these surface profiles as a guide to create the secondary alignment design profile. 
Remember each secondary profile already has locked elevations defined where they intersect 
the primary alignments and where it meets the circulatory roadway.
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 12. Develop secondary setup corridor top surface
A setup corridor top surface will be created along each leg of the secondary alignments. The 
corridors use control profiles to define the cross slopes. These surfaces will also assist in 
developing the outer edge of pavement profiles.
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 13. Develop outer edge of pavement profiles
Using the surface profiles created from the primary and secondary setup corridors, the outer 
edge of pavement profiles may be created. It may be advantageous to maintain these profiles 
as surface profiles until the vertical geometry is well defined.

 14. Create curb return profile intersection objects
If you haven’t guessed, it is intersection object time again. Here the intersection objects will 
be used to tie the coincidental ends of the curb return profile elevations to the edge of pave-
ment profiles much like a more conventional intersection.
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 15. Develop curb return profiles
With intersection object controlling the ends of the curb return profiles the curb return pro-
files can now be developed using the min and max surfaces that were create with the 
crowned setup corridor.
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 16. Vertical hierarchy control model - Profiles and intersection objects
We may now see the concept in its entirety. All the profile and intersection objects that form 
the backbone of the vertical hierarchy control. The basic linear process of the vertical hier-
archy control is to create a titled plane surface, create a surface profile, create a setup sur-
face, tie two profiles together with and intersection, then repeat outward from the titled 
plane surface to the outer circulatory roadway to the approach roadway legs and match lines.
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 17. Vertical hierarchy control model - Titled plane and setup corridor surfaces
This is the vertical hierarchy control system surfaces, from the titled plane to the setup cor-
ridor surfaces.

 o Level one surface of the vertical hierarchy control is the tilted plane.
 o Level two surface is the crowned setup corridor surface.
 o Level three surfaces are the primary setup corridor surfaces.
 o Level four surfaces are the secondary setup corridor surfaces.

Info: The crowned setup corridor also provides the cross slope envelop surfaces that 
define the curb return profile limits.
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Corridor layout

Video: rndbt-vrtcl-dsgn-intro-05.mp4 2:11

Corridors, regions and baseline layout

Now that we have sketched out the elements and process for developing the vertical control back-
bone, we can fine tune the various profiles to meet cross slope and design criteria for drivability and 
drainage by modifying the titled plane and setup corridor cross slopes and design profiles as 
needed.

In the rest of the storyboard, we will outline the process to develop corridors to create the top and 
datum refinement surface dwg.

The most important concept at this point is to understand that there is no single modeling tool or 
workflow that will work for every roundabout or within a single roundabout. The focus should be on 
finding ways to develop the feature lines or breaklines that define the roundabout.

Before jumping in and developing any corridors, a layout of the corridors, regions, grading objects 
and feature lines should be carefully created. Corridors always run perpendicular to the baseline 
used, so regions should be developed to maximize perpendicular efficiency within the roundabouts 
diverging and curved geometry. The baselines and region locations should consider the vertical hier-
archy system to minimize the need for multiple targets where possible.
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Some areas of the roundabout may be defined by the corridor surrounding it and may not need to 
be developed as a region. These cases illustrate the need to maintain top and datum point coding 
that can be used to extract top and datum feature lines form the corridors. Understanding the use of 
boundaries and the hierarchy of pasting surfaces together to define the refinement surface is also 
used to determine our corridor layout.

This corridor layout drawing will be used as a referenced overlay into design drawings to be used as 
a guide.

Corridor surface development

Video: rndbt-vrtcl-dsgn-intro-06.mp4 2:06

 1. Create circulatory roadway corridor
First up is creating the circulatory roadway corridor. This corridor is much different than the 
setup corridor as its subassemblies will be fully developed to create the circulatory roadway 
lane, curb, and truck apron. The lane will target the setup corridor surface and conditionally 
target the ends of the splitter islands.
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 2. Develop roundabout corridor region along east bound baseline
For the approach and exit sections of the roundabout develop a single corridor with multiple 
baseline regions. This is the east bound baseline (primary alignment) from the match line 
towards the start of the curb return.
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 3. Develop roundabout corridor region along west bound baseline
Develop the west bound corridor baseline region from the match line towards the start of the 
curb return. These regions should extend along the secondary alignment as far as possible 
until the corridor frequencies begin to skew away from being perpendicular toany lane areas.

 4. Develop roundabout corridor region along north bound baseline
Develop the north bound corridor baseline region from the match line towards the start of 
the curb return. These region locations should have been pre-developed during the corridor 
layout sketch in consideration with maintaining perpendicular lane areas and using the edge 
of corridor regions to establish “warped” cross section transition areas without developing 
regions in those areas… These areas are in the tapered exit areas and the entry deflection 
areas where the lanes widen and the geometry deviates dramatically from being per-
pendicular to the baselines.
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 5. Develop roundabout corridor region along south bound baseline
Develop the south bound corridor baseline region from the match line towards the start of 
the curb return.
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 6. Develop curb return corridors
Develop the four curb return corridor regions. These regions also include the curb end con-
dition areas. The baseline for these are the curb return alignments.

 7. Create splitter island setup corridor top surface
Create a splitter island setup corridor based on the primary and secondary design profiles for 
each island. Create a single top surface from the corridor.

Page: 1063

Published on: 5/17/2023

Roundabout: vertical design - introduction



 8. Create splitter island alignments
Create the splitter island alignments from the geometry objects extracted from the round-
about edge line dwg.

 9. Create splitter island profiles
Create splitter island profiles from the splitter island setup surface. Maintain these profiles as 
surface profiles unless design profiles are desired for final deliverable needs.
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 10. Create splitter island corridor
Create the splitter island corridor. Create a top and datum splitter island surface and border 
for each island corridor region.

 11. Create approach corridor surface boundaries
Create a top and datum boundary for each surface in each approach corridor drawing.
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Refinement surface development

Video: rndbt-vrtcl-dsgn-intro-07.mp4 3:22

 1. Data reference corridors and surfaces in refinement surface drawings
With the corridors created the refinement surface drawing may now be developed. To create 
the refinement surface dwgs each approach leg top and datum surfaces will be data ref-
erenced into the appropriate drawing.

This is where the process of creating the refinement surface may differ from other roadway 
workflows. A data shortcut of the roundabout corridors will be added to the refinement sur-
face. The roundabout corridor top and datum surfaces will be created in the refinement sur-
face drawings.
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 2. Create top and datum surfaces from the roundabout corridors
This diagram also shows the different design corridors in a color code to illustrate the rela-
tionship between the separate corridors and show the baseline regions within the outer 
roundabout corridor. It also helps define the areas where a corridor object is not being cre-
ated. These areas are within the lane section that connect to the curb returns on each leg.

The top and datum surfaces in these areas are defined by the edge of the corridor objects 
that encompass them and contain multiple transitioning cross slopes.
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 3. Create dynamic featurelines
 A. Create dynamic featurelines from circulatory roadway

Create dynamic feature lines of the top and datum from the circulatory corridor. 
These feature lines will be used to cleanly define the top and datum refinement sur-
faces without needing to create infill corridor regions that will cause ripples in the sur-
faces.
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 B. Create dynamic featurelines from curb return corridors
Create dynamic feature lines of the top and datum from each of the curb return cor-
ridors.

 C. Create dynamic featurelines from splitter island corridors
Create dynamic feature lines of the top and datum from each of the splitter island cor-
ridors.
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 4. Create circulatory roadway surface boundaries
Create a boundary for the top circulatory roadway corridor surface and datum circulatory 
roadway corridor surface.

 5. Create roundabout corridor surface boundaries
Create an outer boundary for the top outer roundabout corridor surface and the datum 
outer roundabout corridor surface.
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 6. Build refinement surfaces
 A. Paste approach corridor surfaces

Paste the approach leg corridor top surfaces into the refinement top surface and 
approach leg corridor datum surfaces into the refinement datum surface.

 B. Paste outer roundabout corridor surfaces
Paste the outer roundabout corridor top surface into the refinement top surface and 
outer roundabout corridor datum surface into the refinement datum surface.
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 C. Paste circulatory corridor surfaces
Paste the circulatory roadway corridor top surface into the refinement top surface and 
circulatory roadway corridor datum surface into the refinement datum surface.

 D. Paste splitter island corridor surfaces
Paste the splitter island corridor top surface into the refinement top surface and split-
ter island corridor datum surface into the refinement datum surface.
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 7. Add dynamic feature lines to the refinement surfaces
Add the top surface dynamic feature lines to the top refinement surface definitions and add 
the datum surface dynamic feature lines to the datum refinement surface definitions.
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Corridor modeling situations and design elements
Roadway modeling tip videos
Last updated: 2020-10-26

Total video time: 38:13

 

How to structure the point codes for a shoulder cutout

crdr-ele-rdwy-mdl-tip-01.mp4 6:14

How to structure the point codes and curb return subassemblies for an inter-
section cutout

(sideroad pavement depth deeper than mainline)

crdr-ele-rdwy-mdl-tip-02.mp4 6:19

How to add point codes and structure them for an intersection cutout

(sideroad pavement depth deeper than mainline) considering that the curb return assembly is not 
creating crown-based point codes

crdr-ele-rdwy-mdl-tip-03.mp4 6:01

How to add point codes to create all needed feature lines behind WisDOT 
CGGen subassembly

crdr-ele-rdwy-mdl-tip-04.mp4 4:16

Refinement surface edits that are common for intersections

crdr-ele-rdwy-mdl-tip-05.mp4 9:24

A method for handling a change in pavement depth on a roadway

crdr-ele-rdwy-mdl-tip-06.mp4 5:56

DaylightProfileControlled workshop
Last updated: 2023-02-02

Total video time: 1:33:33
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Dataset: trn-dalitpc-wrkshp-c3d22.zip

            Standards discussion and subassembly  features      

crdr-ele-dalitpc-wrkshp-01.mp4 7:53

The flexibility of the DaylightProfileControlled (DaylightPC) subassembly allows a wide range of slope 
editing and slope configuration changes without having to change assemblies or regions. This work-
shop is focused on showing the capabilities of the subassembly, not on the practical imple-
mentations of it.

For instance, while it is completely possible to change a side slope from 6:1 to 2:5:1 over a distance 
of 25 FT, that doesn't mean it will meet standards or is easily constructable. Links can also be made 
that are very narrow. Generally speaking, slopes that can be constructed with an 8 FT wide bulldozer 
blade are what should be designed. However, modernization projects can have different require-
ments than perpetuation and rehabilitation projects.

All of this is to say, designers must be mindful of standards and constructability when designing side 
slopes and their transitions. Below are some of the FDM sections that discuss side slopes and 
ditches:

 l FDM 11-15-1.11 Side Slopes
 l FDM 11-15-1.12 Side Ditches
 l FDM 11-15-1.13 Clear Zones, Horizontal Clearances, and Clear Roadway Widths of Bridges
 l FDM 11-40-6 Design Standards for Perpetuation Projects
 l FDM 11-40-7 Design Standards for Rehabilitation Projects
 l FDM 11-45-20 Roadside Hazard Analysis
 l FDM 13-30-1 Channel Types and Characteristics

DaylightProfileControlled features

 l Has multiple link logic
 l Can control slope values by targeting control profiles
 l Can force fill and ditch logic as needed

            Subassembly logic         

crdr-ele-dalitpc-wrkshp-02.mp4 7:18

A daylight subassembly is built to intercept a surface. DaylightPC does that with a number of 
optional interior links.

Normally the sub's daylight link (final link) logic is determined by it's insertion elevation with regards 
to target surface (Exist)

 1. goes down if insertion is above Exist (fill logic)
 2. goes up if insertion is below Exist (cut/ditch logic)
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Warning: Depending on link slope values and existing ground, it is easy for any Daylight sub to 
NOT intercept existing ground. If nothing gets drawn on a section, check Panorama for error 
status.

Daylight subs typically cannot be forced to switch between fill and ditch logic. They will always go up 
if below Exist and down if above Exist.

Tip: DaylightPC can switch between fill and ditch logic. This means that no matter where 
the sub is inserted, it can have a positive (up) or negative (down) daylight link. 

See DaylightProfileControlled for images of different slope situations and for full documentation of 
sub behavior.

Fill logic options (from outside to in)

 1. 1 down daylight link (fill slope)

 2. OPTIONAL: 1 down link (recoverable slope (clear zone))

Ditch logic options (from outside to in)

 1. 1 up daylight link (ditch backslope)
 2. OPTIONAL: 1 up link (traversable ditch backslope)
 3. OPTIONAL: 1 flat link (flat-bottom ditch)
 4. OPTIONAL: 1 down link (ditch slope)
 5. OPTIONAL: 1 down link (connecting slope) used when ditch point elevation is managed by a 

ditch profile and the start of the ditch slope is beyond the recoverable foreslope.
 6. OPTIONAL: 1 down link (recoverable foreslope) used when ditch point elevation is managed 

by a ditch profile.

Page: 1076

Published on: 5/17/2023

DaylightProfileControlled workshop

../../../../../../Content/wisdot-sub-hlp-chm/DaylightProfileControlled.htm


 7. AND Berm logic 
 A. Berm logic kicks in if all the logic up to this point puts you above Exist and you need to 

go down to daylight. A flat link (berm width) and a down daylight link (fill slope) are 
inserted after ditch backslope

Multi-intercept options for both fill and ditch

Daylight link option for multi-intercept on both fill and ditch logic.

Multi-intercept can be controlled by:

 1. Minimum offset distance controlled by horizontal target Minimum offset to intercept
 2. Minimum offset distance controlled by control profile Minimum offset to intercept from 

profile
 3. Number of intercepts from control profile Number of target surface intercepts from pro-

file

             Common input and target parameters

crdr-ele-dalitpc-wrkshp-03.mp4 6:35

Warning: This is not a complete list of parameters for DaylightPC. Please refer to Day-
lightProfileControlled for full documentation.
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Input parameters

Input para-
meter           Usage

Set min off-
set >/= to 
clear zone or 
recoverable 
slope offset?

If Yes, this parameter will force the sub to follow it's logic at least out to the 
clear zone offset and then attempt to daylight afterwards. If No and the sub 
finds a daylight intercept before the clear zone, it will daylight and stop. Func-
tionally, if a project's scope is to ensure recoverable slopes out to the clear 
zone, setting this parameter to Yes will make sure grading happens at least 
that far out. If a project's scope requires daylighting as soon as possible, No 
will make that happen. 

Target parameters

Target parameter           Usage

Ditch/Fill Switch

Controls whether the sub follows ditch or fill logic

 l 1 = Automatic
 l Greater than 1 = Force fill logic
 l Less than 1 = Force ditch logic

Ditch backslope from 
profile and Fill slope 
from profile

The final slope of the sub in ditch and fill logic

Offset to measure 
recoverable slope from

The offset to start the clear zone measurement from. 
Typically this is the farthest out edge of travelled way.

Clear zone width from 
profile

The width where the slope breaks from the Recov-
erable value to the Ditch backslope or the Fill Slope.

 Recoverable foreslope 
from profile

The recoverable slope. This is only in effect if the 
clear zone offset is greater than the insertion point of 
the subassembly.

 Using Control Profile Editor and data setup         

crdr-ele-dalitpc-wrkshp-04.mp4 11:27
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How to set up slope/width control profiles

 1. Use Profile - Control Profile Editor

Tip: Many subassemblies in the WisDOT sub library use control profiles to target  para-
meters not available for targeting in the default Civil 3D interface. Control profiles are 
just station-based "buckets" to hold and manage whatever parameter values you need. 
Slopes, widths, heights, and other parameters can all be controlled with control profiles 
and then targeted for easier manipulation of parameters.

All slopes are entered in decimal values. Common slopes and their decimal equivalents

Slope (run:rise) Decimal equivalent

10:1 0.1

6:1 0.167

4:1 0.25

3:1 0.33

2.5:1 0.4

 2. Add begin station with default value
 3. Add end station with default value
 4. Save the profile
 5. Target the profile

How to use the slope/width control profiles #use-cntrl-prfl

When there is an edit to a default value to make

 1. Enter a station and default value for the end of the default and resuming the default
 2. Enter a station and new value for the range of the change. This can be one station or many.

Here is an example of changing the default final slope for 200 FT

Station FinalSlp (Fill Slope, Ditch backslope)

20+00 0.25

20+50 0.4

22+50 0.4

23+00 0.25

Here is an example of forcing a fill for one station
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Since this a logic switch and not a linear transition, the bounding stations of the default value 
are brought right next to the custom value station.

Station Ditch/Fill Switch

10+99 1.0

11+00 1.5

11+01 1.0

 1. XREFs
 A. Topo-Ex.dwg (unloaded)

 2. Surfaces
 A. Exist (DREF from Surf-Ex.dwg)

 3. Alignments
 A. Centerline (all DREF from AliProf-25.dwg)

 I. 25
 II. Lcl-4thAve

 B. Offset (all DREF from AliProf-25.dwg)
 I. 25-L-EGS

 II. 25-L-EPS
 III. 25-L-ETW
 IV. 25-R-EGS
 V. 25-R-EPS

 VI. 25-R-ETW
 4. Profiles

 A. 25-Exist
 B. 25-Prop

 5. Assembly
 A. 25-Full Section

 6. Model views
 A. 3D-25-Crdr
 B. Top-25-Asmbly
 C. Top-25-Crdr

 Create control profiles and corridor         

crdr-ele-dalitpc-wrkshp-05.mp4 5:34

Info: 
The following steps use a number of custom tools to quickly build and target the corridor, it's 
target parameters, and the resulting corridor surfaces.
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The inputs for these tools can be customized for specific project needs. The defaults will not 
apply to every project scope.

All of these steps can be done manually and many will likely need to be at some point in a 
project.

 1. WisDOT Design tab > Design panel > Profile dropdown > Profile - Control Profile Editor
 A. Create tab

 I. Alignment: 25
 II. Multiple - Use WisDOT Default: checked

 III. Create 

Review control profiles created

 2. The assembly 25-Full Section has already been placed, renamed, labeled, and bookmarked 
with model view Top-25-Asmbly. The following steps 

 A. WisDOT Design tab > Design Palettes panel > WisDOT Subassemblies
 I. INTERSECTION ASSEMBLIES tool palette > Rural Full Section Place 

assembly in modelspace
 B. Select assembly in modelspace > Contextual ribbon > Modify assembly panel > 

Assembly Properties
 I. Information tab

 a. Name: 25-Full Section
 b. OK

 C. WisDOT Design tab > Design panel > Assembly dropdown > Assembly - Label 
Assembly 

 I. Press Enter to accept the current text size of 0.0700, or 

type new text size Enter
 II. For global labeling press [All] : For single labeling press 

<Enter> A Enter
 3. Home tab > Create Design panel > Corridor dropdown > Corridor

 A. Name: 25-DLPC
 B. Corridor style: RDWY Proposed
 C. Alignment and profile: selected

 I. Alignment: 25
 II. Profile: 25-Prop

 D. Assembly: 25-Full Section 
 E. Target Surface: Exist
 F. Set baseline and region parameters: checked
 G. OK
 H. 25-DLPC Corridor Properties > Parameters tab

 I. Start Station: 398+25
 II. End Station: 402+00

 III. Frequency dialog
 a. Set all distances to 25
 b. Set all yes/no options to Yes
 c. OK

 IV. OK No need to rebuild at this time.
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 Assign corridor targets         

crdr-ele-dalitpc-wrkshp-06.mp4 7:23

 1. WisDOT Design tab > Design panel > Corridor dropdown > Corridor - Assign Corridor 
Targets

 A. Corridor: 25-DLPC
 B. Baseline: 25 - 25-Prop
 C. Region: 398+25 - 402+00
 D. Targets

 I. Assign: selected
 II. File open CrdrTrgtAssgn-FullSection.csv Open

Tip: This file was pre-copied from C:\WisDOT\Stnd\C3D20XX\Com-
ponents\Assemblies to the same folder as the corridor file to save time. 
You will need to do this on your own in production projects.

 III. Excel
 a. File Save As... C:\Civil 3D Projects\trn-dalitpc-wrkshp-

c3d22\dsgn\crdr\CrdrTrgtAssgn-FullSection.csv
 i. Save

 IV. Assign > File Open C:\Civil 3D Projects\trn-dalitpc-wrkshp-
c3d22\dsgn\crdr\CrdrTrgtAssgn-FullSection.csv

 V. OK Close
 2.  Toolspace > Prospector > Corridors > Right-click 25-DLPC > Rebuild

 Create corridor surfaces, shrinkwrap surfaces         

crdr-ele-dalitpc-wrkshp-07.mp4 3:19

 1. WisDOT Design tab > Design panel > Corridor dropdown > Corridor - Create Corridor 
Surfaces

 A. DOTCREATECORRIDORSURFACES Select Corridor Surface definition 

file [Default browse Current browse Last]:D Enter
 2. WisDOT Design tab > Design panel > Corridor dropdown > Corridor - Shrink Wrap Cor-

ridor Surface
 A. Surface: Crdr-25-DLPC-Datum
 B. Select By Surface Definition
 C. OK
 D. Surface:  Crdr-25-DLPC-Top
 E. Select By Surface Definition
 F. OK
 G. Close

         Set up views for corridor editing         
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crdr-ele-dalitpc-wrkshp-08.mp4 2:43

 1. Select 25-DLPC in modelspace > Contextual ribbon > Modify Corridor Sections panel > 
Section Editor

 2. Set up views to see Section Editor, plan view, and 3D view
 A. Plan view: Top-25-Crdr
 B. 3D view: 3D-25-Crdr

             Remove slope break by changing clear zone control profile         

crdr-ele-dalitpc-wrkshp-09.mp4 5:05

Notes

Info: Exercise steps found below

Get a single daylight link down

Fill logic only has 1 or 2 links.

To always only have one link:

 1. Input parameters 
 A. Offset to measure recoverable slope from: set to design standard
 B. Clear zone distance: 0.0 FT
 C. Reduced recoverable distance: 0.0 FT

If you have Offset to measure recoverable slope from set, you usually want 2 slopes, but you 
want 1 slope for some stations, there are 2 options:

 1. Target Recoverable slope from profile with a slope control profile and set the value the 
same as fill slope. This is the easiest method. It will still have a point at the Clear Zone, but 
that can be removed from cross sections with label control if necessary.

 2. To completely remove the recoverable slope link 
 A. Create a Clear Zone horizontal target (alignment) at an offset that will eliminate the 

slope break (inside sub insertion). The recommendation here is to only create it for the 
length of need, not the entire roadway length.

 B. Target Clear Zone offset  with the horizontal target

Get a single daylight link up

Ditch logic by default will create a single link down (ditch foreslope), and possibly 2 links up (tra-
versable ditch backslope and ditch backslope). We need to zero out the ditch foreslope and tra-
versable ditch backslope to get a single daylight link up.

Assuming we want ditch foreslope and traversable ditch backslope throughout most of the cor-
ridor region, we accomplish this through target parameters
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 1. Create a slope/width control profiles for Ditch foreslope width from profile
 2. Create a horizontal target for Clear zone offset
 3. For the station to have a single daylight link 

 A. Ditch foreslope width value: 0.0 FT
 B. Clear zone target object: inside sub insertion

Exercise steps to change some stations to have single slope instead of two slopes

 1. Section Editor > Select Station: 400+25
 A. Zoom to right side

 2. WisDOT Design tab > Design panel > Profile dropdown > Profile - Control Profile Editor 
> Edit tab 

 A. Alignment: 25
 B. Control Profile: ZCP-25-R-CZWidth
 C. Add the following values

Station Right CZ width

400+00 30

400+25 50

400+50 30

 D. To update the boundary, rerun WisDOT Design tab > Design panel > Corridor drop-
down > Corridor - Shrink Wrap Corridor Surface

 I. Surface:  Crdr-25-DLPC-Top
 II. Select By Surface Definition

 III. OK
 IV. Close
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             Force fill logic         

crdr-ele-dalitpc-wrkshp-10.mp4 6:13

Force a fill slope (daylight slope that goes down) and match it to subgrade

 1. Target Ditch/Fill Switch  with a control profile.
 2. Ditch/Fill Switch value: 1.5 (anything greater than 1 will force Fill)
 3. Make sure Recoverable foreslope from profile  is targeted
 4. Recoverable foreslope control profile value: 0.02

Exercise steps

 1. Section Editor > Select Station: 400+50
 A. Zoom to left side

 2. WisDOT Design tab > Design panel > Profile dropdown > Profile - Control Profile Editor 
> Edit tab 

 A. Alignment: 25
 B. Control Profile: ZCP-25-L-DFS
 C. Add the following values

Station Left Ditch/Fill 
Switch

400+49 1

400+50 1.5

400+51 1
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Tip: A Ditch/Fill Switch does not have a linear transition, so the bracketing sta-
tions are very close

 D. Close

 3. Toolspace > Prospector > Corridors > Right-click 25-DLPC > Rebuild

 A. After this edit, we have forced fill, but the slope is too steep to intercept Exist. Next 
we'll flatten the slope.

 4. WisDOT Design tab > Design panel > Profile dropdown > Profile - Control Profile Editor 
> Edit tab 

 A. Alignment: 25
 B. Control Profile: ZCP-25-L-RcvrFslp
 C. Add the following values

Station Left Recoverable Foreslope

400+25 0.25

400+50 0.02

400+75 0.25

 D. Close

 5. Toolspace > Prospector > Corridors > Right-click 25-DLPC > Rebuild

 6. To update the boundary, rerun WisDOT Design tab > Design panel > Corridor dropdown > 
Corridor - Shrink Wrap Corridor Surface

 A. Surface:  Crdr-25-DLPC-Top
 B. Select By Surface Definition
 C. OK
 D. Close

             Force ditch logic        

crdr-ele-dalitpc-wrkshp-11.mp4 4:44
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Notes

Force a ditch

 1. Target Ditch/Fill Switch  with a control profile.
 2. Ditch/Fill Switch value: 0.5 (anything less than 1 will force Ditch)

Forcing a ditch means that the insertion is above Exist surface, a ditch foreslope is being created, and 
the ditch backslope link is going up to intercept Exist surface.

If no surface is found, a berm is created and the intercept slope goes back down.

Target a custom ditch profile

Forced ditches are very situation-dependent, but some common things to do might be:

 1. Force ditch point below Exist surface 
 A. Create custom ditch profile
 B. Target Ditch elevation with it

 2. Then flatten out backslope 
 A. Create a slope control profile for Traversable ditch backslope from profile or Ditch 

backslope from profile
 B. Target the control profile
 C. Slope control profile value: 0.1 or 0.05 or whatever!

Exercise steps

 1. Section Editor > Select Station: 398+75
 A. Zoom to left side

 2. WisDOT Design tab > Design panel > Profile dropdown > Profile - Control Profile Editor 
> Edit tab 

 A. Alignment: 25
 B. Control Profile: ZCP-25-L-DFS
 C. Add the following values

Station Left Ditch/Fill 
Switch

398+74 1

398+75 0.5

398+76 1

Tip: A Ditch/Fill Switch does not have a linear transition, so the bracketing sta-
tions are very close

 3. Toolspace > Prospector > Corridors > Right-click 25-DLPC > Rebuild
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Let's shorten up the non-recoverable slope while we're here

 4. WisDOT Design tab > Design panel > Profile dropdown > Profile - Control Profile Editor 
> Edit tab 

 A. Alignment: 25
 B. Control Profile: ZCP-25-L-FinalSlp
 C. 

Station Left Final Slope

398+50 0.333

398+75 0.4 (Enter 2.5: and it will convert)

399+00 0.25

 D. Close

 5. Toolspace > Prospector > Corridors > Right-click 25-DLPC > Rebuild

Custom ditch profile

crdr-ele-dalitpc-wrkshp-12.mp4 7:31

Create ditch profile

 1. Modelspace > Zoom into profile view
 2. Home tab > Design panel > Profile dropdown > Profile Creation Tools

 A. CREATEPROFILELAYOUT Select profile view to create profile: Click on 
profile view
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 B. Create Profile - Draw New dialog
 I. Name: <[Alignment Name]>-L-Dtch-1

Warning: You need to add a counter or location info in the name 
because you need a separate ditch profile object for each custom range. 
You cannot have a gap in profiles.

 II. Profile style: PROF Ditch Flow Line
 III. Profile label set: _No Labels
 IV. OK

 C. Profile Layout Tools > PVI dropdown > Draw Tangents Click two points anywhere 
in the profile view

 D.  Profile Layout Tools > Profile Grid View

Station Elevation

400+75 1186.52

402+00 1184.00

Target ditch profile

 3. Toolspace > Prospector > Corridors > Right-click 25-DLPC > Properties...
 A. Parameters tab > Set Targets > DaylightProfileControlled-L > Ditch Elevation : 

25-L-Dtch-1
 B. OK

 4. OK
 5. Rebuild corridor
 6. To update the boundary, rerun WisDOT Design tab > Design panel > Corridor dropdown > 

Corridor - Shrink Wrap Corridor Surface
 A. Surface:  Crdr-25-DLPC-Top
 B. Select By Surface Definition
 C. OK
 D. Close
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Adding missing point codes for surfaces for edited corridor

crdr-ele-dalitpc-wrkshp-13.mp4 4:07

Adding a ditch profile has added a point code that wasn't included in the creation of the Top corridor 
surface. This point needs to be added manually.

To see point codes in Section Editor

 1. Section Editor contextual ribbon > View Tools panel > View/Edit options
 A. View/Edit Corriodr Section Options dialog

 I. Code Set Style: CRDR Proposed - Point codes
 II. OK 

 B. OK 

Add point code to corridor surface

 2. Toolspace > Prospector > Corridors > Right-click 25-DLPC > Properties...
 A. Properties dialog > Surfaces tab > Crdr-25-DLPC-Top: Add data, Feature Lines, 

Break_Point
 B. OK
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 3. Section Editor contextual ribbon > Close

Flat bottom ditch

crdr-ele-dalitpc-wrkshp-14.mp4 4:54

 1. WisDOT Design tab > Design panel > Profile dropdown > Profile - Control Profile Editor 
> Edit tab

 A. Alignment: 25
 B. Control Profile: ZCP-25-L-DtchBtmWdth
 C. Add the following values

Station Left Ditch Bottom 
Width

400+75 0

4010+00 8

401+75 0

 D. Close

 2. Toolspace > Prospector > Corridors > Right-click 25-DLPC > Rebuild

 3. Toolspace > Prospector > Corridors > Right-click 25-DLPC > Properties...
 A. Properties dialog > Surfaces tab > Crdr-25-DLPC-Top: Add data, Feature Lines, 

Ditch_Out
 B. OK

 4. Section Editor contextual ribbon > Close
 5. To update the boundary, rerun WisDOT Design tab > Design panel > Corridor dropdown > 

Corridor - Shrink Wrap Corridor Surface
 A. Surface:  Crdr-25-DLPC-Top
 B. Select By Surface Definition
 C. OK
 D. Close

Multi-intercept parameters, number of surface intercepts
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crdr-ele-dalitpc-wrkshp-15.mp4 4:46

 1. WisDOT Design tab > Design panel > Profile dropdown > Profile - Control Profile Editor 
> Edit tab

 A. Alignment: 25
 B. Control Profile: ZCP-25-L-IntNum
 C. Add the following values

Station Left Intercept Num-
ber

400+44 1

400+45 2

400+55 2

400+56 1

 D. Close

 2. Toolspace > Prospector > Corridors > Right-click 25-DLPC > Properties...
 A. Parameters tab > Set Targets > DaylightProfileControlled-L > Number ot target 

surface intercepts : 25-L-Int-Num
 B. OK

 3. OK
 4. Rebuild corridor

Multi-intercept parameters, minimum offset

crdr-ele-dalitpc-wrkshp-16.mp4 3:26

 1. WisDOT Design tab > Design panel > Profile dropdown > Profile - Control Profile Editor 
> Edit tab

 A. Alignment: 25
 B. Control Profile: ZCP-25-L-MinOs
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 C. Add the following values

Station Left Minimum Off-
set

400+44 0

400+45 -55

400+55 -55

400+56 0

 D. Close

 2. Toolspace > Prospector > Corridors > Right-click 25-DLPC > Properties...
 A. Parameters tab > Set Targets > DaylightProfileControlled-L > Minimum offset 

from profile : 25-L-MinOs
 B. OK

 3. OK
 4. Rebuild corridor
 5. Section Editor contextual ribbon > Close
 6. To update the boundary, rerun WisDOT Design tab > Design panel > Corridor dropdown > 

Corridor - Shrink Wrap Corridor Surface
 A. Surface:  Crdr-25-DLPC-Top
 B. Select By Surface Definition
 C. OK
 D. Close

Modeling beam guard energy absorbing terminals (BG EATs)
Last updated: 2023-01-27

Total video time: 02:27:48

Exercise data begin state crdr-ele-bg-eat-begin-data-c3d22.zip

                     Intro, create BG.dwg, insert detailed beam guard blocks                 

crdr-ele-bg-eat-01.mp4 14:40

Tip: This is not beginner level material. It should not be considered a replacement for learning 
the fundamentals of the topics covered in this exercise.

Requirements: 
There are a few references you will need open to refer to throughout this project:
Standard Detail Drawings needed for reference throughout this project:
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 l SDD 08D01 Concrete Curb and Gutter
 l SDD 14b42 Midwest Guardrail System (MGS) Guardrail
 l SDD 14b44 Midwest Guardrail System (MGS) Energy Absorbing Terminal 
 l SDD 14b45 Midwest Guardrail System (MGS) Thrie Beam Transition

File Naming conventions:
 l FDM 15-5-3.1 AutoCAD Civil 3D Attachment 3.3 Project Folder Structure and File Nam-

ing Standards

This subtopic starts with crdr-ele-bg-eat-c3d22\dsgn\aliprof\AliProf-25.dwg  

Extract the project to C:\Civil 3D Projects to make sure all data connections remain intact.

Create beam guard drawing

 1. Add alignment data via data shortcuts
 2. Add bridge data via Xref

Add beam guard

The beam guard will include a section of Thrie Beam transition for the approach, 2 sections of guard-
rail with wooden posts, and a section of EAT

 1. Ribbon > WisDOT Design > Design Palettes panel > Parametric Blocks dropdown > Para-
metric Blocks - Beam Guard Blocks

 2. Open Beam Guard palette
 A. Ribbon > WisDOT Design > Manage panel > Palettes

 3. Thrie beam transition on curve
 A. Add beam guard

 I. Tool palette > Beam Guard Detail tab > MGS Thrie Beam Transition Curve 
Out

 II. Click in drawing to place
 a. Edit Attributes dialog box > OK

 B. Adjust radius

Info: To check the rail radius: Ribbon > Analyze tab > Inquiry panel > select 
Line and Arc Information command. Select the rail and command line will 
show details.

 I. Select beam guard block
 II. Block Reference window > radTotalShldr > type 2846.784 Enter

 C. Attach and rotate beam guard
 I. Select end grip point of beam guard block

 II. Specify stretch point or [Base point Copy Undo eXit]: Drag to 
insertion point

 III. Command line: type RO (rotate)
 IV. Specify base point: select base point
 V. Specify rotation angle or [Copy/Reference]: type R
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 VI. Specify the reference angle:  select base point
 VII. Specify second point: select front edge of rail

 VIII. Specify the new angle or [Points]:Shift + right-click > Nearest 
OSnap to polyline

 IX. ESC to end command
 X. Command line: type RE (refresh)

 D. Add to layer
 I. Select beam guard block

 II. Block Reference window > Layer dropdown > P_BMGRD
 4. First guardrail with wooden posts

 A. Draw an arc to add these blocks to
 I. Ribbon > Home tab > Draw panel > Arc dropdown > Start, Center, Length

 II. Snap to the front of rail
 III. Specify center point of arc:Shift + right-click > Center OSnap to 

polyline arc (it will rubber band)
 IV. Specify length of chord: type 25Enter

 B. Add guardrail
 I. Tool palette > Beam Guard Detail tab > MGS Guardrail 12.5' - Wooden 

Post
 II. Click in drawing to place

 C. Add to layer
 I. Ribbon > Home tab > Layers > Match Layer

 II. Select objects: select guardrail block Enter
 III. Select object on destination layer: select beam guard block

 D. Attach and rotate guardrail
 I. Select guardrail block

 II. Select square grip and drag to insertion point on arc
 III. Command line: type RO (rotate)
 IV. Specify base point: select base point
 V. Specify rotation angle or [Copy/Reference]:Shift + right-click > 

Nearest OSnap to arc
 VI. ESC to end command

 5. Section of EAT
 A. Add EAT

 I. Tool palette > Beam Guard Detail tab > MGS EAT Curve Out
 II. Click in drawing to place

 III. Edit Attributes dialog box > OK
 B. Adjust radius

 I. Select EAT block
 II. Block Reference window > radTotalShldr > type 2846.784 Enter

 III. ESC to end command

Tip: If posts are not aligned with rail, then redefine the block: Right-click 
block name in Tool Palette and Redefine.
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 C. Attach and rotate EAT
 I. Select EAT block

 II. Select square grip and drag to insertion point on arc
 III. Command line: type RO (rotate)
 IV. Specify base point: select base point
 V. Specify rotation angle or [Copy/Reference]: type R

 VI. Specify the reference angle: Select base point
 VII. Specify second point: Select end of EAT

 VIII. Specify the new angle or [Points]:Shift + right-click > Nearest 
OSnap to polyline

 D. Add to layer
 I. Ribbon > Home tab > Layers > Match Layer

 II. Select objects: select EAT block Enter
 III. Use current layer? [Yes/No] <Yes>:YEnter

 6. Second guardrail with wooden posts
 A. Add guardrail

 I. Select first guardrail
 II. Command line: type CO (copy)

 III. Specify base point: Select base point of first guardrail
 IV. Specify second point: Select end point of first guardrail
 V. ESC to end command

 B. Attach and rotate guardrail
 I. Select guardrail block

 II. Command line: type RO (rotate)
 III. Specify base point: select base point
 IV. Specify rotation angle or [Copy/Reference]: type R
 V. Specify the new angle or [Points]:Shift + right-click > None line 

up with EAT
 VI. ESC to end command

This process needs to be repeated to have matching beam guard groupings on all 4 quadrants.
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                     Insert beam guard layout blocks                 

crdr-ele-bg-eat-02.mp4 13:06 

Create layer and insert beam guard blocks

 1. Open Ali-Prof-25.dwg
 2. Xref bridge and beam guard

 A. Ribbon > WisDOT Design tab > Manage panel > Xref Tools dropdown > Load Xref 
on Layer

 B. Open dialog box
 I. Browse to <project>\dsgn\edgeline folder

 II. Select BG.dwg and bridge.dwg files, using SHIFT + left-click
 III. Open

 C. Remove any extra data you don't need
 3. Create a layer for blocks

 A. Select alignment
 B. Ribbon > Home tab > Layers panel > Layer Properties
 C. Layer Properties dialog box

 I. Select active layer > right-click menu > New Layer
 II. Alert: Layer Filter - New Layer dialog box: A new layer was created that does not 

match the current layer filter.  Close
 D. Select Filters > All
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 E. Scroll to Layer1 > right-click menu > Rename Layer
 I. Rename to P_BMGRD_Blk

 F. Select and make it active layer
 4. Add BG EAT left of tangent (NW quadrant)

 A. Tool palette > Beam Guard Layout tab > BG EAT L Tangent
 B. Click in drawing to place
 C. Specify insertion point or [Basepoint/Scale/Rotate]: select grip point 

and drag to insertion point
 D. Command line: type RO (rotate)
 E. Specify base point: select base point
 F. Specify rotation angle or [Copy/Reference]: type R
 G. Specify the reference angle: Select base point
 H. Specify second point: Select end of gravel shoulder
 I. Specify the new angle or [Points]: Rotate, Shift + right-click > Nearest 

OSnap to edge of gravel shoulder
 5. Add BG EAT right of tangent (SW quadrant)

 A. Tool palette > Beam Guard Layout tab > BG EAT R Tangent
 B. Click in drawing to place
 C. Specify insertion point or [Basepoint/Scale/Rotate]: select grip point 

and drag to insertion point
 D. Command line: type RO (rotate)
 E. Specify base point: select base point
 F. Specify rotation angle or [Copy/Reference]: type R
 G. Specify the reference angle <180>: Select base point
 H. Specify second point: Select end of gravel shoulder
 I. Specify the new angle or [Points]: Rotate, Shift + right-click > Nearest 

OSnap to edge of gravel shoulder
 6. Add BG EAT left side of curve (NE quadrant)

 A. Tool palette > Beam Guard Layout tab > BG EAT L Left Curve
 B. Click in drawing to place

 I. Edit Attributes dialog box > OK
 C. Select block
 D. Command line: type MI (mirror)
 E. Specify first point of mirror line: Select two points to align block
 F. Erase source objects? [Yes/No]:YEnter
 G. ESC to end command
 H. Select block
 I. Specify stretch point or [Base point Copy Undo eXit]: select grip 

point and drag to insertion point
 J. ESC to end command

 K. Select block
 L. Block Reference window > radTotalShldr > type 2846.784 Enter

 M. Command line: type RO (rotate)
 N. Specify base point: select base point
 O. Specify rotation angle or [Copy/Reference]: type R
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 P. Specify the reference angle: Select base point
 Q. Specify second point: Select end of gravel shoulder
 R. Specify the new angle or [Points]: Rotate, Shift + right-click > Nearest 

OSnap to edge of gravel shoulder
 S. ESC to end command
 T. Command line:REA (regenall)

 7. Add BG EAT right side of curve (SE quadrant)
 A. Tool palette > Beam Guard Layout tab > BG EAT R Left Curve
 B. Click in drawing to place

 I. Edit Attributes dialog box > OK
 C. Select block
 D. Command line: type MI (mirror)
 E. Specify first point of mirror line: Select two points to align block
 F. Erase source objects? [Yes/No]:YEnter
 G. ESC to end command
 H. Select block
 I. Specify stretch point or [Base point Copy Undo eXit]: select grip 

point and drag to insertion point
 J. ESC to end command

 K. Select block
 L. Block Reference window > radTotalShldr > type 2882.784 Enter

Info: To check the rail radius: Ribbon > Analyze tab > Inquiry panel > select 
Line and Arc Information command. Select the edge of gravel shoulder and 
command line will show details.

 M. Select block
 N. Command line: type RO (rotate)
 O. Specify base point: select base point
 P. Specify rotation angle or [Copy/Reference]: type R
 Q. Specify the reference angle: Select base point
 R. Specify second point: Select end of gravel shoulder
 S. Specify the new angle or [Points]: Rotate, Shift + right-click > Nearest 

OSnap to edge of gravel shoulder
 T. ESC to end command

                     Create and edit beam guard layout alignments                 

crdr-ele-bg-eat-03.mp4 17:58
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Translate beam guard block lines into alignments

 1. Ribbon > WisDOT Design tab > Design panel > Alignment dropdown > Create Align-
ment from BG Block

 2. Select WisDOT Beamguard Block: Select BG EAT block
 3. Select reference Alignment: Select 25 Alignment
 4. Command line: Process complete
 5. Enter
 6. Repeat for all BG EAT blocks
 7. View list of new alignments

 A. Toolspace > Prospector tab > expand Alignments > expand Miscellaneous Align-
ments

Edit layer

 1. Ribbon > Home tab > Layers panel > Layer Properties
 2. Layers Properties window

 A. Scroll to P_BMGRD-Blk and Freeze
 B. Select 0 to be active layer
 C. X to close Layers window

Create hinge offset alignments

 1. Hinge (SW quadrant)
 A. Select centerline alignment
 B. Command line: type O (offset)
 C. Specify offset distance or [Through Erase Layer]: Endpoint OSnap to 

end of hinge (SW quadrant)
 D. Specify second point:Shift + right-click > Perpendicular Osnap to centerline 

alignment
 E. Specify point on side to offset: Select west of centerline alignment

 2. Hinge (SE quadrant)
 A. Select centerline alignment
 B. Command line: type O (offset)
 C. Specify offset distance or [Through Erase Layer]: Endpoint OSnap to 

end of hinge (SE quadrant)
 D. Specify second point:Shift + right-click > Perpendicular Osnap to centerline 

alignment
 E. Specify point on side to offset: Select east of centerline alignment

Add geometry (SE quadrant)

 1. Paved shoulder
 A. Select object, RDWY Shoulder Paved
 B. Ribbon > Modify panel > Geometry Editor > Fixed Line (Two points) command
 C. Specify start point: Endpoint OSnap to paved shoulder
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 D. Specify next point: Endpoint OSnap  on rail at the start of point of curve
 E. Ribbon > Modify panel > Geometry Editor > Fixed Curve (Three points) com-

mand
 F. Specify start point: Endpoint OSnap to previous point
 G. Specify next point: Endpoint OSnap a second point along rail
 H. Specify end point: Endpoint OSnap at the end of bridge

Tips: To confirm the geometry is perfectly snapped together:
 I. Select created alignment

 II. Right-click menu > Edit Alignment Labels
 III. Alignment Labels dialog box > Import label set > Select a label > 

OK > Apply
 IV. Check if geometry is continuous. If so, then it's good.
 V. Change labels back to _No Labels

 I. X to close Geometry Editor dialog box
 2. Beam guard rail

 A. Select object, RDWY Beam Guard RT
 B. Ribbon > Modify panel > Geometry Editor > Fixed Line (Two points) command
 C. Specify start point: Endpoint OSnap to beam guard rail
 D. Specify next point: Endpoint OSnap on rail at the start of point of curve
 E. Ribbon > Modify panel > Geometry Editor > Fixed Curve (Three points) com-

mand
 F. Specify start point: Endpoint OSnap to previous point
 G. Specify next point: Endpoint OSnap a second point along rail
 H. Specify end point: Endpoint OSnap at the end of bridge
 I. X to close Geometry Editor dialog box

 3. Hinge Line
 A. Select object, RDWY Shoulder Aggregate
 B. Ribbon > Modify panel > Geometry Editor > Fixed Line (Two points) command
 C. Specify start point: Endpoint OSnap to hinge line
 D. Specify next point: Endpoint OSnap on offset alignment, at the start of point of 

curve
 E. Ribbon > Modify panel > Geometry Editor > Fixed Curve (Three points) com-

mand
 F. Specify start point: Endpoint OSnap to previous point
 G. Specify next point: Endpoint OSnap a second point along offset alignment
 H. Specify end point:Shift + right-click > Nearest Osnap to offset alignment, at 

the end of wing wall
 I. Ribbon > Modify panel > Geometry Editor > Fixed Line (Two points) command
 J. Specify start point: Endpoint OSnap to hinge line

 K. Specify next point:Shift + right-click > Nearest Osnap to the wing wall, at a 45 
degree angle.

 L. ESC to end command
 M. X to close Geometry Editor dialog box

 4. Repeat this process for the other 3 quadrants. Note that the North quadrants are on a curve 
and only need the Fixed Curve (Three points) command.
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Info: Remember, creation of the cardinal sub-entities should be made in the same dir-
ection of the alignment.

                     Create curb and gutter alignments, mask alignments for plan sheets, data short-
cut alignments                 

crdr-ele-bg-eat-04.mp4 12:33 

Create curb and gutter alignment (SW quadrant)

 1. Create a polyline and then offset for the flow line
 A. Ribbon > Home tab > Draw panel > Polyline command
 B. Specify start point: Endpoint OSnap to point that is at first post of transition
 C. Specify next point or [Arc Halfwidth Length Undo Width]: Endpoint 

OSnap on rail at the start of point of curve
 D. Specify next point or [Arc Halfwidth Length Undo Width]: type A
 E. [Angle Center CLose Direction Halfwidth Line Radius Second pt 

Undo Width]: type S
 F. Specify second point on arc: Endpoint OSnap to a point
 G. Specify end point of arc: Endpoint OSnap to the front of the offset block
 H. ESC to end command
 I. Select polyline
 J. Command line: type O (offset)

 K. Specify offset distance or [Through Erase Layer]: type 28/12Enter
 L. Specify point on side to offset or [Exit Multiple Undo]: click east 

side of polyline
 M. ESC to end command
 N. Delete original polyline

 2. Convert polyline to an alignment
 A. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Align-

ment from Objects
 B. Select the first line/acr/polyline or [Xref]: Select polyline
 C. Select lines/arcs or polylines to create alignment:Enter
 D. Press enter to accept alignment direction or [Reverse]: type REnter
 E. Create Alignment from Objects dialog box

 I. Name: 25-L-CG-443
 II. Type: Miscellaneous

 III. Alignment Style: RDWY Curb&Gutter Flange
 IV. Alignment label set: _No Labels
 V. Conversion options: Uncheck Add curves between tangents

 VI. OK
 3. Create offset alignments for face and back     

 A. Ribbon > WisDOT Design tab > Design panel > Alignment dropdown > Create 
Curb Offsets
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 B. Offset to face (Enter to skip):  type 28/12Enter
 C. Offset to back (Enter to skip):  type 36/12Enter
 D. Select Alignment [Offsets]: Select the alignment
 E. Alignment Range [Entire Pick]: type EEnter
 F. Pick side: click east side of alignment
 G. ESC to end command

Info: You can repeat process for the remainder quadrants, but this will be included in 
the planning sheets and model.

Clean-up and masking for planning sheets

 1. Delete hinge offset alignments
 2. Select any part of Xref > right-click menu > Unload
 3. Select bridge > right-click menu > Unload
 4. On west side of roadway, select  edge of paved shoulder (25-L-EPS-1) > right-click menu > 

Alignment Properties
 A. Alignment Properties dialog box

 I. Masking tab > select Create a Masking Region button
 II. Select from SW quadrant to NW quadrant, outer ends of beam guards

 III. OK

Tip: Command line: type REA (regenerate)

 5. On west side of roadway, select edge of gravel shoulder (25-L-EGS-1) > right-click menu > 
Alignment Properties

 A. Alignment Properties dialog box
 I. Masking tab > select Create a Masking Region button

 II. Select from SW quadrant to NW quadrant, outer ends of beam guards
 III. OK

 6. On east side of roadway, select  edge of paved shoulder (25-R-EPS-1) > right-click menu > 
Alignment Properties

 A. Alignment Properties dialog box
 I. Masking tab > select Create a Masking Region button

 II. Select from SE quadrant to NE quadrant, outer ends of beam guards
 III. OK

 7. On east side of roadway, select edge of gravel shoulder (25-R-EGS-1) > right-click menu > 
Alignment Properties

 A. Alignment Properties dialog box
 I. Masking tab > select Create a Masking Region button

 II. Select from SE quadrant to NE quadrant, outer ends of beam guards
 III. OK

Create data shortcuts of alignment

 1. Save file
 2. Ribbon > Manage tab > Data Shortcuts panel > Create Data Shortcuts
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 3. Create Data Shortcuts dialog box
 A. Checkmark box Offset Alignments
 B. Checkmark box Miscellaneous Alignments
 C. OK

 4. Go to Toolspace to see if they loaded
 A. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > 

expand Offset Alignments and Miscellaneous Alignments

                     Create pavt.dwg, data shortcut edgelines, assign styles                 

crdr-ele-bg-eat-05.mp4 6:41 

Create pavement drawing file

 1. QNew button to create a new file
 2. QSave > Save Drawing As dialog box

 A. Save in: browse to <project>\dsgn\edgeline folder
 B. File Name: type pavt.dwg
 C. Save

Tip: Normally beam guard data would be included in the pavt.dwg, but in this instance 
it has a separate file. This helps to separate the data for on/off functionality through an 
Xref.

Create data references

 1.  25 alignment
 A. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > 

expand Centerline Alignments > right-click 25 > select Create Reference...
 B. Create Alignment Reference dialog box > OK
 C. Status bar > Drawing Scale > select 1 IN:50 FT
 D. QSave

 2.  Offset Alignments
 A. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > 

expand Offset Alignments
 B. Select all offset alignments (use Shift + select) > drag and drop into drawing
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 3. Miscellaneous Alignments
 A. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > 

expand Miscellaneous  Alignments
 B. Select all miscellaneous alignments > drag and drop into drawing

 4. Assign styles

Info: To view preset assigned alignment styles, based on naming conventions:
 A. Ribbon > WisDOT Design > Design panel > Alignment dropdown > select 

Assign Alignment Styles
 B. Select Style data file [Apply default View default browse 

Current browse Last]: type V
 C. The CSV file opens as an Excel file containing wildcard endings, styles, and label 

sets. Close file; X to close, Don't Save.

 A. Ribbon > WisDOT tab > Design panel > Alignment dropdown > Assign Align-
ments Styles

 B. Select Style data file [Apply default View default browse 

Current browse Last]: type A
 C. Assign Alignment styles [All Select] <All>:Enter

Clean up drawing file

 1. Delete edge of gravel alignments, grading lines, centerline, and beam guard alignments
 2. Add end caps to curb and gutter

 A. Ribbon > Home tab > Layers panel > Layers Properties
 B. Layers Properties window

 I. Filter > select Roadway
 II. Scroll and select P_RDWY_C_and_G

 III. X to close  window
 C. Ribbon > Home tab Draw panel > Create Line command
 D. Specify first point: select front of curb (north side)
 E. Specify next point: select back of curb (north side)
 F. Enter
 G. Specify first point: select front of curb (south side)
 H. Specify next point: select back of curb (south side)
 I. Enter

Xref bridge and beam guard to check placement

 1. Ribbon > WisDOT Design tab > Manage panel > Xref Tools dropdown > select Load Xref 
on Layer

 2. Open dialog box
 A. Browse to <project>\dsgn\edgeline folder
 B. Select BG.dwg and bridge.dwg files, using SHIFT + left-click
 C. Open

Info: While you have the BG.dwg open, check that the block notes are showing for 
future reference.
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 A. Select beam guard block > right-click menu > Open Xref
 B. Select beam guard block (east) > Block Reference window > Visibility > 

Show Notes
 C. Select beam guard block (west) > Block Reference window > Visibility > 

Show Notes
 D. X to close BG.dwg file > Yes save changes

 3. Alignment looks good. Delete beam guard and bridge data from drawing.
 4. X to close pavt.dwg file > Yes save changes

                     Create Crdr-25-BG.dwg, data shortcut objects, XREF files, create break slope align-
ments                 

crdr-ele-bg-eat-06.mp4 10:04

Create pavement drawing file

 1. QNew button to create a new file
 2. QSave > Save Drawing As dialog box

 A. Save in: browse to <project>\dsgn\crdr folder
 B. File Name: type Crdr-25-BG.dwg
 C. Save

Create data references

 1. Exist surface
 A. Toolspace > Prospector tab > expand Data Shortcuts > expand Surfaces > drag 

and drop Exist into drawing
 B. Create Surface Reference dialog box

 I. Surface layer > select Assign a Layer button
 a. Object Layer dialog box

 i. Base layer name > Assign a Layer button > select E_SURF
 ii. OK

 II. Properties > Style > ...
 a. Select Surface Style dialog box

 i. Dropdown, select EX_Border
 ii. OK

 III. OK
 C. Zoom extents

 2. 25 alignment profile
 A. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > 

expand Centerline Alignments > expand 25 > expand Profiles > drag and drop 
25-Prop into drawing

 B. Create Profile Reference dialog box > OK
 C. Status bar > Drawing Scale > select 1 IN:10 FT
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 D. Select alignment > right-click menu > Edit Alignment Labels
 I. Alignment 25 properties dialog box 

 a. Import label set > change to something smallOK
 II. OK

 E. ESC to end command
 3. Offset Alignments

 A. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > 
expand Offset Alignments

 B. Select all offset alignments > drag and drop into drawing
 4. Miscellaneous Alignments

 A. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > 
expand Miscellaneous  Alignments

 B. Select all offset alignments > drag and drop into drawing

Assign styles

 1. Ribbon > WisDOT tab > Design panel > Alignment dropdown > Assign Alignments 
Styles

 2. Select Style data file [Apply default View default browse Current 

browse Last]: type A
 3. Assign Alignment styles [All Select] <All>: type A

Xref beam guard and bridge

 1. Ribbon > WisDOT Design tab > Manage panel > Xref Tools dropdown > select Load Xref 
on Layer

 A. Open dialog box
 I. Browse to <project>\dsgn\edgeline folder

 II. Select BG.dwg and bridge.dwg files
 III. Open

 2. QSave

Change command settings

 1. Toolspace > Settings tab expand Corridor > expand Commands > right-click 
ViewEditCorridorSection > select Edit Command Settings...

 A. Edit Command Settings dialog box
 I. Expand Default Styles 

 a. Code Set Style > change Value to CRDR Proposed - Point CodesOK
 II. OK

Delete all Xrefs on 25 alignment  using selection cycling

Create two miscellaneous alignments to control break and slope on side slopes

 1. Select 25 Alignment
 2. Commandline: type O (offset)
 3. Specify offset distance or [Through Erase Layer] <Through>: type 38
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 4. Specify point on side to offset or [Exit Multiple Undo] <Exit>: select 
left (west) of alignment

 5. Select object to offset [Exit Undo] <Exit>: select 25 Alignment
 6. Specify point on side to offset or [Exit Multiple Undo] <Exit>: select 

right (east) of alignment
 7. ESC to end command

Create alignment from objects

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > select Create Align-
ment from Objects

 2. Select the first line/arc/polyline or [Xref]: Select offset alignment to the 
left

 3. Press enter to accept alignment direction or [Reverse]: type R
 A. Create Alignment from Objects dialog box

 I. Name: 25-L-BrkSlp
 II. Alignment style dropdown > AREA Clear Zone

 III. Alignment label set: _No Labels
 IV. Uncheck box Add curves between tangents
 V. OK

 4. Ribbon > Home tab > Create Design panel > Alignment dropdown > select Create Align-
ment from Objects

 5. Select the first line/arc/polyline or [Xref]: Select offset alignment to the 
right

 6. Press enter to accept alignment direction or [Reverse]:Enter
 A. Create Alignment from Objects dialog box

 I. Name: 25-R-BrkSlp
 II. OK

 7. QSave

                     Create control profiles, insert, explain, and edit assemblies                 
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crdr-ele-bg-eat-07.mp4 9:39

Create control profiles

 1. Ribbon > WisDOT Design tab > Design panel > Profile dropdown > select Control Profile 
Editor

 A. Control Profile Editor dialog box
 I. Alignment: 25

 II. Multiple box
 a. Check box WisDOT Default

 III. Profiles box
 a. Keep everything as is

 IV. Continue
 2. Toolspace > Prospector tab > expand Alignments > expand Centerline Alignments > 

expand 25 > expand Profiles
 A. Control profiles are added

 3. QSave

Create assemblies

 1. Zoom out and select an area a distance away from existing surface
 2. Ribbon > WisDOT Design tab > Design Palettes panel > WisDOT Subassemblies
 3. Tool palette > Beam Guard Assemblies tab > select Beam Guard Rehab
 4. Specify location for Assembly: select location in drawing
 5. ESC to end command
 6. Select assembly

 A. Assembly window > Name rename to 25-BG-Rehab-L-NoCG
 7. Ribbon > Modify Assembly panel > Assembly Properties

 A. Assembly Properties dialog box
 I. Codes tab 

 a. Code set style: CRDR Proposed - Point codes
 b. Apply

 II. Construction tab
 a. Baseline > Right > select PavedShld-R

 i. Base 1 thickness: 9.000"
 b. Baseline > Right > select UnpavedShld-R

 i. Paved shoulder superelevation type: Use outside shoulder 
SEOK

 ii. Unpaved shoulder superelevation type: User definedOK
 iii. Unpaved shoulder slope: -10.00%

 c. Baseline > Left > select PavedShld-L
 i. Base 1 thickness: 9.000"

 d. Baseline > Left > select UnpavedShld-L
 i. Paved shoulder superelevation type: Use outside shoulder 

SEOK
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 ii. Unpaved shoulder superelevation type: User definedOK
 iii. Unpaved shoulder slope: -10.00%

 III. Apply

                     Insert, explain, and edit assemblies (cont'd)                 

crdr-ele-bg-eat-08.mp4 12:31

Create assemblies (cont.)

 1. Ribbon > Modify Assembly panel > Assembly Properties
 A. Assembly Properties dialog box

 I. Construction tab
 a. Baseline > Right > select UnpavedShld-R

 i. Include surface widening points: Yes

Info: To help understand widening points, view this link: 
WisDOT subassembly help/Roadway/ShldGeneric and 
expand Behavior.

 b. Baseline > Left > select UnpavedShld-L
 i. Include surface widening points: No

 c. Baseline > Left > select PavedShld-L
 i. [P9 or P10] Datum: type ETW_Sub

Info: To help understand point codes, view this link: 
WisDOT subassembly help/Roadway/LnExtendBase and 
expand Coding diagram and Point, Link and Shape 
codes.

 d. ApplyOK

Make copies of the assembly

 1. Select 25-BG-Rehab-L-NoCG assembly only

Info: If you select all the subs too, Civil 3D gets confused when you try to edit the loc-
ation of the copied subs.

 2. Commandline: type CO
 3. Specify base point or [Displacement mOde] <Displacement>: select assembly
 4. Specify second point or [Array]:F8 (ortho locking), select next point (above pre-

vious)
 5. Specify second pointor [Array Exit Undo]: select next point (above previous)
 6. ESC to end command
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Rename assemblies

 1. Select second assembly
 A. Assembly window > Name rename to 25-BG-Rehab-L-CG

 2. Select third assembly
 A. Assembly window > Name rename to 25-BG-Rehab-R

Remove subassemblies

 1. 25-BG-Rehab-R: Select all subassemblies from left side and Delete
 2. 25-BG-Rehab-L-CG: Select all subassemblies from right side and Delete
 3. 25-BG-Rehab-L-NoCG: Select all subassemblies from right side and Delete

Edit 25-BG-Rehab-L-CG subassemblies

 1. Adjust curb and gutter
 A. Tool palette > Roadway tab > select CGBasic

 I. Properties window > Parameters
 a. Curb and gutter size: Wi 36"
 b. Wi 36" curb types: TBT

 B. Select marker point within assembly or [Insert Replace 

Detached]: type R
 C. Select subassembly to replace: select Rural Shoulder

 I. Subassembly Name window > rename to CGBasic-LOK
 D. ESC to end command

Info: To check assembly construction: Ribbon > Modify Assembly panel > select 
Assembly Properties. In Assembly Properties dialog box . Construction tab, check logic 
chain. Select OK to close.

 2. Correct back slope
 A. Select CGBasic-L subassembly
 B. Ribbon > Modify Subassembly panel > select Subassembly Properties

 I. Subassembly Properties dialog box > Parameters tab
 a. Input values > Terrace slope (%): -4.00%
 b. ApplyOK

 3. Add lane extension
 A. Select PavedShld-L subassembly
 B. Ribbon > Modify Subassembly panel > select Subassembly Properties

 I. Subassembly Properties dialog box > Parameters tab
 a. Input values > Outside base extension width: 5.000"
 b. ApplyOK

 4. QSave

Create full section beam guard assembly

 1. Tool palette > Beam Guard Assemblies tab > select Beam Guard
 2. Specify location for Assembly: select location (above previous)
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 3. Select assembly
 A. Assembly window > Name rename to 25-BG-Reconstruct

 4. QSave

Create a custom model view

 1. Zoom so all assemblies fill the modelspace
 2. Ribbon > View tab > Named Views panel > select New View

 A. New View dialog box
 I. View name: Top-Assemblies

 II. Select Expand Arrow
 III. Settings: Uncheck box Save layer snapshot with view
 IV. OK

Make similar edits to full reconstruct assembly

Edit daylight slopes

 1. Ribbon > Modify Subassembly panel > select Subassembly Properties
 2. Subassembly Properties dialog box > Parameters tab

 A. Input values > Set min offset >/= clear zone: No
 B. ApplyOK

 3. Repeat for each daylight slope

Add assembly labels

 1. Ribbon > WisDOT Design > Design panel > Assembly dropdown > Label Assembly
 2. Enter text size <1.000>:Enter
 3. Assembly selection [All Individual]: type A
 4. Make sure all labels are visible

 A. Ribbon > Home tab > Layers panel > Layer Properties
 I. Layer Properties window

 a. Filter > All > right-click menu > Visibilty > Thawed
 b. Filter > All > right-click menu > Visibilty > On
 c. X to close window

                     Create corridor, add regions, target objects, create corridor surfaces, shrinkwrap 
surfaces                 

crdr-ele-bg-eat-09.mp4 13:13

Create a corridor

 1. Ribbon > Home tab > Create Design panel > Corridor dropdown > select Corridor
 2. Create Corridor dialog box

 A. Name: 25-BG
 B. Assembly: 25-BG-Rehab-L-NoCG
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 C. Target: Exist
 D. Check box Set baseline and region parameters
 E. OK

 3. Baseline and Region Parameters dialog box
 A. Edit 25-BG-Rehab-L-NoCG

 I. Pick start station
 a. Specify station along baseline: Select point at start of taper 

(SW)
 II. Pick end station

 a. Specify station along baseline: Select point at beginning of 
curb & gutter (SW)

 III. Frequency: ...
 a. Horizontal Baseline > Along tangents > 1000000 
 b. Horizontal Baseline > Curve increment > 1000000
 c. Horizontal Baseline > Along spirals > 1000000
 d. Vertical Baseline > Along vertical curves > 1000000
 e. OK

 B. Add a region
 I. Select BL-25 (1) > right-click menu > Add Region...

 II. Create Corridor Region dialog box
 a. Assembly dropdown > select 25-BG-Rehab-L-CG
 b. OK

 C. Edit 25-BG-Rehab-L-CG
 I. Pick start station

 a. Specify station along baseline: Select point at beginning of 
curb & gutter (SW)

 II. Pick end station
 a. Specify station along baseline: Select point at end of curb & 

gutter
 III. Frequency: ...

 a. Horizontal Baseline > Along tangents > 1000000
 b. Horizontal Baseline > Curve increment > 1000000
 c. Horizontal Baseline > Along spirals > 1000000
 d. Vertical Baseline > Along vertical curves > 1000000
 e. OK

 D. Add a region
 I. Select BL-25 (1) > right-click menu > Add Region...

 II. Create Corridor Region dialog box
 a. Assembly dropdown > select 25-BG-Reconstruct
 b. OK

 E. Edit 25-BG-Reconstruct
 I. Pick start station

 a. Specify station along baseline: Select point at end of bridge 
(NW)
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 II. Pick end station
 a. Specify station along baseline: Select a station past the 

tapers or type 44800 in command line
 III. Frequency: ...

 a. Horizontal Baseline > Along tangents > 1000000
 b. Horizontal Baseline > Curve increment > 1000000
 c. Horizontal Baseline > Along spirals > 1000000
 d. Vertical Baseline > Along vertical curves > 1000000
 e. OK

 F. Add a new baseline
 I. Select Add Baseline

 II. Create Corridor Baseline dialog box > OK
 a. Select Vertical Baseline > Select a Profile > 25-PropOK

 G. Add a region
 I. Select BL-25 (2) > right-click menu > Add Region...

 II. Create Corridor Region dialog box
 a. Assembly dropdown > select 25-BG-Rehab-R
 b. OK

 H. Edit 25-BG-Rehab-R
 I. Pick start station

 a. Specify station along baseline: Select point at start of taper 
(SE)

 II. Pick end station
 a. Specify station along baseline: Select a point at start of 

bridge (SE)
 III. Frequency: ...

 a. Horizontal Baseline > Along tangents > 1000000
 b. Horizontal Baseline > Curve increment > 1000000
 c. Horizontal Baseline > Along spirals > 1000000
 d. Vertical Baseline > Along vertical curves > 1000000
 e. OK

 4. Corridor Properties - Rebuild dialog box
 A. Alert: The corridor definition has been modified and needs to be rebuilt. What do you 

want to do? Select Rebuild the corridor

Edit corridor targets

 1. Ribbon > Home tab > Create Design panel > Corridor dropdown > select Assign Cor-
ridor Targets

 2. Assign Corridor Targets dialog box
 A. Corridor: 25
 B. Basline: 25 - 25Prop (first one listed)
 C. Region: leave as is
 D. Target: template dropdown > select CrdrTrgtAssgn-BeamGuard.crv
 E. Assign: select search for file button
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Tip: Default templates must be stored on a local drive to be editable.

 I. Select Corridor Targets Data File dialog box
 a. Browse to AutoCAD Application/Assemblies folder. 
 b. Select CrdrTrgtAssgn-BeamGuard.crv > right-click menu > Copy
 c. Browse to local drive, paste into <project>\dsgn\crdr folder
 d. Now the file is in the crdr folder, select it
 e. Open

 F. OK to run > Process Complete
 G. Region: change to next selection
 H. OK to run > Process Complete
 I. Region: change to last selection
 J. OK to run > Process Complete

 K. Basline: 25 - 25Prop (change to last in list)
 L. Region: should be changed with baseline change

 M. Check box Rebuild Corridor
 N. OK to run > Process Complete
 O. Close

Create corridor surfaces

 1. Ribbon > Home tab > Create Design panel > Corridor dropdown > select Create Cor-
ridor Surfaces

 2. Select Corridor Surface definition file [Apply default View default 

browse Current browse Last]: type A
 3. Select Corridor: select corridor
 4. Create Corridor Surfaces dialog box > Process Complete. Rebuild Corridor?Yes
 5. Zoom into corridor

 A. Commandline: type Z (zoom) Enter
 B. Select area around corridor and it should zoom to it.

Add custom shrink wrap

 1. Ribbon > WisDOT Design tab > Design panel > Corridor dropdown > select Shrink Wrap 
Corridor Surface

 2. Shrink Wrap Corridor Surface dialog box
 A. Surface: select Crdr-25-BG-Top
 B. Select Select By Surface Definition
 C. OK
 D. Surface: select Crdr-25-BG-Datum
 E. Select Select By Surface Definition
 F. OK
 G. Close
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                     Grading line: when, why, how to use it                 

crdr-ele-bg-eat-10.mp4 12:45

Create custom views

 1. View of corridor
 A. Select Custom View > View Manager
 B. View Manager > New...
 C. New View/Shot Properties dialog box

 I. View Name: 3D-Bridge
 II. View Properties> Settings

 a. Uncheck box Save layer snapshot with view
 b. View Style: dropdown > select Conceptual
 c. OK

 III. OK
 2. View of bridge

 A. Change Custom View to Top
 B. Change Conceptual to 2D Wireframe
 C. Ribbon > WisDOT Design tab > View panel > select Rotate View
 D. Pick left point: Select south end of bridge
 E. Pick right point: Select north end of bridge
 F. Select Custom View > View Manager
 G. View Manager > New...
 H. New View/Shot Properties dialog box

 I. View Name: Top-Bridge
 II. View Properties> Settings

 a. Uncheck box Save layer snapshot with view
 b. View Style: dropdown > select 2D Wireframe
 c. OK

 III. OK
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 3. Use section editor
 A. Select 25-BG > right-click menu > Modify Corridor Sections > select Corridor Sec-

tion Editor...
 B. Ribbon > View Tools panel > select Viewport Configuration
 C. Corridor Section Editor: Viewport Configuration dialog box

 I. Layout: Two: Horizontal
 II. Viewport 1: Section

 III. Viewport 2: Plan
 IV. OK

 4. Change Custom View in Viewport 2
 A. Top > Custom Model Views > select Top-Bridge

Remove Grading Lines

 1. Toolspace > Prospector tab > expand Alignments > expand Miscellaneous > expand 
BG-445+18-L > right-click 25-L-BG-Grdline-445+18 > Delete

 A. Warning: Are you sure you wish to delete? Yes
 2. Toolspace > Prospector tab > expand Alignments > expand Miscellaneous > expand 

BG-442+83-R > right-click 25-R-BG-Grdline-442+83 > Select Delete
 3. Toolspace > Prospector tab > expand Alignments > expand Miscellaneous > expand 

BG-442+74-L > right-click 25-R-BG-Grdline-442+74 > Select Delete
 4. After changes you must manually update the shrink wrap surface

 A. Ribbon > WisDOT Design tab > Design panel > Corridor dropdown > select 
Shrink Wrap Corridor Surface

 B. Shrink Wrap Corridor Surface dialog box
 I. Surface: select Crdr-25-BG-Top

 II. Select Select By Surface Definition
 III. OK
 IV. Surface: select Crdr-25-BG-Datum
 V. Select Select By Surface Definition

 VI. OK
 VII. Close

 5. Toolspace > Prospector tab > expand Corridors > right-click 25-BG > select Properties...
 6. Corridor Properties dialog box

 A. Parameters tab > edit RG-25-BG-Reconstruct-(2)
 I. Target: ...

 II. Target Mapping dialog box
 a. Offset and Elevation tab
 b. Select Subassembly header > deselect all boxes
 c. Scroll down and check boxes to Condition Found - TARGET GradingLine-

R, DaylightProfileControlled-GradingLine-R, and TARGET GradingLine 
and GradingLine slope profile-R

 d. Expand TARGET GradingLine and GradingLine slope profile-R > select 
Slope from Profile

 e. Select profile and pipe to target
 i. Clear out all checked boxes, check and uncheck the check all box
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 f. OK
 B. OK

 7. Corridor Properties - Rebuild dialog box
 A. Alert: The corridor definition has been modified and needs to be rebuilt. What do you 

want to do? Select Rebuild the corridor
 8. Adjust the Grading Line alignment back so that it does not overlap the right shoulder point

Warning: To adjust this alignment in context of this corridor's shoulder point we will 
need to promote the alignment into this drawing file. This is one of the VERY FEW times 
when promoting an alignment is allowed. Promoting is creating a copy of the alignment 
that is not updated from the data shortcut reference source, so loses the benefit of 
single-source definition.

 A. Select the 25-R-BG-GrdngLine-445+25 alignment > right-click menu > select Pro-
mote

 B. Select 25-R-BG-GrdngLine-445+25 alignment > Shift + right-click > Apparent Inter-
section OSnap to where the subgrade shoulder point starts

Tip: If you struggle with the OSnap at this location you can choose None Osnap, 
then zoom very close, and place the end point just outside the shoulder Day-
light_Sub.

 9. Toolspace > Prospector tab > expand Corridors > right-click 25-BG > select Rebuild
 10. Re-run Shrink Wrap Corridor Surface command to update surface

 A. Ribbon > WisDOT Design tab > Design panel > Corridor dropdown > select 
Shrink Wrap Corridor Surface

 B. Shrink Wrap Corridor Surface dialog box
 I. Surface: select Crdr-25-BG-Top

 II. Select Select By Surface Definition
 III. OK
 IV. Close

 11. Ribbon > Section Editor tab > Station Selection panel
 A. Use the station forward and backward buttons to check the stations and after the sta-

tion where the grading line alignment stops at the shoulder point. In the Section View 
window where there is an alignment you should see  a data point for the Grading Line 
point.

 12. In the lower viewport, change Custom View > Custom Model Views > 3D Bridge
 A. Zoom in to just past the large gap in the corridor to see the grading slope line in the 

3D model.
 B. Change Custom View > Custom Model Views > Top-Bridge

 13. Make the engineering decision that we do not want or need that grading line alignment for 
this design.

 A. Select 25-R-BG-GrdngLine-445+25 alignment > Delete
 14. Toolspace > Prospector tab > expand Corridors > right-click 25-BG > select Rebuild
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 15. Re-run Shrink Wrap Corridor Surface command to update surface
 A. Ribbon > WisDOT Design tab > Design panel > Corridor dropdown > select 

Shrink Wrap Corridor Surface
 B. Shrink Wrap Corridor Surface dialog box

 I. Surface: select Crdr-25-BG-Top
 II. Select Select By Surface Definition

 III. OK
 IV. Close

                     Review corridor and edit for curb and gutter region                 

crdr-ele-bg-eat-11.mp4 10:37

Edits to curb and gutter

Info: If your labels are to big, Ribbon > WisDOT Design tab > Design Palettes panel > select 
Assembly Label Sizes, and adjust the label size.

 1. Lane width is targeting edge of traveled way instead of curb and gutter 
 A. Toolspace > Prospector tab > expand Corridors > right-click 25-BG > select Prop-

erties...
 B. Corridor Properties dialog box 

 I. Parameters > edit RG-25-BG-Rehab-L-CG
 a. Target: ...
 b. Target Mapping dialog box

 i. Offset and Elevation tab
 ii. Subassembly > expand PavedShld_L > select Lane width
 iii. Select alignment and pipe to target

 i. Clear out all checked boxes, check and uncheck the check 
all box

 ii. Select Name header > search for *CG* >
 iii. Don't need back and face alignments to be targeted, 

Uncheck box 25-L-CG-443-Back and 25-L-CG-443-
FaceEnter

 iv. Go back to list and check box 25-L-CG-443
 iv. OK

 II. OK
 C. Corridor Properties - Rebuild dialog box

 I. Alert: The corridor definition has been modified and needs to be rebuilt. What 
do you want to do? Select Rebuild the corridor

 D. QSave
 2. Drop curb head using control profile

 A. Ribbon > WisDOT Design tab > Design panel > Profile dropdown > select Control 
Profile Editor
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 B. Control Profile Editor dialog box
 I. Create tab > Individual 

 a. Name: ZCP-25-L-CurbHt
 b. Start Station: select Station Select
 c. Select Station: Endpoint OSnap to start of curb and gutter
 d. End Station: select Station Select
 e. Select Station: Endpoint OSnap to end of curb and gutter
 f. Value: 0.333
 g. Create > AutoCAD Message: Profile created > OK

 II. Edit tab > Control Profile
 a. Name dropdown > select ZCP-25-L-CurbHt
 b. Station: 443.05.71
 c. Value: .0333
 d. Add

 III. Change Station 442+95.71 value to 0
 IV. Close

 C. Toolspace > Prospector tab > expand Corridors > right-click 25-BG > select Prop-
erties...

 D. Corridor Properties dialog box 
 I. Parameters > edit RG-25-BG-Rehab-L-CG

 a. Target: ...
 b. Target Mapping dialog box

 i. Offset and Elevation tab
 ii. Subassembly > expand CGBasic-L > select Curb height from 

profile
 iii. Select alignment and pipe to target 

 i. Select Name header > search for *Curb* > Enter
 ii. Go back to list and check box ZCP-25-L-CurbHt

 iv. OK
 II. OK

 E. Corridor Properties - Rebuild dialog box
 I. Alert: The corridor definition has been modified and needs to be rebuilt. What 

do you want to do? Select Rebuild the corridor
 F. QSave

                     Edit control profiles to steepen shoulder foreslope and fill slope to be non-recov-
erable behind beam guard                 

crdr-ele-bg-eat-12.mp4 7:09 

Edit shoulder foreslope

 1. Ribbon > WisDOT Design tab > Design panel > Profile dropdown > select Control Profile 
Editor
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 2. Control Profile Editor dialog box
 A. Edit tab > Control Profile

 I. Name dropdown > select ZCP-25-R-ShldrFslp
 II. Station: select Station Select

 III. Select Station: Endpoint OSnap Post 9 Station (right side)
 IV. Value: -0.25
 V. Add

 VI. Station: select Station Select
 VII. Select Station: Endpoint OSnap face of bridge

 VIII. Value: -0.4
 IX. TIP: you can type -2.5: in the Value field and it will translate to the -0.4 value 

that is the format required.
 X. Add

 XI. Station: select Station Select
 XII. Select Station: Endpoint OSnap first post after bridge

 XIII. Value: -0.4
 XIV. Add
 XV. Station: select Station Select

 XVI. Select Station: Endpoint OSnap to mid-point of beam guard
 XVII. Value: -0.25

 XVIII. Add
 B. Close

 3. Toolspace > Prospector tab > expand Corridors > right-click 25-BG > select Rebuild

Edit recoverable slope, right side

 1. Ribbon > Section Editor tab > Baseline & Offsets panel > Select a Baseline dropdown > 
select BL-25 (2)

 2. Ribbon > Section Editor tab > Station Selection panel > Select a Station dropdown > 
select Region Stations

 3. In the top down view window click a point near the stations you wish to look at in the Section 
Editor

 4. Ribbon > Section Editor tab > Station Selection panel > Advance Stations button
 5. Review the daylight slope at each station
 6. Ribbon > WisDOT Design tab > Design panel > Profile dropdown > select Control Profile 

Editor
 7. Control Profile Editor dialog box

 A. Edit tab > Control Profile
 I. Name dropdown > select ZCP-25-R-RcvrFSlp

 II. Station: select Station Select
 III. Select Station: Endpoint OSnap guardrail with wooden posts
 IV. Value: 0.25
 V. Add

 VI. Station: select Station Select
 VII. Select Station: Endpoint OSnap last beam guard post before bridge

 VIII. Value: 0.4
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 IX. Add
 X. Station: select Station Select

 XI. Select Station: Endpoint OSnap first beam guard post after bridge
 XII. Value: 0.4

 XIII. Add
 XIV. Station: select Station Select
 XV. Select Station: Endpoint OSnap to guardrail with wooden posts

 XVI. Value: 0.25
 XVII. Add

 B. Close
 8. Toolspace > Prospector tab > expand Corridors > right-click 25-BG > select Rebuild

Update shrink wrap on surface

 1. Ribbon > WisDOT Design tab > Design panel > Corridor dropdown > select Shrink Wrap 
Corridor Surface

 2. Shrink Wrap Corridor Surface dialog box
 A. Surface: select Crdr-25-BG-Top
 B. Select Select By Surface Definition
 C. OK
 D. Close

 3. QSave

                     Create corridor surface data shortcuts and refinement surface files for Top and 
Datum                 

crdr-ele-bg-eat-13.mp4 6:45 

Create data shortcuts

 1. Ribbon > Manage tab > Data Shortcuts panel > Create Data Shortcuts
 2. Create Data Shortcuts dialog box

 A. Check box Surfaces (all surfaces)
 B. Check box 25-BG (corridor)
 C. OK

 3. Ribbon > Section Editor tab > Close panel > select Close 
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 4. X to close the Crdr-25-BG.dwg
 A. Save changes? Yes

Create the refinement surface top drawing file

 1. QNew button to create a new file
 2. QSave > Save Drawing As dialog box

 A. Save in: browse to <project>\dsgn\srfc folder
 B. File Name: type Srfc-Rfnt-All-Top.dwg
 C. Save

 3. Toolspace > Prospector tab > expand Data Shortcuts > expand Surfaces > right-click 
Crdr-25-BG-Top > select Create Reference

 4. Create Reference dialog box
 A. Style: ... 
 B. Select Surface Style dialog box > dropdown > select Top Border OK
 C. OK

 5. Toolspace > Prospector tab > right-click Surfaces > select Create Surface...
 6. Create Surfaces dialog box

 A. Name: type Rfnt-All-Top
 B. Style: ...
 C. Select Surface Style dialog box > dropdown > select Top Triangles OK
 D. OK

 7. Toolspace > Prospector tab > expand Surfaces > right-click Rfnt-All-Top > Select
 8. Ribbon > Modify panel > Edit Surfaces dropdown > select Paste Surface
 9. Select Surface to Paste dialog box > OK

 10. Zoom extents
 11. QSave
 12. Ribbon > Manage tab > Data Shortcuts panel > Create Data Shortcuts
 13. Create Data Shortcuts dialog box

 A. Check box Rfnt-All-Top (surface)
 B. OK

 14. X to close the Srfc-Rfnt-All-Top.dwg

Create a refinement surface datum drawing file

 1. QNew button to create a new file
 2. QSave > Save Drawing As dialog box

 A. Save in: browse to <project>\dsgn\srfc folder
 B. File Name: type Srfc-Rfnt-All-Datum.dwg
 C. Save

 3. Toolspace > Prospector tab > expand Data Shortcuts > expand Surfaces > right-click 
Rfnt-All-Top > select Create Reference

 4. Create Reference dialog box > OK
 5. Toolspace > Prospector tab > right-click Surfaces > select Create Surface...
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 6. Create Surfaces dialog box
 A. Name: type Rfnt-All-Datum
 B. Style: ...

 I. Select Surface Style dialog box > dropdown > select Datum Triangles OK
 C. OK

 7. Toolspace > Prospector tab > expand Surfaces > right-click Rfnt-All-Datum > Select
 8. Ribbon > Modify panel > Edit Surfaces dropdown > select Paste Surface
 9. Select Surface to Paste dialog box > OK

 10. Toolspace > Prospector tab > expand Data Shortcuts > expand Surfaces > right-click 
Crdr-25-BG-Datum > select Create Reference

 11. Create Reference dialog box > OK
 12. Toolspace > Prospector tab > expand Surfaces > right-click Rfnt-All-Datum > Select
 13. Ribbon > Modify panel > Edit Surfaces dropdown > select Paste Surface
 14. Select Surface to Paste dialog box > OK
 15. Zoom extents
 16. Ribbon > View tab > Navigate 2D panel > select Orbit

 A. Orbit around the surface to further inspect the shape
 B. Right-click menu > Exit to end orbit command

 17. Change Custom View to Top
 18. Ribbon > Manage tab > Data Shortcuts panel > Create Data Shortcuts
 19. Create Data Shortcuts dialog box

 A. Check box Rfnt-All-Datum (surface)
 B. OK

 20. X to close the Srfc-Rfnt-All-Datum.dwg
 21. QSave

 

Tip: To learn more about using the DaylightProfileControlled subassembly, check out the "Day-
lightProfileControlled workshop" on page 1074

Exercise data end state crdr-ele-bg-eat-end-data-c3d22.zip

Curb ramp design with feature lines
Last updated: 2020-10-26

Total video time: 68:00

Standards

Curb ramp standard detail drawings: Curb Ramps 8D5

Roadway Model Requirements: FDM 15-5-7.2

Curb Ramp Requirements: FDM 11-46-10

WisDOT Civil 3D Project Data Workflow Map

Civil 3D Project Folder Structure: FDM 15-5 Attachment 3.1
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Civil 3D Object and File Abbreviation Standards: FDM 15-5 Attachment 3.2

Civil 3D Drawing Naming Convention: FDM 15-5 Attachment 3.3

Civil 3D Object Naming Convention: FDM 15-5 Attachment 3.4

Introduction

crdr-ele-crb-rmp-01.mp4 3:39

Delivery goals

 l Curb ramp surface models 
 o Used for plans production curb ramp detail sheets.
 o Verifies to the designers the intended curb ramp will fit within design tolerances
 o Not required for projects per FDM 15-5-7.2 Table 7.2

Concept overview

 l Create non-dynamic models using corridors with feature line/grading tools
 l Early curb ramp design could mean re-design if roadway design changes
 l Best suited for use with preservation projects with static roadway designs and retrofit curb 

ramp situations
 l Applicable to full roadway designs late in the design process 

 o May be required to update the curb ramp design if roadway design changes
 l Overall, the concepts and workflows described here can be applied to any curb ramp type 

and configuration.

Workflow overview

 l Curb Ramp Design with Feature Lines 
 o Create curb and gutter flange alignment
 o Create curb ramp horizontal geometry
 o Create/verify curb existing and proposed profile
 o Create curb corridor and curb cuts
 o Create curb corridor surface
 o Create curb ramp refinement surface
 o Create curb ramp feature lines
 o Assign feature line elevations
 o Add slope intercept gradings and boundaries
 o Inspection
 o Create data shortcuts

 l "Curb ramp detail sheet" on page 1439
 l Curb Ramp workflow map
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Sample Project Data

Sample project data should be downloaded and extracted to C:\WisDOT\Design\c3d. For sub-
sequent versions of files as the training moves on, copy the individual files into the folders as struc-
tured in the zip files.

Project Data Basics

Xref Overview

Xref Topography files (and other files)

Data Shortcut Overview and Process

Data Shortcut Reference Alignments

Curb and gutter alignment

crdr-ele-crb-rmp-02.mp4 5:30

Exercise files: crdr-ele-crb-rmp-begin-data-c3d2018.zip

Prerequisites

 l Survey of the curb ramp design area
 l Main roadway reference alignment is created
 l Existing ground surface is created.

Alignment creation

The source of the curb and gutter flange alignment for full roadway design and rehabilitation pro-
jects should be in ProjectID\Design\AliProf\AliProf-XX.dwg, which also contains the main roadway 
alignments and any roadway feature alignments used design and plans production. Those align-
ments are then data shortcut referenced into the curb ramp design drawing.

Curb and gutter flange alignment

Open ProjectID\Design\AliProf\AliProf-XX.dwg.

 1. Home tab > Create Design > Alignment > Alignment Creation Tools

 A. Name: Int-Margaret-NE-Flag
 B. Type: Miscellaneous
 C. Style: RDWY Curb&Gutter Flange
 D. Alignment label set: _No Labels
 E. OK

Info: Curb Return alignments do not allow the creation of offset alignments from the 
source alignment. If superelevation control is anticipated for the curb and gutter flange 
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alignment, use Centerline. For this training, SE control is not required, so Mis-
cellaneous is used.

 2. Draw lines along the gutter using Fixed Lines
 A. Extend the alignment beyond the area where the curb ramp is (Outside of the radius 

points)
 B. Draw an approaching tangent by snapping on the reference
 C. Draw a departing tangent at the other end of the radius 

 I. Use the Free Curve Fillet (Between two entities, through point) to snap on the 
approaching tangent, then the departing tangent then a place on the radius

Curb and gutter back alignment

Create offset line from alignment at 2.5' (width of curb and gutter)

 1. Home tab > Create Design > Alignment > Create Offset Alignment
 A. Choose the flag alignment to create the offset from.

 2. Create offset alignments dialog: 
 A. Offsets name template: Int-Margaret-NE-Back
 B. Station Range: Leave both checked
 C. No. of offsets on left: 0
 D. No: of offsets on right: 1
 E. Incremental offset on right: 2.5
 F. Alignment Style: RDWY Curb&Gutter Back
 G. Alignment label set: _No Labels
 H. OK

Info: For plans production, you may also want to create a curb and gutter face alignment, 
which is then data referenced into pavt.dwg and other plans drawings.

Tip: Open the data shortcut menu. Create a folder under centerline alignments named Curb 
Returns to organize the curb and gutter flange alignments together. 

Create Data Shortcuts

 1. Save the drawing
 2. Manage tab > Data Shortcuts > Create Data Shortcuts

 A. Select the newly made curb and gutter alignments
 B. OK

Curb ramp horizontal geometry 1

crdr-ele-crb-rmp-03.mp4 6:08

The curb ramp horizontal geometry should be developed in ProjectID\Design\AliProf\AliProf-
XX.dwg. The curb ramp horizontal geometry will be constructed using Miscellaneous Alignments 
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and then data referenced into the curb ramp design model drawing and plan sheet drawings. 
Develop the horizontal geometry based on the latest Standard Detail Drawings.

 1. Open ProjectID\Design\AliProf\AliProf-51.dwg,
 2. External Reference PM.dwg

 A. WisDOT Tools tab > Manage Panel > Xrefs > Load Xref on Layer
 I. Navigate to ProjectID\Design\Edgelines\PM.dwg

 II. Open
 3. Using AutoCAD tools, create lines and polylines on layer P_Misc_NoPlot

 A. Home tab > Layers Panel > Layers drop-down > P_Misc_NoPlot
 B. Using AutoCAD lines, offsets, and dimensions, create drafting lines that represent the 

sidewalk and curb ramp edges, grade breaks, and tapers based on the standard detail 
drawings.

Curb ramp horizontal geometry 2

crdr-ele-crb-rmp-04.mp4 6:09

Create edge of sidewalk alignment

The edge of sidewalk alignment will be used downstream in the curb ramp model drawing and plan 
sheets drawing.

 1. Home tab > Create Design > Alignment > Alignment Creation Tools
 A. Name: CR-Margaret-NE
 B. Type: Miscellaneous
 C. Style: RDWY Sidewalk
 D. Alignment label set: _No Labels
 E. OK

 2. Use the Alignment Layout tools to draw the edges of sidewalk 

 A. Fixed Line (Two Point) 

 B. Tangent-Tangent (No Curves) 

 C. Fixed Curve (Three Point) 

Create sidewalk joint alignment

Create alignment that represents anticipated grade change joint locations, including lower landing, 
ramp, upper landing, and sidewalk tie in locations.

 1. Home tab > Create Design > Alignment > Alignment Creation Tools
 A. Name: CR-Margaret-NE-Joints
 B. Type: Miscellaneous
 C. Style: RW Proposed-SlopeIntercepts
 D. Alignment label set: _No Labels
 E. OK
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 2. Use the Alignment Layout tools to draw the edges of sidewalk 

 A. Fixed Line (Two Point) 

 B. Tangent-Tangent (No Curves) 

 C. Fixed Curve (Three Point) 

Create Data Shortcut Folders

 1. Toolspace > Prospector > Alignments > Miscellaneous Alignments
 2. Right-click Miscellaneous Alignments > Create Folder

 A. New Folder Name: Curb Ramps
 B. OK

 3. Right-click Miscellaneous Alignments > Create Folder
 A. New Folder Name: Curb Ramps - Joints
 B. OK

 4. Ctrl+Select the curb ramp alignments (CR-XX). 
 A. Click and drag into the Curb Ramps folder

 5. Ctrl+Select the curb ramp joint alignments (CR-XX-Joints). 
 A. Click and drag into the Curb Ramps - Joints folder

Create Data Shortcuts

 1. Save the drawing
 2. Manage tab > Data Shortcuts > Create Data Shortcuts

 A. Select the newly made curb and gutter alignments
 B. OK

 3. Save and close the drawing

Curb ramp model drawing

crdr-ele-crb-rmp-05.mp4 4:35

Exercise files: crdr-ele-crb-rmp-01-data-c3d2018.zip

 1. New drawing using wisdot18.dwt
 A. Save As: ProjectID\Design\Corridor\CurbRamps.dwg
 B. Create Data References 

 I. Main roadway alignments
 II. Curb alignments flange alignments and profiles (if available)

 III. Existing surface and proposed design surfaces (if available)
 IV. Curb ramp and curb ramp joints alignments

Tip: Utilize group referencing to reference multiple data shortcuts at once. Options are as fol-
lows: - Right-click the objects or folders that contain the objects. Click Create Reference. - 
Select the objects or folders that contain the objects and drag them from the Prospector tree 
into the drawing. - Note: You can create multiple references at once by using Shift+click or 
Ctrl+click to select the data shortcuts. 

Page: 1129

Published on: 5/17/2023

Curb ramp design with feature lines

https://c3dkb.dot.wi.gov/video/rdwy-dsn/crdr-ele/crdr-ele-crb-rmp-05.mp4
https://c3dkb.dot.wi.gov/data/rdwy-dsn/crdr-ele/crdr-ele-crb-rmp-01-data-c3d2018.zip


 3. Attach External References 
 A. WisDOT Tools Ribbon > Manage > Xrefs > Load Xref on Layer
 B. Topo-ex.dwg: Existing Topography (if needed)
 C. Uti-ex.dwg: Existing Utilities (if needed)
 D. Proposed Storm Sewer Inlets (if applicable) (if needed)
 E. Ult-RW.dwg: Existing and Proposed Right of Way (if needed)
 F. PM.dwg: Pavement Marking (if needed)

Curb and gutter existing profile

crdr-ele-crb-rmp-06.mp4 2:23

 1. Home tab > Create Design > Profile > Create Surface Profile

 A. Alignment: Int-Margaret-NE-Flag
 B. Select Surface: Exist
 C. Add
 D. Profile List > Style column: PROF-Existing
 E. Draw in Profile View

 2. Create a profile view for the alignment
 A. General 

 I. Profile View Name: PV - <[Parent Alignment]> (Optional)
 B. Profile View Style: Stations 100' Major:50' Minor (Optional)
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 C. Station Range: User specified range 
 I. Start: 5-10' less than lowest station value

 II. End: 5-10' greater than highest station value
 3. Profile View Height: User specified

 A. Minimum: 1-2' lower than the minimum shown on Automatic
 B. Maximum: 1-2' higher than the maximum shown on Automatic
 C. Profile Display Options: 

 I. Style Column: Double check the correct style is selected
 II. Labels: _No Labels

 4. Create Profile View
 A. Digitize in model space to place the profile view, typically near the location of the curb 

ramp.

Curb and gutter proposed profile

crdr-ele-crb-rmp-07.mp4 7:04

Full roadway model projects

A curb and gutter radius design profile may already be developed for the roadway corridor design.

 1. Data reference the profile into the curb ramp design drawing.

Preservation projects

Preservation projects typically do not have curb and gutter radius profiles designed for the inter-
sections due to the scope of the project. For curb ramps, a design profile is required to develop a cor-
ridor that represents the curb and gutter that will be constructed at the curb ramp locations.

 1. Home tab > Create Design > Profile > Profile Creation Tools
 A. Select the profile view created in the previous step
 B. Name: <[Alignment Name]>
 C. Profile Style: PROF Proposed
 D. Profile label set: WisDOT Standard
 E. OK

 2. Use the Profile Layout tools to design a profile that closely matches the existing surface pro-
file for the entire length of the alignment

Verify the profile design at curb ramp locations

Check Roadway Cross Slopes At Crosswalks

 1. Refer to FDM 11-46-10.1.1.
 2. Verify that the roadway longitudinal slope (cross walk cross slope) at is no more than 1.5%.
 3. If the intersection is signalized or uncontrolled, the main roadway can maintain its profile.
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Check Curb Radii Profiles

 1. Verify that the curb radii profiles do not exceed 1.5% at the crosswalk locations.
 2. A quick way to verify these locations is to create AutoCAD points where the crosswalk inter-

sects the curb flange alignments.
 3. Then, project these points to the curb radii profile views.
 4. Adjust the curb radii profiles as needed.

Create points

 1. Change display style for points: DDPTYPE
 A. Choose the style, set as absolute units and size to 1

 2. Place AutoCAD points at key locations- the tapers and bottom of curb ramp 
 A. POINT Enter 

 B. Digitize points for the critical locations on the curb ramp
 3. Project the points to Profile View 

 A. Home tab > Profile & Section Views > Profile View > Project Objects to Profile 
View

 B. Select the points along the curb ramp Enter 
 C. Select the target profile view
 D. Project Objects to Profile View 

 I. Style: Basic
 II. Elevation Options: Refinement Top Surface for Full Roadway project, Exist for 

preservation projects.
 III. Label Style: <none>
 IV. OK

 4. Review the locations of the curb ramp and verify the slopes meet the requirements of curb 
ramp cross slopes. Make the adjustments to the curb return profile as necessary.

Tip: When designing the curb profile for a main roadway corridor, it is important to think 
about curb ramp placement before doing any curb ramp design. This will minimize any issues 
when designing the curb ramps. 

Project data reset

crdr-ele-crb-rmp-08.mp4 1:31

The first portion of this training was completed in one location of the sample project data to demon-
strate best practices for creating curb and gutter geometry and curb ramp geometry for pre-
servation projects. The training will now work in a new location, pre-established to show a more 
complex curb ramp design, using data from a full roadway design project (Refinement Surface and 
Proposed Profile). The workflow described here on out is the same for all types of projects.

Curb and gutter corridor
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crdr-ele-crb-rmp-09.mp4 5:19

Create Assembly

 1. Home Ribbon > Create Design > Assembly > Create Assembly
 A. Name: Curb Ramp
 B. Assembly Type: Other
 C. Assembly Style: WisDOT Standard
 D. Code set style: CRDR Proposed
 E. OK

 2. Digitize, in an open area, the location of the Assembly
 3. Turn on palettes (if turned off) 

 A. WisDOT Design Ribbon > Manage & Support > Palettes ON/OFF
 4. Add curb subassembly 

 A. WisDOT Design Ribbon > Assemblies & Subassemblies > WisDOT Subassemblies 
> Roadway tool palette> CGBasic subassembly

 I. Properties
 II. Modify the CGBasic parameters to match project requirements 

 a. Side: Right
 b. Curb and gutter size
 c. Curb Type
 d. Gutter slope method (Standard = 4%)
 e. Subgrade Width = 0'
 f. Terrace Width = 0'

 III. Click the Assembly baseline to place the subassembly

Create Corridor

 1. Home Ribbon > Create Design > Corridor > Corridor

 A. Name: 2nd-NW (SideRdQuadrant)
 B. Corridor Style: RDWY Proposed
 C. Baseline type: Alignment and profile
 D. Alignment: Int-2nd-NW-Flag
 E. Profile: 2nd-NW-Flag
 F. Assembly: CurbRamp
 G. Set baseline and region parameters: checked
 H. OK

 2. Set the starting and ending stations to the limits of the curb ramp construction

 3. Adjust the frequency.
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 A. Along tangents: 2.0'
 B. Curve increment: 2.0'
 C. Vertical Profile Points: Yes
 D. Add corridor frequencies at key locations 

 I. Within the Frequency dialog box click 
 II. Digitize the intersection of the curb ramp taper and curb ramp lines with the 

curb and gutter back alignment (also represented by the AutoCAD point)
 III. Enter
 IV. OK

 4. OK

Tips: 
Open a second view for 3D viewing 

View > Model Viewports > View Port Configuration > Two: Vertical

Orbit about the corridor to develop the 3D view 

View > Navigate 2D > Orbit 

Determine additional key elevation locations along flange

crdr-ele-crb-rmp-10.mp4 3:26

For plans productions, addition corridor frequencies are needed at the curb return quarter points 
and the locations of the cross walk. Add additional corridor frequencies at these locations.

 1. Curb return geometry points 
 A. Freeze the Corridor Layer
 B. Find curb quarter points 

 I. Draw an arc along the arc portion of curb return: Home Ribbon > Draw Panel 
> Arc > 3-Point

 II. DIVIDE Enter 
 a. Select the arc
 b. Number of segments: 4
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 III. If needed, change the display style for points: DDPTYPE
 a. Choose the style, set as absolute units and size to 1

 b. Select and Delete the arc
 2. Turn on or attach as an external reference the Pavement Marking Drawing (PM.dwg), which 

displays the cross walk lines.
 3. Thaw the Corridor Layer
 4. Create additional corridor frequencies at the quarter points and cross walk locations.

Corridor surface

crdr-ele-crb-rmp-11.mp4 2:00

 1. Select corridor > Contextual ribbon > Corridor surfaces
 A. Surfaces tab > Create a corridor surface

 I. Name: Crdr-2nd-NW (Crdr-SideRdQuadrant)
 II. Display Style: _No Display

 B. Add data > Data Type > *Feature Lines* > Specify Code
 I. BackCurb

 II. FaceCurb
 III. Flange
 IV. Flowline_Gutter
 V. TopCurb

 C. Boundaries tab > Right-click Crdr-2ndNW > Add Interactively
 I. Digitize/click the start of the corridor on the flange line. 

 a. On the window, choose the Flange feature line
 II. Digitize the end of the corridor flange, making sure the red preview line 

appears prior to clicking. 
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 a. If prompted, Feature line = Flange
 III. Digitize/click the backcurb adjacent to the last location selected (the end of the 

corridor) 
 a. Featureline = BackCurb

 IV. Digitize/click the start of the corridor on the back of curb 
 a. If prompted, Feature line = BackCurb

 V. Enter To finish the boundary creation process
 D. OK

Create refinement surface

crdr-ele-crb-rmp-12.mp4 2:02

 1. Home > Create Ground Data > Surfaces > Create Surface
 A. Name: Rfnt-2nd-NW-Top (Rfnt-SideRdQuadrant-Top)
 B. Style: Top Border

 2. Toolspace > Surfaces > Rfnt-2nd-NW-Top > Definition > Right-Click Edits > Paste Sur-
face > Select the Corridor Surface Crdr-2nd-NW

 3. Toolspace > Surfaces > Right-Click Rfnt-2nd-NW-Top > Rebuild - Automatic

Curb cut for curb ramp

crdr-ele-crb-rmp-13.mp4 5:24

Info: The subassembly used to build the curb and gutter corridor is built to read a profile that 
represents the curb height while the corridor remains dynamic to the profile. The WisDOT cus-
tom tool Slope/Width Control Editor will be used to define the profile that represents the curb 
height and curb cut. 

 1. WisDOT Design > WisDOT Assemblies & Subassemblies > Slope/Width Control Editor

 2. Create Tab: Used to create the profile

 A. Alignment: Int-2nd-NW-Flag (Choose the alignment representing the flange at the curb 
ramp)

 B. New Profile Name: ZCP - 2nd-NW-CurbHeight

 C. Stations: Leave the default (Limits of the alignment)

 3. Start Slope/Width: 0.5 (represents the curb height in feet)

 4. End Slope/Width: 0.5

 F. Create

Tip: If the alignment is not available in the drop-down list, Refresh All

 5. Edit tab
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 A. Alignment: Choose the alignment for the curb ramp location: Int-2ndNW-Flag

 B. Control Profile: ZCP-2nd-NW-CurbHeight (default unless there are other ZCP profiles 
for the alignment)

 C. Add custom station and curb height locations for the key curb cut locations along the 
alignment

 I. Click the station picker button 

 II. Working down-station to up-station, digitize the different points along the align-
ment and define a curb height in the Slope/Width: box.

 a. Begin Taper: 0.5
 b. End Taper - Curb Ramp Bottom: 0
 c. Begin Taper - Curb Ramp Bottom: 0
 d. End Taper: 0.5
 e. Add to table after each geometry point. The new point/elevation/curb 

height will be listed in the table on the right.
 f. After all geometry points have added, the profile definition within the 

drawing must be updated: Update Profile from table

 D. Move or close the Slope/Width Control Editor to view the corridor.
 6. Add the profile to the corridor through target mapping

 A. Select the corridor > Edit Targets > Select the curb and gutter region to edit
 B. Target mapping 

 I. Curb height from profile: click <none> to edit the target
 II. Alignment: Int-2nd-NW-Flag

 III. Select Profiles: ZCP-2nd-NW-CurbHeight
 IV. Add>>
 V. OK

 7. OK to update and rebuild the corridor. Curb cuts and changes to the curb height profile will 
change automatically with a corridor rebuild.
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Review curb flare slopes and update curb cuts

crdr-ele-crb-rmp-14.mp4 2:39

The curb cut tapers for the curb ramp need to meet Standard Detail Drawing requirements. At the 
time of publication of this training, the taper must not exceed a 10:1 slope.

Review Slopes

Add slope labels on the top of curb.

 1. Annotate Tab > Add Labels
 A. Feature: Surface
 B. Label Type: Slope
 C. Slope label style: Slope Percent
 D. OK

 2. Select the Refinement Surface: Rfnt-2nd-NW-Top
 3. T for Two Point (or select Two Point)
 4. Digitize two points that establish the slope label 

 A. Do not snap to any objects
 B. Digitize somewhere between the ramp bottom and top of curb cut
 C. Digitize somewhere between the Curb Face and Curb Back
 D. This allows for room for adjustments to curb cuts and ensures an accurate rep-

resentation of the curb taper is labeled.

Update curb cuts

crdr-ele-crb-rmp-15.mp4 2:14
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Any slopes on the curb cut tapers greater than 10% will need to be adjusted so the curb cut slope is 
less than 10%.

 1. Open the slope control editor and adjust the stationing of the top of curb cuts to extend the 
curb away from the bottom of the ramp, to flatten the slope.

 2. Update Profile from Table
 3. Rebuild the Curb and Gutter Corridor
 4. Review slope labels to verify changes were made.

Create points at updated curb cut locations

crdr-ele-crb-rmp-16.mp4 2:21

Add profile labels to curb and gutter alignment

 1. Select curb and gutter flange alignment > Right Click > Edit AlignmentLabels
 A. Type: Profile Geometry Points
 B. Profile Geometry Point Label Style: WisDOT Standard
 C. Add>>

 2. Profile Points 
 A. Select Profile: ZCP-2ndNW-CurbHeight
 B. Deselect all geometry points
 C. Select Point of Vertical intersection
 D. OK

 3. OK

Add extra frequencies to corridor

 1. Select Corridor > Contextual ribbon > Edit Frequency
 2. In modelspace select the corridor region to edit the frequency

 3.  to create additional frequencies at the adjusted profile PVIs

Move points to profile PVI locations

 1. Select and move the previously created AutoCAD points to the updated locations as determ-
ined by the profile geometry point alignment labels. Snap to the corridor frequencies.

Update curb ramp horizontal geometry

crdr-ele-crb-rmp-17.mp4 2:49

Copy points to curb ramp horizontal geometry drawing

 1. Select the Autocad points > Right-click > Clipboard > Copy
 2. Open ProjectID\Design\AliProf\AliProf-XX.dwg
 3. Right Click > Clipboard > Paste to Original Coordinates
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Adjust curb ramp horizontal geometry

 1. Select the curb ramp horizontal geometry alignment. Adjust the taper grips to the new loc-
ations.

 2. Save and close the AliProf-XX.dwg.
 3. In CurbRamps.dwg, synchronize the curb ramp horizontal geometry alignment.

Extract corridor feature line

crdr-ele-crb-rmp-18.mp4 2:30

Exercise files: crdr-ele-crb-rmp-02-data-c3d2018.zip

Create a site

 1. Prospector > Right-click Site > New...
 A. Name: 2ndNW
 B. OK

Extract feature line

 1. Select corridor > Contextual ribbon > Launch Pad > Feature Lines From Corridor
 2. Select the back of curb feature line
 3. Enter
 4. Extract Corridor Feature Lines dialog box 

 A. Uncheck all feature lines except BackCurb
 B. Site: 2ndNW
 C. Leave defaults for Style, Layer, and Pay Item
 D. Settings... 

 I. Dynamic link to corridor: checked
 II. Apply Smoothing: unchecked

 III. Name: checked,BOC
 IV. Code Set Style: CRDR Proposed
 V. OK

Create curb ramp feature lines

crdr-ele-crb-rmp-19.mp4 7:51

Tip: To minimize errors created from incorrect object snapping, it is recommended to hide 
(Right click > Isolate Objects) the curb and gutter corridor. 

 1. Home > Create Design > Feature Line > Create Feature Line

 A. Site: 2ndNW
 B. Name: Lower Landing
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 C. Style: Unchecked
 D. OK

 2. Trace the lower landing as shown in the image below.

Info: It will prompt for an elevation every time a line is drawn. Enter to use the default 
for now.

 3. Repeat for the remaining curb ramp feature lines, tracing the shapes of the features as 
shown.

 A. LowerLanding
 B. Ramp
 C. Taper1 and Taper2
 D. Upper Landing
 E. SidewalkFront1 and SidewalkFront2

Tip: Use a circle to find where the tie in location will be. Typically, the distance is 
2 or 3 sidewalk panels from the upper landing to tie into the existing ground or 
roadway design top surface.

 D. SidewalkBack (One continuous feature line)
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Assign feature line elevations

crdr-ele-crb-rmp-20.mp4 7:23

Lower Landing

 1. Select the LowerLanding feature line > Contextual ribbon > Elevation Editor
 2. Feature lines now elevations can now be set relative to a surface. For the lower landing fea-

ture line, it is recommended to set the begin and end elevation point to relative to surface
 3. Within the Elevation Editor, under the Relative to Surface drop-down, select the curb ramp 

corridor surface (Crdr-2ndNW)

 4. Another column will be added to the elevation editor. Change the first and last station point 
from Absolute Elevation to Relative to Surface

 5. The grade of the lower landing can be no greater than 1.5%. Set the [Grade Ahead]{.un-
derline} at station 0+00 to 1% and the other automatically changes.

 A. If the other slope is greater than 1.5%, the grade ahead or grade back values need to 
be adjusted to meet the requirements.

 6. Click the green check mark to finish the changes

Ramp

 1. Select the Ramp feature line > Contextual ribbon > Elevation Editor
 2. The ramp can have a maximum slope of 7%.

 A. Change the first [Grade Ahead]{.underline} of Station 0+00 to 7%.
 B. Change the [Grade Back]{.underline} of the last station to 7% as well.
 C. Adjust the slopes if needed to maintain a less than 1.5% cross slope. In the example, 

the cross slope is 0.35% and is acceptable.
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 3. Click the green check mark to finish the changes.

Upper Landing

 1. Select the UpperLanding feature line > Contextual ribbon > Elevation Editor
 2. The upper landing may not exceed 1.5% in any direction. Change the [Grade Ahead] for Sta-

tion 0+00 to 1%.
 3. Change the [Grade Ahead] of the last station to -1%. 

 A. In the example, a small kink required the first two station's to be set a 1%.
 4. Adjust the slopes to meet the (less than 1.5%) slope requirement.
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Sidewalk Match

 1. Select one of the SidewalkFront feature lines > Contextual ribbon > Elevation Editor
 2. The last two stations should match the existing surface (for preservation projects) or the 

refinement surface (for reconstruction projects). These stations represent the tie in location 
on the sidewalk.

 A. Select the last two stations in the elevation editor (Ctrl+click)

 B. Click the Elevations from Surface button

 C. Select the target surface (Exist for preservation, Rfnt-Top-All for reconstruction/full 
roadway model projects)

 D. The back of sidewalk automatically connects
 E. Repeat with the other sidewalk.

 3. In instances where there is a kink in the sidewalk between the upper landing and the sidewalk 
tie-in-point, use the Set Grade/Slope between points from the feature line contextual rib-
bon.

 A. Select the feature line > Contextual Ribbon > Edit Elevations > Set Grade/Slope 
between points

 B. Click one end of the feature line in question to choose the first elevation to set the 
grade from. Watch for the PI green triangles to highlight as the cursor moves.

 A. Enter to accept the elevation
 C. Click the other end of the feature line that has a correct elevation. 

 I. Enter to accept the elevation
 D. The feature line will be graded between the two points that were selected, and inter-

mediate points between the two points will have automatic elevations assigned.
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 4. Review the longitudinal slopes of the feature line segments connecting the upper landing and 
the tie in point to verify it is less than 7%. If greater than 7%, extend the location of the tie in 
location to another known sidewalk joint for preservation projects or at distance that rep-
resents the standard sidewalk panel lengths.

Add feature lines to refinement surface

crdr-ele-crb-rmp-21.mp4 1:22

 1. Toolspace > Sites > 2ndNW > Right-click Feature Lines > Add to Surface as Breakline...
 A. Select the curb ramp refinement surface: Rfnt-2ndNW-Top
 B. Accept the defaults

Surface inspection

crdr-ele-crb-rmp-22.mp4 1:45

 1.  Annotate tab > Add Labels

 A. Feature: Surface
 B. Label Type: Slope
 C. Slope label style: Slope Percent
 D. Add

 2. ADDSURFACESLOPELABEL: Select a surface or Enter to select the surface from list
 A. Choose refinement curb ramp surface (Rfnt-2ndNW-Top)
 B. OK

 3. ADDSURFACESLOPELABEL: Create Slope Labels or [One-point Two-point]
 A. Click Two-point or type "t" and Enter

 4. Digitize first and second points in different locations to create slope labels
 A. Landings
 B. Ramps
 C. All sidewalk edges and joints
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 D. Used to verify design and make sure slopes are within requirements.

Pedestrian curb

crdr-ele-crb-rmp-23.mp4 5:15

Some curb ramps may require a pedestrian curb at the back of sidewalk to better match the existing 
ground. After designing the main curb ramp and sidewalk tie in, review the location of the existing 
ground to determine if a pedestrian curb may be required. If no pedestrian curb is required, move 
on to slope intercept gradings.

Create pedestrian curb feature lines

 1. Modify Ribbon > Edit Geometry panel > Stepped Offset

 A. Specify the horizontal offset: HORIZONTAL DISTANCE: 0.01 Enter
 B. Select the SidewalkBack feature line
 C. Specify the side to place the offset feature line
 D. Specify the elevation difference: ELEVATION: 0.5 Enter
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 E. A feature line 0.01' to the back and 0.5' above the back of sidewalk feature line will be 
created on the same site as the source feature line.

 2. If required, shorten the feature line to better match field conditions. In the example, the curb 
ramp pedestrian curb will be constructed throughout the limits of the curb ramp.

 A. Modify Ribbon > Edit Geometry panel > Break

 B. Select an object to break: Select the offset feature line.
 C. Click First Point on the command line
 D. Specify first break point: Select the location where the pedestrian curb will terminate.
 E. Specify second break point: Select the end-point of the feature line to be deleted.

Adjust the slope of the offset feature line

To transition the curb from 0 at an end of curb ramp to the desired pedestrian curb height, use the 
set elevation by reference command
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 1. Modify Ribbon > Edit Elevations > Set Elevation by Reference

 A. Specify the reference point: Select the end of back of sidewalk
 B. Object to Edit: Select the offset feature line
 C. Specify point: Select the end of the offset feature line (the location to adjust the 

elevation)
 D. Specify grade:0

Create a stepped offset for the back of curb

 1. Modify Ribbon > Edit Geometry panel > Stepped Offset
 A. Specify offset distance: 0.49 Enter
 B. Select the top-front of curb feature line
 C. Pick the side to offset the line to.
 D. Specify elevation difference: 0.00 Enter
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Add pedestrian curb feature lines to refinement surface definition

 1. Select the refinement curb ramp surface > Contextual ribbon > Modify panel > Add 
Data > Breaklines

 A. Description: PedCurb
 B. OK

 2. Select the two pedestrian curb feature lines
 3. Enter

Slope intercept grading

crdr-ele-crb-rmp-24.mp4 7:04

The goal of this portion of the workflow is to create a grading slope between the back of the curb 
ramp and the existing ground. This grading can be constructed from the back of sidewalk or the ped-
estrian curb, if the curb ramp requires a pedestrian curb.

Create grading at the back of sidewalk/pedestrian curb

 1. Toolspace > Prospector > Sites > *2ndNW* > *Right-click* Grading Groups > New...

 A. Name: Grdng-2ndNW
 B. Automatic surface creation: checked
 C. Use the Group Name: checked
 D. Surface Style: Rock Triangles
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 E. Tessellation Spacing: 2.5'
 F. OK
 G. Create Surface dialog: OK

 2. Home > Create Design > Grading > Grading Creation Tools

 A. Select Grading Group 
 I. Site Name: 2ndNW

 II. Group Name: Grdng-2ndNW
 B. Select Target Surface: Exist
 C. Set Grading Criteria: Grade to Surface

 3. Create Grading button

 A. Select the feature:If applicable, select the back of pedestrian curb feature line
 B. Select the side of the feature line to construct the grading

 C. Apply to the entire length?No
 I. Depends on project conditions and feature line that is the source of the grad-

ing
 D. Cut Format:Slope Enter
 E. Cut Slope:10:1 (Specify desired cut slope) Enter
 F. Fill Format:Slope Enter
 G. Fill Slope:10:1 (Specify desired cut slope) Enter

 4. Repeat step 3 for remaining back of sidewalk or back of pedestrian curb feature lines. Every 
curb ramp may be different for the types and slopes of gradings.

 A. For the example, a 10:1 slope (cut or fill) is constructed for a primary portion of the 
design. The north end will transition to a 4:1

 B. Add the constant slope gradings (10 and 4:1) at each end.
 C. Connect with a "transition" grading.
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 5. Select the Grading Surface > Contextual Ribbon > Surface Properties
 A. Information Tab > Surface Style > _No Display
 B. OK

Add grading surface to the refinement surface

 1. Select the surface Rnt-2ndNW-Top > Contextual ribbon > Edit Surface > Paste Surface
 2. Select Grdg-2ndNW
 3. OK

Refinement surface boundary

crdr-ele-crb-rmp-25.mp4 5:32

 1. Adjust the curb and gutter limits to within the limits of the curb ramp
 A. Select the curb and gutter corridor
 B. Shorten using the diamond Grip

 2. Select the surface *Rfnt-2ndNW-Top* > Contextual Ribbon > Surface Properties > Sur-
face Properties

 3. Information Tab > Default styles > Surface Style > Top Triangles
 4. If applicable, add Elevation Points on the sidewalk feature lines to create triangles and tie in 

locations between the sidewalk and curb and gutter
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 A. Select the feature line > Contextual Ribbon > Edit Elevations panel > Insert Elev-
ation Point

 B. Specify the location of the elevation point - snap to a nearby desired location. The elev-
ation will automatically be calculated and the sidewalk grade will remain constant.
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 C. Enter to accept the elevation

 5. Change active layer to P_Surf
 A. Home Tab > Layers Panel > Layers drop-down > P_Surf

 6. Draw a polyline through the triangles that should be removed. The polyline does not have to 
be perfect, it just needs to cross the triangles that need to be removed from the surface defin-
ition.
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 7. Select the refinement surface > Contextual Ribbon > Add Data > Boundaries
 A. Name: Outer
 B. Type: Outer
 C. Non-destructive breakline: Unchecked
 D. OK

 8. Select the boundary polyline > Enter
 9. Turn the refinement surface back to the Top Border style.

Create refinement surface data shortcut

crdr-ele-crb-rmp-26.mp4 3:11

 1. Toolspace > Prospector > Right-click Surfaces > Create Folder to create folders to organ-
ize the different curb ramp surfaces. Example folders are as follows:

 A. Curb Ramp Crdr
 B. Curb Ramp Grading
 C. Curb Ramp Refinement

 2. Drag and drop the surfaces to their respective folders.
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 3. Toolspace > Prospector > Data shortcuts
 A. Make sure the design project is the active data shortcut project.
 B. Right-click Data shortcuts > Create Data Shortcuts
 C. Rfnt-2ndNW-Top: checked (and any other refinement curb ramp surfaces)
 D. OK

Add curb ramp design alignments to pavement drawing

crdr-ele-crb-rmp-27.mp4 2:22

Exercise files: crdr-ele-crb-rmp-03-data-c3d2018.zip

 1. Open ProjectID\Design\Edgelines\pavt.dwg
 2. Toolspace > Prospector >Data Shortcuts > Alignments > Miscellaneous Alignments > 

Curb Ramps folder
 A. Right-click CR-2ndNW > Create Reference...

 I. Alignment style: RDWY Sidewalk
 II. Alignment label set: _No Labels

 III. OK
 B. Repeat for remain curb ramp edgeline alignments as needed. Utilize data referencing 

of selected groups of objects.
 3. Toolspace > Prospector >Data Shortcuts > Alignments > Miscellaneous Alignments > 

Curb Ramps > Joints folder
 A. Right-click CR-2ndNW-Joints> Create Reference...

 I. Alignment style: RW Proposed-SlopeIntercepts
 II. Alignment label set: _No Labels

 III. OK
 B. Repeat for remain curb ramp joint alignments as needed. Utilize data referencing of 

selected groups of objects.
 4. Save and close pavt.dwg

Exercise files: crdr-ele-crb-rmp-end-data-c3d2018.zip

Divided highway workflow
Last updated: 2012-05-01

Total video time: 148:22

Detailed exercise instructions: crdr-ele-div-hwy.pdf

Begin exercise data: crdr-ele-div-hwy-start-data-C3D10.zip

End exercise data: crdr-ele-div-hwy-finished-data-C3D10.zip

Introduction

crdr-ele-div-hwy-01.mp4 4:46
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Review prepared data

crdr-ele-div-hwy-02.mp4 5:14

Review prepared data 2

crdr-ele-div-hwy-03.mp4 2:55

Setup subgrade shoulder point assemblies

crdr-ele-div-hwy-04.mp4 7:08

Setup subgrade shoulder point assemblies 2

crdr-ele-div-hwy-05.mp4 6:58

Setup subgrade shoulder point assemblies 3

crdr-ele-div-hwy-06.mp4 3:14

Setup subgrade shoulder point corridor creation

crdr-ele-div-hwy-07.mp4 6:46

Setup subgrade shoulder point corridor review

crdr-ele-div-hwy-08.mp4 5:23

Setup subgrade shoulder point dynamically linked feature lines

crdr-ele-div-hwy-09.mp4 10:58

Setup median ditch assembly

crdr-ele-div-hwy-10.mp4 8:36

Setup median ditch assembly 2

crdr-ele-div-hwy-11.mp4 1:34

Setup median ditch corridor creation
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crdr-ele-div-hwy-12.mp4 4:51

Setup median ditch dynamically linked feature lines

crdr-ele-div-hwy-13.mp4 3:35

Project median feature lines to profile view

crdr-ele-div-hwy-14.mp4 5:35

Develop median ditch profile

crdr-ele-div-hwy-15.mp4 8:26

Review median ditch profile

crdr-ele-div-hwy-16.mp4 2:39

STH 25 4-lane assemblies

crdr-ele-div-hwy-17.mp4 9:09

STH 25 4-lane assemblies 2

crdr-ele-div-hwy-18.mp4 5:16

STH 25 4-lane assemblies 3

crdr-ele-div-hwy-19.mp4 1:33

STH 25 4-lane assemblies 4

crdr-ele-div-hwy-20.mp4 5:02

STH 25 4-lane assemblies 5

crdr-ele-div-hwy-21.mp4 4:43

STH 25 4-lane assemblies 6
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crdr-ele-div-hwy-22.mp4 5:38

Create STH 25 4-lane corridor

crdr-ele-div-hwy-23.mp4 8:46

Create STH 25 4-lane corridor 2

crdr-ele-div-hwy-24.mp4 2:49

Create STH 25 4-lane corridor 3

crdr-ele-div-hwy-25.mp4 4:13

Create STH 25 4-lane corridor 4

crdr-ele-div-hwy-26.mp4 2:47

Review STH 25 4-lane corridor

crdr-ele-div-hwy-27.mp4 5:11

Review exercise workflow

crdr-ele-div-hwy-28.mp4 4:36

Traffic control crossovers: corridor-based
Last updated: 2016-05-16

Exercise files: crdr-ele-trfc-cntrl-crssovr-data-C3D16.zip

Exercise files: crdr-ele-trfc-cntrl-crssovr-finished-data-C3D16.zip

Crossover design with Civil 3D

There are multiple ways to design a crossover with Civil 3D and every situation is different.  This doc-
ument discusses one method for modeling crossovers using a combination of tools in Civil 3D.  First, 
here are some best practices and design recommendations to help with the crossover geometry.

 1. Make sure the crossover placement allows for adequate room in the construction zone.
 2. Place the crossover in a location that is visible to approaching motorists.
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 3. Look at the longitudinal profile of your roadway and try to place the crossover in a location 
where the pavement will drain.  If the area is flat, consider using Slotted Corrugated Metal 
Pipe Surface Drains.  Good drainage may sometimes be achieved by warping the pavement 
slopes.

 4. Use SDD 15D11 as a guide.  Design for no less than 10 mph below posted speed.
 5. Use the existing roadway crown to your advantage when selecting curve radii.
 6. The crossover model will be dependent on the existing median pavement edges.  It is critical 

to survey these pavement edges at a minimum.  Ideally, the entire median (pavement edge to 
pavement edge) should be surveyed.

Here is one method to model a median crossover with Civil 3D.  The naming shown is based on a 
East-West roadway.  To avoid rework, finalize the location of the crossover prior to constructing the 
surface models.

Create crossover geometry

 1. Create a new drawing with the WisDOT template and give it an appropriate name such as 
Crdr-Crossover.dwg.  Data shortcut reference the following:

 o NB and SB reference line alignments
 o NB and SB centerline alignments
 o Existing Surface (ideally with a supplemental median survey included)

 2. Xreference the project mapping.
 3. Determine the best location for the crossover.  Create the horizontal geometry for the median 

crossover using alignments.  All the edgeline alignments can be created, but only the edge of 
shoulder alignments will be used for this modeling process.  Show the gore areas with the 
alignments.

 4. Create an alignment representing the inverted crown of the crossover.  Typically this is located 
down the center of the median.  The alignment should extent well past the anticipated loc-
ation where it would intersection the crossover subgrade shoulder points.

 5. Create and existing surface profile for the EB and WB reference line alignments.

Create crossover setup surfaces and surface profiles

 1. Insert the Crossover Setup assembly from the WisDOT assemblies palette.  Adjust the lane 
parameters to match the required pavement structure.

 2. Create a corridor called Setup-Crossover
 o Set the corridor begin and end stations to just beyond the crossover extents.
 o Use the EB alignment, Existing Surface profile, and the assembly from step 1.
 o Recommended frequency is 2.5 ft.
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 o Target the first lane to the inverted crown alignment
 o Target the second lane to the WB reference line alignment and existing surface profile.

 3. Review the lane cross-slopes in the corridor section editor.  The right lane slope will be con-
stant and the other will vary to match the terrain.  Check to make sure the variable slopes are 
reasonable.  You may need to adjust the location of the inverted crown line or modify the 
slope of the constant slope lane in the assembly.  Superelevation or Profile Slope Control tools 
can be used to vary the lane slopes to aid in pavement drainage or to better match the exist-
ing conditions.

 4. In the Surfaces tab of the corridor properties, create the Crdr-Setup-Crossover-Top, Crdr-
Setup-Crossover-Base, and a Crdr-Setup-Crossover-Datum surfaces.  If there are other layers 
in the pavement structure, create those surfaces too.

 5. Set the corridor code set style to No Display.
 6. Create surface profiles on the Crdr-Setup-Crossover-Top surface for the inverted crown and 

edge of gravel shoulder alignments.

Create Proposed Corridor

 1. Insert the following assemblies from the WisDOT assemblies palette.
 o Top-Base-Datum FLs
 o Base-Datum FLs
 o Datum FL
 o Gore FLs with Left Slope
 o Gore FLs with Right Slope

 2. Create a new corridor proposed work corridor named appropriately.
 3. Add the Inverted Crown alignment and surface profile as the baseline.
 4. Use the Top-Base-Datum FLs assembly to create a region that extends from crossover edge 

of gravel shoulder to edge of shoulder gravel shoulder.

 5. Add the EB reference line and existing surface profile as a baseline.
 6. Using the Top-Base-Datum FLs assembly, add a region to the EB baseline that extends the lim-

its of work along the EB reference line.
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 7. Repeat steps 5 and 6 for the WB reference line.

 8. Add one of the crossover edge of shoulder alignments and surface profile to the corridor as a 
baseline.

 9. Add a region using either the Gore FLs with Left Slope or Gore FLs with Right Slope 
assembly.  (Choose based on the direction of the alignment, and direction of the daylight 
slope)

 o The region limits should extend from the end of the crossover limits to the start of the 
gore radius.

 o Target the Existing surface using the SlopeToDaylight subassembly
 o Target the Crdr-Setup-Crossover-Datum surface using the SlopeToDaylight_Sub sub-

assembly
 o Target the Crdr-Setup-Crossover-Base surface using the SlopeToES_Base subassembly

 10. Add a second region using the Top-Base-Datum FLs assembly that extends through the gore 
radius.

 11. Repeat Steps 8-10 for the other edge of gravel shoulder alignment/surface profile.
 12. Add a region to the Inverted Crown baseline that extends from the edge of gravel shoulder to 

the point where the inverted crown alignment intersects the ES_Base feature line created in 
step 9.

 13. Add a region to the Inverted Crown baseline that extends from the point where the inverted 
crown alignment intersects the ES_Base feature line to the point where it intersects the Day-
light_Sub feature line

 14. Repeat steps 12 and 13 for the opposite side of the crossover.
 15. Create corridor surfaces for Top, Base, and Datum.  Required feature lines are shown below.
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Create Corridor Top Surface Boundary

 1. For the Top surface, create a corridor surface boundary using the interactive method.  The 
boundary should follow the Daylight feature line along the shoulder baselines and follow the 
Crown feature line along the EB/WB reference lines.

 2. You will likely notice areas where the boundary falls inside of the Daylight_Sub feature line.  
This is normal and typically occurs at the ends of the crossover limits and near the gores.  
These are areas where the shoulder foreslope matches into the existing ground before reach-
ing the Daylight_Sub feature line.

Create Corridor Datum Surface Boundary

 1. For the Datum surface, create a corridor surface boundary using the interactive method.  The 
boundary should follow either the Daylight or Daylight_Sub feature lines along the shoulder 
baselines (whichever is most interior to the crossover at any given point).  Along the EB and 
WB baselines, the boundary should follow the Crown_Sub feature line.

 2. The boundary will likely jump back and forth between the Daylight and Daylight_Sub feature 
lines.   Just like the corridor top surface boundary, this is normal and typically occurs at the 
ends of the crossover limits and near the gores.  These are areas where the shoulder 
foreslope matches into the existing ground before reaching the Daylight_Sub feature line.
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Alternative Boundary Creation Method

Corridor surface boundary creation is a key element to this workflow.  If you are not accustomed to 
using the interactive boundary creation method in conjunction with editing an interactive boundary 
after it has been create, the task can be challenging.  An alternative to using the interactive method is 
to create a polyline boundary.  This can be done by extracting the required feature lines from the cor-
ridor.  Explode the feature lines so you are left with 3D polylines.  Then, using the trim, extend, and 
join commands, a closed polyline can be created and used for the boundary.

Create Corridor Base Surface Boundary

 1. For the Base surface, create a corridor surface boundary using the interactive method.  The 
boundary should follow either the Daylight or ES_Base feature lines along the shoulder 
baselines (whichever is most interior to the crossover at any given point).  Along the EB and 
WB baselines, the boundary should follow the Crown_Pave1 feature line.

 2. The boundary will likely jump back and forth between the Daylight and ES_Base feature lines.   
Just like the corridor top and datum surface boundaries, this is normal and typically occurs at 
the ends of the crossover limits and near the gores.  These are areas where the shoulder 
foreslope matches into the existing ground before reaching the ES_Base feature line.
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Create Refinement Surfaces

 1. Data reference each corridor surface into its respective refinement surface drawing.
 2. Refinement-Top

 o Paste in Crdr-Top
 3. Refinement-Base

 o Paste in Crdr-Base
 4. Refinement-Datum

 o Paste in Refinement-Top
 o Paste in Crdr-Datum

 5. Surface refinements for the three surface type is similar.  For each surface, add a breakline at 
the gores as shown below.
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 6. For the Refinement-Top surface, check the slope areas for locations like this.  Add breaklines 
as needed.

Traffic control crossovers: feature line-based
Last updated: 2015-04-21

Modeling crossovers

There are multiple ways to design a crossover with Civil 3D and every situation is different. This doc-
ument discusses one method for modeling crossovers using a combination of tools in Civil 3D. First, 
here are some best practices and design recommendations to help with the crossover geometry.

Make sure the crossover placement allows for adequate room in the construction zone.

Place the crossover in a location that is visible to approaching motorists.

Look at the longitudinal profile of your roadway and try to place the crossover in a location where 
the pavement will drain. If the area is flat, consider using Slotted Corrugated Metal Pipe Surface 
Drains. Good drainage may sometimes be achieved by warping the pavement slopes.
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Use SDD 15D11 as a guide. Design for no less than 10 mph below posted speed. 

Use the existing roadway crown to your advantage when selecting curve radii.

The crossover model will be dependent on the existing median pavement edges. It is a best practice 
to survey these pavement edges at a minimum. Ideally, the entire median (pavement edge to pave-
ment edge) should be surveyed.

Here is one method to model a median crossover with Civil 3D. The naming shown is based on a 
North-South roadway. To avoid rework, finalize the location of the crossover prior to constructing 
the surface models.

Crossover geometry

 1. Create a new drawing with the WisDOT template and give it an appropriate name such as 
Crossover Edgelines.dwg. Data shortcut reference the following:

 o NB and SB reference line alignments and existing surface profiles
 o NB and SB centerline alignments
 o Existing Surface (ideally with a supplemental median survey included)

 2. Xreference the project mapping.
 3. Determine the best location for the crossover. Draw the horizontal geometry for the median 

crossover. Be sure to include the edge of pavement and edge of shoulder line work for the 
gore areas. This can be done with lines and arcs, the end result needs to be continuous poly-
lines. Use the proper layers.  Save and close the drawing

Crossover setup surfaces

 1. Create a new drawing with the WisDOT template and give it an appropriate name such as 
Crossover Setup Corridor.dwg. Data shortcut the following:

 o NB and SB reference line alignments and existing surface profiles
 o Existing Surface (ideally with a supplemental median survey included)

 2. Create a joint polyline that represents the inverted crown location of the crossover median. 
The polyline should extend through the limits of the crossover.

 3. Create an assembly consisting of two lanes.

 4. Create a corridor called Crossover Setup. 
 5. Set the corridor begin and end stations to the crossover extents. 
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 6. Use the NB alignment, Existing Surface profile, and the assembly from step 6. 
 7. Recommended frequency is 5 ft.
 8. Target the first lane to the inverted crown polyline
 9. Target the second lane to the SB reference line alignment and existing surface profile.

 10. Review the lane cross-slopes in the corridor section editor. The right lane slope will be con-
stant and the other will vary to match the terrain. Check to make sure the variable slopes are 
reasonable. You may need to adjust the location of the inverted crown line or modify the 
slope of the constant slope lane in the assembly. Also, superelevation can be established on 
the NB alignment to vary the right lane slope to aid in pavement drainage or to better match 
the existing conditions.

 11. Turn off all unnecessary feature lines in the corridor properties Feature Lines tab. The fea-
ture lines that are needed are ETW, Crown, ETW_Sub, and Crown_Sub.

 12. In the Surfaces tab of the corridor properties, create a Top and a Datum surface.
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 13. Save the drawing and create data shortcuts for the Top and Datum surfaces.

Crossover top surface

 1. Create a new drawing with the WisDOT template and give it an appropriate name such as 
Crossover Top Surface.dwg. Data shortcut the following:

 o Crossover Setup - Top surface
 o Exist surface

 2. Xreference the Crossover Edgelines.dwg file.
 3. Create a new Site called "Crossover - Top".
 4. Create feature lines for the cross over edge lines using the Create Feature Line from Objects 

command. Place these feature lines in the Crossover - Top Site. Do not assign a style. Place 
the feature lines on the appropriate layers. Assign elevations from the Crossover Setup - Top 
surface. Accept the default weeding factors.
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Example naming convention: (EOP = Edge of Pavement, EOS - Edge of Shoulder)

South Gore EOP - Top 

South Gore EOS - Top

North Gore EOP - Top

North Gore EOS - Top

 5. Create feature lines representing the NB and SB edges of pavement and place them in the 
Crossover - Top site. Give them appropriate names like NB EOP - Top and SB EOP - Top. 
Assign elevations from the Crossover Setup - Top surface. 

 6. Create a feature line representing the inverted crown location between the edge of shoulder 
gore radii and place it in the Crossover - Top site. Give it an appropriate name like Inverted 
Crown - Top. Assign elevations from the Crossover Setup - Top surface. 

 7. Create a feature line at each end of the crossover limits connecting closing off the work area. 
Name them something appropriate like NB North EOP, NB South EOP, SB South EOP, SB 
North EOP.

 8. From the Modify tab, select the Elevations from Surface command from the Edit Elevations 
panel. Choose the Crossover Setup - Top surface and check Insert intermediate grade break 
points. Select all of the feature lines.

 9. In the Crossover - Top site, create a grading group called Crossover - Top. Turn on Automatic 
Surface Creation. Check Use the Group Name, give it a style of P Triangles-Top, and set the 
Tessellation spacing to 5'
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 10. Open the Grading Creation tools dialogue. Edit the Grading Criteria to match your project 
conditions. Make sure Target is set to Surface and Interior Corner Overlap is set to Hold 
Slope as Maximum.
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 11. Create Gradings off of the Gore EOS - Top feature lines. Set your target surface to Exist. Apply 
to the entire length. 

 12. From the Grading Creation Toolbar, select the Create Grading Infill command. Select each of 
the areas of the crossover to complete the surface creation. These areas include four 
shoulder areas and two pavement areas. 

 13. The Crossover Top surface should now be complete. Inspect the surface for abnormalities 
and make any surface edits as needed.

 14. Save the drawing and create a data shortcut for the Crossover - Top surface. 

Crossover datum surface

 1. Create a copy of the Crossover Top Surface.dwg file and rename it as Crossover Datum 
Surface.dwg

 2. Open the Crossover Datum Surface.dwg file.
 3. Right click on the Crossover Top Grading Group in the Toolspace - Prospector and select prop-

erties. On the Information Tab, uncheck Automatic Surface Creation. Confirm the deletion of 
the Crossover Top surface.

 4. Right click on the Crossover Top Grading Group in the Toolspace - Prospector and select 
Delete. Confirm the deletion of all Gradings.

 5. Create a new Site called SGSP - Setup
 6. Select the two Gore EOS feature lines and move them into the SGSP - Setup site.
 7. Rename the Crossover - Top Site properties, rename the site to Crossover - Datum
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 8. Delete the following feature lines from the Crossover - Datum site:
 o South Gore EOP - Top
 o North Gore EOP - Top
 o NB North End - Top
 o NB South End - Top
 o SB South End - Top
 o SB North End - Top

 9. Rename the remaining feature lines in the Crossover - Datum site with a Datum designation 
instead of Top.

 10. Create a new Grading Group in the SGSP - Setup site called SGSP Setup.  Do not turn on Auto-
matic Surface Creation.

 11. Open the Grading Creation Tools. Set the target surface to Crossover Setup - Datum. Use the 
same Grading Criteria that was used for the Crossover Top gradings.

 12. Create gradings on each of the Gore EOS feature lines.
 13. From the Toolspace - Settings tab, navigate to Gradings - Styles - Standard. Right click on 

standard and select Edit. On the Display tab, turn off all Plan view component visibility except 
for Daylight Line.

 14. Type EXPLODE at the command line. Select the two gradings. What will remain are two 3D 
polylines representing the crossover subgrade shoulder point.

 15. Data shortcut reference the Crossover Top surface. Give it a border only style.
 16. Select the Crossover Top surface and choose the Extract Objects command from the con-

textual ribbon. Click Ok. Turn the Crossover Top surface to the No Display style.
 17. Using the Trim command, trim the ends of the subgrade shoulder point 3d polyline against 

the Crossover Top surface boundary 3d polyline. The Crossover Top surface boundary 3d 
polyline can then be deleted.

 18. Use the Create Feature Lines from Objects command to convert the SGSP polylines to feature 
lines. Give them appropriate names like SGSP south and SGSP north. Do not assign a style. 
Place them on the P_RDWY_Subg_ShldPt layer. Erase existing entities, Assign Elevations from 
the Crossover Setup Datum surface. Do not weed points. These feature lines belong in the 
Crossover - Datum site.

 19. Create a feature line at each end of the subgrade shoulder point feature lines to a point per-
pendicular to the NB EOP and SB EOP feature lines. Similar to step 7 in the Create Crossover 
Top Surface segment.
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 20. Grip edit the NB EOP and SB EOP feature lines ends to match the feature lines created in step 
19. 

 21. Grip edit the Inverted Crown feature line to snap to the subgrade shoulder point feature line.

 22. From the Modify tab, select the Elevations from Surface command from the Edit Elevations 
panel. Choose the Crossover Setup - Datum surface and check Insert intermediate grade 
break points. Select all of the feature lines except the Gore EOS - Top feature lines.

 23. Create a new grading group in the Crossover - Datum site called Crossover - Datum - Infills. 
Turn on Automatic Surface Creation. Check Use the Group Name, give it a No Display style, 
and set the Tessellation spacing to 5'.

 24. Open the Grading Creation Tools. Place infills for the two areas enclosed by the SGSP feature 
lines, NB & SB EOP feature lines, and Inverted Crown feature line.

 25. From the Modify tab - Edit Geometry Panel, select the Stepped Offset command. Set the off-
set distance to 0.01'. Select the NB EOP and SB EOP feature lines. The elevation does not mat-
ter yet.

 26. Rename the feature lines created in step 25 to NB Exist and SB Exist.
 27. Use the Elevations from Surface command to assign elevations to the NB Exist and SB Exist 

feature lines from the Exist surface.
 28. Create a new surface called Crossover - Datum. Give it the P Triangles-Datum display style.
 29. In Toolspace - Prospector, right click on the Crossover - Datum surface and choose Select. 

Click Edit Surface from the contextual ribbon and choose paste surface. Paste the Crossover - 
Top surface. 

 30. Click Edit Surface again and choose paste surface. Now paste the Crossover - Datum - Infills 
surface.

 31. Right click - Display order - Send to Back
 32. Select the NB Exist and SB Exist feature lines and click Add to Surface as Breakline command 

from the contextual ribbon. Choose the Crossover - Datum surface. Under Supplemental 
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factors, check Distance and change it to 5'. Accept the other defaults in the breakline type dia-
logue box.

 33. Create a closed polyline that will act as a hide boundary to trim out the triangle outside of the 
NB South EOP, NB North EOP, SB South EOP, and SB North EOP feature lines created in step 
19. Create a second closed polyline for the other side of the crossover

 34. Expand the Crossover - Datum surface in the Toolspace Prospector. Expand Definition. Right 
click on Boundaries and select Add Boundaries. Change the type to Hide and make sure Non-
destructive Breakline is checked. Click Ok and select the two closed polylines from step 31.

 35. The Crossover Datum surface should now be complete. Inspect the surface for abnormalities 
and make any surface edits as needed.

 36. Save the drawing and create a data shortcut for the Crossover Datum surface.

Maintenance crossovers
Last updated: 2016-05-13

Exercise files: crdr-ele-mntnc-crssovr-data-C3D16.zip

Exercise files: crdr-ele-mntnc-crssovr-finished-data-C3D16.zip

Maintenance Crossovers
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 1. Create the setup corridor for the top surface using the Setup-MntCrossover-Top assembly.  
NB or EB baseline alignment. Target the alignment on the other side of the divided roadway 
with the LinkOffsetOnSurface subassembly. Profiles are either existing surface or proposed.

 2. Use the MntCrossover-Slopes assembly along the crossover centerline to create the daylight 
slopes using the following targets for the subassemblies:

 3. Create surface profiles from the setup corridor surface for the edge of gravel shoulders and 
centerline of crossover

 4. Use the MntCrossover-Tracer assemblies (left and right version depending on alignment dir-
ection) along the edge of gravel shoulder alignment/setup surface profile.

 5. Use the MntCrossover-Tracer assemblies (left and right version depending on alignment dir-
ection) along the main roadway edge or pavement alignment.  For existing condition use exist-
ing surface profile.  For new construction, used proposed profile.

 6. Create corridor surfaces.

 7. Create corridor boundaries.
 o Top follows Crown along NB and SB and ETW along the shoulders
 o Datum follows Crown_Sub along NB and SB and Daylight along slopes
 o Base follows Crown_Pave1 along NB and SB and ETW_Pave1 along shoulders

 8. Paste Crdr-Datum into Rfnt-Datum
 o Add breaklines for TIN edge swaps

 9. Paste Rfnt-Datum into Rfnt-Top
 o Add breaklines for TIN edge swaps

 10. Paste Crdr-Base into Rfnt-Base
 o Add breaklines for TIN edge swaps
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Urban design

Urban design - centerline profile setup

Last updated: 2020-10-26

Total video time: 31:41

Exercise files: urbn-dsn-cntrln-prfl-setup-data-C3D14.zip

Assembly

urbn-dsn-cntrln-prfl-setup-01.mp4 7:17

Urban design requires particular attention to impacts on adjacent properties.  In this example, we will 
use a setup corridor to work from the outside (back of sidewalk) to the inside (roadway centerline).

The assembly consists of generic subassemblies that form the roadway cross section.  The baseline 
of the assembly falls at the outside edge of the sidewalk.  Then, it builds inward toward the roadway 
centerline along two paths that represent the acceptable extremes for cross sectional slopes.  The 
lower portion of the assembly, which represents the minimum roadway profile, includes a vertical 
link at the outside edge of the sidewalk.  The designer can decide the magnitude of this vertical link.  It 
represents an expected acceptable amount of cut slope behind the sidewalk to match into the adja-
cent property.

On the opposite side of the assembly baseline is a single LinkOffsetOnSurface subassembly.  This 
subassembly will target the existing terrain at an offset chosen by the designer.  Later on in the work-
flow, we will use the feature line created by this subassembly to provide information about existing 
drainage patterns.

Setup corridor

urbn-dsn-cntrln-prfl-setup-02.mp4 5:33
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 1. Create a existing ground surface profile along the outside sidewalk alignment(s).
 2. Create a new corridor.  Example name:  Setup-96-Centerline Profile

 A. Alignment = outside sidewalk
 B. Profile = Existing surface profile from step 1
 C. Assembly = Centerline Profile Setup
 D. Target surface = Exist

 3. Set corridor region limits to the limits.
 4. Set frequency to something large (say 10,000) and set "At profile geometry points" to yes
 5. Add another baseline/region for the opposite side of the roadway outside sidewalk alignment 

and existing surface profile.
 6. Create four corridor surfaces using the corresponding links.  Boundaries are not needed.

 A. Crdr-96-Setup-CenterlineProfile-MaxLt
 B. Crdr-96-Setup-CenterlineProfile-MinLt
 C. Crdr-96-Setup-CenterlineProfile-MaxRt
 D. Crdr-96-Setup-CenterlineProfile-MinRt

Setup surface profiles

urbn-dsn-cntrln-prfl-setup-03.mp4 7:12

 1. Create surface profiles for the centerline alignment on the four surfaces created in the pre-
vious section.

 2. Color code the surface profiles so the left side profiles are the same and the right side profiles 
are the same.

 3. Split the corridor regions to separate out intersection areas (approximate).  Once separated, 
delete the intersection regions.  Those gaps will appear in the surface profiles and indicate 
where the intersections are when creating the proposed centerline profile.  Note:  The max tri-
angle distance for the surfaces may need to be reduced to for the gaps in the surfaces.

 4. If there is superelevation on the project, label the centerline alignment with the begin/end 
normal crown locations and the reverse crown locations.  Split the corridor regions on the low 
side of the superelevation at the reverse crown locations.  Split the corridor regions on the 
high side of the superelevation at the begin/end normal crown locations.  The regions 
between the reverse crown locations (low side) and between the norm crown locations (high 
side) can be deleted.  These areas will not be represented correctly by the setup corridor.

Slope patterns

urbn-dsn-cntrln-prfl-setup-04.mp4 4:51

The slope patterns feature of the corridor can be a useful design aid for determining existing drain-
age patterns.  In this workflow, we will use the slope pattern feature to determine if the existing ter-
rain is sloped toward the roadway or away from the roadway at any given location.

Page: 1179

Published on: 5/17/2023

Urban design

https://c3dkb.dot.wi.gov/video/rdwy-dsn/crdr-ele/urbn-dsn-ele/urbn-dsn-cntrln-prfl-setup-03.mp4
https://c3dkb.dot.wi.gov/video/rdwy-dsn/crdr-ele/urbn-dsn-ele/urbn-dsn-cntrln-prfl-setup-04.mp4


 1. Select the centerline profile setup corridor.  
 A. Corridor contextual ribbon > Modify Corridor > Slope Patterns

 I. Add slope pattern
 II. Choose the Sdwk-Out-Max feature line.  This is the upper feature line located at 

the outside of the sidewalk (corridor region baseline)
 III. Choose the test feature line.  This is the feature line created by the LinkOff-

setOnSurface subassembly.  The offset for this subassembly can be chosen by 
the designer to get a good representation of the existing terrain.

The resulting tic marks will indicated whether the terrain is sloping toward the road or away from the 
road.

Info: The WisDOT template does not contain custom slope pattern styles.  The designer can 
modify the styles to fit their preference.

Proposed centerline profile

urbn-dsn-cntrln-prfl-setup-05.mp4 6:48

Using the information gathered from the centerline profile setup corridor, the proposed centerline 
profile can be developed.  A quick way to develop the profile is to establish the tangents first using 
the profile layout tools.  Once the tangents are placed, they can be joined using the ‘solve tangent 
intersection' option under the tangents menu  in the profile layout tools.  Then place free curves to fit 
the constraints.

Tip: It is helpful to create two viewports (one plan, one profile).  Then turn on the station 
tracker, so the slope patterns can be observed while developing the proposed profile.

Info: Do not forget to assign each PVI  the correct K-table category using the ‘select PVI' tools in 
the profile layout tools.

Urban design - small intersections

Last updated: 2020-10-26

Total video time: 35:07

Exercise files: urbn-dsn-sml-int-data-C3D14.zip

Edge of Travel Way (ETW) setup corridor

urbn-dsn-sml-int-01.mp4 6:52

This video is review of the ETW setup corridor workflow covered in other training modules.

Page: 1180

Published on: 5/17/2023

Urban design

https://c3dkb.dot.wi.gov/video/rdwy-dsn/crdr-ele/urbn-dsn-ele/urbn-dsn-cntrln-prfl-setup-05.mp4
https://c3dkb.dot.wi.gov/data/rdwy-dsn/crdr-ele/urbn-dsn-ele/urbn-dsn-sml-int-data-C3D14.zip
https://c3dkb.dot.wi.gov/video/rdwy-dsn/crdr-ele/urbn-dsn-ele/urbn-dsn-sml-int-01.mp4


 l We recommend creating this corridor in the alignment/profile drawing.  This keeps the data 
flowing in a single direction and helps avoid circular references.  The surface from this setup 
corridor can be data referenced in any corridor drawing where it is needed.

 l Split the corridor into regions that only cover the intersection areas to save on drawing per-
formance and processing time.

 l Get one region setup up and then use the match parameters command from the corridor 
contextual menu to copy the targets and frequency settings to the remaining regions.

 l Be sure to add a special frequency where the side road centerline alignment crosses the main 
road edge of travel way alignment.

 l Once the intersection geometry is established later on, be sure to add a special frequency at 
the ends of the curb return radii.  The regions can also be shortened at that time.

Side road profile

urbn-dsn-sml-int-02.mp4 6:34

This video is review of the side road profile workflow covered in other training modules but contains 
some slight adaptations to this scenario.

 1. Open the proposed roadway corridor file
 2. Data Shortcuts > Surfaces > Right-click on the ETW setup corridor surface > Create 

Reference
 3. Create a profile view for the side road alignment

 A. Create an existing surface profile for the side road alignment
 B. Create an arbitrary proposed profile for the side road alignment.  

 I. Snap two PVIs on the profile view that are outside each end of the alignment 
limits.

 4. Add an intersection object where the side road centerline meets the main road centerline.  
 A. Lock the side road proposed profile (priority 2) to the main road proposed profile (pri-

ority 1).  
 B. Remember to uncheck the Create or specify offset alignments box before creating 

the intersection.
 5. Create a surface profile for the main road edge of travel way alignment on the ETW setup cor-

ridor surface.
 6. Repeat step 5 at the intersection of the main road edge of travel way and the side road center-

line.  The main road edge of travel way is priority 1.
 7. Use the profile layout tools to delete the tangent adjacent the main road centerline location.

Tip: Locate the station in plan view where the side road profile should match into existing (con-
struction limits).  Use an AutoCAD point to mark this location.  You may need to use the 
DDPTYPE or PDMODE command to change the point style and size so it is visible.  The project 
the point to the side road profile view using the existing surface profile as elevation.  The pro-
posed profile can then snap to that location.

Intersection geometry
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urbn-dsn-sml-int-03.mp4 6:34

For small intersections that match in quickly, there is no need for additional offset alignment based 
on the side road alignment.  Instead, just create the curb return alignment and extend the tangents 
down the side road to the construction limits station.  We recommend making the curb return align-
ments ‘Centerline" type because superelevation may be desired for these alignments during the curb 
ramp workflow.  Miscellaneous type alignment cannot contain superelevation data.

One method for creating curb return alignments using alignment layout tools:

 1. Use the AutoCAD offset command to offset the side road centerline alignment to the curb 
flange location (left and right).

 2. Alignment > Alignment Creation Tools > Tan-Tan (No Curves)*
 A.   Digitize the three PI locations that define the curb return alignment.

 I. A point on the main road curb and gutter flange alignment beyond the expec-
ted curb return location.

 II. The intersection of the main road curb gutter flange alignment and the polyline 
representing the side road curb and gutter flange (created in step 1)

 III. A point on the side road curb and gutter flange polyline (created in step 1) bey-
ond the expected curb return location.

 3. Add a free curve using the alignment layout tools to complete the curb radius.
* Make your curb return alignments clockwise in direction.

Tip: Instead of Tan-Tan (No Curves), Tan-Tan (with curves) can be used with the curb radius 
predefined.

Update ETW setup corridor

urbn-dsn-sml-int-04.mp4 3:04

Once the intersection geometry is created, a frequency needs to be added to the ETW setup corridor 
in the alignment/profile drawing.  To transfer these locations back the alignment/profile drawing, sev-
eral methods could be used.

 l Alt 1: Create AutoCAD points at the ends of the curb radii in the corridor dwg then copy and 
paste them into the alignment/profile dwg.

 l Alt 2: Temporarily xreference the corridor dwg into the alignment/profile dwg.  Be sure to 
detach the xreference when finished to avoid a circular reference.

 l Alt 3:  Temporarily data reference the curb return alignments into the alignment profile dwg.  
Be sure to remove the data reference when finished to avoid a circular reference.

Curb return profile setup

urbn-dsn-sml-int-05.mp4 6:40
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This video is review of the curb return profile workflow covered in other training modules, but con-
tains some slight adaptations to this scenario.  It also focuses on the use of the corridor contextual 
ribbon.

 1. Create an existing surface profile for the curb return alignments.
 2. Create the setup corridor.  Example name:  Setup-96-CGProfiles

 o Alignment = curb return
 o Profile = Curb return existing surface profile
 o Assembly = Setup-Curb-Prof
 o Target Surface = None

 3. The region limits should be where the curb radius meets the main road curb and gutter and 
where the curb return alignment ends along the side road (construction limits).

 4. Set frequency to 2.5 and add a special frequency station where the main road edge of travel 
way crosses the side road centerline.

 5. Target the main road edge of travel way alignment/surface profile and the side road center-
line alignment/proposed profile.

 6. Target the curb return alignment only.

Tip: For the adjacent curb return region, use the match parameters command to copy the fre-
quency and target parameters from the neighboring region.  Then, switch the target for the 
curb return alignment.

 7. Create the corridor sufaces for min, max, and norm cross slopes using the corresponding 
links.  No boundaries required.

Proposed curb return profiles

urbn-dsn-sml-int-06.mp4 5:23

This video is review of the side road profile workflow covered in other training modules but contains 
some slight adaptations to this scenario.

 1. We recommend turning the curb profile setup corridor feature lines to a no display style.  Also 
set the corridor code set style to no display.

 2. Create a profile view for each curb return alignment.
 3. Create surface profile for each of the setup corridor surfaces (min, max, norm).
 4. Create the proposed curb return profile.  Using the profile layout tools, pick two arbitrary PVIs 

(one on each end of the alignment limits).
 5. If not done already, create an surface profile on the ETW setup surface for the main road curb 

and gutter alignment.
 6. Create an intersection object at the intersection of the curb return alignment and the main 

road curb and gutter alignment.  Lock the curb return proposed profile (priority 2) to the main 
road curb and gutter profile (priority 1).  Remember to uncheck the "Create or specify offset 
alignments" box before creating the intersection.

 7. Use the profile layout tools to delete the profile tangent on the main road side.
 8. At the opposite end of the proposed curb return profile, snap the PVI to the construction lim-

its.  This will be the end of the existing surface profile.
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 9. Add additional geometry as needed to the proposed profile using the setup corridor surface 
profiles as a guide.  Remember profile requirements for curb ramps.

Urban design - curb slope control (curb cuts)

Last updated: 2020-10-26

Total video time: 19:32

Exercise files: urbn-dsn-crb-slp-cntrl-data-C3D14.zip

Assembly

urbn-dsn-crb-slp-cntrl-01.mp4 3:46

Opted to use generic LinkWidthAndSlope subassemblies to for the curb and gutter.  This opens the 
door for using the profile slope control workflow to create curb cuts.  There is a profile that will rep-
resent the gutter slope, curb face slope, and top of curb slope.  For driveway curb cuts, only the curb 
face profile will need modification.  For curb ramps, the gutter, curb face, and curb top will all need 
manipulation.

The base layers under the curb and gutter are also formed using the generic LinkWidthAndSlope sub-
assembly.  The slope of these subassemblies is determined through parameter reference of the adja-
cent lane slope.

Slope control profiles

urbn-dsn-crb-slp-cntrl-02.mp4 6:51

For more information on create profiles for profile slope control, see the profile slope control por-
tion of the Civil 3D training.

 1. Create a profile to represent the gutter slope, curb face slope, and curb top slope for each 
side of the roadway for a total of 6 profiles.

 A. Profile view elevation range will be -1 to 60.
 B. Curb face slope for a 6 inch curb head offset by 0.01 ft is 50 ft/ft.  
 C. Elevation for the profile is 50.
 D. Gutter face slope is -0.0625 ft/ft.  Elevation for the profile is -0.0625.
 E. Top of curb slope is 0.
 F. Elevation for the profile is 0.

Once the profiles are complete for one side of the roadway, trace them for the other side of the road-
way on the same profile views.  Then, create a new profile view for the other side of the roadway.  
Turn on only profiles that are applicable for the profile view.

Driveway aprons
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urbn-dsn-crb-slp-cntrl-03.mp4 6:54

Create a layer for driveway aprons.  One will be needed for the left side and the right side of the road-
way.  Draw the edges of the apron with polylines and include a polyline segment that goes down curb 
the length of the curb head transition.  There are various driveway apron details available.  Only one 
type of driveway apron is shown in this video.

Once one driveway is complete, the polylines can be copied to other driveways.

Slope control profile edits

urbn-dsn-crb-slp-cntrl-04.mp4 5:28

 1. Create AutoCAD point at the curb head transition locations
 2. Select all of the points on one side of the roadway and project them onto the respective pro-

file view.
 3. Set the elevation of the project points to follow the curb face profile.
 4. With the points projected, add PVIs to the curb face profile by using the node OSnap to snap 

to each of the projected points.
 5. Using the profile elevation tabular editor, set the curb face profile elevations at the driveway 

apron.  For example, a ¾-inch curb head lip for a driveway would be a profile elevation of 6.25 
(0.75/12/0.01).  The elevations should always be in pairs.  This makes it easy to quickly edit the 
elevations.
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Urban design - corridor building

Last updated: 2020-10-26

Total video time: 19:32

Create corridor

urbn-dsn-crdr-bldng-01.mp4 6:09

These videos are review of corridor creation.  It focuses on efficiency and the use of the corridor con-
textual ribbon.

 1. Apply the primary assembly to the entire project length
 2. Set the frequency according to FDM standards.
 3. Set the targets horizontal and vertical targets.  

 A. Do not forget the slope control profile targets for the curb and gutter and the drive-
way apron polylines.  

 B. Notice how frequencies automatically added at the driveway aprons.  They are added 
because the corridor is targeting the apron polylines

Main road regions

urbn-dsn-crdr-bldng-02.mp4 6:43

Corridor contextual ribbon commands

 l Split Region:  Split regions as the intersection curb returns.  If the curb return regions are not 
known yet, approximate the locations.  By starting with the single region and splitting it, tar-
gets do not have to be reset for each region.

 l Region Properties:  At an intersection region, use the region properties command from the 
corridor contextual ribbon.  Change out the assembly to one intended for the intersection 
region.  You may need to reset targets for this region.  Civil 3D will attempt to match the tar-
gets, but they need to be checked.  Change the frequency to the intersection standard (2.5 ft).

 l Match Parameters:  Use the match parameters command from the corridor contextual ribbon 
to copy the assembly, frequency, and targets to all similar intersections.

Side road regions

urbn-dsn-crdr-bldng-03.mp4 6:40

Corridor contextual ribbon commands

 l Add Baseline:  Quickly add a new baseline to the corridor. Add the curb returns and the side 
road centerline.
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 l Add Region:  Quickly add a new region to a baseline and sweep an assembly over a station 
range.

 l Set Targets: Jump directly to the add targets dialogue
 l Set Frequency:  Jump directly to the add frequency dialogue for a particular region.
 l Add Section:  Add a corridor frequency at a particular station.

Urban design - sidewalk and driveways

Last updated: 2020-10-26

Total video time: 26:34

Exercise files: urbn-dsn-sdwlk-dwy-data-C3D14.zip

Sidewalk setup assembly

urbn-dsn-sdwlk-dwy-01.mp4 3:09

The sidewalk setup assembly is used to form an acceptable envelop that the proposed sidewalk pro-
file can fall within.  This is similar to the process used to develop curb return profiles.  The assembly 
includes a slope range for the terrace and a slope range for an apron.

Requirement: Refer to WisDOT FDM SDDs 8d18 Driveway and Sidewalk Ramps Types X and Y 
and 8d19 Driveway and Sidewalk Ramps Type Z for current standards on minimum and max-
imum slopes for sidewalks and aprons.

Sidewalk setup corridor

urbn-dsn-sdwlk-dwy-02.mp4 5:20

 1. Create new corridor.  Example name:  Setup-96-SetupSdwkProf
 2. Run the region the length of the sidewalk.
 3. Set frequency according to the FDM standard
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 4. Set horizontal targets as needed.  Be sure to target the conditional subassembly to the drive-
way apron polylines to get automatic frequency creation at the driveways.

 5. Set the curb and gutter slope control profile targets.
 6. Create the following corridor surfaces

 o Crdr-Setup-Sdwk-Min
 o Crdr-Setup-Sdwk-Max
 o Crdr-Setup-Apron-Min
 o Crdr-Setup-Apron-Max

 7. Links can be used for these setup corridor surfaces.  Add the link (as breakline) that matches 
the corresponding surface.

Sidewalk profiles

urbn-dsn-sdwlk-dwy-03.mp4 6:42

 1. Create the following surface profiles for the inside sidewalk alignment. These surface profiles 
will act as a guide for the development of the proposed sidewalk profile.

 o Crdr-Setup-Sdwk-Min
 o Crdr-Setup-Sdwk-Max
 o Crdr-Setup-Apron-Min
 o Crdr-Setup-Apron-Max

 2. Create a surface profile for the inside sidewalk alignment on the existing surface.  Use the 
sample offset option to create the profile at the outside edge of the sidewalk.

 3. The apron surface profiles are only valid at the driveway locations.  The driveway locations are 
easily visible based on the sudden drops in the profiles.

 4. The existing ground surface profile is an indicator for where the proposed sidewalk profile 
should fall.  For example.  If the existing ground is higher than the range, the profile should fol-
low closer to the upper end of the range.

 5. Use the profile layout tools to develop a proposed sidewalk profile.  Add transitions into and 
out of the driveway locations that meet ADA requirements.

Target sidewalk profiles

urbn-dsn-sdwlk-dwy-04.mp4 6:25

 1. Target the sidewalk profiles with the proposed corridor.
 2. To add corridor frequencies at each of the sidewalk PVIs, there are two methods.

 o Label the PVI locations on the alignment and add corridor frequencies manually.
 o Create a dynamically linked feature line from the sidewalk alignment and proposed 

profile.
 3. Targeting a dynamically linked feature line will likely be preferred in most cases.  The only 

draw-back is the possibility of adding additional frequencies that are not needed.
 4. Create a feature line from Alignment.  Name the feature line logically, such as Sdwk-L.  Style 

does not matter.  Weeding is not necessary.  Set the mid-ordinate distance to 0.5.  Make sure 
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the box is checked to create a dynamically linked feature line.  
 A. OK

 5. Target the dynamically linked feature line with the same subassembly used to created cor-
ridor frequencies at the curb head transitions.  We called the subassembly TARGET-L-
DwyPLines and TARGET-R-DwyPLines.

Driveway slopes

urbn-dsn-sdwlk-dwy-05.mp4 4:58

 1. Target the proposed sidewalk profiles with the proposed corridor.
 2. Create a new layer for polylines that represent driveway match locations (saw cuts).  Create a 

layer for the left side of the roadway and the right side of the roadway.
 3. Draw a polyline connecting the two apron polylines at the back of sidewalk.  This will be the 

driveway match polyline.
 4. Draw a polyline from the midpoint of the driveway match polyline  perpendicular to the road-

way centerline.
 5. Extend this polyline down the driveway well past the anticipated match location.
 6. Now, the driveway match polyline can be moved along that perpendicular polyline to quick-

line adjust the match location using the polyline's
 7. Target the driveway match polylines with the roadway corridor (ByLayer).

Urban design - surfaces

Last updated: 2020-10-26

Total video time: 19:57

Exercise files: urbn-dsn-srfc-data-C3D14.zip
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Surface progression

urbn-dsn-srfc-01.mp4 5:51

There are two methods for creating the refinement surfaces.  The conventional method is what is 
thoroughly documented in the WisDOT Civil 3D training curriculum.  We are going to utilize an altern-
ative surface progression for our urban project.  The purpose of the alternative progression is to 
make surface refinements around the driveway aprons simpler.

Conventional surface progression

The conventional Crdr-Datum surface extends to the slope intercept.  The conventional Crdr-Top sur-
face extends only to a point roughly 2 ft behind the back of curb and gutter (typically the ETW_
Datum_CG feature line).  Since the driveway aprons span the ETW_Datum_CG feature line, any refine-
ments made to them would need to happen in both the Rfnt-Datum and Rfnt-Top surfaces.

Alternative surface progression

In the alternative progression, the Crdr-Datum surface only extends to the edge of the roadway sub-
grade (typically 2 ft outside the back of curb and gutter).  The Crdr-Top surface extends to the slope 
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intercepts.  This makes it possible to refine the driveway aprons in the Rfnt-Top surface alone.  These 
refinements then automatically appear in the Rfnt-Datum surface.

Typical top surface refinements

urbn-dsn-srfc-02.mp4 4:46

urbn-dsn-srfc-03.mp4 4:34

In most cases some surface refinements will be needed for the urban driveways in the Rfnt-Top sur-
face.  This will require the addition of some breaklines and the deletion of some surface points.

Determine driveway breakline needs

This surface refinement workflow is based on a particular driveway construction detail.  The workflow 
could vary slightly for other variations of driveway design.
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The purpose of Steps 6 and 7 may not be apparent, but they are necessary.  These steps are import-
ant for the Refinement-Datum Surface and for the breakline extraction process.

Datum surface refinement

urbn-dsn-srfc-04.mp4 4:46

The Refinement-Datum surface becomes simpler due to the work done with the Refinement-Top sur-
face.  To create the Refinment-Datum Surface, first past the Refinement-Top surface into the surface 
definition.  Then, past the Corridor-Datum surface into the surface definition.  A clean break should 
appear along the ETW_Datum-CG feature line location.
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Pipe networks
Pipe network overview
Last updated: 2014-03-10

Total video time: 07:14

What is a Pipe Network Parts Catalog

pipe-ntwrk-ovrvw-01.mp4 4:23

Info: 
The Pipe Network Parts Catalog is comprised of two sub part catalogs, Pipe and Structure. 
The parts catalog enables the pipe network parts lists in a drawing to access content for pipe 
and structure shapes and configuration parameters. Each Parts List in the WisDOT14-
pipe.dwt template references WisDOT pipe and structure parts in the USWIPipesCatalog.

There is no longer a wisdotXX-pipe.dwt. All pipe functionality has been added to the base 
template wisdotXX.dwt.

WisDOT Pipe Network Parts Catalog settings
 l To create and edit Pipe Network objects in any drawing created from wisdotXX.dwt, wis-

dotXX-etopog.dwt, or wisdotXX-plat.dwt the current Parts Catalog folder must be set to: 
C:\\ProjectID\Design\Corridors\Crdr-25.dwg

 l The Pipe catalog must be set to Pipes_USWI Catalog.

 l The Structures catalog must be set to Structures_USWI Catalog.

 l On WisDOT workstations, these settings will be checked and reset automatically each time 
the Civil 3D 2014 application is started, so there shouldn't be any need to set the catalogs 
manually.

Info: Note: External users that are using the catalogs provided from the WisDOT FTP site 
should refer to the document provided with the exe package "WisDOT Civil 3D Startup Cus-
tomization.pdf". This document covers the Pipe Network Parts Catalog setup and paths.

How the Pipe Network Parts Catalog affects your drawing

Info: Parts Catalogs' data links are independent of the drawings. The current Catalog is set by 
the application through the user profile settings. Unlike Data Shortcuts, there is no way to 
attach a drawing to a Catalog. The Parts Catalog and the drawing remain independent, which 
means the drawing will only access the active parts catalog. 

Warning: This also means that there should only be one Parts Catalog per drawing.     
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Tip: IMPORTANT: Everyone editing a drawing that has Pipe Network parts created from the 
Parts Lists in the wisdot14- pipe.dwt, template must have Pipes_USWI Catalog set as the active 
Pipe catalog and Structures_USWI Catalog set as the active Structure catalog PRIOR to opening 
or creating a data reference of the drawing. 

A pipe or structure is created by selecting a part from the Storm Sewer, Culvert Pipes, Non-Standard, 
or Full Catalog Part Lists and then selecting the insertion location in the drawing.

● Storm Sewer = WisDOT storm sewer parts

● Culverts = WisDOT culvert parts

● Non-Standard = WisDOT non-standard parts.

● Full Catalog = an empty parts list to prevent the usage of the CreateNetworkPartsListFull command

Requirement: When making any design edits to the pipe network, the pipe and structure 
objects need to be able to access the part list that was used when they were created and this 
part list in turn needs to be able to access the parts catalog that the parts list references, as 
well as the pay items and rules assigned the parts. This data relationship must be maintained 
in every pipe network drawing to ensure down stream workflows and dynamic capabilities 
stay intact.

Warning: Drawings should not be created without using the USWI Pipes Catalog

The use of the USWI catalog is part of the deliverable requirement. A copy of the Out-of-the-box cata-
log has been incorporated into the USWI catalog. This will not address any customization that may 
have been done to the OOTB catalog.

Starting a new Pipe Network drawing

pipe-ntwrk-ovrvw-02.mp4 1:21

Info: To create a new pipe network drawing, start the new drawing using the wisdot14-
pipe.dwt template. This is the only template that contains the WisDOT parts lists. This template 
only contains the styles, labels, rules, and setting necessary for designing a pipe network. If 
additional styles are desired, they can be imported using the style importer tool. However, if 
the style import tool is used, be sure that the "Import Settings" box is NOT checked

Requirement: Any drawings that utilize the pipe network (such as for plans production) 
should be created using the wisdot-14.dwt template. Before the pipe network is data ref-
erence, the pipe network reference alignment(s) and surface(s) must be data referenced. The 
pipe network can then be data referenced into that drawing. The pipe network will retain the 
assigned styles and labels from the source drawing unless they are overridden in the data ref-
erence dialogue box. Styles and labels may also be reassigned any time after the pipe network 
is data referenced. 
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Creating and managing parts for the WisDOT Catalog

pipe-ntwrk-ovrvw-03.mp4 1:30

Info: In WisDOT's multi-user work environment it is easy to create unwanted changes in draw-
ings if your parts catalogs do not have consistent contents. Because each drawing references 
the parts catalog at the local location unwanted changes in the drawing can occur if a new part 
is created in the catalog of one computer, and then the drawing is opened on a different com-
puter, where a new part is not part of the local catalog. WisDOT has addressed this issue by 
creating a custom Parts Catalog to be used on WisDOT projects and defined a default location 
on the local drive to store the catalog.

WisDOT internal procedure

Info: If a new part is needed or an existing part needs modifications contact Methods Devel-
opment and they will work with you to create the part needed and will update and distribute 
the catalog to all users. At no time should new parts be added to the USWI_Pipe Catalog or the 
USWI_Structure catalog by the user. Any part that is added locally to theses catalogs may be 
overwritten by the synchronization process described above.

Requirement: Consultants should contact WisDOT Methods Development team, to coordin-
ate updates and change requests of the USWI Parts Catalogs to maintain usability and con-
sistency.

Introduction to pipe networks
Last updated: 2014-09-23

Total video time: 10:38

WisDOT Pipe Network Parts Catalog settings

Warning: 
There is no longer a wisdotXX-pipe.dwt. All pipe functionality has been added to the base 
template wisdotXX.dwt.

pipe-ntwrk-intro-01.mp4 10:38

What pipe networks do and don't do

Do not

 l Perform hydrology or hydraulic analysis
Do

 l Provide an initial layout of the storm sewer system
 l Provide feedback on geometric feasibility of the system.
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 l Automate plans production
 l Provide limited clash detection functionality.

The templates

 l 2014-16 Configuration
 o The wisdot2016-14-pipe.dwt should be used for the creation of all pipe networks.
 o The wisdot2016-14.dwt should be used for all pipe network plans production via data 

reference.
 o The pipe network style names are the same in both templates. However, the styles in 

wisdot2016-14-pipe.dwt styles display the model and the wisdot2016-14.dwt styles 
display for plans production.

 l Civil 3D 2016 and 2018
 o the wisdot##.dwt contains all the necessary parts lists and styles used in both design 

and production.
Creating the pipe network

In most cases, it is best to put the entire storm sewer system into a single pipe network. 
.

Reasons for a single network

 l Easier data extraction for misc quantities tables
 l Easier data transfer to hydrology/hydraulics software such as Storm 

and Sanitary Analysis (SSA) or Hydraflow.
There may be reasons to separate the network, perhaps so multiple 
designers can work on it. If so, try to separate the network where they do 
not connect (each side of a high point for example)

When you create a pipe network, you will be asked to specify a reference surface. This is important 
because structures reference the surface to obtain its rim elevation. Pipes reference the surface to 
determine cover.

The catch is that pipes should reference the datum surface and structures should reference the top 
surface. For a storm sewer pipe network it is a best practice to start by layout out all of your struc-
tures. Therefore, choose the top surface when initially creating the pipe network. Once all of the 
structures are in place, change the pipe network reference surface to datum and begin placing the 
pipes.

Understanding Rules

Rules are the basis for the pipe networks' logic during initial layout

Account for:

 l Pipe slope
 l Pipe cover
 l Max pipe length
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 l Crown matching at structures
 l Structure sump depth 
 l Max pipe size for structure

Rules make provide an initial layout for the system based on geometrics, not hydraulics

Once initial layout is complete, rules function as a "design advisor" by informing you of 
issues. (for example: cover is too low at a given location) The catch is that you need to 
check the rules.

Rules can be re-applied at any time, but beware. They may change your design. I recommend using 
rules for initial layout. Then, you take control of the design and use the rules for feedback on feas-
ibility.

Placing a culvert pipe
Last updated: 2021-02-09

Total video time: 53:32

Warning: A known issue has been identified related to Wisconsin county coordinate pro-
jections. Please make sure to use to only use projections beginning with "WisDOT NAD83/". 
Please review "Wisconsin coordinate projection issue - XML/SDB" on page 116 for more inform-
ation.

Pipe datum surface creation

Exercise files: pipe-ntwrk-plac-clvrt-01-data-C3D14.zip

pipe-ntwrk-plac-clvrt-01.mp4 5:39

 1. Open the corridor drawing.
 2. Create a proposed datum surface that extends to the subgrade shoulder points named Crdr-

{Roadway Name}-PipeDatum. 

Info: This surface will be used to check for the appropriate amount of cover over the pipe. 

 3. Save the drawing.
 4. Create a data shortcut for the surface.

Create combined surface

pipe-ntwrk-plac-clvrt-02.mp4 6:06

 1. Click New .
 2. Select the wisdot14.dwt template file. 
 3. Select the Save As command.
 4. Save the file 12345678\Design\Surface\Surf-Cmbn-Ex-Top.dwg. 
 5. In the Toolspace > Settings tab 
 6. Right-click the name of the file (at the top).
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 7. Choose Edit Drawing Settings. 
 8. In the Units and Zone tab:

 o Set the coordinate zone category to USA, Wisconsin.
 o Set the coordinate zone to Wisconsin County Systems: Barron County, US Foot. 
 o Click Ok.

 9. Data shortcut reference the Exist ground surface.
 10. Data shortcut reference the Rfnt-Top surface.
 11. Create a new surface called Cmbn-Ex-Top
 12. Toolspace > Prospector tabright-click on Cmbn-Ex-Top and choose select.
 13. From the Context ribbon > Modify panel > Paster surface .
 14. Repeat the previous step, but now choose the Rfnt-Top surface  

Tip: *Note: If the area of the existing surface does not cover the entire drainage basin for cul-
vert, a DEM surface can be loaded into the drawing. The DEM surface would be pasted into the 
Composite surface before the Exist and Refinement-Top surfaces. Refer to 050-190-001 for cre-
ating a surface from a USGS DEM. 

Create pipe network drawing

Exercise files: pipe-ntwrk-plac-clvrt-02-data-C3D14.zip

pipe-ntwrk-plac-clvrt-03.mp4 10:55 (video used in the following 3 sections)

Warning: 
There is no longer a wisdotXX-pipe.dwt. All pipe functionality has been added to the base 
template wisdotXX.dwt.

 1. Click New 
 2. Select the wisdot14-pipe.dwt template file. 
 3. Select the Save As command.
 4. Save the file 12345678\Design\PipeNetworks\Pipe-Culverts.dwg. 
 5. In the Toolspace > Settings tab 
 6. Right-click the name of the file (at the top).
 7. Choose Edit Drawing Settings. 
 8. In the Units and Zone tab:

 o Set the coordinate zone category to USA, Wisconsin.
 o Set the coordinate zone to Wisconsin County Systems: Barron County, US Foot. 
 o Click Ok

 9. Data shortcut reference all of the project roadway reference alignments.
 10. Data shortcut reference the Cmbn-Ex-Top surface.
 11. Data shortcut reference the Crdr-PipeDatum surface.

Determine culvert pipe alignment
Utilize contour styles for surfaces to determine natural channel alignment.

Page: 1200

Published on: 5/17/2023

Create pipe network drawing

https://c3dkb.dot.wi.gov/data/pipe-ntwrk/pipe-ntwrk-plac-clvrt-02-data-C3D14.zip
https://c3dkb.dot.wi.gov/video/pipe-ntwrk/pipe-ntwrk-plac-clvrt-03.mp4


 1. Home tab > Create Design panel > Feature Line > Create Feature Line 
 2. All defaults may be accepted in the Create Feature Lines dialogue box. 
 3. Click Ok
 4. Digitize first point for defining the channel/pipe alignment. 
 5. Click Enter 

Tip: Elevation will be assigned at a later step. You can also set the elevation from the Cmbn-Ex-
Top if you choose.

 6. Digitize the second point defining the channel/pipe alignment. 
 7. Click Enter 
 8. Click Enter 

Drape the feature line over the Cmbn-Ex-Top surface
 1. Select the feature line. 
 2. Feature Line Context ribbon > Modify panel > Edit Elevations .
 3. Click Elevations from Surface  .
 4. Surface dialog > Set Elevations > pull-down menu choose  Cmbn-Ex-Top
 5. Make sure "Insert intermediate grade break points" is checked. 
 6. Click Ok.
 7. Select the feature line on the screen. 
 8. Click Enter 

Place metal culvert pipe #metal

pipe-ntwrk-plac-clvrt-04.mp4 13:13 (video used in the following 2 sections)

 1. Orbit to an isometric view. Display only what is necessary. Only the feature line is needed.
 2. Draw a line that will define the flowline of the pipe. Snap to the ditch lines or toes of slopes 

depending on your cross section.
 3. Use the MOVE command to move the line in the z direction by the distance of the pipe dia-

meter. 
 4. At this stage, estimate the required pipe size. 
 5. Base point = 0,0,0 Second point = 0,0,[diameter]
 6. Trim the line using the feature line as the cutting object. 

Tip: The line now defines the length of pipe along the crown.

 7. For concrete pipe, check the Apron Endwall SDDs and shorten each end of the line by the cor-
responding endwall "C" dimension. 

See Concrete pipe with concrete endwalls for concrete pipe.

 8. Use the MOVE command again to move the line in the z direction by the distance of the pipe 
radius. Base point – 0,0,0 Second point = 0,0,[-radius] 

Tip: The line now defines the length of pipe along the centerline.

 9. Home tab > Pipe Netowrk > Pipe Network Creation Tools 
 10. Name the pipe network Culverts-25yr.
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 11. Select the Culverts Parts List.
 12. Select the Crdr-PipeDatum surface.
 13. Select the roadway alignment.
 14. Structure and Pipe label styles can be set to <none>.
 15. From the Network Layout Tools menu, Pipes pull-downchoose the pipe size and type.
 16. Choose the corresponding apron endwalls from the structure pull-down box.
 17. Choose the Draw Pipes Only draw option. 
 18. Toggle the Upslope/Downslope button for the direction that you want to draw the pipe.
 19. Snap to the two ends of the line. 

 

Tip: The pipe may utilize rules to set its initial elevation. If this happens, use the grips at the 
ends of the pipe to snap it to the ends of the line.

Info: You will see the following error displayed in the panorama window. This error is normal. 
It simply means that the pipe rule could not located the Pipe Network surface at the ends of 
the pipe. This is because the Crdr- PipeDatum surface only extends out to the subgrade 
shoulder points Source: AeccDbNetworkRule::runDotNetScript  Description: Unable to run 
macro: C:\ProgramData\Autodesk\C3D 2014\enu  \C3DPipeNet-
workRules.dll:PipeNetworkRule.PipeCover::ApplyRule 

Attach the apron endwalls
 1. From the Network Layout Tools menu, select the Draw Structures only option. 
 2. Click on the two ends of the pipe to attach the endwalls.
 3. To rotate an endwall, select it and use the circular rotation grip and snap it to the feature line

Check culvert pipe properties

pipe-ntwrk-plac-clvrt-05.mp4 4:49 (video used in the following 3 sections)

Check Design Criteria 

 1. Select the pipe, right click, and choose Pipe Properties.

Tip: In the Rules tab, you can see what the minimum and maximum cover requirements are 
for the pipe. Compare those values with the actual values. Choose a different pipe type and/or 
configuration if these values are not met. Your roadway profile may also need adjustment.

Tip: Pipe slope, length, and elevation data can be found under the Part Properties tab.

 2. In the information tab, name the pipe it's station location for easy reference later on. 
 3. Name the apron endwalls the station location of the pipe with the suffix In or Out. 

Tip: For example: 100+00-In.
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Determine Pipe Wall Thickness (Metal Pipe Only) 

 1. View the pipe properties. 
 2. In the Rules tab, view the actual maximum and minimum fill height for the pipe. 
 3. Switch to the Part Properties tab and set the wall thickness according the fill height tables in 

the FDM. 

Info: This value has little effect on the layout of the pipe, but it can be used later on for report-
ing purposes.

Create Data Shortcuts for Pipe Networks 

 1. Save the drawing
 2. Create a data shortcut for the pipe network.

Concrete pipe with concrete endwalls #concrete

pipe-ntwrk-plac-clvrt-06.mp4 12:50 (video used in the following 2 sections)

 1. Same as for metal pipe except move the line defining the flowline up by the diameter plus the 
wall thickness.

Info: Wall thickness can be found on the Storm Sewer Summary.

 2. The line now represents the top of the concrete pipe. Trim the line against the feature line.
 3. If concrete endwalls are to be used, shorten the concrete pipe on each end by the ‘C' distance 

shown in the Apron Endwall Standard Detail Drawing.

Concrete pipe with metal sloped apron endwalls
 1. Same as for metal pipe above, except do not shorten the pipe by the ‘C' distance on each end.
 2. Attach the sloped apron endwalls.
 3. Rotate the endwalls to match the pipe direction.
 4. Select both endwalls. 
 5. Use the AutoCAD MOVE command to move the endwalls down by the pipe wall thickness.

Storm sewer layout using pipe networks
Last updated: 2020-10-26

Total video time: 117:22

Warning: A known issue has been identified related to Wisconsin county coordinate pro-
jections. Please make sure to use to only use projections beginning with "WisDOT NAD83/". 
Please review "Wisconsin coordinate projection issue - XML/SDB" on page 116 for more inform-
ation.

Exercise files: pipe-ntwrk-ss-lyout-data-C3D14.zip

Create storm sewer pipe network
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pipe-ntwrk-ss-lyout-01.mp4 8:44

Warning: 
There is no longer a wisdotXX-pipe.dwt. All pipe functionality has been added to the base 
template wisdotXX.dwt.

 1. Click New .
 2. Select the wisdot14-pipe.dwt template file. 
 3. Select the Save As command.
 4. Save the file 12345678\Design\PipeNetworks\Pipe-StormSewer.dwg.
 5. In the Toolspace > Settings tab 
 6. Right-click the name of the file (at the top).
 7. Choose Edit Drawing Settings. 

 o In the Units and Zone tab:
 n Set the coordinate zone category to USA, Wisconsin.
 n Set the coordinate zone to Wisconsin County Systems: Winnebago County, US 

Foot. 
 n Click Ok.

 8. In the Toolspace > Prospector tab > Data shortcut > Alignments > Centerlines
 o Reference all of the project roadway reference alignments. 
 o Tip: Although not required, it can also be useful to data reference the proposed 

profiles for these alignments.

Tip: If the network will span past the slope intercepts of the project, it is best to 
create a combination existing ground and top surface and a combination exist-
ing ground and datum surface.

 o Data shortcut reference the Cmbn-Exist-Top surface
 o Data shortcut reference the Cmbn-Exist-Datum surface
 o Data shortcut reference the Crdr-Commercial-PipeDatum surface

 9. XRef other files that may be needed for the storm sewer design. In this exercise we will xref 
the Pavt.dwg and StormSewer-Sketch.dwg files

 10. Home tab > Create Design panel > Pipe Network > Pipe Network Creation Tools 
 11. Name the pipe network Storm-Begin-To-4thAve
 12. Select the Storm Sewer Parts List
 13. Select the Cmbn-Exist-Top surface
 14. Select the main roadway alignment
 15. Structure and Pipe label styles can be set to <none>

Layout pipe network structures

pipe-ntwrk-ss-lyout-02.mp4 10:18

 1. From the Network Layout Tools, select Draw Structures Only
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Tip: Choose the desired structure type for placement. For efficiency, place all of the like struc-
ture first. Then, switch the structure type and place that type, etc. Refer to the Storm Sewer 
Summary to determine which diameter structures should be used based on your first guess at 
the adjoining pipe size. The structure sizes can be easily swapped later if a different pipe size is 
chosen.

Tip: Use the Station Offset transparent command for accurate structure placement. Refer to 
Storm Sewer Summary  in the  for assistance when determining structure offsets.

Layout pipe network structures – rotate and move

pipe-ntwrk-ss-lyout-03.mp4 3:18

 1. If needed, rotate the structure to the correct orientation using the circular grip. 

Tip: The station/offset transparent command is a handy tool rotating the structures.

 2. Use the square grip to move the structures. 

Tip: The station/offset command can be used in conjuction with the move. In this example, we 
move an inlet structure that drain surface low points. 

 3. Turn the top surface to a contour display style to located the low point and move the struc-
ture to that location.

Defer the placement of any outlets (apron endwalls) until later.

Layout pipe network pipes - laterals

pipe-ntwrk-ss-lyout-04.mp4 6:14

 1. Open a second viewport. 
 2. Set one viewport to top view (2D wireframe style)
 3. Set the other viewport to an isometric view (Shaded style). 

Tip: This will help you validate the pipe network layout.

 4. In the Network Layout Tools, select Draw Pipes Only
 5. Change the network surface to Rfnt-Datum.
 6. Place the pipe by connecting the structures. 
 7. Hover the crosshairs over a structure until the brown symbol appears. 
 8. Left-click to choose the structure. 
 9. Select the other structure to connect to. Start by placing the laterals. Then proceed to the 

trunk.

Tip: You may place the pipes from upstream to downstream or from downstream to 
upstream, but you must have the pipe slope direction toggled correctly in the Pipe Network 
Layout Tools. There are advantages to always placing the pipes from upstream to down-
stream, but it is not required. One advantage is that the pipe start will always be upstream. 
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This will make labeling the pipe inverts for storm sewer detail sheets easier later on. In addi-
tion, the pipe and structure rules are always calculated from upstream to downstream. So, pla-
cing the network in that direction allow the rules to work as intended.

Layout pipe network pipes – trunk

pipe-ntwrk-ss-lyout-05.mp4 4:49

Tip: Similar procedure as laterals. Best practice is to start from upstream and work in the 
downstream direction.

Pipes elevations are automatically calculated based on the slope and cover rules.

Renaming the pipe network parts

pipe-ntwrk-ss-lyout-06.mp4 6:33

Tip: To take advantage of the labeling functions for plans production, you must rename the 
pipe network parts. It also is important for keep things organized when doing the hydraulic 
analysis. Activating the quick properties makes renaming the parts go quickly.

 1. Modify tab > Create Design panel > Pipe Network > Reame Part 
 2. Select the first trunk line structure that you want to rename.
 3. Select the last trunk line structure that you want to rename.
 4. Keep Rename Structure checked, 
 5. Uncheck Rename Pipes. 
 6. Set the value of the first trunk line structure. The name template should be "next counter".
 7. Under Name Conflict Options, choose Rename Existing Parts. 
 8. Click Ok.

Proceed to the lateral structures. Use the quick properties to rename these structures.

When all of the structures have been renamed, use the quick properties to rename the pipes. The 
pipe names should follow this format: <UpstreamStructure>-<DownstreamStructure>.

Inspect the pipe network – crown matching

pipe-ntwrk-ss-lyout-07.mp4 11:45

Info: Generally, the pipes and structures should be placed to comply with the rules auto-
matically. There are some cases where this will not happen.

Tip: The wisdot-pipe.dwt includes a label called Design properties. It is recommended that 
you label each structure that has more than one connecting pipes. The label can help you 
verify that the outflow pipes have the lowest crown elevation.
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If you need to apply rules, go to the Modify tab > Design panel > Pipe Networks > Modify fly-out 
>  Apply Rules .

The way you select the parts to apply rules is very important. Here are the key points:

 1. Always start upstream.
 2. Do not select lateral parts and trunk parts together.
 3. If laterals and the trunk both need rules applied, start with laterals, and then move on to the 

trunk.
 4. If the outflow pipe crown does not have the lowest elevation for a particular structure, that 

can be adjusted in the structure properties. Go the structure properties – Connected Pipes 
tab. Select the outflow pipe and the pipe crown that it should match in the list and right click. 
Choose Match Crowns. Select the pipe crown to match and click ok. Alternatively, you can 
manually enter the elevations.

Inspect the pipe network – review rules

pipe-ntwrk-ss-lyout-08.mp4 6:57

Info: Some pipe and structure rules do not affect the network during layout, but they provide 
valuable feedback to the designer on potential issues.

 1. In the Toolspace > Prospector tab > Pipe network > Pipes or Structures

Tip: The first column shows each parts "status". If a rule flags a potential issue, that status will 
have a number in it indicating the number of issues.

Tip: The Length Check pipe rule does not control network geometry during layout. After lay-
out, if there is an issue, it will appear as an issue in the part status.

Tip: The Maximum Pipe Size Check structure rule does not control network geometry during 
layout. After layout, if there is an issue, it will appear in the part status. IMPORTANT: This rule 
is set up to indicated the true maximum pipe size for any given structure. The max pipe size 
for this rule is based on 180-degrees of pipe separation at the structure. Smaller degrees of 
separation may require a smaller pipe and/or a larger structure.

Tip: The status shown in the Toolspace Item View for the pipe network parts is not always 
accurate. If there is a potential problem, review the pipe and/or structure properties.

Inspect the pipe network – pipe separation at structures

pipe-ntwrk-ss-lyout-09.mp4 7:52

Warning: The Maximum Pipe Size Check structure rule is an aid to make sure the correct size 
structure is selected for a pipe run. However, that rule only applies for pipe with 180-degrees 
of separation.

Page: 1207

Published on: 5/17/2023

Inspect the pipe network – review rules

https://c3dkb.dot.wi.gov/video/pipe-ntwrk/pipe-ntwrk-ss-lyout-08.mp4
https://c3dkb.dot.wi.gov/video/pipe-ntwrk/pipe-ntwrk-ss-lyout-09.mp4


To check pipe connections at all angles at a structure, the Interference Check tool can be used. 

 1. At the command line, type CONVERTTO3DSOLIDS
 A. Select each pipe that is connected to the structure. Enter
 B. Choose No so the pipe network objects are not deleted

 2. At the command line, type SOLIDEDIT
 A. Choose Face
 B. Choose Offset
 C. Select one pipe -> Enter. For elliptical pipe, you need to select all four faces (2 large 

radii and 2 small radii)
 D. Type in the offset distance of 0.5
 E. Choose Offset again to repeat the previous steps on the next pipe
 F. When finished, hit Enter twice to completely exit the command.

 3. Switch the current layer to P_DRN_Interfere (for C3D 2016 and later, you will need to either 
import this layer or create it)

 4. At the command line, type INTERFERE
 A. Select each of the previously created pipe 3d solids
 B. Hit Enter twice
 C. On the Interference Checking Dialog box, uncheck Delete interference objects cre-

ated on Close
 D. Close

 5. Zoom to the structure in question in Top view. Set OSNAPZ to 1. Use the DISTANCE command 
to roughly measure from the center of the structure to the outside of the most exterior inter-
ference (shown in red). Multiply that value by 2. That is the minimum structure size for that 
location.

 6. Swap the structure for the required size.

Tip: The same interference check can be re-run at any time to check pipe separation at other 
structures within the network.

Pipe network rule overrides

pipe-ntwrk-ss-lyout-10.mp4 3:09

Tip: There may be situations where you may want to override a rule. For example, all of the 
pipes have a minimum slope rule of 0.3%. This is just a starting point. You may want steeper 
slopes for smaller pipe sizes or flatter slopes for larger pipe sizes.

 1. Go into the Part Properties > Rules tab 
 2. Uncheck the Use Values from Rules Set. button
 3. Set the rule as desired.

Tip: At this point, you can either adjust the pipe network geometry manually, or you may 
choose to re-run the rules.

Outlets – Compare system elevation to outfall elevation
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pipe-ntwrk-ss-lyout-11.mp4 8:04

Check the outfall ditch elevation. Compare that elevation to the invert elevation at the last structure. 
You may need to adjust the system elevation to match the ditch or match the ditch to the system.

In the training example, we look for opportunities to raise the system to match the ditch elevation. 
The system elevations are then adjusted manually in the part properties by checking the cover and 
slope values along the pipes.

Outlets – Place outlet pipe and endwall

pipe-ntwrk-ss-lyout-12.mp4 15:27

Info: Adding the outlet pipe is similar to the culvert pipe workflow.

 1. View the triangles for the Cmbn-Exist-Top surface.
 2. Draw a line representing the flow line of the outlet pipe. 

 o Snap to the bottom of the upstream pipe and to the surface triangles at the ditch loc-
ation.

 3. Turn the surface triangles off
 4. Set the elevation of the line at the upstream structure to the flow line elevation using ACAD 

properties.
 5. Create a feature line using the Feature Line From Objectcommand. Use the line pre-

viously created.
 6. Drape the feature line on the Cmbn-Exist-Top or Cmbn-Exist-Datum surface.
 7. Move the line up in the z-direction by the pipe diameter plus wall thickness.
 8. Trim the line against the feature line.
 9. Move the line down in the z-direction by half the pipe diameter plus the wall thickness.

 10. Shorten the line by the endwall ‘c' dimension.
 11. Network Layout Tools , change the reference surface to Crdr-PipeDatum
 12. Place the outlet pipe by snapping to the last structure and the end of the line.
 13. Verify the pipe elevations. 

Warning: The rules have overridden your intentions.

 14. Place the apron endwall on the end of the pipe and rotate appropriately.
 15. Rename the pipe and endwall.

Reconstructing and adjusting structures

pipe-ntwrk-ss-lyout-13.mp4 5:33

Tip: Existing storm sewer structures that will be either Reconstructed or Adjusted are placed in 
the pipe network like any other proposed structure. Choose the structure/cover combination 
from the parts list that matches the existing structure.

Page: 1209

Published on: 5/17/2023

Outlets – Place outlet pipe and endwall

https://c3dkb.dot.wi.gov/video/pipe-ntwrk/pipe-ntwrk-ss-lyout-11.mp4
https://c3dkb.dot.wi.gov/video/pipe-ntwrk/pipe-ntwrk-ss-lyout-12.mp4
https://c3dkb.dot.wi.gov/video/pipe-ntwrk/pipe-ntwrk-ss-lyout-13.mp4


 1. In the structure properties:
 o Change its display style to either Existing Inlet or Existing Manhole.
 o Assign the correct name (structure number)
 o Change the description to either "Reconstruct" or "Adjust"
 o Change the Rule Set to "No Rule"

 2. In Part Properties 
 o Set Control Sump By: to Elevation.
 o Set the sump elevation to the flowline elevation of the existing manhole.

 3. Open the Analysis tab > QTO panel > QTO Manager  . 
 4. Click the Edit Pay Items on Specified Object button. 
 5. Select the structure. 
 6. Remove the pay items that no longer apply. 
 7. Add the pay items for either adjusting or reconstructing.

Inlet surface elevation adjustment

pipe-ntwrk-ss-lyout-14.mp4 3:40

Tip: When structures are inserted, their rim elevation is coincident with the reference surface. 
For inlets that elevation will typically fall somewhere in the curb and gutter pan. For con-
sistency and reporting purposes, a Surface Adjustment Value should be assigned to the inlets 
so the rim elevation is correct for the cover flange.

Info: Refer to the Storm Sewer Summary to determine what the Surface Adjustment Value 
should be for each inlet cover type.

 1. In the Toolspace > Prospector tab , sort the structures, so the inlet types are grouped 
together. Then select like inlet types.

 2. In the AutoCAD properties window, the Surface Elevation Adjustment can be set for all of the 
like inlets at one time.

Miscellaneous structure properties

pipe-ntwrk-ss-lyout-15.mp4 2:36

Tip: All WisDOT inlet and manhole structures have been constructed as flat-top structures to 
account for the maximum size footprint. By doing this, the cone height parameter could be 
repurposed. For WisDOT structures, the cone height parameter is used for adjustment ring 
height. By default, this parameter is set to 6- inches in each structure's properties. However, 
depending on your project needs, this parameter can be set from 2" up to 10" in the struc-
tures' properties.
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Tip: For inlets, the default placement characteristic is "On Grade". For inlets that are in a sag 
situation, you must set them to "On Sag" in the structure properties. This is important when 
it's time to check the pipe network hydraulics.

Manhole variable tee and manhole variable special

pipe-ntwrk-ss-lyout-16.mp4 8:31

Tips: The Manhole Variable Tee and Manhole Variable Special structures are 
unique structures that require a slightly modified workflow.

Tip: When using these structures, start by placing the structures in the desired locations. The 
horizontal insertion point is the center of the lower portion of the structure where the pipes 
connect.

The structures default to a 48-inch pipe connection (the smallest size). 

 1. Select the structures in model space
 2. Right-click and choose Structure Properties
 3. Change the Structure Diameter (located at the bottom) to the pipe size desired. 

Tip: For the Manhole Variable Special, you also need to check the Floor Thickness value. For 
pipe sizes 48" – 84", the floor thickness is 13-inches. For pipe sizes greater than 84", the floor 
thickness is 15-inches. The Manhole Variable Tee floor thickness changes automatically accord-
ing to the pipe size.

 4. After placing the structures and setting their size parameter, connect them up with the pipes.

Tip: Once the pipes have been placed, the structures can then be rotated so they are correctly 
oriented with the pipe. The extension Osnap is useful for aligning the structures with the 
pipes.

Tip: Finally, since the manhole covers are offset from the center of the pipe, a Surface Adjust-
ment Value must be entered in the structure properties to the rim is coincident with the top 
surface. To calculate the Surface Adjustment Value, find the Cover Center Offset in the struc-
ture properties. Multiply this value by the cross slope from the center of pipe to the manhole 
cover. This is the Surface Adjustment Value.

Swap parts

pipe-ntwrk-ss-lyout-18.mp4 3:48

Tip: There are two methods for swapping parts. Civil 3D comes with a swap parts command 
that swaps one part at a time. WisDOT includes an additional tool that swaps multiple parts at 
one time.

 1. Select all of the parts that you want swapped to the same new part. 
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Tip: This can be done by picking them on the screen, selecting them, in the prospector win-
dow, or by using the AutoCAD quick select tool.

 2. Type swappartsEnter 
 3. In the dialogue, choose the parts list that contains the desired part.
 4. Choose the part family for pipes if pipes are being swapped, or structures if structures are 

being swapped.
 5. Choose the specific part to swap to in that part family.

Pipe network sump adjust
Last updated: 2020-10-26

Total video time: 03:20

Pipe network sump adjust

pipe-ntwrk-smp-adjst.mp4 03:20

Overview

Civil 3D does not account for the pipe wall thickness when connecting to a structure without a sump. 
It sets the structure sump elevation to the flow line elevation of the lowest pipe. The pipe wall then 
falls within the structure floor. This results in an incorrect structure depth calculation. It should be 
setting the structure sump elevation to the bottom of the pipe wall.   This image shows a typical detail 
for a structure with no sump.  Notice that the pipe wall does not penetrate the floor of the structure.
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Pipe networks work fine if there is a value for sump depth, such as for catch basins, because that 
elevation is set based on a set distance from the flow line of the lowest pipe.  The image below 
shows the problem in Civil 3D when the sump depth is 0.
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At this time, running this utility is optional.  The logic in the WisDOT storm sewer report auto-
matically accounts for this flaw and adjusts the reported structure depth automatically.  Whether or 
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not the Pipe Network Sump Adjust utility is run, the report will be correct.  The purpose of the Pipe 
Network Sump Adjust utility is to create a spatially accurate 3D pipe network, such as for clash 
detection. 

Using the Pipe Network Sump Adjust utility

WisDOT Civil 3D 2016 - Pipe Network Sump Adjust Dialog

Ribbon > WisDOT Design tab > Design Utilities panel > Pipe Network Sump Adjust

WisDOT Civil 3D 2018 - Pipe Network Sump Adjust Palette

Ribbon > WisDOT Design tab > Pipe Network Utilities panel > Pipe Network Sump Adjust
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 1. Select structures from All Structures or Pipe Network(s).
 2. Click Refresh All to see a current list of pipe networks available (if choosing that option).Note: 

"Refresh All" button available in Civil 3D 2018 only.
 3. Select Pipe Network(s) from list (if choosing that option).
 4. Click OK to adjust sump depths.

The utility can also be accessed from the command line: SUMPADJUST

Pipe Network - Swap Parts List Styles
Last updated: 2016-03-11

Total video time: 07:24

pipe-ntwrk-swp-prts-lst-styl-tl.mp4 07:24

Overview

Review of previous WisDOT workflow

In previous WisDOT Civil 3D standards files the user would create a pipe network using a pipe net-
work template.  Then, any plan production drawings would be created using a base template.  The 
templates were created separately to help keep drawing sizes manageable.  Pipe networks reference 
the parts list to assign styles when data referencing. The base template did not contain the parts lists 
to create the pipe networks, so the styles would be incorrect upon data referencing the pipe net-
work. The workflow required importing the pipe network parts list(s) from the source pipe network 
drawing prior to creating the data reference in the plan production drawing.

Current WisDOT workflow

The base  template and the pipe network template were combined to create a single  base design tem-
plate.  This was achievable after the base design template size was reduced by removing all unused 
AutoCAD components and making them available through the ribbons and palettes. The base design 
template now includes all of the parts lists, pipe styles, and structure styles necessary for both plan 
production and design scenarios.  There is no longer a need to import a parts list into a plan pro-
duction drawing created from this template before creating a pipe network data reference.  (Note: If 
a custom parts list was created for a pipe network, that parts list will still need to be imported into 
corresponding production drawing prior to creating a pipe network data reference.)  

In the WisDOT base design template, the assigned pipe and structure styles are set to plan pro-
duction styles.  This assures that all data references of the pipe network will appear with the correct 
plan-view style.  However, during the design process, it is typically desirable to view the pipes and 
structures as a 3D model in all views.  In a standard Civil 3D environment, this would normally 
require changing the assigned pipe styles and structure styles in the drawing manually after they are 
placed.  To avoid this additional work, WisDOT has created the Swap Parts List Styles utility.  This util-
ity is intended to only be used on pipe network source (design) drawings.  The utility changes the 
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styles of all the chosen parts to a "design" or "3D model" style.  If desired, it will also change the style 
for any previously placed pipes and structures.

Usage
WisDOT Design tab > Design panel> Pipe Network dropdown > Swap Parts List Styles

The tool can also be accessed from the command line:  SWAPPARTSTYLES.

 1. Select a Parts List.
 2. Select default styles for Pipe Style and Structure Style.
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 3. Swap Pipe Styles only or Swap Structure Styles only or Swap both styles.
 4. Select Do not update existing Pipes and Structures (parts list only) or All Pipes and Structures 

or Selected Pipe Network(s) only.
 5. Refresh All to see a current list of pipe networks available (if choosing that option).Note: 

"Refresh All" button available in Civil 3D 2018 only.
 6. Select Pipe Network(s) from list (if choosing that option).
 7. OK to update styles.

Pipe network tables
Last updated: 2022-08-30

Culverts
Culvert pipe quantity tables can be produced using the custom WisDOT Culvert and Storm Drain 
report. The tool combines QTO functionality with Pipe Network data.  It is intended to be used with 
pipe networks created with WisDOT custom parts.  Other parts may not produce the same result.

 1. Open Pipe-Culvert.dwg.
 2. If not already done, review each of the metal culvert pipes.

 A. Select pipe > Contextual ribbon > Modify panel > Pipe Properties > Rules tab to 
see how much cover the pipe has.

 B. Use FDM 13-1 Attachment 25 to determine the appropriate wall thickness for the cul-
vert pipe.

 C. Select pipe > Contextual ribbon > Modify panel > Pipe Properties > Part Prop-
erties tab > Part Data > Wall Thickness to set the wall thickness.

 3. WisDOT Tools tab > WisDOT Reports > Culvert and Storm Drain Report to run the cus-
tom report.

 A. Select the pipe network(s) to be included in the report or Select All to include all pipe 
networks in the file.

 B. Culvert Summary: checked
 C. Pay Item List: C:\ProgramData\Autodesk\C3D 2018\enu\Data\Pay Item Data\Un-

ited States\WisDOT\Items_20XX.csv
 D. Output Filename: (Project ID)\Design\PipeNetworks\xxx_Pipe Report.xlsx
 E. Create Report

 4. The report creates an Excel spreadsheet.
 A. The LOCATION column populates the alignment name that the pipe references.  Loca-

tion can quickly be changed using the Find/Replace functionality in Excel.  For example:  
Find: 25 and Replace with: STH 25

 B. If the culvert pipe lands completely on one side of the alignment and LT/RT designator 
will automatically be placed along with the station.

 C. The wall thickness that was chosen in Civil 3D will show up on the right side of the 
table.  These columns can be deleted if only concrete pipe is required.

 D. For the "Culvert Pipe" bid items, both the Aluminum Thickness and Steel Thickness 
columns will need to be filled in.

Page: 1218

Published on: 5/17/2023

Pipe network tables



 E. Fill in the number of joint ties required for concrete pipe.  This column can be deleted if 
only metal pipe is required.

Storm sewer
Storm Sewer quantity tables can be produced using the custom WisDOT Culvert and Storm Drain 
report. The tool combines QTO functionality with Pipe Network data. It is intended to be used with 
pipe networks created with WisDOT custom parts. Other parts may not produce the same result.

 1. Open Pipe-StormSewer.dwg.
 2. WisDOT Tools tab > WisDOT Reports > Culvert and Storm Drain Report to run the cus-

tom report. 
 A. Select the pipe network(s) to be included in the report or Select All to include all pipe 

networks in the file.
 B. Choose the Report Type: Storm Sewer Pipes, Storm Sewer Structures, or Both Storm 

Sewer Pipes and Structures
 C. Pay Item List: C:\ProgramData\Autodesk\C3D 20XX\enu\Data\Pay Item Data\Un-

ited States\WisDOT\Items_20XX.csv
 D. Output Filename: (Project ID)\Design\PipeNetworks\xxx_Pipe Report.xlsx
 E. Create Report

 3. The report creates an Excel spreadsheet. 
 A. The LOCATION column populates the alignment name that the pipe references.  Loca-

tion can quickly be changed using the Find/Replace functionality in Excel.  For example:  
Find: 25 and Replace with: STH 25

 B. In the Pipes Table, fill in the number of joint ties required for any concrete outfall loc-
ations.

Culvert pipe summary
Last updated: 2015-04-21

Culvert pipe summary

Name Rules
CP CLASS III 12-INCH Cover: 2-15 FT

CP CLASS III 15-INCH Cover: 2-15 FT

CP CLASS III 18-INCH Cover: 2-15 FT

CP CLASS III 21-INCH Cover: 2-15 FT

CP CLASS III 24-INCH Cover: 2-15 FT

CP CLASS III 30-INCH Cover: 2-15 FT

CP CLASS III 36-INCH Cover: 2-15 FT
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Name Rules
CP CLASS III 42-INCH Cover: 2-15 FT

CP CLASS III 48-INCH Cover: 2-15 FT

CP CLASS III 54-INCH Cover: 2-15 FT

CP CLASS III 60-INCH Cover: 2-15 FT

CP CLASS III 72-INCH Cover: 2-15 FT

CP CLASS III 84-INCH Cover: 2-15 FT

CP CLASS IV 12-INCH Cover: 1-25 FT

CP CLASS IV 15-INCH Cover: 1-25 FT

CP CLASS IV 18-INCH Cover: 1-25 FT

CP CLASS IV 21-INCH Cover: 1-25 FT

CP CLASS IV 24-INCH Cover: 1-25 FT

CP CLASS IV 30-INCH Cover: 1-25 FT

CP CLASS IV 36-INCH Cover: 1-25 FT

CP CLASS IV 42-INCH Cover: 1-25 FT

CP CLASS IV 48-INCH Cover: 1-25 FT

CP CLASS IV 54-INCH Cover: 1-25 FT

CP CLASS IV 60-INCH Cover: 1-25 FT

CP CLASS IV 72-INCH Cover: 1-25 FT

CP CLASS IV 84-INCH Cover: 1-25 FT

CP CLASS V 12-INCH Cover: 1-35 FT

CP CLASS V 15-INCH Cover: 1-35 FT

CP CLASS V 18-INCH Cover: 1-35 FT

CP CLASS V 21-INCH Cover: 1-35 FT

CP CLASS V 24-INCH Cover: 1-35 FT

CP CLASS V 30-INCH Cover: 1-35 FT
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Name Rules
CP CLASS V 36-INCH Cover: 1-35 FT

CP CLASS V 42-INCH Cover: 1-35 FT

CP CLASS V 48-INCH Cover: 1-35 FT

CP CLASS V 54-INCH Cover: 1-35 FT

CP CLASS V 60-INCH Cover: 1-35 FT

CP CLASS V 72-INCH Cover: 1-35 FT

CP CLASS V 84-INCH Cover: 1-35 FT

   

CPCS 12-INCH Cover: 1-40 FT

CPCS 15-INCH Cover: 1-40 FT

CPCS 18-INCH Cover: 1-40 FT

CPCS 21-INCH Cover: 1-40 FT

CPCS 24-INCH Cover: 1-40 FT

CPCS 30-INCH Cover: 1-40 FT

CPCS 36-INCH Cover: 1-40 FT

CPCS 42-INCH Cover: 1-40 FT

CPCS 48-INCH Cover: 1-40 FT

CPCS 54-INCH Cover: 1-40 FT

CPCS 60-INCH Cover: 1-58 FT

CPCS 72-INCH Cover: 1-49 FT

CPCS 84-INCH Cover: 1-42 FT

CPCS 96-INCH Cover: 1-37 FT

   

CPCSPC 12-INCH Cover: 1-40 FT

CPCSPC 15-INCH Cover: 1-40 FT
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Name Rules
CPCSPC 18-INCH Cover: 1-40 FT

CPCSPC 21-INCH Cover: 1-40 FT

CPCSPC 24-INCH Cover: 1-40 FT

CPCSPC 30-INCH Cover: 1-40 FT

CPCSPC 36-INCH Cover: 1-40 FT

CPCSPC 42-INCH Cover: 1-40 FT

CPCSPC 48-INCH Cover: 1-40 FT

CPCSPC 54-INCH Cover: 1-40 FT

CPCSPC 60-INCH Cover: 1-58 FT

CPCSPC 72-INCH Cover: 1-49 FT

CPCSPC 84-INCH Cover: 1-42 FT

CPCSPC 96-INCH Cover: 1-37 FT

   

CPCSAC 12-INCH Cover: 1-40 FT

CPCSAC 15-INCH Cover: 1-40 FT

CPCSAC 18-INCH Cover: 1-40 FT

CPCSAC 21-INCH Cover: 1-40 FT

CPCSAC 24-INCH Cover: 1-40 FT

CPCSAC 30-INCH Cover: 1-40 FT

CPCSAC 36-INCH Cover: 1-40 FT

CPCSAC 42-INCH Cover: 1-40 FT

CPCSAC 48-INCH Cover: 1-40 FT

CPCSAC 54-INCH Cover: 1-40 FT

CPCSAC 60-INCH Cover: 1-58 FT

CPCSAC 72-INCH Cover: 1-49 FT
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Name Rules
CPCSAC 84-INCH Cover: 1-42 FT

CPCSAC 96-INCH Cover: 1-37 FT

   

CPCA 12-INCH Cover: 1-40 FT

CPCA 15-INCH Cover: 1-40 FT

CPCA 18-INCH Cover: 1-40 FT

CPCA 21-INCH Cover: 1-35 FT

CPCA 24-INCH Cover: 1-35 FT

CPCA 30-INCH Cover: 1-30 FT

CPCA 36-INCH Cover: 1-30 FT

CPCA 42-INCH Cover: 1-30 FT

CPCA 48-INCH Cover: 1-25 FT

CPCA 54-INCH Cover: 1-25 FT

CPCA 60-INCH Cover: 1-32 FT

CPCA 72-INCH Cover: 1-30 FT

CPCA 84-INCH Cover: 1.5-30 FT

   

CPCP 12-INCH Cover: 1-15 FT

CPCP 15-INCH Cover: 1-15 FT

CPCP 18-INCH Cover: 1-15 FT

CPCP 24-INCH Cover: 1-15 FT

CPCP 30-INCH Cover: 1-15 FT

CPCP 36-INCH Cover: 1-15 FT

   

CPRC CLASS III 12-INCH Cover: 2-15 FT
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Name Rules
CPRC CLASS III 15-INCH Cover: 2-15 FT

CPRC CLASS III 18-INCH Cover: 2-15 FT

CPRC CLASS III 21-INCH Cover: 2-15 FT

CPRC CLASS III 24-INCH Cover: 2-15 FT

CPRC CLASS III 27-INCH Cover: 2-15 FT

CPRC CLASS III 30-INCH Cover: 2-15 FT

CPRC CLASS III 36-INCH Cover: 2-15 FT

CPRC CLASS III 42-INCH Cover: 2-15 FT

CPRC CLASS III 48-INCH Cover: 2-15 FT

CPRC CLASS III 54-INCH Cover: 2-15 FT

CPRC CLASS III 60-INCH Cover: 2-15 FT

CPRC CLASS III 66-INCH Cover: 2-15 FT

CPRC CLASS III 72-INCH Cover: 2-15 FT

CPRC CLASS III 78-INCH Cover: 2-15 FT

CPRC CLASS III 84-INCH Cover: 2-15 FT

CPRC CLASS III 90-INCH Cover: 2-15 FT

CPRC CLASS III 96-INCH Cover: 2-15 FT

CPRC CLASS III 102-INCH Cover: 2-15 FT

CPRC CLASS III 108-INCH Cover: 2-15 FT

CPRC CLASS IV 12-INCH Cover: 1-25 FT

CPRC CLASS IV 15-INCH Cover: 1-25 FT

CPRC CLASS IV 18-INCH Cover: 1-25 FT

CPRC CLASS IV 21-INCH Cover: 1-25 FT

CPRC CLASS IV 24-INCH Cover: 1-25 FT

CPRC CLASS IV 27-INCH Cover: 1-25 FT
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Name Rules
CPRC CLASS IV 30-INCH Cover: 1-25 FT

CPRC CLASS IV 36-INCH Cover: 1-25 FT

CPRC CLASS IV 42-INCH Cover: 1-25 FT

CPRC CLASS IV 48-INCH Cover: 1-25 FT

CPRC CLASS IV 54-INCH Cover: 1-25 FT

CPRC CLASS IV 60-INCH Cover: 1-25 FT

CPRC CLASS IV 66-INCH Cover: 1-25 FT

CPRC CLASS IV 72-INCH Cover: 1-25 FT

CPRC CLASS IV 78-INCH Cover: 1-25 FT

CPRC CLASS IV 84-INCH Cover: 1-25 FT

CPRC CLASS V 12-INCH Cover: 1-35 FT

CPRC CLASS V 15-INCH Cover: 1-35 FT

CPRC CLASS V 18-INCH Cover: 1-35 FT

CPRC CLASS V 21-INCH Cover: 1-35 FT

CPRC CLASS V 24-INCH Cover: 1-35 FT

CPRC CLASS V 27-INCH Cover: 1-35 FT

CPRC CLASS V 30-INCH Cover: 1-35 FT

CPRC CLASS V 36-INCH Cover: 1-35 FT

CPRC CLASS V 42-INCH Cover: 1-35 FT

CPRC CLASS V 48-INCH Cover: 1-35 FT

CPRC CLASS V 54-INCH Cover: 1-35 FT

CPRC CLASS V 60-INCH Cover: 1-35 FT

CPRC CLASS V 66-INCH Cover: 1-35 FT

CPRC CLASS V 72-INCH Cover: 1-35 FT

CPRC CLASS V 84-INCH Cover: 1-35 FT
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Name Rules
   

CPRCHE CLASS HE-III 14x23-INCH Cover: 1-15 FT

CPRCHE CLASS HE-III 19x30-INCH Cover: 1-15 FT

CPRCHE CLASS HE-III 24x38-INCH Cover: 1-15 FT

CPRCHE CLASS HE-III 29x45-INCH Cover: 1-15 FT

CPRCHE CLASS HE-III 34x53-INCH Cover: 1-15 FT

CPRCHE CLASS HE-III 38x60-INCH Cover: 1-15 FT

CPRCHE CLASS HE-III 43x68-INCH Cover: 1-15 FT

CPRCHE CLASS HE-III 48x76-INCH Cover: 1-15 FT

CPRCHE CLASS HE-III 53x83-INCH Cover: 1-15 FT

CPRCHE CLASS HE-III 58x91-INCH Cover: 1-15 FT

CPRCHE CLASS HE-III 63x98-INCH Cover: 1-15 FT

CPRCHE CLASS HE-III 68x106-INCH Cover: 1-15 FT

CPRCHE CLASS HE-IV 14x23-INCH Cover: 1-25 FT

CPRCHE CLASS HE-IV 19x30-INCH Cover: 1-25 FT

CPRCHE CLASS HE-IV 24x38-INCH Cover: 1-25 FT

CPRCHE CLASS HE-IV 29x45-INCH Cover: 1-25 FT

CPRCHE CLASS HE-IV 34x53-INCH Cover: 1-25 FT

   

PSP 60-INCH Cover: 1-106 FT

PSP 72-INCH Cover: 1-76 FT

PSP 84-INCH Cover: 1-56 FT

PSP 96-INCH Cover: 1-47 FT

PSP 108-INCH Cover: 1-41 FT

PSP 120-INCH Cover: 1-37 FT
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Name Rules
PSP 132-INCH Cover: 1-35 FT

PSP 144-INCH Cover: 1-33 FT

PSP 156-INCH Cover: 1-32 FT

PSP 168-INCH Cover: 1-31 FT

PSP 180-INCH Cover: 1-30 FT

   

PASP 6-FT SPAN Cover: 1.5-15 FT

PASP 7-FT SPAN Cover: 1.5-15 FT

PASP 8-FT SPAN Cover: 2-12 FT

PASP 9-FT SPAN Cover: 2-11 FT

PASP 10-FT SPAN Cover: 2-10 FT

PASP 11-FT SPAN Cover: 2-8 FT

PASP 12-FT SPAN Cover: 2-7 FT

PASP 13-FT SPAN Cover: 2-6 FT

PASP 14-FT SPAN Cover: 3-12 FT

PASP 15-FT SPAN Cover: 3-11 FT

PASP 16-FT SPAN Cover: 3-10 FT

PASP 16.5-FT SPAN Cover: 3-10 FT

   

PACS 17x13-INCH Cover: 1.5-13 FT

PACS 21x15-INCH Cover: 1.5-12 FT

PACS 24x18-INCH Cover: 1.5-10 FT

PACS 28x20-INCH Cover: 1.5-9 FT

PACS 35x24-INCH Cover: 1.5-9 FT

PACS 42x28-INCH Cover: 1.5-9 FT
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Name Rules
PACS 49x32-INCH Cover: 1.5-7 FT

PACS 57x37-INCH Cover: 1.5-7 FT

PACS 64x43-INCH Cover: 1.5-7 FT

PACS 71x47-INCH Cover: 1.5-7 FT

PACS 77x52-INCH Cover: 1.5-7 FT

PACS 83x57-INCH Cover: 1.5-8 FT

   

PAPCCS 17x13-INCH Cover: 1.5-13 FT

PAPCCS 21x15-INCH Cover: 1.5-12 FT

PAPCCS 24x18-INCH Cover: 1.5-10 FT

PAPCCS 28x20-INCH Cover: 1.5-9 FT

PAPCCS 35x24-INCH Cover: 1.5-9 FT

PAPCCS 42x28-INCH Cover: 1.5-7 FT

PAPCCS 49x32-INCH Cover: 1.5-7 FT

PAPCCS 57x37-INCH Cover: 1.5-7 FT

PAPCCS 64x43-INCH Cover: 1.5-7 FT

PAPCCS 71x47-INCH Cover: 1.5-7 FT

PAPCCS 77x52-INCH Cover: 1.5-7 FT

PAPCCS 83x57-INCH Cover: 1.5-8 FT

   

PACSAC 17x13-INCH Cover: 1.5-13 FT

PACSAC 21x15-INCH Cover: 1.5-12 FT

PACSAC 24x18-INCH Cover: 1.5-10 FT

PACSAC 28x20-INCH Cover: 1.5-9 FT

PACSAC 35x24-INCH Cover: 1.5-9 FT
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Name Rules
PACSAC 42x28-INCH Cover: 1.5-7 FT

PACSAC 49x32-INCH Cover: 1.5-7 FT

PACSAC 57x37-INCH Cover: 1.5-7 FT

PACSAC 64x43-INCH Cover: 1.5-7 FT

PACSAC 71x47-INCH Cover: 1.5-7 FT

PACSAC 77x52-INCH Cover: 1.5-7 FT

PACSAC 83x57-INCH Cover: 1.5-8 FT

   

PCP Cover: 2-15 FT

PCPCS Cover: 1-49 FT

PCPRC Cover: 2-15 FT

CP = CULVERT PIPE

CPCS = CULVERT PIPE CORRUGATED STEEL

CPCSPC = CULVERT PIPE CORRUGATED STEEL POLYMER COATED

CPCSAC = CULVERT PIPE CORRUGATED STEEL ALUMINUM COATED

CPCA = CULVERT PIPE CORRUGATED ALUMINUM

CPCP = CULVERT PIPE CORRUGATED POLYETHYLENE

CPRC = CULVERT PIPE REINFORCED CONCRETE

CPRCHE = CULVERT PIPE REINFORCED CONCRETE HORIZONTAL ELLIPTICAL

PSP = PIPE STRUCTURAL PLATE

PASP = PIPE ARCH STRUCTURAL PLATE

PACS = PIPE ARCH CORRUGATED STEEL

PAPCCS = PIPE ARCH POLYMER COATED CORRUGATED STEEL

PACSAC = PIPE ARCH CORRUGATED STEEL ALUMINUM COATED

PCP = PIPE CATTLE PASS

PCPCS = PIPE CATTLE PASS CORRUGATED STEEL

PCPRC = PIPE CATTLE PASS REINFORCED CONCRETE
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Storm sewer summary
Last updated: 2021-02-17

Names and rules

SSPC STORM SEWER PIPE COMPOSITE

SSPRC STORM SEWER PIPE REINFORCED CONCRETE

SSPNRC STORM SEWER PIPE NONREINFORCED CONCRETE

SSPRCHE
STORM SEWER PIPE REINFORCED CONCRETE HORIZONTAL 
ELLIPTICAL

Name Rules

SSPC 6-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPC 8-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPC 10-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPC 12-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPC 15-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
350 FT

   

SSPRC CLASS II 12-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS II 15-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS II 18-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS II 21-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS II 24-INCH Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
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Name Rules
350 FT

SSPRC CLASS II 27-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
400 FT

SSPRC CLASS II 30-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
400 FT

SSPRC CLASS II 36-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
400 FT

SSPRC CLASS II 42-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
500 FT

SSPRC CLASS II 48-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
500 FT

SSPRC CLASS II 54-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
500 FT

SSPRC CLASS II 60-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS II 66-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS II 72-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS II 78-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS II 84-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS II 90-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS II 96-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS II 102-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS II 108-INCH
Cover and Slope: 1-11 FT Slope: 0.3 - 10% Max Length: 
1000 FT
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Name Rules

SSPRC CLASS III 12-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS III 15-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS III 18-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS III 21-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS III 24-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS III 27-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
400 FT

SSPRC CLASS III 30-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
400 FT

SSPRC CLASS III 36-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
400 FT

SSPRC CLASS III 42-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
500 FT

SSPRC CLASS III 48-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
500 FT

SSPRC CLASS III 54-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
500 FT

SSPRC CLASS III 60-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS III 66-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS III 72-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS III 78-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS III 84-INCH Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
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Name Rules
1000 FT

SSPRC CLASS III 90-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS III 96-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS III 102-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS III 108-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS IV 12-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS IV 15-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS IV 18-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS IV 21-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS IV 24-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRC CLASS IV 27-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
400 FT

SSPRC CLASS IV 30-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
400 FT

SSPRC CLASS IV 36-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
400 FT

SSPRC CLASS IV 42-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
500 FT

SSPRC CLASS IV 48-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
500 FT

SSPRC CLASS IV 54-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
500 FT
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Name Rules

SSPRC CLASS IV 60-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS IV 66-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS IV 72-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS IV 78-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS IV 84-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRC CLASS V 12-INCH
Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 350 
FT

SSPRC CLASS V 15-INCH
Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 350 
FT

SSPRC CLASS V 18-INCH
Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 350 
FT

SSPRC CLASS V 21-INCH
Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 350 
FT

SSPRC CLASS V 24-INCH
Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 350 
FT

SSPRC CLASS V 27-INCH
Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 400 
FT

SSPRC CLASS V 30-INCH
Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 400 
FT

SSPRC CLASS V 36-INCH
Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 400 
FT

SSPRC CLASS V 42-INCH
Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 500 
FT

SSPRC CLASS V 48-INCH
Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 500 
FT

SSPRC CLASS V 54-INCH Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 500 
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Name Rules
FT

SSPRC CLASS V 60-INCH
Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 
1000 FT

SSPRC CLASS V 66-INCH
Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 
1000 FT

SSPRC CLASS V 72-INCH
Cover and Slope: 1-35 FT Slope: 0.3-10% Max Length: 
1000 FT

   

SSPNRC CLASS 3 6-INCH
Cover and Slope: 6-10 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPNRC CLASS 3 8-INCH
Cover and Slope: 6-10 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPNRC CLASS 3 10-INCH
Cover and Slope: 6-10 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPNRC CLASS 3 12-INCH
Cover and Slope: 6-10 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPNRC CLASS 3 15-INCH
Cover and Slope: 6-10 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPNRC CLASS 3 18-INCH
Cover and Slope: 6-10 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPNRC CLASS 3 21-INCH
Cover and Slope: 6-10 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPNRC CLASS 3 24-INCH
Cover and Slope: 6-10 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPNRC CLASS 3 30-INCH
Cover and Slope: 6-10 FT Slope: 0.3 - 10% Max Length: 
400 FT

SSPNRC CLASS 3 36-INCH
Cover and Slope: 6-10 FT Slope: 0.3 - 10% Max Length: 
400 FT

   

SSPRCHE CLASS HE-III 14x23-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
350 FT
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Name Rules

SSPRCHE CLASS HE-III 19x30-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRCHE CLASS HE-III 24x38-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
400 FT

SSPRCHE CLASS HE-III 29x45-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
500 FT

SSPRCHE CLASS HE-III 34x53-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
500 FT

SSPRCHE CLASS HE-III 38x60-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
500 FT

SSPRCHE CLASS HE-III 43x68-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRCHE CLASS HE-III 48x76-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRCHE CLASS HE-III 53x83-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRCHE CLASS HE-III 58x91-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRCHE CLASS HE-III 63x98-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRCHE CLASS HE-III 68x106-INCH
Cover and Slope: 1-15 FT Slope: 0.3 - 10% Max Length: 
1000 FT

SSPRCHE CLASS HE-IV 14x23-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRCHE CLASS HE-IV 19x30-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
350 FT

SSPRCHE CLASS HE-IV 24x38-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
400 FT

SSPRCHE CLASS HE-IV 29x45-INCH
Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
400 FT

SSPRCHE CLASS HE-IV 34x53-INCH Cover and Slope: 1-25 FT Slope: 0.3 - 10% Max Length: 
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Name Rules
500 FT

 

CATCH BASINS 3-FT Max Dia: 1.25 FT Sump: 2 FT

CATCH BASINS 4-FT Max Dia: 2 FT Sump: 2 FT

CATCH BASINS 5-FT Max Dia: 3 FT Sump: 2 FT

CATCH BASINS 6-FT Max Dia: 3.5 FT Sump: 2 FT

   

CATCH BASINS 2X3-FT Max Dia: 2 FT Sump: 2 FT

CATCH BASINS 2.5X3-FT Max Dia: 2 FT Sump: 2 FT

   

MANHOLES 3-FT Max Dia: 1.25 FT

MANHOLES 4-FT Max Dia: 2 FT

MANHOLES 5-FT Max Dia: 3 FT

MANHOLES 6-FT Max Dia: 3.5 FT

MANHOLES 7-FT Max Dia: 4 FT

MANHOLES 8-FT Max Dia: 5 FT

   

MANHOLES 3x3-FT Max Dia: 2 FT

MANHOLES 4x4-FT Max Dia: 3.5 FT

MANHOLES 5x5-FT Max Dia: 3.5 FT

MANHOLES 6x6-FT Max Dia: 4.5 FT

   

INLETS 3-FT Max Dia: 1.25 FT

INLETS 4-FT Max Dia: 2 FT
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Name Rules
INLETS 2X2-FT Max Dia: 1 FT

INLETS 2X2.5-FT Max Dia: 1.5 FT

INLETS 2x3-FT Max Dia: 2 FT

INLETS 2.5x3-FT Max Dia: 2 FT

Concrete pipe wall thickness

Pipe size 
(inches) Wall thickness (inches)

12 2

15 2.25

18 2.5

21 2.75

24 3

27 3.25

30 3.5

36 4

42 4.5

48 5

54 5.5

60 6

66 6.5

72 7

78 7.5

84 8

90 8.5
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Pipe size 
(inches) Wall thickness (inches)

96 9

102 9.5

108 10

14x23 2.75

19x30 3.25

24x38 3.75

29x45 4.5

34x53 5

38x60 5.5

43x68 6

48x76 6.5

53x83 7

58x91 7.5

63x98 8

68x106 8.5

Inlet surface elevation adjustment
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Cover Structure Centerline o/s from Back of Curb (ft) Vertical Correction* (ft)

A 1 0.04

A-S 1 0.04

B 1 0.04

B-A 1 0.04

BW 1 0.04

F 1.5 0.06

H 1 0.04

H-S 1 0.04

HM 1.5 0.04

HM-GJ 1.2 0.04

HM-GJ-S 1 0.04

T 1.27 0.05

V 1.44 0.04

WM 1.25 0.05

Z 0.75 0.03

   
* Based on 0.04 '/' gutter 
or shoulder slope

Pipe network updates
Last updated: 2020-10-26

Pipe network updates

pipe-ntwrk-updt.mp4 07:24

 1. Open the drawing to be updated.
 2. Open a new drawing using the latest WisDOT template that contains the updated parts lists.
 3. In the drawing to be updated,  Analyze Tab > QTO Manager  
 4. Click the folder icon in the upper left hand corner.

Page: 1240

Published on: 5/17/2023

Pipe network updates

https://c3dkb.dot.wi.gov/video/pipe-ntwrk/pipe-ntwrk-updt.mp4


 5. Choose the new bid item file and new categorization file.  OK

Info: Pick the latest version of the pay item files. WisDOT provides these files.

 6. Dismiss the QTO Manager
 7. In the Setting tab of the Toolspace, located the parts list from the empty drawing with the 

updated parts lists.  Drag and drop the desired parts lists into the drawing that needs to be 
updated.  Choose "Overwrite". 

 8. The empty drawing can now be closed.
 9. Navigate to the pipe network in Toolspace > Prospector.

 10. Sort the parts by description.
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 11. Holding the shift key, select the group of parts that need to be updated. Selecting each type 
as a group.

 12. Right click and choose "Select".
 13. Contextual ribbon > Isolate
 14. WisDOT Design ribbon > "Swap Pipe Network Part" tool
 15. Window select the parts in model space > Enter
 16. Choose the same part from the parts list in the dialogue box.  OK
 17. Repeat for other part types.
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Hydro design
Culvert design: time of concentration, catchments, peak 
flow HY8
Last updated: 2014-09-23

Total video time: 128:13

Exercise data 1: hydro-dsn-clvrt-dsn-01-data-C3D14.zip

Exercise data 2: hydro-dsn-clvrt-dsn-02-data-C3D14.zip

Culvert design: time of concentration, catchments, peak flow HY8

hydro-dsn-clvrt-dsn-00.mp4 4:31

There are several applications available at WisDOT to complete culvert designs, such as Cul-
vertMaster, HY8, Hydraflow Express, and Storm and Sanitary Analysis (SSA). A suggested workflow is 
as follows:

 1. Use Civil 3D to create a pipe network for your culvert pipes. This validates the pipe geometry 
in relation to the physical surroundings such as cover, slope, elevation, location and length.

 2. Use Civil 3D to create catchments. Catchments can be used to develop a time of con-
centration for the watershed.

 3. Use SSA to compute the peak runoff. Export the pipe network and catchment(s) to SSA. There, 
peak runoff can be computed based on the catchment data and additional inputs done in 
SSA.

 4. We do not recommend using SSA to check culvert pipe hydraulics. SSA uses EPA SWMM as its 
computing engine. In most cases, HDS-5 should be used for checking culvert pipe hydraulics 
on WisDOT projects.. SSA can replicate the results of HDS-5, but it takes extensive knowledge 
of the application and drainage in general. It is a simpler workflow to just use an application 
designed to follow HDS-5.

 5. Use HY8 from FHWA or a similar application to analyze the culvert pipe hydraulics. The data 
computed in Civil 3D and SSA can be entered in HY8 to complete the analysis.

 6. Make revisions to the Civil 3D pipe network as needed to achieve the desired results in HY8.

Determine watershed boundary

hydro-dsn-clvrt-dsn-01.mp4 8:34

 1. Open Pipe-Culverts.dwg.
 2. In Toolspace > Prospector tab > Surface, right click on the Cmbn-Ex-Top
 3. Select properties.
 4. Change the surface style to Watersheds
 5. In the Analysis Tab, choose Watersheds from the Analysis Type.
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 6. Click the down-arrow under Watershed parameters.
 7. If the Range Details do not populate
 8. In the Information tab Edit Current Style.
 9. Click Ok. 

 10. In the Analysis tab click the down arrow under Watershed Parameters again.
 11. Under Range details, click the light bulb. 
 12. Turn off Boundary Point and Boundary Segment
 13. Click Ok.

The watershed boundaries and contours will now be visible.

Inspect the watershed boundaries and contours to determine which watersheds flow to the culvert 
pipe.

 14. On the P_DRN_Catchment layer, draw a closed polyline that roughly follows the exterior of 
the contributing watershed boundaries.

Determine flow path(s) and create catchment(s)

hydro-dsn-clvrt-dsn-02.mp4 9:54

 1. Determine the flow path from the hydraulically most distant point. 
 2. On the P_DRN_Flow layer, draw a polyline representing this flow path. 
 3. The Water Drop command can be a useful tool for determining the flow path.
 4. Click onAnalyze Tab > Ground Data panel > Flow Path > Water Drop 
 5. Create several possible paths to determine which has the highest time of concentration
 6. From the Analyze Tab > Ground Data panel > Catchment > Create Catchment Group . 
 7. Name the Catchment Group the same as the corresponding culvert pipe.
 8. From the Analyze Tab > Ground Data panel > Catchment > Create Catchment From 

Object . 
 o vSelect the polyline representing the catchment.
 o vSelect the upper end of the polyline representing the flow path.

 9. In the Create Catchment from Object dialogue box, name the catchment the culvert pipe sta-
tion with a numbered suffix. 100+00(1) for example.

 10. Verify the correct catchment group is assigned

Tip: Do not choose the reference structure at this time unless there is only one possible flow 
path from the hydraulically most remote point.

The runoff coefficient does not need to be assigned at this time.

Do not erase existing entities.

 11. Click Ok.
 12. Select the catchment boundary polyline. 
 13. Select the upper end of the polyline representing the alternative flow path. 
 14. In the Create Catchment from Object dialogue box, name the catchment the culvert pipe sta-

tion with a numbered suffix. 100+00(1) for example.
 15. Verify the correct catchment group is assigned
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Tip: Do not choose the reference structure at this time unless there is only one possible flow 
path from the hydraulically most remote point.

 16. The runoff coefficient does not need to be assigned at this time.
 17. Do not erase existing entities.
 18. Click Ok.
 19. Repeat until a catchment has been created for all of the possible flow paths.

Time of concentration – Adding flow segments

hydro-dsn-clvrt-dsn-03.mp4 9:27

 1. Select the Cmbn-Ex-Top surface. 
 2. Open the surface properties. 
 3. Choose a surface style that displays contours.
 4. Select the flow path on the screen, right click and choose Edit Flow Segments.
 5. The flow path will be populated with default values that need to be modified.
 6. Use the add flow segment ( plus button) and delete flow segment (red X buttons) to add and 

delete flow segments. 
 7. Click the plus button to add another flow segment. 
 8. Digitize on the screen where they segments begin/end.
 9. Change each flow segment to the correct flow type (Sheet flow, Shallow Concentrated Flow, 

or Channel Flow).
 10. Sheet flow should be no more than 300 ft from the start of the flow path.

Tip: You can have up to 3 segments per flow type. For shallow concentrated flow, sub-seg-
ments are determined by significant changes in slope or ground cover. For channel flow, sub-
segments are determined by significant changes in slope, ground cover, or channel shape/size. 
The more detail you add, the more accurate the time of concentration will be

Info: 
Helpful Links

Online TR-55

Topo Quads at topoquest.com

Time of concentration – Flow segment characteristics

hydro-dsn-clvrt-dsn-04.mp4 10:01

 1. In the Sheet Flow row, enter the 2-yr 24-hr rainfall. 
 2. This value can be obtained from TR-55 Appendix B, Figure B-3. It can also be obtained in SSA.
 3. In the Sheet Flow row, enter the Manning's Roughness for that segment. 
 4. Values can be obtained from TR-55 Table 3-1.
 5. Set the shallow concentrated flow to either Paved or UnPaved. 
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Tip: Note that in C3D 2014 other surface types can be selected, but they will not transfer to 
SSA. If another surface type is desired, it can be selected manually in SSA. This issue has been 
resolved in C3D 2016.

 6. In the Channel Flow row, enter the Manning's Roughness value.

Info: 
Helpful Links:

 Mannings n for Channel Flow  

Aerial Photography

Time of concentration – Flow segment characteristics continued

hydro-dsn-clvrt-dsn-05.mp4 13:37

 1. In the Channel Flow row, enter the Cross-sectional Area and Wetted Perimeter of the channel. 
 2. Taking a quick profile works well for this. 
 3. Use the No Grid No Exaggeration profile view style so accurate measurements can be made. 
 4. Draw a polyline across the channel, connecting the approximate bank full width elevation on 

each side. 
 5. You can also use an alignment and surface profile if you want a more permanent record of 

the cross section. The conventional way to cut a cross section of a channel is from left to right 
facing downstream.

 6. If the slopes are not populated because the surface assignment was forgotten when the 
catchment was created, click on the Surface button. 

 A. vSelect the Cmbn-Ex-Top surface.
 B. vClick Ok. 
 C. vThe Slope column will then be populated.

 7. Click the green check mark to dismiss the Flow Segment editor.
The total Time of Concentration is then computed and assigned to the Catchment Properties.

Repeat the above steps for the various different possible flow paths. Compare the catchment flow 
paths and choose the one with the highest time of concentration. The catchment labels will display 
the time of concentration for each catchment.

Assign that catchment with the highest time of concentration to the culvert inlet structure. This is 
done in the catchment properties.

Export to Storm and Sanitary Analysis (SSA)

hydro-dsn-clvrt-dsn-06.mp4 7:55

In Civil 3D, move any raster images that are in the drawing to separate layers. In SSA, you can view 
the dwg file in the background for reference. You can also control the display of the images by turn-
ing their layers on and off in SSA.  
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 1. In the Analyze tab, click the Edit in Storm and Sanitary Analysis button. 
 2. Click Ok. 
 3. SSA will then initialize and you'll be prompted to save the import log file. This is not neces-

sary.  

Watershed properties (TR-20)

hydro-dsn-clvrt-dsn-07.mp4 8:50

 1. If the program opened with the Rational Method as the active Hydrology mode. To switch to 
TR-20, Click Project Options from the Design menu. In the General Tab, switch the Hydro-
logy Method to SCS TR-20. OK.

 2. Double click on the subbasin. Notice that the time of concentration was automatically pop-
ulated form Civil 3D.

Info: IMPORTANT: Check the time of concentration methodology. The default is set to average. 
If there is only one subarea per flow segment type, the methodology does not matter. 
However, if there is more than one subarea per flow segment type, the methodology needs to 
be set to Summation.
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If Average is used, it will average the flow times of the subareas. This will result in a lower time of 
concentration. A lower time of concentration will result in a higher peak flow and possibly a larger 
pipe size.

 3. Go to the Curve Number Tab. The basin area can be broken down into subareas to create a 
composite curve number. A good way to get the areas is by viewing an aerial image in Civil 3D 
and measuring the areas of the different cover types. Enter the areas or percentages so they 
total 100%. Enter the corresponding Curve Numbers (CN). You can click on the CN ellipses to 
select the CN. You'll need to know the Hydrologic Soil Group of the area. This can be obtained 
using the USDA Web Soil Survey mapping tool.

http://websoilsurvey.nrcs.usda.gov/app/HomePage.htm

Runoff calculation (TR-20) #runoff

hydro-dsn-clvrt-dsn-08.mp4 8:32

 1. Save the SSA file as 12345678-TR20-25yr.spf . 
 2. Under Input, click the Rain Gage ellipsis button. 
 3. Add. 
 4. Name the Rain gage ID the return year (ie. 25 YR). 
 5. Under Data source, click the Time series Ellipsis button. 
 6. Add
 7. Under Time Series Data, Data Type, choose "User Defined." Load
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 8. Navigate to C:\ProgramData\Autodesk\SSA <version>\Database and choose the appropriate 
county and return period for the analysis being performed.  Click Open.

Requirement: Obtain the Return Period from FDM 13-10-1 Attachment 1.1.

The rainfall depth will automatically populate.

 9. Copy the description to the Time series ID.   Close to close the Time Series dialogue.

 10. Assign... to assign the Rain gage to the sub-basins.

 11. Close Close to close the Rain gage dialogue.

 12. Analysis menu > Analysis Options under Dates, set the End analysis on date to one day 
after the Start analysis on date (24 hours).

 13. Analysis menu > Perform Analysis

 14. You should then received notification of a successful analysis. The results may be saved to a 
location that you specify.

Warning: Disregard the pipe hydraulic analysis that SSA performed. We will check pipe 
hydraulics using HY8.

 15. Time Series Plot to view specific details about the hydrograph.

 16. Check that a smooth curve is developed. If not, may need to adjust Time Steps under Analysis 
Option.

The Routing Timestep is the time increment that computations are completed. The Reporting 
Timestep is the increment that values are reported. 

Culvert pipe runoff calculation (rational)

hydro-dsn-clvrt-dsn-09.mp4 13:37

 1. If you have already completed your culvert design using the TR-20 method, perform a Save As 
12345678-Rational-25yr.spf.

 2. From the Input menu, click Project Options.Project Options
 3. On the General Tab > Hydrology runoff specification section , change the Hydrology 

method to Rational.
 4. From the Input menu, select IDF Curves...
 5. Click Load
 6. Select the IDF file for your project county.
 7. Double click on the subbasin(s). You'll notice all of the time of concentration data imported 

from Civil 3D.
Notice that the time of concentration was automatically populated form Civil 3D. Go to the Runoff 
Coefficient Tab. The basin area can be broken down into subareas to create a composite curve run-
off coefficient. A good way to get the areas is by viewing a aerial image in Civil 3D and measuring the 
areas of the different cover types. 
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 8. Enter the areas or percentages so they total 100%. 
 9. Enter the corresponding runoff coefficients (C). 

Tip: You can click on the ellipses to select the C values. You'll need to know the Hydrologic Soil 
Group of the area and the general slope of the terrain Hydrologic Soil Group can be obtained 
using the USDA Web Soil Survey mapping tool and Exhibit A-1 in TR-55. http://web-
soilsurvey.nrcs.usda.gov/app/HomePage.htm.

Use Civil 3D to determine the slope of the terrain. 

 1. In the Surface Properties > Information tab ,, select the style called Slope Arrows. 
 2. In the Surface Properties > Analysis tab , choose slope arrows under analysis type. 
 3. Change the number of ranges to 3 and click the Run Analysis button. 

 o Set range 1 maximum slope to 2%. 
 o Set range 2 minimum slope to 2% and maximum slope to 6%. 
 o Set range 3 minimum slope to 6%. 

You can change the range colors according to your preference or leave the defaults. 

 4. Click Ok.
 5. From the Analysis menu > Perform Analysis  . 

You should then received notification of a successful analysis. The results may be saved to a location 
that you specify.

 6. Click Time Series Plot to view specific details about the analysis.
 7. Click Save.

Intro to HY8 – existing condition

hydro-dsn-clvrt-dsn-10.mp4 8:45

HY8 is one option for checking culvert hydraulics. Other options include Culvert Master and Hydra-
flow Express. The key is to use HDS-5 methodology. http://www.f-
hwa.dot.gov/engineering/hydraulics/pubs/12026/hif12026.pdf

Requirement: The existing condition culvert must be checked. This is important because you 
must compare the proposed culvert headwater to the existing. Do not increase the pipe head-
water elevation.

 1. Create new HY8 Project. 
 2. Save the project as the project ID. 
 3. Name each culvert crossing the same as the pipe network pipe with a descriptor. 
 4. In the case of an existing pipe it would look something like 100+00- Existing.

Discharge data

 1. Set minimum flow to 0 cfs
 2. Set Design flow to the smaller of the two computed peak runoffs (Rational or TR-20)
 3. Set the Max flow to the larger of the two computed peak runoffs (Rational or TR-20)
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Tailwater data

 1. If the information is available, enter in the irregular channel data for the most accurate res-
ults. If tailwater data is not available, tailwater conditions can be estimated by normal depth 
approximations.

 2. Use Civil 3D to cut a channel cross sections approximately 1 pipe length downstream. 
 3. Alignments and Surface Profiles work well for this.
 4. A Civil 3D surface label can be used to determine the slope along the channel.
 5. Enter in the Manning's n values.

Intro to HY8 – Existing Condition Continued

hydro-dsn-clvrt-dsn-11.mp4 5:50

Roadway data

If the goal is designing to avoid roadway overtopping, a constant roadway elevation can be used. 

If roadway overtopping is part of the design, consult your drainage engineer.

Assuming that roadway overtopping is to be avoided:

 1. Set crest length to 1,000 ft. 
 2. Set the roadway elevation to the top roadway elevation. 
 3. This may be a sag location of the roadway, or some other feature that should not be over-

topped (a driveway for example).
 4. Set the roadway top width.

Culvert data

Name the pipe Existing

Enter the characteristics of the existing culvert pipe. Obtain this information with a field review.

Site data

Obtain from survey data

Click Analyze Crossing to obtain the results. 

Tip: Make note of the headwater elevation for reference during the design of the proposed cul-
vert pipe.

Intro to HY8 – Proposed

hydro-dsn-clvrt-dsn-12.mp4 9:21

Requirement: IMPORTANT: The existing condition culvert must be checked. This is important 
because you must compare the proposed culvert headwater to the existing. Do not increase 
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the pipe headwater elevation. Small changes in culvert type, size, shape, length, and slope 
and/or changes in roadway geometry can significantly affect the headwater elevation.

In the same HY8 project, right click on the existing pipe crossing and choose Duplicate. 

This allows you to reuse some of the data from the existing crossing so you don't need to reenter it.

Rename the new crossing 100+00-Alt1

Discharge data

Discharge data is typically the same as the existing condition. TRANS 233 prohibits increased flows to 
WisDOT right of way from a plat of 5 or more parcels. However, if the roadway profile is changing 
enough to affect a high point location, the contributing drainage area may change and affect the 
peak flow at a crossing.

Tailwater data

May or may not be the same as the existing condition.

Roadway data

Tip: If the goal is designing to avoid roadway overtopping, a constant roadway elevation can 
be used. 

Requirement: If roadway overtopping is part of the design, consult your drainage engineer.

Assuming that roadway overtopping is to be avoided:

 1. Set crest length to 1,000 ft. 
 2. Set the roadway elevation to the maximum allowable headwater elevation. 
 3. This may be the subgrade elevation of the roadway at a nearby sag, a driveway, sideroad, or 

some other feature where it is undesirable to overtop with water.
 4. Set the roadway top width.

Culvert data

Requirement: Before entering this data, consult the Charts 1B & 2B in HDS-5. This will give 
you a starting point for your design. Start on the right side with HW/D of 1.5. Connect that 
value with the peak flow and read the pipe size. That will be the minimum pipe size required 
under inlet control.

 1. Name the pipe 42-Inch CPCS
 2. Select pipe shape, material, and diameter. 
 3. The pipe diameter is entered in feet.
 4. Embedment Depth: 0 (typical)
 5. Inlet Type: conventional (typical)
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 6. Inlet Edge Condition: 
 o "Square Edge with Headwall" for metal pipe, 
 o "Grooved Edge with Headwall" for concrete pipe (typical)

 7. Inlet Depression: No (typical)

Site data

Use the Culvert Design Properties pipe network label to obtain this information from Civil 3D.

Intro to HY8 – Proposed Continued

hydro-dsn-clvrt-dsn-13.mp4 9:19

Click Analyze Crossing to obtain the results

Display the Culvert Summary Table

Compare the results to the existing condition. 

 l If the headwater elevation is increased, select a different alternative.
 l If HW/D is over 1.5, select a difference alternative.
 l If the headwater elevation exceeds the maximum headwater (overtopping), select a different 

alternative.
Check to see if the culvert is in Inlet Control or Outlet Control. Different factors affect the culvert 
capacity under these conditions. 

Requirement: See FDM 13-15-10.3 for a list of factors.

Check the outlet velocity. 

Requirement: Refer to HEC-14 to determine energy dissipation needs.

Select the desired alternative and make the revisions to the Civil 3D pipe network.

Take the revised pipe invert elevations and length and update the HY8 project. Verify the results are 
still acceptable.

SSA project options settings for storm sewer
Last updated: 2015-04-21

Project options settings for storm sewer
Use Hydrodynamic

Enable overflow ponding at nodes

Hydrology: Rational and/or TR-20

Time of Concentration: SCS TR-55 is okay for Rational or TR-20. If known, you can also use User-
Defined. Minimum allowable is 5 min.
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SSA analysis options settings for storm sewer
Last updated: 2015-04-21

Analysis options settings for storm sewer
Set reporting time step to 1 min (TR-20)

Set routing time step to 1 sec (TR-20)

1 day analysis length

SSA  storm sewer tips
Last updated: 2015-04-21

SSA  storm sewer tips
With the WisDOT customization, Civil 3D is set to export pipe network inlets as FHWA HEC-22 generic 
inlets in SSA. Once in SSA, you have the option to switch the inlets to Neenah, if desired. However, 
once they are switched, Civil 3D will switch them back to FHWA if you re-export the Pipe Network to 
SSA.

Civil 3D exports inlets to SSA with the correct grate dimensions. However, the grate type may not be 
correct and needs to be checked and changed if necessary.

Civil 3D exports inlets to SSA with the On Grade or On Sag attribute defined in Civil 3D.

There are IDF curves for each of the Wisconsin counties available in SSA. They are located here: 
C:\ProgramData\Autodesk\SSA 2014\Database

NOAA Atlas 14 rainfall files are located here: C:\ProgramData\Autodesk\SSA 2014\Database
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Swept path analysis
Accurate swept paths for complex OSOW vehicles
Last updated: 2013-06-25

Total video time: 11:48

Overview

swept-pth-acurat-pth-01.mp4 11:48

Most vehicles are simplistic, consisting of a simple tractor/trailer configuration with steering at the 
front axle only. With sound judgment and guidance from the FDM, these swept paths can be created 
with relative ease.

More complicated vehicles are appearing statewide. These vehicles include a combination of fea-
tures or restrictions that can be difficult to model.

 l greater than 2 parts (not difficult by itself)
 l steerable rear axles (either linked or independent)

 o Independent steerable rear axles are the most difficult because it requires the User, 
not the software, to make decisions/judgments about the capability of the vehicle and 
what is realistic.

 l ground clearance restrictions (3D modeling is required)
 l yaw restrictions, also known as articulation angle (not difficult by itself)
 l pitch and roll restrictions (3D modeling required)

Overview

Step 1: Identify the project characteristics – What is the design vehicle or vehicles?

Step 2: Gather physical vehicle data – dimensions, angle, etc.

Step 3: Document real-world swept paths – Survey vehicle maneuvers (Vehicles with more than 1 
steering axle) Step 4: Build the vehicle model – Swept path software

Step 5: Trace the real-world swept paths – Calibrate your model (Vehicles with more than 1 steering 
axle) Step 6: Coordinate with the trucking company – Get feedback from the experts

Step 7: Make refinements – Adjust based on comments

 

Step 1: Identify the project characteristics

 l Is it on the OSOW freight network?
 l The OSOW vehicles listed in the FDM may not be all inclusive. Include freight as a topic for 

your business outreach
 l The project may be "the last mile"
 l Is your project en route to a large bridge?
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Step 2: Gather physical vehicle data

 l Body dimensions
 l Load dimensions/position
 l Axle spacing
 l King pin locations
 l Steering angle(s)
 l Articulation angle(s)
 l Ground clearance
 l Lock to Lock Time

Step 3: Document real-world swept paths (Vehicles with rear steering)

 l Coordinate with trucking company
 l Trace the swept path (front and rear tires) through a 90 degree turn
 l The more of these you do, the more refined the model will be
 l Survey the painted swept path at the intersection
 l Observe and document details like rear axle rate of articulation (∆ steering angle/distanced 

traveled)
Step 4: Build the vehicle model

 l Input the vehicle data into the swept path software
 l Use Methods Development as a resource
 l Double check your inputs and confirm with trucking company

Step 5: Trace the real-world swept paths (Vehicles with more than 1 steering axle)

 l Use the survey data as a guide to drive the vehicle through the intersection
 l This will act as an aid for how to drive other intersections. (Calibration)
 l Pay close attention to the rate of articulation at the rear.

Step 6: Coordinate with the trucking company

 l Share your result with the trucking company. Animate the swept path. Ask them questions 
like:

 l Does this look like a realistic way to maneuver this intersection?
 l Are there any features that would make this intersection easier to drive?

Step 7: Make refinements

 l Use the feedback from the trucking company to refine the swept path
 l Make adjustments to the intersection geometry Send an updated animation to the trucking 

company.

Beam transporter
Last updated: 2013-06-25

Total video time: 64:15

Exercise data: swept-pth-beam-trnsprt-data-c3d12.zip

Introduction and vehicle background
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swept-pth-beam-trnsprt-01.mp4 11:40 

In 2007, WisDOT in cooperation with Spancrete performed a study to accurately model beam trans-
port trucks with swept path software. This training package has been assembled to provide guidance 
to designers on development of proper swept paths for the beam transport trucks. Included with 
this training package are the following files:

 l 149' Beam (Training Vehicle).vcl
 o This vehicle file can be imported in to AutoTURN and used to practice swept path 

development. This is the vehicle that was used in the study and should only be used 
for training purposes. The actual design vehicle is located in the WisDOT OSOW library 
and is called 165' Beam 1.

 l template.dwg
 o This drawing contains the actual surveyed path of the 149' Beam truck at two inter-

sections (1 left turn, and 1 right turn). There are multiple paths from multiple 
vehicles/drivers shown at both intersections to represent variability.

 n 16tdq125305_crop.tif, 16tdq125320_crop.tif, 16tdq140320_crop.tif
 o Cropped USGS aerial imagery to provide background reference

 l Beam Transporter Training.dwg
 o This file has the template.dwg and USGS aerial imagery xreferenced into it
 o This file can be used or copied to practice drawing swept paths.
 o This file contains two swept paths that have been drawn for the left turn and the right 

turn to show what the finished swept paths should looks like.
Import the 149' Beam training vehicle into AutoTURN

 1. Select Vehicles from the AutoTURN menu.
 2. At the bottom of the Vehicles dialogue box, choose Import Vehicle.
 3. Select the 149' Beam (Training Vehicle).vcl file and click Open.

Tips: 
Helpful Hints and information for creating beam transporter swept paths:

 l The rear bogie articulation is completely independent of the front steering and is con-
trolled with hydraulics by the driver. A typical articulation rate for the bogie over a 
given travel distance is dependent on the anticipated vehicle speed. A good starting 
point for design purposes is to articulate the rear bogie a maximum of 4 degrees for 
every 17 feet of travel entering and exiting the maneuver. This is roughly the distance 
between the front axle and the first king pin.

 l The vehicle is capable of articulating the bogie as a stop condition. However, this is 
highly undesirable and is only done is extreme circumstances. This action places elev-
ated lateral forces on the girder and bogie, especially on dry pavement.

 l When articulating the rear bogie while entering the maneuver, try to get the bogie to 
follow the path of the tractor as long as you can. This will method will help provide a 
smooth transition.

 l Avoid articulating the bogie too earlier or too quickly causing it to swing outside of the 
tractor path.
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 l The maximum articulation angle between the jeep and tractor is 45-degrees. The max-
imum articulation angle between the jeep and the beam is 45-degrees. These angles 
are preset in the vehicle template. Exceeding these angles increases the risk of tipping 
the beam. The maximum articulation of the bogie is 20-degrees and is limited by its 
mechanical capability. This is also preset in the vehicle template.

Animate swept path

From the AutoTURN menu, click Run Animation . The Run Animation button has standard controls 
for play speed, stop, pause, and a slider to move to a specific position in the swept path. The anim-
ation will display best if the aerial imagery is turned off. Watch for erratic or unrealistic movements 
such as swerves.

Actual beam transporter rear bogie video

swept-pth-beam-trnsprt-02.mp4 2:55

This section contains actual video footage of the beam transport truck's rear bogie and is intended 
to give the audience a better idea of how the vehicle works.

Calibration

swept-pth-beam-trnsprt-03.mp4 13:13

This is Step 5 from "Accurate swept paths for complex OSOW vehicles" on page 1256. Trace the 
actual swept path that was surveyed in Step 3. This section demonstrates how to the Beam Trans-
porter vehicle works by creating a swept path over an actual surveyed swept path of the vehicle.

Practice drawing swept paths using the 149' Beam training vehicle: 

 1. From the AutoTURN menu, choose vehicles
 2. In the custom vehicle library, select the 149' Beam (Training Vehicle) in the Vehicles dialogue 

box and click OK. 
 3. From the AutoTURN menu, click Generate Arc Path 
 4. Place the vehicle on the screen so the front of the tractor roughly lines up with the surveyed 

point markers 
 5. Click a point in front of the vehicle to define the start angle. Set the start angle so the rear 

bogie roughly lines up with the surveyed paths
 6. In the SmartPath Tools dialogue box, click the Override Angle box. This controls the artic-

ulation angle of the rear bogie. To control the angle in Autocad Civil 3D, hold the Ctrl button 
down while scrolling your mouse wheel.  Negative override angles are for left turns and pos-
itive override angles are for right turns. 

Maneuvering a roundabout

swept-pth-beam-trnsprt-04.mp4 15:08
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In this exercise, we will practice maneuvering the beam transport vehicle through a single lane 
roundabout.

Place the swept path on the proper layer. There are layers available in the wisdot templates for 
swept paths. They can be located easily by using the RAB layer filter.

 l RAB_EB_TURN_Left
 l RAB_EB_TURN_Right
 l RAB_EB_TURN_Thru
 l RAB_EB_TURN_U

Info: Remember: The 165' Beam vehicle located in the WisDOT OSOW library is to be used for 
design. 

 

Create a swept path without applying an override angle to the rear bogie.

In some cases, minor modifications to the roundabout entry, truck apron, and exit can be made to 
make this possible. Adding features like a truck apron to roundabout entry, expanding the central 
island truck apron, and widening the roundabout exit can sometimes be done to make it easier for 
the vehicle. Be sure to have features like these reviewed by a qualified roundabout designer and get 
WisDOT approval.

Create the swept path using the rear bogie override angle

The through maneuver on a roundabout is an S-curve. The key is to make the S-curve as flat as pos-
sible for this vehicle. Maneuvering an S-curve requires the bogie to articulate left, then right, and 
then back left again. While doing this, it is important not to exceed the 4-degree/17 ft rule for trans-
itioning the bogie angle. Only articulate the bogie as much as is needed and no more.

Ground clearance analysis
Last updated: 2020-10-26

Total video time: 23:18

Exercise data: swept-pth-grnd-clrnc-data-C3D18.zip

Setup drawing and create 2D swept path

swept-pth-grnd-clrnc-01.mp4 6:38

Create GroundClearance.dwg

 1. C3D App menu > New > Drawing
 2. Use wisdotXX.dwt template to create the new dwg file
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 3. Save to the ProjectID\Design\Design Checks folder in the Civil 3D project
 4. Name the drawing GroundClearance.dwg
 5. Xreference project mapping and/or project edgelines
 6. Data Reference the surface to check
 7. Create a new surface called GC. GC stands for Ground Clearance. Paste the surface to be 

checked into the GC surface.

Select the DST Lowboy vehicle in the WisDOT Library

 8. AutoTURN/AutoTURN Pro 3D tab > Configure panel > Vehicles
 A. Group Vehicles By: Library
 B. Library selected: WisDOT
 C. Vehicle Name selected: DST Lowboy
 D. OK

Create 2D swept path

Tip: Set layers simulation objects will be created on. This is not required, but a good practice.

 9. AutoTURN/AutoTURN Pro 3D tab > Configure panel > Properties
 A. Select Category: General (2D Simulations)

 I. Draw Path On, New Layer: AT-DSTLowboy
 B. Select Category: Vehicles (2D Simulations)

 I. Draw Path On, New Layer: AT-DSTLowboy-Veh
 C. Select Category: Envelopes (2D Simulations)

 I. Draw Path On, New Layer: AT-DSTLowboy-Env
 D. Select Category: Envelopes (2D Simulations)

 I. Draw Path On, New Layer: AT-DSTLowboy-Hatch
 E. OK

 10. AutoTURN/AutoTURN Pro 3D tab > 2D SmartPaths panel > 2D Arc Path

Tip: Make sure to place the vehicle so that it fits entirely on the GC surface.

 A. Left click to place vehicle in start location

 B. Left click to set orientation, or Apply angle in dialog box
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 C. Drag and click points through the swept path

Tip: It's a good idea to create multiple swept paths to check different pos-
sibilities for navigating the swept path. Different swept paths should be placed 
on different layers.

 D. Right click to finish simulation
 E. Home tab > Layers panel > Layer Properties

Review swept path layers and functionality. Different items can be frozen/thawed indi-
vidually.

3D swept path

Page: 1262

Published on: 5/17/2023

Ground clearance analysis



swept-pth-grnd-clrnc-02.mp4 4:01

Convert 2D to 3D

 1. AutoTURN/AutoTURN Pro 3D tab > Configure panel > Properties
 A. Select Category: General (3D Simulations)

 I. Draw Path On, New Layer: AT-DSTLowboy-3D
 B. Select Category: Vehicles (3D Simulations)

 I. Draw Path On, New Layer: AT-DSTLowboy-3D-Veh
 C. Select Category: Envelopes (3D Simulations)

 I. Draw Path On, New Layer: AT-DSTLowboy-3D-Env
 D. Select Category: Envelopes (3D Simulations)

 I. Draw Path On, New Layer: AT-DSTLowboy-3D-Hatch
 E. Select Category: Conflict Analysis

 I. Draw Conflict Analysis On, New Layer: AT-DSTLowboy-Conflict
 F. OK

 2. AutoTURN Pro 3D tab > 3D > Select Terrain
 A. Surface Name: GC
 B. Use

 3. AutoTURN Pro 3D > 3D > Convert 2D to 3D
 A. Pick a 2D turn simulation Click 2D swept path in modelspace
 B. Would you like to delete the 2D Simulation? NO

Warning: When prompted, choose whether to delete the 2D simulation. We 
recommend not deleting the simulation so it is available for later use.

There are some red hatch areas where there are conflicts, but the 3D simulation did 
not show up. We will turn on the 3D simulation in the next step.

 4. AutoTURN/AutoTURN Pro 3D tab > Configure panel > Properties
 A. Select Category: Envelopes (3D Simulations)

 I. Vehicle Body: checked
 B. Update
 C. Pick any element in a turn simulation to update it Click simulation in 

modelspace
 D. Ok

 5. Quick Access Toolbar > Save
 6. Orbit model to view in 3D
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Return to top view

 7. Home tab > Layers panel > Layer Properties to turn on/off 3D simulation objects same as 
the 2D objects.

Punch throughs

swept-pth-grnd-clrnc-03.mp4 7:07

Create punch through at specific areas of concern

Info: Punch throughs are essentially cross sections

 1. Home tab > Draw panel > Line tool
 A. Draw lines at locations of where you want to create a punch through. Can be in any dir-

ection. The line needs to go through the entire swept path. We will analyze a few con-
flict areas.

 2. AutoTURN Pro 3D > Analyze > Punch Through
 A. Pick a 3D turn simulation

 B. Pick a line to create a punch through and report

 C. Place punch through report in the drawing

 D. Analyze Punch Through (see image for recommended settings) 
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Tip: Dimensions do not always end up where you may want them. We recom-
mend using Civil 3D dimension tools.

OK

 3. Repeat step 2 for other lines, changing the Section Name for each.

Create multiple punch throughs

 4. Home tab > Draw panel > Line tool
 A. Draw one line at the first location where a punch through is desired
 B. Measure the distance forward to create multiple punch throughs

 5. AutoTURN Pro 3D > Analyze > Punch Through
 A. Pick a 3D turn simulation

 B. Pick a line to create a punch through and report

 C. Place punch through report in the drawing

 D. Analyze Punch Through
 I. Section Name: 4

 II. Multiple Cross Sections: checked
 III. Direction: Forward
 IV. Distance: 70 ft
 V. Interval 2 ft

OK

An array of punch throughs will be created

 6. WisDOT Sheets tab > WisDOT Annotation panel > Dimension to check conflict amount

Warning: Punch throughs are not dynamic to the lines, simulation, and surface that created 
them. New punch throughs need to be created if anything changes.

3D Animation

swept-pth-grnd-clrnc-04.mp4 3:16

Create 3D animation

 1. Orbit to desire point of view
 2.  Home tab > Layers panel > Freeze

 A.  Select punch throughs in modelspace
 3. Home tab > Layers panel > Layer Properties

 A. Freeze AT-DSTLowboy-Conflict
 4. Click surface Ex in modelspace to select it
 5. Contextual ribbon > Modify panel > Surface Properties

 A. Information tab > Surface Style: Pavement Triangles
 B. OK

 6. View > Visual Styles > View Styles dropdown > Conceptualto see the simulation better in 
3D

Page: 1265

Published on: 5/17/2023

Ground clearance analysis

https://c3dkb.dot.wi.gov/video/dsn-chk/swept-pth/swept-pth-grnd-clrnc-04.mp4


 7. AutoTURN Pro 3D > Visualize > Animate
 A. Pick a Simulation or Path in the Drawing

Tip: The 3D arrow markers along the path work best for this.

 8. Run Animation Dialog
 A. Hide Simulation: checked to turn off swept path display.
 B. Drag slider to drive vehicle along path

Info: There are options for recording an animation from different view per-
spectives.

 C. Close
 9. View tab > Visual Styles panel > View Styles dropdown > 2D Wireframe

 10. View tab > View panel > Top

Switch existing surface to design surface

swept-pth-grnd-clrnc-05.mp4 2:15

The following steps will switch the existing surface with a design surface in the ground clearance sur-
face.

 1. Toolspace > Prospector > Data Shorcuts > Surfaces > Refinement > Click and drag Rfnt-
CrwndCircRdwy into modelspace to data shortcut reference the revised design surface

 2. Toolspace > Prospector > Surfaces > GC > Right click Edits > Paste Surface...to paste the 
new surface into the GC surface

 A. Click Rfnt-CrwndCircRdwy
 B. OK

 3. Toolspace > Prospector > Surfaces > Right click GC > Properties
 A. Definition tab > Paste Add surface Ex: unchecked
 B. OK
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Regenerate Simulation

 4. AutoTURN Pro 3D > Edit panel > Regenerate Simulation
 A. Pick a Simulation in the Drawing

Recheck Ground Clearance

Warning: Punch throughs are not dynamic and need to be redone

Compare existing cross slope profiles with superelevation 
design
Last updated: 2021-11-10

Total video time: 19:48

This workflow creates a profile view to compare existing pavement slopes to proposed super-
elevation slopes.  Plan and profile sheets based on the cross slope data may also be created for pro-
ject documentation and review.

The same alignment should be used through out this workflow.

Info: For this workflow, a scale of 1IN:100FT with a 1:10 vertical exaggeration is recommended 
but not required.

Multiple WisDOT tools are used in this workflow.

File setup and create cross slope profile

dsn-chk-cros-slp-prfl-01.mp4 5:34

File setup

 1. Start a new drawing from design-start.dwt template
 2. Save file as ProjectID\Design\Design Checks\Cross Slope Prof < Alignment> Ex.dwg
 3. Data reference: 

 A. Existing surface: (Exist) 
 I. Surface style: EX Border

 B. Mainline and sideroad reference alignments (51) 
 I. Perform superelevation design for reference alignments prior to starting this 

workflow.
 II. Use WisDOT Design tab > Design panel > Alignment > Alignment - Adjust 

Superelevation Runout to update shoulder superelevation transitions to 
WisDOT standards

 4. X-ref files: 
 A. Existing topography (topo-ex.dwg)
 B. Existing utilities (util-ex.dwg)

 5. Set the annotation scale to 1IN:100FT
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 6. `WisDOT Sheets tab > Manage panel > Add Components > All Components`
 A. All Components will add all the WisDOT plan production elements (leader styles, 

dimension styles, etc.) that are not initially included in the WisDOT drawing template.
 7. Double click mouse wheel to zoom extents
 8. Label Superelevation Critical Points along the alignment 

 A. Select the alignment
 B. Right-click > Edit Alignment Labels...

 I. Alignment Label dialog box 
 a. Type (dropdown): Superelevation Critical Points
 b. Superelevation Label Style (dropdown): WisDOT Standard
 c. Add

 i. Check Superelevation Points as needed
 ii. OK

 d. OK
 9. Save the file

Create cross slope profiles

Create cross slope profiles of the existing pavement.  It is recommended to use an offset that is 1 or 2 
feet inside the lane edge to better represent the lane slope.

See C3DKB training on the WisDOT tool Profile - Create Cross Slope Profile for further instructions.

 1. WisDOT Design tab > Design panel > Profile dropdown > Profile - Create Cross Slope 
Profile

 2. Entries for creating a profile of the pavement cross slopes along a lane left of the alignment:
 A. Select Surface: Exist
 B. Select Alignment: 51-Ex
 C. Start Station: 536+00
 D. End Station: 581+00
 E. Station Interval: 25
 F. Enter Offset 1: -1
 G. Enter Offset 2: -10
 H. Profile Name: 51-Ex-CrossSlope-L

 3. OK
 4. OK
 5. Repeat the process for a lane right of the alignment.

 A. Enter Offset 1: 1
 B. Enter Offset 2: 10
 C. Profile Name: 51-Ex-CrossSlope-R

 6. OK
 7. OK
 8. Close

Create superelevation profiles

Page: 1268

Published on: 5/17/2023

Create superelevation profiles

../../../../../../Content/c3d/wisdot-cstm/c3d-tab/dsn/dsn-prfl-creat-crs-slp-prfl.htm
../../../../../../Content/c3d/wisdot-cstm/c3d-tab/dsn/dsn-prfl-creat-crs-slp-prfl.htm
../../../../../../Content/c3d/wisdot-cstm/c3d-tab/dsn/dsn-prfl-creat-crs-slp-prfl.htm


dsn-chk-cros-slp-prfl-02.mp4 4:52

Create superelevation profiles based on a selected design criteria file.

See C3DKB training on the WisDOT tool Create Superelevation Profiles for further instructions. 

 1. WisDOT Design tab > Design panel > Profile dropdown > Create Superelevation Profiles
 2. Left Outside Lane: Checked
 3. Right Outside Lane: Checked
 4. OK
 5. OK
 6. Close

When the command finishes, new profiles are created for each lane and shoulder selected.

 l 51-Ex-SE-L-OutLn
 l 51-Ex-SE-R-OutLn

It may be helpful to create an additional profile to emphasize the line that represents a cross slope 
of 0. The easiest way to do this is to use the Control Profile Editor. See training on the WisDOT tool 
Profile - Control Profile Editor for further instructions.

Create profile view

 1. Home tab > Profile & Section Views panel > Profile View dropdown > Create Profile 
View

 A. General
 I. Select alignment = 51-Ex

 II. Profile view name = 51-ExPavtSlp
 III. Profile view style = Superelevation

 B. Station Range
 I. User specified = selected

 II. Start = 536+00
 III. End = 581+00

 C. Profile View Height
 I. User specified = selected

 II. Minimum = -20'
 III. Maximum = 20'

 a. Note that for this analysis the profile height represents a slope percent 
and not an elevation

 D. Profile Display Options
 I. Draw = uncheck all profiles except the cross slope and superelevation pro-

files
 II. Style

 a. 51-Ex-CrossSlope-L = PROF CrossSlope-L
 b. 51-Ex-CrossSlope-R = PROF CrossSlope-R
 c. 51-Ex-SE-L-OutLn = SE Lane-L
 d. 51-Ex-SE-R-OutLn = SE Lane-R
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 III. Labels = _No Labels (51-Ex-CrossSlope-L, 51-Ex-CrossSlope-R)
 IV. Labels = Superelevation (51-Ex-SE-L-OutLn, 51-Ex-SE-R-OutLn)

 E. Data Bands
 I. Select band set = Superelevation

 II. Set band properties
 a. Style: Cross Slope Left > Profile1 = 51-Ex-CrossSlope-L

 i. Profile created using the Create Cross Slope Profile WisDOT tool
 b. Style: Cross Slope Right > Profile1 = 51-Ex-CrossSlope-R

 i. Profile created using the Profile - Create Cross Slope Profile 
WisDOT tool

 F. Create Profile View
 G. CREATEPROFILEVIEW Select profile view origin

 I. Pick the location where the lower left corner of the profile view will be placed
 H. REA to refresh modelspace

Updating profile data

dsn-chk-cros-slp-prfl-03.mp4 3:55

The cross slope profiles created with this workflow are not dynamic and will need to be recreated if 
there are any updates to the alignment and surface used when the profiles were created.

The superelevation profiles created with this workflow are not dynamic and are based on the align-
ment and superelevation design at the time the profiles were created.

The superelevation profiles will need to be recreated if:

 l a curve radius is changed along the alignment and the superelevation design is recalculated
 l a different superelevation table standard is used for the superelevation design

 1. Repeat the process shown in "Create superelevation profiles" on page 1268 shown above.

 2. Select the profile view grid > Profile View Properties > Bands tab

 A. Profile1 column

 I. Profile Data - Cross Slope Left = 51-Ex-CrossSlope-L
 II. Profile Data - Cross Slope Right = 51-Ex-CrossSlope-R

 3. OK

Warning: Always check to make sure the correct cross slope profiles are used for the slope 
labels along the bottom of the profile view.

Create plan & profile sheets (optional)

dsn-chk-cros-slp-prfl-04.mp4 4:24
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Creating plan and profile sheets based on the cross slope data may be beneficial for project doc-
umentation and review.  See the "Plan/profile sheet" on page 1559 workflow  for additional inform-
ation.

Notes

 1. Use the Superelevation Critical Points alignment labels to help determine where to adjust the 
view frames before creating the sheets.  Try to include the entire superelevation transition on 
the same sheet.

 2. Create View Frames based on a scale of 1 IN:100 FT
 A. Output tab > Plan Production panel > Create View Frames

 I. Create View Frames dialog box
 a. Sheets

 i. Sheet Settings
 i. Sheet Type = Plan and Profile
 ii. Template for Plan and Profile sheet

 i. Click on the ellipse button 
 i. Drawing template file name = C:\Wis-

dot\Stnd\C3D2020\Templates\Sheets\05-
PP-wdot.dwt

 ii. Select the ellipse button for additional 
sheet templates

 ii. Select a layout to create new sheets = PlanProf 1 
IN 100FT

 b. Profile Views
 i. Profile View Style > Select profile view style = Superelevation
 ii. Band Set > Select band set style = Superelevation

 3. Create Sheets
 A. Output tab > Plan Production panel > Create Sheets

 I. Create Sheets dialog box
 a. Profile Views

 i. Other profile view options > Choose settings: > Profile View 
Wizard

 i. Profile Display Options
 i. Labels = _No Labels (51-Ex-CrossSlope-L, 51-Ex-

CrossSlope-R)
 ii. Labels = Superelevation (51-Ex-SE-L-OutLn, 51-Ex-

SE-R-OutLn)
 ii. Data Bands

 i. Profile1 column
 i. Profile Data - Cross Slope Left = 51-Ex-

CrossSlope-L
 ii. Profile Data - Cross Slope Right = 51-Ex-

CrossSlope-R
 4. The cross slope profile should be centered in the sheets profile view.  Use the Profile View - 

Profile View Elevation Range WisDOT tool to adjust the minimum and maximum elevations 

Page: 1271

Published on: 5/17/2023

Create plan & profile sheets (optional)

../../../../../../Content/c3d/wisdot-cstm/c3d-tab/dsn/dsn-prfl-vu-elvatn-rang.htm
../../../../../../Content/c3d/wisdot-cstm/c3d-tab/dsn/dsn-prfl-vu-elvatn-rang.htm


for all the sheet profile views.
 A. Minimum elevation  = -20
 B. Maximum elevation = 20

Warning: Always check to make sure the correct cross slope profiles are used for the slope 
labels along the bottom of the profile view.

3D sight distance analysis
Last updated: 2022-09-16

Total video time 54:46

Warning: This workflow can be used for the 3D analysis of stopping sight distance and 
decision sight distance. It is not sufficient for intersection sight distance analysis. Use the "Inter-
section sight distance - 3D analysis" on page 1294 workflow for intersection sight distance ana-
lysis.

Standards
Sight Distances requirements: FDM 11-10-5.1, Attachments for FDM 11-10-5

Introduction and initial setup

dsn-chk-3d-sit-anlysis-01.mp4 3:03

Exercise files: dsn-chk-3d-sit-anlysis-begin-data-c3d22.zip

Begin with file 11701970\dsgn\check\SightDistance-51-Exist.dwg

This training will cover the creation of plan and profile sheets to display the results of a sight dis-
tance analysis.  Sight lines based on the design speed are shown in the plan view and the available 
sight distance is shown in the profile view.  The profile view elements and format are based on the 
example shown below.
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In the sight distance analysis plan and profile sheet, the y-axis of the profile is sight distance length 
instead of elevation.

Info: 
The training covers analyzing existing conditions but may also used to analyze proposed 
designs.

For proposed designs, it is recommend that a Cmbn-Ex-Top surface is created (a combination 
of the refinement Top surface with the existing ground surface) for this analysis.

Obstruction surfaces can be evaluated with either existing or proposed conditions.

Sight distance checks

Sight distance checks can be conducted for a variety of documentation needs.

Existing Conditions based on

 l Existing alignment
 l Existing surface

Proposed Conditions based on

 l Proposed alignment
 l Combined existing surface and proposed top surface

Available sight distance for each direction of travel Example:

 l northbound/southbound
 l eastbound/westbound
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Reported distances

See Visibility Check - Check Sight Distance for documentation on how the WisDOT tool reports dis-
tances.

Create analysis file

dsn-chk-3d-sit-anlysis-02.mp4 4:05

 1. Start a new drawing from design-start.dwt template
 2. Save file as:

 A. ProjectID\dsgn\check\SightDistance-< AlignName >-Exist.dwg for existing con-
ditions

 B. ProjectID\dsgn\check\SightDistance-< AlignName >-Prop.dwg for proposed con-
ditions

 3. Data reference:
 A. Surface(s) to be analyzed
 B. Reference alignment

 4. X-ref files:
 A. Existing topography
 B. Pavement edgelines

Add file components

 1. WisDOT Sheets tab > Manage panel > Add Components dropdown > All Components

 A. Adding All Components will add all the WisDOT plan production elements (leader 
styles, dimension styles, etc.) that are not initially included in the WisDOT drawing tem-
plate.

 2. Save the file

Create feature lines along obstructions

dsn-chk-3d-sit-anlysis-03.mp4 5:07

The sight distance check is a 3D analysis that will examine both the horizontal and vertical impacts.  
Surfaces are created to represent the obstructions along the project.  Feature lines may be used to 
outline the obstruction.

 1. Toolspace palette > Prospector tab > Surfaces > Right-click on Exist surface > Surface 
Properties

 A. Surface style: EX Border
 B. OK

 2. Zoom to station 548+85 along the 51 alignment near the Wallace Road intersection.

Treeline obstruction
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 3. Home tab > Create Design panel > Feature Line dropdown > Create Feature Line
 A. Name = Trees-54900-55900-R
 B. OK
 C. DRAWFEATURELINE Specify start point: Left-click to begin the treeline obstruc-

tion feature line along the right side of the 51 alignment near STA 548+85
 D. DRAWFEATURELINE Specify elevation or [Surface]:Enter to accept elev-

ation of 0.0
 E. DRAWFEATURELINE Specify the next point or [Arc]: Left-click next loc-

ation along the treeline
 F. DRAWFEATURELINE Specify grade or [Slope Elevation Difference SUr-

face Transition]:Enter to accept grade of 0.0
 G. DRAWFEATURELINE Specify the next point or [Arc Length Close 

Undo]: Left-click next location along the treeline
 H. Continue process to the end of the treeline obstruction near STA 559+00
 I. DRAWFEATURELINE Specify the next point or [Arc Length Close 

Undo]:Enter to complete the command
 4. Left-click to select feature line representing the treeline obstruction

 A. Feature Line contextual ribbon > Edit Elevations panel > Elevations from Sur-
face icon

 B. Set Elevations from Surface dialog box 
 I. Surface = Exist

 II. Insert intermediate grade break points = checked
 III. OK

 C. FEATUREELEVSFROMSURF Select object or [Multiple Partial]: Left-click 
to select feature line

 D. Enter
 E. Esc

Building obstruction

 5. Home tab > Create Design panel > Feature Line dropdown > Create Feature Line

 A. Name = Bldg-54850-R
 B. OK
 C. DRAWFEATURELINE Specify start point: Left-click to begin the treeline obstruc-

tion feature line along the right side of the 51 alignment near STA 548+74
 D. DRAWFEATURELINE Specify elevation or [Surface]:Enter to accept elev-

ation of 0.0
 E. DRAWFEATURELINE Specify the next point or [Arc]: Left-click next loc-

ation along the treeline
 F. DRAWFEATURELINE Specify grade or [Slope Elevation Difference SUr-

face Transition]:Enter to accept grade of 0.0
 G. DRAWFEATURELINE Specify the next point or [Arc Length Close 

Undo]: Left-click next location along the treeline
 H. Continue process to the end of the building obstruction
 I. DRAWFEATURELINE Specify the next point or [Arc Length Close 

Undo]:C to complete the command
 6. Left-click to select feature line representing the building obstruction
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 A. Feature Line contextual ribbon > Edit Elevations panel > Elevations from Sur-
face icon

 B. Set Elevations from Surface dialog box 
 I. Surface = Exist

 II. Insert intermediate grade break points = not checked
 a. Note: if the feature line does not cross a void in the surface, check this 

option.
 III. OK

 C. FEATUREELEVSFROMSURF Select object or [Multiple Partial]: Left-click 
to select feature line

 D. Enter
 E. Esc

 7. Save the file

Create obstruction surfaces

dsn-chk-3d-sit-anlysis-04.mp4 3:25

Building obstruction

 1. WisDOT Design tab > Design panel > Surfaces dropdown > Create Wall Surface

 A. DOTCREATEWALLSURFACE Select Feature Line, Survey Feature, or 3D 

Polyline: Left-click feature line that is the treeline.
 B. DOTCREATEWALLSURFACE Pick side to offset: Left-click inside the closed fea-

ture line.
 C. DOTCREATEWALLSURFACE Build to [Height Minimum Height 

Elevation]:Height
 D. DOTCREATEWALLSURFACE Enter height:20Enter
 E. DOTCREATEWALLSURFACE Enter Surface name:Bldg-54850-REnter

 I. The surface is created
 F. Esc

Treeline obstruction

 2. WisDOT Design tab > Design panel > Surfaces dropdown > Create Wall Surface

 A. DOTCREATEWALLSURFACE Select Feature Line, Survey Feature, or 3D 

Polyline: Left-click feature line that is the treeline.
 B. DOTCREATEWALLSURFACE Pick side to offset: Left-click to the right of the fea-

ture line.
 C. DOTCREATEWALLSURFACE Build to [Height Minimum Height 

Elevation]:Height
 D. DOTCREATEWALLSURFACE Enter height:30Enter
 E. DOTCREATEWALLSURFACE Enter Surface name:Trees-54900-55900-REnter

 I. The surface is created
 3. Esc

 4. View in object viewer
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 A. Left-click on the Trees-54900-55900-R, Bldg-54850-R and Exist surface
 B. Contextual ribbon > General Tools panel > Object Viewer
 C. Left-click and drag to rotate and view treeline surface
 D. Close

 5. Save the file

Create Available Sight Distance (ASD) profile views

dsn-chk-3d-sit-anlysis-05.mp4 3:45

Northbound ASD profile view

 1. Home tab > Profile & Section Views panel > Profile View dropdown > Create Profile 
View

 A. General 
 I. Select alignment = 51

 II. Profile view name = 51-NB
 III. Profile view style = Sight Distance

 B. Station Range 
 I. Automatic = selected

 C. Profile View Height 
 I. User specified = selected

 II. Minimum = 0.00'
 III. Maximum = 1700'

 a. Note that for this analysis the profile height represents sight distance 
and not an elevation

 D. Profile Display Options 
 I. Draw = uncheck all profiles

 E. Data Bands 
 I. Select band set = Sight Distance

 F. Create Profile View
 G. CREATEPROFILEVIEW Select profile view origin

 I. Left-click the location where the lower left corner of the profile view will be 
placed

Southbound ASD profile view

 2. Home tab > Profile & Section Views panel > Profile View dropdown > Create Profile 
View

 A. General 
 I. Select alignment = 51

 II. Profile view name = 51-SB
 III. Profile view style = Sight Distance

 B. Station Range 
 I. Automatic = selected

Page: 1277

Published on: 5/17/2023

Create Available Sight Distance (ASD) profile views

https://c3dkb.dot.wi.gov/video/dsn-chk/dsn-chk-3d-sit-anlysis-05.mp4


 C. Profile View Height 
 I. User specified = selected

 II. Minimum = 0.00'
 III. Maximum = 1700'

 a. Note that for this analysis the profile height represents sight distance 
and not an elevation

 D. Profile Display Options 
 I. Draw = uncheck all profiles

 E. Data Bands 
 I. Select band set = Sight Distance

 F. Create Profile View
 G. CREATEPROFILEVIEW Select profile view origin

 I. Left-click the location where the lower left corner of the profile view will be 
placed

Info: The profile view grid lines are located on layers E_PROF_Grid and E_PROF_GridMin and may 
be turned off to make it easier to see the sight distance profiles.

 3. Save the file

Create Available Sight Distance (ASD) profiles

dsn-chk-3d-sit-anlysis-06.mp4 5:41

Perform a sight distance check that is based on a sight distance greater than what is required for the 
design speed.  The analysis results are then used to generate a profile that will show the overall sight 
distance that is available.  This gives the designer a better sense of the overall proximity between the 
available and required sight distances.

A sight distance of 1550 feet is initially used in the analysis to create the available sight distance pro-
file.  This sight distance is greater than the Decision Sight Distance Avoidance Maneuver C of 1180 
feet for a design speed of 75 mph.  This value may be adjusted based design project needs.
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Northbound ASD profile

 1. WisDOT Design tab > Analyze panel > Visibility Check dropdown > Check Sight 
Distance

 A. Check Sight Distance dialog box - Input

 I. Alignment = 51
 II. Start Station = 51800

 III. End Station = 60400
 IV. Check Increment = 25
 V. Sight Distance = 1550

 VI. Object Height = 24 in (SSD)
 VII. Eye/Object Offset = 6.0 (middle of the lane)

 VIII. Terrain Surface = Exist
 IX. Obstruction Surfaces = Bldg 54850-R, Trees 54900-55900-R

 B. Check Sight Distance dialog box - Output

 I. Create Profile = checked
 a. Name = ASD_51_NB_24IN_Exist_1550

 i. naming convention: Available Sight Distance_ < Alignment name> _ 
< Direction of travel > _ < Object height > _ < Exist/Prop condition > _ 
< Sight distance analyzed >

 C. OK

 D. Do not close the Check Sight Distance dialog box

 2. Do not close the Check Sight Distance dialog box
 3. Save the file
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Southbound ASD profile

 1. The Check Sight Distance dialog box should still be open.
 2. Click the Reverse button

 A. Check Sight Distance dialog box - Input 
 I. Alignment = 51

 II. Start Station = 604+00
 III. End Station = 518+00
 IV. Check Increment = 25
 V. Sight Distance = 1550

 VI. Object Height = 24 in (SSD)
 VII. Eye/Object Offset = 6.0 (middle of the lane)

 VIII. Terrain Surface = Exist
 IX. Obstruction Surfaces = Bldg 54850-R, Trees 54900-55900-R

 B. Check Sight Distance dialog box - Output 
 I. Create Profile = checked

 a. Name = ASD_51_SB_24IN_Exist_1550
 i. naming convention: Available Sight Distance_ < Alignment name> _ 

< Direction of travel > _ < Object height > _ < Exist/Prop condition > _ 
< Sight distance analyzed >

 C. OK

Info: The profile view stationing will appear increasing in value as it does for the northbound 
or eastbound direction.  The profile distance values have been generated in the direction of 
decreasing station values.

 4. Select the 51-NB profile view

 A. Profile View:51-NB contextual ribbon > Modify View panel > Profile View Prop-
erties > Profiles tab

 B. Clear/Unselect the Draw check mark for profile ASD_51_SB_24IN_Exist_1550
 C. OK
 D. Esc

 5. Select the 51-SB profile view

 A. Profile View:51-SB contextual ribbon > Modify View panel > Profile View Prop-
erties > Profiles tab

 B. Clear/Unselect the Draw check mark for profile ASD_51_NB_24IN_Exist_1550
 C. OK
 D. Esc

 6. Save the file

Create required Stopping Sight Distance (SSD) and Decision Sight 
Distance (DSD) profiles

dsn-chk-3d-sit-anlysis-07.mp4 4:25
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See Sight Distance Attachments in FDM Section 11-10 Design Controls for required standards.

Review design speeds throughout the project. Profile adjustments will need to be made at locations 
where the design speed changes.

 1. Home tab > Create Design panel > Profile dropdown > Profile Creation Tools

 A. CREATEPROFILELAYOUT Select profile view to create profile: Left-
click to select the 51-NB profile view

 B. Create Profile - Draw New 
 I. Name = SSD_51_Exist

 II. General tab > Profile style = SD Stopping Sight Distance
 III. General tab > Profile label set = _No Labels
 IV. OK

 C. Profile Layout Tools - SSD_51_Exist 
 I. Draw Tangents

 II. Specify start point:

 a. Transparent Command - Profile Station Elevation
 b. PSE >>Select a profile view:  Left-click to select the 51-NB pro-

file view
 c. PSE >>Specify station:51700Enter
 d. PSE >>Specify elevation:250Enter (required stopping sight dis-

tance for 35 mph design speed)
 e. PSE >>Specify station:55494Enter
 f. PSE >>Specify elevation:250Enter
 g. PSE >>Specify station:55495Enter
 h. PSE >>Specify elevation:425Enter (required stopping sight dis-

tance for 50 mph design speed)
 i. PSE >>Specify station:67520Enter
 j. PSE >>Specify elevation:425Enter

 k. Enter
 l. Esc (to end transparent command) 

 i. Profile will appear in both 51-NB and 51-SB profile views since 
they are based on the same alignment.

 III. Esc (to end profile creation command)
 D. Close Profile Layout Tools

 2. Save the file
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Info: Additional profile(s) will need to be created for Category 2 Decision Sight Distances if 
required. Profiles for the required SSDs and DSDs will be needed for each direction for mul-
tilane facilities.

Create sight lines based on required sight distances

dsn-chk-3d-sit-anlysis-08.mp4 5:32

In this training segment the Check Sight Distance tool is used to create the sight lines for a plan view 
based on the required sight distance for the roadway design speed.  A text report may also be cre-
ated for project documentation.

See Sight Distance Attachments in FDM Section 11-10 Design Controls for required standards.

Info: NOTE: A separate analysis will need to be run if there are different design speeds along 
the project.  A separate analysis will also need to be performed if Decision Sight Distance sight 
lines are needed. 

Northbound sight lines

 1. WisDOT Design tab > Analyze panel > Visibility Check dropdown > Check Sight 
Distance

 A. Check Sight Distance dialog box - Input 
 I. Alignment = 51

 II. Start Station = 55495
 III. End Station = 60400
 IV. Check Increment = 25
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 V. Sight Distance = 425
 VI. Object Height = 24 in (SSD)

 VII. Eye/Object Offset = 6.0 (middle of the lane) 
 a. This is the distance the driver's eye and object are offset from the align-

ment. Positive values are always to the right of the alignment based on 
the direction of travel.

 VIII. Terrain Surface = Exist
 IX. Obstruction Surfaces = Bldg 54850-R, Trees 54900-55900-R

 B. Check Sight Distance dialog box - Output 
 I. Create Report = checked

 a. Location = 11701970\dsgn\check\SSD_51_NB_24IN_Exist_425.csv
 i. naming convention: Stopping Sight Distance_ < Alignment name> _ 

< Direction of travel > _ < Object height > _ < Exist/Prop condition > _ 
< Sight distance analyzed >

 II. Create Sight Lines = checked
 a. Travel Direction for Layer Assignment = NB

 C. OK
 D. Do not close the Check Sight Distance dialog box

 2. Save the file

Tip: The individual SIGHT_* layers can be turned on and off to display specific analysis results.

Southbound sight lines

 1. The Check Sight Distance dialog box should still be open.

 A. Check Sight Distance dialog box - Input 
 I. Click the Reverse button 

 a. Alignment = 51
 b. Start Station = 60400
 c. End Station = 55495
 d. Check Increment = 25
 e. Sight Distance = 425
 f. Object Height = 24 in (SSD)
 g. Eye/Object Offset = 6.0 (middle of the lane) 

 i. This is the distance the driver's eye and object are offset from 
the alignment. Positive values are always to the right of the align-
ment based on the direction of travel.

 h. Terrain Surface = Exist
 i. Obstruction Surfaces = Bldg 54850-R, Trees 54900-55900-R

 B. Check Sight Distance dialog box - Output 
 I. Create Report = checked 

 a. Location = 11701970\dsgn\check\SSD_51_SB_24IN_Exist_425.csv
 i. naming convention: Stopping Sight Distance_ < Alignment name> _ 

< Direction of travel > _ < Object height > _ < Exist/Prop condition > _ 
< Sight distance analyzed >
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 II. Create Sight Lines = checked 
 a. Travel Direction for Layer Assignment = SB

 C. OK
 D. Close

 2. Save the file

Tip: The individual SIGHT_* layers can be turned on and off to display specific analysis 
results.

Review sight line data

See Visibility Check - Check Sight Distance for created sight line and report documentation.

Create view frames

dsn-chk-3d-sit-anlysis-09.mp4 3:29

Plan sheets will be created for each condition, alignment and direction that is being analyzed.

 1. Output tab > Plan Production panel > Create View Frames

 A. Alignment 
 I. Alignment = 51

 II. Station Range = User specified
 III. Start = 518+00
 IV. End = 589+00

 B. Sheets 
 I. Sheet Settings 

 a. Sheet Type = Plan and Profile
 II. Template for Plan and Profile sheet 

 a. Drawing template file name = C:\Wis-
dot\Stnd\C3D20XX\Templates\Sheets\05-PP-wdot.dwt

 b. Select a layout to create new sheets = PlanProf 1 IN 100 FT
 C. View Frame Group 

 I. View Frame Group > Name = SIGHT DISTANCE ANALYSIS - NORTHBOUND
 II. View Frame > Name = Left-click on Edit View frame name... icon

 a. Name 
 i. Delete and clear out default name
 ii. Property fields > select Next Counter > Insert
 iii. Type -NB
 iv. End result should be <[Next Counter]>-NB

 b. Number style = 01, 02, 03...
 c. Starting number = 1
 d. OK

 D. Match Lines 
 I. Match Line > Style = _No Display

 II. Labels > Left label style = none
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 III. Labels > Right label style = none
 E. Profile Views 

 I. Profile View Style > Select profile view style = Sight Distance
 II. Band Set > Select band set style = Sight Distance

 F. Create View Frames
 2. Save the file

Create Sheet Set

dsn-chk-3d-sit-anlysis-10.mp4 2:24

 1. SSM

 2. Sheet Set Manager palette > Open dropdown > New Sheet Set...

 A. Begin 
 I. An example sheet set = selected

 II. Next
 B. Sheet Set Example 

 I. Browse to another sheet set to use as an example = selected
 a. Use file C:\Wis-

dot\Stnd\C3D20XX\Components\SheetSets\ProjectSheetData.dst
 II. Next

 C. Sheet Set Details 
 I. Name of new sheet set = 11701970-SightDistance

 II. Store sheet set data file (.dst) here = 11701970\dsgn\check
 III. Sheet Set Properties 

 a. Sheet Set Custom Properties 
 i. County = ONEIDA-VILAS
 ii. Highway = USH 51
 iii. Project No = 1170-19-70
 iv. OK

 IV. Next
 D. Confirm 

 I. Finish

Create sight distance plan and profile sheets

dsn-chk-3d-sit-anlysis-11.mp4 6:53

Plan and profile sheets

 1. Output tab > Plan Production panel > Create Sheets
 2. View Frame Group and Layouts

 A. View Frame Group = SIGHT DISTANCE ANALYSIS - NORTHBOUND
 B. View frame range = All
 C. Layout Creation = All layouts in the current drawing
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 D. Layout name = Left-click on Edit View frame name... icon
 I. Name 

 a. Delete and clear out default name
 b. Property fields > select Next Counter > Insert
 c. Type -NB
 d. End result should be <[Next Counter]>-NB

 II. Number style = 01, 02, 03...
 III. Starting number = 1
 IV. OK

 E. Choose the north arrow block to align in layouts = SheetWizard-NorthArrow
 3. Sheet Set

 A. Sheet Set = select Add to existing sheet set
 I. Left-click the ellipse icon to select sheet set = 11701970-SightDistance

 B. Sheet set storage location = 11701970\dsgn\check
 C. Sheet file name = USH51-NB

 4. Profile Views

 A. Other profile view options 
 I. Get other settings from an existing profile view = selected

 a. Profile view = 51-NB
 5. Create Sheets
 6. OK
 7. CREATESHEETS Select profile view origin

 A. Left-click the location where the lower left corner of the profile view will be placed
 8. REA

 A. This may be needed to regenerate the graphics in order for the profile view grid lines 
to be displayed

 9. Right-click over "Layout1" tab > Delete > OK

 A. "Layout1" tab that will not be used in the file is deleted.
 10. Close the panorama

Profile view adjustments

 1. WisDOT Design tab > Design panel > Profile View menu > Profile View Elevation Range
 2. DOTPROFILEVIEWELEVRANGE Select Profile Views: Select the profile views to be 

adjusted
 3. Enter
 4. DOTPROFILEVIEWELEVRANGE Enter Minimum Elevation [Same]:0 Enter
 5. DOTPROFILEVIEWELEVRANGE Determine height by [New Same Elevation]:

 A. Click Elevation
 I. Enter maximum elevation greater than (minimum elevation 

entered):1600 Enter
 6. Save the file

Plan sheet annotation
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dsn-chk-3d-sit-anlysis-12.mp4 6:57

 1. Set active layer to P_MISC_Text
 2. Left-click on sheet tab 01-NB
 3. WisDOT Design tab > Manage panel > Palettes ON/OFF to toggle the palette on and off.
 4. WisDOT Design tab > Analyze panel > Visibility Check dropdown > Sight Distance 

Palette

Required stopping sight distance profile annotation

 1. Sight Distance Tool Palette > Multileaders > CATEGORY X SIGHT DISTANCE REQUIRED, 
SSD FOR XX-MPH (24-IN OBJECT)

 A. EXECUTETOOL Specify leader arrowhead location or [leader Landing 
first Content first Options]

 I. Shift-right-click > Nearest snap 2. Left-click select a location along the 
required stopping sight distance profile

 II. EXECUTETOOL  Specify leader landing location: 
 a. Left-click select the location where the text will be located
 b. EXECUTETOOL Overwrite default text [Yes No]NoEnter
 c. Double left-click on multileader text to edit text
 d. Update text to display CATEGORY 1 SIGHT DISTANCE REQUIRED, SSD 

FOR 35-MPH (24-IN OBJECT)
 e. Left-click outside the text area to end the command

Available sight distance profile annotation

 4. Sight Distance Tool Palette > Multileaders > NB SIGHT DISTANCE AVAILABLE, TO 24-IN 
OBJECT

 5. EXECUTETOOL Specify leader arrowhead location or [leader Landing 
first Content first Options]

 A. Shift-right-click > Nearest snap
 B. Left-click select a location along the available sight distance profile for a 24 inch object

 6. EXECUTETOOL  Specify leader landing location:

 A. Left-click select the location where the text will be located
 B. EXECUTETOOL Overwrite default text [Yes No]NoEnter

 7. Double left-click on multileader text to edit text along the available sight distance profile for a 
24-inch object

 A. Update text as needed
 B. Left-click outside the text area to end the command

Sight distance profile dimension block

 1. Sight Distance Tool Palette > Blocks > SSD_PROFILE_DIM
 2. EXECUTETOOL Specify insertion point or [Basepoint Scale X Y Z Rotate]

 A. Left-click select the location where the text will be located
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 3. Left-click select the dynamic block to make adjustments
 A. Left-click the blue square base point on the left side of the block to move it to the 

desired location
 B. Triangle grips allow the dimension lines to be adjusted
 C. Square grips near the text allow the block text to be moved
 D. Select the dropdown triangle to change the message for the dimensioned condition 

See the example exhibit at the beginning of this training for additional guidance on labeling sight dis-
tance conditions.

Profile band information

 1. Double-left-click profile viewport
 A. Model space is activated within the viewport

 2. Left-click to select the profile band (lines above stationing)
 3. Profile view contextual ribbon > Modify View panel > Profile View Properties

 A. Bands tab 
 I. Style = Distance Left (Available Sight Distance) 

 a. Profile1 = ASD_51_NB_24IN_Exist_1550
 II. Style = Distance Right (Stopping Sight Distance) 

 a. Profile1 = SSD_51_Exist
 B. OK

 4. Double-left-click outside the viewport
 A. Working in model space within the layout is deactivated

 5. Save the file

Exercise files: dsn-chk-3d-sit-anlysis-end-data-c3d22.zip

Profile sight distance analysis
Last updated: 2023-01-24

Total video time 11:00

This workflow is used to analyze a profile for the required stopping, decision or passing sight dis-
tance. It is not sufficient for intersection or 3D sight distance analysis. This training covers the cre-
ation of an Excel report, an available sight distance profile and sight lines in the profile view.
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The workflow may be used during the scoping phase of a project when limited data for existing con-
ditions is available or it is determined that a profile analysis is sufficient to meet project needs. Typ-
ically, in these situations, surface data is not available and only a surveyed centerline or as-built 
information is available.

See "3D sight distance analysis" on page 1272 for sight analysis based on surfaces and creating 
optional plan and profile sheets.

Standards
Sight Distances requirements: FDM 11-10-5.1, Attachments for FDM 11-10-5

Introduction and Initial Setup

dsn-chk-prfl-sit-dstnc-anlysis-01.mp4 4:58

Sight distance checks

Sight distance checks can be conducted for a variety of documentation needs. 

 l Existing profiles
 l Preliminary proposed profiles

Check available sight distance for each direction of travel.

 l northbound/southbound
 l eastbound/westbound

Reported distances

See Visibility Check - Check Profile Sight Distance for documentation on how the WisDOT tool reports 
distances.

Create analysis file

 1. Start a new drawing from design-start.dwt template
 2. Save file as:

 A. ProjectID\dsgn\check\SightDistance-< AlignName >-ExistProf.dwg for existing pro-
file

 B. ProjectID\dsgn\check\SightDistance-< AlignName >-PropProf.dwg for proposed 
profile

 3. Data references:
 A. Reference alignment
 B. Reference profile (if available)

 4. Survey Query insertion:
 A. Survey figure and points of roadway centerline (if available)

Create profile from survey data
Add points from Survey Database to analysis file 
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 1. Toolspace > Survey tab > right-click Survey Databases > Set working folder...
 A. Select folder = ProjectID\base\srvy

 2. Toolspace > Survey tab > Survey Databases > right-click > SD2020_51200504-A > Open 
for read-only

 3. Toolspace > Survey tab > Survey Databases > SD2020_51200504-A > Survey Queries > 
right-click Centerlines > Insert into drawing

Add alignment name to point properties and create point group

 1. WisDOT Design tab > Design panel > Points dropdown > Point Station Offset to UDP
 A. Point Station/Offset to UDP dialog box

 I. Point Group - Create Point Group
 a. Name = 33 SrvyCL

 II. Alignments
 a. Alignment 1 = checked
 b. Alignment 1 = 33

 III. Apply
 2. See Points - Point Station Offset to UDP for more information on this tool.

Update point group properties with Query Builder

 1. Toolspace > Prospector tab > Point Groups > right-click 33 SrvyCL > Properties...
 A. Point Group Properties dialog box

 I. Query Builder tab
 a. Modify query = checked
 b. Select first cell in Property column
 c. Select first cell in Property column again to activate dropdown

 i. Property = ALIGNMENT1
 d. Right-click within the table > Insert Row...
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 e. Complete the query as shown in the image below

Create profile from points

 1. WisDOT Design tab > Design panel > Profile dropdown > Create Profile from Points
 A. Create Profile From Points dialog box

 I. Point Group = 33 SrvyCL
 II. Alignment = 33

 III. Profile Name = 33 SrvyCL
 IV. Profile Style = PROF Existing
 V. Label Set Style = _No Labels

 VI. OK
 VII. Close when completed

 2. See Profile - Create Profile from Points for more information on this tool.

Create profile view
 1. Home tab > Profile & Section View panel > Profile View dropdown > Create Profile 

View
 A. Create Profile View dialog box

 I. General
 a. Select alignment = 33
 b. Profile view name: PV-33-EB
 c. Profile view style = Stations 100' Major:50' Minor 1:10 Vert Ex
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 II. Station Range
 a. User specified range = selected
 b. Start station = 490+00
 c. End station = 570+00

 III. Profile View Height
 a. Automatic = selected

 IV. Profile Display Options
 a. 33 SrvyCL 

 i. Draw = checked
 ii. Labels = _No Labels

 V. Data Bands
 a. Select band set = Elevation Both (Existing Left Proposed Right)

 VI. Create Profile View
 a. CREATEPROFILEVIEW Select profile view origin

 i. Left-click the location where the lower left corner of the profile 
view will be placed

 ii. NOTE: The profile view grid lines are located on layers E_PROF_
Grid and E_PROF_GridMin and may be turned off to make it easier 
to see the sight distance profiles.

 2. Repeat the process and create another profile view named PV-33-WB

Check profile sight distance

dsn-chk-prfl-sit-dstnc-anlysis-02.mp4 6:02

Check eastbound profile sight distance

 1. WisDOT Design tab > Analyze panel > Visibility Check dropdown > Check Profile Sight 
Distance

 A. DOTCHECKPROFILESIGHTDISTANCE Select Profile View: select PV-33-EB 
profile view

 B. Profile Sight Distance dialog box
 I. Sight Lines

 a. Profile = 33 SrvyCL
 b. Start Station = 490+00
 c. End Station = 570+00

 i. If profile data DOES NOT exist at the analyzed sight distance, a 
sight line is drawn that is truncated to the profile data limits 
within the profile view.

 d. Check Increment (ft) = 25
 e. Sight Distance (ft) = 910, See FDM 11-10-5.1 Sight Distances
 f. Object Height: 24 in (SSD), Stopping Sight Distance

 II. Output
 a. Create Report =  checked

 i. File path = ProjectID\dsgn\check\SSDpc_33_EB_24IN_Exist_910
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 b. Create Profile = checked
 i. Profile name = ASDpc_33_EB_24IN_Exist_910

 i. naming convention: Available Sight Distance profile check_ < 
Alignment name> _ < Direction of travel > _ < Object height > 
_ < Exist/Prop condition > _ < Sight distance analyzed >

 ii. NOTE: The maximum available sight distance calculated is 
based on the Sight Distance value entered. Longer sight 
distances may be available based on the characteristics of 
the analyzed profile.

 c. Create Sight Lines = checked
 d. Travel Direction for Layer Assignment: EB

 III. OK
 IV. Wait for analysis to be completed.
 V. CLOSE

Check westbound profile sight distance

 1. WisDOT Design tab > Analyze panel > Visibility Check dropdown > Check Profile Sight 
Distance

 A. DOTCHECKPROFILESIGHTDISTANCE Select Profile View: select PV-33-WB 
profile view

 B. Profile Sight Distance dialog box
 I. Sight Lines

 a. Profile = 33 SrvyCL
 b. Start Station = 570+00
 c. End Station = 490+00
 d. Check Increment (ft) = 25
 e. Sight Distance (ft) = 910, See FDM 11-10-5.1 Sight Distances
 f. Object Height: 24 in (SSD), Stopping Sight Distance

 II. Output
 a. Create Report =  checked

 i. File path = ProjectID\dsgn\check\SSDpc_33_WB_24IN_Exist_
910

 b. Create Profile = checked
 i. Profile name = ASDpc_33_WB_24IN_Exist_910

 c. Create Sight Lines = checked
 d. Travel Direction for Layer Assignment: WB

 III. OK
 IV. Wait for analysis to be completed
 V. CLOSE

 2. See Visibility Check - Check Profile Sight Distance for more information on this tool.

Create Available Sight Distance (ASD) profile view
Create profile view

 1. Home tab > Profile & Section View panel > Profile View dropdown > Create Profile 
View
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 A. Create Profile View dialog box
 I. General

 a. Select alignment = 33
 b. Profile view name = ASDpc-33-EB
 c. Profile view style = Sight Distance

 II. Station Range
 a. User specified range = selected

 i. Start station = 490+00
 ii. End station = 570+00

 III. Profile View Height
 a. User specified = selected
 b. Minimum = 0.00'
 c. Maximum = 1700'

 i. Note that for this analysis the profile height represents sight dis-
tance and not an elevation

 IV. Profile Display Options
 a. ASDpc_33_EB_24IN_Exist_910

 i. Draw = checked
 ii. Labels = _No Labels

 b. Draw box for the other profiles = unchecked
 V. Data Bands

 a. Select band set = Sight Distance
 VI. Create Profile View

 a. CREATEPROFILEVIEW Select profile view origin

 i. Left-click the location where the lower left corner of the profile 
view will be placed

Update profile band

 1. Left-click to select the ASDpc-33-EB profile view > right-click > Profile View Prop-
erties... > Bands tab

 A. Profile View Properties dialog box
 I. Bands tab

 a. Style = Distance Left (Available Sight Distance)
 i. Profile1 = ASDpc_33_EB_24IN_Exist_910

 b. Style = Distance Right (Stopping Sight Distance)
 i. Show Labels = unchecked

 II. OK
 2. Repeat the process and create another profile view named ASDpc-33-WB
 3. Save the file

Intersection sight distance - 3D analysis
Last updated: 2022-04-12

Total video time 8:34

Data setup and create obstruction wall surfaces
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intrsctn-sight-dist-3d-01.mp4 4:02

Add wall surface to treeline

 1. WisDOT Design tab > Design panel > Surfaces pulldown > Create Wall Surface
 2. Select Feature Line, Survey Feature, or 3D Polyline: Left-click feature line 

that is the treeline.
 3. Pick side to offset: Left-click on the side to offset.
 4. Enter height: 30 Enter
 5. View in object viewer

 A. Left-click on feature line
 B. Contextual ribbon > General Tools panel > Object Viewer
 C. Left-click and drag to rotate and view wall surface.
 D. Esc to end.

Add wall surface to beam guard

 1. WisDOT Design tab > Design panel > Surfaces pulldown > Create Wall Surface 
 2. Select Feature Line, Survey Feature, or 3D Polyline: Left-click feature line 

representing the beam guard.
 3. Pick side to offset: Left-click inside
 4. Enter height: 2.3125 Enter
 5. View in object viewer

Add wall surface to proposed building

 1. WisDOT Design tab > Design panel > Surfaces pulldown > Create Wall Surface 
 2. Select Feature Line, Survey Feature, or 3D Polyline: Left-click feature line 

representing the proposed building.
 3. Pick side to offset: Left-click inside
 4. Enter height: 20 Enter
 5. View in object viewer

Check intersection sight distance, analyze results

intrsctn-sight-dist-3d-02.mp4 4:32

Info: Corridor top surface and existing ground surface are combined into one surface called 
Crdr-Ex-Top. 

Run site distance analysis tool, secondary roadway looking left

 1. Ribbon > WisDOT Design tab > Analyze panel > Visibility Check dropdown > Check 
Intersection Sight Distance
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 2. Intersection Sight Distance dialog box
 A. Left-click Decision Point select from screen button

 I. Pick decision point (eye) location: Shift + right-click > Inter-
section OSnap > Left-click near intersecting lines, where secondary road-
way meets main roadway.

 B. Left-click Vehicle Path select from screen button
 I. Select target path (Polyline) in check direction: Left-click 

centerline of left lane, to the left of the intersection.
 C. Both Decision Point and Visible Point have green check marks to indicate a suc-

cessful selection.
 D. Eye Height (ft): 3.5 (car)
 E. Sight Distance (ft): type 710
 F. Surfaces > Terrain Surface: Crdr-Ex-Top
 G. Surfaces > Obstruction Surfaces: Select Wall1, Wall2, and Wall3
 H. OK

 3. Impaired vision due to treeline.
 4. View in 3D

 A. Ribbon > View tab > Named Views panel > Name View dropdown > 3D
 B. Shift + mouse wheel button, to orbit and move and view site distance analysis.

 5. Return to the top view
 A. Ribbon > View tab > Named Views panel > Name View dropdown > Top

 6. Hide current site analysis
 A. Left-click on site analysis
 B. Right-click menu > Isolate Objects > Hide Selected Objects

Run site distance analysis tool, south driveway looking left

 1. Intersection Sight Distance dialog box
 A. Left-click Decision Point select from screen button

 I. Pick decision point (eye) location: Left-click a point where drive-
way meets roadway.

 B. Keep everything else the same.
 C. OK

 2. Impaired vision due to proposed building.
 3. View in 3D
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Plan production
Plan production basics
Sheet sets
Last updated: 2020-10-26

Total video time: 11:19

Create new sheet set #create

pln-prod-basc-sht-set-01.mp4 3:08

Exercise data: plan-prod-basc-sht-set-data-c3d18.zip

SSM Enter  or Home tab > Palettes > Sheet Set Manager

 1. New Sheet Set
 A. Begin

 I. An example sheet set: checked Next

 B. Sheet Set Example
 I. Select a sheet set to use as an example: checked

 II. ProjectSheetData18This SheetSet contains custom fields that populate the 
WisDOT sheet border blocks.

 III. Next
 C. Sheet Set Details

 I. Name of new sheet set: 11701970
 II. Store sheet set data file (.dst) here: <ProjectID>\SheetsPlan Open

 III. Create a folder hierarchy based on subsets: checked
 IV. Sheet Set Properties

 a. County: VILAS AND ONEIDA
 b. Highway: US51
 c. Project No: 1170-19-70

 d. OK
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 V. 

Next

 D. Confirm
 I. Finish

 2. Right-click project number > Close Sheet Set

Close Sheet Set Manager

Open existing sheet set

pln-prod-basc-sht-set-02.mp4 1:13

SSM Enter
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 1. Open...

 A. <ProjectID >\SheetsPlan\11701970.dst Open
 2. Also available in Sheet Set Manager > Recent

Add sheets to sheet set manually #add

pln-prod-basc-sht-set-03.mp4 4:12

With Sheet Set open in Sheet Set Manager

Add a subset

 1. Select a subset > Right-click > New Subset...

 A. Subset Name: TYPICAL SECTIONS This populates the sheet title in layouts.
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 2. Click subset > Right-click > Import Layout as Sheet...

 A. Browse for Drawings...
 I. <ProjectID>\SheetsPlan Open

 B. Uncheck unwanted layouts. Layouts can only be in one SheetSet at a time. Layouts 
that all ready exist in another Sheet Set will not be available for import.

 C. Prefix sheet titles with file name: unchecked
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 D. Import Checked

 3. Double-click new sheet in Sheet Set Manager to open file and layout
 4. Adds or edits to fields in layouts will not update immediately. REAEnter to refresh all layouts 

and see edits.

Redefine broken sheet border fields
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pln-prod-basc-sht-set-04.mp4 2:44

Use this process when fields in the sheet border are not updating or are broken.

In layout with broken field

 1. Double-click field. Edit Text dialog will open.
 A. Text being driven by a field has a gray background. Regular text has a white back-

ground.
 B. To edit a field, Select field text > Right-click > Edit Field...

 I. Field Category: CurrentSheetSubSet or CurrentSheetSetCustom These are 
the 2 categories that populate field values.

 II. Inspect Custom property name: values

 III. OK
 C. OK

 2. OK  Esc

Add WisDOT AutoCAD components
Last updated: 2020-10-26

Total video time: 2:48

pln-prod-basc-add-autocad-cmpnent-01.mp4 2:48

Exercise data: pln-prod-basc-add-autocad-cmpnent-data-c3d18.zip
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Custom WisDOT AutoCAD components that assist with plan sheet creation are not contained in the 
template sheet files. This keeps files that do not need them (such as design files) simpler and smal-
ler. These custom components can be added to any file. This is helpful for migrating project files 
from previous versions to at all current components to it.

WisDOT Sheets tab > Standards Components panel >  Add All Components

Unused AutoCAD components can be removed from a file with PURGE enter .

Tip: Only unused components are allowed to be purged. Sometimes Purge needs to be done 
more than once.

Xref topography file
Last updated: 2020-10-26

Total video time: 2:25

pln-prod-basc-xref-topo-01.mp4 2:25

Exercise files: pln-prod-basc-xref-topo-data-c3d18.zip

 1. New file >Save Drawing as... > 11701970\Design\ViewFrameGroups\VFG-US51.dwg > 
Save

 2. WisDOT Sheets tab > Manage panel > Load XREF on layer

 A. <ProjectID >\BaseData\Topo-Ex.dwg >Open
 

This creates an XREF with relative path, overlay, insertion point at 0, 0, 0, and on a custom layer with 
the format XREF-<file name>. These are often best practices for most real world XREFs and the cus-
tom layer allows for layer control on multiple XREFs.

Data shortcut alignment
Last updated: 2020-10-26

Total video time: 2:04

Exercise files: pln-prod-basc-dref-ali-data-c3d18.zip

Start with 11701970\Design\ViewFrameGroups\VFG-US51.dwg

pln-prod-basc-dref-ali-01.mp4 2:04

Save the file.
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Confirm that you are in the correct working folder for Data Shortcuts. It should end in 11701970.

Prospector >Data shortcuts >Alignments >Centerline Alignments >Right-click 51 >Create 
Reference...

 1. Name: 51
 2. Alignment style: ALI Proposed
 3. Alignment label set: 1IN 200FT-Ticks 500' Major: 100' Minor
 4. OK

Repeat for the 47 alignment.

 1. Name: 47
 2. Alignment style: ALI Proposed
 3. Alignment label set: 1IN 200FT-Ticks 500' Major: 100' Minor
 4. OK

Tip: Save the file after adding data shortcuts to the active file.

View frames and view frame groups
Last updated: 2020-10-26

Total video time: 12:08

Create single plan view frames and group #create

Exercise files: pln-prod-basc-vu-fram-and-grup-01-data-c3d18.zip

Start with 11701970\Design\ViewFrameGroup\VFG-US51.dwg

pln-prod-basc-vu-fram-and-grup-01.mp4 3:01

Output tab > Plan Production panel > Create View Frames

 1. Alignment
 A. Alignment: 51
 B. Next

 2. Sheets
 A. Sheet Settings: Plan(s) only
 B. Template for Plan sheet: ...

 I.  C:\WisDOT\Stnd\C3D2018\Templates\Sheets\05-PN-wdot18.dwt
 II. Layout: Plan 1 IN 40 FT

 III. OK
 C. Next
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 3. View Frame Group
 A. Leave all defaults
 B. Next

 4. Match Lines
 A. Insert match lines: checked
 B. Positioning

 I. Snaps patient value down to the nearest: checked, 1
 II. Allow additional distance for repositioning (increases few overlap): 100'

 C. Create View Frames
Prospector >Data Shortcuts >Right-click >Create Data Shortcuts...

 1. VFG - 51 - (1): checked
 2. OK

Create dual plan view frames and group #create-dual

Exercise files: pln-prod-basc-vu-fram-and-grup-02-data-c3d18.zip

pln-prod-basc-vu-fram-and-grup-02.mp4 2:36

Output tab > Plan Production panel > Create View Frames

 1. Alignment
 A. Alignment: 51
 B. Next

 2. Sheets
 A. Sheet Settings: Plan(s) only
 B. Template for Plan sheet: ...

 I.  C:\WisDOT\Stnd\C3D2018\Templates\Sheets\05-PN-DUAL-PLN-
wdot18.dwt

 II. Layout: Plan Dbl 1 IN 40 FT
 III. OK

 C. Next
 3. View Frame Group

 A. Leave all defaults
 B. Next

 4. Match Lines
 A. Insert match lines: checked
 B. Positioning

 I. Snaps patient value down to the nearest: checked, 1
 II. Allow additional distance for repositioning (increases few overlap): 100'

 C. Create View Frames
Prospector >Data Shortcuts >Right-click >Create Data Shortcuts...

 1. VFG - 51 - (1): checked
 2. OK

Edit view frames
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Exercise files: pln-prod-basc-vu-fram-and-grup-03-data-c3d18.zip

pln-prod-basc-vu-fram-and-grup-03.mp4 2:39

Tip: Creating layouts from view frames takes a snapshot from the view frame location. Layouts 
do not have a live link to view frames. Any changes to view frame locations should be done 
prior to creating layouts.

View Frame grips

 l Green circle: rotate view frame
 l Blue square: move view frame within the limits of match lines
 l Blue diamond: slide view frame up and down stationing

View Frames are constrained by match lines. Match lines also have grips.

 l Green circle: rotate match line
 l Blue arrowhead: lengthen/shorten match line
 l Blue diamond: slide match line up and down stationing

Stationing can be entered directly by

Select objects stationing grip >station/offset transparent command > Select alignment>type 
in stationing at command line

In example

Station: 52753Enter

Offset: 0Enter

Create additional view frame group

Exercise files: pln-prod-basc-vu-fram-and-grup-04-data-c3d18.zip

Start with 11701970\Design\ViewFrameGroup\VFG-US51-plan overview.dwg

pln-prod-basc-vu-fram-and-grup-04.mp4 3:51

In this example, a different scale of view frames is created for the same alignment and station range 
in a different view frame file. Different view frame groups can be stored in the same file if desired. 
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Both options are accessible. Either way, view frame groups will be accessed from the Prospector 
> Data Shortcuts interface.

Output tab > Plan Production panel > Create View Frames

 1. Alignment
 A. Alignment: 51
 B. Next

 2. Sheets
 A. Sheet Settings: Plan(s) only
 B. Template for Plan sheet: ...

 I.  C:\WisDOT\Stnd\C3D2018\Templates\Sheets\05-PN-wdot18.dwt
 II. Layout: Plan 1 IN 100 FT

 III. OK
 C. Next

 3. View Frame Group
 A. View Frame Group Name: VFG - <[View Frame Group Alignment Name(CP)]> -pla-

noverview
 B. Next

 4. Match Lines
 A. Insert match lines: checked
 B. Positioning

 I. Snaps patient value down to the nearest: checked, 1
 II. Allow additional distance for repositioning (increases few overlap): 100'

 C. Create View Frames
Prospector >Data Shortcuts >Right-click >Create Data Shortcuts...

 1. VFG - 51 - planoverview: checked
 2. OK

Exercise files: pln-prod-basc-vu-fram-and-grup-05-data-c3d18.zip

Create sheet files with layouts from view frame groups
Last updated: 2020-10-30

Total video time: 9:59

Add view frame group to file and create sheets

Exercise files: pln-prod-basc-creat-sht-fil-vu-frm-grup-begin-data-c3d18.zip

Start with xxx-begin.dwg

pln-prod-basc-creat-sht-fil-01.mp4 4:47

Prospector >Data Shortcuts >View Frame Groups >Right-click VFG - 51 - (1) >Create Refer-
ence...

Leave all defaults
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OK

Warning: View frames should not be edited in the files they are referenced into. Civil 3D 
allows this, but these edits are not reflected back in the source file and if the source file is 
edited, these edits would be overwritten. Edits to objects should always be in the source file.

Output tab > Plan Production > Create Sheets

 1. View Frame Group and Layouts
 A. View Frame Group: VFG - 51 - (1)
 B. View frame range: All: checked
 C. Choose View Frames...

 I. Select VF - (1) through VF - (10)
 D. Layout Creation: All layouts in the current drawing checked

Warning: This option should always be used because options that involve new 
drawings create a layer of XREF that can cause problems.

 E. Layout name: click template button
 I. Name: <[Next Counter]>

 II. Number style: 01, 02, 03...
 III. OK

 F. Next
 2. Sheet Set

 A. Add to existing sheet set: 11701970\SheetsPlan\11701970.dst
 B. Sheet file name: click template button

 I. Name: 0231<[Next Counter]>-pl
 II. Number style: 01, 02, 03...

 III. OK

 C. Create Sheets
 3. OK

Create additional set of sheet files

pln-prod-basc-creat-sht-fil-02.mp4 2:11

Output tab > Plan Production > Create Sheets

 1. View Frame Group and Layouts
 A. View Frame Group: VFG - 51 - (1)
 B. View frame range: All: checked
 C. Choose View Frames...

 I. Select VF - (11) through VF - (30)
 D. Layout Creation: All layouts in the current drawing checked
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Warning: This option should always be used because options that involve new 
drawings create a layer of XREF that can cause problems.

 E. Layout name: click template button
 I. Name: <[Next Counter]>

 II. Number style: 01, 02, 03...
 III. Starting number: 11 Make sure this is correct.
 IV. OK

 F. Next
 2. Sheet Set

 A. Add to existing sheet set: 11701970\SheetsPlan\11701970.dst
 B. Sheet file name: click template button

 I. Name: 0231<[Next Counter]>-pl
 II. Number style: 01, 02, 03...

 III. Starting number: 11 Make sure this is correct.
 IV. OK

 C. Create Sheets
 3. OK

Modify sheet set to get fields correct in title block #modify

pln-prod-basc-creat-sht-fil-03.mp4 3:01

Layouts have been automatically added to subsets in sheet set manager based on the view frame 
group name. We will create an appropriate subset and move the sheets into that subset to get the 
title correct in the sheet border.

Move sheets to appropriate subset

 1. Sheet set manager > Open... > 11701970.DST
 2. Right-click subset 02- > New Subset...

 A. Subset Name: Planting

 B. OK
 3. Shift-select sheets 1-10
 4. Drag to subset Planting
 5. REAEnter
 6. Titles will refresh on all sheets.
 7. Shift-select sheets 11-30
 8. Drag to subset Planting

Rename sheets

Any sheets can be renamed in sheet set manager at any time with this process.

Right-click sheet > Rename & Renumber... > Number: empty > Next
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Continue for all sheets that need to be renumbered.

pln-prod-basc-creat-sht-fil-vu-frm-grup-end-data-c3d18.zip

Create layout manually
Last updated: 2022-05-12

Total video time: 5:26

Exercise files: pln-prod-basc-creat-sht-fil-mnul-data-c3d18.zip

Start with Permit Area.dwg

pln-prod-basc-creat-sht-fil-mnul-01.mp4 5:26

Add layout to file

 1. WisDOT Sheets tab > Sheet Creation panel > Detail tool palette > 02-Plan Details 1=100 
(02-PD-wdot18)

 2. Layout name: PermitAreaEnter

Set viewport to area of interest

 3. Double-click inside viewport to activate it.
 4. Unlock the viewport to be able to move it to the project area.

 5. Double-click inside the viewport again to resume to the extents of the project.
 6. Zoom into area of interest.
 7. Set scale of viewport to 1 IN:100 FT to make sure scale is exact.
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 8. WisDOT [***] tab > View panel > Rotate View

 9. First point: Click origin
 10. Second point: Click desired positive X axis
 11. Reset scale to 1 IN:100FT
 12. REAEnter to refresh all graphics.
 13. Lock the viewport.

 14. Double-click layout title. Delete field reference. Type "PERMIT AREA" OK

 15. Save the file.

Page setups
Last updated: 2020-10-26

Total video time: 5:43

Add page setup to single layout

Exercise files: pln-prod-basc-pag-setup-data-c3d18.zip

Start with xxx-begin.dwg

pln-prod-basc-pag-setup-01.mp4 3:03

Page setups are a collection of attributes related to plotting for a layout. Page setups can be saved 
and applied to layouts for functionality such as ensuring uniformity or quickly switching to a different 
plot configuration.

 1. WisDOT Sheets tab > Plot Configuration panel > Page Setups

 2. Page Setups tool palette > PDF-11x17-stnd to add page setup to the file.
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 3. Right-click layout > Page Setup Manager... > Click PDF-11X17-stnd > Set Current

Add page setup to multiple layouts #add

pln-prod-basc-pag-setup-02.mp4 2:40

Page setups are a collection of attributes related to plotting for a layout. Page setups can be saved 
and applied to layouts for functionality such as ensuring uniformity or quickly switching to a different 
plot configuration.

 1. WisDOT Sheets tab > Plot Configuration panel > Page Setups

 2. Page Setups tool palette > PDF-11x17-stnd to add page setup to the file.
 3. WisDOT Sheets tab > Plot Configuration panel > Multi-PageSetup
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 A. May need to click Refresh All to load current file into tool.
 B. Show Modle space in Layouts: unchecked
 C. Select: All
 D. Apply

Results
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Plotting
Last updated: 2020-10-26

Total video time: 13:27

Single layout plotting

Exercise files: pln-prod-basc-plot-data-c3d18.zip

Start with 023001-up.dwg

pln-prod-basc-plot-01.mp4 4:16

Three different options all give you the same results.

 1. Right-click layout > Plot...
 2. Output tab > Plot panel > Plot
 3. Quick Access toolbar > Plot

Opens up the Plot dialog which has all page setup settings.

 1. Printer/plotter
 2. Paper size
 3. Plot area
 4. Plot scale
 5. Plot style table
 6. Plot options
 7. Preview... to preview plot.
 8. OK to plot.
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Multiple layout plotting in Civil 3D

pln-prod-basc-plot-02.mp4 5:17

This batch plot function allows for

 1. Specifying the order of sheets for plotting
 2. Plotting layouts from multiple DWGs, including ones not currently open.
 3. Working in the background

Tip: This funcitonality is also located in DWG TrueView software. Plotting is often fastest from 
TrueView because it opens files read-only and not for editing. "TrueView batch plot" on 
page 1380

Output tab > Plot panel > Batch Plot

 1. Add/remove sheets
 2. Reorder sheets
 3. Apply page setups that exist in DWGs.
 4. Save/open sheets sets.
 5. Publish
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Multiple layout plotting in sheet set manager

pln-prod-basc-plot-03.mp4 3:53

Home tab > Palettes panel > Sheet set manager or SSM Enter

Open... > 11701970\SheetsPlan\11701970.dst > OK>

Right-click sheet set > Publish... > Publish to Plotter

Right-click sheet set > Publish > Sheet Set PDF Publish Options... is where the folder for res-
ulting file will be published to.
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Subsets and single sheets can be multi-selected for plotting.

WisDOT dimensions and multileaders
Last updated: 2020-10-29

Total video time: 9:58

Add dimensions and multileaders

Exercise files: pln-prod-basc-dimnsn-multildr-data-c3d18.zip

Start with xxx-begin.dwg

pln-prod-basc-dimnsn-multildr-01.mp4 4:46

"Add WisDOT AutoCAD components" on page 1302

Dimension

 1. WisDOT Sheets > WisDOT Annotation panel > Linear style: 060-LANE & SHLD
 2. WisDOT Sheets > WisDOT Annotation panel > Linear dimension

Page: 1317

Published on: 5/17/2023

WisDOT dimensions and multileaders

https://c3dkb.dot.wi.gov/data/pln-prod/pln-prod-basc/pln-prod-basc-dimnsn-multildr-data-c3d18.zip
https://c3dkb.dot.wi.gov/video/pln-prod/pln-prod-basc/pln-prod-basc-dimnsn-multildr-01.mp4


 3. Place dimension in paperspace. Size will be correct, but not value. 060-LANE & SHLD 
PAPERSPACE style is built for this.

 4. Double-click viewport to activate modelspace. Value will be correct, but not size.
 5. Switch to modelspace. Dimension will work properly.

Multileader

 1. WisDOT Sheets tab > WisDOT Annotation panel > Multileader style: 060
 2. WisDOT Sheets tab > WisDOT Annotation panel > Mleader

 3. In text editor: BASE AGGREGATE SHOULDER > Click outside editor to finish > F3 to turn 
off snaps > Click to place arrowhead

Dimension and multileader tool palettes

pln-prod-basc-dimnsn-multildr-02.mp4 2:19

 1. WisDOT Sheets tab > Standards components panel > Components palettes dropdown > 
Dimensions palette

 2. Arrow on dimension tools opens all dimension commands
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 3. Dimension Styles tool palette > Linear command (default) 060-LANE & SHLD > Click 
start > Click end > Click dimension label offset

 4. WisDOT Sheets tab > Standards components panel > Components palettes dropdown > 
Multi-leader palette

 5. General tool palette > 060-Text

 6. Click text location
 7. Click arrowhead location
 8. Double-click text to open text editor: BASE AGGREGATE SHOULDER > Click outside editor to 

exit.
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Blocks and dimensions in modelspace and paperspace

pln-prod-basc-dimnsn-multildr-03.mp4 2:53

 l Blocks and dimensions placed in paperspace will only show up in the single layout.
 l Blocks and dimensions placed in modelspace will show up in all viewports with them in their 

extents.
 l Annotative blocks and dimensions placed in modelspace through an active viewport will have 

the wrong scale.

Adding civil object labels
Last updated: 2020-10-26

Total video time: 11:14

Add labels tool, surface example

Exercise files: pln-prod-basc-add-labl-data-c3d18.zip

Start with 01-pln-prod-basc-group-12.dwg

pln-prod-basc-add-labl-01.mp4 4:07

Annotate tab > Labels & tables panel > Add labels drop-down
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Starting a label command here will allow you to change the style before placing the label.

Warning: If you start a label with the image on the panel instead of the drop-down by the text, 
only the default style will be available.
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Civil 3D object labels are dynamic to the object. Here is an example of a spot elevation label on a sur-
face.

Labels can also be placed by first selecting the object and then using the contextual ribbon com-
mands. Here is an example of the surface contextual ribbon. Only surface-type labels are available.
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The same dialog box will appear through this method.

Profile label examples

pln-prod-basc-add-labl-02.mp4 2:06

 1. Click profile view > contextual ribbon > Labels panel
 2. Click profile > contextual ribbon > Labels panel 

Both access profile labels

Edit Profile Labels > Import label set... > WisDOT Standard > OK
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Cancel

Add View Labels > Depth > Select profile view > Pick first point > pick second point

Add View Labels > Station Offest > Select profile view > Specify station > Specify elevation

To change label style

Click label > Right-click > Label Properties... > Profile Station Elevation style > 
WisDOT Standard
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Parcel label examples

pln-prod-basc-add-labl-03.mp4 2:29

Annotate tab > Labels panel > Add labels text > Figure > Add Figure Labels

Feature: Survey Figure

Label type: Single Segment

Line label style: UG Gas Line (3D Survey)

Add

Annotate tab > Labels panel > Add labels text > Figure > Add Figure Labels

Feature: Survey Figure

Label type: Single Segment
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Line label style: Basic

Add

Line, curve and note label examples

pln-prod-basc-add-labl-04.mp4 2:32

Line, curve and note labels do not require Civil 3D objects.

Annotate tab > Labels panel > Add labels text > Line and Curve > Add Line and Curve Labels

Feature: Line and Curve

Label type: Single Segment

Line label style: Bearing Distance

Add

Click polyline

Annotate tab > Labels panel > Add labels text > Note > Add Note Label

Feature: Note

Label type: Note

Note label style: N E

Marker style: Basic

Add

Click modelspace

Adding civil object tables
Last updated: 2020-10-26

Total video time: 6:38

Point table example

Exercise files: pln-prod-basc-add-tabl-data-c3d18.zip

Start with 01-pln-prod-basc-group-12.dwg

pln-prod-basc-add-tabl-01.mp4 3:26

Need to first create labels for objects to populate tables.

Labels are then turned into tags to populate table rows.

Annotate tab > Labels & Tables panel > Add Point Table
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Table style: RW Points Y X Z

Points can be selected by:

 1. Active style
 2. Point group
 3. Graphically in modelspace

All tables have split logic and reactivity behavior.
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Alignment table example

pln-prod-basc-add-tabl-02.mp4 3:12

Annotate tab > Labels & Tables panel > Add Labels > Alignment > Add Alignment Labels
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Add labels

Feature: Alignment

Label type: Multiple Segment

Line label style: Bearing Distance

Curve label style: PI ^ D T L R PC PT

Ok

Annotate tab > Labels & Tables panel > Add Tables > Alignment > Add Segment
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Table style: Standard

By alignment: CthE

OK

Tables can be sorted by editing the style and selecting a sorting column.

Page: 1330

Published on: 5/17/2023

Adding civil object tables



Inserting blocks
Last updated: 2020-10-26

Total video time: 10:33

Blocks from tool palettes and design center

Exercise files: pln-prod-basc-insrt-blk-data-c3d18.zip

Start with 05001-tc.dwg

pln-prod-basc-insrt-blk-01.mp4 3:53

Many WisDOT blocks are available from tool palettes.

WisDOT Sheets tab > Sheet Creation Components > Signs > M-signs > M1-4
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All blocks are available through DesignCenter.

WisDOT Tools tab > Standards Components > Open Design Center or Home tab > Palettes > 
Design Center

Design Center allows you to browse files for blocks and other AutoCAD components.

C:\WisDOT\Stnd\C3D2018\Components\Blocks\MarkingSigning18.dwg\Blocks

Blocks can be dragged and dropped from Design Center into modelspace or paperspace.

Dynamic blocks, grips and fields

pln-prod-basc-insrt-blk-02.mp4 2:59

Dynamic blocks have multiple grips that do different things.
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Some blocks also have text attributes that can be changed.

Info: Grey in Value means that the text is coming from a field and cannot be edited here.

Blocks in modelspace and paperspace

pln-prod-basc-insrt-blk-03.mp4 3:40

Blocks in paperspace

 1. Will only show up in one layout.
 2. Will align with top of layout with no rotation.

Blocks in modelspace
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 1. Will show up all layouts.
 2. Will align with positive Y-axis with no rotation.

Some blocks are scaled for modelspace, paperspace, or both. If a block does not work in one, you 
may need to place it in the other space or scale it.

Place north arrow
Last updated: 2020-10-26

Total video time: 6:41

Manual method

pln-prod-basc-plac-nrth-arro-01.mp4 3:54

This method is typically used when:

 l manually creating sheet layouts
 l creating plan over plan layouts

Warning: North arrows in the layouts generated from using the dual plan view frames are not 
at the correct rotation.  Use manual methods for placing north arrows when producing plan 
over plan sheets.

Insert from tool palette

It is recommended that the north arrow is placed in model space so it is orientated correctly in the 
layouts.

 1. WisDOT Sheets tab > Sheets Creation panel > palette for sheet type
 A. Palette for sheet type examples: 

 I. Title palette group dropdown > Title sheet palette
 II. Construction Details palette group dropdown > Details sheet palette

 2. Sheet palette > Startup Main palette tab > Blocks heading > left-click **North Arrow** 
> left-click to place at desired location

Palette groups that have a north arrow include:

 l Title
 l Construction Details
 l ROW / Plat
 l Plan / Profile

NOTE: The north arrow block used by the sheet creation wizard to create sheet layouts is rotated to 
the correct orientation.  The north arrow block is not rotated to the correct orientation when sheet 
layouts are manually created from the WisDOT Sheets palettes.
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Insert from ribbon

 1. WisDOT Sheets tab> Standard Components panel > Add All Components
 2. Insert tab > Block panel > Insert > N block

 A.  INSERT Specify insertion point or [Basepoint Scale Rotate]: Left 
click insertion location

Sheet wizard method

pln-prod-basc-plac-nrth-arro-02.mp4 2:46

 1. Output tab > Plan Production panel > Create Sheets
 A. View Frame Group and Layouts 

 I. Choose the north arrow block to align in layouts: SheetsWizard-NorthArrow
 B. Create Sheets (after other sheet creation options have been chosen)

 2. Select a layout tab that has been created.
 3. A north arrow is located off the sheet and has been rotated to the viewport rotation.  The 

north arrow is only rotated if the layouts were created by the sheet creation wizard.
 4. Left-click select the north arrow block
 5. Left-click the grip at the bottom of the north arrow
 6. Left-click at the location where the north arrow will be moved to
 7. Move the north arrow in each layout

Warning: North arrows in the layouts generated from using the dual plan view frames are not 
at the correct rotation.  Use manual methods for placing north arrows when producing plan 
over plan sheets.
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Plotting & layouts
2018 WisDOT plot standards
Last updated: 2020-10-26

Total video time: 25:49

Introduction and plot styles

plt-lyout-2018-plt-stndrd-01.mp4 10:31

Plot Styles

 1. STB
 A. Named styles
 B. The named style controls color lineweight etc.

 2. CTB
 A. Color dependent plot styles
 B. The color controls color, lineweight. etc.
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 3. Why is WisDOT switching to CTB?
 A. Past experience- multiple product defects related to STB
 B. No clean starting point for an STB template

 I. C3D does not ship with an STB C3D template
 II. WisDOT must start from scratch

 C. CTB is the native to AutoCAD and Civil 3D
 I. AutoCAD has used CTB Templates since inception- 1982

 II. STB was introduced in 2000
 III. Civil 3D ships with 66 templates. Only 4 of those are STB

 4. How WisDOT plans to implement CTB?
 A. Simplistic layer based approach implement CTB

 I. Minimize impact on work flow
 II. E-layer colors will be muted (all color numbers ending in 1 will plot gray)

 III. All other colors will remain the same
 IV. Color output by setting layer or object color to RGB
 V. Leverage layer states

Civil 3D 2018 plot style tables overview

The Civil 3D 2018 plot style tables are different than the 2016 plot style tables. The new WisDOT Civil 
3D 2018 plot style tables are CTB (color dependent plot style tables). Just like the 2016 STB (named 
plot style tables), the CTB gives the user flexibility for custom plotting output without ever modifying 
the plot style table.

Plot style tables defined 

The 2018 plot styles are used to define the output color (black, grayscale or color) of an object. When 
an object color is set as ByLayer the plot style color that corresponds with the layer color is used. The 
object properties, layers and/or civil styles define the lineweight and the linetype. There are only two 
plot style tables in 2018. Each are used for creating a specific plot output. The plot style tables in Civil 
3D 2018 are outlined below. 

wisdot_standard.ctb

This is the primary plot style table for standard plan sheet output. This plot style table is set to plot 
black & grayscale. To maintain layer color consistency from previous versions, each AutoCAD color 
from 1-255 in the plot style table is assigned to either plot as black, gray or white for masking. When 
the wisdot_standard.ctb plot style is assigned to a layout, the object color is plotted based on the 
(black, white or gray) color assigned to it in the plot style table. It is not plotted as the visual object 
color assigned in the layer or object settings. When this plot style table is used with the default plot 
style settings as set in the 2018 startup templates, a consistent plot output can be achieved from any 
workstation with the WisDOT 2018 standards installed.
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wisdot_color.ctb

This plot style table is set to plot color: by object and lineweight: by object. Use this plot style table 
when there is a need for many color and/or lineweight overrides at the Civil 3D style, layer or object 
level. This plot style table can also be used to plot a drawing where a majority of objects need to be 
plotted in color. This plot style table allows you to override the standard color and lineweight set-
tings instead of using wisdot_standard.stb. Color and lineweight is determined by the civil object 
style, layer, or object property settings. When the wisdot_color.ctb plot style is assigned to a layout, 
the object color is plotted based on the visual color assigned to it in the layer or object. This plot style 
table is similar to the WisDOT Civil 3D 2014 plot style table wisdot_color.stb.
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Legacy plot style table comparison

The 2016 plot styles in the wisdot_standard.stb plot style table define the color output as black, gray 
and white and also the linetype and lineweight output. The 2018 wisdot_standard.ctb plot style table 
only defines the color output.

WisDOT uses a four-part plot standard

Part 1: Plot style table

The plot style table file is referenced into the drawing that provides drawing object output settings. 
These settings are not associated to any output device. The WisDOT 2016 STB and 2018 CTB plot 
style tables are used to assign individual plots styles to a layer, civil style or a drawing object. The 
plots style tables are set per drawing layout and adapted into the WisDOT page setups.
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In order to maintain layer color consistency from previous version each AutoCAD colors from 1-255 
in the plot style table are assigned to either plot as black, gray or white, with the layer or style con-
trolling all other settings.

Please refer to the Wisdot_standard_CTB.pdf located in: C:\Wis-
dot\Stnd\C3D2018\Appdata\Plotters\PlotStyles\WisDOT_Standard_CTB.pdf

This file can be accessed from each WisDOT ribbon on the Manage & Support panel Open WisDOT 
standard CTB pdf.

Warnings: 
To ensure the 2018 plot style tables are consistent on each workstation the users should not 
make edits to the plot style tables. 

Any changes should only be made to a renamed saved copy and the copied plot style file 
should be provided with the project.

Part 2: Layers and civil styles

Since the plot style controls the black and gray shades, all other output including lineweight, linetype 
and even nonstandard colors can be set by the layer or style.  This provides the flexibility to develop 
output settings that are part of the drawing.

Standard layer example

Standard style defined example
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Style deferred to layer example
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Part 3: Layer states #layer-state

The third-tier is the layer states. This is the real backbone of the entire system.  A layer state is simply 
a snapshot of all the layer settings within the layer manager. The Layer States Manager is used to 
save the settings developed in the second tier. The layer states are saved within the drawing but can 
also be exported and imported into other drawings. WisDOT has included a few standard output lay-
ers states in each of the begin drawing templates; design, survey, plat, and construction-survey. 
WisDOT also provides the same layer states as files that can be imported into any drawing not star-
ted with the 2018 templates.

Access the WisDOT layer states palette from WisDOT Sheets > Plot Configuration > Layer States
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Or from WisDOT Sheets > Plot Configuration > Unsaved Layer States > Manage Layer States
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Info: The image above shows the settings to use when managing the WisDOT Layer States. 
The color, linetype and lineweight properties should always be checked to be restored. The 
other layer properties might need to be unchecked when depending on what the previous 
layer state or user set within the layer manager.

Part 4: Page setups & sheet templates

WisDOT provides predefined page setups. A page setup is a saved setting that specifies the plot area, 
paper size, scale, and plot style to use which determine the appearance of a plotted or published out-
put. These setups can be assigned to sheet layouts. WisDOT Civil 3D 2018 page setups have already 
been created for all of the standard WisDOT sheet sizes. All the page setups can also be imported 
from the Page Setups palette as needed and assigned to existing sheet layouts.

Access the WisDOT Page Setup palette from WisDOT Sheets > Plot Configuration > Page Setups

Page: 1344

Published on: 5/17/2023

2018 WisDOT plot standards



Notice all the settings, including the plots style that are set within a saved page setup.
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To access the WisDOT tool to manage page setups, go to WisDOT Sheets > Plot Configuration > 
Multi-Page Setup.
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Plot style tables for use with new Civil 3D 2018 drawings

The new wisdot_standard.ctb plot style table should be used with all drawings started in Civil 3D 
2018. Each color plot style can be overridden at the layer or object level.  When complete color out-
put is desired, it may be easier to use the wisdot_color.ctb plot style table. 

As in previous versions these two plot style tables are to be used in conjunction with a saved page 
setup and layer states that WisDOT has provided. Refer to the Page setup tool on the WisDOT Design 
and WisDOT Sheets palette.

Below are a few examples of plot style and layer settings comparisons.
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For sheet plans production WisDOT generally has had 3 standard output colors that could be 
assigned to CAD objects; black, gray, and white.  These may have been named Proposed, Existing, 
and Masking or ##B-wisdot and ##G-wisdot. Within the gray there have been a few options such as 
dark, medium or light gray. In each previous STB configuration, Normal is used to revert all settings 
to the layer, including the color. 

None of these concepts have changed when using the CTB. WisDOT is still providing the three main 
colors along with grayshade options, and of course the ability to make any object a specific color 
besides black, gray or white. 

The first thing you will notice is there is no Plot style that needs to be to set in the Layer manager 
when using a CTB.  The output color is determined by the color of the layer.

Black (Proposed)

In the WisDOT 2018 CTB configuration black is each color except for colors ending with 1, and colors 
21-29, and colors 243-255.

Gray (Existing)

In the WisDOT 2018 CTB configuration gray is each color that ends with a 1, and colors 22-29, and col-
ors 243-255. These two group of colors are used for county maps and to give the user additional 
gray shade options.

White (Masking)

The color 255 is reserved to use for masking.
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Normal (Color)

In the WisDOT 2018 CTB configuration all layer properties except for color can be considered to be 
set to Normal.  To override the plot style color change the color to a TrueColor (RGB color). Example 
red = (255,0,0)

 

How to modify 2018 civil object styles

To plot specific civil objects in color in an otherwise standard plot, the user can change the civil 
object style to an "override" TrueColor (RGB) or assign the civil object style to a layer that is set to 
plot an RGB color. In order to make a change to a style create a new style and adjust the hard-coded 
color in the style definition. Putting a suffix like _color in them can help denote predefined style sets 
to be used for overriding the output color and or lineweight at the object or layer level. For example, 
in order to plot proposed alignments in color follow these steps:

How to change a civil object style to an "override" TrueColor

To make a change to a style create a new style. Putting a suffix like _color in the name of the new 
color style can help denote predefined style sets to be used for overriding the output color and or 
lineweight in the object properties. Then adjust the color in the style definition to be a TrueColor. For 
example, in order to plot a proposed alignment in color using a defined civil style instead of changing 
the color properties of the layer, follow these steps:

 1. Create a copy of the ALI Proposed style and rename it to something unique.
 2. Edit the new style, and change all of the components' colors to an RGB color on the Display 

tab.
 A. You may want to modify both the Plan and Section display.
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In order to plot certain AutoCAD objects in color in an otherwise standard plot, the user will need to 
set the object to a TrueColor (RGB). This can be accomplished 2 ways:

 1. Select object to be plotted in color and change the color of the object to a TrueColor (RGB) in 
the properties dialog box.

 2. Keep all of the AutoCAD objects' colors set to BYLAYER, which is the default setting and 
change the color of the object layer to a TrueColor (RGB). This will plot all objects on this layer 
using the layer color. This can also be done to xreference layers when the color of an xrefer-
ence needs to be changed.

Tip: Any Civil 3D style may be copied and saved as a new style. The color, lineweight, and line-
type settings in the "Display" tab can then be set to create an override style. Do not edit the ori-
ginal WisDOT Civil 3D styles. Always create a copy. 

Demonstration: Modify objects using the WisDOT C3D 2018 plot style tables

plt-lyout-2018-plt-stndrd-02.mp4 3:01

plt-lyout-2018-plt-stndrd-data-c3d18.zip

plt-styl-bsc-demo.dwg, plt-styl-bsc-demo-fnshd.dwg

This is a simple demonstration to show the basics of setting object properties and layers to conform 
with the WisDOT Civil 3D 2018 plots styles.

This example will show how to:

 l Modify layers and objects to plot the black, gray, masked or color output you want
 l Modify objects so that they can conform to the standard layer states
 l Load standard layer states and set a layer state current
 l Save your custom layer settings as layer states within the drawing

In this drawing we can see that all the objects are on layer 0; in this case the wrong layer. Layer 0 is 
set to color 7. This will show ways to set the object's color to black, gray and masked.

 1. Open the layer manager and review the layers. Notice all the layers in this example are set to 
white and some of the lineweights are set pretty thick.

 2. Switch to the layout tab where you can see the object will plot black.
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 3. Switch back to the model tab where you can see each object will plot black.

plt-lyout-2018-plt-stndrd-03.mp4 5:50

 4. WisDOT Sheets > Manage & Support > Open WisDOT standard CTB pdf to review the plot 
style table.

 A. Use the table to manually set the objects to an appropriate color that will make them 
plot black, gray and masked. In this demonstration the Quick Properties is set to on.

 B. Select the line labeled E_AREA (Existing, Gray) and change the color to 11 and deselect
 C. Select the line labeled P_AREA (Proposed, Black) and change the color to red and 

deselect
 D. Select the line labeled P_RDWY_Berm (Proposed, Black) and change the color to 80, 

deselect
 E. Select the line labeled P_MISC_Mask (Masked, White) and change the color to 255, 255, 

255, deselect
 F. Switch the hatch by using right to left crossing and change the color to 255, 255, 255, 

deselect
 5. Switch to the layout tab to see the plotting effects of these changes. Now modify the gray 

shade to be darker.
 6. Access the model space through the viewport. Select the line labeled E_AREA (Existing, Gray) 

and change the color to 251, deselect
 7. Select all objects and set the color to ByLayer
 8. Select each object and set it to the proper layer defined by the text. Set all the text to be on P_

MISC_Text. Each object now has a linetype defined by the layer
 9. To set all the layer settings including the color to the 2018 WisDOT standard:

 A. Exit the model space viewport and switch to the model tab
 B. WisDOT Sheets > Plot Configuration > Layer States to open the palette
 C. This is an easy way to load any of the layer states into the current drawing. The 

WisDOT begin drawing templates have the appropriate standard layer states already 
loaded

 10. Pick WisDOT18 All Layers (default) to load the layer state into the drawing
 11. WisDOT Sheets > Plot Configuration > Unsaved Layer State pulldown and select 

WisDOT All Layers (default)
 A. Open the Layer manager, select the All Used Layers filter
 B. Now each layer is set to plot black, gray or masked depending on the color of the layer 

it is assigned. The standard color of most of the proposed layers has not changed 
since most of them plot as black

 12. Switch to the Layout tab to see the standard plot output
 13. To modify objects on a layer to plot color define that color as an RGB color

 A. Open the Layer Manager and change the color of layer P_RDWY_Berm to the TrueCo-
lor equivalent to magenta

 B. The line will plot in color
 14. To save this custom color configuration to a Layer State: WisDOT Sheets > Plot Con-

figuration > Unsaved Layer State > Manage Layer States
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 15. Make sure both restore options in the lower left are unchecked and New
 16. Name it: My Custom Layer State, Close
 17. From the Unsaved Layer State pull-down you can switch back and forth between WisDOT All 

Layers (default) and My Custom Layer State

Demonstration: Options for preparing legacy dwgs for use with the WisDOT C3D 
2018 plot style table #demo

plt-lyout-2018-plt-stndrd-04.mp4 6:26

plt-lyout-2018-plt-stndrd-data-c3d18.zip

plt-styl-mdfy-lgcy-dwgs.dwg, plt-styl-mdfy-lgcy-dwgs-fnsh.dwg

Even new projects that begin in the Civil3D 2018 version using the WisDOT 2018 standards might 
need to reference some drawings that were developed with previous standards using previous 
AutoCAD versions. These files will need to be setup so they will work with the 2018 plot style table.

If you have permission to edit these drawings then use the following steps as a guide to update the 
drawings that require conversion. If you do not have permission to edit these drawings then you will 
need to send these steps and the WisDOT18 All Layers (default).las LayerState file to the person that 
can make these modifications.

In this example exercise we will be assuming that an older existing base drawing will be  referenced 
into a design dwg. For ease of display and demonstration purposes the drawing background has 
been set to white. The drawing has already been converted to a CTB plot style format drawing, and a 
WisDOT C3D 2018 Page Setup has been loaded and set for the layout.

Tasks covered in this example:

 l Change objects to ByLayer
 l Create a Layer filter
 l Modify layer colors to plot gray
 l Modify blocks to plot according to the layer they are on

 1. Open plt-styl-mdfy-lgcy-dwgs.dwg

Tip: WisDOT has provided Preset LayerStates that include all the layers and settings that 
are used for WisDOT Standards 2018 and 2016. It may not be an all-inclusive list for 
your specific base drawing that needs to be converted. The existing dwg may or may not 
have existing layer states imported. New LayerStates will need to be imported.

 2. Create a custom layer snap shot of the existing conditions of the drawing:
 A. WisDOT Sheets > Plot Configuration > Unsaved Layer States > New Layer States
 B. Name it: Existing Topo Layers
 C. Description: Topo-Ex existing layer states

 3. Import the WisDOT C3D 2018 default layer state from the palette.

 A. WisDOT Sheets tab > Plot configuration > Layer States
 B. Select WisDOT18 All Layers (default) from the palette
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 4. WisDOT Sheets > Plot Configuration > Layer States pull-down > Select the layer state 
to make it current.

 5. Expand the pull-down and move the cursor over each layer state in the list to reveal the layer 
color changes in the drawing area.

Info: The dwg may require legacy or older custom layers to be modified manually. 
Most things that may need to be modified manually would be custom layers not 
included in the 2018 standards.  Objects that are not set to color ByLayer, and civil 
objects using styles from a previous version.

The following steps as a guide to manually update object and layer settings to conform with the 
WisDOT 2018 layer states.

IIn cases where the dwg was created using the 2018 plot style and standards tools, there usually is 
not a need to modify anything.

Info: It is now clear which objects are not set to a grayscale color for plotting. The trees and 
manholes are still black.

 1. By checking the Quick properties of the tree line and tree blocks we can see they are on a 
non-standard layer named E-LAND-Trees.

 2. The quick Properties of the manhole reveal that the blocks are on layer E_DRN_Grate.
 3. In the Layer Properties Manager, scroll down until there are layers that have a light green 

value. Notice the existing layers that are close to green are set to 81. (Numbers ending in 1 
plot gray)

 4. Now look at existing layers that have a light blue value. Notice the existing layers that are 
close to blue are set to 171. (Numbers ending in 1 plot gray)

 5. Select the color column of the E-LAND-Trees layer and type in the color number 81.
 6. Switch back to the drawing area

 A. The trees change to a gray scale.
 B. Notice that the block MHO is still black and not gray after setting the layer state. This 

usually means that the block may be a legacy block or one from another CAD software 
that has the color set within the block and not referencing the layer it is on.

 7. To edit all the references of the block, select one of the manhole blocks > right click > 
Block Editor

 A. Select all the circle objects
 B. In the quick Properties change the color to ByBlock and the layer to 0.

Info: Setting the block to ByBlock and layer to 0 allows the block to take on the 
layer it is assigned to in the drawing and be editable through the xref layers of 
the host drawing.

 C. Close Block Editor, Save the changes
 8. Repeat the last step for all the blocks that have the block objects set directly within the block. 

Some objects like the trees still are black and not set to gray.
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 9. Change all objects in the drawing to ByLayer to ensure that they are being controlled by the 
layer color, use the Quick Select tool in the right-click menu.

 A. Apply to: Entire drawing
 B. Object type: Multiple
 C. Properties: Color
 D. Operator: <> Not Equal
 E. Value: ByLayer
 F. OK

 10. Properties palette > Color: ByLayer

Now all the objects and layers should be ready to plot using the WisDOT C3D 2018 plot style table.

Multi-page setup tool #multi

Once page setups are added to the drawing from the palette, the Multi-Page Setup tool can be used 
to set the layouts to a page setup. This can be done globally or by selection of layouts in a list. See 
Multi-Page Setup for more info.

Using plot overrides
Last updated: 2016-03-10

Total video time: 11:56

plt-lyout-plt-overrides.mp4 11:56 - This video contains the training for this entire module.

Plot overrides

Plot overrides may be used to override the standard plot style table. Two examples of plot overrides 
are color or lineweight.

Override method

 l Use the Normal plot style
 l This plot style sets color and lineweight to use object settings. This includes layer settings.
 l Visual properties determine plotted output

Override types

 l Override by object settings
 l Override by layer settings
 l Override by Civil 3D style. At this point there is a defect within the Civil 3D stb dwg format, 

where the Civil styles for alignments and profiles cannot set a plot style as an override.

Global plot override by plot style table method

 l Allows all objects in a drawing to be plotted using overrides
 l Use wisdot_override.stb plot style table

By object
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Override method

Object properties can be altered to effect single or multiple objects.

 1. Open the Properties palette.
 2. Select an object (or objects).
 3. Change the Plot Style to Normal in the Properties palette.

 4. Change object color and/or lineweight (if desired).
 5. The object(s) will now plot using the visual properties of the object(s).

By layer

Layer properties can be altered to effect all objects on a layer.

 1. Open the Layer Properties Manager.
 2. Select a layer (or layers).
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 3. Change the Plot Style to Normal.

 4. Change layer color and/or lineweight (if desired).
 5. All objects on the layer(s) will now plot using the visual properties of the layers(s).

By Civil 3D style

Civil 3D styles can be altered to effect single or multiple Civil 3D objects.

 1. Open the Properties palette.
 2. Select a Civil 3D object.
 3. Change the Plot Style to Normal in the Properties palette.
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 4. Right-click on the object and select its Properties window, or select using the button on the 
Ribbon.

 5. On the Information tab select an Object style that is named ...Override. Select Copy Current 
Selection from the dropdown button to the right of the Object style. The Style editing window 
will open.

 6. Select the Display tab. You will notice the ...Override style already has the Plot Style set to 
Normal.
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 7. Make any desired edits to the color and/or lineweights.

 8. Select the Information tab, rename the style, and click OK to save the style.
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 9. Verify the newly created Object style is set and click OK

 10. The Civil 3D object will now plot using the visual properties of the Civil 3D style.

Tip: Any Civil 3D style may be copied and saved as a new style. The color, lineweight, and plot 
style settings in the "Display" tab can then be set to create an override style. Do not edit the ori-
ginal WisDOT Civil 3D styles. Always create a copy.

Global plot override by plot style table

A global override can be set that will allow all objects in the drawing to be plotted using color and 
lineweight overrides. This method is best used on a drawing that will be primarily plotted in color. 
Layer settings, layer states, and custom styles can then be used to quickly create the desired output 
settings.

 1. Select Page Setups from the WisDOT Standards ribbon.

Page: 1360

Published on: 5/17/2023

Using plot overrides



 2. On the Page Setups palette select a page size corresponding to the layouts in the drawing 
and select the page setup for that size named ..._override. Click the button to add the over-
ride page setup to the drawing.

 3. Right-click on a layout tab and select "Page Setup Manager..."
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 4. Select the .._override page setup and click Set Current to apply it to the layout.

 5. Optionally, use the Current Page Setup All tool to set all layouts to the current page setup.

 6. Notice in the layout, all objects are set to plot using object color and set to plot using object 
lineweight. This is a global change.

 7. Use object properties settings, layer properties settings, and Civil 3D style settings to control 
color and lineweight. The visual appearance determines the plotted output.

 8. Use layer settings, layer states, and custom styles to quickly switch between different plot 
override settings.
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 9. To return to standard plot settings, set current a ...-stnd page setup in the layout(s).

Plotting workflow using C3D 2016 templates
Last updated: 2016-03-11

The purpose for the upgrades of the plot style tables and plotting workflow in Civil 3D 2016 is to 
make sure that standard output can be achieve consistently using all workstations with WisDOT Civil 
3D 2016 standards loaded.  Non-standard output is achieved by saving those changes within the 
drawing files.  In the past, users would often make their own custom plot style table to get a desired 
output.  The downside to that workflow is the custom table is only located on that user's machine.  
No other person would be able to get the same plotting output without obtaining the custom plot 
style table.  The new standards provided with the Civil 3D 2016 WisDOT customization gives each 
user the flexibility for custom plotting output without modifying the plot style tables.

Civil objects – styles-dependent

Style-dependent is where the output and/or display settings are defined within the civil style and not 
merely redirected to multiple layer settings

Most of the civil object styles in the Civil 3D 2016 drawing templates are styles-dependent as 
opposed to layer-dependent as they were in the Civil 3D 2014 templates. This translates to a slightly 
different plotting workflow in 2016. The 2016 civil styles are configured to match the WisDOT Stand-
ards for Color and Linetype using Plot Styles. These style are considered hard-coded to the wisdot 
standards. This differs from the setup in Civil 3D 2014, where all of the civil style properties were con-
trolled by the layer settings.
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WisDOT 2016 page setups
Last updated: 2016-03-10

Total video time: 03:36

2016 page setups

plt-lyout-wisdot-pg-setups.mp4  03:36

WisDOT has provided predefined page setups. A page setup is a saved setting that specifies the plot 
area, paper size, scale, and plot style to use which determine the appearance of a plotted or pub-
lished output.

Civil 3D 2016 also utilizes page setups. A page setup hard-codes the plot style table, plotter, paper 
size, and orientation among other plotting options. These setups are then assigned to sheet layouts. 
These page setups have already been created for all of the standard WisDOT sheet sizes, and can be 
imported from the Page Setups palette as needed and then assigned to sheet layouts. 
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Current Page Setup All Tool

Once one Layout is set to a page setup, the Current Page Setup All tool can be used to set the rest of 
the layout to the same page setup. This tool is accessed by expanding the Plot Configuration panel 
pull-down on the WisDOT Sheets ribbon.

Sheet layout title block text fields
Last updated: 2016-03-11

WisDOT Civil 3D sheet layout title blocks contain a mixture of auto-generated and user-generated 
text. This generated text is accomplished by using text fields instead of regular text. The use of text 
fields eliminates the need to manually enter title block text in each layout.

Updating text fields

Text field updating is controlled by a system variable named FIELDEVAL. WisDOT Civil 3D standards 
have this variable set to update all fields upon an open, save, plot, or eTransmit. To update a text 
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field manually, type UPDATEFIELD and select the text field(s) you wish to update.

Title block text fields

Auto-generated text fields

Some Title Block text fields contain auto-generated text.

FILE NAME and LAYOUT NAME are automatically generated and do not require user input.

The PLOT DATE and PLOT BY fields are automatically generated.
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PLOT SCALE is auto-generated if using the original viewport in with the layout. If the original viewport 
is deleted or a new viewport is added then PLOT SCALE must be entered manually.

User-generated text fields

Auto-generated text fields

Some Title Block text fields are populated with user-generated values. These values are acquired 
from the Sheet Set the layout belongs to.

PROJECT NO, HWY, and COUNTY are populated with values from the Sheet Set Custom Properties. To 
access Sheet Set Custom Properties:
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 1. Open the sheet set manager palette.

 2. Open a sheet set (if not already open).
 3. Add layout(s) to the sheet set (if not already added).
 4. Right-click on the sheet set name and select Properties...
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 5. Enter values for the Sheet Set Custom Properties and click OK. 

These values only need to be entered once per sheet set. These user-generated values will then pop-
ulate the text fields of all layout sheet title blocks that are in the same sheet set.

 6. Click Save to see changes. 

The SHEET TITLE text field is populated with the user-generated name of the Sheet Set subset.
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 7. Right-click on a sheet set and select New Subset...

 8. Give the subset a name and add layouts to it. All layouts belonging to a Sheet Set subset will 
have the title block sheet title field populated with the subset name. 

To have multiple layouts in one sheet set with different sheet titles, organize layouts into distinct sub-
sets.

Plotting overrides for survey figures & alignments in XREFs
Last updated: 2016-03-10

Total video time: 08:03

This is the Civil 3D 2016 workflow to override plotting output for Survey Figures and Alignments con-
tained in XREFs.  Any component of an alignment or survey figure style that is set to ByLayer can be 
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overridden through the xreference layer properties.  This includes color, lineweight and plot style.  
These styles were set up this way to eliminate the user having to alter the XREFs. Rather, these over-
rides can be implemented in the consuming production drawing. 

Overrides done on the XREF layers

plt-lyout-plt-overrides-srvy-fig-ali-in-xrefs.mp4  08:03

When the need to plot any of the Survey Figures or Alignments in color arises, the user will simply 
need to set the plot style within the appropriate XREF layer(s). The following is the workflow:

 1. Before any overrides are applied, the user may want to create a layer state which will pre-
serve the XREF layers in their original state. When the override settings have been made the 
user can then create another layer state for the override configuration which will allow tog-
gling between the two. See the last part of this document for more on creating layer states. 

 2. Open the civil style(s) for the civil objects to be plotted in color in order to view the settings.
 3. Determine which component layers need to be edited. For survey figures, this is a single 

layer. For alignments, this could be multiple layers since lines, curves and spirals all have indi-
vidual layer settings. Most of the time these will all be on the same layer.

 4. Once the layers to edit have been identified, close the style settings dialog and make the plot 
style change to Normal on the identified XREF layers NOT on the production drawing layers. 
The XREF layers are found on the very bottom of the Layer Properties Manager filters list. This 
will now enable these civil objects contained in the XREF to be plotted in color. Color and line-
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weight changes are also made on the same XREF layers.

Tips: NOTE: Be aware that occasionally there is glitch where the color dis-
played on the screen is incorrect, but the output will still plot the correct 
color:

Layer states for overrides

 1. The user can then create a new Layer State for these settings to allow toggling back and forth 
between the standard layer setting and the new override layer settings

 2. Give this new Layer State an appropriate name and description.

Turning off frames on overlapping images
Last updated: 2013-01-15
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Turning off frames on overlapping images

If frames are showing up on overlapping attached image or PDFs, the following settings will turn 
them off:

Info: There are two settings that control frames for images. They are FRAME and 
IMAGEFRAME.

Type FRAMEEnter the type 0Enter.

Tip: If that doesn't shut off the frames: 

Type IMAGEFRAMEEnter then type 0Enter.

Info: That should turn off the frames and set them so they do not plot. 

Plot sheet set in DWG TrueView
Plotting from DWG TrueView is usually the fastest method of plotting Civil 3D files. This is especially 
true for sheet sets that contain sheets from multiple DWGs. DWG TrueView will only open files as 
read-only. Civil 3D opens files for edit and can run processes to update corridors, Civil 3D object data 
shortcuts, and XREFs that take time.

Create drawing set description (*.dsd) file from Civil 3D sheet set (*.dst)

The Autodesk publish (batch plot) engine is in their softwares that open DWGs. A plot set can be 
saved in a *.dsd file. These can be created in the publish dialog box. In the following steps, we will 
create a *.dsd file from the Sheet Set Manager in Civil 3D.

 1. Open Sheet Set Manager in Civil 3D 
 A. Home tab > Palettes panel dropdown > Sheet Set Manager
 B. Sheet Set Manager palette > Open

 I. Navigate to Sheet Set file location and select *.dst file
 2. Sheet Set Manager palette > Print button > Publish Dialog Box...
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 A. Publish dialog box > Save Select file location and name to save dsd (Example: N:\p-
ds\c3d\12345678\SheetsPlan\*.dsd).
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 B. Publish dialog box > Cancel

Open *.dsd file in DWG TrueView and plot
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 1. Open a dwg file in TrueView
 2. Home tab > Output panel > Batch Plot > Publish dialog box

 A. Open

 B. Do you want to save the current list of sheets?No
 C. Load *.dsd file
 D. One or more sheets are currently in the sheet list. What do you want to do?Replace 

all sheets in the list
 E. This message box may appear
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 F. Close
 G. Check that PDF Preset: WisDOT PDF

 H. Publish
 I. Select file location and name to save pdf (Example: N\p-

ds\c3d\12345678\SheetsPlan\pdf\*.pdf)
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TrueView single plot
Last updated: 2020-10-26

Total video time: 3:18

Exercise files: plt-lyout-truvu-sngl-plt-data-C3D16.zip

plt-lyout-truvu-sngl-plt.mp4 3:18

Trueview single plot

 1. c3d >12345678 > SheetsOther > 
 2. Open file Stoneridge Road Aerial.dwg
 3. View panel > middle drop-down > Intersection 
 4. Output tab > Plot
 5. In Printer/plotter area

 A. Name = WisDot PDF.pc3
 B. Paper size = WisDot 8.5"x11"
 C. Preview
 D. Cancel

 6. In the bottom Left-Hand corner select on thePlan 1IN 100 FT sheet layout
 7. Output tab > Plot
 8. In the Printer/plotter area

 A. Name = WisDot PDF.pc3
 B. Paper size = ANSI full bleed B(11.00x17.00 Inches)
 C. What to Plot = Layout
 D. Preview
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 E. OK
 F. c3d>12345678 > SheetsOther

 I. name the file Stoneridge Road Aerial-Plan 1IN 100 FT.pdf
 G. Save

 9.  No on the box that appears.

TrueView batch plot
Last updated: 2020-10-26

Total video time: 3:54

Exercise files: plt-lyout-truvu-btch-plt-data-C3D16.zip

plt-lyout-truvu-btch-plt.mp4 3:54

Trueview batch plot
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 1. Open Stoneridge Road Aerial.dwg file.
 2. Output > Plot > Batchplot

 A. Publish to = Plotter named in page setup
 B. Publish Operations Information is set to the project location.
 C. CTRL select the drawing files and the layout tabs. 

 I. Remove Sheets
 D. Add Sheets

 I. 12345678 > SheetsPlan > select 024501-pm.dwg
 E. CTRL select the model and some of the files from the bottom 

 I. Remove Sheets
 F. Select the Stoneridge Road Aerial-Plan 1 IN 100 FT and move it to the bottom. 

 G. Publish

Structures plan production
08 Structures
Last updated: 2022-05-16

Total video time: 1:52:10

Overview

Loads palette content used in the creation of structures plans, including bridges, culverts, retaining 
walls, sign structures, and miscellaneous structures.
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Usage

WisDOT Sheets tab > Sheet Creation panel >  Structure

The palettes can also be loaded from the command line: =WIS-SHEETS-08.

Templates palette

Create new drawings and layout sheets with structures title blocks from templates, or convert exist-
ing MicroStation drawings.

Content

 l Create a new drawing from template     
 o The LAYOUT & GEO template uses base units of feet,       measured in decimal format. 

This template should be used for the General Plans sheet and       Subsurface Exploration 
sheet, where it is important for xrefs to be coordinate correct.      

 o The DETAILS template uses base units of inches measured in       architectural format. 
This template should be used in most sheets.      

 l Create sheet layouts with the structures sheet borders.     
 o Sheet layouts are separated into two categories: Bureau of Structures layouts and        Con-

sultant layouts. BOS layouts contain language and logos specific to BOS, while       con-
sultant layouts leave blanks for consultant-specific logos.      

 o Within each category, there are 3 sheet layouts, each containing different sheet bor-
ders:       

 n SHEET 1
 n SHEET 2 - A generic border
 n SHEET 4 - Subsurface exploration sheet border

 l Purge Non Structures Styles     
 o This tool will run "Purge All," but keeps the layers, text styles, dimension styles,       and 

multileader styles that are standard for structures drawings.      
 l Fix Annotation Scales     

 o This tool will remove all annotation scales except the currently active scale from        selec-
ted annotative elements.      

 l Convert MicroStation drawings to use the Structures Civil 3D styles

Structures templates & title blocks

sht-creatn-struct-tmp.mp4 13:50

MicroStation conversion

sht-creatn-struct-cnv.mp4 9:21
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Blocks Palettes

The remaining palettes mainly contain blocks for detailing structures plans. A list of each block    along 
with tutorial videos are provided within each palette heading below.

Warning: The structures blocks use layers and fonts stored in the structures templates. They 
work best when used as intended in the     struct-decimal-start.dwt or struct-inch-start.dwt 
template drawings.    These templates can be quickly accessed from the Templates palette.   

sht-creatn-struct-blks-01.mp4 9:49

sht-creatn-struct-blks-02.mp4 1:57

Annotations

Quickly create annotations according to the standard structures styles, and place annotation sym-
bols.

Quick Annotations

Quick annotations can be used to quickly apply layers and styles according to the standard struc-
tures styles. 

Warning: The quick annotation tools will only work while in a struct-decimal-start.dwt or 
struct-inch-start.dwt template drawing.    These templates can be quickly accessed from the 
Templates palette.   

 l Dimension
 l General Text
 l Subtitle Text
 l Title Text
 l Multileader
 l Keynote Multileader

Symbols

 l Symbols     

sht-creatn-struct-anno-sym.mp4 0:31

 l Numbered Symbols     

sht-creatn-struct-anno-sym-no.mp4 0:48

 l Swirl
 l Breakline     

sht-creatn-struct-anno-brk.mp4 0:59
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 l Masked Arrow     

sht-creatn-struct-anno-arr.mp4 0:42

 l Note Callout     

sht-creatn-struct-anno-note.mp4 0:47

 l Section Mark     

sht-creatn-struct-anno-sect.mp4 0:55

 l Station Mark     

sht-creatn-struct-anno-sta.mp4 0:40

 l Caution Symbol     

sht-creatn-struct-anno-cau.mp4 0:16

General plans

This palette contains blocks that help detail bridge general plan sheets, as well as general plan 
sheets for other structures.

Sheet Layout

Tip: The Sheet Layout blocks are intended to be placed directly on the sheet layout at a scale 
of 1.0.    Many of these blocks will snap directly to the title block. If you want, you can place the 
blocks in model space instead, but    you will need to scale the blocks up by 12 before applying 
your viewport scale factor.   

 l Design Data
 l Design Contacts     

sht-creatn-struct-gen-cont.mp4 0:26      

 l Sheet List
 l Revision Symbol

Plan

 l North Arrow    
 l Waterway Flow     

sht-creatn-struct-gen-wtwy.mp4 0:35

Page: 1384

Published on: 5/17/2023

08 Structures

https://c3dkb.dot.wi.gov/video/wisdot-cstm/c3d-tab/sht/sht-creatn-struct-anno-arr.mp4
https://c3dkb.dot.wi.gov/video/wisdot-cstm/c3d-tab/sht/sht-creatn-struct-anno-note.mp4
https://c3dkb.dot.wi.gov/video/wisdot-cstm/c3d-tab/sht/sht-creatn-struct-anno-sect.mp4
https://c3dkb.dot.wi.gov/video/wisdot-cstm/c3d-tab/sht/sht-creatn-struct-anno-sta.mp4
https://c3dkb.dot.wi.gov/video/wisdot-cstm/c3d-tab/sht/sht-creatn-struct-anno-cau.mp4
https://c3dkb.dot.wi.gov/video/wisdot-cstm/c3d-tab/sht/sht-creatn-struct-gen-cont.mp4
https://c3dkb.dot.wi.gov/video/wisdot-cstm/c3d-tab/sht/sht-creatn-struct-gen-wtwy.mp4


 l Lane Arrows     

sht-creatn-struct-gen-lane.mp4 1:24

 l Wing Note     

sht-creatn-struct-gen-wing.mp4 0:30

 l Station Mark     

sht-creatn-struct-anno-sta.mp4 0:40

 l Riprap     
 l Bench Mark    

Elevation

 l Cross Slope
 l Waterline Symbol     

sht-creatn-struct-gen-wtln.mp4 0:21

 l Fill Detail at Wings     

sht-creatn-struct-gen-fill.mp4 0:59

 l Riprap Toe Detail     

sht-creatn-struct-gen-riprap.mp4 0:29

 l Elevation Scale     

sht-creatn-struct-gen-el.mp4 1:38

Cross Section and Quantities

This palette contains blocks that help detail bridge cross section views, as well as bid item and quant-
ities tables, bridge general notes, and typical details.

Tip: The Bid Items and Quantities, General Notes, and Typical Details blocks are intended    to 
be placed directly on the sheet layout at a scale of 1.0. Some of these blocks will snap directly 
to the title block.    If you want, you can place the blocks in model space instead, but you will 
need to scale the blocks up by 12 before applying    your viewport scale factor.   

sht-creatn-struct-quan.mp4 11:34    

Cross Section

 l Cross Slope
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Bid Items and Quantities

 l Table

General Notes

 l New Bridges     

sht-creatn-struct-quan-gen.mp4 1:47

 l Overlays

Typical Details

 l Profile Grade Line
 l Substructure Callout for Profile Grade Line      

sht-creatn-struct-quan-pglc.mp4 0:57

 l Abutment Backfill Detail     

sht-creatn-struct-gen-abut.mp4 0:23

 l Backfill Details for Substructures     

sht-creatn-struct-gen-bkfl.mp4 0:25

 l Rodent Screen Details     

sht-creatn-struct-gen-rsd.mp4 0:25

 l Bench Mark

Substructures

This palette contains blocks that help detail bridge substructures.

All Bridge Substructures

 l Standard Bubble Notes
 l Rocker Bearing     

sht-creatn-struct-sub-rocker.mp4 0:20

 l Beam Seat
 l Pile Details     

sht-creatn-struct-sub-pile.mp4 1:23

 l Pile Elevations
 l Batter Arrow
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Abutments

Tip: The A1 Abutment Section and Slope Paving blocks are drawn at a scale of 2.0.    They are 
intended to be used together along with the Pile Elevations block to create a complete    abut-
ment section detail, and should be used in a viewport with an annotation scale of 2.0 (1 paper 
inch = 24 drawing feet).   

 l A1 Abutment Section     

sht-creatn-struct-sub-a1.mp4 4:44

 l Slope Paving
 l Rodent Screen Detail     

sht-creatn-struct-gen-rsd.mp4 0:25

 l 6in Drain     

sht-creatn-struct-sub-drain.mp4 0:51

 l Eyebolt     

sht-creatn-struct-sub-eyebolt.mp4 0:20

Piers

 l Pier Column
 l Rustication Detail
 l Bevel     

sht-creatn-struct-sub-pbev.mp4 0:21

 l Precast Option

Rebar

This palette contains blocks that help detail rebar, bar callouts, and bill of bar tables.

Bar Detailing

 l Rebar Section     

sht-creatn-struct-rebar-sect.mp4 0:48

 l Deck Bar Callout
 l Stirrup
 l Rotated Stirrup
 l U-Bar     

sht-creatn-struct-rebar-ubar.mp4 1:36
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 l L-Bar
 l Equally Spaced Bars     

sht-creatn-struct-rebar-spaced.mp4 3:01

 l Hooked Bar
 l Parapet Bars

Bill of Bars

 l Bill of Bars Table     

sht-creatn-struct-rebar-bob.mp4 3:14

sht-creatn-struct-rebar-bob2.mp4 19:12

 l Bundling Detail
 l All Bar Bends     

sht-creatn-struct-rebar-bend.mp4 1:24

 l L Bar
 l Stirrups
 l U Bar
 l Spiral
 l Z Bar
 l Hook
 l Double Hook
 l Hairpin
 l Hooked Hairpin
 l 135° Bend
 l Hat
 l Abutment Diaphragm
 l 32SS Bars
 l 36SS Bars
 l 42SS Bars
 l 56SS Bars

Superstructures

This palette contains blocks that help detail bridge superstructures.

Girder

 l Prestressed Shapes     

sht-creatn-struct-super-ps.mp4 0:34
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 l Haunch Details
 l Shear Connection Detail
 l Transportation Note

Deck

 l Deck Section     

sht-creatn-struct-super-sect.mp4 1:23

 l Joint Details     

sht-creatn-struct-super-joint.mp4 0:17

 l Median Details
 l Floor Drain
 l Strip Seal Elevation

Annotation

 l V Groove Note
 l Deck Bar Callout
 l Top of Deck Elevation Table
 l Deflection Diagram
 l Tangent Offset Table

Barriers

This palette contains blocks that help detail barriers, rails, and lighting.

Parapets and Barriers

 l Barriers     

sht-creatn-struct-bar-bar.mp4 1:02

 l Parapet Transition     

sht-creatn-struct-bar-trans.mp4 1:02

 l Beamguard Anchor Assembly     

sht-creatn-struct-bar-bg.mp4 0:25

Fence and Railings

 l Fence and Railings     

sht-creatn-struct-bar-fen.mp4 0:53
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Lights

 l Light     

sht-creatn-struct-bar-light.mp4 0:36

Steel

This palette contains common steel shapes and details.

Piles

 l Cast in Place Piles     

sht-creatn-struct-steel-cip.mp4 0:29

 l HP Piles     

sht-creatn-struct-steel-hp.mp4 0:22

 l Sheet Pile
 l Elevations

Steel Shapes

 l Angle     

sht-creatn-struct-steel-angle.mp4 0:21

 l Channel     

sht-creatn-struct-steel-channel.mp4 0:20

 l HSS     

sht-creatn-struct-steel-hss.mp4 0:24

 l MC Channel     

sht-creatn-struct-steel-mc.mp4 0:24

 l Pipe     

sht-creatn-struct-steel-pipe.mp4 0:38

 l WF Beam     

sht-creatn-struct-steel-wf.mp4 0:25
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https://c3dkb.dot.wi.gov/video/wisdot-cstm/c3d-tab/sht/sht-creatn-struct-steel-channel.mp4
https://c3dkb.dot.wi.gov/video/wisdot-cstm/c3d-tab/sht/sht-creatn-struct-steel-hss.mp4
https://c3dkb.dot.wi.gov/video/wisdot-cstm/c3d-tab/sht/sht-creatn-struct-steel-mc.mp4
https://c3dkb.dot.wi.gov/video/wisdot-cstm/c3d-tab/sht/sht-creatn-struct-steel-pipe.mp4
https://c3dkb.dot.wi.gov/video/wisdot-cstm/c3d-tab/sht/sht-creatn-struct-steel-wf.mp4


Bolts

 l Bolt Plan
 l Bolt Section
 l Anchor Rod
 l Washer

Other

 l Girder Stud
 l Rocker Bearing
 l Strip Seal Joint

Culverts

This palette contains blocks that help detail culverts.

General Plan

 l Design Data and General Notes     

Tip: The Design Data and General Notes block is intended to be placed directly on the 
sheet layout at a scale of 1.0.      This block will snap directly to the title block. If you want, 
you can place the block in model space instead, but      you will need to scale the block up 
by 12 before applying your viewport scale factor.     

 l Backfill Note
 l Misc. Notes

Box Details

 l Header Bars
 l Header Detail
 l Joint Detail

Apron Details

 l Cut Off Wall Detail
 l Inlet Nose Details
 l Joint Detail
 l Name Plate Detail

Miscellaneous

This palette contains miscellaneous blocks that don't fit with other palettes.

Structural Approach Slab

 l Typical Section
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Retaining Wall

 l Design Data     

Tip: The Design Data block is intended to be placed directly on the sheet layout at a 
scale of 1.0.      This block will snap directly to the title block. If you want, you can place the 
block in model space instead, but      you will need to scale the block up by 12 before apply-
ing your viewport scale factor.     

 l Elevation Detail
 l Joint Detail
 l Name Plate

Subsurface Exploration

 l Grid

Viewport

 l Outline     

sht-creatn-struct-misc-vp.mp4 2:22

Setting up a Structures drawing with a rotated modelspace
Last updated: 2022-08-30

Create a new drawing in the correct template

 1. Open the Structures Palettes
WisDOT Sheets tab > Sheet Creation panel > Structure

The palettes can also be loaded from the command line: =WIS-SHEETS-08.

 2. Create a new Layout and Geo template from the Template Palette.             
Templates Palette > LAYOUT & GEO (decimal-ft)

 3. Save the file.
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Add external references to the drawing

 1. Xref all needed files into the plan details sheet file using the WisDOT Xref tools - Load Xref on 
Layer tool. 

 A. Ribbon > WisDOT Sheets tab > Manage panel > Load Xref on Layer
 B. Browse to the file > Open

 2. Repeat for any other files.
 3. Zoom extents (ZE)to see the drawing data.

Rotate View

 1. Rotate view to make structure layout line horizontal             
 A. Ribbon > WisDOT Sheets tab > View panel > Rotate View

 B. This tool requires 2 points to rotate. The first should be left of the second   (i.e. 1st = “ori-
gin” and 2nd = “point on x-axis”).

Create UCS for Structure

 1. Type UCS at the command line.             
 A. Alternatively,                     

 I. Below the View Cube click the down arrow next to WCS
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 II. Choose "New UCS"

 2. Create new UCS using the View option.

            

 3. Open the UCS Manager with  Ribbon > View Tab >  Coordinates panel > bottom right 
arrow  (or USCMAN):

            

 4. In the Named UCSs tab, click on "Unnamed" and rename it to "STRUCTURE". 
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 5. OK

Reset Crosshairs Orthogonal to View

 1. Type the command SNAPANG
 2. Type 0
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Toggle UCSs

 1. If it is not currently displayed, turn on the View Cube.             
 A. Ribbon > View tab > Viewport Tools panel > View Cube

 2. UCS can be toggled at any point in time using the drop-down below the View Cube.

            

Notes:

Requirement: All dimensioning and annotating should be completed with the “STRUCTURE” 
UCS active.

Warning: Changing the UCS also changes the location of coordinate 0,0 with respect to the 
World Coordinate System (WCS).   All XREFs should occur when UCS is set to “WCS”     

Info: Rotation of view will not impact the proper insertion of the reference.                  

Creating structures layout sheets with rotated viewports
Last updated: 2022-05-16

Setting up a Structures drawing with a rotated modelspace #setup

 1. Begin with a structures drawing from the Structure template. 
 2. Follow steps in "Setting up a Structures drawing with a rotated modelspace" on page 1392
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Create a Layout Sheet

 1. Open the Structures Tool Palette: WisDOT Sheets tab >     Sheet Creation panel > 08 Struc-
ture Tool Palette

 2. In the Template Palette choose a Sheet option under     Sheet Layouts - BOS or     Sheet Lay-
outs - Consultants

 3. In model space, be sure change UCS to WCS (not "STRUCTURE" or "Unnamed")     

Info: The view doesn’t have to be physically rotated, but it is important that the       View 
Cube is      aligned with North     

 4. Follow the instructions given on      Sheet Tools - Align Viewport  
 o For structures templates, the Scale mode functions the same, but the values       to enter 

are dependent on the structures template currently being used. 
 n For a LAYOUT & GEO file, type the desired scale in the command line. For 

example, for a scale of "10.0", type 10
 n For a DETAILS file, type the desired scale x 12 in the command line. For 

example, for a scale of "2.00", type 24
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Tip: If the “Scale” is set incorrectly while running the Align Viewport tool,         
the viewport can easily be unlocked and changed to the appropriate 
Annotation Scale       

 5. Reset Crosshairs Orthogonal to View     
 A. Unlock the viewport      
 B. Activate the viewport and change the UCS to “STRUCTURE” (previously created in        "Set-

ting up a Structures drawing with a rotated modelspace #setup" on page 1396)      
 C. Type PLAN in the command line      
 D. Choose the Current ucs option in the command line       

 E. Lock the viewport      

Structures insert sheets
Last updated: 2022-02-15

Total video time: 13:29

Download and modify insert sheets

pln-prod-struct-ins-01.mp4 5:07

Bridge Manual Insert Sheets

Import insert sheet to existing drawing

pln-prod-struct-ins-02.mp4 8:21

Sample plan sheets
Last updated: 2023-02-02

Description Example Training topic

Title sheet 010101-ti.pdf "Title sheet" on page 1400

General notes 020101-gn.pdf
"General notes sheet" on 
page 1405

Project overview 020201-po.pdf
"Project overview sheet" on 
page 1409

Typical sections 020301-ts.pdf "Typical section sheet" on 
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Description Example Training topic

page 1411

Construction details 021001-cd.pdf
"Construction details sheet" on 
page 1427

Intersection detail 021101-id.pdf
"Intersection detail sheet" on 
page 1433

Plan detail 021201-pd.pdf "Plan details" on page 1437

Curb ramp detail 021301-cr.pdf
"Curb ramp detail sheet" on 
page 1439

Pavement grades 021401-pg.pdf  

Contour map 021601-cm.pdf
"Contour map sheet        " on 
page 1451

Earthwork matchlines 021801-em.pdf  

Erosion control 022001-ec.pdf
"Erosion control sheet" on 
page 1456

Storm sewer plan/-
profile

022501-ss.pdf
"Storm sewer plan/profile sheet" 
on page 1459

Planting detail 023101-pl.pdf
"Planting detail sheet" on 
page 1489

Permanent signing 023201-ps.pdf
"Permanent signing" on 
page 1490

Lighting plan 023601-lp.pdf  

Traffic signal plan sheet 
and phasing

024201-sp.pdf, 
024301-ph.pdf

"Traffic signal plan sheet and phas-
ing" on page 1495

Pavement marking 024501-pm.pdf
"Pavement marking sheet" on 
page 1497

Traffic con-
trol/Construction sta-
ging

026001-s1.pdf
"Traffic control / Stage con-
struction" on page 1506
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Description Example Training topic

Detour map 027001-dt.pdf "Detour sheet" on page 1537

Alignment sheet 027201-ad.pdf "Alignment sheet" on page 1546

Miscellaneous quant-
ities

030201-mq.pdf
"Miscellaneous quantities sheets" 
on page 1550

R/W plat (trans-
portation project plat)

040101-rp.pdf "Parcels/Plats" on page 1611

Plan/profile 050101-pp.pdf "Plan/profile sheet" on page 1559

Earthwork quantities 090101-ew.pdf
"Earthwork quantities sheet" on 
page 1581

Cross sections 090201-xs.pdf
"Cross section sheets" on 
page 1594

Title sheet
Last updated: 2020-10-26

Total video time: 26:21

Example title sheet: 010101-ti.pdf

Create title layout and fill out title fields

Exercise files: pln-prod-titl-begin-data-c3d18.zip

pln-prod-titl-01.mp4 3:16

 1. Click + file tab to start a new file QNEW.
 2. App menu > Save as ProjectID\SheetsPlan 010101-ti.dwg > Save
 3. Right-click any layout tab > From template... > C:\wis-

dot\Stnd\C3D2018\Templates\Sheets\01-TITLE-wdot18.dwt > Open
 4. TITLE SHEET 1 IN EQ 1 MI > OK
 5. Right-click layout tab "Layout1" > Delete > OK
 6. Click layout tab "TITLE SHEET 1 IN EQ 1 MI" to activate it.
 7. Double-click layout tab "TITLE SHEET 1 IN EQ 1 MI" > Rename to "01" > Enter

Inspect title layout block

 8. Double-click anywhere on block. A text attribute window for most text entry will pop up.
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Enhanced Attribute Editor window

Tag Value

PROJECTID1 1170-19-70

PROJECTID 1170-19-70

COUNTY2 VILAS AND ONEIDA

COUNTY VILAS AND ONEIDA

ROUTE USH 51

LIMITS 3RD AVE TO N JCT STH 70

TITLE MINOCQUA-MANITOWISH

AADT1 2012

AADT2 2036

AADT1VALUE 13,200-15,300

AADT2VALUE 18,400-19,900

DSVALUE 35 MPH/50 MPH

OK

Add/edit blocks for two project IDs

pln-prod-titl-02.mp4 3:16

 1. WisDOT Sheets tab > Sheet Creation panel > Title
 2. WisDOT Sheets tab > Manage & Support panel > Palettes ON/OFF if the tool palette does 

not appear.
 3. Title sheet tool palette > Blocks group > Title Sheet Additional Project Information > 

Place block in layout "01"
 4. Double-click Additional Project Information block

Enhanced Attribute Editor

Tag Value

LIMITS 3RD AVE TO N JCT STH 70 SANITARY AND WATER UTILITIES

ROUTE USH 51
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Tag Value

COUNTY ONEIDA AND VILAS 

PROJECTID 1170-19-71

TITLE MINOCQUA-MANITOWISH

Ok

There is a block for additional design designation information on the Title sheet tool palette.

The information for the survey coordinates is separate from the rest of the title block.

Edit survey coordinate block

 5. Double-click Title sheet coordinates block

Enhanced Attribute Editor

Tag Value

YEAR 1991

COUNTY VILAS 

Ok

Edit state map block

 6. Click state map block > Click visibility grip > Click ONEIDA

Add additional counties to state map block

 7. Home tab > Draw panel > Hatch > Contextual ribbon > Pattern panel > SOLID
 8. Click inside appropriate County > Right-click > Enter

Get county map, edit

pln-prod-titl-03.mp4 3:34

Info: This workflow uses linework from county map DWGs. Editable mapping linework can 
also be obtained from InfraWorks. County map DWGs do not have local roads within city and 
village limits, but they do have highway shields. An example of importing linework from 
InfraWorks can be found at "Export road linework from InfraWorks to Civil 3D" on page 309 
and then "Project overview sheet" on page 1409

County map DWG file location
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 l WisDOT internal user – N:\pds\c3d\Stnd\CountyMaps-CTB
 l External user - C:\wisdot\Stnd\CountyMaps-CTB

In Windows Explorer

 1. Select ONEIDA.DWG and VILAS.DWG from above location
 2. Copy and paste files to ProjectID\BaseData\Other

In Civil 3D

 1. File Open ProjectID\BaseData\Other\ONEIDA.dwg
 2. WisDOT Sheets tab > Plot Configuration panel > Layer States > County Maps Layer 

States group > Set County Map Layers to Plot In Grayscale to add layer state to file.
 3. WisDOT Sheets tab > Plot Configuration panel > Layer States pull-down > W18 County 

Maps (grayscale)

 This will not show up in the Layer States pull-down.

Objects will appear red in modelspace. This is correct for greyshade plotting.

 4. Repeat for VILAS.dwg
 5. Save and close file.

Xref county map and set in title sheet

pln-prod-titl-04.mp4 6:17

 1. Open ProjectID\SheetsPlan\010101-ti.dwg
 2. Insert tab > Reference panel > Attach > ProjectID\BaseData\Other\ONEIDA.dwg > 

Open
 3. Attached External Reference

Reference Type Overlay: checked

Scale: 1 for all

Insertion point: 0 for all

Path type: Relative path

Rotation angle: 0

OK

 4. Double-click middle mouse button to zoom extents
 5. Repeat for VILAS.dwg
 6. Zoom in to project extents
 7. Click layout tab "01" to activate it
 8. Double-click inside large square on title sheet. This will activate the viewport located 

inside it.
 9. Status bar > Unlock

 10. Double-click middle mouse button inside viewport to zoom extents
 11. Zoom in to project extents
 12. Status bar > Annotation scale pull-down > 1 IN:1 MI

Page: 1403

Published on: 5/17/2023

Xref county map and set in title sheet

https://c3dkb.dot.wi.gov/video/pln-prod/pln-prod-titl-04.mp4


 13. Click and drag middle mouse button to pan view to proper location
 14. Status bar > Lock

Move xref objects

 15. Select Vilas County XREF > Contextual ribbon > Edit panel > Edit Xreference In-Place > 
OK

 16. Select shield blocks and associated text that are overlaying the project location
 17. M Enter to move the selected items
 18. Click start and end location to move the shields and text.

Tip: Remember that these edits are in the county map files and will show up in other 
files that XREF them.

 19. Repeat for Oneida County.
 20. Turn off xref objects that are unwanted
 21. Xlist Enter > Select unwanted object to see layer
 22. Home tab > Layers panel > Layer Properties

 A. Layer search: *C_LAKE*
 B. Turn off ONEIDA|C_lake_txt and VILAS|C_lake_txt
 C. Layer search: *TWNRD*
 D. Turn off ONEIDA|C_twnrd_txt and VILAS|C_twnrd_txt

Tip: Home tab > Layers panel > Layer freeze > select objects will also turn off 
objects.

 23. Double-click outside viewport to de-activate viewport modelspace

Draw and label project extents

pln-prod-titl-05.mp4 4:11

 1. WisDOT Sheets > Sheet Creation > Title > Set Layer group > P_MISC_Text to set active 
layer

 2. Home tab > Draw panel > Polyline to draw the project location
 3. Select polyline > Properties > Global width: 0.1 Esc
 4. Repeat for side road
 5. WisDOT Sheets > Standard Components > Add all components to add all WisDOT 

AutoCAD components
 6. WisDOT Sheets > WisDOT Annotate > Multileader pull-down > BEGIN CONST-STA 

MATCH
 7. WisDOT Sheets > WisDOT Annotate > Multileader > Click beginning of project > Click 

location for multileader text > Overwrite default text: No 
 8. Repeat for side road
 9. WisDOT Sheets > WisDOT Annotate > Multileader pull-down > END CONST-STA MATCH

 10. WisDOT Sheets > WisDOT Annotate > Multileader > Click end of project > Click location 
for multileader text > Overwrite default text: No
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 11. Repeat for side road
 12. Double-click main begin project multileader text > Type correct station: STA. 518+00 > 

Click outside text editor
 13. Double-click main end project multileader text > Type correct station: STA. 589+00 > 

Click outside text editor
 14. Double-click side begin project multileader text > Type correct station: STA. 794+75 > 

Click outside text editor
 15. Double-click side end project multileader text > Type correct station: STA. 805+00 > 

Click outside text editor

Add town/range labels

pln-prod-titl-06.mp4 3:52

 1. Click Model tab
 2. Home tab > Draw > Polyline with ortho snap turned on F8 to make visual reference for 

town/range lines
 3. WisDOT Sheets > WisDOT Annotate > Multileader pull-down > T-#-N
 4. WisDOT Sheets > WisDOT Annotate > Multileader > Click town/range line location out-

side viewport
 5. Repeat for all desired town/range lines.
 6. Double-click side town/range text > Type correct data > Click outside text editor
 7. T-40-N, T-39-N, R-6-E, R-6-E
 8. Select town labels > co Enter > Click new location to copy town labels to other side of 

viewport
 9. Select construction polylines in viewport > Delete

 10. Save file

Add title sheet to sheet set

pln-prod-titl-07.mp4 1:52

 1. Home tab > Palettes panel > Sheet Set Manager
 2. Sheet Set Manager

 A. Open ProjectID\SheetsPlan\11701970.dst Ok
 B. Right-click subset "01-" > Import Layout as Sheet... 

 I. Browse for Drawings... > ProjectID\SheetsPlan\010101-ti.dwg
 II. Prefix sheet titles with filename: unchecked

 III. Import Checked

Exercise files: pln-prod-titl-end-data-c3d18.zip

General notes sheet
Last updated: 2023-01-25

Example sheet: 020101-gn.pdf
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Standards
FDM 15-1-12: General Notes, Railroad, and Contacts Sheet

Utility Coordination Guide 13.1

FDM 15-5-3: CADDS Directory and File Name Convention

Create file
This process utilizes the 02-GN-SPSHT-wdot.dwt General Notes speed sheet template which con-
tains 5 view frames and layouts for creating general notes sheets.

 1. WisDOT Sheets ribbon > Sheet Creation > Title drop-down > General Notes palette
 A. General Notes Startup template area > 02-General Notes Speed Sheet (02-GN-

SPSHT-wdot) 
 I. This will create a new dwg using the 02-GN-SPSHT-wdot.dwt General Notes 

Speed sheet Template.
 B. Set Layer area > P_MISC_Text

 2. Save file as 020101-gn.dwg

Tip: Tip: Another way to start a new General Notes Sheet: File New > Navigate to 
C:\WisDOT\Stnd\C3D20XX\Templates\Sheets\02-GN-SPSHT-wdot.dwt.

Add general notes blocks
There are two options for adding the standardized general notes blocks and building the general 
notes sheets. Prior to developing the general notes sheet, review FDM 15-1-12: General Notes, Rail-
road, and Contacts Sheet for requirements pertaining to the contents required.

Option 1: Insert all general notes blocks

 1. WisDOT Sheets ribbon > Sheet Creation > Title drop-down > General Notes palette
 2. General Notes Startup template area > Insert General notes Blocks

 A. This will insert all of the general notes blocks in predetermined locations.
 B. Users are encouraged to modify the blocks, remove blocks, add blocks, and adjust loc-
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ations as desired

Option 2: Insert individual general notes blocks

 1. WisDOT Sheets ribbon > Sheet Creation > Title drop-down > General Notes palette
 2. Blocks area

 A. Select the desired blocks to insert them into the drawing and to build the general 
notes sheet.

 B. All blocks that would be inserted in Option 1 are available as individual blocks on the 
General Notes palette.

Standardized general notes sheet blocks
Most blocks on the general note palette that are inserted using both Options 1 and 2 are dynamic. 
This means that they are editable to be customized for the project. To edit the attributes available in 
each block, double click the block.

Standard General Notes

Designer Note: Explode this block and delete any general notes that do not apply. The general notes 
provided are examples and do not include all possible general notes. Verify with Region preferences 
for exact wording.

General notes should be kept to an absolute minimum and should not duplicate information con-
tained elsewhere in the plans, proposal, or Standard Specifications.
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Standard Abbreviations

The standard abbreviation block provided can be exploded and edited or the block could be opened 
and edited. The block is built from an AutoCAD table.

To hide the table grid lines, turn off/freeze the Defpoints layer.

Runoff coefficient table

This block is built from an AutoCAD table. To hide the table grid lines, turn off/freeze the Defpoints 
layer.

Double click the block to edit the available attributes.

Contact blocks

All contact blocks have editable attributes for most of the content within the block. Double click the 
block to edit those attributes.

Order of Section 2 Sheets block

This block contains enough attributes to create a list of thirty section 2 sheets. Double click the block 
to access this list of attributes.

Paving Table block

This table provides the ability to detail the pavement layers, thickness, and type for each road-
way/cross section type. Create a copy of the block for each roadway/cross section type. The number 
of layers in the table can be changed using the block visibility states (Select the block and click the tri-
angle grip). Then edit the layer content by double clicking the block to access the attribute defin-
itions.

Add sheet to the sheet set
 1. Home tab > Palettes drop-down > Sheet Set Manager (sheet of paper with rolled end) to 

open the Sheet Set Manager
 2. Open drop-down menu > Open

 A. Browse to ProjectID\sheet<ProjectID>.dst
 3. Right-click  02- subset > New Subset

 A. Click Subset Name field: GENERAL NOTES
 B.  OK

 4. Click and drag GENERAL NOTES subset to the correct order location under the 02- subset
 5. Right-click on GENERAL NOTES subset > Import Layout as Sheet

 A. Browse to Drawing and browse to ProjectID\sheet\020101-gn.dwg
 B. Check the layouts from the file, and uncheck unneeded layouts.
 C. Make sure Prefix sheet titles with file name is UNCECKED.
 D. Import Checked
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Project overview sheet
Last updated: 2020-10-26

Total video time: 11:29

Example sheet: 020201-po.pdf

This topic is continued from "Export road linework from InfraWorks to Civil 3D" on page 309   

Create sheet file, data shortcut alignments         

Exercise files: pln-prod-prjct-ovrvu-begin-data-c3d18.zip

pln-prod-prjct-ovrvu-01.mp4 1:45

 1. New File > Quick Access Toolbar > Left Click New Icon
 A. Save as: N:\PDS\C3D\11701970\SheetsPlan
 B. File name: 020201-po.dwg

 2. WisDOT Sheets tab > Standards Components panel > Add all components
 3. Toolspace > Prospector Tab > Data Shortcuts > Alignments > Centerline Alignments > 

Right Click 51 > Create Reference...
 A. Alignment Label Set: _No Labels
 B. Alignment Style: _No Markers
 C. Ok

 4. Toolspace > Prospector Tab > Data Shortcuts > Alignments > Centerline Alignments > 
Right Click 47 > Create Reference...

 A. Alignment Label Set: _No Labels
 B. Alignment Style: _No Markers
 C. Ok

 5. Zoom Extents to double check lines                 

Import IMX file to Civil 3D, edit and style alignments #import         

pln-prod-prjct-ovrvu-02.mp4 5:29 

Info: This workflow uses linework imported from InfraWorks. Editable mapping linework can 
also be obtained from Wisconsin county map DWGs. County map DWGs do not have local 
roads within city and village limits, but they do have highway shields. An example of that work-
flow can be found at "Title sheet" on page 1400

 1. Autodesk Infraworks tab > Import panel > Open Model
OR         

 1. Insert tab > Infraworks panel > Open Infraworks Model
 A. Infraworks Model: N Drive PDS\C3D\11701970-Prjct-ovrvu\BaseData\Other\                         
 B. Files of type: IMX
 C. File Name: USH51-STH47_Export.imx

 I. OK
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 D. Set a Coordinate System: Use the Infraworks Model Coordinate System
 E. Objects Settings: Project Overview Alignments.xml
 F. Refine Selection Set: Unselect Water Areas

 I. OK
 G. Open Model

 2. Toolspace > Prospector > Alignments > Right-Click Centerline Alignments > Create 
Folder

 A. New Folder: Hidden
 B. OK

 3. Drag and Drop extra alignments into Hidden folder Hold shift to multi-select alignments
 4. Prospector Tab >  Alignments > Centerline Alignments > Click an Alignment in Item 

View > Ctrl+A > Right Click Style Header > Edit...
 A. Label Style: _No Display
 B. OK

Tip: Alignments from IMX are yellow. Alignments from Dref are green

 5. Status Bar > Annotation Scale > 1IN:100FT
 6. Save File                 

Add alignment labels         

pln-prod-prjct-ovrvu-03.mp4 1:45         

 1. Annotate Tab > Labels & Tables panel > Add Labels > Alignment > Add Alignments 
Labels

 A. Label Type : Station Offset - Fixed Point
 B. Station Offset Label Style: Alignment Name [From Desc]
 C. Marker Style: None
 D. Add

 I. Select Alignment > Select Label Location(s) > Escape to deselect > Select 
new Alignment and repeat

 II. Use Grips to reposition label                             
 E. Close

Add layout and set viewframe         

pln-prod-prjct-ovrvu-04.mp4 2:30         

 1. WisDOT Sheets Tab > Sheet Creation panel > Construction Details drop-down > Detail
 A. WisDOT Sheets Tab > Palettes ON\OFF to ensure tool palette is visible                     

 2. Startup Main Palette > 02 - Plan Details 1=100 (02-wdot18) to create new layout                 
 A. (C:02-PD-Plan-1-100) Press Enter to continue with layout name 

<Plan 1 IN 100 FT> : or type new name for layout. 01 Enter                     
 3. Layout 01 > Double Click inside Viewport > Status Bar > Drawing Scale >  Unlock Selec-

ted Viewport > Zoom Extents
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 4. WisDOT Tools Tab > Rotate View
 A. Pick first point Pick near the south end of US51 Alignment                     
 B. Pick next point to define the rotation Pick near the mid point of US51 

Alignment                     
 5. Status Bar > Drawing Scale > 1IN:100FTAlignment labels can be adjusted in modelspace 

through the viewport once the layout is set to final scale and rotation.                 
 6. Status Bar > Drawing Scale > Lock Selected Viewport
 7. Save File 

"Add sheets to sheet set manually #add" on page 1299

Typical section sheet
Last updated: 2020-10-26

Total video time: 34:08

Example sheet: 020301-ts.pdf

Create file with speed sheet template

Exercise files: pln-prod-typ-sctn-data-begin-c3d18.zip

pln-prod-typ-sctn-01.mp4 3:14

Typical section sheets are created using the WisDOT speed sheet template. The speed sheet tem-
plate contains layouts with viewports that are aligned with the frames in the model space.  Inform-
ation that will be displayed within the layout needs to within the model space frames.

 1. Make sure that Tool Palette is visible 
 A. WisDOT Sheets tab > Palettes On/Off to toggle the palette on and off.

 2. WisDOT Sheets tab > Sheet Creation panel > Construction Details > Typical Section
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 A. Typical Section Tool Palette > Startup Main tab > Typical Section Startup Tem-
plates > 02-Typical Sections Speed Sheet (02-TS-SPSHT-wdot18.dwt)

 I. A new drawing with TS (typical sections) layout sheets and model space views 
are created

 B. Typical Section Tool Palette > Startup Main tab > Insert Typical Section Blocks
 I. Typical section drawing elements are added to the drawing file
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Items to check before drafting

 1. Check that the annotation scale is set to the same scale as the model frame before drawing 
elements are added

 2. WisDOT Sheets tab > Standard Components panel > Add All Components
 A. Add All Components will add all the WisDOT plan production elements (leader styles, 

dimension styles, etc.) that are not initially included in the WisDOT drawing template.
 3. Save the file to PDS\C3D\ProjectID\SheetsPlan\020301-ts.dwg

Create urban typical section top

pln-prod-typ-sctn-02.mp4 4:18
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 1. Set the current layer to P_MISC_TYPS for proposed work or E_MISC_TYPS for existing con-
ditions. 

 A. Typical Section Tool Palette > Startup Main tab > Set Layer > P_MISC_TYPS (or 
Home ribbon > Layers panel > Layer dropdown).

 2. Zoom to the PROPOSED LANE SLOPES tree in the upper left corner of the left TYPICAL 
SECTION DRAWING ELEMENTS... box

 3. Explode the proposed slope tree blocks

 A. Select the slope tree of PROPOSED LANE SLOPES and the slope tree of PROPOSED SIDE 
SLOPES

 B. Type X in the command line
 C. Enter to explode the two blocks

 4. Copy the desired slope text and lane slope lines for the typical section 
 A. Select the desired slope text and the lane slope line for each side of the roadway.  

When the text is selected, all the assigned annotative scales will display indicating that 
the text is annotative

 B. Right-click on the selected elements > Basic Modify Tools > Copy
 I. Shift-Right-click > Endpoint > select where the two lane lines meet in the 

middle
 II. Place copied lane lines and slope text within the 020301-ts frame or the 

desired frame location
 III. Right-click > Enter to complete the command

 5. Create vertical line at the crown of the roadway 
 A. Home tab > Draw panel > Create line

 I. LINE Specify first point: Snap to the endpoint where the two copied 
lane lines intersect
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 II. F8 to turn Ortho on
 III. LINE Specify next point or [Undo]: Extend line to desired height
 IV. Right-click > Enter to complete the command

 B. F8 again to turn Ortho off
 6. Create offsets for horizontal dimensions 

 A. Select vertical line
 B. Home tab > Modify panel > Offset

 I. OFFSET Specify offset distance or [Through Erase Layer]: 7 
Enter

 II. OFFSET Specify point on side to offset or [Exit Multiple 

Undo]: Place a line to the right
 III. OFFSET Select object to offset or [Exit Undo]: Select center ver-

tical line
 IV. OFFSET Specify point on side to offset or [Exit Multiple 

Undo]: Place a line to the left
 V. Right-click > Enter to end the command

 C. Create an offset of 24 feet from the 7 foot offset lines created in the previous step
 7. Extend the lane lines to the outer vertical lines 

 A. Home tab > Modify panel > Fillet
 I. FILLET Select first object or [Undo Polyline Radius Trim 

Multiple]:R for Radius (or click on Radius in the command line)
 II. FILLET Specify fillet radius: 0 Enter

 III. FILLET Select first object or [Undo Polyline Radius Trim 

Multiple]: Select the right lane line
 IV. FILLET Select second object or shift-select to apply corner 

or [Radius]: Select the outer right vertical line
 B. Enter to restart the Fillet command
 C. Select the left lane line and the outer left vertical line to intersect the lines

Create urban typical section pavement depth

pln-prod-typ-sctn-03.mp4 4:02

 1. Zoom to the VERTICAL LINES ARE MULTIPLIED BY 2 box in the upper middle of the TYPICAL 
SECTION DRAWING ELEMENTS... box - second from the left

 2. Explode the vertical lines block
 A. Select the VERTICAL LINES ARE MULTIPLIED BY 2 block
 B. Type X in the command line
 C. Enter to explode the block

 3. Create 5-inch vertical line for pavement by combining two vertical lines
 A. Select the vertical lines for the 2-inch and 3-inch depth
 B. Right-click on the selected elements > Basic Modify Tools > Copy

 I. Left-click at a location near the two selected lines
 II. Place copied vertical lines within the 020301-ts frame or the desired frame loc-

ation
 III. Right-click > Enter to complete the command

 C. Select the lower copied vertical line
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 D. Right-click on the selected elements > Basic Modify Tools > Move
 E. Move lower line to the bottom of the upper vertical line
 F. Select both vertical lines
 G. Move the two vertical lines to the centerline of the typical section

 4. Create upper layer of pavement
 A. Select the horizontal lane lines
 B. Right-click on the selected elements > Basic Modify Tools > Copy

 I. Shift-Right-click > Endpoint > select where the two lane lines meet in the 
middle

 II. Place copied lane lines at the bottom of the lower vertical line
 III. Right-click > Enter to complete the command

 5. Create additional layer of pavement structure
 A. Select the two vertical lines from the layer above (2-inch + 3-inch = 5-inch)
 B. Copy the lines to the bottom of the "5-inch" vertical line
 C. Copy the 6-inch vertical line VERTICAL LINES ARE MULTIPLIED BY 2 box and place 

below the previously placed line.  The result is a vertical line representing 11-inches (2-
inch + 3-inch + 6-inch).

 D. Select the top horizontal lane lines and copy to the bottom of the "11-inch" vertical line
 6. Add curb and gutter blocks

 A. Zoom to the CURB & GUTTER BLOCKS box in the upper left corner of the TYPICAL 
SECTION DRAWING ELEMENTS... box - second from the left

 B. Copy the CONC C&G 30-INCH [PROP & EXIST] blocks to a location near the typical sec-
tion in 020301-ts frame

 C. Select the right curb and gutter by the insertion point and move it to the outside end 
of the right lane line.

 D. Select the left curb and gutter by the insertion point and move it to the outside end of 
the left lane line.

 7. Copy vertical dimension line
 A. Copy the vertical line at the end of the lane line from the bottom end point and place it 

at the top back of curb on each side
 8. Draw edge of base material limits

 A. Select the vertical dimension line at the top back of curb on the left side
 B. Home tab > Modify panel > Offset

 I. OFFSET Specify offset distance or [Through Erase Layer]: 1 
Enter

 II. OFFSET Specify point on side to offset or [Exit Multiple 

Undo]: Place a line left of curb and gutter
 III. OFFSET Select object to offset or [Exit Undo]: Select the ver-

tical dimension line at the top back of curb on the right side
 IV. OFFSET Specify point on side to offset or [Exit Multiple 

Undo]: Place a line right of the curb and gutter
 V. Right-click > Enter to end the command
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 9. Extend the base lines to the outer vertical lines
 A. Home tab > Modify panel > Fillet

 I. FILLET Select first object or [Undo Polyline Radius Trim 

Multiple]:R for Radius (or click on Radius in the command line)
 II. FILLET Specify fillet radius: 0 Enter

 III. FILLET Select first object or [Undo Polyline Radius Trim 

Multiple]: Select the bottom right layer line
 IV. FILLET Select second object or shift-select to apply corner 

or [Radius]: Select the outer right vertical line
 B. Enter to restart the Fillet command
 C. Select the bottom left layer line and the outer left vertical line to intersect the lines

Create rural typical section pavement

pln-prod-typ-sctn-04.mp4 3:38

 1. Set the current layer to P_MISC_TYPS for proposed work or E_MISC_TYPS for existing con-
ditions. 

 A. Typical Section Tool Palette > Startup Main tab > Set Layer > P_MISC_TYPS (or 
Home ribbon > Layers panel > Layer dropdown)

 2. Zoom to the PROPOSED LANE SLOPES tree in the upper left corner of the left TYPICAL 
SECTION DRAWING ELEMENTS... box.

 3. Explode the proposed slope tree blocks

 A. Select the slope tree of PROPOSED LANE SLOPES and the slope tree of PROPOSED 
SIDE SLOPES

 B. Type X in the command line
 C. Enter to explode the two blocks
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 4. Copy the desired slope text and lane slope lines for the typical section 
 A. Select the desired slope text and the lane slope line for each side of the roadway.  

When the text is selected, all the assigned annotative scales will display indicating that 
the text is annotative

 B. Right-click on the selected elements > Basic Modify Tools > Copy
 I. Shift-Right-click > Endpoint > select where the two lane lines meet in the 

middle
 II. Place copied lane lines and slope text within the 020301-ts frame or the 

desired frame location
 III. Right-click > Enter to complete the command

 5. Create vertical line at the crown of the roadway 
 A. Home tab > Draw panel > Create line

 I. LINE Specify first point: Snap to the endpoint where the two copied 
lane lines intersect

 II. F8 to turn Ortho on
 III. LINE Specify next point or [Undo]: Extend line to desired height
 IV. Right-click > Enter to complete the command

 B. F8 again to turn Ortho off
 6. Create offsets for horizontal dimensions 

 A. Select vertical line
 B. Home tab > Modify panel > Offset

 I. OFFSET Specify offset distance or [Through Erase Layer]: 7 
Enter

 II. OFFSET Specify point on side to offset or [Exit Multiple 

Undo]: Place a line to the right
 III. OFFSET Select object to offset or [Exit Undo]: Select center ver-

tical line
 IV. OFFSET Specify point on side to offset or [Exit Multiple 

Undo]: Place a line to the left
 V. Right-click > Enter to end the command

 C. Create an offset of 24 feet from the 7 foot offset lines created in the previous step
 7. Extend the lane lines to the outer vertical lines 

 A. Home tab > Modify panel > Fillet
 I. FILLET Select first object or [Undo Polyline Radius Trim 

Multiple]:R for Radius
 II. FILLET Specify fillet radius: 0 Enter

 III. FILLET Select first object or [Undo Polyline Radius Trim 

Multiple]: Select the right lane line
 IV. FILLET Select second object or shift-select to apply corner 

or [Radius]: Select the outer right vertical line
 B. Enter to restart the Fillet command
 C. Select the left lane line and the outer left vertical line to intersect the lines

 8. Zoom to the VERTICAL LINES ARE MULTIPLIED BY 2 box in the upper middle of the TYPICAL 
SECTION DRAWING ELEMENTS... box - second from the left
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 9. Explode the vertical lines block. 
 A. Select the VERTICAL LINES ARE MULTIPLIED BY 2 block
 B. Type X in the command line
 C. Enter to explode the block

 10. Create 5-inch vertical line for pavement by combining two vertical lines. 
 A. Select the vertical lines for the 2-inch and 3-inch depth
 B. Right-click on the selected elements > Basic Modify Tools > Copy

 I. Left-click at a location near the two selected lines
 II. Place copied vertical lines within the 020301-ts frame or the desired frame loc-

ation
 III. Right-click > Enter to complete the command

 C. Select the lower copied vertical line
 D. Right-click on the selected elements > Basic Modify Tools > Move
 E. Move lower line to the bottom of the upper vertical line
 F. Select both vertical lines
 G. Move the two vertical lines to the centerline of the typical section

 11. Create upper layer of pavement 
 A. Select the horizontal lane lines
 B. Right-click on the selected elements > Basic Modify Tools > Copy

 I. Shift-Right-click > Endpoint > select where the two lane lines meet in the 
middle

 II. Place copied lane lines at the bottom of the lower vertical line
 III. Right-click > Enter to complete the command

 12. Create additional layer of pavement structure 
 A. Select the two vertical lines from the layer above (2-inch + 3-inch = 5-inch)
 B. Copy the lines to the bottom of the "5-inch" vertical line
 C. Copy the 6-inch vertical line VERTICAL LINES ARE MULTIPLIED BY 2 box and place 

below the previously placed line.  The result is a vertical line representing 11-inches (2-
inch + 3-inch + 6-inch).

 D. Select the top horizontal lane lines and copy to the bottom of the "11-inch" vertical line
 13. Create paved shoulder dimension line 

 A. Select the vertical dimension line at the outside of the right lane
 B. Home tab > Modify panel > Offset

 I. OFFSET Specify offset distance or [Through Erase Layer]: 3 
Enter

 II. Place a line to the right
 III. Select the vertical dimension line at the outside of the left lane
 IV. Place a line to the left
 V. Right-click > Enter to end the command

 14. Create unpaved shoulder dimension line 
 A. Select the vertical dimension line at the outside of the right paved shoulder
 B. Home tab > Modify panel > Offset

 I. OFFSET Specify offset distance or [Through Erase Layer]: 7 
Enter

 II. Place a line to the right
 III. Select the vertical dimension line at the outside of the left paved shoulder
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 IV. Place a line to the left
 V. Right-click > Enter to end the command

 15. Extend pavement lines to the outside edge of the paved shoulder 
 A. Home tab > Modify panel > Fillet

 I. FILLET Select first object or [Undo Polyline Radius Trim 

Multiple]:R for Radius (or click on Radius in the command line)
 II. FILLET Specify fillet radius: 0 Enter

 B. Fillet the left and right top of pavement lines with the vertical dimension line for the 
outside edge of the paved shoulder

 C. Fillet the left and right bottom of pavement lines with the vertical dimension line for 
the outside edge of the paved shoulder

 16. Create the top of unpaved shoulder 
 A. Select the 4% slope text and the lane slope line for each side of the roadway from 

the PROPOSED LANE SLOPES tree in the upper left corner of the left TYPICAL 
SECTION DRAWING ELEMENTS... box.  When the text is selected, all the assigned 
annotative scales will display indicating that the text is annotative.

 B. Copy the text and lane slope lines to a location near the typical section in 020301-ts 
frame

 C. Move the slope text and lane slope lines to the left and right outer edge of the paved 
shoulder

 D. Fillet the left and right top of unpaved shoulder lines with the vertical dimension line 
for the outside edge of the unpaved shoulder

 17. Create shoulder foreslope 
 A. Select the 4:1 side slope text and the side slope line for each side of the roadway 

from the PROPOSED SIDE SLOPES tree in the upper left corner of the left TYPICAL 
SECTION DRAWING ELEMENTS... box.  When the text is selected, all the assigned 
annotative scales will display indicating that the text is annotative.

 B. Copy the text and side slope lines to a location near the typical section in 020301-ts 
frame

 C. Move the slope text and side slope lines to the left and right outer edge of the 
unpaved shoulder

 D. Fillet the left and right top of shoulder foreslope lines with the bottom of base layer 
line

 18. Create bottom of aggregate shoulder line. 
 A. Home tab > Modify panel > Trim pulldown > Extend

 I. EXTEND Select objects:Enter to select all the edges
 II. EXTEND [Fence Crossing Project Edge Undo]:

 a. Select the right bottom of pavement line to extend it to the right 
shoulder foreslope line

 b. Select the left bottom of pavement line to extend it to the left shoulder 
foreslope line

 III. Right-click > Enter to close the command

Create rural and urban side slopes
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pln-prod-typ-sctn-05.mp4 3:14

Rural side slopes

 1. Create ditch foreslope 
 A. Home tab > Modify panel > Offset

 I. OFFSET Specify offset distance or [Through Erase Layer]:T 
Enter (or click on Through in the command line)

 II. OFFSET Select object to offset or [Exit Undo]: Select one of the 
vertical dimension lines

 III. OFFSET Select through point or [Exit Multiple Undo]:Shift-
Right-click > Endpoint > select subgrade left shoulder point (where the 
shoulder foreslope intersects the bottom of the base layer)

 IV. OFFSET Select object to offset or [Exit Undo]: Select one of the 
vertical dimension lines

 V. OFFSET Select through point or [Exit Multiple Undo]:Shift-
Right-click > Endpoint > select right subgrade shoulder point

 VI. Right-click > Enter to close the command
 B. Offset the vertical dimension line at the subgrade shoulder point the width of the typ-

ical ditch width (distance from subgrade shoulder point to the ditch invert) for the left 
and right side

 C. Select the desired typical side slope text (example: 6:1) and the side slope line for 
each side of the roadway from the PROPOSED SIDE SLOPES tree in the upper left 
corner of the left TYPICAL SECTION DRAWING ELEMENTS... box.  When the text is 
selected, all the assigned annotative scales will display indicating that the text is annot-
ative.

 D. Copy and place the copied slope lines and slope text within the 020301-ts frame or 
the desired frame location

 E. Move the slope text and side slope lines to the left and right subgrade shoulder point
 F. Fillet the left and right ditch foreslope line with the vertical dimension line located at 

the ditch invert
 2. Create flat bottom of ditch (perform step only if needed) 

 A. Home tab > Draw panel > Create line
 I. LINE Specify first point: Snap to the endpoint of the ditch foreslope

 II. F8 to turn Ortho on
 III. LINE Specify next point or [Undo]: Extend line to the right and enter 

the width of the ditch bottom
 IV. Enter to complete the command

 B. Perform the step 2A on the left side as needed
 C. F8 again to turn Ortho off

 3. Create ditch backslope 
 A. Select the desired typical side slope text and the side slope line for each side of the 

roadway from the PROPOSED SIDE SLOPES tree in the upper left corner of the left 
TYPICAL SECTION DRAWING ELEMENTS... box.
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 B. Copy and place the copied slope lines and slope text within the 020301-ts frame or 
the desired frame location

 C. Move the slope text and side slope lines to the left and right of the ditch invert
 4. Add existing ground intercept block 

 A. Zoom to the TEXT AND LEADER EXAMPLES box in the upper right of the TYPICAL 
SECTION DRAWING ELEMENTS... box - second from the left.

 B. Select the IN CUT or IN FILL block and desired text
 C. Right-click on the selected elements > Basic Modify Tools > Copy
 D. Place copied elements at the slope intercept for the typical section

Urban side slopes

 1. Create terrace slope 
 A. Select the 4% slope text and the lane slope line for each side of the roadway from 

the PROPOSED LANE SLOPES tree in the upper left corner of the left TYPICAL 
SECTION DRAWING ELEMENTS... box

 B. Copy the text and lane slope lines to a location near the typical section in 020301-ts 
frame

 C. Move the slope text and lane slope lines to the left and right outer edge of the top 
back of curb

 2. Complete Datum outline 
 A. Home tab > Modify panel > Trim pulldown > Trim

 I. TRIM Select objects:Enter to select all the edges
 II. TRIM [Fence Crossing Project Edge eRase Undo]:

 a. Select the outer left vertical line above the terrace line to trim the left 
datum limits

 b. Select the outer right vertical line above the terrace line to trim the right 
datum limits

 III. Right-click > Enter to close the command

Create urban sidewalk and hatch pavement areas

pln-prod-typ-sctn-06.mp4 3:23

Create urban sidewalk

 1. Create offsets for horizontal dimensions 
 A. Home tab > Modify panel > Offset

 I. Type the distance in the command line for the offset distance to the inside 
edge of the sidewalk

 II. Select the vertical dimension line at the top back of the curb and place a line on 
the side of the sidewalk

 III. Right-click > Enter to end the command
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 2. Trim terrace line to inside of sidewalk 
 A. Home tab > Modify panel > Trim pulldown > Trim

 I. Enter to select all the edges
 II. Select the terrace line beyond the dimension line at the inside sidewalk location

 III. Right-click > Enter to close the command
 3. Create sidewalk 

 A. Zoom to the VERTICAL LINES ARE MULTIPLIED BY 2 box in the upper middle of the 
TYPICAL SECTION DRAWING ELEMENTS... box - second from the left

 B. Copy the 4-inch vertical line and place it at the end of the terrace line in the typical sec-
tion

 C. Copy the 1.5% slope text and the lane slope line from the PROPOSED LANE SLOPES 
tree in the upper left corner of the left TYPICAL SECTION DRAWING ELEMENTS... box 
and place it at the end of the terrace line in the typical section

 D. Home tab > Modify panel > Offset
 I. Type t for Through (or click on Through in the command line)

 II. Select the line for the top of the sidewalk
 III. Shift-Right-click > Endpoint > select the bottom of the vertical line for 

the sidewalk
 IV. Right-click > Enter to end the command

 E. Enter to restart the offset command 
 I. Type the distance in the command line for the width of the sidewalk

 II. Select the vertical line at the inside of the sidewalk and left-click to place a line 
at the outside of the sidewalk

 III. Right-click > Enter to end the command
 F. Fillet all the corners of the sidewalk using a radius of 0

Hatch pavement areas

 1. Zoom to the PROPOSED HATCHING EXAMPLES box at the bottom of the TYPICAL SECTION 
DRAWING ELEMENTS... box - second from the left

 2. Left-click to select the HMA Pavement hatching 
 A. The Hatch Editor ribbon automatically appears when a drawing hatch pattern is 

selected
 B. Zoom to the urban typical section
 C. Hatch Editor ribbon > Boundaries panel > Pick Points

 D. Left-click inside the HMA pavement areas of the urban typical section
 E. Enter to end the command

Other material hatch patterns can be placed using the same method.

Note: The hatch placed in the typical section is recognized as the same object of the hatch pattern 
originally selected.
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Note: Be careful to select the PROPOSED or EXISTING hatch patterns to match the typical section.  
PROPOSED and EXISTING hatch patterns are different for the same materials and will plot dif-
ferently on plan sheets.

Note: Hatching only works inside completely enclosed areas that do not have any gaps.

Create dimensions

pln-prod-typ-sctn-07.mp4 5:21

Place dimensions

 1. Set the current layer to P_MISC_TYPS for proposed work or E_MISC_TYPS for existing con-
ditions. 

 A. Typical Section Tool Palette > Startup Main tab > Set Layer > P_MISC_TYPS (or 
Home ribbon > Layers panel > Layer dropdown)

 2. Perform this step if all the WisDOT plan production elements have not been added. 
 A. WisDOT Sheets tab > Standard Components panel > Add All Components
 B. Add All Components will add all the WisDOT plan production elements (leader styles, 

dimension styles, etc.) that are not initially included in the WisDOT drawing template.
 3. WisDOT Sheets tab > WisDOT Annotation > Standard (dimension style) > 070-LANE & 

SHOULDER
 4. WisDOT Sheets tab > WisDOT Annotation > Linear (dimension) 

 A. DIMLINEAR Specify first extension line origin: Snap to the bottom end 
of the first vertical line on one side of the lane (where the vertical line intersects the 
typical section)

 B. DIMLINEAR Specify second extension line origin: Snap to the bottom 
end of the vertical line on the other side of the lane (where the vertical line intersects 
the typical section)

 C. DIMLINEAR [Mtext Text Angle Horizontal Vertical Rotated]: Move the 
cursor to the desired location for the horizontal dimension and left-click to place the 
dimension

 D. Enter to restart the DIMLINEAR command
Note: If the vertical lines did not exist, snap to the beginning and end of the element (example: line).

Note: To align additional horizontal dimension lines, snap to a previously placed dimension when 
choosing the vertical location of the dimension text (described in step 4C).

Edit dimension properties

 1. Select dimension
 2. Right-click > Properties

 A. Properties palette > Lines & Arrows > Ext line: On/Off toggle, setting for dis-
playing vertical lines that extend to the dimension line and value

 B. Properties palette > Text > Text override:  Allows user to replace the dynamic 
dimension with a custom and static information (numbers and/or text)
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Final steps for completing typical section dimensions

 1. Select and delete the vertical construction lines used to layout the typical section
 2. Select dimension lines
 3. Right-click > Properties > Lines&Arrows

 A. Ext line 1 = On
 B. Ext line 2 = On

 4. Esc to release the grips
 5. Annotate ribbon > Dimensions panel > Dimjogline

 A. This command allows the user to specify a dimension that is greater than what is actu-
ally drawn.  This may be used in combination where a text override dimension is 
placed.

 B. DIMJOGLINE Select dimension to add jog or [Remove]: Select dimension 
line

 C. DIMJOGLINE Specify jog location (or press Enter): Specify jog location 
on dimension line

Create multileader annotations

pln-prod-typ-sctn-08.mp4 6:05

Place multileader annotation

 1. Add annotation to typical section 
 A. Zoom to the TEXT AND LEADER EXAMPLES box in the upper right of the TYPICAL 

SECTION DRAWING ELEMENTS... box - second from the left
 2. Select: 

 A. CL
 B. EXISTING/FINISHED TYPICAL SECTION station range dynamic block
 C. All multileader text

 3. Right-click on the selected elements > Basic Modify Tools > Copy
 A. Shift-Right-click > Endpoint > select end of any element

 4. Place the copied elements within the 020301-ts frame or the desired frame location
 5. Select the EXISTING/FINISHED TYPICAL SECTION station range dynamic block
 6. Left-click the downward triangle to select the number of station ranges the typical section 

applies to
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 7. Double left-click on the EXISTING/FINISHED TYPICAL SECTION station range dynamic block
 

 A. This will bring up the Enhanced Attribute Editor dialog box

 B. Attribute tab - Select one of the listed attributes and update the text in the Value box
 

 I. OK
 8. Select one multileader text
 9. Right-click on the selected elements > Basic Modify Tools > Move

 A. Left-click on the multileader and move the text to the desired location
 B. Select the leader line and move the grip at the arrowhead to the desired location
 C. Double left-click the multileader text to edit the text 

 I. Left-click outside of the text to complete the text editing
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Adding a second leader line

 1. Select a the leader line with the arrowhead
 2. Right-click on the selected elements > Add Leader
 3. Pick or snap to the location of the second arrowhead
 4. Right-click > Enter to end the command

Purge unused components

pln-prod-typ-sctn-09.mp4 0:53

All the WisDOT plan production elements (leader styles, dimension styles, etc.) were added at the 
beginning of the typical section sheet creation.  Remove the unused components when the drawing 
is completed.

 1. PURGE Enter
 A. Purge All
 B. Purge All
 C. Close

 2. Save the drawing

Exercise files: pln-prod-typ-sctn-data-end-c3d18.zip

Construction details sheet
Last updated: 2020-11-30

Total video time: 13:32

Example sheet: 021001-cd.pdf

Create file with speed sheet

Exercise files: pln-prod-cnstrctn-dtl-begin-data-c3d18.zip

pln-prod-cnstrctn-dtl-01.mp4 2:16

 1. WisDOT Sheets tab > Sheet Creation panel > Construction Details to open tool palette.
 A. WisDOT Sheets tab > Tools panel > Palettes ON/OFF if WisDOT tool palette not vis-

ibible.
 2. Construction Details palette group > Startup Main tool palette > 02-Construction 

Details Speed Sheet to create a new file from the speed sheet DWT.
 A. This DWT has 10 pre-set windows in modelspace that line up with 10 layouts.

 3. Construction Details palette group > Startup Main tool palette > P_MISC_Text to set the 
active layer to P_MISC_Text.

 4. App menu > Save as > ProjectID\SheetsPlan\021001-cd.dwg > Save

Place pre-made blocks from tool palettes
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pln-prod-cnstrctn-dtl-02.mp4 2:45

 1. Construction Details palette group > Startup Main tool palette > Slope Tree for Non-
Pavement > Click in modelspace

 2. Construction Details palette group > Startup Main tool palette > Slope Tree for Pave-
ment > Click in modelspace

Tip: Both of these blocks can be very useful in drafting accurate typical sections

 3. Right-click tool palette stack > Click cdtraffic (traffic control blocks) > Light Pole Detail 
> Click in modelspace rectangle LAYOUT 1

As it turns out, this block is very small in modelspace. We'll try placing it in paperspace

 4. Click layout tab 01 to activate it.
 5. cdtraffic tool palette > Light Pole Detail > Click in paperspace of layout 01
 6. Right-click tool palette stack > Click cddrnage (drainage blocks) > Pipe Grate Detail > 
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Click in paperspace of layout 01

Edit blocks

pln-prod-cnstrctn-dtl-03.mp4 5:20

Remove storm sewer from light pole detail

 1. Click LIGHT POLE DETAIL block > Right-click > Block Editor
 A. Window select objects for STORM SEWER > Delete

Info: Edits in Block Editor are made the same as in modelspace, but only impact 
the block definition.

 B. Contextual ribbon > Close Block Editor > Save the changes to 13_cdtraffc12
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Block edits will show up immediately in the file.

Adjust layout of pipe grate detail

Since this edit is dependent on the block's layout in paperspace, it will be done in-place.

 2. Click PIPE GRATE DETAIL block > Right-click > Edit Block in-place... > Ok
 A. Objects in paperspace that are not in the block will be dimmed.
 B. Shift-select objects to move

 C. M Enter to start move command > Click base point > F8 to lock ortho > Move 
cursor to right > Click second point.
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Tip: If you want to add any objects to the block while editing in-place, after cre-
ating objects Select objects > Contextual ribbon > Edit Reference panel > 
Add to Working Set

 D. When finished editing the block, Contextual ribbon > Edit Reference panel > Save 
changes > OK 

Edit photocell text in LIGHT POLE DETAIL block

 3. Double-click LIGHT POLE DETAIL block > OK to open block in Block Editor.
 A. Click mtext starting with "250 WATT" > Click down arrow grip > Drag grip down 

> Click to increase Column Height and eliminate the need for the second column.

 B. Contextual ribbon > Close Block Editor > Save the changes to 13_traffc12 to save 
and close the block.
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Create dividing line between blocks

 4. Home tab > Draw panel > Polyline
 5. Shift-right click > Nearest > Click on top border line
 6. Shift-right click > Perpendicular > Click on bottom border line
 7. Right-click > Enter to finish the polyline.

Edit text in PIPE GRATE DETAIL

 8. Double-click PIPE GRATE DETAIL block > OK to open block in Block Editor.
 A. Double-click following text to open in Text Editor.

 B. Select 9/16 > Delete > Type 9/16 > Click outside Text Editor to make fraction easier 
to read.

 C. Double-click following text to open in Text Editor.

 D. Select ø > Delete > Type DIA > Click outside Text Editor to correct text to appro-
priate abbreviation.

 E. Contextual ribbon > Close Block Editor > Save the changes to 24_cddrnge12 to 
save and close the block.

Add layouts to sheet set

pln-prod-cnstrctn-dtl-04.mp4 3:10

 1. SSM Enter to open Sheet Set Manager
 2. Open... > ProjectID\SheetsPlan\Sheet Sets\11701970.dst > Open
 3. Right-click 02- > New Subset...

 A. Subset Name: CONSTRUCTION DETAILS
 B. OK

 4. Quick Access Toolbar > Save
 5. Right-click CONSTRUCTION DETAILS > Import Layout as Sheet...

 A. Browse for Drawings... > ProjectID\SheetsPlan\021001-cd.dwg > Open
 B. Uncheck layouts 04-10. Leave layouts 01-03 checked.

Page: 1432

Published on: 5/17/2023

Add layouts to sheet set

https://c3dkb.dot.wi.gov/video/pln-prod/pln-prod-cnstrctn-dtl-04.mp4


 C. Import Checked
 D. Layouts will be added in Sheet Set Manager.

 6. Fields may not update immediately in layouts. REA Enter to refresh all layouts in active file.

Exercise files: pln-prod-cnstrctn-dtl-end-data-c3d18.zip

Intersection detail sheet
Last updated: 2022-08-30

Total video time: 34:08

Example sheet: 021101-id.pdf

Initial setup and add layout

Exercise files: pln-prod-intrsctn-dtl-begin-data-c3d18.zip

pln-prod-intrsctn-dtl-01.mp4 3:41

 1. WisDOT Sheets  > Standard Components > Add All Components
 2. WisDOT Sheets > Palettes ON/OFF > Sheet Creation > Drop down arrow next to Con-

struction Details > Left Click Detail
 A. Startup Main Tab > 02-Plan Details 1=40 (02-PD-wdot18)
 B. (C:02-PD-Plan-1-100) Press Enter to continue with layout name 

<Plan 1 IN 40 FT> : or type new name for layout.: 01 Enter
 3. Status Bar > Right Click Layout1 > Delete > Double Click anywhere in the viewport
 4. Status Bar > Unlock
 5. Zoom Extents
 6. WisDOT Tools Tab > Navigation > Rotate View >  Click on 2 points of the drawing
 7. Status Bar > Drawing Scale > 1IN:40FT  > Lock View > Pan to Center

Add radius points for labels and apply station offset UDPs

pln-prod-intrsctn-dtl-02.mp4 4:04

 1. Home Tab  > Create Ground Data > Points > Point Creation Tools > Expand Chevron
 A. Prompt for Description: Automatic
 B. Default Description: POINTS
 C. Chevron Icon: Collapse Chevron

 2. Create Points Tool Bar > 4th Icon Drop down arrow > Random Points
 A. CREATEPOINTRANDOMPOINTS Please Specify a location for then new 

point:Select radius points of curbs
 B. Close toolbar: Click Red X

 3. ToolSpace  > Prospector > Right Click Point Groups > New  > Information Tab
 A. Name: Points
 B. Point Style: WisDOT Standard Radius PT
 C. Point Label Style: Pnt Number Circled

Page: 1433

Published on: 5/17/2023

Intersection detail sheet

https://c3dkb.dot.wi.gov/data/pln-prod/pln-prod-cnstrctn-dtl-end-data-c3d18.zip
https://c3dkb.dot.wi.gov/Content/doc/fdm-xmpl/021101-id.pdf
https://c3dkb.dot.wi.gov/data/pln-prod/pln-prod-intrsctn-dtl-begin-data-c3d18.zip
https://c3dkb.dot.wi.gov/video/pln-prod/pln-prod-intrsctn-dtl-01.mp4
https://c3dkb.dot.wi.gov/video/pln-prod/pln-prod-intrsctn-dtl-02.mp4


 D. Include tab
 I. With raw descriptions matching: POINTS

 E. Ok
 4. Layout Tab 01  > Double Click Inside Viewport
 5. WisDOT Sheets  > Point Station Offset to UDP > Add Properties Tab

 A. Point Group: POINTS
 B. Alignment: 51
 C. User Defined Properties: as Alignment 1
 D. Apply
 E. Alignment: 47
 F. User Defined Properties: as Alignment 2
 G. Apply

Create radius point tables

pln-prod-intrsctn-dtl-03.mp4 1:16

 1. Annotate Tab  > Labels and Tables Panel > Add Point Table
 A. Table style: NUM STA OFF STA OFF Y X RADIUS Z sort by Point
 B. Point Groups Selected: POINTS
 C. Max row per table: 10
 D. Ok

 2. ADDPOINTTABLE Select upper left corner:Click location in layout tab
 3. Select and move with grips for readability

Adjust point labels, add dimensions,  and clean up labels

pln-prod-intrsctn-dtl-04.mp4 6:24

 1. Select and move point labels off of the nodes with their grips
 2. WisDOT Sheets Tab  > Standard Components Panel > Add All Components
 3. WisDOT Sheets Tab  > WisDOT Annotation Panel > Manage Dimension Styles > 070-

PLANJOINTS
 4. WisDOT Sheets Tab  > WisDOT Annotation Panel > Radius
 5. DIMRADIUS Select are or circle:Select outside curved portion of curb
 6. Set location of the tail of dimension line to match node
 7. Right click dimension line to make adjustments (Text has masking)
 8. Double click inside viewport 
 9. Type a command:L

 A. LINE Specify first point:Radius point of curb
 B. LINE Specify second point:Perpendicular to alignment 
 C. Repeat for desired radii
 D. Esc to end command

 10. Select Alignment  > Contexual tab > Labels and Tables Panel > Add Labels > Add Align-
ment Labels
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 A. Station Offset Label Style: Station Offset - LT Justified [Stacked 0.06]
 B. Marker Style: No Display
 C. Add

 11. ADDALIGNOFFXYLBL Select alignment:Select the alignment 
 12. ADDALIGNOFFXYLBL Select point:Select apparent intersection of outer curb and 

line from previous step 
 A. Repeat as needed
 B. Adjust label locations as needed
 C. Adjust label style to: Station Offset - RT Justified [Stacked 0.06] as needed
 D. Delete Lines from previous step

Add multileaders, mtext, intersection label, and alignment labels

pln-prod-intrsctn-dtl-05.mp4 7:28

 1. WisDOT Sheets Tab  > WisDOT Annotaton Panel > Multileader Text dropdown > 070
 2. Type a command:UCS Enter
 3. UCS Specify origin of UCS or [ Face NAmed OBject Previous View World 

X Y ZAxis] :V Enter
 4. WisDOT Sheets Tab  > WisDOT Annotation Panel > Multileader

 A. MLEADER Specify leader arrowhead location of [leader Landing 

first Content first Options]:Select outer curb location
 B. MLEADER Specify leader landing location:Select desired location and 

enter call out
 C. Click outside text editor to complete

 5. Right Click mulitleader line  > Add Leader
 A. MLEADEREDIT Specify leader  arrowhead location or [Remove Lead-

ers]:select another outer curb location
 B. Repeat as needed
 C. Right Click Enter to leave command

 6. WisDOT Sheets Tab  > Sheet Creations Panel > Construction Detail Dropdown > Detail
 7. WisDOT Sheets Tab  > Support Panel > Palettes ON/OFF > Tool Palette > Intersection 

Details Tab > ArialRegular 0.100
 A. MTEXT Specify first corner:Select desired location
 B. MTEXT Specify oposite corner:Select desired location
 C. MTEXT:Enter desired text
 D. Click outside text editor to exit
 E. Repeat as needed
 F. Right click text to edit (Copy, Rotate, Move)

 8. Type a command:UCS Enter UCS Specify origin of UCS or:W Enter
 9. Annotate Tab  > Labels and Tables Panel > Add Labels > Notes

 A. Note Label Style: Intersection
 B. Marker Style: Basic
 C. Add
 D. ADDNOTELABEL Pick label location:Apparent intersection of both align-

ments
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 E. ADDNOTELABEL Select alignment for label style componet Mainline 

Station:Right click select alignment 51
 F. ADDNOTELABEL Select alignment for label style componet Side Road 

Station:Right click select alignment 47
 G. Esc to exit command

 10. Right Click STH 47 Alignment > Alignment Properties > Information tab
 A. Description: STH 47
 B. Ok

 11. Right Click USH 51 Alignment  > Alignment Properties > Information tab
 A. Description: USH 51
 B. Ok

 12. Annotate Tab  > Labels and Tables Panel > Add Labels > Alignment > Add Alignment 
Labels

 A. Label Type: Single Segment
 B. Line label style: RW Bearing 070
 C. Curve label style: _No Display
 D. Spiral label style: _No Display
 E. Add
 F. ADDALINESEGLBL :Select location along  alignment

 I. Repeat as needed
 II. Esc to exit command

 G. Select label and use grips to adjust location
 I. Right Click Label  > Flip Label

Locating and labeling curb ramp locations

pln-prod-intrsctn-dtl-06.mp4 4:31

 1. Model Space Tab  > Insert Tab > Reference Tab > Attach
 A. Path Type: Relative Path
 B. Scale > Specify On-Screen: Unchecked
 C. Insertion Point > Specify On-Screen: Unchecked
 D. Rotation > Specify On-Screen: Unchecked
 E. ProjectID\Design\Edgelines\CurbRamp.dwgOpen

 2. WisDOT Sheets Tab  > Palettes ON/OFF > Intersection Details > P_MISC_Text
 3. PLINE:Snap to end points (Make Sure Osnaps and Endpoints are turned ON)
 4. XR:Enter External References tab

 A. Right click CurbRamp > Detach
 5. 01 layout > Double click in the Viewport
 6. Type a command:UCS
 7. UCS Specify origin of UCS or:V
 8. WisDOT Annotation  > Multileader

 A. Right click: Midpoint
 B. (Enter Desired Text)
 C. Select Leader: Add Leader
 D. (Repeat as needed)
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 9. Type a command:UCS
 10. UCS Specify origin of UCS or:W
 11. WisDOT Sheets Tab  > Sheet Creation > Construction Detail Chevron > Detail > Palettes 

ON/OFF
 A. Startup Main Tab: North Arrow
 B. (place as needed)

Exercise files: pln-prod-intrsctn-dtl-end-data-c3d18.zip

Plan details
Last updated: 2021-02-18

Sample plan details sheet: 021201-pd.pdf

Plan details overview
There are a wide variety of plan details sheet types. Plan details sheets might include  pavement 
types and elevations, curb types and elevations, lane dimensions, survey point tables, miscellaneous 
quantities, miscellaneous notes, and more. Generally any information that isn't already represented 
somewhere else in the plan set. 

Creating plan details sheets

Example files: pln-prod-pln-dtl-data-begin-c3d20.zip

Create new drawing, add WisDOT Standards Components, and set annotation 
scale

 1. To create a new file, Quick Access Toolbar > New.
 2. SAVEthe file as <project>\SheetsPlan\xxxxxx-pd.dwg
 3. Ribbon > WisDOT Sheets tab > Standards Components panel > Add All Components

Click the Model tab near the bottom left corner of the Civil 3D application window.

 4. Click the Annotation Scale dropdown arrow in the status bar near the bottom of the Civil 3D 
application window and select 1 IN:50 FT(Select scale appropriate for the sheet in the pro-
ject.)

 5. SAVE the file.                     

Create view frames for the plan details sheet file

Info: View Frames are defined areas in model space along an alignment that can be used to 
create layout sheets with a view frame area automatically centered to scale in a viewport. A 
View Frame Group is a collection of View Frames used to create an automated sheet set of mul-
tiple layouts containing predefined viewports. View Frame Groups can also be data referenced 
to create sheet sets in other drawings.
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 1. To create a new file, type QNEW at the command line.
 2. SAVEthe file as <Project>\Design\View Frames\xxxxxx-vf.dwg
 3. Data Reference into the file the primary alignment that the view frames will be created along.
 4. Create View Frames. Make sure to create view frames that are the same scale that is used in 

the plan details sheet file.
 5. SAVE the file.
 6. Create a Data Shortcut for the view frame group.
 7. SAVE the file.
 8. Data Reference the View Frame Group into the plan details sheet file xxxxxx-pd.dwg.

(Alternatively, if the View Frames are not likely to be shared among other drawings, the View 
Frames can be created directly in the plan details sheet file.)

Add external references and data references to drawing

See Xreference vs data shortcut concepts

Add external references

 1. Xref all needed files into the plan details sheet file using the WisDOT Load Xref on Layer tool. 
 A. Ribbon > WisDOT Sheets tab > Manage panel > Load Xref on Layer
 B. Browse to the file > Open

 2. Repeat for any other files.
 3. Zoom extents (ZE)to see the drawing data.

Use data shortcuts to add data references

See Data shortcuts

Create sheets

 1. See Create sheet files with layouts from view frame groups
 2. See Sheet layout title block text fields Make sure the name that appears on the sheet layout 

border has something more descriptive than “Plan Details” only.

Add dimensions and multileaders

See WisDOT dimensions and multileaders

Add text notes

 1. Set layer to P_MISC_Text.
 2. Ribbon > WisDOT Sheets tab > WisDOT Annotation panel pull-down > Set WisDOT 

Textstyle/Size
 A. In the style pull-down select a text style.
 B. In the size pull-down select a text size.
 C. Open Annotate Ribbon.
 D. Close the WisDOT Annotation palette.

 3. Ribbon > Annotate tab > Text panel > Multiline Text button.
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 4. Create a text box by left-clicking the upper left point where the text will be placed then left-
click another point to the lower right.

 5. Type the text that is needed.

Insert blocks

See Inserting blocks

Example files: pln-prod-pln-dtl-data-end-c3d20.zip

Curb ramp detail sheet
Last updated: 2021-02-16

Total video time: 75:16

Prerequisite: This workflow requires a detailed curb ramp surface to create label-only pipe 
network structures and associated labels and tables. Please see "Curb ramp design with fea-
ture lines" on page 1124 on how create this surface.

Standards
Roadway Model Requirements: FDM 15-5-7.2

Sample detail sheet: 021301-cr.pdf

Curb Ramp Requirements: FDM 11-46-10

WisDOT Civil 3D Project Data Workflow Map

Civil 3D Project Folder Structure: FDM 15-5 Attachment 3.1

Civil 3D Object and File Abbreviation Standards: FDM 15-5 Attachment 3.2

Civil 3D Drawing Naming Convention: FDM 15-5 Attachment 3.3

Civil 3D Object Naming Convention: FDM 15-5 Attachment 3.4

Introduction

pln-prod-crb-rmp-dtl-01.mp4 1:22

Goals

 l Curb Ramp Detail Sheets 
 o Produced using curb ramp surface models
 o See FDM 11-46-10.2.3 for curb ramp detail sheet requirements and list of suggested 

detail in the curb ramp detail sheet.
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Workflow Overview

 l Curb Ramp Design (Link to C3DKB)
 l Plans Production Curb Ramp Detail Sheets 

 o Data reference design objects
 o External reference existing and design drawings
 o Create view frame
 o Draw approximate pavement joints at grade changes
 o Add elevation points 

 n Pipe network structures
 n Create structure table

 o Add slope labels
 o Add miscellaneous annotations
 o Re-align view frame and create sheet layout
 o Add layout to sheet set

Sample Project Data

Sample project data should be downloaded and extracted to C:\WisDOT\Design\c3d. For sub-
sequent versions of files as the training moves on, copy the individual files into the folders as struc-
tured in the zip files.

Create curb ramp detail plan sheet drawing

pln-prod-crb-rmp-dtl-02.mp4 5:19

Exercise files: pln-prod-crb-rmp-dtl-begin-data-c3d2018.zip

 1. Create new drawing using C:\WisDOT\Stnd\C3DXXXX\Templates\Begin-dwg\design-wis-
dotXX.dwt.

 2. Save: ProjectID\SheetsPlan\023101-cr.dwg
 3. Load sheets components 

 A. WisDOT Sheets tab > Standards Components panel > Add All Components
 4. Toolspace > Prospector > Data Shortcuts > Create Data Shortcut References

 A. Surfaces 
 I. Roadway design refinement top surface (Rfnt-All-Top) 

 a. Style: _No Display
 II. Curb ramp design refinement surfaces (Rfnt-2ndNW-Top) 

 a. Style: Slope Intercept
 III. Existing Surface (Exist) 

 a. Style: _No Display
 B. Alignments 

 I. Mainline reference alignment: 51
 a. Alignment style: ALI Proposed
 b. Alignment label set: 1IN 40FT-Ticks 100' Major:25' Minor
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 II. Side road reference alignment: Lcl-2ndAve, Lcl-3rdAve, 47
 a. Alignment style: ALI Proposed
 b. Alignment label set: 1IN 40FT-Ticks 100' Major:25' Minor

 III. Curb Return Alignments: Int-2ndNW-Flag
 a. Alignment style: RDWY Curb&Gutter Flange
 b. Alignment label set: _No Labels

 IV. Curb Return Profiles: Same as curb return alignment
 a. Profile style: PROF Proposed
 b. Profile label set: _No Labels

 5. WisDOT Sheets tab > Manage & Support panel > Load Xref on Layer
 A. Create External references of the following drawings 

 I. Existing Topography (ProjectID\BaseData\Topo-Ex.dwg)
 II. Proposed Roadway and Curb Ramp Edgelines (Pro-

jectID\Design\Edgelines\pavt.dwg)
 III. (If applicable) Storm Sewer - Inlets Only (Pro-

jectID\Design\PipeNetwork\PipeNetworks - Inlets.dwg)
 IV. (If applicable) Traffic Signals
 V. (If applicable) Street Lighting(ProjectID\Design\Edgelines\Lighting.dwg)

 VI. (If applicable) Pavement Marking (ProjectID\Design\Edgelines\PM.dwg)
 VII. (If applicable) Right of Way (Existing and Proposed) (ProjectID\RW\Ult-

RW.dwg)
 6. Clean up the drawing by freezing/turning off unnecessary external reference layers.

Create sheet set

pln-prod-crb-rmp-dtl-03.mp4 1:25

If not already completed for the Civil 3D Project, create a sheet set before making plan sheets. See 
the topic here: "Sheet sets" on page 1297

Create view frames

pln-prod-crb-rmp-dtl-04.mp4 5:04

Create view frame

A view frame will be used to create a curb ramp detail sheet for each curb ramp location.

 1. Output tab > Plan Production ribbon > Create View Frames

 A. Alignment 
 I. Alignment: 51 (Main roadway)

 II. Station Range: Specify a short 50' range near the curb ramp. 
 a. Start: 524+50
 b. End: 525+00

 III. Next>
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 B. Sheets: Sheet Settings 
 I. Choose the sheet type you want to generate: Plan(s) only

 II. Template for plan and profile sheet: 
 a. C:\WisDOT\Stnd\C3D2018\Templates\Sheets\02-PD-wdot18.dwt
 b. Layout template: Plan 1 IN 10 FT
 c. OK

 III. View Frame Placement: Along alignment
 IV. Next>

 C. View Frame Group: 
 I. Name: VFG - 2ndNW

 II. Next>
 D. Match Lines 

 I. Insert match lines: Unchecked
 E. Create View Frames

 2. Adjust the view frame to surround the curb ramp area

 A. Select the view frame
 B. Click the square grip and move to surround the curb ramp area.

The view frame will be adjusted later on to match the desired plan sheet area

 3. Adjust the model annotation scale to match the sheet annotation scale
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Tip: Rotate the view to match the orientation of the view frame. UCS > select top left of view 
frame > select top right of view frame > digitize a point above the view frame > PLAN > 
Current > Enter

Save the view for each curb ramp location

 1. View Tab > Views panel > View Manager
 2. New 

 A. View Name: 2ndNW (curb ramp quadrant)
 B. Boundary: Define Window

 I. Click the object picker  to define the window
 II. Snap to the view frame

 III. Enter to accept
 C. OK

 3. OK

Review and add sidewalk joints

pln-prod-crb-rmp-dtl-05.mp4 1:26

Page: 1443

Published on: 5/17/2023

Review and add sidewalk joints

https://c3dkb.dot.wi.gov/video/pln-prod/pln-prod-crb-rmp-dtl-05.mp4


 1. Home tab > Layers > Layer Drop Down > Select P_Path_Sidewalk to make the layer active
 2. Home tab > Draw > Polyline

 A. Draw a polyline at each of the locations representing sidewalk tie in joints and any curb 
ramp significant grade change locations.

 B. Select the polylines > Right click > Properties > Line type > Wisdot1

Create pipe network

pln-prod-crb-rmp-dtl-06.mp4 3:00

Pipe network structures will be used to create the elevation points, labels, and tables for the import-
ant locations of a curb ramp.

 1. Home tab > Create Design panel > Pipe Network > Pipe Network Creation Tools
 A. Network Name: 2ndNW(Curb Ramp Name)
 B. Network parts list: Detail Sheets
 C. Surface name: Rfnt-2ndNW-Top (Curb ramp design surface)
 D. Alignment Name: 51 (Main roadway reference alignment)
 E. Structure label style: Detail Sheets - Elevation
 F. Pipe label style: <none>

 2. Network Layout Tools > Pipe Network Properties

 A. Verify the settings under Labels, Network Parts List, and Default object reference 
match what was set in the creation dialog box.

 3. Name Templates 1. Structures:  to edit the name template.

 4. Name: <[Next Counter]> 1. Number Style: 01, 02, 03.... 2. Starting number: 1

Tip: For each subsequent pipe network/curb ramp location, modify the starting num-
ber in a way to not over-write previously named/numbered structures and provide a 
name/number buffer between curb ramp locations. IE: First curb ramp occupies num-
bers 1 - 23. Start the second curb ramp structure name template at 30. 

Determine key elevation point locations
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pln-prod-crb-rmp-dtl-07.mp4 4:30

Recommended locations for elevation points are posted here: FDM 11-46-10.2.3

 1. Curb return geometry points 
 A. Find curb quarter points 

 I. Draw an arc along the arc portion of curb return: Home tab > Draw panel > 
Arc > 3-Point

 II. DIVIDE Enter

 a. Select the arc
 b. Number of segments: 4Enter

 III. DDPTYPE Enter to change display style for points

 a. Choose the style, set as absolute units and size to 1

 IV. Select and Delete the arc

 B. Profile Points: Select the alignment > Right-Click > Edit Alignment labels
 I. Type: Profile Geometry Points

 II. Profile Geometry Point Label Style: Standard
 III. Edit the Label Style
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 a. Layout Tab
 b. Component Name: Line
 c. Start Point Y Offset: 0.00"
 d. OK
 e. Add>>

 i. Select Profile: 2ndAve-NWQuad-Flag (curb return vertical profile)
 ii. Uncheck all geometry points
 iii. Check Low Point, High Point, Grade Break, Point of Vertical Inter-

section
 iv. OK

 f. OK

Create pipe network structures

pln-prod-crb-rmp-dtl-08.mp4 6:36

 1. Network Layout Tools > Structure Part Selection drop-down > Concentric Cylinder 
Structure > Concentric Structure 48 dia....

 2. Network Layout Tools > Draw Pipes and Structures button > Structures Only
 A. Recommended layout of structures/elevation points: 

 I. Work from downstation to upstation of the curb return alignment
 II. Work in "layers" through the curb ramp for consistent numbering

 III. Flange Line
 IV. Curb Back
 V. Ramps

 VI. Sidewalk Landings
 VII. Tie-in Points

 B. If some elevations are "0", there isn't a surface definition in that exact location. Best 
practice is to add the required locations as frequencies to the curb and gutter corridor 
in the curb ramp design drawing.

 C. Recommended elevation point locations 
 I. Curb and gutter flange geometry points and intersections with cross walk

 II. Curb back/curb ramp lower landing and taper intersection points
 III. Ramp
 IV. Upper Landing
 V. Tie in locations

 VI. Locations of sidewalk grade change
 3. Remove the profile labels from the curb and gutter flange alignment. 

 A. Select the alignment > Right-Click > Edit Alignment labels
 B. Select the Profile Geometry Points line

 C.  (delete)
 4. Select and delete the points created along the alignment.

Adjust labels
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pln-prod-crb-rmp-dtl-09.mp4 2:37

The goal is to adjust the labels so they aren't impeding background linework. Try to place the labels 
in white space.

 1. Select the label
 2. Adjust the label location using square grip
 3. Adjust leader anchor location

Create additional structures and update naming

Create additional structures at any new locations as needed.

Create pipe network structure table

pln-prod-crb-rmp-dtl-10.mp4 5:37

Add table

 1. Annotate tab > Labels & Tables panel > Add Tables > Pipe Network > Add Structure

 2. Structure Table Creation dialog:

 A. Table Style: Detail Sheets
 B. By Network: checked
 C. Select Network: 2ndNW (choose the curb ramp pipe network)

 3. Split Table:

Tip: Optional depending on number of structures/elevation points. A good starting 
point is divide the number of elevation points by 2 and put that in the "Maximum rows 
per table." Round up for odd numbers. 

 A. Maximum rows per table: 18
 B. Maximum tables per stack: 3
 C. Offset (distance between tables): 0.5"
 D. Tile tables: Across
 E. Behavior: Dynamic
 F. OK

 4. Digitize the location of the table
 5. Rotate the table to match the view orientation

 A. Select the tables > Home tab > Modify panel > Rotate
 I. Specify base point: Choose the top left corner of the view frame

 II. Specify rotation angle:Reference Enter
 III. Specify reference angle: Choose the top left corner of the table
 IV. Specify second point: Choose the top right corner of the table
 V. Specify the new angle: Choose the top right corner of the view frame

 6. Move the table back into the view frame
 A. Adjust the view frame as needed to allow proper placement of table and labels
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Add a wipeout to hide existing topography

 1. Home Tab > Layers > Layers drop-down > P_MISC
 2. Home tab > Draw panel > Rectangle Draw a rectangle/closed polyline that encompasses 

the pipe network structure table
 3. WIPEOUT

 A. Specify first point or [Frames/Polyline]: P to choose a polyline
 B. Select the polyline that encompasses the structure table
 C. Erase polyline?:Y to erase

 4. Select the structure tables > Home tab > Layers panel > Layers Drop Down > P_MISC_
Text

 5. WisDOT Sheets tab > Manage panel > Layers pull-down > Layer Display Order
 A. Select P_MISC_Text

 B. Use the up arrow  to move the layer above P_MISC
 C. OK

Info: The structure table is dynamic to the pipe network. If a structure is added to the network, 
the table will automatically update. If the elevation or location of the structure changes, the 
table will update. 

Update network with additional elevation points

pln-prod-crb-rmp-dtl-11.mp4 6:52

The structure table remain dynamic to the pipe network and the structures it contains. Create more 
structures along the pedestrian curb to label the elevations and locations of the pedestrian curb 
grade breaks. (Add more structures as needed in other areas as well)

Add pedestrian curb to pavt.dwg

The pedestrian curb should be added to pavt.dwg so it may be shown in other plan sheet drawings 
other than the curb ramp plan detail drawing.

 1. Close the curb ramp plan detail sheet drawing (023101-cr.dwg)
 2. Open ProjectID\11701902\Design\Edgelines\pavt.dwg
 3. Create a polyline along the back of sidewalk within the limits of the curb ramp. 

 A. On layer P_Path_Sidewalk
 4. Offset the polyline 0.5' for the Pedestrian Curb Back.
 5. Select the Pedestrian Curb Back 

 A. Home Tab > Layers > Layers drop-down > P_RDWY_C_AND_GBack
 6. Delete the polyline that is concurrent with back of sidewalk
 7. Save and Close

Create additional elevation points

 1. Open ProjectID\11701902\SheetsPlan\023101-cr.dwg
 2. Modify Tab > Design panel > Pipe Network
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 3. Pipe Networks Contextual ribbon > Modify panel > Edit Pipe Network
 A. Select pipe network: 2ndNW
 B. OK

 4. Use the Network Layout Tools to create additional storm sewer structures.

Rename Parts

Rename any structures to modify the point numbering system.

 1. Select the structures to be renamed in the order to be named.
 2. Modify tab > Pipe Network > Pipe Network Contextual ribbon > Modify panel drop-

down > Rename Parts

Info: The structure table is dynamic to the pipe network. If a structure is added to the 
network, the table will automatically update. If the elevation or location of the structure 
changes, the table will update. 

Add slope arrows

pln-prod-crb-rmp-dtl-12.mp4 8:25

 1. Locations: Review the continent checklist for latest suggestions. FDM 11-46-10.2.3
 A. Gutter slope and all gutter slope transition points
 B. All locations for transverse slope change
 C. All longitudinal grade locations, both sides of walks
 D. Special attention to landing and ramp edges
 E. Slope of gutter in middle of cross walk in direction of pedestrian travel.

 2. Add labels 
 A. Annotate tab > Labels & Tables panel > Add Labels

 I. Feature: Surface
 II. Label Type: Slope

 III. Slope label style: WisDOT CR Slope Above or WisDOT CR Slope Below
 a. Above/Below is dependent on the desired location of the arrow in rela-

tion to the two point line that is labeled.
 IV. Add

 B. Select a surface:Enter to select from list
 C. Select a surface: Rfnt-2ndNW-Top (Curb Ramp top surfaces)
 D. Create Slope Label: Click Two-point or type T- Enter for two point slopes
 E. Digitize the first and second points of locations to draw slope labels.

Requirement: For consistency, place the labels so the arrow is pointing downhill and the 
slope value is negative. 

Add miscellaneous annotations

pln-prod-crb-rmp-dtl-13.mp4 5:59
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Review the curb ramp detail sheet object matrix (Link to matrix) and FDM 11-46-10.2.3 for the 
types of Civil 3D objects used to create the miscellaneous annotations.

 l Curb Ramp Type: 070-Circle Tag Multileader without leader
 l Detectible Warning Field: Polyline on P_Misc_NoPlot layer, Hatch on E_Path_Sidewalk layer, 

HEX Pattern
 l Horizontal Dimensions: WisDOT Sheets tab > WisDOT Annotation panel > Dimension 

Styles > 060-LANE&SHLD > Aligned
 l Legend 

 o Lines/Polylines
 o Multiline Text 

 n Text Frame: Yes
 n Background Mask: Yes

 l General Notes: Multiline Text 
 o Text Frame: Yes
 o Background Mask: Yes

 l Masks/Wipeout behind legend, tables, general notes.

Create plan sheet

pln-prod-crb-rmp-dtl-14.mp4 5:04

 1. Adjust the view frame one last time to fit all information
 2. Create a sheet set if one has not been created.
 3. Output tab > Plan Production panel > Create Sheets

 A. View Frame Group and Layouts 
 I. View Frame Group: VFG-2ndNW (View frame for curb ramp location)

 II. Layout Creation: All layouts in the current drawing
 III. Layout name: 01-2ndNW (increase number for subsequent curb ramps)
 IV. Choose the north arrow block to align: SheetWizard-NorthArrow
 V. Next

 B. Sheet set 
 I. Add to existing sheet set: checked

 II. Click 
 III. Choose the project sheet set: 1170-19-70.dst
 IV. Create Sheets
 V. OK

 4. Home tab > Palettes drop-down > Sheet Set Manager to open Sheet Set Manager 
 A. First curb ramp detail only: Rename the newly created subset 

 I. Right Click the Subset > Rename Subset
 II. Name: CURB RAMP DETAILS

 a. The name of the subset will affect the title block information on the plan 
sheets.
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 III. Subsequent curb ramp details 
 a. Select the newly created detail sheet
 b. Click and drag to the CURB RAMP DETAILS subset

 5. Save the drawing to make the changes take affect
 6. Open the curb ramp detail sheet layout 

 A. Double click the CURB RAMP DETAILS portion of the title block 
 I. Add - 2ND NW as a descriptor for the page

 II. The title block should read CURB RAMP DETAILS - 2ND NW
 7. Move the north arrow into an open space on the page.

Exercise files: pln-prod-crb-rmp-dtl-end-data-c3d2018.zip

Contour map sheet        
Total video time: 14:01

Example sheet: 021601-cm.pdf      

Initial setup and add layout         

Exercise files: pln-prod-cntour-map-begin-data-c3d18.zip

Begin with file 11701970\SheetsPlan\021601-cm.dwg         

pln-prod-cntour-map-01.mp4 4:33         

Initial setup         

 1. Start a new drawing from design-wisdotXX.dwt template                 
 2. Data reference the proposed top refinement surface and roadway alignments                 
 3. WisDOT Sheets ribbon > Standard Components panel > Add All Components

 A. Add All Components will add all the WisDOT plan production elements (leader styles, 
dimension styles, etc.) that are not initially included in the WisDOT drawing template.                     

 4. Select surface Rfnt-51-Top ribbon > Modify panel > Surface properties
 A. Surface properties dialog box > Information tab                                 

 I. Surface style: P Contours 5' Major: 1' Minor
 a. The contour interval used may vary depending on project relief. 

 II. OK

Add layout         

 1. Make sure that Tool Palette is visible                 
 A. WisDOT Sheets ribbon > Palettes On/Off to toggle the palette on and off.                      

 2. WisDOT Sheets ribbon > Sheet Creation panel > Construction Details > Detail
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 A. Detail Tool Palette > Startup Main tab > Sheet Layouts > 02-Plan Details 1=50 
(02-PD-wdot18)

 I. (C:02-PD-PLAN-1-50) Press enter to continue with layout 

name <Plan 1 IN 50 FT> : or type NEW name for Layout. 01 
Enter

 a. A new layout named 01 is created                                     
 3. Right-click over Layout1 tab > Delete > OK

 A. Layout1 that will not be used in the file is deleted.                     
 4. 01 layout tab > Double-click inside sheet viewport

 A. Model space within the layout viewport is now active                     
 5. Click the Viewport Lock to unlock the viewport 

 6. Double-click mouse wheel to zoom extents                 
 7. Pan and zoom to desired project location                 
 8. REA

 A. REGENALL may be needed for text to show at the correct scale                     
 9. WisDOT Design ribbon > Navigation panel > Rotate View

 A. Pick first point: pick a location along the alignment that will be on the left side 
of the sheet                     

 B. Pick next point to define the rotation: pick a location along the align-
ment that will be on the right side of the sheet                     

 C. The view is rotated so the line between the two selected locations along the alignment 
is at angle = 0                     

Page: 1452

Published on: 5/17/2023

Initial setup and add layout



 10. Change the annotation scale to 1IN:50FT

 11. Pan within the view to the desired location                 
 12. Lock the viewport                 
 13. Double-click outside the viewport

 A. Working in model space within the layout is deactivated                     

Add contour surface labels         

pln-prod-cntour-map-02.mp4 3:02         

 1. 01 layout tab > Double-left-click viewport
 A. Model space is activated within the viewport                     

 2. Annotate ribbon > Labels & Tables panel > Add Labels > Surface > Add Surface Labels
 A. Add Labels dialog box                         

 I. Feature: Surface
 II. Label type: Contour - Multiple

 III. Major contour label style: Proposed
 B. Add

 I. ADDCONTOURLABELING Select a surface < or press enter key to 

select from list >: left-click to select surface                                 
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 II. ADDCONTOURLABELING Specify first point or [Objects]: select 
beginning of line to cross contours to be labeled                                 

 III. ADDCONTOURLABELING Specify next point: select end of line that 
crosses contours to be labeled                                 

 a. Major contour label line is labeled                                     
 C. Add to label additional contour locations                         
 D. Enter to exit the labeling command                         
 E. Close to exit the Add Labels dialog box                         

 3. Double-left-click outside the viewport
 A. Working in model space within the layout is deactivated                     

Check drainage with water drop and add slope arrows         

pln-prod-cntour-map-03.mp4 3:14         

 1. 01 layout tab > Double-left-click viewport
 A. Model space is activated within the viewport                     

 2. Select surface Rfnt-51-Top > Contextual ribbon > Analyze panel > Water Drop
 A. Water Drop Path - Path Layer: 0
 B. OK                     
 C. Left-click to select multiple locations to determine flow paths
 D. Right-click to end the command                     

 3. Esc to deselect the surface                 
 4. Change active layer to P_DRN_Flow
 5. WisDOT Sheets ribbon > Sheet Creation panel > Construction Details > Drainage and 

Utilities
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Info: If palette does not open, click the Palettes ON/OFF button on the left hand side of 
the WisDOT ribbon                 

 6. Drainage and Utilities palette > Erosion Control tab > Left-click Blocks - EC Flow Arrow
 A. EXECUTETOOL Specify insertion point: left-click where the tip of the drainage 

arrow will be located                     
 B. EXECUTETOOL Specify rotation angle: rotate the drainage arrow to the 

desired direction and left-click to set flow direction                     
 7. Click select a single water drop line > Right-click > Select Similar...
 8. Delete
 9. Double-click outside the viewport

 A. Working in model space within the layout is deactivated 

Add multileaders and north arrow         

pln-prod-cntour-map-04.mp4 3:12         

Add multileaders text labels         

 1. Change active layer to P_MISC_Text
 2. Layout tab > Double-click viewport

 A. Model space is activated within the viewport                     
 3. UCS Enter at the command line

 A. UCS Specify origin of UCS or [Face NAmed OBject Previous View 

World X Y Z ZAxis]: V Enter                    
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 4. WisDOT Sheets ribbon > WisDOT Annotation panel > Multileader
 A. MLEADER Specify leader arrowhead location or [leader Landing 

first Content first Options]

 I. Shift-right-click > Nearest snap
 II. Left-click select a location along the side road alignment

 B. MLEADER Specify leader landing location:                         
 I. Left-click select the location where the text will be located

 II. Type TUCKAWAY
 III. Left-click outside the text area to end the command

 5. WisDOT Sheets ribbon > WisDOT Annotation panel > Multileader
 A. MLEADER Specify leader arrowhead location or [leader Landing 

first Content first Options]

 I. Shift-right-click > Nearest snap
 II. Left-click select a location along the mainline alignment

 B. MLEADER Specify leader landing location:                         
 I. Left-click select the location where the text will be located

 II. Type USH 51
 III. Left-click outside the text area to end the command

 6. Double-left-click outside the viewport
 A. Working in model space within the layout is deactivated                     

Add north arrow         

 1. Layout tab > Double-left-click viewport
 A. Model space is activated within the viewport                     

 2. UCS Enter at the command line
 A. UCS Specify origin of UCS or [Face NAmed OBject Previous View 

World X Y Z ZAxis]: W Enter                    
 3. WisDOT Sheets ribbon > Sheet Creation panel > Construction Detail > Detail

 A. Details palette > Startup Main tab > Left-click Blocks - North Arrow
 I. EXECUTETOOL Specify insertion point or [Basepoint Scale 

Rotate]: Click to place North arrow in the desired location within the view-
port                             

 II. EXECUTETOOL Specify rotation angle: 0
 4. Double-click outside the viewport

 A. Working in model space within the layout is deactivated                     
Exercise files: pln-prod-cntour-map-end-data-c3d18.zip

Erosion control sheet
Last updated: 2022-10-27

Example sheet: 022001-ec.pdf

Create the erosion control sheets
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 1. 1. Create a new dwg using design template.
 A. Application menu > New > design-start.dwt
 B. or WisDOT Sheets > 02 > Drainage and Utilities Palette > Startup Main > Design 

& Production
 2. Save as SheetsPlan\022001-ec.dwg
 3. "Add WisDOT AutoCAD components" on page 1302
 4. Xref tools - Load Xref on Layer Load Xref on Layer

 A. Edgelines file, SI (slope intercept), Topo-Ex, Wetlands-Ex.
 5. Data shortcuts

 A. "Data shortcut alignment" on page 1303
 B. "Create single plan view frames and group #create" on page 1304.  One VFG can be 

used for multiple types of 02 Detail Sheets.
 C. DREF VFG into file and "Modify sheet set to get fields correct in title block #modify" on 

page 1309 
 6. "Create sheet files with layouts from view frame groups" on page 1307
 7. "Place north arrow" on page 1334
 8. Save the 022001-ec.dwg

Erosion control sheet palette
Used to access drawing objects and styles for use on erosion control sheets.  See Drainage and Util-
ities Palette here: 02 Details

Add hatch
 1. Double click inside viewport.
 2. Type UCS ENTER
 3. Type V for View.
 4. Set active layer to desired Hatch Pattern (P_EC_MatClass1).
 5. Home Tab > Draw Panel > Hatch

 A. Scale: 10
 6. Boundaries > Select boundary objects

 A. Select the polyline
 7. Palette alternative hatch

 A. WisDOT Sheets > Support > Palettes ON/OFF
 B. WisDOT Sheets > Sheet Creation > Drainage and Utilities palette > Erosion Con-

trol tab.
 8. Draw hatch area limits

 A. Home > Layers > layer pull-down > P_MISC_NoPlot
 B. Draw the shape of the area to be hatched.

 I. Use C to Close the polyline shape area.
 9. Select a point inside the closed polyline to hatch the area.

 10. Select the hatch.
 11. Contextual ribbon > Properties panel > Scale: 10

Add Blocks and Labels
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 1. Add blocks 
 A. Open the 04 layout tab
 B. UCS Enter V Enter
 C. WisDOT Sheets > Support > Palettes ON/OFF
 D. WisDOT Sheets > Sheet Creation > 02 pulldown menu > Drainage and Utilities 

palette > Erosion Control tab
 E. EC Inlet Protection

 I. Scroll down to Blocks area, select the EC Inlet Protection block.
 II. R Enter for the Rotate command.

 a. Place the block insertion point, which is the point to rotate around
 b. Select a starting point
 c. Select a point to end the rotation

 III. Scale the block to the file
 a. Select block > Right-click > Properties
 b. Properties palette > Scale X field: 0.5

 IV. Repeat the above steps for all other erosion control blocks:
 F. Wetland (Marsh) block

Warning: This next step requires permission from the individual responsible for 
the Wetland-Ex.dwg file. As an alternative, this process could be done in the 
Topo-Ex file, with similar permission required.

 I. Select the wetland delineation line.
 II. Contextual ribbon > Edit panel > Open Reference

 III. WisDOT Sheets > Sheet Creation panel > Topo palette > Exist-
ingEdgeofAreas tab

 IV. Select Wetland/Marsh Area Symbol button and drag to wetland area locations.
 V. Save and close the Wetland-Ex.dwg.

 VI. In the 022001-ec.dwg, reload the Wetland-Ex XREF.
 2. Add Lines

 A. Erosion Control Palette > EC – Silt Fence
 B. Draw location of the silt fence

 3. Add Labels
 A. Slope Intercept, Delineated Wetlands Typ., Silt Fence

 I. Multileader style: WisDOT Sheets > Standard Components panel > Com-
ponents Palettes pulldown > Multileader Palette > Plan Sheet tab > 
WETLANDS

 B. EC Inlet Protection Type
 I. WisDOT Sheets > WisDOT Annotation panel pull-down > Set WisDOT 

Textstyle/Size
 a. Style: Calibri Light
 b. Size: 0.100”

 II. Annotate tab > Text panel > Multiline Text
 III. Create a text box near the inlet block.

 a. B
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 IV. Click outside the text box.
 V. Select text > Right-click > Properties 

 a. Justify: Middle Center
 b. Text Frame: Yes

 C. Road name
 I. WisDOT Sheets > WisDOT Annotation panel pull-down > Set WisDOT 

Textstyle/Size
 a. Style: Calibri Light
 b. Size: 0.100”

 II. Annotate tab > Text panel > Multiline Text
 III. Create a text box in the roadway.

 a. USH 51
 IV. Click outside the text box.
 V. Move and rotate text appropriately for the area.

 D. Alignment R/L
 I. Select the alignment.

 II. Context ribbon > Labels & Tables panel > Add Labels drop-down > Add 
Alignment Labels

 a. Label Type: Single Segment
 b. Line label style > General Line Label Style: Alignment Name [from 

Desc]
 c. Curve label style > General Curve Label Style: Alignment Name [from 

Desc]
 d. Add

 III. Select the segment of the alignment.
 IV. Select label > Right-click > Edit Label Text. Select the label text again.
 V. Before the <alignment Description> tag type R/L

 a. Repeat these steps for each R/L label.

Create a legend and notes
 1. WisDOT Sheets > Support > Palettes ON/OFF
 2. WisDOT Sheets > Sheet Creation > Drainage and Utilities palette > Erosion Control tab

 A. Scroll down to Blocks area and drag EC Legend into the sheet.
 3. Insert the EC Legend block from the palette, Right-click block > Edit Block in Place > OK 

 A. Delete the items and text not represented in this sheet.
 B. Move blocks and related text to fill in gaps in legend.
 C. Edit Reference panel > Save Changes
 D. OK

 4. Select the viewport edge and select the polyline.
 5. Hover over the rectangular grip at the midpoint of a viewport edge and choose Add Vertex.
 6. Shift so the viewport is not displaying over the legend.
 7. Repeat this as necessary to get a box around the legend.

Storm sewer plan/profile sheet
Last updated: 2021-04-07
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Total video time: 139:43

Standards
Sample detail sheet: 022501-ss.pdf

FDM on Storm Sewer Sheets: FDM 15-1-20.8

WisDOT Civil 3D "Project data workflow map" on page 181

Civil 3D Project Folder Structure: FDM 15-5 Attachment 3.1

Civil 3D Object and File Abbreviation Standards: FDM 15-5 Attachment 3.2

Civil 3D Drawing Naming Convention: FDM 15-5 Attachment 3.3

Civil 3D Object Naming Convention: FDM 15-5 Attachment 3.4

Introduction

pln-prod-strm-swr-01.mp4 5:39

Prerequisite: This workflow requires a detailed storm sewer model using Civil 3D Pipe Net-
work Parts.  More information on developing a storm sewer model is here:  "Storm sewer lay-
out using pipe networks" on page 1203

Workflow overview

 l Plans Production Storm Sewer Plan Profile Sheets

 o Data reference design objects
 o External reference existing and design drawings
 o Create alignments and surface profiles for pipe network trunks and laterals
 o Create view frames
 o Create Storm Sewer Sheets
 o Project pipe network objects to profile views
 o Create super imposed profiles for pipe network trunks on roadway alignment profile 

views
 o Create profile views for laterals
 o Add plan view labels
 o Add profile view labels
 o Final sheet clean up

Key takeaways

 l These sheets use the main roadway alignment and/or side road alignments as the baseline 
for view frame creation.

 o Since the existing and proposed ground over the storm sewer parts is to be shown in 
the profile view, alignments of the pipe network will be created.  Surface profiles along 
the pipe network trunk alignments will then be superimposed to the roadway 
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alignment profile views to be viewed on the plan sheets.

 o Individual profile views for the laterals will be created and shown on the plan sheets.
 l Storm sewer plan profile sheets utilize stacked profiles to create two profile views on each 

sheet.  The top profile can be used to display the trunk line and the bottom profile view can be 
used to display the laterals.  In cases where there are trunk lines on either side of the road-
way, the two trunk lines can be used to display each trunk line. 

Sample project data

Sample project data should be downloaded and extracted to C:\WisDOT\Design\c3d. For sub-
sequent versions of files as the training moves on, copy the individual files into the folders as struc-
tured in the zip files.

Create sheet file and review references

Exercise files: pln-prod-strm-swr-02-begin-data-c3d20.zip

pln-prod-strm-swr-02.mp4 7:31

Set the Data Shortcuts working folder and project folder

Make sure the data shortcuts working folder is set to your project.

 1. In Toolspace > Prospector tab > right-click Data Shortcuts > Set Working Folder
 2. Browse to the 11701902(Your Project ID) project folder, and go one level up from that.

Tip: You should select the C3D folder that is two levels above the project _Shortcuts 
Folder or one level above the Civil 3D Project Folder.

 3. OK
 4. In Toolspace > Prospector tab > right-click Data Shortcuts > Set Data Shortcut Project 

Folder
 5. Select the project folder 11701902(Your Project ID)
 6. OK
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Create the sheet file

 1. Create new drawing
 A. Application Menu > New > design-start.dwt
 B. Start Tab > New > design-start.dwt

 2. Add all components and save the file
 A. WisDOT Sheets Tab > Standards Components > Add All Components
 B. Application Menu > Save

 I. Project ID\SheetsPlan\022501-ss.dwg . 

Review storm sewer Pipe Network reference files

The design storm sewer pipe network references other Civil 3D objects such as surfaces and align-
ments to allow for automatic labeling and design calculations.  These objects must be referenced into 
the sheet drawing prior to referencing the pipe network.

 1. Open the source drawing for the pipe network 
 A. Toolspace > Prospector tab > Data Shortcuts > Expand Pipe Network > Right-

click  Storm pipe network > Open Source Drawing
 B. In the source drawing for the pipe network review and make note of the object ref-

erences for the pipe network
 I. Toolspace > Prospector tab > Expand Pipe Network  > Expand Storm > 

Click Pipes
 II. In the Toolspace > Prospector tab > preview area (at the bottom) look for 

the Reference Alignment column.
 a. Scroll down through to find the alignments the pipes reference.  Make 

note. 
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 III. Look for the Surface Column
 a. Scroll down through to find the surfaces the pipes reference.  Make 

note. 

     

 IV. I Toolspace > Prospector tab > Expand Pipe Network  > Expand Storm > 
Click Structures

 V. In the Toolspace > Prospector tab > preview area (at the bottom) look for 
the Reference Alignment column.

 a. Scroll down through to find the alignments the structures reference.  
Make note. 

 C. Look for the Surface Column
 I. Scroll down through to find the surfaces the structures reference.  Make note.

Tip: The Process of searching names can be made easier if you left click 
the Reference Alignment / Reference Surface column header.  This will 
sort the table by this column. 

Create data shortcut references

Exercise files: pln-prod-strm-swr-03-data-c3d20.zip
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pln-prod-strm-swr-03.mp4 7:17

 1. Create Data Shortcut References

Tip: To create a data shortcut reference, in Toolspace > Prospector Tab > Data-
shortcuts, expand the object types (Surfaces, Alignments, etc) to find the object you 
want to reference.  Right click on the object and choose Create Reference.  Then assign 
object and label styles as desired for the object.

 2. Surfaces 

 A. Style
 I. All surfaces may be referenced using the _No Display style

 B. Objects: All surfaces the pipe network references plus other existing and design sur-
faces

 I. Cmbn-Ex-Top
 II. Cmbn-Ex-Datum

 III. Exist
 IV. Rfnt-All-Top
 V. Rfnt-All-Datum

 VI. Crdr-51-PipeDatum

Tip: Utilize group data referencing to make this process faster.

 3. Alignments
 A. Styles:

 I. Alignment Style: ALI Proposed
 II. Label Set: 1IN 40FT-Ticks 100' Major:25' Minor-NoPCPT(Pick one without the 

PCPT Labels)
 B. Alignment Objects: All centerline/reference alignments that the pipe network ref-

erences and alignments for sideroads.
 I. 51

 II. Lcl-Trapp
 III. Lcl-Tuckaway

 4. Profiles Design profiles for referenced centerline and reference alignments are used as ref-
erences for profile view creation. They are not shown on the Storm Sewer Plan Profile Sheet

 A. Styles
 I. Profile Style: PROF Proposed

 II. Label Set: WisDOT Standard
 B. Profile Objects: Only profiles of alignments that plan/profile sheets are created from 

are needed
 I. 51

 5. Storm Sewer Pipe Networks
 A. Storm-51-Trapp-Arrowhead

 I. Pick the appropriate Parts List (Storm Sewer)
 II. Do not override reference alignment and surface.
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 III. Do not assign labels.
 6. If available and required to be shown:

 A. Existing Sanitary sewer pipe networks
 B. Existing storm sewer pipe networks
 C. Culvert Pipe Networks

 I. 575+00

Info: If there is any other data that is needed in the plan sheet, repeat these steps for the 
appropriate objects.

Attach external references

Exercise files: pln-prod-strm-swr-04-data-c3d20.zip

pln-prod-strm-swr-04.mp4 3:34

 1. WisDOT Sheets Tab > Manage Panel > Load Xref on Layer
 A. ProjectID/Design/Edgelines/pavt.dwg (proposed edgelines file)
 B. ProjectID/BaseData/Util-Ex.dwg (Existing Utilities)

 I. Freeze all Overhead Utility layers.  Show only underground.
 C. ProjectID/BaseData/Topo-Ex.dwg (Existing Topography) 

 I. Freeze unncessary layers (Mapping lines, roadway names, etc)
 D. ProjectID/RW/Ult-RW.dwg (Ultimate Right of Way)

 2. Attach any other desired drawings using the above method.
 3. Utilize Layer Display Order to adjust display order of objects.

 A. WisDOT Tab > Manage Panel > Layers > Layer Display Order
 B. Organize the external reference layers for appropriate display
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Adjust display styles of network parts

Exercise files: pln-prod-strm-swr-05-data-c3d20.zip

pln-prod-strm-swr-05.mp4 3:33

The default styles for storm sewer pipe network parts are the following:

 l Apron Endwalls : Proposed Storm Sewer Endwall (Production)
 l Inlets: Proposed Storm Sewer Inlet (Production)
 l Manholes: Proposed Storm Sewer Manhole (Production)

If there are pipes and structures that require a different style (Such as Existing) adjust the styles to 
reflect the appropriate Existing Storm Sewer Style for those pipes and structures.

 1. Toolspace > Prospector > Pipe Networks > Networks > Expand the Pipe network > 
Select Pipes or Structures

 2. In the Toolspace > Preview area, adjust the object styles.
 A. Apron Endwalls : Existing Endwall (Production)
 B. Inlets: Existing Inlet (Production)
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 C. Manholes: Existing Manhole (Production)

Create alignments and surface profiles for trunks

Exercise files: pln-prod-strm-swr-06-data-c3d20.zip

pln-prod-strm-swr-06.mp4 9:53

Info: Alignments need to be created above each pipe network part to capture the profile data 
above all of the pipes and structures, and to project that profile data onto the profile views.  
These alignments should be created along with the cardinal directions from South to North 
and West to East.  Once the alignments are created, extend them 10' past the start and end 
locations.

Create an alignment and surface profile for the pipe trunk

 1. Home Tab > Create Design Panel > Alignment > Create Alignment from Network Parts
 2. Select first connected Network Part: Select the Southern or Western structure of 

the trunk line.
 3. Select next Network Part: Pan to the Northern or Eastern structure of the trunk line 

and select it.
 4. Enter
 5. Create Alignment from Pipe Network Dialog

 A. Name: Trunk 30-36 (Naming convention is Trunk BeginStructure-EndStructure)
 B. Alignment style: DRN Storm Sewer
 C. Alignment label set: _No Labels
 D. Create profile and profile view: Checked
 E. OK

 6. Create Profile from Surface dialog
 A. Make sure Alignment assignment is correct: Trunk 30-36
 B. Select Surface: Exist > Add
 C. Select Surface: Rfnt-All-Top > Add
 D. Assign appropriate styles to the profiles

 I. Exist > PROF Existing
 II. Rfnt-All-Top > RDWY Lane Edge

 E. Click Draw in profile view
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 7. Create Profile View Dialog (Profile view will be used for superimposing along mainline road-
way)

 A. General
 I. Verify the selected alignment:  Trunk 30-36

 II. Profile View Style: Storm Sewer 1:5 Vert Ex
 III. Next

 B. Station Range: Automatic
 I. Next

 C. Profile View Height: User Specified - leave the default
 I. Next

 D. Profile Display Options
 I. Labels Column > _No Labels

 II. Next
 E. Pipe/Pressure Network

 I. Deselect all parts
 F. Create Profile View

 8. Digitize the location of the profile view in model space.
 9. Extend the limits of the alignment by 10' on either end

 A. Utilize the Extension object snap.

Info: Repeat for other trunk lines in the storm sewer pipe network.

Create alignments and surface profiles for laterals

Exercise files: pln-prod-strm-swr-07-data-c3d20.zip
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pln-prod-strm-swr-07.mp4 5:46

 1. Home Tab > Create Design Panel > Alignment > Create Alignment from Network Parts
 2. Select first connected Network Part: Select the Southern or Western structure of the lateral.
 3. Select next Network Part: Pan to the Northern or Eastern structure of the lateral and select it.
 4. Create Alignment from Pipe Network Dialog

 A. Name: Lateral 30-30A (Naming convention is Lateral BeginStruture-EndStruture)
 B. Alignment style: DRN Storm Sewer
 C. Alignment label set: _No Labels
 D. Create profile and profile view: Checked

 5. Create Profile from Surface dialog
 A. Make sure Alignment assignment is correct: Lateral 30-30A
 B. Select Surface: Exist > Add
 C. Select Surface: Rfnt-All-Top > Add
 D. Assign appropriate styles to the profiles

 I. Exist > PROF Existing
 II. Rfnt-All-Top > RDWY Lane Edge

 E. OK
 6. Extend the limits of the alignment by 10' on either end

 A. Utilize the Extension object snap.

Info: Repeat for other laterals in the storm sewer pipe network.

Create view frames

Exercise files: pln-prod-strm-swr-08-data-c3d20.zip

pln-prod-strm-swr-08.mp4 6:16

Info: The view frames will be created along the roadway reference line so that the sheets have 
a base as they are being created. The pipe network data will then be projected to the plan and 
profile views.

Create the view frames

 1. Output tab > Plan Production panel > Create View Frames
 2. Create View Frames

 A. Alignment
 I. Alignment: 51(Mainline roadway reference Line)

 II. Station Range: User Specified (Contain the limits of the pipe networks - make 
station range adjustments to get full sheets)

 a. Start: 566+00
 b. End: 583+10
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 B. Sheets
 I. Sheet Settings: Plan and Profile

 II. Template for Plan and Profile sheet: 
 a. C:\WisDOT\Stnd\C3D2020\Templates\Sheets\02-SS-wdot.dwt
 b. Layout: SS 1 IN 40 FT

Info: WisDOT provides layout scales of 1 IN:10 FT, 1 IN:20 FT, 1IN: 
40 FT, 1 IN: 50 FT, and 1 IN:100 FT for storm sewer sheets. FDM 
15-1-20.8 states that "The scale should normally be 1"=50' or lar-
ger." The [10 FT, 20 FT, 40 FT, and 50 FT] scales all fit this state-
ment while [100 FT] is provided for abnormal situations.

 C. View Frame Group
 I. Name: VFG-51-SS-40(VFG-Roadway-SS-Description)

 D. Match Lines
 I. Snap station value down to the nearest: 1 and checked

 II. Allow additional distance for repositioning:
 a. Checked
 b. 25'(This defines the overlap distance and depends on scale of sheet and 

number of curves.)
 III. Match Line Style: _No Display
 IV. Match Line Labels: _No Display

 E. Profile Views
 I. Select profile view style: Storm Sewer 1:5 Vert Ex

 II. Select band set style: Storm Sewer

Tips: 
Best practices for choosing Profile View Style are as follows:

 n Annotation Scale = 10 FT, 20 FT ; Single Profile View ; Style = 
Storm Sewer 1:5 Vert Ex

 n Annotation Scale = 40 FT, 50 FT ; Single Profile View ; Style =  
Storm Sewer 1:10 Vert Ex

 n Annotation Scale = 10 FT, 20 FT ; Double Profile Views ; Style = 
Storm Sewer 1:2 Vert Ex

 n Annotation Scale = 40 FT, 50 FT ; Double Profile Views ; Style = 
Storm Sewer 1:5 Vert Ex

 n Annotation Scale = 100 FT ; Single and Double Profile Views ; 
Style = Storm Sewer 1:10 Vert Ex
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 A. Create View Frames

Turn pipe alignment display off

Exercise files: pln-prod-strm-swr-09-data-c3d20.zip

pln-prod-strm-swr-09.mp4 1:24

Info: After the view frames are created, make sure the alignments over the trunks and laterals 
are not visible.

 1. Toolspace > Prospector tab > Alignments > Click Miscellaneous Alignments
 2. In Toolspace > Prospector tab > preview area, shift-select or control-select the trunk and lat-

eral alignments from the list.
 3. Scroll to the right to find the Style column.
 4. Right-click the header of the Style column and choose Edit
 5. Select _No Display
 6. OK

Create storm sewer sheets

Exercise files: pln-prod-strm-swr-10-data-c3d20.zip

pln-prod-strm-swr-10.mp4 9:03

Requirement: If a sheet set for the project has not been created, close out of the wizard and 
create a sheet set.  Steps are here: "Sheet sets" on page 1297
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Info: The Create Sheets command makes use of the "Stacked Profiles" process, which is 
slightly different than the process used for road design plan and profile sheets.

Tip: Unload all external references to make pipe network object selection easier.

 1. Output Tab > Plan Production Panel > Create Sheets
 2. View Frame Group and Layouts

 A. Select the correct view frame group: VFG-SS-40
 B. All Layouts in the current drawing
 C. Layout name: Next Counter, start at 01. (Should be default, but double check.  Also 

modify as the plan builds)
 D. North Arrow: SheetWizard-NorthArrow
 E. Next

 3. Sheet Set
 A. Click the ellipsis next to Add to existing sheet set.

 I. Navigate to Civil 3D Project\SheetsPlan\11701970.dst
 II. Select the project sheet set that has already been created.

 III. Open
 B. Sheet File Name: Since we creating the layouts in the current drawing, the Sheet File 

Name does not apply.
 C. Next

 4. Profile Views
 A. Other profile view options > Choose settings
 B. Profile View Wizard

 5. Profile View Wizard
 A. General

 I. Show offset profiles by vertically stacking profile views: Checked

Info: This is optional.  Checking this will create dual/stacked profile views.  
In Storm Sewer Plan Profile sheets, the top profile view can be used for 
the main trunk line.  The bottom profile view can be used to display the 
laterals.  Some Storm Sewer Plan Profile sheets may not require stacked 
profile views.  

 B. On the left select Profile View Height
 C. Profile View Height

 I. Profile view datum by: Mean Elevation
 II. Next

 D. Stacked Profile
 I. Number of Stacked views: 2

 II. Gap between views: 0.000'
 III. Top view Style: Storm Sewer 1:5 Vert Ex
 IV. Middle view Style: Storm Sewer 1:5 Vert Ex
 V. Bottom view style: Storm Sewer 1:5 Vert Ex
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Info: The profile view styles should match the view style specified in the 
Create View Frames wizard.

 E. Profile Display Options
 I. Bottom View

 a. Deselect all boxes in the Draw column
 II. Top View

 a. Deselect all boxes in the Draw column
 b. Next

 F. Pipe/Pressure Network
 I. Top View: Select parts from screen

 a. Select pipe nework or [individual Parts or Series of 

parts]:Series of parts
 i. Select the upper and lower parts contained in the trunk.
 ii. Enter or Right Click

 II. Bottom View: Deselect all parts
 III. Next

 G. Data Bands
 I. Bands do not show, no need to modify anything here.

 H. Finish
 6. Create Sheets
 7. Digitize the origin location of the profile views in model space (choose an open area)

Project trunks to profile views

Exercise files: pln-prod-strm-swr-11-data-c3d20.zip

pln-prod-strm-swr-11.mp4 2:49

Tip: This can be done automatically using the profile view creation wizard, but if some parts 
are missing, this process allows you to select exactly the parts to be added in a profile view. 

 1. Select a Profile View >Contextual Ribbon > Launch Pad > Draw Parts in Profile View
 2. Select network(s) to add to profile view or [Selected parts only]: 

Selected parts only or S
 3. Select only the main trunk pipes and structures contained within the view frame for the selec-

ted profile view
 4. Enter or Right Click
 5. Select profile view: Select the profile view to receive the projected parts. (Same as ori-

ginally selected)
 6. Repeat for remaining profile views.

Create trunk superimposed profiles

Exercise files: pln-prod-strm-swr-12-data-c3d20.zip

pln-prod-strm-swr-12.mp4 4:24
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Create superimposed profiles of trunk lines

Prerequisite: This requires a profile view for the centerline/reference line alignments and the 
pipe network alignments.

 1. Home Tab > Create Design > Profile > Create Superimposed Profile
 2. Select Source Profile: Select the trunk line - existing surface profile
 3. Select destination profile view: Select the roadway profile view
 4. Superimpose Profile Options > OK
 5. Repeat for the Rfnt-Top-All Surface Profile.
 6. Repeat for other trunk lines.

Turn off superimposed profiles in lower profile views

 1. Select one of the lower profile views.
 2. Contextual Ribbon > Modify View panel > Profile View Properties

 A. Profiles Tab > Draw Column > Deselect all of the profiles
 3. OK
 4. Repeat for remaining lower profile views.

Review and adjust profile views

Exercise files: pln-prod-strm-swr-13-data-c3d20.zip

pln-prod-strm-swr-13.mp4 5:41

At times the elevations of the profile views may not have the correct elevations assigned to properly 
display all of the required objects. Adjust the profile view elevations to shift the profiles to the upper 
portion of the profile view to be sure all pipe networks are shown.
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Manually

 1. Select the profile view > Contextual ribbon > Modify View panel > Profile View Prop-
erties

 2. Elevations Tab
 A. Make note of the value in the Height (in the example 18.5')
 B. Adjust the Minimum and Maximum Elevation to best show the profile and pipe net-

work, while maintaining the original overall height.
 3. On a sheet with dual profile views, adjust the lower profile view to match the elevation limits 

of the upper profile view.

Custom command: DOTPROFILEVIEWELEVRANGE

Info: At the time of recording, a button does not exist for this command, but the command 
does exist.  In the future, the command may have a button located on the WisDOT Tabs.

 1. DOTPROFILEVIEWELEVRANGEEnter
 2. Select profile views:Select the profile views to be adjusted

 A. Enter
 3. Enter Minimum Elevation:Specify the minimum elevation of the profile views

 A. Enter
 4. Determine height by [Same New Elevation]: Determines how the maximum elevation 

is specified.
 A. Enter to maintain default choice of Same

Update the sheet set

Exercise files: pln-prod-strm-swr-14-data-c3d20.zip

pln-prod-strm-swr-14.mp4 5:09

Sheet Set Manager

The Sheet Set Manager is used to automatically title the sheet layout title blocks.  The Sheet Set Sub-
set labels the title of the sheet.  Update the subset.
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 1. If not already open, open the Sheet Set Manager
 A. Home Tab > Palettes Panel Drop-Down > Sheet Set Manager
 B. Rename the Subset to Storm Sewer - 51
 C. Right click **Sheet 01** > Rename & Renumber

 I. Delete the value from the Number field
 II. Next

 III. Repeat for the remaining sheets
 IV. OK

 D. Review Sheet Layouts for accuracy

Delete extra layout

 1. Layout1 is part of the design template.  It can be deleted.
 2. Select Layout1
 3. Right-click > Delete

Create profile views for laterals

Exercise files: pln-prod-strm-swr-15-data-c3d20.zip

pln-prod-strm-swr-15.mp4 8:58

Create lateral profile views

Info: As explained later in this training, the lateral profile views create a unique situation when 
overlapping a larger profile view, such as the bottom profile view here.  When labeling, the 
labeling tool gets confused as to which profile view it is part of and usually places labels incor-
rectly.  Options include the following: 

Option 1: When creating the profile views for the laterals, digitize them in open model space.  Add 
pipe network labels, and then move the profile views to the bottom profile view within the limits of 
the plan sheet.

Option 2: If lateral profile views overlap the bottom profile view, select the main bottom profile view 
and move it out of the way.  Add labels to the lateral profile view, then slide the main profile view 
back into place. (This will be demonstrated in this training topic)

A profile view will be created for each lateral that is not shown in the trunk line profile view. 

 1. Home Tab > Profile & Section Views > Profile View > Create Profile View
 A. General

 I. Select Alignment: Lateral 30-30A
 a. This specifies the lateral to be displayed

 II. Profile View Style: Storm Sewer 1:5 Vert Ex (Insert)
 III. Next

 B. Station Range:
 I. Automatic

 II. Next

Page: 1476

Published on: 5/17/2023

Create profile views for laterals

https://c3dkb.dot.wi.gov/data/pln-prod/pln-prod-strm-swr-15-data-c3d20.zip
https://c3dkb.dot.wi.gov/video/pln-prod/pln-prod-strm-swr-15.mp4


 C. Profile View Height
 I. Match the elevation range of the main lower profile view on the sheet

 II. Minimum: 1593.00
 III. Maximum: 1611.50'

Prerequisite: It is very important the elevations of the profile view match 
the bottom profile view elevations on the target plan sheet.

 D. Profile Display Options
 I. Ensure both profiles are checked in the Draw Column

 II. Labels Column: _No Labels
 E. Pipe/Pressure Network

 I. Select parts from screen
 II. Series of parts

 a. Select the upper and lower parts contained in the lateral.
 b. Enter or Right Click

 III. Next

 F. Data Bands
 I. Select Band Set: Storm Sewer

 II. The data bands in the (Insert) profile views are turned off, so this doesn't mat-
ter as much.

 G. Create Profile View
 H. Digitize the profile views in the lower profile view.

Turn on external references

If the external references have been turned off, turn them back on using the following steps.

 1. Home Tab > Palettes > External References Manager
 2. Select all of the external references to be turned on
 3. Right Click > Reload

Create plan view labels

Exercise files: pln-prod-strm-swr-16-data-c3d20.zip
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pln-prod-strm-swr-16.mp4 6:03

This process can be done as a whole network or each part individually.  Depending on the project con-
ditions, it is recommended to use Entire Network Plan to start and then add/adjust individual 
labels later. Best practice is to work through the different pipe part labels, one at a time (Pipe labels 
and structure labels).  When working on pipes, set the structure label style to _No Labels.  When work-
ing on structures, set the pipe label style to _No Labels. 

Task:

 l Add structure description labels. Structure Desc Circle (Left/Right)
 l Add pipe slope arrows. PLAN Storm - Single/Multiple Arrows
 l Add pipe labels. PLAN Storm - Diameter/HE Dimensions/Pipe Name

Add Labels:

 1. Annotate Tab > Labels & Tables > Add Labels
 A. Feature: Pipe Network
 B. Label Type: Entire Network Plan(Or Single Part Plan if it is desired to add one label at 

a time.)
 C. Pipe Label Style:

 I. PLAN Storm - Multiple Arrows (Default - Used on long pipe runs - Places multiple 
arrows)

 II. PLAN Storm - Single Arrow:  (Use for short pipe runs.  Will place an arrow at the mid 
point of the pipe.)

 III. PLAN Storm - Diameter  (Displays round pipe diameter)
 IV. PLAN Storm - HE Dimensions (Displays HE pipe dimensions)
 V. PLAN Storm - Pipe Name (Displays the pipe name)

 D. Structure Label Style:
 I. Structure Desc Circle (Left/Right)Labels structure name, station, offset, and 

description (bid item).  Need to choose Left or Right depending on the location to 
place the label.

 II. Structure Desc Circle with Ali Desc (Left/Right) Same as "I" but adds the reference 
alignment description after the full station range.

 III. Structure Desc Circle with Ali Desc +00 (Left/Right) Adds the alignment descrip-
tion after the main station value before the "+."

 E. Add
 2. Add Pipe Labels

 A. Label Type: Entire Network Plan
 B. Pipe Label Style: PLAN Storm - Multiple Arrows
 C. Structure Label Style: _No Labels
 D. Add
 E. Select one of the pipes.  All pipes will be labeled with the specified style
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 F. In areas where arrows do not display
 I. Change the Pipe Label Style to PLAN Storm - Single Arrow

 II. Add
 G. Add a descriptive label and adjust locations (Optional)

 I. PLAN Storm - Diameter
 II. PLAN Storm - HE Dimensions

 III. PLAN Storm - Pipe Name
 H. Adjust pipe labels as needed

 3. Add Structure Labels
 A. Label Type: Entire network Plan
 B. Pipe Label Style: _No Labels
 C. Structure Label Style: Structure Desc Circle Left
 D. Add
 E. Select one of the Pipe network structures.  All structures will receive the label as pre-

scribed.  

Adjust plan view labels

Exercise files: pln-prod-strm-swr-17-data-c3d20.zip

pln-prod-strm-swr-17.mp4 7:21

Adjust structure labels

Tip: The labels rotate to the view and are best adjusted within the layouts. 

 1. Select a layout tab (01) to view the layout.
 2. Double click the top "plan" viewport to access the model
 3. Select the structure labels and grip-edit move them to locations that are readable and appro-

priate
 4. For labels  that need to be flipped

 A. Select the labels that need to be flipped > Right Click > Edit Label Style
 B. Structure Desc Circle Right
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 C. OK

 5. Adjust leaders to direct towards the center of the circle of the label.
 6. If required to switch the alignment of the label, select the label > Edit Label Style > Change the 

Label Style to the desired type.

Adjust pipe labels

 1. Identify labels that may not be working properly
 A. PLAN Storm - Diameter labels do not work with HE Pipes.
 B. PLAN Storm - HE Dimensions labels do not work with round pipes.

 2. Delete incorrect labels.
 3. Add correct labels

 A. Label Type: Single Part Plan
 B. Pipe Label Style: PLAN Storm - xxxx
 C. Structure Label Style: _No Labels
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 D. Add

 4. In areas where arrows do not display
 A. Change the Pipe Label Style to PLAN Storm - Single Arrow
 B. Add

 5. Adjust label location using the Diamond grip.

Create profile view labels - the basics

pln-prod-strm-swr-18.mp4 5:36

This process can be done as a whole network or each part individually.  Depending on the project con-
ditions, it is recommended to use Single Part Profile in profile views.  Best practice is to work 
through the different part labels, one at a time (Pipe labels and structure labels).  When working on 
pipes, set the structure label style and crossing label style to _No Labels.  When working on struc-
tures, set the pipe label style and crossing label style to _No Labels. 

Task:

 l Add elevation labels to the inverts of the start and end of pipes. Invert Start/End
 l Add labels for pipe size and description and slope. PROF Storm
 l Add a rim elevation label to each structure. Rim Elevation
 l Add a sump elevation labels to structures with sumps. Sump Elevation - LT/RT
 l Add a structure name label to each structure Structure Profile
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Add profile label basics:

 1. Perform this work while in model space.  Pan to the profile views used in the sheets.
 2. Annotate tab > Labels & Tables panel > Add Labels

 A. Feature: Pipe Network
 B. Label Type: Single Part Profile(Or Entire Network Profile if it is desired to add more 

than one label at a time.)
 C. Label Style Options

 I. Pipe Label Style: Add Invert and Prof Storm labels to each pipe
 a. Invert End: Labels the pipe end elevation. Requires the label to be dragged 

to insert a leader.
 b. Invert End LT/RT: Adds a label of the end of pipe invert elevation.  Choice 

of LT/RT depends on the desired location of the label with respect to the 
pipe. LT is placed on the left end of the pipe.  RT is placed on the right end of 
the pipe  Label contains a line that connects with the bottom of the pipe.

 c. Invert Start:Labels the pipe start elevation. Requires the label to be 
dragged to insert a leader

 d. Invert Start Lt/Rt: Adds a label of the start of pipe invert elevation.  Choice 
of LT/RT depends on the desired location of the label with respect to the 
pipe. LT is placed on the left end of the pipe.  RT is placed on the right end of 
the pipe Label contains a line that connects with the bottom of the pipe.

 e. PROF Storm:Labels Pipe Description, Class, Size, and Slope (Use Label 
Entire Network Profile)

 II. Structure Label Style: Add a Rim Elevation and Structure Profile label to each 
structure.

 a. Rim Elevation: Adds a rim elevation label.  Must be dragged to add a leader
 b. Rim Elevation - LT/RT: Adds the rim elevation with a leader line (can be 

dragged if needed with a leader)
 c. Structure Profile:Labels the Structure Name (Use label type Entire Net-

work Profile)
 d. Sump Elevation - LT/RT: Adds the sump elevation  with a leader line.  Must 

be dragged to the bottom left or right corner of the structure.
 3. Adjust labels to fit in profile view and not overstrike other parts

 A. For short pipes, pipe labels can be dragged out of pipe.  
 4. Adjust leaders to direct towards the center of the circle of the label.
 5. If required to switch the direction/layout of a label, select the label > Edit Label Style > Change 

the Label Style to the desired type.

Info: Additional information on label adjustments is explained here: "Adjust labels to fit profile 
views #adjst-lbl" on page 1485

Add profile labels to structures and pipes

Exercise files: pln-prod-strm-swr-19-data-c3d20.zip
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pln-prod-strm-swr-19.mp4 7:27

Info: For dual profile views, only do work in the upper profile view at this time.  Lateral profile 
views require special workflows to place labels correctly.

Add structure name and pipe description labels

 1. Annotate tab > Labels & Tables panel > Add Labels
 A. Feature: Pipe Network
 B. Label type: Entire Network Profile
 C. Pipe label style: PROF Storm
 D. Structure label style: Structure Profile
 E. Crossing pipe label style: No Labels
 F. Add

 2. In each trunk profile view, select a pipe or structure to place the labels.
 A. Re-click Add for each profile view.

Add structure rim elevation labels

Review the profile view to determine which rim elevation labels may be best.  Rim Elevation - LT and 
Rim Elevation - RT labels are available to minimize post-placement adjustments.  In tight areas, 
these labels may be used in dragged state to customize the label location.

 1. Annotate tab > Labels & Tables panel > Add Labels
 A. Feature: Pipe Network
 B. Label type: Single Part Profile
 C. Pipe label style: _No Labels
 D. Structure label style: Rim Elevation - LT or Rim Elevation - RT
 E. Crossing pipe label style: _No Labels
 F. Add

 2. In each trunk profile view, select each structure to place the labels.
 3. Change the Structure label style as needed while working through the profile views and sub-

sequent structures. 

Add structure sump elevation labels

Review the profile view to determine which sump elevation labels may be best.  Sump Elevation - LT 
and Sump Elevation - RT labels are available to minimize post-placement adjustments.  In tight 
areas, these labels may be used in dragged state to customize the label location.

 1. Annotate tab > Labels & Tables panel > Add Labels

 A. Feature: Pipe Network
 B. Label type: Single Part Profile
 C. Pipe label style: _No Labels
 D. Structure label style: Sump Elevation - LT or Sump Elevation - RT
 E. Crossing pipe label style: _No Labels
 F. Add
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 2. In each trunk profile view, select a structure to place the labels.
 3. Change the Structure label style as needed while working through the profile views. 

Add pipe invert labels

Pipe invert labels should be placed one at a time.  Depending on the start/end and slope of the pipe, 
label styles are available for both the LT and RT ends of a pipe for both the start and end of the pipe.  
LT means the label is intended to be placed on the left end of the pipe.  RT means the label is inten-
ded to placed on the right end of the pipe.  Start means the label reads and displays the start invert 
of the pipe in the direction it was drawn.  End means the label reads and displays the end invert of 
the pipe in the direction it was drawn.

 1. Annotate tab > Labels & Tables panel > Add Labels

 A. Feature: Pipe Network
 B. Label type: Single Part Profile
 C. Pipe label style: Invert - Start - LT/RT or Invert - End - LT/RT
 D. Structure label style: _No Labels
 E. Crossing pipe label style: _No Labels
 F. Add

 2. In each trunk profile view, select a pipe to place the label.
 A. Either change the label style for each end of the pipe depending on the configuration, 

or place similar label styles along all of the pipes with similar configurations.
 3. Change the structure label style as needed while working through the profile views. 

Laterals: Add pipe network labels

Exercise files: pln-prod-strm-swr-20-data-c3d20.zip

pln-prod-strm-swr-20.mp4 6:41

When two profile views are overlapping, the pipe network labels can become unpredictable when 
placing.  This is avoided by separating overlapping profile views:

Option 1: When creating the profile views for the laterals, digitize them in open model space.  Add 
pipe network labels, and then move the profile views to the bottom profile view within the limits of 
the plan sheet. (Not Demonstrated)

Option 2: If lateral profile views overlap the bottom profile view, select the main bottom profile view 
and move it out of the way.  Add labels to the lateral profile view, then slide the main profile view 
back into place. (This will be demonstrated in this training topic)

 1. Select the bottom profile views of the dual profile views.  (Do not select the smaller lateral pro-
file views)

 2. Home Tab > Modify Panel > Move
 A. Specify base point: Select a base point anywhere in model space

Page: 1484

Published on: 5/17/2023

Laterals: Add pipe network labels

https://c3dkb.dot.wi.gov/data/pln-prod/pln-prod-strm-swr-20-data-c3d20.zip
https://c3dkb.dot.wi.gov/video/pln-prod/pln-prod-strm-swr-20.mp4


 B. Specify second point or: Select a point that moves the profile views outside of the lim-
its of the lateral profile views.     

 3. Add Pipe and Structure Labels as specified in 'Add hyperlink'>Add profile labels to structures 
and pipes

 4. Move main bottom profile view back into place
 A. Select all of the main-bottom profile views that are out of place.
 B. Home Tab > Modify Panel > Move
 C. Specify base point: Select a base point  on the top left or right corner of one of the pro-

file views to be moved. 
 D. Specify second point or:  Select a second point on the lower left or right corner of the 

corresponding upper profile view. 

Adjust labels to fit profile views #adjst-lbl

Exercise files: pln-prod-strm-swr-21-data-c3d20.zip

pln-prod-strm-swr-21.mp4 7:38

Label styles are set up to be a best guess at desired location.  In some conditions, the label styles will 
need to be adjusted.  Use the grips to adjust the label location.  Review the following on how to adjust 
the different types of labels.

Profile structure label

When entering dragged state for profile structure labels, the leader tends to want to attach to the 
overall center of the structure.  This tip provides a way to have the leader attach to the top center of 
the rim.

 1. Enter the dragged state by grabbing the diamond grip and moving the label.  Adjust the label 
so the anchor is near the top center of the rim.

 2. Zoom in and Grab the Diamond Grip and adjust where the leader is attached to the label (it 
doesn't matter the location, just need to adjust the leader)
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 3. While the label is selected, on the Contextual Ribbon, click Toggle Label Pin.
 4. Grab the Square Grip and adjust the label location.
 5. Near the diamond grip, click the "-" grip to reset the leader attachment.
 6. You can now adjust the label to where ever you wish and the leader will follow, but remain 

pinned to the top of the structure.

Profile pipe label - Invert labels

In areas where the standard invert labels may not work, the label must be dragged.  When this 
occurs, the leader attaches to the centerline of the pipe.  Here is the workflow to get the leader to 
"attach" to the pipe bottom.

 1. Make sure the diamond grip is snapped to the end of the pipe.
 2. Enter the dragged state by grabbing the square grip and adjusting the label to the desired loc-

ation.
 3. Adjust the diamond grip so the leader end intersections the structure edge.
 4. Click the "+" grip to add a leader vertex.  
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 5. Snap the new vertex to the bottom of the pipe at the intersection with the structure.

Adjust labels to fit profile views: Part 2

Exercise files: pln-prod-strm-swr-22-data-c3d20.zip

pln-prod-strm-swr-22.mp4 5:11

Placing labels in lateral profile views

Labels placed in smaller profile views that may be overlaying larger profile views may not look cor-
rectly because Civil 3D incorrectly sees the labels being placed in the larger profile view. 

 1. Select the larger profile views
 2. Move or Home Tab > Modify Panel > Move
 3. Move the larger profile views down so they do not overlap with the smaller profile views.
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 4. Place labels in the smaller profile views.
 5. Move the large profile views back to their original location, snapping to an upper corner of 

the bottom profile as the base point and target the lower corner of an upper profile view as 
the move point.

 A. Move or Home Tab > Modify Panel > Move

Pipes with labels outside of profile view

In cases where pipes may partially hang off of a profile view, when placing a label, the labels might 
not appear. This is because the labels get placed at the mid point of the pipe.  The profile view needs 
to be extended temporarily, to allow the label to be displayed and moved.

 1. Select the profile view displaying the pipe.
 2. Contextual Ribbon > Profile View Properties

 A. Stations Tab 
 B. Adjust the start or end station value by 100'.
 C. OK

 3. Locate/add/adjust labels as needed.
 4. Contextual Ribbon > Profile View Properties

 A. Stations Tab 
 B. Adjust the start or end station value back to the original station value.
 C. OK

Final sheet clean up

Exercise files: pln-prod-strm-swr-23-data-c3d20.zip

pln-prod-strm-swr-23.mp4 6:37

 l North Arrow
 o Visit each layout and slide the north arrow into place

 l Review title bar data (Should be automatic from Sheet Set)
 o Review that the tile bar data reads correctly.  Adjust the sheet set as needed, or add 

supplementary text.
 l Freeze Unwanted Layers

 o Home Tab > Layers Panel > Freeze
 l Profile View Display Order

 o Select all of the profile views > Right Click > Display Order > Send to Back
 l Add Proposed and Existing Surface Profile Labels

 o WisDOT Sheets > WisDOT Annotation Panel > Multileader drop-down > 070 > 
Multileader

 o Existing Ground
 o Proposed Ground

Exercise files: pln-prod-strm-swr-end-data-c3d20.zip
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Planting detail sheet
Last updated: 2021-02-19

Example sheet: 023101-pl.pdf

Create sheet
 1. Create Plan Sheet (similar to plan/profile sheet workflow here): "Plan/profile sheet" on 

page 1559
 A. Create sheet

 I. Create sheet file 023101-pl.dwg
 II. XREF edgeline files

 III. Add All Components
 IV. Add sheet layouts at 20 scale

 B. Or Create multiple sheets
 I. Create or use view frame group

 II. Create multiple sheets along project from VFG
 2. Place hatching for concrete or other materials

 A. Depending on the XREF of edgeline file you may need to NCOPY the edges of hatching 
edges into the file.

 B. Typical Section palette > Material Hatching tab
 I. Or Home > Draw > Hatch

 3. Place planting blocks
 A. Mleader 070-CIRCLE TAG, place one, remove leader, then copy for each needed plant-

ing marker.
 I. For different size plantings explode one of the mleader texts, scale command 

to adjust proper size, double-click to edit the attributes and change the text size 
to 1.4 or what is appropriate.

 4. Place label tags
 A. Mleader 070-HEX TAG

 I. Planting bed type and number (ex: M-13 for 13 of the total M-type planting 
being in an area)

 5. Place legend for tags and blocks
 A. Draw lines where legend table will be located.
 B. Copy one of each planting blocks and label tags.
 C. MTEXT for notes, planting number, and descriptions

Adding planting details to sheet
 1. Planting Detail sheet (similar to construction detail sheet here): "Construction details sheet" 

on page 1427
 A. Details drawing
 B. Mleader text
 C. Detail titles
 D. Plant schedule and material schedule tables.
 E. General Notes
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Permanent signing
Last updated: 2021-02-19

Total video time: 35:44

Sample permanent signing plan sheet: 023201-ps.pdf

WisDOT sign block features

pln-prod-prmnnt-sign-01.mp4 6:38

Palettes

WisDOT sign blocks can be found on the Signs palettes and the Permanent Signing palette.

The WisDOT Signs palettes contain face view sign blocks representative of the Sign Plates in the 
WisDOT Sign Plate manual. The blocks are organized on the palettes by their letter series des-
ignation with the exception of some M-series, S-series, and W-series signs which are grouped by func-
tion on a separate Work Zone (WZ-Signs) palette.

The WisDOT Permanent Signing palette contains plan view sign blocks used in the creation of Per-
manent Signing plan sheets. The palette also includes commands and objects such as Set Layer, 
MText, and Multileaders.

Modelspace or Paperspace

The face view sign blocks can be placed in either model space or paper space (layout tab) or both. 
There is no preferred method for placing face view sign blocks, choose the best way to convey the 
information for your particular project.

The plan view sign blocks should always be placed in modelspace.  Placing blocks in model space 
allows them to appear in other drawings when Xrefed.

Annotation can be placed in model space or paper space. Note that annotation placed in model 
space can be visible in other drawings if the drawing is xrefed. Keep this in mind when creating 
staged construction plans.

Setting a visibility state

A visibility state is a block property that allows only specific geometry to display within a block. With 
visibility states, a single block can be created that has multiple different visual representations.  A vis-
ibility state is set by selecting a block's visibility states grip.

 1. Select a sign block to reveal the AutoCAD grips.
 2. Select the light blue, inverted triangle grip on  the block.
 3. Select a visibility state from the context menu.
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Moving or rotating sign blocks

The sign blocks include the ability to easily move or rotate a sign block after it has been placed.

 1. Select a sign block to reveal the AutoCAD grips.
 2. Select the dark blue, square grip.
 3. Right-click and select Move or Rotate from the context menu.
 4. Move or rotate the block to the desired position.
 5. Esc to deselect the block.

Moving sign block text

Some sign blocks include the ability to easily move the block text.

 1. Select a sign block to reveal the AutoCAD grips.
 2. Select the light blue, square grip in the center of the text.
 3. Drag the text to the desired location and left-click to place the text.

Editing sign attributes

Attributes can be used to change text within a block without affecting other blocks in the drawing of 
the same kind. The face view sign blocks use attributes to display the editable text. Notice that the 
text shows up in two attributes lines. The “ST” attributes are meant for staging sheets so that text can 
be placed on layers for control in staging sheets. Edit both so they match. 

 1. Double-click a face view sign block.
 2. The Enhanced Attribute Editor dialog will appear.
 3. Editable text will be shown in the Attribute tab of the dialog.
 4. Select a Tag from the list and edit the value in the text box below.
 5. Apply and OK to exit the dialog.

Sign block layers

The sign blocks use multiple layers to control display and visibility.

 l E_SGN is used to place existing (remove) sign blocks.
 l E_SGN_Cell is used to display existing (remove) block geometry.
 l E_SGN_Text is used to display existing (remove) block text.
 l P_SGN is used to place proposed (install) sign blocks.
 l P_SGN_Cell is used to display proposed (install) block geometry.
 l P_SGN_Text is used to display proposed (install) block text.
 l ST_SGN_Cell and ST_SGN_Text are used to control block display for staged construction plan 

sheets.

Create permanent signing plan sheets

Exercise files: pln-prod-prmnnt-sign-data-begin-c3d20.zip
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Placing face view sign blocks

pln-prod-prmnnt-sign-02.mp4 5:42

Face view sign blocks are placed in Model Space by clicking through a viewport in the layout.

 1. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Signs
 2. Tool Palette > XX-Signs tabs
 3. Set a sign layer to be current.
 4. Select a Layout tab.
 5. Double-click inside the viewport.
 6. Set the UCS to View. 

 A. UCS Enter
 B. VEnter

 7. Select a sign block from the palette and left-click to place in the viewport.
 8. Set a visibility state.
 9. Double-click the sign block to bring up Enhanced Attribute Editor dialog box and edit text as 

needed.
 10. Use AutoCAD grips to move block or block text as needed.

Using "J" Sign assembly blocks

pln-prod-prmnnt-sign-03.mp4 3:44

"J" Sign assembly blocks are used to facilitate creating multiple sign layouts.

 1. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Signs Tool Palette > J-Signs tabs
 2. Select a "J" Sign assembly block from the palette and place it in the drawing.
 3. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Signs Tool Palette > XX-Signs 

tabs
 4. Select a face view sign block from the palette and place it into the "J" Sign assembly block.

Tip: Use midpoint, endpoint, or insertion Osnaps to precisely place face view sign blocks into 
the "J" Sign assembly block.

Placing plan view sign blocks

pln-prod-prmnnt-sign-04.mp4 4:25

Plan view sign blocks are placed in Modelspace by clicking through a viewport in the layout.

 1. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Sheet layouts dropdown > Sign-
ing and Marking

 2. Tool Palette > Permanent Signing palette tab
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 3. Insert a single plan view sign block
 A. Use the layer buttons in the palette to set the current layer.
 B. Select a plan view sign block from the palette.
 C. Left-click to place the block.
 D. Select the block.
 E. Select the dark blue, square grip.
 F. Right-click and select Rotate from the context menu.
 G. Use the cursor to rotate the block and left-click to set the rotation angle.
 H. Set a visibility state.

 4. Insert multiple plan view sign blocks
 A. Set the UCS in the viewport to align with the roadway.

 I. Ribbon > View tab > Coordinates panel > 3 Point button
 II. Left-click to place the origin of the UCS.

 III. Rotate the cursor around the origin point to align the X-axis with the roadway. 
Left-click to set X-axis.

 IV. Set the Y-axis by choosing either above or below the X-axis (depending on the 
direction of travel).

 B. Use the layer buttons in the palette to set the current layer.
 C. Select a plan view sign block from the palette.
 D. Left-click to place the block. (Block will come in aligned with the UCS at a com-

plimentary rotation angle).
 E. Set a visibility state.
 F. Repeat steps C-E to place multiple blocks.

Add multileader reference tags

pln-prod-prmnnt-sign-05.mp4 2:15

Multileader reference tags are placed in Model Space by clicking through a viewport in the layout.

 1. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Sheet layouts dropdown > Sign-
ing and Marking Tool Palette > Permanent Signing palette tab

 2. Use the layer buttons in the palette to set the current layer.
 3. Select a Layout tab.
 4. Double-click inside the viewport.
 5. Set the UCS to View. 

 A. UCSEnter
 B. VEnter

 6. Select the 070-OVAL TAG multileader from the palette.
 7. Left-click to place the oval tag.
 8. Enter the tag number.
 9. OK

Add sign legend to layout

pln-prod-prmnnt-sign-06.mp4 4:09
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Create a clipped viewport

 1. Select a Layout tab.
 2. Double-click outside the viewport to enter paper space.
 3. Turn on Selection Cycling.

 A. Type: SELECTIONCYCLING
 B. Type: 2

 4. Select the viewport border.
 5. The Selection Cycling Menu will appear.
 6. Select Polyline.
 7. The viewport polyline grips will appear.
 8. Hover over a midpoint grip on either the right or left side and select Add Vertex.
 9. Hold down Shift and right-click to bring up the Osnap menu.

 10. Select a location directly above or below the midpoint grip by using the nearest Osnap.
 11. Hover over a midpoint grip on either the top or bottom and select Add Vertex.
 12. Hold down Shift and right-click to bring up the Osnap menu.
 13. Select a location directly right or left of the midpoint grip by using the nearest Osnap.
 14. Select the square grip in between the two new vertexes and drag towards the middle of the 

viewport.
 15. Left-click to create the clipped viewport.
 16. Grip edit the viewport to create the desired size and shape.

Place the sign legend block

 1. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Sheet layouts dropdown > Sign-
ing and Marking

 2. Tool Palette > Permanent Signing palette tab
 3. Scroll and select the Sign Legend block.
 4. Left-click to place the block in the white space area of the clipped viewport.
 5. EXPLODE the Sign Legend block.
 6. Add/Remove/Edit symbols and text as needed.
 7. Type: GROUP. (The AutoCAD GROUP command combines selected objects so they can be acted 

upon as a unit.)
 8. Select all the objects that make up the Sign Legend.
 9. Enter

 10. An unnamed group is created.
 11. Select the Sign Legend group.
 12. Right-click > Clipboard > Copy and Right-click > Clipboard > Paste the Sign Legend group 

to other Layout tabs as needed.

Tip: Use the EDITGROUP or UNGROUP commands to add/remove group objects or to explode 
the group.

Create permanent signing sheets for staged construction
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pln-prod-prmnnt-sign-07.mp4 8:51

Requirement: Create an individual permanent signing plan sheet for each construction stage.

Info: Face view sign blocks use ST_SGN_Cell and ST_SGN_Text layers to control sign block dis-
play in staged construction plan sheets.

Create individual plan sheets

 1. Create a permanent signing plan sheet for Stage 1. (023201-ps1.dwg)
 2. Place sign blocks, set visibility states, and edit attributes as needed. Be sure to set attribute 

values for the "ST" tags.
 3. Set staged layer visibility.

 A. LAYER The Layer Properties Manager will open.
 B. Find layers ST_SGN_Cell and ST_SGN_Text in the list. Notice the default display is off.
 C. Click the light bulb icon for each layer to turn them on.
 D. Find layers P_SGN_Cell and P_SGN_Text in the list. Notice the default display is on.
 E. Click the light bulb icon for each layer to turn them off.

 4. SAVEthe drawing.
 5. Repeat steps 1-4 to create separate permanent signing plan sheets for each subsequent con-

struction stage (023201-ps2.dwg, 023201-ps3.dwg, etc.).

Xref staged construction plan sheets

 1. Open the Stage 2 permanent signing plan sheet drawing.
 2. Ribbon > WisDOT Design tab > Manage panel > Load Xref on Layer
 3. Browse to and select the Stage 1 permanent signing plan sheet drawing.Open
 4. LAYER The Layer Properties Manager will open.
 5. In the upper right corner of the Layer Property Manager, type: *ST_SGN* in the layer search 

filter box.
 6. The stage construction sign block layers will be listed. (Stage 1 layers will be prefixed by the 

xref filename.)
 7. Turn layers on as needed to display staged sign blocks.
 8. Change Layer Color setting as needed to control plot display.

Tip: Double-click inside a viewport before opening the Layer Property Manager to 
change layer settings for the active viewport only.

 9. SAVEthe drawing.
 10. Repeat steps 1-10 for each stage. (Xref Stage 2 into Stage 3, then xref Stage 3 into Stage 4, 

etc.)

Exercise files: pln-prod-prmnnt-sign-data-end-c3d20.zip

Traffic signal plan sheet and phasing
Last updated: 2021-02-16
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Example sheets: 024201-sp.pdf, 024301-ph.pdf

Setup traffic signal plan sheet
 1. Start a new file using the design-start.dwt.
 2. Save file as <proj num>/Sheets Plan/024201-sp.dwg
 3. WisDOT Sheets ribbon > Support panel > Palettes ON/OFF
 4. WisDOT Sheets > Sheet Creation panel > Sheets Layout
 5. Sheets Layout tab > 02-Plan Details 1=40 (02-PD-wdot)
 6. At command line type 01 ENTER
 7. WisDOT Sheets > Sheet Creation panel > Sheets Layout drop-down > Lighting and Sig-

nals
 8. Lighting and Signal tool palette > Traffic Signal Plan tab > Blocks – Signal Legend & 

Title Blocks area
 9. Select Title Block – Signal Page 1 – 3 Lines.

 A. In paperspace snap to the lower right corner of drafting area.
 B. Fill in Attributes dialog with appropriate data.

Add traffic signal plan sheet data
 1. Create viewport for view of model space.
 2. Add north arrow and rotate appropriately.
 3. Add blocks from Traffic Signal Plan tool palette to model area.
 4. Add Legend – Signal Plan block from Traffic Signal tool palette to sheet
 5. Add other blocks and annotation as needed.

Setup traffic signal phasing sheet
 1. WisDOT Sheets ribbon > Support panel > Palettes ON/OFF
 2. WisDOT Sheets > Sheet Creation panel > Sheets Layout drop-down > Lighting and Sig-

nals
 3. Lighting and Signal tool palette > Traffic Signal Phasing tab > Sheet Layouts area > 

Phasing Sheet Layout
 A. At command line type SEQUENCE ENTER

 4. Traffic Signal Phasing tab > Signature Blocks area select Title Block – Signal PG2 – 3 
Lines

 A. In paperspace snap to the lower right corner of drafting area.
 B. Fill in Attributes dialog with appropriate data. OK

Add phasing data tables and data
 1. Add table blocks from Traffic Signal Phasing tool palette > Dynamic Tables

 A. These table blocks are dynamic with visibility states for different selection com-
binations. Select the down-arrow dynamic grip to choose the marked combinations.
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 2. Add tables from Traffic Signal Phasing tool palette > Other Tables
 A. Add and change data in these tables through Block Editor.
 B. Add dynamic blocks from Traffic Signal Phasing tool palette > Phasing Table 

Dynamic Components to the tables while in the Block Editor.
 C. Add text, blocks, and manually created tables as needed.

Pavement marking sheet
Last updated: 2020-12-02

Example sheet: 024501-pm.pdf

Create the pavement marking sheet file

Info: The Pavement Marking file needs to have plan sheets made so that the markings can be 
displayed across the entire project. This process begins with creating a plan only sheet file.

Add WisDOT Standards Components and set annotation scale

 1. To create a new file, Quick Access Toolbar > New.
 2. SAVEthe file as <project>\SheetsPlan\xxxxxx-pm.dwg
 3. Ribbon > WisDOT Sheets tab > Standards Components panel > Add All Components

 4. Click the Model tab near the bottom left corner of the Civil 3D application window.

 5. Click the Annotation Scale dropdown arrow in the status bar near the bottom of the Civil 3D 
application window and select 1 IN:50 FT (Select scale appropriate for the sheet in the pro-
ject.)
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 6. SAVE the file.                     

Create view frames for the pavement marking sheet file

Info: View Frames are defined areas in model space along an alignment that can be used to 
create layout sheets with a view frame area automatically centered to scale in a viewport. A 
View Frame Group is a collection of View Frames used to create an automated sheet set of mul-
tiple layouts containing predefined viewports. View Frame Groups can also be data referenced 
to create sheet sets in other drawings.

 1. To create a new file, type QNEW at the command line.
 2. SAVEthe file as <project>\Design\View Frames\xxxxxx-vf.dwg
 3. Data Reference into the file the primary alignment that the view frames will be created along.
 4. Create View Frames. Make sure to create view frames that are the same scale that is used in 

the pavement marking sheet file.
 5. SAVE the file.
 6. Create a Data Shortcut for the view frame group.
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 7. SAVE the file.
 8. Data Reference the View Frame Group into the Pavement Marking sheet file xxxxxx-pm.dwg.

(Alternatively, if the View Frames are not likely to be shared among other drawings, the View 
Frames can be created directly in the Pavement Marking sheet file.)

Create the pavement marking design file

Tip: This file will be Xref’d into <project>\SheetsPlan\024501-pm.dwg when complete.

 1. To create a new file, type QNEW at the command line.
 2. SAVEthe file as <project>\Design\View Frames\PM.dwg
 3. Ribbon > WisDOT Sheets tab > Standards Components panel > Add All Components
 4. Set the model space annotation scale to 1 IN:50 FT.
 5. Xref the edgeline file into the pavement marking design file using the WisDOT Load Xref on 

Layer tool. 
 A. Ribbon > WisDOT Sheets tab > Manage panel > Load Xref on Layer
 B. Browse to the project’s Edgeline folder and select the Edgelines.dwg.

 6. Zoom extents (ZE)to see the drawing data.
 7. SAVE the file.

Add design elements to the pavement marking design file

Place pavement marking lines using the Pavement Marking tool palette

 1. Open In the PM.dwg file.
 2.  Ribbon > WisDOT Sheets tab > Sheet Creation panel > Sheet Layouts dropdown > Sign-

ing and Marking
 1. The SIGNING AND MARKING palette group will load in the Tool Palette. Select the Pave-

ment Marking tab.

Tip: If palette does not appear... Ribbon > WisDOT Sheets tab > Support panel > 
Palettes ON/OFF

 2. Scroll through the list and select Lane Line (12.5’-37.5’).
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 3. The correct layer  is preset and the PLINE command will automatically begin.
 4. Draw the polyline in the intended location.

Requirement: Pavement Marking linetypes are "True scale linetypes". Objects that are 
set to a True scale linetype must have the object Linetype scale set to the inverse of 
the annotation scale or inverse of the viewport scale in order to display properly.

 5. Select the pavement marking line, right-click, and select Properties.... The Properties palette 
will open.

 6. In the Properties palette, change the Linetype scale value to the inverse of the annotation 
scale or the viewport scale. In this example, for an annotation scale of 1 IN 50 FT the object 
Linetype scale value would be typed as 1/50 -or- 0.02.
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Place pavement marking lines manually

 1. Open the PM.dwg file.
 2.  Set P_PM_6 as the current layer. Ribbon > Home tab > Layers panel > Layers dropdown 

list
 3. Draw a polyline (PLINE) for the first crosswalk line.
 4. OFFSET the polyline 6 FT  to create the other crosswalk line.

Place blocks for painted markings

Info: The blocks in the palette are preset to Layer 0. This will allow the block to take on the set-
tings of whatever the active layer is at the time of insertion.

 1. Open the PM.dwg file.
 2. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Sheet Layouts dropdown > Sign-

ing and Marking.
 3. The SIGNING AND MARKING palette group will load in the Tool Palette. Select the Pave-

ment Marking tab.
 4. Scroll down the palette to the Pavement Marking Painted Arrows section.
 5. Select Arrow PM – LT Type 2 and place it in the drawing.
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 6. After placing the block in location, it will prompt for the rotation angle. Rotate the block to the 
proper orientation.

 7. Repeat to place another block in the drawing.

Xref pavement marking design files into pavement marking sheet file

Xref Edgeline and PM file into pavement marking sheet file

 1. Open the <project>\SheetsPlan\xxxxxx-pm.dwg file.
 2. Xref the Edgeline and PM files into the pavement marking design file using the WisDOT Load 

Xref on Layer tool. 
 A. Ribbon > WisDOT Sheets tab > Manage panel > Load Xref on Layer
 B. Browse to the project’s Edgeline folder and select the Edgelines.dwg.
 C. Ribbon > WisDOT Sheets tab > Manage panel > Load Xref on Layer
 D. Browse to the project’s Edgeline folder and select the PM.dwg.

 3. Zoom extents (ZE)to see the drawing data.

Set Edgeline Xref layer colors

Create a layer state to save the original layer settings

 4. LAYERSTATE Enter to open the Layer States Manager.
 5.  New... Name this Layer State Pre-XREF Gray. OK
 6. Close to exit the Layer States Manager.
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Set the objects in the Edgeline Xref to appear gray

 7. WisDOT Sheets tab > Manage panel > Layers dropdown > Convert Layer Colors
 A. Filters: Roadway-xref
 B. Layers: Select All
 C. Convert Color Definition

 I. User Defined Color: selected
 II. Choose Color 252 OK

 III. Apply

Create a layer state to save the new layer settings

 8. Type LAYERSTATE and press Enter to open the Layer States Manager.
 9. Click New.... Name this Layer State Post-XREF Gray.

 10. Click OK.
 11. Click Close to exit the Layer States Manager.
 12. SAVE the file.

Annotate pavement marking sheet file

Label lines with multileaders

 1. Ribbon > Home tab > Layer panel > Layer dropdown, scroll and select P_MISC_Text.
 2. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Sheet Layouts dropdown > Sign-

ing and Marking
 3. The SIGNING AND MARKING palette group will load in the Tool Palette. Select the Pave-

ment Marking tab.
 4. In the Multileaders section at the top of the palette, select 070-CIRCLE TAG to place a mul-

tileader in the drawing, pointing to one of the pavement marking lines. (The first click places 
the location of the arrowhead and the second click places the landing and tag location.)

 5. In the Edit Attributes dialog, enter 1 for the tag number and click OK.

Add a intersection station label

 6. Ribbon > Annotate tab > Labels & Tables panel > Add Labels dropdown > Notes
 7. In the Add Labels dialog box, select Intersection - Description from the "Note label style:" 

dropdown.
 8. Click Add.
 9. Select the first alignment.

 10. Select the second alignment.
 11. Right-click to place the label.
 12. Select the new label and use the diamond grip to drag it to an appropriate location.
 13. Select the intersection note, right-click Edit Label Text..., and change the text to the correct 

station data.
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Create legend(s) for linetype descriptions, materials

Place legend title

 14. Switch to the layout tab for the sheet.
 15. Double-click inside the viewport to activate the viewport and access Model Space.
 16. Type UCS at the command line, type V for view and hit Enter.
 17. Ribbon > Home tab > Layer panel > Layer pull-down, scroll and select P_MISC_Text.
 18. Ribbon > WisDOT Sheets tab > WisDOT Annotation panel dropdown > Set WisDOT 

Textstyle/Size
 19. The WisDOT Annotate palette will open.

 A. Set the textstyle to CalibriLight.
 B. Set the height to 0.070.
 C. Click Open Annotate Ribbon.
 D. Close the WisDOT Annotate palette.

 20. Ribbon > Annotate tab > Text panel > Multiline Text dropdown > Multiline Text
 21. Click in the drawing area to create a bounding box for the Mtext.
 22. Type PAVEMENT MARKING LEGEND.

Place tag block in the legend

 23. Type INSERT at the command line. The BLOCKS palette will open.

Tip: The BLOCKS palette is a new addition to Civil 3D 2020. The INSERT command now 
opens the new BLOCKS palette instead of opening the Insert dialog box. If you prefer to 
use the legacy Insert dialog box, type CLASSICINSERT at the command line.

 24. Select the Current Drawing tab.
 25. Under Insertion Options, checkmark Insertion Point and leave the rest of the boxes 

unchecked. 
 26. Scroll to find _TagCircle070 in the list and click to select.
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 27. Insert the block underneath the PAVEMENT MARKING LEGEND text.
 28. In the Edit Attributes dialog, enter 1 for the tag number and click OK.
 29. To the right of the circle tag Place a line manually that corresponds next to the circle tag

Place arrow block in the legend

 30. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Sheet Layouts dropdown > Sign-
ing and Marking.

 31. The SIGNING AND MARKING palette group will load in the Tool Palette. Select the Pave-
ment Marking tab.

 32. Scroll down the palette to the Pavement Marking Painted Arrows section.
 33. Select Arrow PM – LT Type 1 and place it in the legend below the circle tag.
 34. When prompted for rotation, type 0 and hit Enter.
 35. Select Arrow PM – LT Type 2 and place it in the legend below the Arrow PM – LT Type 1 

arrow.
 36. When prompted for rotation, type 0 and hit Enter.
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Place legend text 

 37. Ribbon > Annotate tab > Text panel > Multiline Text dropdown > Multiline Text
 38. Create a bounding box for the Mtext to the right of the Arrow blocks.
 39. Type ARROWS EPOXY TYPE 1 (white).
 40. Hit <enter> twice. Enter Enter.
 41. Type ARROWS EPOXY TYPE 2 (white).
 42. Click an empty space in the drawing area  outside the Multiline Text Editor to end the com-

mand.
 43. MOVE the MText and/or the Arrow blocks so they line up together.
 44. SAVE the file.

Create sheet layouts and add to sheet set

Create sheet layouts

 1. Open the <project>\SheetsPlan\xxxxxx-pm.dwg file.
 2. Ribbon > Output tab > Plan Production panel > Create Sheets

 A. Create sheet  layouts from the view frame group.
 I. Create Sheets dialog box > View Frame Group and Layouts page

 a. View frame range: All
 b. Layout Creation: All layouts in the current drawing

 II. Create Sheets dialog box > Sheet Set page
 a. Sheet Set: Add to existing sheet set
 b. Select the ellipsis button ….
 c. Browse to <project>\SheetsPlan\xxxxxx.dst

 B. New sheet layouts will be created and the Sheet Set Manager will open with the new 
layouts included in the list.

Adjust the location of the layouts in the sheet set list

 3. Right-click on the 02- subset and select Create Subset.
 4. Type PAVEMENT MARKING and click OK.
 5. Select all the sheet layouts from the xxxxxx-pm.dwg drawing.
 6. Drag and drop the layouts up to the new PAVEMENT MARKING subset.

Info: Dragging and dropping the layouts can be tricky. When layouts are correctly 
dropped in a subset, the subset name will highlight in blue and the layout names will 
tree out under the subset.

 7. SAVE the file. (The title block text will update so it reads the sheet set subset name, 
PAVEMENT MARKING.)

Traffic control / Stage construction
Last updated: 2022-05-13

Total video time: 1:37:09
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Sample detail sheet: 026001-s1.pdf

Reference overview

pln-prod-trffc-cntrl-stg-cnstrctn-01.mp4 3:50

During this process we will be referencing several sources of information for design standards. 
These include the FDM Standard Detail Drawings, Bid Items list, and the Wisconsin Manual on Uni-
form Traffic control Devices (which you may know as WMUTCD). It may be a good idea to have these 
sources open or readily available.

 1. Traffic Control Standard Detail Drawings, specifically in the 15D section.
 A. SDD 15D20-b Traffic Control, Single Right Lane Closure, Undivided Non-Free-

way/Expressway
 B. SDD 15D22 Traffic Control, Two Lane Closure, Divided Non-Freeway / Expressway
 C. SDD 15D06 Traffic Control, Two Lane Two Way Operation
 D. SDD 15C11-a Channelizing Devices, Flexible Tubular Marker Post

 2. Bid Items can provide the object naming as we label the sheet.
 A. Standard Bid items To label the pavement marking and call outs.

 I. For object naming
 3. Wisconsin Manual on Uniform Traffic Control Devices (WMUTCD)

 A. This is available as a website
 B. We will be using Chapter 6

 I. 6C-2 Types of Tapers and Buffer Spaces (p. 14)

Plan sheet

pln-prod-trffc-cntrl-stg-cnstrctn-02.mp4 6:37

 1. QNew to create a new file
 2. Quick Access toolbar > Save As

 A. Save Drawing As dialog box
 B. Save in: Browse to PDS\C3D\11701970\SheetsPlan
 C. File name: Rename to 026001-s1.dwg
 D. Save

 3. Ribbon > WisDOT Sheets tab > Standard Components panel > Add All Components
 4. Ribbon > WisDOT Sheets tab > Manage panel > Load Xref on Layer

 A. Select a file to Xref dialog box
 I. Look in: Go up one folder level to 11701970

Tip: Next to the browse dropdown are several icons.  One is a folder with 
an up arrow.  Use this to go up one folder from the current one selected.

 II. Basedata folder > TopoEx.dwg
 III. Open

 B. Zoom+Extents to see drawing
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 5. Ribbon > WisDOT Sheets tab > Manage panel > Load Xref on Layer
 A. Select a file to Xref dialog box

 I. Look in: Go up one folder level to 11701970 > Design folder > Edgelines 
folder > SI.dwg

 II. Open
 6. Ribbon > WisDOT Sheets tab > Manage panel > Load Xref on Layer

 A. Select a file to Xref dialog box
 I. Look in: Go up one folder level to 11701970 > Design folder > Edgelines 

folder > SI.dwg

Info: This is a file that has only the design surface set to the SI style to dis-
play the slope intercept. We are XREFing it, but you could choose to DREF 
the top design surface and change the style to SI. If you don’t have this 
surface yet it is recommended that you create that prior to continuing.

 II. Open
 7. REA (Regen all)
 8. Toolspace > Prospector tab > Data Shortcuts ( …\PDS\C3D\11701970) > Alignments > 

Centerline Alignments

Warning: Make sure the correct project folder is listed.

 A. Right-click 51-Ex > Create Reference
 I. Create Alignment Reference dialog box

 a. Alignment Style: ALI Existing (No Markers)
 b. Alignment Label Style: No Labels
 c. OK

 B. Right-click 51 > Create Reference
 I. Create Alignment Reference dialog box

 a. Alignment Style: ALI Proposed
 b. Alignment Label Style: 1IN 40FT-Ticks 100’ Major
 c. OK

 9. Toolspace > Prospector tab > Surfaces
 A. Right-click Crdr-604+80 Pipe – Datum > Create Reference

 I. Create Surface Reference dialog box
 a. Style: No Display
 b. OK

 10. Toolspace > Prospector tab > Data Shortcuts > Pipe Networks
 A. Right-click 605+00 > Create Reference

 I. Keep defaults
 II. OK

 11. Zoom project to review
 A. Toolspace > Prospector tab > Surfaces

 I. Right-click Crdr-604+80 Pipe – Datum > Zoom to
Save project.
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Establish work area

pln-prod-trffc-cntrl-stg-cnstrctn-03.mp4 7:14

 1. Rotate the UCS so project is horizontal
 A. Ribbon > View tab > Coordinates panel > 3 Point
 B. Shift + right-click > OSnap Nearest > select on alignment
 C. Repeat,Shift + right-click > OSnap Nearest > select on alignment a distance away 

from first selection.
 D. Click a third time, west of the alignment, to set which side +Y is on.
 E. Commandline:PLAN Enter
 F. Enter an option:CEnter

 2. Set Layer
 A. Ribbon > Home tab > Layers panel > Layer dropdown > P_MISC_NoPlot

 3. Draw line along the alignment slightly longer then work area dashed line.

Tips: 
We will draw construction lines to find distances on this layer so if we forget to delete 
them, they will not appear in plots.

We will use LINES for the construction lines and POLYLINES for the design geometry 
because this will make it easier to delete the construction lines later.

 A. Ribbon > Home tab > Draw panel > select Line > Create Line
 B. Shift + right-click > Nearest OSnap, select on Centerline (CL) alignment
 C. Repeat, Shift + right-click > Nearest OSnap, select on CL alignment a distance away 

from first selection.
 D. Enter

 4. Create offset line to just north of the OH linework.
 A. Ribbon > Home tab > Modify panel > select Offset command
 B. Specify offset distance: Click construction line.
 C. Specify second point: Click north of OH electric line.
 D. Select object to offset: Click construction line

 I. Selection menu > Line
 E. Specify point on side to offset: Select to the north of construction line.

 5. Set layer
 A. Ribbon > Home tab > Layers panel > Layer dropdown > select P_STGCONST_1 

Info: This was added to the file during the Add All Components tool. If you don’t 
have this layer run that tool to fill in all the needed components. Ribbon > 
WisDOT Sheets tab > Standard Components panel > Add All Components

 6. Draw polylines around work area.
 A. Ribbon > Home tab > Draw Panel > select Polyline tool
 B. Draw polylines along the dashed lines from Centerline alignment, out to outside edge 

of work area, including an angle polyline where the work area is not as wide. Use 
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OSnap Nearest to connect to construction lines.
 C. Commandline:C to close shape

 7. Delete construction lines
 A. Shift + Select both lines, Selection menu select Line, and Delete

 8. Hatch the area.
 A. Ribbon > Home tab > Draw Panel > select Hatch tool
 B. Hatch Tool ribbon

 I. Pattern panel, select ANSI31
 II. Properties panel, Properties scale: 40 (to match drawing scale)

 III. Boundaries panel, Select
 a. Select polyline just created

 IV. ESC
 9. Label work area

 A. Ribbon > Annotate tab > Text panel
 I. Text size: 0.0700

 II. Font: CalibriLight
 B. Select Multiline Text
 C. Draw text box inside work area, type WORK AREA

 10. Edits to text box
 A. Use diamond slider to adjust size, frames just the words.
 B. Select text > Right-click menu > Properties

 I. Text dropdown
 a. Text frame: Yes
 b. Background mask: Yes

 i. Check box Use background mask
 ii. Check box Use a drawing background color
 iii. OK

 C. Select text > right-click menu > Display Order > Bring to Front
 D. Select text > Selection, select MText and move to final placement.

Save project.

Existing pavement markings

pln-prod-trffc-cntrl-stg-cnstrctn-04.mp4 7:11

Verify existing pavement markings are in the file

 1. There are 2 centerline alignments.  Need to hide Proposed 51 alignment.
 A. Select centerline alignment > Selection, select first alignment
 B. Ribbon > Modify panel > Alignment properties

 I. Alignment Properties dialog box
 a. Verify alignment name is 51.  That is the proposed alignment.
 b. Cancel to close.

 C. With the alignment highlighted > right-click menu > Isolate objects > Hide Selec-
ted Objects
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 2. Create a new layer
 A. Ribbon > Home tab > Layers panel > Layers Properties
 B. Layer Properties Manager

 I. Search for E_PM
 II. Select E_PM layer

 III. Clear Search bar
 IV. Select New Layer icon
 V. Rename new layer: E_PM_Centerline

 VI. Linetype: ContinuousOK
 VII. Lineweight: 0.020"OK

 VIII. Select E_PM layer
 IX. Select New Layer icon
 X. Rename new layer: E_PM_4

 XI. Linetype: PM1OK
 XII. Lineweight: 0.020"OK

 XIII. Close Layer Manager
 3. Add offset lines 5'

Info: Reference SDD 15C08-a to indicate space between offset lines. Offset alignment 
5” (0.41667’ or round up to 0.42’) on both sides of alignment.

 A. Ribbon > Home tab > Modify panel > Offset command
 B. Specify offset distance:0.42
 C. Select object to offset: Select centerline.
 D. Specify point on side to offset: Click to the north.
 E. Select object to offset: Select centerline.
 F. Specify point on side to offset: Click to the south.
 G. Enter
 H. Select both offset lines.
 I. Ribbon > Home tab > Layers panel > Layers dropdown > select E_PM_Centerline

 4. Add offset lines 12’ (4 lines total; 2 north and 2 south of centerline)
 A. Ribbon > Home tab > Modify panel > Offset command
 B. Specify offset distance:12
 C. Select object to offset: Select centerline.
 D. Specify point on side to offset: Click to the north.
 E. Select object to offset: Select new offset line.
 F. Specify point on side to offset: Click to the north.
 G. Select object to offset: Select centerline.
 H. Specify point on side to offset: Click to the south.
 I. Select object to offset: Select new offset line.
 J. Specify point on side to offset: Click to the south.

 K. ESC
 5. End object isolation of Proposed 51 alignment.

 A. Right-click menu > Isolate Objects > End Object Isolation
 6. Need to offset median lines 5”

 A. Ribbon > Home tab > Modify panel > Offset command
 B. Specify offset distance:0.42
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 C. Select object to offset: Select first 12’ offset line south of centerline.
 D. Specify point on side to offset: Click to the north.
 E. Select object to offset: Select first 12’ offset line north of centerline.
 F. Specify point on side to offset: Click to the south.
 G. Right-click menu > Enter
 H. Select both original offset lines and delete
 I. Select both new offset lines
 J. Ribbon > Home tab > Layer panel > Layers dropdown > select E_PM_4

 K. Edit Linetype scale 
 I. Select offset lines > Right-click menu > Properties

 II. Properties palette
 a. Linetype scale: 1/40 (or 0.0250)

 III. Close Properties palette
 L. ESC

Save project.

Establish horizontal lane shift geometry, part 1

pln-prod-trffc-cntrl-stg-cnstrctn-05.mp4 4:19

When determining the lane shifts each project is going to be unique and you’ll need to do some 
investigating specific to the project you’re working on.

 l Reference SDD 15D20-b, SDD15D22 
 o Buffer Space = 220’
 o Taper Length = 540’ per lane

 l Reference WMUTCD 6C-2 Types of Tapers and Buffer Spaces
 o Shifting Taper = 1/2 Taper Length

Info: Since there is an intersection with one lane becoming 2 to the east, we will 
block the inside lane so that we can use the “shifting taper” instead of “merging 
taper.”

Buffer space and taper length for southbound lane, north side of work area

 1. Ribbon > Home tab > Layer panel > Layers dropdown > select P_MISC_NoPlot
 2. Ribbon > Home tab > Draw panel > Line command > Create Line
 3. Specify first point: Endpoint OSnap, select NW corner of Work Area
 4. Specify next point: Endpoint OSnap, select NE corner of Work Area
 5. Right-click menu > Enter
 6. Select line, Selection > Line
 7. Hover over end grip point, right-click menu > Lengthen
 8. Repeat to other end grip point
 9. Select construction line

 10. Ribbon > Home tab > Modify panel > Offset command
 11. Specify offset distance:220
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 12. Select point on side to offset: Click right of construction line.
 13. Right-click menu > Enter
 14. Select new construction line
 15. Ribbon > Home tab > Modify panel > Offset command
 16. Specify offset distance:540
 17. Select point on side to offset: Click right of construction line.
 18. Right-click menu > Enter

Save project.

Establish horizontal lane shift geometry, part 2

pln-prod-trffc-cntrl-stg-cnstrctn-06.mp4 5:11

Establish lane shift geometry southbound lane, north side of work area

 1. Delete edge of pavement, this is the second set of offset lines created, from both sides of the 
centerline.

 2. Create transition lane
 A. Ribbon > Home tab > Draw panel > Line command > Create Line
 B. Specify first point:Shift + right-click > Apparent Intersect OSnap, select 

intersection where edge of roadway meets 540’ offset line, left of centerline.
 C. Specify next point:Shift + right-click > Apparent Intersect OSnap, select inter-

section where centerline meets 220’ buffer offset.
 D. Enter to close
 E. Ribbon > Home tab > Modify panel > Offset command
 F. Specify offset distance:12
 G. Select object to offset: Select line, Selection > Line
 H. Select point on side to offset: Click right of line.
 I. Right-click menu > Enter

 3. Close off transition lane with curve.

Info: In this case, line has to be an arc since it is on a curve.

 4. Ribbon > Home tab > Draw panel > Arc command
 5. Specify start point of arc: Select intersection where median meets 540’ offset line, 

left of centerline.
 6. Specify second point of arc:Shift + right-click > Nearest OSnap, click a point at 

half the distance.
 7. Specify end point of arc:Shift + right-click > Nearest OSnap, click a second point at 

the final length.

Establish lane shift geometry southbound lane, south side of work area

 1. Buffer space and taper length for southbound lane
 A. Ribbon > Home tab > Draw panel > Line command > Create Line
 B. Specify first point: Endpoint OSnap, select SE corner of Work Area.
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 C. Specify next point: Endpoint OSnap, select SW corner of Work Area.

Tip: Make sure you snap to the endpoint of the work area because there is elev-
ation.

 D. Right-click menu > Enter
 E. Select line, Selection > Line
 F. Hover over last grip point (west) > Lengthen
 G. Repeat to the east grip point
 H. Select construction line
 I. Ribbon > Home tab > Modify panel > Offset command
 J. Specify offset distance:100

 K. Select point on side to offset: Click left of construction line.
 L. Right-click menu > Enter

 M. Select new construction line
 N. Ribbon > Home tab > Modify panel > Offset command
 O. Specify offset distance:200
 P. Select point on side to offset: Click left of construction line.
 Q. Right-click menu > Enter

 2. Create merging taper on southbound lane (Reference WMUTCD 6C-2)
 A. Ribbon > Home tab > Draw panel > Line command > Create Line
 B. Specify first point:Shift + right-click > Apparent Intersect OSnap, select 

intersection where edge of pavement meets 200’ construction line, left of centerline.
 C. Specify next point:Shift + right-click > Apparent Intersect OSnap, select inter-

section where centerline meets 100’ construction line.
 D. Right-click menu > Enter

 3. Create shifting taper on southbound lane (Reference WMUTCD 6C-2)
 A. Ribbon > Home tab > Modify panel > Offset command
 B. Specify offset distance:270
 C. Select object to offset: Select 100’ construction line.
 D. Select point on side to offset: Click left of construction line.
 E. Right-click menu > Enter
 F. Ribbon > Home tab > Draw panel > Line command > Create Line
 G. Specify first point:Shift + right-click > Apparent Intersect OSnap, select 

intersection where new construction line meets centerline.
 H. Specify next point:Shift + right-click > Apparent Intersect OSnap, snap to 

lane line first, then snap to 100’ construction line.
 I. Right-click menu > Enter

Save project.

Establish horizontal lane shift geometry, part 3

pln-prod-trffc-cntrl-stg-cnstrctn-07.mp4 6:26
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Draw polylines over southbound construction lines

 1. Starting at south side of work area, left side construction lines, create a continuous polyline 
from one transition to the other, including an arc line in the middle for the curve.

 A. Ribbon > Home tab > Draw panel > Polyline command
 B. Specify start point: Endpoint OSnap on first point at beginning of transition.
 C. Specify next point: Endpoint OSnap close to construction line meets centerline.
 D. Specify next point: Endpoint OSnap at PC.
 E. Specify next point: Type A (arc), Endpoint OSnap at the start of transition out.
 F. Specify next point: Type L (line), Endpoint OSnap at end of transition.
 G. Right-click menu > Enter

 2. Create polyline for the right side construction lines
 A. Ribbon > Home tab > Draw panel > Polyline command
 B. Specify start point: Endpoint OSnap on first point at beginning of transition.
 C. Specify next point: Endpoint OSnap close to construction line meets centerline.
 D. Specify next point:Shift + right-click > Nearest OSnap, click a point on the 

median line, inline with PC.
 E. Specify next point: Type A (arc), Endpoint OSnap at the start of transition out.
 F. Specify next point: Type L (line), Shift + right-click > Apparent Intersect OSnap, 

click where construction line meets centerline.
 G. Specify next point: Endpoint OSnap at end of transition.
 H. Right-click menu > Enter

 3. Delete all construction lines
 A. Select a construction line, Selection > Line
 B. Right-click menu > Select Similar
 C. Delete

Buffer space and merging taper length for northbound lane, south of work area

 l Reference MUTCD 6C-2 Longitudinal Buffer Space for buffer between north bound and south 
bound tapers.

 1. Create buffer space for northbound lane
 A. Ribbon > Home tab > Layers panel > Layers dropdown > P_MISC_NoPlot
 B. Ribbon > Home tab > Draw panel > Line command > Create Line
 C. Specify first point: Endpoint OSnap, select furthest southbound lane point 

along centerline.
 D. Specify next point:Shift + right-click > Perpendicular OSnap, click on lane 

line.
 E. Right-click menu > Enter
 F. Select line
 G. Hover over end grip point to extend, right-click menu > Lengthen
 H. Repeat to other end grip point
 I. Ribbon > Home tab > Modify panel > Offset command
 J. Specify offset distance:220

 K. Select object to offset: Select construction line.
 L. Select point on side to offset: Click left of construction line.

 M. Right-click menu > Enter
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 N. Ribbon > Home tab > Modify panel > Offset command
 O. Specify offset distance:540
 P. Select object to offset: Select new construction line.
 Q. Select point on side to offset: Click on construction line.
 R. Right-click menu > Enter

 2. Create merging taper on northbound lane, south of work area
 A. Ribbon > Home tab > Draw panel > Line command > Create Line
 B. Specify first point:Shift + right-click > Apparent Intersect OSnap, select 

intersection of centerline and 540’ construction line.
 C. Specify next point:Shift + right-click > Apparent Intersect OSnap, snap to 

lane line first, then snap to 220’ construction line.
 D. Right-click menu > Enter

 3. Create polyline for the northbound lane
 A. Ribbon > Home tab > Draw panel > Polyline command
 B. Specify start point: Endpoint OSnap on first point at beginning of transition, at 

centerline.
 C. Specify next point: Endpoint OSnap to the end of construction line.
 D. Specify next point: Endpoint OSnap to the end of southbound transition at 

northbound lane center line.
 E. Specify next point: Endpoint OSnap at PC.
 F. Specify next point: Type A (arc), Endpoint OSnap at the start of transition out.
 G. Specify next point: Type L (line), Shift + right-click > Apparent Intersect 

OSnap, click where construction line meets proposed alignment.
 H. Specify next point:Shift + right-click > Nearest OSnap follow proposed align-

ment and click at end of transition.
 I. Right-click menu > Enter

 4. Delete all construction lines
 A. Select a construction line, Selection > Line
 B. Right-click menu > Select Similar
 C. Delete

Polylines remain.

Save project.

Create view frames and sheets

pln-prod-trffc-cntrl-stg-cnstrctn-08.mp4 6:09
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Create view frames

 1. Planning for Advanced Warning Signs
 A. Ref. SDD 15D20-05b
 B. Measure warning sign location 500’, 1000’, 1500’ before tapers begin.

Info: You don’t need these signs to be shown at the true distances since that 
would create sheet with very little data on them. You can bunch them together 
with measurements noted.

 2. Ribbon > Output tab > Plan Production panel > Create View Frames
 A. Create View Frames – Alignment dialog box

 I. Alignment: 51 proposed
 II. Station Range: User Specified

 a. Select From Screen button for start station
 b. Specify station along baseline:58775
 c. Select From Screen button for end station
 d. Specify station along baseline:62225

 III. Next
 B. Create View Frames – Sheets dialog box

 I. Sheet Setting: Plan(s) only
 II. Template for Plan sheet: select ...

 a. Verify template file name is 02-PD-wdot.dwt, found in Sheets folder.
 b. Select a layout to create new sheets: select Plan 1 IN 40 FT
 c. OK

 III. View Frame Placement: Along alignment
 IV. Next

 C. Create View Frames – View Frame Group dialog box
 I. View Frame Group Name: VFG-TC-51-40

 II. Next
 D. Create View Frames – Match Lines dialog box

 I. Uncheck box Insert match lines
 II. Check box Snap station value down to the nearest: 1

 III. Check box Allow additional distance for repositioning: 25
 IV. Create View Frames

 3. Check and update view frames
 A. Adjust VF-6, overlay is too much

 I. Select view frame
 II. Select diamond grip and slide along alignment to station 621

Create sheets

 1. Ribbon > Output tab > Plan Production panel > Create Sheets
 A. Create Sheets – View Frame Group and Layout dialog box

 I. View Frame Group: VFG-TC-51-40
 II. View Frame Range: All

 III. Layout Creation: check box All layouts in the current drawing.
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 IV. Layout name: select Name Template button
 a. Starting number: 1
 b. OK

 V. Next
 B. Create Sheets – Sheet Set dialog box

 I. Sheet Set: Add to existing sheet set
 a. Select  ...

 i. 11701970\SheetPlan\11701970.dst
 ii. Open

 II. That should update everything else
 III. Create Sheets

 a. OK to warning
 2. Creates layout tabs
 3. Opens Sheet Set Manager, close for now
 4. Select Layout 1 tab > right-click > Delete

 A. OK to warning

Info: This is only used as a place holder.

Save project.

Temporary pavement markings

pln-prod-trffc-cntrl-stg-cnstrctn-09.mp4 3:59

Offset lanes

 1. Ribbon > Home tab > Modify panel > Offset command
 2. Specify offset distance: 0.42'
 3. Select object to offset: Select southbound transition lane.
 4. Specify point on side of object: Click top side (left).
 5. Select object to offset: Select northbound merging in transition lane line.
 6. Specify point on side of object: Click top side (left).
 7. Select object to offset: Select northbound center lane line.
 8. Specify point on side of object: Click to bottom side (right).
 9. Right-click menu > Enter

 A. Create Sheets – View Frame Group and Layout dialog box

Make layers

 1. Ribbon > Home tab > Layers panel > Layer Properties
 2. Layers Properties Manager

 A. Search: type P_PM_4
 B. Select it and clear search

Tip: Clearing out the search bar allows you to see the new layer once created.
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 C. Select New Layer icon
 D. Rename Layer1 to P_PM_Temp_White
 E. Layer color: White
 F. Select New Layer icon
 G. Rename Layer1 to P_PM_Temp_Yellow
 H. Layer color: Yellow
 I. OK

 3. Close Layers Properties Manager
 4. Select southbound transition offset line 
 5. Ribbon > Home tab > Layers panel > Layers dropdown > select P_PM_Temp_White
 6. Select both northbound offset lines
 7. Ribbon > Home tab > Layers panel > Layers dropdown > select P_PM_Temp_Yellow
 8. Clean these two lines to end at the point where the intersect the existing centerline

 A. Select northbound line along centerline and remove last grip
 I. Right-click > Remove Vertex

 B. Select transition line and drag last grip back to centerline or of you have a snapped 
point at centerline then remove last grip as above.

Save project.

Pavement marking removals

pln-prod-trffc-cntrl-stg-cnstrctn-10.mp4 3:57

Add remove line to northbound center lane line

 1. Ribbon > Home tab > Layers panel > Layers dropdown > select P_PM_Remove
 2. Ribbon > Home tab > Draw panel > Polyline
 3. Turn on OSnap > Endpoint
 4. Specify start point: Select endpoint of northbound center line.
 5. Specify next point: Snap to endpoint where sound bound transition meets it.
 6. Right-click menu > Enter
 7. Need to correct the scale

 A. Cross-window select where endpoint is.  This will highlight more points, so you need to 
clear the other lines out of selection.  Use Shift + left-click and select lines to be 
removed from selection.

 B. Right-click menu > Properties…
 C. Properties Palette

 I. Layer: P_PM_Remove

Info: This should already be the name if you have the correct point selec-
ted.

 II. Linetype scale: 0.025
 D. Turn off OSnap
 E. To get better coverage of Xs, grab and drag end grip point.
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Add remove line to south end center lane line

 1. Ribbon > Home tab > Draw panel > Polyline
 2. Turn on OSnap > Endpoint
 3. Specify start point: Select endpoint where center lane line meets southbound trans-

ition line.
 4. Specify next point: Snap to endpoint where center lane line meets northbound trans-

ition line.
 5. Right-click menu > Enter
 6. Need to correct the scale

 A. Select endpoint
 B. Select first Polyline (black label)
 C. Properties Palette

 I. Layer: P_PM_Remove

Info: This should already be the name if you have the correct point selec-
ted.

 II. Linetype scale: 0.025
 D. Turn off OSnap
 E. To get better coverage of Xs, grab and drag end grip point.

Add remove line to northbound in transition lane line

 l Reference SDD 15D20-05b
 1. Ribbon > Home tab > Draw panel > Polyline
 2. Turn on OSnap > Endpoint 
 3. Specify start point: Select endpoint where hashmark line meets northbound trans-

ition line.
 4. Specify next point:Shift + right-click > Nearest OSnap, click a point along hash line 

that is near the endpoint of transition line.
 5. Right-click menu > Enter
 6. Need to correct the scale

 A. Cross-window select where endpoint is.  This will highlight more points, so you need to 
clear the other lines out of selection.  Use Shift + left-click and select lines to be 
removed from selection.

 B. Properties Palette
 I. Layer: P_PM_Remove

Info: This should already be the name if you have the correct point selec-
ted.

 II. Linetype style: 0.025
 C. Turn off OSnap
 D. To get better coverage of Xs, grab and drag end grip point.

Save project.

Create polylines for traffic control drums
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pln-prod-trffc-cntrl-stg-cnstrctn-11.mp4 5:02

Create polylines for traffic control drums

 l Reference SDD 15D20-05b and MUTCD for barrel placement.
 l Reference SDD-15C11-b for barrel type.

 1. Offset the lane edge lines
 A. Ribbon > Home tab > Modify panel > Offset
 B. Specify offset distance:2
 C. Select object to offset: Select south bound transition lane edge line.
 D. Specify point on side to offset: Select left/west side.
 E. Select object to offset: Select north bound transition lane edge line.
 F. Specify point on side to offset: Select right side.
 G. Select object to offset: Select north bound lane center line.
 H. Specify point on side to offset: Select left side.
 I. Right click menu > Enter

 2. Offset south bound centerline at north bound transition
 A. Ribbon > Home tab > Modify panel > Offset
 B. Specify offset distance: 2
 C. Select object to offset: Select south bound transition lane edge line.
 D. Specify point on side to offset: Select right side.
 E. Right click menu > Enter

 3. Break the polylines where barrels end
 A. Ribbon > Home tab > Modify panel pulldown > Break at Point command
 B. Select object: Select polyline where north transition ends at centerline.
 C. Turn on OSnap > Endpoint
 D. Specify first break point: Select polyline at point.
 E. Ribbon > Home tab > Modify panel pulldown > Break at Point command
 F. Select object: Select polyline where south transition ends at centerline.
 G. Specify first break point: Select polyline at point.
 H. Ribbon > Home tab > Modify panel pulldown > Break at Point command
 I. Select object: Select polyline of the south transition line, that meets north bound 

center lane line.
 J. Shift + right-click > Apparent Intersect OSnap

 K. Specify first break point: Snap at intersection with north bound center lane 
line.

 L. Ribbon > Home tab > Modify panel pulldown > Break at Point command
 M. Select object: Select polyline of the north bound center lane line.
 N. Shift + right-click > Apparent Intersect OSnap
 O. Specify first break point: Snap at intersection with south transition line.
 P. Ribbon > Home tab > Modify panel pulldown > Break at Point command
 Q. Select object: Select the northbound center line offset polyline.
 R. Shift + right-click > Apparent Intersect OSnap
 S. Specify first break point: Snap to the point the centerline meets.
 T. Delete the remainder of the north bound transition offset polylines.

Save project.
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Traffic control drums and cones, part 1

pln-prod-trffc-cntrl-stg-cnstrctn-12.mp4 5:32

Adding traffic cones or barrels

 1. Ribbon > Home tab > Draw panel > Polyline command
 2. Specify start point: Snap to endpoint of northbound center line offset polyline.
 3. Shift + right-click > Nearest OSnap
 4. Specify next point: Snap on the centerline just beyond the intersection of southbound 

transition and northbound centerline.
 5. Right click menu > Enter
 6. Select polyline
 7. Ribbon > Home tab > Layers panel > Layers dropdown > select P_TC_Cones_50
 8. Right-click polyline > Properties…
 9. Properties palette

 A. Linetype scale: 0.025
 10. Grab endpoint grip point to adjust cone distance along polyline.

Matching properties to other polylines

 1. Ribbon > Home tab > Clipboard panel > Match Properties command
 2. Select source object: Select polyline with cones.
 3. Select destination object(s): Select all polylines; in the work area, transitions on 

both north and south, and beyond the transitions.
 4. Change layer type for each polyline.

 A. Ribbon > Home tab > Layers panel > Layers dropdown
 B. Southbound transition line, on north side, change to P_TC_DrumsLight_50
 C. Northbound transition line, on north side, change to P_TC_Drums_50
 D. Southbound center lane closed barrels, on north side, change to P_TC_Drums_50
 E. Southbound transition line, on south side, change to P_TC_Drums_50
 F. Northbound transition line, on south side, change to P_TC_DrumsLight_50

 5. Add a break point where the northbound transition line, on south side, meets center lane 
line.

 A. Ribbon > Home tab > Modify panel pulldown > Break at Point
 B. Shift + right-click > Endpoint OSnap
 C. Hover and snap to endpoint

 6. Continue changing layer
 A. Northbound center lane closed barrels, on south side, change to P_TC_DrumsLight_50
 B. Centerline of the road, between transitions, change to P_TC_Drums_100
 C. Northbound center lane line, between transitions, change to P_TC_Drums_100

 7. Adjust line length so barrels start and end where they need to.
Save project.

Traffic control drums and cones, part 2
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pln-prod-trffc-cntrl-stg-cnstrctn-13.mp4 3:03

Adding closing barrels to north side transition lines

 1. Southbound center lane to median
 A. Grip point
 B. Ribbon > Home tab > Layers panel > Layers dropdown > select P_TC_Drumlight_

15
 C. Ribbon > Home tab > Draw panel > Polyline command
 D. Draw polyline from median to southbound center lane, but not to the line but near so 

it is easier to see.
 E. Select polyline
 F. Shift + right-click > Properties…
 G. Properties palette

 I. Linetype: 0.025
 H. Select endpoint grip point and drag the line until 5 barrels appear.
 I. Adjust southbound center lane closed barrels polyline to meet lane closing barrels

 2. Southbound transition line
The barrel distance is 10’ here and there is not a linetype to match this, so you need to use a 
block.

 A. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Sheets Layout dropdown 
> Traffic Control

 B. Ribbon > Support panel> Palette ON/OFF
 C. Traffic Control palette > Traffic Control tab > select TC_DrumThis is where you 

can manually place a single object, like a barrel, if needed to fill gaps.
 D. Specify insertion point: Place next to southbound transition lighted barrel.
 E. Deselect and reselect object.
 F. Commandline: Copy
 G. Specify base point: Select barrel
 H. Specify second: Continue placing barrels, total 5.
 I. Verify barrels are on the correct layer

 I. Ribbon > Home tab
 II. Shift + Select all 5 barrels

 III. Check the layer name in the Layers panel. It should be P_TC.  If it isn’t, use drop-
down to select from list.

 J. Close palette.
Save project.

Place arrow boards and barricades

pln-prod-trffc-cntrl-stg-cnstrctn-14.mp4 3:49

 l Reference SDD 15D22 for arrow boards and barricades placement.
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Placing lighted arrow board at northbound incoming transition

 1. Start at the buffer of northbound transition.
 2. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Traffic Control dropdown > 

select Traffic Control palette
 3. Ribbon > WisDOT Sheets > Support panel > select Palette ON/OFF
 4. Traffic Control palette > Traffic Control tab > select TC Flashing Arrow Board
 5. Specify insertion point or [Basepoint Scale X Y Z Rotate]: type R Enter
 6. Specify rotation angle: Shift+right-click > Nearest OSnap > Left-click the center-

line.
 7. Specify second point: Shift+right-click > Perpendicular OSnap > Left-click the lane 

line.
 8. Specify insertion point: Move and left-click for placement.
 9. Change layer arrow board is on.

 A. Left-click arrow board.
 B. Ribbon > Home tab > Layers panel > Layers dropdown > select P_TC

 10. Make P_TC the active layer.
 A. Ribbon > Home tab > Layers panel > Layers dropdown > select P_TC

Placing lighted arrow board at start of southbound outgoing transition, south of 
work area

 1. Traffic Control palette > Traffic Control tab > select TC Flashing Arrow Board
 2. Specify insertion point or [Basepoint Scale X Y Z Rotate]: type R Enter
 3. Specify rotation angle: Shift+right-click > Nearest OSnap > Left-click the north-

bound lane line.
 4. Specify second point: Shift+right-click > Perpendicular OSnap > Left-click the 

centerline.
 5. Specify insertion point: Move and left-click for placement at end of southbound out-

going transition.

Placing lighted arrow board at start of southbound outgoing transition, north of 
work area

 1. Traffic Control palette > Traffic Control tab > select TC Flashing Arrow Board
 2. Specify insertion point or [Basepoint Scale X Y Z Rotate]: type R Enter
 3. Specify rotation angle: Shift+right-click > Nearest OSnap > Left-click the lane 

line.
 4. Specify second point: Shift+right-click > Perpendicular OSnap > Left-click the lane 

edge.
 5. Specify insertion point: Move to behind traffic control barrels and left-click for place-

ment.
 6. Commandline: type Copy
 7. Specify base point: Left-click arrow board
 8. Specify second point: Move to where southbound traffic shifts to cross centerline and 

left-click for placement.
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Place barricades near workarea

 1. Traffic Control palette > Traffic Control tab > select TC Barricade
 2. Specify insertion point or [Basepoint Scale X Y Z Rotate]: Left-click and 

place barricade to the right of work area, in outside lane.
 3. Traffic Control palette > Traffic Control tab > select TC Barricade with Sign
 4. Specify insertion point or [Basepoint Scale X Y Z Rotate]: Left-click and 

place barricade to the right of work area, in inside lane.
 5. Change direction of inside lane barricade.

 A. Left-click barricade.
 B. Hover over and left-click on grip point.
 C. Rotate 180 degrees.

Save Project.

Place traffic control arrows

pln-prod-trffc-cntrl-stg-cnstrctn-15.mp4 4:29

Add traffic arrows at north side of project

 1. Traffic Control palette > Traffic Control tab > select TC Flow Arrow Straight
 2. Place arrow in southbound outside lane.
 3. Left-click on arrow.
 4. Left-click circular grip point and rotate 180 degrees, pointing south.
 5. ESC to release.
 6. Traffic Control palette > Traffic Control tab > select TC Flow Arrow Curve
 7. Place arrow in southbound inside lane, line up to other arrow. Adjust to keep off median, but 

still in lane.
 8. Left-click on arrow.
 9. Left-click circular grip point and rotate 180 degrees, pointing south.

 10. ESC to release.
 11. Adjust as needed.
 12. Change layer arrows are on.

 A. Shift+left-click both arrow signs.
 B. Ribbon > Home tab > Layers panel > Layers dropdown > select P_TC

Add traffic arrows in transitions, north side of work area

 1. Traffic Control palette > Traffic Control tab > select TC Flow Arrow Straight
 2. Place arrow in southbound outside lane, just after transition lighted barrels.
 3. Left-click on arrow.
 4. Left-click circular grip point and rotate 180 degrees, pointing south.
 5. ESC to release.
 6. Traffic Control palette > Traffic Control tab > select TC Flow Arrow Straight
 7. Place arrow in northbound outside lane, just across from the southbound arrow.
 8. Left-click on arrow.
 9. Right-click menu > Basic Modify Tools > select Copy
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 10. Left-click on arrow to select.
 11. Move to inside northbound lane and left-click to place.
 12. ESC to release.
 13. Change layer arrows are on.

 A. Ribbon > Home tab > Clipboard panel > select Match Properties tool
 B. Left-click on one of the first arrows placed earlier.
 C. Left-click on each new arrow to place them on the P_TC layer.

Add traffic arrows in full transition, next to work area

 1. Move to full transition, north of work area.
 2. Traffic Control palette > Traffic Control tab > select TC Flow Arrow Straight
 3. Place arrow in northbound inside lane.
 4. Traffic Control palette > Traffic Control tab > select TC Flow Arrow Straight
 5. Place arrow in northbound outside lane.
 6. Left-click arrow in northbound inside lane.
 7. Select circular grip point and rotate 180 degrees, it's now pointing south.
 8. Change layer arrows are on.

 A. Ribbon > Home tab > Clipboard panel > select Match Properties tool
 B. Left-click on previous placed arrow.
 C. Left-click on each of the new arrows to place them on the P_TC layer.

 9. Shift+left-click on both arrows.
 10. Right-click menu > Basic Modify Tools > select Copy
 11. Left-click on arrow to select.
 12. Move to the south side of work area and left-click to place.
 13. Adjust as needed.

Add traffic arrows in transitions, south side of work area

 1. Left-click on south pointing arrow.
 2. Right-click menu > Basic Modify Tools > select Copy
 3. Left-click arrow to select.
 4. Move to end of transition and place two arrows in southbound lanes, one outside lane and 

one inside lane, and one in the northbound lane.
 5. Left-click on the northbound lane arrow.
 6. Select circular grip point and rotate 180 degrees, pointing north.
 7. Adjust as needed.

Add traffic arrows at south side of project

 1. Shift+left-click on south pointing arrows.
 2. Right-click menu > Basic Modify Tools > select Copy
 3. Left-click arrow to select.
 4. Move to south end of project and left-click to place 2 arrows in southbound lanes and left-

click to place 2 arrows in northbound lanes.
 5. Shift+left-click on both northbound arrows to select them.
 6. Right-click menu > Basic Modify Tools > select Rotate
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 7. Left-click on arrow group and rotate 180 degrees, pointing north.
 8. Adjust as needed.

Save Project.

Placing advanced warning signs, part 1

pln-prod-trffc-cntrl-stg-cnstrctn-16.mp4 6:21

Align UCS to the alignment in view frame

Info: This process should be done to each VF you’ll be working in.

 1. Ribbon > View tab > Coordinates panel > 3 Point tool
 2. Shift + right-click > Endpoint OSnap
 3. Specify new origin point: Select bottom, left corner of VF-1
 4. Shift + right-click > Endpoint OSnap
 5. Specify point on positive portion of x-axis: Select bottom, right corner of VF-

1.
 6. Specify point on positive-y portion of the UCS XY plane:Left-click any-

where in VF-1 above the two points
 7. Commandline: PLANEnter
 8. Enter an option: CEnter

Placing advanced warning signs

 l Use reference SDD 15D20-b, use to reference placement dimension.

Info: True distance will not be used, just 100’ spacing but with proper dimensioning.

 1. Ribbon > Home tab > Layer panel > Layer dropdown > select P_MISC_NoPlot
 2. Add Construction lines to help with sign placement

 A. Ribbon > Home tab > Draw panel > Create Line tool
 B. Shift + right-click > Endpoint OSnap
 C. Specify first point: Select the beginning point of the southern transition, at 

centerline.
 D. Shift + right-click > Perpendicular OSnap
 E. Specify next point: Select point on northbound lane line.
 F. Right-click menu > Enter
 G. Select construction line
 H. Hoover over end grip point > Lengthen, extend line
 I. Repeat for other grip point
 J. ESC

 3. Duplicate construction line for each sign placement
 A. Ribbon > Home tab > Modify panel > Offset command
 B. Specify offset distance:100
 C. Select object to offset: Select construction line, southside, left-click to place.
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 D. Select object to offset: Select new construction line, southside, left-click to 
place.

 E. Repeat 2 more times, for a total of 4 construction lines.
 F. Right-click menu > Enter
 G. Ribbon > Home tab > Modify panel > Offset command
 H. Specify offset distance:50
 I. Select object to offset: Select 2nd construction line, southside, left-click to 

place.
 J. Right-click menu > Enter

 4. Offset lane lines on both sides of the road to help with sign placement.
 A. Ribbon > Home tab > Modify panel > Offset command
 B. Specify offset distance:20
 C. Select object to offset: Select northbound lane line, eastside, left-click to 

place.
 D. Select object to offset: Select southbound lane line, westside, left-click to 

place.
 E. Right-click menu > Enter

 5. Add sign blocks
 A. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Sheet Layouts dropdown 

> select Traffic Control
 B. Turn on Traffic Control palette

 I. Ribbon > WisDOT Sheets tab > Support panel > Palette ON/OFF
 C. Traffic Control palette > Traffic Control tab > TC Sign on Permanent Support
 D. Shift + right-click > Apparent Intersect OSnap
 E. Specify insertion point: Select point on the first 100’ construction line where it 

meets the offset northbound lane line.
 F. Adjust direction of sign

 I. Left-click post
 II. Right-click menu > Rotate

 III. Shift + right-click > Nearest OSnap, to snap to offset northbound lane line.
 G. Repeat steps for 3 remaining construction lines.
 H. Repeat steps to add an End of Work sign on the southbound lanes line where it meets 

the first 100’ construction line.  Remember the sign needs to face the direction of 
traffic flow.

 6. Repeat UCS alignment steps and placing advanced warning signs, steps 2-5, for the northside 
transition.

 7. Once complete, remove all construction lines and offset lane lines.
Save project.

Placing advanced warning signs, part 2

pln-prod-trffc-cntrl-stg-cnstrctn-17.mp4 3:12
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Label advanced warning sign dimensions

 1. Ribbon > Annotate tab > Dimensions panel > Style Selector dropdown > select 070-
PLAN JOINTS & RADII

 2. Ribbon > Annotate tab > Dimensions panel > Tool dropdown > select Linear
 A. Specify first extension line origin: Working left to right, select below the 

first post at its midpoint.
 B. Specify second extension line origin: Select below the post to the right at 

its midpoint.
 C. Drag down a distance for visibility.

 3. Continue to the next post
 A. Ribbon > Annotate tab > Dimensions panel > Continue command
 B. Specify second extension line origin: Select below the post to the right at 

its midpoint.
 C. Specify second extension line origin: Select below the post to the right at 

its midpoint.
 D. Specify second extension line origin: Select point where barrels start at 

centerline.
 E. Right-click menu > Enter
 F. ESC

 4. Select each dimension to edit properties
 A. Select first measurement
 B. Right-click menu > Properties…
 C. Properties palette will open
 D. Scroll to Text dropdown
 E. Text override: 500
 F. ESC
 G. Select next measurement
 H. Scroll to Text dropdown
 I. Text override: 250
 J. ESC

 K. Select next measurement
 L. Scroll to Text dropdown

 M. Text override: 250
 N. ESC
 O. Select next measurement
 P. Scroll to Text dropdown
 Q. Text override: 500
 R. ESC to end command
 S. Close Properties palette

 5. Adjust first measurement to include jogline
 A. Ribbon > Annotate tab > Dimensions panel > Dimjogline command
 B. Specify jog location: Select the line of the first measurement.
 C. Grab the jog
 D. Specify stretch point: Drag to center of line.
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 E. Repeat for each line.  You can also extend the lines, just make sure each line line-up 
with each other.  Use Endpoint OSnaps if needed.

 6. ESC to end command
 7. Repeat steps 2-6 for the northside transition, working right to left.

Save project.

Placing advanced warning signs, part 3

pln-prod-trffc-cntrl-stg-cnstrctn-18.mp4 5:50

Labeling advanced warning signs

 1. Change layer
 A. Ribbon > Home tab > Layers panel > Layers dropdown > select P_TC

 2. Add polylines
 A. Ribbon > Home tab > Draw panel > Polyline command
 B. Specify start point:Select first dimension line, near its top.
 C. Specify next point: Select a point beyond the bottom end of dimension line. Use 

F8/Ortho to place a straight line.
 D. Copy polyline

 I. Select polyline
 II. Right-click menu > Basic Modify Tool > Copy

 III. Drag to next dimension line
 IV. Repeat for each signpost

 3. Add sign faces
 o Use reference SDD 15D20-b

 1. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Sheets Layout dropdown > 
select Signing and Marking

 2. Signing and Marking palette > Advanced Warning tab
 A. Select W20-1A Road Work Ahead
 B. Place below first (left to right) polyline.
 C. Select W20-55A Left Lane Closed Ahead
 D. Place below second polyline.

 3. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Signs
 4. Signing and Marking palette > D-Signs tab

 A. Select W4-2L
 B. Place below forth polyline

 5. Signing and Marking palette > I/S/G Signs tab
 A. Select G20-1
 B. Place below third polyline
 C. Select G20-2A
 D. Place on other side of roadway by the sign post there

 4. Add mile value to Road Work sign (G20-1)
 A. Double-click on sign for Attribute Editor
 B. Select MILE,  Value: 1/2
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 C. Select MILE-ST, Value: 1/2
 D. OK

 5. Add dimension and polyline for End of Work sign on other side of roadway.
 A. Ribbon > Home tab > Draw panel > Polyline command
 B. Specify start point: Select near sign post
 C. Specify next point: Select a point near the sign you placed. Use F8/Ortho to 

place a straight line.
 D. Ribbon > Annotate tab > Dimensions panel > Tool dropdown > select Linear
 E. Specify first extension line origin: Select point where barrels start at 

centerline.
 F. Specify second extension line origin: Select below the post, to the right, 

at its midpoint.
 G. Drag up a distance for visibility.
 H. Use grip point and drag dimension line to the top of the sign post so it’s not in the 

roadway.

Add legend

 1. Ribbon > WisDOT Sheets tab > Sheet Creation panel > Sheets Layout dropdown > 
select Traffic Control

 2. Traffic Control palette > Traffic Control tab > select TC Legend
 3. Add to the top. left corner of VF-1.
 4. Select legend and use grip point to move

 A. Select grip point > Right-click menu > Perpendicular OSnap
 B. Snap to top edge of View Frame

 5. Select blue diamond, visualization button
 A. Select Masked

Repeat steps for southbound transition, view frame will be different.

Save project.

Add miscellaneous labels

pln-prod-trffc-cntrl-stg-cnstrctn-19.mp4 4:52

Adding labels to VF-1

Tips: 
If you are continuing this exercise, select F8 to turn off Ortho.

UCS should be rotate to match VF.

 1. Add text to mark station
 A. Ribbon > Annotate tab > Labels & Tables panel > Add Labels dropdown > Select 

Alignment > Add Alignment Labels
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 B. Add Labels dialog box
 I. Label type: Station Offset - Fixed Point

 II. Station offset labels style: Station
 III. Marker style: _No Display
 IV. Add

 C. Select alignment: Select centerline alignment.

Info: If there are multiple alignments, select first one.

 D. Shift + right-click > Endpoint OSnap
 E. Snap to point
 F. Select station label
 G. Grab grip point and move to be visible
 H. Close dialog box

 2. Add remove linetype label
 A. Ribbon > WisDOT Sheets tab > WisDOT Annotation panel > Multileader Style 

dropdown
 I. Select 070

 B. Ribbon > WisDOT Sheets tab > WisDOT Annotation panel > Multileader com-
mand

 C. Specify leader arrowhead location: Select "X" marker within VF-1
 D. Specify leader landing location Pick a distance away that is visable.
 E. With CapsLock active, type in the Bid Item description, Reference Standard Bid Items.

 I. MARKING REMOVAL 4-INCH
 F.  Select to the side to accept.  Use label grip to move around if needed.

Warning: Make sure to pick objects/points within the current View Frame and 
not overlapping with another.

Adding labels to VF-3

 2. Rotate UCS to VF
 A. Ribbon > View > Coordinates panel > 3 Point command
 B. Shift  + right-click > Endpoint OSnap
 C. Specify new origin point: Select lower left corner of VF-3
 D. Shift  + right-click > Endpoint OSnap
 E. Specify point of positive portion of x-axis: Select the bottom edge of 

VF-3.
 F. Specify point of positive-y portion of the UCS XY plane: Left-click 

anywhere inside VF-3
 G. Commandline:PLANEnter
 H. Enter an option:CEnter

 3. Add leader labels to temporary marking lines.
 A. Ribbon > WisDOT Sheets tab > WisDOT Annotation panel > Multileader com-

mand
 B. Specify leader arrowhead location: Select yellow marking line along north-

bound center lane line.
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 C. Specify leader landing location: Pick a distance away that is visible.
 D. With CapsLock active, type in the Bid Item description, Reference Standard Bid Items.

 I. Type TEMPORARY MARKING LINE ENTERREMOVALABLE TAPE 4-INCH 
(YELLOW)

 E. Select to the side to accept.  Use label grip to move around if needed.
 4. Add a second leader to label for the other temporary marking line along transition.

 A. Ribbon > Annotate tab > Leaders panel > Add Leader tool
 B. Select a multileader: Select leader
 C. Specify leader arrowhead location: Place point to transition line
 D. Enter to end command

Continue to label for each view frame. Remembering to rotate UCS for each view frame before begin-
ning.

Save project.

Joint detail sheets
Last updated: 2014-09-23

Total video time: 55:18

Exercise files: pln-prod-jnt-dtl-data-C3D14.zip

Begin the joint detail file

pln-prod-jnt-dtl-01.mp4 9:06

 1. Start a file with the wisdot12.dwt template file.

Tip: Optional: Create a shortcut in the open dialog box by dragging the Project folder into the 
left blue shortcut area.

 2. Save the new fileas 12345678\SheetsPlan\12345678-STH25-JointDetails.dwg

Connect to the project

Set the working folder

 1. Toolspace > Prospector tab Right-click on the Data Shortcuts area in the Toolspace, Pro-
spector tab, choose Set Working Folder.

 2. Browse to where the project folder is stored, and select the c3d folder.

Tip: This is two folders above the Project's _Shortcuts folder.

Set Data Shortcuts project folder

 1. Toolspace > Prospector tab right-click the Data Shortcuts area.
 2. Choose Set Data Shortcuts Project Folder.

 o 12345678\BaseData\Survey
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Attach the Data References

 1. Toolspace > Prospector tab > Data Shortcuts > expand Surfaces, 
 2. Right-click on STH-Refinement-Top 
 3. Choose Create Reference.
 4. Change the Style to _No Display.
 5. Toolspace > Prospector tab > Data Shortcuts > Alignments > Centerline Alignments. 
 6. Right-click on 4thAve 
 7. Choose Create Reference
 8. Under Description enter -4thAve.
 9. Choose 1IN 50FT-Ticks100'Major:50'Minor[DESC] for the label set.

 10. Click Ok.
 11. Select the PT label. 
 12. Click the delete button.
 13. Toolspace > Prospector tab > Data Shortcuts > Alignments > Centerline Alignments. 
 14. Right-click on STH25BestFit 
 15. Choose Create Reference
 16. Under Description enter –STH25. 
 17. Choose 1IN 50FT- Ticks100'Major:50'Minor[DESC] for the label set.
 18. Click Ok

Tip: Toggle off show and hide Lineweight to see the lines as all same thickness/weight

 19. Toolspace > Prospector tab > Data Shortcuts > View Frame Groups
 20. Right-click on STH25BestFit 
 21. Choose Create Reference

 o View frame style select Standard
 o View frame label style select VF Name
 o Match line style select _No Display
 o Match line labels can be default
 o Select STH25BestFit for the alignment

 22. Click Ok.

Xref edgelines file

 1. Insert tab > Reference panel > Attach icon 
 2. Browse to 12345678\Design\Edgelines\Edgelines.dwg

 o Set the Reference Type to Overlay
 o Set the Path Type to Relative
 o Set the Insertion Point XY and Z to 0
 o Set the Scale to 1
 o Set the Rotation to 0

 3. Zoom Extents. 

Tip: Use NCOPY to bring in all pavement linework from an XREF.

Create manual points
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pln-prod-jnt-dtl-02.mp4 15:24

 1. Home tab > create ground data panel > Points dropdown > Point Creation Tools .
 2. Click the chevron to expand the Create Points Properties

 o Change the Default Layer to P_RDWY_Text_Grades
 o Expand Points Creation, Default Description to PAV
 o Prompt for Elevations to Automatic
 o Prompt for Point Names to Manual
 o Prompt for Description to None

 3. Expand Default Styles
 o Change Point Style to P PM Pavement Marker
 o Point Label Style to Pave Grade Bottom

 4. Expand Default Name Format
 o Change Point Name Template to PAV<[Next Counter(CP)]>.

 5. Close the chevron.
 6. Create Points Toolbar > Alignment Point dropdown > Measure Alignment 

 7. Select  STH25BestFit, 
 o Enter Start Station, Enter End station, Enter Interval.

 8. Create Points Toolbar > Alignment Point dropdown > Measure Alignment

 9. Select  4thAve, 
 o Enter Start Station, Enter End station, Enter Interval.

 10. Create Points Toolbar > Miscellaneous Point dropdown > Measure Object. 
 11. Select a Pavement line. 

 o Enter Start Station, Enter End station, Enter Interval.
 12. Create Points Toolbar > Miscellaneous Point dropdown > Manual Point.
 13. Pick at the vertice points on the Pavement lines that were not inserted with previous com-

mands.
 14. Context tab > Modify panel > Elevations from Surface ,
 15. Select STH25-Refinement-Top,
 16. Type AEnter.
 17. Context tab > Modify panel > Elevations from Surface 
 18. Select STH25-Refinement-Top,
 19. Type AEnter.
 20. Click the chevron to expand the Create Points Properties,
 21. Expand Default Styles.

 o Change Point Style to P PM Pavement Marker Radius
 o Point Label Style to Point Name Circled

 22. Expand Default Name Format.
 o Change Point Name Template to PAV<[Next Counter(CP)]>

 23. Expand Points Creation.
 o Change Prompt for Point Names to Manual

 24. Close the chevron
 25. Create Points Toolbar > Miscellaneous Point dropdown > Manual Point.
 26. Pick at the Center points of each curb and gutter arc and the endpoints of each Arc

Generate point data for point tables (macro)
Page: 1535

Published on: 5/17/2023

Generate point data for point tables (macro)

https://c3dkb.dot.wi.gov/video/pln-prod/pln-prod-jnt-dtl-02.mp4


pln-prod-jnt-dtl-03.mp4 6:41

 1. Toolspace > Toolbox tab > expand WisDOT Toolbox > expand WisDOT Macros
 2. Right-click Point-Station Offset to UDP.
 3. Select Execute
 4. In the WisDOT Points Station-Offset UDP dialog box :

 o Pick Select Points. 
 o Check Create Point Group.

 5. Enter Radius,
 6. Select STH25BestFit as Alignment 1.
 7. Click Apply .
 8. Select all the radius points, 
 9. Click Enter.

 10. In the WisDOT Points Station-Offset UDP dialog box pick Point Group
 11. Select Radius as the point group,
 12. Select 4thAveas Alignment 2.
 13. Click Apply .
 14. Toolspace > Prospector tab > expand Point Groups,
 15. Select the Radius point group.
 16. Right-click Edit points
 17. Panorama opens to look at the info created for the point table that will be created.

Create point tables

 1. Annotate tab > Labels & Tables Panel > Add Tables dropdown  select Add Point table.
 2. On the Point Table Creation dialog box under the Table style dropdown
 3. Select STA OFF STA OFF NE RADIUS
 4. Click icon next to No Point Group Selected 
 5. Select Radius point group, 
 6. Click Ok.
 7. Click Ok, 
 8. Pick a spot for table to reside.

Create sheets

pln-prod-jnt-dtl-04.mp4 24:07

 1. Output tab > Create Sheets  . 
 2. On the Create Sheets – View Frame Group and Layouts dialog box

 o View frame group select STH25BestFit
 o View frame range select Selection, click Choose View Frames

 3. In the Select View Frames dialog box click the green box icon to select view frame from draw-
ing

 4. Click Ok
 5. Select All layouts in the current drawing
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 6. Click Next
 7. Click Create Sheets. 
 8. Click Ok

Insert radius dimensions

 1. Annotate Tab > Dimension panel . 
 2. Select Radius from the Dimension dropdown. 
 3. Select DOT 140 RADIUS from the Style dropdown.
 4. Insert Radius dimensions as needed.
 5. Select Arc end points on Curb and Gutter

Create joint lines

 1. Home tab > Layers panel  ,
 2. Select the layer dropdown and select the P_RDWY_Joint layer to be current
 3. Home tab > Draw panel, >   Polyline,
 4. Draw polylines to represent Joints marks
 5. Home tab > Modify panel >  Offset.
 6. Type in the distance,
 7. Select side to be offset to, 
 8. ClickEnter
 9. ClickEnter

 10. Type in a new distance, 
 11. Select side.
 12. Repeat until all joint lines are complete.

Tips: 
Use Layer Isolate command to only show the layers needed

Use trim and extends command to clean up joint lines.

Use Layer un-isolate command to bring back the previous layers

Insert joint dimensions

 1. Annotate Tab > Dimension panel > Dimension dropdown > Aligned.
 2. Select  DOT 140 Plan Joints_NoDimLines from the Style dropdown.
 3. Insert Joint dimensions as needed.
 4. Select joint end points on joint lines

Tip: Use DIMCONTINUE command to speed the dimension process up

 5. Annotate Tab > Dimension panel > Dimension dropdown > Aligned.
 6. Select DOT 140 Plan Joints from the Style dropdown
 7. Insert Joint dimensions as needed
 8. Select joint end points on joint lines.

Detour sheet
Last updated: 2020-10-26

Page: 1537

Published on: 5/17/2023

Detour sheet



Example sheet: 027001-dt.pdf

Create and setup detour file
 1. Create file

 A. Quick Access toolbar > New button to start the file with design-wdot18.dwt.
 B. Save the file as ProjectID\SheetsPlan\027001-dt.dwg.

 2. WisDOT Sheets ribbon > Standard Components > Add All Components

Add mapping from county map dwg option

Info: This option should be used when all linework is visible as it contains shields for county, 
state, and US highways.

 1. Setting up county maps
 A. County maps can be found in:

 n WisDOT internal user: N:\pds\c3d\stnd\CountyMaps-CTB
 n External user: C:\WisDOT\Downloads\C3D 20XX\Stnd\CountyMaps-CTB 

 B. Copy dwg file(s) and paste into ProjectID\BaseData\Other
 C. Open the county map files.

 I. WisDOT Sheets ribbon > Plot Configuration panel > Layer States > County 
Maps Layer State group > Set County Map Layers to Plot in Grayscale to 
add layer state to file.

 II. WisDOT Sheets ribbon > Plot Configuration panel > Layer States pull-
down > W18 County Maps (grayscale plot)

Tips: 
 n This will not show up in the Layer States pull-down.
 n Objects will appear red in modelspace. This is correct for gray-

shading.

 D. Save and close the file.
 2. Insert county maps option

 A. Insert into detour file
 I. INSERTEnter

 a. Browse  to ProjectID\BaseData\Other to select the proper county dwg.

Tips: 
 n Make sure to explode the block to have access to delete/-

freeze layers/lines. 
 n Make sure none of the Specify On-screen options are 

chosen.
 n If you are inserting more than one county map you will 

need to do this one at a time.

 B. Delete elements that are not needed.
 I. If the USH/STH/CTH shield hatching is obstructing the road number,

 a. Select one hatch (of each type) > Right-click > Select Similar
 b. Right-click > Display Order > Send to Back
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 II. Select an element to delete > Right-click > Select Similar > Del

Tips: 
 n It may be useful to lock certain layers that you know you need, 

such as c_ush, c_ush_txt, c_sth, c_sth_txt, etc. This way you 
won’t accidentally select and delete these while grabbing other 
items.

 n You can select objects that are too far away from the project loc-
ation and delete them individually. Do not use Select Similar in 
this case so you do not delete elements that you do need to 
keep.

 n Using Window Select (blue) rather than Crossing Window Select 
(green) can prevent accidental selections during this process.

 n Check the progress after several layers have been turned off. 
You are checking that something you need has not been turned 
off with something else accidentally. It is a good idea to check 
and save the file after every couple of steps.

 3. XREF County Maps option
 A. Insert tab > Reference panel > Attach

 I. Browse to ProjectID\BaseData\Other location to select county/counties 
needed. You can attach multiple county dwgs at one time. 

 II. Attachment: Overlay
 III. Path Type: Relative Path
 IV. Do not use Specify On-screen for any options.

 B. XCLIP to reduce amount of maps shown
 I. Draw a polyline around the area needed. Use C for close at the end of the poly-

line.
 II. XCLIP Enter

 III. XCLIP Select Objects: Select all the county maps you have attached. 
Enter when finished.

 IV. XCLIP [ON OFF Clipdepth Delete fenrate Polyline New bound-

ary]:New boundary
 V. XCLIP Select polyline Polygonal Rectangular Invert 

clip]:Polyline
 VI. XCLIP Select polyline:Select the closed polyline you have created

 VII. If you need to make changes to the XCLIP boundary, make the changes to the 
polyline then restart the command. Answer the same prompts as above, but an 
option to delete old boundary will be added. Answer that new prompt with yes. 
The XCLIP boundary will be recreated.

 VIII. Layers needed may differ. You will want to show the road centerlines, and 
USH/STH/CTH shields.  You should keep layers that show water crossing the 
route or aid in navigation of the route.

 IX. Make sure XCLIP boundary will not plot
 a. XCLIPFRAMEEnter
 b. XCLIPFRAME Enter new value for XCLIPFRAME:0Enter
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 c. This frame will still be visible in model and paperspace views, but it will 
not be seen in plot and plot preview. 

 d. Select the polyline that drew the XCLIP boundary. Move it to the P_MISC_
NoPlot layer. 

 C. Layer Off ot reduce unneeded graphics
 I. Home ribbon > Layers panel > Layer Off

 II. Select objects that should not be visible.
 a. County map sheet frame and outside text (town-range, etc.)
 b. County grid lines
 c. Lakes, rivers, and their text
 d. Map symbols like airport or tent/campground symbols

Tips: 
 n Check the progress after several layers have been turned off. You are 

checking that something you need has not been turned off with some-
thing else accidentally. It is a good idea to check and save the file after 
every couple of steps.

 n You will need to do the LayerOff for items in each county separately. 
Since the XREFs name the layers with the host file name included items 
that would be on the same layer are actually on different layers due to 
XREF layering.

 n Usually town or city roads will not be needed unless part of the detour 
route, and then only the road lines in the area to help identify the route. 
Some town/city roads have center/left/right lines. If you need to keep 
the centerlines you can delete the left and right lines.

 n Leave geographic locations such as town or village names to aid in nav-
igation.

Add mapping from InfraWorks option

Info: This option should be used when county maps don't provide enough data (city and vil-
lage areas). This option can also be used to augment county map data.

 1. See Project Overview workflow 
 A. "Export road linework from InfraWorks to Civil 3D" on page 309
 B. "Import IMX file to Civil 3D, edit and style alignments #import         " on page 1409
 C. Tips: 

 n The import IMX needs the drawing coordinate zone to match the IMX 
file. In the Import dialog,

 n Set a Coordinate System
 n Use Infraworks Model Coordinate System to set this.

 n In the Import IMX dialog you may want to use the Refine Selection Set 
and turn off the Water Areas, unless lakes and rivers are specifically 
needed.
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 n In the Refine Selection Set you can also uncheck any alignments that are 
not in or around the needed route. Find the names of alignments that 
have names and uncheck those you do not need. Any alignments that 
are just a short series of numbers may be unnamed roadways in the 
Infraworks model and COULD include the alignments you need. When 
in doubt leave an alignment selected and it can be deleted later.

 2. Delete the alignments that are not needed. Careful use of crossing and window selections can 
help speed this process up.

 3. Select all of the remaining alignments > Right-click > Properties... Style:ALI Existing 
(No Markers). Using the Properties palette instead of the individual alignment properties dia-
log allows you to assign several alignment styles at once.

Create detour route over roads

If you are creating a line over the road centerlines:

 1. Offset the road polylines (or alignments)
 A. Set the layer for the line to be drawn to P_TC
 B. Home ribbon > Modify panel > Offset
 C. Offset the intended detour roads centerlines a small distance (~1’).
 D. Status bar > Lineweight:Check on  to see the true width of the added lines.
 E. Adjust polyline lineweight

 I. Select the detour route polyline(s) > Right-click > Properties...
 II. Lineweight field > drop-down menu > choose a new lineweight If the line-

weight is still not thick enough choose another number.

Tips: 
 n You will get a preview of the lineweight by hovering over the numbers in 

the list. This may help in a better first choice.
 n You could also draw a polyline over the route and increase the thick-

ness of that polyline. This would be in cases where other options aren’t 
available.

If you are using the XREF you can NCOPY road lines:

 1. NCOPYEnter
 2. NCOPY Select nested objects to copy or [Settings]: Select the roads that will 

be part of the detour route. Enter to finish the selection set.
 3. NCOPY Specify base point or [Displacement Multiple]:Enter to accept Dis-

placement
 4. NCOPY Specify displacement <0,0,0>:Enter to accept 
 5. Select the resulting polylines, making sure not to select the XREF directly beneath each new 

polyline.
 6. Right-click > Properties...

 A. Layer: P_ALI
 B. Lineweight:0.42 (this may vary with scale)
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 C. Linetype: Continuous

Tip: The lineweight may vary with zoom level, scale, or road density.

Placed hatched rectangle over work area.

 1. Set the current layer to P_TC
 2. Draw a closed polyline shape (or rectangle) over the work area
 3. Home ribbon > Tools panel > Hatch

 A. Pattern: ANSI31 hatch (45-degree line pattern).
 B. Scale: 20

This may change depending on the scale of the intended layout sheet scale. You may 
need to return to change this scale after the layout sheet is created, and the proper 
scale has been set. This does NOT have to be exact, just close enough to see the pat-
tern and prevent the hatch pattern from appearing solid.

Add layout sheet to file
 1. WisDOT Sheet ribbon > Support panel > Palettes ON/OFF to turn on tool palette.
 2. WisDOT Sheets ribbon > Sheet Creation panel > Construction Details pull-down > Sign-

ing and Marking palette
 3. Startup Main tab > Sheets Layouts > 02-Plan Details 1 = 100 (02-PD-wdot18)
 4. (C:02-PD_PLAN-1-100) Press enter to continue with layout name <Plan 1 

IN 100 FT> : or type NEW name for Layout.01Enter to name and create the layout 
tab.

 5. Double-click inside the viewport to access model space.
 6. Status bar > padlock to unlock the viewport.
 7. Zoom extents to get to the project location. 
 8. Pan and zoom until the project and detour are visible in the viewport. Make sure to adjust the 

location so there is room for the legend area. 
 9. If you need to rotate the view to fit the project into the viewport:

 A. WisDOT Design ribbon > Navigation panel > Rotate View
 B. In the open viewport select one point then a second to create an invisible line that will 

orient to due east.
 C. UCSEnter
 D. UCS Specify origin of UCS:WorldEnter to align UCS with the modelspace.

 10. Add the north arrow to the file.
 A. WisDOT Sheets tab > Sheet Creation panel > 02 drop-down > Traffic Control
 B. Startup Main tool palette > North Arrow
 C. Click a point in the open viewport to place the north arrow in the modelspace.
 D. EXECUTETOOL Specify rotation angle <0>:Enter  to keep arrow aligned 

north
 E. If the north arrow is too small, scale it up
 F. Select north arrow > SCALEEnter
 G. SCALE Specify base point: Click near the north arrow
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 H. SCALE Specify scale factor:100EnterThis may not be the correct scale due to 
viewport scaling, so repeat this until the north arrow is the appropriate size.

Add detour detail to the overview (as needed)

Project Location note

 1. Unlock viewport and shift project to allow room for an inset picture of the project area, or 
detail area. Relock the viewport.

 2. Select the edge of the viewport, grab the rectangle grip in the middle of the edge that is to 
move and shift it to make room for the new viewport. You can also grab the corner square 
grip points if a non-symmetrical viewport is needed.

Tips: 
 o Using the ORTHO function (F8 in the function keys, or ORTHO in the status bar) 

can help if you need to keep the lines straight while moving.
 o If you need to make an odd shaped opening you can hover over the polyline 

rectangular grips and choose Add Vertex. The first added vertex can snap to 
the rectangular grip to create a corner before other vertex points are added to 
create your shape.

 3. Layout contextual ribbon > Layout Viewports panel > Rectangular pull-down > Rect-
angular/polygonal/or shape You can also type MV at the command line for the MakeView-
port command.

Tip: You can make odd shaped viewports with Polygon, or after drawing the shape with 
polylines in paperspace you can use From Object.

Warning: Do not overlap the viewports. This will cause issues with selecting objects or 
the viewports later.

 4. Double click inside the new viewport to activate it and access modelspace.
 5. Zoom and pan to the inset detail location of the project.

 A. Zoom in close enough that you know the inset area is centered in the inset viewport.
 B. Set the inset viewport to 1 IN:0.5 MI scale. If this is not appropriate for your needs, try 

a scale higher or lower in the scale list.  
 C. When this location is set, lock the viewport.

 6. Change the layer to P_TC.
 7. In paperspace above the project viewport draw a rectangle/shape that resembles the inset 

area viewport.
 A. Select the new shape > Right-click > Properties...
 B. Linetype: DASHED-2

 8. Change the layer to P_TC_TXT
 9. UCS Specify origin of UCS:ViewEnter to align UCS with the viewport. This makes text 

and blocks orient to the top.
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 10. Signing & Marking palette > Startup Main tab > Multileader Begin Project-Sta
 A. Click a point for the start of a leader line, then a second point for the text landing
 B. When prompted to Overwrite Default Text,  YEnter
 C. Type PROJECT LOCATION
 D. Click outside text editor to end command

 11. To place the Inset location text
 A. Signing & Marking palette > Startup Main tab > Multileader Begin Project-Sta

 I. Click a point for the start of a leader line, then a second point for the text land-
ing

 II. When prompted to Overwrite Default Text,  YEnter
 III. Type PROJECT LOCATION
 IV. Click outside text editor to end command

 B. Select the text > Right-click > Remove leader This removes the leader and the line 
so you are left with text.

 C. Move the text to a location appropriate for the inset.

Add signs in plan

 1. Activate the layout.
 2. WisDOT Sheets ribbon > Support panel > select Palettes ON/OFF to turn on palettes
 3. Traffic Control tool palette > Detours tab > Blocks – Signing area > Single Sign Single 

Perm Support
 4. Click where the signpost should be located in paperspace.
 5. When prompted for rotation move your cursor so the rotation reference line is generally par-

allel with the road the sign is next to and left click to place it. 
 6. Place several more signs in the inset .

Add leadered circle tag text if needed

 1. Traffic Control palette > Detour tab > Circle Tag 0.07

Warning: This tool will not work if you have not done the Add All Components step in 
this file.

 2. Place the leader line point first, then the leader landing which will place the circled text.
 3. Attributes dialog > Top field: A > OK
 4. Place a copy of the circled tag in the legend and add Calibri Light 0.07 text description
 5. If a circle tag text needs to have the leader removed, select it > right-click > Remove 

Leader > Select the leader to remove it
 6. Repeat these steps for all the circle text that require leaders removed.
 7. Add note text in plan

 A. Traffic control palette > Startup Main tab > Calibri Light 0.07 text
 B. Place a text box near where note is to be placed (this can be adjusted after the text is 

added).

Create Legend (as needed)
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 1. Add the Legend text
 A. Traffic Control palette > Startup Main tab > Calibri Light 0.070
 B. Create a text box in paperspace where the legend is going to display.
 C. Type LEGEND Enter then tab-indent the second line.
 D. Type the text for the first legend item, Enter Tab then type the second legend item. 

Repeat for all legend items.
 E. Inside the text editor box select all the legend items.
 F. Paragraph panel > Line Spacing drop-down menu > 1.5 to increase the spacing. 

You may need to increase this spacing after the blocks are added to the legend.
 2. Add sign blocks in legend

 A. Sign blocks from tool palette
 I. WisDOT Sheets ribbon > Sheet Creation panel > Signs palette 

 II. Find the tab of the sign series needed. 
 III. Scroll to find the needed sign block.
 IV. Left click where the sign should be placed in the legend.

 B. Sign block from Design Center

Tip: Some blocks may not be in the tool palettes. For these you will need to use 
Design Center. Please report any missing sign blocks to CAE Support

 I. WisDOT Sheets ribbon > Standards Components > Open Design Center
 II. In left window of Design Center browse to the sign block area 

C:\WisDOT\Stnd\C3D20XX\Components\Blocks
 III. Drawing files that hold sign blocks are named “signs” with the sign prefix letter 

and the version number.
 a. (example: sign M3-3 for Civil 3D 2018 would be in file signsm18.dwg).

 IV. Expand the dwg and select on the Blocks section. This will take a moment to 
populate the graphics of these blocks.

 V. Find the block name and drag it into the file and place it.
 C. Edit the block as necessary

 I. Visualization settings to place Install/remove options.
 II. Double click to edit text in block attributes

 D. Copy one of the Circle tags and paste next to the appropriate row of the legend.
 3. Add other blocks to legend

 A. Place blocks in the legend area the same way you placed them in the project area. 
 B. Line the blocks up with the legend text that describes them.

 4. Add lines to legend
 A. Set layer to P_TC
 B. Double click on the legend text. This opens the Text Editor.
 C. Place your cursor at the end of the line of text before where the new text is to appear.
 D. Enter to create a new line of text and type the necessary text.
 E. Click outside the Text Editor box to end the text edit function.

 I. Shift the blocks in the legend area to make room for the new text and add any 
block(s) you need for the new line of text.

Purge unused components
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 1. PURGEEnter
 2. Purge dialog box

 A. Purge All
 B. Close 

Add layout sheet to project sheet set
This process is covered  at "Add sheets to sheet set manually #add" on page 1299

Alignment sheet
Last updated: 2021-10-19

Example sheets:

027201-ad.pdf

Sheet creation
 1. "Construction details sheet" on page 1427 is an example of creating a Section 2 type sheet
 2. "Create layout manually" on page 1310

Create alignment DREFs
 1. Alignment that is the focus of the current sheet

 A. Toolspace > Prospector > Data Shortcuts  > Alignments > Centerline > Right-click 
STH113-NB > Create Reference

 B. In the Create Alignment dialog
 I. Alignment Style: ALI Proposed.

 II. Alignment Label Set: 1IN 200FT-Ticks 500’ Major: 100’ Minor.
 III. OK

 2. Alignments that are NOT the focus of the current sheet
 A. Toolspace > Prospector > Data Shortcuts  > Alignments > Centerline > Right-click 

STH113-SB > Create Reference
 B. In the Create Alignment dialog

 I. Alignment Style: ALI Existing (No Markers).
 II. Alignment Label Set: 1IN 200FT-Ticks 500’ Major: 100’ Minor(No PC/PT).

 III. OK
 C. Select alignment STH113-SB > Right-click > Edit Alignment Labels

 I. In the Major Stations Style area click the label tag icon: Truncated 100 (gray).
 II. In the Minor Stations Style area click the label tag icon: Minor Tic (Gray).

 III. OK.
 D. Repeat for each alignment that is not the focus of this current sheet.

Tip: You may need to flip the labels on some of the alignments so they do not 
overlap. This will be a particular issue for the geometry point labels since they 
extend well past the alignment geometry.
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Labeling the alignments
 1. Add Begin/End point labels

 A. Select the alignment, right-click and choose Edit Alignment Labels.
 B. In the Alignment Label Set dialog

 I. Select the Type drop-down and choose Geometry Point.
 II. Set the Geometry Point Label Style to WisDOT Standard [DESC].

 III. Select Add.
 IV. In the Geometry Points dialog clear all the labels, then select Alignment Begin-

ning and Alignment End. Click OK.
 V. Click OK.

 C. Annotate ribbon > Labels and Tables > Add Labels > Notes
 I. Note label style: N E

 II. Add
 D. Snap to the end of the alignment to place the N E label.
 E. Select the N E label, select the square grip point and drag the label to below the EP 

label.
 F. Hover over the square grip point and choose Rotate label. Rotate the label to the same 

rotation as the EP label. You may need to move the label around to better align with 
the EP label.

 G. With the N E label still selected, right-click and choose Toggle Leader.
 2. Add Point of Intersection labels

 A. Select the STH 19 EB alignment.
 B. Contextual ribbon > Labels & Tables panel > Add Labels drop-down > Add Align-

ment Labels
 C. Add Labels dialog

 I. Label Type: Point of Intersection.
 II. Point of Intersection Label style: PI Station (DESC).

 III. OK 
 IV. Select each curve in the STH 19 EB alignment (do not add to the other align-

ments).

Tip: Make sure alignment descriptions(DESC) are added to this file –you 
won’t get the aliprof’s file descriptions in the label otherwise.

 3. Add alignment convergence station labels
 A. Annotate ribbon > Labels & Tables panel > Add Labels > Notes

 I. Note label style: Intersection –Description
 II. Add 

 B. Snap to the location where STH 19 EB connects to STH 19 WB
 C. You will be prompted to select alignment. Select STH 19 EB, then select the STH 19 WB 

alignment.
 D. Select the stationing label, grab the square grip point and drag to a readable spot.
 E. If the label needs to drag to a spot where the label overstrikes the leader...

 I. Select the label where it has been dragged to.
 II. Hover over the square grip point and choose Rotate label.
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 III. Move your mouse so the label is rotated 180 degrees. The text will flip over to 
be readable as you do this.

Tip: Turning on the ORTHO functionality is helpful here to get exact rota-
tion.

 IV. Grab the diamond grip from the leader line and drag and snap it to the label’s 
line.

 4. Add alignment/road names

Tip: having the Endpoint OSNAP turned on will help this process.

 A. Select the STH 19 EB alignment.
 B. Contextual ribbon > Modify panel > Alignment Properties > Information tab

 I. Description: STH19EB
 II. OK

 C. Select the STH 19 EB alignment.
 D. Contextual ribbon  > Labels & Tables panel > Add Labels drop-down > Add Align-

ment Labels
 A. Switch Label Type to Single Segment.
 B. Set Line label style to General Line Label Style: AlignmentName [from Desc].
 C. Switch Curve Label Style to General Curve label style: Alignment Name [from 

Desc].

Tip: Make sure alignment descriptions (DESC) are added to this file –you 
won’t get the aliprof’s file descriptions in the label otherwise.

 E. Add and select the alignment segment to place the alignment name.
 F. Enter to open the select alignment reference dialog.
 G. Select the STH 19 EB alignment from the list.

 5. Place reference line text for other alignments.
 A. Select one of the other alignments.
 B. Contextual ribbon > Modify panel > Alignment Properties > Information tab

 I. Description: R/L and the name of the alignment.
 II. OK

 C. Select alignment > Right-click > Add Labels...
 A. Switch Label Type to  Single Segment.
 B. Set Line label style to General Line Label Style: Alignment Name [from Desc].
 C. Set Curve Label Style to General Curve label style: Alignment Name [from 

Desc].
 D. Add and select the alignment segment to place the alignment name.

 D. Enter to open the select alignment reference dialog
 E. Select the alignment name from the list
 F. Close the Add Labels dialog
 G. Drag each reference line label away from the alignment
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 6. Placing alignment Name label
 A. WisDOT Sheets > WisDOT Annotation panel pull-down > Set WisDOT Textstyle/S-

ize
 I. Textstyle: CalibriLight

 II. Size: 0.100.
 B. Annotate tab > Text panel > Multiline Text
 C. Create a text box near the road name label location
 D. STH 119
 E. Click outside the text box
 F. Select the text > dark blue grip > Right-click > Rotate
 G. Rotate the text to match the direction of the alignment at the location of the label.

 7. Add alignment segment and curve labels
 A. Select the STH 19 EB alignment
 B. Contextual ribbon > Labels & Tables panel > Add Labels drop-down > Add Align-

ment Labels
 I. Label Type: Multiple Segment.

 II. Line Label Style to General Line Label: Bearing.
 III. Curve Label Style to Curve label style: PI XY^ D T L R PC XY PT XY DB DA.
 IV. Add and select the alignment that is the focus of the current sheet.

 C. Select the first curve label and select the square grip point to drag the label away from 
the curve location. This label style has no leader line so it will just drag the label to an 
open area for placement.

 I. Repeat this for all the curves in this sheet.

Tip: you can drag any label that is overstriking or cluttered to a more 
appropriate location. The result should be a sheet that is uncluttered and 
ultimately readable.

 D. Place CURVE number tags to the alignment and the label locations.
 I. WisDOT Sheets > WisDOT Annotation panel pull-down > Set WisDOT 

Textstyle/Size
 a. Textstyle: CalibriLight
 b. Text size: 0.070

 II. Annotate tab > Text panel > Multiline Text
 a. Place the text box above the first curve label and type CURVE 1.

 III. Select text > Text Editor ribbon > Formatting panel > underline.
 IV. Click outside the text box to end the editing.
 V. Copy the new curve text and paste it above each curve label.

 VI. Edit each label to read the proper curve numbers for each label.
 VII. Annotate tab > Text panel > Multiline Text

 a. Place a text box above the first curve.
 b. Type CURVE 1 then click outside the text editor to close it.

 VIII. Select the text > dark blue grip > Right-click > Rotate and click a second 
point so the text label is oriented to the curve chord location. Repeat this for 
each curve.
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Tip: If you become confused as to which curve is which, select the label 
and its origin point will display next to its curve. Make sure that the curve 
label next to the labels matches the curve label at the curve.

 8. Add Dimensions
 A. WisDOT Sheets > WisDOT Annotation > Dimension style drop-down > 070-LANE 

& SHLDR
 B. Select the Dimension tool.
 C. Shift +Right-click, select NEAREST. Select the first alignment.
 D. Shift+Right-click, select PERPENDICULAR. Select the second alignment.

 9. Add the sheet to the Sheet Set Manager for the project "Add sheets to sheet set manually 
#add" on page 1299

Miscellaneous quantities sheets
Last updated: 2022-11-01

Total video time: 26:46

Example sheets: 030201-mq.pdf

Option 1: Using WisDOT Excel Add-In with data links and tables

Excel named ranges and Civil 3D data links and tables

Video: pln-prod-misc-qnty-01.mp4 3:37

Dataset: pln-prod-mq-opt-begin-data-c3d22.zip

The paste link method of pasting an Excel table into Civil 3D does not result searchable text within 
the PDF of the miscellaneous quantities sheets. The quantities tables end up being raster images in 
the final printed product. Also, at times, the paste link method can be unstable. The following work-
flow utilizes Excel named ranges, Civil 3D Data Links and a custom Civil 3D table style to stylize and 
place MQ tables in the Civil 3D plan sheet.

Prerequisites: 
Excel spreadsheet storage location

Store Excel miscellaneous quantities files in the Civil 3D Project directory, under 
dsgn\qty\mq. The Data Link tool works best with a relative path so storing the miscellaneous 
quantities Excel files in the project directory is of priority.
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Merge & Center

Cells that contain text that is too large to fit within that cell must be expanded. Use the Merge & 
Center command followed by the Left Align tool to merge multiple cells and allow the text to fit 
within a single cell.

Gridlines

If grid lines are visible in Excel, they will print from Civil 3D. In Excel, View Tab > Show Panel > 
Uncheck Gridlines

Create Excel named ranges

Video: pln-prod/pln-prod-misc-qnty-02.mp4 4:45

To create the miscellaneous quantities tables in Civil 3D, a named range is required for each quant-
ities table in Excel. This allows a link to be created between the Excel file and Civil 3D drawing. The fol-
lowing workflow utilizes a custom WisDOT tool to create named ranges.

Requirement: The WisDOT Excel add-in must be installed to run the Data Link Named Range 
tool. For external partners, the WisDOT Excel add-in is available on the Wisconsin Department 
of Transportation Civil 3D file descriptions (wisconsindot.gov). Internal users should see 
Autodesk Civil 3D 20XX -Excel Add-In in Software Center.

Create named ranges for quantities tables

See complete tool documentation here: Excel - Data Link Named Range (wi.gov)

 1. In Excel, select the range of cells you wish to create a named range from.
 2. WisDOT Civil 3D Tab > Data Link Named Range
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 3. A named range will be created using the Excel worksheet name.
 A. Naming Convention: DL_Worksheet_Name
 B. All spaces are replaced with underscores(_)
 C. Special characters are not allowed in the Excel named ranges. Only use letters, num-

bers, periods, and underscore characters in the sheet name.
 4. Repeat for other quantities tables and worksheets.

 A. If multiple tables exist on one Excel worksheet, a custom named range dialog box will 
appear. Enter a custom name for the table.

 5. Save the Excel File.
 6. Repeat for other quantities Excel workbooks.

Create data links to Excel file
Once the named ranges are established in the Excel Workbooks, they need to be linked to the Civil 
3D miscellaneous quantities file. Civil 3D data links will be utilized to create this link.

Video: pln-prod-misc-qnty-03.mp4 4:16

Dataset: pln-prod-mq-opt-03-data-c3d22.zip

Create quantities drawing

 1. WisDOT Sheets Tab > Sheet Creation Panel > 
 2. From the palette, click 03- Misc Quantities Speed Sheet
 3. A new drawing will be created from the 03-MQ-SPSHT.dwt template.
 4. Save the drawing in the sheets folder, 030201-mq.dwg, or following FDM File Naming Con-

ventions.

Create data links

See complete tool documentation here: Sheet Tools - Create data links and tables (wi.gov)

WisDOT Sheets Tab > Sheet Creation Panel > Sheet Tools > Create Data Links and Tables

or Command Line: DOTCreateDataLinksAndTables

 1. Data Links tab

 A. Click the  to select the Excel File containing the tables to be inserted.
 I. The named ranges list will populate with all named ranges within the Excel File.

 B. Use Filter to filter the named ranges if desired
 I. For Example DL*

 C. From the list, select all named ranges to be made into a data link. One data link is 
required for each table that will be created in Civil 3D.

 I. Use Ctrl + Select and/or Shift + Select to select the named ranges desired.
 II. Click Select All to select all named ranges and Deselect All to deselect all 

named ranges.
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 D. Path Type: Relative Path should be chosen if the Excel file is within the Civil 3D pro-
ject

 I. It is recommended to always store the Excel file within the Civil 3D project
 E. Settings (Recommended to leave defaults)

 I. Allow writing to source file: This allows the source Excel file to be directly edited 
from Civil 3D

 II. Use Excel Formatting: All formatting established in the Excel file will be dis-
played in the Civil 3D AutoCAD table

 F. Click OK to create the Data Links
 I. Once finished, Process Complete will show at the bottom of the dialog.

 II. 

Create Civil 3D tables
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Video: pln-prod-misc-qnty-04.mp4 4:47

Dataset: pln-prod-mq-opt-04-data-c3d22.zip

Now that the link from the Excel sheet has been made to the Civil 3D drawing, a table can be created 
in Civil 3D. The table data link will create an AutoCAD table in model space while consuming format-
ting and the table data through the data link from the Excel sheet. Some formatting of the table 
comes from the Civil 3D table style which is why it is important to use the WisDOT Standard table 
style.

Dynamic Relationship: The link between the Excel file and Civil 3D drawing is maintained and is 
dynamic. The table can be edited in Civil 3D and changes pushed back to the Excel file, or the Excel 
file can be updated and consumed in the Civil 3D drawing.

WisDOT Tool: Create Data Links and Tables

See complete tool documentation here: Sheet Tools - Create data links and tables (wi.gov)

 1. Tables tab
 A. Once data links are created in the drawing, the Tables tab list will populate with all 

data links that are available. This tab is used to create the tables in model space.
 B. Use the Filter to filter or search the list if desired.
 C. Select which data links to be made into tables in Civil 3D.

 I. Users have the choice to place one, multiple, or all the tables in one action.
 D. Table Style: WisDOT Standard is the WisDOT default and should be used.
 E. Click OK to place the tables selected from the list.

 I. If multiple datalinks are placed, the tool will build the tables in one single row
 F. Click a location in model space to place the table(s). With the dialog box open, users 

can also adjust the location of tables already placed in model space.
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Info: 
The process of creating tables from data links can be a bit time consuming. While it is pos-
sible to create tables from every single data link, it could take considerable time to do so.

Once the tables are created, they will automatically update with any changes made to the ori-
ginal named range in Excel. If the table/named range expands in rows/columns, the table in 
Civil 3D will also update. Ideally, once a table is created from a named range, that table will 
no longer need to be created in Civil 3D.

Table adjustments, updates, and grid lines

Video: pln-prod-misc-qnty-05.mp4 9:21
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Dataset: pln-prod-mq-opt-05-data-c3d22.zip

Adjust the table dimensions

When inserted, the row and column widths do not exactly match the formatting set within Excel. 
While the table style mostly takes care of row height, the column width needs to be manually adjus-
ted. Adjusting the table utilizing the grips does not affect the display of the text contained within the 
table.

 1. Select the table boarder.
 2. Select one of the grips to adjust the column widths. 

 A. The square grips on the interior will adjust the column widths.
 B. The triangle grip on the top right will adjust the overall table width and adjust the 

columns accordingly. This may be the best option for most tables.

Info: Updating data links and tables will override any table dimension adjustments completed 
in Civil 3D. It is best to format tables in Excel as best as possible and leave the table dimen-
sions after they are built in Civil 3D.

Updates to a data link and table

Civil 3D data links and tables do not automatically update after the Excel file is saved or the DWG is 
opened. Once the DWG is open, the data links update process needs to be manually initiated. Prior 
to updating any tables or data links in Civil 3D, the Excel file must be saved.

Info: Updating data links and tables will override any table dimension adjustments completed 
in Civil 3D. It is best to format tables in Excel as best as possible and leave the table dimen-
sions after they are built in Civil 3D.

Option A:

 1. Annotate tab > Tables > Download from Source
 2. Select which tables to update or choose all data links from the command line.

Option B:

 1. Select the table to be updated > Right Click > Update Table Data Links
Option C:

 1. Click one specific cell in a table > contextual ribbon > Download from Source
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Tip: Every now and then, and especially prior to plotting to PDF, it is recommend to use Option 
A along with all data links to make sure all data links are updated to the latest version from 
the Excel File.

Display of table gridlines in Civil 3D

When placing the tables in model space in Civil 3D, even though the gridlines are turned off in Excel, 
the AutoCAD table gridlines will still display.

Once the table is actually printed to PDF the gridlines will not appear, but the formatting for cell bor-
ders set within Excel will show in the PDF.

If desired to turn off the gridlines, the layer Defpoints can be turned off.

Home Tab > Layers Panel > Layers drop-down > Turn off Defpoints
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Dataset: pln-prod-mq-opt-end-data-c3d22.zip

Option 2: Using paste special links

Warning: This method has a known issue associated with it. Please see "Known issue - Excel 
Civil 3D quantities "Microsoft Excel is waiting for another application to complete an OLE 
action."" on page 99 for more information.

Create file from speed sheet template

pln-prod-misc-qnty-06.mp4 3:42

 1. Civil 3D App menu > New
 A. C:\wisdot\Stnd\C3D20XX\Templates\Sheets\03-MQ-SPSHT-wdot22.dwt Open

There are 20 preset rectangles in modelspace associated with 20 layouts. Instructions 
for using the file are above the sheet rectangles.

 2. Civil 3D App menu > Save As
 A. ProjectID\SheetsPlan\030201-mq.dwg Save

 3. Zoom to rectangle labeled LAYOUT1
 4. In Excel

 A. Open Excel spreadsheet with table of miscellaneous quantities.
 B. Format the content with Font: Calibri Light, Font Size: 8. This will make the excel con-

tent mirror how it looks once pasted into Civil 3D.
 C. Make any visual changes desired in Excel (turn off gridlines, resize column widths, 

wrap text in cells)

Link Excel file to DWG

pln-prod-misc-qnty-07.mp4 4:31

Tip: It is recommended to store Miscellaneous Quantities Excel spreadsheets in <Pro-
jectID>\Design\Quantities\MQ within the Civil 3D project.

 1. In Excel
 A. Select the range of cells to be placed in the plan sheet.
 B. Copy the range to the clipboard (Ctrl+C or Copy from the Microsoft Excel Ribbon)

 2. Activate Civil 3D
 3. Home tab > Clipboard panel > Paste drop-down > Paste Special

 A. Paste Link: checked
 B. As: Microsoft Excel Worksheet
 C. OK
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 4. Digitize the location to place the table.  If the table is to big for the view frame, re-organ-
ize/split the table in excel and re-copy to Civil 3D.  Do not resize/scale the table in Civil 3D to 
fit.

 5. If rows and/or columns of content are added in Excel, the Paste Link will not increase in size. 
It is easiest to delete the existing Paste Link and recreate it from Excel.

 6. Borders will show around the Paste Link objects in the layouts. These borders will not plot.
 7. Add the layouts to the project sheet set for automatic update of the layout title block inform-

ation and publishing to pdf. See "Add sheets to sheet set manually #add" on page 1299 for 
instructions.

Plan/profile sheet
Last updated: 2020-10-26

Total video time: 70:37

Create view frame group file and data shortcut alignments

Exercise files: pln-prod-pln-prof-begin-data-c3d20.zip

pln-prod-pln-prof-01.mp4 3:41

File setup

 1. Create a sheet set for the project if one has not been created yet.  See "Sheet sets" on 
page 1297  for more information.

 2. Start a new drawing from design-start.dwt template
 3. Save file as ProjectID\Design\ViewFrameGroups\VFG-51-pp-100scale.dwg

 A. View frames can be saved in the design file for smaller projects
 B. For longer projects, the plan and profile sheets may be separated into multiple draw-

ings. This process keeps the view frames uniform throughout multiple drawings. A sep-
arate view frame group file does NOT need to be created if your project doesn’t 
warrant it.

 C. Generally a 1IN:100FT scale is used for rural projects, 1IN:40FT or 1IN:50FT scale is 
more ideal for urban projects

 4. Annotation scale: 1IN:100FT
 5. Data reference 

 A. Toolspace palette > Prospector tab > Data Shortcuts > Centerline Alignments > 
51 > Right-click > Create Reference...

 I. OK
 B. Toolspace palette > Prospector tab > Data Shortcuts > Centerline Alignments > 

51 > Profiles > 51 > Right-click > Create Reference...
 I. OK
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Tip: It is important to add the profile before the view frames are created.  
The view frames need to “know” this information for later when the pro-
file views are added to the layouts.

 C. Toolspace palette > Prospector tab > Data Shortcuts > Centerline Alignments > 
Lcl-Tuckaway Rd. > Right-click > Create Reference...

 I. OK
 D. Toolspace palette > Prospector tab > Data Shortcuts > Centerline Alignments > 

47 > Right-click > Create Reference...
 I. OK

 6. Double-click the center mouse wheel to zoom extents.
 7. Save the file.

Create view frames and group 1

pln-prod-pln-prof-02.mp4 2:44

 1. Output tab > Plan Production panel > Create View Frames
 2. Create View Frames dialog box 

 A. Alignment: 51
 I. Station Range: User Specified

 a. Start station: 547+00
 b. End station: 606+00
 c. User specified start station should be to the nearest +25/50/100 station 

before the construction limits. The end station should be to the nearest 
+25/50/100 station beyond the construction limits.

 B. Sheets 
 I. Sheet Settings 

 a. Sheet Type: Plan and Profile
 b. Template for Plan and Profile sheet 

 i. ... > Drawing template file name: C:\Wis-
dot\Stnd\C3D20XX\Templates\Sheets\05-PP-wdot.dwt

 i. Select the ellipse button for additional sheet templates
 ii. Select a layout to create new sheets: PlanProf 1 IN 100FT
 iii. OK

 II. View Frame Placement 
 a. Set the first view before the start of the alignment: Not checked

 i. If the view frames are not created in the desired locations, delete 
them and recreate the frames from an earlier start station. This 
option may be used if needed.

Create view frames and group 2

pln-prod-pln-prof-03.mp4 3:20
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 1. Output tab > Plan Production panel > Create View Frames (continued)         
 C. View Frame Group             

 I. View Frame Group > Name: VFG - 51-100-pp
 II. View Frame > Name: Click on Edit View frame Group name... icon

 a. Name 
 i. Delete and clear out default name
 ii. Property fields: dropdown > select Next Counter
 iii. Insert

 b. Number style dropdown: 01, 02, 03...
 c. Starting number: 1
 d. OK

 D. Match Lines             
 I. Positioning 

 a. Snap station value down to the nearest: checked
 b. Snap station value down to the nearest value: 10

 II. Match Line 
 a. Style: Match Line (No Plot)

 i. match lines will display in the file so their location is visible but 
they will not plot

 III. Labels 
 a. Left label style: none
 b. Right label style: none

 E. Profile Views             
 I. Profile View Style 

 a. Select profile view style dropdown: Stations 100'Major:50'Minor 
1:10Vert Ex

 II. Band Set 
 a. Select band set style dropdown: Elevation Both (Existing Left Pro-

posed Right)
 F. Create View Frames

 2. Save the file       

Edit view frame locations

pln-prod-pln-prof-04.mp4 2:30

Review the view frame placement along the alignment.

Tip: Any view frame location changes should be made before profile views are made and 
sheets are created.   Sheets are not updated if the view frames are moved after the sheets have 
been created, this is a one time operation.

There are multiple options for adjusting the view frames to the desired location before the sheets 
are created.
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Option 1 - Shifting all the view frames

If the view frames are not created in the desired locations, delete them and recreate the frames 
from an earlier start station.

 1. Output tab > Plan Production panel > Create View Frames
 A. Sheets 

 I. View Frame Placement 
 a. Set the first view before the start of the alignment by: checked
 b. Set the first view before the start of the alignment by: distance in feet

Option 2 - Create multiple view frame groups

Multiple view frame groups may created along the same alignment, each covering different seg-
ments of the project.  This option may be helpful for projects with multiple intersection locations.

Option 3 - Use grips to adjust individual view frames

Select the view frame

 l Circular grip - rotates the view frame       
 l Diamond grip - slides the view frame along the alignment       
 l Square grip - moves the view frame anywhere in model space       

Create data shortcuts

 1. Save the drawing.
 2. Toolspace palette > Prospector tab > Right-click on Data Shortcuts > Create Data Short-

cuts...
 A. Select the view frame group(s) that will be referenced into other drawings.
 B. OK

Create plan/profile sheet file with XREFs and data shortcuts

pln-prod-pln-prof-05.mp4 4:44

File setup

 1. Start a new drawing from design-start.dwt template
 2. Save file as ProjectID\SheetsPlan/050101-pp.dwg
 3. Data reference: 

 A. Existing surface (Exist, _No Display style)
 B. Mainline and sideroad reference alignments (47, 51, Lcl-Tuckaway Rd.)
 C. Mainline reference alignment design profile (51)
 D. Pipe networks that will be shown in plan and profile sheets (582+50)
 E. View frame groups that will be used for the plan and profile sheets (VFG - 51-100-pp)
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 4. X-ref files: 
 A. Existing topography (Topo-ex.dwg)
 B. Existing utilities (Uti-ex.dwg)
 C. Survey control (SurvCntrl.dwg)
 D. Pavement edgelines (pavt.dwg)
 E. Slope intercepts (SI.dwg)
 F. Ultimate right-of-way (Ult-RW.dwg)

 5. Annotation scale: 1IN:100FT
 6. WisDOT Sheets tab > Standard Components panel > Add All Components

 A. Add All Components will add all the WisDOT plan production elements (leader styles, 
dimension styles, etc.) that are not initially included in the WisDOT drawing template.

 7. Create existing profile along the mainline reference alignment.

Data reference View Frame Groups

 1. Toolspace palette > Prospector tab > Data Shortcuts > View Frame Groups > Right-click 
VFG-51-100-pp > Create Reference...

 A. View frame: View frame style: WisDOT Standard
 B. View frame: View frame label style: No Labels
 C. Match line: Match line style: Match Line (No Plot)
 D. Match line: Match line left label style: _No Display
 E. Match line: Match line right label style: _No Display
 F. Alignment: 51
 G. OK

 2. Save the file

Create sheets and profile views in plan/profile sheet file

pln-prod-pln-prof-06.mp4 6:45

 1. Output tab > Plan Production panel > Create Sheets
 2. View Frame Group and Layouts 

 A. View Frame Group: VFG - 51-100-pp
 B. View frame range: All
 C. Layout Creation: All layouts in the current drawing
 D. Layout name: Click on Edit layout name... icon

 I. Name 
 a. Delete and clear out default name
 b. Property fields: dropdown > select Next Counter
 c. Insert

 II. Number style dropdown: 01, 02, 03...
 III. Starting number: 1
 IV. OK

 E. Choose the north arrow block to align in layouts: SheetWizard-NorthArrow
 3. Sheet Set 

 A. Sheet Set: select Add to existing sheet set
 I. Click the ellipse icon to select sheet set: 11701902\SheetsPlan\11701902.dst

Page: 1563

Published on: 5/17/2023

Create sheets and profile views in plan/profile sheet file

https://c3dkb.dot.wi.gov/video/pln-prod/pln-prod-pln-prof-06.mp4


 B. Sheets > Sheet files storage location: 11701902\SheetsPlan
 4. Profile Views 

 A. Other profile view options 
 I. Choose settings: selected

 a. Profile View Wizard... 
 i. Profile View Height 

 i. Profile view datum by: dropdown: Mean elevation
 ii. Profile Display Options 

 i. 51 design profile style: PROF Proposed
 ii. Exist-51 existing profile style: PROF Existing
 iii. 51 proposed profile label set: _No Labels
 iv. Exist-51 existing profile label set: _No Labels

 iii. Pipe/Pressure Network 
 i. 582+50: selected

 iv. Data Bands 
 i. Style: Elevation Left (Exist), Profile1: Exist-51
 ii. Style: Elevation Left (Exist), Profile2: Exist-51
 iii. Style: Elevation Right (Proposed), Profile1: 51
 iv. Style: Elevation Right (Proposed), Profile2: 51

 v. Finish
 B. Create Sheets

 5. OK
 6. CREATESHEETS Select profile view origin :Click the location where the lower 

left corner of the profile view will be placed
 7. Click the green check mark to dismiss the Panorama
 8. REA Enter

 A. This may be needed to regenerate the graphics in order for the profile view grid lines 
to be displayed

 9. Save the file.

Add sheets to Sheet Set Manager and edit sheet set

pln-prod-pln-prof-07.mp4 2:21

The Create Sheets wizard creates a subset of the new sheets created.  Use the Sheet Set Manager 
palette to organize the sheets.

 1. SSM (if Sheet Set Manager is not open)
 2. Open 11701902\SheetsPlan\11701902.dst
 3. Right-click subset 05 > New Subset..

 A. Subset Name: USH 51
 I. Name should be entered as it will appear on the plan sheet title block

 B. OK
 4. Shift-select the all the sheets from the VFG-51-100-pp group
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 5. Click drag and drop the selected sheets into the USH 51 subset. 
 A. Destination location will turn blue when hovering over subset icon
 B. Make sure sheets end up in the correct subset

 6. Right-click a sheet number within the USH 51 subset > Rename & Renumber...
 A. Number: delete number and leave blank
 B. Next
 C. Remove the Number from all the sheets within the subset
 D. OK when finished

 7. Right-click VFG-51-100-pp subset > Remove Subset

Review warning symbols in profile views

pln-prod-pln-prof-08.mp4 4:15

Placing north arrow

 1. Click the Model tab to work in model space
 2. Make sure that Tool Palette is visible 

 A. WisDOT Sheets tab > Palettes On/Off to toggle the palette on and off.
 3. WisDOT Sheets tab > Sheet Creation panel > Plan/Profile

 A. Plan/Profile palette > Plan/Profile tab > Blocks heading - Click North Arrow
 I. EXECUTETOOL Specify insertion point or [Basepoint Scale X Y 

Z Rotate]:Click to place North arrow in the desired location within the 
view frame

 4. Select the placed north arrow
 5. Right-click > Basic Modify Tools > Copy 

 A. COPY Specify base point or [Displacement mOde]:

 I. Click near the north arrow to specify a base point
 B. COPY Specify second point or [Array]:

 I. Click to place a north arrow inside each view frame
 C. Right-click > Enter

 I. Copy command is ended

Warning symbols

Warning symbols may appear indicating that the proposed profile does not meet certain design cri-
teria.

 1. REA

 A. This may be needed to regenerate the graphics in order to reduce the size of the warn-
ing symbols.

Info: 
Warning symbols appear on the screen but will not plot on the plan sheets.

It is highly recommended that the warning symbols are left on to indicate to anyone using 
the file that there may be certain elements of the proposed profile that do not meet design 
criteria.
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For rare cases where the warning symbols need to be turned off:

 1. Select a warning symbol
 2. Profile 51 contextual ribbon > Modify Profile Reference panel > Profile Properties
 3. Profile Properties dialog box 

 A. Information tab 
 I. Object style: PROF Proposed

 II. Click on the icon with the pencil right of the Object style dropdown to edit the 
PROF Proposed object style 

 a. Profile Style - PROF Proposed dialog box > Display tab 
 i. Component display: Warning Symbols Visibility: Off
 ii. Component display: Notification Symbols Visibility: Off
 iii. OK

 i. Message: This style comes from a reference template 
that cannot be edited.  What do you want to do?

 i. Make a local copy of the style with a unique 
name A new, local copy of this style will be created 
with a new name. It will exist in the drawing and 
will not be added to the reference template.

 ii. OK A new style named PROF Proposed - Copy is 
created and applied

 4. Esc
 A. The profile is no longer selected.

Adjust vertical location of profiles in profile views

pln-prod-pln-prof-09.mp4 1:55

 1. Select the grid of a profile view
 2. Profile View contextual ribbon > Modify View panel > Profile View Properties

 A. Profile View Properties dialog box 
 I. Elevations tab 

 a. Split profile view: checked
 b. Manual: selected
 c. Split profile view data table: Adjusted Datum value: 1584

 i. Enter a lower number than the current value to raise the profile.
 ii. Enter a higher number than the current value to lower the pro-

file.
 d. OK

 3. Esc
 A. The profile view is no longer selected

Repeat the process for each profile view that needs to be adjusted.

Add and edit profile label sets

Page: 1566

Published on: 5/17/2023

Adjust vertical location of profiles in profile views

https://c3dkb.dot.wi.gov/video/pln-prod/pln-prod-pln-prof-09.mp4


pln-prod-pln-prof-10.mp4 3:16

 1. Check that the existing ground profile is dashed and is assigned the PROF Existing style
 2. Check that the proposed design profile is solid and is assigned the PROF Proposed style

Add profile label sets

 1. Select the proposed profile > Right-click > Edit Labels...
 A. Label set editor 

 I. Import label set... 
 a. WisDOT Standard
 b. OK

 II. OK

Edit profile labels

 1. Click to select label
 l Vertical Curve Length label

 o Diamond grip - slides label up and down
 o Square grip - moves label - DO NOT use this

 l VPC and VPT curve labels
 o Diamond grip - slides label up and down, it is located along the VPI label

 l Profile grade labels
 o Square grip - moves label, careful that it is not moved to so it looks like it is labeling 

something else
 2. To reset all labels         

 o Select label whose location has been modified
 l Right-click > Reset All Group Labels 

 o This action will reset all the labels
 3. Review appearance of labels in the layout sheets
 4. Right-click over Layout1 tab > Delete > OK

 A. Layout1  will not be used in the file is deleted.
 5. Save the file.

Add and edit alignment tangent and curve labels

pln-prod-pln-prof-11.mp4 4:02

 1. 03 layout tab > Double-Click inside the plan viewport
 A. Model space is activated within the viewport

 2. Add alignment tangent and curve labels 
 A. Annotate tab > Labels & Tables panel > Add Labels dropdown > Alignment > 

Add Alignment Labels
 I. Add Labels dialog box 

 a. Feature: Alignment
 b. Label type: Multiple Segment
 c. Line label style: General Line Label Style > Bearing Distance
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 d. Curve label style: Curve Label Style > PI XY ^ D T L R PC PT
 e. Press Add

 i. ADDALIGNSEGLBLS Select Alignment: Select alignment
 B. Enter to exit the labeling command
 C. Close to exit the Add Labels dialog box

 3. Edit curve label location 
 A. Select alignment curve label
 B. Select rhombus grip and drag label to desired location

 4. Edit bearing and distance label location 
 A. Select bearing and distance label
 B. Select diamond grip to slide the label to the desired location

 5. Edit side road alignment labels 
 A. Select side road alignment geometry labels
 B. Labels - Alignment Geometry Point Label Group contextual ribbon > Modify 

panel > Edit Label Group
 I. Edit Label Group dialog box 

 a. Select Geometry Points label type
 b. Click red X 

 i. Geometry Point label type line is removed
 c. OK

 6. Double-click outside the viewport
 A. Working in model space within the layout is deactivated

 7. Repeat the process for other layouts

Add benchmarks

pln-prod-pln-prof-12.mp4 4:13

 1. Steps to take before adding the benchmark description text if they have not been done pre-
viously 

 A. WisDOT Sheets tab > Standard Components panel > Add All Components will add 
all the WisDOT plan production elements (leader styles, dimension styles, etc.) that are 
not initially included in the WisDOT drawing template.

 B. 03 layout tab > Double-Click inside the plan viewport Model space is activated 
within the viewport

 C. UCS Enter
 I. UCS Specify origin of UCS or [Face NAmed OBject Previous 

View World X Y Z ZAxis]:VEnter
 D. Home tab > Layers panel > Layer dropdown > quickly type P_M > scroll to and 

select P_MISC_Text
 2. Add multileader text to describe benchmark 

 A. WisDOT Sheets tab > WisDOT Annotation panel > Multileader style dropdown > 
Default Text 070
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 B. WisDOT Sheets tab > WisDOT Annotation panel > Multileader
 I. MLEADER Specify leader arrowhead location or [leader Land-

ing first Content first Options]:Click location of arrowhead at 
the benchmark location

 II. MLEADER Specify leader landing location:Select location for text
 a. Type CONTROL POINT 28

 i. Check that text is in all CAPS. Right-click > All CAPS
 ii. Click drag to expand text box
 iii. Enter to add more lines of text
 iv. Type additional lines of text as needed
 v. Click outside of the text box to end the command

 3. Move multileader text to desired location 
 A. Select the multileader text
 B. Select the upper left grip around the text and move the text to the desired location.
 C. Click to select new location

 4. Repeat the process to describe additional benchmarks
 5. Final steps 

 A. Double-Click outside the viewport
 I. Working in model space within the layout is deactivated

 B. Save the file

Add benchmark table

pln-prod-pln-prof-13.mp4 4:54

 1. Steps to take before adding the benchmark table if they have not been done previously 
 A. WisDOT Sheets tab > Standard Components panel > Add All Components

 I. Add All Components will add all the WisDOT plan production elements (leader 
styles, dimension styles, etc.) that are not initially included in the WisDOT draw-
ing template.
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 B. 03 layout tab > Double-Click inside the plan viewport
 I. Model space is activated within the viewport

 C. UCS
 I. UCS Specify origin of UCS or [Face NAmed OBject Previous 

View World X Y Z ZAxis]:VEnter
 2. Insert the benchmark table dynamic block 

 A. WisDOT Sheet tab > Sheets Creation panel > Plan/Profile palette > PlanProfile 
palette tab > Blocks heading > Select Benchmark Table dynamic block

 I. EXECUTETOOL Specify insertion point or [Basepoint Scale X Y 

Z Rotate]:Click to place the block
 II. Block attribute editor 

 a. If there is only one benchmark on the sheet 
 i. type in the benchmark attribute data

 b. if there is more than one benchmark on the sheet
 i. OK

 III. select the benchmark table
 IV. Click the visibility state downward pointing triangle 

 a. Select how many benchmarks are on the sheet
 b. Esc

 3. Enter benchmark information in the table 
 A. Double Click on the benchmark table 

 I. Enhanced Attribute Editor dialog box is opened 
 a. Select the Tag NO-1
 b. Value: 32
 c. Enter
 d. STA-1 value: 579+05.63 RT
 e. Enter
 f. ELEV-1 value: 1600.413
 g. Enter
 h. DESC-1 value: CP 27  0.75" IRON ROD SET WITH BLUE CAP
 i. Repeat the process for addition benchmarks
 j. OK

 4. Move the benchmark table to desired location 
 A. Select the benchmark table
 B. Right-click > Basic Modify Tools > Move 

 I. MOVE Specify base point or [Displacement]:Click near table to 
establish base point

 II. MOVE Specify second point:Move table and Click at desired location
 5. Hide sheet data behind the benchmark table 

 A. WIPEOUT

 I. WIPEOUT Specify first point or [Frames Polyline]:Endpoint 
snap to the upper left corner of the table

 II. WIPEOUT Specify next point:Endpoint snap to the lower left corner 
of the table

 III. WIPEOUT Specify next point or [Undo]:Endpoint snap to the lower 
right corner of the table

Page: 1570

Published on: 5/17/2023

Add benchmark table



 IV. WIPEOUT Specify next point or [Close Undo]:Endpoint snap to 
the upper right corner of the table

 V. Right-click > Enter
 B. Select the table 

 I. Turn on Selection Cycling if needed to help select the table block
 C. Right-click > Display Order > Bring to Front

 6. Final steps 
 A. Double-Click outside the viewport

 I. Working in model space within the layout is deactivated
 B. Save the file

Add sawcut line

pln-prod-pln-prof-14.mp4 2:01

 1. Steps to take before adding the sawcut line if they have not been done previously 
 A. WisDOT Sheets tab > Standard Components panel > Add All Components

 I. Add All Components will add all the WisDOT plan production elements (leader 
styles, dimension styles, etc.) that are not initially included in the WisDOT draw-
ing template.

 B. 03 layout tab > Double-Click inside the plan viewport
 I. Model space is activated within the viewport

 C. WisDOT Sheets tab > Support panel > Toggle OsnapZ
 I. OSNAPZ: 1 

 a. Osnap substitutes the Z-value of the specified point with the elevation 
set for the current UCS plane (Elevation: 0)

 2. Add sawcut line 
 A. Home tab > Layers panel > Layer dropdown > quickly type P_R > scroll to and 

select P_RDWY_SawCutX
 B. Home tab > Draw panel > Line dropdown > Create Line

 I. LINE Specify first point: Shift-right-click Endpoint snap to the left side 
of the side road limits

 II. LINE Specify next point or [Undo]: Shift-right-click Endpoint snap to 
the right side of the side road limits

 III. Enter
 C. REA Enter

 I. This may be needed to regenerate the graphics displayed
 3. Repeat the process to describe additional sawcut lines
 4. Final steps 

 A. (Optional) WisDOT Sheets tab > Support panel > Toggle OsnapZ
 I. OSNAPZ: 0 
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 a. Osnap uses the Z-value of the specified point
 b. This step is only needed if one needs to snap to the actual elevation

 B. Double-click outside the viewport
 I. Working in model space within the layout is deactivated

 C. Save the file

Add end construction multileader

pln-prod-pln-prof-15.mp4 2:11

 1. Steps to take before adding the construction multileader if they have not been done pre-
viously 

 A. WisDOT Sheets tab > Standard Components panel > Add All Components
 I. Add All Components will add all the WisDOT plan production elements (leader 

styles, dimension styles, etc.) that are not initially included in the WisDOT draw-
ing template.

 B. 03 layout tab > Double-Click inside the plan viewport
 I. Model space is activated within the viewport

 C. UCS
 I. UCS Specify origin of UCS or [Face NAmed OBject Previous 

View World X Y Z ZAxis]:VEnter
 2. Insert the "End Construction" multileader 

 A. Home tab > Layers panel > Layer dropdown > quickly type P_R > scroll to and 
select P_MISC_Text

 B. WisDOT Sheet tab > Sheets Creation panel > Plan/Profile palette > PlanProfile 
palette tab > Multileaders heading > Click END CONST STA MATCH multileader

 I. EXECUTETOOL Specify leader arrowhead location or [leader 
Landing first Content first Options]:

 a. Shift right-click > Apparent Intersection snap
 b. Click the multileader arrow location at the intersection of the 

alignment and sawcut line
 II. EXECUTETOOL Specify leader landing location:Select location of 

text
 III. EXECUTETOOL Overwrite default text [Yes No]:No

 3. Modify the location of the construction multileader 
 A. Select the multileader text
 B. Select the square grip at the upper left corner of the text 

 I. Specify stretch point or [Base point Copy Undo eXit]:Click 
the location where the text will be moved to

 II. Esc
 4. Modify the text of the construction multileader 

 A. Double-click the text
 B. Click drag to select the station information (XXX+XX)
 C. Type 3+50
 D. Click outside text box to end the edit
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 5. Final steps 
 A. Double-Click outside the viewport

 I. Working in model space within the layout is deactivated
 B. Save the file

Add multileader notes

pln-prod-pln-prof-16.mp4 3:30

 1. Steps to take before adding the multileader notes if they have not been done previously 
 A. WisDOT Sheets tab > Standard Components panel > Add All Components

 I. Add All Components will add all the WisDOT plan production elements (leader 
styles, dimension styles, etc.) that are not initially included in the WisDOT draw-
ing template.

 B. 03 layout tab > Double-Click inside the plan viewport
 I. Model space is activated within the viewport

 C. UCS
 I. UCS Specify origin of UCS or [Face NAmed OBject Previous 

View World X Y Z ZAxis]:V
 2. Insert circle tag multileader 

 A. WisDOT Sheet tab > Sheets Creation panel > Plan/Profile palette > PlanProfile 
palette tab > Set Layer heading > Click P_MISC_Text

 B. WisDOT Sheets tab > WisDOT Annotation panel > Multileader style dropdown > 
070-CIRCLETAG

 C. WisDOT Sheets tab > WisDOT Annotation panel > Multileader
 I. MLEADER Specify leader arrowhead location or [leader Land-

ing first Content first Options]:Click location of arrowhead loc-
ation

 II. MLEADER Specify leader landing location:Click location of text
 III. Block attribute editor 

 a. Enter tag number: 2
 b. OK

 IV.  Select the multileader> right-click > Add Leader
 a. MLEADEREDIT Specify leader arrowhead location or 

[Remove leaders]:Select arrowhead location
 b. Right-click > Enter

 3. Place slope intercept multileader 
 A. WisDOT Sheet tab > Sheets Creation panel > Plan/Profile palette > PlanProfile 

palette tab > Multileaders heading > Click SI
 I. MLEADER Specify leader arrowhead location or [leader Land-

ing first Content first Options]:

 a. Shift+right-click > Nearest snapSnap to the slope intercept line
 II. MLEADER Specify leader landing location:Click location of text

 III. EXECUTETOOL Overwrite default text [Yes No]:No
 4. Place existing right-of-way multileader 

 A. WisDOT Sheet tab > Sheets Creation panel > Plan/Profile palette > PlanProfile 
palette tab > Multileaders heading > Click EXISTING ROW
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 I. MLEADER Specify leader arrowhead location or [leader Land-
ing first Content first Options]:

 a. Shift+right-click > Nearest snap Snap to the existing right-of-way 
line

 II. MLEADER Specify leader landing location:Click location of text
 III. EXECUTETOOL Overwrite default text [Yes No]:No

 5. Place right-of-way multileader 
 A. WisDOT Sheet tab > Sheets Creation panel > Plan/Profile palette > PlanProfile 

palette tab > Multileaders heading > Click ROW
 I. MLEADER Specify leader arrowhead location or [leader Land-

ing first Content first Options]:

 a. Shift+right-click > Nearest snap Snap to the right-of-way line
 II. MLEADER Specify leader landing location:Click location of text

 III. EXECUTETOOL Overwrite default text [Yes No]:No
 6. Rotate and move multileader text 

 A. Select the SI, EXISTING ROW and the ROW multileaders
 B. Right-click > Properties > Text heading 

 I. Rotation: 0Enter
 C. Select the square grip at the upper left corner of the multileader text 

 I. Specify stretch point or [Base point Copy Undo eXit]:Click 
the location where the text will be moved to

 D. Esc
 I. Multileaders are unselected

 7. Final steps 
 A. Double-click outside the viewport

 I. Working in model space within the layout is deactivated
 B. Save the file

Add CAUTION block

pln-prod-pln-prof-17.mp4 1:10

 1. Steps to take before adding the CAUTION block if they have not been done previously 
 A. WisDOT Sheets tab > Standard Components panel > Add All Components

 I. Add All Components will add all the WisDOT plan production elements (leader 
styles, dimension styles, etc.) that are not initially included in the WisDOT draw-
ing template.

 B. 03 layout tab > Double-Click inside the plan viewport
 I. Model space is activated within the viewport

 C. UCS
 I. UCS Specify origin of UCS or [Face NAmed OBject Previous 

View World X Y Z ZAxis]:V
 D. Home tab > Layers panel > Layer dropdown > quickly type P_M > scroll to and 

select P_MISC_Text
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 2. Insert CAUTION block 
 A. WisDOT Sheet tab > Sheets Creation panel > Plan/Profile palette > PlanProfile 

palette tab > Blocks heading > Select CAUTION block
 I. EXECUTETOOL Specify insertion point or [Basepoint Scale X Y 

Z Rotate]:Click to place the block
 B. WisDOT Sheets tab > WisDOT Annotation panel > Multileader style dropdown > 

Default Text 070
 C. WisDOT Sheets tab > WisDOT Annotation panel > Multileader

 I. MLEADER Specify leader arrowhead location or [leader Land-

ing first Content first Options]:Click location of arrowhead at 
the desired location

 II. MLEADER Specify leader landing location:Select location next to 
the CAUTION block

 III. Click outside the multileader 
 a. Multileader is unselected

 3. Final steps 
 A. Double-Click outside the viewport

 I. Working in model space within the layout is deactivated
 B. Save the file

Add text for utility names

pln-prod-pln-prof-18.mp4 2:15

 1. Steps to take before adding the utility names if they have not been done previously 
 A. WisDOT Sheets tab > Standard Components panel > Add All Components will add 

all the WisDOT plan production elements (leader styles, dimension styles, etc.) that are 
not initially included in the WisDOT drawing template.

 B. 03 layout tab > Double-Click inside the plan viewport Model space is activated 
within the viewport

 C. UCS Enter
 I. UCS Specify origin of UCS or [Face NAmed OBject Previous 

View World X Y Z ZAxis]:VEnter
 D. Home tab > Layers panel > Layer dropdown > quickly type P_M > scroll to and 

select P_MISC_Text
 2. Insert multiline text 

 A. WisDOT Sheets tab > WisDOT Annotation panel dropdown > Set WisDOT 
Textstyle/Size

 I. WisDOT Annotate dialog box 
 a. Font type: CalibriLight
 b. Font height: 0.070
 c. Open Annotate Ribbon

 B. Annotate tab > Text panel > Multiline Text 
 I. MTEXT Specify first corner:Click first corner at the top left

 II. MTEXT Specify opposite corner or [Height Justify Line spa-

cing Rotation Style Width Columns]:Click opposite corner at the 
bottom right
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 III. MTEXT:

 a. type the name of the utility company
 b. Enter
 c. Enter
 d. Enter

 IV. Click outside the multiline text box
 V. Select the multiline text > right-click > Basic Modify Tools > Copy

 a.  COPY Specify base point or [Displacement mOde]:Click 
near text

 b. F8 to turn on ORTHOMODE
 c. COPY Specify second point or [Array]:Click location for 

copied text
 d. Esc

 VI. Double Click copied text 
 a. Edit copied text
 b. Esc

Create and edit utility legend

pln-prod-pln-prof-19.mp4 5:26

 1. Create legend header text 
 A. WisDOT Sheets tab > WisDOT Annotation panel dropdown > Set WisDOT 

Textstyle/Size
 I. WisDOT Annotate dialog box 

 a. Font type: CalibriLight
 b. Font height: 0.0875
 c. Open Annotate Ribbon

 B. Annotate tab > Text panel > Multiline Text 
 I. MTEXT Specify first corner:Click first corner at the top left

 II. MTEXT Specify opposite corner or [Height Justify Line spa-

cing Rotation Style Width Columns]:Click opposite corner at the 
bottom right

 III. MTEXT: type UTILITY LEGENDClick
 IV. Click outside the multiline text
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 C.  Select the multiline text > right-click > Justify
 I. JUSTIFYTEXT [Left Align Fit Center Middle Right TL TC TR ML 

MC MR BL BC BR]:MC 
 2. Create outside border of legend table 

 A. Home tab > Draw panel > Rectangle 
 I. RECTANG Specify first corner point [Chamfer Elevation Fil-

let Thickness Width]:Click first corner at the top left
 II. RECTANG Specify other corner point or [Area Dimensions Rota-

tion]:Click opposite corner at the bottom right
 B. Adjust the shape of the border using the grips

 3. Create legend header border 
 A. Home tab > Draw panel > Rectangle 

 I. RECTANG Specify first corner point [Chamfer Elevation Fil-
let Thickness Width]:

 a. Shift+right-click > Endpoint Snap at the top left corner of the out-
side legend border

 II. RECTANG Specify other corner point or [Area Dimensions Rota-
tion]:

 a. Shift+right-click > Nearest Snap the opposite corner along the 
right side of the outside border

 4. Center table header text 
 A. Select header text UTILITY LEGEND
 B. Select the middle center grip of text 

 I. Specify stretch point or [Base point Copy Undo eXit]:

 a. Shift+right-click > Mid Between 2 Points 
 i. First point of mid:

 i. Shift+right-click > Midpoint 
 i. mid of: Snap to the left side of the legend 

header rectangle
 ii. Second point of mid:

 i. Shift right-click > Midpoint 
 i. mid of:Snap to the right side of the legend 

header rectangle
 C. Esc

 5. Insert circle tag 
 A. WisDOT Sheets tab > WisDOT Annotation panel > Multileader style dropdown > 

070-CIRCLETAG
 B. WisDOT Sheets tab > WisDOT Annotation panel > Multileader

 I. MLEADER Specify leader arrowhead location or [leader Land-

ing first Content first Options]:Click location of arrowhead loc-
ation

 a. F8 to turn off ORTHOMODE if needed
 II. MLEADER Specify leader landing location:Click location of text to 

the left of the utility name
 III. Block attribute editor 

 a. Enter tag number: 1
 b. OK
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 IV.  Select the multileader > right-click > Remove Leader
 a. MLEADEREDIT Specify leaders to remove or [Add lead-

ers]:Select the multileader
 b. Enter

 V.  Select the circle tag > right-click > Basic Modify Tools > Move
 a. MOVE Specify base point or [Displacement]:Click location 

near circle tag
 b. MOVE Specify second point or < use first point as dis-

placement >:Click to move circle tag to desired location
 6. Duplicate circle tags 

 A. COEnter
 I. COPY Select objects:Select circle tag in the legend

 a. Enter
 b. COPY Specify base point or [Displacement mOde]:Click loc-

ation near circle tag to be copied
 c. F8 to turn on ORTHOMODE
 d. COPY Specify second point or [Array Exit Undo]:Click at 

the location where the copied circle tags will be placed
 e. Enter

 B. Repeat the process as many times as needed 3. Multiple circle tags can be copied at 
the same time

 7. Update numbers within circle tags 
 A. Double-click the circle tag 

 I. Block attribute editor 
 a. Enter tag number: 2
 b. OK

 B. Repeat the process as many times as needed
 8. Hide sheet data behind the legend table 

 A. WIPEOUT Enter
 I. WIPEOUT Specify first point or [Frames Polyline]:Endpoint 

snap to the upper left corner of the table
 II. WIPEOUT Specify next point:Endpoint snap to the lower left corner 

of the table
 III. WIPEOUT Specify next point or [Undo]:Endpoint snap to the lower 

right corner of the table
 IV. WIPEOUT Specify next point or [Close Undo]:Endpoint snap to 

the upper right corner of the table
 V. Right-click > Enter

 B.  Select the Wipeout >right-click > Display Order > Bring Above Object
Turn on Selection Cycling if needed to help select the wipeout

 I. Select reference objects: Select XREF data and additional sheet data that 
should not appear within the legend table

 II. Enter
 III. REA Enter This may be needed to regenerate the graphics
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 9. Final steps 
 A. Double-Click outside the viewport

 I. Working in model space within the layout is deactivated
 B. Save the file

Add and label ditch profiles, cross pipe, and flow arrows

pln-prod-pln-prof-20.mp4 5:16

Initial steps

Steps to take before adding ditch profile labels, cross pipes and flow arrows if they have not been 
done previously

 1. WisDOT Sheets tab > Standard Components panel > Add All Components
 A. Add All Components will add all the WisDOT plan production elements (leader styles, 

dimension styles, etc.) that are not initially included in the WisDOT drawing template.
 2. 03 layout tab > Double-Click inside the plan or profile viewport

 A. Model space is activated within the viewport
 3. UCS (when working in plan viewport) 

 A. UCS Specify origin of UCS or [Face NAmed OBject Previous View 

World X Y Z ZAxis]:V

Add ditch profiles

 1. Home tab > Layers panel > Layer dropdown > quickly type P_M > scroll to and select P_
MISC_Text

 2. Toolspace palette > Prospector tab > Data Shortcuts > Alignments > Centerline Align-
ments > 51 > Profiles > Right-click 51-Ditch-LT > Create Reference

 A. Create Profile Reference dialog box 
 I. Profile style: PROF Ditch Flow Line

 II. Profile label set: _No Labels
 III. OK

 3. Repeat the process for the 51-Ditch-RT profile
 4. Add multileader text to label right ditch profile 

 A. WisDOT Sheets tab > WisDOT Annotation panel > Multileader style dropdown > 
Default Text 070

 B. WisDOT Sheets tab > WisDOT Annotation panel > Multileader
 I. MLEADER Specify leader arrowhead location or [leader Land-

ing first Content first Options]:Click location along the ditch 
profile

 II. MLEADER Specify leader landing location:Click location of text
 a. Type DITCH PROFILE RIGHT

 i. Check that text is in all CAPS 
 i. Right-click > All CAPS 

 ii. Select outside of the text box to end the command
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 5. Alternate label method: begin with PROPOSED PROFILE multileader to label left ditch 
 A. WisDOT Sheet tab > Sheets Creation panel > Plan/Profile palette > PlanProfile 

palette tab > Multileaders heading > Click PROPOSED PROFILE
 I. MLEADER Specify leader arrowhead location or [leader Land-

ing first Content first Options]:

 a. Shift+right-click > Nearest snap
 b. Snap to the ditch profile

 II. MLEADER Specify leader landing location:Click location of text
 III. EXECUTETOOL Overwrite default text [Yes No]:Yes
 IV. Type DITCH PROFILE LEFT
 V. Select outside of the text box to end the command

Add culvert pipes in profile view

 1. Home tab > Layers panel > Layer dropdown > quickly type P_P > scroll to and select P_
PROF_Culvert

 2. Select the profile grid
 3. Profile View Contextual ribbon > Modify View panel > Profile View Properties

 A. Profile View Properties dialog box 
 I. Pipe Network tab 

 a. Unselect to draw the structures
 b. Unselect the 582+50B culvert pipe
 c. OK

 II. Esc

Add flow arrows

 1. Home tab > Layers panel > Layer dropdown > quickly type P_E > scroll to and select P_
EC_FlowArrow

 2. WisDOT Sheets tab > Sheets Creation panel > Construction Details dropdown > Drain-
age and Utilities palette > Erosion Control tab > Blocks heading > Click EC Flow Arrow

 A. EXECUTETOOL Specify insertion point or [Basepoint Scale X Y Z 

Rotate]:Select location for flow arrow
 B. EXECUTETOOL Specify rotation angle:Click orientation of flow arrow

 3. Modify orientation of flow arrow 
 A. Select the flow arrow
 B. Select circular grip 

 I. Specify rotation angle or [Base point Undo eXit]:Click ori-
entation of flow arrow

 C. Esc
 4. Add additional flow arrows as needed.

Final steps

 1. Double-Click outside the viewport
 A. Working in model space within the layout is deactivated

 2. Save the file
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Exercise files: pln-prod-pln-prof-end-data-c3d20.zip

Earthwork quantities sheet
Last updated: 2022-11-01

Total video time: 37:43

Example sheets: 090101-ew.pdf

Standards
Per FDM 11-5-10.6, Earthwork quantities should be included on each cross-section sheet unless a 
separate “Earthwork data” sheet, identified in FDM 15-1-40, is included in the plan. This workflow cov-
ers creating Earthwork Data Sheets.

The Earthwork Summary Tables produced in WisDOT’s earthwork process are not shown in the Earth-
work Data portion of the plan. Per FDM 15-1-30, an Earthwork Summary is to be shown in the Mis-
cellaneous Quantities portion of the plan. The Miscellaneous Quantities topic covers this process.

FDM 11-5-10 Earthwork

FDM 15-1-40 Earthwork Data Sheet

FDM 15-1-30 Miscellaneous Quantities

             Option 1: Civil 3D data link method         

Video: pln-prod-erthwrk-qnty-01.mp4 5:44

Dataset: pln-prod-erthwrk-qnty-begin-data-c3d22.zip

The following workflow utilizes Excel named ranges, Civil 3D Data Links and a custom Civil 3D table 
style to stylize and place Earthwork Data tables in the Civil 3D plan sheet. The resulting plan sheets 
contain searchable text. Updates to the earthwork data tables are relatively straight forward when 
using the latest tools, named ranges, and data links.

Sheet file and Excel file setup

Video: pln-prod-erthwrk-qnty-01.mp4 5:44

Dataset: pln-prod-erthwrk-qnty-begin-data-c3d22.zip

The following workflow utilizes Excel named ranges, Civil 3D Data Links and a custom Civil 3D table 
style to stylize and place Earthwork Data tables in the Civil 3D plan sheet. The resulting plan sheets 
contain searchable text. Updates to the earthwork data tables are relatively straight forward when 
using the latest tools, named ranges, and data links.
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Create the sheet file and layout tabs

 1. Review the FDM for file naming conventions: https://wisconsindot.gov/rdwy/fdm/fd-15-05-
att.pdf#fd15-5a3.3

 2. Complete the Earthwork quantities volume calculation Earthwork quantities
 3. Create Earthwork details file.

 A. WisDOT Sheets > Support > Palettes ON/OFF
 B. WisDOT Sheets > Sheet Creation > Earthwork
 C. Startup Main tab > Earthwork Data Speed Sheet
 D. Save file in Project ID\sheets\090101-ew.dwg
 E. Save

Excel file and prerequisites

Open Earthwork Quantities Spreadsheet that was created using workflow here: Earthwork quantities

 1. Project ID\dsgn\qty\ewrk\ewrk-##.xlsx

Storage location

Store Excel Earthwork files in the Civil 3D Project directory, under ProjectID\dsgn\qty\ewrk. The 
Data Link tool works best with a relative path so storing the Earthwork Excel files in the Project Dir-
ectory is of priority.

Merge & Center

Cells that contain text that is too large to fit within that cell must be expanded. Use the Merge & 
Center command followed by the Left Align tool to merge multiple cells and allow the text to fit 
within a single cell.
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Gridlines

If grid lines are visible in Excel, they will print from Civil 3D. In Excel View Tab > Show Panel > 
Uncheck Gridlines

Delete un-needed columns and notes

Video: pln-prod-erthwrk-qnty-02.mp4 4:10

Any columns in the earthwork data sheets that contain all “zeros” can be deleted from the final plan 
sheet.

 1. Select the column(s) heading to be hiddendeleted
 2. Right Click > Delete

Tip: Following the process of delete earthwork detail sheet columns, the earthwork summary 
worksheet will contain columns that are all zeros or contain text that reads “RangeNotFound”.  
The columns that contain all zeros or “RangeNotFound” of the earthwork summary sheet can 
be deleted.  If there are columns that need to remain but contain cells that read 
“RangeNotFound”, the cell can be overwritten with a zero (0).  The warning “RangeNotFound” 
just means the cells (range) within the earthwork detail sheet no longer exists (deleted). The 
value can be changed to 0, since that is really what it is.

Info: After this process, all data remaining in the earthwork detail and summary sheets should 
be intact. If any cells contain errors, undo your work and re-correct the work to remove any cal-
culation errors. If done properly, the remaining cells should be error free.

The corresponding notes that are not applicable can also be removed from view.

 1. Select the notes/cells that are not applicable
 2. Right Click > Delete

 A. Choose Shift Cells Up

Create Excel named ranges

Video: pln-prod-erthwrk-qnty-03.mp4 6:03

Dataset: pln-prod-erthwrk-qnty-03-data-c3d22.zip

To create the earthwork quantities tables in Civil 3D, a named range is required for each quantities 
table in Excel. This allows a link to be created between the Excel file and Civil 3D drawing. The fol-
lowing workflow utilizes a custom WisDOT tool to create named ranges.

Requirement: The WisDOT Excel add-in must be installed to run the Data Link Named Range 
tool. For external partners, the WisDOT Excel add-in is available on the Wisconsin Department 
of Transportation Civil 3D file descriptions (wisconsindot.gov). Internal users should see 
Autodesk Civil 3D 20XX -Excel Add-In in Software Center.
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See complete tool documentation here: Excel - MQ Named Ranges (wi.gov). The basic workflow to 
create named ranges follows:

 1. In Excel, select the range of cells you wish to create a named range from.
 2. WisDOT Civil 3D Tab > Data Link Named Range
 3. A named range will be created using the Excel worksheet name.

 A. Naming Convention: DL_Worksheet_Name
 B. All spaces are replaced with underscores(_)
 C. Special characters are not allowed in the Excel named ranges. Only use letters, num-

bers, periods, and underscore characters in the sheet name.
 4. Repeat for each table to be displayed in Civil 3D.
 5. For additional tables contained on a single worksheet, a window will open allowing a custom 

named range to be entered.
 6. Re-run the tool to overwrite an existing named range.

Create named range for notes

Prior to creating a table in Civil 3D, a named range for the notes table needs to be created in Excel.

 1. Create a preliminary named range for the sheet
 A. Select cell A1
 B. WisDOT Civil 3D Tab > Data Link Named Range
 C. This creates the first named range on a sheet and then allows us to specify custom 

names for following named ranges on a sheet.
 2. Select the range of cells for the notes tables

 A. Approximately Y11:Z22.
 B. The third column is typically only designer notes and should not be shown on the plan.

 3. WisDOT Civil 3D Tab > Data Link Named Range
 A. Since a named range from step 1 has already been created for the sheet (Step 1) a win-

dow will appear, asking for a custom name (or if it is desired to overwrite the pre-
viously created named range)

 B. Enter a custom name for the notes table: DL_SheetName_Notes

Create named ranges for earthwork data

 1. Select the range of cells for the first earthwork data table
 A. Approximately Row1:Row51.

Tip: Approximately 45 rows of data will fit on one earthwork data sheet

 2. WisDOT Civil 3D Tab > Data Link Named Range
 A. A named range is created for the cells selected.
 B. If a range has already been created for that sheet, apply a suffix to the name: DL_

SheetName_2
 3. Save the Excel File

Test earthwork table size
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Video: pln-prod-erthwrk-qnty-04.mp4 5:45

Dataset: pln-prod-erthwrk-qnty-04-data-c3d22.zip

Before making additional named ranges, it is wise to test the initial named range to make sure it fits 
on the plan sheet. This work utilizes the DOT Create Data Links and Tables tool. Full tool doc-
umentation can be found here: Sheet Tools - Create data links and tables (wi.gov)

 1. Open Sheets\090101-ew.dwg
 2. WisDOT Sheets Tab > Sheet Creation Panel > Sheet Tools > Create Data Links and 

Tables
or Command Line:DOTCreateDataLinksAndTables

 A. Data Links tab : Create Data links for the tables

 I. Click the  to select the Excel File containing the tables to be inserted.
 II. Use Filter to filter the named ranges if desired

 a. For Example DL*
 III. From the list, select all named ranges to be made into a data link. One data link 

is required for each table that will be created in Civil 3D.
 a. Utilize Ctrl+Select and/or Shift+Select to select the named ranges 

desired.
 b. Click Select All to select all named ranges and Deselect All to deselect 

all named ranges.
 IV. Leave the default Path Type and Settings.
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 V. Click OK to create the Data Links

 B. Tables tab
 I. Select the first earthwork data table (DL_8_1#EWK).

 II. Table Style: WisDOT Standard is the WisDOT default and should be used.
 III. Click OK to place the first table.
 IV. Click a location in model space within the Layout 1 viewport to place the table

(s). With the dialog box open, users can also adjust the location of tables 
already placed in model space.
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 V. Repeat for the Notes table (DL_8_Notes#EWK).
 3. Adjust the location of the first earthwork data table and note table to make sure both can be 

situated to fit within one view port.
 4. If adjustments to the named range are to be made, make a note and return to the spread-

sheet to adjust.

Create additional named ranges for remaining earthwork data

Video: pln-prod-erthwrk-qnty-05.mp4 5:12
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 1. Return to the earthwork data spreadsheet
 2. If required, adjust the existing named ranges

 A. Select the range of cells for the first earthwork data table to be adjusted
 B. WisDOT Civil 3D Tab > Data Link Named Range
 C. Enter the name of the range to be updated.

 3. Duplicate the data sheet headers for addition earthwork data tables/sheets
 A. Select Rows 1:6 > Right Click > Copy
 B. Right click the row below previous data table > Insert Copied Cells
 C. Add one more row above the duplicated header to provide a blank space

 I. Right-click the top row of the duplicated header > Insert
 D. Duplicate the header for all earthwork data sheets.

 4. Create named ranges for any remaining earthwork data tables and sheets.
 A. *Approximately 40-45 rows of data (not including headers) will fit on one
 B. Select the range of cells for the remaining earthwork data tables
 C. WisDOT Civil 3D Tab > Data Link Named Range
 D. Enter the name of the ranges remaining, remember to apply a suffix that makes sense 

to the users
 I. DL_8_2

 II. DL_8_3
 III. DL_Gatewood Heights

 E. Remember, a sheet that does not contain a previous named range will default to a 
named range of DL_Sheet name**.

 5. Save the earthwork data spreadsheet.

Create data links and tables for remaining earthwork data tables

Video: pln-prod-erthwrk-qnty-06.mp4 3:13

Dataset: pln-prod-erthwrk-qnty-06-data-c3d22.zip

 1. Return to 090101-ew.dwg.
 2. WisDOT Sheets Tab > Sheet Creation Panel > Sheet Tools > Create Data Links and 

Tables
 A. Data Links tab

 I. Create data links for any remaining named ranges that have not already been 
created

 B. Tables tab
 I. Create tables within subsequent layout view frames for any remaining data 

links
 3. Adjust the earthwork data tables to fit within the view frame.

 A. For the most part, the height of the table as initially created is at it’s minimum and 
does not require adjustment. The width, on the other hand, will need to be lessened to 
fit within the view frame.

 B. Best practice is to window select the table and use the triangle grip in the lower right 
to adjust the table size.
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 I. The benefit of this grip is that it will not allow the table to be shrunk vertically 
beyond a minimum height based on the data contained.

 II. 

 C. If desired, individual column widths can be adjusted using the various grips within the 
table.

Updates to earthwork data tables

Video: pln-prod-erthwrk-qnty-07.mp4 9:51

If there are design changes and the earthwork requires recomputing, these changes can be pushed 
back into the final Earthwork Data plan sheets. 

 1. Follow the "Earthwork quantities" on page 1793 training to update the earthwork detail Excel 
worksheets and workbooks

 2. Prepare the affected detail worksheets for the plan sheets
 A. Delete columns with no data (all zeros)

 3. Update named ranges for the affected detail worksheets.
 A. Select the range of cells
 B. WisDOT Civil 3D Tab > Data Linked Named Range
 C. Overwrite the named range OK
 D. Make sure the named range is exactly the same as it was before the updates

 4. Save the Excel File

Civil 3D data links and tables do not automatically update after the Excel file is saved or the DWG is 
opened. Once the DWG is open, the data links update process needs to be manually initiated. Prior 
to updating any tables or data links in Civil 3D, the Excel file must be saved.

Option A:

 1. Annotate tab > Tables > Download from Source
 2. Select which tables to update or choose all data links from the command line.
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Option B:

 1. Select the table to be updated > Right Click > Update Table Data Links
Option C:

 1. Click one specific cell in a table > contextual ribbon > Download from Source

Display of table gridlines in Civil 3D

When placing the tables in model space in Civil 3D, even though the gridlines are turned off in Excel, 
the AutoCAD table gridlines will still display.

Once the table is actually printed to PDF the gridlines will not appear, but the formatting for cell bor-
ders set within Excel will show in the PDF.

If desired to turn off the gridlines, the layer Defpoints can be turned off.
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 1. Home Tab > Layers Panel > Layers drop-down > Turn off Defpoints

Add the sheets to a sheet set

 1. Add sheets to sheet set manually #add

Dataset: pln-prod-erthwrk-qnty-end-data-c3d22.zip

Option 2: Paste link method
The paste link method relies on copying the cells in Excel and Pasting a Link in Civil 3D. The content 
shown updates automatically in Civil 3D when it is updated in Excel. The final output in Civil 3D is an 
OLE (Object Linking and Embedding) object and is published as an image in the final PDF. The text is 
unsearchable in the PDF. Updates to the existing OLE Table in Civil 3D are automatically consumed.  
To update a table with different dimensions, the object in Civil 3D must be deleted and re-pasted 
from the Excel file.

Warning: This method has a known issue associated with it. Please see "Known issue - Excel 
Civil 3D quantities "Microsoft Excel is waiting for another application to complete an OLE 
action."" on page 99 for more information.

Create the sheet file and layout tabs
 1. Review the FDM for file naming conventions: https://wisconsindot.gov/rdwy/fdm/fd-15-05-

att.pdf#fd15-5a3.3
 2. Complete the Earthwork quantities volume calculation Earthwork quantities
 3. Create Earthwork details file.

 A. WisDOT Sheets > Support > Palettes ON/OFF
 B. WisDOT Sheets > Sheet Creation > Earthwork
 C. Startup Main tab > Earthwork Data Speed Sheet
 D. Save file in Project ID\sheets\090101-ew.dwg
 E. Save

Open the Excel spreadsheet
 1. Earthwork Quantities Spreadsheet was created using workflow here: Earthwork quantities
 2. Open the Excel spreadsheet from Project ID\dsgn\qty\ewrk\EWK-25.xlsx
 3. In Excel, File > Options > Formula Tabs > Error Checking Rules. Uncheck both Formulas 

which omit cells in a region, and Unlocked cells containing formulas. OK
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Info: This step is important since it turns green arrow error markers in cells off. The 
green arrow markers will appear in most cells of the Civil3D linked table causing con-
fusion and clutter.

 4. Switch to the View tab of the ribbon > Show panel > Uncheck the Gridlines option

Hide un-needed columns and notes
Any columns in the earthwork data sheets that contain all “zeros” can be hidden from the final plan 
sheet

 1. Select the column heading to be hidden
 2. Right Click > Hide

The corresponding notes that are not applicable can also be hidden from view.

 1. Select the notes/cells that are not applicable
 2. Right Click > Delete

 A. Choose Shift Cells Up

Copy and paste Notes into sheet view frames
 1. Open the EWK-25.xlsx file in Excel.
 2. Scroll to the right to see the Notes area.

 A. Widen the X, Y, and Z columns so all the text in these cells is readable.

Info: Column AA are designer notes and are not shown on the plan.

 3. Select the remaining notes, right-click > Copy

Info: Column AA are designer notes and are not shown on the plan.

 4. In Civil 3D, open 090101-ew.dwg.
 5. Home ribbon > Clipboard panel > Paste pull-down > Paste Special

 A. In the Paste Special dialog select the Paste Link button
 B. Select Microsoft Excel Worksheet
 C. OK

 6. Place the frame of the Notes table at the bottom of the first view frame.
 7. Copy the first Notes Table from the first view frame to several following view frames.

Copy table data and paste into first sheet view frame
 1. In the Excel spreadsheet > Earthwork Details Tabs
 2. Select the cells within the Earthwork Details

Info: It approximately 45 rows (not including headers) will fit on a standard Earthwork 
Data sheet.

 3. Right-click > Copy
 4. In Civil 3D, open 090101-ew.dwg.
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 5. Home ribbon > Clipboard panel > Paste pull-down > Paste Special
 A. In the Paste Special dialog select the Paste Link button
 B. Select the Microsoft Excel Worksheet
 C. OK

 6. Move the OLE frame into the frame of Layout 1. Click to place it inside the frame.

Determine required table size to fit one Earthwork Data sheet
 1. Inspect where the data grid falls outside the Layout 1 frame or over the Notes table.

 A. If the frame is too wide
 I. Return to the Excel spreadsheet and adjust the columns to fit the table inside 

the frame.
 II. Save the file.

 III. Return to the 090101-ew.dwg file and notice the change to the inserted table. 
You may need to move the table to fit it more appropriately on the sheet.

 B. If the frame is too long
 I. Find the last full row that will fit on the sheet without overlapping the Notes 

table. Remember the station of the row that will be the last for the page.
 II. Approximately 45 rows of data (not including headings) will fit in the standard 

Earthwork details sheet.
 2. Duplicate the column headings for each Earthwork Layout

 A. Return to the Excel spreadsheet.
 B. Select rows 2 through 6 (Headings) > right-click the rows > Copy
 C. Scroll down to the table station that will fit on one page.
 D. Select the ROW BELOW that station’s row, Right-click > Insert Copied Cells.
 E. Repeat this for any remaining sheets

 I. Approximately 45 rows of data will fit on one Earthwork Data Sheet.

Place the adjusted tables on the sheets
 1. Copy and paste the adjusted table data into the frames.

 A. Select first series of earthwork data > right-click > Copy
 B. Return to the 090101-ew.dwg.
 C. Delete the original table that was placed in the Layout 1 frame.
 D. Select rows 2 through 6 (Headings) > right-click the rows > Copy

 I. In the Paste Special dialog select the Paste Link button
 II. Select the Microsoft Excel Worksheet.

 III. OK
 E. Place the table frame at the top of the Layout 1 frame.
 F. Return to the Excel spreadsheet.
 G. Select next series of earthwork data > right-click > Copy
 H. Return to the 090101-ew.dwg.
 I. Home ribbon > Clipboard panel > Paste drop-down > Paste Special

 I. In the Paste Special dialog select the Paste Link button
 II. Select the Microsoft Excel Worksheet.

 III. OK
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 J. Place the table frame in the Layout 2 frame
 K. Repeat for remaining Earthwork Data

Place the Notes table on the rest of the sheets
 1. Copy the first Notes Table from the first view frame to any remaining view frames.

Add the sheets to a sheet set
 1. Add sheets to sheet set manually #add

Cross section sheets
Last updated: 2022-08-30

Example sheet: 090201-xs.pdf

Create file
 1. Create a new file with the QNEW button in the Quick Access Toolbar.
 2. Save the file <ProjectID>\SheetsPlan\090201-xs.dwg
 3. Add Data References and XREF's as needed.

 A. Data Reference the alignment of the road that is to be sampled by the cross sections
 I. Toolspace > Prospector tab > Data Shortcuts area > expand Alignments > 

expand Centerline > Right-click on the alignment to be referenced > 
Create Reference

 B. Data reference alignments for right-of-way, property lines, and other markings to dis-
play in section views.

 4. Data reference the Rfnt surfaces for Top and Datum
 A. Toolspace > Prospector tab > Data Shortcuts area > expand Surfaces
 B. Right-click on Rfnt-<CorridorName>-Top > Create Reference

 I. Style: Top Border
 C. Right-click on Rfnt-<CorridorName>-Datum > Create Reference

 I. Style: Datum Border
 5. Data Reference the corridor

 A. Open the corridor file from <ProjectID>\Design\Corridor folder
 B. Save the file to make sure data shortcut links will be properly pathed
 C. Prospector > Right-click on Data Shortcuts > Create Data Shortcut
 D. Checkmark the corridor to be shared with the cross section file. OK
 E. Open the cross section file. This file should already have the alignment and other 

DREF’d objects from earlier steps.
 F. Prospector > Data Shortcuts > Expand Corridors > Right-click on the corridor 

name > Create Reference
 G. In the Create Corridor Reference OK

 6. In this file complete the following tasks
 A. Create "Sample lines" on page 1686/ Sample the refinement surface
 B. Create "Section views" on page 1694 with "Section view group" on page 1703
 C. "Create section sheets" on page 1707
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Some other common tasks in cross sections are:

 1. "Cross section corridor labels" on page 1723
 2. "Project objects onto section views" on page 1773

 

All topics related to cross sections can be found in "Cross sections" on page 1685

Exercise - Annotate cross sections
Last updated: 2011-07-01

Total video time: 06:32

Exercise files: pln-prod-anno-xs-data-C3D12.zip

Annotate cross sections

pln-prod-anno-xs-01.mp4 3:16

 1. Modify and set Section View Group settings including annotations.
 2. Delete project data and download and unzip this exercise.
 3. Open file 12345678\SheetsPlan\090101_xs.dwg

Set section view group bottom to top

 4. Toolspace > Prospector tab, right-click Section View Group - 1
 5. Click Properties.
 6. Under Group Plot Styleset to "By Page Bottom to Top".
 7. Click Ok.
 8. Click Ok.

Annotate section station labels

pln-prod-anno-xs-02.mp4 3:16

 1. From Prospector, click Section View Group - 1
 2. Click one of the sections in the list below. Press Ctrl+A to select all sections
 3. Right-click the selected sections and click Select. Press Ctrl+1 to view the Properties window of 

all sections.
 4. Change Description to F
 5. Change Style to Sheets 1 IN 20 FT Horiz 20 FT Vert
 6. Press Esc to clear the selection
 7. Description can also be entered in Create Section View workflow.
 8. Home tab > Profile & Section Views ribbon > Section Views button > Create Multiple 

Views.
 9. Create Multiple Section Views dialog > General > Description: F
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Options to create slope intercept file
Last updated: 2022-08-30

Total video time: 21:31

Option one: create slope intercept file with no manual edits

pln-prod-slp-intrcpt-01.mp4 7:53

 1. Create SI.dwg
 A. Application Menu dropdown > New
 B. Select template dialog box

 I. Look in: Begin-dwg folder
 II. Select drawing design-start.dwt

 III. Open
 C. Save drawing as SI.dwg

 I. Application Menu dropdown > Save As
 II. Save Drawing As dialog box

 a. Save in: Local Disk:\WisDOT\Design\c3d\12345678\Design\Edgelines
 b. File name: SI
 c. File type: *.dwg
 d. Save

 2. Data reference (Dref) in top surface data.
 A. Toolspace > Prospector tab> Data Shortcuts right-click > Set Working Folder...
 B. Set Working Folder dialog box

Info: Working Folder is always set 2 levels above the shortcuts folder.

 I. Folder: browse to c3d (Local Disk:\WisDOT\Design\c3d)
 II. Select Folder

 C. Toolspace > Prospector tab> Data Shortcuts right-click > Set Data Shortcuts Pro-
ject Folder...

 I. Verify project folder 12345678 is in list and select it.
 II. OK

 D. Toolspace > Prospector tab> Data Shortcuts > Surfaces
 I. Verify surfaces are available.

 II. Right-click Rfnt-25-Top > Create Reference...
 III. Create Surface Reference dialog box

 a. Name: Keep existing name
 b. Style: ... to browse, use dropdown and select Slope InterceptOK
 c. OK

 IV. Commandline:ZEnterEEnter (zoom extents)
 3. Xref proposed pavement drawing.

 A. Ribbon > WisDOT Survey tab > Manage panel > Xref Tools dropdown > Load Xref 
on Layer
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 B. Select a File to Xref dialog box
 I. Look in: Local Disk:\WisDOT\Design\c3d\12345678\Design\Edgelines

 II. Select Pavt.dwg
 III. Open

 4. Mask slope intercept line where it crosses roadway.
 A. Select Pavement Xref
 B. Commandline:WIPEOUT
 C. Specify first point: Select start point
 D. Specify next point: Select multiple points to cover the north end of the project. 

Type C to close the shape.

Tips: 
Use XClipping if you are masking out the slope intercept and roadway area in 
one location for printing. Context ribbon > Clipping panel > Create Clipping 
Boundary

When using Wipeout command, the draw order can be set. Right-click menu 
> Draw Order > Select option

 5. Set Wipeout Frame value
 A. Commandline:WIPEOUTFRAME
 B. Enter new value:0

 6. Save file.
 7. Xref SI.dwg into the project plan set sheet

 A. Quick Access toolbar > Open
 B. Select File dialog box

 I. Look in: Local Disk:\WisDOT\Design\c3d\12345678\SheetsPlan
 II. Select 050101-pn.dwg

 III. Open
 C. Close Sheet Set Manager
 D. Select Model layout tab
 E. Open Xref Manager

 I. Commandline:XREF
 II. Unload Topo-Ex file; right-click Topo-Ex > Unload

 III. Keep pavt file
 F. Load Slope Intercept lines

 I. Ribbon > WisDOT Survey tab > Manage panel > Xref Tools dropdown > 
Load Xref on Layer

 II. Select a File to Xref dialog box
 a. Look in: Local Disk:\WisDOT\Design\c3d\12345678\Design\Edgelines
 b. Select SI.dwg
 c. Open

 8. Change the draw order of any geometry masked by wipeout.

Option two: create a manually editable slope intercept file

pln-prod-slp-intrcpt-02.mp4 5:00
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 1. Create a new drawing.
 A. Application Menu dropdown > New
 B. Select template dialog box

 I. Look in: Begin-dwg folder
 II. Select drawing design-start.dwt

 III. Open
 2. Dref roadway refinement and rural driveway top surfaces.

Info: Since we want these surfaces to be invisible and used as a building block, apply _
No Display style.

 A. Toolspace > Prospector tab > Data Shortcuts > right-click Rfnt-25-Top > Create 
Reference...

 B. Create Reference dialog box
 I. Style: ... to browse, use dropdown and select _No DisplayOK

 II. OK
 C. Toolspace > Prospector tab > Data Shortcuts > right-click Rfnt-All-RuralDwy > 

Create Reference...
 D. Create Reference dialog box

 I. Style: ... to browse, use dropdown and select _No DisplayOK
 II. OK

 3. Create a new surface.
 A. Toolspace > Prospector tab > Active Drawing > right-click Surfaces > Create Sur-

face...
 B. Create Surface dialog box

 I. Name: Cmbn-Top-Dwy
 II. Style: ... to browse, use dropdown and select Slope InterceptOK

 III. OK
 C. Commandline:ZEnterEEnter (zoom extents)

 4. Paste in invisible top surfaces.
 A. Toolspace > Prospector tab > Active Drawing > expand Surfaces > expand Defin-

ition > right-click Edits > Paste Surface...
 B. Select Surface to Paste dialog box

 I. Select Rfnt-25-TopOK
 C. Toolspace > Prospector tab > Active Drawing > expand Surfaces > expand Defin-

ition > right-click Edits > Paste Surface...
 D. Select Surface to Paste dialog box

 I. Select Rfnt-All-RuralDwyOK
 E. Commandline:ZEnterEEnter (zoom extents)

 5. Xref proposed pavement drawing.
 A. Ribbon > WisDOT Survey tab > Manage panel > Xref Tools dropdown > Load Xref 

on Layer
 B. Select a File to Xref dialog box

 I. Look in: Local Disk:\WisDOT\Design\c3d\12345678\Design\Edgelines
 II. Select Pavt.dwg

 III. Open
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 6. Use Wipeout command to mask slope intercept lines cross proposed pavement lines.
 A. Commandline:WIPEOUT
 B. Specify first point: Select start point
 C. Specify next point: Select multiple points to cover the north end of the project. 

Type C to close the shape.
 D. Repeat steps A-C to each edge of pavement.

 7. Bring pavement drawing to the front.
 A. Select Xref > Right-click menu > Display Order > Bring to Front

 8. Save drawing.
 A. Quick Access > Save (Save As)
 B. Save Drawing As dialog box

 I. Save in: Local Disk:\WisDOT\Design\c3d\12345678\Design\Edgelines
 II. File Name: SI.dwg (if you followed exercise 1, overwrite your existing SI.dwg 

file)
 III. Save

 9. Xref SI.dwg into the project plan set sheet.
 A. Select 050101-pn* tab (above Toolspace)
 B. Open Xref Manager

 I. Commandline:XREF
 II. Reload SI.dwg; right-click SI > Reload

 C. Close Xref Manger
 10. Set Wipeout Frame value.

 A. Commandline:WIPEOUTFRAME
 B. Enter new value:0

Extracting 2D polyline from slope intercept line

pln-prod-slp-intrcpt-03.mp4 4:37

Continuing on, whether option one or option two was used. Exercise is using option one.

 1. Open SI.dwg or, if already open, select SI* tab (above Toolspace) to make it the active draw-
ing.

 2. Select slope intercept line > right-click menu > Surface Properties..
 3. Surface Properties dialog box

 A. Default styles > Surface style dropdown > Slope Intercept (No Plot)
 B. OK

 4. Detach pavement Xref temporarily
 A. Commandline: XREF
 B. Xref Manager > right-click Pavt > Detach
 C. Close Xref Manager

 5. Use Extract from Surface command
 A. Select slope intercept line
 B. Surface contextual ribbon > Surface Tools panel > Extract from Surface drop-

down > Extract Objects
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 C. Extract Objects from Surface dialog box
 I. Check box Border 

 II. OK
 6. Polyline extracted is 3D, change to 2D

 A. Select polyline
 B. Ribbon > Home tab > Layers panel > Layers dropdown > P_RW_SlopeIntercepts
 C. ESC
 D. Ribbon > Modify tab >  Design panel dropdown > Covert 3D to 2D Polylines
 E. Select 3D polylines to convert: Select 3D polyline Enter

 7. Edit linetype and elevation
 A. Select polyline > right-click menu > Properties...
 B. Properties palette

 I. Misc > Linetype generation dropdown > Enabled
 II. Geometry > Elevation > 0

 C. Close Properties palette

Final modifications to slope intercept file

pln-prod-slp-intrcpt-04.mp4 4:01

Break at point command

 1. Xref proposed pavement drawing.
 A. Ribbon > WisDOT Survey tab > Manage panel > Xref Tools dropdown > Load Xref on 

Layer
 B. Select a File to Xref dialog box

 I. Look in: Local Disk:\WisDOT\Design\c3d\12345678\Design\Edgelines
 II. Select Pavt.dwg

 III. Open
 2. Instead of Masking, use AutoCAD Break or Break at Point command

 A. Select Masking > Delete
 B. Select polyline
 C. Ribbon > Home tab > Modify dropdown > Break at Point commandIf you use the 

Break at Point command, the Enter key cannot be used to continue the command. 
Tack the Modify panel dropdown to stay open and have the command readily avail-
able. Tack can be found in lower left corner of panel.

 D. Select object: Select polyline
 E. Specify first break point: Use Endpoint OSnap, select point where polyline 

meets edge of roadway
 F. Ribbon > Home tab > Modify dropdown > Break at Point command
 G. Select object: Select polyline
 H. Specify first break point: Use Endpoint OSnap, select point where polyline 

meets opposite edge of roadway
 I. Select and delete segment in between both points
 J. Select tack on Modify panel to release dropdown to close
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Final modifications to SI.dwg

 1. Xref proposed pavement drawing.
 A. Ribbon > WisDOT Survey tab > Manage panel > Xref Tools dropdown > Load Xref 

on Layer
 B. Select a File to Xref dialog box

 I. Look in: Local Disk:\WisDOT\Design\c3d\12345678\Design\Edgelines
 II. Select Pavt.dwg

 III. Open
 2. Xref existing conditions drawing.

 A. Ribbon > WisDOT Survey tab > Manage panel > Xref Tools dropdown > Load Xref 
on Layer

 B. Select a File to Xref dialog box
 I. Look in: Local Disk:\WisDOT\Design\c3d\12345678\BaseData

 II. Select Topo-Ex.dwg
 III. Open

 3. Look for objects that are to be left in their current locations. Using AutoCAD modification com-
mands and grip points, make adjustments to the slope intercept line.

 4. Save SI.dwg
 5. Xref SI.dwg into the project plan set sheet

 A. Quick Access toolbar > Open
 B. Select File dialog box

 I. Look in: Local Disk:\WisDOT\Design\c3d\12345678\SheetsPlan
 II. Select 050101-pn.dwg

 III. Open
 C. Select Model layout tab
 D. Ribbon > WisDOT Survey tab > Manage panel > Xref Tools dropdown > Load Xref 

on Layer
 E. Select a File to Xref dialog box

 I. Look in: Local Disk:\WisDOT\Design\c3d\12345678\Design\Edgelines
 II. Select SI.dwg

 III. Open
 6. In Modelspace, select sheet 06 tab > right-click menu > Plot...
 7. Batch Plot dialog box

 A. Select Continue to plot a single sheet
 8. Plot dialog box

 A. Preview...
 B. Verify the print has the correct elements.
 C. Cancel dialog box

Dynamic station/offset labels and tables on a surface with 
pipe networks
Last updated: 2022-03-10

Total video time: 12:57
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Exercise files: pln-prod-dynmc-lbls-begin-data-c3d20.zip

Best practices

pln-prod-dynmc-lbls-01.mp4 2:41

This topic will detail how to create a table which is dynamically-linked to labels at points on a surface 
using pipe networks.

Following are best practices to note about this workflow:

 1. A pipe network will only reference a single alignment. 
 A. If you need a table of points with references to 2 alignments use the WisDOT Point Sta-

tion UDP found at WisDOT Design tab > Design panel > Points - Point Station Off-
set to UDP

 2. Pipe networks are dynamic whereas the Points UDP are not. 
 3. Points are not sharable from file to file, however, pipe networks are through data references. 
 4. Structures do not update their location relative to alignment movement, but the station and 

offset will update.
 A. Surface elevations will update, but may sometimes seem to get "stuck".

 5. The elevations are taken from the rim elevation of the structures which are dynamically 
linked to a surface. 

Network parts list
The Pipe Network Parts List for this workflow is already created and in the WisDOT Standards. It is 
called Details Sheets. This is a structures-only parts list. No pipes are included. The structures styles 
are a simple circle as we are not interested in structure size or shape, but just location. We also do 
not want the visual representation of the structures to stand out. 

Create pipe network

pln-prod-dynmc-lbls-02.mp4 3:41

 1. Home tab > Create Design panel > Pipe Network > Pipe Network Creation Tools
 A. Name pipe network with the intersection quadrant so that you have better control 

over the numbering in the table. Network name: Int-2nd-NW-Quad
 B. Default network layers > Structure Plan layer: P_MISC_Text
 C. Network Parts List: Details Sheets
 D. Surface name: Rfnt-Ali-Top
 E. Alignment name: 51
 F. Structure label style: Detail Sheets
 G. OK

 2. Pipe Network Properties > Layout Settings tab > Naming template > Stuctures > Name 
Template  Make sure that the starting number is appropriate for your situation in the 
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project. 
 A. OK to close both dialog boxes

 3. Pipe Network Properties > Structures pulldown> Detail Sheets 
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 4. Set drawing option to Structures Only
 5. Digitize key locations around curb ramp.
 6. Drag labels to appropriate locations. 

Add table to modelspace or paperspace

pln-prod-dynmc-lbls-03.mp4 3:51

 1. Annotate > Add Tables > Pipe Network > Add Structure table
 A. Set Table Style to Detail Sheets
 B. Select By Network
 C. Behavior: Dynamic
 D. OK
 E. Click in modelspace or paperspace to place the table.

Info: If placing the table in modelspace, be sure that the viewport on the sheet 
is adjusted o show the entire table.

 2. Check the table to be sure the point numbers are in the correct order. 
 A. Right-click on table > Edit Table Style > Data Properties tab 

 I. Sort data: checked
 II. Sorting column: 1

Change alignment or surface

pln-prod-dynmc-lbls-04.mp4 2:42
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 1. Structures can reference alignments and surfaces, and the assignment of each can be 
changed for each structure independently within the network. 

 A. Select any structure in modelspace > Modify panel > Edit Pipe Network > Pipe 
Network Vistas

 2. Scroll through the data table to find the Reference Alignment or Reference Surface 
columns.

 3. Mass select the rows that need to change Ctrl+click or Shift+click then right-click on the Refer-
ence Alignment or Reference Surface column and choose Edit and choose the appropriate 
object from the dialog box. 

 4. The table will then update to reflect the new station and offset and/or elevation numbers. 

Warning: Elevations in the table dynamic to the reference surface at times will fail to 
update. Check these to confirm. 

 5. If the surface elevations in the table fail to adjust to changes:
 A. Select any structure in modelspace > right-click > Structure Properties > Part 

Properties tab > Automatic Surface Adjustment
 I. Set to False then Apply 

 II. Set back to True then Apply
 III. OK
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Export pipe table to Excel
Export - Export C3D Table

Exercise files: pln-prod-dynmc-lbls-end-data-c3d20.zip

Mix color and grayshade plotting (example: existing utilities 
in color)
Last updated: 2021-03-17

This topic explains how to set existing utilities in an XREF to plot in color. The tool used is in the 
WisDOT Civil 3D 2018 customizations and beyond. This process can be used to plot any mix of color 
and grayshade based on layers.

Info: 
As a reminder, all grayshade or all color plotting is achieved by setting the plot table in Page 
Setup. 

 l wisdot-standard.ctb = all grayshade plotting
 l wisdot-color.ctb = all color plotting

This can be done manually

 1. Right-click layout tab > Page Setup Manager... > Modify... > Plot style table
Or by applying a page setup

 1. WisDOT Sheets tab > Plot Configuration panel > Page Setups > Click on desired 
page setup to add it to the DWG.

 2. Set it individually in Page Setup Manager or in batch mode with Multi-Page Setup

 1. To save the existing layer state if you want to easily return to it: Home tab > Layers panel > 
Layers dropdown > Layer State dropdown > New Layer State... 

In Civil 3D 2018 and beyond, if you are working with a utility file that you have XREF'd into a 
file, do the following:

 2. Confirm that wisdot_standard.ctb is the active plot style table. This table prints everything 
grayshade that is using an index color. Layers/objects that have True Color assigned to them 
will print in color.

 3. WisDOT <Any> tab > Manage panel > Layers dropdown > Convert Layer Colors
 A. Filters: Utilities Existing-xref
 B. Select All
 C. Convert Color Definition: Index Color to True Color
 D. Layers > Selected Layers: checked
 E. Apply
 F. Home tab > Layers panel > Layers dropdown > Layer State dropdown > New 

Layer State... to save this layer state.
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This process can be applied for any layer groups or any manual selection set of layers for a DWG and 
it's XREFs. 

An xref layer state can be reset to the current layer state of the DWG with "Layers and their prop-
erties" on page 433

Plotting and publishing to DWF/DWFx
Last updated: 2020-10-26

Overview
Design Web Format (DWF/DWFx ) is the Autodesk method of publishing design data. It offers an 
alternative to printing to Portable Document Format (PDF). DWFx is the newer format of this file 
exension. The rest of this topic will use DWFx to talk about both DWF and DWFx. The benefits of 
DWFx    are:

 1. DWFx    files are  native Autodesk file formats and are created directly from DWG file data. In 
comparison, the PDF creation process takes a snapshot of a file to create a published doc-
ument.

 2. DWFx    files can contain DWG extended design data that PDF files cannot.
 3. A DWFx    created in model space maintains its coordinate location. 

DWFx file format 
 1. DWFx    are secure file formats developed by Autodesk to combine and publish 2D and 3D 

design data for sharing with others.
 2. DWF file format (file extension *.dwf) is the original implementation of Design Web Format.   

DWF output is highly compressed and print-ready. DWF file size is generally smaller than PDF. 
Publishing a multi-sheet drawing to DWF is generally faster than publishing to PDF. A DWF file 
requires Autodesk Design Review or other third-party DWF capable software to view or print.

 3. DWFx file format (file extension *.dwfx)  is a newer file format than DWF. DWFx is based on 
the XML Paper Specification (XPS) from Microsoft, making it easier to share design data. DWFx 
file size and publishing time is similar to PDF. An advantage of DWFx is it requires no special 
software to view or print. DWFx files can be opened and printed with Internet Explorer or the 
free Microsoft XPS Viewer, both of which come installed "out-of-the-box" on most computers 
with a Windows operating system.

 4. DWFx  files contain the same data (2D and 3D) as DWG. The only difference is the file format.

Tip: DWFx  can be used as an XREF. If you have a raster file that you need to use that is causing 
problems or very slow plot times, you can create a DWFx with the exact limits and resolution 
you need to optimize plotting. See "Plotting modelspace to a DWFx #plot" on page 1609

Choosing between DWFx   and PDF
The PDF file format is widely used to publish and share documents, but it's capability is limited when 
compared to DWFx  . The following are some factors to consider when choosing between DWFx   and 
PDF:
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 1. More drawing design data may be shared through DWFx   versus creating a PDF. PDF drawings 
are limited to lines, curves, fills, TrueType text, colors, and layers. Support for CAD specific 
design data is limited with PDF. DWFx   files can include additional information from the ori-
ginal CAD model. Hyperlinks,  sheet details, layer properties, object properties, component 
properties, mass properties, block attributes, layouts, model space views, and more can be 
shared with DWFx   files. DWFx   allows extended design data to be shared without needing an 
AutoCAD or Civil 3D license to access it. 

 2. PDF was originally designed to be a document container. DWFx   was specifically designed as a 
file format for the digital design process. So, DWFx   files facilitate the design review process 
better than PDF. A reviewer can examine actual 2D or 3D design model data in a DWFx   file in 
addition to viewing each sheet of a plan set.

 3. DWFx   allows for much higher DPI (dots-per-inch) settings than PDF. This is advantageous 
when working with high resolution raster images, enabling significantly scaled viewports to 
be published in much higher detail than PDF.

 4. DWFx does not have a limit to the "paper size" that can be created. Unlike a PDF that limits it's 
paper sizes to common plotter output sizes.

 5. PDF, DWF, and DWFx files can be opened using Autodesk Design Review which is free soft-
ware available through the WisDOT Software Center (Installs with DWG TrueView). This soft-
ware allows users to  view, mark up, print, and track changes to PDF, DWF, DWFx, or 2D and 
3D DWG files. DWF, DWFx, and DWG files can also be viewed with the free Autodesk 360 
Mobile App or with Autodesk Viewer, which are cloud-based online file viewers. 

 6. DWFx   files can be published to PDF.
 7. DWFx Page Setups are available in the WisDOT Civil 3D configuration to publish files anyone 

can view or print.

Publishing to DWFx with the WisDOT Civil 3D configuration
Assign DWFx plot settings to layouts for Design Web Format publishing.

 1. WisDOT Sheets tab > Plot Configuration panel > Page Setups > DWFx Page Setups tool 
palette > Click a page setup to add a page setup to the active DWG.
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Info: After selecting a Page Setup from the palette, it will appear nothing has 
happened. The Page Setup has loaded in the background and added to the current 
drawing file.

 2. Use the Multi-Page Setup tool to assign the DWFx Page Setup to layouts.
The layout(s) are now setup to publish to a DWFx file.

Plotting modelspace to a DWFx #plot
Sometimes plotting objects in modelspace to a DWFx can be useful as a way to make an XREF. Since 
DWFx retain geographic coordinates, they will be spatially-accurate when XREF'D.

The best use for this is for creating a raster image of base linework drawings to be xref’d at a set 
annotation scale. Any drawing that will be xref’d into a sheet drawing as an underlay, or existing con-
ditions such as the topo and existing utility drawings can be used. Multiple images of the same draw-
ing can be created with different annotations scales set, so that multiple copies of the same drawing 
do not need to be created for sheets with different scales. The DWFx images maintain layer inform-
ation so layers within the DWFx can be turned off and on by using the DWFLAYERS command. 

Some other useful scenarios for this are:
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 l A raster image will not plot correctly. Sometimes taking a snapshot in a DWFx and then using 
that as an XREF can provide a workaround to rasters that will not plot.

 l Mr SID files can be reduced in file size setting up a view at a specific scale for XREF purposes. 
Generally you will not see a reduction in file size for DWG or TIF files. Plotting these files from 
modelspace to DWFx for the express purpose of reducing file size is not recommended.

Plotting modelspace to DWFx workflow

 1. Right-click Model tab > Page Setup Manager... > Modify...
 A. Printer/plotter

 I. Name: A Modelspace DWFx print.pc3 (Available with WisDOT customizations)
 II. Properties

 a. User-defined Paper Sizes & Calibration > Custom Paper Sizes > 
User 1 > Edit...

 i. Change the Width and Height to the dimensions in file units to 
be printed. For example, 5000 FT in the X and 20000 FT in the 
Y would result in Width: 5000 and Height: 20000.

 ii. Next > Next > Next > Finish
 b. OK

 B. Plot Style Table
 I. Verify that the wisdot_standard.ctb is selected for Civil 3D 2018 and beyond.

 C. Plot area, What to plot:
 I. Display: Will plot active window

 II. Limits: will constrain a plot of the active window to the aspect ratio of the mod-
elspace page size selected.

 III. Window: Allows clicking the opposite corners of a rectangle. This will be the 
most accurate option if you create a rectangle the same size as the modelspace 
page size.

 D. Plot scale
 I. Fit to paper: unchecked

 II. Scale: 1:1
 E. OK
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Parcels/Plats
Parcel basics
Last updated: 2021-06-29

Parcel anatomy

prcl-basc-01.mp4 5:03

Exercise files: prcl-basc-data-begin-c3d20.zip

Parcel objects are made up of line and curve segments but is only the area within these segments is 
the parcel area.

Two ways to access parcel properties

 1. Select parcel object label (found in the center of object)
 A. Ribbon > Parcel tab > Modify panel > Parcel Properties

 2. Select parcel object label (found in the center of object)
 A. Right-click > select Parcel Properties... from drop-down menu

Editing parcel segment label style

 1. Select label on a line segment
 2. Ribbon > Label-Parcel Segement Label tab > Mobify panel > Label Properties
 3. AutoCAD Properties dialog box

 A. Design tab > Expand Information dropdown > Line Label Style > Parcel Line Label Style 
> Distance

Tip: You can use either General Line Label Styles or Parcel Line Label Styles from 
list.

 II. X to close properties palette

Editing parcel segment style

Info: Parcel segment styles can not be modified in the Properties palette.  It must be done 
through the parcel object label.

 1. Select parcel object label (found in the center of object)
 2. Ribbon > Parcel tab > Modify panel > Parcel Properties > Parcel Properties dialog box > 

Information tab
 A. Object Style: Select style from dropdown

 3. OK (and Esc to deselect object)
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Editing parcel object label style

 1. Select parcel object label (found in the center of object)
 2. Ribbon > Parcel tab > Modify panel > Parcel Properties > Parcel Properties dialog box > 

Composition tab
 A. Area selection label style dropdown, select style from list

 3. OK (and Esc to deselect object)

Parcel properties

prcl-basc-02.mp4 3:47

Ways to access parcel properties dialog box

Select parcel object label (found in the center of object)

 1. Select parcel object label (found in the center of object)
 A. Contextual Ribbon > Parcel tab > Modify panel > Parcel Properties

 2. Select parcel object label (found in the center of object)
 A. Right-click > select Parcel Properties... from drop-down menu

 3. Toolspace > Prospector tab > Parcel > expand Sites > expand Field Survey > expand 
Parcels > right-click on parcel name > select Properties...

About properties dialog box

 1. Information tab
 A. Name of parcel

Info: This will be grayed-out if you have "Use name template in parcel style" 
check-box checked. Uncheck to edit name.

 B. Description of parcel
 C. Object Style

 I. Once you select an object style from dropdown list, click Apply to see the line 
type change.

 2. Composition tab
 A. Area selection label style 

 I. Changes the parcel object label
 B. Parcel statistics 

 I. Contains area and perimeter measurements
 3. Analysis tab

 A. User can run two different types of analyses
 I. Inverse analysis

 II. Mapcheck analysis
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 B. Calculation Setting
 I. Contains the "Point of Beginning", X & Y coordinates

Info: Point of beginning is either the starting point of the parcel created 
manually with parcel creation tools or, from an object, it's the first vertice 
of the object.

 II. To redefine your point of beginning
 a. Select green pick-box button and object will have arrows showing dir-

ection of analysis
 b. Select a new point of beginning.

 III. Process segment order counterclockwise checkbox
 a. To change the direction of analysis

 4. User Defined Properties tab
 A. To change Property Data values

Tip: Drawing files started with the plat-start WisDOT template file will have 
many user defined property fields available to fill in if possible. This data could 
appear in tables and Excel spreadsheets.

Parcel properties

prcl-basc-03.mp4 3:45

Ways to access Parcel Style dialog box

Select parcel object label (found in the center of object)

 1. Select parcel object label (found in the center of object)
 A. Ribbon > Parcel tab > Modify panel > select Parcel Properties dropdown > select 

Edit Parcel Style
 2. Select parcel object label (found in the center of object)

 A. Right-click > select Edit Parcel Style... from dropdown menu
 3. Toolspace > Settings tab > expand Parcel > expand Parcel Styles > select parcel style in 

use > right-click for dropdown > select Edit...

About Parcel Style dialog box

 1. Information tab
 A. Name of style
 B. Description of style
 C. Created by and date
 D. Last modified by and date

 2. Design tab
 A. Parcel pattern fill

 I. Observe fill distance checkbox and measurement; the distance from the line 
segments to the interior that is filled/hatched.
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Info: To see style applied, go to Display tab > Component display box > Par-
cel Area Fill > Select lightbulb to on.

 B. Parcel name template
 I. Select template icon to access properties used to populate the name template

 3. Section tab
 A. Object Display > Parcel Segments Marker Styles 

 I. Contains marker styles inside the multipurpose settings within the WisDOT 
Standards

 4. Display tab
 A. View direction

 I. Plan, model, or section
 B. Component Diplay

 I. Parcel Segments, displays outside geometry of parcel.
 II. Parcel Area Fill, displays the fill/hatch area.

Info: To view Parcel Segment Marker, change view direction to Section.

 C. Component hatch display
 I. User can edit pattern, angle, and scale of fill/hatch.

 5. Summary tab
 A. Contains information and Design data.

Create/edit parcels
Last updated: 2021-06-28

Total video time: 7:42

Create parcels from object

prcl-creat-edit-01.mp4 3:51

Exercise files: prcl-creat-edit-data-begin-c3d20.zip

Parcels created from an object is the preferred method for parcel creation.  A parcel can be created 
from lines, polylines, and arcs, and these need to be connected/snapped at the endpoints to create a 
closed boundary.

 1. Using polyline command to create an object.

 A. Ribbon > Home tab > Draw panel > Polyline

Tip: Have object snap set to Node only to make selection easier.

 B. Specify start point: Select node for start point and continue to each node to cre-
ate perimeter of object.

 C. To close object: Select final node or type "C" in the command line to auto-snap to start-
ing node and Enter.
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 D. Create a second smaller object, repeating steps A - C, attached to first object.  Node 
snap last point to close.

 E. Home tab > Create Design panel > Parcel dropdown > Create Parcel from 
Objects

 F. Select lines, arcs, or polylines to convert into parcels: Select a 
polyline from both objects, Enter

 G. Create Parcels - From objects dialog box
 I. Site: Select Edit icon to create new site

 a. Site Properties - Field Survey dialog box 
 i. Name: Rename to Field Survey
 ii. OKOK

 II. Parcel Style: RW PLE Proposed
 III. Label styles box

 a. Area label style: Area Acres and SF
 b. Automatically add segment labels: Uncheck box

Info: Unchecking this box due to the overlap of polylines between 
objects.  Overlapping lines will need to be labeled manually.

 IV. Erase existing entities: Check box
 V. OK

Create parcels from union

prcl-creat-edit-02.mp4 3:51

Creating a new parcel next to existing parcels

 1. Ribbon > Home tab > Create Design panel > select Parcel dropdown > select Parcel 
Creation Tools

 2. Parcel Layout Tools toolbar
 A. Select icon Add Fixed Line - Two Points

 I. Create Parcels - Layout dialog box 
 a. Verify Site: Field Survey
 b. Parcel Style: RW PLE Proposed
 c. Label styles box 

 i. Area label style: Area Acres and SF
 d. Automatically add segment labels: Uncheck box

 II. OK
 B. Specify start point: Select start point
 C. Specify start point: Select next point
 D. Prompt: Press Enter to start a new lot line, or select from layout tools or Exit: Select 

Enter
 E. Shift+Right-click menu > Select Endpoint
 F. Select last parcel line point
 G. Node snap to endpoint
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Info: Creating a new closed shape out of parcel segments that are adjacent to 
existing parcels will create a new parcel.

 H. Enter and Esc to end command

Creating a parcel union

 3. Ribbon > Home tab > Create Design panel > select Parcel dropdown > select Parcel 
Creation Tools

 4. Parcel Layout Tools toolbar
 A. Select icon Parcel Union dropdown > select Parcel Union
 B. Select the destination parcel: Select parcel to the north/top.
 C. Select Parcels and press enter: Select lower left parcel and north/top parcel.
 D. Both parcels become unified, area label has changed to show this.

Dissolve a parcel union

 5. Home tab > Create Design panel > select Parcel dropdown > select Parcel Creation 
Tools

 6. Parcel Layout Tools toolbar
 A. Select icon Parcel Union dropdown > select Dissolve Parcel Union
 B. Select parcel: Select parcel that was unified.
 C. Parcel union is dissolved
 D. Exit

Parcel labels
Last updated: 2021-06-28

Total video time: 5:10

Parcel segment labels

prcl-lbl-01.mp4 5:10

Exercise data: prcl-lbl-data-begin-c3d20.zip

Open prcl-lbl-C3D18.dwg.

Parcels segment labels are created with parcel or manually after parcel creation

Add parcel segment labels manually per segment

 1. Select parcel area label onscreen.
 2. Parcel contextual ribbon tab > Labels and tables panel > Add Labels drop-down > 

Single Segment command
 A. Cursor becomes pick-box. Select anywhere along parcel segment.
 B. Observe that segment label appears.
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 C. Add more labels by picking same segment in different location, or by picking addi-
tional parcel segments.

 D. Enter to end command.

Tips: 
Notice a default label style is applied automatically without any prompt allow-
ing you to choose a label style on-the-fly.

To change the style of of a segment label (or all segment labels at once), select 
the labels you'd like to change and choose Label Styles from the contextual tab 
of the ribbon. This brings up the AutoCAD Properties dialog box where both 
the Line Label Style and the Curve Label Style can be changed to the desired 
parcel line and/or curve label style, or general line and/or curve label style.

Notice the label appears wherever you selected along the segment line, not 
necessarily at the midpoint of the line.

Add multiple parcel segment labels manually, all at once

 1. Select parcel area label onscreen.
 2. Parcel contextual ribbon tab > Labels and tables panel > Add Labels drop-down > Mul-

tiple Segment command
 A. Cursor becomes pick-box. Select parcel area label for parcel whose segments you'd 

like to label and choose clockwise, or counterclockwise, to choose direction you'd like 
labels to measure.

 B. Observe that default style segment label appears at midpoint of every segment.
 C. Enter to end command.

Tips: 
Notice a default label style is applied automatically without any prompt allow-
ing you to choose a label style on-the-fly.

To change the style of a segment label (or all segment labels at once), select 
the labels you'd like to change and choose Label Styles from the contextual tab 
of the ribbon. This brings up the AutoCAD Properties dialog box where both 
the Line Label Style and the Curve Label Style can be changed to the desired 
parcel line and/or curve label style, or general line and/or curve label style.

Add parcel segment labels manually through the Add Labels dialog box

 1. Annotate tab > Labels and Tables panel > Label icon (or Parcel > Add Labels drop-
down > hover over Parcels heading > choose Add Parcel Labels from resulting fly-out 
menu
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 B. In resulting floating Add Labels dialog box:
 I. From Feature Type drop-down, select Parcel as feature type to label.

 II. From Label type drop-down, choose Single Segment, Multiple Segment.
 a. Select Replace Multiple Segment commands if you already placed 

labels and want to replace them.
 b. Ignore Area label types because we are experimenting with segment 

labels in this exercise.
 III. Choose Line label style you'd like to apply.
 IV. Choose Curve label style you'd like to apply.
 V. Add.

 a. Select parcel area label (centroid label) for parcel whose segments you'd 
like to label and choose clockwise, or counterclockwise, to choose dir-
ection you'd like bearings to read along the segments.

 b. Direction chosen also controls order of number for segment if label 
becomes tag for use in segment table.

 VI. Enter to end command.

 VII. Close in Add Labels dialog box when done creating new labels.

Tips: 
The benefit to using this dialog box is that you can change the Line label 
style and the Curve label style as you apply your labels as opposed to 
doing so from the AutoCAD Properties dialog box after creating labels 
as we saw before.

Choosing Replace Multiple Segment from the Label Type drop-down of 
the Add Labels dialog box allows users to replace already created seg-
ment labels with new labels without having to delete the old labels first 
and then create new labels from scratch afterward.

Edit parcel segment labels with grips

 1. Select a segment label and observe that two grips appear, a diamond shaped grip and a 
square grip.

 2. Left-click on diamond shaped label grip to slide label to new location along parcel segment 
line.

 3. Left-click on square label grip to move segment label into dragged state complete with leader 
pointing at object being labeled.

 4. With label selected in dragged state, reset label to original location by selecting label 
onscreen and choosing Reset Label command in contextual tab of ribbon, or by selecting 
label onscreen, right-clicking and choosing Reset Label from right-click menu.

 5. Whether label is in dragged state or not, Flip Label is also command option in contextual tab 
of ribbon, or right-click menu, when label is selected and displaying grips. This command 
changes order of label components onscreen to opposite configuration. For instance, if line 
length component is usually above line being labeled and bearing component is below, 
length component will now be below line and bearing component will appear above it.
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 6. Whether label is in dragged state or not, Reverse Label is also command option in contextual 
tab of ribbon, or right-click menu, when label is selected and displaying grips. If order labels 
were placed around parcel was originally clockwise from point of beginning, or first parcel seg-
ment, Reverse Label command will reconfigure segment labels to appear counterclockwise 
around parcel from point of beginning or first parcel segment.

Tip: If you'd like to choose your line and/or curve style for your parcel segment labels at 
the same time you are creating the labels, as opposed to editing the labels later to 
choose a style other than the default label style, go to the Annotate tab of the ribbon, 
the Labels & Tables panel, the Add Labels drop-down, and choose the top parcel label 
heading, Add Parcel Labels. This launches a dialog box allowing you to specify the style 
of the labels as you are creating them.

Parcel tables
Last updated: 2021-06-28

Total video time: 3:10

prcl-tbl-01.mp4 3:10

Exercise data: prcl-tbl-data-begin-c3d20.zip

Open prcl-tbl-C3D18.dwg.

Parcels tables are created from parcel segment labels.

Parcel segment labels are converted to table tags.

 1. Select parcel area label onscreen.
 2. Parcel contextual ribbon tab > Labels & Tables panel > Add Tables drop-down > Add 

Line

 A. In resulting Table Creation dialog box, select green, Pick On-Screen button.
 B. Cursor becomes pick-box. Select all parcel segment labels in drawing window you'd 

like included in table to be created.

Tips: 
Or, in the Select by label or style: portion of the dialog box, select the styles of 
the already existing parcel segment labels you'd like to include in your table. If 
segment labels using that style exist in your drawing, they will automatically be 
added to the table when the OK button is selected when executing the table 
creation command after filling out the rest of the dialog box.

The four table types (four table commands) available in the Add Tables drop-
down are Add Line, Add Curve, Add Segment, and Add Area. Add Line and Add 
Curve create tables consisting of only those segment types, respectively. Add 
Segment creates tables with both line and curve segments included. Add Area 
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creates tables consisting of, for instance, every overall parcel name and its area 
in square feet and/or acres.

 C. Select table layer or accept default WisDOT object layer for tables.
 D. Choose to split table after specifying number of rows allowed per table, or tables per 

table stack, to be created.
 E. Choose an offset distance between tables as they are placed in drawing window if mul-

tiple tables are being created simultaneously due to choice made in split table option.
 F. Choose how tables are to be tiled/arranged onscreen if multiple tables are being cre-

ated simultaneously due to choice made in split table option.
 G. Choose whether tables will be Static (unchanging), or Dynamic (automatically updated) 

if underlying parcel segment data is edited.
 H. OK

 3. As a test, if your table was made to be dynamic in the preceding steps, select a parcel seg-
ment onscreen that is included in the table, select one of its grips, change length of parcel seg-
ments by moving grip associated with vertex grip. Observe table update with new parcel 
segment lengths and/or area.

Create existing r/w
Last updated: 2021-06-29

Total video time: 27:13

Create a new drawing file

plat-creat-ex-row-01.mp4 4:00

Exercise data: plat-creat-ex-row-data-begin-c3d20.zip

 1. Application menu  > New
 2. Select template dialog box

 A. Look in: Templates\Begin-dwg\plat-start.dwt
 B. Open

 3. Once open, Application menu > Save As
 A. Save Drawing As dialog box 

 I. Save in: Local Disk:\WisDOT\Design\c3d\12345678\RW\DWG
 II. File name: 81100024-ERW

 III. Save

Creating and using data shortcuts (aka DREFs)

plat-creat-ex-row-02.mp4 4:21
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Set up working folder

 1. Toolspace > Prospector tab > right-click Data Shortcuts > select Set Working Folder...
 2. Browse For Folder dialog box

 A. Find and select c3d folder (Local Disk\WisDOT\Design\c3d)

Info: Set the working folder 2 levels above your "_Shortcuts" folder location 
(which is in your project folder).

 B. OK

Set up data shortcut project folder

This will verify your data shortcuts are available.

 3. Toolspace > Prospector tab > right-click Data Shortcuts > select Set Data Shortcuts Pro-
ject Folder...

 4. Set Data Shortcut Folder dialog box
 A. verify box is checked for project 12345678
 B. OK

Adding data shortcuts to base drawing

Adding alignments from data shortcuts to drawing

 5. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > expand 
Centerline Alignments > right-click CTH T-ExistROWRefLine > Create Reference...

 A. Leave default settings  OK
 6. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > expand 

Centerline Alignments > right-click STH64-ExistingROWRefLine > Create Reference...
 A. Leave default settings  OK

Two methods of promoting data shortcuts

Both methods will create permanent copies into the base drawing.

 7. Created through the Ribbon
 A. Select alignment object STH64-ExistingROWRefLine

 I. In Selection Cycling box, select Alignment

Tip: Having Selection Cycling on will make this step easier. You can find 
more here: "Status bar" on page 276

 B. Contextual ribbon > Alignment STH64-ExistingROWRefLine tab > Modify panel > 
Promote Data Reference

 C. To verify 
 II. Toolspace > 81100024-ERW > Alignments > Centerline Alignments

 D. Alignment STH64-ExistingROWRefLine is permanent and does not have a shortcut sym-
bol before the name.
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 8. Created through Toolspace
 A. Toolspace > 81100024-ERW > Alignments > right-click CTH T-ExistROWRefLine > 

Promote...

Add topo and section line XREFs

plat-creat-ex-row-03.mp4 4:07

Attaching XREFs

 1. Ribbon > Insert tab > Reference panel > select Attach
 2. Select Reference File dialog box

 A. While here, set quick access for Project folder
 I. Look in: Browse to c3d folder (Local Disk:\WisDOT\Design\c3d)

 II. Select 12345678 folder and drag to Places List

Tip: Use of the WisDOT custom command Load Xref on Layer can be 
seen in "Plat sheet details" on page 1653.

 B. Look in: 12345678\BaseData\Mapping\Orig
 C. Select Base Map.dwg

Info: (Detailed explanation at 1:36 of video) "Topo-Ex.dwg" is used in future 
videos. It is identical to "Base Map.dwg" file used here except that the objects 
have been placed on layers adhering to the current WisDOT layer naming 
regime.

 D. Open
 3. Attach External Reference dialog box

 A. Name: Base Map
 B. Reference Type: Overlay
 C. Scale: X = 1.00, Y = 1.00, Z = 1.00
 D. Insertion point: X = 0.00, Y = 0.00, Z = 0.00
 E. Path type: Relative path
 F. Rotation > Angle: 0
 G. OK

Tip: You can adjust the brightness of the Xref display by typing "OP" for OPTIONS in command 
line. The Options dialog box will open. Select Display tab > Fade control > Xref display to 
adjust.

Attaching a second file

 4. Ribbon > Insert tab > Reference panel > select Attach
 5. Select Reference File dialog box

 A. Select 12345678 project folder from Places list
 B. Select RW\DWG\81100024-ERW-SectLines.dwg
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 C. Open
 6. Attach External Reference dialog box

 A. Keep settings and select OK

Adding right of way polylines using offset command

plat-creat-ex-row-04.mp4 5:00

 1. Open title and right of way plat information
 A. Open File Explorer
 B. Titles: Local Disk:\WisDOT\Design\c3d\12345678\RW\Misc_Info\TitleSearches
 C. Right of Way: Local Disk:\WisDOT\Design\c3d\12345678\RW\Misc_Info\Mis-

c\rwplat-81100024.pdf
 2. Continuing with .dwg from previous exercise.
 3. Open specific layer to work on

 A. Open Layer Properties Manager: LA
 I. Filters: Select Right of Way

 II. Layer Name: Double-click E_RW_Existing to make it current layer

Adding offsets north side, along alignment CTH T

 4. Ribbon > Home tab > Modify panel > select Offset command
 B. Specify offset distance: 33
 C. Select object to offset: Due to multiple objects overlapping, user should have 

Selection Cycling turned on.
 I. Select Selection Cycling in Status bar.

 D. Specify offset distance: Should read 33 from previous entry, Enter
 E. Select object to offset: Select alignment CTH T

 I. Selection dialog box > select Alignment
 F. Select point on side of offset: select right side (NE) of alignment CTH T
 G. Select object to offset: Select alignment CTH T

 I. Selection dialog box > select Alignment
 H. Select point on side of offset: select left side (NW) of alignment CTH T

 5. Use Trim command to create a cutting edge at crossing alignment
 A. Ribbon > Home tab > Modify panel > Trim dropdown > Trim
 B. Select cutting edges...Select objects: Select alignment STH64

 I. Selection dialog box > select Alignment
 C. Enter
 D. Select object to trim: Select both offset lines continuing south of alignment 

STH64 to be deleted.

Adding offsets south side, along alignment CTH T

 6. Ribbon > Home tab > Modify panel > select Offset command2. Specify offset dis-
tance: 40 3. Select object to offset: Select alignment CTH T

 A. Selection dialog box > select Alignment
 B. Select point on side of offset: Select right side (SE) of alignment CTH T
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 C. Enter to end command and Enter to reset offset distance
 D. Specify offset distance: 45
 E. Select object to offset: Select alignment CTH T

 I. Selection dialog box > select Alignment
 F. Select point on side of offset: Select left side (SW) of alignment CTH T

 7. Use Trim command to create a cutting edge at crossing alignment
 A. Ribbon > Home tab > Modify panel > Trim dropdown > Trim
 B. Select cutting edge...Select object: Select alignment STH64

 I. Selection dialog box > select Alignment
 C. Enter
 D. Select object to trim: select both offset lines continuing north of alignment 

STH64 to be deleted.

Adding offsets east side, along alignment STH64

 8. Ribbon > Home tab > Modify panel > select Offset command
 9. Specify offset distance: 75

 10. Select object to offset: Select alignment STH64
 A. Selection dialog box > select Alignment
 B. Select point on side of offset: Select top side (NE) of alignment STH64
 C. Enter to end command and Enter to reset offset distance
 D. Specify offset distance: 60
 E. Select object to offset: Select alignment STH64

 I. Selection dialog box > select Alignment
 F. Select point on side of offset: Select bottom side (SE) of alignment STH64

 11. Use Trim command to create a cutting edge at crossing alignment
 A. Ribbon > Home tab > Modify panel > Trim dropdown > Trim
 B. Select cutting edge...Select object: Select alignment CTH T

 I. Selection dialog box > select Alignment
 C. Enter
 D. Select object to trim: select both offset lines continuing west of alignment CTH 

T to be deleted.

Adding offsets west side, along alignment STH 64

 12. Ribbon > Home tab > Modify panel > select Offset command

2. Specify offset distance: 80

3. Select object to offset: Select alignment STH64

 A. Selection dialog box > select Alignment
 B. Select point on side of offset: Select top side (NW) of alignment STH64
 C. Enter to end command and Enter to reset offset distance
 D. Specify offset distance: 55
 E. Select object to offset: Select alignment STH64

 I. Selection dialog box > select Alignment
 F. Select point on side of offset: Select bottom side (SW) of STH64 alignment
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 13. Use Trim command to create a cutting edge at crossing alignment

 A. Ribbon > Home tab > Modify panel > Trim dropdown > Trim
 B. Select cutting edge...Select object: Select alignment CTH T

 I. Selection dialog box > select Alignment
 C. Enter
 D. Select object to trim: select both offset lines continuing east of alignment CTH 

T to be deleted.

Correcting polyline offset

plat-creat-ex-row-05.mp4 4:45

Using C3D transparent command to correct polyline offset

 1. Ribbon > Home tab > Draw panel > Polyline

Info: This activates polyline command

 2. Transparent Commands toolbar > Select Station Offset

Info: This activates transparent command

 A. Specify station along baseline: 24000Enter
 B. Specify station offset: -50Enter

Info: Negative numbers place offset to the left of station, positive numbers to 
the right.

 C. Specify station along baseline: 25000Enter
 D. Specify station offset: -50Enter
 E. Specify station along baseline: 25000Enter
 F. Specify station offset: -80Enter
 G. Esc to exit transparent command
 H. Esc to exit polyline command

Correcting r/w editing

plat-creat-ex-row-06.mp4 4:53

Editing using offset command

Need to adjust the plat widening in the northwest corner of the intersection.

 1. Home tab > Modify panel > Offset command
 A. Specify offset distance: 50
 B. Select object to offset: Select the 80' r/w offset line
 C. Specify point on side to offset: Select to the north of 80' r/w offset line
 D. Select object to offset: Select alignment CTH T

 I. Selection dialog box > select Alignment
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 E. Specify point on side to offset: Select to the west of alignment CTH T
Use Trim command to create cutting edges

 2. Home tab > Modify panel > Trim dropdown > Trim

 A. Select cutting edge...Select object: Select lines that are cutting edges.

Tip: Use crossing window select to select multiple lines.

 B. Enter
 C. Select object to trim: select all offset lines that cross past the actual r/w line.

Tip: Any lines that should be removed, but were not by the trim command, use 
select and delete to remove.

Removing extra geometry

Removing Xrefs displayed

 1. Open Xref Manager, on command line type XR

 2. Right-click Base Map > Detach

Tip: To hide Xrefs, select Unload.

 3. Right-click Section Info > Detach

Removing centerline alignments

 1. Toolspace > Prospector tab > Alignments > Centerline Alignments > right-click STH64-
ExistROWRefLine > Delete

 2. Are you sure you wish to delete 'STH64-ExistROWRefLine'? Yes

Using Fillet command to connect line segments

 1. Connecting segment to offset line
 A. Select Fillet command 

 I. Home tab > Modify panel > Fillet dropdown > Fillet
 B. Keep radius at 0
 C. Select two lines; segment and offset line, excess will trim off.

 2. Doing multiple Fillet commands
 A. Select Fillet command
 B. In command line, select Multiple
 C. Select two lines and repeat around intersection.

Create proposed r/w
Last updated: 2021-06-29

Total video time: 20:22
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Creating proposed r/w file

plat-creat-prop-row-01.mp4 4:49

Exercise data: plat-creat-prop-row-data-begin-c3d20.zip

 1. Application menu  > New
 2. Select template dialog box

 A. Look in: Templates\Begin-dwg\plat-start.dwt
 B. Open

 3. Application menu > Save As
 4. Save Drawing As dialog box

 A. Select 12345678 folder in the Places List
 B. Save in: 12345678\RW\DWG
 C. File name: 81100024-PRW
 D. Save

Adding data shortcuts to proposed r/w file

Set working folder

 5. Toolspace > Prospector tab > right-click Data Shortcuts > select Set Working Folder...
 6. Browse For Folder dialog box

 A. Local Drive:\WisDOT\Design\c3d

Info: Set the working folder 2 levels above your "_Shortcuts" folder location 
(which is in your project folder).

 B. OK

Set data shortcuts project folder

This will verify your data shortcuts are available.

 7. Toolspace > Prospector tab > right-click Data Shortcuts > select Set Data Shortcuts Pro-
ject Folder...

 8. Set Data Shortcut Folder dialog box
 A. Check box next to current project number, 12345678
 B. OK

Create reference data shortcut alignments

 9. Add Surface
 A. Toolspace > Prospector tab > Data Shortcuts > Surfaces > right-click Road-

wayModel-Datum > Create Reference...
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 I. Create Reference dialog box 
 a. Information > Style: Select ellipse (...)

 i. Select Surface Style dialog box
 i. Select dropdown > Slope Intercept
 ii. OK

Info: If your 81100024-PRW drawing file was cre-
ated from WisDOT Civil 3D 2020 Plat-start template, 
you may not have "Slope Intercept" style available.  
Use "Standard" style instead.

 b. OK

 II. Use Zoom Extents; double-click mouse wheel or type Z+Enter and E+Enter
 10. Add data shortcuts (DREFs)

 A. Toolspace > Prospector tab > Data Shortcuts > Alignments > Centerline Align-
ments > right-click CTH T-ProposedROWRefLine > Create Reference...

 I. No changes and select OK
 B. Toolspace > Prospector tab > Data Shortcuts > Alignments > Centerline Align-

ments > right-click STH64-ProposedROWRefLine > Create Reference...
 I. No changes and select OK

 11. Promote data shortcuts
 A. Toolspace > Open Drawing > 81100024-PRW > Alignments > Centerline Align-

ments > right-click CTH T-ProposedROWRefLine > Promote...
 B. Toolspace > Open Drawing > 81100024-PRW > Alignments > Centerline Align-

ments > right-click STH64-ProposedROWRefLine > Promote...
 C.  

 12. Save file

Adding XREFs to proposed r/w

plat-creat-prop-row-02.mp4 4:45

Opening Xref Manager/External Reference palette 2 ways

 1. Turned on Dynamic Input (found on status bar)
 2. Type XR or XREF
 3. Enter

OR

 1. Ribbon > Insert tab > Reference panel
 2. Select diagonal arrow in lower right corner of panel

Tip: To keep palette from docking; right-click on External Reference bar, left-click to uncheck Allow 
Docking.
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Adding XREF 81100024-ERW.dwg

 3. XRef Manager
 A. Select File Source dropdown > select Attach DWG...

 4. Select Reference File dialog box
 A. Select project folder 12345678 in Places List
 B. Select RW\DWG\81100024-ERW.dwg
 C. Open

 5. Attach External Reference dialog box
 A. Name: 81100024-ERW
 B. Reference Type: Overlay
 C. Scale: X=1.00, Y=1.00, Z=1.00
 D. Path Type: Relative path
 E. Insertion Point: X=0.00, Y=0.00, Z=0.00
 F. Rotation Angle: 0
 G. OK

Tip: Use of the WisDOT custom command Load Xref on Layer can be seen in 
"Plat sheet details" on page 1653.

Adding XREF 81100024-ERW-SectLines.dwg

 6. XRef Manager
 A. Select File Source dropdown > select Attach DWG...

 7. Select Reference File dialog box
 A. Select project folder 12345678 in Places List
 B. Select RW\DWG\81100024-ERW-SectLines.dwg
 C. Open

 8. Attach External Reference dialog box
 A. Name: 81100024-ERW-SectLines
 B. Reference Type: Overlay
 C. Scale: X=1.00, Y=1.00, Z=1.00
 D. Path Type: Relative path
 E. Insertion Point: X=0.00, Y=0.00, Z=0.00
 F. Rotation Angle: 0
 G. OK

Finished adding XREFs, close External Reference palette by selecting the "x" in upper left corner.

Create proposed r/w boundary lines

Info: Set working environment: open title files and legal docs as needed.

 9. Open 12345678\RW\Misc_Info\TitleSearches\titles\8110-00-24.pdf, Parcel 1-Gillis 
Trust.pdf, Parcel 2-Cody Trust.pdf, and Parcel3-Krampert.pdf.

 10. Also open 12345678\RW\Misc_Info\Misc\rwplat-81100024.pdf.
 11. Open and peruse 12345678\RW\Misc_Info\TitleSearches\Misc\6424\rwplat\rwplat-

81100024.pdf, or other documents available in these folders, as needed.

Page: 1629

Published on: 5/17/2023

Adding XREFs to proposed r/w

../../../../../../Content/c3d/wisdot-cstm/c3d-tab/shr/shr-mng-load-xref-layr.htm


Create proposed r/w alignment southwest

 12. Ribbon > Home tab > Create Design panel > Alignment dropdown > select Alignment 
Creation Tools

 13. Create Alignment - Layout dialog box
 A. Name: type Proposed ROW RT Southwest
 B. Type: Miscellaneous
 C. Starting Station: 0+00.00'
 D. Site: None
 E. Alignment Style: dropdown > select RW Proposed
 F. Alignment layer: Browse

 I. Object Layer dialog box 
 a. Based layer name: Browse > select P_RW_ProposedOK

 II. OK
 G. Alignment label set: dropdown > select _No Labels
 H. OK

 14. First turn on OSNAPS
 A. Object Snap settings in Status bar, select check boxes for Endpoint and Nearest, then 

select OK.
 15. Alignment Layout Tools toolbar

 A. Alignment creation dropdown > Tangent-Tangent (No curves)

Create proposed r/w boundary lines (cont.)

plat-creat-prop-row-03.mp4 4:59

Create proposed r/w alignment southwest

 1. Alignment Layout Tools toolbar
 A. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 B. Specify start point: Select Transparent command toolbar > Station Offset
 C. Select alignment: select centerline alignment STH64

 I. Selection dialog box: select Alignment
 D. Specify station along baseline: 26000Enter
 E. Specify station offset:

Info: Be sure OSnaps are turned on; Object Snap settings in status bar, check 
boxes for endpoint and nearest, then OK.

 I. Snap to nearest ROW line south of STH64.
 F. Specify station along baseline:26200Enter
 G. Specify station offset: 75Enter
 H. Specify station along baseline:26450Enter
 I. Specify station offset: 75Enter
 J. Esc to exit transparent command

 K. Esc to exit alignment command
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 2. Alignment Layout Tools toolbar

 A. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 B. Specify start point: Select Transparent command toolbar > Station Offset
 C. Select alignment: select centerline alignment CTH T
 D. Specify station along baseline: 2. select endpoint from previous alignment
 E. Specify station offset: select same point again
 F. Specify station along baseline:9800Enter
 G. Specify station offset: use the nearest OSnap to snap to r/w line west of CTH 

T.
 H. Esc to exit transparent command
 I. Esc to exit alignment command

 3. Close Alignment Layout Tools toolbar

Create proposed r/w alignment northwest

 4. Home tab > Create Design panel > Alignment dropdown > select Alignment Creation 
Tools

 5. Create Alignment - Layout dialog box

Info: Some of these options are defaults from the previous settings.

 A. Name: type Proposed ROW LT Northwest
 B. Type: Miscellaneous
 C. Starting Station: 0+00.00'
 D. Site: None
 E. Alignment Style: RW Proposed
 F. Alignment layer: Browse 

 I. Object Layer dialog box 
 a. Based layer name: browse > select P_RW_ProposedOK

 II. OK
 G. Alignment label set: dropdown > select _No Labels
 H. OK

 6. Alignment Layout Tools toolbar
 A. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 B. Specify start point: Select Transparent command toolbar > Station Offset
 C. Select alignment: select centerline alignment STH64

 I. Selection dialog box: select Alignment
 D. Specify station along baseline: 26100Enter
 E. Specify station offset: 2. Use the nearest OSnap to snap to offset line north of 

STH64
 F. Specify station along baseline:26200Enter
 G. Specify station offset: -100Enter
 H. Specify station along baseline:26400Enter
 I. Specify station offset: -100Enter
 J. Esc to exit transparent command

 K. Esc to exit alignment command
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 7. Alignment Layout Tools toolbar
 A. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 B. Specify start point: Select Transparent command toolbar > Station Offset
 C. Select alignment: select centerline alignment CTH T
 D. Specify station along baseline: 

 I. Turn on OSnaps; Object Snap settings in status bar, check boxes for endpoint 
and nearest, then OK.

 II. select endpoint from previous alignment
 E. Specify station offset: select same point again
 F. Specify station along baseline:10225Enter
 G. Specify station offset: use the nearest OSnap to snap to r/w line west of CTH T
 H. Esc to exit transparent command
 I. Esc to exit alignment command

Create proposed r/w boundary lines (cont.)

plat-creat-prop-row-04.mp4 5:51

Create proposed r/w alignment northeast

Tip: Every time you end the command, there is a chance the OSnaps need to be added again.  
Turn on OSnaps; Object Snap settings in status bar, check boxes for endpoint and nearest, 
then OK.

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > select Alignment 
Creation Tools

 2. Create Alignment - Layout dialog box

 A. Name: type Proposed ROW LT Northeast

All other settings should carryover, exception for Alignment Layer.

 B. Alignment layer: Browse
 I. Object Layer dialog box 

 a. Based layer name: browse > select P_RW_ProposedOK
 C. OK

 3. Alignment Layout Tools toolbar
 A. Check OSnaps 

 I. Turn on OSnaps; Object Snap settings in status bar, check boxes for endpoint 
and nearest, then OK.

 B. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 C. Specify start point: Select Transparent command toolbar > Station Offset
 D. Select alignment: select centerline alignment CTH T
 E. Specify station along baseline: 10225Enter
 F. Specify station offset: use the nearest OSnap to snap to offset line east of CTH 

T
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 G. Specify station along baseline:10150Enter
 H. Specify station offset: 40Enter
 I. Esc to exit transparent command
 J. Esc to exit alignment command

 4. Alignment Layout Tools toolbar
 A. Check OSnaps 

 I. Turn on OSnaps; Object Snap settings in status bar, check boxes for endpoint 
and nearest, then OK.

 B. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 C. Specify start point: Select Transparent command toolbar > Station Offset
 D. Select alignment: select centerline alignment STH64
 E. Specify station along baseline: select endpoint from previous alignment
 F. Specify station offset: select same point again
 G. Specify station along baseline:26670Enter
 H. Specify station offset: use the nearest OSnap to snap to r/w line north of STH 

64
 I. Esc to exit transparent command
 J. Esc to exit alignment command

Create proposed r/w alignment southeast

 5. Ribbon > Home tab > Create Design panel > Alignment dropdown > select Alignment 
Creation Tools

 6. Create Alignment - Layout dialog box
 A. Name: type Proposed ROW RT Southeast

 I. All other settings should carryover, exception for Alignment Layer.
 B. Alignment layer: Browse

 I. Object Layer dialog box
 II. Based layer name: browse > select P_RW_ProposedOK

 C. OK
 7. Alignment Layout Tools toolbar

 A. Check OSnaps 
 I. Turn on OSnaps; Object Snap settings in status bar, check boxes for endpoint 

and nearest, then OK.
 B. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 C. Specify start point: Select Transparent command toolbar > Station Offset
 D. Select alignment: select centerline alignment STH64

 I. Selection dialog box: select Alignment
 E. Specify station along baseline: 26900Enter
 F. Specify station offset: use the nearest OSnap to snap to offset line south of 

STH64
 G. Specify station along baseline:26800Enter
 H. Specify station offset: 90Enter
 I. Specify station along baseline:26680Enter
 J. Specify station offset: 90Enter
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 K. Esc to exit transparent command
 L. Esc to exit alignment command

 8. Alignment Layout Tools toolbar
 A. Check OSnaps 

 I. Turn on OSnaps; Object Snap settings in status bar, check boxes for endpoint 
and nearest, then OK.

 B. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 C. Specify start point: Select Transparent command toolbar > Station Offset
 D. Select alignment: select centerline alignment CTH T
 E. Specify station along baseline: select endpoint from previous alignment
 F. Specify station offset: select same point again
 G. Specify station along baseline:9800Enter
 H. Specify station offset: use the nearest OSnap to snap to r/w line north of CTH 

T
 I. Esc to exit transparent command
 J. Esc to exit alignment command

Warning: Correction: "Create proposed r/w alignment southeast" was created in the wrong dir-
ection, against the flow of the alignment stationing.  Here's how to correct that:

 9. Select the alignment
 10. Ribbon > Alignment ProposedROW RT Southwest tab > Modify panel dropdown > 

Reverse Direction
 11. Warning prompt > OK
 12. Save file

Create ultimate r/w
Last updated: 2021-06-28

Total video time: 6:28

plat-creat-ultmt-row-01.mp4 6:28

Exercise data: plat-creat-ultmt-row-data-begin-c3d20.zip

Creating ultimate r/w alignments

Turn on OSnaps

 1. Status bar > Object Snap settings menu > select Endpoint
 2. Make sure the OSNAPS are turned on.

Create ultimate r/w alignment southwest

 3. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment 
Creation Tools
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 4. Create Alignment - Layout dialog box
 A. Name: Ultimate ROW Southwest
 B. Type: Miscellaneous
 C. Site: None
 D. Alignment style: RW Ultimate
 E. Alignment layer: Browse

 I. Object Layer dialog box 
 a. Based layer name: Browse > select P_RW_UltimateOK

 II. OK
 F. Alignment label set: _No Labels
 G. OK

 5. Alignment Layout Tools toolbar
 A. Alignment command dropdown > select Tangent-Tangent (No Curves)
 B. Using the Endpoint OSnaps and selecting each point as described: Begin alignment at 

western most endpoint (SW) of the existing eastbound ROW boundary line. Next point 
will be at the first convergence of the western most endpoint of the proposed ROW 
line, continuing to each endpoint along the geometry until it converges with the pro-
posed west side of the southbound ROW line. Last point will be at the southern most 
endpoint of this ROW line.

 C. Enter to end command
 6. Verify alignment appears in Miscellaneous Alignments

 A. Toolspace > Prospector tab > expand Alignments > expand Miscellaneous Align-
ments > Ultimate ROW Southwest

 7. X to close Alignment Layout Tools toolbar

Create ultimate alignment r/w southeast

 8. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment 
Creation Tools

 9. Create Alignment - Layout dialog box

All settings should be retained from previous setup except:

 A. Name: Ultimate ROW Southeast
 B. Alignment layer: Browse

 I. Object Layer dialog box 
 a. Based layer name: Browse > select P_RW_UltimateOK

 II. OK
 C. OK

 10. Alignment Layout Tools toolbar
 A. Select Alignment command dropdown > Tangent-Tangent (No Curves)
 B. Using the Endpoint OSnaps and selecting each point of Proposed SE alignment as 

described: Begin alignment at southern most endpoint (SE) of the existing northbound 
ROW boundary line. Next point will be at the first convergence of the proposed ROW 
line, continuing to each endpoint along the geometry until it converges with the south 
side of the proposed eastbound ROW line. Last point will be at the eastern most 
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endpoint of this ROW line.

Tip: Creating the ROW alignments in consistent direction can be beneficial if you 
need to use them as targets later in the design.

 C. Enter to end command
 11. Verify alignment appears in Miscellaneous Alignments

 A. Toolspace > Prospector tab > expand Alignments > expand Miscellaneous Align-
ments > Ultimate ROW Southeast

 12. X to close Alignment Layout Tools toolbar

Create ultimate r/w alignment northeast

 13. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment 
Creation Tools

 14. Create Alignment - Layout dialog box

All settings should be retained from previous setup except:

 A. Name: Ultimate ROW Northeast
 B. Alignment layer: Browse

 I. Object Layer dialog box 
 a. Based layer name: Browse > select P_RW_UltimateOK

 II. OK
 C. OK

 15. Alignment Layout Tools toolbar
 A. Select Alignment command dropdown > Tangent-Tangent (No Curves)
 B. Using the Endpoint OSnaps and selecting each point of Proposed NE alignment as 

described: Begin alignment at eastern most endpoint (NE) of the existing westbound 
ROW boundary line. Next point will be at the first convergence of the proposed ROW 
boundary line, continuing to each endpoint along the geometry until it converges with 
the east side of the northbound ROW line. Last point will be at the northern most end-
point of this ROW line.

 C. Enter to end command
 16. Verify alignment appears in Miscellaneous Alignments

 A. Toolspace > Prospector tab > expand Alignments > expand Miscellaneous Align-
ments > Ultimate ROW Northeast

 17. X to close Alignment Layout Tools toolbar

Create ultimate r/w alignment northwest

 18. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment 
Creation Tools

 19. Create Alignment - Layout dialog box

All settings should be retained from previous setup except:
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 A. Name: Ultimate ROW Northwest
 B. Alignment layer: Browse 

 I. Object layer dialog box 
 a. Base layer name: Browse > select P_RW_UltimateOK

 II. OK
 C. OK

 20. Alignment Layout Tools toolbar

 A. Select Alignment command dropdown > Tangent-Tangent (No Curves)
 B. Using the Endpoint OSnaps and selecting each point of Proposed NW alignment as 

described: Begin alignment at northern most endpoint (NW) of the existing south-
bound ROW boundary line. Next point will be at the first convergence of the proposed 
ROW boundary line, continuing to each endpoint along the geometry until it converges 
with the north side of the westbound ROW line. Last point will be at the western most 
endpoint of this ROW line.

 C. Enter to end command
 21. Verify alignment appears in Miscellaneous Alignments

 A. Toolspace > Prospector tab > expand Alignments > expand Miscellaneous Align-
ments > Ultimate ROW Northeast

 22. X to close Alignment Layout Tools toolbar

Create TLE 1 alignment

 23. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment 
Creation Tools

 24. Create Alignment - Layout dialog box

All settings should be retained from previous setup except:

 A. Name: TLE 1
 B. Type: Miscellaneous
 C. Site: None
 D. Alignment style: RW Temp Limited Easement
 E. Alignment layer: Browse

 I. Object layer dialog box 
 a. Base layer name: Browse > select P_RW_FeePatterns_TLEOK

 II. OK
 F. Alignment label set: _No Labels
 G. OK

 25. Alignment Layout Tools toolbar

 A. Select Alignment command dropdown > Tangent-Tangent (No Curves)
 B. Select Transparent command > Alignment Station Offset
 C. Select STH 64 alignment 

 I. Selection dialog box > select Alignment
 D. Specify station along baseline: 26250
 E. Specify station offset: 75
 F. Specify station along baseline: 26250
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 G. Specify station offset: 125
 H. Specify station along baseline: 26300
 I. Specify station offset: 125
 J. Specify station along baseline: 26300

 K. Specify station offset: 75
 L. Esc to exit transparent command

 M. Use OSnap and select beginning point (NW corner) to close

To clean up the ultimate r/w file

 26. Remove Xrefs
 A. Ribbon > Insert tab > Reference panel diagonal arrow

 I. Xref manager > File References 
 a. right-click 81100024-ERW > Detach
 b. right-click 81100024-ERW-SecLines > Detach

 27. Remove data shortcuts
 A. Toolspace > Prospector tab > expand Surfaces

 I. right-click RoadwayModel-Datum > Delete...
 II. Are you sure you want to delete 'RoadwayModel-Datum'? Yes

Save file

 28.  Application menu > Save As...
 A. Save Drawing As dialog box 
 B. Save in: Local drive:\WisDOT\Design\c3d\12345678\RW\DWG
 C. File name: 81100024-Ult-RW.dwg

Create takings parcels
Last updated: 2021-06-28

Total video time: 29:34

Create takings parcel with proposed r/w alignments

plat-creat-tkng-prcl-01.mp4 5:47

Exercise data: plat-creat-tkng-prcl-data-begin-c3d20.zip

Open drawing file and create data shortcuts (DREFs)

 1. Select Open Files... from main screen window
 2. Select File dialog box

 A. Select project folder 12345678 from Places List
 3. Look in: 12345678\RW\DWG 3. Select 81100024-PRW.dwg
 4. Open
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Set working folder

 5. Toolspace > Prospector tab > right-click Data Shortcuts > select Set Working Folder...
 6. Browse For Folder dialog box

 A. Local Drive:\WisDOT\Design\c3d

Info: Set the working folder 2 levels above your "_Shortcuts" folder location 
(which is in your project folder).

 B. OK

Set data shortcuts project folder

 7. Toolspace > Prospector tab > right-click Data Shortcuts > select Set Data Shortcuts Pro-
ject Folder...

 8. Set Data Shortcut Folder dialog box
 A. Verify box is checked for project 12345678
 B. OK

Create data shortcuts

 9. Toolspace > Prospector tab > right-click Data Shortcuts > select Create Data Short-
cuts...

 10. Create Data Shortcuts dialog box
 A. Expand Miscellaneous Alignments 

 I. Check boxes for: Proposed ROW LT Northeast, Proposed ROW LT North-
west, Proposed ROW RT Southeast, Proposed ROW RT Southwest.

 B. OK
 11. Toolspace > Prospector tab > Data Shortcuts > Alignments > Miscellaneous Alignments

 A. Verify alignments appear here; Proposed ROW LT Northeast, Proposed ROW LT 
Northwest, Proposed ROW RT Southeast, Proposed ROW RT Southwest.

Create a new takings drawing

 12. Select application menu (A in upper left corner) > New
 13. Select template dialog box

 A. Look in: Templates\Begin-dwg
 B. Select plat-start.dwt
 C. Open

 14. Select application command > Save As
 15. Save Draw As dialog box

 A. Select 12345678 folder in the Places List
 B. Save in: 12345678\RW\DWG
 C. File name: 81100024-Tkng-PRW
 D. Save
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Create reference to data shortcuts

Proposed ROW alignments

 16. Toolspace > Prospector tab > Data Shortcuts > Alignments > Miscellaneous Alignments 
> right-click Proposed ROW LT Northeast > select Create Reference...

 17. Create Alignment Reference dialog box
 A. Alignment style: RW Proposed
 B. Alignment layer: Browse

 I. Object Layer dialog box 
 a. Based layer name: browse > select P_RW_ProposedOK

 II. OK
 C. Alignment label set: _No Labels
 D. OK

 18. Use Zoom Extents; double-click mouse wheel or Z+Enter and E+Enter
 19. Repeat steps 1-3 for each of the remaining miscellaneous alignments; Proposed ROW LT 

Northwest, Proposed ROW RT Southeast, Proposed ROW RT Southwest.
 20. Verify alignments are active in the drawing:

 A. Toolspace > Prospector tab > 81100024-Tkng-PRW > Alignments > Miscellaneous 
Alignments

 B. There will be a little "box with arrow" in front of the alignment name. This symbol 
means it is a data shortcut (DREF). Temporary Limited Easement (TLE) alignment

 21. Open Ultimate ROW drawing file
 A. Quick Access toolbar > Open command
 B. Select File dialog box 

 I. Look in: 12345678\RW\DWG
 II. Select 81100024-Ult-RW.dwg

 III. Open
 22. Toolspace > Prospector tab > right-click Data Shortcuts > select Create Data Short-

cuts...
 A. Create Data Shortcuts dialog box 

 I. Expand Miscellaneous Alignments, checkmark TLE 1
 II. OK

 23. Toolspace > Prospector tab > Data Shortcuts > Alignments > Miscellaneous Alignments 
> right-click TLE 1 > select Create Reference...

 A. Create Alignment Reference dialog box 
 I. Alignment style: RW Temp Limited Easement

 II. Alignment layer: Browse 
 a. Object Layer dialog box 

 i. Based layer name: browse > select P_RW_FeePatterns_TLEOK
 b. OK

 III. Alignment label set: _No Labels
 IV. OK

 B. Use Zoom Extents; double-click mouse wheel, or Z+Enter and E+Enter
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Info: The above Proposed ROW... alignments could have been added from the 
Ultimate ROW drawing file, reducing the amount of steps performed.

XREF existing row (ERW) file

 24. Opening Xrefs Manager palette
 A. Insert tab > Reference panel > select diagonal arrow (in lower right corner of 

panel)
 B. XRef Manager palette 

 I. Select File Source dropdown > select Attach DWG...
 II. Select Reference File 

 a. Look in: DWG\81100024-ERW.dwg
 b. Open

 III. Attach External Reference dialog box 
 a. Name: 81100024-ERW
 b. Reference Type: Overlay
 c. Scale: X=1.00, Y=1.00, Z=1.00
 d. Path Type: Relative path
 e. Insertion Point: X=0.00, Y=0.00, Z=0.00
 f. Rotation Angle: 0
 g. OK

 IV. Close Xref Manager

Create takings parcel (part 1)

plat-creat-tkng-prcl-02.mp4 5:01

Alignment geometry cannot be used to create Civil 3D parcels. Parcels are a 3D object known as a 
feature line, a special kind of polyline. They are collected in Sites in the Prospector.

Create takings parcel with Parcel Creation Tools command

 1. Home tab > Create Design panel > Parcel dropdown > select Parcel Creation Tools
 2. Parcel Layout Tools toolbar

 A. Select first icon, Create Parcel
 B. Create Parcels - Layout dialog box 

 I. Site: select action button, to create new site 
 a. Site Properties - Site dialog box 

 i. Information tab 
 i. Name: TakingsParcels

 ii. Numbering tab 
 i. Parcel: Next Automatic Area Counter: 1001
 ii. Parcel: Next Manual Area Counter: 1

 iii. OK
 II. Parcel style: RW Property Existing

 III. Layers: No change, according to the template
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 IV. Label Styles 
 a. Area label style: Parcel Number

 V. Uncheck Automatically add segment labels
 VI. OK

 C. Select OSnap settings > checkmarkEndpoint
 D. On toolbar, select Add Fixed Line by Two Points command.
 E. On drawing, southwest corner, start selecting alignment geometry by clicking the 

beginning and endpoint for each segment line individually. Finishing at the point of 
beginning point.

 F. ESC twice to end command
 3. Select area label > right-click menu > Properties...

Tip: Civil 3D area label appear too small in the AutoCAD drawing window, click the 
annotation scale button (in status bar) and choose a scale that displays the at a  read-
able scale while you are designing. This does not affect label height when labels are 
printed. C3D Label Styles control printed label heights.

 A. Parcel Properties dialog box
 I. Information tab

 a. Object style: RW Property Fee S135'
 II. User Defined Properties tab

 a. Property Data 
 i. Owner ID Number: 2
 ii. Interest required: FEE & TLE
 iii. Owners Name: James A. and Arliss Cody Trust

 b. General 
 i. Parcel Tax ID: 0

 c. Utility Data 
 i. Volume/Page/Document: No Easement Information Found

Info: This parcel's information came from ...\c3d\12345678\RW\Misc_
Info\TitleSearches\titles\Parcel 2-Cody Trust.pdf

 III. Composition tab
 a. Area Section label style dropdown > select Owner ID

 IV. OK

Tips: 
Ways to access parcel properties

2 Ways parcel area labels help to access the parcel properties or other editing commands:

 1. Select area label
 A. Right-click > select Parcel Properties... > Parcel Properties dialog box

 2. Select area label
 A. Parcel tab > Modify panel > select Parcel Properties > Parcel Properties dia-

log box
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If you don't have an area label, you can still access the parcel properties through the Pro-
spector:

 1. Toolspace > Prospector tab > Sites > TakingsParcels > Parcels > right-click par-
cel's name > select Properties... > Parcel Properties dialog box

Creating takings parcel

plat-creat-tkng-prcl-03.mp4 5:00

Continue with 81100024-Tkng-PRW.dwg from the previous exercise section, or download a com-
pleted-to-this-point version of the 81100024-Tkng-PRW.dwg at the following link if you've gotten lost 
or would like to check your work:

Watch the beginning of the video for the Parcel 1 properties details that were filled, off camera.

Create boundary polylines (Parcel 3)

Create Parcels from Objects command requires creating a parcel from AutoCAD lines, arcs, or poly-
lines. First create a 2D polyline using the Boundary Creation command before using Create Parcels 
from Objects command.

 1. Start Boundary Creation command
 A. Home tab > Draw panel > Hatch dropdown > select BoundaryOR Type in com-

mand line BPOLY or BO
 2. Boundary Creation dialog box

 A. Boundary retention
 I. Object type: Polyline

 B. Island detection unchecked

Tip: This is used to avoid drawing polylines over label and other object within 
the selected area.

 C. Select Pick Points icon
 I. Select northeast and southeast parcel areas in which to create the boundary 

within.  If areas look correct, hit Enter to accept and end command.

Tip: If the area(s) do not look correct, hit ESC to cancel the command and restart 
the command.

Create takings parcel with Create Parcel from Objects command

Northeast Parcel

 3. Home tab > Create Design panel > Parcel dropdown > Create Parcel from Objects
 A. Curser becomes a pick box. Select boundary polyline of northeast parcel. 

 I. Selection box 
 a. Select Polyline and Enter

 4. Create Parcels - From objects dialog box
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Info: The difference between this dialog box and the Create Parcels - Layout dialog box 
is this dialog box has "Erase existing entities" option. Checking this box will erase the 
polyline used to create this parcel as the new parcel is created.

 A. Site: TakingsParcels
 B. Parcel style: RW Property Fee S90
 C. Layers: No change, according to the template
 D. Label Styles 

 I. Area label style: Parcel Number
 E. Check Erase existing entities
 F. OK

 5. Select area label

 6. Parcel tab > Modify panel > select Parcel Properties

 A. Parcel Properties dialog box 
 I. User Defined Properties tab 

 a. Property Data 
 i. Owner ID Number: 3

 II. Composition tab 
 a. Area Section label style dropdown > select Owner ID

 III. OK

Southeast Parcel

 7. Home tab > Create Design panel > Parcel dropdown > Create Parcel from Objects

 A. Curser becomes a pick box. Select boundary polyline of southeast parcel. 
 I. Selection box 

 a. Select Polyline and Enter
 8. Create Parcels - From objects dialog box

 A. Site: TakingsParcels
 B. Parcel style: RW Property Fee S90
 C. Layers: No change, according to the template
 D. Label Styles 

 I. Area label style: Parcel Number
 E. Check Erase existing entities
 F. OK

 9. Select area label
 10. Parcel tab > Modify panel > select Parcel Properties

 A. Parcel Properties dialog box 
 I. User Defined Properties tab 

 a. Property Data 
 i. Owner ID Number: 3

 II. Composition tab 
 a. Area Section label style dropdown > select Owner ID
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 III. OK

TLE 1 parcel, creating boundary polylines and takings parcel

 11. Home tab > Draw panel > Hatch dropdown > select Boundary
 12. Boundary Creation dialog box

 A. select Pick Points icon 
 I. Select within the TLE 1 parcel

 II. Enter to accept
 13. Home tab > Create Design panel > Parcel dropdown > Create Parcel from Objects

 A. Cursor becomes a pick box. Select boundary polyline of TLE 1 parcel. 
 I. Selection box 

 a. Select Polyline and Enter
 14. Create Parcels - From objects dialog box

 A. Site: TakingsParcels
 B. Parcel style: RW TLE Proposed
 C. Layers: No change, according to the template
 D. Label Styles 

 I. Area label style: Parcel Number
 E. Check Erase existing entities
 F. OK

 15. Select area label
 16. Parcel tab > Modify panel > select Parcel Properties

 A. Parcel Properties dialog box 
 I. User Defined Properties tab 

 a. Property Data 
 i. Owner ID Number: 2

 II. Composition tab 
 a. Area Section label style dropdown > select Owner ID

 III. OK

Edit user defined parcel properties (this is not included in the video)

 17. Select parcel label > right-click menu > Parcel Properties
 B. On User Defined Properties tab, make sure parcel numbers start at 1001 and go to 

1005 for the SW, NW, NE, SE, TLE parcels respectively.
 I. If they don't, go to Information tab, uncheck Use name template in parcel 

style check-box.
 II. Type proper parcel numbers into name value cell for each parcel respectively.

Tip: Parcel names initially come from the Parcel style applied when the 
parcel is first created. If you need to adjust the standard WisDOT num-
bering applied via these styles, go to the Numbering tab in the style and 
set the beginning number for your purposes.

 C. Input utility easement data, and property data, like Owner ID Number, Owners Name, 
Volume/Page/Document, etc. from title docs/easement docs found in project folder 
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under C:\WisDOT\Design\c3d\12345678\RW\Misc_Info\TitleSearches\titles (see 
videos).

 D. In this case, Owner ID Number should be set to 1 for NW parcel.
 E. Owner ID Number should be set to 2 for SW parcel and TLE 1 parcel.
 F. Owner ID Number should be set to 3 for NE and NW parcels.
 G. Click Apply if you'd like to observe changes onscreen before leaving Parcel Properties 

dialog box.
 H. Or click OK to apply changes and close Parcel Properties dialog box simultaneously.

 18. Save and Close file.

Creating parcel data table

plat-creat-tkng-prcl-04.mp4 6:06

To view and copy all user defined parcel properties

 1. Select Item Preview toggle, icon in upper left of Toolspace (square with magnifying glass). This 
will display item preview in bottom half of the Toolspace.

 2. Toolspace > Prospector tab > Sites > TakingsParcels > right-click Parcels > Properties...
 A. Site Parcel Properties dialog box 

 I. User defined property classification dropdown > All
 II. OK

 3. Toolspace > Prospector tab > Sites > TakingsParcels > right-click Parcels > Refresh
 4. Toolspace > Prospector tab > Sites > TakingsParcels > click on Parcels

With it highlighted, the Item Preview displays all of the user defined parcel data for each par-
cel.

 5. In Item Preview, Select all rows. Select top row, Hold Shift, then bottom row.  All rows 
should be highlighted.

 6. Right-click on selection for menu and Copy to clipboard.

Populate table in Excel

 7. In Excel, open Schedule of L&I Template.xslx

Info: You may need to find the location of this Excel spreadsheet if it is not in your pro-
ject folder. (Local Disk:\WisDOT\Design\c3d\12345678\BaseData\Other)

 8. File > Save As

 A. Save in: Local Disk:...\WisDOT\Design\c3d\12345678\RW\Misc_Info\Reports
 B. File Name: 81100024-ParcelInfoTable
 C. Save as type: Excel Worksheet (.xlsx)

Info: A completed version of this Excel file already exists in the Reports folder.  You can 
overwrite it or give your file a unique name.

 9. Select a cell below the existing table, right-click for menu and paste.
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 10. Using = sign in the existing spreadsheet, select corresponding data from the copied data table 
to populate the data.  Hit Enter after each selection.  Some columns may need = + formula (ex: 
Sq.Ft. to Acres).

Tip: Watch the video for a better visual explanation.

Copy table from Excel and paste special into Civil 3D

 11. Highlight table cells to be displayed in Civil 3D drawing.
 12. Right-click on selection for menu and Copy
 13. Return to drawing in Civil 3D
 14. Home tab > Clipboard panel > Paste dropdown > Paste Special
 15. Paste Special dialog box

 A. Select Paste radio button
 B. OK

 16. Select desired location within Civil 3D drawing window to insert table.
 17. SCEnter, to launch AutoCAD Scale command.

 A. Select object: Select table
 B. Specify base point: Select bottom-left corner of inserted table
 C. Specify scale factor: 100Enter

Updating table

 18. Copy any revised data from the Item Preview
 19. Return to the Excel file and update the spreadsheet
 20. Select the updated table, right-click and copy to the clipboard
 21. Delete the old table from Civil 3D drawing
 22. Repeat the Paste Special process mentioned above

Creating r/w traverse alignment

plat-creat-tkng-prcl-05.mp4 7:39

Continue working with 81100024-Tkng-PRW.dwg

Data shortcut centerline alignments

 1. Toolspace > Prospector tab > Data Shortcuts > Alignments > Centerline Alignments > 
right-click CTH T-PropsoedROWRefLine > Create Reference...

 A. Alignment style: RW Proposed
 B. Alignment label set: 1IN 100FT-Ticks 200' Major:100' Minor
 C. OK

 2. Toolspace > Prospector tab > Data Shortcuts > Alignments > Centerline Alignments > 
right-click STH64-PropsoedROWRefLine > Create Reference...

 A. Alignment style: RW Proposed
 B. Alignment label set: 1IN 100FT-Ticks 200' Major:100' Minor
 C. OK
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Create traverse alignment

 3. Home tab > Create Design panel > Alignments dropdown > select Alignment Creation 
Tools

 4. Create Alignment - Layout dialog box
 A. Name: ProposedROWTraverse
 B. Site: None
 C. Alignment style: RW Traverse
 D. Alignment layer: Browse

 I. Object Layer dialog box 
 a. Based layer name: Browse > select P_RW_TraverseOK

 II. OK
 E. Alignment label set: select dropdown > _No Labels
 F. OK

 5. Alignment Layout Tools - ProposedROWTraverse toolbar
 A. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 B. Use Endpoint OSnaps to snap to each vertex
 C. Start the traverse alignment at the horizontal PI 259+88.04 along the proposed STH64 

alignment.
 D. Continue selecting each vertex along the outside edge of the takings parcels, in the dir-

ection you would like the stationing to follow.
 E. For the last station, left-click the point-of-beginning, PI 259+88.04.
 F. "X" to close Alignment Layout Tools toolbar

Create points for traverse alignment

 6. Home tab > Create Ground Data panel > Points dropdown > select Point Creation 
Tools

 7. Create Points toolbar
 A. Select chevron button, to expand toolbar
 B. Expand Points Creation

 I. Prompt For Elevations: None
 II. Prompt For Point Names: None

 III. Prompt For Description: None
 IV. Disable Description Keys: True
 V. Collapse Point Creation

 C. Expand Default Styles
 I. Point Style: WisDOT Standard with RW Marker

 II. Point Label Style: Browse > select PRW Pnt Number 070 90 degOK
 D. Expand Default Name Format

 I. Point Name Template: Browse 
 a. Name Template dialog box 

 i. Name: <[Next Counter(CP)]>
 ii. Number style: 1, 2, 3...
 iii. Starting number 1
 iv. Increment value: 1
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 b. OK
 E. Expand Point Identity

 I. Next Point Number: 1
 F. Select chevron button, to collapse toolbar
 G. Select Create Misc Points dropdown (first icon) > Manual
 H. Using Endpoint OSnap, begin at the start point, PI 259+88.04, and select each vertex 

point along the traverse alignment clockwise. At the last point, just before the starting 
point, hit ESC to finish point creation command.

 I. Select starting point > right-click > Edit Label Text...
 J. Select a text component to edit: Select point label 

 I. Text Component Editor - Label Text dialog box 
 a. In label editor box, Change name to TRAV<[Point Number]>
 b. OK

 II. Observe label change, on screen, to starting point

Create points for TLE parcel

 8. Create Points toolbar 
 A. Select chevron button, to expand toolbar
 B. Expand Default Styles

 I. Point Label Style: Browse > select TLE Pnt Number 070 90 degOK
 C. Select chevron button, to collapse toolbar
 D. Select Create Misc Points dropdown (first icon) > Manual
 E. Using Endpoint OSnap, begin at the start point, NW point, and select each vertex point 

along the TLE alignment counterclockwise. At the last point, Esc to finish point creation 
command.

 F. "X" to close Create Points toolbar

Zoom out to see your completed work so far and Save the drawing.

Create plat sheets
Last updated: 2021-06-29

Total video time: 15:41

Prepare sheet

plat-creat-sht-01.mp4 7:20

Exercise data: plat-creat-sht-data-begin-c3d20.zip

 1. Remove L&I table with Erase command
 A. Select table
 B. Home tab > Modify panel > Erase
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 2. Data shortcut centerline alignments
 A. Verify working folder is in correct location. 

 I. Toolspace > Prospector tab > right-click Data Shortcuts > Set Working 
Folder...

 II. Browse For Folder dialog box 
 a. Browse to WisDOT\Design\c3d
 b. OK

 III. Toolspace > Prospector tab > right-click Data Shortcuts > Set Data Short-
cuts Project Folder...

 IV. Set Data Shortcuts Folder dialog box 
 a. Check box next to current project number
 b. OK

 B. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > 
expand Centerline Alignments > right-click CTH T-ExistROWRefLine > Create 
Reference...

 I. No changes and select OK
 C. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > 

expand Centerline Alignments > right-click STH64-ExistROWRefLine > Create 
Reference...

 I. No changes and select OK
 3. Promote centerline alignments

 A. Toolspace > Prospctor tab > expand Alignments > expand Centerline Alignments 
> right-click CTH T-ExistROWRefLine > Promote

 B. Toolspace > Prospctor tab > expand Alignments > expand Centerline Alignments 
> right-click STH64-ExistROWRefLine > Promote

Create view frames

 4. Setup View Boundary using output tools
 A. Output tab > Plan Production panel > launch Create View Frames command
 B. Create View Frames - Alignment wizard

 I. Alignment page
 a. Alignment: dropdown and select STH64-ProposedROWRefLine
 b. Station Range: Automatic
 c. Next

 II. Sheets page
 a. Sheet Setting: Plan(s) only
 b. Template for Plan sheet: Select ellipsis (...)

 i. Select Layout as Sheet Template dialog box
 i. Drawing template file name: Select ellipsis (...)

 i. Look in: WisDOT...\Templates\Sheets folder
 ii. Scroll and select 04-TPP34-wdot18.dwt

Tip: WisDOT plat sheets templates start with 
"04-TPP", then a measurement.  If there is a 

Page: 1650

Published on: 5/17/2023

Prepare sheet



"R" next, that means the sheet was rotated 
90 degrees.

 iii. Open
 ii. Select a layout to create new sheets: select TPP 34 1 IN 

200 FT
 iii. OK

 c. View Frame Placement: select Along alignment
 d. Next

 III. View Frame Group page
 a. Name: add 0401 and remove brackets so it reads, VF - 0401<|Next 

Counter(CP)|>
 b. Select Name Template icon 

 i. Incremental number format > Style: 1,2,3...
 ii. Starting number: 1
 iii. Incremental value: 1
 iv. OK

 c. Next
 IV. Match Lines page

 a. Uncheck Insert match line, since this is a single sheet
 V. Create View Frames

 VI. Zoom out
 VII. View frame should have label: VF - 04011, the last "1" is supplied by the counter 

in the name template.

Create plat sheets

plat-creat-sht-02.mp4 8:21

 1. Output tab > Plan Production panel > Create Sheets command

 A. Create Sheets - View Frame Group and Layouts wizard
 I. View Frame Group and Layouts page

 a. View Frame Group: VFG - STH64-ProposedROWRefLine - (1)
 b. Layout Creation:

 i. Number of layouts per raw drawing: 1, since there is only a single 
sheet.

Tip: This number can be increased for larger plans set with 
more collaborators.

 c. Layout Name: add 0401 and remove brackets so it reads, 0401<|Next 
Counter(CP)|>

 i. Select Name Template icon
 ii. Incremental number format > Style: 01,02,03...
 iii. Starting number: 1
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 iv. Incremental value: 1
 v. OK

 d. Choose the north arrow block to align in layouts: GN
 e. Next

 II. Sheets Set page

 a. Sheet Set
 i. Select Add to existing sheet set
 ii. Select ellipsis (...)
 iii. Browse the sheet set file dialog box 

 i. Look in: 12345678\SheetsPlan\planproduction.dst
 ii. Open

 b. Sheets
 i. Sheet files storage location: Select ellipsis (...)

 i. Browse for Folder
 i. Select Project folder 12345678\RW\DWG
 ii. Open

 ii. OK
 ii. Sheet file name: 12345678 - 0401<|next Counter|>-rp

Requirement: The naming convention is found at FDM15-
5 attachment 3.3

 i. Select Name Template icon
 ii. Incremental number format > Style: 01,02,03...
 iii. Starting number: 1
 iv. Incremental value: 1
 v. OK

 c. Next
 III. Data References page

 a. No changes
 IV. Create View Frames

Prompt: To complete this process your current drawing will be saved. OK

 B. Sheet Set Manager should be open automatically

Tip: If the Sheet Set Manager does not open, in the command line type "SSM."

Printing plats

 2. From Sheet Set Manager
 A. Single plat sheet 

 I. right-click layout name, 1 - 040101 > Publish > Publish to PDF
 B. Several plat sheets 

 I. right-click subset heading > Publish > Publish to PDF
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Info: If you have several subsets and plats sheets, right-click the sheet set name.  Sheets will 
publish in the same order as they are in the sheet set.

Go to "Plat sheet details" below  for instruction on finishing the plat sheet.

Plat sheet details
Last updated: 2021-06-29

Total video time: 1:26:32

Creating a plat sheet layout

plat-sht-dtl-01.mp4 5:36

Exercise data: plat-sht-dtl-data-begin-c3d20.zip

This is an alternative process to using the Plan Production tools.

Create a paperspace sheet

 1. WisDOT Sheets tab > select Palettes ON/OFF button to activate tool palette
 2. WisDOT Sheets tab > Sheet Creation panel > select ROW/Plat
 3. Tool Palette > Startup Main tab

 A. Scroll to Sheet Layout (TPP Layout 34")
 B. Select 04-TPP-34" Landscape 1=200 (04-TPP34-wdot18)

 4. Type NEW name for Layout: 040102Enter

Info: This was just an example of how to create.  Since we don't need it, right-click on the draw-
ing tab (found in bottom left of screen) labeled "040102", and select delete. You will continue 
using layout 040101.

Tip: You need to decide whether if it is better to put each sheet in its own file or create a sep-
arate layout tab for each sheet within an overall sheets drawing or RP drawing file.

Editing plat sheet layout

Edit space for adding notes and legends

 5. Select drawing tab 12345678-040101-rp
 6. Single left-click on viewport border, grips will appear on each corner and midpoint.
 7. Select both, top and bottom, mid-grip points and adjust border to desired size, to the edge of 

the model.

Tip: To keep the viewport polylines strictly horizontal/vertical, select the Ortho setting 
in the status bar.

 8. Double-click inside viewport to activate it.
 9. Select Viewport padlock in status bar to unlock it.  This allows you to move/pan the model.
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 10. Select and drag model to the right, being careful not to touch the mouse wheel which 
changes the model's scale.

 11. Double-click outside viewport to deactivate it.
 12. Single left-click on viewport border.
 13. Select left mid-grip point and adjust to edge of the model.

Tip: If you roll the mouse and resized the model, to return it to the correct scale, select 
Scale dropdown in the status bar and select the scale to reset (1IN:200FT for this exer-
cise)

Reading ROW lines

The XREF didn't bring the ROW lines into the current RP drawing because the information was 
attached as an overlay from the first drawing file to the second drawing file.  This then did not bring 
the information to the third drawing file. This needs to be corrected by using the Attach option 
instead.

 14. Select drawing tab 81100024-Tkng-PRW
 15. Launch Xref Manager

 A. Insert tab > Reference panel > launcher arrow in lower right corner
 B. Xref Manager 

 I. Select 81100024-ERW
 II. Details, change Type from Overlay to Attach

 16. X to close Xref Manager
 17. Select drawing tab 12345678-040101-rp
 18. Launch Xref Manager

 A. Insert tab > Reference panel > launcher arrow in lower right corner
 B. Xref Manager 

 I. Right-click 81100024-Tkng-PRW > Reload
 19. X to close Xref Manager

ROW lines should be in model.

Editing a plat sheet layout

plat-sht-dtl-02.mp4 6:22

Plat sheets, starting with a custom WisDOT sheet, have a deed recoding section and surveyor's 
information section prebuilt into the layout.  These are required by statue and are placed in their 
mandated locations.  There are 2 versions of the surveyor's information box, depending on if 
WisDOT's surveyors did the work or an outside firm.

Adding notes and legends

 1. Open ROW/Plat tool palette.
 A. Home tab > Palettes panel > Select ROW/Plat tool palette
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Tip: If the ROW/Plat palette is not available in the Palette panel, it can be added. 
WisDOT Sheets tab > Sheet Creation panel > select ROW/Plat

 2. ROW/Plat palette > Line & Symbols tab > TPP Title Sheet Block
 A. Select TPP Project Info, this is required by statue. Place on top of the sheet, if pos-

sible, next to the deeds recording section. Otherwise it can be placed where space is 
available.

 B. Select TPP Notes, describes the coordinate reference system. Place on left of View-
port.

Tip: Some of these blocks have attributes that can be editted with custom 
information. To edit the block definition, double-click on the block to open Block 
Editor; Edit Block Definition dialog box > OK. Edit as needed, then select 
Close Block Editor command in the ribbon > Save the changes...

 C. Select each of these legends and place them on the bottom of the sheet: TPP Conv 
Abbreviations, TPP Conv Symbols, TPP Conv Utility Symbols, and TPP Curve 
Data Abbreviation.

 D. Close ROW/Plat palette

Adding Tables

 3. SL&I table (Schedule of Land and Interest table)
 4. Utility Interests Required table, utilities within the project area.
 5. Sign Schedule table, any commercial advertising signs impacted by the project.

Location is Local Drive:\WisDOT\Design\c3d\12345678\RW\Misc_Info\Reports

The table are Excel templates and can be edited in Excel. To learn how to create and edit the tables, 
watch video plat-creat-tkng-prcl-04, Create Taking Parcels #4.

To add the tables to your sheet, follow this process or watch video @ 2:56.

 6. Select the applicable cells from the SL&I table of the spreadsheet
 A. Right-click for menu, select Copy

 7. Return to Civil3D.  Use special paste command.
 A. Home tab > Clipboard panel > Paste dropdown > Paste Special
 B. Paste Special dialog box > OK
 C. Select sheet for table to appear and rescale it (50%) to fit in upper left corner 

 I. Type SC
 II. Scale select objects: Select table

 III. Select Endpoint OSNAP, then select upper left corner of table.
 IV. Specify scale factor: type .5
 V. Type M

 VI. Select table and use Endpoint OSNAP to move to upper left corner.
 8. Repeat steps for Utility Interests Required and Sign Schedule tables.

Page: 1655

Published on: 5/17/2023

Editing a plat sheet layout



Add north arrow block

 9. Home tab > Palettes panel > Select ROW/Plat tool palette
 10. ROW/Plat palette > Line & Symbols tab > Title Sheet Misc Blocks > North Arrow
 11. Add to top right corner of model area.

Add scale bar

Add property location map

 12. Select Model layout tab
 13. Open Xref Manager

 A. Insert tab > Reference panle > launcher arrow in lower right
 B. Attach dropdown > Attach DWG
 C. Select Reference File dialog box 

 I. Look in: 12345678\RW\Misc_Info\County_Info\STCROIX.dwg
 II. OK

 14. Select 040101 layout tab
 15. MV Enter
 16. Draw rectangle to place viewport
 17. Double-click inside the viewport
 18. Z Enter, E Enter

 19. Pan and Zoom to desired map location
 20. Open drawing scale

 A. Choose Custom...
 B. Edit Drawing Scales dialog box 

 I. Add
 II. Add Scale dialog box 

 a. Name appearing in scale list: type 1IN=10000FT
 b. Scale Properties > Draw Units: type 10000
 c. OK

 III. OK
 21. Open drawing scale

 A. Select 1IN=10000FT
 22. Adding MTEXT above map

 A. Annotate tab > Text panel > Multiline Text
 B. Draw rectangle above map
 C. Type LOCATION MAP NOT TO SCALE
 D. Center above map

 23. Adding project location in map
 A. Select Model layout tab
 B. Home tab > Draw panel > Rectangle tool
 C. Draw a rectangle over traverse alignment
 D. Select and drag rectangle to open space
 E. Home tab > Draw panel > Hatch dropdown > Hatch > Pattern panel > Solid
 F. Select inside rectangle
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 G. Select hatched rectangle with a crossing window
 H. Drag over to map and place in location

 24. Select 040101 layout tab
 25. Add text and leader to project location

 A. WisDOT Sheets tab > WisDOT Annotation panel > Multileader
 B. Specify leader arrowhead location: Select project location in viewport
 C. Specify leader landing location: Select another point
 D. Type PROJECT LOCATION
 E. Move label to inside viewport 

 I. Select label and move using square grip

Editing a plat sheet layout

plat-sht-dtl-03.mp4 6:00

Prep before adding labels

 1. Select/Open 81100024-Tkng-PRW drawing file.

We'll begin adding additional labels to the model itself using the takings parcels drawing since 
that's the drawing containing the model which is XREFed into our sheet. Therefore, when we 
add additional labels and model elements to the takings parcels file and then save the file, 
the XREF of this file will be updated in our sheet file either automatically or when we reload it. 
To reload, in the commandline type XR to open XREF Manager.  Right-click on the takings par-
cels file (81100024-Tkng-PRW) and select Reload.

 2. Go to status bar and verify you are using 1IN=200FT scale, otherwise use the dropdown arrow 
and select it.

As we move through the process of adding more labels in the model drawing it makes sense 
to mimic the 1IN=200FT environment we're using in our sheet viewport because otherwise 
our labels don't appear the same height and take up the same amount of space.

Adding labels

Adjusting the point labels that appeared when we created traverse points along the traverse align-
ment.

 3. Ribbon> Annotate tab > Add Labels dropdown > Alignment > select Add Alignment 
Labels

 4. Add Labels dialog box
 A. Feature: Alignment
 B. Label Type: select dropdown, Station Offset-Fixed Point
 C. Station offset label style: select dropdown, RW Sta Off 070 90 degrees
 D. Marker style: None

Tip: Doing this removes the overlay of alignment label markers over already 
existing point markers.
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 E. Add

Info: Dialog box remains visible in case you need to return to it at any time.

 5. The curser becomes a select/pick box
 6. Select alignment: select centerline alignment STH64
 7. On the status bar, select OSnaps menu and check boxes Endpoint and Node
 8. Select point: select each point along the takings parcel and the label will appear.
 9. Esc to exit labeling command.

Rotate point and alignment station offset labels

Civil 3D doesn't allow rotating both labels at the same time, you need to do each individually.

 10. Start by rotating the point label, then rotate its associated station offset label.
 A. Select point label, hover over square grip, and select Rotate label from menu. You 

can either type in a degree measurement or rotate with the mouse to where you'd like 
it to be.

 B. Repeat above for station offset label.
 C. This proces scan be repeated if labels need to be adjusted again.

 11. If your alignment station offset labels are not plan readable, but the setting should always be 
set to plan readable.

 A. Select label > right-click menu > select Edit Label Style
 B. Station Offset Label Style dialog box 

 I. Select second dropdown and Edit Current Selection
 II. Label Style Composer dialog box 

 a. General tab > Plan Readablity > Plan readable set to True
 b. OK

Editing alignment segment labels

plat-sht-dtl-04.mp4 4:58

Placing segment labels

 1. Annotate tab > Labels & Tables panel > Add Labels dropdown > Alignment > select Add 
Alignment Labels

 2. Add Labels dialog box
 A. Feature: Alignment
 B. Label type: dropdown, select Single Segment
 C. Line label style: dropdown, select RW Bearing over Dist 070
 D. Curve label style: _No Display
 E. Spiral label style: _No Display
 F. Add

Tip: Note: Dialog box remains visible in case you need to return to it at any time.

 3. The curser becomes a select/pick box
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 4. Status bar > Selection Cycling is on.  With this on, if there are multiple objects overlapping the 
alignment you are selecting, a menu box will appear a list of objects. Select Alignment.

 5. Select traverse alignments along parcel. A label will appear on each line.
 6. Close Add Labels dialog box

Editing segment labels

 7. Moving the label
 A. Select label, using diamond-shaped grip, drag label to desired placement.

 8. Right-click menu options, select label and right-click
 A. Reverse Label, reverse the direction of the label.
 B. Flip Label, swaps label to the opposite side of the line.
 C. Label Properties, opens Properties palette, where you can change the styles.

Watch video @4:17 to the end to see final look of drawing.

Editing traverse segment label tags and tables

plat-sht-dtl-05.mp4 7:21

If the segment being labeled is shorter than the label itself or if other labels occupying the space 
where the segment label is needed, labels can be converted into tags that correlate with a table list-
ing instead of using full labels. The TLE parcel is perfect for the example.

Confirm the direction of the alignments

Tip: When doing a drawing, alignments should always be drawn in a clockwise direction, to 
ensure the table appears in numeric order.

 1. Bring the TLE parcel to the front of the display order
 A. Select > right-click menu > Display Order > Bring to Front

 2. Hover over alignment for Tool Tips box to appear.  Look at Station location for each align-
ment. The TLE parcel was drawn in the wrong direction.

 3. Select TLE parcel
 4. Alignment TLE1 > Modify panel dropdown > Reverse Direction

Info: The Reverse Direction command is only available for alignments that actually 
occupy the current drawing.  Therefore, the data shortcut for the miscellaneous TLE 
alignment was promoted into this file between videos.

 5. Reversing the alignment will remove all station equations, design speeds, superelevation 
data, dynamic offset, curb return alignments, and may adversely affect objects and data 
already created from the alignment.  Select OK.

 6. Esc to deselect TLE parcel
 7. Hover over alignment and check Station locations again.
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Change alignment ordinate station

Since the north TLE segment line is already accounted for in the southern ROW traverse alignment, 
the beginning station of 0+00 needs to be changed to the upper right corner.

 8. Select alignment
 9. Alignment TLE1 tab > Modify panel > select Alignment Properties

 10. Alignment Properties dialog box
 A. Station Control tab 

 I. Reference point box 
 a. Right of the X & Y coordinates, select Pick Reference Point button

 II. Warning appears, select OK
 B. Dialog box temporarily disappears for you to select a new point
 C. Make sure OSNAPs is on, with Endpoint or Intersection selected
 D. Select top right corner of TLE alignment
 E. Return to dialog box and select OK

Create initial segment labels

 11. Ribbon> Annotate tab > Add Labels dropdown > Alignment > select Add Alignment 
Labels

 12. Add Labels dialog box
 A. Feature: Alignment
 B. Label type: dropdown, select Single Segment
 C. Line label style: dropdown, select RW Bearing over Dist 070
 D. Curve label style: _No Display
 E. Spiral label style: _No Display
 F. Add

Info: Dialog box remains visible in case you need to return to it at any time.

 13. The curser becomes a select/pick box
 14. Select eastern TLE alignment segment line. If there are multiple objects, select Alignment 

from Selection box.
 15. Continue selecting southern segment line and western segment line.
 16. Close Add Labels dialog box

Create table

 17. Annotate tab > Label & Tables panel > Add Tables dropdown > hover over Alignment > 
fly-out menu > select Add Line

 18. Table Creation dialog box
 A. Table style: Traverse Table 070
 B. Select button next to No tags selected

 19. Return to draw and select tags in the order they were created, clockwise direction.
 A. Create Table - Convert Child Styles dialog box 

 I. Select Convert all selected label styles to tag mode
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 20. Table Creation dialog box
 A. Do not select any label styles, only want the 3 TLE segment labels selected.
 B. OK

 21. Table will be attached to cursor. Place to the right, outside the model area

Steps for creating section corner labels

plat-sht-dtl-06.mp4 8:32

 1. Open 12345678-040101-rp file
 2. Look at the current viewport and decide where you will place the section labels.

 A. We are doing 3 section corner labels; one in NW corner, one in NE corner, last one in 
SW corner.

XREF viewport into seclines drawing

We need to XREF the viewport into this file to see which actual section corner point objects we need 
for the section labels.

 3. Open 81100024-ERW-SecLines.dwg file
XREF

 4. Xref Manager dialog box 
 A. Select Attach dropdown > Attach DWG
 B. Select Reference dialog box 

 I. Look in: Local Disk:\WisDOT\Design\c3d\12345678\RW\DWG
 II. Select 81100024-Tkng-PRW.dwg

 III. Open
 C. Attach External Reference dialog box 

 I. Reference Type: Overlay
 II. Scale: X = 1.00, Y = 1.00, Z = 1.00

 III. Insertion point: X = 0.00, Y = 0.00, Z = 0.00
 IV. Path type: Relative path
 V. Rotation > Angle: 0

 VI. OK
 D. XREF files should appear under Reference Name column
 E. X to close dialog box

Adding section corner labels using left point

 5. Home tab > Palettes panel > Tool Palettes button
 6. Tool Palette > Section Corners tab > select Corner (1 Town & Range)
 7. Left-click on block section

 A. Right-click and change Scale to 100
 B. Left-click and drag to location
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 8. Edit text attributes
 A. Double-click block
 B. Enhanced Attribute Editor dialog box 

 I. SEC-NW, Value: 27
 II. SEC-NE, Value: 26

 III. SEC-SW, Value: 34
 IV. SEC-SE, Value: 35
 V. TOWN, Value: 31

 VI. RANGE, Value: 17
 VII. T-D, Value: N

 VIII. R-D, Value: W
 IX. select OK to accept changes

 9. Annotate tab > Add Labels dropdown > Notes
 10. Add Labels dialog box

 A. Note label style: dropdown, select N E

Info: This will pull the Northing-Easting value from what you select on-screen

 B. Select Add
 11. Select the center of the section corner point 3117266 using endpoint or node OSNAP
 12. Label is populated. Select it and use square grip to drag label and place below the section 

corner block.
 13. Remove leader line, select leader > right-click menu > select Toggle Leader
 14. Select label > right-click menu > select Edit Label Text...

 A. Text Component Editor - Label Text dialog box 
 I. In Preview window 

 a. Left-click to the left of the Northing information and hit ENTER. This will 
add a line above the Northing text.

 b. Left-click on this new line, type SEC 801 and hit ENTER
 c. On new line type RAILROAD SPIKE

 II. Select OK
 15. New data should be added to the label.  Select label and drag to move if needed.

Adding section corner labels using middle point

 16. Home tab > Palettes panel > Tool Palettes button
 17. Tool Palette > Section Corners tab > select Quarter (1 Town & Range NS)
 18. Left-click on block section

 A. Right-click and change Scale to 100
 B. Left-click and drag to location

 19. Edit text attributes
 A. Double-click block
 B. Enhanced Attribute Editor dialog box 

 I. SEC-N, Value: 26
 II. SEC-S, Value: 35

 III. TOWN, Value: 31
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 IV. RANGE, Value: 17
 V. T-D, Value: N

 VI. R-D, Value: W
 VII. select OK to accept changes

 20. Annotate tab > Add Labels dropdown > Notes
 21. Add Labels dialog box

 A. Note label style: dropdown, select N E
 B. Add

 22. Select the center of the section corner point 3117267 using endpoint or node OSNAP
 23. Label is populated. Select it and use square grip to drag label and place below the section 

corner block.
 24. Remove leader line, select leader > right-click menu > select Toggle Leader
 25. Select label > right-click menu > select Edit Label Text...

 A. Text Component Editor - Label Text dialog box 
 I. In Preview window 

 a. Left-click to the left of the Northing information and hit ENTER. This will 
add a line above the Northing text.

 b. Left-click on this new line, type SEC 800 and hit ENTER
 c. On new line type BRASS MONUMENT

 II. Select OK
 26. New data should be added to the label.  Select label and drag to move if needed.

Adding section corner labels using right point

 27. Home tab > Palettes panel > Tool Palettes button
 28. Tool Palette > Section Corners tab > select Corner (1 Town & Range)
 29. Left-click on block section

 A. Right-click and change Scale to 100
 B. Left-click and drag to location

 30. Edit text attributes
 A. Double-click block
 B. Enhanced Attribute Editor dialog box 

 I. SEC-NW, Value: 26
 II. SEC-NE, Value: 25

 III. SEC-SW, Value: 35
 IV. SEC-SE, Value: 36
 V. TOWN, Value: 31

 VI. RANGE, Value: 17
 VII. T-D, Value: N

 VIII. R-D, Value: W
 IX. select OK to accept changes

 31. Annotate tab > Add Labels dropdown > Notes
 32. Add Labels dialog box

 A. Note label style: dropdown, select N E
 B. Select Add

 33. Select the center of the section corner point 3117256 using endpoint or node OSNAP
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 34. Label is populated. Select it and use square grip to drag label and place below the section 
corner block.

 35. Remove leader line, select leader > right-click menu > select Toggle Leader
 36. Select label > right-click menu > select Edit Label Text...

 A. Text Component Editor - Label Text dialog box 
 I. In Preview window 

 a. Left-click to the left of the Northing information and hit ENTER. This will 
add a line above the Northing text.

 b. Left-click on this new line, type SEC 805 and hit ENTER
 c. On new line type RAILROAD SPIKE

 II. Select OK
 37. New data should be added to the label.  Select label and drag to move if needed.

Adding bearing and distance labels along section lines

plat-sht-dtl-07.mp4 7:14

Westside bearing and distance label

 1. Annotate tab > Add Labels dropdown > hover over Line and Curve > fly-out menu > 
select Add Line and Curve Labels

 2. Add Labels dialog box
 A. Label type: Single Segment
 B. Line label style: dropdown, select Bearing

Tip: Bearing style was picked due to it only having one component to edit.

 C. Add
 3. Cursor becomes a pick box.
 4. Select point on entity: Staying to the west of the intersection, select the section line 

that runs down the middle of STH64 ROW.
 5. Esc to end labeling command
 6. Select label > right-click menu > Edit Label Text...
 7. Select a text component to edit: select the label
 8. Text Component Editor - Label Text dialog box

 A. In Preview window, select/highlight text
 B. Properties: Format, change to DD MM'SS.SS" (the format with no spaces)
 C. Select ARROW button to push changes into the highlighted text

Warning: If you don't not select the ARROW button the edits/changes will not 
take place.

 D. We need to add a second component. In Preview window, left-click at the end of the 
text line and add a SPACE

 E. Properties: dropdown, select General Segment Length
 F. Properties: Precision, change to 0.01
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 G. Select ARROW button to push changes
 H. In Preview window, left-click at the beginning of all the text, and type SECTION LINE=

Warning: Make sure to add a SPACE at the end of what you are typing to sep-
arate it from the other component.

 I. OK to accept changes
 9. Label is populated.  Select label and use diamond grip to drag to desired placement.  If the 

label overstrikes other annotations, it's okay for now and will be cleared up in future videos.

Eastside bearing and distance label

 10. Add Labels dialog box should still be open.  If not, go to Annotate tab > Add Labels drop-
down > hover over Line and Curve > fly-out menu > select Add Line and Curve Labels

 11. Add Labels dialog box
 A. Label type: Single Segment
 B. Line label style: dropdown, select Bearing
 C. Add

 12. Cursor becomes a pick box.
 13. Select point on entity: Staying to the east of the intersection, select the section line 

that runs down the middle of STH64 ROW.
 14. Esc to end labeling command
 15. Select label > right-click menu > select Edit Label Text...
 16. Select a text component to edit: select the label
 17. Text Component Editor - Label Text dialog box

 A. In Preview window, select/highlight text
 B. Properties: Format, change to DD MM'SS.SS" (the format with no spaces)
 C. Select ARROW button to push changes into the highlighted text
 D. We need to add a second component. In Preview window, left-click at the end of the 

text line and add a SPACE
 E. Properties: dropdown, select General Segment Length
 F. Properties: Precision, change to 0.01
 G. Select ARROW button to push changes
 H. In Preview window, left-click at the beginning of all the text, and type SECTION LINE=

Warning: Make sure to add a SPACE at the end of what you are typing to sep-
arate it from the other component.

 I. OK to accept changes
 18. Label is populated.  Select label and use diamond grip to drag to desired placement.

Adding section corner markers (watch video @4:44)
Since two of our section corner points are outside of the viewport, special labeling is needed for 
those.  Stand-in marker will be needed for those.  The middle point is the only one we can see within 
our viewport.
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Left side marker

 19. Change the current layer
 A. Home tab > Layers panel > Layer dropdown > select P_RW_SectionLine

 20. Open Tool Palette
 A. Home tab > Palettes panel > Tool Palettes button

 21. Open Block palette
 A. WisDOT Sheets tab > Standard Components panel > Components Palettes drop-

down > Block Palette
 22. Return to Tool Palette > Plat Blocks tab > select Section Corner Monument
 23. Before you place the marker

 A. right-click to change the scale to 0.15, which is the same size as the traverse markers.
 B. Change OSNAP to Nearest

 24. Left-click on the section line, just to the east of the 16ths section line, to place marker.
 25. Add line break symbol with polyline command to the right of marker

 A. Home tab > Draw panel > Polyline command (upper right corner button)
 26. Using the polyline command again and setting OSNAP to Center, select the section corner 

marker and make a new leader to the section block containing the section annotations.

Right side marker

 27. Return to Tool Palette > Plat Blocks tab > select Section Corner Monument
 28. Before you place the marker

 A. right-click to change the scale to 0.15, which is the same size as the traverse markers.
 B. Change OSNAP to Nearest

 29. Left-click on the section line to place marker.
 30. Add line break symbol with polyline command to the left of marker

 A. Home tab > Draw panel > Polyline command (upper right corner button)
 31. Using the polyline command again and setting OSNAP to Center, select the section corner 

marker and make a new leader to the section block containing the section annotations.

Middle marker

Since the middle marker is visible, a new polyline leader is the all that needs to be done.

 32. Using the polyline command again and setting OSNAP to Center, select the mid-point marker 
and make a new leader to the section block containing the section annotations.

Adding traverse tie-in label

plat-sht-dtl-08.mp4 5:16

On the west side of the traverse, we placed a stand-in section corner point to represent the actual 
section corner point that is outside of the view port. To get the bearing distance measurement, we 
will add a temporary AutoCAD line from the actual section corner point to the starting point of the 
project traverse.
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 1. Home tab > Draw panel > Line command dropdown > select Create Line
 2. Specify first point: Select actual section corner point, using Node or Endpoint OSNAP
 3. Specify next point: Select traverse start point
 4. Esc to end command
 5. Annotate tab > Add Labels dropdown > Line and Curve menu > select Add Line and 

Curve Labels
 6. Add Labels dialog box

 A. Label type: Single Segment
 B. Line label style: dropdown, select Bearing
 C. Add

 7. Select point on entity: Select Line
 8. Selection dialog box > Line
 9. Select bearing label > right-click menu > Flip Label

The label appears on the bottom side of line

 10. Select bearing label > right-click menu > Edit Label Text...
 11. Select a text component to edit: select bearing label
 12. Text Component Editor - Label Text dialog box

 A. In Preview window, select/highlight text
 B. Properties: Format, change Value to DD MM'SS.SS" (the format with no spaces)
 C. Select ARROW button to push changes into the highlighted text

Warning: If you don't not select the ARROW button the edits/changes will not 
take place.

 D. We need to add a second component. In Preview window, left-click at the end of the 
text line and add a SPACE

 E. Properties: dropdown, select General Segment Length
 F. Properties: Precision, change to 0.01
 G. Select ARROW button to push changes
 H. OK to accept changes

 13. Next, draw a polyline which will connect the bearing/distance label to the two points.
 A. Home tab > Draw panel > Polyline command
 B. Specify start point: select stand-in section corner point and drop down below 

line break symbol.
 C. Specify next point: continue polyline below the labels, parallel to segment line.
 D. Specify next point: continue polyline up to traverse starting point.
 E. Esc to end command

 14. Explode bearing label

This is only to connect the bearing label to the polyline/leader just created.

 A. Select bearing label
 B. Type X and select X (EXPLODE)

 15. Select the original AutoCAD line and delete it.  It is no longer needed.
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 16. Use AutoCad Break command to create space in the polyline for the bearing label
 A. Home tab > Modify panel dropdown > Break command
 B. Select object: Select polyline where you would like to start the break, using the 

bearing label for guidance.
 C. Specify second break point: Again using bearing label, select end of break.

 17. Select bearing label > right-click menu > Basic Modify Tools > Move
 A. Place bearing label inside the gap of the polyline
 B. Esc to end command

Adjust section labels size to fit into the viewport

 18. Double-click on section label
 19. Text Editor tab > Style panel > expand > select 140

This represents Modelspace text type

 20. Multiline Text - Text Style Change prompt box > select Yes
 21. Use grip edits to resize and move

Repeat for each section label, 4 in all.

Final Steps

We are done adding and editing section information labels.

Before leaving file, detaching the Takings Parcel file, which was used as an overlay.

 22. XREF

 23. Xref Manager Palette
 A. Select 81100024-Tkng-PRW > right-click menu > Detach
 B. X to close

Now SAVE the SecLines file.

Label clean up and r/w labels

plat-sht-dtl-09.mp4 4:41

Insert SecLine drawing file

 1. Open Xref Manager
 A. Home tab > Reference panel > launcher arrow
 B. Attach dropdown > Attach DWG
 C. Select Reference File dialog box 

 I. Look in: DWG folder
 II. Select 81100024-ERW-SecLines.dwg

 III. Open
 D. Attach External Reference dialog box 

 I. Reference Type: Attachment
 II. Scale: X = 1.00, Y = 1.00, Z = 1.00
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 III. Insertion point: X = 0.00, Y = 0.00, Z = 0.00
 IV. Path type: Relative path
 V. Rotation > Angle: 0

 VI. OK

Clean up of label overstrikes

 2. Move alignment geometry labels

Tip: When selecting a label, if you notice other labels highlighting this means they are 
grouped together. To select an individual label, press CTRL key while selecting.

 A. Rotate label to read at 0 degrees/horizontal.

If you have a group of labels selected, these changes will affect all of them. If you 
select a single label, with the CTRL key, the changes will only affect the one label.

 I. Select label group > right-click menu > Properties...
 II. Properties palette > Design tab > Labeling > Geometry Point Label Style 

dropdown > select WisDOT Standard 0 Rotation
 B. Select square grip of label and move to new placement.

 3. Deleting a single label
 A. Alignment station 268 label overstrikes the label created to annotate the section line 

text coming from the SecLine's XREF.
 B. CTRL + select station label > DELETE key

 4. Adjust any non-alignment labels
 A. Rotating a traverse label and off-set label 

 I. Select label, right-click square grip for menu and select Rotate Label
 II. Adjust label

 B. Move a traverse label 
 I. Select label, using square grip, move

 C. Move parcel labels out with leader line 
 I. Select label, using square grip, move

 5. Move TLE parcel table
 A. Select table, using square grip, move to location within the Viewport.

Add bearing labels for CTH T, along northern and southern ROW centerlines

 6. Annotate tab > Add Labels dropdown > hover over Line and Curve > fly-out menu > 
select Add Line and Curve Labels

 7. Add Labels dialog box
 A. Label type: Single Segment
 B. Line label style: dropdown, select Bearing
 C. Add

 8. Cursor becomes a pick box.
 9. Select point on entity: North of the intersection, select the section line that runs 

down the middle of CTH T ROW.

Info: If there are multiple objects, you will get a menu.  Select Alignment from menu.
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 10. Esc to end labeling command
 11. Select label, using the diamond grip, and move where label is visible
 12. Annotate tab > Add Labels dropdown > hover over Line and Curve > fly-out menu > 

select Add Line and Curve Labels
 13. Add Labels dialog box

 A. Label type: Single Segment
 B. Line label style: dropdown, select Bearing
 C. Add

 14. Cursor becomes a pick box.
 15. Select point on entity: South of the intersection, select the section line that runs 

down the middle of CTH T ROW.
 16. Esc to end labeling command
 17. Select label, using the diamond grip, and move where label is visible

Adding ROW dimensions

plat-sht-dtl-10.mp4 5:00

 1. Change layer
 A. Home tab > Layers panel > Layer Manager dropdown > select P_RW_Text

 2. Annotate tab > Dimensions panel > Dimension Styles dropdown > select 070-LANE & 
SHLD

If you don't see any styles, to populate them in, go to WisDOT Sheets > Standards Com-
ponents panel > Add All Components button.

 3. Annotate tab > Dimensions panel > Dimension Styles dropdown > select Linear Dimen-
sion command

 4. Specify first extension line origin: Placement will be west of intersection, north-
side of alignment between stations 262 & 264.

 A. Hold SHIFT + right-click for OSNAP menu and select Nearest
 B. Snap to the alignment
 C. Hold SHIFT and right-click for OSNAP menu and select Perpendicular
 D. Snap to North RW line

 5. Edit dimension
 A. Select object > right-click menu > Properties...
 B. Properties palette > Design tab > Lines and Arrows 

 I. Dim Line 1 dropdown > Off
 II. Dim Line 2 dropdown > Off

 6. Repeat step 4 for each dimension, place on each side of each ROW.

Add curve label for STH64

 7. Annotate tab > Label & Tables panel > Add Labels dropdown > hover over Alignment > 
fly-out menu > Add Alignment Labels
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 8. Add Labels dialog box
 A. Label type: Single Segment
 B. Line label style: PI XY ^ D T L R PC XY PT XY DB DA
 C. Add

 9. Select point on entity: Select STH 64 alignment
 10. Label will populate
 11. Select label, using the square grip. move out into a space near the TLE parcel segment table.

CORRECTION: Traverse point labels

In video plat-sht-dtl-03, all of the traverse point labels were placed in association with STH 64, but 4 
points need to be associated with CTH T; PRW5, PRW6, PRW12, and PRW13.

 12. The point labels are correctly label, only the station off-set labels need to change.
 A. CTRL + select each station offset label for each point
 B. Delete 

 13. Annotate tab > Add Labels dropdown > hover over Alignment > fly-out menu > select 
Add Alignment Labels

 14. Add Labels dialog box
 A. Label type: Station Offset - Fixed Point
 B. Station offset label style: RW Sta Off 070 90
 C. Add

 15. Select alignment: Select CTH T alignment
 16. SHIFT + right-click to open OSNAP menu and select Endpoint
 17. Select point: Select point marker for PRW5
 18. Label populates
 19. Select station offset label > hover over the square grip > select Rotate Label from 

menu
 20. Align label with corresponding point label leader line.
 21. Repeat steps 5 - 9 for points PRW6, PRW12, & PRW13.

Adding adjacent parcels information

plat-sht-dtl-11.mp4 6:48

Adding additional property line information to display the location of any parcels not involved in the 
takings directly, but that might need to be included because they're located directly adjacent to the 
project.

 1. Import as a block, to utilize the Civil3D labels in this drawing
 A. Command line: type I for Insert
 B. Insert dialog box 

 I. Browse 
 a. Select Drawing File dialog box 

 i. Look in DWG folder (Local 
drive:\WisDOT\Design\c3d\12345678\RW\DWG)

 ii. Select 81100024-ERW-Parcels.dwg
 iii. Open
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 II. Insertion point: X = 0.00, Y = 0.00, Z = 0.00
 III. Scale: X = 1.00, Y = 1.00, Z = 1.00
 IV. Rotation > Angle: 0
 V. Check box Explode

 VI. OK
 2. Exploded geometry appears
 3. Some of the needed property lines overlap the TLE Parcel Segment Table. Move the table NW 

of intersection.
 4. Change Layer

 A. Home tab > Layers panel > Layer Manager dropdown > select P_RW_Prop-
ertyLine

 5. Use polyline command
 A. Home tab > Draw panel > Polyline command

 6. Set OSNAP to Endpoint
 7. Trace the property lines, west of TLE parcel, that come off the intersection and aren't part of 

the original parcel drawing.
 8. Where necessary, flip labels

 A. Select label > right-click menu > Flip Label
 9. Other edits include

 A. Move label, use diamond grip to slide labels and make visible
 B. Delete label, select label and DELETE
 C. Edit label 

 I. Select label > right-click menu > Edit Label Text
 II. Add text to preview window

 III. OK

Hide unnecessary visible property lines

 10. Toolspace > Prospector tab > expand Sites > expand Existing Parcels
 A. If there isn't an Existing Parcels, right-click on Sites and select Refresh

 11. Verify these are the newly inserted parcels
 A. Expand Parcels, to see all parcels
 B. Right-click on one of the parcels and select Select, to verify this isn't one of the original 

takings parcels.
 12. Add new parcel style to hide parcels instead of displaying them

 A. Right-click on Parcels > select Properties...
 B. Site Parcel Properties dialog box

 I. Composition tab > Site parcel dropdown > select _No Display

 II. Apply

Make sure new style appears on top of list in Parcel style display order preview

 III. OK
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 13. Return Toolspace...Parcels > right-click 1001 > select Properties...
 A. Parcel Properties - 1001 dialog box 

 I. Information tab > Object Style dropdown > select _No Display
 II. OK

 14. Repeat step 4 for each parcel; 1002, 1003, & 1004.

Adding existing topography and labels (part 1)

plat-sht-dtl-12.mp4 6:20

Xref topo drawing

 1. Use Load Xref on Layer command

 A. For Civil3D 2018: WisDOT Sheets tab > Manage panal > Xrefs dropdown > Load 
Xref on Layer

On later version: WisDOT Sheets tab > Manage panal > Load Xref on Layer

 2. Select a File to Xref dialog box

 A. Look in: Local drive: WisDOT\Design\c3d\21345678\RW\Misc_Info\TOPO
If the file is not there, check here: Local drive: WisDOT\Design\c3d\21345678\BaseData\Other

 A. select Topo-Ex.dwg
 B. Open

Xref opens on it's own layer.  If you hover over the layer, it is labeled Xref-Topo-Ex.

In the command line, you can type XLIST, select and object and it will tell you the layer it is on.

Editing power poles

 3. WisDOT Sheets tab > Standard Components panel > Component Palettes dropdown > 
Block Palette

 4. Change layer
 A. Home tab > Layers panel > Layers Manager dropdown > select E_UTL_EGuyPole

 5. Block Palette > Topo Symbol Blocks tab > scroll to Lighting/Poles > select Power Pole
 6. Change scale

 A. Right-click menu > Scale > type .25
 7. Change OSNAP

 A. Status bar > OSNAP menu > select Center
 8. Select power pole
 9. Home tab > Modify panel > Copy

 10. Select pole again and, with Center OSNAP, continue selecting all power poles within Viewport.
 11. Esc to end command

Editing utility pedestal

 12. WisDOT Sheets tab > Standard Components panel > Component Palettes dropdown > 
Block Palette
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 13. Change layer
 A. Home tab > Layers panel > Layers Manager dropdown > select E_UTL_AG

 14. Block Palette > Topo Symbol Blocks tab > scroll to Utilities > select Utility Pedestal
 15. Change scale

 A. Right-click menu > Scale > type .5
 16. Change OSNAP

 A. Status bar > OSNAP menu > select Geometric Center
 17. Select utility pedestal, in center of polygon
 18. Home tab > Modify panel > Copy
 19. Select pedestal again and continue selecting all power poles within Viewport.
 20. Esc to end command

Adding existing topography and labels (part 2)

plat-sht-dtl-13.mp4 4:47

Filter out unnecessary layers
 1. LA

 2. Layers Properties Manager palette
 A. Filters 

 I. Scroll to Xref > expand Xref > select Topo-Ex
 B. In the list, select all of the layers by selecting the first layer and SHIFT + selecting last 

layer.
 C. Click on lightbulb so all layers are deselected.
 D. Select lightbulbs for: Topo-Ex|E_UTL_EPowerPole, Topo-Ex|E_UTL_AG, Topo-Ex|E_

SGN, Topo-Ex|E_RDWY_Name, and Topo-Ex|E_BLD
 E. X to close

Replicate buildings

 3. Change layer
 A. Home tab > Layers panel > Layers Manager dropdown > select E_BLD

 4. NCOPY

 5. Select nested objects to copy: Select all buildings
 6. ENTER  to finish selection
 7. Specify base point: Select one of the buildings, drag slightly away but return back to 

same position.

Replicate signs

Continuing on the BLD Layer and will change that later.  There is a sign, NW of intersection, with 3 
parts.  We will copy all 3 parts using NCOPY.

 8. NCOPY

 9. Select nested objects to copy: Select the word SIGN and two lines
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 10. ENTER to finish selection
 11. SHIFT + right-click to select Endpoint OSNAP
 12. Select an endpoint, drag objects
 13. Drag objects back to original location
 14. Select object again
 15. Change layer

 A. Home tab > Layers panel > Layers Manager dropdown > select E_BLD

Replicate road names

Continuing on the BLD Layer and will change that later.  There are road names STH 64 and CTH T that 
need to be added to our drawing.

 16. NCOPY

 17. Select nested objects to copy: Select STH 64 on west side of intersection
 18. ENTER to finish selection
 19. SHIFT + right-click to select Endpoint OSNAP
 20. Select an endpoint, drag objects
 21. SHIFT + right-click to select Endpoint OSNAP
 22. Drag objects back to original location
 23. Select object again
 24. Change layer

 A. Home tab > Layers panel > Layers Manager dropdown > select P_RW_Text
 25. Repeat for other road names; STH64 and CTH T.
 26. CTH T needs to be labeled north of the intersection.

 A. CO

 B. Select object and select a base point
 C. Drag to location

Delete Xref
 27. XREF

 28. Xref Manager palette
 A. Select Topo-Ex - right-click menu - Detach

Add addition utilities, clean-up, and review

plat-sht-dtl-14.mp4 7:30

Xref utilities drawing

 1. Use Load Xref on Layer command
 A. WisDOT Sheets tab > Manage panal > Load Xref on Layer

 2. Select a File to Xref dialog box
 A. Look in: Local drive: WisDOT\Design\c3d\21345678\BaseData\Other
 B. select CTHT-UTILS.dwg
 C. Open
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 3. This drawing needs to be attached to both RP plan sheet and takings parcel design file.
 A. XREF

 B. Xref Manager palette 
 I. Select CTHT-UTILS

 II. Details > Type > change to Attach
 III. X to close

Add gas, phone, and sign labels

 4. On RP plan sheet, find tables containing utilities and sign numbers
 A. Gas lines: 10
 B. Phone lines: 20
 C. Sign: 2-1

 5. Return to takings parcel design sheet

Gas Label

 6. Annotate tab > Labels & Tables panel > Add Labels dropdown > Notes
 7. Add Labels dialog box

 A. Note label style: select Utility Parcel Label
 B. Marker style: none
 C. Add

 8. Pick label location: Select location to place label, double bubble with XX inside
 9. Label and leader edits

 A. Move label 
 I. Select label and, using square grip, drag to new location.

 B. Remove leader tail 
 I. Select label > right-click menu > Label Properties...

 II. Properties palette > Annotation > Leader Tail Visibility dropdown > select 
Always Hide

 C. Remove leader line within bubble 
 I. Select leader and, using diamond grip, drag to outer edge of bubble.

 D. Drag arrow, using square grip to point to gas line
 E. Change text in bubble 

 I. Select label > right-click menu > Edit Label Text...
 II. Text Component Editor dialog box 

 a. In preview window, highlight XX and type 10
 b. OK

Phone line label

 10. Annotate tab > Labels & Tables panel > Add Labels dropdown > Notes
 11. Add Labels dialog box

 A. Note label style: select Utility Parcel Label
 B. Marker style: none
 C. Add
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 12. Pick label location: Select location to place label, double bubble with XX inside
 13. Label and leader edits

 A. Move label 
 I. Select label and, using square grip, drag to new location.

 B. Remove leader tail 
 I. Select label > right-click menu > Label Properties...

 II. Properties palette > Annotation > Leader Tail Visibility dropdown > select 
Always Hide

 C. Remove leader line within bubble 
 I. Select leader and, using diamond grip, drag to outer edge of bubble.

 D. Drag arrow, using square grip to point to phone line
 E. Change text in bubble 

 I. Select label > right-click menu > Edit Label Text...
 II. Text Component Editor dialog box 

 a. In preview window, highlight XX and type 20
 b. OK

Sign label

 14. WisDOT Sheets tab > WisDOT Annotation panel > Multileader Style dropdown > select 
070-HEX TAG

 15. WisDOT Sheets tab > WisDOT Annotation panel > Multileader button
 16. Specify leader arrowhead location: Select place on drawing
 17. Specify leader landing location: Select next point
 18. Edit Attributes dialog box

 A. Edit tag number: 2-1
 B. OK

Corrections

Look over and make adjustments for any overlays.

Northing-Easting label is outside of viewport

 19. XR

 20. Right-click 81100024-ERW-SecLines > Open
 21. Select northing-easting label and move to the right, using square grip.
 22. On 81100024-ERW-SecLines tab, select X to close, Yes save changes
 23. Return to 81100024-Tkng_PRW
 24. XR

 25. Right-click 81100024-ERW-SecLines > Reload
 26. Correction should appear
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Make project location label in location map viewport readable

 27. Double-click label
 28. MTEXT Editor

 A. Ribbon > Style panel > Mask 
 B. Background Mask dialog box 

 I. Use background mask: checked
 II. Use drawing background color: checked

 III. Border offset factor: 1.5
 IV. OK

 29. Select outside the box to close MTEXT Editor.

Adjust the model viewport

 30. Left-click westside viewport border
 31. Select mid-grip and drag east to 16th line.

Edit TPP Info block

 32. Double-click block
 33. Enhanced Attributes Editor dialog box
 34. Update highway name and county information

Preview before printing plot

 35. Quick Access toolbar > Printer icon
 36. Plot dialog box

 A. Preview button in lower left corner

Import survey data

plat-imprt-srvy-data-01.mp4 6:06

Exercise data: plat-imprt-srvy-data-begin-c3d20.zip

Creating base data file from points

Open and save new file

 1. Civil 3D Start screen > Start Drawing: Templates dropdown
 A. Scroll and select plat-start.dwt

 2. Application menu > Save As
 A. Save Drawing As dialog box 

 I. Save in: Local drive:\WisDOT\Design\c3d\12345678\BaseData\Survey
 II. File name: Section Information.dwg
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Insert survey points

Tip: Civil 3D can import file types; such as, .csv, .txt, .rtf, among others.

 3. Ribbon > Insert tab > Import panel > select Points from File
 A. Import Points dialog box

 I. Selected Files: select Add files icon
 a. Select Source File dialog box

 i. Change File of type: All Files
 ii. Look in: ...12345678\BaseData\Survey
 iii. Select file StCr Co Section Corners.csv (Excel file)
 iv. Open

 II. Specify point file format:
 a. Select Toggle filtering icon
 b. Scroll and select PNEZD (comma defined)

 III. Preview: Will display a sample based on format selections above.
 IV. Check box Add Points to Point Group.
 V. Next to Point Group dropdown, select Create Group icon

 a. Point File Formats - Create Group dialog box 
 i. Type StCr Co Section Corners
 ii. OK

 b. Dropdown displays new Point Group name
 VI. No Advanced options

 VII. OK

 B. Prompt: Duplicate Point Number dialog box
 I. Duplicate point number resolution 

 a. Resolution dropdown > select Overwrite
 II. OK

 C. If points don't display, perform Zoom Extents (double-click mouse wheel or Z+Enter 
E+Enter)

 D. Save file before continuing (Qsave, quick access bar and save)
 E. Use the Line Creation command to create section lines from the section corner points. 

(done off camera)
 F. Once finished, save file

 I. Application menu > Save As
 a. Save Drawing As dialog box 

 i. Save in: Local drive:\WisDOT\Design\c3d\12345678\RW\DWG
 ii. File name: 81100024-ERW-SecLines

Exercise data: plat-sht-complete-data-end-c3d20.zip

R/W DWG extraction for GIS
Last updated: 2022-11-17
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 1. Create C3D drawing file that contains the below items (if applicable) on the appropriate layer.

R/W data type Layer
Existing Right-of-Way

New Right-of-Way (FEE, Highway Easement (HE)) 

E_RW_Existing

P_RW_Proposed 

New Permanent Easements (PLE, RDE) P_RW_EasementPerm

Existing Permanent Easements except HE E_RW_Easement

Access Restricted by Acquisition
P_RW_AccessAcquisition_
Whiskers

No Access (New Highway)
P_RW_AccessNewRdwy_Tri-
angles

No Access (By Statutory Authority) P_RW_AccessStatute_Balls

Access Restricted (By Previous Project or Control)

Parcel Acquisition Polygons. See "Create takings par-
cels" on page 1638

P_RW_AccessPreviousProject_
Diamonds

P_RW_Parcel

 2. After all the applicable information has been added to the file, Civil 3D app button > Export 
> Export Civil 3D Drawing. The following dialog box will appear:
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The settings should be set as shown in the above dialog box.

 3. Export
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 4. Open the exported ACAD file in Civil 3D
 A. Toolspace > Settings tab > Right-click active file name > Edit Drawing Settings... 

Zone Categories: USA, Wisconsin

Available coordinate systems: Choose correct county system for the plat. WisCRS 
zones contain Wisconsin County CRS in the name. Zones with Feet as units end with 
an F.

 B. OK

 5. Save the file.
 6. Rename the exported ACAD file:

 o Initial Submittal (TPP or Traditional Plat): (Date)_ACAD-XXXXXXXX-RW-GIS.dwg
 o TPP Amendment Submittal: (Date)_ACAD-XXXXXXXX-4.XX_Amendment- RW-

GIS.dwg
 o Revised Traditional Plat Submittal: (Date)_ACAD-XXXXXXXX_Revised- RW-GIS.dwg

(Date format example: 20220804)

(For Permanent Interest Exhibits use the same naming convention used for Traditional Plats)

 7. Submit the Exported ACAD file to the Region.

 8. The Region will submit the ACAD file to Central Office when the TPP is submitted for record-
ing. For Traditional Plats and permanent acquisition exhibits the ACAD file will be submitted 
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to Central Office when the Relocation Order or a revised Relocation Order for the plat or 
Exhibit is sent to the county.
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Cross sections
Upgrading "Cross section drawings #cross" on page 2198 to Civil 3D 2018.

Cross section basics
Last updated: 2023-01-30

Total video time: 04:03

Cross section basics

xsec-basc-01.mp4 04:03

Cross sections are used to display elevation and offset location of surfaces and objects along a hori-
zontal path. Cross sections are created using Alignments, Sample Lines, Sample Line Groups, Sec-
tions, Section Views, Section View Groups, and Section Sheets.

Info: 
In the Civil 3D Prospector tab, Sample Lines, Sections, and Section Views Groups are children 
of the parent alignment.

Alignments

Alignments are horizontal geometry objects representing centerlines or other baselines. 

Sample Lines

Sample Lines are linear objects used to represent cut sections along an alignment.

Sample Line Groups

Sample Line Groups are collections of Sample Lines  from the same alignment.

Sections

Sections are graphical representations of the surfaces or objects being sampled.

Info: Sections can be made dynamic to automatically update the display of Section Views 
when changes to surfaces and objects are made.

Section Views

Section Views are bounded areas representing the limits of an area being sampled. Section Views 
can display grid lines, sections and annotation.

Warnings: 
WisDOT Section View Styles do not display interior grid lines. They display only elevation, sta-
tion, and offset labels. WisDOT cross sections do display a grid when Section Sheets are 
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created, but the grid settings are associated with the Sheet component, not the Section View.

Therefore, when asked to "pick" a Section View, the grid lines cannot be selected. An elev-
ation, station, or offset label inside the section view must be selected instead.

Section View Groups

Section View Groups are collections of Section Views from the same alignment.

Section Sheets

Section Sheets are created from Section View Groups and are used to display cross sections for 
plans production.

Requirement: The active annotation scale must be set equal to the desired horizontal scale of 
the cross sections before creating section sheets.

Sample lines
Last updated: 2023-01-30

Total video time: 18:00

Sample lines are line segments placed at intervals along an existing alignment. Sample lines rep-
resent the location and orientation of surface cross sections.  Sample lines are used to sample source 
data from TIN surfaces, corridors, corridor surfaces, pipe networks, or pressure networks.   Sampled 
source data can be used to create sections for section views.

Create sample line group and sample lines

Exercise files: xsec-smpl-lin-data-c3d16.zip

Start with xsec-smpl-lin-begin.dwg

xsec-smpl-lin-01.mp4 03:54

xsec-smpl-lin-02.mp4 02:15

xsec-smpl-lin-03.mp4 05:08

Info: Workflow below may differ slightly from video content.

A sample line group must be created before creating sample lines. Multiple sample lines associated 
with an individual alignment can be created at once.

Create multiple sample lines by range of stations

 1. Ribbon > Home tab > Profile & Section Views panel > Sample Lines

 2. CREATESAMPLELINES Select an alignment <or press enter key to select 
from list>:

Page: 1686

Published on: 5/17/2023

Sample lines

https://c3dkb.dot.wi.gov/data/xsec/xsec-smpl-lin-data-c3d16.zip
https://c3dkb.dot.wi.gov/video/xsec/xsec-smpl-lin-01.mp4
https://c3dkb.dot.wi.gov/video/xsec/xsec-smpl-lin-02.mp4
https://c3dkb.dot.wi.gov/video/xsec/xsec-smpl-lin-03.mp4


 A. Enter

 B. Select an alignment from the list

 C. OK

Create Sample Line Group dialog

 3. Checkmark TIN surface EXIST and change Style to EX Ground

 4. Checkmark corridor Crdr-Sth25 and change Style to XS Sheets With Links

 5. Checkmark corridor surface Crdr-Sth25 Crdr-Crdr-Sth251-Top Surf and change Style to Final 
Top

 6. Checkmark corridor surface Crdr-Sth25 Crdr-Crdr-Sth251-Subgrade and change Style to Final 
Datum

 7. Checkmark corridor surface  Crdr-Sth25 Crdr-Crdr-Sth251-Pave and change Style to Final 
Base Course

 8. OK

 9. A red station selector will appear on the crosshairs

 10. Pause for next step. Do not click mouse to specify station

 11. Use the Sample Line Tools floating toolbar to specify stations

 12. Sample Line Tools toolbar > Sample line creation methods dropdown > By range of sta-
tions...
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Create Sample Lines - By Station Range dialog

 13. Set From alignment start field to False

 14. Left click in the Start Station field.

 15. Left click the green pick box, then using the red station picker, select somewhere just inside 
the start of the corridor.

 16. Set To alignment end field to False

 17. Left click in the End Station field.

 18. Left click the green pick box, then using the red station picker, select somewhere in the cor-
ridor near the intersection.

 19. Under Left Swath Width set Snap to an alignment to False and in the Width field, enter 75

 20. Under Right Swath Width set Snap to an alignment to False and in the Width field, enter 
75

 21. Under Sampling Increments set Use Sampling Increments field to True

 22. Set Increment Relative To to Absolute Station

 23. In the Increments Along Tangents field, enter 50

 24. In the Increments Along Curves field, enter 25

 25. In the Increments Along Spirals field, enter 50

 26. Under Additional Sample Control set all fields to False
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 27. OK

 28. Enter or Esc

 29. QSAVE

Edit sample lines, group properties, and sample more sources

Continue working in xsec-smpl-lin-begin.dwg

xsec-smpl-lin-04.mp4 01:45

xsec-smpl-lin-05.mp4 04:58
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Info: Workflow below may differ slightly from video content.

Edit a single sample line using grips

Tip: Select a sample line to activate grips

 l Left click the diamond grip in the center of the sample line to adjust station location

 l Left click an arrow grip at the end of a sample line to adjust the swath width
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 l Left click a square grip at the end of a sample line to change the angle
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Edit a single sample line using dialog box

 1. Select any sample line in a sample line group

 2. Sample Line Contextual ribbon tab > Modify panel > Edit Sample Line

 3. Select the sample line to be edited

 4. In the Edit Sample Line dialog box click Next Vertex or Previous Vertex to cycle between the 
center point and the endpoints of the sample line

 5. Edit field values

Page: 1692

Published on: 5/17/2023

Edit sample lines, group properties, and sample more sources



 6. Select a different sample line to edit or press Esc to exit the command

Edit sample line group properties

 1. Select any sample line in a sample line group

 2. Sample Line Contextual ribbon tab > Modify panel > Group Properties

 3. In the Sample Line Group Properties dialog box, select the Sample Lines tab

 4. Select a sample line in the list Use Ctrl or Shift to select more than one sample line at once

 5. Select any of the fields in the list and edit the value or selection

 6. Apply

 7. OK

Sample more sources

 1. Select any sample line in a sample line group

 2. Sample Line Contextual ribbon tab > Modify panel > Sample More Sources

 3. In the Sample More Sources dialog box, select a data source from the left column under 
Available sources:

 4. Add >> to add a data source

 5. Select a data source from the right column under Sampled sources:
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 6. << Remove to remove a data source

 7. OK

 8. Esc

Section views
Last updated: 2020-10-26

Total video time: 19:01

Create multiple views part 1

Exercise files: xsec-sctn-vu-data-c3d16.zip

Start with xsec-sctn-vu-begin.dwg

xsec-sctn-vu-01.mp4 04:36

To create multiple section view

Home tab of the Ribbon>Profile & Section Views panel>Section Views dropdown>Create Mul-
tiple Section Views

In the Create Multiple Section Views dialog box
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 1. Set the Alignment to STH25BestFit
 2. Set the Sample line group name to SLG-1
 3. Set the station range to Automatic
 4. Set the Section view style to Sheets 1 IN 10 FT Horiz 10 FT Vert

If you notice that your drawing scale does not match the scale defined in the cross section 
style, cancel out of the Create Multiple Section Views dialog, adjust the drawing scale accord-
ingly, then resume.

 5. Next
 6. Slelct Production
 7. Click on the ellipses
 8. Browse to the 09-XS-wdot16.dwt template
 9. Select X-Section 1 IN 10 FT Horiz 10FT Vert

 10. OK
 11. Set the Group Plot Style to By Page (Bottom to Top)
 12. Next

Create multiple views part 2

xsec-sctn-vu-02.mp4 03:59

In the Create Multiple Section Views dialog box, in the Offset Range section,

 1. In the Offset Range select Automatic
 2. Next
 3. In the Elevation Range select Automatic
 4. Next
 5. In the Selection Display Options verify sections and styles
 6. Next
 7. In the Data Bands select _No Labels
 8. Create Section Views
 9. Left click in model space to locate the lower left corner of you section views

 

Create single section view

xsec-sctn-vu-03.mp4 04:44

To create a single section view

Home Tab of the Ribbon>Profile and Section Views panel>Section Views dropdown>Create 
Section View
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 1. In the Create Section View dialog 
 o Select the alignment STH25BestFit
 o Select the sample line group SLG-1 
 o Select the Sample line SL-7 or station value 376+00.00'
 o Select the Section view style Sheets 1 IN 10 FT Horiz 10 FT Vert

 2. Next
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 3. Set the offset range to Automatic
 4. Next
 5. Set the elevation range to Automatic
 6. Next
 7. In Section Display Options

 A. Select the sections you want to be drawn
 B. Change the label sets to _No Labels 

 8. Next
 9. Set data bands to _No Labels

 10. Create Section View
 11. Left Click in model space to place the section view

Tips: If you have labels on a section that you do not want:
 1. Select the labels
 2. Select Edit Label Group from the contextual ribbon

 3. Import label set...
 4. Select _No Labels
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 5. OK
 6. OK

Section view properties part 1

xsec-sctn-vu-04.mp4 03:17

To access a section view's properties

 1. Left click on a section view
 2. Contextual ribbon>Section View Properties
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In the Section View Properties dialog you can view the properties

Information tab

Name can be modified

Object style can be modified

The drawings annotation scale needs to match the section view style

Offsets tab

Offset range can be modified
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Elevations tab

Elevation range can be modified

Section view properties part 2

xsec-sctn-vu-05.mp4 02:25

Page: 1700

Published on: 5/17/2023

Section view properties part 2

https://c3dkb.dot.wi.gov/video/xsec/xsec-sctn-vu-05.mp4


To access a section views properties

 1. Left click on a section view
 2. Contextual ribbon>Section View Properties

In the Section View Properties dialog, you can view the properties

Sections tab

Modify sections style and labels

View vital stats of the section view
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Bands tab

WisDOT Standards do not use bands on section views

Volume Tables tab

If volume calculations have been done, you can access those settings and styles
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Profile Grade Lines tab

WisDOT standards do not utilize the Profile Grade Lines

Section view group
Last updated: 2020-10-26

Total video time: 08:01
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Section view group part 1

xsec-sctn-vu-grup-01.mp4 03:24

Exercise files: xsec-sctn-vu-grup-data-c3d16.zip

Start with 90201-xs.dwg

To access a section view group's properties

 1. Left click on a section view
 2. Contextual ribbon>View Group Properties

On the Section Views tab of the Section View Group Properties dialog

Make changes to individual section views or all section views in a group

Change style settings
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Change offset and elevation settings

Section view group part 2

xsec-sctn-vu-grup-02.mp4 02:24

IWisDOT Standards use a _No Labels band style

WisDOT Standards do not use a Profile Grade Line

Sections tab

Select sections to be drawn

Set label sets for individual sections in ever section view
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Sheets tab

Information about the section sheet layout

Update group layout

xsec-sctn-vu-grup-03.mp4 02:13

To update the section view layout

Left click on a section view

Contextual ribbon>Update Group Layout
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Create section sheets
Last updated: 2020-10-26

Total video time: 04:14

Create section sheets

Exercise files: xsec-creat-sctn-shet-data-c3d16-begin.zip

Start with 090201-xs.dwg

xsec-creat-sctn-sht-01.mp4 04:14

Open file 090201-xs.dwg

To create section sheets

Output Tab of the ribbon>Create Section Sheets 
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In the Create Section Sheets dialog

 1. Select alignment STH25BestFit
 2. Select sample line group SLG-1
 3. Select section view group Section View Group - 1

 

In the Layout settings left click on the naming template icon 
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In the Name Template dialog

 1. Highlight the name
 2. Insert next counter
 3. Change number style to 01, 02, 03...
 4. Set starting number to 1 and increment value to 1
 5. OK

In the Sheet set area

 1. Select Add to existing sheet set
 2. left click the ellipses
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 3. Navigate to Sheet Plan folder
 4. Select 12345678.dst

 5. Open
Create Sheets

OK

Cross section sheet exercise
Last updated: 2020-10-26

Total video time: 13:50
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Create section file

Exercise files: xsec-exrcs-data-c3d16.zip

Start with wisdot16.dwt

xsec-exrcs-01.mp4 03:30

Menu browser>New

Navigate to wisdot16.dwt

 

Open

Menu Browser>Save as

Navigate to the SheetsPlan folder

Name drawing 090201-xs
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Save

In the Prosepector tab of Toolspace right click on Data Shortcuts and Set Working Folder 

Browse to wisdot videos
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Create section file



 

OK 

right click on Data Shortcuts and Set Data Shortcuts Projects Folder... 

Select 12345678

OK
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Under Data Shortcuts, expand Surfaces

Right click on Rfnt-Sth25 - Top Create Reference 

OK

Right click on Rfnt-Sth25 - Pave Create Reference 

OK

Right click on Rfnt-Sth25 - Datum Create Reference 

OK

Minimize Surfaces

Expand Alignments

Expand Centerline Alignments

Right click on STH25BestFit and Create Reference

In the Create Alignment Reference dialog Set label set to _No Labels 
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OK

Zoom Extents

 

Finish creating section file

xsec-exrcs-02.mp4 01:48

Insert Tab of the ribbon>References panel>Attach

 

Navigate to Crdr-Sth25.dwg

Open

In the Attach External Reference dialog set the Path type to Relative

Leave Scale, Rotation and Insertion point Unchecked

Set the reference type to Overlay 
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OK

Change Drawing scale to 1 IN:10 FT

Create sample lines

xsec-exrcs-03.mp4 03:30

Home tab of the Ribbon>Profile & Section Views panel>Sample Lines 

Page: 1716

Published on: 5/17/2023

Create sample lines

https://c3dkb.dot.wi.gov/video/xsec/xsec-exrcs-03.mp4


Enter

Uncheck corridor surface Crdr-Sth25 Crdr-Crdr-Sth251-Top Surf

Uncheck corridor surface Crdr-Sth25 Crdr-Crdr-Sth252-Subgrade

Uncheck corridor surface Crdr-Sth25 Crdr-Crdr-Sth253-Pave

Change Rfnt-Sth25-Top style to Final Top

Change Rfnt-Sth25-Pave style to Final Base Course

Change Rfnt-Sth25-Datum style to Final Datum

Change EXIST style to EX Ground

Change Crdr-Sth25 code set style to XS Sheets

OK
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Sample Line Tools toolbar>Sample line creation method dropdown>By range of stations... 

From alignment start field - False

Start Station - 37250

To alignment end - False

End Station - 38150

Left Swath Width - 75

Right Swath Width - 75
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OK

Right Click

Left click green check mark to clear warnings

Create multiple section views
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xsec-exrcs-04.mp4 02:47

Home tab of ribbon>Profiles & Section Views panel>Section Views dropdown>Create Multiple 
Views 

Change Section view style to Sheets 1 IN 10 FT Horiz 10 FT Vert

 Next

Select Production for Placement options

Verify that 09-XS-wdot 16.dwt and X-Section 1 IN 10 FT Horiz 10 FT Vert layout are selected (image 
06.04.03)

Next
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Leave offset range set to Automatic

Next

Leave Elevation range set to Automatic

Next

Verify _No Labels for all sections

Create Section Views

Left Click to place section views

Left click green check mark to clear warnings

Save your Drawing

Create section sheets output

xsec-exrcs-05.mp4 02:15

Output tab of ribbon>Plan Production panel>Create Section Sheets 
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Select alignment: STH25 BestFit

Sample line group name: SLG-1

Select section view group: Section View Group - 1

Under Layout Settings Left Click the naming template symbol

In the Name: field Insert Next Counter

Set the Number style to 01, 02, 03...

Set the Starting number and Increment value to 1
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OK

Add to existing sheet set 12345678.dst

Open

Create Sheets

OK

Cross section corridor labels
Last updated: 2020-10-26

Total video time: 48:45

Code set style basics 1

Exercise files: xsec-lbl-01-data-c3d16.zip

Start with 090201-xs.dwg and Crdr-Sth25.dwg

xsec-lbl-01.mp4 06:17

Code Set styles are a set of tools that control visualization and labeling for point, link, and shape 
codes in corridor cross section views.

Open example files Crdr-Sth25 and 90201-xs

In Crdr-Sth25, 
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Left click on corridor>Contextual ribbon>Modify Corridor Sections panel>Section Editor

Section editor ribbon>View Tools panel>Viewport Configuration 

OK

Yes

Left Click in plan view viewport

Toolspace>Prospector tab>Assemblies>Rural Full Section>Right Click>Zoom to
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In drawing file 90201-xs Left click on a section view

Contextual ribbon>Modify View Panel>View Group Properties

In the Section tab under the style column, left click XS Sheets With Links
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Select XS Sheets

OK

OK

In the Crdr-Sth25 drawing, In the top viewport, left click on the assembly marker

Contextual ribbon>Modify Assembly panel>Assembly Properties>Assembly Prperties dia-
log>Codes tab

Change Code set style to XS Sheets With Links
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OK

Esc

Left Click on corridor>Contextual ribbon>Modify Corridor panel>Corridor Prop-
erties>Corridor properties dialog>Codes tab

Change the code set style to XS Sheets 
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OK

Rebuild Corridor

Left Click on corridor>Contextual ribbon>Modify Corridor panel>Corridor Prop-
erties>Corridor properties dialog>Codes tab

Change the code set style to Basic

OK

Rebuild Corridor

Close Section Editor

Code set style basics 2

xsec-lbl-02.mp4 04:28

Toolspace>Settings tab>General>Code Set Styles>Right Click on XS Sheets> Copy

Page: 1728

Published on: 5/17/2023

Code set style basics 2

https://c3dkb.dot.wi.gov/video/xsec/xsec-lbl-02.mp4


On the Information tab, rename to XS Sheets-MainlineStage2

Apply

Left Click on the Codes tab

Change the Datum link code label style to Slope Percent
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OK

OK

Left Click on a Section view

Contextual Ribbon>Modify View>View Group Properties>Section View Group Propeties dia-
log>Sections tab

Change the Crdr-Sth25 style to XS Sheets-MainlineStage2
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OK

OK

Esc

Switch over to Crdr-Sth25 drawing

Toolspace>Prospector tab>Assemblies>Rural Full Section>Right Click>Zoom to
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Left Click on the left hand shoulder Subassembly

Contextual ribbon>Modify Subassembly>Subassembly Properties

On the Parameters tab of the Subassembly Properties dialog

Scroll down in the Input values winday to [L108] Datum and add ,Custom to the default input value

Cancel
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Adding code set style labels during multiple view creation

Exercise files: xsec-lbl-02-data-c3d16.zip

Start with 090201-xs.dwg

xsec-lbl-03.mp4 02:05

Home tab of ribbon>Profile & Section Views panel>Section Views dropdown>Create Multiple 
Views

In the Create Multiple Views dialog, Section Display Options section

Change the Crdr-Sth25 code set style to XS Sheets
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OK

Create Section Views

Left click to place

Adding/changing the code set style for an existing section view

xsec-lbl-04.mp4 01:47

Left click on a section view

Contextual Ribbon>Modify View panel>View Group Properties

On the Sections tab of the Section View Group Properties dialog

Page: 1734

Published on: 5/17/2023

Adding/changing the code set style for an existing section view

https://c3dkb.dot.wi.gov/video/xsec/xsec-lbl-04.mp4


Change the Crdr-Sth25 code set style to XS Sheets

OK

OK

Repeat and choose a different code set to view display options

Editing the code set style labels

xsec-lbl-05.mp4 02:18

Left Click on a point code label

Contextual ribbon>Labels panel>Edit Code Labels
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On the Codes tab, scroll down to ETW

Left Click in the Labels column
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Select ElevOff-RoRxt-NoLead045
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OK

OK

Esc

Modifying code set styles: Grip edits

xsec-lbl-06.mp4 02:48

Left Click on a label

Notice all the labels are selected
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Esc

Hold Ctrl and left click on a label

Only the label is selected and a grip point appears

Left Click on the grip and move the label to the desired location
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Esc

It is helpful to toggle off OSNAP for the placement of labels

To reset the label,

Left click on a label

Right click and select Reset Label

Page: 1740

Published on: 5/17/2023

Modifying code set styles: Grip edits



Modifying code set styles: Label properties

xsec-lbl-07.mp4 03:33

Left click on a label

Right click and select Label Properties
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In the Label Properties dialog, Left click in the Style column

Select ElevOff-RoTxt-ExtLead090
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OK

OK

Left click another label

Right Click and select Label Properties...

Change Flip Label to True
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OK

Left Click on a the same label

Right Click and select Label Properties...

Change the Label Visibility to False
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OK

Left Click on a label

Right Click and select Edit Corridor Section Properties...
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On the Codes tab Reset Labels

OK

Adding view labels manually

xsec-lbl-08.mp4 01:44

Left click on the section view

Contextual ribbon>Labels panel>Add View Labels dropdown>Offset Elevation
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Shift+Right Click Endpoint

Select Daylight endpoint

Contextual ribbon>Labels panel>Add View Labels dropdown>Grade

Page: 1747

Published on: 5/17/2023

Adding view labels manually



Use Endpoint object snap to select 2 points

Projecting/changing project objects to section views

Exercise files: xsec-lbl-03-data-c3d16.zip

Start with 090201-xs.dwg

xsec-lbl-09.mp4 05:12

Toolspace>Prospector tab>Data Shortcuts>Surfaces

Right Click on EXIST and Create Reference...

Page: 1748

Published on: 5/17/2023

Projecting/changing project objects to section views

https://c3dkb.dot.wi.gov/data/xsec/xsec-lbl-03-data-c3d16.zip
https://c3dkb.dot.wi.gov/video/xsec/xsec-lbl-09.mp4


OK

Home tab of ribbon>Profile & Section Views panel>Section Views dropdown>Project Objects 
to Multiple Section Views
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Left click one sample line

The Project Objects To Multiple Section Views dialog appears

Uncheck all objects except Feature Lines
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Edit Output Display > ...

Elevation Options: EXIST

Crossing Label Style: <None>

OK

Insert survey database objects to project to multiple views
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Exercise files: xsec-lbl-04-data-c3d16.zip

Start with 090201-xs.dwg

xsec-lbl-10.mp4 06:52

Toolspace>Survey tab>SD12345678>Survey Queries

Left click, hold and drag UtilityFigures into the drawing space

Toolspace>Prospector tab>Data Shortcuts>Surfaces

Right Click on EXIST and Create Reference...
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OK

Home tab of ribbon>Profile & Section Views panel>Section Views dropdown>Project Objects 
to Multiple Section Views

Left click one sample line

The Project Objects To Multiple Section Views dialog appears

Uncheck all objects except Survey Figures

Edit Output Display > ...

Elevation Options: EXIST

Crossing Label Style: <None>
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Left click the watermain WVM survey figure

Contextual ribbon > Modify panel > Figure Properties dropdown > Edit Figure Style

On the Sections tab change the Marker Style to XS Water

Edit projected objects in views

xsec-lbl-11.mp4 03:30

Home Tab of ribbon>Profiles & Section Views panel>Section Views dropdown>Project Objects 
to Multiple Section Views
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Left click one sample line

The Project Objects To Multiple Section Views dialog appears

Uncheck all objects except Feature Lines

In the Elevation Option column, select EXIST

In the Label Style column, change the label style to <None>
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OK

Override with new settings

Add custom point code labels to code set

Exercise files: xsec-lbl-05-data-c3d16.zip

Start with 090201-xs.dwg

xsec-lbl-12.mp4 04:52

WisDOT Design tab of the ribbon>Assemblies & Subassemblies panel>Subassembly Help
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Expand WisDOT-Lanes and Shoulders

Left Click on ShldGeneric

Left Click Coding Diagram
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Scroll down to view the codes. In this case, we are after the P2 or ESP code

Close the HTML Help dialog

Left Click the ShldGeneric-L subassembly

Contextual ribbon>Modify Subassembly panel>Subassembly properties

On the Parameters tab in the Input values window, scroll down to [P2] Top
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In the Default Input Value column, key in EPS, ElevOff-Ext045

Warning: It is important to type the exact code label name

OK

Tooplspace>Prospector tab>Corridors>Crdr-Sth25

Right Click and select Rebuild
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Clear any warnings in the Panorama

Save your drawing

Open 09020a-xs.dwg

Select the Manage Xrefs icon in the lower right
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Right Click on Crdr-Sth25 and select Reload

Close the EXTERNAL REFERENCES panel

Add/edit section labels (non-code set labels)

Exercise files: xsec-lbl-06-data-c3d16.zip

Start with 090201-xs.dwg

xsec-lbl-13.mp4 03:19

Left Click the section view

Contextual Ribbon>Labels panel>Edit Section Labels
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Left Click the Top surface section

Import Label Set

Select WisDOT Standard

OK

OK

ESC

Left Click on the label text

Contextual ribbon>Modify panel>Edit Label Group
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Change the Weeding of Segments to 10

Apply

Left Click on Segment and Left Click the red X 

Apply

Left Click on Grade Breaks

Change the Weeding to 30
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Apply

Change the Grade Breaks weeding to 10

Left Click on label text

Contextual ribbon>Modify panel>Edit Label Group

Change the Grade Breaks Start offset to -25, change the End offset to 25 and change the Weeding 
to 5

OK

Add section view to existing group
Last updated: 2023-01-30

Total video time: 4:08

xsec-add-sctn-vu-01.mp4 4:08

Create an individual sample line
 1. Ribbon > Home tab > Profile & Section Views panel > Sample Lines

 2. Sample Line Tools toolbar > Current sample lines group dropdown

 A. Select a Sample Line Group from the list. Make sure to select the correct group before 
continuing to the next step.

 3. Sample Line Tools toolbar > Sample line creation methods dropdown > At a Station

 A. CREATESAMPLELINES Select an alignment <or press enter key to 
select from list>:
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 I. Enter

 II. Select an alignment from the list

 III. OK

 B. CREATESAMPLELINES Specify station along baseline:

 I. Using the red station selector, select a location for the sample line

 C. CREATESAMPLELINES enter the left swath width: 75

 I. Enter width value

 II.  Enter

 D. CREATESAMPLELINES enter the right swath width: 75

 I. Enter width value

 II. Enter

 4. Esc to exit command

Create individual section view
 1. Ribbon > Home tab > Profile & Section Views panel > Section Views dropdown > Create 

Section View

 A. General page       

 I. Select alignment: 25

 II. Sample line group name: SLG-2

 III. Sample line: SL-15Will be the highest numbered sample line, but dropdown list 
will be in station order

 IV. Section view style: Sheets 1 IN 10 FT Horiz 10 FT Vert

 V. Leave the rest defaults

 VI. Next >

 B. Offset Range page       

 I. Automatic: selected

 II.  Next >

 C. Elevation Range page       

 I. Automatic: selected

 II. Next >

 D. Section Display Options page       

 I. Draw checked for all surfaces

 II. Label set: _No Labels for all surfaces
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 III. Leave the rest defaults

 IV. Create Section View

 2. CREATESECTIONVIEW Identify section view origin:

 A. Choose a location in model space. Crosshair is located at the lower left corner of the 
section view.

 B. Left-click  to create the individual section view

Add individual section view to an existing sample line group
 1. TOOLSPACE > Prospector tab > [current drawing name] > Alignments > Centerline 

Alignments > 25 > Sample Line Groups > Individual section views Right click > Move to 
Section View Group...

 2. Select a Section View Group from the dropdown list

 3. OK

 4. This will add the individual section view to the section view group in the correct station order.

 5. Your section view group may or may not update on its own. If it doesn't, Right click the sec-
tion view group in the Prospector tab and select Update Section View Layout

Alternate way to create individual sample lines and section views
 1. Select an existing sample line

 2. Select the diamond grip located on the baseline 

 3. Specify stretch point or [Base point Copy Undo eXist] 

 A. Select Copy
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 4. Choose a location along the alignment

 A. Left-click to place a copy of the source sample line

 B. A sample line is created and added to the sample line group

 C. Left-click to continue placing sample lines or press Esc to exit the command

Warning: The copied sample line labels will display correctly.  However, the 
actual station name of copied sample lines must be manually updated in the 
Section View Group Properties dialog box.

 D. Section views are created, but not placed in the correct order on the section sheets. 
They must be updated manually.

 I. Select any section view in the section view group

Warning: WisDOT Section View components do not have grid lines. The 
visible grid lines are actually associated with the Sheet component. There-
fore, when asked to select a section view, an elevation, station, or offset 
label inside the section view must be selected instead.

 II. Ribbon > Section Views contextual tab > Modify View panel > Update 
Group Layout

Info: 
Important notes about adding section views to an existing section view group:

 l Creating additional sample lines and section views may increase the number of sheet 
layouts needed. New sheet layouts are not automatically generated after creating 
additional section views. Section views will shift accordingly in model space, but the 
number of sheets layouts will remain as originally generated. Additional sheet layouts 
may have to be created.

 l Civil 3D objects and labels inside section views will float with section view placement 
changes.

 l Any AutoCAD objects (mtext, lines, mleader, etc.) added in model space of a section 
view that are inside the section view drafting buffer will float with section view place-
ment changes.

 l Any AutoCAD objects (mtext, lines, mleader, etc.) added in a sheet layout (paper 
space) WILL NOT float with section view placement changes.

Cross sections: how to control size and layout
Last updated: 2020-08-04

Total video time: 19:15

Object and style information
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xsec-cntrl-sz-lyout-01.mp4 4:14

 1. Object structure
 A. Alignment > Sample lines > Sections > Section View Groups
 B. Impacts

 I. There cannot be sections on different alignments in the same section view 
group

 II. Sample lines are based on the alignment, go left and right, and cannot be neg-
ative (i.e. you cannot have a section with offsets from -150 to -10)

 2. Section view group important details (this is where all the good stuff is at)
 A. Station range: do not need to pick entire station range of sample lines at the same 

time
 B. Section view style and cross section sheet template: where scale is set
 C. Offset range: inherited from sample lines
 D. Elevation range: this combined with scale determines how many sections are on a 

sheet
 I. Automatic: Good for a station range with large variation in section height. Has a 

tendency to use a LOT of space.
 II. User specified: Good for controlling number of sections per sheet

Info: Both of these options start the minimum elevation at a major inter-
val. i.e. if the major interval is 10 FT, the section minimum elevation will 
be 1170 FT or 1180 FT, but never 1175 FT or 1172 FT.

 III. Section view height option: Determines section height with automatic option. 
Determines minimum and maximum based on selection for both options.

 3. Paper dimensions for cross section sheet
 A. Grid area: 15.75 IN wide x 9.75 IN high
 B. Buffer between section views: 0.5 IN
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Scale 

Max. 
swath 

width (left 
+ right) FT

Section 
height (FT)

Number of 
sections per 

sheet

1 IN 5 FT Horiz 5 FT Vert 75 10 4

  75 20 2

1 IN 10 FT Horiz 4 FT Vert 150 10 3

  150 20 2

1 IN 10 FT Horiz 10 FT Vert 150 10 6

  150 20 4

1 IN 20 FT Horiz 10 FT Vert 300 10 6

  300 20 4

1 IN 20 FT Horiz 20 FT Vert 300 20 6

  300 40 4

1 IN 40 FT Horiz 20 FT Vert 600 20 6

  600 40 4

1 IN 40 FT Horiz 40 FT Vert 600 40 6

  600 80 4

Maximums for Scale/Section height combinations #max

Tip: These are not the only possible section heights. They are only showing a sample of pos-
sible combinations. Manual section heights are recommended to be in increments of 5 FT.

Create and adjust section view group height and layout

xsec-cntrl-sz-lyout-02.mp4 7:32

090101-xs.dwg

 l XREF corridor file
 l Six sample lines
 l ANNOSCALE: 1 IN:10 FT

Create section view group
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 1. Home tab > Profile & Section Views panel > Section views > Create multiple views
 A. General

 I. Select alignment: 25
 II. Sample line group name: SLG-2

 III. Station range: Automatic
 IV. Section view style: Sheets 1 IN 10 FT Horiz 10 FT Vert
 V. Next >

 B. Section Placement
 I. Placement Options: Production C:\wis-

dot\stnd\c3d2018\templates\sheets\09-XS-wdot18.dwt|XS 1IN 10FT Horiz 
10FT Vert

 II. Group Plot Style: By Page (Bottom to Top)
 III. Next >

 C. Offset Range
 I. Automatic: checked

 II. Next >
 D. Elevation Range

 I. Automatic: checked
 II. Create Section View

 2. Click in modelspace 
This will create 2 section sheets with 6 sections of varying height. All sections start and end at inter-
vals of 10 FT. Let's try fitting more sections on the first sheet.

Set user-defined height of sections

 1. Toolspace > Prospector > Right-click Section View Group - 1 > Properties...
 A. Section views tab > Offset and Elevation > ...

 I. Elevation Range: User Specified
 II. Height: 20'

 III. Section views height option: From mean elevation of all sections
 IV. OK

 B. OK
 2. Toolspace > Prospector > Right-click Section View Group - 1 > Update Section View Lay-

out
If for some reason you need a smaller major interval, you can edit the section view group style.

Edit major interval of section view group style

 3. Toolspace > Settings > Section View > Section View Styles > Right-click Sheets 1 IN 10 
FT Horiz 10 FT Vert > Edit... Vertical Axes tab

 A. Left > Major Tick Details > Interval: 5'
 B. Right > Major Tick Details > Interval: 5'
 C. OK

 4.  Toolspace > Prospector > Right-click Section View Group - 1 > Delete
 5. Home tab > Profile & Section Views panel > Section views > Create multiple views > 

Create Section Views > Click in modelspace
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Info: Sections now can begin and end at 5' intervals. They can also be set to heights in 
5' increments.

Adjust individual section view height and layout

xsec-cntrl-sz-lyout-03.mp4 2:51

Edit height of a section view

 1. Select section view at 400+00 > contextual ribbon > Section View Properties 
> Elevations tab

 A. Elevation range: User specified
 B. Minimum: 1175
 C. Maximum: 1195
 D. OK

 2. Select section view at 399+96.33 > contextual ribbon > Section View Properties 
> Elevations tab

 A. Elevation range: User specified
 B. Minimum: 1175
 C. Maximum: 1195
 D. OK

 3. Toolspace > Prospector > Right-click Section View Group - 2 > Update Section View Lay-
out

The last section will shift up to make space for the taller section view.

Edit Minimum and Maximum of a section view to move the sections

Sections can also be adjusted not only for their height, but the height can be kept the same and shift 
the Minimum and Maximum up or down. This has the net effect of moving the sections up or down 
on the section view.

 1. Select section view at 399+96.33 > contextual ribbon > Section View Properties 
> Elevations tab

 A. Elevation range: User specified
 B. Minimum: 1170
 C. Maximum: 1190
 D. OK

Adjust section view widths and layout

xsec-cntrl-sz-lyout-04.mp4 4:35

Edit width of a sample lines

Tip: When section view left and right swath widths are set to Automatic, changing the width of 
sample lines will change the width of section views.
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 1. Toolspace > Prospector > Alignments > 25 > Sample line groups > Select SLG-2 > Lower 
table window > Select first sample line (SL-7)

 A. Right offset: 0'
 2. Toolspace > Prospector > Alignments > 25 > Sample line groups > Select SLG-2 > Lower 

table window > Select second sample line (SL-8)
 A. Left offset: 0'

Info: Sample line widths can be zeroed out left or right, but sample lines must touch the align-
ment (e.g. a sample line can be 0 FT to 100 FT. It cannot be 10 FT to 100 FT)

Dealing with sample line widths that exceed the maximum sheet width

Sample lines on the same sheet can be of different widths as long as the maximum width is not 
exceeded (see "Maximums for Scale/Section height combinations #max" on page 1769). For 
example, if a sheet has a maximum width of 150 FT, that sheet could support some of the following 
scenarios:

 1. Any combination of left and right offsets of 75 FT or less.
 2. Left or right only sections of 150 FT or less.

If sample lines on the same sheet exceed maximum width, Civil 3D will place sections in station-
order on as few sheets as it can.

For example:

For a cross section sheet with a maximum width of 150 FT, if there are two sample lines left 150 
FT, one sample line 150 FT right, and one sample line 150 FT left, Civil 3D will generate 3 sheets 
to fit them all on the sheets fully.

The WisDOT default Section View Group Plot style By Page (Bottom to Top) aligns section views 
about the centerline. To fit sample lines that combine to exceed the maximum width on a sheet, 
there is a Section View Group Plot style By Page (Bottom to Top) Right-aligned that will align sec-
tions around the right side instead of centerline. This allows any combination of sections that don't 
exceed maximum sheet width on any single sample line to be on the same section sheet. If the 
DWG does not have the Section View Group Plot style By Page (Bottom to Top) Right-aligned, the fol-
lowing change can be made to a Section View Group Plot style

Toolspace > Settings > Section View > Group Plot Styles > Right-click By Page (Bottom to Top) 
> Edit... > Array tab > Align section views about: Right
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The section views should be right-aligned only and not left-aligned so that the station labels stay 
aligned on a sheet.

When this change is made, all sections that do not exceed the maximum width on the section sheet 
will fit. Each section will have it's own offset labels and the centerlines will not line up.

Project objects onto section views
Last updated: 2022-02-03

Total video time: 39:18

Section view sources

xsec-prjct-objct-01.mp4 1:26
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Sample line sources

The following objects can be sampled with Sample Lines. This is covered elsewhere.

 l Surfaces
 l Corridors 
 l Pipe Networks

To sample new objects with existing Sample Lines/Section Views: 

Select a Sample Line > Contextual Ribbon > Sample More Sources

Projections and crossing sources

The following objects can be projected to section views:

 l Points
 l Solids
 l Blocks
 l Multi View Blocks
 l 3D Polylines
 l Cogo Points
 l Feature Lines (Typical at WisDOT)
 l Survey Figures (Typical at WisDOT)

The basics

xsec-prjct-objct-02.mp4 6:10

Home Tab > Profile & Section Views Panel > Section Views > Project Objects to Multiple Sec-
tion Views

or 

Home Tab > Profile & Section Views Panel > Section Views > Project Objects To Section Views

 1. Select the receiving sample line group or section view group
 2. Uncheck all objects except Feature Lines and/or Survey Figures
 3. Select the Source Layers and/or Source Display (styles) to be projected

Tip: This allows the objects to be filtered by layer or style.  This is especially useful when 
using Option B and C below.

 4. Edit Output Display > Click[...]
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 5. There are three ways to show a feature lines or survey figure in cross section views.  
 A. Option A: Crossing Marker Styles. 

 I. Tip: Examples include utility survey figures, utility feature lines, right-of-
way feature lines and beam guard feature lines. These styles utilize 
marker styles which are defined in the feature line and survey figure 
style.

 II. Crossing Marker Style: Use Object
 III. Crossing Label Style: <None>
 IV. Elevation Options: Use Object (or appropriate design or existing surface)

 B. Option B: Description Crossing Label Styles

 I. Tip: Examples include any object where a custom label is desired in sec-
tion views.  It also works for labeling utility feature lines and survey fig-
ures, right of way lines, and centerline/reference lines. This requires a 
description to be added to each object and the description will then be 
displayed in the section views.

 II. Crossing Marker Style: _No Display
 III. Crossing Label Style: Desc-Object (black), Desc-Utility Type
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 IV. Elevation Options: Use Object (or appropriate design or existing surface)

 V. 

 VI. Add a description to objects to be shown in the section view
 a. Select the feature line(s) or survey figure(s) in plan view > Ctrl+1 

to open Properties palette
 b. Properties palette > Description field: Enter the desired descrip-

tion/text to be shown in the cross section
 C. Option C: Pre-Defined Crossing Label Styles

 I. Tip: WisDOT has predefined crossing label styles for utility survey figures 
and feature lines.

 II. Crossing Marker Style: _No Display
 III. Crossing Label Style: Match the appropriate style to each object in the dia-

log (There are label styles for each type of utility)
 IV. Elevation Options: Use Object (or appropriate design or existing surface)

 D. OK  > OK

 6. If there are existing projections in the section views, a message will appear, asking how to pro-
ceed.
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 A. Override with new settings: Objects that were previously projected to the section 
views will be updated to the new settings defined in the Display Options dialog box.  If 
Layers or Styles are used to filter the selection set (Step 3 above), only the objects in 
the selection set will be updated and objects that do not match the layer/style filtering 
will retain their old settings in the section views.

 B. Keep old settings for duplicated objects: Objects already projected will not be 
updated with the new settings.  Only new objects will be updated. 

Projecting utilities: add feature lines and survey figures

xsec-prjct-objct-03.mp4 2:40

Utilities can be projected to cross sections in the form of feature lines or survey figures. No matter 
the object type, WisDOT templates contain feature line and survey figure styles for all possible utility 
types. 

Feature Line Insertion

Most of the time, utilities will come in the form of survey figures.  If they are not survey figures, they 
could be polylines or feature lines. If they are polylines, they must be converted to feature lines to be 
projected to cross sections. At this point feature lines are not easily shared through data shortcuts or 
survey databases (unlike alignments and survey figures). To share into a cross section drawing, they 
are simply copied from the original drawing and pasted into the cross section drawing. 

 1. In the source utility drawing, select the utility feature lines to be shared
 A. Right Click > Clipboard > Copy

 2. In the cross section drawing
 A. Right click > Clipboard > Paste to Original Coordinates

Survey figure insertion

Survey figures need to be inserted into the drawing from a Survey Database to be able to be used in 
Cross Sections.  

 1. Toolspace > Survey tab > right-click on Survey Databases > Set Working Folder
 A. Browse to ProjectID\BaseData > Click Survey folder >OK

 2. Right-click on SD-ProjectID > Open Read Only
 3. Insert the survey figure data into file using one of these options:

 A. Expand Survey Queries > Right click on the appropriate figure query (example: 
utilities would be UtilFigures query) > Insert into Drawing

 B. Click Figures. In the Preview area at the bottom of the toolspace, Ctrl+Select the 
object type figures from the list of figures in the database > Right-click on one 
of the selected figures > Insert into Drawing.

 C. Expand Import Events > Expand the import event that holds the object type > 
Right-click Figures > Insert into Drawing Not all Import Events will be named in a 
way to be the obvious event to choose so this may not be the best option.

 4. Right-click survey database > Close Survey Database
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Projecting utilities: options to project feature lines and survey figures

xsec-prjct-objct-04.mp4 7:26

Option A: Crossing marker styles

 1. Home Tab > Profile & Section Views Panel > Section Views > Project Objects to Mul-
tiple Section Views

 2. Select the sample line group or section view group
 3. Uncheck all objects except Feature Lines and/or Survey Figures
 4. Edit Output Display > Click[...]

 A. Crossing Marker Style > <set all> >Use Object
 B. Crossing Label Style: <None>
 C. Elevation Options > <set all>  >Use Object (or appropriate design or existing sur-

face)

Option B: Description crossing label styles

 1. Add a description to objects to be shown in the section view
 A. Select one feature line or survey figure > Right Click > Select Similar
 B. Ctrl + 1 to open the properties palette
 C. Properties palette > Description Field  Enter the desired description
 D. Repeat for other types of objects (Other utility types)

 2. Home Tab > Profile & Section Views Panel > Section Views > Project Objects to Mul-
tiple Section Views

 3. Select the sample line group or section view group
 4. Uncheck all objects except Feature Lines and/or Survey Figures
 5. Filter the objects by layer or style

 A. Click **Varies**  under either Source Layers or Source Display
 B. Deselect all object layer or styles except 1 style/layer.
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 C. OK

 6. Edit Output Display > Click[...]
 A. Crossing Marker Style: _No Display
 B. Crossing Label Style: , Desc-Electric(Match the objects that are being filtered)
 C. Elevation Options: Use Object (or appropriate design or existing surface)
 D. OK

 7. Repeat for other types of utilities/objects, matching the crossing label style to the layer/object 
style filter.

 A. Since this process utilizing filtering by Layer or Style, Override with new settings can 
be chosen in the Project Objects - Override Object Settings dialog box.

Option C: Pre-Defined crossing label styles

 1. Home Tab > Profile & Section Views Panel > Section Views > Project Objects to Mul-
tiple Section Views

 2. Select the sample line group or section view group
 3. Uncheck all objects except Feature Lines and/or Survey Figures
 4. Filter the objects by layer or style

 A. Click **Varies**  under either Source Layers or Source Display
 B. Deselect all object layer or styles except 1 style/layer.
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 C. OK

 5. Edit Output Display > Click[...]

 A. Crossing Marker Style: _No Display
 B. Crossing Label Style:  ElectricOr style that matches the objects being projected.
 C. Elevation Options: Use Object (or appropriate design or existing surface)
 D. OK

 6. Repeat for other types of utilities/objects, matching the crossing label style to the layer/object 
style filter.

 A. Since this process utilizing filtering by Layer or Style, Override with new settings can 
be chosen in the Project Objects - Override Object Settings dialog box.

Modify utility colors in cross sections

xsec-prjct-objct-05.mp4 7:11

For all situations mentioned above for projecting utilities to the cross sections, the overall print color 
of the objects can be modified to fit different situations.  The display objects and labels for utilities 
utilize the layers to drive their display. WisDOT has multiple layer states available that modify the 
standard layers depending on the desired print output. 
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 1. Review the Layer States Documentation to see how to access.
 2. Select the layer state for the desired plot output

 A. Set Utilities to Plot in Color
 B. Set Existing Utilities to Plot Black
 C. Set Darker Existing Features

 3. To return back to default plotting standards:
 A. Layer State: WisDOTxx All Layers (Default)

Tip: Once the layer states are loaded into the drawing, utilize the Layer States drop down to 
switch between.

There are times when the layer states don't accomplish the desired plot output. Utilize the following 
options to modify the plot output.  

 l Layers - Convert Layer Colors
 l "Mix color and grayshade plotting (example: existing utilities in color)" on page 1606
 l "Layers and their properties" on page 433

Projecting alignments

xsec-prjct-objct-06.mp4 5:57

This workflow could be useful for the following, depending on project data:

 l Centerline or Reference Line Alignments
 l Beamguard
 l Right of Way (Existing and proposed)

Convert alignments to feature lines

Alignments need to be converted to Feature Lines prior to projecting to section views. 

 1. Create data shortcut references of alignment objects
 A. Toolspace > Prospector > Data Shortcuts > Right click desired alignment > 

Create Reference
 2. Create data shortcut references of profile objects

 A. Useful to automatically assign elevations to feature lines created from alignments.
 B. Toolspace > Prospector > Data Shortcuts > Alignments > Right click desired pro-

file > Create Reference

Home ribbon > Create Design panel > Feature Line pull-down > Feature Line from Alignment

 1. Site: None
 2. Name: Name of the alignment
 3. Profile: Select the Design Profile

 A. Weed Points: Unchecked
 4. Style: select a style appropriate to the object type (example: E RW Existing Right-of-Way Line 

for a RW line)
 A. Alignments: Unchecked
 B. Right of Way: E RW Existing Right-of-Way
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 5. Layer: Specify an appropriate layer for the object
 A. P_ALI_XX for centerline/reference line alignments

 6. Create dynamic link to alignment: checked
 7. OK

Add elevation data to feature lines

If the feature line create from the alignment does not have elevation data (typically from a profile), 
add elevation data to the feature line from a design or existing surface.

 1. Select the feature line
 2. Contextual Ribbon > Edit Elevations Panel > Elevations from Surface

 3. From the drop down, select the desired surface
 4. OK
 5. Use the pick box to select the feature line and assign elevations.
 6. Enter

Project alignment feature lines to section views

Utilize Option B  to project feature lines that have been converted from alignments.  This allows a 
user to assign a description to label the object in section views.

 1. Add a description to objects to be shown in the section view
 A. Select the feature line (converted from the alignment)
 B. Ctrl + 1 to open the properties palette
 C. Properties palette > Description Field  Enter the desired description
 D. Repeat for other objects

 2. Home Tab > Profile & Section Views Panel > Section Views > Project Objects to Mul-
tiple Section Views

 3. Select the sample line group or section view group
 4. Uncheck all objects except Feature Lines
 5. Edit Output Display > Click[...]

 A. Crossing Marker Style: _No Display
 B. Crossing Label Style: , Desc-Object (black)
 C. Elevation Options: Use Object (or appropriate design or existing surface)
 D. OK > OK

Projecting other objects

xsec-prjct-objct-07.mp4 8:25
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While utilizing feature lines, many objects may be projected and labeled in the cross section views.  
Some examples include (but not limited to):

 l Beam Guard
 l Right of Way

Using Option B along with the crossing label style Desc-Object (black) opens up limitless pos-
sibilities of what can be labeled on cross sections. The objects described below may come from 
sources of many shapes and forms.  The goal is to convert those objects to feature lines to provide 
the most flexible options of projecting to the cross sections.

Beam guard

If the corridor contains beam guard objects as part of the assembly, those should project through 
into the cross sections while using the XS Sheets codes sets. No further work is needed. The fol-
lowing covers situations where the beam guard is not part of the design corridor. 

Workflow: 

 1. Beam guard feature lines must be manually drawn or converted from other objects. 
 o The beam guard line must be drawn along the proposed face of rail.

 2. Assign the beam guard objects appropriate beam guard feature line styles. 
 l P BMGRD Guard Rail LT
 l P BMGRD Guard Rail RT

 3. Utilize Option A to project to section views
 4. Home Tab > Profile & Section Views Panel > Section Views > Project Objects to Mul-

tiple Section Views
 5. Select the sample line group or section view group
 6. Uncheck all objects except Feature Lines
 7. Edit Output Display > Click[...]

 A. Option A: Crossing Marker Styles. 
 B. Crossing Marker Style: Use Object

 III. Crossing Label Style: <None>
 IV. Elevation Options: Use Object (or appropriate design or existing surface)

Right of Way

 l Right of way feature lines must be manually drawn or converted from other objects.
 l Assign the right of way objects appropriate feature line styles

 o E RW Existing Right-Of-Way Line
 o P RW Proposed Right-Of-Way
 o There are other usable right-of-way feature line styles, both existing and proposed

 1. Home Tab > Profile & Section Views Panel > Section Views > Project Objects to Mul-
tiple Section Views

 2. Select the sample line group or section view group
 3. Uncheck all objects except Feature Lines
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 4. Edit Output Display > Click[...]
 A. Option A: Crossing Marker Styles

 I. Crossing Marker Style: Use Object
 II. Crossing Label Style: <None>

 III. Elevation Options: Use Object (or appropriate design or existing surface)
 B. Option B: Object Description

 I. Crossing Marker Style: _No Display
 II. Crossing Label Style: , Desc-Object (black)

 III. Elevation Options: Use Object (or appropriate design or existing surface)
 5. OK > OK

Cross section abbreviations

Object Abbreviation

Building BLDG

Centerline C/L

Conduit CDU

Electric ELEC

Fence FNCE

Fiber Optic FO

Gas GAS

Marsh MAR

Match Line MATCH LINE

Overhead Utilities OH

Pipeline PIPL

Permanent Limited Easement PLE

Reference Line R/L

Railroad RW

Right of Way - Existing EX RW

Right of Way RW
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Object Abbreviation

Sanitary SAN

Septic SEP

Storm Sewer - Existing EX SS

Storm Sewer SS

Telephone TEL

Temporary Limited Easement TLE

Tree TREE

TV TV

Water WAT

Cross sections with pipes
Last updated: 2021-02-18

Total video time: 15:31

Introduction/add pipe networks to cross-section file

Exercise files: xsec-pip-data-begin-c3d20.zip

Start with 090201-xs.dwg

xsec-pip-01.mp4 03:08

Add pipe to cross section file

 1. Open file 090201-xs.dwg
 2. Data reference the culverts into the file

 A. Toolspace> Prospector > Data Shortcuts > Pipe Networks
 B. Right-click on 582+50 > choose Create Reference

 I. Create Pipe Network Reference
 II. OK

 C. Right-click on 605+00 > choose Create Reference
 I. Create Pipe Network Reference

 II. OK
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Add pipes to section sources (sample more sources)

 1. Select on any sample line in the group
 2. In the context ribbon select on Sample More Sources

 A. Select corridor 51 and Add
 B. Select culvert 582+50 and Add
 C. Select culvert 605+00 and  Add
 D. Set corridor styles to XS Sheets With Shapes
 E. OK

Warning: Make sure pipe sections are not included in earthwork calculations 
(especially half views).

Add sample lines at pipes

xsec-pip-02.mp4 02:32

Add perpendicular sample lines for all skewed pipe ends

Info: There will be no skewed sample lines –they should be perpendicular to alignment.

 1. Zoom and pan to station 605+00. We will need to create sample lines for BOTH ends of this 
pipe since it is skewed on both ends.

Warning: Before we start these sample lines it is important to remember, these should 
not be the same sample line group that is used for earthwork volume calculations. That 
sample line group should be in a different file in the Design\Quantities folder

 2. Home > Profile & Section Views > Sample Lines
 A. Select the 51 alignment
 B. Use the default option of At a Station
 C. Shift + right click to Midpoint OSNAP to the south end of the culvert pipe.

 I. When prompted for the left swath width, type 0 Enter.
 II. When prompted for the right swath width, type 150 Enter.

 D. Shift + right click to Midpoint OSNAP to the north end of the culvert pipe.
 I. When prompted for the left swath width, type 150 Enter.

 II. When prompted for the right swath width, type 0 Enter.
 E. Enter to end the command. 

Create section views

xsec-pip-03.mp4 04:33
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Create section views

 1. In the lower right Drawing scale list change the drawing scale to 1 IN:20 FT.
 2. Home > Profile& Section Views > Section Views > Create Multiple Views

 A. General tab settings:
 I. Select alignment: 51

 II. Sample line group name: SLG-1
 III. Section view style: Sheets 1 IN 20 FT Horiz 1 IN 20 FT Vert

 B. Section Placement tab settings:
 I. Under Production click the ellipsis button and choose XS 1 IN 20 FT Horiz 1 

IN 20 FT Vert
 II. OK

 C. Click Next three times to open the Section Display Options tab. Check the Label 
Styles are set to No Labels and the Section Styles are set correctly. OK

 D. Create Section Views
 E. Click in Modelspace to place the views.

Reduce skewed pipe sections to half-view if desired

Info: 
Before starting change the width of the last culvert pipe end sample line (605+07) to left 150’ 
and right 150’. That way we can show changing the view to only displaying half.

If you made a skewed end sample line full width, meaning you placed it for the pipe on one 
end like the right, but not the left, you can trim the view down

 1. Select the section view for station 605+07
 A. Select on the offset text or the elevation text.

 2. From the context ribbon select the Section View Properties 
 A.  Offsets tab  > Offset range area >  User specified radio button

 I. Left: -150
 II. Right: 0

Move section views 

Info: If a pipe falls a little low in a section view, you could make the views slightly deeper to 
compensate.

 1. Select the section view elevation text or offset text.
 2. In the context ribbon select Section View Properties. We only want the one view, not the 

GROUP.
 A.  Elevations tab  > Elevation range area >  User specified radio button
 B. Add 5 or so feet to the minimum value. OK
 C. Do the same to the other views. 

 3. Select ANY section view text and choose Update Layout from the contextual ribbon.

Exercise files: xsec-pip-data-end-c3d20.zip
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Cross section labels: custom labels for corridors and station 
values
Last updated: 2020-10-26

Custom labels for corridor point codes/feature lines
This workflow is for custom text labels, not station/offet labels. See "Cross section corridor labels" on 
page 1723 for editing station/offset labels.

 1. Select section view(s)
 2. Contextual ribbon > Modify View panel > View Group Properties > Sections Tab > Style 

Column > Click the Corridor Style (XS Sheets)
 3. Code Set Style > Edit Drop Down > Edit Current Selection
 4. Codes > Expand Point > Find the Point code you wish to label

 A. Description: Enter the description you wish to display
 B. Label Style: Code Set-Point Description

 C. OK > Make a local copy of the custom code set style with a unique name > OK > 
OK

Custom alignment suffix for station values
The Section View Group styles in the WisDOT standards have the Section View Description embed-
ded into the station value. This means that the Section View Description just needs to be populated 
for it to display.

This can be done at time of creation by filling in Create Multiple Section Views > General > 
Description. This will fill in the values for all the section views in the group.

Page: 1788

Published on: 5/17/2023

Cross section labels: custom labels for corridors and station values



It can also be done after creation by selecting the section views (the individual section views, not the 
section view group)

 1. Select one section view in modelspace > Right-click > Select similar... 
 2. Ctrl+1 to open the Properties palette
 3. Properties > Description

Either method will result in the following:
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Plotting section markers in color
Last updated: 2016-03-10

Section markers projected from feature lines
When the need arises to plot any of the Section Markers in color which were projected from Feature 
LInes, follow these steps:

 1. Set the plot style on layer P FTLN to Normal.
 2. Rather than adjusting color on the P FTLN layer, the color of each marker is adjusted on the 

corresponding Marker Style - Display tab –Section View Direction. This will need to be 
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done for each style separately if any color other than the one set in the style is desired. 

Section markers projected from survey figures
When the need arises to plot any of the Section Markers in color which were projected from Survey 
Figures, follow these steps:

 1. For each Survey Figure style, determine which component layer needs to be edited, and set 
the plot style on those layers to Normal. The layer will be different for each Survey Figure 
style. 
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 2. Just like with Section Markers projected from Feature Lines, rather than adjusting color on the 
layers in the last step, the color of each marker is adjusted on the corresponding Marker 
Style - Display tab –Section View Direction. This will need to be done for each style sep-
arately if any color other than the one set in the style is desired. 
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Quantities
Earthwork quantities
Last updated: 2022-09-14

Total video time: 1:37:41

Overview

qnty-erthwrk-01.mp4 2:54

Exercise files qnty-erthwrk-begin-data-c3d22.zip

Standards on earthwork calculations can be found in FDM 11-5-10.7

For information on creating design surfaces beyond Datum and Top for WisDOT Earthwork quant-
ities, please visit: "Creating design surfaces for WisDOT earthwork quantities" on page 1834

Process Overview

 1. Create the earthwork file
 2. Create sample lines for volume calculation
 3. Compute materials through project
 4. Create detailed reports from computed materials for individual earthwork divisions through-

out the project
 5. Create a summary report that summarizes the earthwork quantities from all detail earthwork 

divisions
 6. Include all Earthwork reports in the contractor data packet

 A. FDM 19-10-43.5 PS&E Transmittal and Composition (wisconsindot.gov)
 7. Include the Detail Reports in the 09-Earthwork Data area of the plan

 A. FDM 15-1-40 Earthwork Data Sheet
 B. "Earthwork quantities sheet" on page 1581

 8. Include the summary report in the 03-Miscellaneous Quantities area of the plan.
 A. FDM 15-1-30 Miscellaneous Quantities
 B. "Miscellaneous quantities sheets" on page 1550

Average end area volume

Volume is calculated by determining the section areas at sample lines and calculating an average 
between adjacent sample lines. The average section area is then multiplied by the distance between 
the lines to calculate volume.

Volumes in intersections

Sample lines will be shortened so that they do not overlap and quantities are not double counted.
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Create quantities file

qnty-erthwrk-02.mp4 6:42

 1. Civil 3D Start Menu > New > design-start.dwt
 2. App menu > Save as ProjectID\dsgn\qty\ewrk\ewrk-< roadway>.dwg
 3. Save

Surface data shortcuts references

For information on creating design surfaces for WisDOT Earthwork quantities, please visit: Creating 
design surfaces for WisDOT earthwork quantities

Data shortcut reference all surfaces required for earthwork calculations. At a minimum, the final 
datum and existing surface are required. If there is marsh excavation, rock excavation, EBS, or sub-
grade improvement those surfaces will need to be referenced as well.

 1. Prospector > Data Shortcuts > Surfaces > Right-click Surface name > Create Refer-
ence...
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 A. Minimum required surfaces

Surface Surface Style Description

Exist EX Border Existing Surface

Rfnt-All-Datum Datum Border Final Refinement Datum Surface

 B. Optional surfaces

Surface Surface 
Style Description

Rfnt-All-MarshEx-
cLimits

Marsh 
Border

Limits of excavated marsh. Required for 
Marsh calculations.

Marsh-Bottom
Marsh 
Border

Defines the maximum marsh depth that 
will be excavated. Required for Marsh cal-
culations.

Rfnt-All-Marsh-
Waste-Limits

Marsh 
Border

Limits of marsh waste placement if excav-
ated marsh/EBS will be used in the road-
way embankment outside the 1:1 slope. 
Optional for marsh calculations.

Rock
Rock 
Border

Top of the rock surface

Rfnt-All-EBS EBS Border Final EBS limits

Rfnt-All-Subg-
Impr

SubgImpr 
Border

Subgrade Improvement Limits

 2. Zoom Extents

Reference alignment data shortcuts

 1. Data shortcut reference all alignments that contain cross sections in the plan, or contain 
earthwork.

 A. Prospector > Data Shortcuts > Alignments > Centerline Alignments > Right-click 
Alignment name > Create Reference...

 2. Data shortcut reference the mainline edgeline alignments representing the outside edge of 
lanes

 A. Prospector > Data Shortcuts > Alignments > Offset Alignments > Right-click 
Alignment name > Create Reference...
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Alignment Alignment 
Style Alignment label set

SideRoads ALI Proposed
1IN 200FT-Ticks 500' Major:100' 
Minor:NoPCPT

Mainline ALI Proposed
1IN 200FT-Ticks 500' Major:100' 
Minor:NoPCPT

Mainline-Out-
sideLaneLines

RDWY Lane 
Edge

_No Labels

External reference pavt.dwg

 1. WisDOT tab > Manage Panel > Xref Tools > Load Xref onLayer > Pro-
jectID\dsgn\edgeline\pavt.dwg > Open

 2. This file will be used to construct the limits of the intersections/match lines.

Set limits for sample lines to prevent overlap in intersection

qnty-erthwrk-03.mp4 5:50

Exercise files qnty-erthwrk-03-data-c3d22.zip

 1. Home tab > Draw panel > Line
 2. Draw lines perpendicular to roadways at farthest extents of curb returns
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 3. Make sure the polylines intersect.

a

Create matchlines

Create matchlines that will be used as targets when creating sample lines.

 1. Home tab > Create Design panel > Alignment pulldown > Alignment Creation Tools

Alignment name Alignment Style Alignment label set

Matchline-SideRdwy-LT RDWY Lane Edge _No Labels

Matchline-SideRdwy-RT RDWY Lane Edge _No Labels

 2. Alignment Layout Tools > Tangent-Tangent (No Curves)

 A. Vertex 1: Intersection of the first intersection limit lines
 B. Vertex 2: Intersection of the mainline lane edge offset alignment and sideroad center-

line
 C. Vertex 3: intersection of the opposite intersection limit lines
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 3. Save file

Create matchlines tip: Extend matchlines in acute angle intersections to min-
imize sample line overlap

In acute intersections, extend the matchlines beyond the intersection point of the drafting polylines 
to allow for automatic sample line width generation in areas outside of the Curb and Gutter.
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To utilize the matchline extension, in the Create Sample Lines - By Station Range dialog, the 
matchline can be targeted and a swath width can also be assigned. In this case, if the matchline is 
not seen by the sample line it will follow the width set in the create sample line dialog.

 1. In the Create Sample Lines - By Station Range Dialog, first set the Left and Right Swath 
Width to the desired normal width

 2. Then, set Snap to an alignment to True
 3. Select the desired matchline alignment

 A. When the matchline alignment is found, the sample line will stop at that alignment.
 B. When the matchline alignment is not found, the sample line will go to the desired 

swath width
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Create sample lines preferred option: Data shortcut reference cross sec-
tion sample lines

qnty-erthwrk-04.mp4 3:58

Exercise files qnty-erthwrk-04-data-c3d22.zip

Sample line locations outside of intersections should match the exact locations of cross sections. 
Therefore it is recommended to use the sample lines as established in the cross sections, utilizing 
data shortcut reference.

Per FDM 15-1-45, the normal cross section interval is the station (100 ft). A 50-ft interval is often used 
on urban projects. Additional cross sections should be provided at special locations like driveways, 
culverts, horizontal geometry changes, and critical superelevation changes.

Create data shortcuts for sample line groups

 1. Open the cross section file(s) ProjectID\sheets\090201-xs.dwg
 2. If the data shortcuts project is not set, set the data shortcuts project:

 A. Data shortcuts (wi.gov)
 B. Toolspace > Prospector > Right Click Data Shortcuts > Set Data Shortcut Project
 C. Set the data shortcut project to the active design Civil 3D Project
 D. If the project does not appear, you may have to set the Working Folder
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 3. Check/adjust sample line group name (optional)
 A. If desired, adjust the sample line group names to reflect their intended usage
 B. Toolspace > Prospector > Expand Centerline Alignments > Expand Alignment 

Name >  Expand Sample Line Groups
 C. Right Click the sample line group > Properties > Information Tab
 D. Set the sample line group name as desired: SLG-XS-RdwyName

 4. Create data shortcuts for sample line groups
 A. Toolspace > Prospector > Right Click Data Shortcuts > Create Data Shortcuts
 B. Select the checkmark next to each sample line group
 C. OK

Create promoted data shortcut references to sample line groups

qnty-erthwrk-05.mp4 5:42

Exercise files qnty-erthwrk-05-data-c3d22.zip

Typically, we want to create data shortcut references for most objects. In this case with sample line 
groups, we essentially want to copy the sample line groups from the cross section file into the earth-
work file as modifications to the sample frequency are required at intersections. In this workflow, 
instead of using Create Reference, we will Promote the sample line group data references.

 1. Open ProjectID\dsg\qty\ewrk\ewrk-< roadway>.dwg
 2. Toolspace > Prospector > Data Shortcuts > Expand Alignments > Expand Centerline 

Alignments
 3. Expand a centerline alignment that contains cross sections > Expand Sample Line 

Groups
 A. Right click the Sample Line Group > Promote
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 4. Create Sample Line Group Reference
 A. Deselect any unwanted Data Sources

 I. Corridors
 II. Pipe Networks

 III. Surfaces
 B. Set display styles for each surface. This is useful if desired to create cross sections to 

view the earthwork materials as calculated.

Surface Recommended Section Style

Exist EX Ground

Rfnt-All-Datum Final Datum

Rfnt-All-MarshExcLimits Marsh

Marsh-Bottom Marsh Bottom

Rfnt-All-Marsh-Waste-Limits Marsh

Rock Rock

Rfnt-All-EBS EBS

Rfnt-All-Subg-Impr SubgImpr

Info: In the Create Sample Line Group Reference dialog, the data 
sources to sample list will display both data shortcut referenced 
objects in the current drawing and objects that are sampled in the 
source (cross section) drawing.  Deselect all objects from the source 
drawing as the objects referenced for earthwork already exist in 
the current drawing and don't need to be re-referenced.
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 C. OK

 5. Repeat for all centerline alignments that contain cross sections

Remove unwanted sample lines

There may be certain sample lines from the cross section files that are not required for earthwork. 
Since the sample line groups were promoted in the last step, these un-needed sample lines can be 
deleted. Examples are as follows:

 l Sample lines within the intersection limits

 o These sample lines can be deleted as they do not fit within the matchlines created 
earlier in this topic. They also do not meet the frequency required for earthwork com-
putations in intersections

 o Delete all sample lines on both mainline and sideroads within the limits of the match-
lines developed earlier.

 l Skewed culvert pipe sample lines

 o A skewed sample line will result in inflated earthwork numbers
To delete:

 1. Select all sample lines to be deleted
 2. Del

Add intersection mainline sample lines

qnty-erthwrk-06.mp4 7:09
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Exercise files qnty-erthwrk-06-data-c3d22.zip

Add sample lines within the intersection limits with a 5' frequency. Use intersection matchlines to 
determine sample line width.

 1. Home Tab > Profile & Section Views panel > Sample Lines > Select mainline alignment
 2. Sample Line Tools dialog > Create sample line pull-down > By range of stations...

 A. Station Range 
 I. From alignment start: False

 II. Start Station: (first curb return limit)
 III. To alignment end: False
 IV. End Station:  (last curb return limit)

 B. Left Swath Width 
 I. Snap to an Alignment: True

 II. Alignment: Matchline-SideRdwy-LT
 C. Right Swath Width 

 I. Snap to an Alignment: True
 II. Alignment: Matchline-SideRdwy-RT

 D. Sampling Increments: Use 5' increments within the intersection limits 
 I. Increment Along Tangents: 5'

 II. Increment Along Curves: 5'
 III. Increment Along Spirals: 5'

 E. Additional Sample Controls 
 I. At Range Start: True

 II. At Range End: True
 III. At Horizontal Geometry Points: False
 IV. At Superelevation Critical Points: False

 F. OK
 3. Repeat Step 2 for remaining intersections

Add sideroad intersection sample lines

Add sample lines within the intersection limits with a 5' frequency. Use intersection matchlines to 
determine sample line width.

First curb return limit - mainline outside edge of lane

 1. Home Tab > Profile & Section Views panel > Sample Lines > Select mainline alignment
 2. Sample Line Tools dialog > Create sample line pull-down > By range of stations...

 A. Create Sample Lines – By Station Range dialog 
 I. Station Range 

 a. From alignment start: False
 b. Start Station:  (first curb return limit)
 c. To alignment end: False
 d. End Station: (edge of outer mainline lane)
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 II. Left Swath Width 
 a. Snap to an Alignment: True
 b. Alignment: Matchline-SideRdwy-LT

 III. Right Swath Width 
 a. Snap to an Alignment: True
 b. Alignment: Matchline-SideRdwy-LT

 IV. Sampling Increments 
 a. Increment Along Tangents: 5'
 b. Increment Along Curves: 5'
 c. Increment Along Spirals: 5'

 V. Additional Sample Controls 
 a. At Range Start: True
 b. At Range End: False
 c. At Horizontal Geometry Points: False
 d. At Superelevation Critical Points: False

 VI. OK

Mainline edge of traveled way - last curb return limit

 1. Sample Line Tools dialog > Create sample line pull-down > By range of stations...

 A. Create Sample Lines – By Station Range dialog 
 I. Station Range 

 a. From alignment start: False
 b. Start Station: (outside edge of mainline lane)
 c. To alignment end: False
 d. End Station: (last curb return limit)

 II. Left Swath Width 
 a. Snap to an Alignment: True
 b. Alignment: Matchline-SideRdwy-RT

 III. Right Swath Width 
 a. Snap to an Alignment: True
 b. Alignment: Matchline-SideRdwy-RT

 IV. Sampling Increments 
 a. Increment Along Tangents: 5'
 b. Increment Along Curves: 5'
 c. Increment Along Spirals: 5'

 V. Additional Sample Controls 
 a. At Range Start: False
 b. At Range End: True
 c. At Horizontal Geometry Points: False
 d. At Superelevation Critical Points: False

 VI. OK
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Create sample lines at edge of mainline outside lane

To make sure no earthwork is calculated on the sideroad across the mainline portion of the road-
way, sample lines are required at the intersection of the sideroad alignment and the mainline edge 
of outside lane. These sample lines should have an overall width of 0.0002' (Almost 0).

Sample Line Tools dialog > Create sample line pull-down > At a Station...

 1. Select or specify the station/location of the sample line.
 2. Specify the left swath width: 0.0001

 A. Enter
 3. Specify the right swath width: 0.0001

 A. Enter

 4. Repeat steps A to C at other locations

 5. Esc to end the command

 
a

Clean up sample lines

Adjust sample lines that are overlapping over surfaces near intersections or are not terminating at 
matchlines.
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 1. Select the sample line
 2. Using the triangle grip, grip edit the sample lines to be shorter so they don't overlap.

Proceed to the compute materials portion of this training topic

The following section covers the option of creating sample line groups from scratch. if the sample 
line groups for calculating earthwork are already created, the next step is to compute materials.

Create sample lines alternative: Create sample lines from scratch

qnty-erthwrk-07.mp4 3:29

Exercise files qnty-erthwrk-07-data-c3d22.zip

If it is not desired or possible to copy the sample line groups from the cross section file to the earth-
work file, the sample lines can be created from scratch. The sample lines in the earthwork cal-
culations should match the exact location of the cross sections that are shown in the plan. Per FDM 
15-1-45, the normal cross section interval is the station (100 ft). A 50-ft interval is often used on 
urban projects. Additional cross sections should be provided at special locations like driveways, cul-
verts, horizontal geometry changes, and critical superelevation changes.
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Create sample line group for mainline

 1. Home tab > Profile & Section Views panel > Sample lines > Select mainline roadway 
alignment

 2. Create Sample Line Group dialog

 A. Set the Sample Line Group name: SLG-ewrk-< roadway>

 B. Sample Column: select which surface to sample in the earthwork calculations

 C. Set display styles for each surface. This is useful if desired to create cross sections to 
view the earthwork materials as calculated.

Surface Recommended Section Style

Exist EX Ground

Rfnt-All-Datum Final Datum

Rfnt-All-MarshExcLimits Marsh

Marsh-Bottom Marsh Bottom

Rfnt-All-Marsh-Waste-Limits Marsh

Rock Rock

Rfnt-All-EBS EBS

Rfnt-All-Subg-Impr SubgImpr
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 D. OK

Create sample lines for mainline

qnty-erthwrk-08.mp4 6:40

Exercise files qnty-erthwrk-08-data-c3d22.zip

Create sample lines: begin project to first intersection

Create sample lines from the beginning of the project to the limits of the first intersection

 1. Sample Line Tools dialog > Create sample line pull-down > By range of stations...

 A. Create Sample Lines – By Station Range dialog 
 I. Station Range 

 a. From alignment start: False
 b. Start Station: (begin project)
 c. To alignment end: False
 d. End Station:  (first intersection limit)

 II. Sampling Increments: Match normal cross section interval in the plan 
 a. Per FDM 15-1-45, the normal cross section interval is the station (100 ft). 

A 50-ft interval is often used on urban projects.
 b. Additional sections at horizontal geometry points and superelevation 

critical points
 c. Sampling increment should match cross section increment

 III. Additional Sample Controls 
 a. At Range Start: True
 b. At Range End: False
 c. At Horizontal Geometry Points: True
 d. At Superelevation Critical Points: True
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 IV. OK

Create sample lines within the intersection limits

Create sample lines within the limits of the intersections.

 1. Sample Line Tools dialog > Create sample line pull-down > By range of stations...

 A. Create Sample Lines – By Station Range dialog 
 I. Station Range 

 a. From alignment start: False
 b. Start Station:  (first curb return limit)
 c. To alignment end: False
 d. End Station: (last curb return limit)

 II. Left Swath Width 
 a. Snap to an Alignment: True
 b. Alignment: Matchline-SideRdwy-LT

 III. Right Swath Width 
 a. Snap to an Alignment: True
 b. Alignment: Matchline-SideRdwy-RT

 IV. Sampling Increments: Use 5' increments within the intersection limits 
 a. Increment Along Tangents: 5'
 b. Increment Along Curves: 5'
 c. Increment Along Spirals: 5'

 V. Additional Sample Controls
 VI. At Range Start: True

 VII. At Range End: True
 VIII. At Horizontal Geometry Points: False

 IX. At Superelevation Critical Points: False
 X. OK

Create sample lines: between intersections

Create sample lines between individual intersections

Sample Line Tools dialog > Create sample line pull-down > By range of stations...

 1. Create Sample Lines – By Station Range dialog

 A. Station Range 
 I. From alignment start: False

 II. Start Station: (End of first intersection)
 III. To alignment end: False
 IV. End Station:  (start of next intersection)

 B. Sampling Increments: Match normal cross section interval in the plan 
 I. Per FDM 15-1-45, the normal cross section interval is the station (100 ft). A 50-ft 

interval is often used on urban projects.
 II. Additional sections at horizontal geometry points and superelevation critical 
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points
 III. Sampling increment should match cross section increment

 C. Additional Sample Controls 
 I. At Range Start: False

 II. At Range End: False
 III. At Horizontal Geometry Points: True
 IV. At Superelevation Critical Points: True

 D. OK

Create sample lines: last intersection to end project

Create sample lines from the last intersection to the end of the project.

 1. Sample Line Tools dialog > Create sample line pull-down > By range of stations...

 A. Create Sample Lines – By Station Range dialog 
 I. Station Range 

 a. From alignment start: False
 b. Start Station: (last curb return limit)
 c. To alignment end: False
 d. End Station:  (end surface)

 II. Left Swath Width 
 a. Snap to an Alignment: False

 III. Right Swath Width 
 a. Snap to an Alignment: False

 IV. Sampling Increments: Match normal cross section interval in the plan 
 a. Per FDM 15-1-45, the normal cross section interval is the station (100 ft). 

A 50-ft interval is often used on urban projects.
 b. Additional sections at horizontal geometry points and superelevation 

critical points
 c. Sampling increment should match cross section increment

 V. Additional Sample Controls 
 a. At Range Start: False
 b. At Range End: True
 c. At Horizontal Geometry Points: True
 d. At Superelevation Critical Points: True

 VI. OK
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Create sample lines for side road

qnty-erthwrk-09.mp4 7:04

Exercise files qnty-erthwrk-09-data-c3d22.zip

 1. Home tab > Profile & Section Views panel > Sample lines > Select SideRoadAlignment

 2. Create Sample Line Group dialog

 A. Name: SLG-ewrk-< roadwayname >

 B. Sample Column: Select or deselect any surfaces needed/not needed for earthwork cal-
culations

 C. Set display styles for each surface. This is useful if desired to create cross sections to 
view the earthwork materials as calculated.

Surface Recommended Section Style

Exist EX Ground

Rfnt-All-Datum Final Datum

Rfnt-All-MarshExcLimits Marsh

Marsh-Bottom Marsh Bottom

Rfnt-All-Marsh-Waste-Limits Marsh

Rock Rock

Rfnt-All-EBS EBS

Rfnt-All-Subg-Impr SubgImpr

 D. OK

Project start to intersection limits

Create sample lines on the sideroad from the beginning of the project to the start of the intersection.

 1. Sample Line Tools dialog > Create sample line pull-down > By range of stations...

 A. Create Sample Lines – By Station Range dialog 
 I. Station Range 

 a. From alignment start: False
 b. Start Station: (begin project)
 c. To alignment end: False
 d. End Station: (first intersection limit)
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 II. Sampling Increments: Match normal cross section interval in the plan 
 a. Per FDM 15-1-45, the normal cross section interval is the station (100 ft). 

A 50-ft interval is often used on urban projects.
 b. Additional sections at horizontal geometry points and superelevation 

critical points
 c. Sampling increment should match cross section increment

 III. Additional Sample Controls 
 a. At Range Start: True
 b. At Range End: False
 c. At Horizontal Geometry Points: True
 d. At Superelevation Critical Points: True

 IV. OK

Intersection limit to outside edge of mainline lane

Create sample lines from the start of the intersection limit to the outside edge of mainline roadway

 1. Sample Line Tools dialog > Create sample line pull-down > By range of stations...

 A. Create Sample Lines – By Station Range dialog 
 I. Station Range 

 a. From alignment start: False
 b. Start Station: (first intersection limit)
 c. To alignment end: False
 d. End Station: (outside edge of mainline lane)

 II. Left Swath Width 
 a. Snap to an Alignment: True
 b. Alignment: Matchline-SideRdwy-LT

 III. Right Swath Width 
 a. Snap to an Alignment: True
 b. Alignment: Matchline-SideRdwy-LT

 IV. Sampling Increments 
 a. Increment Along Tangents: 5'
 b. Increment Along Curves: 5'
 c. Increment Along Spirals: 5'

 V. Additional Sample Controls
 VI. At Range Start: True

 VII. At Range End: False
 VIII. At Horizontal Geometry Points: False

 IX. At Superelevation Critical Points: False
 X. OK

Opposite outside edge of mainline lane to last intersection limit

Create sample lines from the the opposite outside edge of mainline lane to the last intersection limit
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 1. Sample Line Tools dialog > Create sample line pull-down > By range of stations...

 A. Create Sample Lines – By Station Range dialog 
 I. Station Range 

 a. From alignment start: False
 b. Start Station: (outside edge of mainline lane)
 c. To alignment end: False
 d. End Station: (last intersection limit)

 II. Left Swath Width 
 a. Snap to an Alignment: True
 b. Alignment: Matchline-RT

 III. Right Swath Width 
 a. Snap to an Alignment: True
 b. Alignment: Matchline-RT

 IV. Sampling Increments 
 a. Increment Along Tangents: 5'
 b. Increment Along Curves: 5'
 c. Increment Along Spirals: 5'

 V. Additional Sample Controls
 VI. At Range Start: False

 VII. At Range End: True
 VIII. At Horizontal Geometry Points: False

 IX. At Superelevation Critical Points: False
 X. OK

Last intersection limit to end of project

Create sample lines from the intersection limit to the end of the project on the sideroad.

 1. Sample Line Tools dialog > Create sample line pull-down > By range of stations...

 A. Create Sample Lines – By Station Range dialog 
 I. Station Range 

 a. From alignment start: False
 b. Start Station: (last intersection limit)
 c. To alignment end: False
 d. End Station:  (end project)

 II. Left Swath Width 
 a. Snap to an Alignment: False

 III. Right Swath Width 
 a. Snap to an Alignment: False

 IV. Sampling Increments: Match normal cross section interval in the plan 
 a. Per FDM 15-1-45, the normal cross section interval is the station (100 ft). 

A 50-ft interval is often used on urban projects.
 b. Additional sections at horizontal geometry points and superelevation 

critical points
 c. Sampling increment should match cross section increment
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 V. Additional Sample Controls 
 a. At Range Start: False
 b. At Range End: True
 c. At Horizontal Geometry Points: True
 d. At Superelevation Critical Points: True

 VI. OK

Create sample lines at edge of mainline outside lane

To make sure no earthwork is calculated on the sideroad across the mainline portion of the road-
way, sample lines are required at the intersection of the sideroad alignment and the mainline edge 
of outside lane. These sample lines should have an overall width of 0.0002' (Almost 0).

Sample Line Tools dialog > Create sample line pull-down > At a Station...

 1. Select or specify the station/location of the sample line.
 2. Specify the left swath width: 0.0001

 A. Enter
 3. Specify the right swath width: 0.0001

 A. Enter
 4. Repeat steps A to C at other locations
 5. Esc to end the command

Create sample lines in custom locations

qnty-erthwrk-10.mp4 5:12

Exercise files qnty-erthwrk-10-data-c3d22.zip
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Potential resource needs

 l External References

 o Beam guard layout
 o Culvert pipe locations

Create sample lines

 1. Create sample lines at custom locations. Possible locations include:

 A. Horizontal geometry location
 B. Culvert pipe locations
 C. Beam guard locations

 2. Sample Line Tools dialog > Create sample line pull-down > At a Station...

 A. Select or specify the station/location of the sample line.
 B. Specify the left swath width > Enter
 C. Specify the right swath width > Enter
 D. Repeat steps A to C at other locations
 E. Esc to end the command

Create sample lines tip: Extend matchlines in acute angle intersections to min-
imize sample line overlap

In acute intersections, extend the matchlines beyond the intersection point of the drafting polylines 
to allow for automatic sample line width generation in areas outside of the Curb and Gutter.
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To utilize the matchline extension, in the Create Sample Lines - By Station Range dialog, the 
matchline can be targeted and a swath width can also be assigned. In this case, if the matchline is 
not seen by the sample line it will follow the width set in the create sample line dialog.

 1. In the Create Sample Lines - By Station Range Dialog, first set the Left and Right Swath 
Width to the desired normal width

 2. Then, set Snap to an alignment to True
 3. Select the desired matchline alignment

 A. When the matchline alignment is found, the sample line will stop at that alignment.
 B. When the matchline alignment is not found, the sample line will go to the swath width 

as prescribed.
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Clean up overlapping sample lines

Clean up sample lines that are overlapping over surfaces near intersections.

 1. Select the sample line
 2. Using the triangle grip, grip edit the sample lines to be shorter so they don't overlap.

Compute materials lists for roadways

qnty-erthwrk-11.mp4 6:02

Exercise files qnty-erthwrk-11-data-c3d22.zip
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Once the sample line groups are completed, the earthwork materials must be calculated within Civil 
3D.

Mainline

 1. Analyze tab > Volumes and Materials > Compute Materials

 A. Select a Sample Line Group dialog 
 I. Select alignment: Mainline Alignment

 II. Select sample line group: SLG-ewrk-##
 III. OK

 B. Compute Materials dialog 
 I. Quantity takeoff criteria: WisDOT Mass Ordinate

 II. Surfaces: Select all applicable Surfaces (Not all surfaces are required)
 a. For each Surface Criteria, click "Click here to set all"
 b. Exist: Exist
 c. Final Datum: Rfnt-All-Datum
 d. Final Marsh Excavation Limits: Rfnt-All-MarshExcLimits (Final marsh 

excavation)
 e. Final Marsh Bottom: Marsh-Bottom (Maximum marsh excavation depth)
 f. Final Marsh Waste Limits: Rfnt-All-Marsh-Waste-Limits (Limits of marsh 

placement)
 g. Rock: Rock
 h. Final EBS Limits: Rfnt-All-EBS
 i. Subgrade Improvement Limits: Rfnt-All-Subg-Impr

 III. OK
 C. If a surface is not selected for all surface criteria, a warning will display. This is accept-

able. 
 I. OK to dismiss.

Side road

 1. Analyze tab > Volumes and Materials > Compute Materials

 A. Select a Sample Line Group dialog 
 I. Select alignment: Sideroad Alignment

 II. Select sample line group: SLG-ewrk-##
 III. OK

 B. Compute Materials dialog 
 I. Quantity takeoff criteria: WisDOT Mass Ordinate

 II. Surfaces: Select all applicable Surfaces (Not all surfaces are required)
 a. For each Surface Criteria, click "Click here to set all"
 b. Exist: Exist
 c. Final Datum: Rfnt-All-Datum
 d. Final Marsh Excavation Limits: Rfnt-All-MarshExcLimits (Final marsh 

excavation)
 e. Final Marsh Bottom: Marsh-Bottom (Maximum marsh excavation depth)
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 f. Final Marsh Waste Limits: Rfnt-All-Marsh-Waste-Limits (Limits of marsh 
placement)

 g. Rock: Rock
 h. Final EBS Limits: Rfnt-All-EBS
 i. Subgrade Improvement Limits: Rfnt-All-Subg-Impr

 III. OK
 C. If a surface is not selected for all surface criteria, a warning will display. This is accept-

able. 
 I. OK to dismiss.

 2. Repeat for all side roads

Re-compute materials after design changes

If design surfaces change, the material lists have to be recalculated.

 1. Analyze tab > Volumes and Materials > Compute Materials
 2. Select a Sample Line Group dialog

 A. Select alignment: Sideroad Alignment
 B. Select sample line group: SLG-ewrk-##
 C. OK

 3. Edit Material List dialog

 A. The dialog lists all materials/criteria that being calculated for the material list.
 B. OK to re-compute the materials

 4. Repeat for all affected alignments.

Add surfaces to material lists

At times, surface assignments need to be modified for material calculations. To update material list 
surface assignments, the old material list should be deleted and Compute Materials should be re-
done.

 1. Delete the existing material list

 A. Toolspace > Prospector > Alignments > Centerline Alignments
 I. Expand the centerline alignment containing the material list

 II. Alignment name > Sample Line Groups > SLG Name > Material Lists
 B. Select the material list > Right click > Delete

 2. Re-compute materials

 A. Analyze tab > Volumes and Materials > Compute Materials
 I. Select a Sample Line Group dialog 

 a. Select alignment: Alignment Name
 b. Select sample line group: SLG-ewrk-##
 c. OK

 II. Compute Materials dialog 
 a. Assign the surfaces as required for earthwork calculations
 b. OK
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Optional: Create cross sections to analyze earthwork materials

qnty-erthwrk-12.mp4 3:32

Exercise files qnty-erthwrk-12-data-c3d22.zip

The WisDOT Mass Ordinate quantity takeoff criteria has pre-assigned shape styles for each of the 
material types. Cross section views can be created for the sample lines in the earthwork drawing to 
easily display and identify where a certain earthwork material is calculated in a particular section.

Create cross section views as instructed here: "Section views" on page 1694. While the shape styles 
should be assigned for the material types, double check they are correctly selected in Create Mul-
tiple Section Views Dialog.

The results are section views which contain shapes that identify the materials as calculated in the 
earthwork process.

Create WisDOT earthwork detail reports

qnty-erthwrk-13.mp4 6:54

Exercise files qnty-erthwrk-13-data-c3d22.zip
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Requirement: Standards on earthwork calculations can be found in FDM 11-5-10.7

More info on the WisDOT Earthwork Detail Report: QTO - Earthwork Detail Report

The first step in creating earthwork reports is to create detailed earthwork reports for each baseline 
alignment on the project. The WisDOT Earthwork Detail Report in Civil 3D will be used.

Warnings: 
CONSULT WITH THE PROJECT MANAGER AND/OR SOIL ENGINEER PRIOR TO RUNNING THIS 
REPORT TO DETERMINE HOW MARSH AND EBS MATERIALS WILL BE HANDLED. The soil engin-
eer should provide the appropriate factors to be used in earthwork calculations for the pro-
ject.

Make sure the Mass Ordinate Equation Considerations settings are the same when running 
the Detailed earthwork report and the Summary report. If they are not the same, the Mass 
Ordinate may be different between the reports.

 1. WisDOT Tab > QTO > Earthwork Detail Report
 2. Earthwork Detail Report dialog

 A. Start sample line: Click the  to select the first sample line for an alignment. The 
sample line that is picked notifies the tool the of sample line group and alignment  and 
what station to start the report.

 B. End Sample Line: Click the  to specify the last sample line to report to, or select 
the button End Sample Line to select the last sample line in the sample line group.

 C. Material List: The material list will pre-populate with the material list assigned to the 
sample line group.

 D. Factors: Consult with the WisDOT Soil Engineer for the appropriate factors for the pro-
ject. The following factors are examples 

 I. Fill: 1.25
 II. Rock: 1.1

 III. Cut: 1
 IV. Marsh Backfill: 1.5
 V. EBS Backfill: 1.3

 VI. Reduced Marsh Fill: 0.6
 VII. Reduced EBS in Fill: 0.8

 E. Mass Ordinate Options: Consult with the soils engineer to determine how the mater-
ials should be handled. If the box(es) are not selected, this means that granular backfill 
will be used for marsh and/or EBS backfill.

 F. Worksheet name: Enter the name of the worksheet to be used in Excel. Typically this is 
the name of the Roadway.

 G. Click the folder icon to open the Save File As.. dialog. 
 I. To create one workbook containing all detail sheets for the project, always 

select the same workbook. If the workbook already exists, it will be appended.
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 II. If the worksheet name already exists in the workbook, it will be overwritten.
 III. Save the file in Project ID\dsgn\qty\ewrk\ewrk-<mainroadway>.xlsx

 H. Create Report
 I. If the chosen workbook name does not exist, a new workbook will be created 

with the detail sheet for the baseline.
 II. If the workbook exists, it must be closed prior to creating the report.

 III. If the workbook exists, a worksheet will be added for the new material list/-
alignment

 I. Repeat for all alignments/sample line groups in the project.
 3. Detail reports for each selected sample line group/material list will be created.

Create WisDOT earthwork summary report

qnty-erthwrk-14.mp4 3:56

Exercise files qnty-erthwrk-14-data-c3d22.zip

Requirements: 
Standards on earthwork calculations can be found in FDM 11-5-10.7

The WisDOT Excel add-in must be installed to run the earthwork summary report. For 
external partners, the WisDOT Excel add-in is available on the WisDOT Civil 3D file descrip-
tions (wisconsindot.gov).  Internal users should see Autodesk Civil 3D 20XX -Excel Add-In in 
Software Center.

More info on the WisDOT Earthwork Summary Report: Excel  - Earthwork Summary Report

The second step in the creation of the earthwork report, after creating the earthwork detail reports, 
is to create the earthwork summary report. This topic uses the Earthwork Summary Report avail-
able in the WisDOT Excel Add-In.  If the WisDOT Excel add-in is not available to the user, the Legacy 
Earthwork report process (below) is still applicable.

 1. Open Project ID\dsgn\qty\ewrk\ewrk-<mainroadway>.xlsx
 2. WisDOT Civil 3D Tab > Reports Panel > Earthwork Summary

 A. Detail Sheet Selection 
 I. All earthwork detail worksheets in the workbook will populate.  Select/deselect 

which sheets to include.
 II. By default, all detail sheets are listed in the same division (1). To separate the 

detail sheets into multiple divisions, assign the division number to each detail 
sheet in the Division column.

 B. Factors: Enter the factors used to compute the earthwork details. The factors entered 
in this dialog are placed in the header of the summary table. They are then checked 
against the factors used for each detail sheet. 

 I. Fill: 1.25
 II. Rock: 1.1

 III. Cut: 1
 IV. Marsh Backfill: 1.5

Page: 1823

Published on: 5/17/2023

Create WisDOT earthwork summary report

https://c3dkb.dot.wi.gov/video/qnty/qnty-erthwrk-14.mp4
https://c3dkb.dot.wi.gov/data/qnty/qnty-erthwrk-14-data-c3d22.zip
https://wisconsindot.gov/Pages/doing-bus/eng-consultants/cnslt-rsrces/tools/cad/civil-3d.aspx
https://wisconsindot.gov/Pages/doing-bus/eng-consultants/cnslt-rsrces/tools/cad/civil-3d.aspx
../../../../../../Content/c3d/wisdot-cstm/xcl-add-in/xcl-erthwrk-sum-rprt.htm


 V. EBS Backfill: 1.3
 VI. Reduced Marsh Fill: 0.6

 VII. Reduced EBS in Fill: 0.8
 C. OK to create the summary worksheet.

Manual modifications to the earthwork report

qnty-erthwrk-15.mp4 8:20

qnty-erthwrk-16.mp4 7:21

Exercise files qnty-erthwrk-15-data-c3d22.zip

Changes to expansion factors

If modifications are required for the expansion factors, the earthwork process does not need to be 
re-run. Simply modify the expansion factor in the headers of all earthwork details and the earthwork 
summary sheets.

Unusable/Salvaged Pavement

The unusable/salvaged pavement column E on the earthwork detail sheets will default to 0 for each 
row.  Users are required to manually enter the cross sectional area for each station throughout the 
corridor.

 l Option A: For consistent cross section roadways, it may be as easy as calculating the cross 
sectional area for one section and copying that value to the rest of the rows.

 l Option B: For irregular pavement cross sections another more complicated workflow utilizing 
the earthwork process to calculate unusable/salvaged pavement may be required.

 A. Create a second Drawing in ProjectID\dsgn\qty\ewrk named Unusable Pave-
ment.dwg

 B. Create a polyline that wraps the existing pavement surface.  This will be used as an out-
side surface boundary

 C. Data reference the existing surface
 D. Create a new surface in Unusable Pavement.dwg
 E. Paste the existing surface into the new surface
 F. Add the boundary polyline as an outside surface boundary
 G. Lower the surface (Edits) by the pavement depth. This surface represents the bottom 

of the existing pavement
 H. Data shortcut reference all sample line groups from the original ewrk-rdwy.dwg
 I. Run the earthwork report process using the new pavement bottom surface as the 

datum surface and the existing surface.
 J. Copy the "Cut" column from the pavement bottom earthwork process to the Ewrk-

Rdwy.xlsx - Unsuable/Salvaged pavement column.
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Tip: (Option B) If the pavement depth varies, create multiple unusable pavement sur-
faces depending on the pavement depth.  Then create one final surface and paste all 
unusable pavement surfaces to create one complete unusable pavement surface.

Exercise files qnty-erthwrk-end-data-c3d22.zip

Legacy earthwork reports

qnty-erthwrk-17.mp4 2:52

Exercise files qnty-erthwrk-20-data-c3d22.zip

Prior to creating earthwork reports, material lists must be created.  Please refer to the topics earlier 
to discover how to create material lists.

Create volume reports

Once material lists have been created for the alignments/sample lines, the next step is to create XML 
files of the detailed earthwork for each roadway. These XML's will be used later on by a tool to create 
the earthwork reports.

Mainline

 1. Open ProjectID\dsgn\qty\ewrk\ewrk-< roadway>.dwg
 2. Analyze tab > Volumes and Materials > Volume Report

 A. Report Quantities dialog 
 I. Select alignment: STH25BestFit(Centerline alignment)

 II. Select sample line group: SLG-1
 III. Select Materials List: Material List – (1)
 IV. Display XML report: checked
 V. OK

 3. Dismiss the browser that contains the earthwork table.
 4. Volume report will open in default XML software. Likely a web browser. From software, save 

file to ProjectID\dsgn\qty\ewrk\25.xml

Side road

 1. Analyze tab > Volumes and Materials > Volume Report

 A. Report Quantities dialog 
 I. Select alignment: 4thAve

 II. Select sample line group: SLG-2
 III. Select Materials List: Material List – (2)
 IV. Display XML report: checked
 V. OK

 2. Dismiss the browser that contains the earthwork table.
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 3. Volume report will open in default XML software. Likely a web browser. From software, save 
file to ProjectID\dsgn\qty\ewrk\4thAve.xml

 4. Repeat for remaining sideroads.

Create WisDOT earthwork detail and summary reports

qnty-erthwrk-18.mp4 3:54

Exercise files qnty-erthwrk-18-data-c3d22.zip

The second step is to use the WisDOT Earthwork Tool to create detail and summary earthwork 
reports in Excel.

Requirements: 
Standards on earthwork calculations can be found in FDM 11-5-10.7

The Soils Engineer must be consulted prior to entering the expansion factors and mass ordin-
ate equation considerations.

 1. Desktop > WisDOT Civil 3D Apps > Earthwork tab

 A. Settings tab 
 I. Expansion Factors (These are examples. Consult with the soils engineer to 

determine appropriate factors) 
 a. Fill: 1.25
 b. Rock: 1.1
 c. Cut: 1
 d. Marsh Backfill: 1.5
 e. EBS Backfill: 1.3
 f. Reduced Marsh Fill: 0.6
 g. Reduced EBS in Fill: 0.8

 II. Mass Ordinate Equation Considerations 
 a. Check or uncheck boxes as required by the project.
 b. Consult with the soils engineer to determine how the materials should 

be handled. If the box(es) are not selected, this means that granular 
backfill will be used for marsh and/or EBS backfill.

 B. Details tab: Create detail earthwork sheets
 I. Add... 

 a. Navigate to select the XML reports created in Civil 3D
 b. ProjectID\dsgn\qty\ewrk\25.xml, 4thAve.xml
 c. Open

 II. Click the Folder button to open the save as dialog. Navigate to and save the 
new earthwork detail workbook. 

 a. ProjectID\dsgn\qty\ewrk\EWKDetail-25.xlsx
 b. Save
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 III. Create Report
 a. Detail Spreadsheet will open in Excel.
 b. Close the workbook prior to running the summary

 C. Summary tab: Create summary earthwork sheets
 I. Default Summary Divisions 

 a. Specify how to divide the project earthwork: All details to one division 
or Each detail in its own division

 II. Click the Folder button to open the Earthwork Detail Spreadsheet: 
 a. ProjectID\dsgn\qty\ewrk\EWKDetail-25.xlsx
 b. Open

 III. Create Report
 a. Spreadsheet will open in Excel. The earthwork summary worksheet will 

be filled out.

Exercise files qnty-erthwrk-end-data-c3d22.zip

Earthwork finals - borrow pit
Last updated: 2013-01-13

Total video time: 11:26

Exercise files: qnty-erthwrk-fnl-brw-pit-data-C3D12.zip

Earthwork finals - borrow site

qnty-erthwrk-fnl-brw-pit-01.mp4 11:26

This section will demonstrate three ways to obtain final site volume information and how to create 
the two surfaces needed; a Borrow site surface created from point and breakline files, and an exist-
ing surface built from a data reference. This workflow can also be used for almost any earthwork site 
volume calculations.

Create drawing from template

 1. Create a new drawing using the wisDOT12.dwt template.
 2. Save the drawing.

Creating the Borrow site surface from an SRV file

 1. Ensure the Final SRV file has been placed into the project folder structure (Refer to WisDOT 
project folder structure for recommended folder structure). The SRV file contains point and 
break line information that will be used to create a surface.

 2. Run Convert SRV to PNT/FLT macro from the WisDOT toolbox, in the Toolbox tab of the 
Toolspace (The Autocad 2012 VBA Enabler needs to be installed for this macro to run). 
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 3. Respond No to the save dialog that appears at the end of running the macro. This macro will 
build point and Breakline/Fault files with extension PNT and FLT in the same folder location 
as the original SRV file. These file can now be used as definitions for a surface.

 4. Create a new surface and name it ACME Borrow Site
 5. Select the Final Top Border as the surface style
 6. Add Point file definitions to the surface using PENZD (Space Delimited) file format. Press the 

Plus icon/button and select the PNT file.
 7. Select break link to file and OK.
 8. Add Breakline definitions to the surface using the From file option and select the FLT file
 9. Select break link to file and OK

 10. The ACME Borrow Site surface is created. Zoom extents to see the surface.
 11. Save the drawing.

Create the Existing Surface by creating a Data Reference

 1. Navigate in the Toolspace, on the Prospector tab and expanding the Data Shortcuts col-
lection. Select the Exist surface under the Surface collection and right-click and select Create 
Reference.

 2. Select the EX border surface style for best drawing performance and for visual reference.
 3. Save the drawing.

Calculate Borrow Site volume using the Composite Volumes tool

 1. Select Analyze>Volume tool, to create a new volume entry
 2. Select the Exist surface as the base surface and ACME Borrow Site as the comparison surface 

to be used.

Info: Notice the cut and fill volumes shown in the panorama are a calculation 
and do not represent a volume surface. This data is not saved with the draw-
ing and must be re-calculated once the Composite Volumes panorama is 
closed. This information can be exported to an xml file by using the export 
button on the top menu of the composite volume panorama.

 3. Save the drawing.

Calculate Borrow Site Volume using the Volume Dashboard tool

Info: This is an add-on for version 2012 and may be downloaded from the 
Autodesk Subscription Center

 1. Open the Volume Dashboard from the command line by typing VOLUMEDASHBOARD. This tool 
can also be accessed in the Toolspace, Toolbox tab, under the Subscription Extension Man-
ager collection. Expand Volumes Dashboard Extension for AutoCAD Civil 3D 2012 and right-
click on Volumes Dashboard for AutoCAD Civil 3D 2012 and select Execute.

 2. Create a new Volume Surface. Select the Exist surface as the base surface and ACME Borrow 
Site as the comparison surface to be used.
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 o Review the cut and fill volumes that are shown in both tabular and graph form on the 
Dashboard. This information is derived from a Volume surface. This new volume sur-
face is saved in the drawing.

 3. Generate a Volume Report by selecting the Generate Cut/Fill Report button on the Dash-
board.

 o A report is created for viewing. The information in the html report can be copied and 
pasted into an excel worksheet.

 4. Save the drawing.

Calculate Borrow Site volume from Section areas using the Average End-Area 
Method

 1. Create an Alignment that extends down the middle of the longest direction of the borrow pit 
surface

 o The alignment should extend past the surface area on both ends.
 2. Create a Sample Line Group from Ribbon>Profile & Section Views>Sample Lines
 3. Select the newly created alignment
 4. Set the data sources to sample in the Create Sample Line Group dialog. Verify the Exist sur-

face and ACME Borrow Site surface are selected and close dialog.
 5. Create Sample lines by range of stations
 6. Define the swath width and station frequency of sample lines so they extend beyond the 

width of the borrow site surface.
 7. Set the sample increments. A 10' increment is appropriate for most sites.

 o The sample increments are in direct correlation to the desired volume precision.
 8. Select OK and close the Sample Line Tools dialog.
 9. To add more sample lines for critical location and site irregularities select the sample method 

At a Station, then pick on screen the location desired for an additional sample line. Follow the 
command line prompts for left and right swath width, then select another location or press 
enter to quit the command

Info: Note that both these sample line methods create sample lines that are 
perpendicular to the alignment.

 10. Erase all the Sample lines in the model that do not cross over both surfaces, except for the 
first sample line

 11. Open the Sample Line Group Properties Dialog by selecting one of the sample lines, then 
selecting Group Properties on the contextual ribbon.

 o In the Material List tab, Click on Import another criteria and use the WisDOT Mass 
Ordinate Quantity Takeoff criteria.

 o Choose <Click here to set all> next to Exist surface and assign the "Exist" surface.
 o Choose <Click here to set all> next to Final Datum surface and assign the ACME Bor-

row Site surface.
 n Not all materials will be assigned.

 o Press OK to continue
 12. Set Volume calculation method to Average End Area and click OK to exit

 o The material volumes have now been computed.
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 13. On the sample line contextual ribbon, select Generate Volume Report.
 o Verify the alignment, sample line group, and material list is correct.

 14. Generate Volume Report using the earthwork.xls style sheet.
 15. Save the drawing.

Info: The cumulative volumes in the report can be compared with the 
volumes developed using the Volume Dashboard. The information in the 
html report can be copied and pasted into an excel worksheet.

Earthwork finals - project
Last updated: 2013-01-13

Total video time: 30:14

Earthwork finals - Project

qnty-erthwrk-fnl-prjct-01.mp4 30:14

 1. This section will demonstrate two ways to obtain final project cut volume(s) information:
 o Surface Comparison by creating a Volume Surface
 o Calculate Average End Area Volumes, using sections along a baseline alignment

 2. For this exercise, a final survey was performed after the base/pavement had been placed. 
This workflow can also be used for almost any earthwork project volume calculations.

 3. Create a drawing from the template using wisDOT12.dwt.
 o Save the drawing.

 4. The subgrade and final survey drawings are to be located in the 3DModelDeliverable folder of 
the project. Verify that a Data Shortcut has been created of the following surfaces:

 o Final survey surface
 o Existing ground surface
 o Design subgrade surface

Info: Note: If the final survey was completed prior to base and pavement 
placement, the subgrade surface is not needed and the final survey surface 
can be used as-is without creating a composite surface.

 

 5. Create Data References of the Surfaces 
 o Expand the Surfaces list below Data Shortcuts in the Prospector tab on the Toolspace
 o Highlight the Existing surface,

 n Right-click and choose Create Reference.
 n Use the default name and style settings and press OK.

 o Repeat the previous steps to create a data reference for the all surface needed
 n Zoom extents if necessary to see the surfaces.
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 6. Create the Final Earthwork Composite Surface
 o Navigate to Surfaces from the Home ribbon and selecting Create Surface. Name the 

composite surface something similar to Final Earthwork Composite
 o Add Final Survey surface definition to the Final Earthwork Composite surface using 

the Paste tool
 n Press Surface on the Modify Ribbon above Ground Data. This will open the 

default Surface contextual Ribbon.
 n From Edit Surface select Paste Surface.

 n Press the space bar to open the dialog box and select the surfaces from 
a list.

 n Info: Note: The first surface to select is the main or base surface, 
and the second surface is the one to paste onto the base sur-
face.

 n Highlight the Final Earthwork Composite surface in the list, as the base 
surface, then press OK

 n Highlight the Final Survey surface in the list, as the surface to paste onto 
the base surface, then press OK

 o Add 3DSurfaceModel-Subgrade surface definition to the Final Earthwork Composite 
surface

 n Press Surface on the Modify Ribbon.
 n This will open the default Surface contextual Ribbon.

 n From Edit Surface select Paste Surface.
 n Press the space bar to open the dialog box to select the surfaces from a 

list.
 n Highlight Final Earthwork Composite surface in the list, as the base surface, 

then press OK
 n Highlight 3DSurfaceModel-Subgrade surface in the list, as the surface to paste, 

then press OK

Surface comparison by creating a volume surface
 1. Calculate Final Earthwork Volume from Surface Comparisons by Creating a TIN Volume Sur-

face
 o Press Surface on the Home Ribbon, and select Create Surface.

 n Set the Type to TIN Volume Surface.
 n Name: Final Earthwork Volume
 n Select the Existing surface for the Base Surface
 n Select the Final Earthwork Composite surface for the Comparison Surface

 o Go to the Surface Properties Statistics tab and review the TIN Volume numbers
 n Information here may be copied to the clipboard using the right-click menu for 

comparison with the Average End Area calculations.
 2. Create Volume Report using the Volume Dashboard Tool (This is an add-on for version 2012 

and may be downloaded from the Autodesk Subscription Center)
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 o Typing VOLUMEDASHBOARD at the command line to show the dialog.
 n The Volume Dashboard can be accessed in the Toolspace, Toolbox tab, under 

the Subscription Extension Manager collection. Expand Volumes Dashboard 
Extension for AutoCAD Civil 3D 2012 and right-click on Volumes Dashboard for 
AutoCAD Civil 3D 2012 and select Execute.

 o Press the Add Volume Surface button
 n The first one on the left, and select the Final Earthwork Volume surface.

 o Select the Final Earthwork Volume surface
 n Here you can review the cut and fill volumes that are shown in both tabular 

and graph form and generate a Volume Report by selecting the Generate 
Cut/Fill Report button on the Dashboard. A report is created for viewing. The 
information in the html report can be copied and pasted into an excel work-
sheet.

 

Matchline alignments (for end area method)
 1. Matchline alignments should already exist as part of the design process.

 o Data reference all the matchline alignments for the project, including any side roads 
into the drawing.

 o Highlight each matchline alignment, one at a time in the Prospector tree, right-click 
and select Promote. The matchline alignment should be in the Miscellaneous Align-
ments collection

 o Verify that each matchline alignment extends beyond the final survey surface and edit 
the alignment to extend if necessary, ensuring that the tangent angle is preserved.

For a tee intersection a left and right matchline alignment should exist as a data shortcut within the 
project.
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Create sample lines through intersections along the main roadway
 1. When working with the Sample line groups a good practice is to set each surface display style 

to a border only or no display style.
 o Create a Sample Line Group from Home ribbon, Profile & Section Views, Sample Lines
 o Select the main road centerline alignment.

 n Verify the Exist surface and Final Composite surface are checked as data 
sources to sample.

 o Create Sample lines by range of stations.
 n Set the "From alignment start" and the "To alignment end" settings to False.

 o Select the Start Station to reveal the select-from-drawing button.
 n Pick the radius point of the curb return with the lowest Station along the selec-

ted alignment.
 o Select the End Station to reveal the select-from-drawing button

 n Pick the radius point of the curb return with the highest Station along the selec-
ted alignment.

 o Set the Left and Right Swath Width; Snap to alignment to be True
 n Define the left and right swath width target alignment by clicking on the ellipse 

button to access the drop down list or use the select-from-drawing button and 
select the matchline alignment for each.

 o Set the Sample Increments to 5' for rural intersections and 2.5' or less for urban 
areas.

 n In the Additional Sample Controls, set the At Range Start to True, the At Range 
End to True, and the rest of the controls to True.

 o Select OK to close, or repeat these steps for other intersections along the alignment.
 2. Create Sample lines through intersections along the crossing roadway

 o Repeat the same procedures for sample lines through intersections along the main 
roadway, selecting the cross road centerline alignment, as well as accompanying 
matchline alignments for swath widths

 3. Create Sample Lines along Roadway
 o Select a Sample Lines from Home ribbon and select the centerline alignment. 

 n Verify the Exist surface and Final Composite surface are checked as data 
sources to sample.

 o Create Sample lines by range of stations
 n Set the "From alignment start" and the "To alignment end" settings to False.

 o Select the Start Station to reveal the select-from-screen button.
 n Pick the start station of the area to be sampled, this may be the start of the pro-

ject or it may be the radius point of the down station intersection.
 o Select the End Station to reveal the select-from-screen button.

 n Pick the end station of the area to be sampled, this may be the end of the pro-
ject or it may be the radius point of the up station intersection.

 o Define the swath width and station frequency of sample lines so they extend beyond 
the border of the Final Survey surface.
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 o Set the sample increments.
 n A 50' increment for rural locations, while 25' or less may be appropriate for 

urban areas.
 o Under the Additional Sample Controls;

 n Set the At Range Start to True if the range start is at the beginning of the pro-
ject. Set the At Range End to False, if the range end is at the beginning of an 
intersection area. Set it to True if the range end is at the end of the project. Set 
the rest of the controls to True.

 o Select OK and close the Sample Line Tools dialog.
To add more sample lines for critical location and site irregularities select the sample method "At a 
Station", then pick the location desired for an additional sample line. Follow the command line 
prompts for left and right swath width, then select another location or press enter to quit the com-
mand

Both of these sample line methods create sample lines that are perpendicular to the alignment.

In a situation where two baseline somewhat parallel each it may be necessary to use a longitudinal 
matchline as a swath width target between the two baselines to ensure the two sample line groups 
do not overlap. Some examples of this are divided highway, frontage road, or ramp situations.

 4. Calculate Final Earthwork Volume from Sections using the Average End-Area Method
 o Open the Sample Line Group Properties Dialog by selecting one of the sample lines, 

then selecting Group Properties on the contextual ribbon.
 n In the Material List tab, Click on Import another criteria and use the WisDOT 

Mass Ordinate Quantity Takeoff criteria.
 n Choose <Click here to set all> next to Exist surface and assign the Existing sur-

face.
 n Choose <Click here to set all> next to Final Datum surface and assign the Final 

Earthwork Composite surface, if created, otherwise assign the final survey sur-
face. Not all material will be assigned.

 n Press OK to continue
 o Set Volume calculation method to Average End Area and click OK to exit.

 n The material volumes have now been computed.
 o On the sample line contextual ribbon, select Generate Volume Report.

 n Verify the alignment, sample line group, and material list is correct.
 o Generate Volume Report using the earthwork.xls style sheet.

 n The cumulative volumes in the report can be compared with the volumes 
developed using the surface comparison method by creating a volume surface.

The information in the html report can be copied and pasted into an excel worksheet.

Creating design surfaces for WisDOT earthwork quantities
Last updated: 2022-06-03

Total video time: 52:16

Introduction
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erthwrk-dsn-srfc-qnty-01.mp4 1:14

Existing surfaces and Final Datum surfaces

erthwrk-dsn-srfc-qnty-02.mp4 4:06

Existing surfaces

Exist

This surface defines the current topography of the earth's surface.

FDM 15-5 Attachment 7.1 Surface Model Types

Surface creation methods

 l Existing surfaces are created from aerial collection methods and field survey.

See the following topics in the WisDOT C3DKB for more information.

 l  
 l  
 l  

Rock

This surface defines the top of the rock surface.
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Surface creation methods

How an existing rock surface is created will vary depending on the information available to create 
the rock surface. The options listed below are a few methods that could be used.

 l Option 1: Create rock surface solely on boring data if density of data is adequate
 l Option 2: Offset existing surface based on boring data
 l Option 3: Surface data is provided

Final Marsh Bottom

This surface defines the maximum marsh depth that will be excavated. How an marsh surface is cre-
ated will vary depending on the information available to create the marsh surface and the depth of 
excavation. The options listed below are a few methods that could be used.

Surface creation methods

Partial Depth Excavation

 l The Final Marsh Bottom surface will be above the actual existing bottom of the marsh.

Full Depth Excavation

 l Option 1: Offset existing surface based on marsh probe or boring data
 l Option 2: Create marsh surface solely on marsh probe or boring data if density of data is 

adequate
 l Option 3: Surface data is provided

Info: The Final Marsh Bottom surface is used to define the areas of marsh material being 
excavated. Any portion of the existing roadway that is in a proposed cut will be considered 
marsh material if the Final Marsh Bottom surface extends under the existing roadway.

Recommendations for rehabilitation and reconstruction projects
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 1. Determine the existing subgrade shoulder point
 2. Define the marsh surface beyond the existing subgrade shoulder point to outside the pro-

posed slope intercept. The inside marsh surface limit should be farther away from the ref-
erence alignment than the inside marsh excavation slope intercept.

Design Surfaces

Final Datum

FDM 15-5 Attachment 7.1 Surface Model Types

Surface creation methods

 l The Final Datum surface is a refinement surface created from any or all of the following: cor-
ridor surfaces, gradings, additional breaklines

See the following topic in the WisDOT C3DKB for more information.

Corridor and refinement surfaces
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Datum design based on existing subsurfaces

 l Rock excavation beyond subgrade shoulder point

FDM 11-15 Attachment 1.8 Modernization Roadway Sections in Rock Cut
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Subassemblies

 l DaylightProfileControlled -- used to create various ditch configurations
 l Overburden subassembly - Subassembly models benching and slope requirements for sec-

tions in rock cut. Used in area between a Rock Surface and the existing ground, which is typ-
ically called the Earth Overburden (based on WisDOT FDM Procedure 11-15-1)

Subgrade Improvement limits

erthwrk-dsn-srfc-qnty-03.mp4 4:00

See FDM 11-5-15 Select Materials in Subgrades for policy and design standards
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FDM 11-5 Attachment 15.2 Standard Select Materials Systems

Surface creation methods
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 l This surface can be created from subgrade improvement point codes that are included in the 
WisDOT subassemblies LnExtendBase and ShldGeneric.

 1. Using a parameter reference to the LnExtendBase subassembly -- Subgrade improvement 
thickness will automatically adjust the ShldGeneric value.

 2. The Subgrade improvement surface is drawn at a width defined by Subgrade improvement 
width measured from the origin of the subassembly.

If this parameter is set to 0 ft., the distance used will be equal to the Paved width + Unpaved 
width parameters (edge of shoulder).

 3. To close the bottom of the subgrade improvement surface, the Subgrade improvement clos-
ure link slope is used to define the slope of the link that extends upward to the intersection 
with the subgrade (datum surface).

If a value of 0 is used for the Subgrade improvement close link slope, a near vertical link 
will be drawn from the subgrade improvement layer to the subgrade.

 4. When Show subgrade improvement foreslope is yes, then the subgrade improvement 
foreslope is drawn, extending from the subgrade shoulder point at a slope defined by 
the Method to set subgrade improvement foreslope (and accompanying logic) to the inter-
section with a temporary projection of the bottom of the subgrade improvement.

Create SGImp surface from feature lines

 l Crown_SGImp
 l Crown_SGImp_CG
 l ETW_SGImp
 l ETW_SGImp_CG
 l ES_SGImp
 l SGImp_Int
 l Daylight_SGImp (not needed with vertical cut out)
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Surface boundary

 l If near vertical surface is included = SGImp_Int feature line
 l If only the bottom surface edge of shoulder = ES_SGImp feature line
 l To the intersection of the shoulder foreslope = Daylight_SGImp feature line

Final EBS limits (Alternative 1: sloped sides

erthwrk-dsn-srfc-qnty-04.mp4 14:06

There are many ways to create an EBS surface. Which approach used will depend on the extent and 
location of the EBS and the shape of the excavation based on the construction detail in the plan. EBS 
surface breaklines can be generated using a corridor or done manually (example: feature lines). The 
methods shown below are based on using a corridor.

General workflow

 1. Create a corridor surface
 A. This could be created within the design corridor file, Crdr-EBS

 2. Create a volume surface
 A. Base Surface = Existing surface; Comparison Surface = surface used for EBS surface

 3. Create boundary/boundaries from volume surface
 A. Elevation = 0 contour. This is the limits of the EBS.

 4. Create the Final EBS surface
 A. Paste the Crdr-EBS surface or offset Crdr-Datum surface into the Final EBS surface
 B. Apply the boundary from step 3.

EBS that is included in Common Excavation

205.3.4 Excavation Below Subgrade

(1) Remove deposits of frost-heave material, unstable silty soils, wet and unstable soil, material salvaged 
from old road cores in marshes, topsoil containing considerable humus or vegetable matter, rocks, or 
other undesirable foundation material to the depth below finished grade as the plans show or the engin-
eer directs. If possible, slope and drain the excavation bottoms to prevent water accumulation.
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Surface creation method

 l EBS based on 1:1 slope from subgrade shoulder point
 l Other surface creation methods could also be used

Subassemblies
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These subassemblies are added to the same assembly used for roadway design.

 l ProfileParameterRef (WisDOT subassembly)
 o Added at subgrade shoulder point
 o Profile Target = ZCP EBS Depth (negative number)

 n Allows for the direct entry of depth vs targeting an elevation profile
 l LinkSlopeAndVerticalDeflection (Autodesk subassembly)

 o Vertical Deflection > Parameter Reference = ProfileToParameterRef.Elevation as Slope
 l LinkSlopeToSuface (Autodesk subassembly)

 o Input Value > Add Link in = Cut Only
 o Target Surface = EXIST

Potential alternate workflow -- MultiUseWidthAndSlopeLinks (WisDOT subassembly)

Surfaces

 1. Create Crdr-EBSCommon
 A. Extend depth profile additional 25 ft and a +number to ensure the EBS surface and 

EXIST surface intersect
 B. Create corridor surface from EBS bottom feature lines
 C. Create surface boundary from outer EBS point codes

 2. Create Vol-EBSCommon
 A. Create a volume surface with the Crdr-EBSCommon and EXIST surface

 3. Volume boundary
 A. Find the Elevation = 0 contour. Make a boundary/boundaries from this.

 4. Create Final EBS Surface
 A. Paste the Crdr-EBSCommon surface into the Final EBS Limits surface.
 B. Add boundary from the previous step.

Final EBS limits (Alternative 2: offset datum surface)

erthwrk-dsn-srfc-qnty-05.mp4 2:38

 1. Data reference the Crdr-Datum file into a new dwg.
 2. Offset the Crdr-Datum surface down X ft. X ft is the consistent EBS depth. X is typically 2-4'.

Final EBS limits (Alternative 3: vertical sides)

erthwrk-dsn-srfc-qnty-06.mp4 4:14

MultiUseWidthAndSlopeLinks subassembly

EBS that is included in Rock Excavation

erthwrk-dsn-srfc-qnty-07.mp4 6:09

205.3.7 Excavating Rock

Page: 1844

Published on: 5/17/2023

Final EBS limits (Alternative 2: offset datum surface)

../../../../../../Content/wisdot-sub-hlp-chm/ProfileParameterRef.htm
https://knowledge.autodesk.com/support/civil-3d/learn-explore/caas/CloudHelp/cloudhelp/2021/ENU/Civil3D-Subassembly-Ref/files/GUID-105A5F1E-4306-4761-B5F6-061443CF7095-htm.html?st=LinkSlopeAndVerticalDeflection
https://knowledge.autodesk.com/support/civil-3d/learn-explore/caas/CloudHelp/cloudhelp/2021/ENU/Civil3D-Subassembly-Ref/files/GUID-C6F2FD9E-8DC1-4F98-8A30-DB61347FD501-htm.html?st=linkslopetosurface
../../../../../../Content/wisdot-sub-hlp-chm/MultiUseWidthAndSlopeLinks.htm
https://c3dkb.dot.wi.gov/video/qnty/erthwrk-dsn-srfc-qnty-05.mp4
https://c3dkb.dot.wi.gov/video/qnty/erthwrk-dsn-srfc-qnty-06.mp4
../../../../../../Content/wisdot-sub-hlp-chm/MultiUseWidthAndSlopeLinks.htm
https://c3dkb.dot.wi.gov/video/qnty/erthwrk-dsn-srfc-qnty-07.mp4


205.3.7.1 General

(1) Remove rock, if encountered in excavation, to a depth of approximately 6 inches below the earth sub-
grade between limits of the shoulder slopes. If the plans show design details covering the depth of rock 
excavation, perform the work according to the details. If the plans or special provisions do not require spe-
cific materials, then use selected material obtained from roadway and drainage excavation to backfill 
areas of EBS in rock excavation. If excavation methods leave undrained pockets in the rock surface, drain 
the depressions properly. If the engineer allows, the contractor may fill the depressions with engineer-
approved impermeable material, at no expense to the department.

Create an EBSRock surface that will be used as the Datum surface ONLY when computing materials 
for Rock excavation. This approach is used so the EBS in rock excavation is not included in Com-
mon/EBS quantities.

Surface creation method

 l Use a separate corridor to create a portion of the EBSRock surface
 l Other surface creation methods could also be used

Profile

 l Create ZCP-EBSRock-Depth (negative number) using WisDOT Slope/Width Control Editor

Subassemblies

These subassemblies are used in an assembly not used for roadway design. The assembly is used in 
a corridor to create the top of the EBSRock surface.

 l LnExtendBase (WisDOT subassembly)
 o Only needed as a way to track current pavement structure design

 l ProfileParameterRef (WisDOT subassembly)
 o Added anywhere along LnExtendBase subassembly

 l MultiUseWidthAndSlopeLinks (WisDOT subassembly)
 o Vertical distance from insertion > Parameter Reference = Pro-

fileToParameterRef.Elevation as Slope
 o Allow right/left width link to daylight = Yes

Corridor

 l Create EBSRock corridor for where rock excavation will occur
 l Target: Surfaces > Left/Right daylight surface = Crdr-Top
 l Target: Slope or Elevation Targets > Profile Elevation = ZCP-EBSRock-Depth

Surfaces

 1. Create Crdr-EBSRock
 A. Create corridor surface from feature lines created by MultiUseWidthAndSlopeLinks 

(P1-P5 as needed)
 B. Create surface boundary from outer MultiUseWidthAndSlopeLinks point codes (Outer 

left and right point)
 2. Setup-EBSRock

 A. Paste Top surface
 B. Paste Crdr-EBSRock surface
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 3. Create Vol-EBSRock-Setup
 A. Create a volume surface with the Crdr-EBSRock and EXIST surface

 4. Volume boundary
 A. Base Surface = ROCK, Comparison Surface = Setup-EBSRock
 B. Find the Elevation = 0 contour. Make a boundary/boundaries from this.

 5. Create Final-EBSRock  surface
 A. Paste the Setup-EBSRock surface into the Final-EBSRock surface.
 B. Add boundary from the previous step.

Final Marsh Excavation limits

erthwrk-dsn-srfc-qnty-08.mp4 4:46

FDM 11-15-1.16 Marsh Section

FDM 11-15 Attachment 1.13 Typical Modernization Marsh Sections

Overview
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Project Type: New construction

Surface creation methods (consult with Soils Engineer on which marsh excavation method to use)

 l Option 1
 o See detail below
 o excavation depth based on 2H:1V slope projection from subgrade shoulder point to 

the existing surface; from the existing surface intercept vertically project to the marsh 
excavation depth; a slope is then projected at 0.5H:1V to the existing surface to estab-
lish the extend of marsh excavation.
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FDM 11-15 Attachment 1.13 Typical Modernization Marsh Sections

Subassembly
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 l MarshExc 
 o Insert at subgrade shoulder point

Create Marsh Exc Limits surface from feature lines

 l Marsh_Bottom_In
 l Marsh_Bottom_Out
 l Marsh_Daylight_Out

Surface boundary

 l Marsh_Daylight_Out feature line
 l Option 2

 o See detail below
 o excavation based on Wisconsin DOT standard depth tables.

Subassembly

 l MarshExcDT 
 o Insert at the end of the subassembly's Daylight link

Create Marsh Exc Limits surface from feature lines

 l Marsh_Daylight
 l Marsh_Bottom

Surface boundary

 l Marsh_Daylight feature line

Project Type: Rehab/Reconstruction construction

Surface creation method
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 l Marsh excavation beyond existing roadway embankment
 o See detail below

Subassembly

 l PartialMarsh
 l Insert at subgrade shoulder point

Create Marsh Exc Limits surface from feature lines

 l Marsh_Daylight_In
 l Marsh_Bottom_In
 l Marsh_Bottom_Out
 l Marsh_Daylight_Out

Surface boundaries

 l Inside = Marsh_Daylight_In (Hide boundary if marsh excavation is on both sides of the road)
 l Outside = Marsh_Daylight_Out (Outer boundary if marsh excavation is on both sides of the 

road)

Final Marsh Waste limits (optional)

erthwrk-dsn-srfc-qnty-09.mp4 0:38

This surface is only needed if excavated marsh and/or EBS material will be used in the roadway 
embankment outside the 1:1 slope.
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Subassembly

 l LinkSlopeToSurface (Autodesk subassembly)
 l Added at subgrade shoulder point

Create Marsh Waste Limits surface from feature lines

 l Create corridor surface from Daylight_Sub and subassembly LinkSlopeToSurface point code 
(WasteLimit custom code added) feature lines

Surface boundaries

 l Inside = Daylight_Sub (Hide boundary if marsh fill is on both sides of the road)
 l Outside = WasteLimit (Outer boundary if marsh fill is on both sides of the road)

Materials

erthwrk-dsn-srfc-qnty-10.mp4 3:31

The materials used in the Civil 3D WisDOT Mass Ordinate are based on the Roadway Excavation 
Material Classifications in the WisDOT Standard Specifications

Section 205 Roadway and Drainage Excavation

205.2.1 Classification

The department classifies excavation as common, rock, stone piles and stone fences, or marsh excavation. 
If the contract contains the Excavation Common and Excavation Rock bid items, the engineer will classify 
that excavation as either common or rock, based on unfrozen material, as the contractor performs the 
work.

The department classifies EBS outside of marshes as common or rock.
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WisDOT Mass Ordinate quantity takeoff criteria
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Computing the material list a onetime operation. If changes are needed, delete the material list and 
import the WisDOT Mass Ordinate criteria then assign the surfaces as needed.

The areas of different materials will overlap. The WisDOT Civil 3D Earthwork App takes the various 
material areas and calculates the areas that will be used in the Earthwork spreadsheet. See the 
Attachments for more information.

Common

General

CutCommon

All areas below the Existing surface and above the final Datum surface.

Embankment

All areas above the Existing surface and below the final Datum surface.

Subgrade Improvement

CutSubgradeImprovement

This is the cut area below the Existing and Datum surface that is within the Subgrade Improvement 
area. Excavation for subgrade improvement is included in Common Excavation. Subgrade improve-
ment takes place below the Datum surface. Therefore, this area needs to be accounted for in order 
to add it to the CutCommon material when using the WisDOT Civil 3D Earthwork App.

EmbankmentSubgradeImprovement

This is the fill area above the Existing surface and below the Datum surface that is within the Sub-
grade Improvement area. Fill within the subgrade improvement area should not included as 
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Embankment. Therefore, this area needs to be accounted for in order to subtract it from the 
Embankment material when using the WisDOT Civil 3D Earthwork App.

Excavation Below Subgrade (EBS)

EBS

Excavation Below Subgrade excavation is accounted for since it is added to the Cut volume and 
included in the final Common Excavation quantity in the Earthwork spreadsheet.

EBSSubgradeImprovement

The EBSSubgradeImprovement material is the portion of EBS material that is within the Subgrade 
Improvement area. This area is where EBS and SubgradeImprovement overlap and share the same 
space. Therefore, this area needs to be accounted for in order to subtract it from the EBS material 
when using the WisDOT Civil 3D Earthwork App.

Rock

General

RockExc

Rock material that is paid for as Rock Excavation. Excavated rock material is credited as fill in the 
Earthwork spreadsheet.
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Marsh

General

FDM 11-15 Attachment 1.13 Typical Modernization Marsh Sections

MarshExc

The top of the Marsh material is coincident with the Existing surface.

This material classification accounts for excavating marsh material to the limits or boundaries estab-
lished based on [FDM 11-15 Attachment 1.13 Typical Modernization Marsh Sections] and a soil engin-
eer's direction. The Datum surface is not included in this material calculation.

This material is added to the Marsh Excavation quantity when using the WisDOT Civil 3D Earthwork 
App.

CutMarshBottom

The top of the Marsh material is coincident with the Existing surface.

This material is defined where the Datum surface cuts below existing ground but does not cut below 
the Marsh bottom surface.

This material is added to the Marsh Excavation quantity when using the WisDOT Civil 3D Earthwork 
App.
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CutMarshExcLimits

The top of the Marsh material is coincident with the Exist surface.

This area is where the Datum surface cuts below the Existing surface inside the Marsh Excavation 
Limits. It is also where the MarshExc material overlaps with the CutMarshBottom material and 
shares the same space. This material is subtracted from the final Marsh Excavation quantity when 
using the WisDOT Civil 3D Earthwork App.

MarshExcSubgradeImprovement

The MarshExcSubgradeImprovement material is the portion of marsh material that is within the Sub-
grade Improvement area.  This area is where MarshExc and SubgradeImprovement overlap and 
share the same space.  Therefore, this area needs to be accounted for in order to subtract it from the 
Cut material when using the WisDOT Civil 3D Earthwork App.
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EmbankMarshWasteAllowable

The Final Marsh Waste Limits surface is optional. The Final Marsh Waste Limits surface and 
EmbankMarshWasteAllowable material classification is only required if excavated marsh material 
will be placed as fill along the embankment outside the 1:1 slope from the subgrade shoulder point.

The EmbankMarshWasteAllowable quantity is not included or credited as fill in the WisDOT Civil 3D 
Earthwork App or Earthwork spreadsheet. The spreadsheet needs to be manually updated to 
include this material if used.

Shape code set style

Shape styles are assigned to the materials in the WisDOT Mass Ordinate

Cross section material checks

You will get warnings in the event viewer panorama that two materials define a common area -- this 
is normal and not an error.
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Section view tables

erthwrk-dsn-srfc-qnty-11.mp4 3:29

Materials are those that simply meet the cut/fill criteria set up, most of these numbers will not match 
what you see in the Excel spreadsheet. Final earthwork volumes are determined based on the mater-
ial quantities in Civil 3D and calculated by the WisDOT Civil 3D Earthwork App or Earthwork spread-
sheet.

While creating multiple section views a Total Volume and Material table can be added to section 
views.

Tables can also be added after the section views have been created.

 1. Select section > Modify View panel > View Group Properties > Section Views tab > 
Change Volume Tables ellipse.

 2. Update Section View Tables dialog box as shown above
 3. Modify View panel > Update Group Layout
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Earthwork computations

erthwrk-dsn-srfc-qnty-12.mp4 3:42

Questions to address before starting earthwork computations

 1. Will marsh excavation be backfilled with common excavation?
 2. Will EBS excavation be backfilled with common excavation?
 3. Will marsh excavation be used as embankment fill outside of the 1:1 slope from the subgrade 

shoulder point?
 4. Will EBS excavation be used as embankment fill outside of the 1:1 slope from the subgrade 

shoulder point?
 A. If disposed outside 1:1 slope:

 I. Will it need to be excavated later for future expansion?
 II. Would it result in utility conflicts?

 III. Will it slide?
 IV. CMM - 832 QMP - Subgrade

The soils engineer should be consulted to confirm that the marsh or EBS is suitable for use in the 
embankment and to provide the estimated reduction factor.

WisDOT Civil3D earthwork app

Settings > Mass Ordinate Equation Considerations
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Warnings: 
CONSULT WITH THE PROJECT MANAGER AND/OR SOIL ENGINEER PRIOR TO RUNNING THIS 
REPORT TO DETERMINE HOW MARSH AND EBS MATERIALS WILL BE HANDLED.

Make sure the Mass Ordinate Equation Considerations settings are the same when running 
the Detailed earthwork report and the Summary report. If they are not the same, the Mass 
Ordinate may be different between the reports.

No Mass Ordinate equation considerations are checked

If the box(es) are not selected, this means that granular backfill will be used for marsh and/or EBS 
backfill. The material used to backfill the marsh/EBS will be paid for under the item of granular back-
fill and will not affect the volume of cut that is available for the fill (i.e. mass ordinate).

The volume of granular material is equal to the expanded marsh or EBS volumes.

FDM 11-5 Attachment 10.1 Earthwork Calculation Examples

Granular Marsh Backfill

Marsh Exc 15,001 CY x Marsh Backfill Exp 1.5 = 22,501 CY

Note: This is the volume of granular backfill required to backfill the marsh. This does not affect the 
cut or fill and is not used in the mass ordinate computations.

Granular EBS Backfill

EBS Exc 7,500 CY x EBS Backfill Exp 1.3 = 9,750 CY

Note: This is the volume of granular backfill required to backfill the EBS. This does not affect the cut 
or fill and is not used in the mass ordinate computations.

This also means that the excavated marsh/EBS material that is not, or cannot be, be disposed of by 
flattening slopes or filling in low places on the right-of-way, will be disposed of at no expense to the 
department outside the right-of-way.

Backfill Marsh with Common, Backfill EBS with Common

Cut will be used to backfill the marsh or EBS. This reduces the amount of cut material available to be 
used as fill.

Use Marsh in Fill, Use EBS in Fill

Excavated marsh and/or EBS material will be used as fill material outside the 1:1 slope projecting 
from the subgrade shoulder point. A reduction factor is applied in the earthwork spreadsheet to the 
excavated marsh/EBS material to be used as fill. This is done to account for the reduced volume of 
marsh/EBS available as it is placed in the embankment. Marsh/EBS material typically shrinks as it 
goes from its natural state to its compacted state in the embankment.

The soils engineer should be consulted to confirm that the marsh or EBS is suitable for use in the 
embankment and to provide the estimated reduction factor.
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Earthwork template spreadsheet

The template is located under C:\WisDOT\Stnd\Apps\Earthwork Template.xlsx

The WisDOT Civil 3D Earthwork App creates a new spreadsheet based on the Earthwork Template 
spreadsheet.

Earthwork Spreadsheet columns

WisDOT Mass Ordinate material areas developed in Civil 3D are included in the XML Volume Report 
generated by Civil 3D. The WisDOT Civil 3D Earthwork App uses this information to calculate the val-
ues shown in the earthwork spreadsheet. The spreadsheet equations used to determine the earth-
work values are based on the Mass Ordinate Equation Consideration settings selected before the 
detailed earthwork spreadsheet is created. It is important not to reuse earthwork spreadsheets from 
previous projects since the equations may not match the current project conditions and goals.

WisDOT Civil3D App logic: Spreadsheet Area = Adding and subtracting various WisDOT Civil 3D mass 
ordinate material areas

CUT

WisDOT Civil3D App logic: Cut = CutCommon + CutSubgradeImprovement - RockExc -- CutMarshBot-
tom - MarshExcSubgradeImprovement

Bid Item 205.0100 Common Excavation (Cut and EBS Excavation are included in this bid item)

SALVAGED/UNUSABLE

WisDOT Civil3D App logic: Area values are entered manually into the spreadsheet

FILL

WisDOT Civil3D App logic: Fill = Embankment -- EmbankmentSubgradeImprovement

MARSH EXC

WisDOT Civil3D App logic: Marsh Exc = MarshExc + CutMarshBottom -- CutMarshExcLimits

Bid Item: 205.0500 Marsh Excavation

ROCK EXC

WisDOT Civil3D App logic: Rock Exc = RockExc

Bid Item: 205.0200 Rock Excavation

EBS

WisDOT Civil3D App logic: EBS = EBS - EBSSubgrade improvement

Bid Item 205.0100 Common Excavation (Cut and EBS Excavation are included in this bid item)
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All other columns are calculated within the earthwork spreadsheet based on the equations used to 
determine the earthwork values based on the Mass Ordinate Equation Consideration settings selec-
ted before the detailed earthwork spreadsheet is created.

EXPANDED FILL

Spreadsheet calculation: Expanded Fill = (FILL - (RockExc*ERfactor) - (MarshExc*RMIFfactor) - 
(EBS*REIFfactor)) * EFfactor

Reviewing reduced MARSH and EBS quantities used in fill

The comparison of how much excavated marsh/EBS material there is versus how much can be used 
in fill on the project is not an automated process. This process requires the designer to review the 
material placement since marsh/EBS material may be used anywhere on the project, not just at the 
same station as the marsh/EBS excavation.

Material volume available from excavation:

When "use in fill" for EBS and/or Marsh is checked in the WisDOT Civil 3D Earthwork App, the marsh 
excavation is multiplied by a reduction factor and is shown in the Reduced Marsh in Fill and/or 
Reduced EBS in Fill columns . This is the total marsh excavation volume available as fill material. 
The Mass Ordinate is then adjusted accordingly. This calculation is described in FDM 11-5-10.7 Steps 
3 & 4.

Material volume that may be used in the embankment:

The total volume of marsh/EBS material that may be consumed or used on the project is based on 
the EmbankmentMarshWasteAllowable material quantity. This material can be reviewed in Civil 3D 
and is in the XML Volume Report generated by Civil 3D, but it is not imported into the WisDOT earth-
work spreadsheet.

A Material Volume Table can be generated within Civil 3D to review the Embank-
mentMarshWasteAllowable volume. This table can be set to be dynamic when it is created.

Analyze tab > Volume and Materials panel > Material Volume Table
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The designer reviews the EmbankmentMarshWasteAllowable material volume and compares it with 
the total Reduced Marsh in Fill and/or Reduced EBS in Fill spreadsheet volume.

 l If the total Reduced Marsh in Fill and/or Reduced EBS in Fill < Embank-
mentMarshWasteAllowable, then no adjustments are required.

 l If the total Reduced Marsh in Fill and/or Reduced EBS in Fill > Embank-
mentMarshWasteAllowable, then adjustments are required. Adjustment could include things 
like changes to the reduction factor or shortening the stretch of marsh or EBS used in fill.

Volumes from surface to surface comparison

 1. Create volume surface
 A. Analyze tab > Volume and Materials panel > Volumes Dashboard

 I. Surface Name: BreakerRun
 II. Base Surface: SubgradeImprovement

 III. Comparison Surface: Datum
 2. Review volume surface data

 A. Volumes Dashboard
 B.   Surface Properties dialog box > Statistics tab > Volume

Notes in Earthwork spreadsheet

Edit backfill and mass ordinate notes in the spreadsheet as needed to describe how earthwork 
volumes were calculated.
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Resources

WisDOT Standard Specification - Section 205 Roadway and Drainage Excavation

FDM 11-5-10 Earthwork

FDM 11-5 Attachment 10.1 Earthwork Calculation Examples

FDM 15-1-30 Miscellaneous Quantities Sheet

FDM 15-1-40 Earthwork Data Sheet

C3DKB - Earthwork quantities

Attachments

Attachment 1 - No Mass Ordinate Equation Considerations are checked

Attachment 2 - Backfill Marsh with Common, Backfill EBS with Common
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Attachment 3 - Use Marsh in Fill, Use EBS in Fill

Attachment 4 -- Backfill EBS with Common, Use EBS in Fill
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Attachment 5 -- Summary of WisDOT Civil 3D App Mass Ordinate Equation Considerations

3D Surface area
Last updated: 2023-05-01

Total video time: 33:13

This workflow demonstrates how to calculate 3D areas from surfaces and report the station range 
for each area. Examples of 3D areas include but is not limited to topsoil, erosion mat, work asso-
ciated with seeding, pavements, etc. This training will demonstrate an example of topsoil area cal-
culations.

File setup
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qnty-3d-srfc-area-01.mp4 2:39

 1. Start a new drawing from design-start.dwt template
 2. Save file as ProjectID\dsgn\qty\Topsoil-Master.dwg
 3. Set the active layer to P_MISC
 4. Set the Working folder
 5. Data reference: 

 A. Toolspace palette > Prospector tab > Data Shortcuts > Surfaces > Exist surface > 
left-click hold and drag into drawing

 I. Surface style: _No Display
 II. OK

 B. Toolspace palette > Prospector tab > Data Shortcuts > Surfaces > Crdr-25-Datum 
surface > left-click hold and drag into drawing

 I. Surface style: _No Display
 II. OK

 C. Toolspace palette > Prospector tab > Data Shortcuts > Surfaces > Rfnt-All-Top 
surface > left-click hold and drag into drawing

 I. Surface style: Slope Intercept
 II. OK

 D. Toolspace palette > Prospector tab > Data Shortcuts > Alignments > Centerline 
Alignments > Lcl-4thAve > left-click hold and drag into drawing

 I. Alignment style: ALI_Porposed

 II. OK

The example workflow removes the subgrade surface area from the Rfnt-Top surface and leaves the 
remaining side slopes for topsoil calculations.

Rounding boundary

qnty-3d-srfc-area-02.mp4 6:07

The rounding area is the space beyond the proposed slope intercepts that may be disturbed during 
construction. The 3D surface area calculation workflow is capable of measuring these areas, how-
ever other calculation methods may be used if the area beyond the slope intercepts will be accoun-
ted for in the quantities.

 1. Extract boundary from Rfnt-Top surface 
 A. Left-click to select the border of the Rfnt-Top surface 

 I. Surface Data Reference Rfnt-Top contextual ribbon > Surface Tools panel 
> Extract from Surface dropdown > Extract Objects

 a. Property - Border: selected
 b. OK

 2. Break the 3D polyline boarder at all project construction limits locations 
 A. Commandline: typeBreak
 B. Select object: left-click select the 3D polyline border of the Rfnt-Top surface any-

where along the project limits pavement tie in
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 C. Specify second break point or [First point]: pick First point
 D. Snap to the Rfnt-Top polyline border at the left slope intercept of the project limits
 E. Specify second break point

 F. Snap to the Rfnt-Top polyline border at the right slope intercept of the project limits
 3. Repeat step 4 for each project limits location
 4. Modify tab > Edit Geometry panel > Stepped Offset icon

 A. Specify offset distance or [Through Layer]:5 Enter
 B. Left-click select one of the resulting polylines
 C. Specify side to offset or [Multiple]: Left-click pick side to the outside of 

the polyline
 D. Specify elevation or [Grade Slope Difference Variable] side to 

offset or [Multiple]: Pick Difference
 E. Specify elevation difference or [Grade Slope Elevation Vari-

able]: 0 Enter
 5. Repeat the process to offset the polylines in the remaining polylines 

 A. Esc when finished
 6. Left-click select the original Rfnt-Top surface border polylines
 7. Delete
 8. Connect the offset 3D Polylines at the project construction limits locations 

 A. Commandline: type3dpoly
 B. Specify start point of polyline: Snap to the end of the polyline
 C. Specify end point of polyline or [Undo]: Snap to the end of the tri-

angulated surface at the construction project limits 
 D. Pick the nearest location where the line continues forward and does not go backwards
 E. Specify end point of polyline or [Undo]: Snap to the end of the tri-

angulated surface at the opposite side of the roadway at the construction project lim-
its 

 F. Pick the nearest location where the line continues forward and does not go backwards
 G. Specify end point of polyline or [Undo]: Snap to the end of the slope 

intercept polyline at the opposite side of the roadway at the construction project limits
 H. Enter

 9. Enter to restart the 3DPOLY command
 10. Repeat the process to close each end of the project limits with 3D polylines
 11. Commandline: type join

 A. JOIN Select source object or multiple objects to join at once: 
**window select all the polylines **

 B. JOIN Select objects to join:Enter
 12. Left-click select the 3D polyline to confirm that everything was joined correctly and the bound-

ary closes
 13. Modify tab > Edit Elevations panel > Elevations from Surface icon

 A. Select Exist surface
 B. Options - Insert intermediate grade break points: unchecked
 C. OK
 D. Specify object or [Multiple Partial]: Left-click select the 3D polyline bor-

der
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 E. Enter
 F. Save the file

Master surface

qnty-3d-srfc-area-03.mp4 5:07

 1. Home tab > Create Ground Data panel > Surface dropdown > Create Surface
 A. Name: Topsoil-Master
 B. Style: Top Triangles
 C. OK

 2. Toolspace palette > Prospector tab > Surfaces > expand Topsoil-Master > Definition > 
right-click Edits > Paste Surface

 A. Rfnt-Top surface
 B. OK

 3. Toolspace palette > Prospector tab > Surfaces > expand Topsoil-Master > Definition > 
right-click Breaklines > Add...

 A. Description: Rounding
 B. Type: Standard
 C. OK
 D. Select object:left-click select 3D polyline border
 E. Enter

 4. Toolspace palette > Prospector tab > Surfaces > expand Topsoil-Master > Definition > 
right-click Boundaries > Add...

 A. Name: Rounding
 B. Type: Outer
 C. Non-destructive breakline: checked
 D. OK
 E. Select object:left-click select 3D polyline border
 F. Tip: Names these breaklines and boundaries will be useful in a later step.

Tip: Tip: Names these breaklines and boundaries will be useful in a later step.

 5. Tin Surface: Topsoil-Master contextual ribbon > Modify panel > Add Data dropdown > 
Boundaries

 A.  Name: Subgrade
 B. Type: Hide
 C. Non-destructive breakline: checked
 D. OK
 E. Select object(s) or [Surface]: pick Surface
 F. Select a surface [or press enter key to select from list]:Enter
 G. Select a surface: Crdr-25-Datum
 H. OK

 6.  Save the file
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Topsoil surface without rounding

 1. Left-click select Topsoil-Master surface
 2. Tin Surface: Topsoil-Master contextual ribbon > Modify panel > Surface Properties

 A. Definition tab 
 I. Operation Type 

 a. Add breakline - Rounding:  unchecked
 b. Add boundary - Rounding Boundary: unchecked

 II. OK
 B. Rebuild the surface

Curb

qnty-3d-srfc-area-04.mp4 6:01

Use this workflow when there are small areas that need to be added in (example: the two feet 
behind the curb and gutter in the curb returns) .

 1. Toolspace palette > Prospector tab > Data Shortcuts > Corridors > 25 > right-click > 
Create Reference...

 2. OK
 3. Left-click select the corridor
 4. Corridor: 25 contextual ribbon > Launch Pad panel > Feature Lines from Corridor

 A. FEATURELINESFROMCORRIDOR Select corridor feature lines or [All by Regions within 
Polygon]: pick All

 B. Extract Corridor Feature Lines dialog box
 I. Unselect all feature lines

 II. BackCurb: selected
 III. ETW_Datum_CG: selected
 IV. Settings... 

 a. Dynamic link to corridor: checked
 b. Apply Smoothing: unchecked
 c. Layout name: unchecked
 d. OK

 C. Extract
 5. Toolspace palette > Prospector tab > Feature Lines

 A. Review feature lines in Prospector table
 6. If not all feature lines can be added to the surface, Toolspace palette > Prospector tab > 

expand Surfaces > expand Topsoil Master > expand Definition > right-click Breaklines 
> Add...

 A. Add breaklines dialog box
 I. Description: Back of Curb

 II. Type: Standard
 III. Supplementing factors

 a. Distance: checked
 b. Distance value: 0.100
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 IV. OK
 B. Select objects: select all Auto Corridor Feature Lines for BackCurb and ETW_

Datum_CG
 C. Enter

 7. If all feature lines can be added to the surface, Toolspace palette > Prospector tab > right-
click Feature Lines > Add to Surface as Breakline...

 A. Select Surface: Topsoil-Master
 B. OK
 C. Add Breaklines dialog box

 I. Description: Back of Curb
 II. Type: Standard

 III. Supplementing factors 
 a. Distance: checked
 b. Distance value: 0.100

 IV. OK

Info: When curb breaklines are added, the surface will triangulate beyond the back of 
curb breakline to the top of curb breakline. As a result a very small area will be added 
to the quantity, however this is acceptable for calculating topsoil.

 8. Select Corridor 25
 9. Properties palette > Design tab > Layer > P_CRDR

 10. Home tab > Layers panel > Freeze icon > left-click select Corridor 25
 11. Enter
 12. Toolspace palette > Prospector tab > expand Surfaces > right-click Topsoil Master > 

Rebuild
 13. Save the file.

Create surface breakout areas

qnty-3d-srfc-area-05.mp4 3:18

Create closed polygons to define the limits of individual quantity areas. The closed polygons may 
extent beyond the surface limits and do not have to trace the surface of interest. Example breakout 
areas: left and right mainline areas and left and right side road areas.

 1. Set current layer to P_MISC
 2. Commandline: type PL, to create a polyline.

 A. Specify start point: click point in a location southeast of the project
 B. Specify next point or [Arc Close Halfwidth Length Undo Width]: 

Osnap to end of curb return slope intercept
 C. Continue in command to enclose area of interest. Point locations include but not lim-

ited to:
 I. Osnap to triangle edges along slope at the end of curb return (repeat multiple 

times)
 II. end of ETW_Datum_CG feature line

 III. end of BackCurb feature line
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 IV. middle of side road lane
 V. points along middle of main road lane (continue beyond south end of project)

 D. Specify next point or [Arc Close Halfwidth Length Undo Width]: C
 3. Repeat this for the north leg of the intersection leaving a gap in the intersection interior for 

the secondary road breakout.
 4. Repeat this for the secondary road. Snap to the adjacent main road polylines where area 

boundaries are the same. The secondary road CAN be one breakout or could be broken into 
two breakout areas.

Create cropped surfaces

qnty-3d-srfc-area-06.mp4 3:31

Breaking out quantity locations is accomplished by using cropped surfaces. Cropped surfaces act as 
a copy of the source surface that reads back to the original surface. Cropped surfaces update if the 
original surface is changed.

Cropped surfaces may be created manually in Civil 3D or very quickly by using a WisDOT tool Create 
Cropped Surfaces. See Surfaces - Create Cropped Surfaces for more information.

 1. Ribbon> WisDOT Design tab > Design panel Surfaces drop-down > Surfaces - Create 
Cropped Surfaces

 A. Select Surface: Topsoil-Master 
 B. Polyline selection options [Individual/ByLayer] <Individual>: I
 C. Select Polylines: select boundrary polyline Enter
 D. Associate Alignment?(Yes No): Yes
 E. Select an alignment: select Alignment 25 Enter

 2. Topsoil MasterCropped surface is created. A number is added to each cropped surface name 
when multiple cropped surfaces are created. Example: Topsoil MasterCropped 1, Topsoil 
MasterCropped2, etc.

 3. Toolspace palette > Prospector tab > expand Surfaces > right-click Topsoil Master-
Cropped > Surface Properties…

 A. Information tab > Name: Topsoil MasterCropped-25-SE

 I. Name cropped surfaces so the location is easily understood.

 4. Repeat the process for each boundary.

Report 3D surface areas and locations

qnty-3d-srfc-area-07.mp4 2:53

See QTO - 3D Surface Area Report for more information.
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 1. WisDOT Design tab > Analyze panel > QTO dropdown > QTO - 3D Surface Area Report
 2. 3D Surface Areas Report dialog box

 A. Select Surfaces: Shift-select all Topsoil MasterCropped surfaces
 B. Default Alignment: 25 (report will read alignment associated with cropped surface)
 C. Settings

 I. Station Precision: 2
 II. Area Precision: 2

 III. Units: SY
 IV. See FDM and Standard Specifications for appropriate precision and units

 D. Report location: proj\dsgn\qty\Topsoil.xlsx
 I. Save

 E. Create Report
 F. Close

 3. The Topsoil.xlsx report opens in Excel
 4. Review and Close the report
 5. Save Topsoil-Master.dwg

Info: The WisDOT Create Cropped Surfaces tool stores cropped surfaces in the same 
dwg as the source surface. The cropped surface definition points to a dwg, not directly 
to a surface object. So, if the dwg changes in any way, the cropped surfaces will show 
up as out of date. If the source and cropped surfaces were up to date before the save, 
they are up to date after the save unless the original surface was changed.

 6. Toolspace palette > Prospector tab > right-click Surfaces > Rebuild Out of Date Items
 7. Save Topsoil-Master.dwg

Update surface and reports

qnty-3d-srfc-area-08.mp4 3:37

 1. Make sure report Excel spreadsheet file is closed.
 2. Open Topsoil-Master.dwg
 3. Toolspace palette > Prospector tab > expand Surfaces > right-click Topsoil Master-

Cropped > Surface Properties…
 4. Surface Properties - Topsoil Master dialog box

 A. Definition tab
 I. Operation Type

 a. Add breakline - Rounding: unchecked
 b. Add boundary - Rounding boundary: unchecked

 B. OK
 C. Rebuild the surface

 5. Save the file Topsoil-Master.dwg
 6. Toolspace > Prospector tab > right-click Surfaces > Rebuild Out of Date Items
 7. Save the file Topsoil-Master.dwg

Info: The WisDOT Create Cropped Surfaces tool stores cropped surfaces in the same 
dwg as the source surface. The cropped surface definition points to a dwg, not directly 
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to a surface object. So, if the dwg changes in any way, the cropped surfaces will show 
up as out of date. If the source and cropped surfaces were up to date before the save, 
they are up to date after the save unless the original surface was changed.

 8. WisDOT Design tab > Analyze panel > QTO dropdown > QTO - 3D Surface Area Report
 9. Rerun the report as shown in the previous subtopic "Report 3D surface areas and locations".

 10. The existing Topsoil.xlsx report can be overwritten and updated to show topsoil areas to the 
slope intercept and does not include the rounding areas. A new report can also be created to 
compare values.

Tip: If you need to keep records of the changes you can save this file as a different 
name to avoid overwriting earlier reports.
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Digital data
"WisDOT Civil 3D forms" on page 51
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Contractor data
"WisDOT Civil 3D forms" on page 51

Contractor data packet overview
Last updated: 2022-09-14

Requirement: The designer shall create a Contractor Data Packet for each let project with a 
geospatially accurate reference alignment. Submitted data required for a project is dependent 
on the scope of the project. See Table 43.4 for recommended data by project type. See Table 
43.3 for accepted file formats. Unused layers and referenced data should not be included in 
the Contractor Data Packet.

Terminology

AMG: Automated Machine Guidance. The most common uses of AMG on WisDOT construction pro-
jects are for earthwork grading and aggregate placement. AMG paving applications are emerging on 
our projects also.

Contractor Data Packet (CDP): Digital data files with survey, design, and staking information. CDPs 
are delivered with the design project, and are provided to bidders at project advertisement.

DTM: Digital Terrain Model. An object used to represent terrain in Civil 3D and other civil engineering 
software. DTMs consist of an irregular network of 3D triangle faces developed from 3D points and 
3D breaklines (linear terrain features).

3D Surface Model: Contractor Data Packet representation of terrain. Proposed work surface models 
consist of a DTM, breakline file, and surface boundary file. Existing ground surface models consist of 
a DTM, and a surface boundary file.

Design Model: Contractor Data Packet representation of proposed work terrain. Design models are 
required to contain Top and Datum surface models.

Construction Model: DTMs employed by the contractor(s) in AMG and other construction oper-
ations. Contractors are responsible for construction model development.

Purpose

CDPs contain design survey information, roadway design information, and construction stak-
ing reports. Formats used are consumable in survey systems used for construction staking, and in 
contractor software used in advanced model-based workflows. Some of the information in a CDP is 
provided elsewhere, in roadway plans for example, so what is the purpose of CDPs? In many cases, 
the traditional construction contract document sources of the design information (typically the plan) 
requires the re-creation of data if it is to be used in other systems. When the survey, design, and stak-
ing information is packaged in the formats specified for the CDPs, meaningful project data is trans-
ferred directly into contractor systems, creating opportunities for increased efficiency in 
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construction project activities. Other types of CDP information may not be readily available in Plans, 
but can be extracted from the design project data and shared with contractors to allow for additional 
efficiencies. Generally, any WisDOT project with a construction reference line should have a CDP 
associated with it.

WisDOT shares CDPs with our contractors for convenience. While the CDP is a contractual design pro-
ject deliverable, it does not have construction contract document status for construction projects. If 
there is a discrepancy between the information in the plan and the information in the CDP, the con-
tractor is required to build the project according to the plan.  Typically, contractors invest time and 
effort in the verification of the CDP , comparing it to the plan as the plan is the contractual doc-
ument. The Department needs to make sure the CDP delivered is consistent with the plan. The 
WisDOT roadway design workflows were developed with this primary goal in mind.

In order to have a more thorough understanding of the purpose of the CDP, a conversation about 
the intended uses of the information provided in the packet is needed.  WisDOT has received feed-
back from contractors regarding benefits of using the CDPs. Much of the pre-bid benefit of CDPs 
comes from the existing ground surface model and the proposed work surface models. These mod-
els are delivered in highly portable data formats, and can be used directly in contactor software with 
very little data import effort. Within minutes contractors have a complete representation of existing 
and proposed terrain and are now enabled to prepare bids in ways they haven't been able to in the 
past, as most contractors will not invest in proposed work model development until they've won the 
bid. They can use this information to analyze and confirm the project quantities. They can get 
a more accurate account of the distribution of earthwork volumes of a project, which can help plan 
various aspects of construction operations to a much greater level of detail than projects without 
Design Models. They can assess operational alternatives to optimize the project game plan of how to 
conduct operations. This deeper level of plan helps contractors reduce the unknowns about the pro-
ject which reduces risk. Risk reduction in the competitive bidding environment results in more com-
petitive bids. 

Contractor Data Packet uses don't stop with the Letting, the benefits extend into construction project 
activities. Automated Machine Guidance applications use the Construction Model DTM surfaces to 
define proposed work. The Design Model proposed work surface models in the CDP give contractors 
a head start in the development of their construction models. On WisDOT projects, contractors often 
do not use the Design Model surfaces directly in their operations. Direct design model surface usage 
does happen occasionally, but it seems to be more the exception than the rule. Contractors are 
employing AMG in different ways. The structure of Construction model surfaces, the feature rep-
resentation, and the level of detail can all vary from one contractor to the next. The reasons for 
these differences in AMG methodology depend upon who is asked, but there is a common under-
lying reason – contractors want to gain a competitive advantage over their counterparts. The use of 
AMG has evolved and matured in contractors independent organizations. They have invested in 
equipment and hardware, and they have also invested in the education and training of staff. Con-
tractors want to protect those investments by retaining their methodologies. WisDOT wants to sup-
port and facilitate this kind of innovation when possible, and at the very least, foster an environment 
that allows innovation to occur.
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In the early days of 3D Design at WisDOT, The Department had a goal of delivering 100% con-
struction ready surface models in Design Models. As experience has grown, WIsDOT has come to 
understand there are differences in how contractors use AMG, and these differences are sometimes 
reflected in their construction models. There is no single surface model concept that will work for all 
contractors on all types of projects. This understanding of how AMG technologies are being 
employed on WisDOT projects has reduced the importance of high levels of precise detail in the DTM 
component of Design Model surface models, and has increased the importance of proposed surface 
model breakline delivery. Breaklines are the foundation of surface model development, and provid-
ing those foundational elements directly from our design data gives contractors a base platform 
from which they can develop construction models.

The post-bid benefits of our CDPs aren't limited to design model surfaces and AMG technology uses, 
construction staking contractors use CDP staking reports and other design information to streamline 
their processes too. The CDP staking data is formatted for easy import into survey systems, and 
makes design data transfer much more efficient compared to manual transfer from plan sheets. 
Design Model surfaces have uses in construction staking also, allowing for establishment of pro-
posed grade anywhere on a project.

Finally, the models in our CDPs can facilitate better communication on our construction projects. 
Communication between all project staff, engineering and contractor. And, models are particularly 
useful in communicating project information with non-industry people such as property owners, 
local officials, businesses, and other stakeholders who aren't familiar with our traditional plan sheet 
representations of project concepts.

Requirements

Requirements Standards

Submittal process
FDM 19-10-43.2 Con-
tractor Data Packet Sub-
mittal

List and description of digital design data Categories
FDM 19-10-43.5, Table 
43.2 Digital Data Exchange 
Categories

File formats for data in each Category

FDM 19-10-43.5, Table 
43.3 Digital Data Exchange 
Accepted Formats by Cat-
egory

Digital data provided based on project type
FDM 19-10-43.6, Table 
43.4 Recommended Elec-
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Requirements Standards

tronic Project Data by Pro-
ject Type

Contractor Data Packet directory structure

FDM 15-5 Attachment 3.1 
CADDS AutoCAD Civil 3D 
Project Folder Structure 
Standard

Transmittal document to contractors "Civil 3D 
Metadata Sheet for WisDOT Project - Contractor 
Data Packet" (includes directory structure and file 
naming conventions)

C3DKB WisDOT Civil 3D 
forms

Contractor Data Packet Feedback
C3DKB WisDOT Civil 3D 
forms

Workflows

Warning: Contractor data files are files exported from design files. They do not have a live con-
nection to the files they were created from. They only need to be generated for P.S.& E. deliv-
ery.

The const folder structure is embedded in the WisDOT Civil 3D project template.

Refer to Attachment 1 - File Information in the Civil 3D Metadata Sheet for WisDOT Project - Contractor 
Data Packet document for a description of the information included in each data export.

Data Folder Exported File Training Link

Contractor data 
packet metadata 
sheet

const  
Contractor data 
packet metadata 
sheet

Contractor data 
packet feedback form

const  
Contractor data 
packet feedback form

Field Control Data - 
Survey control points

const\CD-
BaseData

< Construction_ID >-
SurvCtrl.xml

"Export LandXML 
files" on page 1884

Field Control Data - 
Datum doc-

const\CD-
BaseData

< Construction_ID >-
DT1773.docx

"Geodetic references 
documentation" on 
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Data Folder Exported File Training Link

umentation page 1884

Existing Surface - DTM
const\CD-
BaseData

< Construction_ID >-
Surf-Ex.xml

"Export LandXML 
files" on page 1884

Existing Surface - 
Boundary

const\CD-
BaseData

< Construction_ID >-
Surf-Ex-Bndry.dwg

"Export ACAD DWG 
files" on page 1889

Existing Topography - 
General

const\CD-
BaseData

< Construction_ID >-
Topo-Ex.dwg

"Export ACAD DWG 
files" on page 1889

Existing Topography - 
Utilities

const\CD-
BaseData

< Construction_ID >-
Uti-Ex.dwg

"Export ACAD DWG 
files" on page 1889

Reference Line / Pro-
file - Mainlines

const\CD-
Design\CD-
AliProf

< Construction_ID >-
AliProf-RL.xml

"Export LandXML 
files" on page 1884

Reference Line / Pro-
file - Edgelines

const\CD-
Design\CD-
AliProf

< Construction_ID >-
AliProf-Pavt.xml

"Export LandXML 
files" on page 1884

Superelevation Data
const\CD-
Design\CD-
AliProf

< Construction_ID >-
Super-Ali-< Ali 
Name >.csv or .xlsx

"Export alignment 
superelevation data" 
on page 1900

Proposed Point Data
const\CD-
Design

< Construction_ID >-
Pts-< Location Desc 
>.xml

"Export LandXML 
files" on page 1884

Proposed Roadway 
Features

const\CD-
Design

< Construction_ID >-
Pavt.dwg

"Export ACAD DWG 
files" on page 1889

Proposed Structure 
Horizontal Features

const\CD-
Design

< Construction_ID >-
Struct.dwg

"Export ACAD DWG 
files" on page 1889

Proposed Surface - 
Datum Breaklines / 
Boundary

const\CD-
Design\CD-
Surface

< Construction_ID >-
Datum-Breaklines-
< Const-Stg >.dwg

"Extract design sur-
face breaklines" on 
page 1894
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Data Folder Exported File Training Link

Proposed Surface - 
Datum DTM

const\CD-
Design\CD-
Surface

< Construction_ID >-
Datum-Surf-< 
Const-Stg >.xml

"Export LandXML 
files" on the next 
page

Proposed Surface - 
Top Breaklines / 
Boundary

const\CD-
Design\CD-
Surface

< Construction_ID >-
Top-Breaklines-< 
Const-Stg >.dwg

"Extract design sur-
face breaklines" on 
page 1894

Proposed Surface - 
Top DTM

const\CD-
Design\CD-
Surface

< Construction_ID >-
Top-Surf-< Const-
Stg >.xml

"Export LandXML 
files" on the next 
page

Proposed Surface - 
Top Rural Driveway 
Breaklines / Boundary

const\CD-
Design\CD-
Surface

< Construction_ID >-
Top-Breaklines-Rur-
alDwy.dwg

"Extract design sur-
face breaklines" on 
page 1894

Proposed Surface - 
Top Rural Driveway 
DTM

const\CD-
Design\CD-
Surface

< Construction_ID >-
Top-Surf-Rur-
alDwy.xml

"Export LandXML 
files" on the next 
page

Proposed Cross Sec-
tion Data

const\CD-
Design\CD-
X-Section

< Construction_ID >-
Slp-Stk-< Ali >-< 
Const-Stg >.xlsx

"Export cross section 
slope stake files" on 
page 1901

Earthwork Data
const\CD-
Design\CD-
X-Section

< Construction_ID >-
EWK-< Ali >-< 
Const-Stg >.xlsx

"Copy earthwork 
data spreadsheet" on 
page 1902

Right-of-Way Monu-
mentation - Points

const\CD-
RW

< Construction_ID >-
Pts-Ult-RW.xml

"Export LandXML 
files" on the next 
page

Right-of-Way Monu-
mentation - Lines

const\CD-
RW

< Construction_ID >-
Ult-RW.dwg

"Export ACAD DWG 
files" on page 1889

Zip const folder for 
submittal

const
< Construction_ID >-
cdp.zip

"Create Zip file of 
ConstData folder for 
delivery" on 
page 1902
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Contractor data packet metadata sheet
Last updated: 2022-02-14

 WisDOT Civil 3D forms - WisDOT-C3D-ContrDataPack-Meta.docx

The Contractor Data Packet shall contain a metadata document that lists all files submitted. The pur-
pose of the metadata sheet is to provide the contractor with a list of all the exported design files that 
are being provided for the project. 

Fill in exported data file names in the Project File(s) column. Enter "NA" where no data is provided.

A Notes to Contractor - digital data text box is included to provide any written comments to the con-
tractor regarding any of the data files provided. These notes do not pertain to the Notes to Con-
struction that are sometimes provided on projects.

Attachment 1 - Explanation of the source and purpose of the exported data. 

Attachment 2 - Typical point codes used for surface breakline definition.

Geodetic references documentation
Last updated: 2023-05-17

Form dt1773.doc

The purpose of this documentation is to provide written documentation of the horizontal  datum, ver-
tical datum, and coordinate system used for the project.  This form serves as a check to ensure the 
plan title sheet information is correct and that the datum information is provided with the digital 
design data in the contractor data packet. See FDM 9-5-10 Standard Geodetic References for more 
information

Export LandXML files
Last updated: 2023-03-07

cntrctr-data-xprt-xml-01.mp4 6:59

Field Control Data - Survey control points

 1. Open drawing file < Project_ID >\base\SurvCtrl.dwg
 2. Output tab > Export panel > Export to LandXML

 A. Export to LandXML dialog box
 I. Click on the Uncheck All button

 II. Place a check mark in the box next to Point Groups
 III. LandXML version: 1.2
 IV. OK

 3. Browse to < Project_ID >\const\CD-BaseData
 4. File name =  < Construction_ID >-SurvCtrl.xml
 5. Save

Existing and Proposed surfaces
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Civil 3D exports 3D breaklines when exporting surfaces to LandXML. This makes existing LandXML 
surface files significantly larger. Only the existing surface triangles are needed to define the existing 
surface when imported in other software programs. All the proposed design breaklines provided to 
the contractor are only to be in the breakline.dwg file. 

The following workflow produces LandXML files for existing and proposed surfaces that contain only 
point and face data. 

Create a temporary DWG file

 1. Application menu icon > New
 A. Select C:\WisDOT\Stnd\C3D20XX\Templates\Begin-dwg\design-start.dwt
 B. Open
 C. You do NOT need to save this file.

 2. Data reference all required surfaces for the Contractor Data Packet. See WisDOT-C3D-Con-
trDataPack-Meta.docx for Contractor Data Packet requirements.

Export the LandXML file

 1. Output tab > Export panel > Export to LandXML
 A. Export to LandXML dialog box

 II. Click on the Uncheck All button
 III. Select the existing surface by placing a check mark in the box next to the sur-

face's name
 IV. LandXML version: 1.2
 V. OK

 2. Browse to < Project_ID >\const\CD-BaseData
 3. File name =  <Construction_ID>-Srfc-Ex.xml
 4. Save
 5. Repeat steps 1-4 for each design surface utilizing the naming conventions below.

Source Surface File Surface Exported LandXML file

Project ID\BaseData\Surf-
Ex.dwg

Exist
Project ID\const\CD-BaseData\ Con-
struction_ID-Srfc-Ex.xml

Project ID\Design\Sur-
faces\ Surf-Rfnt-All-
Datum.dwg

Rfnt-All-
Datum

Project ID\const\CD-Design\CD-Sur-
face\Construction_ID-Datum-Srfc-Const-
Stg.xml

Project ID\Design\Sur-
faces\ Surf-Rfnt-All-
Top.dwg

Rfnt-All-
Top

Project ID\const\CD-Design\CD-Sur-
face\Construction_ID-Top-Srfc-Const-
Stg.xml

Project ID\Design\Sur-
faces\ RuralDwy.dwg

Rfnt-All-
RuralDwy

Project ID\const\CD-Design\CD-Sur-
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Source Surface File Surface Exported LandXML file

face\Construction_ID-Top-Srfc-Rur-
alDwy.xml

Reference Line / Profile - Mainlines

This file includes all mainline and side road reference line and design profile data for the LET project.

When all project alignments and profiles are in one file

 1. Open drawing file < Project_ID >\dsgn\aliprof\AliProfXX.dwg
 2. Output tab > Export panel > Export to LandXML

 A. Export to LandXML dialog box
 I. Click on the Uncheck All button

 II. Select all the mainline reference alignments and design profiles by placing a 
check mark in the box(es) next to the name

 III. LandXML version: 1.2
 IV. OK

 3. Browse to < Project_ID >\const\CD-Design\CD-AliProf
 4. File name =  < Construction_ID >-AliProf-RL.xml
 5. Save

When project alignments and profiles are in multiple files

Create a temporary DWG file

 1. Application menu icon > New
 A. Select C:\WisDOT\Stnd\C3D20XX\Templates\Begin-dwg\design-start.dwt
 B. Open
 C. You do NOT need to save this file.

 2. Data reference all required alignments and profiles for the Contractor Data Packet. See 
WisDOT-C3D-ContrDataPack-Meta.docx for Contractor Data Packet requirements.

Export the LandXML file

 1. Output tab > Export panel > Export to LandXML
 A. Export to LandXML dialog box

 I. Select all the alignments and profiles by placing a check mark in the box next to 
the Alignment heading

 II. LandXML version: 1.2
 III. OK

 2. Browse to < Project_ID >\const\CD-Design\CD-AliProf
 3. File name =  < Construction_ID >-AliProf-RL.xml
 4. Save

Alignment / Profile - Edgelines
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Requirement: File includes the mainline and side road edge line alignments and design pro-
files used in the design of the project that are also included in the LET plan. Design alignments 
that do not have a corresponding profile should also be included.

Profile examples: curb return profiles, intersection islands

 1. Open drawing file < Project_ID >\dsgn\edgeline\Pavt.dwg
 2. Data reference any design edgeline profiles that are included in the LET plan

 A. Data shortcuts may need to be created in the source dwg if this has not already been 
done.

 3. Output tab > Export panel > Export to LandXML
 A. Export to LandXML dialog box

 I. Click on the Uncheck All button
 II. Select all the edge line alignments and design profiles by placing a check mark 

in the box(es) next to the edge line alignment's name and profile name.
 III. LandXML version: 1.2
 IV. OK

 4. Browse to < Project_ID >\const\CD-Design\CD-AliProf
 5. File name =  < Construction_ID >-AliProf-Pavt.xml
 6. Save

Proposed Point Data

This category includes points provided in plan detail sheet tables. 

Examples include intersection and curb ramp details. 

Other design points shown in the plan that are not in a table may be provided as well but are not 
required. Projects completed in Civil 3D 2019 and earlier are excluded from this requirement.

Tip: Multiple files may be exported in order to separate design point data by location.

Option 1 - Exporting drainage structure data when used as design layout points

To use this option, design point information was created using dynamic pipe network drainage struc-
tures. See the "Curb ramp detail sheet" on page 1439 workflow for more details.

Refer to the training documentation Contractor Data - Structures To Point LandXML to export point 
data.

Option 2 - Exporting COGO points

To use this option, design point information was created using static COGO points.

 1. Output tab > Export panel > Export to LandXML
 A. Export to LandXML dialog box

 I. Click on the Uncheck All button
 II. Select the applicable point group(s) by placing a check mark in the box next to 

the point group's name
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 III. LandXML version: 1.2
 IV. OK

 2. Browse to < Project_ID >\const\CD-Design
 3. File name =  < Construction_ID >-Pts-< Location Desc >.xml
 4. Save

Right-of-Way Monumentation - Points

Requirement: Consult with the person preparing the Traditional Right-of-Way plat or TPP to 
ensure the correct file(s) is exported.

Information included in this submittal is as follows:

 1. Project right-of-way points. This is a combination of the existing and proposed (FEE) right-of-
way points

 2. Permanent Limited Easement points
 3. Temporary Limited Easement points

Option 1 - Existing and proposed right-of-way points are stored in a single dwg file

 1. Open drawing file < Project_ID >\rw\dwg\Ult-RW.dwg
 A. Consult with the person preparing the right-of-way plat or TPP to ensure the correct 

file is exported.
 2. Output tab > Export panel > Export to LandXML

 A. Export to LandXML dialog box
 I. Click on the Uncheck All button

 II. Place a check mark in the box next to Point Group
 III. LandXML version: 1.2
 IV. OK

 3. Browse to < Project_ID >\const\CD-BaseData
 4. File name =  < Construction_ID >-Pts-Ult-RW.xml
 5. Save

Option 2 - Existing and proposed right-of-way points are stored in separate dwg files

 1. Open drawing file < Project_ID >\rw\dwg\ERW.dwg (Exiting right-of-way)
 A. Consult with the person preparing the right-of-way plat or TPP to ensure the correct 

file is exported.
 2. Output tab > Export panel > Export to LandXML

 A. Export to LandXML dialog box
 I. Click on the Uncheck All button

 II. Place a check mark in the box next to Point Group
 III. LandXML version: 1.2
 IV. OK

 3. Browse to < Project_ID >\const\CD-RW
 4. File name =  < Construction_ID >-Pts-ERW.xml
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 5. Save
 6. Open drawing file < Project_ID >\rw\dwg\PRW.dwg (Proposed right-of-way)

 A. This file has been prepared by the person preparing the right-of-way plat or TPP.
 7. Output tab > Export panel > Export to LandXML

 A. Export to LandXML dialog box
 I. Click on the Uncheck All button

 II. Place a check mark in the box next to Point Group
 III. LandXML version: 1.2
 IV. OK

 8. Browse to < Project_ID >\const\CD-RW
 9. File name =  < Construction_ID >-Pts-PRW.xml

 10. Save

Export ACAD DWG files
Last updated: 2023-01-03

Existing Surface - Boundary

Option 1 - Standard procedure

This workflow is intended for an existing surface file that has no other objects in it.

 1. Open drawing file <Project_ID>\base\Surf-Ex.dwg
 2. Prospector tab > Surfaces > Exist > Right-click > Surface Properties...

 A. Information tab
 I. Surface style = EX Border

 3. Left-click select the border of the Exist surface
 4. Surface Data Reference: Exist contextual ribbon > Surface Tools panel > Extract from 

Surface dropdown > Extract Objects
 A. Property - Border: selected
 B. OK

 5. See "Export Civil 3D files to AutoCAD format #xprt" on page 1892
 6. Exported file name and location: const\CD-BaseData\<Construction_ID>-Surf-Ex-

Bndry.dwg
 7. Close Surf-Ex.dwg without saving.

Option 2 - Alternative workflow - Create a new temporary DWG file for export

This workflow may be used when there is additional information in the surface file and it may be 
easier to create a temporary file to export the existing surface border.  

 1. Application menu icon > New
 A. Select C:\WisDOT\Stnd\C3D20XX\Templates\Begin-dwg\survey-start.dwt
 B. Open

 2. Data reference the existing surface used during design.
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 3. Prospector tab > Surfaces > Exist > Right-click > Surface Properties...
 A. Information tab

 I. Surface style = EX Border
 4. Left-click select the border of the Exist surface
 5. Surface Data Reference: Exist contextual ribbon > Surface Tools panel > Extract from 

Surface dropdown > Extract Objects
 A. Property - Border: selected
 B. OK

 6. Save the temporary file (example: const\Surf-Ex-Bndry for export.dwg)
 7. See "Export Civil 3D files to AutoCAD format #xprt" on page 1892
 8. Exported file name and location: const\CD-BaseData\<Construction_ID>-Surf-Ex-

Bndry.dwg
 9. Delete temporary dwg

Existing Topography - General

Typical source file: ProjID\base\Topo-Ex.dwg

Export the existing topography file used for the project's design and plans production.

See "Export Civil 3D files to AutoCAD format #xprt" on page 1892

Exported file name and location: const\CD-BaseData\<Construction_ID>-Topo-Ex.dwg

Existing Topography - Utilities

Typical source file: ProjID\base\Uti-Ex.dwg

Export the existing utility file used for the project's design and plans production.

See "Export Civil 3D files to AutoCAD format #xprt" on page 1892

Exported file name and location: const\CD-BaseData\<Construction_ID>-Uti-Ex.dwg

Proposed roadway features

Information included in this submittal are proposed physical features of the roadway which may 
include but are not limited to:

 l edges of pavement
 l shoulder edges
 l curb and gutter
 l barriers

Typical source file: ProjID\dsgn\edgeline\Pavt.dwg

Export the proposed roadway features used for the project's design and plans production.

See "Export Civil 3D files to AutoCAD format #xprt" on page 1892

Exported file name and location: const\CD-Design\<Construction_ID>-Pavt.dwg

Proposed structure horizontal features
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Information included in this submittal are proposed structure geometrics which may include but are 
not limited to:

 l structure roadway widths
 l sidewalk
 l parapets
 l abutments
 l wingwalls
 l piers
 l footings
 l does not include reinforcement details, piling locations, and girders

Warning: This export provides 2D representation of the approximate location of proposed 
structure(s). These graphics are for general reference and are not to be used for construction 
staking or structure layout.

Export the proposed structure horizontal features used for the project's design and plans pro-
duction.

See "Export Civil 3D files to AutoCAD format #xprt" on the next page

Exported file name and location: const\CD-Design\<Construction_ID>-Struct.dwg

Right-of-Way Monumentation - Lines

Consult with the person preparing the Traditional Right-of-Way plat or TPP to ensure the correct file
(s) is exported.

Information included in this submittal is as follows:

 1. Project right-of-way lines. This is a combination of the existing and proposed (FEE) right-of-
way lines

 2. Permanent Limited Easement lines
 3. Temporary Limited Easement lines

Option 1 - Existing and proposed right-of-way linear objects are stored in a single dwg 
file

Typical source file: <Project_ID>\rw\dwg\Ult-RW.dwg

Export the existing and proposed roadway right-of-way features used for the plat and plan pro-
duction.

See "Export Civil 3D files to AutoCAD format #xprt" on the next page

Exported file name and location: const\CD-RW\<Construction_ID>-Ult-RW.dwg

Option 2 - Existing and proposed right-of-way linear objects are stored in separate dwg 
files

Existing Right-of-Way

Typical source file: <Project_ID>\rw\dwg\ERW.dwg (Exiting right-of-way)
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Export the existing roadway right-of-way features used for the plat and plan production.

See "Export Civil 3D files to AutoCAD format #xprt" below

Exported file name and location: const\CD-RW\<Construction_ID>-ERW.dwg

Proposed Right-of-Way

Typical source file: <Project_ID>\rw\dwg\PRW.dwg (Proposed right-of-way)

Export the proposed roadway right-of-way features used for the plat and plan production.

See "Export Civil 3D files to AutoCAD format #xprt" below

Exported file name and location: const\CD-RW\<Construction_ID>-PRW.dwg

Export Civil 3D files to AutoCAD format #xprt

This workflow will export a Civil 3D drawing to a DWG with only AutoCAD objects in it. This is 
required because some software packages can import AutoCAD DWGs, but they cannot import Civil 
3D objects.

 1. Open DWG file to export. Files needing to be exported to AutoCAD DWG can be found in FDM 
19-10-43.5 Categories of Digital Data Exchange in Table 43.3

 2. App Menu  > Export > Export Civil 3D Drawing
 A. Export to file type: AutoCAD DWG
 B. External DWG references: Detach
 C. Files to export:

 I. Either Current Drawing Only or Selected drawings in source folder can be 
used. If a Civil 3D project folder contains multiple DWGs to export, the process 
can be run for multiple files at once.

 D. Include sheets: unchecked
 E. Export Setting dialog

 I. Export file type: AutoCAD DWG
 II. DWG file version: 2010

 III. Export feature lines as: 3D
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 IV. The label background scale factor for export sheets: Not used

 F. Source folder: Only used if Selected drawings in source folder is selected.
 G. Destination folder: Select appropriate subfolder in ConstData
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 H. Export

File selection and naming

 1. The selection method for ACAD export is based on user preference. To minimize the number 
of times the tool is opened for a given project, use the following options:

 A. File to export:
 I. Selected drawings in source folder: checked

 II. Include drawings in subfolders: checked
 B. Source folder: Civil 3D project folder

 2. Then select and export the appropriate Civil 3D DWGs for each appropriate subfolder in the 
ConstData folder. The design surfaces for ProjectID\ConstData\CD-Design\CD-Surface is 
the example shown in the above image. Repeat for each folder used by project data.

 3. File naming standards for ACAD DWG exports can be found in WisDOT-C3D-ContrDataPack-
Meta.docx. Using the Construction ID as a prefix and following file naming standards in 
WisDOT-C3D-ContrDataPack-Meta.docx will minimize file renaming.

Extract design surface breaklines
Last updated: 2022-08-30

Total video time: 33:09
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The table below is a summary of the files and surfaces that will be used to create the final deliverable 
breakline file.

The examples shown in the table below are based on the following:

 1. Project ID = 12345678
 2. Construction ID = 98765432
 3. Datum surface (Top surface would follow the same workflow)

WisDO-
T Civil 

3D 
tool

Input File
Input 

Sur-
face

Output File Output 
Created Purpose

Con-
tractor 
Data - 
Design 
Surface 
Data 
Extracto-
r

12345678\dsgn\s-
rfc\Srfc-Rfnt-All-
Datum.dwg

Rfnt-
All-
Datum

12345678\dsg-
n\srfc\ Srfc-
Rfnt-All-
Datum-
RawData.dwg

3D 
Polylines

Extract 
breaklines 
from 
refine-
ment sur-
face

Con-
tractor 
Data - 
Create 
Veri-
fication 
Surface

12345678\dsgn\s-
rfc\Srfc-Rfnt-All-
Datum-
RawData.dwg

Rfnt-
All-
Datum

12345678\dsg-
n\srfc\ Srfc-
Rfnt-All-
Datum-Veri-
fication.dwg

Rfnt-All-
Datum 
(data ref-
erenced)

Check 
extracted 
breakline 
surface 
matches 
design sur-
face

 --- --- ---

Rfnt-All-
Datum- 
FromBreak-
lines sur-
face

 

 --- --- ---

Rfnt-All-
Datum- 
Verification 
volume sur-
face
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Con-
tractor 
Data - 
Assign 
CDP 
Break-
line Lay-
ers

12345678\dsgn\s-
rfc\ Srfc-Rfnt-All-
Datum-Veri-
fication.dwg

NA

12345678\dsg-
n\srfc\ Srfc-
Rfnt-All-
Datum-Veri-
fication.dwg

Assign 
breaklines 
to new lay-
ers based 
on point 
code

Increase 
contractor 
under-
standing 
of what 
breakline 
represents

"Export 
ACAD 
DWG 
files" on 
page 18-
89

12345678\dsgn\s-
rfc\ Srfc-Rfnt-All-
Datum-Veri-
fication.dwg

NA

12345678\con-
st\CD-
Design\CD-
Surface\  
98765432-
Datum-Break-
lines.dwg

Basic 
AutoCAD 
dwg with 
no Civil 3D 
objects

Use in con-
tractor 
software

Extract and validate breaklines

cntrctr-data-xtrct-dsn-srfc-brkln-01.mp4 6:01

Tool Used: WisDOT Design tab > Output panel > Contractor Data dropdown > Contractor 
Data - Design Surface Data Extractor

Input file: <Project_ID>\dsgn\srfc\Refinement surface.dwg

Examples: Srfc-Rfnt-All-Datum, Srfc-Rfnt-All-Top

Output file: <Project_ID>\dsgn\srfc\<Refinement Surface>-RawData.dwg

Steps

 1. Open the refinement surface dwg file
 2. WisDOT Design tab > Output panel > Contractor Data dropdown > Contractor Data - 

Design Surface Data Extractor
 3. Design Surface Data Extractor dialog box (Example below is based on datum surface)

 A. Extract design surface data 
 I. Select design surface: < Refinement Surface >

 a. (Examples: Rfnt-All-Datum, Rfnt-All-Top)
 II. Select a drawing template: C:\WisDOT\Stnd\C3D20XX\Templates\Begin-

dwg\x-wisdot.dwt
 III. Specify a new drawing: <Project_ID>\dsgn\srfc\Srfc-<Refinement Surface>-
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RawData.dwg
 a. (Examples: Srfc-Rfnt-All-Datum-RawData, Srfc-Rfnt-All-Top-RawData)

 B. Validate extracted data 
 I. Specify a drawing created from extracting design surface data: Keep default of 

new drawing name
 C. Extract Data 

 I. Depending on the size of the data, the extraction and validation process may 
take some time.

Once the process is complete the drawing will open. Take some time to review the drawing, looking 
for anything unusual.

There should not be a large number of breakline segments on the LINE_NO_MATCH layers.

If Gradings were used to develop part of the surface definition, you will notice they are represented 
by the TIN edge of the grading surface. Grading breaklines cannot be extracted from Civil 3D, so the 
TIN edges will be used for the breakline deliverable in the areas created by Gradings.

Verify surface created from extracted breaklines

cntrctr-data-xtrct-dsn-srfc-brkln-02.mp4 7:40

The easiest way to verify that the extracted breaklines represent the design surface is to make a new 
surface from the extracted breaklines. Next, compare the new surface with the design refinement 
surface.

Tool Used:WisDOT Design tab > Output panel > Contractor Data dropdown > Contractor Data 
- Create Verification Surface

Input file: <Project_ID>\dsgn\srfc\Srfc-<Refinement Surface>-RawData.dwg

Output file: <Project_ID>\dsgn\srfc\Srfc-<Refinement Surface>-Verification.dwg

The output file contains 3 surfaces:

 1. Design Surface
 A. Data referenced
 B. Style = _No Display

 2. < Design Surface > - FromBreaklines
 A. Surface created from selected breaklines and boundary
 B. Style = P_Triangles

 3. < Design Surface > - Verification
 A. Volume surface 

 I. Base surface = Design Surface
 II. Comparison surface = surface from breaklines

 B. Style = Elevations 
 I. The analysis ranges are set for elevations less than 0.01 foot and greater than 

0.01 foot.
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The Create Verification Surface tool is run from the breakline raw data file. It copies the pertinent 
breakline and boundary data into a new file and creates a new surface from that data. The design 
surface is data referenced into the drawing and a verification surface is created (volume surface) to 
compare the design surface and breakline surface.

Steps:

 1. Open <Project_ID>\dsgn\srfc\Srfc-<Refinement Surface>-RawData.dwg
 2. WisDOT Design tab > Output panel > Contractor Data dropdown > Contractor Data - 

Create Verification Surface
 A. Create Verification Surface dialog box 

 I. Design Surface: Refinement surface (Example: Rfnt-All-Datum, Rfnt-All-Top)
 II. Design Surface Data Extractor File: checked (if WisDOT Design Surface Data 

Extractor was used to extract breaklines)
 III. See Contractor Data - Create Verification Surface for more information
 IV. OK
 V. CLOSE

 3. Save newly created file as <Project_ID>\dsgn\srfc\Srfc-<Refinement Surface>-Veri-
fication.dwg

Analyze surface created from extracted breaklines

cntrctr-data-xtrct-dsn-srfc-brkln-03.mp4 5:57

Review file:<Project_ID>\dsgn\srfc\Srfc-<Refinement Surface>-Verification.dwg

The surface styles in the Verification.dwg are automatically set by Create Verification Surface tool.

The solid red areas appearing in the volume surface are locations where there is a 0.01 ft or greater 
difference between the breakline surface in the Verifcation.dwg and the original design surface in 
the Refinement surface.dwg.

A common sense approach must be used to determine if there are areas that actually need to be 
edited in the breakline file since the surface tolerance being evaluated is only 0.01 ft.

 1. First, check for areas that are within the subgrade shoulder points. In most cases, the red 
areas appear based on the way the surface triangulates. To check if the breaklines produced 
a valid surface, perform a swap edge command on the TIN edge of the < Design Surface > - 
FromBreaklines surface.

 A. Check that the volume surface, < Design Surface > - Verification, is set to Rebuild-Auto-
matic

 B. Select the < Design Surface > - FromBreaklines surface
 C. Tin Surface: < Design Surface > - FromBreaklines contextual ribbon > Modify 

panel > Edit Surface > Swap Edge
 D. The color from the volume surface should disappear. If it does not, further 

troubleshooting of the breaklines may be needed.
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Tip: The Design Surface Data Extractor includes a custom tooltip toggle. This button will trigger 
a detailed tooltip for each breakline that displays additional information about its origin.

Breakline extraction troubleshooting

cntrctr-data-xtrct-dsn-srfc-brkln-04.mp4 7:00

 1. Once the areas within the subgrade shoulder points have been reviewed, view the Volume 
Surface properties.

 A. Prospector tab > Right-click < Design Surface > - Verification surface > Surface 
Properties > Statistics tab > General

 B. Observe the minimum and maximum elevation. 
 I. These are the maximum deviations between the design surface and the 

FromBreaklines surface.
 II. Do they seem reasonable for areas outside of the subgrade shoulder points?

 C. To examine where these differences are occurring, a contour style can be applied to 
better evaluate potential problem areas. 

 I. Prospector tab > Right-click < Design Surface > - Verification surface > Sur-
face Properties > Information tab

 a. Surface style: P Contours 2' Major:0.5' Minor
 2. Turn on the LINE_NO_MATCH layer in the <Project_ID>\dsgn\srfc\Srfc-<Refinement Sur-

face>-RawData.dwg

 A. Was a needed breakline placed on the LINE_NO_MATCH layer and not included in the 
< Design Surface > Rfnt-All-XXX-FromBreaklines surface?

 B. Maybe a breakline's missing in a crucial location.
 C. Maybe the extractor's validation process deleted a line that shouldn't have been 

deleted.

Tip: The Design Surface Data Extractor includes a custom tooltip toggle. This but-
ton will trigger a detailed tooltip for each breakline that displays additional 
information about its origin.

 3. If for some reason, the Extract Design Surface Data utility removed a valid breakline during 
the extraction process, that missing breakline can be obtained manually from the source.

 A. Extract a corridor feature line as a 3D polyline 
 I. Corridor contextual ribbon > Launch Pad dropdown > Polyline from Cor-

ridor
 a. CREATEPOLYLINEFROMCORRIDOR Select a corridor feature 

line:select desired feature line
 b. Enter

 II. Select created 3D polyline > Right-click Clipboard > Copy
 III. Go to <Project_ID>\dsgn\srfc\Srfc-<Refinement Surface>-Verification.dwg
 IV. Right-click Clipboard > Paste to Original Coordinates
 V. Select the 3D polyline
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 VI. Home tab > Modify panel dropdown > Break
 a. edit the polyline as needed

 VII. Add the 3D polyline to the Rfnt-All-XXX- FromBreaklines surface.
 4. Perfectly vertical triangle legs cannot be created in DTM surfaces. A slight offset of 0.01 feet 

can be used to create near vertical surface features. This should be done in the source cor-
ridor by adding or modifying the subassemblies in that location.

 5. You may notice areas where breaklines have gaps. If the gaps are small enough where they 
do not impact surface triangulation, they are ok.

Assign CDP breakline layers and export breaklines for delivery

cntrctr-data-xtrct-dsn-srfc-brkln-05.mp4 6:19

Assign CDP breakline layers

Tool Used:WisDOT Design tab > Output panel > Contractor Data dropdown > Contractor Data 
- Assign CDP Breakline Layers

Input file:<Project_ID>\dsgn\srfc\Srfc-<Refinement Surface>-Verification.dwg

Output file:<Project_ID>\dsgn\srfc\Srfc-<Refinement Surface>-Verification.dwg

Use the Contractor Data - Assign CDP Breakline Layers to assign the design surface data to layers 
that represent the features for the contractors.

Export breaklines for delivery

Tool Used: Output tab > Export panel > Export Civil 3D Drawing

Input file:<Project_ID>\dsgn\srfc\Srfc-<Refinement Surface>-Verification.dwg

Output file: <Project_ID>\const\CD-Design\CD-Surface\<Construction_ID>-<Surface>-Break-
lines-<Const-Stg>.dwg

List of exported surface breaklines for CDP:

 l Datum-Breaklines
 l Top-Breaklines
 l Top-Breaklines-RuralDwy (if applicable)

Steps

 1. In the Verification.dwg file, set all surfaces to No Display.
 2. See "Export ACAD DWG files" on page 1889 on how to export the Verification.dwg.
 3. Save file as const\CD-Design\CD-Surface\<Construction_ID>-<Surface>-Breaklines-

<Const-Stg>.dwg
 4. The exported dwg file contains breaklines and the surface boundary.

Export alignment superelevation data
Last updated: 2022-08-29
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Total video time: 4:33

cntrctr-data-xprt-ali-supr-data-01.mp4 4:33

Civil 3D 2020 and later – export to xlsx

Alignment superelevation information is exported to an Excel spreadsheet instead of using the CSV 
export button in superelevation tabular editor. 

See Contractor Data - Superelevation Report for more information.

Civil 3D versions prior to 2020 – export to csv

Export alignment superelevation CSV files

 1. Open drawing file with alignment to export
 2. Select the centerline alignment graphically.
 3. Contextual ribbon > Modify > Superelevation pulldown > View Tabular Editor
 4. Tabular Editor panorama > Export Superelevation Data icon
 5. In the Export to CSV dialog browse to the project 12345678\const\CD-Design\CD-AliProf and 

type in the filename  < Construction_ID >-Super-Ali-< Ali Name >.csv
 6. Save

Clean up alignment superelevation csv file

Info: If your design has no  "inside" lanes or shoulders (non-divided design) you will need to  
delete extra columns from the csv file.

 1. Open file 12345678\const\CD-Design\CD-AliProf\< Construction_ID >-Super-Ali-< Ali Name 
>.csv

 2. Review this file. It had superelevation data for both the outside lanes and shoulders as well as 
the inside lanes and shoulders. Nothing needs to be cleaned out of this file.

 3. Open file Superelevation Example.CSV
 4. Select the Column G header (Left Inside Lane) then CTRL + select following columns:

 A. Column H (Left Inside Shoulder)
 B. Column K (Right Inside Lane)
 C. Column L (Right Inside Shoulder)
 D. Right-click > Delete to remove columns.
 E. Save 

Export cross section slope stake files
Last updated: 2022-08-30

Create cross section slope stake reports for all proposed Datum surfaces in the plan.

cntrctr-data-xprt-xs-slp-stk-01.mp4 3:13
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Civil 3D 2020 and later

This report creates an .xlsx file of breakpoints on a surface along the sample lines of an alignment.

See Contractor Data - Slope Stake Report for more information.

Civil 3D versions prior to 2020

Tool Used: Toolspace > Toolbox tab > WisDOT Toolbox > WisDOT Reports > Other Reports > 
right-click on Slope Stake > choose Execute

Input file: < Project_ID >\dsgn\qty\ewrk\Earthwork-< Ali >-< Comment >.dwg

Output file: < Project_ID >\const\CD-Design\CD-X-Section\ < Construction_ID >-Slp-Stk-< Ali >-< 
Const-Stg >.csv

The Slope Stake report requires a drawing that has:

 l an alignment
 l sample lines
 l a surface

Tip: If any of these are data shortcuts and the report does not work, save a copy of the file, pro-
mote the objects, and run the report from the copy drawing.

Steps

 1. Open drawing file 12345678\dsgn\qty\ewrk\Earthwork-STH25.dwg
 2. Slopestake Report dialog box

 A. Baseline Alignment: STH25
 B. Sample Line Group: SLG-STH25
 C. Surface: Rfnt-STH25-All-Datum
 D. File name: Browse, 12345678\const\CD-Design\CD-X-Section\98765432-Slp-Stk-

STH25.csv
 E. Create Report

If the Excel file opens, review it then close it.

Copy earthwork data spreadsheet
Last updated: 2022-02-14

This file is the tabular data included in the plan’s computer earthwork data sheets.

Tool Used: Create copy of the file using File Explorer/Excel

Input file: < Project ID >dsgn\qty\ewrk\spreadsheet used at the beginning of Section 9 in plan.

Output file: const\CD-Design\CD-X-Section\ < Construction_ID >-EWK-< Ali >-< Const-Stg >.xlsx

Create Zip file of ConstData folder for delivery
Last updated: 2022-08-30
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The Contractor Data Packet files shall be zipped into a single file and named < Contruction ID >-
cdp.zip. The Civil 3D project subfolder const should be the top folder within the zip file. 

Submit the .zip file using the lowest construction ID when multiple construction IDs are shown on a 
single title sheet.

 1. Make sure all files included in the Contractor Data Packet are closed.
 2. WisDOT Civil 3D Apps > Project Cleanup tab > Include Folders > Add

 A. < Project ID >/const folder
 I. OK

 B. Check file types to be removed
 I. BAK

 II. DWL
 C. Remove Files

 I. OK
 3. Right-click Windows Start button (lower left of screen) > File Explorer
 4. Browse to the project < Project ID >/const folder
 5. Right-click on the const folder > Send to > Compressed (zipped) folder
 6. In the file name field type < Construction_ID >-cdp.

 A. Example: A project with a construction ID of 00000000 shall be submitted as 
00000000-cdp.zip.

Run CDP Integrity Report
Last updated: 2022-08-29

Total video time: 3:29

cntrctr-data-run-intgrty-rprt-01.mp4 3:29

Tool Used: WisDOT Design tab > Output panel > Contractor Data dropdown > Contractor Data 
- CDP Integrity Report> 

Input file: <Project_ID>\const\00000000-cdp.zip

Output file: <Project_ID>\const\00000000-cdp-CDPIntegrityCheck.xlsx

The CDP Integrity Report does not check that all the required files have been submitted, it just 
checks that the files have been exported properly. The Integrity Report is not included with the CDP, 
it is just for the designer’s use before esubmitting the packet.

See Contractor Data - CDP Integrity Report for more information report details.

eSubmit Contractor Data Packet
Last updated: 2022-02-14

The designer shall submit the entire Contractor Data Packet (00000000-cdp.zip) through the eSub-
mit system.

See FDM 19-10 PS&E Transmittal and Composition for information on esubmitting project files. 
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See FDM 19-10-43.2 PS&E Transmittal and Composition for Contractor Data Packet submittal sched-
ule.

Design model standards
Design model standards blog
Last updated: 2020-10-26

Subscribe link to Design/Construction Integration listserve

Welcome to WisDOT's design model standards blog page. Methods Development will use this page 
to share information about proposed updates to design model delivery requirements.  On this page 
we will provide status updates on our effort to restructure design model standards. We will also 
share common questions and comments we receive about our new standards concept and our reac-
tions to those comments.

Our goal in restructuring design model delivery requirements is to establish the appropriate role for 
3D roadway design activity and deliverables in WisDOT's roadway project delivery environment.  To 
achieve this vision, we are developing a system of standards that:

 1. Establishes a flexible standards framework that can be adapted to various project situations.
 2. Allows Region offices to make decisions within the flexible framework of standards to determ-

ine the appropriate design model development effort scope for their projects
 3. Clearly communicates design model content and level of detail expectations.

At the foundation of the updated design model standards concept is the Design Model Features 
Example Library.  The 3D objects in this library will  bring significant improvements to the com-
munication of content expectations of our design model deliverables.

For detailed information about our new design model standards concept, please watch "Design 
model standards update" on page 1916.  "Design model standards update (part 1) #design" on 
page 1916  is a general overview of our goals and the proposed system of standards to help us 
achieve those goals. "Design model standards update (part 2) #design2" on page 1920  explores the 
new system in greater detail, and discusses the anticipated benefits this change will bring to 
WisDOT's roadway project delivery environment.  Links for sending us comments and feedback are 
provided at the conclusion of each video.  Don't forget to check back here for status updates and 
shared perspectives.

Please send design model standards comments to brad.hollister@dot.wi.gov.

2019-01-29 #20190129

On December 12, 2018, MDU led an ACEC Civil 3D Users Group webinar discussion about WisDOT 
design model standards.  ACEC has posted a recording of that discussion, the link to that video is on 
ACEC Wisconsin Civil 3D Users Group webpage.

The design model discussion covers topics such as:
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 l Design model standards goals
 o "Right-sizing" the 3D design effort
 o Improve communication of design model delivery expectations
 o Address the over-extended role of roadway design

 l Model features example library overview and utilization concepts
 l Guiding principles for defining Base Level of Detail (Base LOD) standards.  These include:

 o Reduced model detail expectations, but retain high value detail
 o Require detail with high communication value of engineering design concepts
 o Require detail that benefits construction, option detail that benefits design
 o Develop sufficient detail to ensure geometric constructability

 l A close examination of the DRAFT Base LOD Sill Abutment model example, and discussion 
about how the guiding principles of defining Base LOD are incorporated into this model 
(Note:  DRAFT Base LOD Sill Abutment model example files will be available for download 
from the WisDOT C3DKB in February 2019)

Design model roundtable, ACEC Civil 3D Workshop 2018 

Last updated: 2018-10-30

MDU recently led a roundtable format discussion on our Design Model standards proposal with 
attendees of the ACEC Wisconsin 2018 Civil 3D User Group Workshop on October 22, 2018.  Prior to 
the workshop, the ACEC Civil 3D Committee facilitated a review of the Design Model Standards pro-
posal and sent MDU the resulting questions and comments from ACEC membership.  The focus of 
the October 22nd discussion was the ACEC comments, and MDU's reactions to those comments.  
Today's Design Model standards blog entry is a summary of the roundtable discussion.
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Tip: MDU would like to send a big Thanks to everyone who participated in the pre-conference 
review, and also to those who participated in the roundtable discussion.  Your feedback is 
appreciated and very much needed as we work towards our goal of finding the best, most 
appropriate uses of 3D Design practices on WisDOT roadway projects.

Opening comments from MDU

One concept addition to the Design Model standards proposal since the release of the videos in 
early September is the idea of releasing model feature examples as guidance initially, for an 
undetermined amount of time.  A guidance period will give us time to see how effective the 
examples are in practice, and identify additional needs for the implementation.  Because the model 
feature example library concept fits and is fully functional within today's Design Model standards.  
We may find we are able to fully realize the benefits we are trying to achieve with the Model Feature 
Example Library during a guidance status period, and this approach will allow us to build out the 
example library more quickly.

If you haven't heard about our "Design model standards update" on page 1916, please review it in 
the C3DKB, the comments and responses below will be more meaningful if you understand the 
concept proposal.  You may also find the "Contractor data packet overview" on page 1878 to be help-
ful background information, in particular the discussion about purpose and intended uses of Con-
tractor Data Packet content including Design Models.

ACEC Comment #22 (Civil 3D project delivery requirements):

On a side note, is WisDOT still committed to requiring one delivery platform?  Why not allow 
consultants to use a delivery platform that is compatible with WisDOT to provide con-
sultants with the opportunity to be as efficient as we can be with the delivery platform that 
we prefer.  In general our firms experience with C3D has been absolutely frustrating!  It is 
costing us significant amounts of time, of which WisDOT is not compensating us for.  WisDOT 
is looking for project efficiencies in every aspect of project delivery at this time.  One of the 
most significant efficiencies that could be realized immediately by WisDOT would be to dis-
continue dictating the use of C3D and allow a consultants to deliver the program more effi-
ciently with delivery platforms that are compatible with each other.

The Civil 3D Project Delivery Requirements conversation topic is outside the scope of the Design 
Model standards discussion.  However, since we received the comment, MDU would like to respond 
by saying we think we should reexamine the reasons why Civil 3D Project Delivery requirements 
were implemented, assess status of our implementation goals and status of the industry in regard to 
those goals, and revisit that conversation with the roadway design community.  Preparation for, and 
execution of, that type of process is going to require attention and effort from MDU, and we will 
have to fit it into our workload.  Right now our higher priority is to make additional progress with this 
design model standards effort.  To be clear, we are not saying we think WisDOT needs to make a 
policy change, we are saying it would be beneficial to revisit the conversation, and we will make pre-
parations to do that at a future date.
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ACEC Comment #1 (model features example library):

Who is generating the Roadway Model Library (will ACEC members need to be involved in 
this effort?)

MDU has primary responsibility for model example library development, and the roadway design 
community will have opportunities to contribute to the development of it.  Most, probably all, Base 
LOD examples will be manufactured by MDU, and distributed in draft status for Region and industry 
comment.  We will compile comments received and share our reactions to that input through the 
form of status updates on our Design Model Standards blog page in the C3DKB.  Furthermore, ini-
tially completed Base LOD model examples will progress from draftstatus to guidancestatus after 
initial waves of review and commenting are addressed.  We will monitor effectiveness and feedback 
comments while examples are in guidancestatus for an undetermined period of time.  Our goal is to 
achieve standards status ultimately, but it is too early in the process to set a timeline for that final 
step.  The model example library concept should be very effective at achieving the goals we've set for 
it while in guidancestatus.  Time and project experiences will help us determine when, or even if 
standardsstatus is a necessary step.

Roadway design community involvement, including consultants, won't be limited to review and com-
menting though.  Once we have some initial examples released for review, we'll put out an open 
request for submission of Advanced Level of Detail (LOD) model examples.  Industry participation will 
help us meet the Advanced LOD example needs of the Model Features Example Library more 
quickly.  We'll standardize the examples we receive from the design community and redistribute 
them as draftproposals for industry comment.

ACEC Comment #4 (model features example library):

How was the feature list generated (is there room for adding/removing items/ different 
levels of detail?)

Absolutely.  We'll get a few draftmodel feature examples released, and that will help deepen every-
one's understanding of how the library will function.  Following that we will publish our full list of fea-
tures we intend to develop in the model feature example library, and anyone is welcome to send us 
their suggested additions.  The library content can be added to at any time, but it will take time for 
the library to build out to a mature state.

Once the library is put into practice, we need to be careful about removing items.  We don't want to 
affect projects mid-stream that may have incorporated example concepts, but certainly adding to 
the features represented in the library and improving current examples with new versions will be an 
absolute necessity if WisDOT is going to find the best role for 3D Design practices on our projects.  
We expect design model deliverables will be an evolving concept, it is not something that will remain 
static after initial implementation.  We expect construction project needs will evolve, design systems' 
capabilities will evolve, and the model feature example library must stay current with those industry 
changes.
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ACEC Comment #18 (model features example library):

Please consider providing one example of a feature and what it looks like at each level of 
detail. The level of effort versus level of detail is not linear based on the feature. An 
example, a low level of detail vs high level of detail for physical gores differs by a lot of 
effort. Low level of detail vs high level of detail for a simple/basic stretch of roadway (no 
curves, no superelevation, no beamguard, etc.) doesn't differ by much effort.

MDU agrees, level of effort is a complex question that will be vary for each type of feature, and will 
also vary by specific project situations.  We should be able to identify general trends in effort levels, 
but hourly effort estimates will be difficult to determine and are not something MDU will develop 
with initial model feature example library releases.

MDU is working on Base Level of Detail (LOD) models now, and the first draftexample release will be 
TOP and DATUM surface models at an overpass structure abutment.  With this initial DRAFT release 
of an abutment Base LOD model example, MDU will also develop an Advanced LOD model version to 
be used as a comparison.  We will add more features to the library in the upcoming months, they will 
be released with their associated documentation incrementally as soon as each feature is ready.

ACEC Comment #5 (model features example library):

How do you determine what's basic and advanced, what features, models will look like?  (The 
Model Library will probably play a role?)

The model example library and its supporting documentation will be our means of communicating 
that.  Initial instance of draftBase LOD model feature examples are proposed by MDU, and will 
receive comments from an open review process.  We are hoping to receive roadway design com-
munity and Construction Industry feedback before examples progress from DRAFT to GUIDANCE 
status.

ACEC Comment #9 (model features example library):

Model Examples Linked to the Spreadsheet both DWG and PDF could be helpful for gauging 
what will be needed.

We agree.  PDF or some other means for non-Civil 3D users to be able to navigate model space and 
review the 3D objects, ideally without any special software install.  MDU is working on that.

DraftBase LOD examples will generally include the following:

 l FDM Contractor Data Packet deliverables:
 o Surface models in LandXML
 o Surface model breaklines in ACAD DWG
 o Surface model boundaries in ACAD DWG
 o Surface model 3D Faces (TIN) in ACAD DWG
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 l Additional information for review convenience:
 o Civil 3D Design Data that produced the example

Info: 
 n The Civil 3D design data is provided for informational purposes only, it 

is not intended to convey Civil 3D project delivery requirements or 
design model delivery requirements.

 n Workflows used in the development of the model feature example may 
not be consistent with the latest and best MDU workflow recom-
mendations.

 n Content and structure of the Civil 3D design data is not consistent with 
Civil 3D project delivery requirements, all model feature example design 
data will usually be delivered in a single Civil 3D DWG file.  The design 
data is structured this way for convenience of sharing source data of 
our model feature examples.

 o Surface model contours in ACAD DWG
 o Surface model contours in 3D PDF
 o Surface model breaklines in 3D PDF
 o Surface model boundaries in 3D PDF
 o Surface model 3D Faces (TIN) in 3D PDF
 o Example Documentation

 n Base LOD documentation to identify critical design elements with background 
information

 n Advanced LOD documentation to include suggested purpose of advanced level 
of detail in specific types of project situations (why should a design team con-
sider the elevated level of detail in design model scope?)

ACEC Comment #2 (design model scoping):

How will people scoping and reviewing project contracts be trained?  (C3D KB Videos?)

Design contract scoping and negotiation is outside MDU's area of responsibilities and expertise.  
MDU must involve Regions, BPD Consultant Services Section, and perhaps additional stakeholders 
within the Department in the identification of training needs and determination of how to best meet 
those needs.  We have not done that yet, it is a future need to address during this effort.

MDU intends to develop guidance documentation articles for advanced LOD model examples that 
describe the benefits of different elements of advanced LOD in the example and what types of pro-
ject situations they are appropriate for.  That type information is something MDU is in a good pos-
ition to develop, and although it probably isn't the full solution that is needed, it will be an important 
and necessary part of the solution.

ACEC Comment #17 (design model scoping):

We like the idea of standardizing what features should look like, but have concerns with 
level of detail vs. level of effort interpretation.  It's dangerous to think that a lower level of 
detail may require a lower level of effort, which intern will be interpreted to mean 
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faster/cheaper by WisDOT PM's. Just because a low level of detail may be appropriate for a 
project doesn't necessarily correlate with a low level of effort. Cookie cutter roads and inter-
sections are a low level of effort regardless of the level of detail because the program and 
workflows work as they are intended. Most designs though are not cookie cutter.  Consider 
construction staging, it isn't necessarily a feature but increases the level of effort and model 
complexity.

We agree with this comment. Project situations must be considered when estimating design effort. 
Roadway design is not cookie cutter.   An Advanced Level of Detail (LOD) model feature rep-
resentation may require less effort to design than what is required for Base LOD models (for the 
same feature) on other projects. And best application of design workflow concepts can substantially 
change for the same feature from one project to the next, there is no one way to develop the design 
that is best for all circumstances.  This is a great comment, insightful.

Level of effort is not something MDU is estimating in the initial development of model feature 
examples.

Level of effort estimating will need to consider many things.  For example, simply estimating effort to 
develop a feature's representation in the design model doesn't factor design process benefits that 
can be realized by developing some features to greater levels of detail.  A curb ramp model requires 
effort and has limited uses in construction, but it can be an overall net gain in design process effi-
ciency when factoring in the effort to develop curb ramp construction details.  We think experienced 
designers will naturally do the design work in the best manner to support design process needs, and 
the Design Model deliverables shouldn't mandate extra model detail if the benefit is mostly on the 
design side.

ACEC Comment #19 (design model purpose):

Has there been any communication with the construction industry as to if the design mod-
els are actually used, and if so, to what level of detail they are being used?  I've personally 
talked with a couple contractor's and they have indicated they are NOT using the models 
provided by WisDOT design and are creating their own models to fit their needs.

Every contractor has their own approach, there is no single way to achieve their goal of greater effi-
ciency in construction operations.  They are using different methods, they are innovating com-
petitively.  There will always be specific contractors with differing opinions and philosophies, or 
specific project situations that are contrary to general industry trends, so we would never argue with 
anyone who has heard that perspective from one of our contractors or has had the type of project 
experience that the commenter is describing.  We are speaking to industry trends, and there will 
always be specific project experiences that are contrary to the general trends.

Regarding the first part of the question, asking if we have received input from the construction 
industry, the answer is Yes.  We have been fortunate to be able to work with multiple WisDOT con-
tractors, industry organizations, construction equipment vendors, and construction/contractor 
focused software developers over the past 10 years.  We always have an open door for any con-
tractor, equipment vendor, software developer, or other industry resource who would like to discuss 
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our digital design deliverables, we are not trying to be exclusive with this type of interaction, we wel-
come it.

We've enjoyed a strong partnering relationship with WisDOT contractors who have volunteered their 
time to work with us on this effort, helping us understand what types of design information is most 
useful to their operations, and what formats for that information are easiest for them to use.  Much 
of our engagement has been with earthwork contractors as the dominant use of design model data 
on our projects is in earthwork and aggregate placement operations.  These interactions have ranged 
from remote questionnaires with written responses, to full day in-person meetings at contractors' 
offices with opportunities to see WisDOT design model deliverables used in contractor software for 
project analysis, construction model development, QC, and related types of activity.

Regarding the second part of the question, asking how (or if) our digital design data is being used, 
that answer depends on the contractor you talk to.  Speaking to general industry trends, the 
instances of WisDOT design models being used directly in AMG operations are not common.  The 
name we used for that direct use of design models concept was "100% Construction Ready Surface 
Models", and that was a goal for our design model implementation when it was first announced in 
2011.  Early feedback from contractors and project experiences convinced us that is the wrong pur-
pose for design models in our project environment, and the 100% Construction Ready concept is no 
longer a WisDOT goal.  The Base LOD model examples that define statewide delivery requirements 
will generally not be used directly in construction operations, they do not have enough design detail 
to be used in most contractors' AMG operations.

Our intended use for design models, and all contractor data packet information generally falls under 
3 categories.  1) pre-bid and post-bid project analysis and planning, 2) construction model devel-
opment and QC, and 3) construction staking.  We encourage anyone who may be looking for more 
information on the intended uses of our Contractor Data Packet content, including Design Models, to 
review "Contractor data packet overview" on page 1878 in the C3DKB, found under "Digital data" on 
page 1877.

ACEC Comment #20 (design model purpose):

The text discusses using the design model for AMG. Has this been tested/attempted with 
C3D?  We have staff in Illinois that are having trouble with processing the data needed for an 
AMG ready surface on an Illinois Tollway project, using MicroStation.   They basically need 
cross section "cuts" every 2-inches along the entire corridor. Horizontal and Vertical tangent 
sections process quickly, but as soon as curvature is introduced, specifically vertical 
curvature, the processing is very slow and time consuming.  Our experience has been that 
microstation is much faster than C3D so we can only imagine how much time this pro-
cessing may take in C3D.

We are interpreting this comment to be based on the idea of direct use of the Design Model in AMG 
operations, the 100% Construction Ready Surface Model concept.  It was not our intention to com-
municate that as the purpose of Design Models in the design model standards videos.  We were think-
ing that way 7 years ago, but we are thinking about it differently now.  We will not be requiring full 
roadway Design Model deliveries developed to that level of detail, we believe that practice is not a 
good fit for our project environment. Contractors needing that type of model detail for their 
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operations can use our Design Models as a platform to build construction models from, or as a 
source of data for QC of their construction models, and those are the types of AMG uses of our 
Design Models that we've encountered most often.

ACEC Comment #16 (design model scoping):

It seems the guidance leaves a lot to interpretation.  Thus the WisDOT Project Manager may 
have different expectations than the Consultant at the time of scoping the project.  Scoping 
and fee development will be critical because of this.   Has there been consideration for remov-
ing this "individual interpretation" to provide "standard guidance" such as creating a matrix 
of anticipated modeling effort to help WisDOT and Consultant Project Managers understand 
the hours to be scoped for various levels of design models?

As a scoping aid, MDU will develop a simple matrix that lists model feature scope options with links 
to our C3DKB guidance documentation, this MDU guidance will not estimate design effort levels.  We 
hope to receive feedback when our scoping aid and additional guidance is put into practice, and we 
will consider how well things are working and continue to refine the system and develop additional 
guidance information based on the feedback we receive.  We expect immediate process improve-
ment with the model example library concept, we don't want to wait for the effort level estimating 
solution to be developed before we realize the benefits of better definition of deliverables through 
the example library.

In addition to the MDU guidance, we have future plans to incorporate estimated effort levels that are 
coordinated with the example library into the MasterWorks work breakdown structure for design 
contract negotiations.

ACEC Comment #6 (QA, QC, and design delivery acceptance):

Who is checking models after submitted?  Now that we will know what level of detail is 
needed we still need to validate it.

There is no formal review process for acceptance in place.  It would benefit this implementation if we 
were to establish a review process for design deliveries, and Regions may choose to consider that, 
and we would help and support them if they did.  The Bureau of Project Development is not con-
sidering applying resources for statewide review and acceptance of Design Model deliveries on a pro-
ject by project basis.  However, a model review and acceptance program will be easier to establish 
with improved definition of deliverables, so the Model Example Library implementation work is a pre-
requisite to that sort of program.

MDU has developed QC guidance for design project team review of their own work.  That doc-
umentation is  at "Civil 3D QC surface checklist" on page 866, and may need updating to remain con-
sistent with concepts introduced by the Design Model standards implementation.  The QC guidance 
will be updated as needed as we progress in this implementation.
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ACEC Comment #3 (design model scoping):

We envision the Consultant taking the first stab at what deliverables will be needed during 
contacting?  Review and Revise with DOT Staff?

Regions, Consultant Services Section, and perhaps other stakeholders need to get involved in that 
conversation.  Other groups within the Department will need some time to get familiar with the 
Design Model standards proposal, they haven't had an opportunity to work with us on this concept 
yet.

ACEC Comment #10 (design model scoping):

Is there a way to expediate the contracting spreadsheet, tying overall project type to a min-
imum level of detail for the items needed.

We've considered mapping Design Model scope to project type, but we struggled with defining a pro-
ject type based standard in a way that provides the needed flexibility.  Tying Design Model scope to 
project situations that consider anticipated construction operations, environmental sensitivities, chal-
lenges of design fit into existing condition, etc. just worked better for our goals of applying 3D Design 
processes to our project environment.  We believe a feature-based approach to defining design 
model scope will allow project teams to be more effective in prescribing the appropriate amount of 
design effort to the variety of project situations encountered on projects of the same improvement 
type.

ACEC Comment #11 and #12 (design model scoping):

Contract Spreadsheet looks a lot like the Utility Spreadsheet (which was cumbersome at 
first but now used all the time!)

Delivery Model Examples will need to happen in conjunction with the spreadsheet.

We haven't developed a Design Model scoping aid yet, the slide displayed in the Design Model stand-
ards video was showing something that was quickly developed to communicate a concept.  We're not 
sure what a Design Model scoping tool will look like yet, or the details of how it will be used, but we 
absolutely agree it must be synched with model example library content.

ACEC Comment #14 (design model scoping):

Part 1 of Videos: If the standards are set during scoping process, what happens if the con-
tractor or region reviewers request additional detail? Modifying the model could be very dif-
ficult and time consuming at the end of a project.

That would be a project team discussion as to how to handle, and existing policies and practices for 
design contract administration would apply.  Our scoping process aids and model example library 
will benefit those situations because of the added documentation and better definition of initial 
design delivery expectations.

We agree that in most cases the overall design effort will be less work if the need for higher levels of 
detail in model elements are identified early in the design process.  Late design model scope changes 
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that increase level of detail may require rework and an overall greater design effort than when the 
higher level of detail scope is set early.

ACEC Comment #15 (design workflow):

Part 2 of Videos: Could issues arise if Civil 3d elements are eliminated from the library that 
are used in the examples? Will DOT always have legacy items that will always be able to be 
used? Example would be the new abilities of the DOT daylight subassembly be used in the 
example but not be available in future releases.

Interesting question, and we can see how that could possibly happen.  We are thinking about the abil-
ities of our design system when we are setting delivery requirements, and we are thinking about our 
delivery requirements when we identify and address functionality needs/changes to our design sys-
tem.  We want to avoid making changes to our Civil 3D tools that make delivery requirements harder 
to achieve.  If we miss something and that would occur, it would be a high priority in our Civil 3D work 
to fix it.

Also, the model example library defines deliverables, but does not require specific workflows as to 
how to develop the deliverables.  A subassembly used in the development of one of the models 
might be changed or retired, but the functionality to achieve the results should still be available, 
although perhaps differently.  Workflow and delivery requirements have relationships to each other, 
but are not rigidly locked to each other.

ACEC Comment #13 and #21 (curb ramp modeling):

We don't have to model Curb Ramps if we don't want too!

It is GREAT to see the text that curb ramps will not be modeled.

These comments are encouraging to hear!  We also think they demonstrate that better definition of 
our design model standards is needed and will be beneficial.  Curb ramps have never been required 
design model elements in our FDM standards, the FDM has always said curb ramps are optional fea-
tures for designers to consider adding to models.  However, our Civil 3D training shows people how 
to model curb ramps because some projects have found there are design benefits in doing so.  So in 
this case our C3D workflow training has gotten mixed up with our FDM delivery requirements, and it 
is a common misunderstanding that extends to many others besides these 2 commenters.  We think 
the model example library is going to be an effective way of creating better, easier to interpret defin-
itions of design model delivery expectations, and will help us resolve these types of mis-
understandings.

ACEC Comment #8 (design workflow, or design model scoping):

There will still need to be an emphasis for getting the correct level of detail early on the pro-
ject to minimize escalating design levels as the project nears completion.

If we interpret this comment as being about workflow, we think it is an effective design workflow 
strategy, but it needs to be applied with a balanced approach.  If the roadway alignment/profile are 
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still unsettled, investing too much time in detail development is risking lost effort and rework.  It's a 
project by project consideration.  But certainly, pushing the design detail early rather than waiting 
until PS&E will have design process benefits.

If we interpret this comment as being about design model scoping we agree that in most cases the 
overall design effort will be less work if the need for higher levels of detail in model elements are 
identified early in the design process.  Late design model scope changes that increase level of detail 
may require rework and an overall greater design effort than when the higher level of detail scope is 
set early.

ACEC Comment #7 (contractor use of digital design data):

Is there going to be requirements for contractors to keep up with software/use data?  Some-
times contractors still don't see the benefit with smaller jobs.

We interpreted this question a couple ways, so we have 2 answers that are based on 2 different inter-
pretations.

 1. We won't have any requirements in place for contractors to use specific software, or to use 
specific types of data.  Contractors will continue to determine their means and methods

 2. Design and construction processes will evolve as new technology and applications of ideas 
emerge.  Maximizing the value of our design work is the goal, and to achieve that goal we are 
thinking about the solution as a moving target.  MDU will continue to work with the con-
struction industry to assess the effectiveness of our design deliverables.  We've benefitted 
from the voluntary involvement of many terrific partners from the construction industry, and 
we expect that to continue.

ACEC Comment #23 (Civil 3D development):

Continue to improve and provide more efficient workflows to generate plans and deliv-
erable.

Yes.  With the help of our user base, MDU will continue to assess the effectiveness of our Civil 3D 
build and improve the tools for WisDOT project types.  We will also continue to communicate our 
functionality needs and ideas to Autodesk to promote solutions that are best realized in the core 
software.

ACEC Comment #24 (design modeling and EG design survey):

Deliverables are based on the level of quality/detail of existing conditions.  If the existing 
DTM has low frequency, the design deliverable should roughly match the interval.

This commenter has identified an important concept.  The relationship between design survey accur-
acy/density and design modeling practices is a topic that is worthy of extended discussion.  There is a 
lot to think about, much more information than we'll attempt to communicate in this blog post, but 
we'll summarize our thoughts here and look for future opportunities to have a greater discussion on 
the topic.
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The effect of EG1 accuracy and/or density on design model development is dependent on the type of 
design work.  In general, a less dense or less accurate EG will do the greatest damage to design 
concept integrity at the match points of the design.

For simple reconstruct design scenarios, it is usually the accuracy of proposed slope intercept loc-
ations that are most affected.  As you move further inside the footprint of proposed work, the neg-
ative effects of a less dense and/or less accurate EG are less substantial, and the value of higher 
levels of detail in the design model is preserved.

For more complex retrofit design situations where fitting the design concept into existing terrain con-
ditions is a more complex challenge, it is still the match points between proposed work and EG that 
are affected, but the effects can be more detrimental to the overall design concept.  For example, 
let's consider a shoulder widening operation with a longitudinal match to existing pavement along 
the edge of traveled way.  In this situation, it is the existing pavement profile that controls the com-
plete roadway design solution.  Every cross sectional feature, every proposed work offset/elevation 
label on the plan cross sections, is a projection from the existing edge of pavement.  The integrity of 
the entire roadway design is entirely dependent on the accuracy/density of EG at the edge of pave-
ment matchline.  If this is understood and accommodated in the design survey collection methods, 
the design can be effectively developed.  If it is not accommodated in the design survey collection 
methods, serious design concept flaws can result, leading to significant construction project issues.

Designers need to consider the design survey collection methods used on their projects, and determ-
ine if EG accuracy/density will sufficiently meet design project needs.  Awareness and understanding 
of the commonly used survey collection methods, the strengths and weaknesses of the resulting sur-
vey data is a critical skill for effective roadway design.

MDU is developing workflow concepts to improve the communication of design survey collection 
methods employed on a project.  Improving communication of survey collection methods to design-
ers and to contractors will improve processes help project teams avoid costly construction project 
issues.

Design model standards update
Last updated: 2020-10-26

Total video time: 39:13

Design model standards update (part 1) #design

dsn-mdl-stnd-updat-01.mp4 15:14

Wisconsin DOT started developing design models for our roadway projects as a voluntary deliv-
erable in 2010 when we started using Civil 3D as our roadway design software. In 2014, after a few 
years of voluntary design model deliveries and pilot project experiences, WisDOT implemented 
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statewide design model delivery requirements that applied to all new design projects with 
earthwork.  The design model concept we implemented consisted of a group of 3D surface models 
that represent proposed work terrain.  The 2014 standards required surface models for TOP (which 
is finished grade of all work), DATUM (which is finished earthwork grade), all roadway base and sub-
bases, and a pavement model. Over our first years of project experiences with design model delivery 
standards we recognized that there was not strong utilization of some of the surface models on our 
construction projects, so in 2018 we updated the design model concept by removing Base, Sub-
bases, and Pavement from the list of required surface models, leaving us with today's design model 
concept that is made up of a Top and a Datum surface model only.  However, continued feedback 
from project experiences has exposed other elements of our design model implementation that 
could be improved upon.  We presently have a one-size-fits-all design model concept that requires 
the same deliverables developed to the same level of detail for all projects with earthwork.  There is 
no consideration in design model standards for project complexity or other project needs.  In 
informal conversations with designers and project staff who have experience with design models on 
WisDOT projects, we've been hearing we could be doing a better job of "right-sizing" the scope of 
design model development to specific project needs. 

What follows is Part 1 of a two-part presentation that describes a proposed concept for restructuring 
Wisconsin DOT's design model standards that will help us achieve our goal of right-sizing design 
model delivery efforts.  Part 1 is an overview of the proposed restructuring.  Part 2 will look more 
closely at the details of how the proposed standard would work, and how it would benefit our Pro-
ject Delivery environment.

How do we "right-size" the design model effort?

How do we do a better job of right-sizing the 3D design effort to specific project needs?  We've iden-
tified 3 measures that will help us achieve that goal.

 1. The first is a restructuring of the content and level of detail standards for our design models. 
The new standards will allow for more variation in content and detail, allowing delivery 
requirements to be tailored to all types of WisDOT projects and establish a roadway design 
environment that invests the appropriate amount of 3D design effort for a project's specific 
needs.  The addition of a model feature examples Library to our design model content 
requirements will create such a flexible standards framework, I'll explain how and why in this 
presentation.

 2. One problem with a rigid, uniform statewide standard is the unique nature of individual road-
way projects.  No two projects are the same.  Projects of the same improvement type can 
have significantly different needs.  Complex project situations will sometimes benefit from 
the development of additional detail in design models, while in other project situations that 
same level of detail development may be overkill.  So, our second goal in developing a Right-
Sizing strategy is to allow more project level control over the scope of 3D design deliverables.  
The update we are proposing will create a framework for defining 3D design standards, and 
Regions will work within that framework to tailor the 3D design scope to the specific needs of 
projects.

 3. Our third measure is to develop a standard that communicates and documents 3D design 
delivery expectations much more clearly than our present day FDM standards.  Today's 
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design model standards set requirements for content and level of detail of our proposed 
work surface models, but the quality of the communication of those ideas has not been as 
effective as we need it to be.  Project teams' interpretation and application of our design 
model standards has not always been consistent.  Restructuring our design model standards 
provides an opportunity to make improvements in communicating 3D design content and 
detail expectations, and our proposal is designed to accomplish that.

Design model features example library

Central to our proposed update of design model standards is the Design Model Features Example 
Library.  The examples in this library will not be full project surface model examples.  Instead, the lib-
rary will be a collection of 3D models of smaller elements which are often found within a surface 
model on a Wisconsin DOT roadway project.  These smaller elements represent specific roadway fea-
tures. Listed on the slide are some of the roadway features we plan to develop examples for in our 
Model Features Example Library.  We will add more features to the library as the needs become 
apparent.  Some features will only have a base level of detail example, other features will have mul-
tiple example versions with advanced examples containing more detail than the base example.

The FDM's design model standards will reference these model feature examples. In other words, the 
examples will be part of the FDM standard for defining design model content and detail.  The 
examples will establish level of detail expectations on a feature by feature basis.  The use of model 
feature examples will help us achieve our goal of improving communication of design delivery 
expectations.  It is well understood that one of the benefits of 3D design is that it improves the com-
munication of design concepts, compared to traditional 2D only deliveries.  So, it is ironic that we've 
been trying to communicate the content of 3D surface models with written text and 2D drawings.  
When you think about it that way, it makes sense that a better way to communicate 3D surface 
model content concepts is with 3D surface models, so we will be bringing our design standards into 
3D.

Each Model Feature will have a base level of detail example.  The content and detail of a feature's 
base example will be the statewide design model delivery requirement, it will define the minimum 
amount of detail a surface model must contain, on a feature by feature basis.  Some model features 
will have advanced levels of detail representations in the library, in addition to the base level 
example.  Advanced detail examples will have descriptions of purpose.  We will describe project situ-
ations where advanced detail may be beneficial, and why it would be beneficial.

Project design model scope decisions

With this new structure of design model standards, Regions will work within the Level of Detail defin-
ition framework to define the scope of design model development for their projects.  The design 
model scope decisions will be made at the beginning of the PDS design effort, and documented 
using a simple scoping matrix that is similar to the table shown on this slide.  A project's design 
model scope can be updated as unanticipated project needs become apparent while the design pro-
gresses. The base level examples that are the statewide minimum design requirements will often be 
less detailed than many designers' expectations today.  This is because we are lowering expectations 

Page: 1918

Published on: 5/17/2023

Design model standards update



for design model detail in the mandatory statewide requirements.  The standard will have the higher 
detail model examples to allow for elevated model detail where and when a project needs it.  The 
decision to elevate model detail for a feature will no longer be a uniform decision applied to all occur-
rences of a feature on all projects across the state, instead the decision will be made at the project 
level based on project needs.  The decision to elevate detail for an element wouldn't have to be uni-
form within a project either, it could be varied from one occurrence of a feature to the next.  For 
example, a project may have 3 bridges to construct, but perhaps only 1 bridge falls within an area 
that is highly sensitive to project impacts.  The design model scope could elevate detail requirements 
for the design model at that 1 bridge while leaving the other 2 bridges at the base level.  

"Right-size" the design model effort

Let's reexamine the 3 measures that our new design model standards will use to address Right-Siz-
ing concerns.  

 1. The design model Features Example library will bring options for defining design model Level 
of Detail scope down to the feature level for each project, and it will offer multiple Level of 
Detail options for some of the features.  The default base level of detail standard, which will 
be the statewide minimum, will require less surface model detail than today's design model 
standard does.  The advanced detail examples for many features in the library will create 
options for Regions to specify elevated levels of detail within a project when appropriate.   
These characteristics of design model Features Example Library create the flexible standards 
framework that can be adapted to specific needs of projects.

 2. Regions will have more control over the scope of the design model development effort on 
their projects under this new standard.  The inventory of roadway features in the example lib-
rary will be organized in a simple matrix that Regions can use to document design model 
scope decisions.  It is this scope decision making process that is facilitated by the Example 
Library that will allow Regions to elevate design model Levels of Detail when project needs jus-
tify the extra design effort.  These design model scope decisions will be made within Regions 
where the needs of each project are best understood.  

 3. Finally, the Example Library will improve communication of design model delivery expect-
ations by its use of 3D surface models as the language to communicate Level of Detail 
concepts.  With 3D model based definitions of how models should represent different fea-
tures, and with the design model scope matrix that documents decisions for applying the 
standard to projects, designers will have a much better understanding of what they must 
deliver and how it should be shown in the model.

What is next?

We will be sharing information about this proposal for restructuring our design model standards 
through our Civil 3D knowledge base, and we will post implementation status updates there as well.  
Email will be one channel for people to provide comments and ask questions.  As we see patterns or 
themes in the feedback we receive, we will use the C3D knowledge base to share those common 
comments and questions, and our responses to them.  We will be discussing this proposal with 
region offices, our consultant roadway designers, construction contractors, and other industry 
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partners where and when we have the opportunity, such as at Civil 3D user group meetings, con-
ferences, and workshops.

As we are receiving this valuable feedback on the standards concept as, we will also be producing 
our base level of detail examples that we will propose as the statewide standard of minimum level of 
design model detail.  Those base examples will be released incrementally for review as they are 
developed.  

We will also be asking our roadway design community to share their ideas about representation of 
features at various levels of detail by asking them to send us examples of roadway design work.  We 
will review the examples we receive, look for common themes and best practices, and standardize 
them into advanced detail examples that will be shared for broader review and ultimately incor-
porated into our design model Features Example Library.  

As we move through this standards development process we will share updates on our progress, on 
comments we receive, and on concept changes through a variety of communication channels includ-
ing user group meetings, video releases, internal management meetings, etc.  If this standards 
concept stays largely intact after receiving input from the roadway project community, we expect to 
have the standard ready for FDM publishing in 2019.

Thank you for watching Part 1 of our design model standards update presentation.  Part 1 was a 
summary of the major components of the proposed update to our standard.  If you would like to 
hear more detail about how the proposed restructuring Wisconsin DOT's design model standards 
would be applied, and how it would benefit our WisDOT roadway projects, please proceed to "Design 
model standards update (part 2) #design2" below of the presentation.

Questions and comments regarding design model Standards should be sent by email to Brad Hol-
lister at Wisconsin DOT.

Design model standards update (part 2) #design2

dsn-mdl-stnd-updat-02.mp4 23:59

What follows is Part 2 of a two-part presentation that describes a proposed concept for restructuring 
Wisconsin DOT's design model standards that will help us achieve our goal of right-sizing design 
model delivery efforts.  "Design model standards update (part 1) #design" on page 1916 is an over-
view of the main elements of the proposed restructuring.  In Part 2, we will look more closely at the 
details of how the proposed standard would work, and how it would benefit our Project Delivery 
environment.  If you haven't watched Part 1 of the presentation, please do so before continuing with 
Part 2.

In Part 2 we will discuss:

 l What exactly is a design model feature example?  What does each example contain, and 
why? 

Page: 1920

Published on: 5/17/2023

Design model standards update

mailto:brad.hollister@dot.wi.gov?subject=Design model standards update
mailto:brad.hollister@dot.wi.gov?subject=Design model standards update
https://c3dkb.dot.wi.gov/video/dgitl-data/dsn-mdl-stnd/dsn-mdl-stnd-updat-02.mp4


 l We'll explain in greater detail how the design model Features Example library will improve 
communication of design model standards and other aspects of roadway design.  what the 
benefits of improved communication will be

 l We'll identify other types of benefits the implementation of this standard will help us realize.

What is a design model feature example?

The DTM and Breakline components of a design model feature example will be the information that 
tells designers what must be delivered.  The DTM and breaklines will be referenced by the FDM as 
part of the definition of delivery requirements, and will communicate important details about the 
structure of the design model such as the location and configuration of breaklines, density of elev-
ation points, and other 3D geometric information that is most easily communicated with 3D objects.  
Designers will certainly benefit from seeing the structure and configuration of breaklines in the 
design standard, it will help them understand what should be delivered with the final design.

The source Civil 3D design data will not be part of the FDM design delivery requirements.  The source 
design data is supplemental information provided to show designers how the example was 
developed, and may be helpful to them in developing and improving their roadway design 
workflows.  Even though the examples can convey workflow ideas, the primary purpose of the 
examples is to communicate geometric requirements of design model delivery, and examples may 
not have been developed using the best, most recent Civil 3D design workflow concepts.  We will 
maintain models so they are current with design deliverables needs, but we will not maintain 
examples to stay current with latest application of new tools and workflow ideas.  Our Civil 3D train-
ing found in the Civil 3D knowledge base will continue to be our source for Civil 3D workflow ideas, 
and over time we will have an opportunity to develop training that is specific to feature example con-
cepts.

Many feature examples will be accompanied by a supplemental narrative containing information 
about what elements of the feature are more important to develop precise and accurate detail for.  
For each advanced detail example, the narrative will also explain how the additional model detail 
might benefit a project, and what types of project situations would be appropriate for considering 
setting design model scope above the minimum level of detail. 

Feature level scope definition benefits

When implemented, this standard will provide a design model scope document in the FDM that lists 
all model features in the example library and their different levels of detail. The design model scope 
determination should be accomplished early in the design effort, perhaps during design contract 
negotiations for our consultant designed projects, and in a similar timeframe for our DOT designed 
projects.  The design model scope document should be retained as a record of design delivery 
expectations, and will be a required item in Contractor Data Packet deliveries. 

By defining design model scope at the feature level, project teams will be able to selectively apply 
higher levels of 3D design effort where it will be most beneficial, and lesser effort levels where the 
additional detail isn't as beneficial.  We will see variations in approach as Regions apply this design 
model standard against the backdrop of their office philosophies and past project experiences, but 
with this standards structure and associated design delivery content documentation, those 
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variations in regional approach will become a strength of the new system.  With proper feedback 
mechanisms in place we will have an opportunity to learn more about the amounts of design effort 
associated with the development of different elements of our roadway models to varying degrees of 
detail, and we will also have opportunities to learn about the differences in project benefit provided 
by the various levels of detail for each feature.  Combining our increased understanding of design 
effort and project benefit, we will deepen our understanding of the appropriate role of 3D design 
practices on our projects, and continue to improve our design model scoping information to help us 
find the right balance between 3D design effort and project benefit – at the roadway feature level.

Feature-level based scope definition is a characteristic of the proposed standard is a key element 
that will help us achieve our goal of right-sizing the design effort to our many variations of project 
situations.  

3D models improving communication

As discussed in Part 1, we believe the model feature example library will significantly improve com-
munication of design delivery expectations.  The DTM surface and breakline components of feature 
examples will provide significant improvements in how we communicate design delivery 
requirements.  

But examples will communicate more than what must be delivered.  The library will also help 
advance our discussions and designer's understandings of how design models are being used.  Not 
all pieces of the model are of the same importance, some areas of a model are acceptable with reas-
onable degrees of inaccuracy while other areas may be critical to have precisely accurate design 
information, and the examples can serve as a source for that type of information.  As an example, 
think about the earthwork cone that is constructed to support a bridge abutment.  Depending on the 
situation, we may not need highly detailed earthwork models around the wingwalls to adequately 
communicate the design concept for a construction project's needs.  But in front of the abutment 
where slope paving will be placed, now that is an area of importance to get the design developed cor-
rectly and to a high level of detail.  This is because the bridge abutment might be constructed early in 
a project's construction sequencing, before many of the surrounding roadway features are built.  A 
contractor will want to get the slope paving constructed before the bridge girders are placed, while 
heavy equipment can still access the slope paving area.  If the design geometry between the earth-
work cone and the roadway features beneath the bridge has inaccuracies and those problems aren't 
discovered until after girders are set, reshaping the slope paving area without heavy equipment 
access is not going to be a fun task.  So, you can see why it would be important to invest extra design 
effort to ensure the slope paving design geometry is highly detailed and accurate, a small investment 
in the design process that can prevent significant construction issues.  The design model standard 
we are developing will account for the importance of detailed, accurate slope paving geometry, and 
the associated documentation will help our designers understand why.

The design model features example library and the enhanced communication of ideas that are inher-
ent to 3D design objects can be used as a centerpiece for these types of discussions.  We will include 
a narrative article with many of the examples in the library, sharing our ideas about where the most 
critical areas of the design are, and why.  For the advanced detail examples, we will describe project 
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situations where designing above the base level of detail may be beneficial, and how projects would 
realize those benefits.  So, you can see that the example library will certainly improve designer's 
understanding of WisDOT design delivery expectations, but it can also help facilitate deeper con-
versations about the relationship between roadway design and construction operations, and that 
will bring process improvements to project delivery processes.

Improved communication of design delivery expectations will:

 1. Reduce excess design effort that can occur in the absence of effective com-
munication.

With today's FDM design model standards language as the only information source, roadway 
designers are wondering how much detail they should develop in their proposed work sur-
face models.  Have they done enough?  How do they know?  Many people, being the con-
scientious engineers that they are, will take a conservative approach and develop high levels 
of detail throughout their surface models, perhaps more detail than is necessary or beneficial 
to the project.  It isn't only the design work that may be expending extra effort, just the level 
of detail decision-making process itself is requiring time and effort.  Designers are asking 
these questions and making their own determinations on each design model delivery.  The 
lack of clear communication of delivery expectations is costing us design effort.  The Model 
Features Example Library will resolve designers' questions about how much detail is neces-
sary.

 2. Help standardize representation of features in models across all WisDOT design deliv-
eries (similar to our goals for plan sheets).

With designers left to make their own final determinations about representation of common 
roadway features in their proposed work surface models, it isn't surprising that the result is a 
variety of different solutions.  The same types of features can look different from one design 
model to the next.  Long ago we recognized the benefits of standardization in our design out-
put, and accordingly standardized plan sheets are a bedrock principle of all our Civil 3D road-
way design and plan production workflows.  Standardization across our design model 
deliveries will benefit projects in much the same way, and the model feature example Library 
will be a strong step in the right direction for achieving that type of standardization.

 3. Promote increased efficiencies for contractors.

Consistent representation of roadway features in our design models will allow contractors to 
develop more consistency in their construction model development workflows.  Once road-
way project features are represented with the same type of geometry and breakline con-
figuration repetitively, contractors will become more efficient in the use of our design model 
data.  

Another efficiency contractors will realize is the improved communication of design intent.  
Just like our plan sheets, when models communicate the same type of information in the 
same manner on all of our projects, interpretation of that design information will be more 
consistent and will require less effort.
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By including the design model scope document with Contractor Data Packets, contractors will 
have immediate information on the expected content and level of detail of our design model 
deliveries, and will be able to plan their project activities accordingly.  With clear doc-
umentation of design delivery expectations, we will have an opportunity to ask contractors 
for their assessment of how well the design delivery met those expectations, and where it 
may have fallen short.  This would provide valuable feedback to designers, and also to the 
Department in our assessment of 3D design proficiency amongst our roadway design com-
munity.

 4. Reduce design detail expectations

The communication abilities of the Model Features Example Library will help us reduce level 
of detail expectations of our design models.  For many features, the base level of detail 
requirements, which are the statewide minimum detail standard, will be less detailed than 
many of our roadway designers might expect.  In large part, this is because WisDOT is no 
longer trying to deliver 100% Construction Ready surface models with our design deliveries.  
100% construction ready surface models was a goal we established early in our Civil 3D imple-
mentation, and it heavily influenced how we taught roadway design in Civil 3D.  At that time 
we were thinking the role of a design model should be similar to the Plan, developed by the 
roadway designer as a static document that is used in construction, and therefore it needed 
to be developed to a sufficient level of detail to support our contractors' most advanced 
implementations of AMG technology and other model based processes.  But through our pro-
ject experiences we've learned there is no single design model concept that is 100% con-
struction ready for all of our potential contractors on all of our projects, many contractors will 
have different methods of feature representation that have become standard practice in their 
organization, and they don't want to change the way they are doing their work.  Contractors 
want a design model delivery they can use in the development of their construction models, 
but is flexible enough to be customized to their specific methods of operation.  So, we are 
now thinking about the purpose of the design model differently.  We no longer see it as the 
Plan-like rigid document that cannot be modified, instead we see it as a collection of geo-
metric roadway design data that can be used by contractors in many ways.  The DTM com-
ponent of our proposed work surface models is most useful to our contractors pre-bid for 
project exploration, planning, and analysis.  But for construction operations, many con-
tractors will utilize our design model breaklines to help them in the development of their con-
struction models, which they configure specific to their implementation of Automated 
Machine Guidance.  With this changed understanding of design models' role on our projects, 
highly detailed design model representations of features is not as critical, and often times 
less detail is sufficient.  But many of our designers still perceive that highly detailed and accur-
ate DTMs in our design models are needed, the Model Features Example Library will help cor-
rect that misunderstanding.
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Base requirements that emphasize construction benefits, option design benefits

As we are making decisions about the appropriate level of detail in the base design model standard, 
a concept goal we'll be keeping in mind is we would like the base delivery requirements to emphas-
ize 3D design content that benefits construction projects.  When the feature's detail is more bene-
ficial to design processes and not as beneficial to construction, we'd like to make the development of 
that type to be an advanced feature example, and not a base requirement, allowing project teams to 
use judgment on whether or not that added level of detail for the feature should be developed into 
the model.  There may be exceptions to this concept goal in our final standards, but it is a general 
principle we are using to guide us through these decisions.

An example that demonstrates this concept goal is design model representation of slope paving 
around abutments.  We talked earlier about why highly detailed and accurate design information for 
slope paving installations is a risk reduction measure that helps prevent construction project issues.  
Slope paving areas are a good example of a situation where investing a little more design effort deliv-
ers construction project benefit, and our base standards will require detailed representations of 
slope paving to be incorporated in design models.

Curb ramp model features are the opposite type of example, they are a model feature that primarily 
benefit design processes, at least in today's construction project environment.  So far, we just don't 
see use of curb ramp models in construction operations, and curb ramp construction detail draw-
ings in our plans are our primary means of communicating design intent for curb ramp construction. 

 

A curb ramp model delivery typically will not benefit the construction project, but there is a design 
benefit to producing highly detailed and accurate curb ramp models.  Some designers believe that a 
model based design workflow is the most efficient way to develop an ADA compliant curb ramp 
design concept and the associated construction detail drawing needed to communicate that design.  
The curb ramp modeling workflow you'll find in WisDOT's Civil 3D training is an efficient way of work-
ing through the iterative process of developing proposed grades and elevations that accommodate 
all the constraining elements found in curb ramp design, and with the resulting surface model out-
put and intelligent Civil 3D labels, the path to plan sheets flows right out of the design.  Additionally, 
because of the automation involved, the Quality Control checking of plan content should be much 
simpler with the model based design approach.  However, other designers believe they can most effi-
ciently develop curb ramp designs using manual methods to calculate design elevations and grades, 
and produce the curb ramp construction detail drawings using traditional CAD drafting techniques.  
If they prefer to use that traditional approach to doing the design work, there would be no benefit to 
developing detailed representations of curb ramp and sidewalk geometry in their design model sur-
faces since that information would not be used in construction or design.  So, it makes sense to let 
the Region's design project team decide whether development of a curb ramp model is worth the 
added design effort, and not have a blanket requirement mandating curb ramp models in our base 
design model standards. 

Design vs. Construction benefit is a concept we will consider as we think about specific roadway fea-
tures and the level of detail that is needed in their design model representations.  When the design 
process is the primary beneficiary of advanced levels of model detail, the Region's design project 
team should have the authority to decide if that feature should be modeled to that advanced level.  
When the construction project is the primary beneficiary and the project benefits justify the design 
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effort costs, the base standards should require development of that feature's detail in design mod-
els.

3D design quality improvement

Implementation of this standard will elevate the quality of our design model deliveries.  When our 
design standards clearly communicate how features should be represented in design models, design-
ers will have a benchmark to shoot for in design model development.  Design teams' 3D design qual-
ity control practices can be developed much more effectively, and the quality of our design deliveries 
will improve as a result.

Today's construction contract structure does not recognize our design model deliveries as contract 
documents, design models are provided for contractor's convenience and contractors assume risk 
when they use our design model data.  This is appropriate policy considering the current state of our 
design model implementation, and most contractors will invest effort to check our design model 
data before using it in their processes.  But when our design model implementation has matured to 
a state where we are consistently delivering accurate and standardized design models on our pro-
jects, the Department could consider elevating our design models to be part of our construction con-
tract documents.  For that to happen, it is reasonable to expect that WisDOT will want to establish 
review and acceptance procedures for design models and incorporate those into our standard 
design review processes.  The clear definition of design model content requirements this standard 
provides will make such a program possible to establish.

Construction project feedback opportunities

Establishment of this standard will create opportunities for new types of feedback from contractors.  
It provides the framework for conversations about benefits of added detail for different types of 
roadway features in different type of project situations.  WisDOT will gain valuable insight by enga-
ging in these types of conversations with our contractors, and over time we can apply what we learn 
into improving our design model scope definition processes.  We will continue to improve our applic-
ation of 3D design concepts on our projects, and as technology evolves and changes construction 
methods, we will have design standards mechanisms in place that allow us to adapt our design pro-
cesses to future changes in project needs.  

WisDOT will also have an opportunity to establish mechanisms for receiving contractor feedback on 
the quality and accuracy of design model deliveries.  This kind of feedback would benefit designers, 
and more broadly could benefit the Department by helping us assess how well we are doing in meet-
ing our goal for consistently delivering accurate models of standardized content.

Thank you for watching Part 2 of our design model standards update presentation.  If you haven't 
seen it, please watch "Design model standards update (part 1) #design" on page 1916 of this present-
ation as that is the overview of the major components of the proposed update to our standards.  

Questions and comments regarding design model standards should be sent by email to Brad Hol-
lister at Wisconsin DOT.
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Design  model features example library
Last updated: 2020-08-03

Subscribe link to Design/Construction Integration listserve

Design model features example library overview

The Design Model Features Example Library consists of model representations of individual roadway 
features commonly found on WisDOT roadway projects.  The examples in the library establish Level 
of Detail (LOD), and content expectations for Design Model deliveries on WisDOT design projects.  
Using 3D objects to improve the communication of design model delivery expectations will promote 
efficiencies in roadway design, and will promote greater consistency in our design model deliveries.

Additional information about the purpose of the Design Model Features Example Library can be 
found at "Design model standards update" on page 1916

Base LOD examples and advanced LOD examples

Examples in the design model features example library will be classified as Base Level of Detail (Base 
LOD) or Advanced Level of Detail (Advanced LOD).  Base LOD examples establish the minimum level 
of detail required for representation of a feature in a design model.  Advanced LOD examples estab-
lish delivery requirements for optional higher level of detail representations of a feature in a design 
model.  Decisions to elevate level of detail to advanced levels for specific features in a project's 
design model are made by Region offices, and documented using a design model scope summary 
form (form currently being developed).  See "Project design model scope decisions" discussion in 
"Design model standards update" on page 1916 for more information.

Model example files content and purpose

Model examples files will consist of:

 l surface models as DTMs in LandXML
 o provided for transfer of complete surface model as a DTM object

 l surface model breaklines as polylines in AutoCAD DWG
 o provided to demonstrate the location, and configuration, and the expected level of 

detail of breaklines for proper feature representation in design model deliveries
 l surface model TIN as 3D Faces in AutoCAD DWG

 o provided as an example of a required format for Triangulated Irregular Network (TIN) 
representations of features in design model deliveries

 l Source Civil 3D design files.
 o Provided as a resource to help designers see how the model example could be 

developed.  It is important to understand that the purpose of model example library 
content is to communicate design model delivery requirements, it is not intended to 
communicate the best, most recent roadway design workflows.  The model example 
source Civil 3D design files will not be maintained as Civil 3D roadway design work-
flows are improved.  The C3DKB Civil 3D training is the source of our most current road-
way design workflow information.

 o Civil 3D design data is not a  design project design model deliverable.
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 l Surface model contours as polylines in AutoCAD DWG
 o Provided as an alternate visual representation of surface model geometry.
 o Contour files are not a design project design model deliverable

 l 3D PDF files for non-Civil 3D users
 o Provided to allow non-Civil 3D users an opportunity to review model example files and 

concepts.  3D pdfs of breakline files, 3D Faces files, and contour files are provided.
 o 3D pdf files are not a design project design model deliverable.
 o NOTE:  We are planning to implement a future solution for non-Civil 3D user review of 

model example files that will utilize an internet browser-based model viewer.  When 
implemented, the browser-based model viewer will replace 3D pdf model example 
files.

Design model examples commenting and feedback #design

WisDOT Design Model Guidance Team site introduction

https://trello.com/designmodelguidance

Welcome to WisDOT Design Model Guidance Team on Trello. WisDOT Design Model Guidance is a 
place to interact with the Methods Development team and other WisDOT Design Model standards 
development followers. You can use this platform to do things like:

 l Propose new model examples
 l Comment on proposed, DRAFT, and GUIDANCE status model examples
 l Submit revisions to consider for existing model examples
 l Submit  new model examples for idea exchange

WisDOT  Design Model Guidance team members have full access to participate in the discussions 
about design model standards.  To join the team, send a request to support.cae@dot.wi.gov.  Before 
joining the team, please review the WisDOT Trello disclaimer.

On WisDOT Design Model Guidance you will find 4 boards:

1) Suggest Features for Future Examples

2) Comment on Features in Example Development Queue

3) Comment on DRAFT Model Examples

4) Comment on GUIDANCE Model Examples

Please review the "How to use this board" list found in each board for information on how to make 
the most of your WisDOT Design Model Guidance team participation.

Only WisDOT Design Model Guidance team members can comment on idea cards found on this 
board.  You can request team membership by sending an email message to support.cae@dot.wi.gov.  
You will receive a team membership invitation email message.  If you don't have a Trello site account, 
you will be prompted to create one when you join the team.
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Only members of a given board can add ideas cards to that board.  To become a board member, you 
must first become a WisDOT Design Model Guidance team member (see above).  Once you've joined 
the team, click Join Board on the top of the board.

All content of these boards is visible to anyone on the internet. The source of content is also publicly 
visible.  If you would prefer to provide comments or ask questions about our design model guidance 
effort anonymously, send your comments and questions by email to support.cae@dot.wi.gov with 
"design model guidance comments" in the subject line of the message.  We may ask you if we can 
share your comments on the Trello boards without identifying the source, but we will not do that 
without your permission.

Tip: To get started on any board, review the How to use this board list within the board.

1) Suggest Features for Future Examples board

The 1) Suggest Features for Future Examples board is the place for submitting suggestions for new 
features to be considered for development and addition into the WisDOT Design Model Features 
Example Library.

2) Comment on Features in Example Development Queue board

The 2) Comment on Features in Example Development Queue board consists of a list of roadway fea-
tures for which MDU will develop model examples.  This board provides an opportunity for people to 
provide input on proposed model examples - early in the development process.

3) Comment on DRAFT Model Examples board

The 3) Comment on DRAFT Model Examples board consists of a list of roadway features for which 
DRAFT status examples are available for review.  This board provides an opportunity for people to 
ask questions and provide comments on DRAFT status model examples.  Methods Development will 
respond to comments and questions.

Example model files are available for download from the WisDOT Civil 3D Knowledge Base (C3DKB), 
links to example downloads are found in the example cards.

4) Comment on GUIDANCE Model Examples board

The 4) Comment on GUIDANCE Model Examples board consists of a list of roadway features for 
which GUIDANCE status examples are available for review.  This board provides an opportunity for 
people task questions and provide comments on Guidance status model examples.  Methods Devel-
opment will respond to comments and questions.  Examples listed on the board are in GUIDANCE 
status and are deemed ready for use in roadway design practice.

Example model files are available for download from the WisDOT Civil 3D Knowledge Base (C3DKB), 
links to example downloads are found in the example cards.

DRAFT status model feature examples
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Links to model feature examples documentation, and download links to DRAFT model example file 
packages.

 1. "DRAFT B-301-1.0 base LOD sill abutment model example" below
 2. "DRAFT B-101-1.1, B-101-2.0 base LOD beam guard EAT" on page 1939

GUIDANCE status model feature examples

Model feature examples documentation, and download links to GUIDANCE model example file pack-
ages.

DRAFT B-301-1.0 base LOD sill abutment model example
Last updated: 2020-08-03

Overview

Model feature example download package (.ZIP)

The DRAFT version 1.0 of the Base Level of Detail (LOD) sill abutment model feature example is avail-
able for review.  This DRAFT example release is part of Wisconsin DOT's effort to update our design 
model standards by utilizing 3D design objects to communicate level of detail expectations and 
other geometric requirements of design models.

Additional information about the purpose of design model feature examples can be found at 
"Design model standards update" on page 1916

Goals of all Base LOD model feature examples

The geometric elements of a Base LOD example will establish a feature-oriented standard for the 
minimum required level of detail for design model deliveries.  These examples will define a standard 
that produces design models that are an accurate representation of design intent, and are con-
sistent with plan sheets.

Design model features developed to a Base LOD will contain accurate geometric information, but 
less design geometry information than Advanced LOD features.  Base LOD features are accurate, but 
may not be fully representative of proposed work.

Base LOD should focus designers' efforts on elements of design geometry that are most beneficial to 
construction project needs and representation of design intent.  The Base LOD standard will min-
imize design efforts on elements that provide lesser construction project benefits.

Purpose of the sill abutment model feature example

Model feature examples define geometric requirements of design models including level of detail 
expectations and key elements of feature representation.  This example represents the design of the 
earthwork embankment cone that supports a sill abutment for a typical overpass structure.  It con-
sists of a TOP and DATUM (finished earthwork) surface model of the roadway underneath the 
bridge, roadway approach to the bridge, and the earthwork cone including slope paving area.
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As a Base LOD example, it must accurately represent elements of design geometry traditionally com-
municated on WisDOT plans.  It should include all critical elements of design geometry for sill abut-
ment earthwork in regard to representation of design intent.  It should also include all critical 
elements of design geometry needed for construction operations.  It will not be a complete rep-
resentation of design geometry. Construction project users of the design model may need to inter-
pret design intentions from the information provided to develop supplemental detail for a 
construction model to meet the needs of construction operations.

A Base level feature should contain sufficient detail to ensure the design concept is geometrically 
consistent with itself and with surrounding terrain. In other words, the Base design model ensures 
the feature is constructable.

Design model geometry requirements established by the example

 1. Highly resolved and accurate design detail in critical areas
 A. 1 foot corridor frequency spacing in areas of

 I. Clear zone transition
 II. Slope paving

 III. Wing wall earthwork and slopes
 B. Standard detail in other areas (corridor frequency spacings from FDM 15-5-7.2.2.1)

 2. Important breaklines
 A. Completed design should have highly detailed breaklines and design data rep-

resenting
 I. Clear zone transitional elements

 II. Slope paving
 III. Earthwork grade at abutment

Model feature example files

Design model files in contractor data packet required formats

These files are representations of the design model deliverables which would be included in con-
tractor data packets (see FDM 19-10-43.10 for design delivery requirements and CMM 7-10.3 for con-
struction responsibilities)

 1. BaseLOD-SillAbut-dft1.xml
 A. TOP and DATUM (finished earthwork) DTM surfaces in LandXML v1.2 format, this file 

meets surface model delivery requirements for WisDOT contractor data packets.
 2. ACAD-BaseLOD-SillAbut-CrdrBreaklines-dft1.dwg

 A. TOP and DATUM breakline file in AutoCAD format, this file meets breakline delivery 
requirements for WisDOT contractor data packets.

 B. All Civil 3D corridor graphical elements are also included in AutoCAD format, layer 
name conventions are used to identify elements used in the design surface model 
definition.

 C. Elements used in the design TOP surface model definition are identified by layers 
named specific to TOP elements.
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 D. Elements used in the design DATUM surface model definition are identified by layers 
named specific to DATUM elements.

 E. Elements used in both the design TOP and DATUM surface model definition are iden-
tified by layers named specific to TOP/DATUM elements.

 F. Corridor elements not used to define surface model geometry are on generic corridor 
layers.

 3. ACAD-BaseLOD-SillAbut-Datum3DFace-dft1.dwg
 A. DATUM (finished earthwork) surface model triangle file in AutoCAD format, this file 

meets TIN triangle delivery requirements for WisDOT contractor data packets.
 4. ACAD-BaseLOD-SillAbut-Top3DFace-dft1.dwg

 A. TOP surface model triangle file in AutoCAD format, this file meets TIN triangle delivery 
requirements for WisDOT contractor data packets.

Non-contractor data packet files

These files are not contractor data packet deliverables:

 1. C3D-BaseLOD-SillAbut-dft1.dwg
 A. Civil 3D design data that produced the model feature example.  This file is provided for 

informational purposes only, it is not intended to convey Civil 3D Project delivery 
requirements or design model delivery requirements.

 B. Workflow used in development of the Civil 3D design data for this model feature 
example may not be consistent with best MDU workflow recommendations.  It is one 
way to produce design content.

 C. Content of file and data structure is not consistent with Civil 3D project delivery 
requirements, all data is in a single dwg.  Data was structured in this manner for con-
venience of sharing model feature example source data.

 2. ACAD-BaseLOD-SillAbut-DatumContour-dft1.dwg
 A. DATUM (finished earthwork) surface model contours (0.2' major, 0.05' minor) and sur-

face model boundary in AutoCAD format.  Contour files are not required in WisDOT 
contractor data packets, but contours could be added as a required design deliverable 
if the contracting industry indicates they are useful.  Contour files are produced from 
Civil 3D design data with little effort and are an effective visual representation of sur-
face models.

 3. ACAD-BaseLOD-SillAbut-TopContour-dft1.dwg
 A. TOP surface model contours (0.2' major, 0.05' minor) and surface model boundary in 

AutoCAD format.  Contour files are not required in WisDOT contactor data packets, but 
contours could be added as a required design deliverable if the contracting industry 
indicates they are useful.  Contour files are produced from Civil 3D design data with 
little effort and are an effective visual representation of surface models.

 4. BaseLOD-SillAbut-CrdrBreaklines-dft1.pdf
 A. PDF provided for non-C3D users who would like to review model examples.  3D PDF 

file with graphical representation of model breaklines and additional corridor ele-
ments.
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 5. BaseLOD-SillAbut-Datum3DFace-dft1.pdf
 A. PDF provided for non-C3D users who would like to review model examples.  3D PDF 

file with graphical representation of DATUM TIN triangles.
 6. BaseLOD-SillAbut-Top3DFace-dft1.pdf

 A. PDF provided for non-C3D users who would like to review model examples.  3D PDF 
file with graphical representation of TOP TIN triangles.

 7. BaseLOD-SillAbut-DatumContour-dft1.pdf
 A. PDF provided for non-C3D users who would like to review model examples.  3D PDF 

file with graphical representation of DATUM (finished earthwork) contours.
 8. BaseLOD-SillAbut-TopContour-dft1.dwg

 A. PDF provided for non-C3D users who would like to review model examples.  3D PDF 
file with graphical representation of TOP contours.

Critical design geometry elements in the sill abutment example

Slope paving

The slope paving area is the portion of the earthwork cone that falls underneath the bridge.  See the 
outlined area in Diagram 1 #dia1 below.

The slope paving area of the sill abutment earthwork is a critical feature that is designed to a high 
level of detail in the example.  This is a risk reduction measure that will help prevent issues on con-
struction projects.  Bridges are sometimes built early in construction project phasing, before the 
earthwork operation for the associated roadways is substantially started.  When this happens, the 
abutment earthwork cone is constructed to support construction of the abutment, but earthwork of 
surrounding features may not be developed until later in the project.  Contractors need to complete 
construction of the slope paving before the bridge girders are placed, while heavy equipment can 
still access the slope paving area.  Sometimes the earthwork operations to construct the underneath 
roadway have not commenced, and the slope paving area must be shaped without the benefit of the 
entire area being constructed to grade.  If the design geometry between the earthwork cone and the 
roadway features beneath the bridge has inconsistencies and those problems aren't discovered until 
after girders are set, reshaping the slope paving area without the benefit of heavy equipment access 
will require significant effort, and additional construction project costs may be incurred.  Developing 
highly detailed design model geometry in this area will help prevent that type of construction project 
issue from occurring.

Diagram 1 #dia1
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Underneath roadway clear zone

In this example, the roadway passing underneath the bridge transitions from a ditch section as it 
approaches the earthwork cone to a slope paving section at the earthwork cone.  The design should 
define geometry with sufficient detail to ensure this transition area meets roadway design standards 
for safety and traversability.  This example assumes a longitudinal transition slope should not exceed 
10:1 within the clear zone, and TOP surface model ditch sections should be traversable throughout 
the transition area as defined in FDM 11-15-1.

Diagram 2
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Diagram 3

Diagram 4

Diagrams 5 - 8 show the transition of 3 cross sectional features within the clear zone:

 1. The drainage swale flowline from just off the shoulder under the bridge to the ditch flowline 
in the normal section.

 2. The clear zone limits point from an elevated location in the slope paving area to the ditch 
backslope location in the normal section.

 3. The subgrade shoulder point transition from a buried condition in the slope paving area to 
incorporation into the TOP surface model in the normal section.

Diagram 5
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Diagram 6

Diagram 7

Diagram 8
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DRAFT status review and commenting considerations

Things to consider during your review of the model:

Level of Detail

 1. Is there sufficient design detail for less complex project situations?
 2. Are all critical geometric elements of the roadway project captured in this Base LOD example?
 3. Does this level of detail support production of plan cross sections at traditional cross section 

locations and frequencies for this type of work?
 4. What types of risks are introduced to our projects with the lesser amount of design detail 

compared to an advanced level of detail representation of the feature?
 5. Earthwork cone transition from slope paving to wing wall slopes was purposely omitted 

because of the design effort needed to develop an accurate representation of how the dif-
ferent elements meet together.  For less complex project situations, this detail element is con-
sidered to not be a necessity.  Sufficient design information is provided to support 
construction model development, but some design intent interpretation and supplemental 
detail development will be necessary to complete construction models to the extent neces-
sary to support construction operations.  Does this approach make sense?  What is your per-
spective on this approach?

Feature representation

 1. Datum/Top configuration through slope paving area.  Is this suitable?

 2. Clear zone transition strategy and transitional elements.  Is this appropriate design strategy?

Page: 1937

Published on: 5/17/2023

DRAFT B-301-1.0 base LOD sill abutment model example



File content and format

 1. Questions for users of contractor data packets.  Breakline file is a graphic representation of 
Civil 3D corridors with surface model definition elements identified by Layer naming.  There 
are extra graphical elements in the file such as corridor links (cross section elements) at each 
corridor frequency location (including plan cross section locations, plus additional locations 
not in plan cross sections).

 A. Do users of contractor data packets see value or benefit in the provision of the extra 
content?

 B. Would identifying the transverse corridor links which are coincident with TOP or 
DATUM bring additional value to design models?

 2. Question for users of contractor data packets.  Is the contour file a useful deliverable as a rep-
resentation of surface models?

Earthwork quantification

The Base LOD for sill abutments model example does not support surface-to-surface earthwork 
quantification, but average end area methodology solutions are possible.  Future development of 
advanced LOD examples will help us assess the degrees of inaccuracy in earthwork quantities.  A 
design workflow problem to consider, what earthwork estimating workflows would work best with 
this Base LOD model?

Info: Additional design elements could be developed in Civil 3D to approximate slope geo-
metry for earthwork quantification, but those elements should not be included in the model 
unless the slope geometry is resolved accurately.  (No information is better than bad inform-
ation)

Geometric constructability verification

The Base LOD model doesn't contain information about the earthwork cone transition from slope 
paving back to the slopes projecting from the wingwalls.  These areas can be modeled to a high 
degree of accuracy using Civil 3D design workflows, however the extra design effort to develop that 
additional detail may not be justified considering the project benefit.  Design intent is adequately 
communicated without that extra information.  Construction model development workflows could 
use this Base LOD design model as a foundation, and add supplemental detail as needed to support 
contractor operations.

Designers can spot check approximate slopes in the earthwork cone transition area by measuring 
between Base LOD model elements in Civil 3D.  This example demonstrates why slope checking is 
necessary.  The design goal is to not exceed 2:1 slope rates throughout the embankment.  In this 
example, the slope measured from the corner of the earthwork ledge at the abutment down to the 
roadway clear zone is a 1.9:1, even though the slope paving itself does not exceed a 2:1.  If this 
example were an actual design project, the designer could move the underneath roadway's clear 
zone transition further south to flatten out the earthwork cone transition area.
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The Base LOD should provide enough information to ensure the embankment's geometric con-
structability and adherence to design standards, even if the details of the slope transitions are not 
fully represented in the model.

DRAFT B-101-1.1, B-101-2.0 base LOD beam guard EAT
Last updated: 2020-08-04

Overview

Model feature example download package version 1.1 (.ZIP)

Model feature example download package version 2.0 (.ZIP)

The DRAFT example version 1.1 and  DRAFT example version 2.0 of the Base Level of Detail (Base 
LOD) beam guard EAT1 model feature are available for review.  These DRAFT examples are part of 
Wisconsin DOT's effort to update our design model standards by utilizing 3D design objects to com-
municate level of detail expectations and other geometric requirements of design models.

More information  about WisDOT's "Design model standards update" on page 1916

Goals of all Base LOD model feature examples

The geometric elements of a Base LOD example will establish a feature-oriented standard for the 
minimum required level of detail for design model deliveries.  These examples will define a standard 
that produces design models that are an accurate representation of design intent, and are con-
sistent with plan sheets.

1Energy absorbing terminal. This is the typical end of a section of beam guard. It includes 
geometry deflection, increased post placement, and terminal end.
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Design model features developed to a Base LOD will contain accurate geometric information, but 
less design geometry information than Advanced LOD features.  Base LOD features are accurate, but 
may not be fully representative of proposed work.

Base LOD should focus designers' efforts on elements of design geometry that are most beneficial to 
construction project needs and representation of design intent.  The Base LOD standard will min-
imize design efforts on elements that provide lesser construction project benefits.

Review of the Base LOD beam guard EAT model feature example

Model feature examples define geometric requirements of design models including level of detail 
expectations and key elements of feature representation. Two Base LOD examples have been 
developed to represent earthwork grading to support beam guard EAT construction.  Both examples 
comply with the geometric requirements of standard detail drawing SDD 14b-44a Midwest Guardrail 
System (MGS) Energy Absorbing Terminal (EAT) - Layout.  We are intending to promote both DRAFT 
Base LOD examples to Guidance status, pending industry comments.  Geometric representations 
from either example would be acceptable in design model deliveries. Regions may choose to specify 
one method over the other for their project designs.

B-101-1.1 Base LOD beam guard EAT example

Example version 1.1 closely follows the earthwork geometry as depicted in the standard detail draw-
ing.  It creates cross section slope breaks at the locations of the standard detail drawing's (SDD's) 
Hinge Point Line and Gradeline.  Designing beam guard EAT earthwork in this manner will yield the 
narrowest roadway cross section footprint allowable by the SDD geometric requirements.  However, 
it also results in more complex slope geometry, and is more difficult to construct due to the narrow 
widths of slope areas.

Figure 1:  Image clipped from Standard Detail Drawing SDD 14b-44a with model example stationing iden-
tified of key geometric transition locations
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Figure 2:  Isometric view of DRAFT B-101-1.1 Base LOD beam guard EAT Top surface model with corridor 
breaklines

Figure 3:  DRAFT B-101-1.1 model example with standard detail drawing Gradeline and Hinge Point Line fea-
tures accentuated

Figure 4:  DRAFT B-101-1.1 model example with side slope transition configuration accentuated
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Figure 5:  Narrow width cross section elements makes the B-101-1.1 design geometry difficult to construct

B-101-2.0 Base LOD beam guard EAT example

Example version 2.0 simplifies the configuration of side slope geometry compared to the slope con-
figuration in B-101-1.1, and is in compliance with the geometric slope requirements of SDD 14b-44a.  
It maintains a minimum cross slope width of 8' for side slope elements.  Version 2.0 is easier to 
design, it's design geometry is easier to understand and communicate, and it makes the earthwork 
easier to construct than B-101-1.1.
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A negative aspect of the B-101-2.0 slope configuration is the roadway cross section footprint is wider 
than B-101-1.1 through the beam guard EAT area.  The width variance is sensitive to the specific geo-
metry of the location, in this example the difference is 5.5' at the widest point – the intersection of 
the Gradeline and the Clear Zone Limits.

Another negative aspect of version 2.0 slope configuration is the clear zone slope transition occurs at 
a distance that is further along the roadway from the start of the EAT (compared to the slope trans-
ition of version 1.1), and may require a greater overall length beam guard installation.  In version 1.1, 
all side slopes are transitioned to 2.5:1 by station 400+37.34.  In version 2.0, all side slopes are 
transitioned to 2.5:1 by station 400+87.34, 50 feet further away from the start of the EAT than ver-
sion 1.1.

Figure 6:  Isometric view of DRAFT B-101-2.0 Base LOD beam guard EAT Top surface model with corridor 
breaklines

Figure 7:  DRAFT B-101-2.0 model example with standard detail drawing Gradeline and Hinge Point Line fea-
tures accentuated
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Figure 8:  DRAFT B-101-2.0 model example with side slope transition configuration accentuated

Figure 9:  The greatest roadway footprint width difference between the two Base LOD beam guard EAT 
examples is 5.5', occurring at the end of the Gradeline

Page: 1944

Published on: 5/17/2023

DRAFT B-101-1.1, B-101-2.0 base LOD beam guard EAT



Critical design geometry elements in the beam guard EAT examples

Consistency with SDD 14b-44a

Both example version 1.1 and example version 2.0 meet the geometric roadway requirements for 
beam guard energy absorbing terminal construction as shown in SDD 14b-44a.

Special corridor frequency locations

The following locations are key points in the geometric transitions associated with this feature, and 
must be represented in the C3D corridor.  Model example stationing is used to help identify loc-
ations.

Feature Station in 
example

The start of the 15:1 widening taper of the HINGE POINT LINE 398+35.23

Post 1 399+53.67

Post 5 399+78.67

The start of GRADELINE targeting, coinciding with the start of the 
shoulder foreslope's 25 FT long slope transition from 4:1 to 2.5:1

399+93.56

Post 9 400+03.67

The end of the shoulder foreslope's 25 FT long slope transition 400+18.56

B-101-1.1
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Feature Station in 
example

from 4:1 to 2.5:1

The end of GRADELINE targeting, clear zone slope transitioned to 
2.5:1

400+37.34

Optional special frequency location at start of shoulder pavement widening. SDD 
14b-44a does not specify widening of shoulder pavement.  However, some pro-
ject designs do widen the shoulder pavement to match the face of beam guard, 
and this example has shoulder pavement widening included in its design 
concept.  When the shoulder pavement is widened it affects cross sectional geo-
metry and therefore the start of the widening taper should be depicted in the 
corridor with a special frequency.

399+03.67

Figure 10:  BaseLOD beam guard EAT Version 1.1 special corridor frequency locations

Feature Station in 
example

The start of the 15:1 widening taper of the HINGE POINT LINE 398+35.23

Post 1 399+53.67

Post 5 399+78.67

B-101-2.0
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Feature Station in 
example

Post 9,  coinciding with the start of the shoulder foreslope's 25 FT 
long slope transition from 4:1 to 2.5:1

400+03.67

The end of the shoulder foreslope's 25 FT long slope transition 
from 4:1 to 2.5:1.

400+28.67

The start of the clear zone's 50 FT long slope transition from 4:1 to 
2.5:1

400+37.34

The end of the clear zone's 50 FT long slope transition from 4:1 to 2.5:1 400+87.34

Optional special frequency location at start of shoulder pavement 
widening.  SDD 14b-44a does not specify widening of shoulder pave-
ment.  However, some project designs do widen the shoulder pave-
ment to match the face of beam guard, and this example has 
shoulder pavement widening included in its design concept.  When 
the shoulder pavement is widened it affects cross sectional geo-
metry and therefore the start of the widening taper should be 
depicted in the corridor with a special frequency. 

399+03.67

Figure 11:  Base LOD beam guard EAT Version 2.0 special corridor frequency locations
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Clear zone slope transition of B-101-2.0

B-101-2.0 transitions the roadway side slope within the clear zone from 4:1 to 2.5:1 over a distance 
of 50 FT.

Shoulder foreslope transition distances

B-101-1.1 transitions the shoulder foreslope slope from 4:1 to 2.5:1 over a distance of 25 FT.

Model feature example files

Design model files in contractor data packet required formats

These files are representations of the design model deliverables which would be included in con-
tractor data packets (see FDM 19-10-43.10 for design delivery requirements and CMM 7-10.3 for con-
struction responsibilities)

 1. BaseLOD-BGEAT-draft1-1.xml; BaseLOD-BGEAT-dft2.xml
 A. TOP and DATUM (finished earthwork) DTM surfaces in LandXML v1.2 format, this file 

meets surface model delivery requirements for WisDOT contractor data packets.
 2. ACAD-BaseLOD-BGEAT-CrdrBreaklines-dft1-1.dwg; ACAD-BaseLOD-BGEAT-CrdrBreak-

lines-dft2.dwg
 A. TOP and DATUM Breakline file in AutoCAD format, this file meets breakline delivery 

requirements for WisDOT contractor data packets.
 B. All Civil 3D corridor graphical elements are also included in AutoCAD format, layer 

name conventions are used to identify elements used in the designer's surface model 
definition.

 I. Elements representing the TOP surface model are identified by layers named 
specific to TOP elements.

 II. Elements representing the DATUM surface model are identified by layers 
named specific to DATUM elements.

 III. Elements representing both the TOP and the DATUM surface model are iden-
tified by layers named specific to TOPDATUM elements.  TOPDATUM clas-
sification is used when the TOP and DATUM surface models are coincident.

 3. ACAD-BaseLOD-BGEAT-Datum3DFace-dft1-1.dwg; ACAD-BaseLOD-BGEAT-Datum3DFace-
dft2.dwg

 A. DATUM (finished earthwork) surface model triangle file in AutoCAD format, this file 
meets TIN triangle delivery requirements for WisDOT contractor data packets.

 4. ACAD-BaseLOD-BGEAT-Top3DFace-dft1-1.dwg; ACAD-BaseLOD-BGEAT-Top3DFace-
dft2.dwg

 A. TOP surface model triangle file in AutoCAD format, this file meets TIN triangle delivery 
requirements for WisDOT contractor data packets.
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Non-contractor data packet files

These files are not contractor data packet deliverables:

 1. c3d-BaseLOD-EAT-draft1-1.dwg; c3d-BaseLOD-EAT-draft2.dwg
 A. Civil 3D design data that produced the model feature example.  This file is provided for 

informational purposes only, it is not intended to convey Civil 3D project delivery 
requirements or design model delivery requirements.

 B. Workflow used in development of the Civil 3D design data for this model feature 
example may not be consistent with best MDU workflow recommendations.  It is one 
way to produce design content.

 C. Content of file and data structure is not consistent with Civil 3D project delivery 
requirements, all data is in a single dwg.  Data was structured in this manner for con-
venience of sharing model feature example source data.

 2. ACAD-BaseLOD-BGEAT-DatumContour-dft1-1.dwg; ACAD-BaseLOD-BGEAT-DatumCon-
tour-dft2.dwg

 A. DATUM (finished earthwork) surface model contours (0.2' major, 0.05' minor) and sur-
face model boundary in AutoCAD format.  Contour files are not required in WisDOT 
contractor data packets, but contours could be added as a required design deliverable 
if the contracting industry indicates they are useful.  Contour files are produced from 
Civil 3D design data with little effort and are an effective visual representation of sur-
face models.

 3. ACAD-BaseLOD-BGEAT-TopContour-dft1-1.dwg; ACAD-BaseLOD-BGEAT-TopContour-
dft2.dwg

 A. TOP surface model contours (0.2' major, 0.05' minor) and surface model boundary in 
AutoCAD format.  Contour files are not required in WisDOT contractor data packets, 
but contours could be added as a required design deliverable if the contracting 
industry indicates they are useful.  Contour files are produced from Civil 3D design 
data with little effort and are an effective visual representation of surface models.

 4. BaseLOD-BGEAT-CrdrBreaklines-dft1-1.pdf; BaseLOD-BGEAT-CrdrBreaklines-dft2.pdf
 A. PDF provided for non-C3D users who would like to review model examples.  3D PDF 

file with graphical representation of model breaklines and additional corridor ele-
ments.

 5. BaseLOD-BGEAT-Datum3DFace-dft1-1.pdf; BaseLOD-BGEAT-Datum3DFace-dft2.pdf
 A. PDF provided for non-C3D users who would like to review model examples.  3D PDF 

file with graphical representation of DATUM TIN triangles.
 6. BaseLOD-BGEAT-Top3DFace-dft1-1.pdf; BaseLOD-BGEAT-Top3DFace-dft2.pdf

 A. PDF provided for non-C3D users who would like to review model examples.  3D PDF 
file with graphical representation of TOP TIN triangles.

 7. BaseLOD-BGEAT-DatumContour-dft1-1.pdf; BaseLOD-BGEAT-DatumContour-dft2.pdf
 A. PDF provided for non-C3D users who would like to review model examples.  3D PDF 

file with graphical representation of DATUM (finished earthwork) contours.
 8. BaseLOD-BGEAT-TopContour-dft1-1.pdf; BaseLOD-BGEAT-TopContour-dft2.pdf

 A. PDF provided for non-C3D users who would like to review model examples.  3D PDF 
file with graphical representation of TOP contours.
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Are you interested in seeing what people are saying about the DRAFT model examples?  See the 
Design Model trello team board page for discussions about our DRAFT status design model 
examples.  If you’d like to share your thoughts and ideas, check out the "Design model examples com-
menting and feedback #design" on page 1928 section of the "Design  model features example lib-
rary" on page 1927 to get started.

We welcome comments and questions of any subject concerning the model examples.  Here are a 
few issues we’d like you to consider and would like to hear from you about:

Level of Detail

 1. Is there sufficient design detail for less complex project situations?
 2. Are all critical geometric elements of the roadway project captured in this Base LOD example?
 3. Does this level of detail support production of plan cross sections at traditional cross section 

locations and frequencies for this type of work?

Slope geometry

 1. Questions or concerns regarding compliance with SDD 14b-44a?
 2. Are there alternative slope configurations that should be considered in addition to example 

versions 1.1 and 2.0?

Clear Zone slope transition length of B-101-2.0

Quoting from FDM 11-15-1.11 article on side slopes:  "Gradual transitions from cut to fill slopes, or 
within cut or fill slopes, will avoid unattractive bulges and sharp depressions. Do not vary fill slopes 
of adjacent full stations by more than 1:1, except under unusual conditions."

B-101-2.0 transitions the roadway side slope within the clear zone from 4:1 to 2.5:1 in a distance of 
50’, 1/3 the distance that is called for in 11-15-1.11.  The example transitions the clear zone slope 
more quickly because there is a safety benefit from the quicker transition in that it results in a 
shorter overall length of beam guard installation.  There is a slight construction cost reduction in the 
quicker transition because of the shorter overall length of beam guard installation.  Do these benefits 
outweigh the aesthetic concerns of unattractive bulges and sharp depressions that can be cause by 
quicker slope transitions?

Shoulder foreslope slope transition length of B-101-1.1 and B-101-2.0

Both example versions transition the shoulder foreslope slope from 4:1 to 2.5:1 over a distance of 
25’.  The location of this transition is protected by the beam guard and is compliant with SDD 14b-
44a.

 1. Any concerns or comments about the transition distance or location?
 2. Any concerns about constructability of the shoulder foreslope transition over a distance of 

25’?
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File Content and Format

Questions for users of contractor data packets:

 1. The corridor breakline file is a graphic representation of Civil 3D corridors with surface model 
definition elements identified by Layer naming.  There are extra graphical elements in the file 
such as corridor links (cross section elements) at each corridor frequency location (including 
plan cross section locations, plus additional locations not in plan cross sections).  Do users of 
Contractor Data Packets see value or benefit in the provision of the corridor cross section ele-
ments, categorized by surface model type in the AutoCAD layer names?

 2. Is the contour file a useful deliverable as a representation of surface models?
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Roadway resource files

Issue: Batch Surface Profile Tool

In intersection design, it takes time to create surface profiles.

Solution:

New tool to batch create surface profiles from multiple alignments.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Initializer.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-
sources.csv

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml

Issue: Retire Rebuild Surfaces Command

With the introduction of the “Rebuild out of date items” for surface objects in the Prospector, the 
Rebuild Surfaces Command is obsolete.

Solution:

Remove DOTRebuildSurfaces command.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Initializer.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml
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 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\Wiribbon24-1.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1_light.dll

Issue: Area & Length report command information enhancement

User feedback is that these tools are not intuitive for finding quick areas/lengths.

Solution:

Dynamic total lengths/areas text added to the interface. As objects are selected, the text on the UI is 
updated. Changes to the precision settings and units (areas report) also dynamically update the run-
ning total display. Clicking on the displayed total copies the value to the system clipboard for use in 
other applications. The label areas function in the areas report has been separated from the create 
report function. A separate label areas button is now provided.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

Issue: Control Profile Editor: Show transition rate

Users request the ability to see the rate of transition between control profile PVIs. This is useful for 
making sure transition rates are not extreme.

Solution:

Read-only column added to the profile edit grid that displays the rate of transition (i.e. slope ahead) 
between the profile PVIs.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

Issue: Load XRef on Layer: Add layer locking

Need a way to avoid accidental moves, deletes and scaling of XReferences.

Solution:

Add layer locking to the “Load XRef on Layer” and “Assign XRefs to Layer” commands.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Initializer.dll
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Issue: Add gaps to earthwork calculations

Civil 3D has to ability to include gaps in the earthwork quantities (example: bridge projects). 
However, the WisDOT earthwork detail report ignores the gaps.

Solution:

Update the Earthwork Detail Report to include the gaps specified in Civil 3D.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

Issue: Request from users to masks to sign blocks

Current sign blocks do not have masks and they have to be added if white space is not found in the 
plan sheet.

Solution:

New right click menu option added to block references. Select one or many block references, right 
click and choose “Add/Update mask”. Can also run from command line DOTMaskBlock. A filled 
MPolygon object is created behind the selected block reference(s). The MPolygon is placed on the 
WisDOT "P_MISC_Mask" layer. Layer is created if it does not exist.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Initializer.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1_light.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\Wiribbon24-1.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml

Issue: Purge unused references tool

Drawings can become bloated with many references that are not needed or used. Need a quick way 
to identify and remove unused references.

Solution:

New command DOTPurgeUnusedReferences presents the user with a list of XReferences, and a list 
of unused Data References in a TreeView. The user chooses references to purge. The tool also iden-
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tifies any surface profile data references in the drawing as a reminder that the best practice is to 
avoid data referencing surface profiles to avoid circular references.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Initializer.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-
sources.csv

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml

Issue: Design Surface Data Extractor: Extract from Corridor Surface

When the input surface is a corridor surface, the Design Surface Data Extractor does not extract the 
break lines. Only the boundary is extracted.

Solution:

Update the Design Surface Data Extractor to recognize if the input surface is a corridor surface and 
extract the break lines.

Updated Files:

 l C:\Pro-
gramData\Autodesk\Ap-
plicationPlugins\Wi24.1.bundle\Content\AcDesignSurfaceDataExtractor.dll

Issue: EC Block masks

Request to add a mask visibility state to all erosion control blocks.

Solution:

Mask visibility states added

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\Drainage.dwg

Issue: Section Editor Viewport Configuration

The default section editor viewport configuration is set to four views.
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Solution:

Set the default section editor viewport configuration to two horizontal, plan/section

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt

Issue: Traffic Control Barricade Block Updates

Request to have an option to flip tiger stripes in the traffic control barricade blocks.  Request to have 
a Type 3 with signage and no lights.

Incorrect wording on R11-3 Sign.

Solution:

Add Flip grip to barricade blocks to flip the tiger strips.

Rename **Type III Barricade with Signage** to  **Type III Barricade with Signage and Lites**

Create a **Type III Barricade with Signage without Lites**

Update the R11-3 visibility state to match correct wording

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\Workzone.dwg

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-4\Palettes\30-Detours.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\WZ-Signs.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\WIPaletteImages.dll

Removed Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Type III Barricade with Signage64.png

Issue: Sharrow Bike Arrow

WisDOT package does not include a bike shared lane symbol for pavement marking.

Solution:

Add the MBIKESHARED block to the Pavement Marking Palette. Also update MBIKES block and 
palette image to match the SDD.
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Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\MarkingSigning.dwg

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-6\Palettes\60-Pavement Mark-
ing.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\MBIKES64.png

New Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\MBIKESHARED64.png

Issue: Add more scales to CD speedsheet template

User request for more viewframes and layouts in the CD Speedsheet template.

Solution:

Added 10 view frames and layouts for each 1IN:5FT and 1IN:2FT scales.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\02-CD-SPSHT-wdot.dwt

Issue: TPP Title Sheet Notes-Update to match FDM

FDM fd-12-10.pdf (wisconsindot.gov) changed for TPP Title Sheet notes.

Solution:

Update the TPP Title Notes block to match the FDM.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-plats.dwt

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\Plats.dwg

 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\04-TPP-TITLE30-wdot.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\04-TPP-TITLE34-wdot.dwt

Issue: ROW Plat > Lines & Symbols > Parallel Offset: Incorrect File Path

Parallel offset button is path is searching for the wrong file in the 2020 directory.

Solution:

Update the file path to 2022.
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Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\04\Palettes\30-Lines Symbols.atc

Issue: Update (circle, square, oval, hex) tag blocks used in multileaders to have masks

Current blocks do not have masks. Request to add masks.

Solution:

MPolygons/solids added to block definition so the tag multileaders are masked. MPolygon was 
placed on the P_MISC_Mask Layer.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Dimensions\Mleaderstyles.dwg

Issue: Update Station Increment Labels tool to handle station equations

The tool skips a segment of labels when a station equation introduces the stationing that goes back 
on itself creating two instances of the same station.

Solution:

Updated to handle station equation scenarios where stations can occur multiple times.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

Issue: Update Layer P_MISC_Mask to color 249

Current layer uses color 255,255,255 and when used makes it hard to see objects in model space 
with black background (White objects over white mask)

Solution:

Color 249 in model space is a light maroon color and plots to PDF a gray that is almost white. The 
gray is mostly not noticeable. Updated all templates, dwgs, and layer states that contained this layer 
with this new color.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Layers\Layers.dwg

 l C:\WisDOT\Stnd\C3D2022\Components\Layers\Layers.dwg_LayerList.csv

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-align-prof.dwt
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 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-corridor.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-parcel.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-pipe.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-qto.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-section.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-surface.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-plat.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-survey.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\plat-start.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\survey-start.dwt

Issue: Typical Section Template and Palette Style Updates

Old dimension and multileader styles in the Typical Section Speed sheet.

Solution:

Updated the typical section speed sheet to include updated dimension styles and multileader styles. 
Added a new 060-UNDERLINE and 070-UNDERLINE multileader style for typical sections to replace 
the outdated multileader style.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\TypicalSpeedSheet.dwg

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-2\Palettes\10-Startup Main.atc

 l C:\WisDOT\Stnd\C3D2022\Components\Dimensions\Mleaderstyles.dwg

Issue: Update MQ and EW Speed sheets designer notes

Designer note included outdated workflows.

Solution:

Updated designer note to include link to updated workflows on the C3DKB.
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Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\03-MQ-SPSHT-wdot.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\09-EW-SPSHT-wdot.dwt

Issue: Fix linetype palette command to not overwrite the current default linetype

The buttons on the Linetype palette that integrate the **dotdrawlinetypetoscale** is not setting the 
default linetype in the dwg back to “BYLAYER”.

Solution:

Fixed the dotdrawlinetypetoscale command to reset the default linetype to “BYLAYER”.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

Issue: Add awareness to sheet palettes for users to add dimension styles

If the dwg does not contain the dimension styles, improper settings are used when the dimension 
style is selected from the palette.

Solution:

Add button to palettes to make users aware to add dimension styles prior placing dimensions.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Dims\Palettes\10-Dimension 
Styles.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-1\Palettes\10-Startup Main.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-2\Palettes\10-Startup Main.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-3\Palettes\20-Intersection 
Details.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-4\Palettes\10-Startup Main.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-6\Palettes\10-Startup Main.atc

Issue: DOTROTATEANNOTOVIEWPORT doesn't rotate block attributes

Command rotates the block reference, but any associated attribute text is left at its original rotation.

Solution:

Command updated to rotate attribute text along with block reference.
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Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

Issue: Command to import multileader style and create multileaders

WisDOT palettes for Multileaders have the style definitions baked into the palette .atc files. This can 
result in the palattes getting out of sync with the Multileader source files.

Solution:

Create custom commands to create MultiLeaders. The command prompts for the style name and 
then starts the mleader command. If the style does not exist in the drawing, it checks the WisDOT 
style source dwg files and imports them.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Initializer.dll

Issue: Insert Assembly from WisDOT palette introduces drawing error

After inserting an assembly from the WisDOT palettes, a drawing error is shown when running audit.

Solution:

Updated the assembly dwgs that were being called by each assembly palette tool.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies*.dwg

Issue: Update SPEL Block

The SPEL block is built using two polylines and when used in a point object, is not snappable.

Solution:

Update the SPEL block to be built out of four lines instead of two polylines. The point styles (such as 
E Surf Spot Elevation) will now be snappable using a node snap.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-marker-xsection-symbols.dwt

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\MarkerSymbols\MarkerSymbols.dwg
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 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-general.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-survey.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-plat.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-survey.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-align-prof.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-pipe.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-qto.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-point.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\plat-start.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\survey-start.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt

Issue: General Notes Blocks Corrections and Updates

Requests to adjust the new general notes blocks.

Solution:

Added project overview to standard Section 2 Order of Sheets

Removed Utility Emergency Contact Block from dwg and Palette

Updated block layers to P_MISC_Text and P_MISC.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\GenNotes.dwg

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\01\Palettes\General Notes.atc

Removed Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Emergency Contact64.png

Issue: Update Multileader Palette Buttons so most recent styles are used

Most multileaders on most of the WisDOT Sheets Palettes are out of sync with current multileader 
styles.

Solution:

All palette buttons updated with the new command to create WisDOT Multileaders - 
DOTDrawMultileader. Once the button is pressed, the tool checks the drawing for the specified 
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multileader style.  If it doesn’t exist, the style is loaded. Update multileader styles source DWG as well 
- new style "Perm Sign Note".

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Dimensions\Mleaderstyles.dwg

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\01\Palettes\Title Sheets.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-1\Palettes\10-Startup Main.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-2\Palettes\10-Startup Main.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-3\Palettes\20-Intersection 
Details.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-4\Palettes\30-Detours.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-5\Palettes\30-Storm Sewer.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-6\Palettes\60-Pavement Mark-
ing.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-6\Palettes\30-Permanent Sign-
ing.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-6\Palettes\10-Startup Main.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-7\Palettes\10-Startup Main.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\05\Palettes\20-Plan-Profile.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Multi-leaders\Palettes\10-
Multileaders.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Multi-leaders\Palettes\20-Title 
Sheet.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Multi-leaders\Palettes\30-Typ-
ical Section.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Multi-leaders\Palettes\40-Plan 
Sheet.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Multi-leaders\Palettes\50-Pro-
file Sheet.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Multi-leaders\Palettes\60-
Traffic Control.atc

Issue: Update TLE template wording

TLE Template currently states “Sheet Number”.
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Solution:

Adjusted TLEMAPTITLEBLOCK block so it reads EXHIBIT instead of SHEET.  Adjusted components to 
fit the longer word.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\04-TLE-MAP-wdot.dwt

Issue: Draw Floating Curve unhandled exception

Unhandled exception when using the Draw Floating curve command from a line with the OrthoMode 
set to 1.

Unhandled exception when using the Draw Floating curve command from a line and object snapping 
to the end of the line.

Solution:

Updated the tool to account for these scenarios.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

Issue: AE CPRC Bid items contain duplicate sizes

All apron endwall for culvert pipe reinforced concrete bid items contained duplicate diameter dimen-
sions.

Solution:

Removed the extra dimensions.

Updated Files:

 l C:\ProgramData\Autodesk\C3D 2022\enu\Data\Pay Item Data\United States\WisDOT\Items_
2020.csv

 l C:\ProgramData\Autodesk\C3D 2022\enu\Data\Pay Item Data\United States\WisDOT\Items_
2022.csv

 l C:\ProgramData\Autodesk\C3D 2022\enu\Data\Pay Item Data\United States\WisDOT\Items_
2023.csv
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Issue: Update Manhole blocks - components are not centered around insertion point

Report that the manhole blocks and components contained are not centered around the insertion 
point.

Solution:

Updated manhole block components to be centered around insertion point

 l MHO

 l MH

 l MH-EL

 l MH-SAN

 l MH-SS

 l MH-TEL

 l MH-UT

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\survey-start.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\plat-start.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-survey.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-plat.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-survey.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-qto.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-align-prof.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-general.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-pipe.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-point.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-marker-xsection-symbols.dwt

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\MarkerSymbols\MarkerSymbols.dwg

Issue: BG Assembly Updates

Incorrect width and slope parameters in Unpaved Shoulder Subassembly

Add assemblies for CG under Thrie Beam Transitions
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Unpaved shoulder subassemblies in WisDOT BG-Profile Slope Control.dwg parameters out of order

Solution:

Updated Unpaved shoulder subassembly in WisDOT BG-Profile Slope Control.dwg with latest 
ShldGeneric subassembly.

Updated all UnpvdShld subassemblies to correct settings

 l Paved slope= 4%

 l Unpaved Slope = 10%

 l Parameter reference pavement strucutre thickness to nearest paved shld subassembly

 l Adjusted method to calculate adjacent lane slope = Outside Shldr and 4%.

 l Adjusted point codes to match 2018 version of subassembly

New Assemblies for Thrie Beam Transitions in full lane and rehab scenarios

 l Includes Curb and Gutter

 l Beam Guard - Thrie Beam Transition

 l Beam Guard - Rehab - Thrie Beam Transition

Updated CrdrTrgtAssgn-BeamGuard.csv to include new subassembly names.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\WisDOT BG-Profile Slope Control.dwg

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\WisDOT BG-Rehab-NoLane-Profile Slope 
Control.dwg

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Design\Wis-A-Sub-Assemblies\Palettes\60-
WisDOT_BEAM GUARD-ASSEMBLIES.atc

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\CrdrTrgtAssgn-BeamGuard.csv

New Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\WisDOT BG-Rehab-TBT-NoLane-Profile 
Slope Control.dwg

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\WisDOT BG-TBT-Profile Slope Con-
trol.dwg

Issue: SurfaceStatistics property set updates

The SurfaceStatistics property set in “ref-property-sets.dwt is referencing the incorrect version of 
AutoCAD.  Users need guidance on how to use this property set.
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Solution:

Change the ‘ACADver’ property to a formula property so it can be updated at the property set level 
when the AutoCAD version changes. It is currently a text property, so it must be updated at the 
object level.

Include a Civil 3D ‘Note’ label (Surf_3DArea) example in the “ref-property-set.dwt” to demonstrate 
how to use the SurfaceStatistics property set in labels.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-property-sets.dwt

Issue: Create Alignments from BG block unhandled exceptions

When a folder already exists for the BG alignments, an unhandled exception occurs, and the align-
ments are not created.

Unhandled exception when alignment names already exist.

Solution:

Tool checks if folder already exist.

Tool checks if alignment names already exist and goes with next counter.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOT.Extensions.dll

Structure resource files

Issue: Structures - Updated Blocks

 l Incorrect tables in DEFLECTION, SHEET_LIST, TANOFF, TOD

 l Added TABLE block for more easily creating generic tables

 l Added GT_BORING_TABLE block and removed the optional boring table from the GT_GRID 
block

 l Incorrect SHEET_PILE linetype

 l Separate ABUT_FILL block to add CULBF and WALL_BF blocks, and add fill behind culvert wing 
wall detail.

 l Error in geometry for the 56SS parapet in the BARRIERS block.

 l Update DESIGN_CONTACTS block for staff changes.
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Solution:

Updated the blocks to be correct.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\structures.dwg

Issue: Structures - File type

Error with file type tool not corrected last quarter.

Solution:

Updated the tool to remove the bug.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\ WisDot.Bos.Acad.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\ WisDot.Bos.Draft-
ing.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\ WisDot.Bos.Geo-
metry.dll

Issue: Structures - Updated Palette Images

Update tool palette to reference resource library instead of individual images.

Solution:

Updated the tool to remove the bug.

Updated Files:

 l \WiBOSPaletteImages.dll

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\02-Anno.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\03-General.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\04-Quan.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\05-Substr.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\06-Rebar.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\07-Super.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\08-Barriers.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\09-Steel.atc
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 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\10-Culvert.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\11-Misc.atc

2023-01-25

Roadway resource files

Issue: Solution for scheduled batch plotting of DSDs

Need an efficient way to batch plot using multiple DSD files and the ability to schedule those plots to 
run at a specified time and recurrence.

Solution:

Publish Collections Manager (DOTPublishCollectionsManager) developed to manage and execute the 
plotting of multiple DSD files (Publish Collection).

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-
sources.csv

New Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\BatchPublish.dll

Issue: Supplemental tools for AutoCAD drafting

Several gaps exist with out of the box AutoCAD draw tools.

 l Fillet: When creating a fillet between two arc or circle entities, the fillet direction cannot be 
chosen.

 l Draw Line tangent to Arc/Circle: This works with out of the box tools, but only to the extent of 
the arc. Need to draw a line tangent to the full circular projection of the arc.

 l Draw floating arc: Need to dynamically draw an arc tangent to lines, arcs, and circles while see-
ing it’s proposed position as the cursor moves.
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Solution:

Create four new commands and add them as buttons to a new “Draw” panel on the WisDOT Design 
ribbon.

Ribbon buttons on the new Draw Panel:

 l WisDOT Design > Draw > Lines > Floating Line

 l WisDOT Design > Draw > Lines > Free Line

 l WisDOT Design > Draw > Curves > Floating Curve

 l WisDOT Design > Draw > Curves > Free Curve

Commands:

 l DOTDrawFloatingLine: Command prompts for an arc or circle entity. A preview of the line 
is drawn dynamically based on the cursor position. User selects the end point of the line to 
add the entity to the drawing.

 l DOTDrawFreeLine: Command prompts for two arc/circle entities. User is presented will all 
possible tangents between the entities. User selects the desire tangent to add to the drawing.

 l DOTDrawFloatingCurve: Command prompts for a line, arc, or circle entity and a radius for 
the proposed arc. A preview of the arc is draw dynamically based on the cursor position. The 
radius can be change while the command is active. User selects the end point of the arc to 
add the entity to the drawing.

 l DOTDrawFreeCurve: Command prompts for two arc/circle/line entities and a radius. User is 
presented with all possible curve options and can choose one to add to the drawing. The 
radius can be changed while the command is active.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1_Light.dll

Issue: Copy Assembly

Need a more efficient way to copy an assembly between two drawings.

Solution:

Added new command Copy Assembly to the Assembly object context menu. Added Assembly - 
Paste to Original Coordinates and Assembly - Paste commands to the Application default context 
menu.
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 l Paste commands are only visible when an assembly has been copied.

 l One paste per copy allowed.

 l Option to specify for a new name for the pasted assembly is provided.

 l New assembly will use the original code set style assignment if it is available.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: General Notes Upgrades

Request from NE and NC regions to enhance the General Notes Palette with more standardized 
blocks, text, and general notes.

Solution:

Create new blocks, notes, and objects for the palette.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\NotesTables.dwg

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\plansht.dwg

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\cdErosionControl.dwg

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-1\Palettes\cdErosionControl.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\01\Palettes\General Notes.atc

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

New Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\02-GN-SPSHT-wdot.dwt

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\GenNotes.dwg

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Miscellaneous Contact64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Survey Coordinator Contact64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\County Highway Commissioner 
Contact64.PNG"

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\City-Town Contact64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Design Project Manager 
Contact64.PNG"

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Design Leader Contact64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\DNR Contact64.PNG"
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 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Emergency Contact64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Utility Contact64.PNG"

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Utility Header64.PNG"

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Paving Table64.PNG"

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Order of Sheets64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\General Notes Header64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Standard General Notes64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Standard Abbreviations64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Diggers Hotline64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Runoff Coefficient Table64.PNG

Removed Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\GN Utility Contact Format64.PNG

Issue: Create a Clear Zone Width from profile target parameter for sub Day-
lightProfileControlled and a Recoverable distance from profile target parameter for sub 
CutFillProfileControlled

Controlling the location of the slope break between recoverable and non-recoverable slopes (clear 
zone/recoverable width) would be easier with a control profile than editing a horizontal target object.

Solution:

Added new “Clear zone width from profile” elevation target to DaylightProfileControlled.

Added new “Recoverable distance from profile” elevation target to CutFillProfileControlled.

Updated Files:

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\CutFillPro-
fileControlled\e31774a1f6be4f37ae4b8c2a88d90fa5.atc

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\CutFillPro-
fileControlled\e31774a1f6be4f37ae4b8c2a88d90fa5.cfg

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\CutFillPro-
fileControlled\e31774a1f6be4f37ae4b8c2a88d90fa5.dll

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\CutFillPro-
fileControlled\e31774a1f6be4f37ae4b8c2a88d90fa5.emd

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\CutFillPro-
fileControlled\e31774a1f6be4f37ae4b8c2a88d90fa5.pvd
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 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\CutFillPro-
fileControlled\e31774a1f6be4f37ae4b8c2a88d90fa5.xaml

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\Day-
lightProfileControlled\c8544c3853224aabb4e5311832173a93.atc

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\Day-
lightProfileControlled\c8544c3853224aabb4e5311832173a93.cfg

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\Day-
lightProfileControlled\c8544c3853224aabb4e5311832173a93.dll

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\Day-
lightProfileControlled\c8544c3853224aabb4e5311832173a93.emd

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\Day-
lightProfileControlled\c8544c3853224aabb4e5311832173a93.pvd

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\Day-
lightProfileControlled\c8544c3853224aabb4e5311832173a93.xaml

Issue: Input CSVs updated related to adding Clear Zone width from profile to Day-
lightProfileControlled sub

Solution:

Add parameters to input CSVs for Create Control Profiles in Control Profile Editor and Set Corridor 
Target tools

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-
US\CreateSlpCntlProfs.csv

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-
US\CreateSlpCntlProfs-ReturnFillet.csv

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\CrdrTrgtAssgn-BeamGuard.csv
 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\CrdrTrgtAssgn-FilletReturn.csv
 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\CrdrTrgtAssgn-FullSection.csv

Issue: Fix ProfileToParameterRef default output values

The ProfileToParameterRef subassembly does not use the input values as an output value for the 
referencing subassembly when in layout mode.

Solution:

Update the ProfileToParameterRef subassembly so the input values are used as the default output 
parameter reference value for the consuming subassembly.
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Updated Files:

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\ProfileToParameterRef\3d662*

Issue: Plat Palette button does not work

On the ROW/Plat Palette > Non-TPP Tab. The O4-PLAT-Title button does not work.

Solution:

Command updated to point to the correct file.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Intersection Assemblies - Update Returns to remove crown point Codes - Add 
Sideroad CL Assembly

The intersection assembly for curb returns have the lane not inserted properly. Also, there is not a 
standard assembly for the Sideroad Centerline.

Solution:

Update the lane subassembly so the crown is on the outside and there are no Crown point codes. 
Add a Sideroad CL assembly.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\WisDOT Curb Return Fillet.dwg

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\WisDOT Shoulder Return Fillet.dwg

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Design\Wis-A-Sub-Assemblies\Palettes\70-
WisDOT_INTERSECTION-ASSEMBLIES.atc

New Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\WisDOT Sideroad CL.dwg

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\Sideroad CL.png

Issue: Erosion Control Legend - Culvert Pipe Check Correction

The erosion control legend has the culvert pipe check incorrectly named: “Culvert Pipe Ditch Check”

Solution:

The block was updated to the correct name: “Culvert Pipe Check”
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Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\Drainage.dwg

Issue: Create Superelevation Profiles does not run

Unhandled exception when attempting to run Create Superelevation Profiles.

Solution:

Fixed issue where application attempts to populate data grid before necessary rows are established.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: CDP Integrity Report - Read zip subfolders within a zip folder

Data Referenced alignments should not be listed since they are read-only.

Solution:

Filter out Data Referenced alignments so they no longer show in the list of alignments.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Remove DRef alignments from Superelevation Runout lists

DRef’d alignments should not be listed since they are read-only.

Solution:

Filter out DRef’d alignments so they no longer show in the list of alignments.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Lengths Report/Areas Report unhandled exception with no alignments in draw-
ing

Lengths report does not support lines, arcs, circles, or ellipses. When quick total option is used for 
these reports, the value must be transposed to the destination.
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Solution:

Support for lines, arcs, circles, and ellipses added to the Lengths Report. When the quick total option 
is used for the Areas Report/Lengths Report, the resulting value is now added to the clipboard so it 
can be pasted to the desired destination.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Areas Report/Lengths Report enhancements

Lengths report does not support lines, arcs, circles, or ellipses. When quick total option is used for 
these reports, the value must be transposed to the destination.

Solution:

Support for lines, arcs, circles, and ellipses added to the Lengths Report. When the quick total option 
is used for the Areas Report/Lengths Report, the resulting value is now added to the clipboard so it 
can be pasted to the desired destination.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Survey Database Settings file update to fix figure edit crashes

Issues with making edits to survey figures in SSD leads to crashes in some situations.

Solution:

Set the default for the Logging Enabled for Change Reporting setting to NO in the settings file. This 
will turn off logging of changes when making changes to survey entities and committing them to the 
database.

Updated Files:

C:\ProgramData\Autodesk\C3D 2022\enu\Survey\WisDOT Survey Database Settings.sdb_set

Issue: Add Create Corridor Surfaces input CSV for roadway and curb returns

Create an additional CSV for automatically creating corridor surfaces for setup corridors.

Solution:

New CSV file added that uses the link codes Top, Norm, Min, and Max to create each surface.
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New Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-
US\CreateSetupSurfs.csv

Issue: Sync Project Files: ACC compatibility

The command DOTSyncProjectFiles does not work with projects on ACC. Two issues are known:

 l ACC file paths are per user, so if a different user tries to load the file/object list CSV, an error 
occurs.

 l An error occurs when a drawing save is attempted via the .NET API.

Solution:

 l When loading a CSV that contains user-specific paths, the paths are now converted to the cur-
rent user path for that session.

 l Drawing save is now performed by sending the QSAVEcommand to the command line. This 
change has only been tested for Desktop Connector 16.0 and newer.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: DWG Clean: ACC compatibility

The command DOTDrawingClean does not work with files on ACC. An error occurs when a drawing 
save is attempted via the .NET API.

Solution:

Drawing save is now performed by sending the QSAVEcommand to the command line. This change 
has only been tested for Desktop Connector 16.0 and newer.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Add type TBT curb head for 30-inch and 36-inch, add Types R and T to 30-inch

There appears to be a new curb head type TBT that can be for both 30-inch and 36-inch curb and gut-
ter that need to be added. Currently in the CGBasic sub, both R and T are assigned to 36-inch. They 
need to be added as options to the 30-inch group also.
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Solution:

Type R and T have been added as options to the 30-inch group.

New Files:

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\CGBasic2.

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Design\Wis-A-Sub-Assemblies\Palettes\10-
WisDOT_ROADWAY.atc

Issue: Input CSVs updated related to adding Clear Zone width from profile to Day-
lightProfileControlled sub

Solution:

Added parameters to input CSVs for Create Control Profiles in Control Profile Editor and Set Cor-
ridor Target tools

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-
US\CreateSlpCntlProfs.csv

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-
US\CreateSlpCntlProfs-ReturnFillet.csv

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\CrdrTrgtAssgn-BeamGuard.csv

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\CrdrTrgtAssgn-FilletReturn.csv

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\CrdrTrgtAssgn-FullSection.csv

Structure resource files

Issue: Structures - Updated Blocks

 l Update ABUT_FILL block to correct typos, remove recursive blocks, and adjust dimension 
pointing to incorrect location.

 l Update CULINLET to align with standard details.

 l Update DECK_SECTION to allow stacked fractions.

 l Update DESIGN_CONTACTS block for staff changes.

 l New blocks: PS_GIRD_PLAN, BAR_SIZES

Solution:

Updated the blocks to be correct.
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Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\structures.dwg

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\02-Anno.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\03-General.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\06-Rebar.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\07-Super.atc

Issue: Structures – Add Dimension Style

Request for a dimension style that uses decimal-feet for design sketches.

Solution:

Added a new dimension style named “Decimal” and a shortcut to this style in the tool palette.

Updated Files:

 l C:\WisDOT\Stnd\ C3D2022\Templates\Begin-dwg\struct-decimal-start.dwt

 l C:\WisDOT\Stnd\ C3D2022\Templates\Begin-dwg\struct-inch-start.dwt

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\02-Anno.atc

2022-11-02

Roadway resource files

Issue: Control Profile Editor: Default CSV access

Need more convenient access to the WisDOT default CSV.

Solution:

Added a button to to open the WisDOT default CSV (read-only) in the default CSV editor. User can 
"Save As" the CSV to a desired location for further editing.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Point Station/Offset to UDP rebuild

Incorporate multiple user requests to the Point Station/Offset to UDP tool.
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Solution:

Tool rebuilt with the following enhancements:

 1. Adds USWI Alignments UDP to drawing if it does not exist.

 2. If a point is coincident with the center of curve for any curve in the drawing, the radius value 
is populated.

New command name is DOTPOINTSOUDP.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-
sources.csv

 l C:\Pro-
gramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTCivil3DExtensions.dll

Issue: Control Profile Editor: Allow '%' value entries

The Control Profile Editor automatically interprets entries that contain ':' as X:1 slope and converts 
the values to ft/ft. Option requested to enter values with a '%' and convert those to ft/ft.

Solution:

Control Profile Editor enhanced to allow values entries that contain '%'. These values are converted 
from percent to ft/ft.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Control Profile Editor - Copy PVI(s) from one profile into another

Need a way to copy profile PVI(s) from one control profile to another.

Solution:

Right click menu option added for the edit control profile grid.

Menu command copies selected PVI(s) from the active profile to another control profile with the 
same parent alignment. This function will not overwrite PVI stations that already exist under the des-
tination control profile. Menu is not available if only one control profile exists under the alignment.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
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Issue: Create profile from points

An automated process is needed to create a profile from point data. This tool will benefit the Check 
Profile Sight Distance analysis which is intended to be used when limited design data is available.

Solution:

New tool created DOTCreateProfileFromPoints. Tool uses points in a Point Group to develop a pro-
file.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-
sources.csv

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml

Issue: Updated SetCrdrTargets input CSV for Beam Guard

There was an error in the setting of paved shoulder feature line in the area of beam guard.

Solution:

Correct the input CSV for beam guard.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Assemblies\CrdrTrgtAssgn-BeamGuard.csv

Issue: Apply Layer State

An enhanced method for applying layer states is needed to include XReference layers when applying 
a layer state.

Solution:

New tool "Apply Layer State" added. Access is via command line DOTApplyLayer or via the Layer Col-
ors Manager. The Apply Layer State tool applies the selected layer state to the active drawing, with 
the option to apply it to any corresponding XRef layers and save the layer state with the cor-
responding XRef layers.
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Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-
sources.csv

Issue: Layer Colors Manager

Incorporate several enhancement ideas into the Convert Layer Colors tool.

Solution:

Convert Layer Colors tool rebuilt and renamed to "Layer Colors Manager".  Command is DOTLay-
erColorsManager. Changes include:

 l Add layer colors to the grid view.

 l Grid view sortable by layer or color

 l Add same layer selection controls as Layer Properties Manager

 l Tool reactive to changes in drawing

 l More compact design

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-
sources.csv

Issue: Fix MultiProfToParameterRef default output values

The MultiProfToParameterRef subassembly does not use the input values as an output value for the 
referencing subassembly when in layout mode.

Solution:

Updated the MultiProfToParameterRef subassembly so the input values are used as the default out-
put parameter reference value for the consuming subassembly.
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Updated Files:

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\MultiProfToParameterRef\*.*

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Design\Wis-A-Sub-Assemblies\Palettes\30-
WisDOT_GENERAL SUBASSEMBIES.atc

Issue: Change DRef Surface Storage

Currently when a data reference surface is created the geometry is stored in a drawing. There is a 
command setting which controls whether the geometry of reference surfaces is saved in the draw-
ing.

Solution:

Changed the command setting which controls whether the geometry of reference surfaces is saved 
in the drawing to NO.

The geometry of reference surfaces will not be saved in the drawing. When set to NO, the reference 
is checked every time the drawing is opened. The drawing will be smaller and save faster but will 
open more slowly.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\plat-start.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\survey-start.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\x-wisdot.dwt

Issue: Excel Add-in: Create multiple instances of header cells

It is difficult to fit long tables onto plan sheets. They often need to be broken up. Need to insert 
header rows multiple times in long tables so they can span multiple plan sheets.

Solution:

Created an Excel Add-in tool to replicate selected cells at a specified frequency of rows. "Repeat 
Selection Every ___"

Updated Files:

 l WisDOTC3DExcelAddinSetupx64.msi

 l WisDOTC3DExcelAddinSetupx86.msi
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Issue: Add WisDOT default paths to the AutoCAD Block Library palette tab

The AutoCAD INSERT Blocks palette Library tab does not have the WisDOT default paths added.

Solution:

Added the WisDOT default paths to the Block Library. A profile reset may be required to see the 
changes.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\2022wisdot.arg

Issue: New standard size manholes

2023 spec book includes standard 9-FT and 10-FT manholes. These are not currently included in the 
WisDOT Civil 3D storm sewer parts list.

Solution:

 l Added 9-FT and 10-FT manholes to the Storm Sewer parts list.

 l Removed the 10-FT sizes from the Non-Standard parts list.

 l Added 9-FT manhole to parts catalog.

 l Added 2023 Spec year pay item files

 l Mapped start templates to 2023 spec year pay item files

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Program\PipesCatalog\Structures_USWI\USWI Manholes\USWI_
Cylinder_Manholes 3-8.xml

 l C:\WisDOT\Stnd\C3D2022\Program\PipesCatalog\Structures_USWI\USWI Inlets\Type C Cover-
s\USWI_Cylinder_Manholes 3-8_C.xml

 l C:\WisDOT\Stnd\C3D2022\Program\PipesCatalog\Structures_USWI\Aec-
cSharedPropertyLists.xml

 l C:\WisDOT\Stnd\C3D2022\Program\PipesCatalog\Structures_USWI\Structures_USWI.apc

 l C:\WisDOT\Stnd\C3D2022\Program\PipesCatalog\Structures_USWI\Validate\Catalog_Regen_
Summary.txt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-pipe.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt
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New Files:

 l C:\ProgramData\Autodesk\C3D 2022\enu\Data\Pay Item Data\United States\WisDOT\Cat-
egories_2023.xml

 l C:\ProgramData\Autodesk\C3D 2022\enu\Data\Pay Item Data\United States\WisDOT\Items_
2023.csv

Issue: Pavement marking layers: Correct layer settings

The layer settings for the majority of the pavement marking layers are incorrect.

Solution:

The layer settings were corrected to Pre-2020 standards.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Layers\Layers.dwg

Issue: Update WisDOT Standard table size margins

Initial release had 0.03 margins on all cells.

Solution:

Update to 0.02 vertical and 0.01 horizontal to minimize cell size.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Tables\Tables.dwg

 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\03-MQ-SPSHT-wdot.dwt

 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\09-EW-SPSHT-wdot.dwt

Issue: Label Assemblies tool causes C3D crash

When using the Label Assemblies command from the Assembly right click menu, Civil 3D crashes.

Solution:

Code revised to avoid C3D crash.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
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Issue: Palette image consolidation

There are many palette image files that are duplicated because they are used on multiple palettes. 
There are also many palette image files that are no longer used.

Solution:

Created a shared palette image directory. Re-mapped palette ATC files to the shared image dir-
ectory. Removed image files that are no longer used. Used built-in Autodesk images wherever pos-
sible. For blocks, used a single image for dark/light modes.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\*.atc

New Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Images\*

Removed Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\ (various unused files)

Issue: Alignment Description Report Save Error

The Alignment Description Report produces a file save error. The report is created, but it is not auto-
matically saved.

Solution:

"Save as" path repaired to eliminate error.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: PDFSHX system variable

Some PDF outputs have comments created where there should be text.

Solution:

Set PDFSHX = 0 at application startup for WisDOT devices. External users can apply WisDOT-specific 
settings using DOTSETWISDOTVARIABLES.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
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Issue: Superelevation Report: Stations out of alignment range

Occasionally, an alignment superelevation definition may contain stations that are outside of the 
alignment range. The WisDOT superelevation report does not run in this scenario.

Solution:

WisDOT superelevation report modified to handle superelevation data that is outside of the align-
ment range.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: BG EAT R Left Curve block pavement edge graphic issue

Adjusting the radius to the BG EAT R Left Curve block pavement edge shows a full circle.

Solution:

Updated the BG EAT R Left Curve parametric block to not show extraneous graphics when modifying 
the radius.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\Parametric\param-bg-eat.dwg

Issue: BG EAT note linetypes set to ByLayer instead of Continuous

Note lines for post offsets and radius were set to ByLayer. If these blocks were put on a beam guard 
type layer they inherited that linetype.

Solution:

All note object linetypes were set to Continuous.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\Parametric\param-bg-eat.dwg

Issue: BG EAT paved shoulder goes out of range

The paved shoulder polyline could become corrupt depending on edits made.
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Solution:

Grips were removed and a maximum value set to distTotaltoPavedShldrto eliminate problems.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\Parametric\param-bg-eat.dwg

Issue: Add type TBT curb head for 30-inch and 36-inch, add Types R and T to 30-inch

There is a new curb head type TBT that can be used for both 30-inch and 36-inch curb and gutter.

Currently in the CGBasic sub, both R and T curb head types are assigned to 36-inch. They need to be 
added as options to the 30-inch group.

Solution:

Added type TBT curb head for 30-inch and 36-inch, added Types R and T to 30-inch

Updated Files:

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\CGBasic\1f-
bae749c07644d9892c9b3be42ac296.atc

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\CGBasic\1f-
bae749c07644d9892c9b3be42ac296.cfg

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\CGBasic\1f-
bae749c07644d9892c9b3be42ac296.dll

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\CGBasic\1f-
bae749c07644d9892c9b3be42ac296.emd

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\CGBasic\1f-
bae749c07644d9892c9b3be42ac296.xaml

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Design\Wis-A-Sub-Assemblies\Palettes\10-
WisDOT_ROADWAY.atc

Issue: CDP Integrity Report: Remove check for Contractor Feedback

The Contractor Feedback Form has been removed from the CDP. It is now given to the contractor via 
a web survey.

Solution:

Remove the check for the Contractor Feedback form.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
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Issue: Assign Corridor Targets tool Unhandled Exception

Assign Corridor Targets tool sometimes gives Unhandled Exception errors when starting.

Solution:

Error resolved.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Set Linetype to Continuous for all blocks in the Beam Guard Detail tool palette

The beam guard detailed hardware component blocks obtained their linetype setting from the cur-
rent layer on insertion from the palette.  This resulted in undesired linetypes when placed on beam 
guard layers.

Solution:

All blocks in Beam Guard Detail tool palette have linetypes set to Continuous. They will now display 
correctly when placed on layers with beam guard linetypes.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\Parametric\param-bg-dtl.dwg

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Design\Parametric\BeamGuard\Palettes\20-
Beam Guard Detail.atc

Issue: Rename DOTResetWisDOTProfile

The name of this command and its description is not accurate. The command actually deletes the 
current profile. It does not have to be a WisDOT profile. It will not delete the <<C3D_Imperial>> pro-
file.  

Solution:

Command name and description edited to reflect the actual functionality. New command name is 
DOTRemoveCurrentProfile. Added warning when running the command indicating that the current 
profile will be removed and Civil 3D will exit.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix
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 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml

Structure resource files

Issue: Structures - Updated Blocks

 l PPT_TRANSITION had incorrect width at end of transition.

 l Typos in CULV_JT and RODENT blocks.

 l Added additional slope detail to ABUT_FILL

 l Update DESIGN_CONTACTS block for staff changes.

 l New blocks: WALL_NOTES, BAR_LAP, SLAB_SECTION and SLAB_SECTION_NOTCH

Solution:

Updated the blocks to be correct.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\structures.dwg
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\06-Rebar.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\07-Super.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\11-Misc.atc

Issue: Structures –Culvert Palette

The Apron Joint detail gives the detail for joints between barrels.

Solution:

Update Culvert Palette to correct blocks.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\10-Culvert.atc

Issue: Structures –TemplatesPalette

Missing ability to import standard Structures layers, and difficult to check a file to see if it follows the 
standards in the Structures templates.

Solution:

Added two new tools to the Templates Palette:
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 l Import Structures Layers tool will import any missing standard structures layers and correct 
any non-standard settings in existing structures layers.

 l Check Drawing Type tool will check the drawing’s settings and let you know if it is set up as a 
structures layout file (decimal-ft), a structures details file (architectural-in), or if the file has 
bad settings and may cause errors.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\01-Templates.atc

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\wisdot.bos.acad.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\wisdot.bos.drafting.dll

Issue: Structures –Breakline Tool

The Breakline tool on the annotation palette would not scale correctly when an annotative dimen-
sion style was being used. The tool would crash if it was used in an invalid drawing file.

Solution:

Updated the tool to correct these errors.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\wisdot.bos.acad.dll

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\wisdot.bos.drafting.dll

2022-08-31

Roadway resource files

Issue: Update WisDOT Design Criteria 2009.xml

According to the WisDOT FDM/SDD Transmittal 424 Update Notification – May 17, 2022, the sight dis-
tances standards have been updated to reflect those listed in a more current version of the AASHTO 
Green Book Edition 2018.

Solution:

Revise file to match FDM update which is based on 2018 Policy on Geometric Design of Highways 
and Streets standards.

 l Update Categories
 l Add additional design speed standards
 l Update passing sight distances
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Updated Files:

 l C:\ProgramData\Autodesk\C3D 2022\enu\Data\Corridor Design Standards\Imperial_WisDOT 
Design Criteria 2009.xml

Issue: Add New Roadway Access Control lines to ROW/Plat palette

New Roadway Access Control lines missing from R/W Palette. Layers and linetypes exist, only need to 
create palette buttons.

Solution:

Add buttons for Access by New Project Line (Triangles) and Access by New Project Segment 
Line (Triangles) on the ROW/PLAT Palette. 

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\04\Palettes\30-Lines Symbols.atc

Issue: Assign Page Setup

Code consolidation. Some functions are not needed for the Multi-page setup tool

Solution:

Tool redeveloped. New command DOTAssignPageSetup

 l Removed "Show model space in Layouts" checkbox. Model space is automatically excluded
 l Change page setups selection to a combo box.
 l Added help button

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

Removed Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\MultiPageSetup.dll

Issue: Control Profile Editor Rebuild

Multiple enhancement request.

Solution:

Public summary of the solution developed.
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 l Add to Alignment right click menu
 l Open to "Edit" tab if control profiles exist. Open to "Create" tab is no control profiles exist.
 l Only display control profiles that do not include curves
 l Only display alignments on the edit tab that have ZCP profiles
 l Eliminate "Remove" tab
 l Allow elevation entries as ft/ft or x:1.
 l Full station equation support, including when stations occur multiple times
 l Allow station edits in data grid view
 l Add style choices for profile style and label set style
 l Auto profile update when editing table
 l Auto-populate profile view name, but remain editable
 l Display option to choose which profiles to create in CSV

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Removed Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\SlopeControlEditor.dll

Issue: Swap Parts not functioning

The WisDOT swap multiple pipe network parts tool is not functioning. It does not read the drawing 
parts lists.

Solution:

Redevelop tool with new command DOTSwapParts.  

 l Parts can be swapped by multiple methods. 

 o Preselect all parts to be swapped (must be all structures or all pipes). Then run the 
command. Command can be accesses with the right click menu, button on ribbon tab, 
or command line.

 o Run the command and then choose to select structures or pipes.
 l All available parts lists are presented in a tree view. The desired part is selected from the tree 

view.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

Removed Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\SwapParts.dll
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Issue: Swap Parts List Styles

Code consolidation.

Solution:

Tool redeveloped for consistency for other WisDOT tools. New command 
DOTSwapPartsListStyles

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-

sources.csv

Issue: Adjust Superelevation Runout

Code consolidation

Solution:

Tool redeveloped for consistency for other WisDOT tools. New command DOTAd-
justSuperelevationRunout

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

Removed Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\SEUpdate.dll

Issue: Remove Earthwork "Beta" label

No further user feedback has been received on the new earthwork reporting tools.

Solution:

Remove the "Beta" label on the new earthwork reporting tools. 

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix
 l WisDOTC3DExcelAddinSetupx86.msi
 l WisDOTC3DExcelAddinSetupx64.msi
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Issue: Sight Distance: 2D analysis

A non-AutoTURN option is needed for the "quick" 2D Sight Distance analysis on profiles.

Solution:

Provide new tool for analyzing sight distance on Civil 3D profile options. DOTCheck-
ProfileSightDistance

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-

sources.csv

New Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\C3D_Check-
ProfileSightDistance.png

Issue: Set Text Style/Size rebuild

The Set Text Style/Size tool is not functioning properly.

Solution:

Rebuild the tool. New command DOTSetTextStyle.  Remove former command. Improvements 
include:

 l Load WisDOT text style when initializing tool
 l Bi-directional connection with AutoCAD TextStyle and TextSize variables.
 l Added MText button

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
 l C:\Pro-

gramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTCivil3DExtensions.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-

sources.csv
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Removed Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\SetTextSize.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\SetTextSize.ini

Issue: Design Surface Data Extractor and ACC

The Design Surface Data Extractor fails to run on projects kept on ACC.

Solution:

Updated the Design Surface Data Extractor to use the new Civil 3D Data Shortcut API. Removed the 
input for the Data Shortcut project folder since it is no longer needed. Updated the palette behavior 
at startup.

Updated Files:

 l C:\Pro-
gramData\Autodesk\Ap-
plicationPlugins\Wi24.1.bundle\Content\AcDesignSurfaceDataExtractor.dll

 l C:\Pro-
gramData\Autodesk\Ap-
plicationPlugins\Wi24.1.bundle\Content\AcDesignSurfaceDataExtractor.dll.config

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
 l C:\Pro-

gramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTCivil3DExtensions.dll

Removed Files:

 l C:\Pro-
gramData\Autodesk\Ap-
plicationPlugins\Wi24.1.bundle\Content\AcDesignSurfaceDataExtractor.xml

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\AcDesignSur-
faceDataExtractor.resources.dll

Issue: Structure Sump Adjust

Code consolidation. Improved access and ease of use for the Sump Adjust tool is needed.

Solution:

Tool redeveloped. New command DOTAdjustSumps

 l Removed UI and moved to command line
 l Command can be accessed from the ribbon or the structure right click menu
 l Structure selection is more flexible. Can select all or individual using command prompt. Pick-

first options added to allow selection on screen or using Toolspace-Prospector.
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Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

Removed Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\SumpAdjust.dll

Issue: Lengths Report, Areas Reports, 3D Surface Area Report : station format

Users' request easier access to station values in the reports.

Solution:

Separate begin and end station values into separate columns. Keep station values as numbers and 
use Excel formatting to include the '+' character.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Areas/Lengths Report: Include object Layer

The object layer is needed to help sort out the resulting quantities in the report

Solution:

Add a column to report the object layer.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Earthwork Detail Report: Ability to delete columns

The formulas created in Excel by the Earthwork Detail Report include dependencies on columns that 
are often deleted because they are not used on all projects. If these columns are deleted, the down-
stream formulas no longer function.

Solution:

Implement the IFERROR() function in Excel formulas that are downstream of columns that are fre-
quently deleted.
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Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Update Earthwork Template.xslx

Formatting of earthwork template - details - resulted in unwanted cell borders on portions of the 
Mass Ordinate Column due to the proximity of that column to the notes. Real Station does not wrap. 
Confusion on if 3rd column of notes on detail sheets are required for plan sheets.  Some cells need to 
be merged for use with the C3D Datalink>Table workflow.

Solution:

Bundle and Apps Versions: Move the notes to Column Y to add separation between Mass Ordinate 
Column and the notes. Change Cell B2 (Real Station) to Wrapped Text. Modified formatting of 3rd 
column of Detail Notes to reflect they are designer notes. 

Bundle Version only: Detail sheet merged/Left Align cells A1:M1.  Merged/Left aligned each row of the 
Ewk Summary Notes cells. Update Cell D8 of Earthwork Summary Template to warn users to delete 
the un-needed row if EBS column is deleted. 

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\Earthwork Tem-
plate.xlsx

 l C:\WisDOT\Stnd\Apps\Earthwork Template.xlsx

Issue: Rename MQ_Named Range

There is a misunderstanding over the purpose of this tool due to the "MQ" prefix. The purpose of the 
tool is to create easily distinguishable named ranges for data linking in AutoCAD. It can be used for 
any data linking purpose, not just for miscellaneous quantity tables.

Solution:

Rename tool to "Data Link Named Range". Change named range prefix to "DL".

Updated Files:

 l WisDOTC3DExcelAddinSetupx86.msi
 l WisDOTC3DExcelAddinSetupx64.msi

Issue: Add WisDOT Parts Lists button not working

The Add WisDOT Parts Lists button is not working.

Page: 1999

Published on: 5/17/2023

WisDOT Civil 3D 2022 "What's new?"



Solution:

The button is calling an unknown command. It should be calling DOTAddWisPartsLists.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

Issue: Shrink Wrap Corridor Surface - Boundary creation error

DOTShrinkwrapCorridorSurface returns a boundary error when the corridor has multiple regions 
and at least 1 region has a single isolated station that includes the boundary point codes. The error 
occurs because a polygon boundary can not be defined by less than 3 points.

Solution:

Instances where where the defining point codes occur at a single isolated station are now ignored.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Remove styles for Sight Distance analysis for 6-in object

According to the WisDOT FDM/SDD Transmittal 424 Update Notification – May 17, 2022, the sight dis-
tances standards have been updated to reflect those listed in a more current version of the AASHTO 
Green Book Edition 2018.

 l Standards involving a 6-in object height have been removed
 l Category 3 has been removed

Solution:

Remove styles:        Profile > Profile Styles > SD Available Sight Distance 6in       Update style:

 l Rename Profile > Profile Styles > SD Available Sight Distance 24in to SD Available Sight Distance
 l Rename Profile View > Band Styles > Profile Data > Distance Left (24in Object Height) to 

Distance Left (Available Sight Distance)
 l Rename Profile View > Band Styles > Profile Data > Distance Right (6in Object Height) to 

Distance Right (Stopping Sight Distance)
 l Profile View > Band Styles > Band Sets > Sight Distance use renamed Profile data

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-align-prof.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-plat.dwt
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 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-survey.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt

Issue: WisDOT Ribbon Icon Clean-up

There a many legacy icons that are no longer used. Some icons appear blurry.

Solution:

Consolidate redundant images and use stock images where possible. Remove images that are no 
longer in use.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\Bulldozer.png
 l C:\Pro-

gramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\ExcelLogo3DataLink.png
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\layers_map.png
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\C3D_RebuildSur-

faces.png
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\C3D_paletteRCDATA2-

doptim.png
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\trello-logo.png
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix

New Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\Wiribbon24-1.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1_light.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\WIS_EXPORT.png
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\RCDATA_SCHEDULE_

TABLE_EXPORT_16.bmp
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\RCDATA_SCHEDULE_

TABLE_EXPORT.bmp

Removed Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons

 o Various images

Issue: CGBasic subassembly - control profile for curb height

The current CGBasic subassembly does not allow for control profile targeting of the curb height 
when the attachment point is the top back of curb.
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Solution:

CGBasic modified to allow for control profile targeting of the curb height and manual curb height 
override when the attachment point is the top back of curb.

Updated Files:

 l C:\ProgramData\Autodesk\C3D 2022\enu\Imported Tools\CGBasic\1f-
bae749c07644d9892c9b3be42ac296.*

Issue: Shrinkwrap Corridor Surface (DRef Corridors)

The Shrinkwrap Corridor Surface command does not work on corridor surfaces that are created 
from a data reference corridor.

Solution:

Removed the point validation that utilized the source corridor assemblies.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Update name of MQ Table Style to avoid confusion

It is possible that the current MQ Table Style name would introduce confusion into users assuming 
the table style must only be used for miscellaneous quantities. 

Solution:

Update the table style name to WisDOT Standard        Modified the Create Data Links and Tables to 
use the WisDOT Standard as the default style.       Added a refresh table style list button to allow users to 
import tables styles using the DOTAddWisTableStyles command while keeping the Create Data Links 
and Tables dialog open.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\03-MQ-SPSHT-wdot.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\09-EW-SPDSHT-wdot.dwt
 l C:\WisDOT\Stnd\C3D2022\Components\Tables\Tables.dwg

Issue: Enable Rotate View command in Layout

User requests ability to use the Rotate View command when Model is the active space in a Layout.
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Solution:

Rotate View enabled when layout viewport active space is Model. Note that cursor will remain ori-
ented with the view. Use the Align Viewport command to keep cursor oriented with WCS.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Load Xref on Layer scaling issue

When inserting xref set to a specific unit (inches, feet, etc.) into a drawing set to unitless, xref is 
scaled in meters.

Solution:

If xref or host dwg is set to Unitless, Force xref scale = 1

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Reset WisDOT Profile command error/Restore User Settings not working

Command does not reset the profile. A message states "Profile cannot be reset".        Restore User Set-
ting command does not work.

Solution:

Repaired Rest Profile command to correctly reset the current profile.       Repaired Restore User Settings 
to correctly save user setting upon C3D exit.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Updates and fixes to survey point styles

Some survey point styles contain incorrect scales. Survey template is missing some point style ref-
erences.  

Solution:

The description keys contain many point style dependencies that were turned off in group-sur-
vey.dwt.  Turned on all point styles under "reference template defaults" in group-survey.dwt.  
Updated and corrected P_XS_Rock point style.
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Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\survey-start.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-survey.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-point.dwt

Issue: WisDOT Mass Ordinate shape styles not assigned

WisDOT Mass Ordinate quantity take off criteria should have shape styles assigned to each criteria. 

Solution:

Assign the appropriate shape styles

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-qto.dwt

Issue: Update SSD multileaders

According to the WisDOT FDM/SDD Transmittal 424 Update Notification – May 17, 2022, the sight dis-
tances standards have been updated to reflect those listed in a more current version of the AASHTO 
Green Book Edition 2018.

 l Category 3 has been removed

Solution:

Remove reference to "Minimum/Upper Minimum" in multileaders

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\Sight\Palettes\10-SIGHT DISTANCE.atc
 l C:\WisDOT\Stnd\C3D2022\Components\Dimensions\Mleaderstyles.dwg

Issue: Create Typical from Assembly missing text

When choosing a vertical exaggeration of 1, the Create Typical from Assembly tool does not produce 
the text for slope labeling.

Solution:

Tool repaired to include text at all vertical exaggerations.
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Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Set SSMAUTOOPEN to 0

Current default setting is for SSM to always open when a drawing that is associated to a sheet is 
opened.

Solution:

Change the default to not open SSM automatically when a drawing associated with a sheet is 
opened. Set variable SSMAUTOOPEN = 0

This default setting is not persistent with a Civil 3D startup and may be changed by the user.  Running 
the profile reset tool will set the SSMAUTOOPEN variable back to 0.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\2022wisdot.arg

Issue: DOTSetWisDOTVariables: Include WisDOT internal variables

The DOTSetWisDOTVariables command only sets the universal variables set by the WisDOT exten-
sion. Need to include the variables set for WisDOT internal devices. This will enable external users to 
more closely replicate the WisDOT internal setup, if desired.       The DOTSetWisDOTVariables command 
does not indicate which variables are set.

Solution:

Included both the universal and WisDOT internal variables in the command. Variables that are set 
are printed to the command line.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Annotation palette: Add Text Styles button not working

The Add Textstyles button is executing an unknown command. "Text" and "Styles" should be 2 
words.

Solution:

Map the button to DOTAddWisTextStyles. Change the button and description to say "Add Text 
Styles".
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Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Fonts\Palettes\10-Cal-
ibriLight.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Fonts\Palettes\20-Cal-
ibriRegular.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Fonts\Palettes\30-Ari-
alRegular.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Fonts\Palettes\40-Ari-
alBlack.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Fonts\Palettes\50-Ari-
alNarrow.atc

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Fonts\Palettes\60-Ari-
alNarrowBold.atc

Issue: Remove outdated erosion control blocks

WisDOT BTS Environmental section has requested the following blocks be removed:

 l Concrete Split Block Retaining Wall
 l Concrete Split Block Wall
 l Concrete Surface Drain
 l Inlet Protection Details
 l Sediment Barrier at Curb Inlet1
 l Sediment Barrier at Curb Inlet2
 l Sediment Barrier Silt Fence Inlet
 l Sediment Filter Sod Inlet
 l Sediment Filter Coarse Aggregate for Drop Inlets
 l Sediment Filter Coarse Aggregate for Inlets
 l Turbidity Barrier Detail
 l Silt Screen Detail

Solution:

Removed blocks and block references from cdErosionControl.dwg and palette references to blocks 
in cdErosionControl.atc.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\cdErosionControl.dwg
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-1\Palettes\cdErosionControl.atc
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Issue: DOTRefTempStatus variable not working at startup

The DOTRefTempStatus variable is not being checked at startup. This is most noticable if a user had 
the WisDOT reference templates disabled, and then runs an update. The reference templates are 
not re-disabled at C3D startup after the update.

Solution:

Update the dll initialization to check the DOTRefTempStatus variable and set the reference template 
status accordingly.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Differentiate the various types of water valves

There is a need to differentiate the various types of water values on plans. There are currently point 
codes for "WV", "WVM", and "WVS*", but they all display the same water valve block symbol that says 
"WV".

Solution:

Add a new block that says "WVM" that is used for WVM point codes. Add a new block that says "WVS" 
that is used for WVS point codes.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-marker-xsection-symbols.dwt
 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\MarkerSymbols\MarkerSymbols.dwg
 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\MarkerSymbols\XSectionSymbols.dwg
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-point.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-survey.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-plat.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\survey-start.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt

Issue: June 2022 WisDOT Sign Plate and Sign Code Manual Transmittal

Block edits and additions need to be added to the sign dwgs and palettes.

Solution:

Edit sign block DWGs and sign palettes to reflect changes from the June 2022 transmittal.
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Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\signsd.dwg
 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\signse.dwg
 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\signsr.dwg
 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\signsw.dwg
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\D-Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\E-Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\R1-R3-Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\R3-R6-Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\R7-R10-

Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\R11-R59-

Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\W-Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\WZ-Signs.atc

New Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\D5-
7064.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\D5-
7064_dark.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\R7-
6764.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\R7-
6764_dark.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\WO8-
7864.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\WO8-
7864_dark.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\W21-
6764.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\W21-
6764_dark.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\W21-
67A64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\W21-
67A64_dark.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\W21-
67B64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\W21-
67B64_dark.PNG
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Removed Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\E5-
51A64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\E5-
51A64D.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\E5-
52A64.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\E5-
52A64D.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\E10-
5364.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\E10-
5364D.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\E10-
5464.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\E10-
5464D.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\E10-
5564.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\E10-
5564D.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\WO8-
7764.PNG

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\WO8-
7764_dark.PNG

Issue: Update Check Sight Distance 24 in (SSD) profile style

According to the WisDOT FDM/SDD Transmittal 424 Update Notification – May 17, 2022, the sight dis-
tances standards have been updated to reflect those listed in a more current version of the AASHTO 
Green Book Edition 2018.  Multiple SSD profile styles are no longer needed.

Solution:

Use style SD Available Sight Distance instead of SD Available Sight Distance 24in for 24 in (SSD) 
profile style.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
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Issue: Update Ewk Material Shape Styles for plotting. Add WisDOT Cross Section QTO 
Criteria

The shape styles utilized in QTO criteria are not colored for grayscale plotting. Create a QTO criteria 
for usage on cross section sheets.

Solution:

All shape styles adjusted for plotting.  Adjusted scales and hatch style and colors. Added a new QTO 
Criteria WisDOT Cross Section Sheets. 

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-qto.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-general.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-survey.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-align-prof.dwt

Issue: Add Surface Styles for EBS and SubgImp, and Section Style for SubgImp, Marsh 
Bottom

The templates do not contain surface styles for EBS and subgrade improvement or  section styles for 
subgrade improvement and marsh bottom. 

Solution:

Surface Styles EBS Border, EBS Triangles, SubgImp Border and SubgImp Triangles Added.  Section 
Styles SubgImp and Marsh Bottom Added. 

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-survey.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-section.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-surface.dwt

Issue: Update SSD_Profile_Dim block

According to the WisDOT FDM/SDD Transmittal 424 Update Notification – May 17, 2022, the sight dis-
tances standards have been updated to reflect those listed in a more current version of the AASHTO 
Green Book Edition 2018.

 l Category 3 has been removed
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Solution:

Remove Category 3 option from SSD_Profile_Dim block.       Minimum/Upper Minimum?

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\NotesTables.dwg

Structure resource files

Issue: Structures - Updated Blocks

 l Structural approach slab option missing for slab bridges in ABUT_FILL block.
 l Keynote leaders for A01, A19, and A15 too small in A1_ABUT block.
 l SYMBOL_NUMBER block should have an option for a background mask/wipeout.
 l Angle precision too high on PILE_DETAILS block.
 l Update DESIGN_CONTACTS block for staff changes.

Solution:

Updated the blocks to be correct.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\structures.dwg

Issue: Structures - New file dropdown

Structures templates are missing from the New File dropdown list in the Structures profile.

Solution:

Fixed bug in structures profile loading

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\BosData.txt

Issue: Structures - Annotation Palette

The keynote multileader icon was missing, and the button was not working correctly.

Solution:

Fixed the button to work properly and display the icon

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\02-Anno.atc
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2022-05-20

Roadway resource files

Issue: WisDOT Stopping Sight Distance tool

The current Stopping sight distance workflow using mainly OOTB Civil 3D tools is labor intensive.

Solution:

Create a custom tool to more efficiently analyze available stopping sight distance. DOTCheck-
SightDistance

Objectives:         • Add the profile creation directly in the tool,          • Analyze both directions,         • Simplify the 
OOTB sight line/layer interface         • Simplify the report output

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\C3D_Check-

SightDistance.png
 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix"
 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml"
 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-

sources.csv"

Issue: Typical Section from Assembly

User request to utilize an assembly object as the basis for developing a typical section.

Solution:

Create new command DOTCreateTypicalFromAssembly. User selects an assembly object, spe-
cifies the desired vertical exaggeration, specifies the desired scale for text height, and picks the loc-
ation for the typical section. The resulting output consists of lines that trace the displayed links of the 
assembly and mtext at all slope label location. All resulting entities are placed on the appropriate typ-
ical section layers.

New button located on WisDOT Sheets Tab > Sheet Tools > Create Typical From Assembly

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"
 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix"
 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml"
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New Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\C3D_
CreateTypFromAssembly.png

Issue: Simplified Earthwork Detail Report

The current earthwork detail workflow requires unnecessary steps of creating xml files and pro-
cessing them in a separate application.

Solution:

New Earthwork Detail Report extracts the material section data directly from Civil 3D and populates 
the Excel worksheet. DOTReportEarthworkDetail

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"

Issue: Add Support for  Wetland Property Sets in Survey Template

Need a way to add attributes to Wetland Boundaries.   Need a layer for the Wetland Project Area. 

Solution:

Add a property set to the survey template that supports wetland types.  New layer named E_WTR_
Wetland_ProjArea. Updated Layer States to include new layer. 

Updated Files:

"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-plat.dwt"        
"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt"        
"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-survey.dwt"        
"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-align-prof.dwt"        
"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-qto.dwt"        "C:\WisDOT\Stnd\C3D2022\Tem-
plates\Template-ref\ref-survey.dwt"        "C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-gen-
eral.dwt"        "C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-property-sets.dwt"        
"C:\WisDOT\Stnd\C3D2022\Components\Layers\Layers.dwg"       "C:\WisDOT\Stnd\C3D2022\Com-
ponents\Layers\Layers.dwg_LayerList.csv"

Issue: New  Component: Table Styles and custom MQ table style

Request for searchable Miscellaneous Quantities Sheets.  Paste-Link of Excel Tables results in text not 
searchable. 
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Solution:

A new workflow was developed that results in searchable table text in the final plan sheets using 
Excel to C3D Table data links.   New Tables.dwg component dwg and table style MQ. New command 
to load Table Style Components (DOTAddWisTableStyles). Add All Components updated to include 
these tables. Add new table style to MQ and EW templates. 

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml
 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\03-MQ-SPSHT-wdot.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\09-EW-SPDSHT-wdot.dwt

New Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Tables\Tables.dwg
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\C3D_Tables.png

Issue: Remove Sight Distance Layers

WisDOT has developed it's own Check Sight Distance tool. This tool creates layers based on the 
inputs provided. There is no longer a need to preset named layers based on the OOTB Civil 3D tool.

Solution:

Remove preset named Sight Distance Layers from WisDOT customization.

Updated Files:

 l "C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\Sight\Palettes\10-SIGHT 
DISTANCE.atc"

 l "C:\WisDOT\Stnd\C3D2022\Components\Layers\Layers.dwg"
 l "C:\WisDOT\Stnd\C3D2022\Components\Layers\Layers.dwg_LayerList.csv"

Issue: Update P_XS_Bold layer lineweight

The XS Sample Lines Alignment style utilizes the layer P_XS_Bold to define it's display properties. To 
avoid conflict with P_Misc_Text, modify the lineweight to 0.014", compared 0.10" which is the line-
weight of P_Misc_Text, for clarity on XS Matchline sheets. 

Solution:

The layer lineweight has been  updated. All layers states updated. All templates updated. 
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Updated Files:

"C:\WisDOT\Stnd\C3D2022\Components\Layers\Layers.dwg"        "C:\WisDOT\Stnd\C3D2022\Com-
ponents\Layers\Layers.dwg_LayerList.csv"        "C:\WisDOT\Stnd\C3D2022\Com-
ponents\Layers\Layers.dwg"        "C:\WisDOT\Stnd\C3D2022\Components\Layers\Layers.dwg_
LayerList.csv"        "C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt"        
"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-plat.dwt"        
"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-survey.dwt"        
"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-align-prof.dwt"        
"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-dwg-settings.dwt"        
"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-general.dwt"        
"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-qto.dwt"        "C:\WisDOT\Stnd\C3D2022\Tem-
plates\Template-ref\ref-survey.dwt"        "C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\survey-
start.dwt"       "C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt"

Issue: Request: add ticks to contour surface style depressions

A request to add ticks to all WisDOT contour surface styles in the depressions has been approved.

Solution:

All contour surface styles now include ticks in the depressions. 

Updated Files:

"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-survey.dwt"        
"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt"       
"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-surface.dwt"

Issue: Surface from PNT FLT - add error message

If the formatting in the PNT or FLT is not correct, usually extraneous header information in the first 
few row, the tool gives a windows unhandled exception error.       SRV to PNT/FLT tool does not flag 
when and SRV file is missing the # header on the header lines.

Solution:

Have the Surface from PNT FLT tool catch the error and prompt a message that explains the error 
and how to fix.

Have the SRV to PNT/FLT tool flag when an SRV file format is incorrect.
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Issue: DOTCreateWallSurface: Add options for top of wall elevation and surface name

It can be useful to use wall surfaces to model objects that have a constant top of wall elevation, 
DOTCreateWallSurface only includes an option to specify the wall height.

Solution:

Add a choice to specify wall height, minimum height, or elevation. Add option to specify the surface 
name.

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"

Issue: Include Excel Add-in

Need a way to deploy the Excel Add-in.

Solution:

Create MSIs for 32-bit and 64-bit Excel. Install as admin.

New Files:

 l WisDOTC3DExcelAddinSetupx64.msi 
 l WisDOTC3DExcelAddinSetupx86.msi 

Issue: DOTTransformCSV: Use "USA-Wisconsin" systems

This DOTTransformSRV command uses the retired systems from the WisDOT category. 

Solution:

Update the DOTTransformSRV command to use the "USA-Wisconsin" systems

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"

Issue: Slope Control Editor - PVI's out of Order

At times, depending on how the table is developed for a slope control profile, the profile PVI's can be 
built out of order.  
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Solution:

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\SlopeControlEditor.dll
 l C:\Pro-

gramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTCivil3DExtensions.dll

Issue: MQ Data Link Generator

The workflow for creating miscellaneous quantity sheets requires the creation of many data links to 
Excel and AutoCAD Tables. This is a time consuming process.

Solution:

Create a tool that automates the data link generation process. User specifies the Excel document 
that contains the content to be linked. The tool presents the user with a list of named ranges that are 
contained in the Excel document. User selects the desired named ranges and the tool creates the 
data links. An option to create the corresponding AutoCAD tables is also included. Command name 
is DOTCreateDataLinksAndTables.

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"
 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml"
 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix"
 l C:\Pro-

gramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\ExcelLogo3DataLink.png
 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-

sources.csv"

Issue: DOTSyncProjectFiles: Prevent run on ACC

Sync Project Files is not compatible with ACC project files

Solution:

Add notification to user when attempting to run on ACC projects.

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"
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Issue: Import SOE error

The import SOE tool is not working.           Invalid class string (Exception from HRESULT: 0x800401F3 (CO_E_
CLASSSTRING))

Solution:

Tool redeveloped. New command DOTImportSOE

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"
 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-

sources.csv"
 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix"

Removed Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\ImportSOE.dll"

Issue: 5 Vert Ex Profile View - Adjust Vertical axis scales

The vertical axis major and minor intervals for 5 vertical ex profile views is too detailed. Since these 
styles are exaggerated half as much of the 10 vertical scale styles, the intervals need to be doubled.

Solution:

Change the interval to 10' Major and 1' Minor.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-align-prof.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt

Issue: Areas Report Units

When using the "no alignment" option of the Areas Report, the resulting value is always SF, even with 
the "SY" option selected.

Solution:

Fixed reported value to match the selected units.
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Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"

Issue: Improve access to input CSVs

Users have problems remembering where the input CSVs are located. This concept is to embed the 
input CSV file location closer to the tool

Solution:

Add content to the dialog box to point users to the standard input CSV files.

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"

Issue: Assign Ali Styles, add view default input function

Solution:

Add option to "View" default csv. This option sets the csv to read only and opens it.

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"

Issue: Create corridor surfaces, add view default input function

Solution:

Add option to "View" default csv. This option sets the csv to read only and opens it.

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"

Issue: Create object folders, add view default input function

Solution:

Add option to "View" default csv. This option sets the csv to read only and opens it.
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Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"

Issue: Parts Catalog: Incorrect part size name

The Storm Sewer Pipe Reinforced Concrete pipe in the WisDOT parts catalog has the incorrect 
acronym of CRPC in the part size name. 

Solution:

Change the parts size name so it has the correct acronym of SSPRC.

Updated Files:

 l "C:\WisDOT\Stnd\C3D2022\Program\PipesCatalog\Pipes_USWI\USWI Circular Pipes\WisDOT_
AeccCircularRFConcretePipe_StormSewer.xml"

Issue: Section View Style that includes grid

User request for a section view style that includes a grid

Solution:

New section view style (Section Grid) created that contains a grid.  

Updated Files:

"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-section.dwt"          
"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt"

Issue: Template Abbreviations

Standard abbreviations set in the drawing settings for Left and Right are not correct. 

Solution:

Update standard abbreviations to "LT" and "RT" in all templates. 

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\survey-start.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\plat-start.dwt
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 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-dwg-settings.dwt

Issue: ACC Exclude Paths update for sheet layout templates

Desktop Connector 15.6 allows for the exclusion of uploading sheet layout templates, which are 
used in the Plan Production - Create Sheets wizard in Civil 3D. 

Solution:

Update the ExcludePaths-WisDOT.xml to include the WisDOT Sheet templates. 

Updated Files:

 l C:\ProgramData\Autodesk\C3DFOP\ExcludePaths-WisDOT.xml

Issue: Proposed Culvert Endwall Plan View Display

The proposed culvert endwall structure style utilizes 3D Solid to display in plan view displays. At 
times, this disappears. Update the style to change the plan view display to "Structure."

Solution:

Update the Proposed Culvert Endwall style > Display > Plan.  Turn on Structure.   Turn off 3D Solid

Updated Files:

"C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-pipe.dwt"

Issue: Pipe Label Styles and Expressions

In some scenarios, the current Pipe Skew label expression does not work. 

The Crossing Pipe Label Section-Culvert has an extra space between the stations. 

Solution:

Adjust the Pipe Skew Label Expression to utilize the Station Values instead of the offset values to cal-
culate skew. 

Adjust the Section-Culvert label style to remove the extra space. 

Updated Files:

"C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt"          "C:\WisDOT\Stnd\C3D2022\Tem-
plates\Template-ref\group-design.dwt"          "C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\ref-
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pipe.dwt"

Issue: 

New Erosion Control detail to be added to the erosion control palette. Erosion Control Blocks need 
updating.

Solution:

Heavy Duty Silt Fence construction detail added to the Erosion Control Palette.  All blocks adjusted to 
scale so all text within blocks sized to standard WisDOT size (0.06 or 0.07).  All text made non-annot-
ative and entire block made annotative. Palette Updated to insert blocks at scale=1.  This results in 
blocks inserted into either model or paper space displaying correctly. Removed 5 details due to pres-
ence in Standard Detail Drawings.  Removed one detail due to duplication. Removed Details: 

 l Turbidity Barrier Detail
 l Silt Screen Detail
 l Riprap Heavy Ditch Detail2
 l Sediment Barrier Silt Fence Inlet
 l Inlet Protection Details
 l Concrete Surface Drain

Updated Files:

"C:\WisDOT\Stnd\C3D2022\Components\Blocks\cdErosionControl.dwg"          
"C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-1\Palettes\cdErosionControl.atc"

New Files:

"C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-1\Palettes\Images\Silt Fence Heavy 
Duty.PNG"          "C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-1\Palettes\Images\Silt Fence 
Heavy Duty_Dark.PNG"

Issue: CDP Integrity Report: Check xml units

Need to make sure that LandXML files delivered in the Contractor Data Packet have the proper linear 
units.

Solution:

Add a check to the CDP Integrity Report to verify LandXML linear units.

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"
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Issue: Create Verification Surface layers do not populate

When using the Create Verification Surface tool does not populate the layer lists in the dialog.

Solution:

Tool fixed so layers are populated.

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"

Issue: Layer state inconsistency

The "Set Utilities to Plot in Color" layer state changes the E_DRN_SS_MH, E_DRN_SS_UG, and E_DRN_
SS_UG_3D layers, but "Set Utilities to Plot Black" and "Set Utilities to Plot Gray" do not.

"Existing Map Frozen" layer state opens the Layer State Manager.

Solution:

Add the E_DRN_SS_MH, E_DRN_SS_UG, and E_DRN_SS_UG_3D layers to the "Set Utilities to Plot Black" 
and "Set Utilities to Plot Gray" layer states.

Remove layerstate command from the "Existing Map Frozen" layer state button.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Layers\Layers.dwg
 l "C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Layers\Palettes\10-Lay-

erStates.atc"

Issue: UDP Classification USWI-ALIGNMENTS is missing from the design template

Station Offsets are not applied to the points when the UDP is missing

Solution:

Add the UDP to the Design Template. 

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt
Structures resource files
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Issue: Structures - Updated Blocks 

 l Unneeded dimension in 56SS option for BARRIER block. 
 l Right side grip for bar series table does not move with the left side grip in BILL_OF_BARS 

block. 
 l CULV_CUTOFF block does not match standard details. 
 l Typos in the DESIGN_DATA block. 
 l Origin grip is sometimes not centered in the HP_SHAPES block. 
 l LANE_ARROWS block is not scaled correctly to work in LAYOUT & GEO template files. 
 l NOTE_CALL block missing descriptions for notes. 
 l RIPRAP_TOE block text style is inconsistent 
 l Steel shape blocks should be placed on layer 0 to allow for more control in drafting styles. 

Solution: 

Updated the blocks to be correct. 

Updated Files: 

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\structures.dwg 

Issue: Structures – No plot layer 

The B_ANNO_NOPLOT layer viewport overrides do not get copied between viewports, which can be 
confusing 

Solution: 

Updated B_ANNO_NOPLOT layer to remove viewport overrides. 

Updated Files: 

 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\struct-inch-start.dwt 
 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\struct-decimal-start.dwt 
 l C:\WisDOT\Stnd\C3D2022\Templates\Sheets\08-STRUCT.dwt 

Issue: Structures – Riprap linetype scale 

The Eripr linetype used in the B_GRND_RIPRAP layer is half as big as it needs to be in structures 
plans. 

Solution: 

Added a Riprap button in the Gen Plans palette from the Structures tool palette. This button starts 
the multiline command, sets the active layer to B_GRND_RIPRAP, and sets the linetype scale to 2.0. 
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Updated Files: 

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\03-General.atc 

Issue: Structures – Request for ability to quickly remove annotative scales 

Leaving the ANNOAUTOSCALES setting on will add multiple annotative scales to annotative objects. 
These additional scales can be confusing and are typically unnecessary in structures plans. 

Solution: 

Added a tool to the Structures tool palette to “Fix Annotation Scales”. This tool removes all annot-
ative scales except the currently active scale from selected annotative elements. 

Updated Files: 

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\ 01-Templates.atc 
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\wisdot.bos.drafting.dll 
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\wisdot.bos.acad.dll 

Issue: Structures – Request for ability to purge non-structures styles 

Purge all will remove structures layers and styles that may be needed as well as unneeded elements. 
As a workaround, structures layers and styles must be unchecked from the purge dialog. 

Solution: 

Added a tool to the Structures tool palette to “Purge Non-Structures Styles”. This tool performs a 
Purge All while retaining all structures layers and styles. 

Updated Files: 

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\08\Palettes\ 01-Templates.atc 
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\wisdot.bos.drafting.dll 
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\wisdot.bos.acad.dll 

Issue: Structures – DGN Conversion Updates 

 l Conversions to Layout templates are 12 times too big 
 l Multileaders do not convert properly 
 l Some dimension text does not convert properly 

Solution: 

Updated to DGN conversion tool to fix these issues. 
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Updated Files: 

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\wisdot.bos.drafting.dll 
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\wisdot.bos.acad.dll 

Issue: Structures Profile 

There are several settings used by structures plans drafters that differ from the standard WisDOT 
profile settings. 

 l ANNOAUTOSCALE: off 
 l ATTREQ: Use default values for attributes 
 l ATTDIA: Use command prompts 
 l ATTIPE: Use full formatting options 
 l DGNIMPORTMODE: Import into active drawing 
 l Use structures drawing templates as the default for new files 

Solution: 

There is now a separate Structures Profile that can be accessed by opening the Structures tool 
Palette from the WisDOT Sheets ribbon. A new desktop shortcut will be created that launches the 
structures palette. 

Updated Files: 

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\wisdot.bos.drafting.dll 
 l C:\Pro-

gramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDot.Bos.Acad.Settings.dll 
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll 
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\BosData.txt 
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\2022wisdotBOS.arg 
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Civil 3D 2022 WisDOT-

BOS.lnk 

2022-02-15

Issue: BG EAT L Curve Block Incorrect Dimensions

The parametric block for the BG EAT L Left Curve is incorrect. When using a smaller radius, the 
length of the guardrail is shorter than 53.125' as shown in the SDD.

Solution:

Updated the block to be correct.
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Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\Parametric\param-bg-eat.dwg

Issue: Contractor Data Packet Integrity Report

Contractor Data Packet quality has been inconsistent.

Solution:

New tool DOTReportCDPIntegrity to check:

 l Does DWG contain Civil 3D object data?
 l Does DWG contain XReferences?
 l Does surface XML contain breakline data?
 l Does surface XML contain boundary data?
 l Does surface XML contain multiple surfaces?
 l Is metadata file present?
 l Is DT1773 file present?
 l Is contractor feedback form present?

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-
sources.csv

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Issue: Intersection Sight Distance

Need a way to quickly check intersection sight distance

Solution:

New command DOTCheckISD can be run to check intersection sight distance. The tool provides 
checks sight distance utilizing input options for decision point location, eye height, required sight dis-
tance, target vehicle path, and target surface.

Add the attached (ISD-Layers.png) supporting layers to Layers.dwg. Include "P_SIGHT_Text" in the 
"Sight Distance" layer filter.

Add button to Sight distance palette to import ISD sight distance layers. Command is DOTADDWIS-
SIGHT-ISD-LAYERS.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix
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 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml
 l C:\WisDOT\Stnd\C3D2022\Components\Layers\Layers.dwg
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\Sight\Palettes\SIGHT DISTANCE.atc
 l C:\WisDOT\Stnd\C3D2022\Components\Layers\LayerFilters\wisdot-layer-filter.lft
 l C:\WisDOT\Stnd\C3D2022\Components\Layers\LayerFilters\wisdot-layer-filter-with-xrefs.lft
 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\plat-start.dwt
 l C:\WisDOT\Stnd\C3D2022\Templates\Begin-dwg\survey-start.dwt
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-

sources.csv

New Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\C3D_Check-
IntersectionSightDistance.png

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Res\Icons\C3D_Vis-
ibilityCheck.png (for new drop down menu)

Issue: Create Verification Surface

The process of creating a verification surface for the breakline extraction workflow is time con-
suming. 

Solution:

New tool "Create Verification Surface". The tool is run from the breakline raw data file. It copies the 
pertinent breakline and boundary data into a new file and creates a new surface from that data. The 
design surface is data referenced into the drawing and a verification surface is created (volume sur-
face) to compare the design surface and breakline surface. Command is 
DOTCREATEVERIFICATIONSURFACE. It can be accessed from the WisDOT Design tab - Output panel - 
Contractor Data menu

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\en-US\HelpRe-

sources.csv
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix
 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\xaml\wisdot-ui.xaml
 l C:\Pro-

gramData\Autodesk\Ap-
plicationPlugins\Wi24.1.bundle\Res\Icons\CreateVerificationSurface.png
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Issue: Revised WisDOT Standard Sign Plates transmittal issued December 2021

Edit Sign Blocks per Revised WisDOT Standard Sign Plates transmittal issued December 2021

Solution:

Created/Edited Sign Blocks per December 2021 transmittal and added blocks to Signs palettes.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\signse.dwg
 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\signsi.dwg
 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\signsm.dwg
 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\signsr.dwg
 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\signsw.dwg
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\E-Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\M-Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\O-Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\R1-R3-Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\R7-R10-

Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\R11-R59-

Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\W-Signs.atc
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\WZ-Signs.atc

New Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Standards\Wis-Signs\Palettes\Images\*.png

Issue: Request for Trailer Mounted Signal Block per SDD 09G02 - 05c

Request for Trailer Mounted Traffic Signal Block per detail SDD 09G02 - 05c

Solution:

Created TrailerTrafficSignal dynamic block and added to Traffic Control palette.

Updated Files:

 l C:\WisDOT\Stnd\C3D2022\Components\Blocks\TrafficControl.dwg
 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-4\Palettes\Traffic Control.atc

New Files:

 l C:\WisDOT\Stnd\C3D2022\Appdata\ToolPalette\Sheets\02-4\Palettes\Images*.*
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Issue: Updated project directory template

 1. lower-casing and shortening folders to ensure maximum flexibility in ACC with the current 
fixed local location and the 256 character limit for windows folder/filenames.

 2. improvements/corrections to the folder structure based on experience with the existing struc-
ture

Solution:

File structure revised for Civil 3D 2022.

Updated Files:

 l C:\Users\Public\Documents\Autodesk\Civil 3D Project Templates\WisDOTProjectTemplate

Issue: Import PI ALI File button

The "beta" tag can be removed from this tool's button. 

Solution:

Remove "beta" from the tool button. Move the button into the location where "ALI Translator" sits. 
Remove "Ali Translator" button.

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Menu\WiRibbon24-1.cuix"

Issue: Corrected input CSVs for CrdrTrgtAssgn-BeamGuard.csv and CrdrTrgtAssgn-
FullSection.csv

The above input CSV files had missing and incorrect variables set.

Solution:

The above input CSV files had corrections and updates made for Offset to measure recoverable 
distance from and Shoulder foreslope.

Updated Files:

 l C:\wisdot\Stnd\C3D2020\Components\Assemblies\CrdrTrgtAssgn-BeamGuard.csv
 l C:\wisdot\Stnd\C3D2020\Components\Assemblies\CrdrTrgtAssgn-FullSection.csv
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Issue: Add ShldPave1 to XS Sheets with Shapes

The XS Sheets with Shapes code set style is missing the shoulder shape code ShldPave1

Solution:

Add ShldPave1 shape code to XS Sheets with Shapes.  Assign Shape Style of CRDR Proposed. 

Updated Files:

 l C:\Wisdot\Stnd\C3D2022\Templates\Begin-dwg\design-start.dwt
 l C:\Wisdot\Stnd\C3D2022\Templates\Begin-dwg\survey-start.dwt
 l C:\Wisdot\Stnd\C3D2022\Templates\Template-ref\group-design.dwt
 l C:\Wisdot\Stnd\C3D2022\Templates\Template-ref\group-survey.dwt
 l C:\Wisdot\Stnd\C3D2022\Templates\Template-ref\ref-align-prof.dwt
 l C:\Wisdot\Stnd\C3D2022\Templates\Template-ref\ref-general.dwt
 l C:\Wisdot\Stnd\C3D2022\Templates\Template-ref\ref-qto.dwt
 l C:\Wisdot\Stnd\C3D2022\Templates\Template-ref\ref-survey.dwt

Issue: New Ali Label Styles for XM and JD Sheets

New alignment label styles were created for developing cross section matchline and joint detail 
sheets. 

Solution:

New Styles include

 l Spot Elevation - Text Above Point - Leader
 l Spot Elevation - Text Below Point - Leader
 l Station - Truncated

Updated Files:

C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-survey.dwt      
C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-design.dwt      
C:\WisDOT\Stnd\C3D2022\Templates\Template-ref\group-plat.dwt     C:\WisDOT\Stnd\C3D2022\Tem-
plates\Template-ref\ref-align-prof.dwt

Issue: Add no alignment option for Lengths Report and Areas Report

Need a way to get areas and lengths quickly without an alignment and without creating a report file.
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Solution:

The alignment selection is now optional for the Lengths Report and Areas Report. If an alignment is 
not selected, an alert dialog will appear with the total length/area of the selected objects. Precision 
and units settings still apply.

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"

Issue: Station Increment Labels - Station Equations

The tool "Station Increment Labels" does not account for station equations.

Solution:

Update the tool to account for station equations.

Updated Files:

 l "C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll"

Issue: System Variable EnableDSTLock set to 1

With Autodesk Construction Cloud, DST files are not automatically locked.  Autodesk created a 
registry variable to automatically lock DST files.  

Solution:

Set this variable to 1 for internal installs. EnableDSTLock=1 on startup.

Updated Files:

 l C:\ProgramData\Autodesk\ApplicationPlugins\Wi24.1.bundle\Content\WisDOTExt2022.dll

Civil 3D 2022 Interface and tool update

 l Status bar on/off setting is persistent across drawings

 l WisDOT ribbon tabs are refreshed at each startup

 l Update WisDOT Civil 3D.exe resets the WisDOT profile after each update.

Page: 2032

Published on: 5/17/2023

WisDOT Civil 3D 2022 "What's new?"



 l DOTIMPORTDESCKEYS (formerly ImportWIDescKeys)

 o Imports point styles without a separate marker block import operation
 o Pulls point styles directly from the ref-point.dwt instead of ref-point.dwg
 o Updates existing description key set instead of making a copy.

 l WisDOT reference templates system variable: NEW.

 o introduced a new system variable DOTRefTempStatus. Value >=1: templates on. 
Value <1 templates off.

 o Initial setting is 1. The value is persistent through updates, so if a user turns them off, 
they will stay off after an update.

 l DOTROTATEVIEW (formerly DOTViewRotate`)

 o Added rubberband

 l DOTVIEWEXPORT & DOTVIEWDELETE are retired.

 o Replaced with  DOTIMPORTVIEWS

 n Imports views directly from the source dwg.
 n Presents user with list of views to select from in the source dwg to import. 

 l DOTLABELASSEMBLIES

 o Set text to not annotative
 o Detects if assemblies are already labeled and skips them if they are

 l DOTLabelSectionSheets (formerly XSAT)

 o Option to select individual section sheets or all section sheets
 o No longer need to pick points to determine sheet location/spacing
 o Sheet labels are now fields that read the sheet names.

 l DOTLoadXRefsOnLayers (formerly LXRSL)

 o Added support for loading multiple XReferences

 l Add components performance improvements

 o Set-<LayerName>: If layer does not exist, imports only that layer instead of all layers 
followed by a purge

 o DOTAddWisDOTTextStyles (formerly DOTAddWisTStyles): Imports styles only 
without the need to purge

 o DOTADDWISDIMSTYLES: Imports styles only without the need to purge
 o DOTADDWISLINETYPES: Imports directly from the Linetypes.dwg
 o DOTADDWISMULTILEADERS: Imports styles only without the need to purge
 o DOTADDWISLAYERS: If layers exist, they are not overwritten. 
 o DOTADDSECTBLOCKS: Imports blocks only without the need to purge
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 o DOTADDWISSYMBLOCKS: Imports blocks only without the need to purge
 o DOTAddWisPartsLists (formerly DOTAddWisPipeNetwork: Connects drawing to the 

corresponding pay item files.

 l DOTRotateAnnoToViewport (formerly AMLT)

 o Add option to select by object types (MText, Text, Multileader, Block Reference), using 
dialog listbox

 o Type selection option uses the rectangular bounding box of the viewport as a crossing 
selection. 

 l DOTStaIncLabels (formerly SOELA)

 o Selection stations by pick points
 o If target object is an alignment, that alignment becomes the parent for the label. This 

forces the label rotation to match the target alignment.

 l LS_LayerStateName  (formerly LAS_LayerStateName )

 o Imports directly from the layer state source dwg. 
 o If layer state exists, it is updated.
 o Applies layer state to xref layers

 l DOTReplaceBlocks (formerly DOTBlkReplace)

 o Allows pick-first option for more flexible block reference selction
 o Presents user with a list of block in the drawing that can be used as the replacement

 l WSAUTOSAVE Is set to 1 at startup. 

This was done to keep user command line orientation settings in place between sessions.

 l DOTCreateWallSurface: NEW. 

Surface creation tool used to make (near) vertical face surfaces from a single Feature Line, 
Survey Figure, or 3D Polyline. Useful fill for creating obstructions for sight distance workflows.

 l WisDOT custom coordinate systems have been retired 

All coordinate systems formerly found in the "WisDOT" category have been moved to the 
"Obsolete Coordinate Systems" category. These coordinate systems are no longer needed. 
Users should refer to the coordinate systems found in the "USA, Wisconsin" category moving 
forward. Issues identified with the "USA, Wisconsin" coordinate systems in previous versions 
have been resolved. Users do not need to reassign coordinate systems if they used "WisDOT" 
coordinate systems for existing drawings.
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 l Object right click command menu shortcut added for the following commands:

 o Move Pipe End
 o Pipe Separation at Structures
 o Label Assemblies
 o Profile View Elevation Range

Civil 3D 2022 add-ons
Last updated: 2022-08-30

WisDOT only: After Civil 3D 2022 is installed, several add-ons will be available for you to 
install with Software Center.  It may take 2-3 days after installing Civil 3D 2022 for these add-
ons to appear in Software Center.

These add-ons include:

 1. Autodesk Vehicle Tracking 2022
 2. Geotechnical Modeler 2022
 3. Storm and Sanitary Analysis (SSA) 2022
 4. Raster Design for Civil 3D 2022
 5. Survey Database Migration Utility
 6. AutoTURN (available for all versions of Civil 3D)
 7. WisDOT Civil 3D add-in for Excel

Civil 3D release comparison 2018 through 2022
Last updated: 2022-02-14

Civil 3D Update releases#update

Previously,  Autodesk AutoCAD-based product updates were often referred to as service packs and 
focused mainly on product fixes. The object code base remained relatively unchanged between 
yearly releases. If different machines had the same yearly release installed, it didn't always matter 
what updates were installed  in order to create compatible objects. Presently, this is not the case.

While yearly major Civil 3D releases (coinciding with the release cycle for AutoCAD) still remain the 
focus for the introduction of new features, some intermediate software Updates now include new 
features and new functionality, along with the  service pack type product fixes. The new features and 
new functionality sometimes introduce changes to the AutoCAD or Civil 3D object code base that res-
ult in interoperability issues if a drawing is shared between two users that do not have the same 
update releases installed. Autodesk documents these issues and sometimes provides workarounds 
built into the products, but best practice is to be aware of and install update releases as soon as they 
become available. (See the "Interoperability issues:" section of this document for more information.)

Info: Civil 3D 2022 is the initial release of Civil 3D 2022. Civil 3D 2022.1 is the first update 
release for Civil 3D 2022. Autodesk issues AutoCAD-based product update releases with the 
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product name appended by "dot" release numbers. (Civil 3D 2022.x). The "dot" releases 
should be considered separate product versions than the initial release.

Requirement: WisDOT often implements new AutoCAD and Civil 3D features and functionality 
as soon as it becomes available.   WisDOT computers will have the most current Civil 3D 2022 
Update release installed. Consultants and contractors will experience interoperability issues 
when working with WisDOT drawings if they do not have the most current Civil 3D 2022 
Update release installed.

DWG file format and proxy graphics#dwg.

DWG file format

The AutoCAD DWG file format (AC1032 - DWG AutoCAD 2018/2019/2020/2021/2022) has been used 
from the initial Civil 3D 2018 release through the most current Civil 3D 2022 release. Drawings saved 
by a Civil 3D 2022 release are mostly backward compatible with other AC1032 - DWG drawings and 
can be directly opened by any 2018-2022 AutoCAD-based software release. However, specific Civil 
3D objects are not always backward compatible when opened in a prior release. Objects that are 
incompatible may cease to function, disappear, be converted to something else, or be displayed as 
proxy graphics. 

Proxy graphics

Proxy graphics are visual placeholders that represent drawing objects that are incompatible with a 
specific AutoCAD-based software release. AutoCAD stores the last viewed image of objects and can 
use an image as a replacement for an incompatible object when the drawing is opened. When open-
ing a drawing with incompatible objects, the Proxy Information dialog box may appear. After one of 
the options is chosen and the dialog box is closed, the setting will be saved in the drawing and the 
dialog box will no longer appear when the drawing is re-opened. To change the proxy graphics set-
ting without the dialog box: PROXYGRAPHICS

Page: 2036

Published on: 5/17/2023

Civil 3D release comparison 2018 through 2022



Civil 3D backward compatability#back.

Backward compatibility between Civil 3D 2022 and Civil 3D 2018-2021 releases

 l Drawings saved in Civil 3D 2022 can be directly opened by Civil 3D 2018-2021 releases.
 l Civil 3D 2022 objects are backward compatible with Civil 3D 2018-2021releases with excep-

tions.
 l Certain Civil 3D objects are not editable if they are opened in a release prior to the release the 

object type was first introduced in. (For example, if an object is created using Civil 3D 2020.6 
and the object type was first introduced in Civil 3D 2020.3, the object is displayed as proxy 
graphics if the drawing is opened with Civil 3D 2020.2 or prior release.)

Backward compatibility between Civil 3D 2022 and Civil 3D 2017 and prior releases

 l To open a drawing saved in Civil 3D 2022 in Civil 3D 2017 or prior release, it must first be 
saved as a drawing in a DWG file format compatible with the prior release.

 l Civil 3D 2022 objects are not backward compatible with Civil 3D 2017 or prior releases at all.
 l Civil 3D 2017 and prior releases  display Civil 3D 2022 objects as proxy graphics that cannot be 

edited.
 l To use a Civil 3D 2022 object with Civil 3D 2017 or prior release, export a LandXML file  from 

Civil 3D 2022 and use the prior release to import the LandXML into a compatible drawing. 
(This can only be done with Civil 3D object types that exist in the code base of the prior 
release.)

Opening a Civil 3D 2022 drawing  in a Civil 3D 2017 or prior release

 1. In Civil 3D 2022: OPEN
 2. PROXYGRAPHICS1Enter  (This will save the graphics with the drawing.)
 3.  C3D Application menu > Save As > Drawing  and save the drawing to a prior DWG file 

format.
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 4. In Civil 3D 2017 or prior release: OPEN
 5. When the drawing is opened, the Civil 3D 2022 objects will be displayed as proxy graphics.

Importing a Civil 3D 2022 object into a Civil 3D 2017 or prior release

 1. In Civil 3D 2022: OPEN
 2. Ribbon > Output tab > Export panel > Export to LandXML
 3. Unselect all objects  in the Export to LandXML dialog box.
 4. Select specific object(s) to export. OK
 5. Name and save to a *.xml file.
 6. In Civil 3D 2017 or prior release: OPEN (to open an existing drawing) or NEW (to create a new 

drawing).
 7. Ribbon > Insert tab > Import panel > LandXML
 8. Browse and select a LandXML file. Open
 9. Unselect all objects in the Import dialog box.

 10. Select the specific object(s) to import. OK

Warning: If the Civil 3D object being imported and a similar object that exists in the drawing 
have the same name, the import will fail.

Civil 3D interoperability issues#interop

There have been specific Civil 3D object changes introduced between releases Civil 3D 2018 and Civil 
3D 2022 that affect drawing interoperability. The sections below describe some of the inter-
operability issues  that may relate to WisDOT projects.

Warning: Editing a WisDOT Civil 3D drawing in a prior release may cause misinterpretation of 
design intents or result in loss of data. Please carefully consider Civil 3D interoperability issues 
before editing a drawing in a prior release.

Drawing changes (2020)

Reference Templates 

 l A host drawing will reference all the components in a reference template by default if the 
host drawing is opened in a release prior to Civil 3D 2020.1 and the reference template path 
is found. When the host drawing is reopened in Civil 3D 2020.1 or later, the reference tem-
plate defaults that were specified using the Set Reference Template Defaults command in 
Civil 3D 2020.1 or later will be restored.

 l The reference template priority settings are preserved if a host drawing is opened in a release 
prior to Civil 3D 2020.1. For example, if you specify that a style will be referenced from a lower 
priority template in Civil 3D 2020.1, that specification will be preserved if you open the host 
drawing in a release prior to Civil 3D 2020.1.
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Object changes (2018-2022)

Alignments and Profiles

 l New alignment curve group types created in Civil 3D 2022 must be converted to fixed entit-
ies in order to edit them in prior releases. A new command named Convert to Fixed has been 
added which converts an alignment with a curve group to fixed geometry. Use this command 
on an alignment with a new Civil 3D 2022 curve group type so that it can be edited in a pre-
vious release of the application.

 l Crossing objects and their labels in profile view  that were created in release Civil 3D 2019.2 
or newer will be displayed as proxy graphics in prior releases, but if you make changes to the 
source objects in a prior release and then save and reopen the drawing in Civil 3D 2019.2 or 
newer, the crossing objects and their labels will be updated.

 l Vertical tangents created with the Float Tangent (Grade, Length) command are automatically 
converted to floating tangents which use a through point as their constraint type when you 
open a Civil 3D 2019.1 or newer drawing in Civil 3D 2019 or Civil 3D 2018. When the drawing 
is re-opened in Civil 3D 2019.1 or newer, the vertical tangents are restored to their previous 
constraint type of grade and length.

 l Fixed vertical curves created with the Fixed Vertical Curve (Parabolic, High/Low Point, Para-
meter, Length) and Fixed Vertical Curve (Circular, High/Low Point, Parameter, Length) com-
mands in Civil 3D 2019 are not backward compatible with Civil 3D 2018. The Convert Curves 
command can be used to convert the fixed parabolic curves so they are compatible with Civil 
3D 2018, but the fixed circular curves cannot be converted and will be missing when the draw-
ing is opened in Civil 3D 2018. If you do not convert the parabolic curves, those curves will 
also be missing when the drawing is opened in Civil 3D 2018. After the curves are converted, 
they cannot be converted back to their original constraint type.

 l Fixed vertical curves created with the Fixed Vertical Curve (Parabolic, High/Low Point, Para-
meter, Length) command in Civil 3D 2019.1 or newer are automatically converted to use two 
points and a parameter as their constraint type when you open the drawing in Civil 3D 2018. 
If you do not edit the curves in Civil 3D 2018, they are restored to use the constraint type of 
Parabolic, High/Low Point, Parameter, Length when the drawing is re-opened in Civil 3D 2019.1 
or newer. If you edit the curves and save the drawing in Civil 3D 2018, the changes are pre-
served when the drawing is re-opened in Civil 3D 2019.1 and newer and the curves will use 
two points and a parameter as their constraint type. If you edit the curves and save the draw-
ing in Civil 3D 2018, the changes are not preserved if the drawing is re-opened in Civil 3D 
2019, but the version of the curve that was saved in Civil 3D 2019.1 and newer is restored 
when the drawing is re-opened in Civil 3D 2019.1 or newer.

Pipe Networks

 l Pipe networks that use the Default Connection Point or Closest Connection Point options for 
connecting the pipes to structures in release Civil 3D 2019.1 or newer can be viewed in 
releases Civil 3D 2019 and Civil 3D 2018. However, if you edit the pipe network in Civil 3D 
2019 or Civil 3D 2018, the pipes will adjust and will be reset to the structure insertion points.
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Sample Line Data Shortcut References

 l Sample line data shortcut references and the section views created from them are displayed 
when you open an Civil 3D 2019.1 or newer drawing in Civil 3D 2019 or Civil 3D 2018. If you 
remove a sample line from the sample line group using Civil 3D 2019 or Civil 3D 2018, the edit 
will be preserved when you reopen the drawing in Civil 3D 2019.1 or newer. Other edits made 
in Civil 3D 2019 or Civil 3D 2018, such as adding sample lines to the sample line group or edit-
ing a sample line, will not be preserved when you reopen the drawing in Civil 3D 2019.1 or 
newer.

Subassemblies

 l Subassemblies developed with Civil 3D 2020.3 and newer releases are not backward com-
patible with any release prior to the release they were created with. Subassembly backward 
compatibility behavior is expected to change with the Civil 3D 2022.2 Update release.

Autodesk Vehicle Tracking objects or third-party add-ons

 l Autodesk Vehicle Tracking objects or other add-on objects might only be compatible as proxy 
graphics with no ability to edit and limited options to show and hide the objects if they are 
from different releases.

Survey Database Format Change (2020)

 l The survey database format was updated from Microsoft SQL Server Compact (SQL CE) 
format to SQLite in Civil 3D 2020. To use survey databases created with releases prior to Civil 
3D 2020 with Civil 3D 2020 and newer releases, the databases must first be migrated to 
SQLite.

Warning: Migrated databases are not compatible with earlier releases of Civil 3D. 
However, the SQL CE (.sdbx) databases are not overwritten or deleted during the migration 
process and can be used in earlier releases of Civil 3D. Contact your Survey Data Coordin-
ator before migrating any survey databases.

General AutoCAD updates

A partial list of general AutoCAD updates that may relate to WisDOT projects.

User Interface (2020)

 l The Dark color scheme and the application ribbon icons have been updated.
 l The Dark color scheme that controls the appearance of the application window, ribbon, and 

other user interface elements has been updated with new colors.
 l Ribbon icons for both the Light and Dark color schemes have been updated for style and clar-

ity, optimized to work with the background colors, and updated to scale with high-resolution 
monitors.
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Floating drawing windows (2022)

 l Multiple drawing files can be visible at the same time without switching between tabs.
 l One or more drawing files can be moved onto another monitor.
 l Drag a drawing file tab off of the AutoCAD application window to make it a floating window.

DWG Compare (2019 and 2020)

 l The DWG Compare feature highlights the differences in model space between two revisions 
of the same drawing or two different drawings.

 o Use colors, to differentiate between the objects that are unique to each drawing and 
the objects that are in common.

 o Exclude objects from being compared by turning off their layers.
 o The current drawing can be edited together with a specified drawing while in the com-

pare state. The comparison takes place in the current drawing. Any changes you make 
in either the current drawing or the compared drawing are dynamically compared and 
highlighted.

XREF Compare (2021)

 l Compare the changes made to a drawing file attached as an external reference (xref) in the 
current drawing. Any changes to the referenced drawing or a compared drawing are high-
lighted using revision clouds.

 l If a referenced drawing has changed, a balloon message is displayed in the lower-right corner 
of the application window (the status bar tray). Click the link in the balloon message to reload 
the modified xref or compare the changes. Changes can also be compared in the External 
References palette.

Blocks palette (2020 and 2021)

 l The INSERT command now displays the Blocks palette, except in scripts, which opens the leg-
acy INSERT command for script compatibility.

 o -INSERTCONTENT - Inserts a drawing or block into the current drawing.
 o CLASSICINSERT - Opens the classic Insert dialog box.

Trace (2022)

 l Trace provides a space to collaborate on drawing changes without altering the existing draw-
ing. The analogy of trace is a virtual, collaborative tracing paper that's laid over the drawing, 
allowing collaborators to add feedback right in the drawing. Create traces in the web and 
mobile apps, then send or share the drawing to collaborators so they can view the trace and 
its contents.

Design efficiency updates 

A partial list of design efficiency updates that may relate to WisDOT projects.
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Alignment and profile enhancements (2019.1)

 l Create a fixed circular or fixed parabolic vertical curve by specifying a high or a low point.
 o Note: These curves are not backward compatible with Civil 3D 2018. You can use the 

Convert Curves command to convert the fixed parabolic curves so they are compatible 
with Civil 3D 2018, but the fixed circular curves cannot be converted.

 l Create and label best fit alignments and profiles using new options.
 o Specify the spiral type to create when creating a best fit alignment.
 o Create best fit profiles that are at or above the elevations of the selected input data. 

Use new options to control whether the resulting best fit profile elevations will be 
above the input data, or whether the elevations can be above and below the input 
data.

 o Add labels to best fit alignments and profiles. Options are now available when creating 
best fit alignments and profiles to insert labels in the drawing to show the offset 
between the source data and the resulting best fit alignment or profile.

 o Specify the maximum rate of change for superelevation cross slope for an alignment.
 o Create a floating vertical tangent in a profile by specifying a grade and a length. The 

specified grade is held if you grip edit the length of this type of tangent

Connected alignment enhancements (2022)

 l The connected alignment functionality has been enhanced in Civil 3D 2022 to better handle 
complex geometry for ramps and interchanges. The following enhancements have been 
made to the connected alignment functionality:

 o Several new alignment curve group combinations have been added, supporting com-
binations of spirals, curves, and reverse spirals.

 o Support has been added for creating curves greater than 180 degrees.
 o Connected alignments can now be created at offsets from parent alignments to sup-

port slip lane and off-ramp scenarios.
 o A preview option is now included so that you can preview the solution in the drawing 

before creating the connected alignment.
 o If a solution cannot be found using the parameters that you input, you can create an 

auto-fit connected alignment.
 l The following new Civil 3D 2022 curve group types are now available when creating align-

ments with the Alignment Layout toolbar:
 o Free Reverse Spiral-Curve-Spiral-Spiral (From entity, end curve)
 o Free Reverse Spiral-Spiral-Curve-Spiral (From curve, end entity)
 o Free Reverse Spiral-Spiral-Curve-Spiral-Spiral (Between two curves)

Pipe network enhancements (2019.1)

 l Specify the type of connection points on structures to use when laying out pipe networks. 
When you lay out a pipe network, you can select which type of connection point to use: the 
structure insertion point, the default connection point (the first connection point that is 
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defined for a structure), or the closest connection point to the cursor. You can also reset the 
connection points after laying out the pipe network.

Corridor updates (2020.4)

 l The Automatic Corner Cleanup Options for corridors are now separated into inner and outer 
corner options. These options can be used to independently control whether the inner and 
outer corners of fixed width corridors are cleaned up at tangent-tangent intersections and at 
tangent-arc intersections.

 l Automatic corner cleanup is now supported for outer corners of fixed width corridors at tan-
gent-arc intersections where the line is not tangent to the curve.

Analyze gravity network updates (2020.4 & 2021.3)

 l The Results page in the Analyze Gravity Network dialog box has been updated to include a 
Pipe Flow column.

 l Gravity network analysis has a new setting called Pipe Length Type which you can use to spe-
cify the pipe length type to use for the analysis calculations.

Feature line editing (2021.1)

 l Use new commands to insert points on crossing feature lines, to edit the grade or slope on 
multiple feature lines, and to set the elevation of a point on a feature-line based corridor at a 
given grade or slope from a specified location.

 o Use the Insert Points at Crossing Locations command to insert PIs or elevation points 
on crossing feature lines in the same site.

 o Use the Set Grade/Slope Across Feature Lines command to edit the grade or slope 
between vertices on two or more intersecting feature lines.

 o Use the Set Corridor Baseline Elevation by Reference command to set the elevation of 
a point on a feature-line based corridor at a given grade or slope from a specified loc-
ation. This command adjusts the elevation of the corresponding PI on the corridor 
baseline accordingly.

Production efficiency updates

A partial list of production efficiency updates that may relate to WisDOT projects.

Autodesk Batch Save Utility (2019)

 l Open and save multiple drawing and template files at once to a specified version of Civil 3D 
using the Autodesk Batch Save Utility. You can also run custom scripts as part of the batch 
operation.

Sample line group data references (2019.1)

 l Reference sample line groups into drawings using data shortcuts.When you create a data 
shortcut for a sample line group, a data shortcut to the parent alignment is also created.
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 l When you create the data references, you can specify which sample lines in the sample line 
group to reference and which data sources to sample.

 l Synchronization notifications are displayed for data references only if a data-referenced 
object is changed in the source drawing and the drawing is saved, and are not displayed if 
something unrelated to the object occurs in the drawing.

Profile view enhancements (2019.2)

 l Add crossing objects to profile views to show where linear objects cross the profile relative to 
the parent alignment. You can show alignments, profiles, feature lines, survey figures, and 3D 
polylines as crossing objects in a profile view.

Data shortcut enhancements (2019.2 and 2019.3 and 2020)

 l When creating a data shortcut reference to a sample line group, you can now automatically 
create references to the sampled sources if data shortcuts exist for those sources. When you 
select these data sources to sample and click OK, references to the sampled sources are cre-
ated in the drawing if they do not already exist.

 l Enter folder paths, including UNC paths, directly into the Folder field in dialog boxes that 
prompt for a folder location.

 l The Manage Data Shortcuts command has been updated with the following features for spe-
cifying a different data shortcut project path when the current path is still valid:

 o If there is another valid path to a data shortcut project available, you can specify that 
path by browsing to the alternate data shortcut Source File or Path from the Data 
Shortcut Manager dialog box. After selecting the alternate Source File or Path, a dialog 
box is displayed which you can use to update the shortcuts. Drawing objects that ref-
erence the original path will be updated to reference the alternate path.

 o You can also specify an alternate valid path as the working folder, and then you can 
use the Link button in the Manage Data Shortcuts dialog box to change the links to the 
objects. Previously, if you attempted to use the Link button to change the link to a dif-
ferent valid path, the Event Viewer would display a message that the reference already 
existed.

 l Use a new system variable named SyncDrefPsetToSource to control whether property 
sets are synchronized when you synchronize data shortcut references.

 l Use a new system variable named PipeNetworkSyncMode to control the synchronization of 
data referenced pipe networks when you open a host drawing.

 l Data shortcut synchronization related to superelevation has been enhanced. With this 
enhancement, changes to more types of superelevation  parameters in a source alignment 
will prompt you to synchronize a data referenced alignment.

Autodesk Dynamo for Civil 3D (2022 and 2022.1)

 l Dynamo for Civil 3D now supports Python 3 as the default version of Python.
 l Python nodes now have a option to allow them to specify if they are created using Python 2.7 

or 3.
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 l Added settings in Dynamo for Civil 3D to control whether binding data is stored and where to 
store it. New nodes have also been added in the AutoCAD > Document and AutoCAD  > 
Object collections to work with binding data stored in a drawing.

Reference templates (2019 and 2020)

 l Use enhanced reference template features to manage styles and settings.
 o You can set up a reference template in advance to control which components in the 

template will be referenced into a host drawing. When you have a drawing DWT file 
open, the new Set Reference Template Defaults command is available on the Styles 
panel. Use this command to set up a reference template. Only the items that are selec-
ted when you set up the reference template will be referenced into the host drawings 
by default.

 o When you attach an additional reference template to a drawing, you are alerted to 
duplicates with warning symbols and tooltips. To change which component is used, 
you can change template priority, or you can clear the selection in the higher priority 
template so that the component in the lower priority template is used.

Corridor updates (2020.4)

 l Use a new setting Add Labels to Points Interpolated from DREF Corridors to control whether 
to add labels to points that are interpolated from data referenced corridors. This setting is 
available in the Edit Feature Settings - Section View dialog box. When this setting is set to On, 
points that are interpolated from data referenced corridors are labeled and symbols are dis-
played on the points. When you move the cursor over these symbols, tooltips are displayed 
to inform you to confirm the actual value of the label in the source drawing.

 l The CorridorSectionLabelsConv command has been enhanced to support converting 
code set labels to corridor point labels. A selection dialog box is displayed when you choose 
to convert the labels to corridor point style labels so you can select a section label set that 
contains a corridor points label style.

 l Components for corridor point label styles have been updated to include an Anchor Corridor 
Point Extension option that can be selected when specifying the anchor points.

Section Views (2020.4)

 l You can use the new DraftingBuffer command to turn the cross section view drafting buf-
fers off and on. This setting controls whether annotation and drafting elements that are 
within drafting buffers, and are bound with the section views, are moved with the section 
views if they are moved.

Collaboration and data exchange updates

A partial list of collaboration and data exchange updates that may relate to WisDOT projects.
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InfraWorks component road to Civil 3D corridor (2019)

 l Create an Civil 3D corridor from an InfraWorks component road. When you bring component 
roads into Civil 3D, assemblies are created using subassemblies in Civil 3D and corridors are 
created.

Civil 3D corridor to InfraWorks component road (2021)

 l Create corridor component roads in InfraWorks from Civil 3D corridors. A corridor com-
ponent road represents the designed corridor in Civil 3D and is read-only in InfraWorks. 
When you bring a Civil 3D corridor into InfraWorks as a corridor component road, geometry 
for the shapes and links is created in the InfraWorks model. You can use the Component Map-
ping dialog box in InfraWorks to specify how the shapes and links are mapped to materials.

New Civil 3D export command (2019 and 2019.2 and 2020)

 l Use a new export command (AeccExportCivilDrawing) in an object-enabled AutoCAD 
application to export an Civil 3D drawing and explode all of the Civil 3D objects.

 l Specify whether the Export Civil 3D Drawing command converts feature lines, parcel seg-
ments, and survey figures to 2D or 3D polylines.

 l Labels with background masks are no longer exported with bowtie-shaped hatches.
 l Xrefs are exploded appropriately on export.
 l Proxy state messages are no longer displayed on export.

Updated LandXML import and export features (2019.1 and 2019.2 and 2020.1)

 l Import breaklines as either feature lines or as 3D polylines when importing surface data from 
LandXML files. Use a new property in the LandXML Settings to control which type of object to 
create. Importing surface breaklines as feature lines has been enhanced to preserve the 
dynamic nature of the breaklines. After a LandXML file is imported into a drawing, you can 
edit the feature lines that were created from the breakline data and the corresponding sur-
face will update.

 l Specify whether property set definitions are created and applied when surface data is impor-
ted from a LandXML file.

 l You can now export feature lines to LandXML files, including feature lines that are created 
from alignments and corridors.

 l Exported feature lines created from an alignment remain dynamic to the parent alignment 
when the alignment is exported and imported along with the feature lines.You can now 
import feature lines on the site specified in the LandXML source file by selecting an option in 
the LandXML Settings dialog box.

 l Update existing object data in a drawing and create property set data when importing 
LandXML files.

 o Update existing objects in a drawing when importing a LandXML file. In the LandXML 
Settings dialog box, on the Import tab, under Conflict Resolution Settings, select the 
Update option.In prior releases, when using the Update option, existing objects in a 

Page: 2046

Published on: 5/17/2023

Civil 3D release comparison 2018 through 2022



drawing were deleted and redrawn when the LandXML file was imported. Now the 
Update option updates most object types without first deleting them. This preserves 
labels that have been added to the objects as well as dependent objects such as align-
ment offsets. Note: This behavior does not apply to parcels. Parcels are deleted and 
redrawn when using the Update option.

 o Specify whether property set definitions are created and applied when objects are 
imported from a LandXML file. You can view this property set data in the AutoCAD 
Properties Palette and in tooltips. Note: Previously, this property set data was created 
for surfaces only.

Civil 3D project version migration from 2016 to Civil 3D 2022
Last updated: 2022-02-14

Info: Civil 3D 2022 has the same DWG file format as 2018 and 2020. Essential CAD standards 
(DWG type, plot tables, linetypes, fonts) remain the same from 2018 forward. At WisDOT, Civil 
3D 2018 and 2020 software is removed and replaced with Civil 3D 2022.

The steps below are for migrating a 2016 project to a newer version.

Minimum migration steps per drawing matrix #min

The following table shows common files from "Project data workflow map" on page 181 with migra-
tion steps for each file.

X = Required.

O = Optional. Required for DWGs with pipe networks.
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Project migration to Civil 3D 2022

Project migration is a choice that requires certain steps and processes be followed to ensure that all 
files are functioning correctly after migration. The following process is used to convert project draw-
ings to WisDOT Civil 3D 2022 standards.

The process of changing a project between Civil 3D versions with different drawing formats needs to 
be thought of in terms of a complete project-based activity. This means:

 l Backward compatibility does not readily exist between Civil 3D 2022 and previous versions. 
 l Everyone working on a migrated project needs to be using the new version files for that pro-

ject. This means not only Project Development staff, but also Technical Services, Planning, 
Consultants, etc. 
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 l Once the decision to migrate the project is made, All DWGs, Data Shortcuts, and referenced 
DWGs that will still need to be edited or accessed in a project must be converted. This may 
require updates to base drawings created by others. 

 l The time and effort to plan and execute the project migration may require more than a few 
hours. Scheduling one day for project migration activities would be appropriate for most pro-
jects. 

 l Migrating project drawings involves a few more considerations besides the save-as steps and 
order of operations to perform the processes. Migrating all the necessary drawings can be a 
significant effort, and the variables described in the next sections should be recognized and 
understood before moving forward with the migration.  

WisDOT does not require project version migration as a rule. However, there are many reasons to 
keep up-to-date on the current software version. Projects shared between in-house staff and con-
sultant staff may require project migration to keep all staff on the same version of Civil 3D. The fol-
lowing chart was developed to assist project staff in the decision of whether to keep a project in the 
current Civil 3D version or migrate to Civil 3D 2022.

The decision whether or not to migrate a project is not a black and white issue. Some additional 
factors to consider for the timing of a project migration include:

 l The benefits of new software functionality and WisDOT standards may or may not outweigh 
the costs of migration.

 l The completion level of design and the timeline to PS&E submittal are critical to this decision. 
If project deadlines (30% submittal, 60% submittal, PS&E, etc.) could be jeopardized by the 
migration taking longer than expected, the project should not be migrated.

 l Project size and complexity will increase the level of effort necessary to migrate the project.
 l All people working on the project in Civil 3D must have the version of software being 

migrated to and are aware of the migration.
 l The expected time commitment to migrate the project can be absorbed by the design team.
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Important potential changes between Civil 3D versions

This Civil 3D version change is referred to as a migration because of these primary factors:

 l Each version may use a different drawing format
 l There may be no backward compatibility between Civil objects and dynamic capabilities
 l Subassemblies use different source code files and are recompiled with a new path
 l Data shortcut functionality may have changed
 l Project drawing files cannot be worked on while Edits to the Data Shortcuts files and accom-

panying drawings are being made
 l Changes to the WisDOT standards files and locations may be appreciably different in the 

latest version

New drawing format

Civil 3D 2022 uses a 2017 DWG file format. In simple terms, Civil 3D uses the DWG file not only as a 
place to store graphical information, it also treats the DWG as something like a database file. To 
accomplish new functionality the files are written differently and new elements are added to the 
2022 DWG files that do not exist in previous DWG versions.

The migration process relies on creating a copy of all Civil 3D files and Data Shortcut files in a new loc-
ation and migrating the originals to Civil 3D 2022. The copied original Civil 3D files are to be used for 
troubleshooting needs that may arise, and to ensure functionality was intact prior to the project 
migration into the 2022 format.

No backward compatibility

Warning: Since there is no backward compatibility of Civil 3D objects between the two DWG 
formats, there is no ability to turn a 2022 drawing back into a fully functioning drawing in a 
2016 or previous version without a lengthy rebuild process. Success with a rebuild is not guar-
anteed to fully succeed.

Before beginning the migration to Civil 3D 2022

The time it will take to transfer a project will vary depending on:

 l Number of drawings
 l How many drawings are consuming xrefs
 l How many drawings are being xref'd
 l The number of data shortcuts and drawings hosting data shortcuts
 l The condition and version format of the original drawings

The Data Shortcut project needs to be reviewed and corrected in its current version prior to the pro-
ject migration.

Additional time should be expected to ensure the project is fully cleaned. All drawings and data short-
cuts need to be working properly prior to going through the various migration steps outlined in the 
following section.
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Only those working directly on the migration of the project data should be opening any of the draw-
ings during the migration process. It is recommended that there should be a minimum number of 
persons involved in doing the migrating tasks, preferably one person.  Most projects contain draw-
ings that are under the ownership of various individuals or sections (PDS, Survey, Plats, etc).  It is 
important to communicate the project migration plan to each party involved and confirm their time 
commitment if they will be the ones performing the migration for their files.

The transfer is complete when all useable DWG files are saved in the 2022 format and a project integ-
rity check has been accomplished.

Clean and fix project drawings and references #clean

Verify that all Data Shortcuts, Data Shortcut References, and External References within the project 
are working properly. Use the following steps as a guide to ensure that they are clean and working 
correctly. These steps require a working knowledge of file management and Project Data shortcut 
tools.

Project Data Shortcuts

These steps are required to be done in the project's current version. It is not recommended to 
migrate or use any of the project drawings and reference files that are not fully functional in the ver-
sion they were initially created in.

 1. All Data Shortcuts must by synchronized and working properly
 2. Open the Data Shortcut project in the Civil 3D Prospector without project drawings open

Tip: This may require communication with the entire project team

 3. Right click- Validate Data Shortcuts
 4. Expand the entire Data Shortcut tree for each object, and search for any exclamation symbols 

 5. Use the right click menu to Remove or Repair Broken Shortcuts

 6. An additional dialog box may prompt to Repair All Broken Shortcuts > YES
 7. This may repair the rest of the broken Shortcuts in the project
 8. Search for any more Exclamation symbols in the Data Shortcut tree in the Prospector tab
 9. Close and reopen Civil 3D to save Data Shortcut edits

Drawing data shortcut references

Civil 3D 2016 includes a tool to assist users in repairing broken data shortcut references within a 
drawing.  Information on how to use the Data Shortcut Manager is published on Autodesk's website.  
Data Shortcut Manager. Use this tool on the project drawings to repair and update data shortcut ref-
erences prior to migrating a project.
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In drawings that contain external references, it is a best practice to review the external references 
manager to ensure correct pathing and resolve any missing references.  This topic is covered here: 
"Repair external references" on page 163  

Batch Save Utility to repair project drawings in their current version

 1. Exit all versions of Civil 3D
 2. Windows Start Menu > Autodesk > Civil 3D Batch Save Utility (Standalone)

 A. Target Civil 3D Version: Civil 3D 2016.5 if the project being migrated is currently in 
Civil 3D 2016.

 B. Custom Script: defaultClean.scr The script will purge registered applications, purge all 
unused resources and audit each drawing in addition to saving Keeping Drawings 
Clean

 C. If there are any directories that you would like to exclude from the process, choose 
them by clicking under Exclude Add 

 D. Under the Skip Drawings section it is recommended to only check the "Read Only" box
 E. Under the Process Settings it is recommended to only check

 I. Timeout for a drawing: checked, 10
 II. Process Simultaneously: checked, 4

 F. Start Depending on the number of files this could take some time.
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 G. Log to verify all drawings were successfully processed

 3. There may be cases where drawings fail. Options include:
 A. Open the drawings manually and clean (Purge, Purge RegAps, Audit) Keeping Drawings 

Clean
 B. If problems persist contact CAE Support

Project drawing migration
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Make a copy of the project before migrating

Save a copy of the entire project. The minimum for this is to create a copy of all the Civil 3D DWG 
files and Data Shortcut files. This project copy should be outside of the original project location, and 
outside of the project folder used to define the Data Shortcut project, store on a local drive or flash 
drive. Leave this copy of the project in its current version. Use the original project location to migrate 
to 2022. This will be the same folder structure for most projects.  (i.e. N:\PDS\C3D\12345678)

When migrating a project to a version that has a newer drawing format (ie. Civil 3D 2016 to 2022), it 
is important that ALL drawing files that are being used as external references (xrefs), Data Refer-
ences, and Sheet production drawings be saved as a Civil 3D 2022 drawing.

Tip: It may not be necessary to migrate drawings or files to the new version if they are not 
going to be used (directly or via reference) in further project development and can be archived 
and PDF deliverables created from them.

Save to Civil 3D 2022 #save

Utilize the Autodesk Batch Save Utility to save all the project drawings to Civil 3D 2022.

 1. Exit all versions of Civil 3D
 2. Start > Autodesk > Civil 3D Batch Save Utility (Standalone)

 A. Target: Civil 3D 2022
 B. Custom script: qsave.scr
 C. If there are any directories that you would like to exclude from the process, choose 

them by clicking under Exclude Add 
 D. Under the Skip Drawings section it is recommended to only check the "Read Only" box
 E. Under the Process Settings it is recommended to only check

 I. Timeout for a drawing: checked, 10
 II. Process Simultaneously: checked, 4

 F. Start Depending on the number of files this could take some time.
 G. Log to verify all drawings were successfully processed

Migration order of operations

Info: For migration, best practice is to start with source drawings (ie. BaseData, RW), follow up 
with design drawings that are Data shortcutted or XRef'd into plan sheets, and finish with plan 
sheet drawings.

Convert plot style to CTB #convert

Prior to WisDOT's implementation of Civil 3D 2018, all previous versions utilized drawings with STB 
Plot Style Tables.  With the release of Civil 3D 2018, WisDOT made the transition to CTB formatted 
drawings.  Follow these steps to convert a drawing from STB to CTB.  This process only needs to be 
completed for plan sheet drawings and drawings that are attached as an external reference (XRef) 
into plan sheet drawings.
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 1. PSTYLEMODE Enter
 o If it is 0 then it is STB and needs to be converted
 o If it is 1 then continue to "Use Layer States to Update DWG Layers"

 2. CONVERTPSTYLES Enter , Ok

 3. The drawing is now a CTB format > Save

Use Layer States to update DWG layers #use

Prerequisite: The drawing must be converted to CTB prior doing this step.  This process only 
needs to be completed for plan sheet drawings and drawings that are attached as an external 
reference in plan sheet drawings.

 1. Save the current layer state. This will be useful for drawings with non-standard drawing layer 
settings.

 A. WisDOT Sheets ribbon > Plot Configuration panel > Unsaved Layer State drop-
down > New Layer 
State

 B. In the dialog box, name the layer something that is easy to recognize (Original-
Pre2022) > Ok

Page: 2062

Published on: 5/17/2023

Civil 3D project version migration from 2016 to Civil 3D 2022



 C. This Layer State can be used later to restore custom layer settings if they exist

 2. WisDOT Sheets ribbon > Plot Configuration panel > Layer States

 3. The Layer States Palette will open. If it doesn't click the Palettes On/Off button on the left end 
of any WisDOT ribbon

 4. Click WisDOT22 All Layers (default) from the Layer States Palette to load the Layer State 
into the drawing. This tool will also open the Layer States Manager

Page: 2063

Published on: 5/17/2023

Civil 3D project version migration from 2016 to Civil 3D 2022



 5. Layer States Manager

 A. Expand the dialog to see Layer properties to restore
 B. Select the WisDOT All Layers (default) layer state from list of options.
 C. Uncheck the following boxes:

 I. Restore options
 a. Turn off layers not found in layer state

 II. Layer properties to restore
 a. On/Off
 b. Frozen/Thawed
 c. Locked/Unlocked

 D.  Restore
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 6. The layers now have been successfully translated to WisDOT Civil 3D 2022 Standards. To 
verify proper translation, Home Tab > Layers Panel > Layer Properties Manager.

 A. 2016 WisDOT Layer Standards (STB Format): Notice the named plot styles in the Plot 
Style column

 B. 2022 WisDOT Layer Standards (CTB Format): Notice the grayed out and color_* named 
Plot Styles.  In this drawing type, the plot color is driven by the color of the layer.   Also, 
notice the index color numbers for some of the layers mostly including the existing lay-
ers.  If you do not see the Plot Style column, right click on the title bar (Name, Linetype, 
Plot Style, etc) and select Restore All Columns to Default.
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 7. Update External References. Before proceeding with this step, all external reference drawings 
must be updated to CTB and Civil 3D 2022 Layer settings.

 A. Create a Layer State for the current layer settings
 B. Home tab > Layers panel > Layers Properties

 I. In the Filters > expand Xref
 II. Right-click the target drawing name > Reset Xref Layer Properties > All 

Properties

Pipe network drawings #pipe

Info: This is only required for drawings that contain pipe network objects (Source or Data 
Reference)

Add updated parts list to old drawings. This process updates the WisDOT parts lists in the drawing.  If 
you previously made any edits to these parts lists, those edits will be overwritten with this process.

 1. WisDOT Design ribbon > Pipe Network Utilities > Add WisDOT Parts List

Import updated Civil 3D styles #import

Info: This is only required for plan sheet drawings and their external references.

Many styles have been updated in Civil 3D 2022. Follow these steps to get the latest style definitions.  
If you previously made edits directly to any WisDOT-provided styles (vs making a copy), this process 
will overwrite those edits.

 1. The drawing must be saved prior to starting this process.

 2. Manage tab > Styles panel > Import
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 3. In the dialog box, navigate to C:\WisDOT\Stnd\C3D20XX\Templates\Begin-dwg\design-
start.dwt or applicable template (ie. Design, Survey, Plats, Construction Survey).

 Open to load the template. Civil 3D will compare the loaded template to the currently open 
drawing.

 4. Once the dialog box opens
 A. Import settings should NOT be checked.
 B. Other settings should be left as is.
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 5. 

OK

 6. The drawing styles are now updated

Cross section drawings #cross

In Civil 3D 2022, slight adjustments were made to the Group Plot Styles and Section View Styles to 
allow for the section views to be placed closer together on a cross section sheet. Drafting Buffers 
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have also been introduced in Civil 3D 2022 and allow annotation objects to be "connected" to section 
views (Drafting Buffer Information).  

Section View Drafting Buffer #section

Info: The following is required for migrating cross section drawings from Civil 3D 2016 to Civil 
3D 2022.

Warning: When opening a Civil 3D 2016 cross section drawing in Civil 3D 2022, a drafting buf-
fer gets added to each section view with a default size that is not editable.  For this reason, the 
drafting buffer is turned off in the Group Plot Styles when opening a 2016 drawing in C3D 
2022.  When importing the updated WIsDOT Group Plot Style, the drafting buffer will be 
turned on.  This results in one view on each cross section sheet.

After importing updated Civil 3D styles to a cross section file, the group plot style for the cross sec-
tion views will need to be updated to keep the section views organized as originally set up.  

 1. Home Ribbon > Toolspace > Settings > Section View > Group Plot Styles
 2. Right Click > Edit any Group Plot Styles that are noted to the left of the style name by the 
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yellow dependency triangle.  
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 3. In the Group Plot Style edit dialog, open the Array tab, and uncheck the "Add drafting buffer 
size to space between views."

 4.  OK to close the dialog. 
 5. The Section View Group Layout will be updated.  Due to the smaller spacing for the Group 

Plot Style and Section View Style, the section views will be placed closer together than what 
was done with Civil 3D 2016.  If desired, follow the next section to update the styles to move 
the section views to pre-Civil 3D 2022 spacing.

Section View and Group Plot Styles #section2

Info: The following is optional for cross section drawings.

Warning: The adjustments made to the section view styles and group plot styles in Civil 3D 
2022 result in slight movement of the section views that were made in Civil 3D 2016.  Any 
annotation objects will not move with the section views.

After modifying the group plot style in the previous section, the section view group layout will update 
and the section views will be placed closer together than what was developed in Civil 3D 2016.  If 
desired, the styles can be updated to reflect the Civil 3D 2016 standards.   This is not required for 
complete migration, it is up to the project staff to decide if this is needed for the cross section 
drawings.  Possible reasons to complete these steps include: 

 l Annotation objects such as labels and Mtext were created in the original cross section view 
locations and no longer line up with the section view.
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 l Since section views are placed closer together, there may be less section sheets than lay-
outs, and some layouts might be empty.

The following describes updating the Group Plot Styles and the Section View styles to reflect the Civil 
3D 2016 standards

 1. Home Ribbon > Toolspace > Settings > Section View > Group Plot Styles
 2. Right Click > Edit any Group Plot Styles that are noted to the left of the style name by the 
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yellow dependency triangle.  
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 3. Group Plot Style edit dialog >  Array tab
 A. Change the Space between adjacent section views to 1" for each option.

 B.  OK  
 4. Home Ribbon > Toolspace > Settings > Section View > Section View Styles
 5. Right Click > Edit any Section View Styles that are noted to the left of the style name by the 

yellow dependency triangle.  
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 8. Section View Style dialog > Grid tab
 A. Change the Axis offset above and below to 0.50".  

 B. OK.  
 9. The Section View Group layout may not update automatically.  To update the layout, select 

one of the section views in model space, either by picking on an elevation or offset axis 
label.  From the contextual ribbon, pick Update Group layout.
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Add Civil 3D 2022 updated components #add

It is recommended that for plan sheet drawings, the updated Civil 3D 2022 components be added to 
get the latest versions of Dimensions, Layers, Linetypes, Marker Symbols, Multileaders, and Text 
Styles.

If only some objects are desired, those objects can be added using the buttons under the "Add Com-
ponent" pull-down.  If all objects are needed in the drawing, the "Add All Components" button can be 
used.
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Insert page setup and update layouts #insert

Requirement: This is required for drawings with plan sheet layouts

Drawings that contain plan sheet layouts may contain page setups that will not plot correctly with 
the 2022 standards.  When the drawing is converted to CTB, the plot style tables set in the existing lay-
out's page setups are removed.  Updated page setups that match WisDOT's Civil 3D 2022 standards 
need to be applied to all layouts in a drawing.

 1. WisDOT Sheets tab > Plot Configuration panel > Page Setups

Tip: If you do not see the tool palettes click the Palettes ON/OFF on the left side of the 
panel.

 2. Page Setups Tool Palette > PDF-11x17-stnd to load the WisDOT Civil 3D 2022 plan sheet 
page setup into the drawing.
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 3. If the page setup being imported contains the same name as a page setup already in the dwg, 
this message will appear- Yes

No to update all layouts

 4. To verify that the page setup has been properly assigned, use the Multi-PageSetup tool to 
assign the newly loaded page setup to the layouts within the drawing. 
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 5. WisDOT Sheets tab > Plot Configuration panel > Multi-PageSetup

 A. Refresh All to update both lists on the palette
 B. Select all the layouts that require the updated Page Setup.  Also, select the updated 

Page Setup in the second list.  Use Shift-Select or Control-Select to pick different lay-
outs.

 C. Apply to apply the updated Page Setup to the selected layouts.

 6. Navigate to a layout and verify a layout is plotting in black and gray scale.  If the page setup 
assignment is incorrect, the layouts will plot color.

Update corridor drawings #update

This is only required for drawings that contain corridor objects.

The following sequence should be applied to each project corridor drawing saved to Civil 3D 2022.

Warning: These steps should not be taken until all other steps in the sections above have 
been completed.
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 1. Open the corridor drawing in Civil 3D 2022
 2. Synchronize all Data Shortcuts
 3. If the Event Viewer has been populated through any of these first steps, all events should be 

cleared before proceeding.
 4. Rebuild the corridor. If the Event Viewer shows events, clear Event Viewer and then:

 A. Corridor Properties dialog > Parameters tab
 I. Uncheck all regions.

 II. Apply to rebuild the corridor with no regions constructed.
 III. Recheck all the regions.
 IV. OK to rebuild the corridor with all regions constructed.

 B. Check the construction of the corridor in plan and corridor section editor.
 5. In the rare case where the Event Viewer still shows events, review the Warning Descriptions, 

looking for: ".Net subassembly project, module, or class not found". If this error is found, 
please email Methods Development at support.cae@dot.wi.gov

 6. If the drawing has more than one corridor, follow steps 4 and 5 for each corridor
 7. Repeat steps 1-6 for each drawing that has corridor.
 8. Save after each corridor rebuilds and before closing the drawing.
 9. Once corridors are built, verify all data references are rebuilt in the drawing.

 10. Save and Close.

Legacy objects (Pre-2016)

Refer to "Demonstration: Options for preparing legacy dwgs for use with the WisDOT C3D 2018 plot 
style table #demo" on page 2171 for additional information for updating legacy objects

C3D 2020
Civil 3D 2020 add-ons
Last updated: 2020-10-26

WisDOT only: After Civil 3D 2020 is installed, several add-ons will be available for you to 
install with Software Center.  It may take 2-3 days after installing Civil 3D 2020 for these add-
ons to appear in Software Center.

These add-ons include:

 1. Autodesk Vehicle Tracking 2020
 2. Geotechnical Module for Civil 3D 2020
 3. Raster Design for Civil 3D 2020
 4. VBA Enabler for Ciivl 3D 2020
 5. AutoTURN (available for all versions of Civil 3D)
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Civil 3D release comparison 2018 to 2020
Last updated: 2020-10-26

Survey database format change #survey

Any Survey database created with a version prior to Civil 3D 2020 will need to be converted 
in order to be used in Civil 3D 2020. The survey database format has been updated from 
Microsoft SQL Server Compact (SQL CE) format to SQLite. To use existing survey databases with Civil 
3D 2020, they must be converted to SQLite.

Please consult with your Survey Data Coordinator prior to using any survey data for Civil 3D 2020 to 
ensure the data is useable and that no backward compatibility is required. The Survey Data Coordin-
ator will be able to help you sort out compatibility issues.

Warning: Migrated databases are not compatible with earlier releases of Civil 3D. 
However, the SQL CE (.sdbx) databases are not overwritten or deleted during the migration 
process and can be used in earlier releases of Civil 3D. Contact your Survey Data Coordin-
ator before migrating any survey databases.

DWG format #dwg

Info: The AutoCAD DWG version format is unchanged from Civil 3D 2018 to Civil 3D 2020. Civil 
3D 2018/2019/2020 use the same DWG version (AC1032 - DWG AutoCAD 2018/2019/2020). 
Even though these Civil 3D versions share the same DWG format that does not mean that 
drawings created in 2020 are entirely backward compatible with 2018 or 2019. 

Backward compatibility between Civil 3D 2020 and prior versions of Civil 3D

Drawings saved in Civil 3D 2020 can be opened in Civil 3D 2019 and Civil 3D 2018. Although draw-
ings can be opened, specific interoperability issues may arise between versions.

When opening a dwg created in Civil 3D 2020 in a previous version of Civil 3D, you may be prompted 
with a proxy graphics dialog like the one shown below. Once you make a selection of how you want 
the proxy graphics shown in the drawing then the dialog will no longer show up when opening the 
drawing. This dialog may even show if there are no Pressure Network objects, or if there are other 
object changes that are made in subsequent updates to Civil 3D 2020.
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To open a Civil 3D 2020 drawing and view the Civil 3D objects in a version prior to Civil 3D 2018:

 1. PROXYGRAPHICS 1 Enter in Civil 3D 2020. This will save the graphics with the drawing.
 2.  App menu > Save As > Drawing  to save the drawing to a prior drawing file format.

 

When you open the drawing in a prior version of the software, the Civil 3D objects will be displayed 
as proxy graphics.

Interoperability between Civil 3D 2020.3 and prior Civil 3D 2020 versions #interop

Civil 3D 2020 was the initial release of this version cycle. Civil 3D 2020.3 is the third update version to 
Civil 3D 2020. Autodesk issues updates with the product name in the format Civil 3D 2020.x. These 
updates should be treated as separate versions as interoperability between updates may be 
affected.

Warning: With the roll out of WisDOT Civil 3D 2020 all WisDOT computers will be working in 
the 2020.3 version of Civil 3D. However there may be some contractors who do not have the 
updates installed who may experience these issues. Best practices would be to install the 
latest updates.

This section describes interoperability between Civil 3D 2020.3, Civil 3D 2020, Civil 3D 2019, or Civil 
3D 2018.

Object changes

There are no specific object changes introduced in Civil 3D 2020.3 that affect drawing inter-
operability with Civil 3D 2019 or Civil 3D 2018.

However, interoperability between versions may apply to your workflows. For example, if you create 
an object in Civil 3D 2020.3 and that object type was introduced in Civil 3D 2020, the object is dis-
played as a proxy object if you open the drawing in Civil 3D 2018.
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Reference templates

A host drawing will reference all the components in a reference template by default if the host draw-
ing is opened in a prior version of Civil 3D and the reference template path is found.

When the host drawing is reopened in Civil 3D 2020.3, the reference template defaults that were spe-
cified using the Set Reference Template Defaults command will be restored. The components that 
had been selected when using the Set Reference Template Defaults command in Civil 3D 2020.3 will 
be referenced into the host drawing, and other components that were not selected will be removed 
from the host drawing if they are not in use.

The reference template priority settings are preserved if a host drawing is opened in a prior version 
of Civil 3D. For example, if you specify that a style will be referenced from a lower priority template in 
Civil 3D 2020.3, that specification will be preserved if you open the host drawing in a prior version.

Subassemblies

Subassemblies updated or developed after Civil 3D 2020.3 is installed are not backward compatible 
with previous versions and may not perform at all. It is important that when using the WisDOT Civil 
3D configuration that you have the 2020.3 or later version installed.

Add-ons and vehicle tracking

Vehicle tracking object and other add-ons may only be backward compatible as proxy graphics with 
no ability to edit the object and limited options to show and hide the objects.

General updates

User Interface (2020)

 l The Dark color scheme and the application ribbon icons have been updated.
 o The Dark color scheme that controls the appearance of the application window, rib-

bon, and other user interface elements has been updated with new colors.
 o Ribbon icons for both the Light and Dark color schemes have been updated for style 

and clarity, optimized to work with the background colors, and updated to scale with 
high-resolution monitors.

Roadway Design Standards (2020.2)

 l The following new design standards files based on the American Association of State Highway 
and Transportation Officials (AASHTO) 2018 design standards are included in Autodesk Civil 
3D 2020.2:
C:\ProgramData\Autodesk\C3D 2020\enu\data\Corridor Design Standards\Imperial\_
Autodesk Civil 3D Imperial (2018) Roadway Design Standards.xml

Design efficiency updates 
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Alignment and profile enhancements (2019.1)

 l Create a fixed circular or fixed parabolic vertical curve by specifying a high or a low point.
 o Note: These curves are not backward compatible with Civil 3D 2018. You can use the 

Convert Curves command to convert the fixed parabolic curves so they are compatible 
with Civil 3D 2018, but the fixed circular curves cannot be converted.

 l Create and label best fit alignments and profiles using new options.
 o Specify the spiral type to create when creating a best fit alignment.

 o Create best fit profiles that are at or above the elevations of the selected input data. 
Use new options to control whether the resulting best fit profile elevations will be 
above the input data, or whether the elevations can be above and below the input 
data.

 o Add labels to best fit alignments and profiles. Options are now available when creating 
best fit alignments and profiles to insert labels in the drawing to show the offset 
between the source data and the resulting best fit alignment or profile.

 o Specify the maximum rate of change for superelevation cross slope for an alignment.

 o Create a floating vertical tangent in a profile by specifying a grade and a length. The 
specified grade is held if you grip edit the length of this type of tangent.

Pipe network enhancements (2019.1)

 l Specify the type of connection points on structures to use when laying out pipe networks. 
When you lay out a pipe network, you can select which type of connection point to use: the 
structure insertion point, the default connection point (the first connection point that is 
defined for a structure), or the closest connection point to the cursor. You can also reset the 
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connection points after laying out the pipe network.

Transparent commands updates (2019.2)

 l Access transparent commands from the ribbon and context menu and use new and updated 
transparent commands.

 o Access transparent commands from the Transparent Commands ribbon tab and from 
the Transparent Commands context menu.

 o Use the new Profile Toolset transparent command to create profile geometry from 
known parameters. You can use the options to enter either a station and elevation, sta-
tion and grade, elevation and grade, or length and grade.

 o Use the updated Station Offset transparent command to enter and lock station and 
offset values and to specify different alignments.

Analyze gravity network updates (2019.2 and 2019.3 and 2020)

 l Assign properties to structures that can be used by the Analyze Gravity Network command 
for drainage analysis. On the Part Properties tab in the Structure Properties dialog box, you 
can change the Structure Type from <none> to a manhole, an outfall, or an inlet type.

 l The Structure Type property also controls which other properties are displayed in the dialog 
box. For example, if you select any inlet type, the Gutter Details properties and inlet dimen-
sions properties will become available.

 l By assigning data to a structure using these properties, the pipe network structures have the 
data necessary for computing inlet performance calculations with the Analyze Gravity Net-
work command.

 l Use the updated Analyze Gravity Network command to analyze a pipe network and apply the 
results to the pipe network.

 l The updated command uses a modeless dialog box so you can leave it open while you do 
other work. 
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 l  You can use this command to perform the following analysis types:
 o Resize Pipes and Reset Inverts: Analyzes the flow through the pipes, and then resizes 

the pipes and resets inverts to accommodate the flow.
 o Compute Energy and Hydraulic Grade Lines: Calculates the energy and hydraulic 

grade lines, and reports whether each line in the system is in a normal state, sur-
charged, or flooded. Note: Compute Energy and Hydraulic Grade Lines is the default 
analysis type.

 o Inlet Analysis: Analyzes the capacity of the inlets and reports the flow, depth, and 
spread at each inlet.

 l Additional updates to the Analyze Gravity Network command include the following enhance-
ments:

 o Storm drain data is now included in a report when Compute Energy and Hydraulic 
Grade Lines is selected as the analysis type.

 o The specified Tailwater Condition now remains selected when re-running the analysis 
on the same pipe network.

 o The pipes in the current parts list are now shown and can be selected manually on the 
Network Details page from a drop-down list.

Info: When resizing a pipe network using the Resize Pipes and Reset Inverts ana-
lysis type, part sizes are added to the parts list from the catalog if required.
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 o Multiple catchments per structure are now supported for gravity network analysis.
 n The Connections tab in the Structure Properties dialog box now has a Con-

nected Catchments section that shows which catchments are connected to the 
structure.

 n In the Analyze Gravity Network dialog box, the combined area, longest time of 
concentration, and the weighted runoff coefficient are displayed for the catch-
ments and these values are used in the analysis calculations.

 o Catchment information can now be defined directly in the Structure Properties dialog 
box and in the Analyze Gravity Network dialog box.

 n You can enter catchment information directly on the Connections tab in the 
Structure Properties dialog box by defining values in the Area, Time of Con-
centration, and Weighted Runoff Coefficient fields.

 n You can also enter catchment information directly on the Network Details page 
of the Analyze Gravity Network dialog box by entering 2D Area, Runoff Coef-
ficient, and Time of Concentration values.

 o Use the new drainage structure parameter mapping feature to map the parameters of 
Part Builder parts to parameters that are required for the Analyze Gravity Network 
command. By setting up and applying the mapping for these parts, the parameter val-
ues will be available within the Analyze Gravity Network command by default.
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 o Use new structure feature settings to specify default values that can be used by the 
Analyze Gravity Network command.

Production efficiency updates

Autodesk Batch Save Utility (2019)

 l Open and save multiple drawing and template files at once to a specified version of Civil 3D 
using the Autodesk Batch Save Utility. You can also run custom scripts as part of the batch 
operation.
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Sample line group data references (2019.1)

 l Reference sample line groups into drawings using data shortcuts.

 l When you create a data shortcut for a sample line group, a data shortcut to the parent align-
ment is also created.

 l When you create the data references, you can specify which sample lines in the sample line 
group to reference and which data sources to sample.

 l Synchronization notifications are displayed for data references only if a data-referenced 
object is changed in the source drawing and the drawing is saved, and are not displayed if 
something unrelated to the object occurs in the drawing.

Profile view enhancements (2019.2)

 l Add crossing objects to profile views to show where linear objects cross the profile relative to 
the parent alignment. You can show alignments, profiles, feature lines, survey figures, and 3D 
polylines as crossing objects in a profile view.

Data shortcut enhancements (2019.2 and 2019.3 and 2020)

 l When creating a data shortcut reference to a sample line group, you can now automatically 
create references to the sampled sources if data shortcuts exist for those sources. When you 
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select these data sources to sample and click OK, references to the sampled sources are cre-
ated in the drawing if they do not already exist.

 l Enter folder paths, including UNC paths, directly into the Folder field in dialog boxes that 
prompt for a folder location.

 l The Manage Data Shortcuts command has been updated with the following features for spe-
cifying a different data shortcut project path when the current path is still valid:

 o If there is another valid path to a data shortcut project available, you can specify that 
path by browsing to the alternate data shortcut Source File or Path from the Data 
Shortcut Manager dialog box. After selecting the alternate Source File or Path, a dialog 
box is displayed which you can use to update the shortcuts. Drawing objects that ref-
erence the original path will be updated to reference the alternate path.

 o You can also specify an alternate valid path as the working folder, and then you can 
use the Link button in the Manage Data Shortcuts dialog box to change the links to the 
objects. Previously, if you attempted to use the Link button to change the link to a dif-
ferent valid path, the Event Viewer would display a message that the reference already 
existed.

 l Use a new system variable named SyncDrefPsetToSource to control whether property 
sets are synchronized when you synchronize data shortcut references.

 l Use a new system variable named PipeNetworkSyncMode to control the synchronization of 
data referenced pipe networks when you open a host drawing.

 l Data shortcut synchronization related to superelevation has been enhanced. With this 
enhancement, changes to more types of superelevation  parameters in a source alignment 
will prompt you to synchronize a data referenced alignment.

Autodesk Dynamo for Civil 3D (2020)

 l Autodesk Dynamo for Civil 3D is a visual programming application. Use the Autodesk Dynamo 
for Civil 3D commands to develop and run scripts for automating tasks and workflows in 
Autodesk Civil 3D.
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Reference templates (2019 and 2020)

 l Use enhanced reference template features to manage styles and settings.
 o You can set up a reference template in advance to control which components in the 

template will be referenced into a host drawing. When you have a drawing DWT file 
open, the new Set Reference Template Defaults command is available on the Styles 
panel. Use this command to set up a reference template. Only the items that are selec-
ted when you set up the reference template will be referenced into the host drawings 
by default.

 o When you attach an additional reference template to a drawing, you are alerted to 
duplicates with warning symbols and tooltips. To change which component is used, 
you can change template priority, or you can clear the selection in the higher priority 
template so that the component in the lower priority template is used.

Collaboration and data exchange updates

Infraworks component road to Civil 3D corridor (2019)

 l Create an Civil 3D corridor from an InfraWorks component road. When you bring component 
roads into Civil 3D, assemblies are created using subassemblies in Civil 3D and corridors are 
created.

New Civil 3D export command (2019 and 2019.2 and 2020)

 l Use a new export command (AeccExportCivilDrawing) in an object-enabled AutoCAD 
application to export an Civil 3D drawing and explode all of the Civil 3D objects.

 l Specify whether the Export Civil 3D Drawing command converts feature lines, parcel seg-
ments, and survey figures to 2D or 3D polylines.

 l Labels with background masks are no longer exported with bowtie-shaped hatches.
 l Xrefs are exploded appropriately on export.
 l Proxy state messages are no longer displayed on export.

Updated LandXML import and export features (2019.1 and 2019.2 and 2020.1)

 l Import breaklines as either feature lines or as 3D polylines when importing surface data from 
LandXML files. Use a new property in the LandXML Settings to control which type of object to 
create. Importing surface breaklines as feature lines has been enhanced to preserve the 
dynamic nature of the breaklines. After a LandXML file is imported into a drawing, you can 
edit the feature lines that were created from the breakline data and the corresponding sur-
face will update.

 l Specify whether property set definitions are created and applied when surface data is impor-
ted from a LandXML file.

 l You can now export feature lines to LandXML files, including feature lines that are created 
from alignments and corridors.
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 l Exported feature lines created from an alignment remain dynamic to the parent alignment 
when the alignment is exported and imported along with the feature lines.

You can now import feature lines on the site specified in the LandXML source file by selecting 
an option in the LandXML Settings dialog box.

 l Update existing object data in a drawing and create property set data when importing 
LandXML files.

 o Update existing objects in a drawing when importing a LandXML file. In the LandXML 
Settings dialog box, on the Import tab, under Conflict Resolution Settings, select the 
Update option.

In prior releases, when using the Update option, existing objects in a drawing were 
deleted and redrawn when the LandXML file was imported. Now the Update option 
updates most object types without first deleting them. This preserves labels that have 
been added to the objects as well as dependent objects such as alignment offsets. 
Note: This behavior does not apply to parcels. Parcels are deleted and redrawn when 
using the Update option.

 o Specify whether property set definitions are created and applied when objects are 
imported from a LandXML file. You can view this property set data in the AutoCAD 
Properties Palette and in tooltips. Note: Previously, this property set data was created 
for surfaces only.

WisDOT Civil 3D start and sheet templates and how to use them
Last updated: 2023-03-20

WisDOT drawing (DWG) files are created from drawing templates (*.dwt). There are two primary 
types of WisDOT drawing template files. 

 1. Start templates: Used to create a new DWG file.
 2. Sheet templates: Used to import a sheet layout into an existing DWG file.

WisDOT start templates

WisDOT start templates differ by the following attributes:

 l Intended use

 l Civil 3D styles

 l Drawing content

 l Drawing settings

 l Drawing units

Start template list

WisDOT start templates are stored in C:\WisDOT\Stnd\C3D20xx\Templates\Begin-dwg.
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Template Usage

plat-start.dwt Used for plat files

survey-start.dwt
Used for files containing survey points and survey fig-
ures

design-start.dwt Used for all other design files or miscellaneous files

struct-decimal-start.dwt Used for structural files (decimal units)

struct-inch-start.dwt Used for structural files (inches)

Info: There are a few specialty start templates with preset sheet layouts in "WisDOT sheet tem-
plates" below. They are designated as speed sheets.

WisDOT Civil 3D start templates use reference templates

The start templates found in the Begin-dwg folder use reference templates to deliver most of the 
WisDOT Civil 3D styles and some of the standard AutoCAD components and other default drawing 
settings.

Info: The reference templates attached to the start templates  should not be changed by the 
user. Editing or removing reference templates may cause a loss of functionality of the WisDOT 
Civil 3D customizations.

Warning: Civil 3D styles in the WisDOT start templates cannot be directly edited. When 
attempting to edit a referenced Civil 3D style in a drawing created from a start template, a dia-
log box is displayed with three choices: Save a copy of the style, keep the changes temporarily 
until the drawing is closed, or cancel the change.

Methods to use the start templates

Create a basic Civil 3D file in a WisDOT project folder structure                

WisDOT sheet templates

WisDOT sheet templates differ by the following attributes:

 l Sheet size (The majority of sheet layouts are 11"x17". Plat, TPP, and 401 permit sheets are dif-
ferent sizes.)

 l Layout and number of viewports

 l Section tab and number for plan production

 l Title line text
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 l Drawing content

 l Drawing settings

Sheet template list

WisDOT sheet templates are stored in C:\WisDOT\Stnd\C3D20xx\Templates\Sheets

Template Usage Sheet layouts

01-TITLE-wdot.dwt Title
TITLE SHEET 1 IN EQ 0.5 Ml; TITLE SHEET 
1 IN EQ 1 Ml; TITLE SHEET 1 IN EQ 2 Ml  

02-CD-SPSHT-
wdot.dwt

Construction detail 
speed sheet. File 
template with pre-
set sheet layouts

01; 02; 03; 04; 05; 06; 07; 08; 09; 10  

02-CD-STRIP-
wdot.dwt

Construction detail 
strip sheets with 
white space above 
and below plan 
viewport

Plan 1 IN 100 FT; Plan 1 IN 200 FT; Plan 1 
IN 40 FT; Plan 1 IN 50 FT; Plan Dbl 1 IN 
200 FT  

02-CD-wdot.dwt Construction details

Plan 1 IN 10 FT; Plan 1 IN 100 FT; Plan 1 
IN 1000 FT; Plan 1 IN 20 FT; Plan 1 IN 
200 FT; Plan 1 IN 2000 FT; Plan 1 IN 40 
FT; Plan 1 IN 5 FT; Plan 1 IN 50 FT; Plan 1 
IN 500 FT; Plan Dbl 1 IN 100 FT; Plan Dbl 
1 IN 200 FT; Plan Dbl 1 IN 40 FT; Plan Dbl 
1 IN 50 FT; Plan Dbl 1 IN 500 FT  

02-PD-DUAL-PLN-
wdot.dwt

Dual viewport plan 
sheets

Plan Dbl 1 IN 100 FT; Plan Dbl 1 IN 200 
FT; Plan Dbl 1 IN 40 FT; Plan Dbl 1 IN 50 
FT; Plan Dbl 1 IN 500 FT  

02-PD-wdot.dwt Plan details

Plan 1 IN 10 FT; Plan 1 IN 100 FT; Plan 1 
IN 1000 FT; Plan 1 IN 20 FT; Plan 1 IN 
200 FT; Plan 1 IN 2000 FT; Plan 1 IN 40 
FT; Plan 1 IN 50 FT  

02-SIGB-wdot.dwt Signal base sheets Sequence of Ops Sheet
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Template Usage Sheet layouts

02-SS-wdot.dwt Storm sewer sheets
SS 1 IN 10 FT; SS 1 IN 100 FT; SS 1 IN 20 
FT; SS 1 IN 40 FT; SS 1 IN 50 FT  

02-TS-SPSHT-
wdot.dwt

Typical section 
speed sheets File 
template with pre-
set sheet layouts

01-ts 1 in-10ft; 01-ts 1in-5ft; 02-ts 1in-
10ft; 02-ts 1in-5ft; 03-ts 1in-10ft; 03-ts 
1in-5ft; 04-ts 1in-10ft; 04-ts 1in-5ft; 05-ts 
1in-10ft; 05-ts 1in-5ft; 06-ts 1in-10ft; 06-
ts 1in-5ft

03-MQ-SPSHT-
wdot.dwt

Miscellaneous 
quantities speed 
sheet File template 
with preset sheet 
layouts

01; 02; 03; 04; 05; 06; 07; 08; 09; 10; 11; 
12; 13; 14; 15; 16; 17; 18; 19; 20  

04-PLAT-wdot.dwt Plats
RW 1 IN 100 FT; RW 1 IN 200 FT; RW 1 IN 
40 FT; RW 1 IN 50 FT  

04-TITLE-PLAT-
wdot.dwt Plat title PLAT TITLE SHEET

04-TLE-MAP-
wdot.dwt TLE map TLE-MAP

04-TPP30-R-
wdot.dwt

Transportation pro-
ject plat 30-IN 
rotated

TPP30R 1 IN 100 FT; TPP30R 1 IN 200 FT; 
TPP30R 1 IN 400 FT  

04-TPP30-wdot.dwt
Transportation pro-
ject plat 30-IN

TPP30 1 IN 100 FT; TPP30 1 IN 200 FT; 
TPP30 1 IN 400 FT 

04-TPP34-R-
wdot.dwt

Transportation pro-
ject plat 34-IN 
rotated

TPP34R 1 IN 100 FT; TPP34R 1 IN 200 FT; 
TPP34R 1 IN 400 FT  

04-TPP34-wdot.dwt
Transportation pro-
ject plat 34-IN

TPP34 1 IN 100 FT; TPP34 1 IN 200 FT; 
TPP34 1 IN 400 FT 

04-TPP-TITLE30-
wdot.dwt

Transportation pro-
ject plat title 30-IN

TPP Title 30x22
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Template Usage Sheet layouts

04-TPP-TITLE34-
wdot.dwt

Transportation pro-
ject plat title 34-IN

TPP Title 34x22

05-PD-STR-
wdot.dwt

Plan detail strip 
sheets with white 
space above and 
below plan view-
port

Plan 1 IN 100 FT; Plan 1 IN 200 FT; Plan 1 
IN 40 FT; Plan 1 IN 50 FT; Plan Dbl 1 IN 
200 FT  

05-PN-DUAL-PLN-
wdot.dwt

Dual viewport plan 
sheets

Plan Dbl 1 IN 100 FT; Plan Dbl 1 IN 200 
FT; Plan Dbl 11N 40 FT; Plan Dbl 1 IN 50 
FT; Plan Dbl 1 IN 500 FT  

05-PN-wdot.dwt Plan sheets
Plan 1 IN 100 FT; Plan 1 IN 20 FT; Plan 1 
IN 200 FT; Plan 1 IN 40 FT; Plan 1 IN 50 
FT  

05-PN401-
wdot.dwt

Plan sheet letter-
sized for Army 
Corps of Engineers 
401 permit sub-
mittal

ACE_PO

05-PP-wdot.dwt Plan profile
PlanProf 1 IN 100 FT; PlanProf 1 IN 200 
FT; PlanProf 1 IN 40 FT; PlanProf 1 IN 50 
FT  

05-PP401-wis-
dot.dwt

Plan profile sheet 
letter-sized for 
Army Corps of 
Engineers 401 per-
mit submittal

ACE_SHT1

05-PROF-DUAL-
PROF-wdot.dwt

Dual viewport pro-
file sheets

Profile Dbl 1 IN 100 FT; Profile Dbl 1 IN 
200 FT; Profile Dbl 1 IN 40 FT; Profile Dbl 
11N 50 FT; Profile Dbl 1 IN 500 FT  

07-SGN-wdot.dwt Sign sheets
Plan 1 IN 100 FT; Plan 1 IN 20 FT; Plan 1 
IN 200 FT; Plan 1 IN 40 FT; Plan 1 IN 50 
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Template Usage Sheet layouts

FT  

09-EW-SPDSHT-
wdot.dwt

Earthwork speed 
sheets File template 
with preset sheet 
layouts

01; 02; 03; 04; 05; 06; 07; 08; 09; 10; 11; 
12; 13; 14; 15; 16; 17; 18; 19; 20  

09-XS-wdot.dwt cross sections

XS 1 IN 10 FT Horiz 10 FT Vert; XS 1 IN 10 
FT Horiz 4 FT Vert; XS 1 IN 20 FT Horiz 10 
FT Vert; XS 1 IN 20 FT Horiz 20 FT Vert; 
XS 1 IN 40 FT Horiz 20 FT Vert; XS 1 IN 40 
FT Horiz 40 FT Vert; XS 1 IN 5 FT Horiz 2 
FT Vert; XS 1 IN 5 FT Horiz 5 FT Vert  

Speed Sheet templates

Some of the sheet templates are referred to as speed sheets. Most drawing workflows have file cre-
ation and sheet layout creation as separate tasks. Speed sheets are drawing templates with preset 
sheet layouts already in them.  Speed sheets may have designated areas delineated in model space 
that correspond to specific viewports in the layouts or contain preloaded drawing content required 
for a particular workflow. Speed sheet templates can be used similar to start templates to create cer-
tain types of plan sheets.

Info: Please see the appropriate training linked to the sheet type in "Sample plan sheets" on 
page 1398 for more information.

Methods to use the sheet templates

 1. WisDOT Sheets tool palettes

 A. WisDOT Sheets tab > Sheet Creation panel > ~sheet group~ > Tool palette > 
Start-up template

 2. Layout tabs

 A. Right-click on a layout tab at the bottom of the screen > From Template... > 
\Templates\Sheets, select the desired template > select the desired layout

Civil 3D project version migration from 2016 to Civil 3D 2020
Last updated: 2021-02-17
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Info: Civil 3D 2020 has the same DWG file format as 2018. Essential CAD standards (DWG type, 
plot tables, linetypes, fonts) remain the same from 2018 forward. At WisDOT, Civil 3D 2018 soft-
ware is removed and replaced with Civil 3D 2020.

The steps below are for migrating a 2016 project to a newer version.

Minimum migration steps per drawing matrix #min

The following table shows common files from "Project data workflow map" on page 181 with migra-
tion steps for each file.

X = Required.

O = Optional. Required for DWGs with pipe networks.
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Project migration to Civil 3D 2020

Project migration is a choice that requires certain steps and processes be followed to ensure that all 
files are functioning correctly after migration. The following process is used to convert project 

Page: 2106

Published on: 5/17/2023

Civil 3D project version migration from 2016 to Civil 3D 2020



drawings to WisDOT Civil 3D 2020 standards.

The process of changing a project between Civil 3D versions with different drawing formats needs to 
be thought of in terms of a complete project-based activity. This means:

 l Backward compatibility does not readily exist between Civil 3D 2020 and previous versions. 
 l Everyone working on a migrated project needs to be using the new version files for that pro-

ject. This means not only Project Development staff, but also Technical Services, Planning, 
Consultants, etc. 

 l Once the decision to migrate the project is made, All DWGs, Data Shortcuts, and referenced 
DWGs that will still need to be edited or accessed in a project must be converted. This may 
require updates to base drawings created by others. 

 l The time and effort to plan and execute the project migration may require more than a few 
hours. Scheduling one day for project migration activities would be appropriate for most pro-
jects. 

 l Migrating project drawings involves a few more considerations besides the save-as steps and 
order of operations to perform the processes. Migrating all the necessary drawings can be a 
significant effort, and the variables described in the next sections should be recognized and 
understood before moving forward with the migration.  

WisDOT does not require project version migration as a rule. However, there are many reasons to 
keep up-to-date on the current software version. Projects shared between in-house staff and con-
sultant staff may require project migration to keep all staff on the same version of Civil 3D. The fol-
lowing chart was developed to assist project staff in the decision of whether to keep a project in the 
current Civil 3D version or migrate to Civil 3D 2020.

The decision whether or not to migrate a project is not a black and white issue. Some additional 
factors to consider for the timing of a project migration include:

 l The benefits of new software functionality and WisDOT standards may or may not outweigh 
the costs of migration.
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 l The completion level of design and the timeline to PS&E submittal are critical to this decision. 
If project deadlines (30% submittal, 60% submittal, PS&E, etc.) could be jeopardized by the 
migration taking longer than expected, the project should not be migrated.

 l Project size and complexity will increase the level of effort necessary to migrate the project.
 l All people working on the project in Civil 3D must have the version of software being 

migrated to and are aware of the migration.
 l The expected time commitment to migrate the project can be absorbed by the design team.

Important potential changes between Civil 3D versions

This Civil 3D version change is referred to as a migration because of these primary factors:

 l Each version may use a different drawing format
 l There may be no backward compatibility between Civil objects and dynamic capabilities
 l Subassemblies use different source code files and are recompiled with a new path
 l Data shortcut functionality may have changed
 l Project drawing files cannot be worked on while Edits to the Data Shortcuts files and accom-

panying drawings are being made
 l Changes to the WisDOT standards files and locations may be appreciably different in the 

latest version

New drawing format

Civil 3D 2020 uses a 2017 DWG file format. In simple terms, Civil 3D uses the DWG file not only as a 
place to store graphical information, it also treats the DWG as something like a database file. To 
accomplish new functionality the files are written differently and new elements are added to the 
2020 DWG files that do not exist in previous DWG versions.

The migration process relies on creating a copy of all Civil 3D files and Data Shortcut files in a new loc-
ation and migrating the originals to Civil 3D 2020. The copied original Civil 3D files are to be used for 
troubleshooting needs that may arise, and to ensure functionality was intact prior to the project 
migration into the 2020 format.

No backward compatibility

Warning: Since there is no backward compatibility of Civil 3D objects between the two DWG 
formats, there is no ability to turn a 2020 drawing back into a fully functioning drawing in a 
2016 or previous version without a lengthy rebuild process. Success with a rebuild is not guar-
anteed to fully succeed.

Before beginning the migration to Civil 3D 2020

The time it will take to transfer a project will vary depending on:

 l Number of drawings
 l How many drawings are consuming xrefs
 l How many drawings are being xref'd
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 l The number of data shortcuts and drawings hosting data shortcuts
 l The condition and version format of the original drawings

The Data Shortcut project needs to be reviewed and corrected in its current version prior to the pro-
ject migration.

Additional time should be expected to ensure the project is fully cleaned. All drawings and data short-
cuts need to be working properly prior to going through the various migration steps outlined in the 
following section.

Only those working directly on the migration of the project data should be opening any of the draw-
ings during the migration process. It is recommended that there should be a minimum number of 
persons involved in doing the migrating tasks, preferably one person.  Most projects contain draw-
ings that are under the ownership of various individuals or sections (PDS, Survey, Plats, etc).  It is 
important to communicate the project migration plan to each party involved and confirm their time 
commitment if they will be the ones performing the migration for their files.

The transfer is complete when all useable DWG files are saved in the 2020 format and a project integ-
rity check has been accomplished.

Clean and fix project drawings and references #clean

Verify that all Data Shortcuts, Data Shortcut References, and External References within the project 
are working properly. Use the following steps as a guide to ensure that they are clean and working 
correctly. These steps require a working knowledge of file management and Project Data shortcut 
tools.

Project Data Shortcuts

These steps are required to be done in the project's current version. It is not recommended to 
migrate or use any of the project drawings and reference files that are not fully functional in the ver-
sion they were initially created in.

 1. All Data Shortcuts must by synchronized and working properly
 2. Open the Data Shortcut project in the Civil 3D Prospector without project drawings open

Tip: This may require communication with the entire project team

 3. Right click- Validate Data Shortcuts
 4. Expand the entire Data Shortcut tree for each object, and search for any exclamation symbols 

 5. Use the right click menu to Remove or Repair Broken Shortcuts

 6. An additional dialog box may prompt to Repair All Broken Shortcuts > YES
 7. This may repair the rest of the broken Shortcuts in the project
 8. Search for any more Exclamation symbols in the Data Shortcut tree in the Prospector tab
 9. Close and reopen Civil 3D to save Data Shortcut edits
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Drawing data shortcut references

Civil 3D 2016 includes a tool to assist users in repairing broken data shortcut references within a 
drawing.  Information on how to use the Data Shortcut Manager is published on Autodesk's website.  
Data Shortcut Manager. Use this tool on the project drawings to repair and update data shortcut ref-
erences prior to migrating a project.

In drawings that contain external references, it is a best practice to review the external references 
manager to ensure correct pathing and resolve any missing references.  This topic is covered here: 
"Repair external references" on page 163  

Batch Save Utility to repair project drawings in their current version

 1. Exit all versions of Civil 3D
 2. Windows Start Menu > Autodesk > Civil 3D Batch Save Utility (Standalone)

 A. Target Civil 3D Version: Civil 3D 2016.5 if the project being migrated is currently in 
Civil 3D 2016.

 B. Custom Script: defaultClean.scr The script will purge registered applications, purge all 
unused resources and audit each drawing in addition to saving Keeping Drawings 
Clean

 C. If there are any directories that you would like to exclude from the process, choose 
them by clicking under Exclude Add 

 D. Under the Skip Drawings section it is recommended to only check the "Read Only" box
 E. Under the Process Settings it is recommended to only check

 I. Timeout for a drawing: checked, 10
 II. Process Simultaneously: checked, 4

 F. Start Depending on the number of files this could take some time.
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 G. Log to verify all drawings were successfully processed

 3. There may be cases where drawings fail. Options include:
 A. Open the drawings manually and clean (Purge, Purge RegAps, Audit) Keeping Drawings 

Clean
 B. If problems persist contact CAE Support

Project drawing migration
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Make a copy of the project before migrating

Save a copy of the entire project. The minimum for this is to create a copy of all the Civil 3D DWG 
files and Data Shortcut files. This project copy should be outside of the original project location, and 
outside of the project folder used to define the Data Shortcut project, store on a local drive or flash 
drive. Leave this copy of the project in its current version. Use the original project location to migrate 
to 2020. This will be the same folder structure for most projects.  (i.e. N:\PDS\C3D\12345678)

When migrating a project to a version that has a newer drawing format (ie. Civil 3D 2016 to 2020), it 
is important that ALL drawing files that are being used as external references (xrefs), Data Refer-
ences, and Sheet production drawings be saved as a Civil 3D 2020 drawing.

Tip: It may not be necessary to migrate drawings or files to the new version if they are not 
going to be used (directly or via reference) in further project development and can be archived 
and PDF deliverables created from them.

Save to Civil 3D 2020 #save

Utilize the Autodesk Batch Save Utility to save all the project drawings to Civil 3D 2020.

 1. Exit all versions of Civil 3D
 2. Start > Autodesk > Civil 3D Batch Save Utility (Standalone)

 A. Target: Civil 3D 2020.2
 B. Custom script: qsave.scr
 C. If there are any directories that you would like to exclude from the process, choose 

them by clicking under Exclude Add 
 D. Under the Skip Drawings section it is recommended to only check the "Read Only" box
 E. Under the Process Settings it is recommended to only check

 I. Timeout for a drawing: checked, 10
 II. Process Simultaneously: checked, 4

 F. Start Depending on the number of files this could take some time.
 G. Log to verify all drawings were successfully processed

Migration order of operations

Info: For migration, best practice is to start with source drawings (ie. BaseData, RW), follow up 
with design drawings that are Data shortcutted or XRef'd into plan sheets, and finish with plan 
sheet drawings.

Convert plot style to CTB #convert

Prior to WisDOT's implementation of Civil 3D 2018, all previous versions utilized drawings with STB 
Plot Style Tables.  With the release of Civil 3D 2018, WisDOT made the transition to CTB formatted 
drawings.  Follow these steps to convert a drawing from STB to CTB.  This process only needs to be 
completed for plan sheet drawings and drawings that are attached as an external reference (XRef) 
into plan sheet drawings.
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 1. PSTYLEMODE Enter
 o If it is 0 then it is STB and needs to be converted
 o If it is 1 then continue to "Use Layer States to Update DWG Layers"

 2. CONVERTPSTYLES Enter , Ok

 3. The drawing is now a CTB format > Save

Use Layer States to update DWG layers #use

Prerequisite: The drawing must be converted to CTB prior doing this step.  This process only 
needs to be completed for plan sheet drawings and drawings that are attached as an external 
reference in plan sheet drawings.

 1. Save the current layer state. This will be useful for drawings with non-standard drawing layer 
settings.

 A. WisDOT Sheets ribbon > Plot Configuration panel > Unsaved Layer State drop-
down > New Layer 
State

 B. In the dialog box, name the layer something that is easy to recognize (Original-
Pre2020) > Ok
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 C. This Layer State can be used later to restore custom layer settings if they exist

 2. WisDOT Sheets ribbon > Plot Configuration panel > Layer States

 3. The Layer States Palette will open. If it doesn't click the Palettes On/Off button on the left end 
of any WisDOT ribbon

 4. Click WisDOT20 All Layers (default) from the Layer States Palette to load the Layer State 
into the drawing. This tool will also open the Layer States Manager

Page: 2114

Published on: 5/17/2023

Civil 3D project version migration from 2016 to Civil 3D 2020



 5. Layer States Manager

 A. Expand the dialog to see Layer properties to restore
 B. Select the WisDOT All Layers (default) layer state from list of options.
 C. Uncheck the following boxes:

 I. Restore options
 a. Turn off layers not found in layer state

 II. Layer properties to restore
 a. On/Off
 b. Frozen/Thawed
 c. Locked/Unlocked

 D.  Restore
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 6. The layers now have been successfully translated to WisDOT Civil 3D 2020 Standards. To 
verify proper translation, Home Tab > Layers Panel > Layer Properties Manager.

 A. 2016 WisDOT Layer Standards (STB Format): Notice the named plot styles in the Plot 
Style column

 B. 2020 WisDOT Layer Standards (CTB Format): Notice the grayed out and color_* named 
Plot Styles.  In this drawing type, the plot color is driven by the color of the layer.   Also, 
notice the index color numbers for some of the layers mostly including the existing lay-
ers.  If you do not see the Plot Style column, right click on the title bar (Name, Linetype, 
Plot Style, etc) and select Restore All Columns to Default.
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 7. Update External References. Before proceeding with this step, all external reference drawings 
must be updated to CTB and Civil 3D 2020 Layer settings.

 A. Create a Layer State for the current layer settings
 B. Home tab > Layers panel > Layers Properties

 I. In the Filters > expand Xref
 II. Right-click the target drawing name > Reset Xref Layer Properties > All 

Properties

Pipe network drawings #pipe

Info: This is only required for drawings that contain pipe network objects (Source or Data 
Reference)

Add updated parts list to old drawings. This process updates the WisDOT parts lists in the drawing.  If 
you previously made any edits to these parts lists, those edits will be overwritten with this process.

 1. WisDOT Design ribbon > Pipe Network Utilities > Add WisDOT Parts List

Import updated Civil 3D styles #import

Info: This is only required for plan sheet drawings and their external references.

Many styles have been updated in Civil 3D 2020. Follow these steps to get the latest style definitions.  
If you previously made edits directly to any WisDOT-provided styles (vs making a copy), this process 
will overwrite those edits.

 1. The drawing must be saved prior to starting this process.

 2. Manage tab > Styles panel > Import

 3. In the dialog box, navigate to C:\WisDOT\Stnd\C3D20XX\Templates\Begin-dwg\design-
start.dwt or applicable template (ie. Design, Survey, Plats, Construction Survey).
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 Open to load the template. Civil 3D will compare the loaded template to the currently open 
drawing.

 4. Once the dialog box opens
 A. Import settings should NOT be checked.
 B. Other settings should be left as is.
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 5. 

OK

 6. The drawing styles are now updated

Cross section drawings #cross

In Civil 3D 2020, slight adjustments were made to the Group Plot Styles and Section View Styles to 
allow for the section views to be placed closer together on a cross section sheet. Drafting Buffers 
have also been introduced in Civil 3D 2020 and allow annotation objects to be "connected" to section 
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views (Drafting Buffer Information).  

Section View Drafting Buffer #section

Info: The following is required for migrating cross section drawings from Civil 3D 2016 to Civil 
3D 2020.

Warning: When opening a Civil 3D 2016 cross section drawing in Civil 3D 2020, a drafting buf-
fer gets added to each section view with a default size that is not editable.  For this reason, the 
drafting buffer is turned off in the Group Plot Styles when opening a 2016 drawing in C3D 
2020.  When importing the updated WIsDOT Group Plot Style, the drafting buffer will be 
turned on.  This results in one view on each cross section sheet.

After importing updated Civil 3D styles to a cross section file, the group plot style for the cross sec-
tion views will need to be updated to keep the section views organized as originally set up.  

 1. Home Ribbon > Toolspace > Settings > Section View > Group Plot Styles
 2. Right Click > Edit any Group Plot Styles that are noted to the left of the style name by the 
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yellow dependency triangle.  
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 3. In the Group Plot Style edit dialog, open the Array tab, and uncheck the "Add drafting buffer 
size to space between views."

 4.  OK to close the dialog. 
 5. The Section View Group Layout will be updated.  Due to the smaller spacing for the Group 

Plot Style and Section View Style, the section views will be placed closer together than what 
was done with Civil 3D 2016.  If desired, follow the next section to update the styles to move 
the section views to pre-Civil 3D 2020 spacing.

Section View and Group Plot Styles #section2

Info: The following is optional for cross section drawings.

Warning: The adjustments made to the section view styles and group plot styles in Civil 3D 
2020 result in slight movement of the section views that were made in Civil 3D 2016.  Any 
annotation objects will not move with the section views.

After modifying the group plot style in the previous section, the section view group layout will update 
and the section views will be placed closer together than what was developed in Civil 3D 2016.  If 
desired, the styles can be updated to reflect the Civil 3D 2016 standards.   This is not required for 
complete migration, it is up to the project staff to decide if this is needed for the cross section 
drawings.  Possible reasons to complete these steps include: 
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 l Annotation objects such as labels and Mtext were created in the original cross section view 
locations and no longer line up with the section view.

 l Since section views are placed closer together, there may be less section sheets than lay-
outs, and some layouts might be empty.

The following describes updating the Group Plot Styles and the Section View styles to reflect the Civil 
3D 2016 standards

 1. Home Ribbon > Toolspace > Settings > Section View > Group Plot Styles
 2. Right Click > Edit any Group Plot Styles that are noted to the left of the style name by the 
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yellow dependency triangle.  
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 3. Group Plot Style edit dialog >  Array tab
 A. Change the Space between adjacent section views to 1" for each option.

 B.  OK  
 4. Home Ribbon > Toolspace > Settings > Section View > Section View Styles
 5. Right Click > Edit any Section View Styles that are noted to the left of the style name by the 

yellow dependency triangle.  
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 8. Section View Style dialog > Grid tab
 A. Change the Axis offset above and below to 0.50".  

 B. OK.  
 9. The Section View Group layout may not update automatically.  To update the layout, select 

one of the section views in model space, either by picking on an elevation or offset axis 
label.  From the contextual ribbon, pick Update Group layout.
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Add Civil 3D 2020 updated components #add

It is recommended that for plan sheet drawings, the updated Civil 3D 2020 components be added to 
get the latest versions of Dimensions, Layers, Linetypes, Marker Symbols, Multileaders, and Text 
Styles.

If only some objects are desired, those objects can be added using the buttons under the "Add Com-
ponent" pull-down.  If all objects are needed in the drawing, the "Add All Components" button can be 
used.
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Insert page setup and update layouts #insert

Requirement: This is required for drawings with plan sheet layouts

Drawings that contain plan sheet layouts may contain page setups that will not plot correctly with 
the 2020 standards.  When the drawing is converted to CTB, the plot style tables set in the existing lay-
out's page setups are removed.  Updated page setups that match WisDOT's Civil 3D 2020 standards 
need to be applied to all layouts in a drawing.

 1. WisDOT Sheets tab > Plot Configuration panel > Page Setups

Tip: If you do not see the tool palettes click the Palettes ON/OFF on the left side of the 
panel.

 2. Page Setups Tool Palette > PDF-11x17-stnd to load the WisDOT Civil 3D 2020 plan sheet 
page setup into the drawing.
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 3. If the page setup being imported contains the same name as a page setup already in the dwg, 
this message will appear- Yes

No to update all layouts
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 4. To verify that the page setup has been properly assigned, use the Multi-PageSetup tool to 
assign the newly loaded page setup to the layouts within the drawing. 

 5. WisDOT Sheets tab > Plot Configuration panel > Multi-PageSetup

 A. Refresh All to update both lists on the palette
 B. Select all the layouts that require the updated Page Setup.  Also, select the updated 

Page Setup in the second list.  Use Shift-Select or Control-Select to pick different lay-
outs.

 C. Apply to apply the updated Page Setup to the selected layouts.

 6. Navigate to a layout and verify a layout is plotting in black and gray scale.  If the page setup 
assignment is incorrect, the layouts will plot color.

Update corridor drawings #update

This is only required for drawings that contain corridor objects.

The following sequence should be applied to each project corridor drawing saved to Civil 3D 2020.

Warning: These steps should not be taken until all other steps in the sections above have 
been completed.
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 1. Open the corridor drawing in Civil 3D 2020
 2. Synchronize all Data Shortcuts
 3. If the Event Viewer has been populated through any of these first steps, all events should be 

cleared before proceeding.
 4. Rebuild the corridor. If the Event Viewer shows events, clear Event Viewer and then:

 A. Corridor Properties dialog > Parameters tab
 I. Uncheck all regions.

 II. Apply to rebuild the corridor with no regions constructed.
 III. Recheck all the regions.
 IV. OK to rebuild the corridor with all regions constructed.

 B. Check the construction of the corridor in plan and corridor section editor.
 5. In the rare case where the Event Viewer still shows events, review the Warning Descriptions, 

looking for: ".Net subassembly project, module, or class not found". If this error is found, 
please email Methods Development at support.cae@dot.wi.gov

 6. If the drawing has more than one corridor, follow steps 4 and 5 for each corridor
 7. Repeat steps 1-6 for each drawing that has corridor.
 8. Save after each corridor rebuilds and before closing the drawing.
 9. Once corridors are built, verify all data references are rebuilt in the drawing.

 10. Save and Close.

Legacy objects (Pre-2016)

Refer to "Demonstration: Options for preparing legacy dwgs for use with the WisDOT C3D 2018 plot 
style table #demo" on page 2171 for additional information for updating legacy objects

C3D 2018

Info: WisDOT has replaced Civil 3D 2018 with Civil 3D 2020 for all WisDOT staff and encourage 
consultants to use Civil 3D 2020 for all project developed with Civil 3D 2018.  This will allow for 
continued WisDOT standards functionality. WisDOT has experience good result with back-
wards compatibility between Civil 3D 2020 and 2018, but all information and issues concerning 
backwards compatibility are the results and responsibility of Autodesk.

See "C3D 2020" on page 2081

Civil 3D release comparison 2016 to 2018
Last updated: 2020-10-26

New file format in Civil 3D 2018
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Info: Traditionally, AutoCAD changes its DWG file format after three versions. AutoCAD 2017 
will be the first version to keep the same DWG format (AC1027) for over four years. This DWG 
format has been used since the AutoCAD 2013 release. 2018 will be a new file format. 

Warning: AutoCAD Civil 3D 2018 is not backward compatible! You can save a 2017 or 
earlier drawing to 2018 and you will be able to use all Civil 3D objects as normal; but after that 
drawing is saved in Civil 3D 2018 format and you try to open it in Civil 3D 2016 or earlier you 
will get the following message:

If you click OK, the Civil 3D objects will be transformed into proxy objects, which basically means pro-
files, alignments, and surfaces will be more like a block. You will lose the ability to edit and update 
them using Civil 3D tools.

Why Did This Happen?

Although the DWG format did not change, Autodesk made the decision to update their objects for 
the 2017 release with custom and AEC objects of vertical and 3rd party products. This will hopefully 
enable them to implement improvements in the initial release, as well as provide the platform with 
some new features on the horizon.

How Does this Affect Me?

Since Autodesk subscription allows you to download and install up to 3 previous versions of Civil 3D, 
this shouldn't affect you if you use the appropriate software that your projects call for.
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If you are working on a project in earlier releases, keep the files with those versions until you are 
ready to move the entire project in the newest version. Just be prepared for when you save a file in 
the Civil 3D 2018 format; plan on keeping it there.

AutoCAD 2018-based products use a different drawing format than AutoCAD 2017-based products 
and earlier. When sharing drawing files with users on AutoCAD 2017-based products or earlier, you 
will need to save your drawings to the appropriate drawing file format using the SAVEAS command 
or another method.

To open AutoCAD Civil 3D 2018 drawings and view the AutoCAD Civil 3D objects in a prior version of 
the software, set the PROXYGRAPHICS system variable value to 1 in AutoCAD Civil 3D 2018 to save 
the graphics with the drawing and then use the Save As command to save the drawing to a prior 
drawing file format. When you open the drawing in a prior version of the software, the AutoCAD Civil 
3D objects will be displayed as proxy graphics.

Interoperability Between AutoCAD Civil 3D 2018 & 2018.1

Warning: With the roll out of WisDOT Civil 3D 2018 all WisDOT computers will be working in 
the 2018.2 version of Civil 3D. However there may be some contractors who do not have the 
service pack installed who may experience these issues. Best practices would be to install the 
latest version and service packs.

This topic describes how to open an AutoCAD Civil 3D 2018 drawing and view the AutoCAD Civil 3D 
objects in a prior version of the software. It also describes interoperability between AutoCAD Civil 3D 
2018 & AutoCAD Civil 3D 2018.1.

Opening an AutoCAD Civil 3D 2018 Drawing in a Prior Version of AutoCAD Civil 3D

Drawings saved in AutoCAD Civil 3D 2018 use the AutoCAD 2018 drawing file format and must be 
saved to a prior drawing file format before they can be opened in a prior version of the software.

To open AutoCAD Civil 3D 2018 drawings and view the AutoCAD Civil 3D objects in a prior version of 
the software, set the PROXYGRAPHICS system variable value to 1 in AutoCAD Civil 3D 2018 to save 
the graphics with the drawing and then use the Save As command to save the drawing to a prior 
drawing file format. When you open the drawing in a prior version of the software, the AutoCAD Civil 
3D objects will be displayed as proxy graphics.

Interoperability Between AutoCAD Civil 3D 2018 and AutoCAD Civil 3D 2018.1

Rehab Corridors

 l If you open and save a drawing in AutoCAD Civil 3D 2018 that contains a rehab corridor cre-
ated in AutoCAD Civil 3D 2018.1, and then re-open the drawing in AutoCAD Civil 3D 2018.1, 
the rehab corridor will not be affected and will appear as it was created. 
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Tip: You can also make edits to anything other than the rehab corridor in the drawing in 
AutoCAD Civil 3D 2018 without affecting the rehab corridor when the drawing is re-opened in 
AutoCAD Civil 3D 2018.1.

 l If you make an edit to a rehab corridor and it is rebuilt in AutoCAD Civil 3D 2018, the rehab 
corridor regions will disappear. If you save the drawing, when you re-open the drawing in 
AutoCAD Civil 3D 2018.1 the rehab corridor regions will not appear. To restore the rehab cor-
ridor regions, ensure that the rehab subassemblies have been imported in AutoCAD Civil 3D 
2018.1, and then make an edit to the corridor and rebuild it.

Tip: The rehab subassemblies are imported automatically when you run the CreateRe-
habCorridor or EditRehabCorridor commands if they have not already been imported. You can 
also import the rehab subassemblies by using the AeccImportNewRehabContent command.

 

Projections and Crossings

 l Linear objects that cross a sample line and are projected to section views in a AutoCAD Civil 
3D 2018 drawing will be displayed as crossings when the drawing is opened in AutoCAD Civil 
3D 2018.1.

Info: Because these linear objects will be displayed as crossings in AutoCAD Civil 3D 2018.1 
instead of projections, projection labels that were added to the objects in AutoCAD Civil 3D 
2018 will be converted to crossing labels after you open the Section View Properties dialog box 
and click Apply in AutoCAD Civil 3D 2018.1.

 l Non-linear objects that are projected to section views in a AutoCAD Civil 3D 2018 drawing will 
be displayed as projections when the drawing is opened in AutoCAD Civil 3D 2018.1 and the 
Draw Crossings check box for those objects will be cleared by default on the Projections and 
Crossings tab of the Section View Properties dialog box.

 l A 3D solid projection that represents the solid exactly where the sample line crosses it in an 
AutoCAD Civil 3D 2018 drawing will have the same appearance when the drawing is opened 
in AutoCAD Civil 3D 2018.1. However, in AutoCAD Civil 3D 2018.1, the 3D solid will be dis-
played as a crossing and <Section> will be selected as the crossing marker style on the Pro-
jections and Crossings tab of the Section View Properties dialog box. The Draw Projections 
check box for the 3D solid will be cleared by default.

Info: In previous releases, when AutoCAD Solids was selected on the Section tab in the Pro-
jection Style dialog box, the Section check box would appear. When the Section check box was 
selected for the projection style, the projection would be created to represent the solid exactly 
where the sample line crossed it. To replicate this appearance in AutoCAD Civil 3D 2018.1, 
select the Draw Crossings check boxes for the 3D solids on the Projections and Crossings tab 
of the Section View Properties dialog box (or in the Projections and Crossings Output Display 
Options dialog box), select <Section> as the crossing marker style, and clear the Draw Pro-
jections check boxes.
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 l A 3D solid crossing created in an AutoCAD Civil 3D 2018.1 drawing using the <Section> cross-
ing marker style will be displayed as a projection when the drawing is opened in AutoCAD 
Civil 3D 2018 and will use either the As Drawn or Marker Style option in its projection style 
(depending on how the projection style it is assigned in AutoCAD Civil 3D 2018.1 is con-
figured). To update the projection style in AutoCAD Civil 3D 2018 so that the 3D solid pro-
jection represents the solid exactly where the sample line crosses it, select AutoCAD Solids on 
the Section tab in the Projection Style dialog box, select As Drawn, and then select the Section 
check box.

 l Crossing labels created in AutoCAD Civil 3D 2018.1 will be displayed as proxy objects if the 
drawing is opened in AutoCAD Civil 3D 2018 and they cannot be deleted. If the drawing is 
saved in AutoCAD Civil 3D 2018 and re-opened in AutoCAD Civil 3D 2018.1, they will be dis-
played as crossing labels.

 l Projections and crossings that are hidden in a section view using AutoCAD Civil 3D 2018.1 will 
be shown if the drawing is opened in AutoCAD Civil 3D 2018. If the drawing is saved in 
AutoCAD Civil 3D 2018 and re-opened in AutoCAD Civil 3D 2018.1, they will be hidden.

Interoperability Between AutoCAD Civil 3D 2018.1 & 2018.2

Warning: With the roll out of WisDOT Civil 3D 2018 all WisDOT computers will be working in 
the 2018.2 version of Civil 3D. However there may be some contractors who do not have the 
service pack installed who may experience these issues. Best practices would be to install the 
latest version and service packs.

Vertical Curves in Offset Profile Slope Transition Regions

When opening a drawing with an offset profile in a different version of AutoCAD Civil 3D, the appear-
ance of the offset profile in slope transition regions where vertical curves are present in the parent 
profile will be maintained until the offset profile is redrawn.

 l To redraw an offset profile, open the Profile Properties dialog box, navigate to the Offset Para-
meters tab, and click OK or Apply.

Opening an AutoCAD Civil 3D 2018 or AutoCAD Civil 3D 2018.1 drawing in AutoCAD Civil 3D 2018.2

 l The tangents that are used instead of vertical curves in an offset profile slope transition 
region are maintained.

 l The tangents will be updated as vertical curves after the offset profile is redrawn in AutoCAD 
Civil 3D 2018.2.

Opening an AutoCAD Civil 3D 2018.2 drawing in AutoCAD Civil 3D 2018 or AutoCAD Civil 3D 2018.1

 l The vertical curves in an offset profile slope transition region are maintained.
 l The vertical curves will be updated as tangents after the offset profile is redrawn in AutoCAD 

Civil 3D 2018 or AutoCAD Civil 3D 2018.1.
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3D Solid Crossing Appearance in Section Views

Opening an AutoCAD Civil 3D 2018.1 drawing in AutoCAD Civil 3D 2018.2

 l The appearance of a 3D solid crossing that uses the <Section> crossing marker style will be 
derived from the layer associated with the 3D solid rather than by the projection style asso-
ciated with the 3D solid.

Opening an AutoCAD Civil 3D 2018.2 drawing in AutoCAD Civil 3D 2018.1

 l The appearance of a 3D solid crossing that uses the <Section> crossing marker style will be 
derived from the projection style associated with the 3D solid rather than by the layer asso-
ciated with the 3D solid.

Corridors

Extracting solids from corridors

 l The process for extracting solids from corridors has been enhanced. New options are avail-
able for selecting the corridor areas to extract within corridor regions, station ranges, or 
closed polygonal areas. When created in the same drawing as the corridor or corridor ref-
erence, the solids can now be created with a dynamic link to the corridor so they update 
when the corridor is updated. 
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 l A Property Data page is now included in the wizard which you can use to automatically asso-
ciate property data with the solids, such as corridor name, region name, and code name. 

 l For more information see To Extract Corridor Solids

Feature lines as corridor baselines

 l In addition to alignments and profiles, you can now use feature lines as corridor baselines. 
You can select the feature lines when creating the corridor and when adding baselines. The 
feature lines that you can use can be created from the feature line creation tools. Corridor fea-
ture lines cannot be used directly but can be used if extracted from the corridor. For more 
information see: Adding Baselines to a Corridor to Create Offset Alignments

Corridor feature lines can cross a base line

 l An option is now provided for controlling whether corridor feature lines can cross a baseline. 
For example, in certain situations, such as with a divided highway, part of a corridor design 
may need to cross the centerline and this can require that the corresponding feature lines 
also cross the centerline. For more information see: Feature Lines Cross Baseline
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Corridor cleanup

 l Where corridor tangents intersect at a corner, and where the corridor is created at a fixed 
width, the inner and outer corners of corridors are cleaned up automatically.

 l In AutoCAD Civil 3D 2018, where corridor tangents intersect at a corner, and where the cor-
ridor is created at a fixed width, the corners are cleaned up as follows: About Corridor 
Cleanup

Corridor Data Shortcuts

Create Corridor data shortcuts

You can now create data shortcuts for corridors so you can reference them into other drawings. 
When you create a data shortcut for a corridor, shortcuts are also created for the alignments and 
profiles that make up the corridor baselines. If corridor baselines are comprised of feature lines, 
shortcuts are not created independently for those feature lines. For more information see: To Work 
with Data Shortcuts and To Create Corridor References 

Save the geometry of a reference

You can now save the geometry of a reference surface in the drawing that contains the data shortcut 
reference. If you choose to save the geometry of a reference surface in the drawing, the drawing that 
contains the reference will become larger, but will open more quickly unless the source surface has 
changed. For more information see: To Work with Surface References

Multiple data shortcut references

You can now create multiple data shortcut references at once, by either right-clicking the data short-
cuts and selecting the Create Reference command, or by selecting them and dragging them into the 
drawing. This functionality is available from the Data Shortcuts collection in Prospector and in the 
Data Shortcut Manager dialog box. For more information see: Work with Data Shortcut References 
and To Manage Data Shortcuts

Control notifications

You can now control whether notifications appear at the drawing status bar when data shortcut ref-
erences are out of date and need to be synchronized. For more information see: To Synchronize a 
Reference Object

Object Data and Shortcut Sub-folders

 l You can now create sub-folders within Prospector and the Data Shortcut Manager. Right-click 
an object collection or a data shortcut collection and click Create Folder. You can drag-and-
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drop existing objects into the new folders, and you can place folders inside other folders. 
When you create references to data shortcuts that are stored in sub-folders, the sub-folder 
structure is replicated in the consumer drawing. For more information see: To Manage Data 
Shortcuts and About the Toolspace Prospector Tab

Roundabouts

From Autodesk Vehicle Tracking

The roundabout-related features from Autodesk® Vehicle Tracking have been integrated into 
AutoCAD Civil 3D. These commands create a new type of roundabout object. For more information 
see: About Roundabouts

From Autodesk Infraworks 360

You can now bring roundabouts into an AutoCAD Civil 3D drawing from Autodesk® InfraWorks® 
360. For more information see: About Exchanging Data Between AutoCAD Civil 3D and Autodesk 
InfraWorks 360.

Design Efficiency

Relative Feature Lines

Create feature lines that are relative to surface. Feature line elevations can be obtained from a sur-
face and can also be relative to a surface, so if the surface is updated, the feature line is updated.

 l Behavior of feature lines created to be relative to surface. If the surface is edited, the feature 
line is updated automatically

 l Behavior of feature lines created at fixed elevations, and then set to be relative. The following 
illustration shows a feature line that was drawn at fixed elevations with no relationship to the 
surface. If the surface below it is edited, the feature line elevations will not update.
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 l However, the relative elevation offsets between the feature line and the surface will now be 
maintained if the surface is edited, such as if the elevation is lowered, as shown in the fol-
lowing illustration.

 l Feature line editing commands are supported for relative feature lines. You can specify rel-
ative elevation options by using the following features in the Grading Elevation Editor.

 l When you create a feature line and assign elevations based on a surface, you can select the 
Insert Intermediate Grade Break Points check box. This creates elevation points along the fea-
ture line where the feature line crosses surface TIN lines. These points are shown as green 
circles in the following illustration.

 l If you edit or otherwise move a relative feature line, or if the surface it is relative to is 
updated, elevation points are not automatically added or removed on the feature line to 
match the surface TIN lines, as shown in the following illustration.

 l You can update the elevation points on the feature line by using the Insert Elevation Point 
and Delete Elevation Point editing options in the Grading Elevation Editor or on the Edit Elev-
ations panel of the Feature Line ribbon tab.
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Offset Profiles Relative to Alignment Baseline

 l You can create dynamic offset profiles using the same command you use to create offset 
alignments. The profile geometry is offset using a default cross slope which you can modify 
by editing the profile properties

Tip: Vertical curves in offset profile geometry are tessellated as multiple straight segments as 
shown below when the profile is superimposed onto another profile view. For reviewing and 
editing the offset profile geometry, insert the offset profile into its own profile view by using 
the Create Profile View command and selecting the offset alignment.

 

 l In areas of the offset profile where there are vertical curves and there is a transition between 
one cross slope to another cross slope, as specified in the Offset Parameters tab of the offset 
profile properties, the vertical curve geometry that was replicated from the parent profile will 
not be preserved. Instead, straight lines are added between control points to approximate 
the curve as shown in the following illustration.
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Intersecting Alignments and Transition Profile

 l Create an alignment that transitions between two intersecting alignments and create a profile 
that transitions between their profiles

 l The connected alignment is created between the two intersecting alignments at a specified 
radius.

 l The geometry of the connected profile is automatically generated from the parent profiles 
that you select. The start and end elevations and slope are taken from the parent profiles, 
and the middle section of the connected profile is calculated depending on whether exten-
sions of the parent profiles intersect.

 l When you create a connected alignment and associated profile, by default they are set to 
dynamic state, which means that they will partially update if their parent alignments and pro-
files change. You can change the update mode to static if you want to prevent any updates 
from occurring and if you want full editing control over the alignment and profile.

Resolve Corridor Bowties

At some locations on corridor models, the corridor links can cross each other, resulting in bowtie-like 
configurations. The following illustration shows a corridor with a bowtie configuration at the corner.
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Automatic and command-based corner cleanup

In some situations, such as where corridor tangents intersect at a corner, and where the corridor is 
created at a fixed width, bowties can be cleared automatically. You can control which types of bowtie 
intersections are cleared automatically by changing the Automatic Clear Bowtie Options in the Edit 
Feature Settings - Corridor dialog box.

In other situations, such as when the corridor is created at a variable width (such as when daylighting 
to a surface), you can use the Clear Corridor Bowties command.

The automatic AutoCAD Civil 3D corridor cleanup behavior can be applied at tangent-tangent, tan-
gent-curve, and tangent-curve-tangent intersection locations in corridors that use feature lines or 
alignment/profiles as baselines, and the assemblies have consistent widths as set by shapes within 
the assembly.

For example, where corridor tangents intersect at a corner, and where the corridor is created at a 
fixed width, the corners are cleaned up as follows:

 l The point where the inner corners meet is calculated and radial lines are extended from that 
location, using the insertion frequency along the baseline as defined in the Frequency to 
Apply Assemblies dialog box.

 l In addition, one station is also added at the corner if the At Horizontal Geometry Points 
option is selected in the Frequency to Apply Assemblies dialog box:
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 l The subassembly width value is overridden at the radial stations; the width is calculated to 
produce a corner solution that is similar to the AutoCAD Offset command.

 l The following illustration represents a corner prior to clearing the bowtie. The corridor 
baseline is shown in red.

 l The following illustration represents a corner after clearing the bowtie.
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 l Points 3 and 4 are moved to the location of point 5, and the elevation of point 4 is now used 
in that location. The locations and elevations of points 1 and 2 are unchanged.

Model, assess, and optimize rehab corridors for roadway rehabilitation projects.

 l When creating a rehab corridor, you specify parameters for cross slope correction, mill, level, 
and overlay, and AutoCAD Civil 3D builds the assembly and the corridor to meet your spe-
cified criteria.

 l Based on the parameters you specify when creating a rehab corridor, the assembly for the 
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corridor is built automatically using the following subassemblies:

Generate Rehab Corridor Reports.

 l You can use the Rehab Manager to generate Cross Slope Correction and Milling and Leveling 
reports for selected stations within rehab corridor regions. You can make changes to values 
in the reports, and apply the changes back to the rehab corridor.

Set Width or Offset Target Dialog Box.

 l Specify whether to use targets on the same side of the baseline as a subassembly or on either 
side of the baseline. When you are setting up subassembly targets, you can select the Use Tar-
gets On the Same Side As the Subassembly check box in the Set Width Or Offset Target dialog 
box to use targets on the same side of the baseline as the subassembly. You can clear this 
check box to use targets on either side of the baseline.

 

Production Efficiency
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Section Views and Sheet Layout

Move section views between section view groups:

 1. The section views that you want to move and the destination section view group must share 
the same sample line group.

 2. Section views can be moved from the individual section views collection to a section view 
group, or from one section view group to another section view group.

 3. The section views are inserted into the section view group in order of their stationing. They 
are inserted between existing section views in the group as needed so all the section views 
are in order.

 4. If the styles are different, the section views you are moving can keep their existing styles, or 
they can use the style of the destination section view group.

 l In the following example, an individual section SL-25 needs to be moved into the section view 
group. Its station is 1+75 so it will be inserted between the sections for station 1+50 and 2+00.

 l The following illustration shows the section view inserted into the section view group. You can 
choose to keep the existing stylization, as shown in this example, or you can choose to apply 
the stylization of the destination section view group to the moved sections. The section view 
for station 3+00 was moved to the next sheet.
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Update the sheet layout

 l When updating the section view sheet layout, resized or inserted section views are respected. 
You can update the layout of a section view group to reset the location of section views that 
were moved out of place, or to update the layout due to another change, such as a change in 
a style or the change in the size of a section or of a drafting buffer. For example, in the fol-
lowing illustration, the bottom edge of the drafting buffer of the top-middle section was 
increased to accommodate the additional annotation below the section view.
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 l You can run the Update Group Layout command to reset the layout so that the minimum row 
height is applied to the layout, as follows.

 l Select a section view whose group layout needs to be updated.
 l Click Section tab>Modify View panel>Update Group Layout > Find.
 l The layout of the section view group is updated to reflect any changes.

Section View Drafting

 l Manage section view annotation by adding it within or crossing the section view drafting buf-
fers. Annotation and drafting elements that you add within or crossing the section view draft-
ing buffers will be bound to the section views and will move along with the section views. 
Section views are created with drafting buffers. When you add AutoCAD annotation or draft-
ing elements or AutoCAD Civil 3D note labels within or crossing the drafting buffers, they are 
bound with the section views, and are moved with the section views if they are moved. In the 
following illustration, the drafting buffers around the section views are shown in magenta. 
Drafting elements that were added to the sheet are shown in red.
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 l When the section views for station 2+50 and 3+00 are moved up or off the sheet, the drafting 
elements that are inside the drafting buffers are moved with the section views. The text that 
notes the lane slope is not moved because it was outside the drafting buffer area.
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Binding drafting elements with a section view

 l Drafting elements become bound to a section view when there are added or modified within 
or crossing the drafting buffer.

 l Any new or existing drafting elements that are added or moved within or crossing a drafting 
buffer become bound to the section view.

 l If you make a drafting buffer larger to encompass or cross existing drafting elements, those 
drafting elements become bound to the section view after you make an edit to them.

 l If you make a drafting buffer smaller, drafting elements that were previously inside or cross-
ing the drafting buffer remain bound to the section view until you make an edit to them.

Use enhanced options for working with projections and crossings in section views. 

 l You can display and label the locations where objects cross a sample line using options that 
are specifically for crossings.

 l When projecting objects to multiple section views, you can use options for filtering the selec-
tion of objects by layer, style, and point group.

 l You can now project objects to a section view from plan view by using a command on the 
sample line context menu.

 l You can now hide projected objects without removing the objects from the section views by 
using check boxes on the Projections tab in the Section View Properties dialog box.

 l Additional options have been added for controlling the label styles for projected objects and 
crossing objects in section views. 

Tip: Now you can change the label styles after the objects have been projected.

To Navigate Between Sample Lines and Section Views.

 l Use new navigation options to zoom to a section view from a sample line, and to zoom to a 
sample line from a section view.

Drafting buffer grips

 l You can use the grips on a drafting buffer to increase or decrease its size. The following illus-
tration shows the grips and the value of the right drafting buffer margin (50.0000) when you 
hover over that grip. You can select the grip and drag it to resize the drafting buffer, or you 
can and enter a new value at the command line.
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 l Resizing a drafting buffer after drafting elements already exist does not automatically change 
the binding behavior of the drafting elements relative to that drafting buffer. For more inform-
ation about the binding behavior, see "Binding drafting elements with a section view" above.

Plan/Plan and Profile/Profile Sheets

 l Create plan/plan and profile/profile sheets by including multiple plan or profile views on a 
single sheet. New drawing templates have been provided that have their viewports already 
configured for these sheet layout types, which you can select when laying out the view 
frames.

 

Add Property set data to labels

 1. Open the Label Style Composer by creating or editing a label style for the project.
 2. In the Label Style Composer dialog box > Layout tab
 3. Select an existing component from the Component Name list, or add a new component for 

the label text.
 4. Under Text, click in the value column for contents > OK

 5. In the Text Component Editor dialog box, click the Property Sets tab.

Info: The Property Sets tab will not appear in the Text Component Editor if there is no 
property set applied to the relevant object type.

 6. Select the property set definition to use and the property to insert.
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 7. Click the arrow to insert the property into the text window. In the following example, the Type 
property has been added to the label style after the point number.

 8. After adding each property into the text window, click in the window and press Enter to insert 
a paragraph return

 9. Add static text as needed in the Text Component Editor window, such as "Condition" or "Tree 
Height". To do this, click in the Text Component Editor window and enter the text directly.

 10. OK

Traverse Editor

Traverse Editor: 

 l Input and edit traverse data. Create points, lines, and curves representing traverse legs and 
sideshots using COGO input and editing tools. The traverse can be used to generate a poly-
line, COGO points, and a TRV2 traverse file which you can open in the Traverse Adjustment 
dialog box and apply an adjustment method. For more information see: To Input Traverse 
Data in the Traverse Editor
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Traverse Adjustment: 

 l Apply an adjustment method to traverse data. Perform traverse adjustments and generate 
reports using Compass, Transit, Crandall, and Grant Line adjustment methods, and update 
COGO points and traverse geometry within the drawing. For more information see: To Adjust 
Traverse Data

Civil 3D 2018 add-ons

WisDOT only: After Civil 3D 2018 is installed, several add-ons will be available for you to 
install with Software Center.  It may take 2-3 days after installing Civil 3D 2018 for these add-
ons to appear in Software Center.

These add-ons include:

 1. Civil 3D Batch Save Utility (available for all versions of Civil 3D)
 2. Autodesk Vehicle Tracking 2018
 3. Geotechnical Module for Civil 3D 2018
 4. Raster Design for Civil 3D 2018
 5. AutoTURN (available for all versions of Civil 3D)

2018 WisDOT plot standards
Last updated: 2020-10-26

Total video time: 25:49

Introduction and plot styles

plt-lyout-2018-plt-stndrd-01.mp4 10:31

Plot Styles

 1. STB
 A. Named styles
 B. The named style controls color lineweight etc.
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 2. CTB
 A. Color dependent plot styles
 B. The color controls color, lineweight. etc.

 3. Why is WisDOT switching to CTB?
 A. Past experience- multiple product defects related to STB
 B. No clean starting point for an STB template

 I. C3D does not ship with an STB C3D template
 II. WisDOT must start from scratch

 C. CTB is the native to AutoCAD and Civil 3D
 I. AutoCAD has used CTB Templates since inception- 1982

 II. STB was introduced in 2000
 III. Civil 3D ships with 66 templates. Only 4 of those are STB

 4. How WisDOT plans to implement CTB?
 A. Simplistic layer based approach implement CTB

 I. Minimize impact on work flow
 II. E-layer colors will be muted (all color numbers ending in 1 will plot gray)

 III. All other colors will remain the same
 IV. Color output by setting layer or object color to RGB
 V. Leverage layer states

Civil 3D 2018 plot style tables overview

The Civil 3D 2018 plot style tables are different than the 2016 plot style tables. The new WisDOT Civil 
3D 2018 plot style tables are CTB (color dependent plot style tables). Just like the 2016 STB (named 
plot style tables), the CTB gives the user flexibility for custom plotting output without ever modifying 
the plot style table.

Plot style tables defined 

The 2018 plot styles are used to define the output color (black, grayscale or color) of an object. When 
an object color is set as ByLayer the plot style color that corresponds with the layer color is used. The 
object properties, layers and/or civil styles define the lineweight and the linetype. There are only two 
plot style tables in 2018. Each are used for creating a specific plot output. The plot style tables in Civil 
3D 2018 are outlined below. 
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wisdot_standard.ctb

This is the primary plot style table for standard plan sheet output. This plot style table is set to plot 
black & grayscale. To maintain layer color consistency from previous versions, each AutoCAD color 
from 1-255 in the plot style table is assigned to either plot as black, gray or white for masking. When 
the wisdot_standard.ctb plot style is assigned to a layout, the object color is plotted based on the 
(black, white or gray) color assigned to it in the plot style table. It is not plotted as the visual object 
color assigned in the layer or object settings. When this plot style table is used with the default plot 
style settings as set in the 2018 startup templates, a consistent plot output can be achieved from any 
workstation with the WisDOT 2018 standards installed.

wisdot_color.ctb

This plot style table is set to plot color: by object and lineweight: by object. Use this plot style table 
when there is a need for many color and/or lineweight overrides at the Civil 3D style, layer or object 
level. This plot style table can also be used to plot a drawing where a majority of objects need to be 
plotted in color. This plot style table allows you to override the standard color and lineweight 
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settings instead of using wisdot_standard.stb. Color and lineweight is determined by the civil object 
style, layer, or object property settings. When the wisdot_color.ctb plot style is assigned to a layout, 
the object color is plotted based on the visual color assigned to it in the layer or object. This plot style 
table is similar to the WisDOT Civil 3D 2014 plot style table wisdot_color.stb.

Legacy plot style table comparison

The 2016 plot styles in the wisdot_standard.stb plot style table define the color output as black, gray 
and white and also the linetype and lineweight output. The 2018 wisdot_standard.ctb plot style table 
only defines the color output.

WisDOT uses a four-part plot standard
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Part 1: Plot style table

The plot style table file is referenced into the drawing that provides drawing object output settings. 
These settings are not associated to any output device. The WisDOT 2016 STB and 2018 CTB plot 
style tables are used to assign individual plots styles to a layer, civil style or a drawing object. The 
plots style tables are set per drawing layout and adapted into the WisDOT page setups.

In order to maintain layer color consistency from previous version each AutoCAD colors from 1-255 
in the plot style table are assigned to either plot as black, gray or white, with the layer or style con-
trolling all other settings.

Please refer to the Wisdot_standard_CTB.pdf located in: C:\Wis-
dot\Stnd\C3D2018\Appdata\Plotters\PlotStyles\WisDOT_Standard_CTB.pdf

This file can be accessed from each WisDOT ribbon on the Manage & Support panel Open WisDOT 
standard CTB pdf.

Warnings: 
To ensure the 2018 plot style tables are consistent on each workstation the users should not 
make edits to the plot style tables. 

Any changes should only be made to a renamed saved copy and the copied plot style file 
should be provided with the project.

Part 2: Layers and civil styles

Since the plot style controls the black and gray shades, all other output including lineweight, linetype 
and even nonstandard colors can be set by the layer or style.  This provides the flexibility to develop 
output settings that are part of the drawing.

Standard layer example

Standard style defined example
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Style deferred to layer example

Page: 2160

Published on: 5/17/2023

2018 WisDOT plot standards



Part 3: Layer states #layer-state

The third-tier is the layer states. This is the real backbone of the entire system.  A layer state is simply 
a snapshot of all the layer settings within the layer manager. The Layer States Manager is used to 
save the settings developed in the second tier. The layer states are saved within the drawing but can 
also be exported and imported into other drawings. WisDOT has included a few standard output lay-
ers states in each of the begin drawing templates; design, survey, plat, and construction-survey. 
WisDOT also provides the same layer states as files that can be imported into any drawing not star-
ted with the 2018 templates.

Access the WisDOT layer states palette from WisDOT Sheets > Plot Configuration > Layer States
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Or from WisDOT Sheets > Plot Configuration > Unsaved Layer States > Manage Layer States

Info: The image above shows the settings to use when managing the WisDOT Layer States. 
The color, linetype and lineweight properties should always be checked to be restored. The 
other layer properties might need to be unchecked when depending on what the previous 
layer state or user set within the layer manager.

Part 4: Page setups & sheet templates

WisDOT provides predefined page setups. A page setup is a saved setting that specifies the plot area, 
paper size, scale, and plot style to use which determine the appearance of a plotted or published out-
put. These setups can be assigned to sheet layouts. WisDOT Civil 3D 2018 page setups have already 
been created for all of the standard WisDOT sheet sizes. All the page setups can also be imported 
from the Page Setups palette as needed and assigned to existing sheet layouts.

Access the WisDOT Page Setup palette from WisDOT Sheets > Plot Configuration > Page Setups
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Notice all the settings, including the plots style that are set within a saved page setup.
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To access the WisDOT tool to manage page setups, go to WisDOT Sheets > Plot Configuration > 
Multi-Page Setup.
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Plot style tables for use with new Civil 3D 2018 drawings

The new wisdot_standard.ctb plot style table should be used with all drawings started in Civil 3D 
2018. Each color plot style can be overridden at the layer or object level.  When complete color out-
put is desired, it may be easier to use the wisdot_color.ctb plot style table. 

As in previous versions these two plot style tables are to be used in conjunction with a saved page 
setup and layer states that WisDOT has provided. Refer to the Page setup tool on the WisDOT Design 
and WisDOT Sheets palette.

Below are a few examples of plot style and layer settings comparisons.
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For sheet plans production WisDOT generally has had 3 standard output colors that could be 
assigned to CAD objects; black, gray, and white.  These may have been named Proposed, Existing, 
and Masking or ##B-wisdot and ##G-wisdot. Within the gray there have been a few options such as 
dark, medium or light gray. In each previous STB configuration, Normal is used to revert all settings 
to the layer, including the color. 

None of these concepts have changed when using the CTB. WisDOT is still providing the three main 
colors along with grayshade options, and of course the ability to make any object a specific color 
besides black, gray or white. 

The first thing you will notice is there is no Plot style that needs to be to set in the Layer manager 
when using a CTB.  The output color is determined by the color of the layer.

Black (Proposed)

In the WisDOT 2018 CTB configuration black is each color except for colors ending with 1, and colors 
21-29, and colors 243-255.

Gray (Existing)

In the WisDOT 2018 CTB configuration gray is each color that ends with a 1, and colors 22-29, and col-
ors 243-255. These two group of colors are used for county maps and to give the user additional 
gray shade options.

White (Masking)

The color 255 is reserved to use for masking.
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Normal (Color)

In the WisDOT 2018 CTB configuration all layer properties except for color can be considered to be 
set to Normal.  To override the plot style color change the color to a TrueColor (RGB color). Example 
red = (255,0,0)

 

How to modify 2018 civil object styles

To plot specific civil objects in color in an otherwise standard plot, the user can change the civil 
object style to an "override" TrueColor (RGB) or assign the civil object style to a layer that is set to 
plot an RGB color. In order to make a change to a style create a new style and adjust the hard-coded 
color in the style definition. Putting a suffix like _color in them can help denote predefined style sets 
to be used for overriding the output color and or lineweight at the object or layer level. For example, 
in order to plot proposed alignments in color follow these steps:

How to change a civil object style to an "override" TrueColor

To make a change to a style create a new style. Putting a suffix like _color in the name of the new 
color style can help denote predefined style sets to be used for overriding the output color and or 
lineweight in the object properties. Then adjust the color in the style definition to be a TrueColor. For 
example, in order to plot a proposed alignment in color using a defined civil style instead of changing 
the color properties of the layer, follow these steps:

 1. Create a copy of the ALI Proposed style and rename it to something unique.
 2. Edit the new style, and change all of the components' colors to an RGB color on the Display 

tab.
 A. You may want to modify both the Plan and Section display.
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In order to plot certain AutoCAD objects in color in an otherwise standard plot, the user will need to 
set the object to a TrueColor (RGB). This can be accomplished 2 ways:

 1. Select object to be plotted in color and change the color of the object to a TrueColor (RGB) in 
the properties dialog box.

 2. Keep all of the AutoCAD objects' colors set to BYLAYER, which is the default setting and 
change the color of the object layer to a TrueColor (RGB). This will plot all objects on this layer 
using the layer color. This can also be done to xreference layers when the color of an xrefer-
ence needs to be changed.

Tip: Any Civil 3D style may be copied and saved as a new style. The color, lineweight, and line-
type settings in the "Display" tab can then be set to create an override style. Do not edit the ori-
ginal WisDOT Civil 3D styles. Always create a copy. 

Demonstration: Modify objects using the WisDOT C3D 2018 plot style tables

plt-lyout-2018-plt-stndrd-02.mp4 3:01

plt-lyout-2018-plt-stndrd-data-c3d18.zip

plt-styl-bsc-demo.dwg, plt-styl-bsc-demo-fnshd.dwg

This is a simple demonstration to show the basics of setting object properties and layers to conform 
with the WisDOT Civil 3D 2018 plots styles.

This example will show how to:

 l Modify layers and objects to plot the black, gray, masked or color output you want
 l Modify objects so that they can conform to the standard layer states
 l Load standard layer states and set a layer state current
 l Save your custom layer settings as layer states within the drawing

In this drawing we can see that all the objects are on layer 0; in this case the wrong layer. Layer 0 is 
set to color 7. This will show ways to set the object's color to black, gray and masked.

 1. Open the layer manager and review the layers. Notice all the layers in this example are set to 
white and some of the lineweights are set pretty thick.

 2. Switch to the layout tab where you can see the object will plot black.
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 3. Switch back to the model tab where you can see each object will plot black.

plt-lyout-2018-plt-stndrd-03.mp4 5:50

 4. WisDOT Sheets > Manage & Support > Open WisDOT standard CTB pdf to review the plot 
style table.

 A. Use the table to manually set the objects to an appropriate color that will make them 
plot black, gray and masked. In this demonstration the Quick Properties is set to on.

 B. Select the line labeled E_AREA (Existing, Gray) and change the color to 11 and deselect
 C. Select the line labeled P_AREA (Proposed, Black) and change the color to red and 

deselect
 D. Select the line labeled P_RDWY_Berm (Proposed, Black) and change the color to 80, 

deselect
 E. Select the line labeled P_MISC_Mask (Masked, White) and change the color to 255, 255, 

255, deselect
 F. Switch the hatch by using right to left crossing and change the color to 255, 255, 255, 

deselect
 5. Switch to the layout tab to see the plotting effects of these changes. Now modify the gray 

shade to be darker.
 6. Access the model space through the viewport. Select the line labeled E_AREA (Existing, Gray) 

and change the color to 251, deselect
 7. Select all objects and set the color to ByLayer
 8. Select each object and set it to the proper layer defined by the text. Set all the text to be on P_

MISC_Text. Each object now has a linetype defined by the layer
 9. To set all the layer settings including the color to the 2018 WisDOT standard:

 A. Exit the model space viewport and switch to the model tab
 B. WisDOT Sheets > Plot Configuration > Layer States to open the palette
 C. This is an easy way to load any of the layer states into the current drawing. The 

WisDOT begin drawing templates have the appropriate standard layer states already 
loaded

 10. Pick WisDOT18 All Layers (default) to load the layer state into the drawing
 11. WisDOT Sheets > Plot Configuration > Unsaved Layer State pulldown and select 

WisDOT All Layers (default)
 A. Open the Layer manager, select the All Used Layers filter
 B. Now each layer is set to plot black, gray or masked depending on the color of the layer 

it is assigned. The standard color of most of the proposed layers has not changed 
since most of them plot as black

 12. Switch to the Layout tab to see the standard plot output
 13. To modify objects on a layer to plot color define that color as an RGB color

 A. Open the Layer Manager and change the color of layer P_RDWY_Berm to the TrueCo-
lor equivalent to magenta

 B. The line will plot in color
 14. To save this custom color configuration to a Layer State: WisDOT Sheets > Plot Con-

figuration > Unsaved Layer State > Manage Layer States
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 15. Make sure both restore options in the lower left are unchecked and New
 16. Name it: My Custom Layer State, Close
 17. From the Unsaved Layer State pull-down you can switch back and forth between WisDOT All 

Layers (default) and My Custom Layer State

Demonstration: Options for preparing legacy dwgs for use with the WisDOT C3D 
2018 plot style table #demo

plt-lyout-2018-plt-stndrd-04.mp4 6:26

plt-lyout-2018-plt-stndrd-data-c3d18.zip

plt-styl-mdfy-lgcy-dwgs.dwg, plt-styl-mdfy-lgcy-dwgs-fnsh.dwg

Even new projects that begin in the Civil3D 2018 version using the WisDOT 2018 standards might 
need to reference some drawings that were developed with previous standards using previous 
AutoCAD versions. These files will need to be setup so they will work with the 2018 plot style table.

If you have permission to edit these drawings then use the following steps as a guide to update the 
drawings that require conversion. If you do not have permission to edit these drawings then you will 
need to send these steps and the WisDOT18 All Layers (default).las LayerState file to the person that 
can make these modifications.

In this example exercise we will be assuming that an older existing base drawing will be  referenced 
into a design dwg. For ease of display and demonstration purposes the drawing background has 
been set to white. The drawing has already been converted to a CTB plot style format drawing, and a 
WisDOT C3D 2018 Page Setup has been loaded and set for the layout.

Tasks covered in this example:

 l Change objects to ByLayer
 l Create a Layer filter
 l Modify layer colors to plot gray
 l Modify blocks to plot according to the layer they are on

 1. Open plt-styl-mdfy-lgcy-dwgs.dwg

Tip: WisDOT has provided Preset LayerStates that include all the layers and settings that 
are used for WisDOT Standards 2018 and 2016. It may not be an all-inclusive list for 
your specific base drawing that needs to be converted. The existing dwg may or may not 
have existing layer states imported. New LayerStates will need to be imported.

 2. Create a custom layer snap shot of the existing conditions of the drawing:
 A. WisDOT Sheets > Plot Configuration > Unsaved Layer States > New Layer States
 B. Name it: Existing Topo Layers
 C. Description: Topo-Ex existing layer states

 3. Import the WisDOT C3D 2018 default layer state from the palette.

 A. WisDOT Sheets tab > Plot configuration > Layer States
 B. Select WisDOT18 All Layers (default) from the palette
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 4. WisDOT Sheets > Plot Configuration > Layer States pull-down > Select the layer state 
to make it current.

 5. Expand the pull-down and move the cursor over each layer state in the list to reveal the layer 
color changes in the drawing area.

Info: The dwg may require legacy or older custom layers to be modified manually. 
Most things that may need to be modified manually would be custom layers not 
included in the 2018 standards.  Objects that are not set to color ByLayer, and civil 
objects using styles from a previous version.

The following steps as a guide to manually update object and layer settings to conform with the 
WisDOT 2018 layer states.

IIn cases where the dwg was created using the 2018 plot style and standards tools, there usually is 
not a need to modify anything.

Info: It is now clear which objects are not set to a grayscale color for plotting. The trees and 
manholes are still black.

 1. By checking the Quick properties of the tree line and tree blocks we can see they are on a 
non-standard layer named E-LAND-Trees.

 2. The quick Properties of the manhole reveal that the blocks are on layer E_DRN_Grate.
 3. In the Layer Properties Manager, scroll down until there are layers that have a light green 

value. Notice the existing layers that are close to green are set to 81. (Numbers ending in 1 
plot gray)

 4. Now look at existing layers that have a light blue value. Notice the existing layers that are 
close to blue are set to 171. (Numbers ending in 1 plot gray)

 5. Select the color column of the E-LAND-Trees layer and type in the color number 81.
 6. Switch back to the drawing area

 A. The trees change to a gray scale.
 B. Notice that the block MHO is still black and not gray after setting the layer state. This 

usually means that the block may be a legacy block or one from another CAD software 
that has the color set within the block and not referencing the layer it is on.

 7. To edit all the references of the block, select one of the manhole blocks > right click > 
Block Editor

 A. Select all the circle objects
 B. In the quick Properties change the color to ByBlock and the layer to 0.

Info: Setting the block to ByBlock and layer to 0 allows the block to take on the 
layer it is assigned to in the drawing and be editable through the xref layers of 
the host drawing.

 C. Close Block Editor, Save the changes
 8. Repeat the last step for all the blocks that have the block objects set directly within the block. 

Some objects like the trees still are black and not set to gray.
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 9. Change all objects in the drawing to ByLayer to ensure that they are being controlled by the 
layer color, use the Quick Select tool in the right-click menu.

 A. Apply to: Entire drawing
 B. Object type: Multiple
 C. Properties: Color
 D. Operator: <> Not Equal
 E. Value: ByLayer
 F. OK

 10. Properties palette > Color: ByLayer

Now all the objects and layers should be ready to plot using the WisDOT C3D 2018 plot style table.

Multi-page setup tool #multi

Once page setups are added to the drawing from the palette, the Multi-Page Setup tool can be used 
to set the layouts to a page setup. This can be done globally or by selection of layouts in a list. See 
Multi-Page Setup for more info.
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Civil 3D project version migration to Civil 3D 2018
Last updated: 2021-02-17

Minimum migration steps per drawing matrix #minimum

The following table shows common files from "Project data workflow map" on page 181 with migration steps for each file.

X = Required.

O = Optional. Required for DWGs with pipe networks.
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X X X X   X          
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Folder Drawing Descrip-
tion

Clea-
n 

and 
fix

Sav-
e to 
Civi-
l 3D 
201-

8

Con-
vert 
to 

CTB

Upda-
te lay-

ers

Updat-
e pipe 

net-
works

Import 
updat-

ed 
styles

Cross 
sec-

tions: 
Draft-

ing buf-
fers

Sec-
tion 
view 

& 
group 
plot 

styles
 

Add Civil 
3D 2018 

updated 
com-

ponents 

Insert 
page 
setup 
and 
upda-

te lay-
outs

Cor-
ridor 
draw-
ings 

BaseData-Other
USGS DEM 
surface

For drain-
age ana-
lysis 

X X                  

 
Existing pipe 
network

Model of 
existing 
facilities

X X     X            

BaseData-Sur-
vey

Sur-
veyEdits.dwg
 

Field sur-
vey edit file
 

X X                  

 
Topo-Ex-Sur-
vey.dwg 

Existing 
survey 
topo 

X X X X   X          

 
Surf-Ex-Sur-
vey.dwg 

Existing sur-
vey surface
 

X X                  

 
SurvCtrl.dwg
 

Field con-
trol data 

X X X X   X          

Design\AliProf 
AliProf-
<Road>.dwg 

Alignments 
and pro-
files 

X X                  

Design\Cor-
ridors 

Crdr-
<Road>.dwg 

Corridor (s)
 

X X                 X
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Folder Drawing Descrip-
tion
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n 

and 
fix

Sav-
e to 
Civi-
l 3D 
201-

8
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vert 
to 

CTB

Upda-
te lay-
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Updat-
e pipe 

net-
works

Import 
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ed 
styles
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Draft-

ing buf-
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view 

& 
group 
plot 

styles
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3D 2018 

updated 
com-

ponents 

Insert 
page 
setup 
and 
upda-

te lay-
outs

Cor-
ridor 
draw-
ings 

Design\Edgelin-
es 

pavt.dwg  
Proposed 
pavements

X X X     X          

  SI.dwg  
Proposed 
slope inter-
cepts

X X X     X          

  PM.dwg  
Pavement 
marking

X X X     X          

Design\Sur-
faces 

Surf-Rfnt-All-
Top.dwg 

Top refine-
ment sur-
faces 

X X                  

 
Surf-Rfnt-All-
Datum.dwg 

Datum 
refinement 
surfaces 

X X                  

 
Surf-Cmbn-
Ex-Top.dwg

Combined 
existing 
and pro-
posed top

X X                  

 
Surf-Cmbn-
Ex-
Datum.dwg  

Combined 
existing 
and pro-
posed 

X X                  
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Folder Drawing Descrip-
tion

Clea-
n 

and 
fix

Sav-
e to 
Civi-
l 3D 
201-

8

Con-
vert 
to 

CTB

Upda-
te lay-
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Updat-
e pipe 

net-
works

Import 
updat-

ed 
styles

Cross 
sec-

tions: 
Draft-

ing buf-
fers

Sec-
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view 

& 
group 
plot 

styles
 

Add Civil 
3D 2018 

updated 
com-

ponents 

Insert 
page 
setup 
and 
upda-

te lay-
outs

Cor-
ridor 
draw-
ings 

datum

 
Rur-
alDwy.dwg 

Rural drive-
way grad-
ing 

X X                  

Design\PipeNet-
works 

Pipe-Cul-
verts.dwg

Proposed 
culvert 
design

X X     X            

 
Pipe-
StormSew-
er.dwg 

Proposed 
storm 
sewer

X X     X            

Design\Quant-
ities  

Quant-
ities.dwg 

Document 
length and 
area meas-
urements

X X                  

 
Earthwork-
<Road>.dwg 

Earthwork 
calculation 
drawings 

X X                  

RW Ult-RW.dwg

Com-
bination of 
exist and 
proposed 
RW

X X X X   X          
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Folder Drawing Descrip-
tion

Clea-
n 

and 
fix

Sav-
e to 
Civi-
l 3D 
201-

8

Con-
vert 
to 

CTB

Upda-
te lay-

ers

Updat-
e pipe 

net-
works

Import 
updat-

ed 
styles

Cross 
sec-

tions: 
Draft-

ing buf-
fers

Sec-
tion 
view 

& 
group 
plot 

styles
 

Add Civil 
3D 2018 

updated 
com-

ponents 

Insert 
page 
setup 
and 
upda-

te lay-
outs

Cor-
ridor 
draw-
ings 

SheetsPlan
Non Civil 3D 
Object 
DWG's 

Do not con-
tain ali, 
profs, 
crdrs, surf, 
or pipe net-
works

X X X X   X     X X  

 
021201-
pd.dwg 

Plan details
 

X X X X O X     X X  

 
022501-
ss.dwg 

Storm 
sewer 

X X X X X X     X X  

 
024501-
pm.dwg 

Pavement 
marking 

X X X X   X     X X  

 
050101-
pp.dwg  

Plan 
andprofile

X X X X O X     X X  

 
090201-
xs.dwg  

Cross sec-
tions

X X X X O X X X X X  

Project version migration to Civil 3D 2018

Project migration is a choice that requires certain steps and processes be followed to ensure that all files are functioning correctly after 
migration. The following process is used to convert project drawings to WisDOT Civil 3D 2018 standards.
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The process of changing a project between Civil 3D versions with different drawing formats needs to be thought of in terms of a complete 
project-based activity. This means:

 l Backward compatibility does not readily exist between Civil 3D 2018 and previous versions. 
 l Everyone working on a migrated project needs to be using the new version files for that project. This means not only Project Devel-

opment staff, but also Technical Services, Planning, Consultants, etc. 
 l Once the decision to migrate the project is made, All DWGs, Data Shortcuts, and referenced DWGs that will still need to be edited or 

accessed in a project must be converted. This may require updates to base drawings created by others. 
 l The time and effort to plan and execute the project migration may require more than a few hours. Scheduling one day for project 

migration activities would be appropriate for most projects. 
 l Migrating project drawings involves a few more considerations besides the save-as steps and order of operations to perform the pro-

cesses. Migrating all the necessary drawings can be a significant effort, and the variables described in the next sections should be 
recognized and understood before moving forward with the migration.  

WisDOT does not require project version migration as a rule. However, there are many reasons to keep up-to-date on the current software 
version. Projects shared between in-house staff and consultant staff may require project migration to keep all staff on the same version of 
Civil 3D. The following chart was developed to assist project staff in the decision of whether to keep a project in the current Civil 3D version 
or migrate to Civil 3D 2018.
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The decision whether or not to migrate a project is not a black and white issue. Some additional factors to consider for the timing of a pro-
ject migration include:

 l The benefits of new software functionality and WisDOT standards may or may not outweigh the costs of migration.
 l The completion level of design and the timeline to PS&E submittal are critical to this decision. If project deadlines (30% submittal, 

60% submittal, PS&E, etc.) could be jeopardized by the migration taking longer than expected, the project should not be migrated.
 l Project size and complexity will increase the level of effort necessary to migrate the project.
 l All people working on the project in Civil 3D must have the version of software being migrated to and are aware of the migration.
 l The expected time commitment to migrate the project can be absorbed by the design team.
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Important potential changes between Civil 3D versions

This Civil 3D version change is referred to as a migration because of these primary factors:

 l Each version may use a different drawing format
 l There may be no backward compatibility between Civil objects and dynamic capabilities
 l Subassemblies use different source code files and are recompiled with a new path
 l Data shortcut functionality may have changed
 l Project drawing files cannot be worked on while Edits to the Data Shortcuts files and accompanying drawings are being made
 l Changes to the WisDOT standards files and locations may be appreciably different in the latest version

New drawing format

Civil 3D 2018 uses a 2018 DWG file format. In simple terms, Civil 3D uses the DWG file not only as a place to store graphical information, it 
also treats the DWG as something like a database file. To accomplish new functionality the files are written differently and new elements 
are added to the 2018 DWG files that do not exist in previous DWG versions.

The migration process relies on creating a copy of all Civil 3D files and Data Shortcut files in a new location and migrating the originals to 
Civil 3D 2018. The copied original Civil 3D files are to be used for troubleshooting needs that may arise, and to ensure functionality was 
intact prior to the project migration into the 2018 format.

No backward compatibility

Warning: Since there is no backward compatibility of Civil 3D objects between the two DWG formats, there is no ability to turn a 2018 
drawing back into a fully functioning drawing in a previous version without a lengthy rebuild process. Success with a rebuild is not 
guaranteed to fully succeed.

Before beginning the migration to Civil 3D 2018

The time it will take to transfer a project will vary depending on:

 l Number of drawings
 l How many drawings are consuming xrefs
 l How many drawings are being xref'd
 l The number of data shortcuts and drawings hosting data shortcuts
 l The condition and version format of the original drawings

Page: 2181

Published on: 5/17/2023

Civil 3D project version migration to Civil 3D 2018



The Data Shortcut project needs to be reviewed and corrected in its current version prior to the project migration.

Additional time should be expected to ensure the project is fully cleaned. All drawings and data shortcuts need to be working properly prior 
to going through the various migration steps outlined in the following section.

Only those working directly on the migration of the project data should be opening any of the drawings during the migration process. It is 
recommended that there should be a minimum number of persons involved in doing the migrating tasks, preferably one person.  Most pro-
jects contain drawings that are under the ownership of various individuals or sections (PDS, Survey, Plats, etc).  It is important to com-
municate the project migration plan to each party involved and confirm their time commitment if they will be the ones performing the 
migration for their files.

The transfer is complete when all useable DWG files are saved in the 2018 format and a project integrity check has been accomplished.

Clean and fix project drawings and references

Verify that all Data Shortcuts, Data Shortcut References, and External References within the project are working properly. Use the following 
steps as a guide to ensure that they are clean and working correctly. These steps require a working knowledge of file management and Pro-
ject Data shortcut tools.

Project Data Shortcuts

These steps are required to be done in the project's current version. It is not recommended to migrate or use any of the project drawings 
and reference files that are not fully functional in the version they were initially created in.

 1. All Data Shortcuts must by synchronized and working properly
 2. Open the Data Shortcut project in the Civil 3D Prospector without project drawings open

Tip: This may require communication with the entire project team

 3. Right click- Validate Data Shortcuts

 4. Expand the entire Data Shortcut tree for each object, and search for any exclamation symbols 
 5. Use the right click menu to Remove or Repair Broken Shortcuts
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 6. An additional dialog box may prompt to Repair All Broken Shortcuts > YES
 7. This may repair the rest of the broken Shortcuts in the project
 8. Search for any more Exclamation symbols in the Data Shortcut tree in the Prospector tab
 9. Close and reopen Civil 3D to save Data Shortcut edits

 

Drawing data shortcut references

Civil 3D 2016 includes a tool to assist users in repairing broken data shortcut references within a drawing.  Information on how to use the 
Data Shortcut Manager is published on Autodesk's website.  Data Shortcut Manager. Use this tool on the project drawings to repair and 
update data shortcut references prior to migrating a project.

In drawings that contain external references, it is a best practice to review the external references manager to ensure correct pathing and 
resolve any missing references.  This topic is covered here: "Repair external references" on page 163  

Batch Save Utility to repair project drawings in their current version

 1. Exit all versions of Civil 3D
 2. Windows Start Menu > Autodesk > Civil 3D Batch Save Utility
 3. Choose current Civil 3D project version. If the project being migrated is currently in Civil 3D 2016, choose Civil 3D 2016.
 4. Under Custom Script, choose defaultClean.scr from the drop-down menu. The script will purge registered applications, purge all 

unused resources and audit each drawing in addition to saving Keeping Drawings Clean
 5. If there are any directories that you would like to exclude from the process, choose them by clicking Exclude 
 6. Under the Skip Drawings section it is recommended to only check the "Read Only" box
 7. Under the Process Settings it is recommended to only check the "Timeout for a drawing" box (set to 10) and the "Process Sim-

ultaneously" box (set to 4)
 8. Start Depending on the number of files this could take some time.
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 9. Log to verify all drawings were successfully processed
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 10. There may be cases where drawings fail. Options include:
 l Open the drawings manually and clean (Purge, Purge RegAps, Audit) Keeping Drawings Clean
 l If problems persist contact CAE Support

Project drawing migration

Make a copy of the project before migrating

Save a copy of the entire project. The minimum for this is to create a copy of all the Civil 3D DWG files and Data Shortcut files. This project 
copy should be outside of the original project location, and outside of the project folder used to define the Data Shortcut project, store on a 
local drive or flash drive. Leave this copy of the project in its current version. Use the original project location to migrate to 2018. This will be 
the same folder structure for most projects.  (i.e. N:\PDS\C3D\12345678)

When migrating a project to a version that has a newer drawing format (ie. Civil 3D 2016 to 2018), it is important that ALL drawing files that 
are being used as external references (xrefs), Data References, and Sheet production drawings be saved as a Civil 3D 2018 drawing.

Tip: Important Note: It may not be necessary to migrate drawings or files to the new version if they are not going to be used (directly 
or via reference) in further project development and can be archived and PDF deliverables created from them.

Save to Civil 3D 2018

Utilize the Autodesk Batch Save Utility to save all the project drawings to Civil 3D 2018.

 1. Exit all versions of Civil 3D
 2. Start > Autodesk > Civil 3D Batch Save Utility

 A. Target: Civil 3D 2018
 B. Custom script: qsave.scr
 C. Add the project folder within the Include area. If there any directories that you would like to exclude from the process, 

choose by clicking the Add button in the Exclude area
 D. Under the Skip Drawings section, only check the "Read Only" box
 E. Under the Process settings Check "Timeout for a drawing" (set to 10) and "Process Simultaneously" (set to 4)
 F. Start Depending on the number of files this could take some time.
 G. Log to verify all drawings were successfully processed
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 3. There may be cases where drawings fail. Options include:
 A. Open the drawings manually and save them to Civil 3D 2018.
 B. If problems persist contact CAE Support

Migration order of operations

Info: For migration, best practice is to start with source drawings (ie. BaseData, RW), follow up with design drawings that are XRef'd 
into plan sheets, and finish with plan sheet drawings.

Convert plot style to CTB 

Prior to WisDOT's implementation of Civil 3D 2018, all previous versions utilized drawings with STB Plot Style Tables.  With the release of 
Civil 3D 2018, WisDOT has made the transition to CTB formatted drawings.  Follow these steps to convert a drawing from STB to CTB.  This 
process only needs to be completed for plan sheet drawings and drawings that are attached as an external reference (XRef) into plan sheet 
drawings.

 1. PSTYLEMODE Enter
 o If it is 0 then it is STB and needs to be converted
 o If it is 1 then continue to "Use Layer States to Update DWG Layers"

 2. CONVERTPSTYLES Enter , Ok

 3. The drawing is now a CTB format > Save

Page: 2187

Published on: 5/17/2023

Civil 3D project version migration to Civil 3D 2018

mailto:support.cae@dot.wi.gov


Use Layer States to update DWG layers

Prerequisite: The drawing must be converted to CTB prior doing this step.  This process only needs to be completed for plan sheet 
drawings and drawings that are attached as an external reference in plan sheet drawings.

 1. Save the current layer state. This will be useful for drawings with non-standard drawing layer settings.
 A. WisDOT Sheets ribbon > Plot Configuration panel > Unsaved Layer State drop-down > New Layer 

State

 B. In the dialog box, name the layer something that is easy to recognize (Original-Pre2018) > Ok
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 C. This Layer State can be used later to restore custom layer settings if they exist

 2. WisDOT Sheets ribbon > Plot Configuration panel > Layer States

 3. The Layer States Palette will open. If it doesn't click the Palettes On/Off button on the left end of any WisDOT ribbon
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 4. Click on WisDOT18 All Layers(default) from the Layer States Palette to load the Layer State into the drawing
 5. Home ribbon > Layers panel > Layers

 6. Unsaved Layer State > Manage Layer States

 7. Layer States Manager
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 A. Select the WisDOT18 All Layers(default) layer state from list of options.
 B. Uncheck the following boxes:

 I. Restore options
 a. Turn off layers not found in layer state

 II. Layer properties to restore
 a. On/Off
 b. Frozen/Thawed
 c. Locked/Unlocked

 C.  Restore
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 8. The layers now have been successfully translated to WisDOT Civil 3D 2018 Standards. To verify proper translation, Home Tab > Lay-
ers Panel > Layer Properties Manager.
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 A. 2016 WisDOT Layer Standards (STB Format): Notice the named plot styles in the Plot Style column

 B. 2018 WisDOT Layer Standards (CTB Format): Notice the grayed out and color_** named Plot Styles.  In this drawing type, the 
plot color is driven by the color of the layer.   Also, notice the index color numbers for some of the layers mostly including the 
existing layers.  If you do not see the Plot Style column, right click on the title bar (Name, Linetype, Plot Style, etc) and select 
Restore All Columns to Default.
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 9. Update External References. Before proceeding with this step, all external reference drawings must be updated to CTB and Civil 3D 
2018 Layer settings.

 A. Create a Layer State for the current layer settings
 B. Home tab > Layers panel > Layers Properties

 I. In the Filters > expand Xref
 II. Right-click the target drawing name > Reset Xref Layer Properties > All Properties

Pipe network drawings
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Info: This is only required for drawings that contain pipe network objects (Source or Data Reference)

Add updated parts list to old drawings. This process updates the WisDOT parts lists in the drawing.  If you previously made any edits to 
these parts lists, those edits will be overwritten with this process.

 1. WisDOT Design ribbon > Pipe Network Utilities > Add WisDOT Parts List

Import updated Civil 3D styles

Info: This is only required for plan sheet drawings and their external references.

Many styles have been updated in Civil 3D 2018. Follow these steps to get the latest style definitions.  If you previously made edits directly to 
any WisDOT-provided styles (vs making a copy), this process will overwrite those edits.

 1. The drawing must be saved prior to starting this process.

 2. Manage ribbon > Styles panel > Import
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 3. In the dialog box, navigate to C:\WisDOT\Stnd\C3D2018\Templates\Begin-dwg\design-wisdot18.dwt or applicable template (ie. 
Design, Survey, Plats, Construction Survey). Click Open to load the template. Civil 3D will compare the loaded template to the cur-
rently open drawing.

 4. Once the dialog box opens, leave everything checked as defaulted. Import settings should NOT be checked.
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 5. OK

 6. OK
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 7. The drawing styles are now updated

Cross section drawings #cross

In Civil 3D 2018, slight adjustments were made to the Group Plot Styles and Section View Styles to allow for the section views to be placed 
closer together on a cross section sheet. Drafting Buffers have also been introduced in Civil 3D 2018 and allow annotation objects to be 
"connected" to section views (Drafting Buffer Information).  

Section View Drafting Buffer

Info: The following is required for migrating cross section drawings from Civil 3D 2016 to Civil 3D 2018.

Warning: When opening a Civil 3D 2016 cross section drawing in Civil 3D 2018, a drafting buffer gets added to each section view with 
a default size that is not editable.  For this reason, the drafting buffer is turned off in the Group Plot Styles when opening a 2016 draw-
ing in C3D 2018.  When importing the updated WIsDOT Group Plot Style, the drafting buffer will be turned on.  This results in one view 
on each cross section sheet.

After importing updated Civil 3D styles to a cross section file, the group plot style for the cross section views will need to be updated to keep 
the section views organized as originally set up.  

 1. Home Ribbon > Toolspace > Settings > Section View > Group Plot Styles

 2. Right Click > Edit any Group Plot Styles that are noted to the left of the style name by the yellow dependency triangle.  
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 3. In the Group Plot Style edit dialog, open the Array tab, and uncheck the "Add drafting buffer size to space between views."

 4.  OK to close the dialog. 
 5. The Section View Group Layout will be updated.  Due to the smaller spacing for the Group Plot Style and Section View Style, the sec-

tion views will be placed closer together than what was done with Civil 3D 2016.  If desired, follow the next section to update the 
styles to move the section views to pre-Civil 3D 2018 spacing.
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Section View and Group Plot Styles

Info: The following is optional for cross section drawings.

Warning: The adjustments made to the section view styles and group plot styles in Civil 3D 2018 result in slight movement of the sec-
tion views that were made in Civil 3D 2016.  Any annotation objects will not move with the section views.

After modifying the group plot style in the previous section, the section view group layout will update and the section views will be placed 
closer together than what was developed in Civil 3D 2016.  If desired, the styles can be updated to reflect the Civil 3D 2016 standards.   This 
is not required for complete migration, it is up to the project staff to decide if this is needed for the cross section drawings.  Possible reas-
ons to complete these steps include: 

 l Annotation objects such as labels and Mtext were created in the original cross section view locations and no longer line up with the 
section view.

 l Since section views are placed closer together, there may be less section sheets than layouts, and some layouts might be empty.
The following describes updating the Group Plot Styles and the Section View styles to reflect the Civil 3D 2016 standards

 1. Home Ribbon > Toolspace > Settings > Section View > Group Plot Styles

 2. Right Click > Edit any Group Plot Styles that are noted to the left of the style name by the yellow dependency triangle.  
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 3. Group Plot Style edit dialog >  Array tab
 A. Change the Space between adjacent section views to 1" for each option.

 B.  OK  
 4. Home Ribbon > Toolspace > Settings > Section View > Section View Styles

 5. Right Click > Edit any Section View Styles that are noted to the left of the style name by the yellow dependency triangle.  
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 8. Section View Style dialog > Grid tab
 A. Change the Axis offset above and below to 0.50".  

 B. OK.  
 9. The Section View Group layout may not update automatically.  To update the layout, select one of the section views in model space, 

either by picking on an elevation or offset axis label.  From the contextual ribbon, pick Update Group layout.
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Add Civil 3D 2018 updated components
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It is recommended that for plan sheet drawings, the updated Civil 3D 2018 components be added to get the latest versions of Dimensions, 
Layers, Linetypes, Marker Symbols, Multileaders, and Text Styles.

If only some objects are desired, those objects can be added using the buttons under the "Add Component" pull-down.  If all objects are 
needed in the drawing, the "Add All Components" button can be used.

Insert page setup and update layouts

Requirement: This is required for drawings with plan sheet layouts

Drawings that contain plan sheet layouts may contain page setups that will not plot correctly with the 2018 standards.  When the drawing is 
converted to CTB, the plot style tables set in the existing layout's page setups are removed.  Updated page setups that match WisDOT's Civil 
3D 2018 standards need to be applied to all layouts in a drawing.
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 1. WisDOT Sheets tab > Plot Configuration panel > Page Setups

Tip: If you do not see the tool palettes click the Palettes ON/OFF on the left side of the panel.

 2. Page Setups Tool Palette > PDF-11x17-stnd to load the WisDOT Civil 3D 2018 plan sheet page setup into the drawing.

 3. If the page setup being imported contains the same name as a page setup already in the dwg, this message will appear- Yes

No to update all layouts
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 4. To verify that the page setup has been properly assigned, use the Multi-PageSetup tool to assign the newly loaded page setup to the 
layouts within the drawing. 

 5. WisDOT Sheets tab > Plot Configuration panel > Multi-PageSetup
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 A. Refresh All to update both lists on the palette
 B. Select all the layouts that require the updated Page Setup.  Also, select the updated Page Setup in the second list.  Use Shift-

Select or Control-Select to pick different layouts.

 C. Apply to apply the updated Page Setup to the selected layouts.
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 6. Navigate to a layout and verify a layout is plotting in black and gray scale.  If the page setup assignment is incorrect, the layouts will 
plot color.

Updating a corridor drawing

This is only required for drawings that contain corridor objects.

The following sequence should be applied to each project corridor drawing saved to Civil 3D 2018.

Warning: These steps should not be taken until all other steps in the sections above have been completed.

 1. Open the corridor drawing in Civil 3D 2018
 2. Synchronize all Data Shortcuts
 3. If the Event Viewer has been populated through any of these first steps, all events should be cleared before proceeding.
 4. Rebuild the corridor. If the Event Viewer shows events, clear Event Viewer and then:

 A. Corridor Properties dialog > Parameters tab
 I. Uncheck all regions.

 II. Apply to rebuild the corridor with no regions constructed.
 III. Recheck all the regions.
 IV. OK to rebuild the corridor with all regions constructed.

 B. Check the construction of the corridor in plan and corridor section editor.
 5. In the rare case where the Event Viewer still shows events, review the Warning Descriptions, looking for: ".Net subassembly project, 

module, or class not found". If this error is found, please email Methods Development at support.cae@dot.wi.gov

 6. If the drawing has more than one corridor, follow steps 4 and 5 for each corridor
 7. Repeat steps 1-6 for each drawing that has corridor.
 8. Save after each corridor rebuilds and before closing the drawing.
 9. Once corridors are built, verify all data references are rebuilt in the drawing.

 10. Save and Close.

Legacy objects (Pre-2016)
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Refer to "Demonstration: Options for preparing legacy dwgs for use with the WisDOT C3D 2018 plot style table #demo" on page 2171 for 
additional information for updating legacy objects

Fatal error on open, reset Civil 3D
Last updated: 2020-10-26

Issue

Civil 3D 2018 may crash with a "Fatal Error" message.  When re-opening Civil 3D, the "Fatal Error" message returns, even with computer 
restarts and re-opening of Civil 3D.

Solution

 1. Close Civil 3D, if open.
 2. Start > Autodesk AutoCAD Civil 3D 2018 > Reset Settings to Default
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 3. Reset Settings - Backup dialog box > Reset custom settings
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 4. OK after settings have been reset.

 5. Autodesk AutoCAD Civil 3D  will begin an initialization process. Once it completes, AutoCAD will open.  Do not interrupt this process.
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 6. Once AutoCAD opens completely, close the application.
 7. From the desktop, Update WisDOT C3D

 A. Click the checkbox next to the version to be updated
 B. Deploy

 8. Let the Civil 3D update process complete.
 9. From the desktop, Civil 3D WisDOT

 10. Once the application opens, WisDOT Tab > Support panel drop-down > Refresh / Configure System Profile
 A. Civil 3D will close.

 11. Re-open Civil 3D WisDOT. The application is ready to use.
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C3D 2016
Civil 3D 2016-14 configuration FAQs
Last updated: 2020-10-26

Total video time: 19:26

16-c3d-16-14-cnfg-faq-01.mp4 19:26          

FAQs

 1. Will all WisDOT Civil 3D users be receiving the Civil 3D 2016-14 configuration?

No.  Only computers that currently have Civil 3D 2014 installed will receive the Civil 3D 2016-14 configuration.  Other users can request the 
Civil 3D 2016-14 configuration if they encounter a need.

 2. Will Civil 3D 2014 be uninstalled from my computer?

Not completely.  Some remnants will remain, but the application will no longer run.

 3. I have Civil 3D 2014 and Civil 3D 2016 installed on my computer.  I no longer need Civil 3D 2014.  Can I have Civil 3D 2014 uninstalled?

A clean uninstall of Civil 3D 2014 will also require a clean uninstall of Civil 3D 2016 first.  At this time, you are better off just leaving Civil 3D 
2014 on your computer.

 4. I no longer need the Civil 3D 2016-14 configuration.  Can I have it be removed so I only have the Civil 3D 2016 configuration?

Yes.  To remove the Civil 3D 2016-14 configuration:
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 A. Go to Software Center.  Windows Start menu > Microsoft System Center folder > 
Software Center

 B. In Software Center, Select C3D2014-2016 Configuration Removal Tool > Click 
INSTALL SELECTED.

 C. When the removal is complete, Windows start menu > Autodesk folder > Civil 3D 
2016 Imperial

 D. After Civil 3D 2016 has opened, WisDOT Standards Ribbon > Tools dropdown arrow 
> Refresh/Configure System Profile.  The configure system profile process will start. A 
cmd dialog will flash by quickly, then Civil 3D will close when it is completed.

 E. Verify there is a C3D shortcut icon on the User's Desktop named Civil_3D_2016_WisDOT.  You 
can now use Civil 3D 2016 using the WisDOT Civil 3D 2016 desktop shortcut.
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 5. What if I accidentally save my drawing while in the 2016 configuration instead of the 2016-14 
configuration and vice versa?

This is not an issue. For plan production drawings, saving the drawing while in the 2016 con-
figuration will not affect your sheets unless you used some of the 2016 configuration tools, such 
those found on the WisDOT Standards or Sheets ribbons.

 6. If I open my Civil 3D 2014 drawings using the Civil 3D 2016-14, does it migrate my drawing 
standards to Civil 3D 2016 standards?

No. Opening and saving a Civil 3D 2014 drawing using the Civil 3D 2016-14 configuration only 
updates the drawing to Civil 3D 2016.  It does not affect any of the drawing standards (layers, styles, 
etc.).  Sheet creation and plotting remain the same.  This is not a project migration.

 7. Can I run two instances of Civil 3D 2016?  One with the 2016-14 configuration and one with the 
2016 configuration?

No.  You can only run in one configuration at a time.

 8. Can I switch configurations while in Civil 3D?

You must exit Civil 3D 2016 and re-open it using the desired configuration.

 9. Now that my drawings will all be in Civil 3D 2016, will I have access to the latest sub-
assemblies?

For drawings that are using the Civil 3D 2016-14 configuration, the answer is "no".  For drawings 
that are using the Civil 3D 2016 configuration, the answer is "yes".  If you are not sure, contact sup-
port.cae@dot.wi.gov .

 10. How will plotting be impacted by this?

Plotting will not be impacted.  If your sheets were previously in Civil 3D 2014, you will open Civil 3D 
2016-14 configuration and plot the same way as you did before. As an alternative, you can use 
DWG TrueView to plot.

 11. How does this affect plotting with DWG TrueView?

Plotting with DWG TrueView will remain the same.  DWG TrueView has been updated to recognize 
the Civil 3D 2016-14 configuration.

 12. If I open a DWG by double-clicking on the file, which configuration of Civil 3D opens?

Do not double-click files to open Civil 3D. Open the desired Civil 3D configuration first, then open 
the DWG from there.

 13. Which Civil 3D 2016 tools developed by WisDOT will be available in the 2014 configuration of 
Civil 3D 2016?

None at this time.  The Civil 3D 2016-14 configuration replicates what was available using Civil 3D 
2014.  The Civil 3D 2016 "WisDOT" ribbons and palettes will only be available with the 2016 con-
figuration.

 14. How does this affect my survey database?
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If your survey database was in Civil 3D 2014, it will be permanently upgraded to Civil 3D 2016 the 
next time you access it.  If you need to plot points and survey figures using Civil 3D 2014 plotting 
standards, use the Civil 3D 2016-14 configuration.

 15. Why does a window stating "Please Wait..." appear every time I start Civil 3D?

When you start Civil 3D, a script must run first to set the desired configuration.  This adds roughly 5 
seconds to the Civil 3D startup time.

 16. How will I know which configuration I am in?

The easiest way to tell is to look for the "WisDOT" Ribbons.  If you see the "WisDOT" ribbons, you are 
in the 2016 configuration.  If they are not there, you are in the 2016-14 configuration.  Another indic-
ator is a "dark" vs "light" theme.  The Civil 3D 2016 configuration runs in a "light" theme and the 
Civil 3D 2016-14 configuration runs in a "dark" theme.

 17. How do I know which configuration my drawing was created in?

The easiest way is to look at the layers and check the plot styles.  The Civil 3D 2016 configuration 
uses plot styles that begin with a number and a letter (ex. "2G-wisdot").  The Civil 3D 2016-14 con-
figuration is the same as what was in Civil 3D 2014.  The plot styles typically are the same as the 
layer family (ex. "E_ALI").

 18. What if my project team consists of both WisDOT and consultant staff and the consultant 
staff are still using Civil 3D 2014?

The Civil 3D 2016-14 configuration can consume Civil 3D 2014 files delivered from consultants.  If 
you are handing off project files that were saved with the Civil 3D 2016-14 configuration, contact 
support.cae@dot.wi.gov and we will work with those consultants to set up the Civil 3D 2016-14 con-
figuration in their environment.

 19. What should I do with my Civil 3D 2014 custom templates, blocks, and plot style tables?

You can continue to use them as you have in the past.  We recommend opening any custom tem-
plates in the Civil 3D 2016-14 and saving them.

 20. Are the standards in the Civil 3D 2016-14 configuration being maintained?

Except for correcting major defects, WisDOT stopped maintaining Civil 3D 2014 standards.  There-
fore, the standards in the Civil 3D 2016-14 configuration will largely remain static.

 21. Does the WisDOT Maintenance tool update the Civil 3D 2016-14 configuration?

No, other than clearing Civil 3D 2016 cache files, the WisDOT maintenance tool does not affect the 
Civil 3D 2016-14 configuration.  It will still be used as the update mechanism for the Civil 3D 2016 
configuration.

 22. Can I just migrate my Civil 3D 2014 project standards to Civil 3D 2016 standards so I don't 
have to deal with the Civil 3D 2016-14 configuration?

The Civil 3D 2016-14 configuration was designed to make using Civil 3D 2016 as seamless as pos-
sible for projects currently using Civil 3D 2014.  Civil 3D 2014 projects can be migrated to Civil 3D 
2016 standards, but if the project has a lot of sheets already created, it may not be worth the 
effort.  Review the information under "Upgrading Civil 3D 2014 drawings to Civil 3D 2016 
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standards" on page 2243.  Contact support.cae@dot.wi.gov if you would like further advice on this 
topic.

 23. Do I need to open and save all of the Civil 3D 2014 files using the Civil 3D 2016-14 con-
figuration?

No, this is not necessary.  Open and save files using the Civil 3D 2016-14 configuration as you do 
your drawing edits.

 24. I closed Civil 3D, but I still receive the error "Civil3D Can Only Run in One Configuration at a 
Time.  Please Close Civil3D First to Run in a Different Configuration"?

This can happen if you immediately try to open Civil 3D just after you closed it.  It can take a few 
seconds for the application to release all of the files used to run the program.  Wait a few second 
and try again.

 25. I had my Civil 3D shortcuts on my Windows Task Bar.  Now when I click on them I get an error 
"Can't open this item....".

Choose "Yes".  This will remove your old shortcuts from the Task Bar.  Then, you can drag the new 
Civil 3D 2016 and Civil 3D 2016-14 shortcuts to the Task Bar.

 26. Will all of the subassemblies, macros, and reports that were available in Civil 3D 2014 also be 
available with the Civil 3D 2016-14 configuration?

Yes

 27. Will I lose all my Civil 3D 2014 workspace changes (such as for the Quick Access Toolbar)?

Yes.  Since the Civil 3D 2016-14 configuration runs in Civil 3D 2016, any workspace changes that you 
had for Civil 3D 2014 will need to be recreated in the Civil 3D 2016-14 configuration.

Civil 3D release comparison 2014 to 2016
Last updated: 2016-03-09

Project management: manage data shortcuts

 l Manage data shortcuts, repair broken shortcuts, and replace drawing objects.
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Collaboration and data exchange: Civil 3D and InfraWorks

 l Civil 3D objects can be exported to InfraWorks and InfraWorks models can be opened in Civil 
3D.
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 l The Export Civil 3D Drawing command for exporting DWG and DGN files has been integrated 
and is now available on the ribbon. The command now provides the ability to export multiple 
files simultaneously. The user interface has been updated and some settings are in a new 
Export Settings dialog box.

Surfaces: new features
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 l Create surface from a point cloud.

 l Create AutoCAD solids from TIN surfaces.

Alignments and profiles: new profile tools

 l Free circular vertical curve, free parabolic vertical curve additional options.

 l Extend fixed and floating profile entities.
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 l Unlock and change constraint types of vertical curves.Options to control how layout profile 
geometry is anchored.

Corridor modeling: new features

 l 3D areas for corridors reported in quantity takeoff report.
 l Retain existing corridor targets when replacing a sub-assembly.
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 l Corridor frequency options for curved portions of baselines and offsets.
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 l Specify how sample lines are incremented (from start of alignment or by absolute station).
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 l Select alignments by layer to be used as width and targets.

Section and section views: new features

 l Create sliced solids of pipe networks.
 l Control the direction of sections in section views. (Up station or down station.)

Pipe Networks: new features

 l Create AutoCAD solids from pipe networks.
 l Create exclusionary catchments.

Annotation labels
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 l Stagger corridor point code labels.

 l You can now use Properties palette to change the object reference that is used in alignment 
station offset labels, surface slope labels, surface spot elevation labels, and surface contour 
labels. Previously, the labels had to be deleted and recreated if you wanted to change the 
object that was being referenced in the label.

 l You can now use a drop-down list in the Properties palette to change reference text objects 
for label types that support reference text objects. Previously, an object selection button was 
available for selecting a different reference text object.

 l Pipe crossing profile and crossing section view labels.

AutoCAD new features: user-interface changes

 l Layout tabs have moved from the bottom-left of the drawing area to the far left of the status 
bar.
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 o 2014   

 o 2016 

 l Status bar icons have been redesigned and are now placed together beginning at the far right 
of the status bar.

 o 2014 

 o 2016

 

WisDOT standards changes adopted for Civil 3D 2016
Last updated: 2016-03-14

WisDOT standards changes for 2016:

WisDOT has made three main Standards changes for 2016:
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Textstyle & fonts

 l l The Custom DOT fonts have been retired. These have been replaced with a variety of com-
mon Windows True Type fonts.

 o o All Textstyles only represent a font style and are not named or set to a size or height. 

Layers

 l l Layer Updates. These changes include removing layers that refer to scales, merging and con-
solidating layers that were being used within civil styles, and renaming layers for clarification.

Plot style tables

 l l New Plot Style Tables have been created. These plot style define a lineweight and a color, 
either black gray or defined by layer. The default within the template layers is to use the line-
weight and color defined by the plot style, and not by the layer.  There are upgraded work-
flows showing how to use them within the templates. The startup templates and sheet 
templates have been updated to reflect these workflows.

Along with these standards changes WisDOT has developed predefined Layer States and Page 
Setups to accommodate the changes to the plotting workflow.

Layer updates in Civil 3D 2016
Last updated: 2016-03-10

Layers – Some removed from templates & some retired

The layer list for design and proposed layers has been slimmed down to reflect technologies avail-
able in Civil 3D. Civil 3D object display is now defined within the styles and plot style is set within the 
object rather than by layer. This has resulted in a significant reduction in the number of layers 
required to define these objects for deliverable output. 

In addition, each layer within the startup templates that is not used in a standard component or style 
has been removed from the template. Specifically all layers that could be purged were removed. The 
removed layers, known as additional design and production components can be imported into any 
drawing at any time using the Layers palette located on the Standards ribbon. 
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The biggest change from previous configurations and WisDOT's 2016 configuration is that layers, as 
the standards default, do not define the lineweight and color output directly, but rather a plot style is 
assigned to a layer from the wisdot standards plot style table, and this plot style defines the color 
and lineweight output.

WisDOT 2016 plot style tables
Last updated: 2016-03-11

Total video time: 14:19

plt-lyout-plt-styl-tbls.mp4 14:19 - This video contains the training for the entire topic.

Civil 3D 2016 plot style tables overview

The 2016 Plot Style Tables are different than the 2014 Plot Style Tables. The new plot style tables 
provided with the Civil 3D 2016 WisDOT customization gives each user the flexibility for custom plot-
ting output without ever modifying the plot style table.  

The purpose for the upgrades to the plot style tables and plotting workflow in Civil 3D 2016 is to 
make sure that standard plotted output is achieved consistently on each and every workstation with 
the WisDOT Civil 3D 2016 standards installed.  This is achieved by creating a standard plot style table 
that solely defines the standards output, and all objects within the drawing are set to a predefined 
plot style. Non-standard output is achieved by making and saving changes within the drawing files 
not by altering the plot style tables.  In the past, users would often make their own custom plot style 
table to get a desired output.  The downside to the previous workflow is the custom table may only 
be located on that user's machine.  No other person would be able to get the same plotting output 
without obtaining the custom plot style table.

To ensure the 2016 plot style tables are consistent on each workstation the users should not make 
edits to the plot style tables as was commonly done with to Civil 3D 2014.

Plot style tables defined
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Plot Style Tables in Civil 3D 2016 are outlined below. Generally speaking, the 2014 plot styles from 
the plot style tables were used to only define the output Color. All other object properties were 
defined by the objects themselves which were generally set to BYLAYER, leaving the layers to define 
the lineweight.

In 2016, there are 3 new plot style tables, each used for creating a specific plotted output.

wisdot_standard.stb

This plot style table is set to plot grayscale This is the primary plot style table for standard plan sheet 
output. Each plot style in this table is assigned a specific color and specific lineweight. When wisdot_
standard.stb plot style table is used, the object lineweight and object color is plotted based on the 
plot style assigned to it, not based on the layer setting or object setting. When this plot style table is 
used with the default plot style settings as set in the 2016 startup templates, a consistent plotted out-
put can be achieved from any workstation with the WisDOT 2016 standards installed.

wisdot_override.stb

This plot style table is set to plot color "by object" and lineweight "by object". Use this plot style table 
when there is a need for many color and/or lineweight overrides at the Civil 3D style, layer or object 
level. This plot style table can also be used to plot a drawing where a majority of objects need to be 
plotted in color. Like the name implies this plot style table allows to override the standard color and 
lineweight settings instead of using wisdot_standard.stb. Color and lineweight is determined by the 
civil object style, layer, or object property settings. This plot style table is similar to the 2014 plot style 
table wisdot-color.stb.
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wisdot_lw.stb

This plot style table is set to plot grayscale. The color output comes from the plot style table with the 
same settings as wisdot_standard.stb. The "lw" in the name stands for lineweight, and it means this 
plot style table allows the lineweight to be defined from object settings rather than plot style settings 
as in wisdot_standard.stb. Use this plot style table when there is a need for many lineweight over-
rides at the civil object style, layer or object property level.  This plot style table is similar to the 2014 
plot style table wisdot-gshade.stb. and is to be primarily used for plotting legacy Civil 3D 2014 draw-
ings that have been upgraded to Civil 3D 2016 standards. This plot style will likely be phased out over 
time. Drawings created with Civil 3D 2016 should not use this plot style table.

Plot Style Tables for use with translated 2014 drawings

When upgrading 2014 drawings to Civil 3D 2016, use this guide for the correct plot style table to use 
in Civil 3D 2016.

The first step is to run the "Add Layers" tool in order to add any layers that may not exist in the draw-
ing so legacy layers if need be can be mapped to the layer used in 2016. This button is found on the 
Standards Components panel located on the WisDOT Standards ribbon. 

Legacy plot style table comparison

The plot style in thewisdot-gshade plot style table define only the color output as black or grey, and 
set the lineweight to by object. This means in most 2014 drawings the lineweight is defined by the 
layer.

After saving a 2014 drawing to 2016, if the desire is to maintaining layer control of the lineweights, 
the wisdot-lw.stb should be used in place of the wisdot-gshade plot style table.

For 2014 drawings that have been saved to 2016 that need to maintain a fully color output then the 
wisdot-override plots style table should be used in place of the wisdot-color
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Plot Style Tables for use with new Civil 3D 2016 drawings

The new wisdot_standard.stb plot style table should be used in all drawings started in Civil 3D 2016 
except when non-standard output is desired (such as color). The wisdot_standard.stb plot style table 
defines the color and lineweight rather than using object properties to define them.

When non-standard output is desired, use the wisdot_override.stb plot style table. This plot style 
table uses the object color and object lineweight settings.

Note: wisdot_lw.stb is only for use when plotting legacy Civil 3D drawings that have been upgraded 
to Civil 3D 2016. It is not to be used with new drawings started with the WisDOT Civil 3D 2016 tem-
plates.

Each of these plot style tables are to be used in conjunction with a saved page setup and layer states 
that wisdot has provided. Refer to the Page setup tool on the WisDOT Standard and WisDOT Design 
palette. 

Below are a few examples of plot style and layer settings comparisons.
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When to use the plot style tables

Each of the 3 new plot style tables contains all of the same named plot styles. The only differences 
among them are the settings. The user only needs to assign the proper page setup to the layout to 
get the desired plot output. The wisdot_standard.stb plot style table is used to plot grayscale. The 
wisdot_override.stb plot style table is used to plot color by object color and also plot lineweight using 
object lineweight.

"Normal" plot style

Each of these 3 new plot style tables includes the plot style "Normal". The "Normal" plot style 
behaves like the styles in wisdot_override.stb. Color and lineweight are set to "by object". The 
"Normal" plot style is best used in cases where only a minor deviation is needed from the wisdot_
standard.stb output. For instance, a drawing where the standard greyscale and standard lineweight 
output is desired, but one utility is to be plotted in color. Rather than change page setups, the utility 
objects could be set to a color and the object's plot style set to "Normal". The object's properties 
could then be changed back to the default setting after plotting.

Object color overrides 

For instance, when plotting grayscale, but with only certain objects in color:

For civil objects

To plot specific civil objects in color in an otherwise grayscale plot, the user will need to change the 
civil object style to an "override" style or create a new style and adjust the hard-coded plot styles in 
the style definition. Styles named with _override in them denotes predefined style sets to be used for 
overriding the output color and or lineweight at the object or layer level. For example, in order to 
plot proposed alignments in color follow these steps:

 l Create a copy of the ALI Proposed style, and rename it to something unique.
 l Edit the new style, and hard-code all of the components' plot styles to Normal on the Display 
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tab. 

For AutoCAD objects

In order to plot certain AutoCAD objects in color in an otherwise grayscale plot, the user will need to 
set the object to use the Normal plot style. This can be accomplished 2 ways:

 l Option 1:  Select all objects to be plotted in color, and change the plot style to Normal in the 
object properties dialog box.
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 l Option 2:  Keep all of the AutoCAD objects' plot styles set to BYLAYER, which is the default set-
ting, and change the plot style of the object layer to Normal. This will plot all objects on this 
layer using the object color.  This can also be done to xreference layers when the color of an 
xreference needs to be changed.

wisdot_standard.stb plot style pen weights

black color gray color

0B-wisdot 0.005" 0G-wisdot 0.005"

1B-wisdot 0.006" 1G-wisdot 0.006"

2B-wisdot 0.007" 2G-wisdot 0.007"

wisdot_standard.stb
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black color gray color

3B-wisdot 0.008" 3G-wisdot 0.008"

4B-wisdot 0.010" 4G-wisdot 0.010"

5B-wisdot 0.012" 5G-wisdot 0.012"

6B-wisdot 0.014" 6G-wisdot 0.014"

7B-wisdot 0.016" 7G-wisdot  0.016"

8B-wisdot 0.020" 8G-wisdot 0.020"

9B-wisdot 0.022" 9B-wisdot 0.022"

10B-wisdot 0.024" 10B-wisdot 0.024"

11B-wisdot  0.028" 11B-wisdot  0.028"

12B-wisdot  0.031" 12B-wisdot  0.031"

13B-wisdot  0.035" 13G-wisdot  0.035"

14B-wisdot  0.040" 14G-wisdot  0.040"

15B-wisdot  0.042" 15G-wisdot  0.042"

16B-wisdot  0.045" 16G-wisdot  0.045"

17B-wisdot  0.055" 17G-wisdot  0.055"

18B-wisdot  0.062" 18G-wisdot  0.062"

19B-wisdot  0.075" 19G-wisdot  0.075"

20B-wisdot  0.082" 20G-wisdot  0.082"

WisDOT 2016 page setups
Last updated: 2016-03-10

Total video time: 03:36

2016 page setups

plt-lyout-wisdot-pg-setups.mp4  03:36
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WisDOT has provided predefined page setups. A page setup is a saved setting that specifies the plot 
area, paper size, scale, and plot style to use which determine the appearance of a plotted or pub-
lished output.

Civil 3D 2016 also utilizes page setups. A page setup hard-codes the plot style table, plotter, paper 
size, and orientation among other plotting options. These setups are then assigned to sheet layouts. 
These page setups have already been created for all of the standard WisDOT sheet sizes, and can be 
imported from the Page Setups palette as needed and then assigned to sheet layouts. 

 

                 

Current Page Setup All Tool

Once one Layout is set to a page setup, the Current Page Setup All tool can be used to set the rest of 
the layout to the same page setup. This tool is accessed by expanding the Plot Configuration panel 
pull-down on the WisDOT Sheets ribbon.
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Translate 2014 layers to 2016 standards tool
Last updated: 2016-03-11

Total video time: 10:33

16-trnslt-lyrs.mp4 10:33 - This video contains the training for this entire module.

Translate 2014 layers to 2016 standards tool

The Translate 2014 Layers to 2016 Standards tool can be run once a 2014 drawing is saved as a 
2016 drawing. 

This tool can be accessed from the WisDOT Standards ribbon by pressing the Layer States tool. This 
will bring up the Layer States palette. The Load Layer State: Translate 2014 Layers to 2016 Standards 
button can be found at the top of this palette.

This standards update tool will:

 l Insert all new WisDOT 2016 Plot Styles into the drawing
 l Insert all new WisDOT 2016 Text Styles into the drawing
 l Insert all WisDOT Linetypes into the drawing 
 l Insert all new WisDOT 2016 Layers into the drawing
 l Import the "Layer Translate 2014 to 2016" Layer State into the drawing
 l Allow the layers to be set with WisDOT 2016 Plot Style settings (Option 1)
 l Allow the layers to be set with WisDOT 2016 Plot Style settings and allow to set all other layer 

settings to WisDOT 2016 standards (Option 2)
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For drawing version updates, WisDOT provides two layer standards update options. Each option 
provides a different standards update path. With each of these options the drawing must be saved 
as a 2016 drawing, using Civil 3D 2016.

Option 1

Use this option to update only the plot style layer settings in the 2014 drawing to 2016 standards 
and maintain the lineweight layer settings as set from the 2014 standards. This allows a drawing to 
be updated with 2016 standards and still allow for 2014 like plotting.

This option requires only the Plot Style layer property be restored from the Layer Translate 2014 to 
2016 layer state.

Tip: Note: Option 1 will have no effect on a drawing that has already been updated using 
Option 2.

Option 2

Use this option to update the drawing layers to conform to all 2016 plot output standards. All layer 
settings can be updated including, but not limited to lineweight and plot style. This option requires 
that all the layer property be restored from the Layer Translate 2014 to 2016 layer state.

Tip: Note: Option 2 can be used on a drawing that has first been updated using Option 1.

Items to check if some objects still plot incorrectly

 1. Some objects may be hard-coded to a color or a plot style. Check that all object properties for 
color and plot style are set to BYLAYER. If they are not, change them to BYLAYER. 

 2. When layer translation is done to an XREF, the XREF needs to be detached and then reat-
tached in order for the updates to take effect. Simply reloading the XREF will not suffice. 

Civil 3D object styles updates
Last updated: 2016-03-09

Civil styles components defined within style: color, linetype, LT scale, lineweight, 
plot style

All the Civil 3D object styles within WisDOT startup templates have been modified to produce the 
default standard output by setting the visual options in the display settings of the style rather than 
have these settings controlled by layer. Plot Styles have also been set to not rely on the layer settings 
to produce the default standard output. These changes dramatically reduce the number of layers 
that are needed to be maintained in the startup templates.
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Upgrading Civil 3D 2014 drawings to Civil 3D 2016 standards
Last updated: 2020-10-26

Overview

Civil 3D 2016 has been released for use within WisDOT. The Civil 3D 2016 installation includes some 
minor Civil 3D and WisDOT custom feature enhancements and significant upgrades to WisDOT Civil 
3D standards.

There is no requirement to upgrade an existing project from Civil 3D 2014 to Civil 3D 2016. Existing 
projects created with Civil 3D 2014 may be upgraded to Civil 3D 2016 on a case-by-case basis. Weigh 
the benefits of using 2016 new additions and upgrades versus the time and effort required to 
upgrade all 2014 drawing files in a project.

Use the following information as a guide when considering whether to upgrade drawings from 2014 
to 2016.

New feature additions in Civil 3D 2016

Civil 3D 2016 program features

 l Data Shortcuts: Manage data shortcuts, repair broken shortcuts, and replace drawing 
objects.

 l Surfaces: Create surface from a point cloud.
 l Profiles: Free circular vertical curve, free parabolic vertical curve additional options.
 l Profiles: Extend fixed and floating profile entities.
 l Profiles: Unlock and change constraint types of vertical curves.
 l Profiles: Options to control how layout profile geometry is anchored.
 l Profile Views: Crossing pipe profile view labels.
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 l Corridors: 3D areas for corridors reported in quantity takeoff report.
 l Corridors: Retain existing corridor targets when replacing a sub-assembly.
 l Corridors: Corridor frequency options for curved portions of baselines and offsets.
 l Corridors: Specify how sample lines are incremented (from start of alignment or by absolute 

station).
 l Corridors: Select alignments by layer to be used as width and targets.
 l Section Views: Control the direction of sections in section views. (Up station or down sta-

tion.)
 l Section Views: Crossing pipe section view labels.
 l Section Views: Stagger corridor point code labels.
 l Import/Export: Civil 3D objects can be exported to InfraWorks and InfraWorks models can 

be opened in Civil 3D.
 l Import/Export: The Export Civil 3D Drawing command for exporting DWG and DGN files now 

provides the ability to export multiple files simultaneously.
 l User Interface: New Light and Dark color schemes
 l User Interface: Layout tabs and status bar icons have been relocated to provide more 

screen area for the drawing window.

WisDOT custom program features

 l New WisDOT workflow-specific ribbon tabs
 l New WisDOT workflow-specific palettes
 l New DWG Clean tool
 l New Swap Parts List Styles macro
 l New Pipe Network Sump Adjust macro
 l New Superelevation Tables macro

New WisDOT content additions in Civil 3D 2016

WisDOT assembly content

 l Crown Location Codes
 l FtLnFromAliProf

WisDOT subassembly content

 l New and improved subassemblies planned for addition

WisDOT blocks

 l Many additions to the Sign Plate block files
 l Work zone barricade blocks

WisDOT pipe networks

 l Updated pipe and structure catalogs
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WisDOT county maps 

 l New County Maps for 2016

New standards upgrades in Civil 3D 2016

WisDOT plotting

 l Plotting standards have been upgraded
 l New plot style tables
 l New page setups
 l 2014 drawings must go through a plot style translation process to use 2016 plot settings

WisDOT drawing components

 l All new textstyles (All WisDOT Civil 3D textstyles now use Windows TrueType fonts. The cus-
tom "DOT" fonts and associated textstyles are now depreciated.)

 l Additional dimension styles available 
 l Additional multileader styles available
 l Standard drawing layers have been consolidated (additions/removals)
 l Additional linetypes available

WisDOT drawing templates 

 l All new 2016 drawing templates (.dwt)
 l Templates purged for stability. Only contain components needed for Civil 3D styles
 l Standards drawing components (such as layers, linetypes, textstyles, dimension styles, mul-

tileaders) are added to drawings only when needed
 l New and updated Civil 3D styles

WisDOT sheet templates 

 l Upgraded Title Sheet layout
 l Sheet layout sizes range from 11"x17" to 36"x144"

WisDOT tool palettes 

 l All new workflow-based Tool Palette additions
 l New Tool Palettes containing sheet creation components for all standard plan sheet types. 

Deciding whether or not to upgrade

Project lifecycle considerations

 l There is no requirement to upgrade an existing project from Civil 3D 2014 to Civil 3D 2016. 
 l If the project is before 30%, likely candidate for upgrade
 l If the project is after 60%, or within 6 months to PS&E, likely should not upgrade
 l In between 30% and 60% is a judgement call (use guidelines below)
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Project lifecycle guidelines

 l It's OK to have 2014 drawings and 2016 drawings intermixed in a project. Not all drawings in 
a project have to be upgraded.

 l If a drawing is upgraded to 2016 and has attached xreferences, the xreferences must be 
upgraded to 2016 as well. If a drawing or project has xreferences used by many different 
drawings then upgrading one drawing may affect others down the line. Keep this complexity 
in mind.

 l A drawing with no xreferences can be left as a 2014 drawing even if other drawings in the 
project are upgraded to 2016

 l Fewer existing 2014 drawings means less work to upgrade and more potential future draw-
ings to gain the benefits of the upgrade to 2016

 l More existing 2014 drawings means more work to upgrade and fewer potential future draw-
ings to gain the benefits of the upgrade to 2016

 l Err on the side of caution. We don't want anyone's project deadlines to get into trouble 
because of time spent on upgrading drawings

Upgrading drawings from Civil 3D 2014 to Civil 3D 2016

Upgrade requirements

 1. Open and save a drawing in Civil 3D 2016
There is no file format change between Civil 3D 2014 and Civil 3D 2016. Both versions use AutoCAD 
2013 Drawing (*.dwg) format. Just open a 2014 drawing in Civil 3D 2016 and save to start working in 
2016.

 2. Upgrade a Civil 3D 2014 drawing to use new WisDOT Civil 3D 2016 plotting standards
WisDOT Civil 3D plotting standards have been upgraded for 2016. WisDOT Civil 3D 2016 plotting 
standards are incompatible with WisDOT Civil 3D 2014 plotting standards. A 2014 drawing must go 
through a plot style translation process to use the new plot style tables and page setups available in 
2016.

Optional additional upgrades

 1. Upgrade a Civil 3D 2014 drawing with WisDOT 2016 standard components (layers, linetypes, 
textstyles, dimension styles, or multileaders)

 2. Upgrade a Civil 3D 2014 drawing with Civil 3D Styles from the new WisDOT 2016 templates
 3. Upgrade a Civil 3D 2014 drawing with 2016 Pipe Network parts lists

Upgrade a Civil 3D 2014 drawing to use new WisDOT Civil 3D 2016 plotting stand-
ards (required)

Upgrade requirements

Upgrading a drawing to use new WisDOT Civil 3D 2016 plotting standards requires understanding 
the new WisDOT Plot Style Tables and also how the WisDOT Page Setups work.
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"WisDOT 2016 plot style tables" on page 2231

"WisDOT 2016 page setups" on page 2239

With plot style tables and page setups in mind, a 2014 drawing will need to have all the 2014 plot 
styles in the drawing translated to the new 2016 plot styles. This is accomplished by using layer 
states.

"Translate 2014 layers to 2016 standards tool" on page 2241

Upgrade a Civil 3D 2014 drawing with WisDOT 2016 standard components 
(optional)

With the release of Civil 3D 2016 upgrades were made to the WisDOT drawing standards. There have 
been changes/additions to layers, linetypes, textstyles, dimension styles, and multileaders. There is 
an easy way to add these standards to a drawing that was originally created with Civil 3D 2014.

 1. Open a drawing you wish to upgrade standards components.
 2. On the WisDOT Standards tab of the ribbon find the Standards Components panel.
 3. Press Add Layers, Add Dimensions, Add Multi-Leaders, Add Textstyles, and/or Add Linetypes 

to add these standards to a drawing.
 4. Save the drawing.

Upgrade a Civil 3D 2014 drawing with Civil 3D Styles from the new WisDOT 2016 
templates (optional)

With the release of Civil 3D 2016 upgrades were made to Civil 3D Styles. These changes/additions 
have been added to the new WisDOT 2016 drawing startup templates. The styles can be added to a 
drawing that was originally created with Civil 3D 2014 by importing them from the 2016 templates.

 1. Open a drawing you wish to upgrade Civil 3D Styles
 2. Save the drawing. (If you do not save, Civil 3D will prompt you to before you can import.)
 3. On the Manage tab of the ribbon find the Styles panel and press Import.

 4. Browse and select one of the 2016 startup templates located here: C:\wis-
dot\stnd\C3d2016\StartupTemplates

 5. The Import Civil 3D Styles dialog will appear. There will be many items selected by default. 
We do not recommend importing all the selected styles at once and we do not recommend 
to "Import settings". Uncheck the Import settings box first, then press the Uncheck All but-
ton second to deselect all the styles.
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 6. Expand the style categories and place checkmarks at the styles you wish to import. When 
done selecting click OK.
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 7. A verification dialog will appear. Press OK to continue.
 8. The Import complete dialog will appear. Click OK to finish.
 9. Save the drawing.

Upgrade a Civil 3D 2014 drawing with 2016 Pipe Network parts lists (optional)

A drawing originally created with Civil 3D 2014 can be upgraded to use the 2016 Pipe Network parts 
lists.

 1. Open a drawing you wish to upgrade the parts lists.
 2. OpenC:\wisdot\stnd\C3d2016\StartupTemplates\wisdot16.dwt
 3. Switch back to the drawing you wish to upgrade. 
 4. Open the TOOLSPACE and select the Settings tab
 5. Select Master View at the top of the tab

Page: 2249

Published on: 5/17/2023

Upgrading Civil 3D 2014 drawings to Civil 3D 2016 standards



 6. Scroll down, find wisdot16 and expand the category.

 7. Under the wisdot16 category, find Pipe Network and Parts Lists and expand the cat-
egories.
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 8. Select a parts list you wish to add. Left-click and drag the parts list from the TOOLSPACE into 
the drawing window. It will take a few seconds for the parts list to import. Be patient and 
wait for it to complete.

 9. Repeat Step 8 for other parts lists if desired.
 10. Save the drawing.
 11. Close C:\wisdot\stnd\C3d2016\StartupTemplates\wisdot16.dwt Do not save any 

changes to the startup template.
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Civil 3D 2014 in Windows 10 at WisDOT
Last updated: 2023-05-17

WisDOT began its deployment of Windows 10 in October 2017. We would like to share our exper-
ience so far. Civil 3D 2014, Civil 3D 2016, and the WisDOT custom configurations were tested using 
Windows 10 in the spring of 2017.  During testing, we did not encounter any issues and we decided to 
bring both Civil 3D 2014 and Civil 3D 2016 forward into Windows 10.

Fast-forward to now, and we have had a couple rounds of pilot deployments of Windows 10 to work-
stations running Civil 3D.  For many of the recipients there were no issues with Civil 3D 2014 or Civil 
3D 2016.  However, we have had multiple cases where Civil 3D 2014 would crash.  Usually, the crash 
would be triggered by simply actions in the user interface, such as selecting a different ribbon.   As we 
started to track these cases, the issues seemed to be isolated to a few specific series of work-
station/graphics card combinations. Unfortunately, we have not discovered a solution for these work-
stations.

We also encountered an issue where the Quick Access Toolbar (QAT) is invisible in Civil 3D 2014.

This is a known issue for Autodesk documented in their Knowledge Network and the fix is a simple 
registry entry.

Quick Access Toolbar missing in all Autodesk Products with Quadro K1100M

While researching these issues, we also discovered a couple Autodesk articles discussing how .NET 
Framework 4.7 may cause Civil 3D to crash.  WisDOT is presenting running .NET Framework 4.6, so it 
is not an immediate issue for us, but we'll want to keep an eye on it in the future.

AutoCAD 2012, 2013, and 2014 crash on Windows 8 and 10 systems

Autodesk products not working after installing .NET Framework 4.7

Info: Given the issues that we've encountered in the earliest stages of our Windows 10 deploy-
ment and the uncertain future of Civil 3D 2014, we have decided to change course by retiring 
the Civil 3D 2014 application internally.

Moving forward, WisDOT staff will utilize Civil 3D 2016 for their Civil 3D 2014 projects.  Since both ver-
sions utilize the same DWG format (2013), Civil 3D 2014 projects can be opened and completed in 
Civil 3D 2016.  This will not be a full migration to our Civil 3D 2016 standards (WisDOT changed the 
plotting standards in Civil 3D 2016 which requires "Upgrading Civil 3D 2014 drawings to Civil 3D 2016 
standards" on page 2243 for all drawings that contribute to plan sheets).

To avoid the process of migrating project plan sheet drawings, we built a Civil 3D configuration that 
points to all the Civil 3D 2014 standards (templates, blocks, plot style tables, etc).  We are calling this 
the Civil 3D 2016-14 configuration.  The Civil 3D shortcuts look the same, except now, the Civil 3D 
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2016-14 shortcut points to Civil 3D 2016 and opens with a profile geared toward the Civil 3D 2014 
standards files.  There is also the regular Civil 3D 2016 WisDOT shortcut that uses our Civil 3D 2016 
drawing standards.

Consultants may have a need for the Civil 3D 2016-14 configuration if they receive Civil 3D files from 
WisDOT or if they encountered similar issues with Civil 3D 2014 in Windows 10. If you have a need 
for the Civil 3D 2016-14 configuration, the files can be downloaded from our Roadway Design Files 
Civil 3D page.

Page: 2253

Published on: 5/17/2023

Civil 3D 2014 in Windows 10 at WisDOT

https://wisconsindot.gov/Pages/doing-bus/eng-consultants/cnslt-rsrces/tools/cad/civil-3d.aspx
https://wisconsindot.gov/Pages/doing-bus/eng-consultants/cnslt-rsrces/tools/cad/civil-3d.aspx


Infraworks
Introduction to InfraWorks webinar
Last updated: 2022-12-13

Total video time: 42:17

Info: This webinar was presented to WisDOT staff. It's purpose was to introduce WisDOT staff 
to the capabilities of InfraWorks and to provide a framework about how to think about dif-
ferent models generated from InfraWorks and their appropriate uses. People outside of 
WisDOT may find useful information in this topic.

Warning: This topic contains no information on requirements or mandates of usage of 
InfraWorks on WisDOT projects by consultants. It should be used for information only by 
people outside the Department.

Introduction and level of accuracy

iwx-intro-wbinr-01.mp4 10:34

The inception of Autodesk Infraworks into WisDOT for visualization purposes.

 1. What is visualization
 A. The representation of and object, situation or set of information as a chart or other 

image.
 I. Plan view of a corridor in Civil 3D
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 II. Conceptual View of same corridor in Infraworks

 III. With visualization it is easier to convey an idea to someone who is not in our 
field.

 2. Infraworks is that visualization tool
 A. Convey a set of 2D plans in a 3 dimensional world
 B. Convey multiple ideas in one model
 C. Produce a fly through video to help illustrate the model

 3. Infraworks levels of accuracy- How precise geographically an object is placed in the model.
 A. Low Accuracy

 I. Using Infraworks by itself and other free data
 II. Created for the purpose of internal meetings

 III. Early stages of design
 IV. Drawn manually or placed free handed
 V. Noncritical features

 B. Medium Accuracy
 I. Using Pre-DSR Civil 3D and Infraworks data

 II. Created for the purpose of internal or public meetings
 III. Early stages of planning
 IV. Tied to a coordinate system
 V. Features from Pre-DSR

 VI. Examples of data to bring in: Civil-D drawing, IMX files, LandXML, or GIS 
SHP/SDF files

 C. High Accuracy
 I. Using Post-DSR Civil 3D and GIS data

 II. Created for the purpose of internal of public meetings
 III. Final stages of planning or production
 IV. Tied to a coordinate system
 V. Features from Post-DSR

 VI. Examples of data to bring in:  Civil-D drawing, IMX files, LandXML, or GIS 
SHP/SDF files

 4. Infraworks levels of detail - How refined.

Level of detail and their intent
Page: 2255

Published on: 5/17/2023

Level of detail and their intent



iwx-intro-wbinr-02.mp4 8:50

 1. Level 1
 A. Sketch or layout of ideas in the early planning stage and collaboration
 B. Time: 1 day or less to build
 C. Software Infraworks
 D. Containing simple representations of roadways, buildings, water features, signs, etc.
 E. Not including right-aways or grading challenges
 F. Intent is to convey and share ideas

 2. Level 2 
 A. Meeting proposals and designs that have moved past the conceptual stage
 B. Time: multiple days to several weeks to complete
 C. Software: Infraworks, Civil 3D, GIS Data
 D. Objects have higher detail; including corridors from Civil 3D, GIS information, street 

lamps, cars or people
 E. Could include a video fly through
 F. Intent is to show the complete idea or plan in its entirety within the 3D model

 3. Level 3 
 A. Time: several weeks or a month to build model
 B. Software: 3DS Max, Video Editing, Post production processing
 C. Highly professional, photo-realism; importing the model into 3DS Max or another 

video editing software
 D. Additional animations; people walking, cars driving on the road, lighting features to 

create light and shadows
 4. Combining Level of Accuracy with Level of Detail

 A. Possible to have high LOA with low LOD
 B. Possible to have low LOA with high LOD
 C. In the end we want a high LOA with a high LOD

Building a level 1 model

iwx-intro-wbinr-03.mp4 05:44

Create Model

 1. Home screen > open Model Builder...
 2. Area Selection toolbar

 A. Search a location: type Gotham, Wisconsin
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 3. Select Draw a Rectangle

 4. Model Name: type Model Name
 5. Description: this is optional
 6. Coordinate System: If unsure, select LL84
 7. Select Create Model
 8. Message: We are preparing your new model.  Continue 

Info: You will receive an email when it is finished.

Open created model

 1. Home screen > Recent > select Model Name
 2. Message: Where would you like to store the  Model Builder model? select Local

Info: It may take any where for 4-20 minutes to download depending on model size. 
When it's done downloading there will be terrain, water features, roads, buildings and 
everything else it collected.

Edit model properties

 1. Infraworks toolbar > select Application Options
 A. Application Options dialog box

 I. Unit Configuration
 a. Default Units: Imperial
 b. Type: Feet
 c. Decimals: 2 (0.00)

 B. OK
 2. Ribbon > Manage tab > select Model Properties

 A. Model Properties dialog box
 I. User Coordinate System: select Globe , scroll and select RichlandWI.F

 B. Apply
 C. OK
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Split the road

Info: In a level 1 drawing you don't have be to careful about where the road goes you will be 
able to adjust that in Level 2. 

 1. Decide to start and end points of the split
 A. Right-click start point > Split feature
 B. Right-click end point > Split feature 
 C. Delete the center

 2. Draw new road
 A. Ribbon > Create tab > Transportation panel > select Planning Road
 B. Select a Draw Style
 C. Left-click at start point, continue clicking along the path to the end point
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Connect existing roadwork

 1. Select any existing roads
 2. Left-click red end grip point and drag to new aligned road, creating an intersection

Add generic building

 1. Zoom to existing road to the north that has other buildings
 2. Ribbon > Create tab > Structures panel > select Building
 3. Select a Draw Style
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 4. Trace the shape of the building

 5. Edit generic building
 A. Select the building and use arrows to edit the dimensions
 B. Use Building palette to edit building properties; such as name, facade color, roof slope, 

and roof material.
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Add stand of trees

 1. Zoom to curve of new aligned road
 2. Ribbon > Create tab > Environment panel dropdown > select Stand of Trees
 3. Draw a polyline/outline along the north edge of curve, returning back to start point
 4. Edit tree models

 A. Single-click a tree or double-click to select all of the trees
 B. Use scroll bar to adjust the density
 C. Arrows to adjust height
 D. Use tree palette to edit other properties

 5. Repeat process to south edge of curve
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Add vehicles

 1. Ribbon > Create tab > Environment panel > select City Furniture
 2. Select Draw Style > select Silver Compact Car
 3. Select a place on the road

 A. Use arrows to align or rotate
 B. Use Window Copy/Paste commands (Ctrl+C, Ctrl+V) to duplicate
 C. Use the City Furniture palette to change the style of vehicle

Duplicate objects to make other objects

 1. Car to tree
 A. Select object to change
 B. City Furniture palette > Manual Style > More Styles

 I. Select 3D Model Style dialog box
 a. Dropdown > select 3D Model/Vegetation
 b. Select a tree
 c. OK

 2. Car to person
 A. Select object to change
 B. City Furniture palette > Manual Style > More Styles

 I. Select 3D Model Style dialog box
 a. Dropdown > select 3D Model/People
 b. Select a person
 c. OK

Tip: It is quicker to copy and past the same object to place in the model and then use 
the style palette to change the color or type of car and even to change the car into a 
tree, person, etc.

Info: Remember the focus is not accuracy. Just conveying the idea.

Adding a Storyboard to the model

Ribbon > Present/Share tab

 l Present panel
 o Storyboard Creator - opens Storyboard tool
 o Storyboard Player - plays the storyboards
 o Watermarks - add watermark to your videos or images

 l Share panel
 o Export 3D Model - exports files to .fbx, .dae, or .obj formats
 o Export IMX - exports in IMX format
 o Export FGDB - exports to a Esri file geodatabase (.gdb)

 1. Ribbon > Present/Share tab > select Storyboard Creator > Storyboard tool > select 
Camera Path Animation button dropdown
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 A. Select Create from Component Road to create a camera path
 B. Select Add an Animation to create camera movement, such as looking left or right, to 

create crane or orbit animations.

Building a level 2 model

iwx-intro-wbinr-04.mp4 06:08

To make a Level 2 model start with a Level 1 model and more accurate data

 1. Export an IMX file from Civil 3D
 A. Ribbon > Output tab > Export panel > select Export IMX

 2. Configure the road
 A. Set the coordinate system

 B. Give the road a Rule Style

 C. Corridor is accurately placed in the model based on the coordinate system
 3. Configure the Surface

 A. The terrain from the USGS is not always the most accurate

 B. Configure the terrain from the imported IMX file

 C. This will give you the terrain that is realistic not +/- 30'
 4. Alternatively import the Civil 3D drawing directly

 A. Configure the settings to confirm the correct coordinate system
 B. The imported road comes in as a design road with limited variables

 C. Convert the road to a component road

 D. Adjust the width and slope of the lanes

 E. Add components to the road
 I. Add a lane and adjust to 4' width

 II. Add a gravel shoulder
 III. Adjust the material to look like gravel
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 IV. Add a jersey wall
 a. Split the jersey wall to make room for a field entrance

 b. Split the gravel shoulder
 c. Adjust the gravel width to match the jersey wall

 V. Add a guard rail to the other side
 VI. Adjust spacing and rotation of the guard rail

 VII. Set seam offset to 1' so rail is on top of gravel

 F. Adjust the road from fixed width to fixed slope
 G. Adjust the grading limit to fall outside the design limits

 I. You can split the grading area 
 II. Add a transition from 3:1 to 4:1

 H. Add to the library to use again without have to build again

Trimble warehouse models

iwx-intro-wbinr-05.mp4 07:44

Trimble warehouse is a great location to get models that are more realistic

 1. Insert model from Trimble warehouse
 A. https://3dwarehouse.sketchup.com/index.html
 B. Use search key to find things like an old barn
 C. Download
 D. Open in free software Sketchup Make
 E. Unlock and delete the ground
 F. Export as a Collada model (.dae)
 G. Place in model

 2. Create a new Proposal view for each design option
 A. Copy the master for each Proposal
 B. Make changes in the different proposals independent of the other views

 3. Bookmarks allow you to save views and jump back and forth between specific views
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 4. Adjust the Sun and Sky

 5. Add a Watermark

Summary and next steps at WisDOT

iwx-intro-wbinr-06.mp4 06:42

 1. Visualization can be broken down into two concepts
 A. Level of Detail (LOD)
 B. Level of Accuracy (LOA)

 C. What else can Infraworks do
 I. Structure Design

 II. Drainage Analysis (requires cloud credits)
 III. Culvert Design (standards-driven)
 IV. Intersection Design (rules-driven)
 V. Traffic Analysis

 VI. Profile Optimization (requires cloud credits)
 VII. Earthwork quantity Generation

 VIII. And a host of other things
 D. Starting an early adopter deployment to run through early 2018

 I. Starts now or when you have a suitable project until group is full
 II. Other functional areas such as Survey, Utilities, Traffic...

 III. Up to 50 early adopters- depending on project type and location
 E. Check with your supervisor if you think Infraworks would be suitable and you want to 

become an early adopter
 I. Send and email to support.cae@dot.wi.gov

 II. We'll send you a questionnaire about your project and goals
 III. Once you're selected we'll arrange for the software to be installed

 F. Licensing
 I. Our current licensing structure allows for 3 named users per license

 II. This is not a pool license. Each user will be assigned a license
 III. This may change with the next license renewal

How to become a WisDOT early adopter

iwx-intro-wbinr-07.mp4 05:56
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 1. User Expectations
 A. Participate in follow-up meetings and user groups
 B. Give feedback on challenges, successes and share with other users
 C. Test updates and help develop content
 D. Be an active participant

 2. What happens once its installed
 A. Basic standards and workflows will be available to help you get started but early adop-

ters will be guiding our standards development as they work through their projects
 B. Technical support will be available through a visualization email address similar to the 

CAE Support email you use for Civil 3D and provided by our consultant partner CTC 
Technologies

 C. You'll receive regular correspondence from MDU asking for your input on a variety of 
things such as standards and workflows

 D. You'll attend user group/ follow-up meetings to help us understand your needs and 
share your insights with other users

 3. I want to learn Infraworks but I don't have a suitable project
 A. There is a free 30 day trial version of Infraworks if you don't have a project that is suit-

able for the early adopter program. You will have to make arrangements through your 
supervisor to have it installed.

 B. If you install the trial version and later want to move to the licensed version, you will 
not lose all your previous work if you set up your account using you WisDOT email 
address.

 4. Check with your supervisor if you think Infraworks would be suitable and you want to become 
an early adopter

 A. Send and email to support.cae@dot.wi.gov
 B. We'll send you a questionnaire about your project and goals
 C. Once you're selected we'll arrange for the software to be installed

Infraworks level 1
InfraWorks overview
Last updated: 2022-12-13

Total video time: 9:03

iwx-lvl01-ovrvu-01.mp4 9:03

 1. Create a Level 1 model using Model Builder
 A. Select an area for the model and giving it a name
 B. Verifying the coordinate system
 C. It pulls information from the USGS website; aerial, terrain, streets, buildings, etc.

 2. Open the created model
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 3. Add elements
 A. Place planning road and convert to component road.
 B. Join another road to the component road to make an intersection.
 C. Add row/stand of trees
 D. Add city furniture; trees, cars, buildings, signs, people, etc.

 4. Edit objects
 A. Use Copy & Paste command to duplicate
 B. Use Style palette to change material, color, or appearance
 C. Use gizmos and arrows to adjust size, placement, elevation

 5. Create a storyboard

InfraWorks Model Builder
Last updated: 2022-12-13

Total video time: 4:20

iwx-lvl01-mdl-bldr-01.mp4 6:25

Create a model

 1. Home screen > select Model Builder...
 2. Model Builder window

 A. Model space is an interactive map
 I. Mouse wheel to scroll

 II. Left-click to pan around
 III. + and - symbols to zoom in and out
 IV. Map dropdown to choose road view or aerial view.

 B. Area of Interest
 I. Area Selection bar: enter in a location

 a. Type Gotham, WI 
 II. Area Selection by current view (maximum of 200 sq km), rectangle, polygon, or 

insert a polygon.
 a. Select Draw a rectangle to select an AOI and draw out the model area.

Page: 2267

Published on: 5/17/2023

InfraWorks Model Builder

https://c3dkb.dot.wi.gov/video/infrawrks/iwx-lvl01/iwx-lvl01-mdl-bldr-01.mp4


 III. Model Name: enter in the name for the model area
 a. Type WisDOT-Training Video

 IV. Add description: optional, additional 1000 character description to further 
define the model

 V. Coordinate System: must be selected and cannot be changed after model is cre-
ated.

 a. Select Name Selected
 b. Select Coordinate System dialog box

 i. Select WI83-CF
 ii. OK

 VI. Create Model
 3. Message: We are preparing your new model Close
 4. X to close Model Builder window

Info: You will receive an email when it is finished.

Open created model

 1. Home screen > Recent > select WisDOT-Training Video
 2. Message: Where would you like to store the Model Builder model? BIM360
 3. Select a BIM 360 Project Folder dialog box

 A. Browse to ...WisDOT Videos\Project Files\Infraworks Model Builder
 B. OK

Info: It may take any where for 4-20 minutes to download depending on model size. 
When it's done downloading there will be terrain, water features, roads, buildings and 
everything else it collected.

(BIM360 and Project Admin) 4:20

 

InfraWorks interface
Last updated: 2022-12-13

Total video time: 11:47

iwx-lvl01-intrfc-01.mp4 11:47

 icon is the InfraWorks Home button

Utilities toolbar (upper right)

 l Undo
 l Redo
 l Display model in full-screen mode
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 l Application Options - includes General, Navigation, Model Generation, Unit Configuration, 3D 
Graphics, Data Import, Point Cloud, and User Interface

 l BIM 360 - Launch button
 l Sync - used if you are collaborating with others
 l Shared Views 
 l InfraWorks Help - Online help, tips and shortcuts, community, tutorials, message log
 l Account Administration - Sign-in, manage licenses, BIM 360 collaboration, Autodesk 360 pro-

files
 l Switch active proposals
 l Tools to customize your views

Ribbon > Manage tab

 l Model panel - Model properties, Model Explorer, Proposals
 l Content panel - Data Sources, Style Palette, Drainage parts editor, Autodesk Connecter for 

ArcGIS
 l Display panel - Surface Layers, Terrain Themes, Feature Themes, Style Rules, Component 

Mapping, Sun and Sky
 l Point Clouds panel - Point Cloud Themes, Point Cloud Terrains, Linear Feature Extraction, Ver-

tical Feature Extraction, Image Lookup, Export Point Cloud

Ribbon > Create tab

 l Transportation panel - Component Road, Planning Road, Barrier, Railway, Right of way
 l Structures panel - Bridge, Tunnel, Building, Generic Object
 l Drainage panel - Culvert, Pipeline, Pipeline connector, Drainage network
 l Environment panel City Furniture, Point of Interest, Coverage, Grading Area, River, Water 

Area, Row of Trees, Stand of Trees, Parcel, Easement, Suitability Maps

Ribbon > Analyze tab

 l Transportation panel - Profile Optimization, Corridor Optimization, Traffic Simulation, Sight 
Distance, Job Monitor, Mobility Simulation

 l Structures panel - Line Girder Analysis, Refined Analysis, Quantities
 l Drainage - Watershed, Highlight Drainage, Size drainage network, Inspect Performance, Rain-

fall Content

Ribbon > Present/Share tab

 l Present panel - Storyboard Creator, Storyboard Player, Watermarks, Create Snapshot, Launch 
Screencast

 l Share panel - Export 3D Model, Export IMX, Export FGDB, Publish to ArcGIS

InfraWorks: sketch roads
Last updated: 2022-12-13

Total video time: 2:16
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Sketch roads

iwx-lvl01-skch-rd-01.mp4 2:16

Draw new design road

 1. Open model
 2. Ribbon > Create tab > Transportation panel > select Planning Road
 3. Select Draw Style dialog box

 A. Select Frontage Street/Interstate
 4. Left-click start point for new road, continue left-clicking to the end, and double-click end point
 5. Select road and edit

 A. Cyan cone grips to adjust vertical grading/elevation
 B. Pink square grip points to adjust PI (X,Y)
 C. Orange arrows grips to adjust barrier or distance
 D. Gizmo to adjust the placement of the whole object.

Create Intersection

 1. Left-click end point of new road and continue to an existing road
 2. Snap to existing road
 3. Double-click to end

InfraWorks: Sketch buildings
Last updated: 2022-12-13

Total video time: 3:00

iwx-lvl01-skch-bldg-01.mp4 3:00

Create a building

 1. Open model
 2. Ribbon > Create tab > Structures panel > select Building
 3. Left-click and draw shape of building from aerial image, double-click to end
 4. Building Properties data card

 A. Manual Style > More Styles
 I. Select a facade or material to change the building

 II. OK
 B. Roof Material > More Styles

 I. Material > Roofing > select a style
 II. OK

 C. Roof Slope: 25%
 D. Select building and use arrow grip to change height
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 E. Select a side of the building > right-click menu > Add Vertex
 I. Select mid-grip point and drag to desired shape

 II. Select point > right-click menu > Remove Vertex

InfraWorks: City furniture
Last updated: 2022-12-13

iwx-lvl01-city-frntr-01.mp4 8:47

Add vehicles

 1. Open model
 2. Ribbon > Create tab > Environment panel > select City Furniture
 3. Select Draw Style dialog box

 A. In search bar: type vehicle
 B. Select a vehicle from the list of styles

 4. Left-click and drag a distance to place the vehicle
 5. Tip: When placing an object, the tool requires a distance. If you select more than the 

length of a single object, the tool will place multiple objects.

 6. Double-click to close
 7. Use gizmo or arrow grips to make adjustments
 8. Use Copy/Paste commands to duplicate; select object,  Ctrl+C , Ctrl+V, and double-click to 

place

Edit objects

 1. Select a vehicle
 2. City Furniture Properties data card > Manual Style > More Styles
 3. Select 3D Model Style dialog box

 A. Open Vegetation Folder and select a tree

Add a row of trees

 1. Ribbon > Create tab > Environment panel > select City Furniture
 2. Select Draw Style dialog box

 A. In search bar: type vegetation
 B. Select a tree from the list of styles

 3. Left-click and drag a distance along a roadway for the placement of trees
 4. Double-click to close

Tip: It is quicker to copy and past the same object to place in the model and then use 
the style palette to change the color or type of car and even to change the car into a 
tree, person, building, etc.
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InfraWorks: Coverages
Last updated: 2022-12-13

Total video time: 4:10

iwx-lvl01-cvrg-01.mp4 4:10

Coverages are objects that use to shape the terrain and visual change the way the ground is dis-
played. Coverages are commonly used for zoning and have predefined styles to represent their 
appearance.

Add coverage area

 1. Open a model with a building
 2. Ribbon > Create tab > Environment panel > select Coverage
 3. Select Draw Style dialog box

 A. Select a coverage from the list of styles
 4. Draw shape around the building, double-click end point to close
 5. Select area and use gizmos to make adjustments

Add/Remove vertices

 1. Select a side > right-click menu > Add Vertex or Remove Vertex

Change style

 1. Coverage Properties data card > Manual Style > More Styles
 2. Select 3D Model Style dialog box

 A. Select a different style from the list
 B. OK

Customize a style

 1. Ribbon > Manage tab > Content panel > select Style Palette
 2. Style Palette > Coverage tab

 A. Select an existing style
 B. Style Editing > select Duplicate
 C. Rename the new style
 D. Select the new style
 E. Style Editing > select Edit (pencil)
 F. Configure dialog box

 I. Fill Style: Pick a Style/Color icon > select Transparent OK
 II. Outline Width: 1

 III. OK

Tip: From the Style palette, the style can be dragged onto the coverage area.
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Grading

If a building doesn't sit on the existing ground, add a finish floor elevation.

 1. Ribbon > Create tab > Environment panel > select Coverage
 2. Draw a shape around building, double-click to close
 3. Coverage Properties data card

 A. Name: type FG
 B. Manual Style > More Styles

 I. Select Style/Color dialog box
 a. Material tab > Terrain > select Grass
 b. OK

 4. Select area
 5. Select each corner cyan cone grip and type, in dimension tool tip box, 1080

InfraWorks: Storyboard
Last updated: 2022-12-13

iwx-lvl01-strybrd-01.mp4 5:43

Create a storyboard

A storyboard is a dynamic presentation tool that guides the viewer along a designated path through 
the model. A storyboard can display titles and captions and use a variety of camera angles to create 
visual effects.

 1. Open model with a roadway
 2. Ribbon > Present/Share tab > Present panel > select Storyboard Creator
 3. Storyboard > Camera Path Animation dropdown > select Add Camera Path Animation
 4. First key frame is added to the storyboard
 5. Pan down roadway, hold right-click and drag to next point.

Tip: Using right-click will keep the view at the same elevation.

 6. Storyboard > select + next to first keyframe to add a keyframe
 7. Continue down the road adding additional keyframes

 o It's good to place a keyframe at Point of Curve (PC) and Point of Tangent (PT)
 o Use arrow keys to shift view or pivot at the location

 8. Select green Play button to run storyboard animation

Edit storyboard speed

 1. Storyboard > Camera speed control
 2. Select Keyframe #1
 3. Set speed: 400 mph

Info: This changes the speed for all proceeding keyframes.

 4. Select Keyframe #3
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 5. Set speed: 200 mph

Info: To change a single keyframe to be a different speed, select the keyframe and 
enter a speed value, then select the proceeding keyframe and enter the original speed 
value.

 6. Select Keyframe #4
 7. Set speed: 400 mph
 8. Select green Play button to run storyboard animation

Creating keyframes with design and component roads

 1. Storyboard > select Add New Storyboard
 2. Convert road to a component road

 A. Select road > right-click menu > Convert to Component Road
 3. Storyboard > Camera Path Animation dropdown > select Create from Component 

Road
 4. Left-click on road
 5. Create a Camera Path from a Component Road dialog box

Contains values for editing the keyframes; camera position offsets, Tangent position offsets, 
and advanced settings. Offset values - negative is left and positive is right.

 6. Leave values as default
 7. Create
 8. Select green Play button to run storyboard animation

InfraWorks: Exporting the storyboard
Last updated: 2022-12-13

iwx-lvl01-xprt-strybrd-01.mp4 2:03

Exporting will create a video of the model built in Storyboard.

 1. Ribbon > Present/Share tab > Present panel > select Storyboard Creator
 2. Storyboard > select Exports Current Storyboard to Video 
 3. Export Storyboard dialog box

 A. Encoder: select Widows Media video
 B. File Name: rename, type Story.mov at the end of the path
 C. Frame rate: select 30 frames per second
 D. Select radio Use Viewport Resolution
 E. Check box Export Section

 I. From: 4.0, To: 20.0
 F. Record
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Infraworks level 2
Infraworks level 2 overview
Last updated: 2022-12-13

Total video time: 10:16

iwx-lvl02-ovrvu-01.mp4 10:16

A Level 2 model starts with an existing Level 1 model, but then more detail is added to it.

 1. 2 ways to insert a file into InfraWorks
 A. Export an IMX file from Civil 3D and import into InfraWorks

 I. Include road and surface source data
 B. Bring in an Autodesk Civil 3D DWG directly

 I. Configure road and terrain data

Tip: By bringing in Civil 3D data improves accuracy of the model.

 2. Convert the design road to a component road
 A. Allows functionality and adjusts grading elements of the component road

 3. Select a road assembly and edit grading elements
 A. Adjust cut and fill slopes or edit material styles and colors

 4. Insert road components
 5. Place decorations
 6. Adjust the grading
 7. Split elements into multiple segments

 A. Allow a section to be deleted so another road component can be added, like an inter-
section

 8. Add component road to the library
 9. Add 3D elements with high detail components using Sketchup or Revit

 A. Download model, export model as COLLADA File (.dae), and insert in InfraWorks
 B. Configure and place

 10. Proposals - Option that can be developed separately from other designs
 A. Master view is the existing conditions
 B. Copy Master model for each design proposal
 C. Edit and make changes to the proposal model

Info: These changes are independent of the other proposals.

 11. Add bookmarks
 o Saved views within a model, such as areas of interest

 12. Sun and sky
 A. Adjust the time and date

 I. Accurate position of the sun throughout the day or time of year
 B. Adjust the wind direction or speed
 C. Adjust cloud cover

 13. Add a watermark into the model
 A. Adjust placement, transparency, and scale
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Tip: Will remain displayed when playing a storyboard.

Infraworks: Proposals
Last updated: 2022-12-13

Total video time: 3:05

iwx-lvl02-prpsl-01.mp4 3:05

Add a new proposal

A proposal is a way to convey multiple ideas all within the same model. Every new proposal is a copy 
of the previous proposal built.

Tip: It is recommended that you only include base model information (existing conditions) in 
the master proposal. Then create a new proposal for each new design alternative based on 
the master proposal.

Your starting proposal is called Master

 1. Ribbon > Active Proposal dropdown > Add
 2. Add New Proposal dialog box

 A. Name: type NewProposal1
 B. OK

The new proposal is identical to the Master.

Edit the new proposal

 1. Select a road and change the material style using the style palette
 A. Ribbon > Manage tab > Content panel > Style palette

Infraworks: Import LandXML file
Last updated: 2022-12-13

Total video time: 7:43

iwx-lvl02-landxml-01.mp4 7:43

A LandXML file from Civil 3D will be horizontally and vertically accurate do to the coordinate system 
and the constraints of Civil 3D.

Create LandXML file in Civil 3D

 1. Open drawing file in Civil 3D
 2. Ribbon > Output tab > Export panel > Export to LandXML
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 3. Export to LandXML dialog box
 A. In this dialog box, check and uncheck objects to include with this file.

Tip: The list of objects will only include those native to the drawing.

 B. Specify LandXML version: Select the most current version
 C. OK

 4. Export LandXML dialog box
 A. Save in: Select a location to save the file or save to Desktop
 B. File name: Rename or keep current name
 C. Save

 5. Close Civil 3D

Import LandXML file into InfraWorks

 1. Open InfraWorks
 2. Open model
 3. Ribbon > Manage tab > Content panel > Data Sources
 4. Data Sources panel > Add file data source dropdown > LandXML
 5. Select Files dialog box

 A. Navigate to your file location and select file
 B. Open

 6. Choose Data Sources dialog box
 A. Check boxes of objects to include; check surfaces, corridors, and alignments.
 B. OK

 7. Data Source panel
 8. Find added  Surfaces > Right-click menu > Configure

Info: Surface data will be under Terrain. Corridor and Alignment data will be found 
under Roads.

 9. Data Source Configuration dialog box
 A. Name: Can be changed
 B. Coordinate System: verify its correct, HARN/WI.Richland.WI-F
 C. If any data has been changed, Close & Refresh ,or if no data has changed, OK or 

Cancel
 10. Repeat for Corridors and Alignments

Infraworks: Inserting a IMX file
Last updated: 2022-12-13

Total video time: 7:43

iwx-lvl02-landxml-01.mp4 7:43

An IMX file is a specific filetype for Autodesk software. This includes Civil 3D and Infraworks. When 
creating an IMX file from Civil 3D it will extract: Surfaces, Alignment and Profiles, and Pipe Networks.
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Create IMX file in Civil 3D

 1. Open drawing file in Civil 3D
 2. Ribbon > Output tab > Export panel > Export IMX
 3. Please enter the writable Imx folder path <...\Projects|WisDOT>: select 

Enter to accept
 4.  Please enter the wanted Imx version: Select the most current version and Enter to 

accept
 5. Close Civil 3D

Import IMX file into InfraWorks

 1. Open InfraWorks
 2. Open model
 3. Ribbon > Manage tab > Content panel > Data Sources
 4. Data Sources panel > Add file data source dropdown > Autodesk IMX
 5. Select Files dialog box

 A. Navigate to your file location and select file
 B. Open

 6. Choose Data Sources dialog box
 A. Check boxes of objects to include; check roads or surfaces
 B. OK

 7. Data Sources panel
 8. Find added   sources > right-click Config > select Configure

Info: Surface data will be under Terrain. Roads data will be found under Roads.

 9. Data Source Configuration dialog box
 A. IMX tab 

 I. Surface to Import: check box next to surface name
 B. Geo Location tab

 I. Coordinate System: verify its correct, HARN/WI.Richland.WI-F
 C. Sources tab

 I. Don't Drape
 D. Select Close & Refresh 

 10. Message: You have surface(s) under the uncategorized folder. The surface under this folder 
will not be visible. Do you want to open Surface Layers Panel to manage surface layers? Yes

 11. Surface Layers dialog box
 A. Find surface layer, Terrain Surfaces > Uncategorized > Surface Name
 B. Right-click the Surface Name and drag to Ground Surface
 C. Select lightbulb to make it visible
 D. OK

 12. Repeat for Roads, change the Draping to Drape so the road appears on top of surface.

Infraworks: Component roads
Last updated: 2022-12-13

Page: 2278

Published on: 5/17/2023

Infraworks: Component roads



Total time: 31:35

Draw a component road

iwx-lvl02-cmpnent-rd-01.mp4 3:51

Component roads are an advanced road option in InfraWorks that gives the users engineering 
design capabilities. Features such as roadside grading, cross slopes of lanes, super elevation, or 
curve radius based on traveled speed. The ability to calculate quantities from a component road is 
also an option. A component road gives us the ability to edit on multiple levels, such as the lanes, 
shoulders, and medians.

 1. Open model
 2. Ribbon > Create tab > Transportation panel > Component Road
 3. Road Properties data card

 A. Name: Component Road A
 B. Radio selected PI based
 C. Assembly: change to Four Lane Undivided

 4. On the model, left-click at start point, continue selecting points along the path to the end 
point, double-click at end point to close.

 5. Select road
 6. Road Properties data card

 o Attributes - Such as function, set speed, add/remove lane markings
 o Grading - Such as cut/fill material, cut/fill slopes

Converting a planning road to a component road

 1. Select planning road > right-click menu > Convert to Component Road

Adding and swapping components 

iwx-lvl02-cmpnent-rd-02.mp4 6:34

 1. Adding component, shoulder
 A. Select component road > right-click menu > Insert Road Component
 B. Select template dialog box

 I. Select Shoulder
 C. A yellow line represents the placement of the new component
 D. Left-click the north side of the road to place the shoulder

 I. Use grips to widen the shoulder
 II. Drag middle grip point to the start grip to remove transition, repeat other side

 III. Edit the station number, manually key in number
 IV. Select start or end point and set the station to align with Start of Road and End 

of Road
 E. Shoulder Properties data card

 I. Under Type, change the shoulder's material style
 II. Under Geometry, change the width, depth, or slope of the shoulder
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 2. Swapping component, shoulder to jersey wall
 A. Select shoulder > right-click menu > Replace Component
 B. Select Component Style dialog box

 I. Select Jersey Barrier
 II. OK

Adding decorations

iwx-lvl02-cmpnent-rd-03.mp4 4:55

Besides lanes and shoulders, component roads will allow additional features to be added to it like 
street lights, power poles, and guard rails. These features are known as decorations. These dec-
orations can be given a start location, spacing and then a potential horizontal or vertical offset from 
its insertion location

 1. Add guard rail
 A. Select component road > right-click menu > Place Decorations
 B. Select Component dialog box

 I. Select Guard Rail Straight
 C. Message: Pick a seam on the road to place decoration, then press Enter to finish.

 I. A yellow line represents the placement of the new component
 II. Select south side of the road

 III. Enter
 2. Select and edit guard rail

 A. Decoration Properties data card
 I. Name: rename

 II. Geometry
 a. Spacing: 9.8 , to place them close together
 b. Rotate: 180 , to rotate to face inside the road
 c. Other adjustments include horizontal or vertical offsets and scaling

Roadside grading

iwx-lvl02-cmpnent-rd-04.mp4 5:06

Roadside grading with component roads allows different slopes to be applied from one side of the 
road to the other. It is possible to also have different side slope on the same side of the road with a 
transition area to blend the two areas together.

 1. Add grading
 A. Select component road
 B. Road Properties data card

 I. Grading
 a. Grading Method: Fixed Slope
 b. Cut Material > More Styles > Color > GreenOK
 c. Fill Material > More Styles > Color > BlueOK
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 C. Message: Hit Enter or click away from card to regenerate the section.
 D. Left-click inside the model window
 E. Select grading on north side of the road
 F. Grading Properties data card is specific to that grading

 I. Cut Slope: 1.00:1
 II. Fill Slope: 1.00:1

 III. Enter to update
 2. Add a transition

 A. Select grading > right-click menu > Split Grading
 B. Either left-click a point or key in station value
 C. Repeat so there are 3 sections
 D. Select middle section
 E. Grading Properties data card

 I. Cut Slope: 3.00:1
 II. Enter to update

 F. Select section to the right > right-click menu > Add transition
 G. Either left-click a point or key in station value

Superelevations

iwx-lvl02-cmpnent-rd-05.mp4 1:58

Component Roads can display the transition areas for superelevation as it enters and exits the 
curve. The Max Slope, Runoff for Tangent, and Spiral can be set within the properties of the road.

 1. View superelevation
 A. Select component road
 B. Road Properties data card

 I. Attributes > Superelevation toggle on
 C. Left-click inside the model window to update
 D. Select center line of road > right-click menu > check box Show Superelevation
 E. Road Properties data card

 I. Superelevation Input includes Max Superelevation Rate, Runoff on Tangent, 
and Runoff on Spiral

Cross section display

iwx-lvl02-cmpnent-rd-06.mp4 3:26

Display cross sections in three different views.

 1. Select road > right-click menu > Show station in Cross Section view
 2. Road Cross Section dialog box

 A. Station number box: use + or - to change the station
 B. A yellow line appears on the model to show where the cross section is. Right-click and 

drag to change location.
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 C. Click  to switch between Superelevation, Road Assembly, and Cut/Fill views 
of the roadway cross section.

Advanced road options

Bottom of the Road Properties data card, are advanced options.

 1. Select Earthwork Quantities (Cut/Fill) icon to preform calculations
 A. Earthwork Quantities dialog box

 I. Enter station ranges and turn on toggle
 B. Return to data card and select Play button to compute

 I. Calculates Cut, Fill, and Net Fill quantities
 2. Select Materials Quantities (Calculator) icon

 A. Material Quantities dialog box
 I. Enter station ranges and turn toggle on

 II. Report calculates the length (ft.), area (sq.ft.), and volume (cu.yd) for each com-
ponent of the road. This can include components such as jersey walls, light 
poles, trees, etc.

 III. Generate Report to generate a .CSV file.

Splitting components

iwx-lvl02-cmpnent-rd-07.mp4 3:41

When the design of the road is not typical from one end to the other it may be required to split apart 
your road components to add in the necessary detail. 

 1. Create opening
 A. Select component barrier > right-click menu > Split Component
 B. Message: Key in a station value and press Enter, or click at a road station.
 C. Select component barrier > right-click menu > Split Component
 D. Message: Key in a station value and press Enter, or click at a road station.
 E. Select the middle section > right-click menu > Delete Component

 2. Modify opening
 A. Select shoulder > right-click menu > Split Component
 B. Snap point to station
 C. Select shoulder > right-click menu > Split Component
 D. Snap point to station

Page: 2282

Published on: 5/17/2023

Infraworks: Component roads

https://c3dkb.dot.wi.gov/video/infrawrks/iwx-lvl02/iwx-lvl02-cmpnent-rd-07.mp4


 E. Shoulder Properties data card > Geometry
 I. Width: 10.0'

 3. Add transition
 A. Select barrier's end grip point and move to allow room for transition
 B. Message: You have one or more edits on the component. Click outside of the com-

ponent to refresh.
 C. Select shoulder > right-click menu > Transition In

Importing component roads into the library

iwx-lvl02-cmpnent-rd-08.mp4 2:04

Once a typical cross section has been created that area of the component road can be extracted and 
added the library for quick access. It is better to start with something that is similar then it is to start 
with a clean slate.

 1. Add a typical cross section to the library
 A. Select component road > right-click menu > Road Assembly > Add to Library
 B. Message: Key in a station value and press Enter, or click at a road station.
 C. Add to Library dialog box

 I. Type in a name and OK
 2. Use cross section to create a new road

 A. Ribbon > Create tab > Transportation panel > Component Road
 B. Road Properties data card

 I. Type > Assembly > Select the name of the assembly (blue hypertext)
 C. Select Assembly dialog box

 I. Select the new cross section
 D. Draw new road on model

Infraworks: Inserting GIS data
Last updated: 2022-12-13

Total video time: 8:31

iwx-lvl02-gis-data-01.mp4 8:31

Inserting GIS Data into the model will help improve the model's level of detail.

Bring in data 

 1. Open InfraWorks
 2. Open model
 3. Bring in building footprint

 A. Ribbon > Manage tab > Content panel > Data Sources
 B. Data Sources panel > Add file data source dropdown > SHP
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 C. Select Files dialog box
 I. Navigate to your file location and select file Buildings.shp

 II. Open
 D. Data Sources panel

 I. Find added   source Buildings > right-click menu > Configure
 II. Data Source Configuration dialog box

 a. Common tab
 i. Name: Buildings
 ii. Type: Coverage Areas
 iii. Style: Rule Style > select Style Chooser icon

 i. Select Style/Color dialog box
 i. Select a color for coverage: Restricted Area (yel-

low with red outline)
 ii. OK

 b. Geo Location tab
 i. Coordinate System: WISCRS2011-DaneF

 c. Source tab
 i. Draping Options: Drape

 d. Close & Refresh
 4. Bring in sanitary sewer structures

 A. Data Sources panel > Add file data source dropdown > SHP
 B. Select Files dialog box

 I. Navigate to your file location and select file SS_Struc.shp
 II. Open

 C. Data Sources panel
 I. Find added   source SS_Struc > right-click menu > Configure

 II. Data Source Configuration dialog box
 a. Common tab

 i. Name: SS_Struc
 ii. Type: Pipelines Connectors
 iii. Style: Rule Style > select Style Chooser icon

 i. Select Style dialog box
 i. Select Green Circle 
 ii. OK

 iv. Elevation Offset: select Expression Editor icon
 i. Elevation Offset dialog box

 i. In text area, type Rim_elev, select it to add
 ii. OK

 v. Size, Height: select Expression Editor icon
 i. Height dialog box

 i. In text area, type Depth_ft, select it to add
 ii. Place cursor at the end and type -Rim_elev, select 

it to add
 iii. OK
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 b. Geo Location tab
 i. Coordinate System: WISCRS2011-DaneF

 c. Close & Refresh
 5. Bring in sanitary sewer pipes

 A. Data Sources panel > Add file data source dropdown > SHP
 B. Select Files dialog box

 I. Navigate to your file location and select file SS_Main.shp
 II. Open

 C. Data Sources panel
 I. Find added   source SS_Struc > right-click menu > Configure

 II. Data Source Configuration dialog box
 a. Common tab

 i. Name: SS_Main
 ii. Type: Pipelines
 iii. Elevation

 i. Select radio Elevation (Pipe Invert) 
 ii. Elevation From: select Expression Editor icon

 i. Elevation Offset From dialog box
 i. In text area, type From_el, select it to add
 ii. OK

 iii. Elevation To: select Expression Editor icon
 i. Elevation Offset From dialog box

 i. In text area, type To_el, select it to add
 ii. OK

 iv. Style: Rule Style > select Style Chooser icon
 i. Select Style dialog box

 i. Select Green Circle
 ii. OK

 b. Geo Location tab
 i. Coordinate System: WISCRS2011-DaneF

 c. Source tab
 i. Draping Options: Set Elevation

 d. Close & Refresh

To view pipes, which are on the underside of the model

 1. Data Sources panel
 2. Select SS_Struc > right-click menu > Select Features
 3. Use mouse to zoom and pan to underside

Infraworks: Culverts
Last updated: 2022-12-13

Total video time: 8:31
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Adding box culvert

iwx-lvl02-gis-data-01.mp4 8:31

 1. Ribbon > Create tab > Drainage panel > select Culvert
 2. Select start point, draw across road, and select end point

Tip: If you need a fixed length, type a number in the tool tip.

 3. When selected, grip points appear
 o Including horizontal location, elevation control, height of culvert, width of culvert, 

radius of barrel, height of headwall, flare angle
 4. Culvert Properties data card

 o Type - Inlet configuration, barrels count, shape, material, Manning's n
 o Attributes - Tailwater conditions and elevations
 o End treatment - Headwall height and flare angle
 o Performance - Show analysis results toggle, flow, and report
 o Geometry (not editable) - Size, culvert length, entrance invert and exit invert elev-

ations, barrel slope and skew angle 

Infraworks: Bookmarks
Last updated: 2022-12-13

Total video time: 2:16

iwx-lvl02-bookmrk-01.mp4 2:16

A bookmark is a quick hyperlink to get to a specific location or spot within the model.

 1. Add bookmark
 A. Zoom to area you want to bookmark
 B. Ribbon > select Bookmarks

 C. Select Add
 D. Thumbnail will appear in bookmark list
 E. Type in a name

 2. Delete bookmark
 A. Ribbon > select Bookmarks
 B. Find the bookmark to be deleted

 C. Select  to delete

Infraworks: Watermarks
Last updated: 2022-12-13
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Total video time: 2:22

iwx-lvl02-wtrmrk-01.mp4 2:22

Watermark allows the placing of an image, typically a logo, on the model. The placement of the 
image is where it will remain throughout the entirety of the model. Watermarks are beneficial when 
you are creating videos or producing a storyboard that will be exported because the image rep-
resents ownership or is customized for the viewer.

 1. Ribbon > Present/Share tab > Present panel > select Watermarks
 2. Watermark panel

 A. Select green + to add
 B. Choose Watermark Image to Import dialog box

 I. Select image
 II. Open

 C. Watermark Properties
 I. Name

 II. Image Location
 A. Transparency - Click and drag slider to make adjustments
 B. Placement - Includes anchor placement, scaling, and offsets
 C. Select red X to delete

Sun and sky
Last updated: 2022-12-13

Total video time: 2:53

iwx-lvl02-sun-sky-01.mp4 2:53

The Sun and Sky feature within InfraWorks helps bring the model to life. Because InfraWorks is geo-
located by a coordinate system the location of the sun will be accurate to the specific time and date 
of the year. The date and time can be set for the model so you can display the model to see the 
effects of the sun with shadowing. Along with the location of the sun, the model can also adjust the 
amount of cloud cover and change in wind direction.

 1. Ribbon > Manage tab > Display panel dropdown > select Sun and Sky
 2. Sun and Sky dialog box

 A. Date & Time
 I. Click and drag slider to make adjustments

 B. Wind & Clouds
 I. Click and drag slider to make adjustments

Infraworks: Storyboards
Last updated: 2022-12-13

Total time: 41:05

Interface of the storyboard
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iwx-lvl02-strybrd-01.mp4 7:19

Storyboards creator is a tool that will generate a fly through of your model. This fly through can be 
created by manually adding keyframes based on the current view of the model or directly from a 
design or component road. Addition animations can be added to streamline the overall fly through. 
Once the storyboard is complete it can be exported out to a windows media format.

Open storyboard creator

 1. Ribbon > Present/Share tab > Present panel > select Storyboard Creator

Storyboard toolbar

 1. Storyboard Name - Editable, name of the storyboard
 2. Duration - The total time of the storyboard
 3. Play & Stop - Play or stop the animation of the storyboard
 4. Follow storyboard position
 5. Add a new Camera Path animation

 A. Import a path from another design
 B. Create a path from the component road, this will follow the center line.

 6. Add a new Zoom animation
 A. Including Crane, Look around, Orbit, Pan and Zoom, Recorded walk, Still motions, 

Track, and Zoom
 7. Add a new Caption
 8. Add a new Title
 9. Add a new Date/Time animation

 A. Includes editing sun & sky settings
 10. Import existing storyboards
 11. Add new Storyboard
 12. Export current Storyboard
 13. Export current Storyboard to video
 14. "-" Zoom out
 15. "+" Zoom in
 16. Zoom resolution - 1 sec. - 30 mins.
 17. Hide Item Details
 18. Show Storyboard Library

Storyboard and properties 

Storyboard is broken into 2 parts; Captions & Titles and Paths & Animations. At the top is a time ruler 
that measures the time placement of each container or keyframe.

 1. Select Title, displays the title of the video
 A. The properties box includes 

 I. Name of item selected and its duration
 II. Transition in/out information
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 III. Text tab
 a. Font styles and placement
 b. Window that displays how the text will appear
 c. Text or HTML
 d. Transparency

 2. Select Caption, displays information within the video
 A. The properties box includes 

 I. Name of item selected and its duration
 a. Transition in/out information
 b. Text tab
 c. Font styles and placement
 d. Window that displays how the text will appear
 e. Text or HTML
 f. Transparency

 3. Select a keyframe, a frame from the video
 A. The properties box includes 

 I. Name of item selected and its duration
 II. Keyframe station and transition information

 III. Camera speed control settings
 IV. Reset button

Crane animation

iwx-lvl02-strybrd-02.mp4 3:23

The Crane animation will create a fly through that will simulate the path being linked to the end of a 
crane. As the path moves higher it will also move backwards. As the path moves lower it will also 
move forward.

Open storyboard creator

 1. Ribbon > Present/Share tab > Present panel > select Storyboard Creator

Add crane animation

 1. Play through animation to the point you want the crane animation to start.
 2. On the time ruler, select and drag red arrow to the start time of crane animation.

 3. Storyboard toolbar > Add a new Zoom animation dropdown > select Add Crane Anim-
ation
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 4. In properties box
 A. Name: name animation
 B. Duration: 3.0 sec.
 C. Transition: Cut
 D. Type: Crane up
 E. Distance up: 150.0 ft.
 F. Distance back: 75.0 ft.
 G. Select play button to preview

Add another crane animation

 1. On the time ruler, select and drag red arrow to the end of previous animation.
 2. Storyboard toolbar > Add a new Zoom animation dropdown > select Add Crane Anim-

ation
 3. In properties box

 A. Name: name animation
 B. Duration: 3.0 sec.
 C. Transition: Cut
 D. Type: Crane down
 E. Distance down: 100.0 ft.
 F. Distance forward: 75.0 ft.

 4. Pull back video playthough (blue line) and press play button 

Look around animation

iwx-lvl02-strybrd-03.mp4 4:18

The Look Around animation allows the user to rotate the camera to the left, right, up, or down based 
off of a current pivot point on the cameras path.

Open storyboard creator

 1. Ribbon > Present/Share tab > Present panel > select Storyboard Creator

Add looking left animation

 1. Play through animation to the point you want the look around animation to start.
 2. Storyboard toolbar > Add a new Zoom animation dropdown > select Add Look Around 

Animation
 3. In properties box

 A. Name: name animation
 B. Start time and duration, adjust if needed
 C. Angle Left, 90.0 degrees
 D. Select play button to preview
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Add a pause after an animation

 1. Storyboard toolbar >  Add a new Camera Path animation dropdown > select Add Cam-
era Path animation

 2. With new keyframe selected, adjust waiting time.
 A. In properties box

 I. Waiting time: 1.0 sec. 

Add looking right animation

 1. On the time ruler, select and drag red arrow to the end of previous animation.

 2. Storyboard toolbar > Add a new Zoom animation dropdown > select Add Look Around 
Animation

 3. In properties box
 A. Name: name animation
 B. Start time and duration, adjust if needed
 C. Angle Right, 90.0 degrees

 4. Pull back video playthough (blue line) and press play button

Orbit animation

iwx-lvl02-strybrd-04.mp4 3:39

The Orbit animation will create a fly through that will simulate the path being rotated about a pivot 
point that is equal to the center of the screen. Similar to the Look around animation just the pivot 
point is in front of the camera and not at the location of the camera.

Open storyboard creator

 1. Ribbon > Present/Share tab > Present panel > select Storyboard Creator

Add orbit animation

 1. Play through animation to the point you want the orbit animation to start.
 2. Add a crane up animation.
 3. Storyboard toolbar > Add a new Zoom animation dropdown > select Add Orbit Anim-

ation
 4. In properties box

 A. Name: name animation
 B. Start time and duration, adjust if needed
 C. Angle Left, 180.0 degrees
 D. Select play button to preview
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Add a pause after an animation

 1. Storyboard toolbar >  Add a new Camera Path animation dropdown > select Add Cam-
era Path animation

 2. With new keyframe selected, adjust waiting time.
 A. In properties box

 I. Waiting time: 2.0 sec.

Add another orbit animation

 1. Storyboard toolbar > Add a new Zoom animation dropdown > select Add Orbit Anim-
ation

 2. In properties box
 A. Name: name animation
 B. Start time and duration, adjust if needed
 C. Angle Right, 180.0 degrees

 3. Pull back video playthough (blue line) and press play button

Pan and zoom animation

iwx-lvl02-strybrd-05.mp4 4:27

The Pan and Zoom animation will create a fly through that will simulate the path sliding horizontally, 
and will move the model either left or right or move forward (up) or backwards (down). Applying a 
zoom factor to the animation will adjust the vertical relationship with the model.

Open storyboard creator

 1. Ribbon > Present/Share tab > Present panel > select Storyboard Creator

Add pan and zoom animation

 1. Play through animation to the point you want the pan and zoom animation to start.
 2. Add a crane up animation.
 3. Storyboard toolbar > Add a new Zoom animation dropdown > select Add Pan and 

Zoom Animation
 4. In properties box

 A. Name: name animation
 B. Pan Right, 80.0 ft.
 C. Distance Up, 75.0 ft.
 D. Percentage Zoom-in, 75%
 E. Select play button to preview

Add a pause after an animation

 1. Storyboard toolbar >  Add a new Camera Path animation dropdown > select Add Cam-
era Path animation
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 2. With new keyframe selected, adjust waiting time.
 A. In properties box

 I. Waiting time: 2.0 sec.

Add another pan and zoom animation

 1. Storyboard toolbar > Add a new Zoom animation dropdown > select Add Pan and 
Zoom Animation

 2. In properties box
 A. Name: name animation
 B. Pan Left, 160.0 ft.
 C. Distance Up, 75.0 ft.
 D. Percentage Zoom-in, 70%

 3. Pull back video playthough (blue line) and press play button

Recorded walk animation

iwx-lvl02-strybrd-06.mp4 3:03

The Recorded Walk animation will create a fly through that will record the actions or my movements 
throughout the model.

Open storyboard creator

 1. Ribbon > Present/Share tab > Present panel > select Storyboard Creator

Add a walking animation

 1. Play through animation to the point you want the walking animation to start.
 2. Storyboard toolbar > Add a new Zoom animation dropdown > select Add Recorded 

Walk Animation
 3. In properties box

 A. Name: name animation
 B. Select Start Recording

 4. Use mouse on the model and rotate view, zoom in or out, or pan around.
 5. In properties box 

 A. Select Stop Recording  

Add a still image

 1. Zoom to object or area you want to take a still image of.
 2. Storyboard toolbar > Add a new Zoom animation dropdown > select Add Recorded 

Walk Animation
 3. In properties box

 A. Name: name animation
 B. Select Start Recording
 C. Select Stop Recording 
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iwx-lvl02-strybrd-07.mp4 2:12

The Still Motion animation will create a fly through that will simulate the path not moving. The cam-
era does not move during the shot, although other transitions may be introduced or added into the 
shot.

Open storyboard creator

 1. Ribbon > Present/Share tab > Present panel > select Storyboard Creator

Add a still motion animation

 1. Play through animation to the point you want the still motion animation to start.
 2. Storyboard toolbar > Add a new Zoom animation dropdown > select Add Still Motion 

Animation
 3. In properties box

 A. Name: name animation
 B. Start time and duration, adjust if needed

Track animation

iwx-lvl02-strybrd-08.mp4 4:06

The Track animation will create a fly through that will simulate the path sliding to the left or to the 
right without pivoting.

Open storyboard creator

 1. Ribbon > Present/Share tab > Present panel > select Storyboard Creator

Add a track animation

 1. Play through animation to the point you want the still motion animation to start.
 2. Storyboard toolbar > Add a new Zoom animation dropdown > select Add Track Anim-

ation
 3. In properties box

 A. Name: name animation
 B. Start time and duration, adjust if needed
 C. Dropdown above preview: Start here, Half-way point, or End here
 D. Type: Track right or Track left
 E. Track distance: 100.0 ft.
 F. Check box lock camera on center of interest if you want the view to pivot.
 G. Select play button to preview

Zoom animation
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iwx-lvl02-strybrd-09.mp4 4:07

The Zoom animation will create a fly through that will simulate a camera path zooming in or out 
from the model. 

Open storyboard creator

 1. Ribbon > Present/Share tab > Present panel > select Storyboard Creator

Add a zoom animation

 1. Play through animation to the point you want the still motion animation to start.
 2. Add a crane up animation.
 3. Storyboard toolbar > Add a new Zoom animation dropdown > select Add Zoom Anim-

ation
 4. In properties box

 A. Name: name animation
 B. Start time and duration, adjust if needed
 C. Dropdown above preview: Start here, Half-way point, or End here
 D. Type: Zoom  in or Zoom out
 E. Zoom distance: 500.0 ft.

 5. Pull back video playthough (blue line) and press play button

Titles and captions

iwx-lvl02-strybrd-10.mp4 4:31

Inserting a Title to a storyboard helps to start the video out with a quick description of the model 
before the actual fly through takes place. Adding a captions to the storyboard help identify areas of 
interest in the model as the fly though is taking place.

Open storyboard creator

 1. Ribbon > Present/Share tab > Present panel > select Storyboard Creator

Add a caption

 1. Storyboard toolbar > select Add a new Caption
 2. In storyboard, select and drag caption container to the point you want the caption to appear 

in the playthrough.
 3. In properties box

 A. Name: name animation
 B. Duration: 5.0 sec.
 C. Transitions:

 I. In: Fade, over 0.5 sec.
 II. Out: Fade, over 0.5 sec.
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 D. Font setting toolbar
 I. Font style dropdown

 II. Font size
 III. Bold, Italicize, or Underline
 IV. Justifications; Left, Right, or Center

 E. Text preview box: Edit text, add caption
 4. Pull back video playthough (blue line) and press play button

Add a title

 1. Storyboard toolbar > select Add a new Title
 2. In storyboard, select and drag title container to the point you want the title to appear in the 

playthrough.
 3. In properties box

 A. Name: name animation
 B. Duration: 4.0 sec.
 C. Transitions:

 I. In: Fade, over 1.0 sec.
 II. Out: Fade, over 1.0 sec.

 D. Font setting toolbar
 I. Font style dropdown

 II. Font size
 III. Bold, Italicize, or Underline
 IV. Justifications; Left, Right, or Center

 E. Text preview box: Edit text, add title
 F. Transparency: adjust slider or type a percentage, set to 40%

 4. Pull back video playthough (blue line) and press play button
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External resources
Last updated: 2021-10-22

ACEC WI Civil 3D Group webcasts Quarterly webcasts focused on  using Civil 3D. Many directly related 
to WisDOT work.

Autodesk University The largest collection of classes on Autodesk products. Many have online video 
and handouts available.

FHWA 3D engineered models

Production Support | CADD - FDOT Autodesk Resources

http://civil-community.autodesk.com/ An online community center focused on Infraworks, Civil 3D, 
and where they meet.

YouTube

 l ADSK Infrastructure home
 l ATG USA YouTube channel

Blogs | Autodesk

 l Infrastructure Reimagined Ideas and innovations for civil engineering
 l AEC Connection Sharing Autodesk cloud collaboration ideas & workflows
 l Civil Immersion Sharing Autodesk infrastructure ideas & workflows

AutoDesk knowledge network

 l AutoCAD Civil 3D Knowledge Overview 
 l AutoCAD Civil 3D Forum
 l AutoCAD Civil 3D Ideas  Share ideas for future product features directly with the AutoCAD 

Civil 3D team and collaborate on existing suggestions with your peers.
 l Autodesk Civil 3D Tutorial Videos

AutoCAD resources

 l AutoCAD Keyboard Shortcuts
 l AutoCAD 2020 - About Coordinate Entry
 l Videos: AutoCAD Tips by Lynn Allen

TRANSOFT resources

 l AUTOTURN | EVALUATING THE QUALITY OF A SWEPT PATH ANALYSIS
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https://www.fdot.gov/cadd/default.shtm
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